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executive parameters 31-4

Glossary: F 31-4
finite element analysis 31-4
finite element mesh 31-4
floating boundaries 31-5
floating conductor 31-5

Glossary: G 31-5
Genetic Algorithm 31-5
goal 31-5
grid plane 31-5
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hotkeys 31-5
Glossary: I 31-5

imaginary permeability 31-5
imaginary anisotropic relative permeability 31-6
imaginary relative permeability 31-6
impedance 31-6
independent generator 31-6
inductance 31-6
infinite bus 31-6
insulating boundary 31-6
insulator 31-6
isotropicmaterials 31-7

Glossary: L 31-7
laminationmodel 31-7
line impedance 31-7
LMB 31-7
Lorentz force 31-7
Lorentz torque 31-7
lumped capacitance 31-7

Glossary: M 31-7
magnetic coercivity 31-7
magnetic flux 31-8
magnetic loss tangent 31-8
magnetic retentivity 31-8
magnetic susceptibility 31-8
matching boundaries 31-8
material consumption 31-8
material coordinate system 31-9
mesh refinement 31-9
multi-processing 31-9

Glossary: N 31-9
natural boundary 31-9
Neumann boundary 31-10
nodes 31-10
nominal design 31-10
nonlinear materials 31-10
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Glossary: O 31-10
outer terminals 31-10

Glossary: P 31-10
parametric analysis 31-10
paste buffer 31-11
perfect conductor 31-11
permanent magnets 31-11
permeability 31-11
permittivity 31-11
phasors 31-11
polyline 31-11
post processing 31-11
press board (pressboard) 31-12
problem region 31-12

Glossary: R 31-12
relative permeability 31-12
relative permittivity 31-12
resistance 31-12
RMB 31-12
RMBM 31-12

Glossary: S 31-13
section 31-13
seeding 31-13
self-inductance 31-13
skin depth 31-13
slot fill factor 31-13
solver 31-13
solver residual 31-13
superposition 31-14
surface 31-14
sweep 31-14
symmetry boundary 31-14

Glossary: T 31-14
terminal 31-14
tile window 31-14
toolbar 31-14
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Glossary: V 31-14
value boundary 31-14
variable sweep definition 31-15
vector functions 31-15
view window 31-15
virtual force 31-15
virtual torque 31-15
visibility 31-15

Index Index-1

Contents-84
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



1 - Legal Notices
Legal Notice
1. ANSYS, Inc. Contact Information
2. ANSYS Trademarks List
3. GNU LESSER GENERALPUBLIC LICENSE (LGPL)
4. Apache License
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7. CommonDevelopment and Distribution License (CDDL)
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Legal Notice
Copyright and Trademark Information
© 2016 SAS IP, Inc. All rights reserved. Unauthorized use, distribution or duplication is prohibited.
ANSYS, ANSYSWorkbench, Ansoft, AUTODYN, EKM, Engineering KnowledgeManager, CFX,
FLUENT, HFSS and any and all ANSYS, Inc. brand, product, service and feature names, logos and
slogans are registered trademarks or trademarks of ANSYS, Inc. or its subsidiaries in the United
States or other countries. ICEMCFD is a trademark used by ANSYS, Inc. under license. CFX is a
trademark of SonyCorporation in Japan. All other brand, product, service and feature names or
trademarks are the property of their respective owners.
Disclaimer Notice
THIS ANSYS SOFTWARE PRODUCT AND PROGRAMDOCUMENTATION INCLUDE TRADE
SECRETS AND ARE CONFIDENTIAL AND PROPRIETARY PRODUCTS OF ANSYS, INC.,
ITS SUBSIDIARIES, OR LICENSORS. The software products and documentation are furnished by
ANSYS, Inc., its subsidiaries, or affiliates under a software license agreement that contains
provisions concerning non-disclosure, copying, length and nature of use, compliance with exporting
laws, warranties, disclaimers, limitations of liability, and remedies, and other provisions. The
software products and documentationmay be used, disclosed, transferred, or copied only in
accordance with the terms and conditions of that software license agreement.
ANSYS, Inc. is certified to ISO9001:2008.
U.S. Government Rights
For U.S. Government users, except as specifically granted by the ANSYS, Inc. software license
agreement, the use, duplication, or disclosure by the United StatesGovernment is subject to
restrictions stated in the ANSYS, Inc. software license agreement and FAR 12.212 (for non-DOD
licenses).
Third-Party Software
This product contains the following licensed software which requires reproduction of the following
notices.
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ACIS and ACIS GeometricModeler are registered trademarks of Spatial Technology, Inc.
Copyright 1984-1989, 1994 Adobe Systems Incorporated. Copyright 1988, 1994 Digital
Equipment Corporation. Permission to use, copy, modify, distribute and sell this software and its
documentation for any purpose and without fee is hereby granted, provided that the above
copyright notices appear in all copies and that both those copyright notices and this permission
notice appear in supporting documentation, and that the names of Adobe Systems and Digital
Equipment Corporation not be used in advertising or publicity pertaining to distribution of the
software without specific, written prior permission. Adobe Systems& Digital Equipment
Corporationmake no representations about the suitability of this software for any purpose. It is
provided "as is" without express or implied warranty.
Adobe and Acrobat are registered trademarks of Adobe Systems Incorporated
ANTLR 3: Copyright (c) 2005 Terence Parr. All rights reserved. Redistribution and use in source
and binary forms, with or without modification, are permitted provided that the following conditions
aremet: (1) Redistributions of source codemust retain the above copyright notice, this list of
conditions and the following disclaimer. (2) Redistributions in binary formmust reproduce the
above copyright notice, this list of conditions and the following disclaimer in the documentation
and/or other materials provided with the distribution. (3) Neither the name of the author nor the
names of its contributorsmay be used to endorse or promote products derived from this software
without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENTOF SUBSTITUTE GOODSOR SERVICES; LOSS OFUSE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORYOF LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDINGNEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Apache commonsCLI, Apache CommonsCompress, Apache CommonsDBCP, and Apache
CommonsPool (http://commons.apache.org) - Copyright 2001-2008 The Apache Software
Foundation Licensed under the Apache License, Version 2.0 (the "License"); youmay not use this
file except in compliance with the License. Youmay obtain a copy of the License at
http://www.apache.org/licenses/LICENSE-2.0 Unless required by applicable law or agreed to in
writing, software distributed under the License is distributed on an "AS IS" BASIS,WITHOUT
WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See the License for
the specific language governing permissions and limitations under the License.
See Apache License for a complete listing of the Apache License.
Apache Formatting Objects Processor Apache License, Version 2.0
http://xmlgraphics.apache.org/fop/license.html
Apache™ FOP License
License
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All new Apache™ FOP releaseswill be licensed under the Apache™ License, version 2.0.
Releases until version 0.20.5 are released under the Apache™ License, version 1.1.
To inspect the license terms please consult the LICENSE andNOTICE files in the root directory of
the distribution. The full license text can also be accessed via the web from the Apache Licenses
page.
Apache FOP comeswith a number of libraries all of which are currently coming fromwithin the
Apache Software Foundation. These libraries are all licensed under one of the Apache License
versions. There is one exception which is "xml-apis.jar" which contains code licensed by theW3C.
Please consult the license files included with the libraries in the "lib" directory for details.
Armadillo C++ Linear Algebra Library. Copyright Conrad Sanderson.
Source code for Armadillo is available at http://arma.sourceforge.net.
BLACS http://netlib.org/scalapack/LICENSE
Copyright (c) 1992-2011 The University of Tennessee and The University of Tennessee Research
Foundation. All rights reserved.
Copyright (c) 2000-2011 The University of California Berkeley. All rights reserved.
Copyright (c) 2006-2011 The University of Colorado Denver. All rights reserved.
$COPYRIGHT$
Additional copyrightsmay follow
$HEADER$
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:
- Redistributions of source codemust retain the above copyright notice, this list of conditions and
the following disclaimer.
- Redistributions in binary formmust reproduce the above copyright notice, this list of conditions
and the following disclaimer listed
in this license in the documentation and/or other materials provided with the distribution.
- Neither the name of the copyright holders nor the names of its contributorsmay be used to
endorse or promote products derived from this software without specific prior written permission.

The copyright holders provide no reassurances that the source code provided does not infringe
any patent, copyright, or any other intellectual property rights of third parties. The copyright holders
disclaim any liability to any recipient for claims brought against recipient by any third party for
infringement of that parties intellectual property rights.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENTOF SUBSTITUTE GOODSOR SERVICES; LOSS OFUSE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORYOF LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDINGNEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE
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OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Boost C++ Libraries http://www.boost.org is licensed under the `Boost Software License
V1`http://www.boost.org/users/license.html
CATIA is a registered trademark of Dassault Systems s.a. in France and other countries.
CGAL is licensed under GNU LESSER GENERALPUBLIC LICENSE (LGPL) Version 3.0. See
GNU LESSER GENERALPUBLIC LICENSE (LGPL) for a complete listing of the GNU LESSER
GENERALPUBLIC LICENSE.
cpp (GCC): Copyright (C) 2003 Free Software Foundation, Inc.
cjpeg: Independent JPEGGroup's CJPEG, version 6b 27-Mar-1998 Copyright (C) 1998, Thomas
G. Lane
3DConnexion: Development tools and related technology provided under license from
3Dconnexion. © 1992 - 2007 3Dconnexion. All rights reserved.
THE 3DCONNEXION SDK AND ALLMATERIALS PROVIDED HEREUNDER BY
3DCONNEXION ARE PROVIDED "AS IS"WITHOUTWARRANTY OF ANY KIND.
3DCONNEXION AND ITS AFFILIATED COMPANIES MAKE NOWARRANTIES, EXPRESS
OR IMPLIED, INCLUDINGWITHOUT LIMITATION THE IMPLIEDWARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND
NONINFRINGEMENTREGARDINGTHE 3DCONNEXION SDK AND ALLMATERIALS OR
ITS USE AND OPERATION ALONEOR IN COMBINATIONWITH ANY PRODUCT. IN NO
EVENT SHALL 3DCONNEXION OR ANY OF ITS AFFILIATED COMPANIES BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY OR CONSEQUENTIAL
DAMAGES (INCLUDINGBUT NOT LIMITED TO, PROCUREMENTOF SUBSTITUTE
GOODSOR SERVICES; LOSS OFUSE, DATA OR PROFITS; OR BUSINESS
INTERRUPTION) ARISING IN ANYWAYOUTOFUSE, REPRODUCTION, MODIFICATON
AND/OR DISTRIBUTION, OR THE INABILITY TOUSE, ANY PORTION OF THE
3DCONNEXION SDK OR ITS DERIVATIVES ORMODIFICATIONS, INCLUDINGTHE
DEVELOPER FORCE FEEDBACK GAME, AND ANY OF THEMATERIALS PROVIDED
HEREUNDER BY 3DCONNEXION, HOWEVER CAUSED AND ON ANY THEORYOF
LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY OR TORT (INCLUDING
NEGLIGENCEOR OTHERWISE), EVEN IF 3DCONNEXION OR ANY OF ITS AFFILIATED
COMPANIES HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. Because
some states/jurisdictions do not allow the exclusion or limitation of consequential or incidental
damages, the above limitationmay not apply to you.
ANSYS productsmake use of the CrayMPI Library technology fromCray, Inc.
Crypto ++ Library (as a Compilation)
Compilation Copyright (c) 1995-2013 byWei Dai. All rights reserved. This copyright applies only to
this software distribution package as a compilation, and does not imply a copyright on any
particular file in the package.
All individual files in this compilation are placed in the public domain byWei Dai and other
contributors.
I would like to thank the following authors for placing their works into the public domain:
Joan Daemen - 3way.cpp
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Leonard Janke - cast.cpp, seal.cpp
Steve Reid - cast.cpp
Phil Karn - des.cpp
Andrew M. Kuchling - md2.cpp, md4.cpp
Colin Plumb - md5.cpp
SealWoods - rc6.cpp
ChrisMorgan - rijndael.cpp
Paulo Baretto - rijndael.cpp, skipjack.cpp, square.cpp
Richard DeMoliner - safer.cpp
Matthew Skala - twofish.cpp
Kevin Springle - camellia.cpp, shacal2.cpp, ttmac.cpp, whrlpool.cpp, ripemd.cpp
Ronny Van Keer - sha3.cpp
The Crypto++ Library (as a compilation) is currently licensed under the Boost Software License
1.0 (http://www.boost.org/users/license.html).
Boost Software License - Version 1.0 - August 17th, 2003
Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the
software and accompanying documentation covered by this license (the "Software") to use,
reproduce, display, distribute, execute, and transmit the Software, and to prepare derivative works
of the Software, and to permit third-parties to whom the Software is furnished to do so, all subject
to the following:
The copyright notices in the Software and this entire statement, including the above license grant,
this restriction and the following disclaimer, must be included in all copies of the Software, in whole
or in part, and all derivative works of the Software, unless such copies or derivative works are
solely in the form of machine-executable object code generated by a source language processor.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDINGBUT NOT LIMITED TOTHEWARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-
INFRINGEMENT. IN NOEVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE
DISTRIBUTINGTHE SOFTWARE BE LIABLE FOR ANY DAMAGESOR OTHER LIABILITY,
WHETHER IN CONTRACT, TORTOR OTHERWISE, ARISINGFROM, OUTOFOR IN
CONNECTIONWITH THE SOFTWAREOR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.
DocBook XSL StyleSheets http://wiki.docbook.org/DocBookLicense
Copyright
---------
Copyright (C) 1999-2007 NormanWalsh
Copyright (C) 2003 Jirka Kosek
Copyright (C) 2004-2007 Steve Ball
Copyright (C) 2005-2008 The DocBook Project
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the ``Software''), to deal in the Software without restriction,
including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do
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so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.
Except as contained in this notice, the names of individuals credited with contribution to this
software shall not be used in advertising or otherwise to promote the sale, use or other dealings in
this Software without prior written authorization from the individuals in question.
Any stylesheet derived from this Software that is publically distributed will be identified with a
different name and the version strings in any derived Software will be changed so that no possibility
of confusion between the derived package and this Software will exist.
Warranty
--------
THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDINGBUT NOT LIMITED TOTHEWARRANTIES
OFMERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NOEVENT SHALLNORMANWALSH OR ANY OTHER
CONTRIBUTOR BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,
WHETHER IN AN ACTION OFCONTRACT, TORTOR OTHERWISE, ARISING
FROM, OUTOFOR IN CONNECTIONWITH THE SOFTWAREOR THE USE OR
OTHER DEALINGS IN THE SOFTWARE.
Contacting the Author
---------------------
The DocBook XSL stylesheets aremaintained byNormanWalsh,<ndw@nwalsh.com>, and
members of the DocBook Project, <docbook-developers@sf.net>
DXF is a trademark of Autodesk, Inc
Enthought Tool Suite: http://code.enthought.com
Copyright (c) 2005-2008, Enthought, Inc.
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:
1. Redistributions of source codemust retain the above copyright notice, this list of conditions

and the following disclaimer.
2. Redistributions in binary formmust reproduce the above copyright notice, this list of

conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. Neither the name of Enthought, Inc. nor the names of its contributorsmay be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT
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LIMITED TO, PROCUREMENTOF SUBSTITUTE GOODSOR SERVICES; LOSS OFUSE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORYOF LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDINGNEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
FLEXlm and FLEXnet are trademarks of Macrovision Corporation.
Freeglut: Copyright (c) 1999-2000 PawelW. Olszta. All Rights Reserved. Permission is hereby
granted, free of charge, to any person obtaining a copy of this software and associated
documentation files (the "Software"), to deal in the Software without restriction, including without
limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies
or substantial portions of the Software.
The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDINGBUT NOT LIMITED TOTHEWARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NOEVENT SHALL PAWELW. OLSZTA BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY,WHETHER IN AN ACTION OFCONTRACT,
TORTOR OTHERWISE, ARISINGFROM, OUTOFOR IN CONNECTIONWITH THE
SOFTWAREOR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
Except as contained in this notice, the name of PawelW. Olszta shall not be used in advertising or
otherwise to promote the sale, use or other dealings in this Software without prior written
authorization fromPawelW. Olszta.
GLEW
TheOpenGL ExtensionWrangler Library
Copyright (C) 2002-2008, Milan Ikits <milan ikits[]ieee org>
Copyright (C) 2002-2008, Marcelo E. Magallon <mmagallo[]debian org>
Copyright (C) 2002, Lev Povalahev
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:
* Redistributions of source codemust retain the above copyright notice, this list of conditions and
the following disclaimer.
* Redistributions in binary formmust reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.
* The name of the author may be used to endorse or promote products derived from this software
without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,

Legal Notices 1-7
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENTOF SUBSTITUTE GOODSOR SERVICES; LOSS OFUSE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORYOF LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDINGNEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
TheGNU Standard C++ Library http://gcc.gnu.org is licensed under TheGNU General Public
License (GPL) Version 2 June 1991 Copyright © 1989, 1991 Free Software Foundation, Inc. 59
Temple Place, Suite 330, Boston, MA 02111-1307 USA
ANSYS, Inc. will provide you with a completemachine-readable copy of the source code, valid for
three years. The source code can be obtained by contacting ANSYS, Inc.
Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed. BECAUSE THE PROGRAM IS LICENSED FREE OFCHARGE,
THERE IS NOWARRANTY FOR THE PROGRAM, TOTHE EXTENT PERMITTED BY
APPLICABLE LAW. EXCEPTWHEN OTHERWISE STATED IN WRITINGTHE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS"WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. THE ENTIRE RISK AS TOTHE QUALITY AND PERFORMANCE
OF THE PROGRAM ISWITH YOU. SHOULD THE PROGR4AMPROVE DEFECTIVE, YOU
ASSUME THE COSTOF ALLNECESSARY SERVICING, REPAIR OR CORRECTION.
SeeGNU GENERALPUBLIC LICENSE (GPL) for a complete listing of the GNU GENERAL
PUBLIC LICENSE.
gzip http://www.gzip.org is licensed under TheGNU General Public License (GPL) Version 2 June
1991 Copyright © 1989, 1991 Free Software Foundation, Inc. 59 Temple Place, Suite 330,
Boston, MA 02111-1307 USA
ANSYS, Inc. will provide you with a completemachine-readable copy of the source code, valid for
three years. The source code can be obtained by contacting ANSYS, Inc. at
open.source@ansys.com.
Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed. BECAUSE THE PROGRAM IS LICENSED FREE OFCHARGE,
THERE IS NOWARRANTY FOR THE PROGRAM, TOTHE EXTENT PERMITTED BY
APPLICABLE LAW. EXCEPTWHEN OTHERWISE STATED IN WRITINGTHE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS"WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. THE ENTIRE RISK AS TOTHE QUALITY AND PERFORMANCE
OF THE PROGRAM ISWITH YOU. SHOULD THE PROGR4AMPROVE DEFECTIVE, YOU
ASSUME THE COSTOF ALLNECESSARY SERVICING, REPAIR OR CORRECTION.
SeeGNU GENERALPUBLIC LICENSE (GPL) for a complete listing of the GNU GENERAL
PUBLIC LICENSE.
ANSYS productsmake use of the IBMPlatformMPI technology (formerly namedHP-MPI) from
IBMCorporation.
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IGES is a trademark of IGES Data Analysis, Inc
IIOP.Net http://iiop-net.sourceforge.net is licensed under GNU LESSER GENERALPUBLIC
LICENSE (LGPL) Version 2.1, February 1999 Copyright © 1991, 1999, Free Software
Foundation, Inc. 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA
ANSYS, Inc. will provide you with a completemachine-readable copy of the source code, valid for
three years. The source code can be obtained by contacting ANSYS, Inc. at
open.source@ansys.com.
Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed. NOWARRANTY BECAUSE THE LIBRARY IS LICENSED FREE OF
CHARGE, THERE IS NOWARRANTY FOR THE LIBRARY, TOTHE EXTENT PERMITTED
BY APPLICABLE LAW. EXCEPTWHEN OTHERWISE STATED IN WRITINGTHE
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS"
WITHOUTWARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TOTHE QUALITY AND
PERFORMANCEOF THE LIBRARY ISWITH YOU. SHOULD THE LIBRARY PROVE
DEFECTIVE, YOU ASSUME THE COSTOF ALLNECESSARY SERVICING, REPAIR OR
CORRECTION.
SeeGNU LESSER GENERALPUBLIC LICENSE (LGPL) for a complete listing of the GNU
LESSER GENERALPUBLIC LICENSE.
PortionsCopyright © 2002-2009 Charlie Poole or Copyright © 2002-2004 JamesW. Newkirk,
Michael C. Two, Alexei A. Vorontsov or Copyright © 2000-2002 Philip A. Craig
Intel is a registered trademark of Intel Corporation
ANSYS productsmake use of the Intel (TM) MPI Library technology from Intel Corporation.
Inventor andMechanical Desktop are registered trademarks of Autodesk, Inc.
java service wrapper http://wrapper.tanukisoftware.org/doc/english/licenseServer.htmlis
licensed under Community Software License Agreement Version 1.0 Copyright © 1999,
2006 Tanuki Software, Inc.
ANSYS, Inc. will provide you with a completemachine-readable copy of the source code, valid for
three years. The source code can be obtained by contacting ANSYS, Inc. at
open.source@ansys.com.
Permission is hereby granted, free of charge, to any person obtaining a copy of the Java Service
Wrapper and associated documentation files (the "Software"), to deal in the Software without
restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute,
sub-license, and/or sell copies of the Software, and to permit persons to whom the Software is
furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDINGBUT NOT LIMITED TOTHEWARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. IN NOEVENT SHALL THE AUTHORSOR COPYRIGHT HOLDERS BE
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY,WHETHER IN AN ACTION OF
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CONTRACT, TORTOR OTHERWISE, ARISINGFROM, OUTOFOR IN CONNECTIONWITH
THE SOFTWAREOR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
See Community Software License Agreement for a complete listing of the Community Software
License Agreement.
JCalendarhttp://flib.sourceforge.net/JCalendar/doc/index.html
ANSYS, Inc. will provide you with a completemachine-readable copy of the source code, valid for
three years. The source code can be obtained by contacting ANSYS, Inc. at
open.source@ansys.com.
jdk http://java.sun.com/javase/is licensed under Sun's Binary Code License.
JGroups - Copyright (c) 2002-2010 Bela Ban/Red Hat - This library is free software; you can
redistribute it and/or modify it under the terms of the GNU Lesser General Public License as
published by the Free Software Foundation; either version 2.1 of the License, or (at your option)
any later version. This library is distributed in the hope that it will be useful, but WITHOUT ANY
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR A
PARTICULAR PURPOSE. See theGNU Lesser General Public License for more details. You
should have received a copy of the GNU Lesser General Public License along with this library; if
not, write to the Free Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-
1301 USA. See ANSYS, Inc. Contact Information for contact information.
SeeGNU LESSER GENERALPUBLIC LICENSE (LGPL) for a complete listing of the GNU
LESSER GENERALPUBLIC LICENSE.
This software is based in part on the work of the Independent JPEGGroup.
CONTAINS IBM(R) 64-bit Runtime Environment for AIX(TM), Java(TM) 2 Technology Edition,
Version 1.4Modules (c) Copyright IBMCorporation 1999, 2002 All Rights Reserved
Jython http://www.jython.org is licensed under the PYTHON SOFTWARE FOUNDATION
LICENSE VERSION 2
Copyright (c) 2007 Python Software Foundation; All Rights Reserved
See http://www.jython.org/license.html for a complete listing of the license.
LBNL double-double precision, quad-double precision and arbitrary precision (also termed
"multiprecision" or "multiple precision") software:
Copyright (c) 2003, The Regents of the University of California, through Lawrence Berkeley
National Laboratory (subject to receipt of any required approvals fromU.S. Dept. of Energy)
All rights reserved.
THE LBNL SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND
CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE
COPYRIGHTOWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING,
BUT NOT LIMITED TO, PROCUREMENTOF SUBSTITUTE GOODSOR SERVICES; LOSS
OFUSE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORYOF LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDINGNEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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libtiff
Copyright (c) 1988-1997 SamLeffler
Copyright (c) 1991-1997 SiliconGraphics, Inc.
Permission to use, copy, modify, distribute, and sell this software and its documentation for any
purpose is hereby granted without fee, provided that (i) the above copyright notices and this
permission notice appear in all copies of the software and related documentation, and (ii) the
names of Sam Leffler and SiliconGraphicsmay not be used in any advertising or publicity relating
to the software without the specific, prior written permission of Sam Leffler and SiliconGraphics.
libungif
TheGIFLIB distribution is Copyright (c) 1997 Eric S. Raymond
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction,
including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do
so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.
Mathcad is a registered trademark of Mathsoft Engineering & Education, Inc.
Mesa Library license requirements: Copyright (C) 1999-2005 Brian Paul All Rights Reserved.
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction,
including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense,
and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do
so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDINGBUT NOT LIMITED TOTHEWARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT. IN NOEVENT SHALL BRIAN PAULBE LIABLE FOR ANY CLAIM,
DAMAGES OR OTHER LIABILITY,WHETHER IN AN ACTION OFCONTRACT, TORTOR
OTHERWISE, ARISINGFROM, OUTOFOR IN CONNECTIONWITH THE SOFTWAREOR
THE USE OR OTHER DEALINGS IN THE SOFTWARE.
Mesa Component Licenses also apply. Reference http://mesa3d.sourceforge.net/.
METIS 4.0.1 Copyright 1997, Regents of the University of Minnesota. METIS waswritten by
George Karypis (karypis@cs.umn.edu)
Our policy regarding the distribution of METIS with third-party applications is as follows: Non-
commercial applicationsMETIS can be freely distributed provided that proper references are
included and the original documentation and copyright notice is included.
Commercial applicationsMETIS can be freely distributed provided that proper references are
included, the original documentation and copyright notice is included andMETIS is a relatively
small portion of the overall application. In either case, permission to distribute/includeMETIS with
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your applicationmust be obtained by sending email to metis@cs.umn.edu.
Microsoft, Windows,Windows 2000 andWindowsXP are registered trademarks of Microsoft
Corporation.
ANSYS products use theMono open-source technology to execute on non-.NET enabled
platforms. ANSYS has obtained for its customers a covenant fromMicrosoft not to sue any such
customer who usesMono to run ANSYS software on these platforms. The specific covenant can
be accessed at http://www.microsoft.com/interop/collab/ansys/customer-covenant.aspx.
MiniZip - Copyright (c) 1998-2010 - byGilles Vollant - version 1.1 64 bits fromMathias Svensson
MinpackCopyright Notice (1999) University of Chicago. All rights reserved
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:

1. Redistributions of source codemust retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary formmust reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the
following acknowledgment:
"This product includes software developed by the University of Chicago, asOperator of
Argonne National Laboratory.”
Alternately, this acknowledgment may appear in the software itself, if and wherever such
third-party acknowledgments normally appear.

4. WARRANTY DISCLAIMER. THE SOFTWARE IS SUPPLIED "AS IS"WITHOUT
WARRANTY OF ANY KIND. THE COPYRIGHT HOLDER, THE UNITED STATES, THE
UNITED STATES DEPARTMENTOF ENERGY, AND THEIR EMPLOYEES: (1)
DISCLAIMANYWARRANTIES, EXPRESS OR IMPLIED, INCLUDINGBUT NOT
LIMITED TOANY IMPLIEDWARRANTIES OFMERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, TITLE OR NON-INFRINGEMENT, (2) DONOT ASSUME
ANY LEGAL LIABILITY OR RESPONSIBILITY FOR THE ACCURACY,
COMPLETENESS, OR USEFULNESS OF THE SOFTWARE, (3) DONOTREPRESENT
THAT USE OF THE SOFTWAREWOULD NOT INFRINGE PRIVATELY OWNED
RIGHTS, (4) DONOTWARRANT THAT THE SOFTWAREWILL FUNCTION
UNINTERRUPTED, THAT IT IS ERROR-FREE OR THAT ANY ERRORSWILL BE
CORRECTED.

5. LIMITATION OF LIABILITY. IN NOEVENTWILL THE COPYRIGHT HOLDER, THE
UNITED STATES, THE UNITED STATES DEPARTMENTOF ENERGY, OR THEIR
EMPLOYEES: BE LIABLE FOR ANY INDIRECT, INCIDENTAL, CONSEQUENTIAL,
SPECIALOR PUNITIVE DAMAGESOF ANY KIND OR NATURE, INCLUDINGBUT NOT
LIMITED TOLOSS OF PROFITS OR LOSS OFDATA, FOR ANY REASON
WHATSOEVER,WHETHER SUCH LIABILITY IS ASSERTED ON THE BASIS OF
CONTRACT, TORT (INCLUDINGNEGLIGENCEOR STRICT LIABILITY), OR
OTHERWISE, EVEN IF ANY OF SAID PARTIES HAS BEENWARNED OF THE
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POSSIBILITY OF SUCH LOSS OR DAMAGES.
MiG Layout - Copyright (c) 2004, Mikael Grev, MiG InfoComAB All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:

l Redistributions of source codemust retain the above copyright notice, this list of conditions
and the following disclaimer.

l Redistributions in binary formmust reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

l Neither the name of MiG InfoComAB nor the names of its contributorsmay be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE COPYRIGHT
HOLDER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENTOF SUBSTITUTE GOODSOR SERVICES; LOSS OFUSE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORYOF LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDINGNEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Licensed by theModelica Association under theModelica License 2
Copyright © 1998-2014, Modelica Association
ThisModelica package is free software and the use is completely at your own risk; it can be
redistributed and/or modified under the terms of theModelica License 2. For license conditions
(including the disclaimer of warranty) seeModelica.UsersGuide.ModelicaLicense2 or visit
https://www.modelica.org/licenses/ModelicaLicense2.
Modelica® is a registered trademark of theModelica Association.
MPI/Pro® is a registered trademark of MPI Software Technology, Inc. Copyright © 1999-2003
MPI Software Technology, Inc.
MPICH Copyright Notice 1993 University of Chicago 1993Mississippi State University
Permission is hereby granted to use, reproduce, prepare derivative works, and to redistribute to
others. This software was authored by: Argonne National LaboratoryGroupW. Gropp: (630) 252-
4318; FAX: (708) 252-7852; email: gropp@mcs.anl.gov E. Lusk: (630) 252-7852; FAX: (708) 252-
7852; email: lusk@mcs.anl.govMathematics and Computer Science Division Argonne National
Laboratory, Argonne IL 60439Mississippi State Group N. Doss: (601) 325-2565; FAX: (601) 325-
7692; email: doss@erc.msstate.edu A. Skjellum: (601) 325-8435; FAX: (601) 325-8997; email:
tony@erc.msstate.eduMississippi State University, Computer Science Department & NSF
Engineering Research Center for Computational Field Simulation P.O. Box 6176, Mississippi
StateMS 39762
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GOVERNMENT LICENSE Portions of thismaterial resulted fromwork developed under a U.S.
Government Contract and are subject to the following license: the Government is granted for itself
and others acting on its behalf a paid-up, nonexclusive, irrevocable worldwide license in this
computer software to reproduce, prepare derivative works, and perform publicly and display
publicly.
DISCLAIMER This computer codematerial was prepared, in part, as an account of work
sponsored by an agency of the United StatesGovernment. Neither the United States, nor the
University of Chicago, nor Mississippi State University, nor any of their employees, makes any
warranty express or implied, or assumes any legal liability or responsibility for the accuracy,
completeness, or usefulness of any information, apparatus, product, or process disclosed, or
represents that its use would not infringe privately owned rights.
MPICH2Copyright Notice + 2002 University of Chicago Permission is hereby granted to use,
reproduce, prepare derivative works, and to redistribute to others. This software was authored by:
Argonne National LaboratoryGroupW. Gropp: (630) 252-4318; FAX: (630) 252-5986; e-mail:
gropp@mcs.anl.gov E. Lusk: (630) 252-7852; FAX: (630) 252-5986; e-mail: lusk@mcs.anl.gov
Mathematics and Computer Science Division Argonne National Laboratory, Argonne IL 60439
nose: http://www.wxpython.org/ is copyright Jason Pellerin 2005-2009. Licensed under the GNU
LESSER GENERALPUBLIC LICENSE (LGPL).
Numpy: http://numpy.scipy.org/
Copyright (c) 2005, NumPyDevelopers
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:
1. Redistributions of source codemust retain the above copyright notice, this list of conditions

and the following disclaimer.
2. Redistributions in binary formmust reproduce the above copyright notice, this list of

conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. Neither the name of NumPyDeveloper nor the names of its contributorsmay be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENTOF SUBSTITUTE GOODSOR SERVICES; LOSS OFUSE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORYOF LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDINGNEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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The content of this file is subject to the Open CASCADE Technology Public License Version 6.2
(the "License"). Youmay not use the content of this file except in compliance with the License.
Please obtain a copy of the License at http://www.opencascade.org and read it completely before
using this file.
The Initial Developer of the Original Code isOpen CASCADE S.A.S., with main offices at Tour
Opus 12, 77, Esplanade duGeneral de Gaulle, 92914, Paris, La Defense Cedex, France. The
Original Code is copyright (c) Open CASCADE S.A.S., 2001. All rights reserved.
Please see the License for the specific terms and conditions governing rights and limitations under
the License".
Copyright (c) 1998-2008 TheOpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:
1. Redistributions of source codemust retain the above copyright notice, this list of conditions

and the following disclaimer.
2. Redistributions in binary formmust reproduce the above copyright notice, this list of

conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. All advertisingmaterialsmentioning features or use of this softwaremust display the
following acknowledgment: "This product includes software developed by theOpenSSL
Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or
promote products derived from this software without prior written permission. For written
permission, please contact openssl-core@openssl.org.

5. Products derived from this softwaremay not be called "OpenSSL" nor may "OpenSSL"
appear in their nameswithout prior written permission of the OpenSSL Project.

6. Redistributions of any formwhatsoever must retain the following acknowledgment: "This
product includes software developed by theOpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)"

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY
EXPRESSED OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE OpenSSL PROJECTOR ITS
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENTOF SUBSTITUTE GOODSOR SERVICES; LOSS OFUSE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
================================================================
This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by TimHudson (tjh@cryptsoft.com).
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Original SSLeay License
-----------------------
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The
implementation waswritten so as to conformwith Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are
aheared to. The following conditions apply to all code found in this distribution, be it the RC4, RSA,
lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this
distribution is covered by the same copyright terms except that the holder is TimHudson
(tjh@cryptsoft.com).
Copyright remains Eric Young's, and as such anyCopyright notices in the code are not to be
removed. If this package is used in a product, Eric Young should be given attribution as the author
of the parts of the library used. This can be in the form of a textual message at program startup or in
documentation (online or textual) provided with the package.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:
1. Redistributions of source codemust retain the copyright notice, this list of conditions and the

following disclaimer.
2. Redistributions in binary formmust reproduce the above copyright notice, this list of

conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. All advertisingmaterialsmentioning features or use of this softwaremust display the
following acknowledgement: "This product includes cryptographic software written by Eric
Young (eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the
library being used are not cryptographic related :-).

4. If you include anyWindows specific code (or a derivative thereof) from the apps directory
(application code) youmust include an acknowledgement: "This product includes software
written by TimHudson (tjh@cryptsoft.com)"

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR
IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES
OFMERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE
DISCLAIMED. IN NOEVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR
ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENTOF SUBSTITUTE
GOODSOR SERVICES; LOSS OFUSE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORYOF LIABILITY,WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDINGNEGLIGENCEOR
OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
The licence and distribution terms for any publically available version or derivative of this code
cannot be changed. i.e. this code cannot simply be copied and put under another distribution
licence [including theGNU Public Licence.]
libpng version 1.0.8 - July 24, 2000
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Copyright (c) 1998-2000Glenn Randers-Pehrson
Copyright (c) 1996, 1997 AndreasDilger
Copyright (c) 1995, 1996GuyEric Schalnat, Group 42, Inc.
Pro/ENGINEER is a registered trademark of Parametric TechnologyCorporation.
http://pygments.org/
Copyright (c) 2006-2009 by the respective authors (see AUTHORS file).
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:
* Redistributions of source codemust retain the above copyright notice, this list of conditions and
the following disclaimer.
* Redistributions in binary formmust reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENTOF SUBSTITUTE GOODSOR SERVICES; LOSS OFUSE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORYOF LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDINGNEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Python is owned by the Python Software Foundation, Copyright (c) 2001, 2002, 2003, 2004, 2005,
2006, 2007, 2008, 2009 Python Software Foundation; All Rights Reserved
License Agreement: PYTHON SOFTWARE FOUNDATION LICENSE VERSION 2
1. This LICENSE AGREEMENT is between the Python Software Foundation ("PSF"), and the

Individual or Organization ("Licensee") accessing and otherwise using this software
("Python") in source or binary form and its associated documentation.

2. Subject to the terms and conditions of this License Agreement, PSF hereby grants Licensee
a nonexclusive, royalty-free, world-wide license to reproduce, analyze, test, perform and/or
display publicly, prepare derivative works, distribute, and otherwise use Python alone or in
any derivative version, provided, however, that PSF's License Agreement and PSF's notice
of copyright, i.e., "Copyright (c) 2001, 2002, 2003, 2004, 2005, 2006, 2007, 2008, 2009
Python Software Foundation; All Rights Reserved" are retained in Python alone or in any
derivative version prepared by Licensee.

3. In the event Licensee prepares a derivative work that is based on or incorporates Python or
any part thereof, and wants tomake the derivative work available to others as provided
herein, then Licensee hereby agrees to include in any such work a brief summary of the
changesmade to Python.
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4. PSF ismaking Python available to Licensee on an "AS IS" basis. PSFMAKES NO
REPRESENTATIONS ORWARRANTIES, EXPRESS OR IMPLIED. BYWAYOF
EXAMPLE, BUT NOT LIMITATION, PSFMAKES NOAND DISCLAIMS ANY
REPRESENTATION ORWARRANTY OFMERCHANTABILITY OR FITNESS FOR ANY
PARTICULAR PURPOSE OR THAT THE USE OF PYTHONWILL NOT INFRINGE ANY
THIRD PARTY RIGHTS.

5. PSF SHALLNOT BE LIABLE TOLICENSEE OR ANY OTHER USERS OF PYTHON
FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIALDAMAGESOR LOSS AS A
RESULTOFMODIFYING, DISTRIBUTING, OR OTHERWISE USINGPYTHON, OR
ANY DERIVATIVE THEREOF, EVEN IF ADVISED OF THE POSSIBILITY THEREOF.

6. This License Agreement will automatically terminate upon amaterial breach of its terms and
conditions.

7. Nothing in this License Agreement shall be deemed to create any relationship of agency,
partnership, or joint venture between PSF and Licensee. This License Agreement does not
grant permission to use PSF trademarks or trade name in a trademark sense to endorse or
promote products or services of Licensee, or any third party.

8. By copying, installing or otherwise using Python, Licensee agrees to be bound by the terms
and conditions of this License Agreement.

This software uses theQt library, amultiplatformC++ GUI toolkit from Trolltech. See
http://www.trolltechcom/qt/ for more information.
ScaLAPACK http://netlib.org/scalapack/LICENSE
Copyright (c) 1992-2011 The University of Tennessee and The University of Tennessee Research
Foundation. All rights reserved.
Copyright (c) 2000-2011 The University of California Berkeley. All rights reserved.
Copyright (c) 2006-2011 The University of Colorado Denver. All rights reserved.
$COPYRIGHT$
Additional copyrightsmay follow
$HEADER$
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:
- Redistributions of source codemust retain the above copyright notice, this list of conditions and
the following disclaimer.
- Redistributions in binary formmust reproduce the above copyright notice, this list of conditions
and the following disclaimer listed in this license in the documentation and/or other materials
provided with the distribution.
- Neither the name of the copyright holders nor the names of its contributorsmay be used to
endorse or promote products derived from this software without specific prior written permission.
The copyright holders provide no reassurances that the source code provided does not infringe
any patent, copyright, or any other intellectual property rights of third parties. The copyright holders
disclaim any liability to any recipient for claims brought against recipient by any third party for
infringement of that parties intellectual property rights.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
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"AS IS" AND ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR
A PARTICULAR PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENTOF SUBSTITUTE GOODSOR SERVICES; LOSS OFUSE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORYOF LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDINGNEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Secure Hash Algorithm (SHA) Copyright © 2000-2001, Aaron D. Gifford All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:

1. Redistributions of source codemust retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary formmust reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

3. Neither the name of the copyright holder nor the names of contributorsmay be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTOR(S) ``AS IS'' AND
ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE AUTHOR OR CONTRIBUTOR(S)
BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENTOF
SUBSTITUTE GOODSOR SERVICES; LOSS OFUSE, DATA, OR PROFITS; OR BUSINESS
INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORYOF LIABILITY,WHETHER
IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDINGNEGLIGENCEOR
OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Sentinel is a registered trademark of Rainbow Technologies Inc.
SentinelSuperPro(TM) is a trademark of Rainbow Technologies, Inc
SolidWorks is a registered trademark of SolidWorksCorporation.
SUNDIALS
Copyright © 2002, The Regents of the University of California.
Produced at the Lawrence Livermore National Laboratory.
All rights reserved.
This file is part of SUNDIALS.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:
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1. Redistributions of source codemust retain the above copyright notice, this list of conditions
and the disclaimer below.

2. Redistributions in binary formmust reproduce the above copyright notice, this list of
conditions and the disclaimer (as noted below) in the documentation and/or other materials
provided with the distribution.

3. Neither the name of the UC/LLNL nor the names of its contributorsmay be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE REGENTS OF THE
UNIVERSITY OF CALIFORNIA, THE U.S. DEPARTMENTOF ENERGYOR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENTOF SUBSTITUTE GOODSOR SERVICES; LOSS OFUSE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Additional BSD Notice
1. This notice is required to be provided under our contract with the U.S. Department of Energy

(DOE). This work was produced at the University of California, Lawrence Livermore National
Laboratory under Contract No.W-7405-ENG-48 with the DOE.

2. Neither the United StatesGovernment nor the University of California nor any of their
employees, makes anywarranty, express or implied, or assumes any liability or responsibility
for the accuracy, completeness, or usefulness of any information, apparatus, product, or
process disclosed, or represents that its use would not infringe privately-owned rights.

3. Also, reference herein to any specific commercial products, process, or services by trade
name, trademark, manufacturer or otherwise does not necessarily constitute or imply its
endorsement, recommendation, or favoring by the United StatesGovernment or the
University of California. The views and opinions of authors expressed herein do not
necessarily state or reflect those of the United StatesGovernment or the University of
California, and shall not be used for advertising or product endorsement purposes.

GNU Tar http://www.gnu.org/software/tar is licensed under TheGNU General Public License
(GPL) Version 3, 29 June 2007 Copyright © 2007 Free Software Foundation, Inc. http://fsf.org/
ANSYS, Inc. will provide you with a completemachine-readable copy of the source code, valid for
three years. The source code can be obtained by contacting ANSYS, Inc.
Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed. BECAUSE THE PROGRAM IS LICENSED FREE OFCHARGE,
THERE IS NOWARRANTY FOR THE PROGRAM, TOTHE EXTENT PERMITTED BY
APPLICABLE LAW. EXCEPTWHEN OTHERWISE STATED IN WRITINGTHE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS"WITHOUT
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WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. THE ENTIRE RISK AS TOTHE QUALITY AND PERFORMANCE
OF THE PROGRAM ISWITH YOU. SHOULD THE PROGR4AMPROVE DEFECTIVE, YOU
ASSUME THE COSTOF ALLNECESSARY SERVICING, REPAIR OR CORRECTION.
SeeGNU GENERALPUBLIC LICENSE (GPL) for a complete listing of the GNU GENERAL
PUBLIC LICENSE.
TIFF: Copyright (c) 1988-1997 SamLeffler, Copyright (c) 1991-1997 SiliconGraphics, Inc. -
Permission to use, copy, modify, distribute, and sell this software and its documentation for any
purpose is hereby granted without fee, provided that (i) the above copyright notices and this
permission notice appear in all copies of the software and related documentation, and (ii) the
names of Sam Leffler and SiliconGraphicsmay not be used in any advertising or publicity relating
to the software without the specific, prior written permission of Sam Leffler and SiliconGraphics.
TIFF: pnmtotiff.c - converts a portable anymap to a Tagged Image File Derived by Jef Poskanzer
from ras2tif.c, which is: Copyright (c) 1990 by SunMicrosystems, Inc. Author: Patrick J. Naughton,
naughton@wind.sun.comPermission to use, copy, modify, and distribute this software and its
documentation for any purpose and without fee is hereby granted, provided that the above
copyright notice appear in all copies and that both that copyright notice and this permission notice
appear in supporting documentation.
The Visualization ToolKit (VTK): http://www.vtk.org
VTK is an open-source toolkit licensed under the `BSD license`
http://opensource.org/licenses/bsd-license.php.
Copyright (c) 1993-2008 KenMartin, Will Schroeder, Bill Lorensen
All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:
* Redistributions of source codemust retain the above copyright notice, this list of conditions and
the following disclaimer.
* Redistributions in binary formmust reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.
* Neither the name of KenMartin, Will Schroeder, or Bill Lorensen nor the names of its contributors
may be used to endorse or promote products derived from this software without specific prior
written permission.
THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE COPYRIGHT
OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENTOF SUBSTITUTE GOODSOR SERVICES; LOSS OFUSE,
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
THEORYOF LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
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(INCLUDINGNEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Visual MainWin® Copyright 2002Mainsoft Corporation. All rights reserved. Mainsoft, Mainwin, the
software porting company, e-porting, the e-porting company, and Visual MainWin are trademarks
or registered trademarks of Mainsoft Corporation in the United States and/or foreign countries.
whirlgif - Copyright (c) 1997, 1998, 1999 byHansDinsen-Hansen Copyright (c) 1995, 1996 by
Kevin Kadow Copyright (c) 1990, 1991, 1992 byMark Podlipec. All rights reserved. This software
may be freely copied, modified and redistributed without fee provided that this copyright notice is
preserved intact on all copies andmodified copies. There is no warranty or other guarantee of
fitness of this software. It is provided solely "as is". The author(s) disclaim(s) all responsibility and
liability with respect to this software's usage or its effect upon hardware or computer systems.
wxPytjon: http://www.wxpython.org/ for the Grapical User Interface is licensed under the
`wxWindows Licence` http://wxwidgets.org/newlicen.htm.
XML.c - implementation file for basic XML parser written in ANSI C++ for portability. It works by
using recursion and a node tree for breaking down the elements of an XML document.@version
V2.25@author Frank Vanden Berghen
BSD license: Copyright (c) 2002, Frank Vanden Berghen All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet: * Redistributions of source codemust retain the
above copyright notice, this list of conditions and the following disclaimer. * Redistributions in
binary formmust reproduce the above copyright notice, this list of conditions and the following
disclaimer in the documentation and/or other materials provided with the distribution. * Neither the
name of the Frank Vanden Berghen nor the names of its contributorsmay be used to endorse or
promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS "AS IS" AND
ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE REGENTS AND
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENTOF SUBSTITUTE GOODSOR SERVICES; LOSS OFUSE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY
OF LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
#ZipLib: Copyright (C) 2001Mike Krueger Copyright (C) 2004 John Reilly
Zlib Copyright (C) 1995-2013 Jean-loupGailly andMark Adler

l ajax4jsfhttp://labs.jboss.com/jbossajax4jsf/
l bshhttp://www.beanshell.org/
l cismethttps://github.com/cismet/cismet-gui-commons
l infinispanhttp://www.jboss.org/infinispan
l itexthttp://itextpdf.com
l jbosshttp://www.jboss.com/
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l JCommonhttp://www.jfree.org/jcommon/
l jexcelapihttp://jexcelapi.sourceforge.net/
l jgroupshttp://www.jgroups.org
l jfreecharthttp://www.jfree.org/jfreechart/
l jgraphhttp://www.jgraph.com/
l LOGBackhttp://logback.qos.ch/
l Mono runtimehttp://www.mono-project.com/
l pthreads-win32http://sourceware.org/pthreads-win32
l richfaceshttp://www.jboss.org/richfaces
l 7-Ziphttp://www.7-zip.org/

are licensed under GNU LESSER GENERAL PUBLIC LICENSE (LGPL) Version 2.1,
February 1999 Copyright © 1991, 1999, Free Software Foundation, Inc. 51 Franklin Street, Fifth
Floor, Boston, MA 02110-1301 USA
ANSYS, Inc. will provide you with a completemachine-readable copy of the source code, valid for
three years. The source code can be obtained by contacting ANSYS, Inc. at
open.source@ansys.com.
Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed. NOWARRANTY BECAUSE THE LIBRARY IS LICENSED FREE OF
CHARGE, THERE IS NOWARRANTY FOR THE LIBRARY, TOTHE EXTENT PERMITTED
BY APPLICABLE LAW. EXCEPTWHEN OTHERWISE STATED IN WRITINGTHE
COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS"
WITHOUTWARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TOTHE QUALITY AND
PERFORMANCEOF THE LIBRARY ISWITH YOU. SHOULD THE LIBRARY PROVE
DEFECTIVE, YOU ASSUME THE COSTOF ALLNECESSARY SERVICING, REPAIR OR
CORRECTION.
SeeGNU LESSER GENERALPUBLIC LICENSE (LGPL) for a complete listing of the GNU
LESSER GENERALPUBLIC LICENSE.

l anthttp://ant.apache.org/
l axis http://ws.apache.org/axis/
l boilerpipe http://code.google.com/p/boilerpipe
l derbyhttp://db.apache.org/derby/
l Geronimo 1.0.1 staxhttps://svn.apache.org/repos/asf/geronimo/specs/tags/geronimo-stax-
api_1.0_spec-1.0.1/

l jakarta commonshttp://jakarta.apache.org/commons/
(beanutils, codec, collections, compress, dbcp, net, pool, digester, discovery, el, fileupload, io,
httpclient, lang, validator, logging, net, cli)

l jackrabbit, jcr http://jackrabbit.apache.org/
l jakarta-orohttp://jakarta.apache.org/oro/
l jakarta jstlhttp://jakarta.apache.org/taglibs/index.html
l jdomhttp://www.jdom.org/index.html
l log4jhttp://logging.apache.org/log4j/
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l lucenehttp://lucene.apache.org/java/docs/
l Metadata extractor http://www.drewnoakes.com/drewnoakes.com/code/exif/
l myfaceshttp://www.myfaces.org/
l nekohtmlhttp://sourceforge.net/projects/nekohtml
l PDFBoxhttp://www.pdfbox.org/
l poihttp://jakarta.apache.org/poi/
l Riverhttp://river.apache.org/
l Romehttp://java.net/projects/rome/
l TagSoup http://home.ccil.org/~cowan/XML/tagsoup/
l Tika http://tika.apache.org/
l tomcat http://tomcat.apache.org/index.html
l xerceshttp://xerces.apache.org/
l XMLBeanshttp://xmlbeans.apache.org/index.html
l xmlrpc http://ws.apache.org/xmlrpc/index.html

are licensed under the Apache License, Version 2.0 (the “License”); youmay not use this file
except in compliance with the License.
Apache License
Version 2.0, January 2004
http://www.apache.org/licenses/
See Apache License for a complete listing of the Apache License.

l dom4jhttp://sourceforge.net/projects/dom4j
is licensed under BSD LicenseCopyright © 2002-2007, www.pdfbox.org All rights reserved.
Youmay obtain a copy of the License at: http://www.pdfbox.org/license.html#License.
Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions aremet:

l Redistributions of source codemust retain the above copyright notice, this list of conditions
and the following disclaimer.

l Redistributions in binary formmust reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

l Neither the name of pdfbox; nor the names of its contributorsmay be used to endorse or
promote products derived from this software without specific prior written permission. THIS
SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
"AS IS" AND ANY EXPRESS OR IMPLIEDWARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NOEVENT SHALL THE
REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENTOF SUBSTITUTE GOODSOR
SERVICES; LOSS OFUSE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORYOF LIABILITY,WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDINGNEGLIGENCEOR
OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OF THIS SOFTWARE, EVEN
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IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
l graphvizhttp://www.graphviz.org/
l wsdl4jhttp://wsdl4j.sourceforge.net/

are licensed under Common Public License Version 1.0 (CPL)
ANSYS, Inc. will provide you with a completemachine-readable copy of the source code, valid for
three years. The source code can be obtained by contacting ANSYS, Inc. at
open.source@ansys.com.
THE ACCOMPANYINGPROGRAM IS PROVIDED UNDER THE TERMSOF THIS COMMON
PUBLIC LICENSE ("AGREEMENT"). ANY USE, REPRODUCTION OR DISTRIBUTION OF
THE PROGRAMCONSTITUTES RECIPIENT'S ACCEPTANCEOF THIS AGREEMENT.
See Common Public License Version 1.0 (CPL) for a complete listing of the Common Public
License Version 1.0 (CPL).

1. ANSYS, Inc. Contact Information
ANSYS, Inc.
Southpointe
2600 ANSYS Drive
Canonsburg, PA 15317
ansysinfo@ansys.com
http://www.ansys.com
(T) 724-746-3304
(F) 724-514-9494
Contact ANSYS, Inc. at open.source@ansys.com for Open source code.

2. ANSYS Trademarks List
l Ansoft™
l Ansoft Designer®
l Ansoft Links™
l ANSYS®
l ANSYS® AI*Environment™
l ANSYS® Airpak®
l ANSYS® Asas™
l ANSYS® Aqwa™
l ANSYS® Autodyn®
l ANSYS® AutoReaGas™
l ANSYS® BladeModeler™
l ANSYS® CFX®
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l ANSYS® DesignModeler™
l ANSYS® DesignSpace®
l ANSYS® DesignXplorer™
l ANSYS® DesignXplorerVT™
l ANSYS® EKM™
l ANSYS® Engineering KnowledgeManager™
l ANSYS® Emag™
l ANSYS® Fatigue™
l ANSYS® FIDAP™
l ANSYS® Flotran®
l ANSYS® Fluent®
l ANSYS® Iceboard®
l ANSYS® ICEMCFD™
l ANSYS® Icechip®
l ANSYS® Icemax®
l ANSYS® Icepro™
l ANSYS® Icepak®
l ANSYS® Icewave™
l ANSYS® LS-DYNA®
l Maxwell®
l ANSYS®Mechanical™
l ANSYS®MeshMorpher™
l ANSYS®Multiphysics™
l ANSYS® ParaMesh™
l ANSYS® Polyflow®
l ANSYS® Professional™
l Simplorer®
l Solver on Demand®
l ANSYS® Structural™
l ANSYS® TGrid™
l ANSYS® TurboGrid™
l ANSYS®Workbench™
l ANSYS® Vista™
l ANSYS® VT Accelerator™
l CADOE™
l CoolSim™
l Enductive Solutions™
l ePhysics®
l Full-Wave SPICE™
l FloWizard®
l FLUENT/FLOWLAB®
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l GAMBIT®
l G/Turbo®
l HFSS™
l Mixsim®
l Nexxim®
l Optimetrics™
l Parlcs®
l PExprt™
l Q3D Extractor™
l QuickEye™
l RMxprt™
l Serende®
l Slwave™
l Simulation Driven™
l Simulation Driven Product Development™
l Super-Compact®
l VerifEye™
l TPA™

3. GNU LESSER GENERAL PUBLIC LICENSE (LGPL)
Included herewith:
Version 3
Version 2.1
VERSION 3
GNU LESSER GENERALPUBLIC LICENSE
Version 3, 29 June 2007
Copyright © 2007 Free Software Foundation, Inc. <http://fsf.org/>
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing
it is not allowed.
This version of the GNU Lesser General Public License incorporates the terms and conditions of
version 3 of the GNU General Public License, supplemented by the additional permissions listed
below.

0. Additional Definitions.
As used herein, “this License” refers to version 3 of the GNU Lesser General Public License, and the
“GNU GPL” refers to version 3 of the GNU General Public License.
“The Library” refers to a covered work governed by this License, other than an Application or a
CombinedWork as defined below.
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An “Application” is anywork that makes use of an interface provided by the Library, but which is not
otherwise based on the Library. Defining a subclass of a class defined by the Library is deemed a
mode of using an interface provided by the Library.
A “CombinedWork” is a work produced by combining or linking an Application with the Library. The
particular version of the Library with which the CombinedWorkwasmade is also called the “Linked
Version”.
The “Minimal Corresponding Source” for a CombinedWorkmeans the Corresponding Source for
the CombinedWork, excluding any source code for portions of the CombinedWork that, considered
in isolation, are based on the Application, and not on the Linked Version.
The “Corresponding Application Code” for a CombinedWorkmeans the object code and/or source
code for the Application, including any data and utility programs needed for reproducing the
CombinedWork from the Application, but excluding the System Libraries of the CombinedWork.

1. Exception to Section 3 of the GNU GPL.
Youmay convey a covered work under sections 3 and 4 of this License without being bound by
section 3 of the GNU GPL.

2. Conveying Modified Versions.
If youmodify a copy of the Library, and, in your modifications, a facility refers to a function or data to
be supplied by an Application that uses the facility (other than as an argument passed when the
facility is invoked), then youmay convey a copy of themodified version:

l a) under this License, provided that youmake a good faith effort to ensure that, in the event
an Application does not supply the function or data, the facility still operates, and performs
whatever part of its purpose remainsmeaningful, or

l b) under the GNU GPL, with none of the additional permissions of this License applicable to
that copy.

3. Object Code Incorporating Material from Library Header Files.
The object code form of an Applicationmay incorporatematerial from a header file that is part of the
Library. Youmay convey such object code under terms of your choice, provided that, if the
incorporatedmaterial is not limited to numerical parameters, data structure layouts and accessors,
or small macros, inline functions and templates (ten or fewer lines in length), you do both of the
following:

l a) Give prominent notice with each copy of the object code that the Library is used in it and
that the Library and its use are covered by this License.

l b) Accompany the object code with a copy of the GNU GPL and this license document.
4. Combined Works.

Youmay convey a CombinedWork under terms of your choice that, taken together, effectively do
not restrict modification of the portions of the Library contained in the CombinedWork and reverse
engineering for debugging suchmodifications, if you also do each of the following:

l a) Give prominent notice with each copy of the CombinedWork that the Library is used in it
and that the Library and its use are covered by this License.

l b) Accompany the CombinedWorkwith a copy of the GNU GPL and this license document.
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l c) For a CombinedWork that displays copyright notices during execution, include the
copyright notice for the Library among these notices, as well as a reference directing the
user to the copies of the GNU GPL and this license document.

l d) Do one of the following:
l 0) Convey theMinimal Corresponding Source under the terms of this License,
and the Corresponding Application Code in a form suitable for, and under terms
that permit, the user to recombine or relink the Application with amodified
version of the Linked Version to produce amodified CombinedWork, in the
manner specified by section 6 of the GNU GPL for conveying Corresponding
Source.

l 1) Use a suitable shared librarymechanism for linking with the Library. A
suitablemechanism is one that (a) uses at run time a copy of the Library already
present on the user's computer system, and (b) will operate properly with a
modified version of the Library that is interface-compatible with the Linked
Version.

l e) Provide Installation Information, but only if you would otherwise be required to provide
such information under section 6 of the GNU GPL, and only to the extent that such
information is necessary to install and execute amodified version of the CombinedWork
produced by recombining or relinking the Application with amodified version of the Linked
Version. (If you use option 4d0, the Installation Informationmust accompany theMinimal
Corresponding Source and Corresponding Application Code. If you use option 4d1, you
must provide the Installation Information in themanner specified by section 6 of the GNU
GPL for conveying Corresponding Source.)

5. Combined Libraries.
Youmay place library facilities that are a work based on the Library side by side in a single library
together with other library facilities that are not Applications and are not covered by this License, and
convey such a combined library under terms of your choice, if you do both of the following:

l a) Accompany the combined library with a copy of the samework based on the Library,
uncombined with any other library facilities, conveyed under the terms of this License.

l b) Give prominent notice with the combined library that part of it is a work based on the
Library, and explaining where to find the accompanying uncombined form of the same
work.

6. Revised Versions of the GNU Lesser General Public License.
The Free Software Foundationmay publish revised and/or new versions of the GNU Lesser General
Public License from time to time. Such new versionswill be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Library as you received it specifies that a
certain numbered version of the GNU Lesser General Public License “or any later version” applies to
it, you have the option of following the terms and conditions either of that published version or of any
later version published by the Free Software Foundation. If the Library as you received it does not
specify a version number of the GNU Lesser General Public License, youmay choose any version of
the GNU Lesser General Public License ever published by the Free Software Foundation.
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If the Library as you received it specifies that a proxy can decide whether future versions of the GNU
Lesser General Public License shall apply, that proxy's public statement of acceptance of any
version is permanent authorization for you to choose that version for the Library.
VERSION 2.1
GNU LESSER GENERALPUBLIC LICENSE (LGPL) Version 2.1, February 1999 Copyright ©
1991, 1999, Free Software Foundation, Inc. 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301
USA
ANSYS, Inc. will provide you with a completemachine-readable copy of the source code, valid for
three years. The source code can be obtained by contacting ANSYS, Inc. at
open.source@ansys.com.
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing
it is not allowed. NOWARRANTY BECAUSE THE LIBRARY IS LICENSED FREE OFCHARGE,
THERE IS NOWARRANTY FOR THE LIBRARY, TOTHE EXTENT PERMITTED BY
APPLICABLE LAW. EXCEPTWHEN OTHERWISE STATED IN WRITINGTHE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE LIBRARY "AS IS"WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. THE ENTIRE RISK AS TOTHE QUALITY AND PERFORMANCE
OF THE LIBRARY ISWITH YOU. SHOULD THE LIBRARY PROVE DEFECTIVE, YOU
ASSUME THE COSTOF ALLNECESSARY SERVICING, REPAIR OR CORRECTION.
GNU LESSER GENERAL PUBLIC LICENSE
Version 2.1
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing
it is not allowed.
Preamble
The licenses for most software are designed to take away your freedom to share and change it. By
contrast, the GNU General Public Licenses are intended to guarantee your freedom to share and
change free software--to make sure the software is free for all its users.
This license, the Lesser General Public License, applies to some specially designated software
packages--typically libraries--of the Free Software Foundation and other authors who decide to use
it. You can use it too, but we suggest you first think carefully about whether this license or the
ordinaryGeneral Public License is the better strategy to use in any particular case, based on the
explanations below.
Whenwe speak of free software, we are referring to freedom of use, not price. Our General Public
Licenses are designed tomake sure that you have the freedom to distribute copies of free software
(and charge for this service if you wish); that you receive source code or can get it if you want it; that
you can change the software and use pieces of it in new free programs; and that you are informed
that you can do these things.
To protect your rights, we need tomake restrictions that forbid distributors to deny you these rights or
to ask you to surrender these rights. These restrictions translate to certain responsibilities for you if
you distribute copies of the library or if youmodify it.
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For example, if you distribute copies of the library, whether gratis or for a fee, youmust give the
recipients all the rights that we gave you. Youmust make sure that they, too, receive or can get the
source code. If you link other code with the library, youmust provide complete object files to the
recipients, so that they can relink themwith the library after making changes to the library and
recompiling it. And youmust show them these terms so they know their rights.
We protect your rights with a two-stepmethod: (1) we copyright the library, and (2) we offer you this
license, which gives you legal permission to copy, distribute and/or modify the library.
To protect each distributor, we want to make it very clear that there is no warranty for the free library.
Also, if the library ismodified by someone else and passed on, the recipients should know that what
they have is not the original version, so that the original author's reputation will not be affected by
problems that might be introduced by others.
Finally, software patents pose a constant threat to the existence of any free program.Wewish to
make sure that a company cannot effectively restrict the users of a free program by obtaining a
restrictive license from a patent holder. Therefore, we insist that any patent license obtained for a
version of the librarymust be consistent with the full freedom of use specified in this license.
Most GNU software, including some libraries, is covered by the ordinaryGNU General Public
License. This license, the GNU Lesser General Public License, applies to certain designated
libraries, and is quite different from the ordinaryGeneral Public License.We use this license for
certain libraries in order to permit linking those libraries into non-free programs.
When a program is linked with a library, whether statically or using a shared library, the combination
of the two is legally speaking a combined work, a derivative of the original library. The ordinary
General Public License therefore permits such linking only if the entire combination fits its criteria of
freedom. The Lesser General Public License permitsmore lax criteria for linking other code with the
library.
We call this license the "Lesser" General Public License because it does Less to protect the user's
freedom than the ordinaryGeneral Public License. It also provides other free software developers
Less of an advantage over competing non-free programs. These disadvantages are the reason we
use the ordinaryGeneral Public License for many libraries. However, the Lesser license provides
advantages in certain special circumstances.
For example, on rare occasions, theremay be a special need to encourage the widest possible use
of a certain library, so that it becomes a de-facto standard. To achieve this, non-free programsmust
be allowed to use the library. A more frequent case is that a free library does the same job aswidely
used non-free libraries. In this case, there is little to gain by limiting the free library to free software
only, so we use the Lesser General Public License.
In other cases, permission to use a particular library in non-free programs enables a greater number
of people to use a large body of free software. For example, permission to use theGNU C Library in
non-free programs enablesmanymore people to use the whole GNU operating system, aswell as
its variant, the GNU/Linux operating system.
Although the Lesser General Public License is Less protective of the users' freedom, it does ensure
that the user of a program that is linked with the Library has the freedom and the wherewithal to run
that program using amodified version of the Library.
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The precise terms and conditions for copying, distribution andmodification follow. Pay close
attention to the difference between a "work based on the library" and a "work that uses the library".
The former contains code derived from the library, whereas the latter must be combined with the
library in order to run.
GNU LESSER GENERALPUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION
0. This License Agreement applies to any software library or other programwhich contains a notice
placed by the copyright holder or other authorized party saying it may be distributed under the terms
of this Lesser General Public License (also called "this License"). Each licensee is addressed as
"you".
A "library" means a collection of software functions and/or data prepared so as to be conveniently
linked with application programs (which use some of those functions and data) to form executables.
The "Library", below, refers to any such software library or work which has been distributed under
these terms. A "work based on the Library" means either the Library or any derivative work under
copyright law: that is to say, a work containing the Library or a portion of it, either verbatim or with
modifications and/or translated straightforwardly into another language. (Hereinafter, translation is
included without limitation in the term "modification".)
"Source code" for a workmeans the preferred form of the work for makingmodifications to it. For a
library, complete source codemeans all the source code for all modules it contains, plus any
associated interface definition files, plus the scripts used to control compilation and installation of the
library.
Activities other than copying, distribution andmodification are not covered by this License; they are
outside its scope. The act of running a program using the Library is not restricted, and output from
such a program is covered only if its contents constitute a work based on the Library (independent of
the use of the Library in a tool for writing it). Whether that is true depends on what the Library does
and what the program that uses the Library does.
1. Youmay copy and distribute verbatim copies of the Library's complete source code as you receive
it, in anymedium, provided that you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this
License and to the absence of anywarranty; and distribute a copy of this License along with the
Library.
Youmay charge a fee for the physical act of transferring a copy, and youmay at your option offer
warranty protection in exchange for a fee.
2. Youmaymodify your copy or copies of the Library or any portion of it, thus forming a work based
on the Library, and copy and distribute suchmodifications or work under the terms of Section 1
above, provided that you alsomeet all of these conditions:
a) Themodified workmust itself be a software library.
b) Youmust cause the filesmodified to carry prominent notices stating that you changed the files and
the date of any change.
c) Youmust cause the whole of the work to be licensed at no charge to all third parties under the
terms of this License.
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d) If a facility in themodified Library refers to a function or a table of data to be supplied by an
application program that uses the facility, other than as an argument passed when the facility is
invoked, then youmust make a good faith effort to ensure that, in the event an application does not
supply such function or table, the facility still operates, and performswhatever part of its purpose
remainsmeaningful.
(For example, a function in a library to compute square roots has a purpose that is entirely well-
defined independent of the application. Therefore, Subsection 2d requires that any application-
supplied function or table used by this functionmust be optional: if the application does not supply it,
the square root functionmust still compute square roots.)
These requirements apply to themodified work as a whole. If identifiable sections of that work are
not derived from the Library, and can be reasonably considered independent and separate works in
themselves, then this License, and its terms, do not apply to those sectionswhen you distribute them
as separate works. But when you distribute the same sections as part of a whole which is a work
based on the Library, the distribution of the wholemust be on the terms of this License, whose
permissions for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by
you; rather, the intent is to exercise the right to control the distribution of derivative or collective works
based on the Library.
In addition, mere aggregation of another work not based on the Library with the Library (or with a
work based on the Library) on a volume of a storage or distributionmedium does not bring the other
work under the scope of this License.
3. Youmay opt to apply the terms of the ordinaryGNU General Public License instead of this
License to a given copy of the Library. To do this, youmust alter all the notices that refer to this
License, so that they refer to the ordinaryGNU General Public License, version 2, instead of to this
License. (If a newer version than version 2 of the ordinaryGNU General Public License has
appeared, then you can specify that version instead if you wish.) Do not make any other change in
these notices.
Once this change ismade in a given copy, it is irreversible for that copy, so the ordinaryGNU
General Public License applies to all subsequent copies and derivative worksmade from that copy.
This option is useful when you wish to copy part of the code of the Library into a program that is not a
library.
4. Youmay copy and distribute the Library (or a portion or derivative of it, under Section 2) in object
code or executable form under the terms of Sections 1 and 2 above provided that you accompany it
with the complete correspondingmachine-readable source code, whichmust be distributed under
the terms of Sections 1 and 2 above on amedium customarily used for software interchange.
If distribution of object code ismade by offering access to copy from a designated place, then offering
equivalent access to copy the source code from the same place satisfies the requirement to
distribute the source code, even though third parties are not compelled to copy the source along with
the object code.
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5. A program that contains no derivative of any portion of the Library, but is designed to work with the
Library by being compiled or linked with it, is called a "work that uses the Library". Such a work, in
isolation, is not a derivative work of the Library, and therefore falls outside the scope of this License.
However, linking a "work that uses the Library" with the Library creates an executable that is a
derivative of the Library (because it contains portions of the Library), rather than a "work that uses
the library". The executable is therefore covered by this License. Section 6 states terms for
distribution of such executables.
When a "work that uses the Library" usesmaterial from a header file that is part of the Library, the
object code for the workmay be a derivative work of the Library even though the source code is not.
Whether this is true is especially significant if the work can be linked without the Library, or if the work
is itself a library. The threshold for this to be true is not precisely defined by law.
If such an object file uses only numerical parameters, data structure layouts and accessors, and
small macros and small inline functions (ten lines or less in length), then the use of the object file is
unrestricted, regardless of whether it is legally a derivative work. (Executables containing this object
code plus portions of the Library will still fall under Section 6.)
Otherwise, if the work is a derivative of the Library, youmay distribute the object code for the work
under the terms of Section 6. Any executables containing that work also fall under Section 6,
whether or not they are linked directly with the Library itself.
6. As an exception to the Sections above, youmay also combine or link a "work that uses the Library"
with the Library to produce a work containing portions of the Library, and distribute that work under
terms of your choice, provided that the terms permit modification of the work for the customer's own
use and reverse engineering for debugging suchmodifications.
Youmust give prominent notice with each copy of the work that the Library is used in it and that the
Library and its use are covered by this License. Youmust supply a copy of this License. If the work
during execution displays copyright notices, youmust include the copyright notice for the Library
among them, aswell as a reference directing the user to the copy of this License. Also, youmust do
one of these things:
a) Accompany the work with the complete correspondingmachine-readable source code for the
Library including whatever changeswere used in the work (whichmust be distributed under
Sections 1 and 2 above); and, if the work is an executable linked with the Library, with the complete
machine-readable "work that uses the Library", as object code and/or source code, so that the user
canmodify the Library and then relink to produce amodified executable containing themodified
Library. (It is understood that the user who changes the contents of definitions files in the Library will
not necessarily be able to recompile the application to use themodified definitions.)
b) Use a suitable shared librarymechanism for linking with the Library. A suitablemechanism is one
that (1) uses at run time a copy of the library already present on the user's computer system, rather
than copying library functions into the executable, and (2) will operate properly with amodified
version of the library, if the user installs one, as long as themodified version is interface-compatible
with the version that the work wasmadewith.
c) Accompany the work with a written offer, valid for at least three years, to give the same user the
materials specified in Subsection 6a, above, for a charge nomore than the cost of performing this
distribution.
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d) If distribution of the work ismade by offering access to copy from a designated place, offer
equivalent access to copy the above specifiedmaterials from the same place.
e) Verify that the user has already received a copy of thesematerials or that you have already sent
this user a copy.
For an executable, the required form of the "work that uses the Library" must include any data and
utility programs needed for reproducing the executable from it. However, as a special exception, the
materials to be distributed need not include anything that is normally distributed (in either source or
binary form) with themajor components (compiler, kernel, and so on) of the operating system on
which the executable runs, unless that component itself accompanies the executable.
It may happen that this requirement contradicts the license restrictions of other proprietary libraries
that do not normally accompany the operating system. Such a contradictionmeans you cannot use
both them and the Library together in an executable that you distribute.
7. Youmay place library facilities that are a work based on the Library side-by-side in a single library
together with other library facilities not covered by this License, and distribute such a combined
library, provided that the separate distribution of the work based on the Library and of the other
library facilities is otherwise permitted, and provided that you do these two things:
a) Accompany the combined library with a copy of the samework based on the Library, uncombined
with any other library facilities. Thismust be distributed under the terms of the Sections above.
b) Give prominent notice with the combined library of the fact that part of it is a work based on the
Library, and explaining where to find the accompanying uncombined form of the samework.
8. Youmay not copy, modify, sublicense, link with, or distribute the Library except as expressly
provided under this License. Any attempt otherwise to copy, modify, sublicense, link with, or
distribute the Library is void, and will automatically terminate your rights under this License.
However, parties who have received copies, or rights, from you under this License will not have their
licenses terminated so long as such parties remain in full compliance.
9. You are not required to accept this License, since you have not signed it. However, nothing else
grants you permission tomodify or distribute the Library or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, bymodifying or distributing the Library
(or anywork based on the Library), you indicate your acceptance of this License to do so, and all its
terms and conditions for copying, distributing or modifying the Library or works based on it.
10. Each time you redistribute the Library (or anywork based on the Library), the recipient
automatically receives a license from the original licensor to copy, distribute, link with or modify the
Library subject to these terms and conditions. Youmay not impose any further restrictions on the
recipients' exercise of the rights granted herein. You are not responsible for enforcing compliance by
third parties with this License.
11. If, as a consequence of a court judgment or allegation of patent infringement or for any other
reason (not limited to patent issues), conditions are imposed on you (whether by court order,
agreement or otherwise) that contradict the conditions of this License, they do not excuse you from
the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations
under this License and any other pertinent obligations, then as a consequence youmay not distribute
the Library at all. For example, if a patent license would not permit royalty-free redistribution of the
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Library by all those who receive copies directly or indirectly through you, then the only way you could
satisfy both it and this License would be to refrain entirely from distribution of the Library.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the
balance of the section is intended to apply, and the section as a whole is intended to apply in other
circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of
the free software distribution systemwhich is implemented by public license practices. Many people
havemade generous contributions to the wide range of software distributed through that system in
reliance on consistent application of that system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a licensee cannot impose that choice.
This section is intended tomake thoroughly clear what is believed to be a consequence of the rest of
this License.
12. If the distribution and/or use of the Library is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Library under this Licensemay
add an explicit geographical distribution limitation excluding those countries, so that distribution is
permitted only in or among countries not thus excluded. In such case, this License incorporates the
limitation as if written in the body of this License.
13. The Free Software Foundationmay publish revised and/or new versions of the Lesser General
Public License from time to time. Such new versionswill be similar in spirit to the present version, but
may differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Library specifies a version number of
this License which applies to it and "any later version", you have the option of following the terms and
conditions either of that version or of any later version published by the Free Software Foundation. If
the Library does not specify a license version number, youmay choose any version ever published
by the Free Software Foundation.
14. If you wish to incorporate parts of the Library into other free programswhose distribution
conditions are incompatible with these, write to the author to ask for permission. For software which
is copyrighted by the Free Software Foundation, write to the Free Software Foundation; we
sometimesmake exceptions for this. Our decision will be guided by the two goals of preserving the
free status of all derivatives of our free software and of promoting the sharing and reuse of software
generally.
15. BECAUSE THE LIBRARY IS LICENSED FREE OFCHARGE, THERE IS NOWARRANTY
FOR THE LIBRARY, TOTHE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPTWHEN
OTHERWISE STATED IN WRITINGTHE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE LIBRARY "AS IS"WITHOUTWARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES
OFMERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK
AS TOTHE QUALITY AND PERFORMANCEOF THE LIBRARY ISWITH YOU. SHOULD THE
LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COSTOF ALLNECESSARY SERVICING,
REPAIR OR CORRECTION.
16. IN NOEVENT UNLESS REQUIRED BY APPLICABLE LAWOR AGREED TO INWRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTYWHOMAYMODIFY AND/OR
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REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TOYOU FOR
DAMAGES, INCLUDINGANY GENERAL, SPECIAL, INCIDENTALOR CONSEQUENTIAL
DAMAGES ARISINGOUTOF THE USE OR INABILITY TOUSE THE LIBRARY (INCLUDING
BUT NOT LIMITED TOLOSS OFDATA OR DATA BEINGRENDERED INACCURATE OR
LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO
OPERATEWITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS

4. Apache License
Apache License
Version 2.0, January 2004
http://www.apache.org/licenses/
TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
1. Definitions.
"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by
Sections 1 through 9 of this document.
"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting
the License.
"Legal Entity" shall mean the union of the acting entity and all other entities that control, are
controlled by, or are under common control with that entity. For the purposes of this definition,
"control" means (i) the power, direct or indirect, to cause the direction or management of such entity,
whether by contract or otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding
shares, or (iii) beneficial ownership of such entity.
"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this
License.
"Source" form shall mean the preferred form for makingmodifications, including but not limited to
software source code, documentation source, and configuration files.
"Object" form shall mean any form resulting frommechanical transformation or translation of a
Source form, including but not limited to compiled object code, generated documentation, and
conversions to other media types.
"Work" shall mean the work of authorship, whether in Source or Object form, made available under
the License, as indicated by a copyright notice that is included in or attached to the work (an example
is provided in the Appendix below).
"DerivativeWorks" shall mean anywork, whether in Source or Object form, that is based on (or
derived from) theWork and for which the editorial revisions, annotations, elaborations, or other
modifications represent, as a whole, an original work of authorship. For the purposes of this License,
DerivativeWorks shall not include works that remain separable from, or merely link (or bind by
name) to the interfaces of, theWork and DerivativeWorks thereof.
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"Contribution" shall mean anywork of authorship, including the original version of theWork and any
modifications or additions to thatWork or DerivativeWorks thereof, that is intentionally submitted to
Licensor for inclusion in theWork by the copyright owner or by an individual or Legal Entity
authorized to submit on behalf of the copyright owner. For the purposes of this definition, "submitted"
means any form of electronic, verbal, or written communication sent to the Licensor or its
representatives, including but not limited to communication on electronicmailing lists, source code
control systems, and issue tracking systems that aremanaged by, or on behalf of, the Licensor for
the purpose of discussing and improving theWork, but excluding communication that is
conspicuouslymarked or otherwise designated in writing by the copyright owner as "Not a
Contribution."
"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a
Contribution has been received by Licensor and subsequently incorporated within theWork.
2. Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
copyright license to reproduce, prepare DerivativeWorks of, publicly display, publicly perform,
sublicense, and distribute theWork and such DerivativeWorks in Source or Object form.
3. Grant of Patent License. Subject to the terms and conditions of this License, each Contributor
hereby grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable
(except as stated in this section) patent license tomake, havemade, use, offer to sell, sell, import,
and otherwise transfer theWork, where such license applies only to those patent claims licensable
by such Contributor that are necessarily infringed by their Contribution(s) alone or by combination of
their Contribution(s) with theWork to which such Contribution(s) was submitted. If You institute
patent litigation against any entity (including a cross-claim or counterclaim in a lawsuit) alleging that
theWork or a Contribution incorporated within theWork constitutes direct or contributory patent
infringement, then any patent licenses granted to You under this License for thatWork shall
terminate as of the date such litigation is filed.
4. Redistribution. Youmay reproduce and distribute copies of theWork or DerivativeWorks thereof
in anymedium, with or without modifications, and in Source or Object form, provided that Youmeet
the following conditions:
(a) Youmust give any other recipients of theWork or DerivativeWorks a copy of this License; and
(b) Youmust cause anymodified files to carry prominent notices stating that You changed the files;
and
(c) Youmust retain, in the Source form of anyDerivativeWorks that You distribute, all copyright,
patent, trademark, and attribution notices from the Source form of theWork, excluding those notices
that do not pertain to any part of the DerivativeWorks; and
(d) If theWork includes a "NOTICE" text file as part of its distribution, then anyDerivativeWorks that
You distributemust include a readable copy of the attribution notices contained within such NOTICE
file, excluding those notices that do not pertain to any part of the DerivativeWorks, in at least one of
the following places: within a NOTICE text file distributed as part of the DerivativeWorks; within the
Source form or documentation, if provided along with the DerivativeWorks; or, within a display
generated by the DerivativeWorks, if and wherever such third-party notices normally appear. The
contents of the NOTICE file are for informational purposes only and do not modify the License. You
may add Your own attribution noticeswithin DerivativeWorks that You distribute, alongside or as an
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addendum to the NOTICE text from theWork, provided that such additional attribution notices
cannot be construed asmodifying the License.
Youmay add Your own copyright statement to Your modifications andmay provide additional or
different license terms and conditions for use, reproduction, or distribution of Your modifications, or
for any such DerivativeWorks as a whole, provided Your use, reproduction, and distribution of the
Work otherwise complies with the conditions stated in this License.
5. Submission of Contributions. Unless You explicitly state otherwise, anyContribution intentionally
submitted for inclusion in theWork by You to the Licensor shall be under the terms and conditions of
this License, without any additional terms or conditions. Notwithstanding the above, nothing herein
shall supersede or modify the terms of any separate license agreement youmay have executed with
Licensor regarding such Contributions.
6. Trademarks. This License does not grant permission to use the trade names, trademarks, service
marks, or product names of the Licensor, except as required for reasonable and customary use in
describing the origin of theWork and reproducing the content of the NOTICE file.
7. Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor
provides theWork (and each Contributor provides its Contributions) on an "AS IS" BASIS,
WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND, either express or implied, including,
without limitation, anywarranties or conditions of TITLE, NON-INFRINGEMENT,
MERCHANTABILITY, or FITNESS FOR A PARTICULAR PURPOSE. You are solely responsible
for determining the appropriateness of using or redistributing theWork and assume any risks
associated with Your exercise of permissions under this License.
8. Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence),
contract, or otherwise, unless required by applicable law (such as deliberate and grossly negligent
acts) or agreed to in writing, shall anyContributor be liable to You for damages, including any direct,
indirect, special, incidental, or consequential damages of any character arising as a result of this
License or out of the use or inability to use theWork (including but not limited to damages for loss of
goodwill, work stoppage, computer failure or malfunction, or any and all other commercial damages
or losses), even if such Contributor has been advised of the possibility of such damages.
9. AcceptingWarranty or Additional Liability. While redistributing theWork or DerivativeWorks
thereof, Youmay choose to offer, and charge a fee for, acceptance of support, warranty, indemnity,
or other liability obligations and/or rights consistent with this License. However, in accepting such
obligations, Youmay act only on Your own behalf and on Your sole responsibility, not on behalf of
any other Contributor, and only if You agree to indemnify, defend, and hold each Contributor
harmless for any liability incurred by, or claims asserted against, such Contributor by reason of your
accepting any such warranty or additional liability.
END OF TERMS AND CONDITIONS

5. Common Public License Version 1.0 (CPL)
THE ACCOMPANYINGPROGRAM IS PROVIDED UNDER THE TERMSOF THIS COMMON
PUBLIC LICENSE ("AGREEMENT"). ANY USE, REPRODUCTION OR DISTRIBUTION OF
THE PROGRAMCONSTITUTES RECIPIENT'S ACCEPTANCEOF THIS AGREEMENT.

1. DEFINITIONS
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"Contribution" means:
a) in the case of the initial Contributor, the initial code and documentation distributed under this
Agreement, and
b) in the case of each subsequent Contributor:
i) changes to the Program, and
ii) additions to the Program;
where such changes and/or additions to the Program originate from and are distributed by that
particular Contributor. A Contribution 'originates' from aContributor if it was added to the Program
by such Contributor itself or anyone acting on such Contributor's behalf. Contributions do not include
additions to the Programwhich: (i) are separatemodules of software distributed in conjunction with
the Program under their own license agreement, and (ii) are not derivative works of the Program.
"Contributor" means any person or entity that distributes the Program.
"Licensed Patents " mean patent claims licensable by a Contributor which are necessarily infringed
by the use or sale of its Contribution alone or when combined with the Program.
"Program"means the Contributions distributed in accordance with this Agreement.
"Recipient" means anyone who receives the Program under this Agreement, including all
Contributors.

2. GRANTOF RIGHTS
a) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a non-
exclusive, worldwide, royalty-free copyright license to reproduce, prepare derivative works of,
publicly display, publicly perform, distribute and sublicense the Contribution of such Contributor, if
any, and such derivative works, in source code and object code form.
b) Subject to the terms of this Agreement, each Contributor hereby grants Recipient a non-
exclusive, worldwide, royalty-free patent license under Licensed Patents tomake, use, sell, offer to
sell, import and otherwise transfer the Contribution of such Contributor, if any, in source code and
object code form. This patent license shall apply to the combination of the Contribution and the
Program if, at the time the Contribution is added by the Contributor, such addition of the Contribution
causes such combination to be covered by the Licensed Patents. The patent license shall not apply
to any other combinationswhich include the Contribution. No hardware per se is licensed
hereunder.
c) Recipient understands that although each Contributor grants the licenses to its Contributions set
forth herein, no assurances are provided by anyContributor that the Program does not infringe the
patent or other intellectual property rights of any other entity. Each Contributor disclaims any liability
to Recipient for claims brought by any other entity based on infringement of intellectual property
rights or otherwise. As a condition to exercising the rights and licenses granted hereunder, each
Recipient hereby assumes sole responsibility to secure any other intellectual property rights needed,
if any. For example, if a third party patent license is required to allow Recipient to distribute the
Program, it is Recipient's responsibility to acquire that license before distributing the Program.
d) Each Contributor represents that to its knowledge it has sufficient copyright rights in its
Contribution, if any, to grant the copyright license set forth in this Agreement.

3. REQUIREMENTS
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A Contributor may choose to distribute the Program in object code form under its own license
agreement, provided that:
a) it complies with the terms and conditions of this Agreement; and
b) its license agreement:
i) effectively disclaims on behalf of all Contributors all warranties and conditions, express and
implied, including warranties or conditions of title and non-infringement, and implied warranties or
conditions of merchantability and fitness for a particular purpose;
ii) effectively excludes on behalf of all Contributors all liability for damages, including direct, indirect,
special, incidental and consequential damages, such as lost profits;
iii) states that any provisionswhich differ from this Agreement are offered by that Contributor alone
and not by any other party; and
iv) states that source code for the Program is available from such Contributor, and informs licensees
how to obtain it in a reasonablemanner on or through amedium customarily used for software
exchange.
When the Program ismade available in source code form:
a) it must bemade available under this Agreement; and
b) a copy of this Agreement must be included with each copy of the Program.
Contributorsmay not remove or alter any copyright notices contained within the Program.
Each Contributor must identify itself as the originator of its Contribution, if any, in amanner that
reasonably allows subsequent Recipients to identify the originator of the Contribution.

4. COMMERCIALDISTRIBUTION
Commercial distributors of softwaremay accept certain responsibilities with respect to end users,
business partners and the like. While this license is intended to facilitate the commercial use of the
Program, the Contributor who includes the Program in a commercial product offering should do so in
amanner which does not create potential liability for other Contributors. Therefore, if a Contributor
includes the Program in a commercial product offering, such Contributor ("Commercial Contributor")
hereby agrees to defend and indemnify every other Contributor ("Indemnified Contributor") against
any losses, damages and costs (collectively "Losses") arising from claims, lawsuits and other legal
actions brought by a third party against the Indemnified Contributor to the extent caused by the acts
or omissions of such Commercial Contributor in connection with its distribution of the Program in a
commercial product offering. The obligations in this section do not apply to any claims or Losses
relating to any actual or alleged intellectual property infringement. In order to qualify, an Indemnified
Contributor must: a) promptly notify the Commercial Contributor in writing of such claim, and b) allow
the Commercial Contributor to control, and cooperate with the Commercial Contributor in, the
defense and any related settlement negotiations. The Indemnified Contributor may participate in any
such claim at its own expense.
For example, a Contributor might include the Program in a commercial product offering, Product X.
That Contributor is then a Commercial Contributor. If that Commercial Contributor thenmakes
performance claims, or offers warranties related to Product X, those performance claims and
warranties are such Commercial Contributor's responsibility alone. Under this section, the
Commercial Contributor would have to defend claims against the other Contributors related to those
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performance claims and warranties, and if a court requires any other Contributor to pay any
damages as a result, the Commercial Contributor must pay those damages.

5. NOWARRANTY
EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, THE PROGRAM IS
PROVIDED ON AN "AS IS" BASIS,WITHOUTWARRANTIES OR CONDITIONS OF ANY KIND,
EITHER EXPRESS OR IMPLIED INCLUDING,WITHOUT LIMITATION, ANYWARRANTIES
OR CONDITIONS OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR
A PARTICULAR PURPOSE.
Each Recipient is solely responsible for determining the appropriateness of using and distributing the
Program and assumes all risks associated with its exercise of rights under this Agreement, including
but not limited to the risks and costs of program errors, compliance with applicable laws, damage to
or loss of data, programs or equipment, and unavailability or interruption of operations.

6. DISCLAIMER OF LIABILITY
EXCEPT AS EXPRESSLY SET FORTH IN THIS AGREEMENT, NEITHER RECIPIENT NOR
ANY CONTRIBUTORS SHALLHAVE ANY LIABILITY FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIALDAMAGES (INCLUDING
WITHOUT LIMITATION LOST PROFITS), HOWEVER CAUSED AND ON ANY THEORYOF
LIABILITY,WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCEOR OTHERWISE) ARISING IN ANYWAYOUTOF THE USE OR
DISTRIBUTION OF THE PROGRAMOR THE EXERCISE OF ANY RIGHTS GRANTED
HEREUNDER, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

7. GENERAL
If any provision of this Agreement is invalid or unenforceable under applicable law, it shall not affect
the validity or enforceability of the remainder of the terms of this Agreement, and without further
action by the parties hereto, such provision shall be reformed to theminimumextent necessary to
make such provision valid and enforceable.
If Recipient institutes patent litigation against a Contributor with respect to a patent applicable to
software (including a cross-claim or counterclaim in a lawsuit), then any patent licenses granted by
that Contributor to such Recipient under this Agreement shall terminate as of the date such litigation
is filed. In addition, if Recipient institutes patent litigation against any entity (including a cross-claim or
counterclaim in a lawsuit) alleging that the Program itself (excluding combinations of the Program
with other software or hardware) infringes such Recipient's patent(s), then such Recipient's rights
granted under Section 2(b) shall terminate as of the date such litigation is filed.
All Recipient's rights under this Agreement shall terminate if it fails to comply with any of thematerial
terms or conditions of this Agreement and does not cure such failure in a reasonable period of time
after becoming aware of such noncompliance. If all Recipient's rights under this Agreement
terminate, Recipient agrees to cease use and distribution of the Program as soon as reasonably
practicable. However, Recipient's obligations under this Agreement and any licenses granted by
Recipient relating to the Program shall continue and survive.
Everyone is permitted to copy and distribute copies of this Agreement, but in order to avoid
inconsistency the Agreement is copyrighted andmay only bemodified in the followingmanner. The
Agreement Steward reserves the right to publish new versions (including revisions) of this
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Agreement from time to time. No one other than the Agreement Steward has the right to modify this
Agreement. IBM is the initial Agreement Steward. IBMmay assign the responsibility to serve as the
Agreement Steward to a suitable separate entity. Each new version of the Agreement will be given a
distinguishing version number. The Program (including Contributions) may always be distributed
subject to the version of the Agreement under which it was received. In addition, after a new version
of the Agreement is published, Contributor may elect to distribute the Program (including its
Contributions) under the new version. Except as expressly stated in Sections 2(a) and 2(b) above,
Recipient receives no rights or licenses to the intellectual property of anyContributor under this
Agreement, whether expressly, by implication, estoppel or otherwise. All rights in the Program not
expressly granted under this Agreement are reserved.
This Agreement is governed by the laws of the State of New York and the intellectual property laws
of the United States of America. No party to this Agreement will bring a legal action under this
Agreement more than one year after the cause of action arose. Each party waives its rights to a jury
trial in any resulting litigation.

6. Community Software License Agreement
Community Software License Agreement
Version 1.0 Copyright © 1999, 2006 Tanuki Software, Inc.
ANSYS, Inc. will provide you with a completemachine-readable copy of the source code, valid for
three years. The source code can be obtained by contacting ANSYS, Inc. at
open.source@ansys.com.
Permission is hereby granted, free of charge, to any person obtaining a copy of the Java Service
Wrapper and associated documentation files (the "Software"), to deal in the Software without
restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sub-
license, and/or sell copies of the Software, and to permit persons to whom the Software is furnished
to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDINGBUT NOT LIMITED TOTHEWARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT.
IN NOEVENT SHALL THE AUTHORSOR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY,WHETHER IN AN ACTION OFCONTRACT, TORT
OR OTHERWISE, ARISINGFROM, OUTOFOR IN CONNECTIONWITH THE SOFTWAREOR
THE USE OR OTHER DEALINGS IN THE SOFTWARE.
Tanuki Software, Inc. Community Software License Agreement Version 1.0
IMPORTANT-READ CAREFULLY: This license agreement is a legal agreement between you and
Tanuki Software, Inc.("TSI"), which includes computer software, associatedmedia, printed
materials, andmay include online or electronic documentation ( Software ). PLEASE READ THIS
AGREEMENTCAREFULLY BEFORE YOU INSTALL, COPY, DOWNLOAD OR USE THE
SOFTWARE ACCOMPANYINGTHIS PACKAGE.
Section 1 - Grant of License
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Community editions of the Software aremade available on theGNU General Public License,
Version 2 ("GPLv2"), included in Section 3 of this license document. All sections of the Community
Software License Agreement must be complied with in addition to those of the GPLv2.
Section 2 - Your Obligations
A copy of this licensemust be distributed in full with the Product in a location that is obvious to Your
customers. The Software Programmay not bemodified, nor may the Product in anyway obfuscate
or obstruct the copyright notice and license information displayed in the console and log files by the
Software Program on startup.
Section 3 - GPLv2 License Agreement
GNU GENERALPUBLIC LICENSE
Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301, USA
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing
it is not allowed.
Preamble
The licenses for most software are designed to take away your freedom to share and change it. By
contrast, the GNU General Public License is intended to guarantee your freedom to share and
change free software--to make sure the software is free for all its users. ThisGeneral Public License
applies tomost of the Free Software Foundation's software and to any other programwhose
authors commit to using it. (Some other Free Software Foundation software is covered by theGNU
LibraryGeneral Public License instead.) You can apply it to your programs, too.
Whenwe speak of free software, we are referring to freedom, not price. Our General Public
Licenses are designed tomake sure that you have the freedom to distribute copies of free software
(and charge for this service if you wish), that you receive source code or can get it if you want it, that
you can change the software or use pieces of it in new free programs; and that you know you can do
these things.
To protect your rights, we need tomake restrictions that forbid anyone to deny you these rights or to
ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you
distribute copies of the software, or if youmodify it.
For example, if you distribute copies of such a program, whether gratis or for a fee, youmust give the
recipients all the rights that you have. Youmust make sure that they, too, receive or can get the
source code. And youmust show them these terms so they know their rights.
We protect your rights with two steps:
(1) copyright the software, and
(2) offer you this license which gives you legal permission to copy, distribute and/or modify the
software.
Also, for each author's protection and ours, we want to make certain that everyone understands that
there is no warranty for this free software. If the software ismodified by someone else and passed
on, we want its recipients to know that what they have is not the original, so that any problems
introduced by others will not reflect on the original authors' reputations.
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Finally, any free program is threatened constantly by software patents. Wewish to avoid the danger
that redistributors of a free programwill individually obtain patent licenses, in effect making the
program proprietary. To prevent this, we havemade it clear that any patent must be licensed for
everyone's free use or not licensed at all.
The precise terms and conditions for copying, distribution andmodification follow.
GNU GENERALPUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING,
DISTRIBUTION AND MODIFICATION
0. This License applies to any program or other work which contains a notice placed by the copyright
holder saying it may be distributed under the terms of this General Public License. The "Program",
below, refers to any such program or work, and a "work based on the Program"means either the
Program or any derivative work under copyright law: that is to say, a work containing the Program or
a portion of it, either verbatim or with modifications and/or translated into another language.
(Hereinafter, translation is included without limitation in the term "modification".) Each licensee is
addressed as "you".
Activities other than copying, distribution andmodification are not covered by this License; they are
outside its scope. The act of running the Program is not restricted, and the output from the Program
is covered only if its contents constitute a work based on the Program (independent of having been
made by running the Program).Whether that is true depends on what the Program does.
1. Youmay copy and distribute verbatim copies of the Program's source code as you receive it, in
anymedium, provided that you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this
License and to the absence of anywarranty; and give any other recipients of the Program a copy of
this License along with the Program.
Youmay charge a fee for the physical act of transferring a copy, and youmay at your option offer
warranty protection in exchange for a fee.
2. Youmaymodify your copy or copies of the Program or any portion of it, thus forming a work based
on the Program, and copy and distribute suchmodifications or work under the terms of Section 1
above, provided that you alsomeet all of these conditions:
a) Youmust cause themodified files to carry prominent notices stating that you changed the files and
the date of any change.
b) Youmust cause anywork that you distribute or publish, that in whole or in part contains or is
derived from the Program or any part thereof, to be licensed as a whole at no charge to all third
parties under the terms of this License.
c) If themodified program normally reads commands interactively when run, youmust cause it,
when started running for such interactive use in themost ordinary way, to print or display an
announcement including an appropriate copyright notice and a notice that there is no warranty (or
else, saying that you provide a warranty) and that usersmay redistribute the program under these
conditions, and telling the user how to view a copy of this License. (Exception: if the Program itself is
interactive but does not normally print such an announcement, your work based on the Program is
not required to print an announcement.)
These requirements apply to themodified work as a whole. If identifiable sections of that work are
not derived from the Program, and can be reasonably considered independent and separate works
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in themselves, then this License, and its terms, do not apply to those sectionswhen you distribute
them as separate works. But when you distribute the same sections as part of a whole which is a
work based on the Program, the distribution of the wholemust be on the terms of this License,
whose permissions for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by
you; rather, the intent is to exercise the right to control the distribution of derivative or collective works
based on the Program.
In addition, mere aggregation of another work not based on the Programwith the Program (or with a
work based on the Program) on a volume of a storage or distributionmedium does not bring the
other work under the scope of this License.
3. Youmay copy and distribute the Program (or a work based on it, under Section 2) in object code
or executable form under the terms of Sections 1 and 2 above provided that you also do one of the
following:
a) Accompany it with the complete correspondingmachine-readable source code, whichmust be
distributed under the terms of Sections 1 and 2 above on amedium customarily used for software
interchange; or,
b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge
nomore than your cost of physically performing source distribution, a completemachine-readable
copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above
on amedium customarily used for software interchange; or,
c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable formwith such an offer, in accord with Subsection b above.)
The source code for a workmeans the preferred form of the work for makingmodifications to it. For
an executable work, complete source codemeans all the source code for all modules it contains,
plus any associated interface definition files, plus the scripts used to control compilation and
installation of the executable. However, as a special exception, the source code distributed need not
include anything that is normally distributed (in either source or binary form) with themajor
components (compiler, kernel, and so on) of the operating system onwhich the executable runs,
unless that component itself accompanies the executable.
If distribution of executable or object code ismade by offering access to copy from a designated
place, then offering equivalent access to copy the source code from the same place counts as
distribution of the source code, even though third parties are not compelled to copy the source along
with the object code.
4. Youmay not copy, modify, sublicense, or distribute the Program except as expressly provided
under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is
void, and will automatically terminate your rights under this License. However, parties who have
received copies, or rights, from you under this License will not have their licenses terminated so long
as such parties remain in full compliance.
5. You are not required to accept this License, since you have not signed it. However, nothing else
grants you permission tomodify or distribute the Program or its derivative works. These actions are
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prohibited by law if you do not accept this License. Therefore, bymodifying or distributing the
Program (or anywork based on the Program), you indicate your acceptance of this License to do so,
and all its terms and conditions for copying, distributing or modifying the Program or works based on
it.
6. Each time you redistribute the Program (or anywork based on the Program), the recipient
automatically receives a license from the original licensor to copy, distribute or modify the Program
subject to these terms and conditions. Youmay not impose any further restrictions on the recipients'
exercise of the rights granted herein. You are not responsible for enforcing compliance by third
parties to this License.
7. If, as a consequence of a court judgment or allegation of patent infringement or for any other
reason (not limited to patent issues), conditions are imposed on you (whether by court order,
agreement or otherwise) that contradict the conditions of this License, they do not excuse you from
the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations
under this License and any other pertinent obligations, then as a consequence youmay not distribute
the Program at all. For example, if a patent license would not permit royalty-free redistribution of the
Program by all those who receive copies directly or indirectly through you, then the only way you
could satisfy both it and this License would be to refrain entirely from distribution of the Program.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the
balance of the section is intended to apply and the section as a whole is intended to apply in other
circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of
the free software distribution system, which is implemented by public license practices. Many people
havemade generous contributions to the wide range of software distributed through that system in
reliance on consistent application of that system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a licensee cannot impose that choice.
This section is intended tomake thoroughly clear what is believed to be a consequence of the rest of
this License.
8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Program under this Licensemay
add an explicit geographical distribution limitation excluding those countries, so that distribution is
permitted only in or among countries not thus excluded. In such case, this License incorporates the
limitation as if written in the body of this License.
9. The Free Software Foundationmay publish revised and/or new versions of the General Public
License from time to time. Such new versionswill be similar in spirit to the present version, but may
differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies a version number of
this License which applies to it and "any later version", you have the option of following the terms and
conditions either of that version or of any later version published by the Free Software Foundation. If
the Program does not specify a version number of this License, youmay choose any version ever
published by the Free Software Foundation.
10. If you wish to incorporate parts of the Program into other free programswhose distribution
conditions are different, write to the author to ask for permission. For software which is copyrighted
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by the Free Software Foundation, write to the Free Software Foundation; we sometimesmake
exceptions for this. Our decision will be guided by the two goals of preserving the free status of all
derivatives of our free software and of promoting the sharing and reuse of software generally.
NOWARRANTY
11. BECAUSE THE PROGRAM IS LICENSED FREE OFCHARGE, THERE IS NOWARRANTY
FOR THE PROGRAM, TOTHE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPTWHEN
OTHERWISE STATED IN WRITINGTHE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE PROGRAM "AS IS"WITHOUTWARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES
OFMERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK
AS TOTHE QUALITY AND PERFORMANCEOF THE PROGRAM ISWITH YOU. SHOULD
THE PROGRAMPROVE DEFECTIVE, YOU ASSUME THE COSTOF ALLNECESSARY
SERVICING, REPAIR OR CORRECTION.
12. IN NOEVENT UNLESS REQUIRED BY APPLICABLE LAWOR AGREED TO INWRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTYWHOMAYMODIFY AND/OR
REDISTRIBUTE THE PROGRAMAS PERMITTED ABOVE, BE LIABLE TOYOU FOR
DAMAGES, INCLUDINGANY GENERAL, SPECIAL, INCIDENTALOR CONSEQUENTIAL
DAMAGES ARISINGOUTOF THE USE OR INABILITY TOUSE THE PROGRAM (INCLUDING
BUT NOT LIMITED TOLOSS OFDATA OR DATA BEINGRENDERED INACCURATE OR
LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAMTO
OPERATEWITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS
Section 4 - 3rd Party Components
(1) The Software Program includes software and documentation components developed in part by
Silver Egg Technology, Inc. ("SET") prior to 2001. All SET components were released under the
following license.
Copyright (c) 2001 Silver Egg Technology
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sub-license, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to
the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDINGBUT NOT LIMITED TOTHEWARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT.
IN NOEVENT SHALL THE AUTHORSOR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY,WHETHER IN AN ACTION OFCONTRACT, TORT
OR OTHERWISE, ARISINGFROM, OUTOFOR IN CONNECTIONWITH THE SOFTWAREOR
THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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7. Common Development and Distribution License (CDDL)
CommonDevelopment and Distribution License (CDDL)
Version 1.0
Definitions.
1.1. Contributor means each individual or entity that creates or contributes to the creation of
Modifications.
1.2. Contributor Versionmeans the combination of the Original Software, prior Modifications used by
a Contributor (if any), and theModificationsmade by that particular Contributor.
1.3. Covered Softwaremeans

l the Original Software, or
l Modifications, or
l the combination of files containing Original Software with files containingModifications,

in each case including portions thereof.
1.4. Executablemeans the Covered Software in any form other than Source Code.
1.5. Initial Developer means the individual or entity that first makesOriginal Software available under
this License.
1.6. Larger Workmeans a work which combinesCovered Software or portions thereof with code not
governed by the terms of this License.
1.7. Licensemeans this document.
1.8. Licensablemeans having the right to grant, to themaximumextent possible, whether at the time
of the initial grant or subsequently acquired, any and all of the rights conveyed herein.
1.9. Modificationsmeans the Source Code and Executable form of any of the following: A. Any file
that results from an addition to, deletion from or modification of the contents of a file containing
Original Software or previousModifications; B. Any new file that contains any part of the Original
Software or previousModification; or C. Any new file that is contributed or otherwisemade available
under the terms of this License.
1.10. Original Softwaremeans the Source Code and Executable form of computer software code
that is originally released under this License.
1.11. Patent Claimsmeans any patent claim(s), now owned or hereafter acquired, including without
limitation, method, process, and apparatus claims, in any patent Licensable by grantor.
1.12. Source Codemeans

l the common form of computer software code in whichmodifications aremade and
l associated documentation included in or with such code.

1.13. You (or Your) means an individual or a legal entity exercising rights under, and complying with
all of the terms of, this License. For legal entities, You includes any entity which controls, is controlled
by, or is under common control with You. For purposes of this definition, control means (a) the
power, direct or indirect, to cause the direction or management of such entity, whether by contract or
otherwise, or (b) ownership of more than fifty percent (50%) of the outstanding shares or beneficial
ownership of such entity.
2. LicenseGrants.
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2.1. The Initial Developer Grant. Conditioned upon Your compliance with Section 3.1 below and
subject to third party intellectual property claims, the Initial Developer hereby grants You a world-
wide, royalty-free, non-exclusive license:

l under intellectual property rights (other than patent or trademark) Licensable by Initial
Developer, to use, reproduce, modify, display, perform, sublicense and distribute the
Original Software (or portions thereof), with or without Modifications, and/or as part of a
Larger Work; and

l under Patent Claims infringed by themaking, using or selling of Original Software, to make,
havemade, use, practice, sell, and offer for sale, and/or otherwise dispose of the Original
Software (or portions thereof).

l The licenses granted in Sections 2.1(a) and (b) are effective on the date Initial Developer
first distributes or otherwisemakes theOriginal Software available to a third party under the
terms of this License.

l Notwithstanding Section 2.1(b) above, no patent license is granted:
l for code that You delete from theOriginal Software, or
l for infringements caused by:
l themodification of the Original Software, or
l the combination of the Original Software with other software or devices.

2.2. Contributor Grant.
Conditioned upon Your compliance with Section 3.1 below and subject to third party intellectual
property claims, each Contributor hereby grants You a world-wide, royalty-free, non-exclusive
license:

l under intellectual property rights (other than patent or trademark) Licensable byContributor
to use, reproduce, modify, display, perform, sublicense and distribute theModifications
created by such Contributor (or portions thereof), either on an unmodified basis, with other
Modifications, as Covered Software and/or as part of a Larger Work; and

l under Patent Claims infringed by themaking, using, or selling of Modificationsmade by that
Contributor either alone and/or in combination with its Contributor Version (or portions of
such combination), to make, use, sell, offer for sale, havemade, and/or otherwise dispose
of:
l Modificationsmade by that Contributor (or portions thereof); and
l the combination of Modificationsmade by that Contributor with its Contributor Version
(or portions of such combination).

l The licenses granted in Sections 2.2(a) and 2.2(b) are effective on the date Contributor first
distributes or otherwisemakes theModifications available to a third party.

l Notwithstanding Section 2.2(b) above, no patent license is granted:
l for any code that Contributor has deleted from the Contributor Version;
l for infringements caused by:
l third partymodifications of Contributor Version, or
l the combination of Modificationsmade by that Contributor with other software (except
as part of the Contributor Version) or other devices; or

l under Patent Claims infringed byCovered Software in the absence of Modifications
made by that Contributor.
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3. Distribution Obligations.
3.1. Availability of Source Code.
AnyCovered Software that You distribute or otherwisemake available in Executable formmust also
bemade available in Source Code form and that Source Code formmust be distributed only under
the terms of this License. Youmust include a copy of this License with every copy of the Source
Code form of the Covered Software You distribute or otherwisemake available. Youmust inform
recipients of any such Covered Software in Executable form as to how they can obtain such
Covered Software in Source Code form in a reasonablemanner on or through amedium
customarily used for software exchange.
3.2. Modifications.
TheModifications that You create or to which You contribute are governed by the terms of this
License. You represent that You believe Your Modifications are Your original creation(s) and/or You
have sufficient rights to grant the rights conveyed by this License.
3.3. Required Notices.
Youmust include a notice in each of Your Modifications that identifies You as the Contributor of the
Modification. Youmay not remove or alter any copyright, patent or trademark notices contained
within the Covered Software, or any notices of licensing or any descriptive text giving attribution to
anyContributor or the Initial Developer.
3.4. Application of Additional Terms.
Youmay not offer or impose any terms on anyCovered Software in Source Code form that alters or
restricts the applicable version of this License or the recipients rights hereunder. Youmay choose to
offer, and to charge a fee for, warranty, support, indemnity or liability obligations to one or more
recipients of Covered Software. However, youmay do so only on Your own behalf, and not on
behalf of the Initial Developer or anyContributor. Youmust make it absolutely clear that any such
warranty, support, indemnity or liability obligation is offered by You alone, and You hereby agree to
indemnify the Initial Developer and every Contributor for any liability incurred by the Initial Developer
or such Contributor as a result of warranty, support, indemnity or liability termsYou offer.
3.5. Distribution of Executable Versions.
Youmay distribute the Executable form of the Covered Software under the terms of this License or
under the terms of a license of Your choice, whichmay contain terms different from this License,
provided that You are in compliance with the terms of this License and that the license for the
Executable form does not attempt to limit or alter the recipients rights in the Source Code form from
the rights set forth in this License. If You distribute the Covered Software in Executable form under a
different license, Youmust make it absolutely clear that any termswhich differ from this License are
offered by You alone, not by the Initial Developer or Contributor. You hereby agree to indemnify the
Initial Developer and every Contributor for any liability incurred by the Initial Developer or such
Contributor as a result of any such termsYou offer.
3.6. Larger Works.
Youmay create a Larger Work by combining Covered Software with other code not governed by the
terms of this License and distribute the Larger Work as a single product. In such a case, Youmust
make sure the requirements of this License are fulfilled for the Covered Software.
4. Versions of the License.
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4.1. New Versions.
SunMicrosystems, Inc. is the initial license steward andmay publish revised and/or new versions of
this License from time to time. Each version will be given a distinguishing version number. Except as
provided in Section 4.3, no one other than the license steward has the right to modify this License.
4.2. Effect of New Versions.
Youmay always continue to use, distribute or otherwisemake the Covered Software available
under the terms of the version of the License under which You originally received the Covered
Software. If the Initial Developer includes a notice in the Original Software prohibiting it from being
distributed or otherwisemade available under any subsequent version of the License, Youmust
distribute andmake the Covered Software available under the terms of the version of the License
under which You originally received the Covered Software. Otherwise, Youmay also choose to use,
distribute or otherwisemake the Covered Software available under the terms of any subsequent
version of the License published by the license steward.
4.3. Modified Versions.
When You are an Initial Developer and You want to create a new license for Your Original Software,
Youmay create and use amodified version of this License if You:

l rename the license and remove any references to the name of the license steward (except
to note that the license differs from this License); and

l otherwisemake it clear that the license contains termswhich differ from this License.
5. DISCLAIMER OFWARRANTY.
COVERED SOFTWARE IS PROVIDED UNDER THIS LICENSE ON AN AS IS BASIS,
WITHOUTWARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING,
WITHOUT LIMITATION,WARRANTIES THAT THE COVERED SOFTWARE IS FREE OF
DEFECTS, MERCHANTABLE, FIT FOR A PARTICULAR PURPOSE OR NON-INFRINGING.
THE ENTIRE RISK AS TOTHE QUALITY AND PERFORMANCEOF THE COVERED
SOFTWARE ISWITH YOU. SHOULD ANY COVERED SOFTWARE PROVE DEFECTIVE IN
ANY RESPECT, YOU (NOT THE INITIAL DEVELOPER OR ANY OTHER CONTRIBUTOR)
ASSUME THE COSTOF ANY NECESSARY SERVICING, REPAIR OR CORRECTION. THIS
DISCLAIMER OFWARRANTY CONSTITUTES AN ESSENTIAL PARTOF THIS LICENSE. NO
USE OF ANY COVERED SOFTWARE IS AUTHORIZED HEREUNDER EXCEPT UNDER THIS
DISCLAIMER.
6. TERMINATION.
6.1. This License and the rights granted hereunder will terminate automatically if You fail to comply
with terms herein and fail to cure such breach within 30 days of becoming aware of the breach.
Provisionswhich, by their nature, must remain in effect beyond the termination of this License shall
survive.
6.2. If You assert a patent infringement claim (excluding declaratory judgment actions) against Initial
Developer or a Contributor (the Initial Developer or Contributor against whomYou assert such claim
is referred to as Participant) alleging that the Participant Software (meaning the Contributor Version
where the Participant is a Contributor or the Original Software where the Participant is the Initial
Developer) directly or indirectly infringes any patent, then any and all rights granted directly or
indirectly to You by such Participant, the Initial Developer (if the Initial Developer is not the
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Participant) and all Contributors under Sections 2.1 and/or 2.2 of this License shall, upon 60 days
notice fromParticipant terminate prospectively and automatically at the expiration of such 60 day
notice period, unless if within such 60 day period You withdraw Your claimwith respect to the
Participant Software against such Participant either unilaterally or pursuant to a written agreement
with Participant.
6.3. In the event of termination under Sections 6.1 or 6.2 above, all end user licenses that have been
validly granted by You or any distributor hereunder prior to termination (excluding licenses granted to
You by any distributor) shall survive termination.
7. LIMITATION OF LIABILITY.
UNDER NOCIRCUMSTANCES AND UNDER NOLEGAL THEORY,WHETHER TORT
(INCLUDINGNEGLIGENCE), CONTRACT, OR OTHERWISE, SHALL YOU, THE INITIAL
DEVELOPER, ANY OTHER CONTRIBUTOR, OR ANY DISTRIBUTOR OFCOVERED
SOFTWARE, OR ANY SUPPLIER OF ANY OF SUCH PARTIES, BE LIABLE TOANY PERSON
FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIALDAMAGESOF ANY
CHARACTER INCLUDING,WITHOUT LIMITATION, DAMAGES FOR LOST PROFITS, LOSS
OFGOODWILL,WORK STOPPAGE, COMPUTER FAILURE ORMALFUNCTION, OR ANY
AND ALLOTHER COMMERCIALDAMAGESOR LOSSES, EVEN IF SUCH PARTY SHALL
HAVE BEEN INFORMED OF THE POSSIBILITY OF SUCH DAMAGES. THIS LIMITATION OF
LIABILITY SHALLNOT APPLY TOLIABILITY FOR DEATH OR PERSONAL INJURY
RESULTINGFROMSUCH PARTYS NEGLIGENCE TOTHE EXTENT APPLICABLE LAW
PROHIBITS SUCH LIMITATION. SOME JURISDICTIONS DONOT ALLOW THE EXCLUSION
OR LIMITATION OF INCIDENTALOR CONSEQUENTIALDAMAGES, SOTHIS EXCLUSION
AND LIMITATION MAY NOT APPLY TOYOU.
8. U.S. GOVERNMENT END USERS.
The Covered Software is a commercial item, as that term is defined in 48 C.F.R. 2.101 (Oct. 1995),
consisting of commercial computer software (as that term is defined at 48 C.F.R. 252.227-7014(a)
(1)) and commercial computer software documentation as such terms are used in 48 C.F.R. 12.212
(Sept. 1995). Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 227.7202-1 through 227.7202-4
(June 1995), all U.S. Government End Users acquire Covered Software with only those rights set
forth herein. This U.S. Government Rights clause is in lieu of, and supersedes, any other FAR,
DFAR, or other clause or provision that addressesGovernment rights in computer software under
this License.
9. MISCELLANEOUS.
This License represents the complete agreement concerning subject matter hereof. If any provision
of this License is held to be unenforceable, such provision shall be reformed only to the extent
necessary tomake it enforceable. This License shall be governed by the law of the jurisdiction
specified in a notice contained within the Original Software (except to the extent applicable law, if
any, provides otherwise), excluding such jurisdictions conflict-of-law provisions. Any litigation
relating to this License shall be subject to the jurisdiction of the courts located in the jurisdiction and
venue specified in a notice contained within the Original Software, with the losing party responsible
for costs, including, without limitation, court costs and reasonable attorneys fees and expenses. The
application of the United NationsConvention on Contracts for the International Sale of Goods is
expressly excluded. Any law or regulation which provides that the language of a contract shall be
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construed against the drafter shall not apply to this License. You agree that You alone are
responsible for compliance with the United States export administration regulations (and the export
control laws and regulation of any other countries) when You use, distribute or otherwisemake
available anyCovered Software.
10. RESPONSIBILITY FOR CLAIMS.
As between Initial Developer and the Contributors, each party is responsible for claims and
damages arising, directly or indirectly, out of its utilization of rights under this License and You agree
to work with Initial Developer and Contributors to distribute such responsibility on an equitable basis.
Nothing herein is intended or shall be deemed to constitute any admission of liability.
----------

8. GNU GENERAL PUBLIC LICENSE (GPL)
Included herewith:
Version 3
Version 2
VERSION 3
GNU GENERALPUBLIC LICENSE
Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org>
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing
it is not allowed.
Preamble
TheGNU General Public License is a free, copyleft license for software and other kinds of works.
The licenses for most software and other practical works are designed to take away your freedom to
share and change the works. By contrast, the GNU General Public License is intended to guarantee
your freedom to share and change all versions of a program--to make sure it remains free software
for all its users. We, the Free Software Foundation, use theGNU General Public License for most of
our software; it applies also to any other work released this way by its authors. You can apply it to
your programs, too.
Whenwe speak of free software, we are referring to freedom, not price. Our General Public
Licenses are designed tomake sure that you have the freedom to distribute copies of free software
(and charge for them if you wish), that you receive source code or can get it if you want it, that you
can change the software or use pieces of it in new free programs, and that you know you can do
these things.
To protect your rights, we need to prevent others from denying you these rights or asking you to
surrender the rights. Therefore, you have certain responsibilities if you distribute copies of the
software, or if youmodify it: responsibilities to respect the freedom of others.
For example, if you distribute copies of such a program, whether gratis or for a fee, youmust pass on
to the recipients the same freedoms that you received. Youmust make sure that they, too, receive or
can get the source code. And youmust show them these terms so they know their rights.
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Developers that use theGNU GPL protect your rights with two steps: (1) assert copyright on the
software, and (2) offer you this License giving you legal permission to copy, distribute and/or modify
it.
For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this
free software. For both users' and authors' sake, the GPL requires that modified versions bemarked
as changed, so that their problemswill not be attributed erroneously to authors of previous versions.
Some devices are designed to deny users access to install or runmodified versions of the software
inside them, although themanufacturer can do so. This is fundamentally incompatible with the aim of
protecting users' freedom to change the software. The systematic pattern of such abuse occurs in
the area of products for individuals to use, which is precisely where it ismost unacceptable.
Therefore, we have designed this version of the GPL to prohibit the practice for those products. If
such problems arise substantially in other domains, we stand ready to extend this provision to those
domains in future versions of the GPL, as needed to protect the freedom of users.
Finally, every program is threatened constantly by software patents. States should not allow patents
to restrict development and use of software on general-purpose computers, but in those that do, we
wish to avoid the special danger that patents applied to a free program couldmake it effectively
proprietary. To prevent this, the GPL assures that patents cannot be used to render the program
non-free.
The precise terms and conditions for copying, distribution andmodification follow.
TERMS AND CONDITIONS
0. Definitions.
“This License” refers to version 3 of the GNU General Public License.
“Copyright” alsomeans copyright-like laws that apply to other kinds of works, such as semiconductor
masks.
“The Program” refers to any copyrightable work licensed under this License. Each licensee is
addressed as “you”. “Licensees” and “recipients” may be individuals or organizations.
To “modify” a workmeans to copy from or adapt all or part of the work in a fashion requiring copyright
permission, other than themaking of an exact copy. The resulting work is called a “modified version”
of the earlier work or a work “based on” the earlier work.
A “covered work” means either the unmodified Program or a work based on the Program.
To “propagate” a workmeans to do anything with it that, without permission, wouldmake you directly
or secondarily liable for infringement under applicable copyright law, except executing it on a
computer or modifying a private copy. Propagation includes copying, distribution (with or without
modification), making available to the public, and in some countries other activities aswell.
To “convey” a workmeans any kind of propagation that enables other parties tomake or receive
copies. Mere interaction with a user through a computer network, with no transfer of a copy, is not
conveying.
An interactive user interface displays “Appropriate Legal Notices” to the extent that it includes a
convenient and prominently visible feature that (1) displays an appropriate copyright notice, and (2)
tells the user that there is no warranty for the work (except to the extent that warranties are
provided), that licenseesmay convey the work under this License, and how to view a copy of this
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License. If the interface presents a list of user commands or options, such as amenu, a prominent
item in the list meets this criterion.
1. Source Code.
The “source code” for a workmeans the preferred form of the work for makingmodifications to it.
“Object code” means any non-source form of a work.
A “Standard Interface” means an interface that either is an official standard defined by a recognized
standards body, or, in the case of interfaces specified for a particular programming language, one
that is widely used among developers working in that language.
The “System Libraries” of an executable work include anything, other than the work as a whole, that
(a) is included in the normal form of packaging aMajor Component, but which is not part of that
Major Component, and (b) serves only to enable use of the work with that Major Component, or to
implement a Standard Interface for which an implementation is available to the public in source code
form. A “Major Component”, in this context, means amajor essential component (kernel, window
system, and so on) of the specific operating system (if any) on which the executable work runs, or a
compiler used to produce the work, or an object code interpreter used to run it.
The “Corresponding Source” for a work in object code formmeans all the source code needed to
generate, install, and (for an executable work) run the object code and tomodify the work, including
scripts to control those activities. However, it does not include the work's System Libraries, or
general-purpose tools or generally available free programswhich are used unmodified in performing
those activities but which are not part of the work. For example, Corresponding Source includes
interface definition files associated with source files for the work, and the source code for shared
libraries and dynamically linked subprograms that the work is specifically designed to require, such
as by intimate data communication or control flow between those subprograms and other parts of
the work.
The Corresponding Source need not include anything that users can regenerate automatically from
other parts of the Corresponding Source.
The Corresponding Source for a work in source code form is that samework.
2. Basic Permissions.
All rights granted under this License are granted for the term of copyright on the Program, and are
irrevocable provided the stated conditions aremet. This License explicitly affirms your unlimited
permission to run the unmodified Program. The output from running a covered work is covered by
this License only if the output, given its content, constitutes a covered work. This License
acknowledges your rights of fair use or other equivalent, as provided by copyright law.
Youmaymake, run and propagate covered works that you do not convey, without conditions so long
as your license otherwise remains in force. Youmay convey covered works to others for the sole
purpose of having themmakemodifications exclusively for you, or provide you with facilities for
running those works, provided that you comply with the terms of this License in conveying all material
for which you do not control copyright. Those thusmaking or running the covered works for youmust
do so exclusively on your behalf, under your direction and control, on terms that prohibit them from
making any copies of your copyrightedmaterial outside their relationship with you.
Conveying under any other circumstances is permitted solely under the conditions stated below.
Sublicensing is not allowed; section 10makes it unnecessary.
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3. Protecting Users' Legal Rights From Anti-Circumvention Law.
No covered work shall be deemed part of an effective technological measure under any applicable
law fulfilling obligations under article 11 of theWIPOcopyright treaty adopted on 20 December 1996,
or similar laws prohibiting or restricting circumvention of suchmeasures.
When you convey a covered work, you waive any legal power to forbid circumvention of
technological measures to the extent such circumvention is effected by exercising rights under this
License with respect to the covered work, and you disclaim any intention to limit operation or
modification of the work as ameans of enforcing, against the work's users, your or third parties' legal
rights to forbid circumvention of technological measures.
4. Conveying Verbatim Copies.
Youmay convey verbatim copies of the Program's source code as you receive it, in anymedium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright
notice; keep intact all notices stating that this License and any non-permissive terms added in accord
with section 7 apply to the code; keep intact all notices of the absence of anywarranty; and give all
recipients a copy of this License along with the Program.
Youmay charge any price or no price for each copy that you convey, and youmay offer support or
warranty protection for a fee.
5. Conveying Modified Source Versions.
Youmay convey a work based on the Program, or themodifications to produce it from the Program,
in the form of source code under the terms of section 4, provided that you alsomeet all of these
conditions:

a. The workmust carry prominent notices stating that youmodified it, and giving a relevant
date.

b. The workmust carry prominent notices stating that it is released under this License and
any conditions added under section 7. This requirement modifies the requirement in
section 4 to “keep intact all notices”.

c. Youmust license the entire work, as a whole, under this License to anyone who comes
into possession of a copy. This License will therefore apply, along with any applicable
section 7 additional terms, to the whole of the work, and all its parts, regardless of how
they are packaged. This License gives no permission to license the work in any other way,
but it does not invalidate such permission if you have separately received it.

d. If the work has interactive user interfaces, eachmust display Appropriate Legal Notices;
however, if the Program has interactive interfaces that do not display Appropriate Legal
Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their
nature extensions of the covered work, and which are not combined with it such as to form a larger
program, in or on a volume of a storage or distributionmedium, is called an “aggregate” if the
compilation and its resulting copyright are not used to limit the access or legal rights of the
compilation's users beyond what the individual works permit. Inclusion of a covered work in an
aggregate does not cause this License to apply to the other parts of the aggregate.
6. Conveying Non-Source Forms.
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Youmay convey a covered work in object code form under the terms of sections 4 and 5, provided
that you also convey themachine-readable Corresponding Source under the terms of this License,
in one of these ways:

a. Convey the object code in, or embodied in, a physical product (including a physical
distributionmedium), accompanied by the Corresponding Source fixed on a durable
physical medium customarily used for software interchange.

b. Convey the object code in, or embodied in, a physical product (including a physical
distributionmedium), accompanied by a written offer, valid for at least three years and
valid for as long as you offer spare parts or customer support for that product model, to
give anyone who possesses the object code either (1) a copy of the Corresponding
Source for all the software in the product that is covered by this License, on a durable
physical medium customarily used for software interchange, for a price nomore than your
reasonable cost of physically performing this conveying of source, or (2) access to copy
the Corresponding Source from a network server at no charge.

c. Convey individual copies of the object code with a copy of the written offer to provide the
Corresponding Source. This alternative is allowed only occasionally and
noncommercially, and only if you received the object code with such an offer, in accord
with subsection 6b.

d. Convey the object code by offering access from a designated place (gratis or for a
charge), and offer equivalent access to the Corresponding Source in the sameway
through the same place at no further charge. You need not require recipients to copy the
Corresponding Source along with the object code. If the place to copy the object code is a
network server, the Corresponding Sourcemay be on a different server (operated by you
or a third party) that supports equivalent copying facilities, provided youmaintain clear
directions next to the object code saying where to find the Corresponding Source.
Regardless of what server hosts the Corresponding Source, you remain obligated to
ensure that it is available for as long as needed to satisfy these requirements.

e. Convey the object code using peer-to-peer transmission, provided you inform other peers
where the object code and Corresponding Source of the work are being offered to the
general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding
Source as a System Library, need not be included in conveying the object code work.
A “User Product” is either (1) a “consumer product”, whichmeans any tangible personal property
which is normally used for personal, family, or household purposes, or (2) anything designed or sold
for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful
cases shall be resolved in favor of coverage. For a particular product received by a particular user,
“normally used” refers to a typical or common use of that class of product, regardless of the status of
the particular user or of the way in which the particular user actually uses, or expects or is expected
to use, the product. A product is a consumer product regardless of whether the product has
substantial commercial, industrial or non-consumer uses, unless such uses represent the only
significant mode of use of the product.
“Installation Information” for a User Product means anymethods, procedures, authorization keys, or
other information required to install and executemodified versions of a covered work in that User
Product from amodified version of its Corresponding Source. The informationmust suffice to ensure
that the continued functioning of themodified object code is in no case prevented or interfered with
solely becausemodification has beenmade.
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If you convey an object code work under this section in, or with, or specifically for use in, a User
Product, and the conveying occurs as part of a transaction in which the right of possession and use
of the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how
the transaction is characterized), the Corresponding Source conveyed under this sectionmust be
accompanied by the Installation Information. But this requirement does not apply if neither you nor
any third party retains the ability to install modified object code on the User Product (for example, the
work has been installed in ROM).
The requirement to provide Installation Information does not include a requirement to continue to
provide support service, warranty, or updates for a work that has beenmodified or installed by the
recipient, or for the User Product in which it has beenmodified or installed. Access to a networkmay
be denied when themodification itself materially and adversely affects the operation of the network
or violates the rules and protocols for communication across the network.
Corresponding Source conveyed, and Installation Information provided, in accord with this section
must be in a format that is publicly documented (and with an implementation available to the public in
source code form), andmust require no special password or key for unpacking, reading or copying.
7. Additional Terms.
“Additional permissions” are terms that supplement the terms of this License bymaking exceptions
from one or more of its conditions. Additional permissions that are applicable to the entire Program
shall be treated as though theywere included in this License, to the extent that they are valid under
applicable law. If additional permissions apply only to part of the Program, that part may be used
separately under those permissions, but the entire Program remains governed by this License
without regard to the additional permissions.
When you convey a copy of a covered work, youmay at your option remove any additional
permissions from that copy, or from any part of it. (Additional permissionsmay be written to require
their own removal in certain caseswhen youmodify the work.) Youmay place additional
permissions onmaterial, added by you to a covered work, for which you have or can give appropriate
copyright permission.
Notwithstanding any other provision of this License, for material you add to a covered work, youmay
(if authorized by the copyright holders of that material) supplement the terms of this License with
terms:

a. Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of
this License; or

b. Requiring preservation of specified reasonable legal notices or author attributions in that
material or in the Appropriate Legal Notices displayed byworks containing it; or

c. Prohibitingmisrepresentation of the origin of that material, or requiring that modified
versions of suchmaterial bemarked in reasonable ways as different from the original
version; or

d. Limiting the use for publicity purposes of names of licensors or authors of thematerial; or
e. Declining to grant rights under trademark law for use of some trade names, trademarks, or

servicemarks; or
f. Requiring indemnification of licensors and authors of that material by anyone who conveys

thematerial (or modified versions of it) with contractual assumptions of liability to the
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recipient, for any liability that these contractual assumptions directly impose on those
licensors and authors.

All other non-permissive additional terms are considered “further restrictions” within themeaning of
section 10. If the Program as you received it, or any part of it, contains a notice stating that it is
governed by this License along with a term that is a further restriction, youmay remove that term. If a
license document contains a further restriction but permits relicensing or conveying under this
License, youmay add to a covered workmaterial governed by the terms of that license document,
provided that the further restriction does not survive such relicensing or conveying.
If you add terms to a covered work in accord with this section, youmust place, in the relevant source
files, a statement of the additional terms that apply to those files, or a notice indicating where to find
the applicable terms.
Additional terms, permissive or non-permissive, may be stated in the form of a separately written
license, or stated as exceptions; the above requirements apply either way.
8. Termination.
Youmay not propagate or modify a covered work except as expressly provided under this License.
Any attempt otherwise to propagate or modify it is void, and will automatically terminate your rights
under this License (including any patent licenses granted under the third paragraph of section 11).
However, if you cease all violation of this License, then your license from a particular copyright holder
is reinstated (a) provisionally, unless and until the copyright holder explicitly and finally terminates
your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some
reasonablemeans prior to 60 days after the cessation.
Moreover, your license from a particular copyright holder is reinstated permanently if the copyright
holder notifies you of the violation by some reasonablemeans, this is the first time you have received
notice of violation of this License (for anywork) from that copyright holder, and you cure the violation
prior to 30 days after your receipt of the notice.
Termination of your rights under this section does not terminate the licenses of parties who have
received copies or rights from you under this License. If your rights have been terminated and not
permanently reinstated, you do not qualify to receive new licenses for the samematerial under
section 10.
9. Acceptance Not Required for Having Copies.
You are not required to accept this License in order to receive or run a copy of the Program. Ancillary
propagation of a covered work occurring solely as a consequence of using peer-to-peer
transmission to receive a copy likewise does not require acceptance. However, nothing other than
this License grants you permission to propagate or modify any covered work. These actions infringe
copyright if you do not accept this License. Therefore, bymodifying or propagating a covered work,
you indicate your acceptance of this License to do so.
10. Automatic Licensing of Downstream Recipients.
Each time you convey a covered work, the recipient automatically receives a license from the original
licensors, to run, modify and propagate that work, subject to this License. You are not responsible for
enforcing compliance by third parties with this License.
An “entity transaction” is a transaction transferring control of an organization, or substantially all
assets of one, or subdividing an organization, or merging organizations. If propagation of a covered
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work results from an entity transaction, each party to that transaction who receives a copy of the
work also receiveswhatever licenses to the work the party's predecessor in interest had or could
give under the previous paragraph, plus a right to possession of the Corresponding Source of the
work from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.
Youmay not impose any further restrictions on the exercise of the rights granted or affirmed under
this License. For example, youmay not impose a license fee, royalty, or other charge for exercise of
rights granted under this License, and youmay not initiate litigation (including a cross-claim or
counterclaim in a lawsuit) alleging that any patent claim is infringed bymaking, using, selling, offering
for sale, or importing the Program or any portion of it.
11. Patents.
A “contributor” is a copyright holder who authorizes use under this License of the Program or a work
on which the Program is based. The work thus licensed is called the contributor's “contributor
version”.
A contributor's “essential patent claims” are all patent claims owned or controlled by the contributor,
whether already acquired or hereafter acquired, that would be infringed by somemanner, permitted
by this License, of making, using, or selling its contributor version, but do not include claims that
would be infringed only as a consequence of further modification of the contributor version. For
purposes of this definition, “control” includes the right to grant patent sublicenses in amanner
consistent with the requirements of this License.
Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the
contributor's essential patent claims, to make, use, sell, offer for sale, import and otherwise run,
modify and propagate the contents of its contributor version.
In the following three paragraphs, a “patent license” is any express agreement or commitment,
however denominated, not to enforce a patent (such as an express permission to practice a patent
or covenant not to sue for patent infringement). To “grant” such a patent license to a partymeans to
make such an agreement or commitment not to enforce a patent against the party.
If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source
of the work is not available for anyone to copy, free of charge and under the terms of this License,
through a publicly available network server or other readily accessible means, then youmust either
(1) cause the Corresponding Source to be so available, or (2) arrange to deprive yourself of the
benefit of the patent license for this particular work, or (3) arrange, in amanner consistent with the
requirements of this License, to extend the patent license to downstream recipients. “Knowingly
relying” means you have actual knowledge that, but for the patent license, your conveying the
covered work in a country, or your recipient's use of the covered work in a country, would infringe
one or more identifiable patents in that country that you have reason to believe are valid.
If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate
by procuring conveyance of, a covered work, and grant a patent license to some of the parties
receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of
the covered work, then the patent license you grant is automatically extended to all recipients of the
covered work and works based on it.
A patent license is “discriminatory” if it does not include within the scope of its coverage, prohibits the
exercise of, or is conditioned on the non-exercise of one or more of the rights that are specifically
granted under this License. Youmay not convey a covered work if you are a party to an arrangement
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with a third party that is in the business of distributing software, under which youmake payment to
the third party based on the extent of your activity of conveying the work, and under which the third
party grants, to any of the parties who would receive the covered work from you, a discriminatory
patent license (a) in connection with copies of the covered work conveyed by you (or copiesmade
from those copies), or (b) primarily for and in connection with specific products or compilations that
contain the covered work, unless you entered into that arrangement, or that patent license was
granted, prior to 28March 2007.
Nothing in this License shall be construed as excluding or limiting any implied license or other
defenses to infringement that may otherwise be available to you under applicable patent law.
12. No Surrender of Others' Freedom.
If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict
the conditions of this License, they do not excuse you from the conditions of this License. If you
cannot convey a covered work so as to satisfy simultaneously your obligations under this License
and any other pertinent obligations, then as a consequence youmay not convey it at all. For
example, if you agree to terms that obligate you to collect a royalty for further conveying from those to
whom you convey the Program, the only way you could satisfy both those terms and this License
would be to refrain entirely from conveying the Program.
13. Use with the GNU Affero General Public License.
Notwithstanding any other provision of this License, you have permission to link or combine any
covered work with a work licensed under version 3 of the GNU Affero General Public License into a
single combined work, and to convey the resulting work. The terms of this License will continue to
apply to the part which is the covered work, but the special requirements of the GNU Affero General
Public License, section 13, concerning interaction through a network will apply to the combination as
such.
14. Revised Versions of this License.
The Free Software Foundationmay publish revised and/or new versions of the GNU General Public
License from time to time. Such new versionswill be similar in spirit to the present version, but may
differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies that a certain
numbered version of the GNU General Public License “or any later version” applies to it, you have
the option of following the terms and conditions either of that numbered version or of any later
version published by the Free Software Foundation. If the Program does not specify a version
number of the GNU General Public License, youmay choose any version ever published by the Free
Software Foundation.
If the Program specifies that a proxy can decide which future versions of the GNU General Public
License can be used, that proxy's public statement of acceptance of a version permanently
authorizes you to choose that version for the Program.
Later license versionsmay give you additional or different permissions. However, no additional
obligations are imposed on any author or copyright holder as a result of your choosing to follow a
later version.
15. Disclaimer of Warranty.
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THERE IS NOWARRANTY FOR THE PROGRAM, TOTHE EXTENT PERMITTED BY
APPLICABLE LAW. EXCEPTWHEN OTHERWISE STATED IN WRITINGTHE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM “AS IS” WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIEDWARRANTIES OFMERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. THE ENTIRE RISK AS TOTHE QUALITY AND PERFORMANCE
OF THE PROGRAM ISWITH YOU. SHOULD THE PROGRAMPROVE DEFECTIVE, YOU
ASSUME THE COSTOF ALLNECESSARY SERVICING, REPAIR OR CORRECTION.
16. Limitation of Liability.
IN NOEVENT UNLESS REQUIRED BY APPLICABLE LAWOR AGREED TO INWRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTYWHOMODIFIES AND/OR
CONVEYS THE PROGRAMAS PERMITTED ABOVE, BE LIABLE TOYOU FOR DAMAGES,
INCLUDINGANY GENERAL, SPECIAL, INCIDENTALOR CONSEQUENTIALDAMAGES
ARISINGOUTOF THE USE OR INABILITY TOUSE THE PROGRAM (INCLUDINGBUT NOT
LIMITED TOLOSS OFDATA OR DATA BEINGRENDERED INACCURATE OR LOSSES
SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAMTOOPERATE
WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
17. Interpretation of Sections 15 and 16.
If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect
according to their terms, reviewing courts shall apply local law that most closely approximates an
absolute waiver of all civil liability in connection with the Program, unless a warranty or assumption of
liability accompanies a copy of the Program in return for a fee.
END OF TERMS AND CONDITIONS
VERSION 2
GNU GENERALPUBLIC LICENSE
Version 2, June 1991
Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301, USA
Everyone is permitted to copy and distribute verbatim copies of this license document, but changing
it is not allowed.
Preamble
The licenses for most software are designed to take away your freedom to share and change it. By
contrast, the GNU General Public License is intended to guarantee your freedom to share and
change free software--to make sure the software is free for all its users. ThisGeneral Public License
applies tomost of the Free Software Foundation's software and to any other programwhose
authors commit to using it. (Some other Free Software Foundation software is covered by theGNU
LibraryGeneral Public License instead.) You can apply it to your programs, too.
Whenwe speak of free software, we are referring to freedom, not price. Our General Public
Licenses are designed tomake sure that you have the freedom to distribute copies of free software
(and charge for this service if you wish), that you receive source code or can get it if you want it, that
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you can change the software or use pieces of it in new free programs; and that you know you can do
these things.
To protect your rights, we need tomake restrictions that forbid anyone to deny you these rights or to
ask you to surrender the rights. These restrictions translate to certain responsibilities for you if you
distribute copies of the software, or if youmodify it.
For example, if you distribute copies of such a program, whether gratis or for a fee, youmust give the
recipients all the rights that you have. Youmust make sure that they, too, receive or can get the
source code. And youmust show them these terms so they know their rights.
We protect your rights with two steps:
(1) copyright the software, and
(2) offer you this license which gives you legal permission to copy, distribute and/or modify the
software.
Also, for each author's protection and ours, we want to make certain that everyone understands that
there is no warranty for this free software. If the software ismodified by someone else and passed
on, we want its recipients to know that what they have is not the original, so that any problems
introduced by others will not reflect on the original authors' reputations.
Finally, any free program is threatened constantly by software patents. Wewish to avoid the danger
that redistributors of a free programwill individually obtain patent licenses, in effect making the
program proprietary. To prevent this, we havemade it clear that any patent must be licensed for
everyone's free use or not licensed at all.
The precise terms and conditions for copying, distribution andmodification follow.
GNU GENERALPUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING,
DISTRIBUTION AND MODIFICATION
0. This License applies to any program or other work which contains a notice placed by the copyright
holder saying it may be distributed under the terms of this General Public License. The "Program",
below, refers to any such program or work, and a "work based on the Program"means either the
Program or any derivative work under copyright law: that is to say, a work containing the Program or
a portion of it, either verbatim or with modifications and/or translated into another language.
(Hereinafter, translation is included without limitation in the term "modification".) Each licensee is
addressed as "you".
Activities other than copying, distribution andmodification are not covered by this License; they are
outside its scope. The act of running the Program is not restricted, and the output from the Program
is covered only if its contents constitute a work based on the Program (independent of having been
made by running the Program).Whether that is true depends on what the Program does.
1. Youmay copy and distribute verbatim copies of the Program's source code as you receive it, in
anymedium, provided that you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer to this
License and to the absence of anywarranty; and give any other recipients of the Program a copy of
this License along with the Program.
Youmay charge a fee for the physical act of transferring a copy, and youmay at your option offer
warranty protection in exchange for a fee.
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2. Youmaymodify your copy or copies of the Program or any portion of it, thus forming a work based
on the Program, and copy and distribute suchmodifications or work under the terms of Section 1
above, provided that you alsomeet all of these conditions:
a) Youmust cause themodified files to carry prominent notices stating that you changed the files and
the date of any change.
b) Youmust cause anywork that you distribute or publish, that in whole or in part contains or is
derived from the Program or any part thereof, to be licensed as a whole at no charge to all third
parties under the terms of this License.
c) If themodified program normally reads commands interactively when run, youmust cause it,
when started running for such interactive use in themost ordinary way, to print or display an
announcement including an appropriate copyright notice and a notice that there is no warranty (or
else, saying that you provide a warranty) and that usersmay redistribute the program under these
conditions, and telling the user how to view a copy of this License. (Exception: if the Program itself is
interactive but does not normally print such an announcement, your work based on the Program is
not required to print an announcement.)
These requirements apply to themodified work as a whole. If identifiable sections of that work are
not derived from the Program, and can be reasonably considered independent and separate works
in themselves, then this License, and its terms, do not apply to those sectionswhen you distribute
them as separate works. But when you distribute the same sections as part of a whole which is a
work based on the Program, the distribution of the wholemust be on the terms of this License,
whose permissions for other licensees extend to the entire whole, and thus to each and every part
regardless of who wrote it.
Thus, it is not the intent of this section to claim rights or contest your rights to work written entirely by
you; rather, the intent is to exercise the right to control the distribution of derivative or collective works
based on the Program.
In addition, mere aggregation of another work not based on the Programwith the Program (or with a
work based on the Program) on a volume of a storage or distributionmedium does not bring the
other work under the scope of this License.
3. Youmay copy and distribute the Program (or a work based on it, under Section 2) in object code
or executable form under the terms of Sections 1 and 2 above provided that you also do one of the
following:
a) Accompany it with the complete correspondingmachine-readable source code, whichmust be
distributed under the terms of Sections 1 and 2 above on amedium customarily used for software
interchange; or,
b) Accompany it with a written offer, valid for at least three years, to give any third party, for a charge
nomore than your cost of physically performing source distribution, a completemachine-readable
copy of the corresponding source code, to be distributed under the terms of Sections 1 and 2 above
on amedium customarily used for software interchange; or,
c) Accompany it with the information you received as to the offer to distribute corresponding source
code. (This alternative is allowed only for noncommercial distribution and only if you received the
program in object code or executable formwith such an offer, in accord with Subsection b above.)
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The source code for a workmeans the preferred form of the work for makingmodifications to it. For
an executable work, complete source codemeans all the source code for all modules it contains,
plus any associated interface definition files, plus the scripts used to control compilation and
installation of the executable. However, as a special exception, the source code distributed need not
include anything that is normally distributed (in either source or binary form) with themajor
components (compiler, kernel, and so on) of the operating system onwhich the executable runs,
unless that component itself accompanies the executable.
If distribution of executable or object code ismade by offering access to copy from a designated
place, then offering equivalent access to copy the source code from the same place counts as
distribution of the source code, even though third parties are not compelled to copy the source along
with the object code.
4. Youmay not copy, modify, sublicense, or distribute the Program except as expressly provided
under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program is
void, and will automatically terminate your rights under this License. However, parties who have
received copies, or rights, from you under this License will not have their licenses terminated so long
as such parties remain in full compliance.
5. You are not required to accept this License, since you have not signed it. However, nothing else
grants you permission tomodify or distribute the Program or its derivative works. These actions are
prohibited by law if you do not accept this License. Therefore, bymodifying or distributing the
Program (or anywork based on the Program), you indicate your acceptance of this License to do so,
and all its terms and conditions for copying, distributing or modifying the Program or works based on
it.
6. Each time you redistribute the Program (or anywork based on the Program), the recipient
automatically receives a license from the original licensor to copy, distribute or modify the Program
subject to these terms and conditions. Youmay not impose any further restrictions on the recipients'
exercise of the rights granted herein. You are not responsible for enforcing compliance by third
parties to this License.
7. If, as a consequence of a court judgment or allegation of patent infringement or for any other
reason (not limited to patent issues), conditions are imposed on you (whether by court order,
agreement or otherwise) that contradict the conditions of this License, they do not excuse you from
the conditions of this License. If you cannot distribute so as to satisfy simultaneously your obligations
under this License and any other pertinent obligations, then as a consequence youmay not distribute
the Program at all. For example, if a patent license would not permit royalty-free redistribution of the
Program by all those who receive copies directly or indirectly through you, then the only way you
could satisfy both it and this License would be to refrain entirely from distribution of the Program.
If any portion of this section is held invalid or unenforceable under any particular circumstance, the
balance of the section is intended to apply and the section as a whole is intended to apply in other
circumstances.
It is not the purpose of this section to induce you to infringe any patents or other property right claims
or to contest validity of any such claims; this section has the sole purpose of protecting the integrity of
the free software distribution system, which is implemented by public license practices. Many people
havemade generous contributions to the wide range of software distributed through that system in
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reliance on consistent application of that system; it is up to the author/donor to decide if he or she is
willing to distribute software through any other system and a licensee cannot impose that choice.
This section is intended tomake thoroughly clear what is believed to be a consequence of the rest of
this License.
8. If the distribution and/or use of the Program is restricted in certain countries either by patents or by
copyrighted interfaces, the original copyright holder who places the Program under this Licensemay
add an explicit geographical distribution limitation excluding those countries, so that distribution is
permitted only in or among countries not thus excluded. In such case, this License incorporates the
limitation as if written in the body of this License.
9. The Free Software Foundationmay publish revised and/or new versions of the General Public
License from time to time. Such new versionswill be similar in spirit to the present version, but may
differ in detail to address new problems or concerns.
Each version is given a distinguishing version number. If the Program specifies a version number of
this License which applies to it and "any later version", you have the option of following the terms and
conditions either of that version or of any later version published by the Free Software Foundation. If
the Program does not specify a version number of this License, youmay choose any version ever
published by the Free Software Foundation.
10. If you wish to incorporate parts of the Program into other free programswhose distribution
conditions are different, write to the author to ask for permission. For software which is copyrighted
by the Free Software Foundation, write to the Free Software Foundation; we sometimesmake
exceptions for this. Our decision will be guided by the two goals of preserving the free status of all
derivatives of our free software and of promoting the sharing and reuse of software generally.
NOWARRANTY
11. BECAUSE THE PROGRAM IS LICENSED FREE OFCHARGE, THERE IS NOWARRANTY
FOR THE PROGRAM, TOTHE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPTWHEN
OTHERWISE STATED IN WRITINGTHE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
PROVIDE THE PROGRAM "AS IS"WITHOUTWARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIEDWARRANTIES
OFMERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK
AS TOTHE QUALITY AND PERFORMANCEOF THE PROGRAM ISWITH YOU. SHOULD
THE PROGRAMPROVE DEFECTIVE, YOU ASSUME THE COSTOF ALLNECESSARY
SERVICING, REPAIR OR CORRECTION.
12. IN NOEVENT UNLESS REQUIRED BY APPLICABLE LAWOR AGREED TO INWRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTYWHOMAYMODIFY AND/OR
REDISTRIBUTE THE PROGRAMAS PERMITTED ABOVE, BE LIABLE TOYOU FOR
DAMAGES, INCLUDINGANY GENERAL, SPECIAL, INCIDENTALOR CONSEQUENTIAL
DAMAGES ARISINGOUTOF THE USE OR INABILITY TOUSE THE PROGRAM (INCLUDING
BUT NOT LIMITED TOLOSS OFDATA OR DATA BEINGRENDERED INACCURATE OR
LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAMTO
OPERATEWITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
END OF TERMS AND CONDITIONS
Section 4 - 3rd Party Components
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(1) The Software Program includes software and documentation components developed in part by
Silver Egg Technology, Inc. ("SET") prior to 2001. All SET components were released under the
following license.
Copyright (c) 2001 Silver Egg Technology
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, sub-license, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to
the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial
portions of the Software.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUTWARRANTY OF ANY KIND, EXPRESS
OR IMPLIED, INCLUDINGBUT NOT LIMITED TOTHEWARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT.
IN NOEVENT SHALL THE AUTHORSOR COPYRIGHT HOLDERS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY,WHETHER IN AN ACTION OFCONTRACT, TORT
OR OTHERWISE, ARISINGFROM, OUTOFOR IN CONNECTIONWITH THE SOFTWAREOR
THE USE OR OTHER DEALINGS IN THE SOFTWARE.
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2 -Welcome to Maxwell Online Help

Use the following links for quick information on the following topics.

Use the following links for Maxwell Process Flow topics:

User Interface Quick Links
Use the following links for quick information on the following topics.

TheMaxwell Desktop Customize Toolbar Options
General Purpose Keyboard Shortcuts for
Maxwell

RunningMaxwell From aCommand
Line

Maxwell Online Help
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For detailed information on these andmany other topics:
l Use F1 on any open dialog to open theOnline Help for that dialog.
l Click the "?" icon on the toolbar, and then click on anymenu command, icon, or window for
help on that selection.

l With the Online HelpContents tab selected, navigate the help topic hierarchy.
l With the Online Help Index tab selected, search the help index.
l With the Online Help Search tab selected, search the full help text.
l With Online Help Favorites tab selected, create a custom list of favorite topics.

Modeling Quick Links
Use the following links for quick information on the following topics.

Set themodel’s units of measurement. SettingModeler DrawingOptions
Assign transparency to an object. Selecting Items in theModeler

Window
Subtract objects. DrawingObjects
Measuring Objects Choosing the Cursor Movement

Mode
Drawing Bondwires Importing Files
Keyboard shortcuts for the 3D Modeler
Window.

Modifying Objects

Modifying theModel View

For detailed information on these andmany other topics:
l Use F1 on any open dialog to open theOnline Help for that dialog.
l Click the "?" icon on the toolbar, and then click on anymenu command, icon, or window for
help on that selection.

l With the Online HelpContents tab selected, navigate the help topic hierarchy.
l With the Online Help Index tab selected, search the help index.
l With the Online Help Search tab selected, search the full help text.
l With Online Help Favorites tab selected, create a custom list of favorite topics.

Boundaries/Excitations Quick Links
Use the following links for quick information on the following topics.

Defining Boundary Conditions Defining Excitations
Setting Eddy Effects and Displacement
Current

Setting Core Loss
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Setting UpMotion for Transient Projects Functional Boundaries and
Excitations

Defining Boundary Conditions in 2D Defining 2D Excitations

For detailed information on these andmany other topics:
l Use F1 on any open dialog to open theOnline Help for that dialog.
l Click the "?" icon on the toolbar, and then click on anymenu command, icon, or window for
help on that selection.

l With the Online HelpContents tab selected, navigate the help topic hierarchy.
l With the Online Help Index tab selected, search the help index.
l With the Online Help Search tab selected, search the full help text.
l With Online Help Favorites tab selected, create a custom list of favorite topics.

Meshing Quick Links
Use the following links for quick information on the following topics.

DefiningMeshOperations Plot the finite element mesh
Detecting and Addressing
Model
Problems to ImproveMeshing

Handling Complicated
Models

For detailed information on these andmany other topics:
l Use F1 on any open dialog to open theOnline Help for that dialog.
l Click the "?" icon on the toolbar, and then click on anymenu command, icon, or window for
help on that selection.

l With the Online HelpContents tab selected, navigate the help topic hierarchy.
l With the Online Help Index tab selected, search the help index.
l With the Online Help Search tab selected, search the full help text.
l With Online Help Favorites tab selected, create a custom list of favorite topics.

Analysis Quick Links
Use the following links for quick information on the following topics.

Specifying the Analysis Options Remote Analysis
Configuring Distributed Analysis Specifying Solution Settings
Selecting anOptimal Configuration for Distributed
Analysis

Setting Adaptive Analysis
Parameters

For detailed information on these andmany other topics:
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l Use F1 on any open dialog to open theOnline Help for that dialog.
l Click the "?" icon on the toolbar, and then click on anymenu command, icon, or window for
help on that selection.

l With the Online HelpContents tab selected, navigate the help topic hierarchy.
l With the Online Help Index tab selected, search the help index.
l With the Online Help Search tab selected, search the full help text.
l With Online Help Favorites tab selected, create a custom list of favorite topics.

Optimetrics Quick Links
Use the following links for quick information on the following topics.

Setting up a Parametric Analysis Setting up anOptimization
Analysis

Setting up a Sensitivity Analysis Tuning a Variable
Setting up a Statistical Analysis Setting a Range function
Setup Calculations for
Optimetrics

Adding a cost function

For detailed information on these andmany other topics:
l Use F1 on any open dialog to open theOnline Help for that dialog.
l Click the "?" icon on the toolbar, and then click on anymenu command, icon, or window for
help on that selection.

l With the Online HelpContents tab selected, navigate the help topic hierarchy.
l With the Online Help Index tab selected, search the help index.
l With the Online Help Search tab selected, search the full help text.
l With Online Help Favorites tab selected, create a custom list of favorite topics.

Results Quick Links
Use the following links for quick information on the following topics.

View solution data Creating Reports
Plot field overlay Working with Traces
Plot the finite element
mesh

Adding DataMarkers to Traces

Create animations Creating aQuick Report
Specifying Output
Variables

Dynamically Updating Reports During
Solution

Using the Fields Calculator
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For detailed information on these andmany other topics:
l Use F1 on any open dialog to open theOnline Help for that dialog.
l Click the "?" icon on the toolbar, and then click on anymenu command, icon, or window for
help on that selection.

l With the Online HelpContents tab selected, navigate the help topic hierarchy.
l With the Online Help Index tab selected, search the help index.
l With the Online Help Search tab selected, search the full help text.
l With Online Help Favorites tab selected, create a custom list of favorite topics.

Scripting Quick Links
Use the following links for quick information on the following topics.

Recording a Script Running a script
Stopping Script
Recording

Pausing and Resuming a
Script

Stopping a Script

For detailed information on these andmany other topics:
l Use F1 on any open dialog to open theOnline Help for that dialog.
l Click the "?" icon on the toolbar, and then click on anymenu command, icon, or window for
help on that selection.

l With the Online HelpContents tab selected, navigate the help topic hierarchy.
l With the Online Help Index tab selected, search the help index.
l With the Online Help Search tab selected, search the full help text.
l With Online Help Favorites tab selected, create a custom list of favorite topics.
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3 - Getting Started with Maxwell and RMxprt
Maxwell is an interactive software package that uses finite element analysis (FEA) to solve three-
dimensional (3D) electrostatic, magnetostatic, eddy current, and transient problems.
UsingMaxwell you can compute:

l Static electric fields, forces, torques, and capacitances caused by voltage distributions and
charges.

l Staticmagnetic fields, forces, torques, and inductances caused byDC currents, static external
magnetic fields, and permanent magnets.

l Time-varyingmagnetic fields, forces, torques, and impedances caused by AC currents and
oscillating external magnetic fields.

l Transient magnetic fields caused by electrical sources and permanent magnets.
RMxprt™ is an interactive software package used for designing and analyzing electrical machines.
Maxwell and Rmxprt are integrated into the ANSYS Electronics Desktop.

Related Topics

Working with Maxwell Projects and Designs
Setting Up aMaxwell Design
Getting Started with RMxprt
Quick Start for RMxprt
Using theMaxwell Circuit Editor

Welcome to ANSYS Electronics Desktop
The ANSYS Electronics Desktop, illustrated in the following figure, provides a comprehensive
environment for designing and simulating various electronic components and devices. The ANSYS
Electronics Desktop consists of a unified user interface where both electromagnetic designs and
circuits can be created. Typically, you can create or import a design, set up the simulation, validate
your design, run the analysis, and post process the results.

Maxwell Online Help
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The desktop has the following design types and features:
l HFSS Design - a general purpose 3D interface for the design, analysis, and simulation of
electromagnetic components.

l HFSS 3D Layout Design - a full-wave layout-based electromagnetic simulator with a
specialized interface for geometries created in layout.

l HFSS-IE Design - a full wave Integral Equation solver for large open problems.
l Q3D Extractor Design - a quasi-static 3D solver for extracting lumpedRLGC parameters and
Spicemodels.

l 2D Extractor Design - a 2D solver for extracting per-unit-length RLGC parameters of
transmission lines.

l Circuit Design - a schematic-based interface to the Nexxim circuit simulator.
l Circuit Netlist - a netlist (text-based) interface to the Nexxim circuit simulator.
l Maxwell 3D Design - uses finite element analysis (FEA) to solve three-dimensional (3D)
electrostatic, magnetostatic, eddy current, and transient problems.

l Maxwell 2D Design - uses finite element analysis (FEA) to solve two-dimensional (2D)
electrostatic, magnetostatic, eddy current, and transient problems.

l RMxprt Design - a template-based electrical machine design tool that provides fast, analytical
calculations of machine performance and 2-D and 3-D geometry creation for detailed finite
element calculations in ANSYS®Maxwell®.

l Maxwell Circuit Design - sets up external circuit designs to supply excitations to coil terminals
for Maxwell 2D and 3D EddyCurrent and Transient designs.

l Simplorer Design - an integrated, multi-domain, mixed-signal simulator for complex technical
systems.
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l Filter Design - a schematic-based design for creating filters for high frequencyRF and
microwave applications.

l Launch Savant - a tool for simulating near-field, far-field, and coupling performance of
antennas installed on platforms and within other complex and electrically large environments.

l Launch EMIT - a simulation tool for the prediction of radio frequency interference (RFI) in
complex environments.

If you go to theProject menu, you can access all of the design types. Any combination of these
design types can be inserted into a single project file. The schematics can be used to wire up the
different field solver models and create amodel of a high-level system. The ANSYS Electronics
Desktop provides an efficient way tomanage complicated projects that require several different
analysis tools to model all of its pieces. Designs can also be parameterized.With the help of the
Optimetrics feature the best design variations can bemade available to other moduleswhen the
designs are linked into a higher level simulation. This lets you study the effect of varying a design
parameter on the behavior of the entire system.

Related Topics

"Launching ANSYS Electronics Desktop" below

Launching ANSYS Electronics Desktop

After you have installed ANSYS Electronics Desktop, start the program by one of the following
methods:
Maxwell contains the followingmenus, which appear at the top of the desktop:

l Double-click theANSYS Electronics Desktop icon on your desktop.
l ClickANSYS Electronics Desktop on theWindowsStart menu.
l ClickStart>All Programs>ANSYS Electromagnetics>ANSYS Electromagnetics Suite
18.0>ANSYS Electronics Desktop 2017.0 on theWindowsStart menu.

Related Topics

"Welcome to ANSYS Electronics Desktop" on page 3-1

System Requirements
Maxwell supports certain versions ofWindows and Linux. For supported platforms and system
requirements, go to:
http://www.ansys.com/Solutions/Solutions-by-Role/IT-Professionals/Platform-Support
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The Maxwell Desktop UI
TheMaxwell desktop consists of several windows, amenu bar, toolbars, and a status bar. You can
openmultiple windows inMaxwell to display different parts of themodel. For instance, one window
can remain fixed on the winding, one on the diagram, and one on themain desktop window. To open
a new window, clickWindow>NewWindow. Tomove back and forth between windows, select the
Windowsmenu, and select the window you want to view.

Click a link below to view more information about that desktop component.

Menu Bar MessageManager
Toolbars ProgressWindow
Project Manager Modeler Window
Property
Window

History Tree
Window

Status Bar

Working with the Menu Bar

Themenu bar enables you to perform all Maxwell tasks, such asmanaging project files, customizing
the desktop, drawing objects, and setting andmodifying all project parameters.
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Maxwell contains the followingmenus, which appear at the top of the desktop:

File menu Use the Filemenu commands tomanageMaxwell project files and printing options.
Edit menu Use theEditmenu commands tomodify the objects in the activemodel and undo and

redo actions.
View menu Use theViewmenu commands to display or hide desktop components andmodel

objects, modify 2D and 3D Modeler window visual settings, andmodify themodel
view. TheWizards command opens theWizardswindow which lets you work with
ACT integration tools.

Project
menu

Use theProjectmenu commands to add aMaxwell or RMxprt design to the active
project, define datasets, and define project variables.

Draw
menu

Use theDrawmenu to draw the elements that make up amodel.

Modeler
menu

Use theModelermenu commands to import, export, and copy 2D Modeler files and
3D Modeler files; assignmaterials to objects; manage the 3D Modeler window’s grid
settings; define a list of objects or faces of objects; control surface settings; perform
boolean operations on objects; and set the units for the active design.

Maxwell3D,
Maxwell2D,
or RMxprt
menu

Use thesemenu commands to change solution type, assign boundaries and
excitations, set up parameters, add analysis setups, set up Optimetrics, post process
solutions, export equivalent circuits, define datasets, and other design tasks.

Tools
menu

Use the Toolsmenu tomodify the active project'smaterial library, arrange the
material libraries, run and record scripts, update project definitions from libraries,
display options, customize the desktop's toolbars, andmodifymany of the software's
default settings.

Window
menu

Use theWindowmenu commands to rearrange the Modeler windows and toolbar
icons.

Help menu Use theHelpmenu commands to access the online help system and view the current
Maxwell version information.

Related Topics

Getting Help

Working with Windows

TheWindowmenu allows you tomanage the currently open windows in theMaxwellDesktop user
environment.
In addition to the standard functions listed in the table, themenu also contains a list of currently open
windows for easily switching between them. This is important in multiple window environments
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where the desktopmake become crowded with open windows and somemay be partially or
completely obscured. Minimized windows are automatically opened when selected in this list.

Command Description
New Window Open a new window. New windows shows themodel by default.

Cascade Arranges all non-minimized windows in a cascade with the window title bar
visible.

Tile
Horizontally

Arranges all non-minimized windows to use themaximumhorizontal size of the
desktop.

Tile Vertically Arranges all non-minimized windows to use themaximum vertical size of the
desktop.

Arrange Icons Arranges the icons of anyminimized windows along the bottom of the Desktop.
Close All Close All currently open desktop windows.

Moving and Resizing Desktop Windows

You can customize the appearance of the desktop bymoving and resizing the Status Bar, the
MessageManager, the Project Manager, the docked Properties window, and the Progresswindow.
Tomove one of these windows:

1. Click and hold on the title bar.
2. Drag the cursor towards the region where you want to place the window.

A rectangle shape follows the cursor. As you drag the rectangle to different parts of the
desktop, the changes in dimension show when you have reached a location where you can
place the window. This can be at the top, left, bottom, and side of themodeler window. You
can place a window next to another, as well as above or below another.
If you drag the window to the center of the 3D Modeler window, you can place it there as a
floating window.

3. Release themouse button to place the window.
You can also resize the windows in two ways.

l To size a desktop window, place the cursor over an edge of the window. Over the inner-
edges, for sizing a window within the desktop, the cursor changes to a double bar with arrows
pointing each direction. Over the outer-edges, for sizing the desktop, the cursor changes to a
line with arrows pointing each direction. Press and drag to size the window.

l To expand a window to fill the horizontal or vertical space it shareswith another window, click
the triangle in the window title bar. When you expand a window, the triangle appears as
inverted and any other windows in the same horizontal or vertical space are compressed to
only the title bar. If a window does not share a horizontal or vertical space with another, the
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triangle does not appear.

Window Layouts

You can create and save specific window layouts for rhe desktop and apply themwhen needed. For
example, you can create a layout that shows a large component window. There are options to apply
a saved layout, restore the default window layout, and remove saved layouts.
To save a wndow layout:

1. On theViewmenu, clickWindow Layouts>Save Current Layout.
2. Enter the layout name in the Layout Name dialog, and clickOK. The layout is saved and

added to the list of layouts on theWindow Layouts submenu.
To apply a saved layout:

1. On theViewmenu, clickWindow Layouts and select from the listed saved layouts.
To restore the default window layout:

1. On theViewmenu, clickWindow Layouts>Default.
To remove window layouts:

1. On theViewmenu, clickWindow Layouts>Remove Saved Layouts.
2. In theModify Layouts dialog, select one or more layouts and clickDelete, or clickDelete

All.

Working with the Toolbars

The toolbar buttons and shortcut pull-down lists act as shortcuts for executing various commands.
To execute a command, click a toolbar button or click a selection on the shortcut pull-down list.
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To open a help topic about a toolbar button’s functionality, pressShift+F1, and then click the toolbar
button or a command in the shortcut pull-down list.
To display a brief description of the toolbar button, move the pointer over the button or shortcut pull-
down list.

Hint Tomodify the toolbars on the desktop, do one of the following:
l On the Toolsmenu, clickCustomize.
l Right-click the history tree, and then clickCustomize on the shortcut menu.

To reset to toolbars to the default positions and settings:
l On the Toolsmenu, clickCustomize. On theCustomize dialog box, click
ResetAll.

Related Topics

Customize Toolbar Options
Customize Toolbar Commands

Customizing Toolbars

To customize the Toolbar displays by using the toolbar list:
1. Select Tools>Customize.

This displays theCustomize dialog with the Toolbars tab selected. The field lists the
available toolbars, with those currently selected being checked. To the right of the field are
three buttons:
New... -- launches the New Toolbar dialog that lets you specify a new toolbar name.
Reset -- This resets the toolbar display to apply your current selections.
Reset All -- this resets the toolbar display tomatch the original defaults.

2. Check the buttons to add additional toolbars to the desktop.
New toolbar icons are added to new rows as you click them. You can drag these to convenient
locations.

3. Uncheck any buttons to remove toolbar icons.
4. Use theOK button to close the dialog, or theCancel button to close without making changes.

Related Topics

Working with Toolbars
Customize Toolbar Commands

Customize Toolbar Commands

To customize the Toolbar by dragging icons:
1. Select Tools>Customize.
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This displays theCustomize dialog with theCommands tab selected. The Categories field
lists the available toolbars. The icons for the currently selected toolbar are shown to the right of
the field.

2. Select from the Categories list to display the icons you want to add to the toolbar.
3. Drag the icons from the Customize dialog to a location on the desktop toolbar.
4. Use theOK button to close the dialog, or the Cancel button to close without making changes.

Related Topics

Customize Toolbar Options
Working with Toolbars

External User Tools

To add an external user toolsmenu toMaxwell:
1. ClickTools>External Tools
2. This displays theCustomize User Tools Menu dialog.

If aUser Toolsmenu has been defined, its contents are displayed. Navigation buttons let you
Move Up, Move Down, Add, and Delete.

3. Click theAdd button in theCustomize User Tools Menu dialog.
This enables the following fields:
Menu Text field -- this displays [new tool] as text you will replace with the text you want to
appear in the User Toolsmenu.
Command field -- this will display the external executable. An ellipsis button [...] lets you
navigate to the file location.
Arguments field -- this field accepts command arguments from the > buttonmenu selections
for File Path, File Directory, File Name, File Extension, Project Directory, or TempDirectory.
Initial Directory -- this field specifies the initial directory for the command to operate. The
ellipsis button {...] displays a dialog that lets you navigate folders in your desktop, or across the
network.

4. ClickOK to add the External Toolsmenu toMaxwell orCancel to close the dialog without
changes.

You can also add scripts to the Toolsmenu. Assuming you have a script to generate custom reports
called report.vbs, use the cscript.exe program to execute your script.
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This example shows the cscript.exe program added to the Toolsmenu asRunMyScript. The
command line argument to the csscript.exe program is report.vbs. You can also name the directory
in which it will be run.

Working with the Shortcut Menus

A variety of shortcut menus—menus that appear when you right-click a selection— are available in
the toolbars area of the desktop, in theModeler window, and in the Project Manager
window.

Shortcut
menu in the
toolbars
area

Use the shortcut menu in the toolbars area of the desktop to show or hide windows
or toolbars, and customize the toolbars.

Shortcut
menu in the
Modeler
window

Use the shortcut menu in theModeler window to select, magnify, andmove
options (zoom, rotate, etc.), change the view, perform boolean operations, assign
materials, or mesh operations to objects, and work with field overlays.

Shortcut
menus in the
Project
Manager
window

Use the shortcut menus in theProject Manager window tomanageMaxwell
project and design files and design properties; assign and edit excitations, and
mesh operations; add, analyze, andmanage solution setups; add optimetrics
analyses; create post-processing reports; edit project definitions.

Shortcut Use the shortcut menus in the History tree to expand or collapse groupings. If you
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menus in the
History Tree

select particular objects in the history tree, the shortcut menu lists the commands
that you can apply to the selected object or objects.

Note All of the commands on the shortcut menus are also available on themenu
bar.

Shortcut Menu in the Toolbars Area

Use the shortcut menu in the toolbars area of the desktop to show or hide windows or toolbars, and
customize the toolbars.
To access the shortcut menu in the toolbars area:

l Right-click in the toolbars area at the top of the desktop.
A check box appears next to a command if the item is visible. For example, if a check box appears
next to the Project Manager command, then the Project Manager window is currently visible
on the desktop.
ClickCustomize to open theCustomize dialog box, which enables you tomodify the toolbar
settings on the desktop.

Shortcut Menu in the Modeler Window

Use the shortcut menu in theModeler window to select, magnify, andmove options (zoom, rotate,
etc.), change the view, assignmaterials, nets, excitations, or mesh operations to objects, work with
field overlays, and plot objects.
To access the shortcut menu in theModeler window:

l Right-click in theModeler window (grid area).

Shortcut Menus in the Project Manager Window

Each node, or item, in the project tree has a shortcut menu.
To access the shortcut menu in theProject Manager window, for a particular node:

l Select a node or item.
l Right-click in theProject Manager window.

General Purpose Keyboard Shortcuts for Maxwell

The following keyboard shortcuts apply to Maxwell and RMxprt in general
l F1: Help
l F1 + Shift: Context help
l F4 + CTRL: Close program
l CTRL + C: Copy
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l CTRL + N: New project
l CTRL + O: Open...
l CTRL + P: Print...
l CTRL + V: Paste
l CTRL + X: Cut
l CTRL + Y: Redo
l CTRL + Z: Undo
l CTRL + 0: Cascade windows
l CTRL + 1: Tile windows horizontally
l CTRL + 2: Tile windows vertically

To customize the shortcut assignments, use Tools>Keyboard Shortcuts.

Related Topics

Keyboard Shortcuts for the 3D Modeler Window
CustomKeyboard Shortcuts

Custom Keyboard Shortcuts

ClickTools>Keyboard Shortcuts to display a dialog that lets you view existing assignments,
create new shortcuts, save and load assignment files.
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Selecting a Command category lists the available Commands for that category. If the command has
an assigned shortcut, it is displayed in theShortcuts for selected command field. You can use the
Remove button to disable the shortcut for the selected command. If the selected command does not
have an assigned shortcut, theShortcuts for selected command field and theRemove button
are grayed out.
To create a new shortcut key:

1. Select the Category and Command.
2. If you want disable a current assignment for the selected command, clickRemove.
3. To assign a keyboard shortcut, place the cursor in thePress new shortcut key field.

The field displays the keystrokes youmake.When you havemade keystrokes, the dialog
enables theAssign button. If you combine keystrokes these are displayed with a “+” between
them. For example, Ctrl + p or Alt +o.

4. The Use new shortcut in field displaysGlobal by default, whichmeans that the shortcut will
apply to all applicable contexts. If a limited context exists, themenuwill offer a selection.

5. When you havemade the desired assignments, you can save the assignments to a named
file.
Clicking the Save... button displays a browser window that lets you navigate the file structure
and assign a name, using an aks suffix for Ansoft Keyboard Shortcut file.
Buttons on the browser window let you designate the file location asUse Path, Personallib,
Syslib,UserLib, or Project folder.
If you have an existing aks file, you can use the Load... button to display a browser window to
locate the desired file.

6. You canOK the current settings, orReset to Default.

Working with the Status Bar

The status bar is located at the bottom of the application window. It displays information about the
command currently being performed.
To display or hide the status bar:

l ClickView>StatusBar.
A check box appears next to this command if the status bar is visible.
When visible, the status bar contains buttons to show or hide themessage window and
progresswindow.
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Whenmore than one progress bar is active, the top progress bar is represented on the status
bar with a progress indicator.

Depending on the command being performed, the status bar can display the following:
l X, Y, and Z coordinate boxes.
l A pull-down list to enter a point's absolute, relative, cartesian, cylindrical, or spherical
coordinates.

l Themodel's units of measurement.
When creating object in themodel window, youmay jump to the coordinate entry boxes by pressing
the Tab key. In addition, the Tab keymoves the focus to the next coordinate boxwhen performing
manual data entry.

Exiting the Desktop

To exit the desktop, use File>Exit.
If simulations are running, amessage informs you that if you continue, the simulationswill be
aborted. If you chooseOK, Maxwell does a clean abort before going on with the Exit.

Working with the Project Manager

TheProject Manager window displays the open project's structure, which is referred to as the
project tree.
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TheProject Manager window displays details about all openMaxwell projects. Each project
ultimately includes a geometricmodel, its boundary conditions and excitations, and field solution and
post-processing information. Any 3D Components appear under the 3D Components icon.
To show or hide theProject Manager window, do one of the following:

l ClickView>Project Manager.
A check box appears next to this command if theProject Manager window is visible.

l Right-click in the toolbars area on the desktop, and then clickProject Manager on the
shortcut menu.

A check box appears next to this command if theProject Manager window is visible.

Related Topics

Working with the Project Tree
Shortcut Menus in the Project Manager Window
"Working with the RMxprt Project Manager" on page 26-14

Working with the Project Tree

The project tree is located in theProject Manager window and contains details about all open
Maxwell projects.
The top node listed in the project tree is the project name. It is namedProjectn by default, where n is
the order in which the project was added to the current session of Maxwell. Expand the project icon
to view the project'sMaxwell design information, 3D Components (if any) andmaterial definitions.
By default, the Project tree icon for the active window is highlighted, as shown in the figure below.
(See User Interface for the options.) With the option disabled,Rotational_Act_TR (Transient) in
the Project tree would not be highlighted.
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When the Project tree is taller than the window, if youmouse has a scroll wheel, you can click in the
Project manager and use the wheel to scroll up and down. If the Project tree is larger than the
window size, there is also a scroll bar can control with themouse cursor.

In the project tree, an "unknown" section lists objects that do not fit one of the following
dimensionality types: solid, sheet, or wire.

Related Topics

ViewingMaxwell Design Details

Setting the Project Tree to Expand Automatically

You can set the project tree to automatically expand when an item is added to a project.
1. ClickTools>Options>General Options.

TheOptions dialog box appears.
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2. Click theProject Options tab.
3. UnderAdditional Options, selectExpand Project Tree on Insert.
4. ClickOK.

Viewing Maxwell Design Details

Once you insert a Maxwell design into a project, it is listed as the second node in the project tree. It is
namedMaxwellModeln by default, where n is the order in which the design was added to the project.
Expand the design icon in the project tree to view specific data about themodel.
TheMaxwellModeln node contains the following project details:

3D
Components

Lists any 3D components added to the design.

Model Allows you to display the design list, definemotion setup, and set the symmetry
multiplier.
For Transient solutions only, when theModel icon is selected, the Properties
window displays aMotion Variables tab showing Speed and Direction variables
values (not user-editable) if a motion setup has been defined.

Boundaries Allows you to define boundary conditions on selected faces.
Excitations Allows you to define voltage and current sources on selected objects.
Parameters Allows you to assign executive parameters to solve for (such as force and torque).
Mesh
Operations

Displays themesh operations specified for objects or object faces. Mesh operations
are optional mesh refinement settings that are specified before amesh is
generated.

Analysis Displays the solution setups for aMaxwell design. A solution setup specifies how
Maxwell computes the solution.

Optimetrics Displays anyOptimetrics setups added to aMaxwell design.
Results Displays any post-processing reports that have been generated.
Field
Overlays

Displays field overlay plots, which are representations of basic or derived field
quantities on surfaces or objects.
Plot folders are listed under Field Overlays. These folders store the project's plots
and can be customized. SeeSetting Field Plot Defaults for information on how to
customize the plot folders.

Note To edit a project's design details:
l In the project tree, double-click the design setup icon that you want to
edit.

A dialog box appears with that setup's parameters, which you can then
edit.

In the project tree, an "unknown" section lists objects that are not solid, sheet, or wire.
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Design List Dialog Box

You can view the design list for amodel in the following ways:
l By clickingMaxwell3D,Maxwell2D, orRMxprt and then selecting List.
l By double-clickingModel in the project tree.
l By right-clicking items in the project tree and selecting List from the shortcut menu.

Information about themodel, boundaries and excitations, mesh operations, and analysis setup can
be viewed in theDesign List dialog box that appears, with the following tabs available:

l Model
l Machine (for RMxprt projects)
l Motion
l Boundaries
l Excitations
l Parameters
l Mesh Operations
l Analysis Setup

In theDesign List dialog box, all objects are shown, regardless of the type of dimensionality (solid,
sheet, wire, or unknown); whereas, in the project tree, an "unknown" section lists objects that are not
solid, sheet, or wire.

Motion Variables Tab

For Transient solutions only, when theModel icon in the project tree is selected, theProperties
window displays aMotion Variables tab showingSpeed andDirection variables values if a motion
setup has been defined. These variable values are not user-editable. Like other variables, they can
be used in expressions and reports.

Related Topics

Setting UpMotion for Transient Projects

Viewing Material Definitions

The definitions node is listed at the bottom of the project tree and displays all of thematerial
definitions that are assigned to the objects in the activemodel.

Related Topics

Adding New Materials
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Working with the Properties Window

ThePropertieswindow displays the attributes, or properties, of an item selected in the project tree,
the history tree, or theModeler window. ThePropertieswindow enables you to edit an item's
properties. The properties, and the ability to edit them in thePropertieswindow vary depending on
the type of item selected. The tabs available in thePropertieswindow also vary depending the
selection.
You can choose to show or hide a dockedPropertieswindow as part of the desktop. You canmove
and resize the docked Properties window within the desktop to suit your work style. When you have
a docked Properties window, it displays the properties of any item you select in the Project tree, the
History Tree, or theModeler window. You selectView>Properties Window to toggle the viewing of
the docked properties window.
Regardless of the whether you display a dockedPropertieswindow, you can still open an undocked
Propertieswindow for any item in the project tree, the history Tree, or the 3D Modeler window by
double-clicking.

Related Topics

Opening the PropertiesWindow
Showing and Hiding the PropertiesWindow
Setting the PropertiesWindow to Open Automatically
Modifying Object Attributes using the PropertiesWindow
Modifying Object Command Properties Using the PropertiesWindow
Working with the RMxprt PropertiesWindow

Opening the Properties Window

1. Select the object whose properties you want to view.
2. ClickEdit>Properties.

ThePropertieswindow for that object appears.
3. When you are finishingmaking changes, clickOK.

Rather than opening a separate window, you can also view an object's properties if you have the
Propertieswindow displayed within the desktop.

Related Topics

Showing and Hiding the PropertiesWindow
Setting the PropertiesWindow to Open Automatically
Modifying Object Attributes using the PropertiesWindow
Modifying Object Command Properties Using the PropertiesWindow
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Showing and Hiding the Properties Window

To show or hide thePropertieswindow on the desktop, do one of the following:
l ClickView>Properties Window.

A check box appears next to this command if thePropertieswindow is visible.
l Right-click in the toolbars area at the top of the desktop, and then click Properties on the
shortcut menu.

A check box appears next to this command if thePropertieswindow is visible.

Note You can also click any command or attribute in theProperty window, and then click
Edit>Properties to view its properties.

Related Topics

Setting the PropertiesWindow to Open Automatically

Setting the Properties Window to Open Automatically

Tomodify the object's properties and set thePropertieswindow to open after an object is drawn, do
the following:

1. ClickTools>Options>Modeler Options.
TheModeler Optionswindow appears.

2. Click theDrawing tab.
3. SelectEdit property of new primitives.
4. ClickOK.

Hereafter, after you draw an object in point mode, thePropertieswindow will open.
However, if you draw an object in Dialogmode, this setting is ignored.

Related Topics

Showing and Hiding the PropertiesWindow

Modifying Object Attributes Using the Properties Window

1. Select the object for which you want to edit its attributes by clicking it in the view window or
clicking its name in the history tree.

2. Under theAttribute tab in thePropertieswindow, edit the object attribute.
Depending on the attribute type, you can edit it by doing one of the following:
l Select the check box to apply the attribute; clear the check box to disable the attribute.
l Click in the field and edit the numeric values or text, and then pressEnter.
l Click the button and then edit the current settings in the window or dialog box that appears.
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l Click theValue column of the attribute, and then select a new setting from themenu that
appears.

Related Topics

Modifying Objects
Modifying Object Command Properties Using the PropertiesWindow

Modifying Object Command Properties Using the Properties Window

TheCommand tab in thePropertieswindow displays information about an action selected in the
history tree that was performed either to create an object, such as theDraw>Box command, or to
modify an object, such as theEdit>Duplicate>Mirror command.
Not all command properties can bemodified. The command properties you can typicallymodify
include the numeric values, such as position values (base position, normal position, start position,
etc.), size values (height, radius, etc.), and various other coordinate values. You can alsomodify
many of the unit settings for a command property.

1. In the history tree, select the command for which you want to edit its properties.

Hint Press and holdCtrl to select multiple commands. If you select multiple commands,
only the common, or shared, properties are displayed under theCommand tab.

2. Under theCommand tab in thePropertieswindow, edit the command's properties.
Depending on the property type, you can edit it by doing one of the following:
l Select the check box to apply the property; clear the check box to disable the property.
l Click in the field and edit the numeric values or text, and then pressEnter.
l Click the button and then edit the current settings in the window or dialog box that appears.
l Click the attribute, and then select a new setting from themenu that appears.

Related Topics

Modifying Objects
Modifying Object Attributes using the PropertiesWindow

Working with the Progress Window

TheProgresswindow monitors a simulation while it is running.
To display or hide theProgresswindow, do one of the following:
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l Click theShow Progress orHide Progress buttons on the status bar:

Whenmore than one progress bar is active, the top progress bar is represented on the status
bar with a progress indicator.

l ClickView> Progress Window.
A check box appears next to this command if theProgresswindow is visible.

l Right-click the history tree, and then clickProgress on the shortcut menu.
A check box appears next to this command if theProgresswindow is visible.

Related Topics

Stopping or Aborting Simulation Progress
Viewing Distributed Analysis Subtasks

Stopping or Aborting Simulation Progress

To abort progress, right-click in the Progresswindow, and selectAbort.
To stop the simulation cleanly between time steps, right-click in the Progresswindow, and select
Clean Stop.

Stopping and Restarting Time Decomposition Method Analyses

l For TimeDecompositionMethod (TDM) analyses, invokingClean Stop stops the analysis
after completion of the current time subdivision, instead of after completion of the current time
step. As a result, continuation of the solution processwill start from the next time subdivision
after clickingAnalysis. In such a case, the stop time cannot bemodified when TDM is used.

l WhenClean Stop is invoked for projects in which a TDM transient source design is linked to a
transient target design, after completion of the source design the solution process can
continue from the target design. In such a case, the target designmust be non-TDM.
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Viewing Distributed Analysis Subtasks

While a distributed analysis is running, you can access parent and child progress bars. By
default, only themain progress bar is displayed, while the child progress bars (or subtasks)
remain hidden. You can toggle between showing and hiding the child progress bars.
To show the child progress bars:

l Right-click the progresswindow, and selectShow Subtask Progress Bars.
To hide the child progress bars:

l Right-click the progresswindow, and selectHide Subtask Progress Bars.

Working with the Message Manager

TheMessage Manager displaysmessages associated with a project's development, such as error
messages about the design's setup or informational messages about the progress of an analysis.
Messages are organized by project, and then by circuit design. Because a design can contain
multiple levels, andmultiple analyses can be set up for each, this organization helps you determine
where errors have occurred.
TheMessageManager window is a dockable window similar to the Project Manager window. Like
the Project Manager window, it can bemoved and sized as needed. It can also be attached (docked)
to any edge of the desktop. Message text wrapswithin the window. A vertical scrollbar displays as
needed allowing you tomove through the list message-by-message.

l You can drag the window by its title bar to undock, move, and dock it.
l You can resize the window by dragging its edges.
l You canmaximize or minimize the window by clicking the triangle in the title bar.
l You can close the window by clicking the “X” in the title bar.
l You can right-click on amessage and selectDetails to show message details.

Note If a message is too large to fit in the window, clicking the scrollbar to page-up or page-down
will have no effect. To view suchmessages in their entirety, you can resize the window or
right-click on themessage and selectDetails to show message details.

To display or hide theMessageManager:
l ClickView>Message Manager.
A check box appears next to this command if theMessageManager is visible.

l Click theShow Messages orHide Messages buttons on the Status bar. The number of
messages currently in theMessageManager is also shown in the button.
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If you right click in theMessage Manager window, you see a popupmenu that lets you:
l Clear themessages for the current model.
l Copy themessages to the clipboard. This can be helpful for sending themessages to
application engineers.

l Details. This brings up a information dialog with the project and design for specificmessage.
After you run a validation check, you can right-click on an intersection error message in theMessage
window, and selectGo to reference from the shortcut menu. This selects the intersecting objects.

Related Topics

Showing new messages
Showing errors and warnings
Setting theMessageManager to Open Automatically

Setting the Message Manager to Open Automatically

You can set theMessageManager to open automatically to show new messages and errors and
warnings.

Related Topics

Showing new messages
Showing errors and warnings
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Showing new messages

You can set theMessage Manager to automatically be brought up when a new message appears.
1. ClickTools>Options>General Options.

TheGeneral Options dialog box appears.

2. UnderGeneral>Interface Options, selectShow Message Window on new messages.
3. ClickOK.

Showing errors and warnings

You can set theMessage Manager to automatically expand when an item is added to a project.
1. ClickTools>Options>General Options.

TheGeneral Options dialog box appears.

2. UnderGeneral>Interface Options, selectEnsure that new messages are visible in the
Message Window Tree.

3. ClickOK.

Clearing Messages for the Project

You can clear all themessages for a particular project.
To clear messages:

1. Right-click the project# in theMessage Manager.
A pop-up appears.

2. ClickClear messages for Project#.

Clearing Messages for the Model

You can clear all themessages for a particular model.
To clear messages:

1. Right-click theMaxwellModel# in theMessage Manager.
A pop-up appears.

2. ClickClear messages for MaxwellModel#.

Copying Messages

You can copy all themessages for a particular project.
To copymessages:
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1. Right-click in theMessage Manager.
A pop-up appears.

2. ClickCopy messages to clipboard.

Working with the Modeler Window

TheModeler window is the area where you create themodel geometry. It appears to the right of the
Project Manager window after you insert a Maxwell design into a project.
TheModeler window consists of themodel view area, or grid, and the history tree, as shown below:

To open a new Modeler window, do one of the following:
l Insert a Maxwell design into a project.
l Double-click aMaxwell design in the project tree.

Themodel you draw is saved with the current project when you clickFile>Save.
Objects are drawn in theModeler window. You can create 3D objects by usingMaxwell'sDraw
menu commands, or you can draw 1D and 2D objects and thenmanipulate them to create 3D
objects. For more information, seeDrawing aModel.
You canmodify the view of objects in the Modeler window without changing their actual dimensions
or positions. For more information, seeModifying theModel View.

Related Topics

Modifying theModel View
Keyboard shortcuts for the 3D Modeler Window.
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Working with the Extensions Window

TheView>Extensions command opens the Extensionswindow for toolkit extensions implemented
via ANSYS ACT. Depending on how you size and arrange the desktop, the appearancemay vary.
Youmay choose to detach and size the window to suit your needs.

Click on theWizards icon to view active toolkit wizards in theWizards view.

Getting Started with Maxwell and RMxprt 3-27
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

To add an existingWizard, youmust activate it by clicking on theExtension Manager icon. This
changes the view to show the installed extensions. If there aremany available extensions, you can
either scroll or use theSearch field to find the ones you want. Search is not case sensitive. Click the
desired extension to activate it. The extension is loaded and highlighted to show the change in
status. You can unload (deactivate) an extension by clicking on it. In the image below, theMaxwell
extension has been activated, but the HFSS extension is not activated for use.

Click the back arrow icon to return to theACT Start page,

then click theWizards icon to open theWizards view.
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Click on the icon for the wizard you want to use to open it in the window.
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Related Topics

"ModelingMaxwell Motion Eccentricity" on page 13-9

Working with the History Tree

The history tree in theModeler window lists the activemodel's structure and grid details, including
themodel's objects, coordinate systems, default planes, and any object or face lists.
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You can perform the following taskswith the history tree.
l Expand or CollapseGroupings in the History Tree
l History Tree Layout Commands
l Group Commands for Modeler Objects
l Selecting Objects in the History Tree
l Use Shortcut Menus in the History Tree
l View Properties for History TreeObjects
l History of Commands on History TreeObjects
l Control the View of Objects in the History Tree
l Selecting All Objects in a History Tree Folder
l Upgrade Version

The history tree contains the followingmodel details:

Invalid Lists all invalid objects
3D
Component
Names

Lists any 3D components added to the design, listing their Solids, Coordinate
Systems, and Planes, separately from objects drawn in themodeler, or imported to
themodeler.

Solids Displays all themodel's solid objects and a history of the commands carried out on
each object.

Sheets Displays all the sheets in themodel 3D design area. By default, all sheet objects are
grouped by boundary assignment.

Lines Displays all line objects included in the activemodel.
SeeDrawing a Line for information on how to draw a line object.

Points Displays all point objects included in the activemodel.
SeeDrawing a Point for information on how to draw a point object.

Getting Started with Maxwell and RMxprt 3-31
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Groups Displays folders for Groups you have created or imported. SeeGroup Commands for
Modeler Objects.

Coordinate
Systems

Displays all the coordinate systems for the activemodel.
SeeSetting Coordinate Systems for more information on thismodel detail.

Planes Displays the planes for all the coordinate systems.When you create a coordinate
system, default planes are created on its xy, yz, and xz planes.

Lists Displays the object or face lists for the activemodel. By default, a list called
"AllObjects" appears.
Creating an object list is a convenient way to identify a group of objects for a field plot
or calculation.
Creating a face list is a convenient way to identify a specific set of surfaces for a field
plot or calculation.
SeeCreating anObject List.

Note While objects created inMaxwell can always be classed in the history tree as either a solid,
sheet, or wire, some imported objectsmay havemixture of these. Such objects are placed
in an Unclassified folder in the history tree.

Expand or Collapse Groupings in the History Tree

You can expand or collapse object groupings in the history tree by left clicking the + or - respectively.
In addition, right-clicking on any group icon opens a pull-down toExpand All groupings orCollapse
All groupings.

Related Topics

Selecting Objects in the History Tree
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History Tree Layout Commands

A set of History Tree Layout commands lets you organize objects bymaterial, assignment, or by
component definition. By default there is no further organization within groups. You can selectAlso
Organize Within Groups to extend organize settingswithin groups.

If the design does not contain material assignments, sheets, components, or groups, themenu items
are disabled. You can access the History Tree Layout commands by clickingModeler>History
Tree Layout or by right-clicking on theModel icon in the history tree (as shown above). You click on
[-] to close a hierarchy and [+] to open one.

Related Topics

Select Objects in the History Tree
Group Commands for Modeler Objects
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History of Commands on Objects

The history tree also lists the history of all commands carried out amodel’s objects. This history is
displayed in the order in which it occurred. Note in the above image the expanded air object and its
history of commands.
Selecting a command in the history highlights the object in theModeler window and shows that
object’s properties (if available) in the docked Properties window. You can look at the fields in the
Properties window to see any editable fields for that command, such as coordinate system, line type,
coordinates, or units.
For some commands, such asEdit>Arrange>Move, or boolean operations, selecting them in the
history tree enables the X (delete) icon on the toolbar and theEdit>Deletemenu. In these cases,
you can delete those commands from the history tree as a way of undoing those operations. As an
alternative to deletion, you can checkSuppress command in the Properties window for that
command. This undoes the effect of a command on an object without removing it from the History
tree.

Selecting Objects in the History Tree

Selecting objects in the History tree also selects them in the View window. This can be useful for
complex objects, when it may be easier to find the objects of interest by name or material, if the
object of interest is inside or behind others.
You can use CTLR-click tomakemultiple selections. You can select a range of objects by a click on
the first, and then SHIFT-Click to select all in the range. You can also click and drag themouse to
make rubber band selections. Only visible objects are selected. That is, if the hierarchy is closed
under the selection, any operand parts are ignored and do not interfere with cut and paste
operations.
You can also right click on anyHistory tree object or grouping and right click to display a shortcut
menu with aSelect All command. This lets you select at one time all solids, sheets, lines, non-model
objects, or all unclassified objects.

Related Topics

History Tree Layout Commands
Group Commands for Modeler Objects

Shortcut Menus in the History Tree

If you select particular objects in the history tree, right-click displays a shortcut menu lists the
commands that you can apply to the selected command, object, or objects. The shortcut menus for
model objects aremost extensive.
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In other cases, you can only view properties, or expand or collapse hierarchy.

Related Topics

View Properties for History TreeObjects
History of Commands on History TreeObjects

View Item Properties in the History Tree

To view the properties of an item in the history tree:
l Click the item’s name in the history tree.
The item’s properties appears in the dockedPropertieswindow.
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l Double-click on an item in the history tree to display a Propertieswindow.
l Click the item’s name in the history tree, and double right click to display a shortcut menu.
Then selectProperties to display thePropertieswindow.

Related Topics

Purge History command
Generate History command

View and Edit Commands on History Tree Objects

The history tree also lists the history of all commands carried out amodel’s objects, for example,
“CreateBox” or “Subtract.” This history is displayed in the order in which it occurred. Here is a history
tree from the waveguide combiner example.

Selecting a command in the history highlights the object in theModeler window and shows that
object’s properties (if available) in the docked Properties dialog. You can look at the fields in the
Properties dialog to see any editable fields for that command, such as coordinate system, line type,
coordinates, or units.
For some commands, such asEdit>Arrange>Move, or boolean operations, selecting them in the
history tree enables the X (delete) icon on the toolbar and theEdit>Deletemenu. In these cases,
you can delete those commands from the history tree as a way of undoing those operations. As an
alternative to deletion, you can checkSuppress command in the Properties window for that
command. This undoes the effect of a command on an object without removing it from the History
tree.
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Related Topics

Select Objects in the History Tree
Purge History command
Generate History command
Modifying Objects

Controlling the View of Objects in the History Tree

To control the view and visibility of an object such as a box or PML, right click on an object in the
history tree display the short-cut menu and selectView. The short cut menu contains the following
commands:

l Fit in Active View
l Hide in Active View
l Show in Active View
l Fit in All Views
l Hide in All Views
l Show in All Views

Related Topics

Purge History
Generate History

Upgrade Version in History Tree Shortcut Menu

By right-clicking on an operation icon in the history tree in theModeler window, you can see the
Upgrade Version command.

TheModeler by default opens the legacy project in previous (what ever that the project was saved
with) ACIS version so that you don't see side effects of slight topology changes between ACIS
versions. If you want you can use Upgrade Version tomove the operation to use latest ACIS code.
Typically this applies when a needed fix is available with new ACIS version.
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Related Topics

Working with the History Tree

Keyboard Shortcuts for the 3D Modeler Window

The following keyboard shortcuts apply to the 3D Modeler Window
l B: Select face/object behind current selection
l F: Select facesmode
l O: Select objectsmode
l E: Select edgesmode
l V: Select verticesmode
l M: Mult select mode
l Ctrl + A: Select all visible objects
l Ctrl + Shift + A: Deselect all objects
l Ctrl + D: Fit view
l Ctrl + E: Zoom in, screen center
l Ctrl + F: Zoom out, screen center
l Shift + LMB: Zoom in / out
l Alt + LMB: Rotatemodel
l Alt + Shift + LMB: Zoom in / out
l Alt + Double-click LMB: Setsmodel projection to standard isometric projections (cursor must
be in corner of model screen N/NE/E/SE/S etc)

l F3: Switch point entrymode tomouse (draw objects bymouse). This switch takes effect only
after the drawing of an object has started.

l F4: Switch to dialogue entrymode (Draw objects by entry in the command and attribute box).
This switch takes effect only after the drawing of an object has started.

l F6: Render model wire frame
l F7: Render model smooth shaded

Note LMBmeans Left Mouse
Button.

To customize the shortcut assignments, use Tools>Keyboard Shortcuts.

Related Topics

General Purpose Keyboard Shortcuts for Maxwell
CustomKeyboard Shortcuts
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Running ANSYS Electronics Desktop From a Command Line
ANSYS Electronics Desktop includes line arguments that can be included when launching from a
command line or terminal prompt. All command-line arguments are case-insensitive. The
commands associated batch options can also be used with a JobManagement Interface for
submitting jobs to ANSYS or RSMand other supported schedulers. See
RSM Integration with JobManagement UI
Integration with Microsoft Windows® HPC Scheduler
Integration with Platform's Load Sharing Facility (LSF)
Integration with Grid Engine (GE)

Command-line syntax
ansysedt <options> <run command> <project name/script name>

Run Commands
The following command line run commands are available in ANSYS Electronics Desktop. Of
the commands (BatchSave, BatchSolve, BatchExtract, RunScript, RunScriptandExit), one or
nonemust be used as arguments after ansysedt. Links to the valid options for each run
command are listed and/or linked to descriptions.
-BatchSave <project file name>

Saves a named project to the current version. This is primarily intended for converting projects
to the current software version from a previous version. Generally, conversion is supported for
the previous two releases of the product. The conversionmust be done under Windows
before those projects can run on a Linux system.You can run this commandwith the -Iconic
option, the -Logfile option, and the -ng option (no graphics).

-BatchSolve <project file name>

By default, solve all adaptive setups, sweeps, aswell asOptimetrics setups found in the
project file. If parallel solve is possible, you can use the -Distribute option in conjunction with -
BatchSolve. You can run this commandwith the -Iconic option, the -Logfile option, the - ng
option (no graphics), and the -WaitForLicense option.

Additional parameters for batch solves include the following. It is good practice to put quotes
around the path to theMaxwell executable, and the full path to the project. This ensures that
spaces in the path or project will not be an issue. The same is true of the design name, if there
are indeed spaces. The quotesmust enclose the entire argument including the Nominal or
Optimetrics part.

[designName] - batch solve all setups for design with the name given under the project.

[designName]:Nominal - batch solve all nominal setups for design with the name given
under the project.

Getting Started with Maxwell and RMxprt 3-39
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

[designName]:Optimetrics - batch solve all Optimetrics setups for design with the name
given under the project.

[designName]:Nominal:[setupname] - batch solve the specified nominal setup for design
with the name given under the project. The setupname is case insensitive.

[designName]:Optimetrics:[setupname] - batch solve the specified Optimetrics setup for
design with the name given under the project.The setupname is case insensitive.

-Local | -Remote | -Distributed

Perform the -Batchsolve on a local machine, a remotemachine, or as a distributed solve
using a specifiedmachine list (see below). These command line options aremutually
exclusive. That is, only one of these options should be specified. The settings persist only for
the current session.

If you specify -Local, a machine list is not needed.

For -Remote, you should provide amachine list with a single hostname.

For -Distributed, you should provide amachine list or file path.

-Distributed takes optional arguments whichmodify the job distribution parameters. When
the optional parameters are not present, the behavior is single level distributed solveswith no
change in order of precedence among possible distribution types.The optional parameters
are:

includetypes= <default> | <distribution type 1, distribution type 2, ...>
If the distribution types are specified, only the listed distribution types are enabled. If
default is specified, a default set of enabled distribution typeswill be used.
excludetypes= <default> | <distribution type 1, distribution type 2, ...>
If the distributed types are specified, all distribution types except those listed will be
enabled. If default is specified, a default set of enabled distribution typeswill be used.
maxlevels= 1 | 2
This is themaximum level of job distribution. Right now, only single and double level
distribution is supported.
numlevel1= number of level 1 tasks
When two level distribution is enabled, numlevel1 specifies the number of level 1 tasks.

When using -Distributed:

l If neither includetypes= or excludetypes= are specified, default job distribution types
will be used.

l Ifmaxlevels is not specified, multilevel distribution will be disabled.

See the Job Distribution tab in theAnalysis Configuration dialog or the -help text for valid
values for job distribution types.
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The -Machinelist command line option is used to specify the DSOMachines. This command
line option is onlymeaningful if either -Remote or -Distributed is specified. There are three
different formats for the -Machinelist command line option. The different formats are
described below.

-MachineList list=“<machine1>, <machine2>, ...”

In this format, the DSOmachinesmachine1,machine2,... are listed explicitly on the command
line. Themachine namesmust be separated by commas. Themachinesmay be specified by
IP address or by hostname, provided that the hostnames are able to be resolved on the
Desktop host. If the list contains anywhitespace, it must be enclosed in quotes. The number of
distributed COMengines run on each host is equal to the number of times that the hostname
appears in the list. That is, if host1 appears in the list once, and host2 appears in the list twice,
then one COMengine will run on host1 and two COMengineswill run on host2.

list =<machine1, machine2, ...> acceptsmachine specifiers of the form:

<machine name>:<total number of tasks>:<total number of cores>.

For example:

list="Orion:4:8, Aries:3:12, Pluto:6:12"

With this form, duplicatemachine names are not allowed, and the number of coresmust be
greater than the number of tasks.

-MachineList file=“<machine list file path>”

In this format, the DSOmachines are listed in a file. Themachine names are listed in the text
file, one hostname per line. The pathname of the file is file_path_name. Themachinesmay be
specified by IP address or by hostname, provided that the hostnames are able to be resolved
on the local host. The number of distributed COMengines run on each host is equal to the
number of times that the hostname appears in the list. That is, if host1 appears in the list once,
and host2 appears in the list twice, then one COMengine will run on host1 and two COM
engineswill run on host2.

file=<machine list file path> will also accept machine specifiers in the specified file using the
format.

<machine name>:<total number of tasks>:<total number of cores>.

For example:

"Orion:4:8, Aries:3:12, Pluto:6:12"

With this form, duplicatemachine names are not allowed, and the number of coresmust be
greater than the number of tasks.
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You can use either form of the -MachineList option to indicate themachine(s) on which to run
a distributed batchsolve. The settings persist only for the current session.

When you use a file to define themachines available for a distributed solve you should list the
machine addresses or names on separate lines:

192.168.1.1
192.168.1.2
(etc)

-MachineList num = <numb distributed engines>

The "-machinelist num=n" option is now required for batch jobs. This format is used when a
scheduler (such as LSF, PBS, SGE orWindowsHPC) is used tomanage the jobs sent to a
cluster of hosts. In a scheduler environment, you can specify the number of distributed
engines that should be used for distributed processing. In this case, you do not specify the
machine names after the flag because the names are provided by the scheduler. For example,
in theWindowsHPC environment, you can write the number of distributed engines as follows.

-machinelist num=4
The COM engines will be distributed across the hosts
allocated to the job by the scheduler.

-batchoptions“'<option1>' '<option2>'...”

All options that are specified through Tools>Options dialogs go to the user-level registry.
You can override such registry entries via the -batchoptions command line. These overrides
apply only to the current Desktop session. This feature is available for all desktop products.
The registry setting overridesmay be specified on the command line, or may be in a file with
the file pathname specified on the command line. The -batchoptions command line option is
only valid for batch jobs; it is ignored if neither -BatchSolve nor -BatchSave command line
options are specified.

A new batch solve option “CreateStartingMesh” for all 3D products (HFSS, HFSS-3DLayout,
Q3D, Q2D, Maxwell3D andMaxwell2D). When this option is set, only the initial mesh and
manual mesh operationmaking portion of the setup are completed for the batch solve.

Command line example:

ansysedt -batchoptions " 'HFSS/CreateStartingMesh’=1 “ -
batchsolve “D:\projects\OptimTee.aedt"

For more information, see Examples and Further Explanations of -batchoptions use.

-BatchExtract <batchExtractScriptFile> <projectFile>

This command allows the following commands to be executed non-graphically via script and
without checking out anyGUI licenses: ExportProfile, ExportConvergence, ExportMeshStats,
ExportSolnData, ExportCircuit, Update Reports, ExportToFile. A project filemust be specified

Getting Started with Maxwell and RMxprt 3-42
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

when the command line optionBatchExtract is used. Thismeans that commands in the
<batch extract script file> will only be executed in the specified project. The “open/close”
project commands are not supported inBatchExtractmode.

Note l -ngmust be used with BatchExtract or it will fail with an error.
l Including unsupported commands in the batchExtractScriptFilewill terminate the
script execution.

Examples:

l -ng -BatchExtract <batchExtractScriptFile> <projectFile>
l -ng -BatchSolve ..... -BatchExtract <batchExtractScriptFile> <projectFile>
The commands in batchExtractScriptFilewill be executed afterBatchSolve is done and
before the project is saved.
Note thatBatchSolvewill continue to require solve licenses.

Example Script For Report Export:
ansysedt -ng -batchextract exportToFile.py "C:\Program
Files\AnsysEM\AnsysEM18.0\Win64\Examples\Maxwell\2D\opti_
new.aedt"

where exportToFile.py contains:

oDesktop.RestoreWindow()

oProject = oDesktop.SetActiveProject("opti_new")

oDesign = oProject.SetActiveDesign("Maxwell2DDesign1")

oModule = oDesign.GetModule("ReportSetup")

oModule.UpdateReports(["XY Plot 1"])

oModule.ExportToFile("XY Plot 1", "exportToFilePy.csv")

-Monitor

You canmonitor progress andmessages on standard output, during non-graphical analysis.
Progress, warning and infomessages are logged to the standard output stream. Error and
fatal messages are logged to the standard error stream. Schedulers intercept these streams
and provide commands for display of this output - see individual scheduler documentation for
specifics.

Examples:
C:\Maxwell\ansysedt.exe -distributed
-machinelist list="192.168.1.1,192.168.1.2"
-batchsolve design_transient:Optimetrics "C:\distrib_
project.adsn"
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C:\Maxwell\ansysedt.exe -batchsolve Design1:Nominal
"C:\Project1.aedt"
"c:/Program Files/AnsysEM/AnsysEM18.0/Win64/ansysedt.exe"
-Iconic -Queue
-LogFile "H:\Maxwell\_MaxwellQueue\fence-v2 Array with
Fence4.log"

-BatchSolve "Array with Fence4:Nominal" "H:\Maxwell\fence-v2.mxwl"
-RunScript <script file name>

Run the specified script. You can use the -ScriptArgs option to add one or more arguments
to this command and can use the -Iconic option.

-RunScriptAndExit <script file name>

Run the specified script and exit. You can use the -ScriptArgs option to add one or more
arguments to this command. You can also use the -Iconic option, the -Logfile option, and the
-WaitForLicense option. The '-BatchSolve <DesignName>' ismutually exclusive with '-
RunScriptAndExit <ScriptName>'.

<none>

If you do not specify a run commandwith maxwell on the command line, you can still specify
the -Help and -Iconic options.

<project file>

Open the specified project on start up. If -BatchSolve is also set, the project will be solved.

Note The <project file> must be the last command line
entry.

<archive file>

You can specify an archive file instead of a project file. If -Batchsolve is set, the project will be
automatically restored and solved. Otherwise, you are prompted for a restore location, and the
project will be restored and opened. Also see -archiveoptions below.

-archiveoptions

overwritefiles
Allow non project/results extracted files to overwrite existing files.
path=<projectfilepath>

Extract project file to <projectfilepath> and other files into the same directory. If path is not
specified, the archive will be extracted into the same directory as the archive file.

Note Archive options only apply when performing a batchsolve of an archive
file.

Options
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The following options can be associated with one or more of the run commands:
-batchoptionhelp

Open a window listing the -batchoptions help. For instance:

E:\Program Files\AnsysEM\AnsysEM18.0\Win64\ansysedt -
batchoptionhelp

-distribute (equivalent to -Distributed)

Distribute a batch solve tomultiple machines. This optionmust be combined with the -
BatchSolve run command andmust be specified before it in the command line. See
Distributed Analysis for more information on distributed analysis.

Example:
E:\Program Files\AnsysEM\AnsysEM18.0\Win64\ansysedt.exe
-distribute -batchsolve
MaxwellDesign1:Optimetrics:ParametricSetup1 "C:\Project1.aedt"

-Help

Open a window that displays the different command-line options. This is only used when none
of the four run commands is used.

E:\Program Files\AnsysEM\AnsysEM18.0\Win64\ansysedt -help
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-Iconic

RunMaxwell with the window iconified (minimized). This can be used with all or none of the
run commands.

-LogFile <log file name>

Specify a log file (use in conjunction with the -BatchSave, -BatchSolve, or -
RunScriptAndExit run commands). If no log file is specified, it is written to the directory in
which the script or Maxwell project is located, with the name <project_name>.log.

-ng

RunMaxwell in non-graphical mode. (Use in conjunction with -BatchSave or -BatchSolve
run commands.Must be used with -BatchExtract or -BatchSolve command.).

-WaitForLicense

Wait for available licenses (use in conjunction with -BatchSolve or -RunScriptAndExit).

-ScriptArgs <scriptArguments>
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Add arguments to the specified script in conjunction with -RunScript and -
RunScriptAndExit.

ScriptArgs looks at the single argument after it and uses those as script arguments. You can
passmultiple arguments to scriptargs by surrounding the script arguments in quotes.

For instance:

ansysedt -scriptargs "MaxwellDesign1 Setup1"
-RunScriptAndExit c:\temp\test.vbs

Here, MaxwellDesign1 is taken intoMaxwell as the first argument, and Setup1 is the second
argument. Without the quotes, MaxwellDesign1 is taken as the first argument, and Setup1 is
not understood byMaxwell.

ansysedt -scriptargs MaxwellDesign1 Setup1
-RunScriptAndExit c:\temp\test.vbs
Example:
c:\maxwell\ansysedt.exe -runscriptandexit "c:\project1.vbs"

-scriptargs "Setup1"
Example:
C:\maxwell\ansysedt.exe -RunScriptAndExit
C:\scripts\test.vbs -scriptsargs "arg1 arg2 arg3"

Settable Desktop Settings for -batchoptionsUse
For -batchoptionsUse: Project Directory and Lib Paths
For -batchoptionsUse: TempDirectory
For -batchoptionsUse: VariousDesktop Settings
For -batchoptionsUse: Maxwell2D andMaxwell3D Optionswith Paths
Batch OptionsCommand Line Examples
The Tools>Options>Export Options Files commandwrites xml files containing theOptions settings
at all levels to the specified directory. The Tools>Options>Export Options feature is intended to
make it easier for different users to use ANSYS Electromagnetics Suite installed on shared
directories or network drives. The Example Uses for Export Options Features section outlines some
use cases enabled by this feature.

Related Topics

Running a Script

Examples and Further Explanations of -batchoptions use

This section provides examples and further explanations of -batchoptions.
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l Example with registry settings specified on the command line
l Example with registry settings specified in a file
l -batchoptions and relative registry paths
l When to use the -batchoptionsDesktop command line option

The following examples useMaxwell, but this feature is available for all desktop products.
l The registry path separator is the slash "/"
l Registry key pathnames are enclosed in single quotes
l Registry string values are enclosed in single quotes
l Backslashes in registry key valuesmust be escaped with another backslash

Example with registry settings specified on the command line
maxwell.exe -batchsolve -batchoptions
"'Desktop/Settings/ProjectOptions/NumberOfProcessors'=4
'Desktop/ProjectDirectory'='C:\\projects\test'"
projectname.aedt

This command line overrides the values of the Project Options and Desktop/ProjectOptions
registry settings.

Notes:
l Multiple registry settingsmay appear in a single -batchoptions value, separated bywhitespace

l The -batchoptions valuemust be enclosed in double quotes if it contains anywhitespace
Example with registry settings specified in a file

maxwell.exe -batchsolve -batchoptions filename
projectname.aedt

where file filename contains:
$begin 'Config'

'Desktop/Settings/ProjectOptions/NumberOfProcessors'=4
'Maxwell/NumCoresPerDistributedTask'=2
'Desktop/ProjectDirectory'='C:/projects/test'

$end 'Config'

This command line overrides the values of the
Desktop/Settings/ProjectOptions/NumberOfProcessors and Desktop/ProjectOptions registry
settings. These overrides apply only to the current Maxwell session.

Note l The -batchoptions filename valuemust be enclosed in double quotes if it contains
whitespace

l The $begin 'Config' and $end 'Config' lines are required

-batchoptions and Relative Registry Paths
When you use the -batchoptions command line option, the registry paths specified on the command
line or in the batchoptions file are relative paths. The paths are relative to the current version of the
current product. If the examples above are used with Maxwell 2015, then the following table shows
the relative and absolute paths of the registry overrides in the above examples.
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Relative Path Absolute Path for Maxwell 2015
Desktop/Settings/ProjectOptions/Numbe
rOfProcessors

HKCU/Software/Ansoft/Maxwell/16.0/Preferences/Nu
mberOfProcessors

Desktop/ProjectDirectory HKCU/Software/Ansoft/Maxwell/16.0/Desktop/Project
Directory

For additional options and paths for use with -batchoptions, see
For -batchoptionsUse: Project Directory and Lib Paths
For -batchoptionsUse: TempDirectory
For -batchoptionsUse: VariousDesktop Settings
For -batchoptionsUse: Maxwell2D andMaxwell3D Optionswith Paths
When to use the -batchoptions Desktop Command Line Option
Many analysis parameter settingsmay be done using theGUI. For example, a number of Maxwell
optionsmay be set using theAdd Batch Option dialog boxwhich is brought up through theSubmit
Job To dialog. These parameter settings include the following solver options (not a complete list):

l tempdirectory
l DesiredRAMLimitInGB
l MaxRAMLimitInGB
l DefaultProcess Priority

The values of these parameters are saved in the registry whenMaxwell is not running.
When running a batch analysis, these parameters take the values from the registry.
The -batchoptionsDesktop command line option allows you to override the parameter values set in
the registry with values specified on the command line or in a file. The values specified using the -
batchoptions command line option only apply to the batch job, and do not affect the parameter
values in the registry. For example, you could specify the following command to ensure that this
analysis uses 2 processors for distributed processing and 2 processors for non-distributed
processing. If the -batchoptions value is not specified, then the number of processors for
distributed processing or for non-distributed processing could be affected by an interactiveMaxwell
job running on the same host as the same user.

"E:\Program Files\AnsysEM\AnsysEM18.0\Win64\ansysedt.exe"
-distributed includetypes=default maxlevels=1
-machinelist num=4 -monitor -ng
-batchoptions " 'Maxwell 3D/DefaultProcessPriority'='Normal'
'Maxwell 3D/DesiredRAMLimitInGB'=8
'Maxwell 3D/HPCLicenseType'='Pool'
'Maxwell 3D/MPIVendor'='Intel'
'Maxwell 3D/MaxRAMLimitInGB'=16
'Maxwell3D/NumCoresPerDistributedTask'=2
'Maxwell 3D/NumCoresPerDistributedTask'=2
-batchsolve E:\Users\jdoe\Documents\Ansoft\solenoid.aedt
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For -batchoptions Use: Project Directory and Lib Paths

The PersonalLib, syslib and userlib settings are a little different from other settings. If the final
directory name is different fromwhat is expected, then PersonalLib, syslib or userlib is appended as
a final directory. In addition, these settingsmay come from a different registry value if the registry
values shown above are not set

Path Name Default Value Units or
Values Description

Desktop/ProjectDirectory Ansoft subdirectory of user's
HOME directory or "My
Documents" directory

Directory
pathname

Directory where new
projects are created

Desktop/PersonalLib PersonalLib subdirectory of
user's HOME directory or "My
Documents" directory

Directory
pathname

Directory PersonalLib is
appended if final directory
is not PersonalLib

Desktop/syslib syslib subdirectory of
installation directory

Directory
pathname

Directory syslib is
appended if final directory
is not syslib

Desktop/userlib userlib subdirectory of
installation directory

Directory
pathname

Directory userlib is
appended if final directory
is not userlib

Related Topics

For -batchoptionsUse: TempDirectory
For -batchoptionsUse: VariousDesktop Settings
For -batchoptionsUse: Maxwell2D andMaxwell3D Optionswith Paths
RunningMaxwell from aCommand Line

For -batchoptions Use: TempDirectory.

Path Name Default Value Units or Values Description
TempDirectory Set by

installer
- Directory for temporary

files

Related Topics

For -batchoptionsUse: Project Directory and Lib Paths
For -batchoptionsUse: VariousDesktop Settings

Getting Started with Maxwell and RMxprt 3-50
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

For -batchoptionsUse: Maxwell2D andMaxwell3D Optionswith Paths
RunningMaxwell from aCommand Line

For -batchoptions Use: Various Desktop Settings

Note that most of these only affect the GUI.

Note The preferred IP address and preferred subnet address settings aremutually exclusive. If
both are specified to be non-empty strings, then the preferred IP address takes
precedence, and the preferred subnet address is ignored. This feature is typically used for
cluster environments using batch solves. The setting can bemade via batchoptions but can
also be done via UpdateRegistry.

Path Name

Defa
ult
Valu
e

Units or
Values Description

Desktop/Settings/ProjectOptions/AnimationMemory 200
Megaby
tes
(MB)

Stop animationswhen
availablememory falls
below this value

Desktop/Settings/ProjectOptions/AnsoftCOMPreferre
dIPAddress

""
(emp
ty
strin
g)

IP
Address
(as a
string)

IP Address used to
connect fromCOM
Engine to Desktop

Desktop/Settings/ProjectOptions/AnsoftCOMPreferre
dSubnetAddress

""
(emp
ty
strin
g)

Subnet
address

Specify the subnet that
engines use to connect
to the Desktop. Allowed
formats are:
1) IPv4 dotted decimal
network prefix
[example:
123.123.123.0] ,
2) IPv4 network prefix
and networkmask
separated by a slash
character "/" [example:
123.123.123.0/255.255
.255.0], or
3) IPv4 network prefix
and prefix length in
CIDR notation
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Path Name

Defa
ult
Valu
e

Units or
Values Description

[example:
123.123.123.0/24]

Desktop/Settings/ProjectOptions/AutoSaveInterval 10 edits Number of edits to allow
between autosaves

Desktop/Settings/ProjectOptions/AutoShowMessage
Window

1
(tru
e)

0 (false)
or 1
(true)

Show message window
on new messages

Desktop/Settings/ProjectOptions/AutoShowProgress
Window

0
(fals
e)

0 (false)
or 1
(true)

Show progresswindow
when starting a
simulation

Desktop/Settings/ProjectOptions/DiskLimitForAbort 0
Megaby
tes
(MB)

A warning is issued
when available disk
space falls below this
value

Desktop/Settings/ProjectOptions/DoAutoSave 1
(tru
e)

0 (false)
or 1
(true)

Enables autosaves if
true

Desktop/Settings/ProjectOptions/DrawStateIconsInPr
ojectTree3

1
(tru
e)

0 (false)
or 1
(true)

Change icon when
selection does not
match active window

Desktop/Settings/ProjectOptions/ExpandMessageTre
eOnInsert

1
(tru
e)

0 (false)
or 1
(true)

Ensure that new
messages are visible in
themessage window
tree

Desktop/Settings/ProjectOptions/ExpandOnInsert 0
(fals
e)

0 (false)
or 1
(true)

Expand project tree on
insert

Desktop/Settings/ProjectOptions/HighlightActive
ContextInProjectTree2

1
(tru
e)

0 (false)
or 1
(true)

Emphasize active
command context
(menu and toolbars)

Desktop/Settings/ProjectOptions/SavePreviewImages
InProject
File

1
(tru
e)

0 (false)
or 1
(true)

Save preview images in
project file

Desktop/Settings/ProjectOptions/UpdateReportOnFile
Open

0
(fals
e)

0 (false)
or 1
(true)

Update reports on file
open
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Related Topics

For -batchoptionsUse: Project Directory and Lib Paths
For -batchoptionsUse: TempDirectory
For -batchoptionsUse: Maxwell2D andMaxwell3D Optionswith Paths
RunningMaxwell from aCommand Line

For -batchoptions Use: Maxwell2D and Maxwell 3D Options with Paths

Here are theMaxwell Optionswith the complete path names:

Path Name Default
Value Units or Values Description

Maxwell2D (or
3D)/HPCLicenseType

"pack" "pool" or "pack" For Maxwell2D Designs: "pool" =
multiprocessing enabled byHPC
licensing; "pack" = multiprocessing
enabled byHPC Pack licensing

Maxwell2D (or
3D)/MaxRAMLimitInGB

0 (No
Limit)

GB This setting specifies the absolute
maximummemory usage in GB. Type:
Floating Point, Min: 0, Max: 1000000.

Maxwell2D (or
3D)/DesiredRAMLimitInGB

0 (No
Limit)

GB Preferredmemory use in GB. Type:
Floating Point, Min: 0, Max: 1000000.

Maxwell2D(or
3D)/DefaultProcessPriority

Normal Allowed values:
"Critical", "Above
Normal",
"Normal", "Below
Normal", "Idle"

Specifies the default priority of
distributed tasks.

Maxwell2D(or
3D)/SolveAdaptiveOnly

1 Allowed values: 0
(false), 1 (true)

If true, only the adaptive portion of the
setup will be solved. Applies only if a
single setup is selected.

Maxwell2D(or
3D)/CreateStartingMesh

0 Allowed values: 0
(false), 1 (true)

If true, the startingmesh (with mesh
operations if applicable) will be created,
but none of the setup will be solved.
Applies only if a single setup is selected.

Related Topics

For -batchoptionsUse: Project Directory and Lib Paths
For -batchoptionsUse: TempDirectory
For -batchoptionsUse: VariousDesktop Settings
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RunningMaxwell from aCommand Line

Running from a Windows Remote Terminal
When runningMaxwell from a remote terminal, there are some performance and behavior issues to
consider. These issues are due to the interaction of bandwidth/opengldrivers/remote-terminal-
protocol

l Showing axeswhen interactively drawing objects will slow the performance.
l Remote OpenGL performance will be slower in general. Graphics card and driver quality
helps.

l All 3D windowswill be closed when you switch from remote PC to a console or from a console
to remote. This is to avoid display/opengl instability during the switch.

l Grid will not be turned off while viewing a plot from a remote desktop. Themouse over
highlights on 2D plotsmay appear as not totally overlapping the line color or as thin dotted
lines.

Related Topics

Remote Analysis
Modifying theModel View

Windows HPC Commands
HPC Integration allows you to submit jobs directly using ANSYS Electromagnetics command line
arguments for batchsolves. The supported HPC software is described in the ANSYS
Electromagnetics Installation Guide. ANSYS Electromagnetics productsmust be accessible from
the same directory on all machines. The ANSYS Electromagnetics command line syntax is
documented here. Youmust pass in a -distributed flag as part of the ANSYS Electromagnetics
command line arguments if you want to run a distributed simulation.
Before running a job youmust select Tools>JobManagement>Select Scheduler and use the
dialog to designate the head node of a cluster. You can then selectTools>Job
Mangement>Submit Job to submit the batch commands for the job.

Related Topics

High Performance Computing (HPC) Integration

Getting Started Guides
The following getting started guides are available to assist you in familiarizing yourself with the
features and function of ANSYS ElectromagneticsMaxwell software suite.

l 3D Rotational Actuator with Parametrics
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l 3D Transient Rotational Actuator ProblemwithMotion
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l 2D Magnetostatic Solenoid Problemwith Parametrics
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A 3D Rotational Actuator Magnetostatic Problem with Parametrics

After you insert a Maxwell design, you can access this Getting Started Guide fromHelp>Getting
Started Guides.
This Getting Started Guide is written for Maxwell beginners and experienced users who would like to
quickly familiarize themselveswith the capabilities of Maxwell 3D. This guide leads you step-by-step
through creating, solving, and analyzing the results of solving a 3D rotational actuator magnetostatic
problem.
By following the steps in this guide, you will learn how to perform the following tasks:

l Draw a geometricmodel.
l Modify amodel’s design parameters.
l Assign variables to amodel’s design parameters.
l Specify solution settings for a design.
l Validate a design’s setup.
l Run aMaxwell simulation.
l Plot themagnetic flux density vector.
l Run a parametric analysis.
l Create an animation using saved parametric field data.
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A 3D Transient Rotational Actuator Problem with Motion

After you insert a Maxwell design, you can access this Getting Started Guide fromHelp>Getting
Started Guides.
This Getting Started Guide is written for Maxwell beginners and experienced users who would like to
quickly familiarize themselveswith the capabilities of Maxwell 3D. This guide leads you step-by-step
through creating, solving, and analyzing the results of solving a Transient rotational actuator problem
withmotion. ThisGetting Started Guide builds on the problem and techniques presented in the 3D
rotational actuator magnetostatic problem.
By following the steps in this guide, you will learn how to perform the following tasks:

l Import a geometricmodel.
l Modify amodel’s design parameters.
l Assign variables to amodel’s design parameters.
l Specify solution settings for a design.
l Validate a design’s setup.
l Run aMaxwell simulation.
l Plot themagnetic flux density vector.
l Includemotion in the simulation.

A 2D Magnetostatic Solenoid Problem with Parametrics

After you insert a Maxwell design, you can access this Getting Started Guide fromHelp>Getting
Started Guides.
This Getting Started Guide is written for Maxwell beginners and experienced users who would like to
quickly familiarize themselveswith the capabilities of Maxwell 2D. This guide leads you step-by-step
through creating, solving, and analyzing the results of solving a 2D asymmetric solenoid
magnetostatic problemwith parametric analysis.
By following the steps in this guide, you will learn how to perform the following tasks:

l Draw a geometricmodel.
l Modify amodel’s design parameters.
l Assign variables to amodel’s design parameters.
l Specify solution settings for a design.
l Validate a design’s setup.
l Run aMaxwell 2D simulation.
l Plot the simulation results.
l Set up a parametric sweep analysis varyingmultiple solution variables.
l Plot families of curves of the parametric results.
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4 - Getting Help
ANSYS Technical Support
For information about ANSYS Technical Support, go to the ANSYS corporate Support website,
www.ansys.com/Support. You can also contact your ANSYS account manager to obtain this
information.
E-mail can work well for technical support. All Maxwell software files are ASCII text and can be sent
conveniently by e-mail. When reporting difficulties, it is extremely helpful to include very specific
information about what stepswere taken or what stages the simulation reached. This allowsmore
rapid and effective debugging.

Help Menu Options
TheHelpMenu displays different selections depending upon the type of design inserted to the active
project (such asMaxwell, HFSS). The following describes the basic selections displayed on the Help
Menu.

l Maxwell Help opens to theMaxwell help within the Electronics help system.
l Maxwell Scripting Help opens toMaxwell's scripting help.
l Maxwell Getting Started Guides opens to a list of links to theMaxwell Getting Started
Guides. TheseGetting Started Guideswalk you through projects that demonstrate features of
the product solvers.

l Maxwell PDFs opens amenu that links to PDFs forMaxwell Help,Maxwell Scripting, and
Maxwell Getting Started Guides. These PDFs provide a format and function that is better
suited for printing. For example, you can print ranges of pages encompassing topics and
subtopics as needed.

l Maxwell Components is enabled when you insert a Maxwell Circuit design into the active
project, and opens theMaxwell Components help to a section that pertains to the component
type.

l ANSYS Customer Support opens a browser page to the ANSYS Customer Portal. At the
website you can learnmore about ANSYS products and services and log on to contact
ANSYS technical support staff.

l What’s New in this Release opens a PDF that describesWhat’s New in ANSYS
Electronics Desktop for the release.

l ANSYS Product Improvement Program opens a dialog that describes the Product
Improvement Program option. You can choose "Yes, I amwilling to participate in the
ANSYS Product Improvement Program" or "No, I am not willing to participate." This dialog
describes the program, the information that is reported, and customer privacy protections.

l About ANSYS Electronics Desktop opens a dialog that displays the ANSYS®
Electromagnetics Suite release number and contains tabs that show information about the
Installed Components andClient License Settings that have been installed.

F1 Context-Sensitive Help
To accessF1 help from the ANSYS Electronics Desktop user interface, do one of the following:

Maxwell Online Help
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l To open a help topic about amenu option, hover the cursor over the item and press F1. You
can also pressShift+F1 on the item.

l To open a help topic about a dialog box, open the dialog box, and then pressF1.

Related Topics

Scripting in Maxwell

Conventions Used in the Online Help
The following documentation conventions are used in the online help.

l Procedures are presented as numbered lists. A single bullet indicates that the procedure has
only one step.

l Bold type is used for the following:
- Keyboard entries that should be typed in their entirety exactly as shown. For example, "copy
file1" means to type the word copy, to type a space, and then to type file1.
- On-screen prompts andmessages, names of options and text boxes, andmenu commands.
Menu commands are often separated by carats. For example, clickFile>Open.
- Labeled keys on the computer keyboard. For example, "PressReturn" means to press the
key labeledReturn.

l Italic type is used for the following:
- Emphasis.
- The titles of publications.
- Keyboard entries when a name or a variablemust be typed in place of the words in italics.
For example, "copy file name" means to type the word copy, to type a space, and then to type
a file name.

l The plus sign (+) is used between keyboard keys to indicate that you should press the keys at
the same time. For example, "PressShift+F1" means to press theShift key and the F1 key at
the same time.

l Toolbar buttons serve as shortcuts for executing commands. Toolbar buttons are displayed
after the command they execute. For example,

"On theDrawmenu, clickLine " means that you can click the Draw Line toolbar button to
execute the Line command.

Finding Information in the Help
The online help system provides four ways to find information and navigate quickly:

l A hierarchical table of contents - To browse through the table of contents, click theContents
tab. The table of contents is an expandable list of important topics. You can expand or collapse
the list, and then jump to detailed information for a topic by clicking the topic title.
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l A searchable index - you can search for indexed terms by typing the text field, and jump to
topic locations by clicking on them.

l A full text search - you can type text, and search the entire online help. Items are listed
according to rank in discussing the search text. For more information, see Using the Search
Function in the Help.

Using the Search Function in the Help

When you enter words or strings to search for in the online help, the search engine, by default, lists
all topics in which any of the words occur. For example, if you enter “voltage source” without the
quotationmarks, the results show all topics that contain “voltage” or “source.” Thismethod probably
providesmore hits than you want. The Search function in the online help provides several methods
for making searchesmore specific.

Performing a Basic Search
1. Type the words or string you are searching for in the search box.

l If you are searching within the full Electronics help system, the search box includes a
drop-down filter for specifying a product or searching across all products. When you
change the filter, the results dynamically change to the selected filter.

l If you used F1 to access the help for a specific product, the search box permits searches
for that product only.

2. Click on the topic you want in the list results.
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l If you want to view a different topic, press your browser's back button to return to the list
results.

l To turn off highlighting on the page you are viewing, click the Remove Highlights icon

Searching with Quotation Marks
If you enter “voltage source” with the quotationmarks, the results show all topics that include the
phrase.
If you want to limit the resultsmore, you can enter additional words, such as:

“voltage source” transient solver

Notes
l Searches are not case sensitive, so you can type your search in uppercase or lowercase
characters.

l Youmay search for any combination of letters (a-z) and numbers (0-9).
l Punctuationmarks (other than the questionmark) such as the period, colon, semicolon,
comma, and hyphen are ignored during a search.

l If you are searching for a file namewith an extension, you should group the entire string in
quotationmarks, such as "filename.ext."

Using WebUpdate
Automatic updates for ANSYS Electronics Desktop, which includesMaxwell and RMxprt, are
available over theWeb.
To control the timing of automaticWeb updates, use theWeb Update panel underGeneral on the
Options dialog box. SeeWebUpdate Options for details.

Obtaining Information About the Software and Release
To obtain information about

1. ClickHelp>About ANSYS Electronics Desktop to open theAbout ANSYS®
Electromagnetics Suite [release number] dialog.

2. Click the Installed Components tab to view a list of software installed.
3. Click theClient License Settings tab to view information about the following:

l Provider Name
l FlexNet Publisher Host IDs
l FlexNet Publisher Servers
l Admin Directory
l Customer Number
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l FLEXlmVersion
l Redirect Info

4. To export the software information:
a. ClickExport.

TheSave As dialog box appears.
b. Browse to the location where you want to save the information as a text file.
c. Type a name for the file in the File name text box. TheSave as type pull-down list is

already specified asExport (*.txt).
d. ClickSave.

5. ClickOK to close the About ANSYS® Electromagnetics Suite [release number] dialog.
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5 -Working with Maxwell Projects and Designs
AMaxwell project is a folder that includes one or moreMaxwell models, or designs. Each design
ultimately includes a geometricmodel, its boundary conditions andmaterial assignments, and field
solution and post-processing information.
A new project calledProjectn is automatically created when the software is launched, where n is a
number. If you select the Insert a design of type radio button on the Desktop Configuration options
panel, a design of the specified type is automatically created for the new project. You can also open a
new project by clicking File>New. In general, use the Filemenu commands tomanage projects. If
youmove or change the names of files without using these commands, the softwaremay not be able
to find information necessary to solve themodel.

Maxwell Files
When you create an ANSYS Electronics Desktop project, it is given an .aedt file extension and
stored in the directory you specify. Any files related to that project are also stored in that directory.
Some common file and folder types are listed below:

.aedt Maxwell project.
project_
name.
aedtresults

Maxwell folder containing results data for a project.

design_
name.results

Maxwell folder containing results data for a design. This folder is stored in the
project_name.aedtresults folder.

design_
name.asol

Maxwell results data for a design. This file's contentsmay be empty if a solution is
unavailable. This file is stored in the project_name.aedtresults folder.

.cls Ansoft legacy EMprojects.

Creating Projects

1. ClickFile>New .
A new project is listed in the project tree. It is named Projectn by default, where n is the order in
which the project was added to the current session.
Project definitions, such asmaterial assignments, are stored under the project name in the
project tree.

2. ClickProject>Insert Maxwell (2d or 3D) Design.
You specify the name of the project when you save it using the File>Save or File>Save As
commands.

Maxwell Online Help
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Note To insert an RMxprt design, clickProject>Insert RMxprt
Design.

Creating New 2D Designs from 3D Designs
TheMaxwell system contains both 2D and 3D projects. Often, youmaywant to take a cross section
of a 3D model to perform a 2D analysis. The following cases represent the scenarios available for
automatically convertingmodels.

l 3D model to 2D XYmodel
l 3D model to 2D RZmodel

Youmust keep the following points in mind before you convert any project:
l A 2D design is created in the same project.
l All 3D geometry is used, you cannot select which geometry to include in the conversion.
l If there are any sheet objects in 3D, only those sheets that lie in the same plane as the section
plane are converted.

l 1D objects are not converted from 3D to 2D.

Related Topics

Converting a 3D Model to 2D

Converting a 3D Model to 2D

To create a 2D design from an existing 3D design:
1. ClickMaxwell3D>Create 2D Design.

TheCreate 2D Design dialog box appears.
2. Select theCoordinate System to be used for creating sections in the 3D model.
3. Choose theSection Planewithin the chosen coordinate system. You can choose XY, YZ, or

ZX.
4. Select theGeometry Mode, to use for the target 2D design. You can choose either XY or RZ.

5. ClickOK to create the 2D design.
Themodeler creates a new design within the current project and generates the 2D model within the
new design. All material properties andmaterial assignments are copied to the new design.

Related Topics

Creating a Cross-Section
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Creating New 3D Designs from 2D Designs
TheMaxwell system contains both 2D and 3D projects. Often, youmaywant to sweep or rotate a 2D
model to create a full 3D design. The following cases represent the scenarios available for
automatically convertingmodels from 2D to 3D.

l 2D XYmodel to 3D model
l 2D RZmodel to 3D model

Youmust keep the following points in mind before you convert any project:
l A 3D design is created in the same project.
l All 2D geometry is used, you cannot select which geometry to include in the conversion.
l 1D objects are converted from 2D into 3D sheet objects.

Related Topics

Converting 2D XYModel to 3D
Converting 2D RZModel to 3D

Converting 2D XY Model to 3D

To create a 3D design from an existing 2D XY design:
1. ClickMaxwell2D>Create 3D Design.

TheSweep Along Vector dialog box appears.
2. Enter a value in the Length along z-axis box to obtain a swept length of themodel.
3. Choose the desiredDimension of the sweep distance entered from the pull-downmenu.
4. ClickOK to create the 3D design.

Themodeler creates a new design within the current project and generates the 3D model within the
new design. All material properties andmaterial assignments are copied to the new design.

Related Topics

Sweeping Along a Vector

Converting 2D RZ Model to 3D

To create a 3D design from an existing 2D RZ design:
1. ClickMaxwell2D>Create 3D Design.

TheSweep Around Z Axis dialog box appears.
2. Enter theAngle of Sweep to obtain a full 360° 3D-model or a wedgemodel to a selectable

degree.
3. Enter the desiredDraft Angle andDraft Type.

Note Entering a draft angle for amodel where objects touch the z axis results in a error
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due to an invalid object being requested. Draft anglesmay only be used when no
objects are touching the z axis.

4. Enter theNumber of Segments to use in creating the 3D model. If you do not change the
default value (=0), the project will be created with true surfaces.

5. ClickOK to create the 3D design.
Themodeler creates a new design within the current project and generates the 3D model within the
new design. All material properties andmaterial assignments are copied to the new design.

Related Topics

Sweeping Around an Axis

Opening Projects
Open a previously saved project using the File>Open command.

1. ClickFile>Open.
TheOpen dialog box appears.

2. Use the file browser to find theMaxwell project file.
By default, Maxwell files are displayed. To see other files, change the file filter in the Files of
type pull-down list.

3. Select the file you want to open.
4. ClickOK.

The project information appears in the project tree.
If you open another project without editing the automatically-created project, Maxwell removes
the automatically-created project.

You can also open a saved project by:
l Dragging aMaxwell project file icon to theMaxwell icon.
l Dragging aMaxwell project file icon to theMaxwell desktop.
l Double-clicking on aMaxwell project file icon.

Related Topics

Opening LegacyMaxwell Projects
Opening Example Projects

Opening Example Projects

You can directly access and open example projects included with product install by using File>Open
Examples. This displays a browser open to the Examples folder in the product install. You can
select from various display styles for the folders and projects.
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The online help contains additional descriptions of these projects.

Related Topics

Example Projects

Opening Recent Projects

To open a project you recently saved inMaxwell:
l Click the name of the project file at the bottom of the Filemenu.

Note If you open another project without editing the automatically-created project,
Maxwell removes the automatically-created project.

Opening Legacy Maxwell Projects

Maxwell 2015 cannot open legacy *.cls projects. However, Maxwell version 16 can be used to open
legacy .cls projects, which can then be saved as version 16 .mxwl projects. These files can then be
opened inMaxwell 2015.

Legacy Maxwell Project Translation Considerations
When you open a legacyMaxwell project in version 16, virtually all of the project's pre-processing
data is translated. Solution results andOptimetrics setup data are unavailable; however, the nominal
model created for Optimetrics can be translated.
Objects that were considered non-model in the legacy project (Model Object check boxwas cleared
in the Properties dialog) are translated but remain non-model objects in the translated project.
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Following are additional notes about the translation of legacy project information:

Model
Geometry

l The translated geometry's construction history is unavailable; therefore, the
original object properties you defined cannot bemodified in theProperties
window. However, you canmodify the geometry usingMaxwell'smodeling
features.

l For units unavailable in the current version of Maxwell, such as yards, the
nearest available units are used; themodel is scaled slightly to fit the new units.

Excitations
and
Boundaries

l Boundaries assigned to named interface selections or rectangle selections are
not translated.

l For a boundary assigned to the intersection of two faces, Maxwell 16 will create
a new 2D sheet object from the intersecting area and assign the boundary to
that object.

Materials l Functions defined in legacy projects become project variables in version 12 and
later; therefore, functional material properties and functional material
assignment angles are not translated.

l Perfect conductors become regular materials with conductivity values of 1E30.
Maxwell 12 and later uses a conductivity threshold that treats all conductors
over the threshold as perfect conductors.

l Object coordinate systems are created for objects assigned anisotropic
materials in legacy projects. The coordinate system is defined at the same
origin as the global coordinate system, with the same orientation defined when
the anisotropicmaterial was assigned to the object in the legacy project.

l Nonlinear materials from legacy projects that havemagnetic saturation values
greater than zero are treated as ferrite materials in version 16. Their properties
are not modified.

l When translating a legacy project, Maxwell does not import any variables that
depend on intrinsic variables (this feature is unavailable in Maxwell 12 and later
versions). For material properties depending on intrinsic variables, the variable
reference is replaced with its expanded expression.

Mesh
Operations

l Mesh refinement operations performed on arbitrary boxes in legacy projects
are ignored.

l Area-based and volume-basedmesh operations are translated as length-
basedmesh operations in version 12 and later by taking their square roots and
cube roots, respectively.

Optimetrics l Setup information, including design variables, is not supported; however, the
nominal model can be translated.

l Parameterizing a translatedmodel is limited because geometry construction
history is unavailable.

Solution
Setup

l The design's initial mesh is used for the solution. Meshes are not translated.

Solutions l Solution data is not translated; therefore, youmust solve legacyMaxwell
projects again.
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Saving Projects
Use the File>Save As command to do the following:

l Save a new project.
l Save the active project with a different name or in a different location.

Use the File>Save command to save the active project.
Maxwell has a "Save before solving" setting located in the Tools>Options>Maxwell (3D, or 2D)
Options or Tools/Options/RMxprt Optionsmenu. By default this is on. However, for efficiency
reasons, the project is only saved if it has beenmodified since its last save.
A prompt appears when you attempt to save a previously versioned file. If you agree to the prompt,
the file is upgraded to theMaxwell version in which you are running the software. In this case the file
may no longer be compatible with previous versions. If you do not agree to the prompt, the file is not
saved, so the file retains the previous compatibility.
If you have a simulation running, you see a warning that if you continue, Maxwell will abort the
simulation. If youOK the warning, Maxwell aborts the simulation and saves the project.

Related Topics

Saving a New Project
Saving the Active Project
Saving a Copy of a Project
Saving a Project as a Technology File

Saving a New Maxwell Project

1. ClickFile>Save As.
TheSave As dialog box appears.

2. Use the file browser to find the directory where you want to save the file.
3. Type the name of the file in the File name box.

By default, all files have the .aedt extension.
4. ClickSave.

ANSYS Electronics Desktop saves the project to the location you specified.

Warning Be sure to save geometricmodels periodically. Saving frequently helps prevent the loss
of your work if a problem occurs. Although ANSYS Electronics Desktop has an "auto-
save" feature, it may not automatically save frequently enough for your needs.

Related Topics

Saving the Active Project
Saving a Copy of a Project
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Saving the Active Maxwell Project
l ClickFile>Save.
Maxwell saves the project over the existing one.

Warning Be sure to save geometricmodels periodically. Saving frequently helps prevent the loss
of your work if a problem occurs. AlthoughMaxwell has an "auto-save" feature, it may
not automatically save frequently enough for your needs.

Related Topics

Saving a New Project
Saving a Copy of a Project

Saving a Copy of a Project

To save an existing, active project with a new name, a different file extension, or to a new location:
1. ClickFile>Save As.
2. Use the file browser to find the directory where you want to save the file.
3. Type the name of the file in the File name box.
4. ClickSave.

Maxwell saves the project with the new name or file extension to the location you specified.

Related Topics

Saving a New Project
Saving the Active Project

Save a Project as a Technology File

1. ClickFile>Save As Technology File.
TheSave to user library dialog box appears.

2. Click thePersonalLib button orUserLib button to specify the location to save the file.
3. Type the name of the file in the File name box.

By default, all technology files have the .asty extension.
4. ClickSave.

Related Topics

Saving a New Project
Saving the Active Project
Saving a Copy of a Project
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Renaming a Project

To rename an existing, active project:
1. Select the project in the Project tree.
2. Right-click to display the short-cut menu.
3. SelectRename.

This activates the text field for the project name.
4. Type the new project name and press enter.

The new project name appears in the directory and the project remains in the original location.

Saving Project Data Automatically

Maxwell stores recent actions you performed on the active project in an ANSYS Electronics Desktop
auto-save file in case of a sudden workstation crash or other unexpected problem. The auto-save file
is stored in the same directory as the project file and is named Projectn.aedt .auto by default, where
n is the order in which the project was added to the current session. After you have done aSave As,
the autosave file name is <name>.aedt.auto, where <name> is the name you gave the project when
saving.
ANSYS Electronics Desktop automatically saves all data for the project to the auto-save file, except
solution data. By default, ANSYS Electronics Desktop automatically saves project data after every
ten edits. An "edit" is any action you perform that changes data in the project or the design, including
actions associated with project management, model creation, and solution analysis.
With auto-save activated, after a problem occurs, you can choose to re-open the original
project file (Projectn.aedt ) in an effort to recover the solution data or to open the auto-save file. If a
crash recovery file contains 0 bytes, the other file is opened instead.
Tomodify the auto-save settings:

1. ClickTools>Options>General Options.
TheOptions dialog box appears.

2. Under theGeneral>Desktop Configuration tab, verify thatDo Autosave is selected.
This option is selected by default.

3. In theAutosave interval box, enter the number of edits that you want to occur between
automatic saves. By default, this option is set at 10.
Note Auto-save always increments forward; therefore, even when you undo a command,

ANSYS Electronics Desktop counts it as an edit.

4. ClickOK to apply the specified auto-save settings.
Once the specified number of edits is carried out, a "model-only" save will occur. Thismeans
that ANSYS Electronics Desktop does not save solutions data or clear any undo/redo history.
When ANSYS Electronics Desktop auto-saves, an ".auto" extension is appended to the
original project file name. For example, "Project1.aedt " is automatically saved as
"Project1.aedt .auto".
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Warning When you close or rename a project, ANSYS Electronics Desktop deletes the auto-save
file. ANSYS Electronics Desktop assumes that you have saved any desired changes at
this point.

Related Topics

Recovering Project Data in an Auto-Save File

Save Before Solve Option

The Tools>Options>Maxwell 3D Options, Tools>Options>Maxwell 2D Options or
Tools/Options/RMxprt Options commands each display a dialog with a check box for an
automaticSave before solving option. Themain purpose is to force a full save before running the
solve.
In the case where you start a solve while another solve is running, and theSave before solving
option is set, Maxwell asks if you want solve without saving first. This lets you domultiple solves, and
if you have not edited the project in between solves, crash recovery will work. In any case, you can
start a new solve while running another without having to abort the running solve.

Recovering Project Data in an Auto-Save File

Following a sudden workstation crash or other unexpected problem, you can recover the project
data in its auto-save file.

Warning When you recover a project's auto-save file you cannot recover any solutions data;
recovering an auto-save file means you will lose any solutions data that existed in the
original project file.

To recover project data in an auto-save file:
1. If ANSYS Electronics Desktop has crashed, launch ANSYS Electronics Desktop from your

desktop.
2. ClickFile>Open.
3. Select the original Projectn.aedt project file for which you want to recover its Projectn.aedt

.auto auto-save file.
TheCrash Recovery dialog box appears, giving you the option to open the original project file
or the auto-save file.

4. SelectOpen project using autosave file to recover project data in the auto-save file,
and then click OK. Maxwell replaces the original project file with the data in the auto-save
file.
ANSYS Electronics Desktop immediately overwrites the original project file data with the auto-
save file data, removing the results directory (solutions data) from the original project file as it
overwrites to the auto-save file.

Warning If you choose to recover the auto-save file, you cannot recover the original project file

Working with Maxwell Projects and Designs 5-10
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

that has been overwritten; recovering data in an auto-save file is not reversible.

Related Topics

Saving Project Data Automatically

Saving a Project From a Previous Version

When you open aMaxwell project from a version earlier than version 11, Maxwell creates a new
project. The v10 or earlier project is not modified.

Archiving Projects
Use the File>Archive... command to “bundle” a project – and any other files related to the project
that you want to include – in an .mxwlz file or .zip format archive. You can include notes about the
contents of the archive and specify whether to include results and solution files, or related external
files. The Archive command attempts to automatically detect the necessary files for linked projects
and automatically include them in the archive. For example, if a project linked to themain project also
has linked or associated files, you can add them.

Archive File Types
Internally, project archive files are .zip files, and are compatible with any program that can read .zip
files (e.g. WinZip, 7Zip). The naming convention is that project archive files will have an extension
that is unique for each product. The extension is generated by adding a 'z' to the project file extension
(e.g..hfssz, .mxwlz). This extension will be displayed as the default when saving and restoring
archive files. Note that .zip files are also included as a possible filter in file selection dialogs.

File Relocation Considerations
In a project to be archived, external files can be located anywhere on the user's system. One of the
goals is for the restored project to be relatively self contained, and NOT to allow the restoration of an
archived project to haphazardly write files anywhere on the restoring user's system.
To achieve this, it is sometimes necessary to change the location of files in the archived project such
that the external files are now located in the project directory. At archive time, any external files not
located in the project directory are relocated to the restored_files subdirectory of the project
directory in the archived project. Any external files located in the user library or system library will be
relocated to the personal library directory. Note that the project file that is written into the archive will
be updated to refer to the files at the new locations, and the original project file will remain unaltered.

Archive Preview
The Archive command includes a preview feature that lets you review the contents of a planned
archive.
To archive the current project:

1. ClickFile>Archive...
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TheArchive Options dialog opens.

Archive notes: you can specify notes that will be visible when previewing the archive. These
notes can be viewed from the preview dialog without actually restoring the archive.
External Files: selecting this check boxwill cause all external files to be included in the
archive. The External Files check box refers to any existing files associated with the project,
such as linked files, or files added through theProject>Insert Documentation File
command or Project>Data Set command.
Results/solution files: selecting this check boxwill cause the entire results directory to be
included in the archive. Thismay greatly increase the size of the archive file.
ClickingAdditional Files... opens theAdd Additional Files to Archive dialog.
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Here, you can clickAdd... to open a file browser to locate any additional files (such as
documentation files or datasets) you want to include in the archive. You can also select and
thenRemove any files listed, andOK orCancel any proposed changes.

2. Select any optional items, andmake any desired archive notes in the text field.
3. When you havemade your selections for optional items, you can selectPreview Archive to

look at the archive contexts, and the locationswhere restoring from the archive would place
them.

Check theResults/solution option if you want to archive those files. Below is a preview
showing some included results files.

To read longer locations, you can drag the column headers to expand the columns. Use the
scroll bar to view longer lists.
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Previewing an archive before creating the archive can be helpful in order to see exactly what
files will be included in an archive, as well as how those files are being relocated. Another
purpose of previewing an archive is to view warnings and consider if any additional files need
to be added to the archive.
The preview dialog also displays the archive notes, creation date, and the number of included
files.

4. When you are ready to create the archive, close the preview, and specify the format you want
to use, .mxwlz or .zip, and specify the archive location and name. ClickOK to create the
archive.

Related Topics

Restoring Archives

Restoring Archives
To restore an existing archive created with File>Archive:

1. ClickFile>Restore Archive
This displays anArchive to Restore browser window that lets you navigate your file system
for archive files of type .mxwlz or .zip.

2. After selecting a valid archive file, you can clickView Archive to preview the contents.
The preview dialog shows the samewarnings that were generated at archive time. These
warningsmay be useful to identify additional steps that are needed to update any files to refer
to files which had to bemanually added to the archive.

3. ClickOpen to display aProject File Restore Location browser and navigate to the place
where you want to restore the file.
You can edit the file name, and check options toOverwrite existing files and toOpen
project after restoring.

4. ClickSave to restore the archived file. A dialog displays progress and results of the restoration
process.
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A full log file is also generated which contains detailed information about the restore process.
The first line in the text window displays the location of the full log file. After the restore has
been completed, you can clickView Full Log to display a detailed log of the restoration.

Related Topics

Archiving Projects

Downloading Content from Servers
If your installation has access to a server location containing project archives or other files, you can
use File>Download From Server to access them.
For Archive files, clickFile>Download from Server>Project Archives...
This opens theArchive Libraries Access dialog.
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Here you specify a User ID, Password, and Server address. You can then browse for and select the
files needed.
For File Libraries Access, clickFile>Download From Server>Other Files...
This opens the File Library Access dialog.

Here you specify a User ID, Password, and Server address. You can then browse for and select the
files needed.

Closing a Project
To close aMaxwell or RMxprt project:

l ClickFile>Close.
If the project has not been saved since the last change, amessage appears asking if you want to
save the project before closing it. Do one of the following:

l ClickYes to save the project.
l ClickNo to close the projectWITHOUT saving it.
l ClickCancel to keep the project open.

Deleting Projects
To delete a project:

1. Select the project in the project tree.
2. Click either Edit>Delete, or right click to display the short-cut menu and selectDelete.

A dialog displays themessage: "The project selected and all its files will be deleted from the
permanent storagemedium. ClickOK to proceed."

3. ClickOK to delete the files orCancel to retain them.

Exiting Maxwell and RMxprt
To exit theMaxwell and RMxprt interfaces:
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l ClickFile>Exit.

Undoing Commands
Use theUndo command on theEditmenu to cancel, or undo, the last action you performed on the
active project or design. This is useful for undoing unintended commands related to project
management, model creation, and post-processing.

1. In theProject Manager window, do one of the following:
l To undo the last action you performed on the active project, such as inserting a design or
adding project variables, click the project icon.

l To undo the last action you performed on the active design, such as drawing an object or
deleting a field overlay plot, click the design icon.
Note You cannot undo an analysis that you have performed on amodel, that is, the

Maxwell>Analyze command.

2. ClickEdit> Undo, or click theUndo button on the toolbars.
Your last action is now undone.

Note When you save a project, Maxwell always clears the entire undo/redo history for the
project and its designs.

Related Topics

Redoing Commands

Redoing Commands
Use theRedo command on theEditmenu to reapply, or redo, the last action that was canceled, or
undone. You can redo a canceled action related to project management, model creation, and post-
processing.

1. In theProject Manager window, do one of the following:
l To redo the last action you canceled on the active project, such as inserting a design or
adding project variables, click the project icon.

l To redo the last action you canceled on the active design, such as drawing an object or
deleting a field overlay plot, click the design icon.

2. ClickEdit>Redo, or click theRedo button on the toolbars.
Your last canceled action is now reapplied.

Note When you save a project, Maxwell always clears the entire undo/redo history for the
project and its designs.
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Related Topics

Undoing Commands

Removing Unused Components from a Project
To remove unused components from a project:

1. ClickTools>Project Tools>Remove Unused Definitions.
TheUnused Definitions dialog box appears.

2. Select theDelete check box for any components you want to remove.
l You can also click theSelect All button to select all components listed.

3. ClickApply.
A warningmessage appears, telling you that the undo/redo history will be cleared for the
project.

4. ClickOK to continue, or clickCancel to cancel the deletion.
5. When you are finished removing components, clickOK to close theUnused Definitions

dialog box.

Updating Design Components
To update components defined in the current design:

1. ClickTools>Project Tools>Update Definitions.
TheUpdate Definitions dialog box appears.

2. Select one of the following two radio buttons.
l Show Itemswith newer definitions
l Show All Items

3. From theShow Types list in the List Options section, select the types of definitions you want
to show in the Item List list.

4. Select the item you want to update from the Item List list.
5. Click the Select All orUnselect All buttons to select or clear all items listed.
6. ClickUpdate.

A message appears telling you the update was successful. ClickOK to close themessage.
7. When you are finished updating definitions, clickClose.

Managing Projects and Designs

Copy and Paste a Project or Design

To copy a project or design:
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1. Select a project or design in the project tree in Project ManageWindow to enable themenu
commandEdit>Copy.

2. ClickEdit>Copy. The project or design is copied for pasting.
To paste a project or design:

1. Select a project or design in the project tree in Project ManageWindow to enable themenu
commandEdit>Paste.

2. ClickEdit>Paste. The project or design is pasted under the selected project, an icon is added
to the project tree.

Rename a Project or Design

1. Right click the design icon to display the shortcut menu, as shown.

2. ClickRename in the shortcut menu.
3. Define the new name for the design by typing it directly into the Project Window.
4. PressEnter to complete the rename.
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Delete a Project or Design

1. Select a project or design in the project tree in Project ManageWindow to enable themenu
commandEdit>Delete.

2. ClickEdit>Delete, or theDelete key.
3. Confirm the warning box to complete the delete operation, the icon is removed from the

project tree.

Validating Designs
Before you run an analysis on amodel, it is very important that you first perform a validation check on
the design.When you perform a validation check on a design, Maxwell runs a check on all setup
details of the active design to verify that the necessary steps have been completed and their
parameters are reasonable.
To perform a validation check on the active design:

1. ClickMaxwell3D or Maxwell2D, and then selectValidation Check.
Maxwell checks the project setup, and then the Validation Checkwindow appears.

2. View the results of the validation check in theValidation Checkwindow.
The following icons can appear next to an item:

Indicates the step is complete.

Indicates the step is incomplete.

Indicates the stepmay require your
attention.

3. View anymessages in theMessage Manager window.
4. If the validation check indicates that a step in your design is incomplete or incorrect, carefully

review the setup details for that particular step and revise them as necessary.
5. Run a validation check after you have revised any setup details for an incomplete or incorrect

design step.
6. ClickClose.

Related Topics

Modeler Validation Settings
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Modeler Validation Settings

You can adjust the degree to which the software checks amodel for faults that could jeopardize
mesh accuracy. There are three levels of model validation that a user can specify for a given design:
Warning Only,Basic, andStrict. Note that this setting affects only the "3D Model" stage of a
design validation. The default entity check level isStrict.

l TheWarning Only entity check setting allows all models to pass 3D Model validation
regardless of any faults that are found. These faults are posted in themessage window as
warnings.

l TheBasic entity check setting allowsmost models to pass 3D Model validation. Some faults
are flagged asmodel errors, thereby prohibiting a design from proceeding to themeshing
stage of an analysis. Youmust correct such errors before attempting to analyze the design
under the Basic setting, or youmust change theModel Validation level toWarning Only.

l TheStrict entity check setting enforces a tighter tolerance for model faults than the "Warning
Only" and "Basic" settings. All model faults that are found during 3D Model validation are
posted to themessage window. These errorsmust be corrected before attempting to analyze
the design under the Strict setting, or youmust change theModel Validation level to Basic or
Warning Only.

In addition, check boxes allow you to adjust model validation to Ignore Unclassified Objects and
toSkip Intersection Checks. These settings are unchecked by default.
To adjust theModel Validation Settings:

1. SelectModeler->Validation Settings.
This displays theModel Validation Settings dialog box in which you can set the validation as
Basic, Strict, orWarning Only.

2. Choose the desired level of validation from theEntity Check Level drop down box.
3. Optionally, adjust model validation to Ignore Unclassified Objects, or toSkip Intersection

Checks.
4. Optionally, click the Save as Default button tomake the current selections the default

settings.
5. Optionally, click theRestore Default button to clear the check boxes and return the entity

check level to its defaultStrict setting.
6. ClickOK to accept the selection and close the dialog.

Related Topics

Model Analysis
AnalyzeObjects
Interobject Misalignment
Analyze SurfaceMesh
Heal
Technical Notes: Healing andMeshing
Technical Notes:Detecting and AddressingModel Problems to ImproveMeshing
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Exporting Files
You can export the following types of files fromMaxwell:

l Ansoft 2D modeler files
l AutoCAD Drawing Interchange Format files
l 3D model files
l Graphics files
l Reports as data or graphics files in a range of formats

Related Topics

ExportingMatrix Data
Exporting Equivalent Circuit Data

Exporting 2D Modeler Files

When you export a 2D Modeler file, the geometry located within the xy plane is exported. You can
choose to export only the selected parts of the geometry, or all of the parts.

Note If you want to export a plane that does not coincide with the global xy plane, youmust
create a relative coordinate system to redefine the location of the origin and xy plane.
SeeCreating a Relative Coordinate System for more information.

To export a file:
1. ClickModeler>Export .

TheExport File dialog box appears.
2. Use the file browser to find the directory where you want to save the file.
3. Type the name of the file in the File name box.
4. Select the desiredmodel export format from the Save as type pull-down list.
5. ClickSave. The file is exported to the specified location.

Related Topics

Exporting 2D AutoCAD Drawing Interchange Format Files
Exporting 3D Model Files
Exporting Graphics Files

Exporting 2D AutoCAD Drawing Interchange Format Files

When you export a file in the AutoCAD Drawing Interchange Format (.dxf), the 2D geometry
located within the xy plane on the working coordinate system is exported. You can choose to export
only the selected parts of the geometry, or all of the parts.

Working with Maxwell Projects and Designs 5-22
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Note If you want to export a plane that does not coincide with the global xy plane, youmust
create a relative coordinate system to redefine the location of the origin.
SeeCreating a Relative Coordinate System for more information.

To export a file to a .dxf format:
1. ClickModeler>Export.

TheExport File dialog box appears.
2. Use the file browser to find the directory where you want to save the file.
3. Type the name of the file in the File name box.
4. SelectAutoCAD DXF Files(*.dxf) from the Save as type pull-down list.
5. ClickSave. The file is exported to the specified location as a .dxf file.

Related Topics

Exporting 2D Model Files
Exporting 3D Model Files
Exporting Graphics Files

Exporting 3D Model Files

You can export 3D models to the 3D model file formats listed below. You can choose to export only
the selected parts of the geometry, or all of the parts.
To export a file to a 3D model format:

1. ClickModeler>Export to save the file in a 3D model format.
TheExport File dialog box appears.

2. Use the file browser to find the directory where you want to save the file.
3. Enter the name of the file in the File name box.
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4. Select the desired 3D model file format from the Save as type pull-down list.
Extension Contents
.sat ACIS geometry solid model files.

.sm3 Ansoft 3D Modeler files in ACIS version 2.0 or greater.

.dxf AutoCAD Drawing Interchange Format files. The.dxf export now includes true
arc support, closed wires, andmore precise ellipses and splines.

.model,

.exp
.model - CATIA 4.1.9 to 4.2.4
.Catia V4 Export Files

.gds GDSII files

.iges, .igs Industry standard Initial Graphics Exchange Specification (IGES) files. AN
additional license is required.

.x_b, .x_t Parasolid Binary Files.
Parasolid Text Files

.sab Standard ACIS binary.

.step, .stp Industry standard AP203 STEP files. An additional license is required.

5. If you selected .sm3, theSelect Version dialog box appears. Do the following:
l Click an ACIS version in which to export themodel from theACIS SM3 Version pull-down
list, and then clickOK.

6. ClickSave. Unless you selectedGDSII, the file is exported to the specified location as a 3D
model file. If you selectedGDSII, theGDSII Exportdialog appears.
l If themodel has been defined with layers, those layers are listed by layer number in the
table, with columns for Layer Name, Layer Number, Elevation in units. There is a check box
to specify whether to include the layer in the exported file.

l If you have defined a layer map file for themodel, the Layermap button opens a browser
for you to open that file before export. The *.layermap file is a text file that maps theGDSII
layer numbers to layer names in the stackup. The *.layermap file can have the same format
as the .tech file used in GDSII import, but it only needs the layer name and number in the
file. In a *.layermap file, other information is ignored.

l In the Polygon Vertices area, check a radio button to select eitherNo Limit to the number
of vertices or Limit the number of vertices to a specified value.

l For Arc tolerance, specify a value or accept the default.
7. Click the OK button in the GDSII Export dialog to complete the export. The file is exported to

the specified location.

Related Topics

Exporting 2D Model Files
Exporting 2D AutoCAD Drawing Interchange Format Files
Exporting Graphics Files
Importing GDSII Format Files
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Exporting Graphics Files

You can export the following graphics formats:

Extension Contents
.bmp Bitmap files.

.gif Graphics Interchange Format files.

.jpeg Joint Photographics Experts Group files.

.tiff Tagged Image File Format files.

.wrl Virtual RealityModeling Language (VRML)
files.

To export a file to a graphics format:
1. ClickModeler>Export to save the file in a graphics format.

TheExport File dialog box appears.
2. Use the file browser to find the directory where you want to save the file.
3. Type the name of the file in the File name box.
4. Select the desired graphics file format from the Save as type pull-down list.
5. ClickSave. The file is exported to the specified location as a graphics file.

Related Topics

Exporting 2D Model Files
Exporting 3D Model Files

Exporting Data Table Files

Youmust have an existing plot open to see theReport2Dmenu.
1. ClickReport2D>Export to File.

l Alternatively, right-click on the data table, and then clickExport to File on the shortcut
menu.

TheExport plot data to file dialog box appears.
2. Use the file browser to find the directory where you want to save the file.
3. Type the name of the file in the File name box.
4. Select one of the following file formats from the Save as type pull-down list:

Extension Contents
.txt Post processor format file

.csv Comma-delimited data
file
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Extension Contents
.tab Tab-separated file

.dat Ansoft plot data file

5. ClickSave. The file is exported to the specified location as a data table file.

Importing Files
You can import the following types of files toMaxwell:

l 2D model files
l 3D model files

Related Topics

Exporting Files

Importing 2D Model Files

You can import 2D model files directly into the activeModeler window:

Note If you import a file into an activeModeler window that contains an existingmodel, the file is
added to the existingmodel; it will not replace it.

If you want to import amodel in a specific orientation other than the current XY or XZ plane, youmust
first create a relative coordinate systemwith the planes in the desired orientation. SeeCreating a
Relative Coordinate System for more information.
To import a 2D model file:

1. ClickModeler>Import.
The Import File dialog box appears.

2. Select a file type from the Files of type pull-down list.
3. Use the file browser to find and select the file you want to import.
4. ClickOpen.

The file is imported into the activeModeler window.

Related Topics

Importing 3D Model Files
Importing GDSII Format Files
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Importing GDSII Format Files

A GDSII format file is one type of 2D model file that can be read directly into the activeModeler
window.
To import a GDSII format file:

1. ClickModeler>Import.
The Import File dialog box appears.

2. SelectGDSII Files (*.gds) from the Files of type pull-down list.
3. Use the file browser to find and select the GDSII format file you want to import.
4. ClickOpen.

The GDSII Import dialog box appears.

5. Select the desired check boxes in the GDSII structures section of the dialog box.
GDSII Structures Panel:
TheGDSII file may contain several top-level structures. You can do one of the following:
l Click a structure name in theGDSII Structures panel to highlight it.
l Clicking theSelect check box in theGDSII Structures panel highlights the structure and
selects that top-level structure to be imported.

Whenmultiple structures are imported, Maxwell createsmultiple designs under the current
project, one for eachGDSII structure.
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6. View the sub-layouts in theDescendants section of the dialog box.
Descendants Panel:
TheGDSII file is hierarchical andmay contain many sub-layouts. TheDescendants panel
shows the sub-layouts in the selected top-level designs.

7. In the Layers for structurename section, view the layers for the top-level structure.
Layers for structurename Panel:
The Layers for structurename panel shows the layers for themost recently highlighted top-
level structure [structurename]. GDSII layers are identified by layer numbers.

8. In theAll GDSII Layers section, select the layers you want to import.
All GDSII Layers Panel:
TheAll GDSII Layers panel lists all the layers from all the structures in the file.
Use the Import Layers check boxes in theAll GDSII Layers panel to select the layers to
import. You can drag and drop the layers in the list to change the vertical stackup of layers.

9. In theConvert Nodes to section, convert or ignore objects that use the "nodes" data type.
Convert Nodes to Panel:
GDSII supports nodes and boundaries as separate data types. Normally, boundaries
represent polygons. Maxwell can do one of the following: Convert objects that use the nodes
data type to boundary types, or ignore them. You can do one of the following:
l Use theConvert Nodes to radio buttons to selectBoundary or Ignore. The default is to
convert data type nodes to the data type boundary.

l The Flatten Hierarchy check box is automatically selected. Maxwell always flattens any
hierarchical geometry in the GDSII.

10. In the Layer Mapping File section, create amapping to use for the import.

Layer Mapping File Panel:

If desired, you can create amapping of the GDSII layer numbers to layer names in the design
stackup. To create and use themapping, do the following:

l Use a text editor to create a text file that maps theGDSII layer numbers to layer names in
the stackup. The layer mapping file must have a .tech suffix. The format of a .tech format
layer mapping file lists includes the layer number and corresponding layer name, color,
elevation, and thickness. For example, a layer mapping file may look like the following:
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l Click theOpen button in the Layer Mapping File section to locate and open an existing
layer mapping file.

11. When you are finished viewing and selecting options in theGDSII Import dialog box, click
OK.
The file is imported into the activeModeler window.

Related Topics

Importing 2D Model Files

Importing 3D Model Files

You can import 3D model files directly into the activeModeler window:

Note If you import a file into an activeModeler window that contains an existing
model, the file is added to the existingmodel; it will not replace it.

To import a 3D model file:
1. ClickModeler>Import.

The Import File dialog box appears.
2. Select the file type you want from the Files of type pull-down list.
3. Select any import options available for the selected file type.

l Some file types permit you to specify Validation and Healing options. In these cases, you
can choose betweenQuick for faster import, or for Strict healing, which you can specify as
Auto or Manual. See the table below andHealing an Imported Object.
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l For ProE files, you can enable the Import Free Surfaces option. This imports such
surfaces aswell as parts.

l For Natran and STL files, you can set theModel Resolution Length in Model Units, or
accept the auto setting.

l For STEP and IEGS files, you can specify a Stitch tolerance and units. The default value
(auto) comes from theHealing dialogOptions tab with Manual Healing selected

l For formats that allow importing CAD Assemblies as groups, the Import dialog includes an
option to Create group for assembly. This allows you to retain the assembly structure of
objects using groups. This appears for Autodesk Inventor files (*.ipt; *iam), Catia V4/V5
files (*.exp, *.model, *.CATPart, *.CATProduct), Pro/E files (*prt, *.asm), STEP files
(*.step, *stp), SolidWorks Files (*SLDPRT, *SLDASM), and Unigraphics Files (.prt). For
example:

4. Use the file browser to find the file you want to import.
5. Select the 3D model file you want to import or enter the name of the file in the File Name box.
6. ClickOpen.

The file is imported into the activeModeler window.
If you selected Validation and Healing optionsStrict with theManual option selected for the import,
then theHealing Options dialog box opens, allowing you to set parameters for the heal operation.
For tips on dealing with very complexmodels, see Technical Notes: Handling ComplicatedModels.

Note While objects created inMaxwell can always be classed in the history tree as either a solid,
sheet, or wire some imported objectsmay havemixture of these. Maxwell places such
objects in anUnclassified folder in the history tree.
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Extension Contents
.sat ACIS 27.0 geometry solid model files.1

.sm3 Ansoft 3D modeler files ACIS R1.0 to ACIS 2017 1.0.1

.sld Ansoft legacy 3D model files

.anstGeom Ansoft Geometry File supporting UDMs and CAD integration with the
Workbench.

.dxf, .dwg AutoCAD Drawing Interchange Format files from version 2.5 through 2016.
The .tech file is an ASCII file that contains layer names, units, color, elevation,
thickness, andmaterial information in a tab delimited format. See Importing
DXF and DWGFormat Files.

.ipt, iam Autodesk Inventor V11-V2016

.model,

.CATPart

.CATProduct

Catia R4/R5models.1

.model - CATIA 4.1.9 to 4.2.4
CATPart, .CATProduct - CATIA V5: R8-R25 (V5- V-6 R2016), (Windows
only)

.gds GDSII files.

.iges, .igs Industry standard Initial Graphics Exchange Specification (IGES) files versions
up to 5.3.1

.nas NASTRAN format files.2

.x_t, .x_b Parasolid Files (9.0-29.0.137).1

.prt*, .asm* Pro/E model files. For Pro/E models, the import dialog lets enable Import Free
Surfaces, which will include such surfaces aswell as parts.
.Pro/E 16 toWildfire 5.0, Creo 3.0

.sab Standard ACIS binary.

.sldprt, .sldasm Solidworks 98-2015

.step, .stp Industry standard AP203 STEP files and AP214 (geometry only) AP242.1

.stl Stereolithography format files.2

.prt Unigraphics file 11 to NX101

1. Automatic or Manual Healing available if desired. See Healing an Imported Object.
2. Defeaturing based on Model Resolution Length. Select Auto, None, or enter a numeric value
directly in the entry box.

Related Topics

Importing 2D Model Files
Importing DXF and DWGFormat Files.
Exporting 3D Model Files
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SpaceClaim Integration
Technical Notes: Handling ComplicatedModels

Importing DXF and DWG Format Files

You can import AutoCAD versions 2.5 through 2009. The entities are imported as 2 dimensional (not
3D). The types of entities imported are:

l 2D Polyline, Polyline, and Line
l Arc
l Circle
l Ellipse
l Solid
l Block

To import a .dxf or .dwgmodel file (whichmay use an associated .tech file):
1. ClickModeler>Import.

The Import File dialog box appears.
2. SelectAutoCAD Files (*.dxf;*.dwg) from the Files of type pull-down list.
3. Use the file browser to find the file you want to import.
4. Select the .dxf/.dwgmodel file you want to import.
5. ClickOpen.

Initially, theDWG/DXF Import dialog openswith the Layer selection tab displayed.
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The Input name field shows the name of the layer in the DXF/DWG file (not editable).
6. Use the Include check boxes to specify which layers to import from the selected file.
7. You can use the browse button [...] to locate a Layer mapping file. The layer mapping file is a

plain text file that includes units, layer names, color, elevation, and thickness information.
units um
//Layer_Name Color Elevation Thickness
BOTTOMLAYER purple 0 200
MIDLAYER green 500 200
TOPLAYER blue 1000 200
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8. Click theOptions tab.

9. Use theOverride pulldown to select the layout units for the imported file (default ismm).
10. Use theObjects check boxes to fine-tune the import:

l Auto detect closure causes polylines to be checked to see whether or not they are
closed. If a polyline is closed, themodeler creates a polygon in the design.

l Self stitch causesmultiple straight line segments to be joined to form polylines. If the
resulting polyline is closed, a polygon is created in themodeler.
Default Tolerance/Tolerance specifies whether you can specify a self stitch Tolerance
value. If particular features in amodel are outside of a normal tolerance allowance, you
can set a Tolerance for importing that specificmodel.

l Defeature Tolerance removes certain small features in the imported geometry to reduce
complexity. The features that are removed include: multiple points placed within the
specified distance; thin or narrow regions (“thins” and “spikes”); and extraneous points
along straight line segments.

l Round coordinates toDecimal place rounds all imported data to the specified number of
decimal points.

l Convert closed wide lines to polygons imports wide polylines as polygons. You have
more flexibility to change the shape of such an object when it is imported as a polygon.

l Import as 2D sheet bodies causes imported objects to be organized in terms of 2D
sheets.
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11. For Import method, selectScript orAcis.
12. When you have completed selections on all tabs, clickOK on any tab.

The file is imported into the active Layoutwindow.

Importing Data Tables

You can import data table files that contain data in the following formats:
l Tab-separated. Maxwell will recognize complex data if the values are separated by a comma
(e.g. real, imaginary).

l Comma-separated. Maxwell will recognize complex data if the values are separated by a
space (e.g. real imaginary).

1. ClickMaxwell>Results>Import Solutions.
l Alternatively, right-clickResults in the project tree and then click Import Solutions on the
shortcut menu.

The Imported Data dialog box appears.
2. Click Import Table.

The Table Import dialog box appears.
3. In the File Name text box, type the name of the data table file you want to import or click

Browse and use the file browser to locate the file.
4. If the data in the table is complex, select the format— real/ imaginary, or magnitude/ phase—

in which to import the data.
If the data is simple, this option will be ignored.

5. ClickLoad File. Note that the file has not been imported yet.
6. Optionally, type a new name in theSource Name box that indicates the origin or the data

table, or accept the default name.
7. Optionally, type a new name in the Table Name box that describes the data in the table, or

accept the default name
8. In theAll Columns list, the headings of each column in the data file are listed. Optionally,

specify a new name for a column heading by doing the following:
a. In theAll Columns list, click the heading you want to change. The heading appears in the

Column Name box.
b. Type a new name in theColumn Name box, and then clickSet Column Name.

The heading is changed to the new name in every place it appears in the Imported Data
dialog box.

9. In the Independent Data Columns list, the first heading in the data table file is listed by
default. In theDependent Data Columns list, the second and subsequent headings in the
data table file are listed by default. Optionally, click a heading name and then click an arrow
button tomove it from one column to another.

10. If the data in theDependent Data Columns list containsmatrix data, selectMatrix Data. If it
contains field data, select Field Data.

11. Click Import.
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You return to the Imported Data dialog box.
12. Click the data you want to import in theCurrent Imports list, and then clickOK.

The solution data is now available for post processing.

Related Topics

Adding Datasets

Inserting a Documentation File into a Project
To insert a documentation file so that it can be accessed from the project tree:

1. ClickProject>Insert Documentation File.
TheOpen dialog box appears.

2. Find and select the file you want to insert.
3. ClickOpen.

The documentation file appears in the project tree for the current project.

Importing and Converting Materials
To preserve custommaterials, you need to import them from aMaxwell .mat file (from a previous
version of Maxwell) into the latest version of aMaxwell user library (.amat file).
To import thesematerials from previous versions, youmust have at least oneMaxwell design loaded
in the project window.
To translate custommaterials to the latest Maxwell version:

1. From themenu, clickMaxwell3D orMaxwell2D, and then select Translate Material
Database.
The Translate Legacy Material Database appears.

2. Enter the name of the old database in the Legacy Material DB Name box. You can also click
the [...] button to locate the database (.mat file).
Note The .mat extension displays as a shortcut in the file

browser.

3. Enter a name for the new database in your current project in theUser Material DB Name
box.

4. ClickTranslate. The dialog displays a Translation completedmessage when done. The
importedmaterials are stored in a file with an .amat extension in the userlib.

Related Topics

AssigningMaterials.
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Importing a Model from the Clipboard
You can copy and paste amodel to and from the Clipboard in order to use a geometry from a
different design. To use a geometry with datalink, the geometry ID must be preserved.
To import amodel from the Clipboard, themodel for the current designmust be empty.
To import a 3D model from the Clipboard:

l ClickModeler>Import From Clipboard.
The geometrymodel is pasted from the Clipboard with the ID preserved.

Importing Tabular Arrays
Array data in tabular format can be imported from a file using theArray Import wizard that is
invoked by selecting Tools > Import Array from Table and specifying a .csv file from the dialog
that opens.
The tabular array .csv file should contain the following formatting:

l First row consisting of list of Array Index Variable names separated by tabs or commas
l Remaining rows consisting of a list of string values separated by tabs or commas
l Double quotationmarks (“ “) for string values are optional

After you select a .csv file to open:
l If no existing array variables are present in the design, the Import Array From Table: New
Variables dialog opens.

l If one or more existing array variables are present in the design, the Import Array From
Table: Existing Variables dialog opens.

The Import Array From Table: New Variables dialog is shown below.
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The following controls are available:
l Column (Array Index Variable) Name cannot bemodified and is used to create the array
index variable.

l The associatedArray Variable Name has the default name “<ColumnName>_Array". You
canmodify theArray Variable Name, but variable uniqueness and validity is checked upon
closing the wizard.

l Click theCreate checkbox to specify that the array index variable should be created.
l Use the control buttons at bottom to goBack to the previouswizard dialog, proceed to Finish
and close the wizard dialog, or clickCancel to close the dialog without making changes.

If one or more existing array variables are present in the design, when you clickNext in the above
wizard dialog, the Import Array From Table: Existing Variables dialog opens.
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The following controls are available:
l Array Index Variable name can not bemodified.
l Associated Array Variable can bemodified, but variable uniqueness and validity is checked
upon closing the wizard.

l The following choices appear in theAction pulldownmenu:

–Merge with existing value

–Replace existing value

–No Action

If you selectReplace existing value, you are then prompted for verification.

l If you import a file to a design where a string column already exists as an
ArrayIndexVariable, the value of the variable is checked when imported. If the existing array
value is a superset of new array values, the array variable will not appear in the
ExistingVariables dialog.

You can also use the same .csv tabular array file to setup a parametric analysis. When the
parametric analysis is set up, theArrayIndexVariable is searched and its index is used to create the
table. Whether theArrayIndexVariable refers to a double array or a string array, youmust use the
array element from the imported file - rather than the index value itself - to set up theParametric
from File analysis.
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Printing
The printing commands enable you to send an image of the active window to the printer.
To print the project:

1. ClickFile>Print.
The Print dialog box appears.

2. You can change the printer (if other printer names are listed on the drop down), set the print
range, number of copies, or use the check box to Print to file.

3. Do one of the following:
l ClickOK to print the project.
l ClickCancel to dismiss the window without printing.
l ClickProperties to define printer settings.

You can also access the printer properties by clickingPrinter in the Page Setup dialog box.

Previewing the Printout
To preview how the page will lookwhen printed:

1. Click File>Print Preview.
The preview window appears.

2. To print the project after seeing the preview, click thePrint button.
ThePrint dialog box appears.

3. To navigate through the preview, click theNext Page, Prev Page, and/or Two Page buttons.
4. To zoom in or out on the preview, click the Zoom In or Zoom Out button.
5. To close the preview and return to your project, clickClose.

Changing the Page Setup
To set or change the page setup:

1. ClickFile>Page Setup.
ThePage Setup dialog box appears.

2. Under Paper, select aSize andSource for the paper.
3. UnderOrientation, select either Portrait or Landscape.
4. UnderMargins, change the values as desired in the Left,Right, Top, andBottom text

boxes.
5. ClickOK.

You can also access the printer properties by clickingPrinter in thePage Setup dialog box.
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Saving Design Notes
You can save notes about a design, such as its creation date and a description of the device being
modeled. This is useful for keeping a running log on the project.
To add notes to a project:

1. ClickMaxwell3D, Maxwell2D, or RMxprt, and then select Edit Notes. Alternatively, right-
click a design icon in the project tree and selectEdit Notes… from the shortcut menu.
TheDesign Notes dialog box appears.

2. Click in the window and type your notes.
3. ClickOK to save the noteswith the current project.

To edit existing design notes youmay:
l Double-click theNotes icon in the project tree.
l ClickMaxwell3D, Maxwell2D, or RMxprt, and then select Edit Notes.
l Right-click a design icon in the project tree and selectEdit Notes… from the shortcut menu.

TheDesign Noteswindow appears, in which you can edit the design's notes as shown in the
example below.

To delete the existing notes for a design:
1. Select the iconNotes in the project tree, clickEdit>Delete.
2. Right-click the iconNotes in the project tree, clickDelete from the shortcut menu.

The Notes icon is removed from the project tree.

Note Notes are used to document aspects of designs only. For project level documentation, you
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can insert a documentation file into a project with the Project>Insert Documentation Files
command.

Using the Password Manager to Control Access to Resources
Maxwell and RMxprt allow you to specify library resources that require password access and
encryption. The same password can apply to multiple resources.
To access the PasswordManager, clickTools>Password Manager.

Specifying a New Password Protected Resource

To specify a new password protected resource:
1. ClickTools>Password Manager.

The Password Manager dialog box appears.
2. Click theNew button.

TheNew Encrypted Resource dialog box appears.
3. Specify the name of the resource that you want to protect, and clickOK.

TheEnter Passwords dialog appears.
4. Select one of the following radio buttons:

l Enter password - and confirm for Full Access or for Execute Only Access.
l Use Ansoft Password (Execute Only) - This does not require you to enter a password,
but it still encrypts the library.

5. After you have selected a radio button, and, if necessary, specified passwords correctly, click
OK to return to thePassword Manager dialog box in which the new resource is now listed.

Encrypting a Resource

To encrypt a resource:
1. ClickTools>Password Manager.

The Password Manager dialog box appears.
2. Select an existing resource to highlight it and enable theEncrypt File button.

A file browser window appears.
3. Select the desiredCircuit files (*.lib) file you wish to encrypt.

Any existing resources in the selected directory appear.
4. ClickOK.

The resource is encrypted.
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Setting Options in Maxwell
You can use Tools>Options>General Options to open theOptions dialog and set options for
Maxwell as well as the ANSYS Electronics Desktop. The following options are pertinent to Maxwell:

l General Options, such as project directory, WebUpdate options, and distributed analysis
options.

l Maxwell 3D Options, such as the default solution type.
l Report SetupOptions, including advancedmode editing, the number of significant digits to
display, and drag and drop behavior.

l Maxwell 2D Options, such as the default solution type.
l RMxprt Options, such as the default solution type andmaterial thresholds.
l Report2D options, such as formatting and cell size.
l Modeler options, such as coordinate system settings, color, and grid settings.
l Fields Reporter options, such as field overlay and phase animation settings.
l Schematic Editor options, such as fonts, colors ,etc. used by theMaxwell Circuit Editor.

You can use HPC and Analysis Options to specify design-specific options.
Additionally, the Tools>Options>Export Options Files commandwrites xml files containing the
Options settings at all levels to the specified directory. This featuremakes it easier for different users
to use ANSYS Electromagnetics tools installed on shared directories or network drives. The
Example Uses for Export Options Features section outlines some use cases enabled by this feature.

Setting General Options

To set general options in Maxwell:
1. ClickTools>Options>General Options.

When theOptions dialog appears, clicking the + next toGeneral expands the list to show the
following:
l Desktop Configuration
l Project
l Miscellaneous
l User Interface
l Directories
l Desktop Performance
l Default Units
l Remote Analysis
l WebUpdate
l Component LibrariesOptions

2. Click each entry, andmake the desired selections.
3. ClickOK.
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General Options: Desktop Configuration

These options are set in theDesktop Configuration panel underGeneral in the Options
dialog.TheDesktop Configuration panel contains the following sections:

l Desktop Configuration defines theSet targeted configuration,Custom Menu Set,
andSchematic Environment settings. The drop-down list shows these options: All, EM,
RF, SI, andSimplorer. SelectSimplorer if you are not accessing other parts of the
ANSYS Electronics Desktop.

l New Project options specifies whether a design of a particular type is inserted when you
create a new project. If you define Simplorer inSet targeted configuration, the default for
Insert a design of type is Simplorer. You can select other options from the drop-down list,
or select theDon't insert a design option.

l Save Options defines if autosave is enabled and the interval in edits for autosaving. To
enable autosave, select theDo Autosave check box. Set the number of editing actions
after which a backup file is automatically saved to your hard drive in theAutosave interval
text box. The default is 10. The backup file is given the same name as your project and has
an “aedt.auto” file extension.

When all information onDesktop Configuration is defined, select another option underGeneral in
the Options dialog or clickOK to put your settings into effect.

General Options: Project

These options are set on theProject panel underGeneral in the Options dialog.
l 2D Extractor
l Circuit Design
l Circuit Netlist
l HFSS
l HFSS 3D Layout Design
l HFSS-IE
l Maxwell 2D
l Maxwell 3D
l Q3D Extractor
l RMxprt
l Simplorer

When all information on theProject panel is defined, select another option underGeneral in the
Options dialog or clickOK to put your settings into effect.

General Options: Miscellaneous

These options are set on theMiscellaneous panel underGeneral in the Options dialog.
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ANSYS Workbench Application
The ANSYSWorkbench ApplicationPath lets you specify a path to an ANSYSWorkbench
installation, if you have one. This path can be used to open the Icepak application when you create
an Icepak design in RMxprt. It can also be used by theOptimetrics feature for connecting to the
Design Xplorer.

MATLAB Optimization
If you have an installation of MATLAB installed you can use it as anOptimizer. ThisMATLAB path
settingmust to point to the version of MATLAB to be used for performing the optimization. .

Note The platform (64 bit) of the specified version of MATLABmust match the platform of this
application.

Save Preview Images
ClickSave preview images in project file if you want the images to be saved in your projects.
When all information onMiscellaneous is defined, select another option underGeneral in the
Options dialog or clickOK to put your settings into effect.

General Options: User Interface

These options are set on theUser Interface panel underGeneral in the Options dialog.TheUser
Interface panel contains the following sections:

General
l Show Message Windowon new messages – specifies that themessage window is
automatically reopened if a message arrives after themessage window has been closed.

l Ensure that new messages are visible in the Message Window Tree – specifies that
the size of themessage window is expanded as needed whenmessages are displayed.

l Show Progress Windowwhen starting a simulation – specifies that the progress
window is reopened if a message arrives after the progresswindow has been closed.

Project Tree Visualization Options
l Selecting theEmphasize active command context check box causes the label of the
selected Project Tree element that is active (that is, has focus) to be rendered in bold text.

l Selecting theChange icon when selection does not match active window check box
causes a small window-shaped overlay icon to display in the corner of the selected Project
Tree element. This overlay icon is changed only when the data in the active window is
unrelated to the selected project item. (Data is considered related when they affect the
samemodel.) Clicking the icon will open the window and bring it into focus (on top).

l Select theExpand Project Tree on Insert check box if you want to expand the Project
Tree automatically when you insert a new design.

Color Scheme
You can select the color scheme of Blue, Silver, or Black.

Working with Maxwell Projects and Designs 5-45
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Welcome Message
ClickShow welcome message at startup if you want to see a welcomemessage when the
application starts.
When all information on theUser Interface panel is defined, select another option underGeneral in
the Options dialog or clickOK to put your settings into effect.

General Options: Directories

These options are set on theDirectories panel underGeneral in the Options dialog.The
Directories panel contains the following sections:

l Desktop Configuration defines theSet targeted configuration,Custom Menu Set,
andSchematic Environment settings. The drop-down list shows these options: All, EM,
RF, SI, andSimplorer. SelectSimplorer if you are not accessing other parts of the
ANSYS Electronics Desktop.

l New Project options specifies whether a design of a particular type is inserted when you
create a new project. If you define Simplorer inSet targeted configuration, the default for
Insert a design of type is Simplorer. You can select other options from the drop-down list,
or select theDon't insert a design option.

l Save Options defines if autosave is enabled and the interval in edits for autosaving. To
enable autosave, select theDo Autosave check box. Set the number of editing actions
after which a backup file is automatically saved to your hard drive in theAutosave interval
text box. The default is 10. The backup file is given the same name as your project and has
an “aedt.auto” file extension.

When all information on theDirectories panel is defined, select another option underGeneral in the
Options dialog or clickOK to put your settings into effect.

General Options: Desktop Performance Tab

These options are set on theDesktop Performance panel underGeneral in the Options dialog.

Report Update Options for Design Type:
l Select aDesign type to which the report update options apply.
l Select or clearDynamically update reports and field overlays during edits.
If selected, report plots and overlays update dynamically.

l Dynamically update postprocessing data for new solutions.
Updating numerous reportsmay take a significant amount of time. Updating reports during the
analysis process can impact the overall time to solution. Youmaywant to vary the timeswhen
your reports get updated relative to the impact on overall solve time.

l Update reports on file open – specifies that reports be automatically updated whenever an
existing file with solution data is opened for viewing/editing. Enabled by default.
Five options exist for updating reports during solutions:
l Automatically - the default. It means updatemost things immediately.
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For “AdaptivePass” plot context, plots are updated at the end of each solution pass. For
“LastAdaptive” or “Transient” the plot is updated at the end of the transient or adaptive
solution. This option balances report and field plot updating with solution time. For
example, reportsmay be updated after each adaptive pass but field plots will not be
updated until the solution is complete.

l Immediately - update reports and plots as soon as data comes from the solver.
This option will have the greatest impact on the overall solution time but will have themost
rapid updating of reports and field plots. Caution should be used in selecting this option.
Some types of reports and field plotsmay take a long time to update, especially as the
mesh size increases.

l Never - onlymanual intervention updates reports.
This option will prevent updates from impacting the solution time.

l On Completion - as withNever, but a single update is done when the solve completes.
Note Reports that are updated on completion are done after the solve has been

completed. The time for that update is not included in the solve profile.

l After Each Variation - when performing anOptimetric or parametric analysis, all reports
are updated after analysis of each variation has been completed.

Animation
Computing animated plots requires significant memorywhich depends upon the complexity of the
plot type. The animation setting is used to prevent problems related to low memory should an
animation require largememory allocation.
The Animation setting lets you set a limit toStop computing animation frames when available
memory is less than the set value inmegabytes. The default is 100.

Desktop Pre/Post Processing settings:
l Number of Processors – The default is the number of logical processors on themachine
divided by 2. This option is common for both pre-processing and post-processing. This option
only affects pre/post processing in desktop (not solve or simulation)
The following pre-processing algorithms can take advantage of multiple processors:

l Visualization/faceting of 3D models for 3D products
l Model validation for 3D products
l Auto net identification for Q3D

Disk Space Warning
You can set a value toWarn when available disk space is less than the specified number of
gigabytes.
When all information on theDesktop Performance panel is defined, select another option under
General in the Options dialog or clickOK to put your settings into effect.

Working with Maxwell Projects and Designs 5-47
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

General Options: Default Units

These options are set on theDefault Units panel underGeneral in the Options dialog.
TheDefault Units panel of theGeneral Options dialog box allows you to set the default unit values
for the followingmetrics: Length, Frequency,Resistance,Angle, Power, Inductance, Time,
Voltage,Capacitance, Temperature,Current, Force, Torque, Speed,Angular Speed,
Magnetic Induction,Weight,MagneticField Strength, Pressure, andConductance.

Note Units specified in theDefault Units panel are generally for problem definition. The Post
Processor displays output in the unit that scales best for plotting, however, the user may
change the unit when creating the plot. Also, the Fields Calculator alwaysworkswith SI
units.

When all information on theDefault Units panel is defined, select another option underGeneral in
the Options dialog or clickOK to put your settings into effect.

General Options: Remote Analysis

To launch all analyses as a specific user, rather than the current user, do the following in theRemote
Analysis Options panel of the General Options.

Note If any of the remotemachines are Unix-based, youmust specify the current
user.

RSM Service Options
l The ANSYS Electromagnetics RSMService should be running on this port for all distributed
machines. To change theAnsoft Service Port, click theChange button to display an
editable dialog.

l TheSend analysis request as option selection can beService User or Specified User.
SelectingSpecified User enables the fields for User Name, Password, and
Domain/Workgroup information.

l You can alsoDisable access by remote machines, by using the check box.

Desktop-Engine Connection
l If the local machine hasmultiple IP addresses and one of them is preferred for
communication, the Desktop-Engine Connection area lets you specify whether toUse
Default or aSpecified IP address.

Note This option is applicable only when the local machine hasmultiple IP
addresses and one of them is preferred for communication.

Related Topics

Remote Analysis

General Options: Web Update

These options are set on theWeb Update panel underGeneral in the Options dialog.
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Select one of the following from theAutomatically check for updates every pull-down list:
l Select the desired update frequency from theAutomatically check for updates every
drop-down list. The choices areNever, 7 days, 15 days,30 days, 60 days, 120 days, and
180 days. By default, automaticWeb updates are turned off.

l Youwill be prompted before an update. The date of the prompt is recorded as the Last
update attempt date.

l The Last update date shows the last time Simplorer was updated.
Note You can also request aWebUpdate by selecting Launch WebUpdate

from theHelp drop-downmenu on themainmenu bar.

When all information on theWeb Update panel is defined, select another option underGeneral in
the Options dialog or clickOK to put your settings into effect.

General Options: Component Libraries Options

These options are set on theComponent Libraries Options panel underGeneral in the Options
dialog.TheComponent Libraries Options panel contains the following sections:
You can select toUse extractor mode by default for separate dynamic link desktops by using
the check box.
You can select toRun affected property callbacks when variable changes value by using the
check box.
TheComponent Tree Options panel contains the following controls:

l Show Favorites specifies that a list of favorites, in the form of an expandable tree, is
displayed in the Component Libraries’s Components tab window.

l Show Most Recently Used specifies that a list of the components you havemost-recently
used is displayed in the project window.

l Most Recently Usedlist contains specifies the number of recently used components to
display.

TheSearch Options panel contains the following controls:
l UseSet to determine whether searches are performed onAll components,Current list
only, orAppend to current list.

l Load Libraries at Initialization –When checked, Simplorer pre-loads all system and
configured libraries into the Component Libraries search database when the Component
Libraries is initialized at Simplorer startup. Clear this option to reduce the startup time of
Simplorer, in which case the libraries are loaded at first search.

When all information on theComponent Libraries Options panel is defined, select another option
underGeneral in the Options dialog or clickOK to put your settings into effect.

Setting HPC and Analysis Options for Maxwell and RMxprt Designs

HPC and analysis parameters are accessed via a single dialog. Machine list and options settings are
integrated into analysis configurations. The default configuration is for solving on a single, local
machine. You can createmany analysis configurations for remote and distributed solutions, and
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switch between them, depending on the job being solved. Multiprocessing is integrated into the
machine lists.
To set the HPC and Analysis Options:

1. ClickTools>Options>HPC and Analysis Options.
TheHPC and Analysis Options dialog appears, displaying two tabs.

Configurations tab
In theConfigurations tab, you can select the Design Type, and select from a list of available
configurations. Selecting a Design Type displays a list of the Available configurations for that
type. Selecting a configuration from the list displays the details of that configuration in the text
fields. A Name can describe the use for which a configuration has been defined. The Total
Tasks column shows the number of tasks that the analysis configuration can execute.
Design Type
Defines configurations for the selected design type. The Active configuration is used when
solving an analysis for the design type.
Available Configurations List
From the lists ofAvailable Configurations for each design type, click the desired
configuration in the list to select it, then clickMake Active. The active configuration is
indicated with a YES in the Active column.
l Add... button – launches a dialog to create a new analysis configuration.
l Edit... button – launches a dialog to edit the currently selected analysis configuration.
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l Delete button – deletes the currently selected analysis configurations.
Note You cannot delete the Local configuration.

l Copy... button – creates a new analysis configuration, and launches a dialog to edit it. If the
dialog is canceled, the new analysis configuration is not created.

l Import... button – allows the user to import an .acf file to create an analysis configuration.
Note Importing analysis configurations always adds the imported analysis

configurations to the current design type. Also, if there is a name conflict between
an imported analysis configuration and an existing analysis configuration, the
imported configuration is renamed and you are notified.

l Export... button – allows the user to export the selected analysis configurations to an .acf
file. Users can then import the configurations into a different design type, or import them on
a different machine.

Options Tab

Note Options for Maxwell 2D, Maxwell 3D, and RMxprt design types are
described below. Options for other design types, such asHFSS, are
described in theANSYS Electronics DesktopOnline Help.

TheOptions tab in theHPC and Analysis Options dialog contains design type specific
options. These options are not part of an analysis configuration, instead they are always in
effect for the given design type when the following is true:
l A design of thematching design type is being solved
l You have not specified corresponding overriding batch options on the command line.
In theOptions tab you can enable queuing, and set the design type.
l For Maxwell 2D and 3D design types, you can specify the DistributedMemoryMPI
(Message Passing Interface) vendor, specify the Remote SpawnCommand, set the HPC
license type, and set the Default Process Priority.

l For Maxwell 3D design type only, you can also Enable GPU (if installed) for EddyCurrent
solves.

l For RMxprt design type, you can only set the Default Process Priority.
Solving on a singleWindowsmachine does not requireMPI installation; and users running on
Linux do not need to install MPI manually. You can also set the Default Process Priority
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2. For DistributedMemory options, use the drop downmenu to select theMPI Vendor for the
selected Design type.
The solvers use the standardMessage Passing Interface (MPI), and can perform solutions
that distributememory use acrossmachines in a cluster or network. Memory used by theMPI-
enabled solver is therefore limited by the set of machines that are available rather than the
sharedmemory available on any singlemachine. This allows you to simulate larger structures,
and to optimally reconfigure the cluster of machines for the problem at hand. For solving on a
singlemachine, MPI is not required, nor does it provide an advantage.
To use the distributedmemory solution youmust install MPI software from one of the
supported third party vendors on all themachines you intend to use.
Youmay need to set passwords depending on theMPI vendor for authentication on the
machines. Settingswithin each design type turn on distributedmemory solutions and define
the list of machines you intend to use.
InfiniBand Support for Windows
By default, theMPI vendors use the fastest interconnect (typically InfiniBand is faster than
Ethernet). If you want to override the default behavior and force the use of Ethernet, you can
set the ANSOFT_MPI_INTERCONNECT environment variable to “eth” for the job.

3. For Linux authentication, you can specify the Remote SpawnCommand asRSH or SSH (the
default).

4. Select one of the following HPC License Values:
l Pool – SelectingPoolmeans that HPC licenseswill be used for distribution.
l Pack – selectingPackmeans that HPC Pack licenseswill be used for distribution.
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l None – SelectingNone allows you to opt-out of multi-processed simulation. When
HPC is not required, selecting None will not checkout HPC license(s), and simulations
will use a single process.
Do not select None if the simulation requires HPC.

HPC licensing is based on counting the total number of cores in a simulation. For example,
when solving a distributed solution across 10 nodes, with multiprocessing enabling 2 cores per
node, the total number of cores is 2x10, or twenty cores.
The HPC License Type determines the type and number of licenses that will be checked out
for a given number of cores. For the HPC type, one license will be checked out for each core in
use. So a simulation with twenty coreswould require twenty HPC licenses. For the HPC Pack
type, a single pack enables eight cores, and each additional pack enables four times asmany
cores. So a simulation with twenty coreswould require two "HPC Pack" licenses, enabling up
to 8x4, or 32, cores.
Solution setupswith domains, such as transient designs using the TimeDecomposition
Method, always use HPC licensing. Even though domains are distributed andmay use
multiprocessing, they do not use distributed solve or multiprocessing licenses - all of this is
included in the HPC licensing when solving domains.

5. Optionally, users with one HPC pack or 8 HPC pool licenses, and who have an NVIDIA®
graphics card installed, can useGPU acceleration for Maxwell 3D EddyCurrent designs. To
enable use of GPU acceleration, you can set Enable GPU to True. Thematrix solver
automatically determines if all cores should be used, or if oneGPU should be used to give the
best performance. For example, if you specify 4 cores for the simulation, the 3D Eddy current
solver will use 4 cores in parallel duringmatrix assembly while thematrix solver will use either
4 cores or 1 GPU.

You can determine if a GPU is being used for acceleration by viewing the Solutions dialog,
Profile tab. If a GPU is successfully locked for use by the solver process, the profile shows the
GPU's CUDA device ID and its name.

If the GPU is not used, the Profile indicates that, and the fallback to using the CPU cores.

Note GPU acceleration can be toggled by the -batchoptions command line argument:
EnableGPU =[0/1]

For example, the following command turns onGPU acceleration:
ansysedt.exe -batchsolve -batchoptions "Maxwell
3D/EnableGPU’ =1" projectname.aedt
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6. Optionally, you can select one of the following from the Default Process Priority pull-down list:

l Critical (highest) Priority (not recommended)
l Above Normal Priority (not recommended)
l Normal Priority
l Below Normal Priority
l Idle (lowest) Priority
You can set these values using VB Scripts.
To edit configurations, see Editing DistributedMachine Configurations.

Related Topics

High Performance Computing (HPC) Integration
"UsingGPU Acceleration for Maxwell 3D EddyCurrent Designs" on the facing page

Specifying the Remote Spawn Command as RSH or SSH (Linux)

An important step in using a high performance cluster is setting up authentication acrossmachines in
such a way that themachines can be accessed without a password. By default Maxwell 2D and
Maxwell 3D use SSH authentication on Linux to spawn commands on the remotemachines but also
supports RSH. The selection of which to use ismade on theOptions tab of the
Tools>Options>HPC and Analysis dialog.

SSH

Youwill need to set up passwordless access to useMaxwell on a Linux cluster with SSH or RSH. In
general, for SSH, this is accomplished as follows:

1. Verify that you have working SSH servers and clients on your machines.
2. Verify that the server will accept passwordless logins. Youmay need to edit the /etc/ssh/ssh_d

file to allow RSAAuthentication and PubkeyAuthentication.
3. Generating keys on the client system using the ssh-keygen program. Do not use a passphrase

so that you can access themachine without a password.
4. Copy the public key generated in step 1 from the ~/.ssh directory to the server. The easiest

way to transfer the keys is to use the ssh-copy-id program. Alternately, you can use any file
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transfer utility. If the server already has a list of existing keys for other clients add the new
public key to the list.

5. Test the connection. Login to the client machine using the username that you used to create
the identity keys. Open a new shell terminal and attempt to open an SSH login session. For
example type: ssh 192.168.0.4 (where the IP address is the address of themachine you are
attempting to connect to). The server should allow you to login without requesting a password.

RSH

If you choose to use RSH you will need tomake sure RSH is installed on all themachines and set the
machines up so that you are not prompted for a password. There are different ways to set up
password-less RSH so be sure to see the documentation for your machines and network for detailed
instructions.
Machine access using RSH without a password is often set up by editing the /etc/hosts.equiv file and
adding entries for the hosts you would like to use without a password. This file lists hosts and users
that are granted "trusted" access to the system.
If you look at the contents of the /etc/hosts.equiv file you should have something similar to the
following:

job1.n1.com
job2.n1.com
job3.n1.com

Themachines job1, job2 and job3 can connect without a password. Youmay also need to verify that
the files /etc/hosts.allow and /etc/hosts.deny are empty. See your local documentation for detailed
instructions and troubleshooting suggestions.

Related Topics

"Setting HPC and Analysis Options for Maxwell and RMxprt Designs" on page 5-49

Using GPU Acceleration for Maxwell 3D Eddy Current Designs

Maxwell 3D EddyCurrent matrix solver can be accelerated by using an NVIDIA®GPU accelerator.
Numerical factorization of complex symmetricmatrices is supported for GPU acceleration.
Hardware Requirements
GPU acceleration for theMaxwell 3D EddyCurrent solver has been developed for NVIDIA cards
and is officially supported with the Tesla® series. NVIDIA Tesla cards are recommended for the best
performance when using several cards on onemachine to solve using HPC. The following cards are
supported:

l NVIDIA Tesla K20c (both workstation and server)
l NVIDIA Tesla K40c (both workstation and server)
l NVIDIA Tesla K80 (server with GPU cooling solution only, 2 GPUs consume 2 ANSYS HPC
licenses)
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l NVIDIA Quadro K5000, K5200, M6000
l VIDIA Quadro K6000 (both workstation and server, will be slow in graphic processing when
used for GPU acceleration)

Note NVIDIA TeslaM2090 (Not supported in Release 17), a previous generation (code
Fermi) GPU card, doesn’t work for Workstation since it has no fan for active cooling,
but rather needs server with GPU cooling solution (passive cooling) similar to the
NVIDIA Tesla K80.

To obtain the best performance, the GPU used for running simulation jobs should not be attached to
any display. OnlyGPU cardswith CUDA®Compute Compatibility 2.0 and above should be used. To
improve the speedup of visualization, you should install the GPU card on a systemwith PCI-E 3.0
slots. A mixture of interface cardswith lower PCI-E versionsmay result in the data not being
transferred fromGPU to CPU at the highest speed.
Setup for Windows

1. After you install GPU cards and Nvidia graphics drivers, you should be able to find the cards in
WindowsDisplayManager.

2. Run nvidia-smi.exe at C:\ProgramFiles\NVIDIA Corporation\NVSMI to check if GPU
cards are installed successfully. (The executable nvidia-smi.exe should be available
after the display driver is installed.)

3. To further setup the configuration of GPU cards, open a commandwindow as an
administrator.

4. To improve the performance of GPU acceleration, it is recommended that you turn off the
Error Correction Code (ECC) support using the -e 0 option of nvidia-smi. New ECC settings
become effective only after system reboot.

5. (Optional) For remote execution of GPU accelerated jobs (e.g., throughWindowsRemote
Desktop Connection or RSMoptions), it is necessary to turn on the Tesla Compute Cluster
(TCC) mode using the -dm 1 option of nvidia-smi. New TCC settings become effective only
after system reboot.

Note l The above step is unnecessary if you runMaxwell 3D EddyCurrent from a
local machine.

l Only Tesla cards support TCC.
l You cannot run GPU accelerated jobs on remote GeForce andQuadro cards.

Setup for Linux
1. After you install an NVIDIA GPU card and graphics drivers, you should be able to find the card

using the command:
/sbin/lspci | grep -i nvidia

You can also use the following command to check if a GPU card can be recognized by the
system:
/usr/bin/nvidia-smi

2. (Optional) The setting of GPUs to disable ECC (for performance), enable TCC (for remote
execution), and enable Exclusive_Process (for GPU-distributed) are similar toWindows. You
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need the administrative right to make such changes.
sudo nvidia-smi -e 0

sudo nvidia-smi -dm 1

sudo nvidia-smi -c 3

Related Topics

"Setting HPC and Analysis Options for Maxwell and RMxprt Designs" on page 5-49

Setting Solver Settings Using VB Scripts

Being able to set the number of processors, desired RAM limit, andmaximumRAM limit using VB
scripts allows you to solve a project by running a VB script, without having to toggle the computer
hardware usage settings.
The followingmacros allow you to set these options:

oDesign.SetDesiredRamMBLimit <integer num in MB>
oDesign.SetMaximumRamMBLimit <integer num in MB>
oDesign.SetNumberOfProcessors <num>

limit = oDesign.GetDesiredRamMBLimit()
limit = oDesign.GetMaximumRamMBLimit()
num = oDesign.GetNumberOfProcessors()

Maxwell 2D/3D Options

Select theOptions page of interest:
Maxwell 3D Options
Maxwell 2D Options

Setting Maxwell 3D Options

To set Maxwell 3D options:
1. ClickTools>Options>General Options to open the Options dialog, displaying a

hierarchical list of options. Click the + next toMaxwell 3D to show the following choices:
General, Solution Type,Material Threshold,Boundary Assignment.

2. On theGeneral panel, select or clear the following check boxes:
l Save before solving

Note When you enable theSave before solving setting, the project is only saved
if it has beenmodified since its last save.
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l Save Optimetrics field solutions
l Apply variation deletions immediately

3. On theSolution Type panel:
l To change the default solution type when you initially insert a design, select one of the
following from theDefault solution type pull-down list:Magnetostatic, Eddy
Current, Transient, Electrostatic,DC Conduction, ElectroDCConduction,
Electric Transient.

4. On theMaterial Threshold panel, enter the Default perfect conductor andDefault
insulator/conductor values in siemens/m.
Note Setting thematerial threshold affects the default setting for the current and all future

projects/designs. To change thematerial threshold for the current design only, use
theMaxwell>Design Settings command and change thematerial thresholds on
theSet Material Thresholds tab.

5. On theBoundary Assignmentpanel, select or clear the following check boxes:
l Use Wizards for data input when creating new boundaries
When this is checked, the creation of boundaries and excitations useWizards to guide you
through the process.When this is not checked, the creation of boundaries and excitations
displays a Properties dialog with tabs for different kinds of information.

l Duplicate boundaries/mesh operations with geometry
When this is checked, you can duplicate a boundary or excitation when its geometry is
pasted or duplicated. See Duplicating Boundaries and Excitations.

l Visualize boundaries on geometry
When checked, enables visualization of boundaries on geometry.

Related Topics

Setting theMaterial Threshold

Report Setup Options

To set up general options for Reports
1. ClickTools>Options>General Options to open the Options dialog, displaying a

hierarchical list of options. Click the + next toReporter to expand the list and selectReport
Setup.

2. In theReport Setup panel, set theMaximum number of significant digits to display in
the reporter when displaying numeric quantities.

3. In theDrag and Drop section, select eitherDrag Item Data, orDrag Item Definition.
4. TheQuantity selection value specifies thematrix size for using a tree display for matrix

quantities. This is helpful when dealing with larger matrices. The default is 50.When the
number of matrix elements is larger than the number, the Quantities field uses a tree structure
to dividematrix quantities into groups by their first element name. The initial display shows
groups, without initially listing groupmembers.
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A folder Node is not selectable. A click on a folder node toggles (Expand or collapse) the node.
When any of a folder’s child nodes is selected it becomes bolded.

Mouse Click onQuantity Node (Tree leaf node). Shift and Ctrl key only apply to multiple
selection dialogs:
l Without Shift and Ctrl key – Select the quantity and unselect all previous selected
quantities.

l Only with Ctrl key down – Toggle the selection of the quantity. No effect on other selected
quantities.

l Only with Shift key down –Do range selection, deselect any selected quantity that is outside
of the range.

l Both Shift and Ctrl key down –Do range selection, but don’t deselect any selected quantity.
l Ctrl+a – Select all quantities in amultiple selections dialog.
Range selection: Select quantity nodes between the last mouse clicked quantity node and the
newly clicked-on quantity node. Folder nodes in between won’t be selected but their children
will be selected. So those folder nodeswill be in a bolded state.

5. ClickOK.

Setting Maxwell 2D Options

To set Maxwell 2D options:
1. ClickTools>Options>General Options to open the Options dialog, displaying a

hierarchical list of options. Click the + next toMaxwell 2D to show the following choices:
General, Solution Type,Material Threshold,Boundary Assignment.

2. On theGeneral panel, select or clear the following check boxes:
l Save before solving

Note When you enable theSave before solving setting, the project is only saved
if it has beenmodified since its last save.

l Save Optimetrics field solutions
l Apply variation deletions immediately
l Generate model history when importing legacy 2D projects

3. On theSolution Type panel:
l To change the default solution type when you initially insert a design, select one of the
following from theDefault solution type pull-down list:Magnetostatic, Eddy
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Current, Transient, Electrostatic,DC Conduction,AC Conduction.
l To change the default geometrymode when you initially insert a project, select one of
the following from theDefault geometry mode pull-down list: XY, about Z.

4. On theMaterial Threshold panel, enter the Default perfect conductor andDefault
insulator/conductor values in siemens/m.
Note Setting thematerial threshold affects the default setting for the current and all future

projects/designs. To change thematerial threshold for the current design only, use
theMaxwell>Design Settings command and change thematerial thresholds on
theSet Material Thresholds tab.

5. On theBoundary Assignment panel, select or clear the following check boxes:
l Use Wizards for data input when creating new boundaries
When this is checked, the creation of boundaries and excitations useWizards to guide you
through the process.When this is not checked, the creation of boundaries and excitations
displays a Properties dialog with tabs for different kinds of information.

l Duplicate boundaries/mesh operations with geometry
When this is checked, you can duplicate a boundary or excitation when its geometry is
pasted or duplicated. See Duplicating Boundaries and Excitations.

Related Topics

Setting theMaterial Threshold

Setting RMxprt Options

To specify settings for RMxprt options:
1. ClickTools>Options>General Options to open the Options dialog, displaying a

hierarchical list of options. Click the + next toRMxprt to show the following choices:General,
Machine Type, Threshold

2. In theGeneral options panel, select or clear the following check boxes:
l Save before solving

Note When you enable theSave before solving setting, the project is only saved if it
has beenmodified since its last save.

l Apply variation deletions immediately
3. On theMachine Type panel, to change the default machine type when you initially insert a

design, select one of the following from theDefault machine type pull-down list:
l Three Phase InductionMotor
l Single Phase InductionMotor
l Three Phase SynchronousMachine
l Brushless Permanent-Magnet DC Motor
l Adjust-Speed SynchronousMachine
l Permanent-Magnet DC Motor
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l Switched ReluctanceMotor
l Line-Start PMSynchronousMotor
l Universal Motor
l DCMachine
l Claw-Pole SynchronousMachine
l Three Phase Non-Salient SynchronousMachine
l Generic RotatingMachines

4. On the Threshold panel, enter the Default conductivity andDefault permeability values
in siemens/m.
Note Setting thematerial thresholds under Tools>Options impacts the default setting for

the current and all future projects/designs. To change thematerial threshold for the
current design only, use theRMxprt>Design Settings command and change the
material thresholds on theSet Material Thresholds tab.

5. ClickOK to close the dialog box.

Setting Report2D Options

To set Report2D options in Maxwell:
1. ClickTools>Options>General Options to open the Options dialog, displaying a

hierarchical list of options. Click the + next toReporter to expand the list and selectReport2D
to display the following list:
l Curve
l Axis
l Grid
l Header
l Note
l Legend
l Marker
l Marker Table
l X-Y Markers
l Digital
l General
l Table
For properties controlled by check boxes, you can set values for all curves by clicking the
column header cell that contains the property title. Right-clicking on a text field cell displays a
context menu that lets you cut, copy and paste values. Right-clicking on amenu cell displays a
context menu that lets you copy and paste entire rows.
You can use aRestore Defaults button.

2. Click each list item, andmake the desired selections.
3. ClickOK.
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Report 2D Options: Curve

These options are set on theCurve panel underReport2D in the Options dialog.
l Line style -- select the options from the drop downmenu. The options are Solid, Dot, Dash,
and Dot dash.

l Color -- set the color by double clicking to display the Set color dialog. Select a default or
custom color and clickOK.

l Width -- set the line width by editing the real value in the text field.
l Arrows -- use the check box to use arrows on the curve ends.
l Symbol -- use the check box to have symbolsmark the locations of data points on the curve.
l Sym Freq -- set the symbol frequency by editing the integer value in the text field.
l Sym Style -- select the symbol to display for the designated data points. The sym style can be
box, circle, vertical ellipse, horizontal ellipse, vertical up triangle, vertical down triangle,
horizontal left triangle, horizontal right triangle.

l Fill Sym -- use the check box to set the symbol display as a solid or as hollow.
l Sym Color -- set the color for the symbol by double clicking to display the Set color dialog.
Select a default or custom color and clickOK.

Report2D Options: Axis

These options are set on theAxis panel underReport2D in the Options dialog.
l Axis Name -- this describes the axis to which the following options refer.
l Color -- set the color by double clicking to display the Set color dialog. Select a default or
custom color and clickOK.

l Font color -- set the font color of the axis by double clicking to display the Set color dialog.
Select a default or custom color and clickOK.

l Edit Font -- click the cell to display the Edit Text Font dialog. The dialog lets you select from a
list of available fonts, styles, sizes, effects, colors, and script. The dialog also contains a
preview field.OK the selections to apply the font edits and to close the dialog.

l Font Description -- displays the chosen font properties.

Report2D Options: Grid

These options are set on theGrid panel underReport2D in the Options dialog.
l Grid Name -- lists the name or letter of the grid. Not editable.
l Line Style -- select the options from the drop downmenu. The options are Solid, Dot, Dash,
and Dot dash.

l Line Color -- set the color by double clicking to display the Set color dialog. Select a default or
custom color and clickOK.
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Report2D Options: Header

These options are set on theHeader panel underReport2D in the Options dialog.. For the Title
and SubTitle, you can independently specify the following:

l Color -- set the color by double clicking to display the Set color dialog. Select a default or
custom color and clickOK.

l Font -- click the cell to display the Edit Text Font dialog. The dialog lets you select from a list of
available fonts, styles, sizes, effects, colors, and script. The dialog also contains a preview
field.OK the selections to apply the font edits and to close the dialog.

Report2D Options: Note

These options are set on theNote panel underReport2D in the Options dialog.
l Note Color -- set the color by double clicking to display the Set color dialog. Select a default
or custom color and clickOK.

l Note Font -- click the cell to display the Edit Text Font dialog. The dialog lets you select from a
list of available fonts, styles, sizes, effects, colors, and script. The dialog also contains a
preview field.OK the selections to apply the font edits and to close the dialog.

l Background Color -- set the color by double clicking to display the Set color dialog. Select a
default or custom color and clickOK.

l Background Visibility -- use the check box to toggle the background for the note on or off.
l Border Line Color -- set the color by double clicking to display the Set color dialog. Select a
default or custom color and clickOK.

l Border Visibility -- use the check box to toggle the visibility of the note border.
l Border Line Width -- set the line width by editing the real value in the text field.

Report2D Options: Legend

These options are set on the Legend panel underReport2D in the Options dialog.
l Show Trace Name -- use the check box to toggle the visibility of the trace name.
l Show Solution Name -- use the check box to toggle the visibility of the solution name.
l Show Variation Key -- use the check box to toggle the visibility of the variation key.
l Text Color -- set the color by double clicking to display the Set color dialog. Select a default or
custom color and clickOK.

l Text Font -- click the cell to display the Edit Text Font dialog. The dialog lets you select from a
list of available fonts, styles, sizes, effects, colors, and script. The dialog also contains a
preview field.OK the selections to apply the font edits and to close the dialog.

l Background Color -- set the color by double clicking to display the Set color dialog. Select a
default or custom color and clickOK.

l Border Line Color -- set the color by double clicking to display the Set color dialog. Select a
default or custom color and clickOK.

l Border Line Width -- set the line width by editing the real value in the text field.
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l Grid Color -- set the color by double clicking to display the Set color dialog. Select a default or
custom color and clickOK.

Report2D Options: Marker

These options are set on theMarker panel underReport2D in the Options dialog.
l Marker Color -- set the color by double clicking to display the Set color dialog. Select a default
or custom color and clickOK.

l Marker Font -- click the cell to display the Edit Text Font dialog. The dialog lets you select
from a list of available fonts, styles, sizes, effects, colors, and script. The dialog also contains a
preview field.OK the selections to apply the font edits and to close the dialog.

l Arrow Direction -- set the arrow direction by choosing Up, Down, Left, or Right from the
drop-downmenu.

Related Topics

ModifyingMarkers on Point Plots

Report2D Options: Marker Table

These options are set on theMarker Table panel underReport2D in the Options dialog.
l Text Color -- set the color by double clicking to display the Set color dialog. Select a default or
custom color and clickOK.

l Text Font -- click the cell to display the Edit Text Font dialog. The dialog lets you select from a
list of available fonts, styles, sizes, effects, colors, and script. The dialog also contains a
preview field.OK the selections to apply the font edits and to close the dialog.

l Background Color -- set the color by double clicking to display the Set color dialog. Select a
default or custom color and clickOK.

l Border Line Color -- set the color by double clicking to display the Set color dialog. Select a
default or custom color and clickOK.

l Border Line Width -- set the line width by editing the real value in the text field.
l Grid Color -- set the color by double clicking to display the Set color dialog. Select a default or
custom color and clickOK.

l Grid Line Width -- set the line width by editing the real value in the text field.

Report 2D Options: X-Y Markers

These options are set on theX-Y Markers panel underReport2D in the Options dialog..
You can set background colors for Markers 1 through 10 by clicking the current color to open a color
selection dialog box.
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In addition tomarker colors, properties you can set include:
l On-screen intersection
l Marker Font
l Text color
l Line color
l Line style
l Line width
l Whether to Show Name
l Whether to Snap to Vertex

Inter marker delta properties include:
l Whether to show Delta
l Delta font
l Delta text color
l Line color
l Line style
l Line width

Report2D Options: Digital

These options are set on theDigital panel underReport2D in the Options dialog.
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l Digital Literal Foreground color
l Whether to Expand Arrays/Records

Digital StackHeight in Pixels can be set for the following:
l Analog
l Digital
l Enum
l Event
l Literal

Report2D Options: General

These options are set on theGeneral panel underReport2D in the Options dialog.
l Background Color -- set the color by clicking to display the Set color dialog. Select a default
or custom color and clickOK.

l Plot Area Color -- set the color by clicking to display the Set color dialog. Select a default or
custom color and clickOK.

l Highlight Color -- set the color by clicking to display the Set color dialog. Select a default or
custom color and clickOK.

l Accumulate Depth -- set to 4 by default.
l Curve Tooltip Option -- use the check boxes to toggle the following properties:
a. Show Trace Name
b. Show Variation Key
c. Show Solution Name

l Clipboard Option -- use the drop downmenus to specify the following properties:
a. Capture Aspect Size Ratio -- this can be AsShown or Full Screen.
b. Capture Background Color -- this can be AsShown or White.

l Format -- specify the following properties:
a. Field Width -- set the number of digits to display by editing the real value field.
b. Precision -- set the precision for marker placement by editing the real value field.
c. Use Scientific Notation -- use the check box to toggle scientific notation on or off.

Report2D Options: Table

These options are set on the Table panel underReport2D in the Options dialog.
l Rows Per Page - set to 2500 by default.
l Text Color - set the color by clicking to display the Set color dialog. Select a default or custom
color and clickOK.

l Text Font -- click the cell to display the Edit Text Font dialog. The dialog lets you select from a
list of available fonts, styles, sizes, effects, colors, and script. The dialog also contains a
preview field.OK the selections to apply the font edits and to close the dialog.

l Border Width - set to 2 by default.
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l Border Color - set the color by clicking to display the Set color dialog. Select a default or
custom color and clickOK.

l Grid Width - set to 1 by default.
l Grid Color - set the color by clicking to display the Set color dialog. Select a default or custom
color and clickOK.

l Background Color - set the color by clicking to display the Set color dialog. Select a default
or custom color and clickOK.

l Page Link Color - set the color by clicking to display the Set color dialog. Select a default or
custom color and clickOK.

l Arrow Color - set the color by clicking to display the Set color dialog. Select a default or
custom color and clickOK.

l Header Row - use the following properties to set the header row format:
a. Text Color - set the color by clicking to display the Set color dialog. Select a default or

custom color and clickOK.
b. Text Font -- click the cell to display the Edit Text Font dialog. The dialog lets you select

from a list of available fonts, styles, sizes, effects, colors, and script. The dialog also
contains a preview field.OK the selections to apply the font edits and to close the dialog.

c. Background Color - set the color by clicking to display the Set color dialog. Select a
default or custom color and clickOK.

l Format -- use the following properties to set the format:
a. Field Width -- set the table field width by editing the real value in the text field.
b. Precision -- set the table precision by editing the real value in the text field.
c. Use Scientific Notation -- use the check box to toggle scientific notation on or off.

l Copy to Clipboard -- use the following check boxes to toggle the following properties for
table copy operations:
a. With Header
b. With Tab Separator

Setting 3D Modeler Options

To set 3D modeler options:
1. ClickTools>Options>General Options to open the Options dialog, displaying a

hierarchical list of options.
2. Click the + next to 3D Modeler to display the following choices:

l Drawing
l Operation
l Snap
l Display
l Group
l SpaceClaim Link
l Advanced
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2. Click each option, andmake the desired selections.
3. ClickOK.

3D Modeler Options: Drawing

These options are set on theDrawing panel under 3D Modeler in the Options dialog.
1. TheDrawing Data Entry Mode section controls whether you draw new objects directly via

themouse (Point), or whether aProperties dialog opens for you to enter dimensions for the
object. TheDialog mode drawing feature workswith the equation based line, and all two and
three dimensional objects. You can also use F3 to switch to Point mode and F4 for dialog
mode.

2. In the Relative Coordinate System Creation Mode radio buttons control whether the
default usesAxis/Position or Euler Angle to create a new relative coordinate system. You
can use the F3/F4 keys to switch between themodes.
l For theAxis/Position setting, Modeler> Create> Relative CS>[Offset | Rotated |
Offet and Rotated] entersDrawmode, displaying a point selection cursor and the
Measure Data dialog. Also theStatus bar fields for setting X, Y and Z values, as
Coordinate System settings are active.

l For theEuler Angle setting,Modeler>Create>Relative CS>[Offset | Rotated | Offset
and Rotated] displays a dialog in which you type in the needed values and select units.

3. In thePolyline Creation section, select or clear theAutomatically cover closed polylines
check box.
By default, surface objects created with thePolyline commandwill be created with a cover so
that they become sheet objects. You can choose to leave the polyline as an uncovered object
to perform further operations prior to creating a sheet object
l If checked, closed polylines become sheet objects, and are listed as such in the History tree.
l If not checked, closed polylines are listed under lines in the History tree.

4. Select or clear theShow measures dialog during drawing check box. This specifies
whether aMeasure dialog appears on the creation of a new primitive. The dialog shows the
coordinates of the current cursor position.

5. To have a Properties dialog display whenever you create a new object in themodeling
window, check the box for Edit properties of new primitives.

3D Modeler Options: Operation

These options are set on theOperation panel under 3D Modeler in the Options dialog.
1. By default, themodeler will delete tool objects when performing tasks such asUniting,

Subtracting, or Intersecting objects. The user may specify that themodeler shouldmake a
copy (clone) of the tool object prior to the operation, allowing the object to remain available for
subsequent operations. To specify when to clone tool objects, select or clear the following
check boxes in theClone section:
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l Clone tool objects before uniting
l Clone tool objects before subtracting
l Clone tool options before intersecting
l Clone tool objects before imprinting
l Clone tool objects before projecting

2. In the Coordinate System section, select or clear theAutomatically switch to face
coordinate system check box.
By default, themodeler operateswithin the user selected coordinate system. If this option is
enabled, you can select a face and when a new object creation is started, themodeler first
creates a face coordinate system consistent with the selected face and the new object is
created within the face coordinate system.With this selection, unchecked, youmust manually
create a Face Coordinate System before creating an object related to it.

4. For theModel Edit section:
l IfDelete invalid objects created during split operation is checked, themodeler
deletes invalid objects created during split operation. If not checked, invalid objects can be
created. Validation issueswarnings.

l Select or clearAutomatically imprint wrapped sheets.

3D Modeler Options: Snap

These options are set on theSnap panel under 3D Modeler in the Options dialog.
1. To specify snap settings, select or clear the following check boxes in theSnap Mode section:

l Grid
l Vertex
l EdgeCenter
l Face Center
l Quadrant
l ArcCenter

2. Enter how near themouse needs to be to click a grid item in theMouse Sensitivity box, in
pixels.

3D Modeler Options: Display

Under 3D Modeler in the Options dialog, theDisplay options settings are in three sub-groups:
l General
l Rendering
l History Tree

General
1. UnderOperations History Visualization, select or clear theVisualize history of objects

check box.
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This option lets you view an outline of each part that comprises an object when the given part
is selected in themodel history tree. This can help you visualize an object that has been
merged with another object. A change to the option takes effect only when you restart ANSYS
Electronics Desktop. Clearing this selection removes visualization of objects that are part of
themodel history. For largemodels, this is faster and uses lessmemory. The following figure
shows an example history tree with an object selected and the outline view of that object in the
Main window.

2. Select or clear Show coordinate system of selected operations.
3. Under Selection:

a. Select or clear theShow orientation of selected objects check box.
b. Select or clear theHighlight selection dynamically check box. This option causes

objects or faces (depending on the selectionmode) to be highlighted when you pass the
mouse pointer over them. Youmaywant to turn this off for complicatedmodels.

4. Select or clear Display UV Isolines for wireframe display.
For models with curved faces, youmay prefer to clear this selection to simplify the wire-frame
display, so the rendering will be faster.

Rendering
1. To specify a default color for aModeler drawing object or action (such as on select):

l Select the object or action from theDefault color pull-down list. Then click the color button
to open theColor window.

l Select a color, and clickOK.
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2. To specify how to render an object, selectWireFrame or SmoothShade from theDefault
view render pull-down list.

3. To set theDefault transparency, move the slider, or enter a numerical value.
4. To set theObject Visualization Outline contrast, use the slider. The current value, on a

range from 0 to 1 displays in the text field.
History Tree

1. UnderDefault tree layout:
a. Select or clear the Group objects by material check box. This feature is the same as

selecting or clearing theGroup Objects By Material toggle command from the
Modelermenu.

b. Select or clear Group components by definition.
2. Under Selection, for the Select last command on object select option:

l If checked, the history tree is expanded after operations on object properties, even if the
tree is collapsed for the item.

l If not checked, when you select an object in 3D view, only the object selected, and current
tree collapse/expand state is preserved

3. Under Selection, for the Expand history tree on object select option:
l If not checked, the history tree does not open on object selection. This can be useful for
speeding the display of multiple object selections, or complex objects.

l If checked, selecting an object automatically opens the history tree.

3D Modeler Options: Group Options

To set the Group creation for operation result settings for the 3D Modeler, use
Tools>Options>General Options to open theOptions dialog and select 3D Modeler. Under 3D
Modeler options, selectGroup.

1. To specify Group creation for operation settings, select or clear the following check boxes in
theSnap Mode section:
l Simplify
l Duplicate
l Separate Bodies
l Create object from edge
l Create object from face
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3D Modeler Options: SpaceClaim Link

These options are set on theSpaceClaim Link panel under 3D Modeler in the Options dialog.

Import Options
1. Select or clear Import Solid Bodies.
2. Select or clear Import Surface Bodies.
3. Select or clear Import Parameters, and enter the desiredParameter Key.
4. Select or clear Import Rendering Attributes.
5. Select or clear Import Material Assignments.

3D Modeler Options: Advanced

These options are set on theAdvanced panel under 3D Modeler in the Options dialog.

Faceting
1. Select or clear Incremental faceting (facet only modified faces of object).
2. Select or clear Facet bodies by face using multiple processors.

UDM/UDP Geometry Computation for Optimetrics Analysis
Select either Engine computes the geometry orDesktop computes the geometry.

Note Geometry computation with CAD Integration (dynamic links) and
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geometry sharing in ANSYSWorkbench is always byDesktop.

Setting Fields Reporter Options

To set the Fields Reporter options:
1. ClickTools>Options>General Options to open the Options dialog, displaying a

hierarchical list of options. Click the + next toReporter to expand the list and select Fields
Reported to display the following list:
l Animation
l Mesh Plot
l Streamline Plot

2. On theAnimation panel:
a. Specify whether toGroup Field Overlays by Type (default, yes).
b. Set the default Phase Animation settings for Scalar Plots andVector Plots.

Each of these accepts values for From and To in degrees, and the number of Steps.

3. On theMesh Plot tab, in theClipping of volume mesh plot section, choose the conditions
under which the plot is updated dynamically while dragging the clip plane. Options are:Never,
Always, andWhen number of mesh element is less than (default number is 50000).

4. On theStreamline Plot panel:
a. Set theStreamline drawing stopping criteria.
b. Set theStreamline marker spacing for theNumber of marker per bounding box

diagonal. The default value is 100.

Exporting Options Files

The options files at all levels that may affect a product running as a specific user on a specific host
may easily be exported. You can export options files by selecting Tools>Options>Export Options
Files. This brings up a browser dialog that you use to select the destination directory for the options
files. Pressing the Cancel button will cancel the export command. Pressing theOpen button will copy
all of the config files for the current user and current host to the specified directory. Config files for the
install, install_machine, user, and user_machine levels will be copied, if they exist. One additional file,
admin.XML, will also be copied to the destination directory. This file does not contain user
configurable options.

Related Topics

Setting Options in Maxwell
Setting Options via Configuration Files
Example Uses for Export Options Features
User Options and the Update Registry Tool
BatchoptionsCommand Line Examples
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Setting Options via Configuration Files

Note BecauseMaxwell can interact with other ANSYS products, the following sections on
setting options via configuration files include examples and information applicable to
various other ANSYS products.

In addition to setting options from the Desktop UI, you can also set options in several configuration
files. Options that you set from the Desktop UI will override the option settings from the configuration
files. The option settings from the configuration files are used if they are not overridden using the
Desktop UI. Option settings in the configuration filesmay apply to all users or only to a specific user,
and theymay apply to all hosts or only to specific hosts. There are four levels, listed below frommost
specific (highest precedence) to most general (lowest precedence):

l host dependent user options (apply to the specified user on the specified host only)
l host independent user options (apply to the specified user on all hosts)
l host dependent default options (apply to all users on the specified host)
l installation default (default for all users on all hosts)

A setting at any level will override settings at lower levels in the list above. If there is no setting in any
file, then the application default value will be used.
Behavior Examples
Rules for Modifying Option Settings
Configuration File Locations
Products with Multiple Desktop Applications
Table of Directories and Files

Behavior Examples
For example, consider running an application as user jsmith on host host123. If there is no host
dependent user setting for the "Expand Project Tree on Insert" option in the host dependent user
options config file for user jsmith on host host123, but there is a setting for the "Expand Project Tree
on Insert" option in the host independent user options config file for user jsmith, then the latter
setting will be used if it is not overridden using the Desktop UI. Any settings in the host dependent
default options config file or the installation default config file will be ignored.
For another example, consider running an application as user jdoe on host host123. If there is no
setting for the "Expand Project Tree on Insert" option in the host dependent user options config file
for jdoe on host123 or in the host independent user options config file for user jdoe or in the host
dependent default options config file for host host123, then the value from the installation default
config file will be used, if present.

Rules for Modifying Option Settings
Option settings displayed in the Desktop UI follow the above rules. That is, if there is a setting in any
of the option config files, then the setting from the highest priority config file is displayed in the
Desktop UI. If there is no setting in any of the option config files, then the global default value is used.
You canmodify settings using the variousOptions dialog boxes accessed via the Tools>Options
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menu. If a dialog box is closed with theCancel button, then changesmade on any of the tabs are
discarded. If the dialog box is closed with theOK button, then any settings that have been changed
by the user are written to the host dependent user options config file. The changed valueswritten to
this file are then used the next time that the application is run by the same user on the same host. The
Desktop UI option settings are not written to any of the other option config files.

Configuration File Locations
Two of the configuration files (the host dependent default options config file and the installation
default config file) reside in the installation config directory, which is the "config" subdirectory of the
product installation directory. The other two configuration files (the host dependent user options
config file and the host independent user options config file) reside in a user-specific config directory
for the application. The user-specific config directory for an ANSYS Electromagnetics application is
in a subdirectory of the user'sMy Documents directory onWindows, or a subdirectory of the user's
HOME directory on Linux. The subdirectory pathname is
AnsysEM/ApplicationPathAndVersion/config, whereApplicationPathAndVersion is usually
the product name concatenated with the product version, such asMaxwell2015.0.

Products with Multiple Desktop Applications
For products that havemultiple Desktop applications, each Desktop application will have a separate
user specific config directory, with a different value for theApplicationPathAndVersion directory
name. For example, theMaxwell product contains two Desktop applications:Maxwell andMaxwell
Circuit Editor. For theMaxwell application, the user-specific config subdirectory pathname is
AnsysEM/Maxwell2015.0/config. For theMaxwell Circuit Editor application, the user-specific
config subdirectory pathname isAnsysEM/Maxwell Circuit Editor2015.0/config. For products
that contain multiple Desktop applications, the installation default option settings and the host-
dependent default options settings each reside in a single file for all applications, while the host-
dependent user option settings and host independent user option settings for each application are in
separate files. Although the installation default option settings and the host dependent default
options settings for all applications are each written to a single file, the settings for different
applications are in separate portions of the file.

Table of Directories and Files
The table below shows the directories and files, where the "Level Name" is the name used to
describe an options config file when using the UpdateRegistry? tool, described below.

Config
File

Level
Name File Name Linux Directory Pathname Windows Directory

Pathname
host
depende
nt user
options

user_
mach
ine

hostnam
e_
user.XML

$HOME/AnsysEM/ApplicationPathAnd
Version/config

MyDocuments/AnsysE
M/
ApplicationPathAndVersi
on/config

host
indepen
dent

user user.XML
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Config
File

Level
Name File Name Linux Directory Pathname Windows Directory

Pathname
user
options
host
depende
nt
default
options

instal
l_
mach
ine

hostname.
XML

InstallationDirectory/config InstallationDirectory/conf
ig

installati
on
default

install
default.XM
L

NOTES:
$HOME is the user's home directory on Linux
ApplicationPathAndVersion is the Application or Product name concatenated with the Product
Version
MyDocuments is the user's "MyDocuments" directory onWindows
InstallationDirectory is the directory where the product is installed

The table below shows specific file names and directory names for a typical Maxwell installation on
the Linux andMicrosoft Windows platforms. These are the files that apply to user jsmith and
hostname host123.

Applic
ation

Config
File

Level
Nam
e

File
Name Linux Directory Pathname Windows Directory

Pathname

Maxwe
ll

host
depend
ent
user
options

use
r_
mac
hine

host12
3_
user.X
ML

/home/jsmith/AnsysEM/Max
well2015.0/config

MyDocuments/AnsysEM/Max
well2015.0/config

host
indepe
ndent
user
options

user
user.X
ML

host
depend
ent
default
options

insta
ll_
mac
hine

host123
.XML

/opt/AnsysEM/maxwell2015.
0
/Linux/config

C:/Program
Files/AnsysEM/Maxwell2015.0
/Win32/config
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Applic
ation

Config
File

Level
Nam
e

File
Name Linux Directory Pathname Windows Directory

Pathname

installat
ion
default

insta
ll

default.
XML

Maxwe
ll
Circuit
Editor

host
depend
ent
user
options

use
r_
mac
hine

host12
3_
user.X
ML

/home/jsmith/AnsysEM/Max
well Circuit
Editor2015.0/config

MyDocuments/AnsysEM/Max
well Circuit
Editor2015.0/config

host
indepe
ndent
user
options

user
user.X
ML

host
depend
ent
default
options

insta
ll_
mac
hine

host123
.XML

/opt/AnsysEM/maxwell2015.
0
/Linux/config

C:/Program
Files/AnsysEM/Maxwell2015.0
/Win32/config

installat
ion
default

insta
ll

default.
XML

NOTES:
/home/jsmith is the home directory of user jsmith on Linux
MyDocuments is the "MyDocuments" directory for user jsmith onWindows
TheMaxwell product is installed in directory /opt/AnsysEM/AnsysEM18.0/Win64 on Linux
TheMaxwell product is installed in theC:\Program Files\AnsysEM\AnsysEM18.0\Win64
directory on 64 Bit Microsoft Windows.

Related Topics

Setting or RemovingOption Values in Configuration Files: UpdateRegistry Command
Example Uses for Export Options Features
User Options and the Update Registry Tool
BatchoptionsCommand Line Examples
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Setting or Removing Option Values in Configuration Files:
UpdateRegistry Command

A command line tool,UpdateRegistry, is available tomodify option settings in the options config
files. You can use this command to add, change, or remove settings from any of the option config
files. This tool is included in the installation directory of each product.
This feature is intended tomake it easier for different users to use ANSYS Electromagnetics tools
installed on shared directories or network drives.
TheUpdateRegistry command hasmultiple command line formats as shown below. The -Set
format is used to set or change an option value. The -Delete format is used to delete an option
setting. The following command line options aremutually exclusive: -Set, -Get, -Delete, -GetKeys,
and
-FromFile.
UpdateRegistry -Get Command
This command is used to view an option value in an option config file. If the setting exists in the
specified config file or files, then the value, the value type and the config file where the value was
found will be reported. If no value is found, then that will also be reported.
Usage:

UpdateRegistry -Get -ProductName <name> -RegistryKey <keyPath> [ 
-RegistryLevel <level> ]

<name>
Required. The application or product name and version, as described above. Examples:
HFSS15.0, Maxwell15.0, or "Maxwell Circuit Editor15.0". If the name contains spaces, it must
be quoted.

<keyPath>
Required. The pathname of the option setting.

Example:
Desktop/Settings/ProjectOptions/AnimationMemory.

<level>
Optional. A string denoting which config file to search. One of: install, install_machine, user
and user_machine. If the level is not specified, then all config files are searched in order of
precedence.

UpdateRegistry -GetKeys Command
This command is used to view the allowed key names for all of the option settings, or to view a subset
of the key names that match a string. For each key displayed, the current value, if any, is also
reported. If a key has a value inmultiple config files, then only the highest precedence value is
reported.
Usage:

UpdateRegistry -GetKeys [ <pattern>] -ProductName <name> [ -Case
]
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<pattern>
Optional. If no pattern is specified, then all allowed key names are reported. If a pattern is
specified, then only keys that match the pattern are shown. Examples: Settings/Project. If the
name contains spaces, then it must be quoted. By default, the patternmatch is case
insensitive. If the -Case command line option is specified, then the patternmatch is case
sensitive.

<name>
Required. The application or product name and version, as described above. Examples:
HFSS14.0, Maxwell15.0, or "Maxwell Circuit Editor15.0". If the name contains spaces, it must
be quoted.

UpdateRegistry -Set Command
This command is used to add or modify an option setting in an option config file. If the option config
file does not exist, it will be created. If the setting does not exist in the specified config file, it will be
added. If the setting already exists in the specified config file, then the value will be changed to the
specified value.
Usage:

UpdateRegistry -Set -ProductName <name>
-RegistryKey <keyPath>
-RegistryValue <value> [ -RegistryLevel <level>

<name>
Required. The application or product name and version, as described above. Examples: HFSS14.0,
Maxwell15.0, or "Maxwell Circuit Editor15.0". If the name contains spaces, it must be quoted.
<keyPath>

Required. The pathname of the option setting. Example:
Desktop/Settings/ProjectOptions/AnimationMemory.

<value>
Required. The new value of the option, typically a string or a number. If the value contains
spaces, it must be quoted.

<level>
Optional. A string denoting which config file to modify. One of: install, install_machine, user
and user_machine. If the level is not specified, then the user_machine (host dependent user
options) file ismodified.

UpdateRegistry -Delete Command
This command is used to remove an option setting from an option config file. If the setting does not
exist in the specified config file, the file will not be changed. If the setting exists in the specified config
file, then it will be removed. A settingmay need to be removed from an option config file, to allow the
setting from a lower priority file to be used by the application.
Usage:

UpdateRegistry -Delete -ProductName <name>
-RegistryKey <keyPath>
[ -RegistryLevel <level> ]
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<name>
Required. The application or product name and version, as described above. Examples:
HFSS14.0, Maxwell15.0, or "Maxwell Circuit Editor15.0". If the name contains spaces, it must
be quoted.

<keyPath>
Required. The pathname of the option setting. Example:

Desktop/Settings/ProjectOptions/AnimationMemory.

<level>
Optional. A string denoting which option config file to modify. One of: install, install_machine,
user and user_machine. If the level is not specified, then the user_machine (host dependent
user options) file ismodified.

UpdateRegistry -FromFile Command
You can use this form of the UpdateRegistry command to set multiple key-value pairs from a file with
a single UpdateRegistry command. You specify the -FromFile command line option. This option
must be followed by a filename. The file may contain multiple entries, where each entry contains a
registry key and a registry value. The key-value pairs are added to the registry level specified by the -
RegistryLevel command line option; if no -RegistryLevel is specified, then the default registry level
(user_machine) is used.
UpdateRegistry File Format
The file format is similar to the -batchoptions file format. An example UpdateRegistry file is shown
below:

$begin 'AddEntries'
'TempDirectory'='C:/temp/AnsysEM'
'Maxwell/HPCLicenseType'='Pool'
'Maxwell/UseLegacyMultiprocessingLicense'=1

$end 'AddEntries'

Additional notes on the file format:
l The file may contain an arbitrary number of entries, one per line.
l Leading whitespace on each line is ignored. Spaces or tabsmay be used tomake the file more
readable.

Registry key pathname:
l The registry key pathname appears before the equal sign "=" on each line.
l Each registry key pathnamemust be enclosed in single quotes.

Registry value:
l The registry value appears after the equal sign on each line.
l Integral registry valuesmust not be enclosed in quotes.
l All other registry values are treated as strings, andmust be enclosed in single quotes.
l The forward slash "/" may be used as a directory separator onWindows and Linux. The back
slash "\" may be used as a directory separator onWindows only.

l The back slash "\" is used as an escape character in the value string. That it, this character
removes the special meaning of the following character.
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l The single quote character normally ends the value string. The back slashmay be used to
remove this special meaning, and include a single quote in the string.

l To use a back slash as a directory separator onWindows, it must be escaped. That is, a
double back slash "\\" is used to denote a single directory separator.

Alternative UpdateRegistry File Format
l Analysis Configuration File format, which is exported from the HPC and Analysis Options
dialog.

Related Topics

Setting Options via Configuration Files
Example Uses for Export Options Features
User Options and the Update Registry Tool
BatchoptionsCommand Line Examples

Example Uses for Export Options Features

The Tools>Options>Export Options feature is intended tomake it easier for different users to use
ANSYS Electromagnetics tools installed on shared directories or network drives. This section
outlines some use cases enabled by this feature.
Options That Apply to All Users
Example for Setting an Installation Default Value
Example for Setting a Host Dependent Default Value
Example for Reverting from aUser DefinedOption Value to the Administrator Default
Example Searching for a Registry Key Pathname

Related Topics

Setting Options via Configuration Files
Setting or RemovingOption Values in Configuration Files: UpdateRegistry Command
User Options and the Update Registry Tool
BatchoptionsCommand Line Examples

Options That Apply to All Users
In many cases, an ANSYS Electromagnetics tool installation is administered andmaintained by a
single user or group and used by a number of other users or groups. The permissions of the ANSYS
Electromagnetics tool installationmay be set so that the administrator may add, delete, or modify
files; but other usersmay only read or execute these files. The administrator may set the
recommended option settings in the installation default config file and/or the host-dependent default
options config file. These config files reside within the installation directory hierarchy, and should
generally have the same permissions as other ANSYS Electromagnetics tool installation files. This
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allows the administrator to control these settings, but does not allow other users to add, remove, or
change settings.
Each user can override any of these settings, if needed. Thismay be done using the Desktop UI,
which affects the host dependent user options config file. It may also be done using the host-
independent user options config file. If a user has overridden an option setting in either of the user
files, the user may revert back to the option settings provided by the administrator by removing the
setting of the same option in the host-dependent user option config file and/or the host-independent
user option config file.
For global defaults, the administrator may set a value in the installation default config file. These
settingswill to apply to all users on all hosts.
In some cases, there are significant differences between the capabilities of different hosts. The host-
dependent default config file may be used to specify different default values on some hosts. Any
setting in a host-dependent default config file would affect all users running on the specified host.
The installation default value is used if there is no value specified for the setting in the host-
dependent default config file for the current host. Note that the host-dependent default config file is
named hostname.XML, where hostname is the name of the host.

Example for Setting an Installation Default Value

The normal default for theDesktop/Settings/ProjectOptions/DiskLimitForAbort setting is 0MB.
If the administrator is concerned that running out of disk spacemight be a common problem, the
administrator could set the installation default for the
Desktop/Settings/ProjectOptions/DiskLimitForAbort setting to 1000MB, for example. This
limit would then apply to all users running on all hosts. The administrator could use the following
command to change this setting for Maxwell16.0:

UpdateRegistry -Set -ProductName Maxwell16.0 -RegistryKey

Desktop/Settings/ProjectOptions/DiskLimitForAbort

-RegistryValue 1000
-RegistryLevel install

Example for Setting a Host Dependent Default Value

For this example, we assume that all hosts have two cores, except for three hosts: bighost1,
bighost2, and bighost3, that have eight cores each. Becausemost hosts have two cores, the
administrator has set theSimplorer/Preferences/NumberOfProcessorsDistributed option
value to 2 in the installation default config file, as described above. The administrator may then set
theSimplorer/Preferences/NumberOfProcessorsDistributed option value to 8 in the host-
dependent default config files for the three hosts having 8 cores: bighost1, bighost2 and bighost3.
The administrator may log in to host bighost1, and run the following command to change this
setting for the host-dependent default options config file for host bighost1 onMaxwell16.0:

UpdateRegistry -Set -ProductName Maxwell16.0
-RegistryKey Maxwell/Preferences/NumberOfProcessorsDistributed
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-RegistryValue 8
-RegistryLevel install_machine

Tomake this change for the other two hosts, the administrator would login to bighost2 and
bighost3, in turn, and run the same command on each of those hosts.

Example for Reverting from a User Defined Option Value to the Administrator Default

Consider the case in whichMaxwell 16.0 was installed and the administrator initially did not set a
value for theDesktop/Settings/ProjectOptions/DiskLimitForAbort setting in the default
installation config file. User jsmith (who always uses host jshost) wanted to be warned before disk
space dropped to zero, so he set theDesktop/Settings/ProjectOptions/DiskLimitForAbort to
100MB using the UI (Tools>Options>General Options dialog,Project Options tab,Warn when
available disk space is less than setting). This setting is recorded in the host-dependent user
options config file for host jshost and user jsmith. When the administrator learns that many users
are running into disk space issues, the administrator sets the installation default value for the setting
Desktop/Settings/ProjectOptions/DiskLimitForAbort to 1000MB, as in the above example.
When user jsmith runsMaxwell 16.0 on host jshost, the disk limit is 100MB, not 1000MB, because
the host-dependent user options config file overrides all of the other config files. User jsmithmay
revert to the administrator provided default by removing this setting from the host-dependent user
options config file for host jshost and user jsmith. The following commandmay be run by user
jsmith on host jshost to remove this setting:

UpdateRegistry -Delete -ProductName maxwell16.0
-RegistryKey

Desktop/Settings/ProjectOptions/DiskLimitForAbort -
RegistryLevel user_machine

If user jsmith had added a value for this setting to the host independent user options config file, then
user jsmithwould also run the following command to remove this setting from the host-independent
user options config file:

UpdateRegistry -Delete -ProductName Maxwell16.0
-RegistryKey

Desktop/Settings/ProjectOptions/DiskLimitForAbort
-RegistryLevel user

Example Searching for a Registry Key Pathname

Both administrators and ordinary usersmay occasionally use the UpdateRegistry command line tool
to add, change or delete settings. To use this tool, the registry key pathnamemust be known by the
user. The -GetKeys optionmay be used to quickly search for a key pathname if some information is
known about it. For example, if the administrator knows that there is a setting related to issuing
warningmessageswhen available disk space is low, but she does not know the exact key name, the
following commandmay list some of the keys related to disk space:

UpdateRegistry -GetKeys disk -ProductName Maxwell16.0

Working with Maxwell Projects and Designs 5-83
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

This will display a list of all keys that match the string "disk" case insensitively. Typical output may
look like the following:

Registry keys matching pattern <disk> case insensitively:
Desktop/Settings/ProjectOptions/DiskLimitForAbort: value is
<0> at level <user_machine>

Related Topics

Setting Options via Configuration Files
Setting or RemovingOption Values in Configuration Files: UpdateRegistry Command
User Options and the Update Registry Tool
BatchoptionsCommand Line Examples

User Options and the Update Registry Tool

When you change an options value using the Desktop UI, the new value is stored in the host
dependent user options config file. You can also use the UpdateRegistry tool to add or modify
settings in the host dependent user options config file. You cannot use the Desktop UI to remove
settings from the host dependent user options config file, however. Youmust use the
UpdateRegistry tool to remove settings from the host dependent user options config file.
If a user has not explicitly created a host dependent user options config file or a host independent
user options config file, then when a user first runs an ANSYS Electromagnetics tool on a host, all
settingswill come from the host dependent default options config file or the installation default
options config file. Any settings for another host in a host dependent user options config file will not
be carried over to the new host. Thismay be inconvenient if the user has preferred option settings
that differ from the settings that apply to all users, especially if the user runs the ANSYS
Electromagnetics tool on a number of different hosts. In this case, the user may set these option
values in the user's host independent user options config file. Then, these option valueswill be used
on all new hosts, overriding any values set by the administrator to apply to all users. Any changes
made in the UI will only affect the user's host dependent user options config file for the current host.
Getting a Value from a Specific Configuration File
Getting a Value Using Precedence Rules
Example of Removing a Host Dependent User Option Setting
Example Adding a Host Independent User Option Setting
Setting the Temporary Directory
Temporary Directory Configuration File Format
Example Temporary Directory Configuration File Format
Setting the Temporary Directory Using theGUI
Setting or Removing Temporary Directory Values in Configuration Files: UpdateRegistry Command
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Getting a Value from a Specific Configuration File

In the previous example, the user jsmith may decide to check the
Desktop/Settings/ProjectOptions/DiskLimitForAbort setting in the host independent user
configuration file beforemaking any changes to this setting. The following commandmay be used to
quickly view this setting for Maxwell 16.0 beforemaking the change:

UpdateRegistry -Get -ProductName Maxwell16.0 -RegistryKey
Desktop/Settings/ProjectOptions/DiskLimitForAbort -
RegistryLevel user

Getting a Value Using Precedence Rules

In may cases, the user ismore interested in the value of a setting that will be applicable when running
the product than in the setting in a single configuration file. If the -Get option is used with no -
RegistryLevel specified, then the value reported is the value found in the highest precedence
configuration file. If the user jsmith is interested in the highest precedence value for the
Desktop/Settings/ProjectOptions/DiskLimitForAbort setting, then the following commandmay be
used to report this information:

UpdateRegistry -Get -ProductName Maxwell16.0 -RegistryKey
Desktop/Settings/ProjectOptions/DiskLimitForAbort

Example of Removing a Host Dependent User Option Setting

For this example, user jsmith always uses host jshost to runMaxwell 16.0. At some point, jsmith
set the Autosave interval in theGeneral Options dialog,Project Options tab to 1000 edits, and
this value waswritten to the jsmith's host dependent user options config file for host jshost. Now,
jsmithwants to remove this setting and return to the default value of 10. User jsmithmay run the
following command on host jshost to remove the
Desktop/Settings/ProjectOptions/AutoSaveInterval option value from this config file:

UpdateRegistry -Delete -ProductName Maxwell16.0
-RegistryKey Desktop/Settings/ProjectOptions/AutoSaveInterval
-RegistryLevel user_machine

Related Topics

User Options and the Update Registry Tool
Example Adding a Host Independent User Option Setting
Setting the Temporary Directory
Example Temporary Directory Configuration File Format
Setting the Temporary Directory Using theGUI
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Example Adding a Host Independent User Option Setting

Consider the case in which there is no value set for the
Desktop/Settings/ProjectOptions/DiskLimitForAbort setting for all users for Maxwell 16.0. The
default is then 0MB. User jsmith uses a variety of hosts and wants to be warned whenever disk
space drops to 250MB on any host. User jsmithmay use the following command to set the
Desktop/Settings/ProjectOptions/DiskLimitForAbort option value to 250MB for all hosts:

UpdateRegistry -Set -ProductName Maxwell16.0
-RegistryKey

Desktop/Settings/ProjectOptions/DiskLimitForAbort
-RegistryValue 250 -RegistryLevel user

Related Topics

User Options and the Update Registry Tool
Setting the Temporary Directory
Temporary Directory Configuration File Format
Setting the Temporary Directory Using theGUI

Setting the Temporary Directory

As for other option settings, the Temporary Directorymay be configured with an installation default
value, as well as a host dependent default value, a host independent user specified value and a host
dependent user specified value. The Temporary Directory settings are stored in different files from
the other option settings. These files are located in the same directories as the configuration files for
the other option settings. The following table shows the directories and files used to store the
Temporary Directory settings.

Config
File

Level
Nam
e

File
Name Linux Directory Pathname Windows Directory Pathname

host
depend
ent user
specific
Tempor
ary
Director
y

use
r_
mac
hine

hostnam
e.cfg $HOME/AnsysEM/ApplicationP

athAndVersion
/config

MyDocuments/AnsysEM/Applicatio
nPathAndVersion
/config

host
indepen
dent

user
default.c
fg
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Config
File

Level
Nam
e

File
Name Linux Directory Pathname Windows Directory Pathname

user
specific
Tempor
ary
Director
y
host
depend
ent
default
default
Tempor
ary
Director
y

instal
l_
mac
hine

hostnam
e.cfg

InstallationDirectory/config InstallationDirectory/config

installati
on
default
Tempor
ary
Director
y

instal
l

default.c
fg

NOTES:
$HOME is the user's home directory on Linux
ApplicationPathAndVersion is the Application or Product name concatenated with the
Product Version
MyDocuments is the user's "MyDocuments" directory onWindows
InstallationDirectory is the directory where the product is installed

As for other options, the settings in these files have precedence in the following sequence: user_
machine (highest precedence), user, install_machine, install (lowest precedence). The installer will
create the file at the install level. By default, the other files are not created. If the Temporary Directory
is set to an empty string in a configuration file, then that setting is ignored.

Note TheUpdateRegistry tool may not be used tomodify Temporary Directory
settings.

Related Topics

User Options and the Update Registry Tool
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Example Adding a Host Independent User Option Setting
Example Temporary Directory Configuration File Format
Setting the Temporary Directory Using theGUI
Temporary Directory Configuration File Format

Temporary Directory Configuration File Format

This section describes the format of the Temporary Directory configuration files. The format is the
same for files at all four levels: user_machine, user, install_machine, and install. These files are text
files, so any text editor may be used tomodify or create Temporary Directory configuration files.
An example temporary directory configuration file is shown below:

$begin 'Config'
tempdirectory='C:/TEMP/AnsysEM'
$end 'Config'

The temporary directory specified by this configuration file is C:/TEMP/AnsysEM.
Additional notes:
The string containing the pathname of the temporary directorymust be enclosed in single quotes.
The forward slash "/" may be used as a directory separator onWindows and Linux. The back slash
"\" may be used as a directory separator onWindows only.
The back slash "\" is used as an escape character in the tempdirectory string. That it, this character
removes the special meaning of the following character.
The single quote character normally ends the tempdirectory string. The back slashmay be used to
remove this special meaning, and include a single quote in the string.
To use a back slash as a directory separator onWindows, it must be escaped. That is, a double back
slash "\\" is used to denote a single directory separator.
OnWindows, a UNC path normally begins with two back slash characters. In a tempdirectory string,
each of these back slash charactersmust be doubled, so four consecutive back slashes "\\\\" are
used in the config file.

UNC Example
Config file:

$begin 'Config'
tempdirectory='\\\\hostxyz\\TEMP\\abc'
$end 'Config'

Here hostxyz is a host with a sharename TEMP having subdirectory abc used as the Temporary
Directory. This shows that four back slashes are required for UNC names and that back slashes
used as directory separatorsmust be doubled.

Single Quote Example
Config file:

$begin 'Config'
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tempdirectory='C:/TEMP/ab\'cd'
$end 'Config'

Temporary directory is C:/TEMP/ab'cd. This shows how to include a single quote in a tempdirectory
pathname. It also shows that forward slashesmay be used as directory separators onWindows.

Related Topics

User Options and the Update Registry Tool
Example Adding a Host Independent User Option Setting
Example for Setting the Temporary Directory
Setting the Temporary Directory Using theGUI
Setting the Temporary Directory From the Command Line

Setting the Temporary Directory Using the GUI

As for other options, the Temporary Directorymay be viewed or set using the DesktopGUI. In the
Tools>Options>General Options dialog, the TempDirectory setting appears in the Directories
group box on theProject Options tab. Activating theOverride check box allows you to enter a
desired directory pathname in the edit box or to click on the [...] button to bring up a directory file
browser dialog, fromwhich you can select a temp directory. Values set in thismanner are written to
the user_machine level configuration file for the Temporary Directory. If theOverride check box is
unchecked, then when theOK button is pressed, the user_machine level setting for the Temporary
Directory is changed to an empty string. This enables setting from the next highest precedence
config file. The config file which provides the currently active Temporary Directory setting is shown
under the TempDirectory edit box in the Project Options tab of theGeneral Options dialog, if the
Override check box is unchecked.

Setting the Temporary Directory From the Command Line

The temporary directorymay be set from the command line, using the -batchoptions command line
option. See RunningMaxwell from aCommand Line. The BatchoptionsCommand Line Examples
section below includes examples that show how to set the Temporary Directory from the command
line.

Related Topics

User Options and the Update Registry Tool
Example Adding a Host Independent User Option Setting
Example for Setting the Temporary Directory
Temporary Directory Configuration File Format
Example Temporary Directory Configuration File Format
BatchoptionsCommand Line Examples
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RunningMaxwell from aCommand Line

Setting or Removing Temporary Directory Values in Configuration Files: UpdateRegistry
Command

TheUpdateRegistry command line tool, described above, may be used to view, add, change or
remove the Temporary Directory setting from any of the Temporary Directory config files. The
registry key for viewing or modifying the Temporary Directory is TempDirectory. The -Get, -Set, and
-Delete options are valid for viewing a Temporary Directory setting, adding or changing a Temporary
Directory setting, or deleting a Temporary Directory setting. The -GetKeys option does not list the
Temporary Directory key.

Related Topics

User Options and the Update Registry Tool

Batchoptions Command Line Examples

The -batchoptions entries command line argument may be used to specify one or more
batchoptions settings on the command line. To specifymultiple entries using a single -batchoptions
argument, the entries should be enclosed in double quotes. Alternatively, the batchoptionsmay be
specified in a file using the -batchoptions <filename> command line argument format. In this case,
the filename is an absolute or relative pathname of the file containing the batchoptions, as described
above. The two approachesmay not be combined: either all batchoptionsmust be in a file or all
batchoptionsmust be specified explicitly on the command line.
Batchoptions File Format
Example -BatchOptionswith -Remote (Windows)
Example -Batchsolve with -Machinelist (Windows)
Example -Batchsolve with -Machinelist (Linux)
Example -Batchsolve for Local (Windows)

Related Topics

RunningMaxwell From aCommand Line

Batchoptions File Format

An example batchoptions file is shown below:
$begin 'Config'

'Desktop/ProjectDirectory'='C:/test/projects'
'maxwell/Preferences/NumberOfProcessors'=2

Working with Maxwell Projects and Designs 5-90
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

'maxwell/Preferences/NumberOfProcessorsDistributed'=2
$end 'Config'

Additional notes on the file format:
l The file may contain an arbitrary number of batchoption entries, one per line.
l Leading whitespace on each line is ignored. Spaces or tabsmay be used tomake the file more
readable.

l Option pathname:
The option pathname appears before the equal sign "=" on each line.
Each option pathnamemust be enclosed in single quotes.
Option pathnames are case insensitive.

l Option value:
l The option value appears after the equal sign on each line.
l Integral option valuesmust not be enclosed in quotes.
l All other options values are treated as strings, andmust be enclosed in single quotes.
l The forward slash "/" may be used as a directory separator onWindows and Linux. The
back slash "\" may be used as a directory separator onWindows only.

l The back slash "\" is used as an escape character in the value string. That it, this character
removes the special meaning of the following character.

The single quote character normally ends the value string. The back slashmay be used to
remove this special meaning, and include a single quote in the string.

To use a back slash as a directory separator onWindows, it must be escaped. That is, a
double back slash "\\" is used to denote a single directory separator.

Example -BatchOptions with -Remote (Windows)

In this example, we run a batchMaxwell analysis of project file project1.mxwl which contains a 3D
design.Wewant all temporary files and directories created in directory C:\temp\maxwell instead of
using the installation default for the Temporary Directory. We decide that the analysis will be done on
a remote host, at IP address 12.34.56.78. Because of limitedmemory on the remote host, we decide
to run the analysis using only a single COMengine. Because the remote host has four cores, we
decide to use four threads for multiprocessing, for both distributed and non-distributed parts of the
analysis. We can use the -Remote option to specify that there will be a single remote COMengine.
Here is a sample command line for this analysis, where the project file
\\somehost\projects\project1.mxwl is located in a shared directory specified using a UNC path:

maxwell -BatchSolve -Remote -Machinelist list=12.34.56.78
-batchoptions "TempDirectory='C:/temp/maxwell'
Maxwell3D/Preferences/NumberOfProcessors=4
Maxwell3D/Preferences/NumberOfProcessorsDistributed=4"
\\somehost\projects\project1.mxwl

An alternative is to use the -Distributed command line option. Because the -Machinelist list contains
only one host, there is a single remote COMengine in this case, also.
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maxwell -BatchSolve -Distributed -Machinelist list=12.34.56.78
-batchoptions "TempDirectory='C:\\temp\\maxwell'
Maxwell3D/Preferences/NumberOfProcessors=4
Maxwell3D/Preferences/NumberOfProcessorsDistributed=4"
\\somehost\projects\project1.mxwl

The above command lines show that the forward slash "/" may be used as a directory separator on
Windows. The back slash "\" may also be used as a directory separator onWindows, but it must be
doubled to "\\" because the back slash is also an escape character.

Related Topics

BatchoptionsCommand Line Examples
Example -Batchsolve with -Machinelist (Windows)
Example -Batchsolve with -Machinelist (Linux)
Example -Batchsolve for Local (Windows)

Example -Batchsolve with -Machinelist (Windows)

Suppose that we want to run a batchMaxwell analysis of project file project1.mxwl. Because all of
our hosts havemultiples of 2 cores, we specify that we will use two threads for multiprocessing for
both the distributed (NumberOfProcessorsDistributed) and non-distributed (NumberOfProcessors)
parts of the job. The analysis contains a sweep that will be distributed across three hosts, adam, bill,
and charlie. The hosts adam and bill have four cores each, so we run two distributed COMengines
on each of these hosts, each using two threads. Host charlie has only two cores, so we specify only
one distributed COMengine on this host. This COMengine will also use two threads.We specify a
desired RAM limit of 6 GB and amaximumRAM limit of 8 GB for this analysis. The RAM limits are
specified in KB, so the desired RAM limit is 6291456 KB, and themaximumRAM limit is 8388608
KB.
Here is a sample command line for this analysis, where the project file
\\dennis\projects\project1.mxwl is located in a shared directory specified using a UNC path:

maxwell -BatchSolve -Distributed
-Machinelist list=adam,adam,bill,bill,charlie
-batchoptions "Maxwell/Preferences/MemLimitHard=8388608
Maxwell/Preferences/MemLimitSoft=6291456
Maxwell/Preferences/NumberOfProcessors=2
Maxwell/Preferences/NumberOfProcessorsDistributed=2"
\\dennis\projects\project1.mxwl

Related Topics

BatchoptionsCommand Line Examples
Example -BatchOptionswith -Remote (Windows)
Example -Batchsolve with -Machinelist (Linux)
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Example -Batchsolve for Local (Windows)

Example -Batchsolve with -Machinelist (Linux)

In this example, we run a batchMaxwell analysis of project file project2.mxwl, which contains an
Maxwell design.We have four identical hostshost1, host2, host3, and host4 for analysis, and
each host has 4 cores. We do not usemultiprocessing for the distributed analysis, so
NumberOfProcessorsDistributed=1. As each host has four cores, we specifymultiprocessing
using 4 threads for the non-distributed part of the analysis, soNumberOfProcessors=4. Because
we do not usemultiprocessing for the distributed analysis, we will run four distributed COMengines
on each host, with a singe core available for each engine. As in Example 1, we specify a desired
RAM limit of 6 GB and amaximumRAM limit of 8 GB for this analysis. The RAM limits are specified
in KB, so the desired RAM limit is 6291456 KB, and themaximumRAM limit is 8388608 KB.
Here is a sample command line for this analysis, where the project file
/home/jsmith/projects/project2.mxwl is located in a shared directory:

maxwell -BatchSolve -Distributed
-Machinelist file=/home/jsmith/hosts/list2
-batchoptions "Maxwell/Preferences/MemLimitHard=8388608
Maxwell/Preferences/MemLimitSoft=6291456
Maxwell/Preferences/NumberOfProcessors=4
Maxwell/Preferences/NumberOfProcessorsDistributed=1"
/home/jsmith/projects/project2.mxwl

For this example, the hostnames are in the text file /home/jsmith/hosts/list2. Here are the file
contents:

host1
host1
host1
host1
host2
host2
host2
host2
host3
host3
host3
host3
host4
host4
host4
host4
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Related Topics

BatchoptionsCommand Line Examples
Example -BatchOptionswith -Remote (Windows)
Example -Batchsolve with -Machinelist (Windows)
Example -Batchsolve for Local (Windows)

Example -Batchsolve for Local (Windows)

In this example, we run a batchMaxwell analysis of project file testproject.adsn on the local host. We
want all temporary files and directories created in directoryC:\temp\maxwell instead of using the
installation default for the Temporary Directory. Because the local host has four cores, we decide to
use four threads for multiprocessing, for both distributed and non-distributed parts of the analysis.
Here is a sample command line for this analysis, where the project file
\\host123\projects\testproject.mxwl is located in a shared directory specified using a UNC path:

maxwell -BatchSolve -Local -batchoptions
"TempDirectory='C:/temp/maxwell'
Maxwell/SolverOptions/NumProcessors=4
Maxwell/SolverOptions/NumProcessorsDistrib=4"
\\host123\projects\testproject.mxwl

Related Topics

BatchoptionsCommand Line Examples
Example -BatchOptionswith -Remote (Windows)
Example -Batchsolve with -Machinelist (Windows)
Example -Batchsolve with -Machinelist (Linux)

Batchoptions and Analysis Configurations in the Registry

Analysis configurations are used to specifymachines, cores, and options for local, remote, and
distributed analysis, including capabilities that are enabled byHPC licenses.

How Analysis Configurations are Stored in the Registry
There are several major changes related to how configurations are organized. A configuration
contains information in addition to themachines that are to be used in an analysis. For example, the
number of tasks and the number of cores to allocate to the analysis for eachmachine in the list is also
included in the configuration. Other optionsmay be specific to one product or design type, for
example, certain job distribution types andmemory limits. In order to support different options for
different design types, analysis configurations are now associated with the design type. Previously,
configurations applied to all design typeswithin a given product. Now, it is possible to create
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independent configurationswith the same name, but associated with different design types, and the
appropriate configuration for the design being solved will be used.

Copying a Configuration from one Design Type or Product to Another
To copy a configuration from one design type (or product) to another:

1. On theConfigurations tab of theHPC and Analysis Options dialog, use theExport…
button to export the configuration to a file.

2. Switch to the destination design type (or product) and use the Import… button to import the
configuration data.
Any data that is not applicable to the destination design type is ignored; any settings present in
the destination design type that were not present in the source configuration will be assigned
default values. The user may then edit the copy, as desired.

Using HPC and Analysis Options for Configurations
Due to the complexity of the registry values for the configurationswe do not recommend directly
editing these values using the UpdateRegistry tool. Instead, use theHPC and Analysis Options
dialog to edit or create a configuration. (See Setting HPC and Analysis Options.) Configurations
created or edited using theGUI are stored in the user_machine level of the registry. A configuration
may be created for one of the other registry levels using several steps.

1. First, create the configuration using the Analysis ConfigurationsGUI, then export the
configuration to a file.

2. Next, delete the configuration using theGUI so that it will not be present in the user_machine
level. Exit the GUI.

3. Use the UpdateRegistry tool to import the data into the desired registry level using the -
FromFile option to specify the file exported via the GUI, and using the -RegistryLevel option to
specify the registry level where the configuration is to be stored. For example, an administrator
may use this approach to create a configuration at the install level that may be used by any
user on anymachine.

Batch Options Corresponding to Configurations
The batch options corresponding to configurations are affected by the changes to the organization of
configuration information. A number of batch options are changed. For example, the batch options
settingsMaxwell/Preferences/NumberOfProcessors and
Maxwell/Preferences/NumberOfProcessorsDistributed are no longer used. The new batch option
setting, Maxwell/NumCoresPerDistributedTask, resembles the obsolete
Maxwell/Preferences/NumberOfProcessorsDistributed setting, but there is no equivalent to the
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obsoleteMaxwell/Preferences/NumberOfProcessors setting. The non-distributed portion of the
analysis uses all cores that were allocated for distributed tasks on the givenmachine.
When you submit jobs to a cluster, you can specify batch options using the job submission GUI.
When using theGUI, you can select the batch options from a list, making typographical errors less
common. For themost commonly used batch options, there is detailed information about the allowed
values.

To assist users who need to specify batch options and are unable to use the job submission GUI, a
new help option is added to all products. If the product is launched with the -batchoptionhelp
command line argument, a message box is displayed which lists and describes themost common
batch options specific to the product.

Setting Analysis Configurations Using the User Interface

TheDesktop User Interfacemay be used to select the configuration to be used for each design type.
Each configuration is identified by a unique name. These settingsmay be viewed andmodified using
theHPC and Analysis Options dialog andmodified using theAnalysis Configuration dialog.
See Setting HPC and Analysis Options.
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Working with PEmag Designs
If PEmag is installed on your system, you can launch the PEmag desktop directly from themain
Maxwell Toolsmenu. After you have created or opened a design in PEmag, PEmag can be used to
generate bothMaxwell 2D Electrostatic designs, and Eddy current designs. Also, provided that both
Maxwell and PEmag desktops remain open, you canmodify the relatedMaxwell design using
PEmag.
The first time you invoke PEmag fromMaxwell, an “About PExprt Modeler [PEmag]” dialog displays,
informing you that modeling of magnetic components is disabled when PEmag is invoked from
Maxwell. Uncheck the “I want to see thismessage...” checkbox to prevent this dialog from displaying
again.

Note Please refer to the documentation included with PEmag for detailed information on how to
use that application to work with PEmag designs.

Related Topics

CreatingMaxwell DesignsUsing PEmag
ModifyingMaxwell DesignsUsing PEmag
SolvingMaxwell DesignsGenerated by PEmag

Creating Maxwell Designs Using PEmag

To create aMaxwell Design using PEmag:
1. Select Tools>PEmag to launch the PEmag desktop application.
2. In PEmag, choose either toOpen an existing design, or toCreate a new design.

3. When finished creating the PEmag design, you can choose either Modeler>FEA based
Modeler(2D)>Maxwell 2D Link>Eddy Current orModeler>FEA based Modeler
(2D)>Maxwell 2D Link>Electrostatic to have PEmag generate a corresponding design for
Maxwell.

You can also click on the FEA Eddy Current or FEA Electrostatic toolbar icons.
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a. If you chooseModeler>FEA based Modeler(2D)>Maxwell 2D Link>Eddy Current
a dialog similar to the following displays.
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b. If you chooseModeler>FEA based Modeler(2D)>Maxwell 2D Link>Electrostatic a
dialog similar to the following displays.

4. ClickOK to close the dialog. PEmag generates aMaxwell 2D design and adds it to the
Maxwell Project Manager and desktop. The new design is created corresponding to the
PEmagmodel. The project is immediately saved on disk with the name, <PEmag project
name>.mxwl, in a new folder named <PEmag project name>.pjt, which is under the same
directory as the PEmag project.
Note l Adding aMaxwell 2D design via PEmag is not undo-able.

l After aMaxwell design is created through PEmag, attempting to closeMaxwell
while PEmag is still open, displays amessage to inform that theMaxwell
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desktop cannot be closed while PEmag is still open.

Related Topics

ModifyingMaxwell DesignsUsing PEmag
SolvingMaxwell DesignsGenerated by PEmag

Modifying Maxwell Designs Using PEmag

After aMaxwell project is created through PEmag, theMaxwell project and design can bemodified
in theMaxwell desktop while the PEmag desktop is still open. The PEmagmodel can also be
modified through PEmag desktop while theMaxwell desktop is open.

Note l Modifying aMaxwell 2D design via PEmag is not undo-able.
l After aMaxwell design ismodified through PEmag, attempting to closeMaxwell
while PEmag is still open, displays amessage to inform that theMaxwell desktop
cannot be closed while PEmag is still open.

l Modificationsmade in theMaxwell project are not updated in the PEmag project.

l If youmodify theMaxwell 2D design, or add a new Maxwell design to the project in Maxwell;
or if youmodify the PEmagmodel in the PEmag desktop and regenerate theMaxwell
design (by selecting either Modeler>FEA based Modeler(2D)>Maxwell 2D Link>Eddy
Current orModeler>FEA based Modeler(2D)>Maxwell 2D Link>Electrostatic),
PEmagwill pop up a dialog to askwhether to open the existingMaxwell2D project.

a. If you selectYes, theMaxwell 2D project is reloaded from disk, and any changesmade
inMaxwell to theMaxwell 2D design and project are lost.

b. If you selectNo, theMaxwell design and project on theMaxwell desktop will be
overwritten by the design and project generated through PEmagwith the latest changes
in the PEmagmodel. TheMaxwell 2D project is immediately saved to the disk.

l If you launch PEmag fromMaxwell with noMaxwell projects loaded; then open an existing
PEmag project which has previously been used to generate aMaxwell project, modify the
PEmagmodel and regenerate theMaxwell design (by selecting either Modeler>FEA
based Modeler(2D)>Maxwell 2D Link>Eddy Current orModeler>FEA based
Modeler(2D)>Maxwell 2D Link>Electrostatic), PEmagwill pop up a dialog (see above)
to askwhether to open the existingMaxwell 2D project.
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a. If you clickYes, theMaxwell 2D project on disk is loaded to theMaxwell desktop.
b. If you clickNo, PEmag generates aMaxwell project and design on theMaxwell desktop,

corresponding to themodified PEmagmodel. The project is immediately saved to the
disk, overwriting the previous project on disk and deleting the previous solutions (if any).

l If youmodify a PEmagmodel and regenerate theMaxwell design; then attempt to close
PEmag, a dialog pops up asking whether to keep themodified 2D model files.

a. If you clickYes, PEmag closes and nothing is changed.
b. If you clickNo, PEmag closes, theMaxwell design and project is deleted from disk, but

themodifiedMaxwell design remains on theMaxwell desktop, and you can save the
project to disk, if desired. If not, closingMaxwell will permanently lose the project.

Related Topics

CreatingMaxwell DesignsUsing PEmag
SolvingMaxwell DesignsGenerated by PEmag

Solving Maxwell Designs Generated by PEmag

Maxwell designs generated by PEmag are fully setup and are ready for analysis.
l After solving theMaxwell design generated by PEmag, if you subsequentlymodify the
PEmagmodel and regenerate theMaxwell design, the oldMaxwell design is overwritten
and the solutions are deleted.

l While theMaxwell design is being solved on theMaxwell desktop, if youmodify the
corresponding PEmag design on the PEmag desktop and invoke PEmag to regenerate the
Maxwell design, the solver process on theMaxwell desktop will be aborted and theMaxwell
design that has beenmodified by PEmag is loaded intoMaxwell and saved to the disk
simultaneously.

Related Topics

CreatingMaxwell DesignsUsing PEmag
ModifyingMaxwell DesignsUsing PEmag
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Working with Variables
A variable is a numerical value, mathematical expression, or mathematical function that can be
assigned to a design parameter in Maxwell. You can assign a variable to any dimensional or material
property, or output value.Variables are useful in the following situations:

l When you expect to change a parameter often.
l When you expect to use the same parameter value often.
l When you intend to run a parametric analysis, in which you specify a series of variable values
within a range to solve.

l When you intend to optimize a parameter value by running an optimization analysis.
l When you intend to run a convergence on an output variable.

There are two types of variables in Maxwell:

Project
Variables

A project variable can be assigned to any parameter value in the project in which it was
created. Maxwell differentiates project variables from other types of variables by
prefixing the variable namewith the $ symbol. You canmanually include the $ symbol
in the project variable's name, or Maxwell can automatically append the $ after you
define the variable. Project variables can be used in any design within the project.

Design
Variables

A design variable can be assigned to any parameter value in theMaxwell design in
which it was created. Design variables are not available to other designswithin the
same project.

Related Topics

Defining an Expression
DefiningMathematical Functions
Assigning Variables
ViewingOutput Variable Convergence
Specifying Output Variables
UsingOptimetrics for Design Analysis
Choosing a Variable to Optimize
Selecting Objects by Variable
Exporting Variables for Documentation

Adding a Project Variable

A project variable can be assigned to a parameter value in theMaxwell project in which it was
created. Maxwell differentiates project variables from other types of variables by prefixing the
variable namewith the following symbol: $. You canmanually include the symbol $ in the project
variable's namewhen you create it, or Maxwell automatically appends the project variable's name
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with the symbol after you define the variable. Project variables can be used in any design within the
project.

1. ClickProject>Project Variables.
l Alternatively, right-click the project name in the project tree, and then clickProject
Variables on the shortcut menu.

TheProperties dialog box appears.
2. Under theProject Variables tab, clickAdd.

TheAdd Property dialog box appears.
3. In theName box, type the name of the variable.

Project variable namesmust start with the symbol $ followed by a letter. Variable namesmay
include alphanumeric characters and underscores ( _ ). The names of intrinsic functions and
the predefined constant pi (π) cannot be used as variable names.
You can sort the project variables by clicking on the Name column header. By default,
variables are sorted in original order. Clicking once sorts them in ascending order, noted by a
triangle pointing up. Clicking against sorts in descending order, noted by a triangle pointing
down. Clicking a third time sorts in original order, with no triangle.

4. Select a radio button for the variable use:

Selected Use Setable Properties
Variable Unit Type, Units, Value.

Separator Value

Array Index
Variable

Associate Array variable,
Value

Each selection affects the settable options.
5. For Project Variables in theUnit Type text box you can use the drop-downmenu to select

from the list of available unit types. “None” is the default.
When you select a Unit Type, the choices in drop-downmenu for the Units text box adapt to
that unit type. For example, selecting Length as the Unit Type causes the Unit menu to show a
range of metric and english units for length. Similarly, if you select the Unit Type as
Resistance, the Units drop down lists a range of standard Ohmunits.

6. In theValue text box, type the quantity that the variable represents. If you did not specify the
Unit Type and Unit, you can also optionally, include the units of measurement.

Warning If you include the variable’s units in its definition (in theValue text box), do not
include the variable’s units when you enter the variable name for a parameter
value.

The quantity can be a numerical value, amathematical expression, or amathematical
function. The quantity entered will be the current, (or default) value for the variable. If the
mathematical expression includes a reference to an existing variable, this variable is treated
as a dependent variable. The units for a dependent variable will automatically change to those
of the independent variable on which the value depends. Additionally, dependent variables,
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though useful in many situations, cannot be the direct subject of optimization, sensitivity
analysis, tuning, or statistical analysis.

7. ClickOK.
You return to theProperties dialog box. The new variable and its value are listed in the table.
If the value is an expression, the evaluated value is shown. Updating the expression also
changes the evaluated value display. The evaluated values of any dependent variables also
are changed.

8. Optionally, type a description of the variable in theDescription box.
9. Optionally, selectRead-Only. The variable's name, value, unit, and description cannot be

modified whenRead-only is selected.
10. Optionally, selectHidden. If you clear theShow Hidden option, the hidden variable does not

appear in theProperties dialog box.
11. You can also designate a variable as Sweep. Youmay need to use the scroll bar or resize the

dialog to view the check boxes.

The Sweep check box lets you designate variables to include in solution indexing as a way to
permit faster post processing. Variables with Sweep unchecked are not used in solution
indexing. If a solution exists, checking or unchecking a variable’s Sweep setting produces a
warning that the change will invalidate existing solutions. To continue, clickOK to dismiss the
warning dialog.
If a variable has dependent variables, the Sweep check box is disabled and cannot be
changed.

12. ClickOK.
The new variable can now be assigned to a parameter value in the project in which it was created.

Related Topics

Adding a Design Variable
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Deleting Project Variables
Defining an Expression
DefiningMathematical Functions
Exporting Variables for Documentation

Deleting Project Variables

To delete a project variable:
1. Remove all references to the variable in the project, including dependent variables.
2. Save the project to erase the command history.
3. ClickProject>Project Variables to display theProperties dialog with list of variables.
4. Select the variable and clickRemove andOK.

To remove all unused project variables that are not in use (that is, not in the undo/redo command
history):

1. Remove all references to unused project variables, including dependent variables.
2. Save the project to erase the command history.
3. ClickProject>Project Variables to display theProperties dialog with list of variables.
4. ClickRemove and from the drop-downmenu, selectRemove All Unused and clickOK.

All variables that are not in use (not in undo/redo history) are removed.
To force remove all unused project variables:

1. Remove all references to unused project variables, including dependent variables.
2. ClickProject>Project Variables to display theProperties dialog with list of variables.
3. ClickRemove and from the drop-downmenu, select Force Remove All Unused and click

OK. A warningmessage askswhether you want the unapplied changes in the property dialog
to be applied, and clear undo/redo history. If you select No, nothing happens. If you select
Yes, all unapplied changes are applied first, and undo/redo history is cleared; all variables that
are not used are removed (including those that are only in undo/redo history before this
command is executed).

Adding a Design Variable

A design variable is associated with aMaxwell or RMxprt design. A design variable can be assigned
to a parameter value in the design in which it was created. Design variables are only available within
the design where they are created and are not available to other designswithin the same project.

1. ClickMaxwell3D, Maxwell2D, or RMxprt, and then select Design Properties.
l Alternatively, right-click the design name in the project tree, and then clickDesign
Properties on the shortcut menu.

TheProperties dialog box appears opened on the Local Variables tab. From the Properties
dialog you can Add, Add Array, Edit, or Remove variables. This section describesAdd. Use
the links for descriptions of Add Array, Edit and Remove,
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Any existing Design variables are listed in theProperties dialog with the name followed by
cells for Value, Unit, Evaluated Value, Type, Description, and Read-only and Hidden check
boxes. A Show Hidden check box on the lower right of the Properties dialog controls the
appearance of anyHidden variables.
Initially, leave the radio button with Value selected until you have defined a variable. The other
radio buttons let you enable defined variables for Optimization/Design of Experiments,
Tuning, Sensitivity or Statistics. Selecting one of these radio buttons adds a new column to the
Variable definition row for which you can check or uncheck Include for regular variables for
that kind of Optimetrics simulation. For further discussion, seeOptimetrics.

2. ClickAdd.
TheAdd Property dialog box appears.

3. In theName box, type the name of the variable.
Variable namesmust start with a letter, andmay include alphanumeric characters and
underscores ( _ ). The names of intrinsic functions and the predefined constant pi (π) cannot
be used as variable names.
You can sort the variables by clicking on the Name column header. By default, variables are
sorted in original order. Clicking once sorts them in ascending order, noted by a triangle
pointing up. Clicking against sorts in descending order, noted by a triangle pointing down.
Clicking a third time sorts in original order, with no triangle.

4. Select a radio button for the variable use:

Selected Use Setable Properties
Variable Unit Type, Units, Value

Array Index Variable Associate Array variable,
Value

Separator Value

Post Processing
Variable

Unit Type, Units, Value

Each selection affects the settable options.
5. In theUnit Type text box you can use the drop downmenu to select from the list of available

unit types. “None” is the default.
When you select a Unit Type, the choices in drop downmenu for the Units text box adapt to
that unit type. For example, selecting Length as the Unit Type causes the Unit menu to show a
range of metric and english units for length. Similarly, if you select the Unit Type as
Resistance, the Units drop down lists a range of standard Ohmunits.

Working with Maxwell Projects and Designs 5-106
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

6. In theValue box, type the quantity that the variable represents. Optionally, include the units of
measurement.
Note If you include the variable's units in its definition (in theValue box), do not include the

variable's units when you enter the variable name for a parameter value.

The quantity can be a numerical value, amathematical expression, or amathematical
function. The quantity entered will be the current (or default value) for the variable. If the
mathematical expression includes a reference to an existing variable, this variable is treated
as a dependent variable. The units for a dependent variable will automatically change to those
of the independent variable on which the value depends. Additionally, dependent variables,
though useful in many situations, cannot be the direct subject of optimization, sensitivity
analysis, tuning, or statistical analysis.

Note Complex numbers are not allowed for variables to be used in anOptimetrics sweep, or for
optimization, statistical, sensitivity or tuning setups.

7. ClickOK.
You return to theProperties dialog box. The new variable and its value are listed in the table.
If the value is an expression, the evaluated value is shown. Updating the expression also
changes the evaluated value display. The evaluated values of any dependent variables also
are changed.

8. Optionally, type a description of the variable in theDescription box.
9. You can designate a variable asRead-only, Hidden, or Sweep. Youmay need to use the

scroll bar or resize the dialog to view the check boxes.

The Sweep check box lets you designate variables to include in solution indexing as a way to
permit faster post processing. Variables with Sweep unchecked are not used in solution
indexing. If a solution exists, checking or unchecking a variable’s Sweep setting produces a
warning that the change will invalidate existing solutions. To continue, clickOK to dismiss the
warning dialog.
If a variable has dependent variables, the Sweep check box is disabled and cannot be
changed.
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10. ClickOK.
The new variable can now be assigned to a parameter value in the design in which it was
created.

Related Topics

Adding a Project Variable
Deleting Design Variables
Deleting Project Variables
Defining an Expression
DefiningMathematical Functions

Add Array of Values for a Design Variable

A design variable is associated with aMaxwell design. You can also add a variable defined with an
array of values.

1. ClickMaxwell 3D orMaxwell 2D>Design Properties.
l Alternatively, right-click the design name in the project tree, and then clickDesign
Properties on the shortcut menu.
The Local VariablesProperties dialog box appears. From the Properties dialog you can
Add, Add Array, Edit... or Remove variables. This section describes Add Array. Use the
links for descriptions of Add,.Edit and Remove,

Any existing Design variables are listed in theProperties dialog with the name followed by
cells for Value, Unit, Evaluated Value, Type, Description, and Read-only and Hidden check
boxes. A Show Hidden check box on the lower right of the Properties dialog controls the
appearance of anyHidden variables.
Initially, leave the radio button with Value selected until you have defined a variable. The
other radio buttons let you enable regular variables for Optimization/Design of Experiments,
Tuning, Sensitivity or Statistics. Array variables cannot be enabled for Optimetrics use.

2. Click theAdd Array.... button.
TheAdd Array dialog displays.

3. Specify a variable Name in the text field.
4. Select a Unit Type and Units from the drop-downmenus.
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5. To specify the array with Edit in Grid Selected, you can begin by clicking theAppend Rows...
button to display theNumber of Rows dialog. (For Edit in plain text field, see below.)

6. Specify a value and clickOK.
This displays a list of indexed data rows in theAdd Array dialog. You can type any data value
in the cells. If you enter alphanumeric text in a cell it must be delimited by double quotes. You
can edit the rows relative a row selection by clicking buttons to Add Row Above, Add Row
Below, or Remove Row. All cellsmust contain a value.

7. When you have completed the array, clickOK to close the dialog,
The Array variable is listed in theDesign Properties dialog as a Local Variable. The array
variable value field includes the array contents in brackets with the unindexed data values
delimited by commas.
If you elected to edit the array Edit in plain text field in theAdd Array dialog, the bracketed and
comma delimited format is used.

Related Topics

Adding a Project Variable
Deleting Design Variables
Deleting Project Variables
Defining an Expression
DefiningMathematical Functions
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Editing a Design Variable

A design variable is associated with aMaxwell design. A design variable can be assigned to a
parameter value in theMaxwell design in which it was created. You can also add a variable defined
with an array of values.

1. ClickMaxwell>Design Properties.
l Alternatively, right-click the design name in the project tree, and then clickDesign
Properties on the shortcut menu.

The Local VariablesProperties dialog box appears. From the Properties dialog you can Add,
Add Array, Edit, or Remove variables. This section describesEdit. Use the links for
descriptions of Add, Add Array and Remove.

Any existing Design variables are listed in theProperties dialog with the name followed by
cells for Value, Unit, Evaluated Value, Type, Description, and Read-only and Hidden check
boxes. A Show Hidden check box on the lower right of the Properties dialog controls the
appearance of anyHidden variables.
Initially, leave the radio button with Value selected until you have defined a variable. The other
radio buttons let you enable defined variables for Optimization/Design of Experiments,
Tuning, Sensitivity or Statistics. Selecting one of these radio buttons add a new column to the
Variable definition row for which you can check or uncheck Include a regular variable for that
kind of Optimetrics simulation. Array variables cannot be Enabled for Optimetrics. For further
discussion, seeOptimetrics.

2. Select a variable to highlight it.
3. Click theEdit button.

For regular variables, theAdd Property dialog for that variable opens, and for array
variables, theEdit Array variable dialog for that variable opens.

4. Complete the edits and OK the dialog to apply them.

Deleting Design Variables

To delete a design variable:
1. Remove all references to the variable in the design, including dependent variables.
2. Save the project to erase the command history.
3. ClickMaxwell>Design Properties to display theProperties dialog with list of local

variables.
4. Select the variable and clickRemove andOK.

To remove all unused design variables (that is, not in the undo/redo command history):
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1. Remove all references to unused variables in the design, including dependent variables.
2. Save the project to erase the command history.
3. ClickMaxwell 2D orMaxwell 3D>Design Properties to display theProperties dialog with

list of local variables.
4. Select the variable and clickRemove and from the drop-downmenu, selectRemove All

Unused and clickOK. All variables that are not in use (not in undo/redo history) are removed.
To force remove all unused design variables:

1. Remove all references to unused variables in the design, including dependent variables.
2. ClickMaxwell 2D orMaxwell 3D>Design Properties to display theProperties dialog with

list of local variables.
3. Select the variable and clickRemove and from the drop-downmenu, select Force Remove

All Unused and clickOK. A warningmessage askswhether you want the unapplied changes
in property dialog to be applied, and clear undo/redo history. If you select No, nothing
happens. If you select Yes, all unapplied changes are applied first, and undo/redo history is
cleared; all variables that are not used are removed (including those that are only in undo/redo
history before this command is executed).

Related Topics

Deleting Project Variables

Adding Datasets

Datasets are collections of plotted data points that can be extrapolated into an equation based on the
piecewise linear makeup of the plot. Each plot consists of straight line segments whose vertices
represent their end points. A curve is fitted to the segments of the plot and an expression is derived
from the curve that best fits the segmented plot. The created expression is then used in a piecewise
linear intrinsic function such as: pwl, pwlx or pwl_periodic. You can add datasets at either the Project
Level or the Design level. They can be for various purposes, including to define frequency dependent
port impedances or frequency dependent global variables, and boundary definitions.

Note The descriptions of the various controls and fields for working with datasets are also
applicable to theBH Curve dialog boxwhenSpecifying a BH Curve for Nonlinear Relative
Permeability.

Design level datasets can be used in geometry entities like part commands, coordinate systems,
points, and planes. Datasets do not work with equation-based surfaces or curves. Datasets can be
used in directly with piecewise linear functions in expressions or indirectly through variables that can
refer to the dataset. Datasets can be used in the following operations.

l Creation or editing of geometry.
When a geometry uses a dataset directly, edit dataset invalidates the solution. When a
geometry uses a variable that is defined by dataset, edit dataset does not invalidate the
solution.
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l Animation based on a variable which can index in datasets.
l Copy/paste of geometry. If a part refers to a design dataset, it will be pasted to destination
design.

The following procedure describes how to add a dataset manually. You can also add datasets:
l By importing data from an external file.
l By using the SheetScan tool.

1. For a Project level dataset, clickProject>Datasets. For a Design level dataset, clickMaxwell
2D>Design Datasets,Maxwell 3D>Design Datasets, orRMxprt>Design Datasets.
TheDatasets dialog box appears. This lists any existing datasets for the Project or Design
level, respectively.

2. ClickAdd.
TheAdd Dataset dialog box appears. The dialog contains fields for the Dataset name, and a
table for x- and y- coordinates. It contains a graphic display that draws a line for the
coordinates you add. It also includes buttons for the following functions:
l Swap X-Y Data - this swaps the x- and Y- coordinates and adjusts the graphical display.
l Import Dataset - this provides a way to import data sets from an external source. The
format is a tab separated points file. Clicking the button opens a file browser window.

l Export Dataset -- this provides a way to export the current dataset to a tab separated
points file. Clicking the button opens a file browser window.

l Add Row Above - adds a new row to the table above the selected row.
l Add Row Below - adds a new row to the table below the selected row/
l Append Row - opens a dialog that lets you specify a number of rows to add to the table.
l Delete Row - deletes the selected row or rows.

3. Optionally, type a name other than the default for the dataset in theName box.
4. Enter the x- and y- coordinates by one of the followingmethods

Type the x- and y-coordinates for the first data point in the row labeled 1.Type the x- and y-
coordinates for the remaining data points in the dataset using the samemethod.
After you type a point’s coordinates andmove to the next row, the point is added to the plot,
adjusting the display with each newly entered point.

Note l The x-coordinate values for successive data pointsmust increase within ten
significant digits.

l You can also use the Import Dataset button to import data coordinates. Doing so
will overwrite any existing values in the Coordinates panel.

5. When you are finished entering the data point coordinates, clickOK.
6. ClickDone in the Datasets dialog box.

The dataset plot is extrapolated into an expression that can be used in parametric analyses,
boundary definitions, or assigned to amaterial property value.

Related Topics

Adding a Design Variable
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Editing Datasets
Using Piecewise Linear Functions in Expressions
Using Dataset Expressions
Calculating the Properties for a Non-Linear Permanent Magnet
Using SheetScan

Datasets Dialog Box

TheDatasets dialog box provides a browsable listing of all datasets currently defined for the project
or design. A preview window displays a plot of the currently selected dataset. Controls allow you to
Add, Edit,Remove, andClone datasets; to Import andExport characteristics data; and to launch
theSheetScan tool that you can use to extract data from graphics such as data sheets.
Add - Opens a blankAdd Datasetwindow in which you can define a dataset by entering data
coordinates directly, or by importing data from a file.
Edit - Opens the selected dataset in anEdit Datasetwindow for editing.
Remove - Removes the selected dataset from the project.
Clone - Copies the selected dataset to an editing window for modification. The original dataset
remains intact.
Import - Opens an Import Datasetwindow in which you can locate and import characteristics data
from several file types including data exported from theSheetScan tool.
Export - Opens anExport Datasetwindow in which you can export the selected dataset to a tab-
delimited file.
SheetScan - Opens the SheetScan tool in which you can extract characteristics data from graphics
such as data sheets.

Related Topics

Adding Datasets
Importing Datasets
Editing Datasets
Cloning Datasets
Exporting Datasets
Removing Datasets
Using SheetScan

Dataset Preview Plot Properties

1. You can change the properties of various elements of the preview plot such as themajor and
minor grid colors, title font, and trace line style by double-clicking the element to open its
properties dialog box.
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2. Depending on the type of element selected, tabs allow you to set theColor, Font, Line Style,
Scaling, Title, and Legend properties.

3. Right-clicking inside the plot window opens a context menu containing commands to add and
delete datamarkers and labels, change trace type, and print the plot.

4. ClickSave as Defaults to make the changes the default values.
5. ClickOK to apply the changes only while the current dataset plot window is open. Click Save

asDefaults to keep the changes.

Importing Datasets

To import data for a dataset from a file:
1. For a Project level dataset, clickProject>Datasets. For a Design level dataset, clickMaxwell

2D>Design Datasets,Maxwell 3D>Design Datasets, orRMxprt>Design Datasets.
TheDatasets dialog box appears.

2. Click the Import button.
3. In the file browser window that appears, choose the tab delimited data file you wish to import,

and clickOK to import the data.
4. After importing the data, you canmodify it manually (see Editing Datasets).

Note You can also import a dataset in the Add Dataset and Edit Dataset
windows.

Related Topics

Adding Datasets
Editing Datasets
Cloning Datasets
Exporting Datasets
Removing Datasets
Using SheetScan

Editing Datasets

1. For Project level datasets, clickProject>Datasets. For Design level datasets, clickMaxwell
2D>Design Datasets,Maxwell 3D>Design Datasets, orRMxprt>Design Datasets.
TheDatasets dialog box appears.

2. Click the dataset name you want to modify, and then clickEdit.
TheEdit Dataset dialog box appears.

3. Optionally, type a name other than the default for the dataset in theName box.
4. Type new values for the data points as desired.

The plot is adjusted to reflect the revised data points.
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5. When you are finished entering the data point coordinates, clickOK.
6. ClickDone.

Related Topics

Adding Datasets
Adding a Design Variable
Modifying Datasets
Using Piecewise Linear Functions in Expressions
Using Dataset Expressions

Cloning Datasets

Cloning a dataset generates a copy of an existing dataset. The clone can then bemodified as
needed.

1. For Project level datasets, clickProject>Datasets. For Design level datasets, clickMaxwell
2D>Design Datasets,Maxwell 3D>Design Datasets, orRMxprt>Design Datasets.
TheDatasets dialog box appears.

2. Click the dataset name you want to clone, and then clickClone.
TheClone Dataset dialog box appears.

3. Modify the dataset as needed.

Related Topics

Adding Datasets
Importing Datasets
Editing Datasets
Exporting Datasets
Removing Datasets
Using SheetScan

Exporting Datasets

1. For Project level datasets, clickProject>Datasets. For Design level datasets, clickMaxwell
2D>Design Datasets,Maxwell 3D>Design Datasets, orRMxprt>Design Datasets.
TheDatasets dialog box appears.

2. Click theExport button.
TheExport Dataset dialog box appears.
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3. Browse to the location you want to store the exported dataset.
4. Name the file (exported datasets are tab-delimited and are given a .tab extension), and click

Save to complete the export operation.
Note You can also export a dataset in the Add Dataset and Edit Dataset

windows.

Related Topics

Adding Datasets
Importing Datasets
Editing Datasets
Cloning Datasets
Removing Datasets
Using SheetScan

Removing Datasets

1. For Project level datasets, clickProject>Datasets. For Design level datasets, clickMaxwell
2D>Design Datasets,Maxwell 3D>Design Datasets, orRMxprt>Design Datasets.
TheDatasets dialog box appears.

2. Click the dataset name you want to remove, and then clickRemove.
3. When finished removing datasets, clickDone.

Related Topics

Adding Datasets
Importing Datasets
Editing Datasets
Cloning Datasets
Exporting Datasets
Using SheetScan

Using SheetScan

SheetScan allows you to extract characteristics data from graphics such as data sheets which have
been scanned and saved in any of the following formats: .bmp, .dib, .jpg, .gif, .tif, .tga, .pcx, .htm, or
.html.
In addition to importing graphic files directly, SheetScan also can be used to browse the Internet for
datasheet information and transfer a snapshot of the web page to the SheetScan editor where you
canmap axes on the image as an overlay. You can thenmanually add datapoints to approximate the
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characteristic curve(s) on the datasheet.The sampled data can then be converted toMaxwell format,
and the extracted data exported to aMaxwell dataset or saved to a tab-delimited file.
The process for creating a dataset using SheetScan involves four basic operations:

l Loading a datasheet into SheetScan.
l Defining a coordinate system for the imported datasheet picture.
l Defining a characteristic curve using the datasheet picture as reference.
l Exporting the characteristic curve data to a file or to a dataset.

Related Topics

SheetScan Toolbars
SheetScan Settings
The Curve ValuesWindow
Loading a Datasheet into SheetScan
Deleting a Datasheet Picture
Defining a SheetScan Coordinate System
Defining a Characteristic Curve in SheetScan

SheetScan Toolbars

Three toolbars are available in SheetScan. They provide convenient access to commands that are
also found in the SheetScanmainmenu. Toolbars can be toggled on and off via theView>Toolbar
sub-menu.

l TheStandard toolbar includes access to basicWindows functions such as file Open and
Save, Cut, Copy, Paste, Print, and Help.

l TheCurve toolbar contains tools for working with curve values. A pull-downmenu allows you
to select the curve on which to work. Other tools allow you to: change curve settings, change
the curve’s coordinate system, and to select, append, delete, and insert points on the active
curve

l The Zoom toolbar provides tools for scaling the current view, zooming in and out, resetting the
zoom to 100 percent, and toggling the display of the curve’s grid on and off.
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Related Topics

SheetScan Settings
The Curve ValuesWindow
Loading a Datasheet Picture into SheetScan
Deleting a Datasheet Picture
Defining a SheetScan Coordinate System
Defining a Characteristic Curve in SheetScan

SheetScan Settings

Default settings aremade by choosingOptions>Settings. TheSettings dialog box contains three
tabs:

l TheDocument tab allows you to set theWidth and Height of the sheet created when a
picture imported into the SheetScan editor. You can either enter the dimensionsmanually, or
allow SheetScan to adapt the dimensions to the picture being loaded.

l TheAxis tab allows you to set the defaultName,Unit of measure,Scaling factor, andOffset
value for the X and Y axes. CheckingMonotonicity in X automatically prevents you from
adding consecutive data points whose X-values are not increasing.

l TheRepresentation tab lets you choose whether to connect points on the characteristic
curve and to choose the color of the connecting line. You can also choose to displaymarkers
for the point chosen when defining a curve, to set the color of displayedmarkers, and to set the
color of markers when they are selected.
Note You can also override the default settings on the Axis and Representation tabs for

individual curves (see Defining a Characteristic Curve in SheetScan).

Related Topics

Loading a Datasheet Picture into SheetScan
Defining a SheetScan Coordinate System
Defining a Characteristic Curve in SheetScan

The Curve Values Window

TheView>Curve Valuesmenu item toggles the display of a dock-ableCurve Valueswindow that
displays the data points you place when creating a characteristic curve. Data for each curve on a
sheet is displayed on its own tab. You canmanually change the X and Y values in the table to fine-
tune the characteristic curve.

Related Topics

Loading a Datasheet Picture into SheetScan
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Defining a SheetScan Coordinate System
Defining a Characteristic Curve in SheetScan

Loading a Datasheet Picture into SheetScan

By default, SheetScan opens a new, blank datasheet editing window. There are two ways to load a
datasheet picture into the editor:

Loading a Datasheet Picture Directly
1. Browse directly to the datasheet picture file by choosingPicture>Load picture to open a file

browser window.
2. When you have located the desired file, clickOK to load the image into the SheetScan editor.

Supported file types include: .bmp, .dib, .jpg, .gif, .tif, .tga, .pcx, .htm, and .html.

Loading a Datasheet Picture Using the HtmlViewer
1. ChoosePicture>Internet to open the Sheetscan HtmlViewer.
2. Browse the Internet for the desired datasheet.
3. Resize theHtmlViewer window and adjust its scrollbars until the desired portion of the

datasheet is in view

4. Click the To SheetScan button to copy the visible contents of the HtmlViewer window
into the SheetScan editor window.
Note To hide the datasheet picture, choosePicture on theView

menu.

After loading a datasheet picture into the SheetScan editor, the next step is Defining a coordinate
system for the imported picture.

Related Topics

SheetScan Toolbars
SheetScan Settings
The Curve ValuesWindow
Deleting a Datasheet Picture
Loading a Datasheet Picture into SheetScan
Defining a SheetScan Coordinate System
Defining a Characteristic Curve in SheetScan

Deleting a Datasheet Picture

To delete a Datasheet picture, choosePicture>Delete picture.

Warning You cannot undo this action. If you delete a picture from the SheetScan editor, youmust
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reload it from the source file or Internet web page.

Related Topics

Loading a Datasheet Picture into SheetScan

Defining a SheetScan Coordinate System

Use this procedure to define a coordiante system typically for a graph on a datasheet picture that you
have previously loaded into the SheetScan editor.
To define the coordinate system:

1. SelectCoordinate System>New to open theCoordinate System dialog box.
2. Click thePoint1 button.

TheCoordinate System dialog box disappears temporarily and the cursor changes to a
crosshairs.

3. Position the cursor over a corner of the datasheet graph and click the left mouse button.
TheCoordinate System dialog box reappears displaying the X- and Y-Coordinate values for
the chosen point.

4. Enter the X-Value and Y-Value for this point. Typically, these valueswill correspond to the
values taken from the axis scale values on the datasheet.

5. Select the desired scaling (linear, logarithmic, or decibel) for both the X and Y axes.
6. Repeat steps 2 through 4 for thePoint2 andPoint3 buttons.
7. ClickOK. The grid is placed in the graphic.

Note l You can edit the grid after placement either by selectingCoordinate
System>Properties from the SheetScanmainmenu bar, by clicking the
coordinate system icon on the Curve toolbar, or by right-clicking in the
SheetScan editing window and selectingCoordinate system from the
context menu.

l You can hide the grid by selectingGrid on theViewmenu, or by clicking the

grid icon on theCurve toolbar.

8. Proceed toDefining a Characteristic Curve in SheetScan.

Related Topics

SheetScan Toolbars
SheetScan Settings
Loading a Datasheet Picture into SheetScan
Defining a Characteristic Curve in SheetScan
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Defining a Characteristic Curve in SheetScan

Once you have loaded a datasheet picture in the editor and have defined a coordinate system, you
can define one or more characteristic curves as follows:

1. ChooseCurve>New.
TheCurve Settings dialog box opens.

2. Define the properties of the curve. Refer to SheetScan Settings for a detailed explanation of
the settings you canmake on theAxis andRepresentation tabs.

3. When finished defining curve properties, clickOK.
The cursor changes to cross hairs.

4. Click the points of the characteristic which you want to capture for the dataset. The points are
connected automatically.

5. Repeat steps 1 through 4 for each additional characteristic curve you wish to define.
After characteristic curves have been defined, you can perform various operations on them. Refer to
PerformingOperations on SheetScan Curves for details.

Related Topics

SheetScan Toolbars
SheetScan Settings
The Curve ValuesWindow

Performing Operations on SheetScan Curves

You can perform the following operations on existing characteristic curves:
l select a curve for editing
l edit a curve
l delete a curve
l change curve settings
l check if a curve ismonotonically increasing along the X-axis
l export the curve data to a dataset

Selecting a SheetScan Characteristic Curve

1. To select a SheetScan curve for editing, do one of the following:
a. SelectCurve>Select on the SheetScanmenu bar.
b. Right-click in the editor window and chooseSelect Curve from the context menu.
TheSelect Curve dialog box opens.
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2. Click the desired curve name to highlight it, then clickOK to select the curve.
Note If the Curve Valueswindow is open, you can also click the tab of the desired curve to

select it.

Related Topics

SheetScan Toolbars
SheetScan Settings
The Curve ValuesWindow

Changing Characteristic Curve Settings

You can changes curve settings for a characteristic curve as follows:
1. Select the curve whose settings you wish to change.
2. ChooseCurve>Change Settings.

TheCurve Settings dialog box opens.
2. Change the properties of the curve as desired. Refer to SheetScan Settings for a detailed

explanation of the settings you canmake on theAxis andRepresentation tabs.
3. When finished changing curve properties, clickOK.
4. Repeat steps 1 through 3 for each additional characteristic curve you wish to change.

Related Topics

SheetScan Toolbars
SheetScan Settings
The Curve ValuesWindow

Editing a SheetScan Characteristic Curve

The following SheetScan curve editing functions are available either via themainCurvemenu, the
Curve toolbar, or the editor window context menu:

l Select points— click on a point to select it.Ctrl+click selectsmultiple points.
l Append points— click to add data points to the end of a curve.
l Delete points— click a data point to remove it from the curve.
l Insert points— click to insert new data points between existing data points.

Related Topics

SheetScan Toolbars
SheetScan Settings
The Curve ValuesWindow
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Deleting a SheetScan Characteristic Curve

To delete a characteristic curve and all of its associated data points:
1. Select the desired curve.
2. SelectCurve>Delete.

Warning You cannot undo this action. If you delete a curve and its data points from the
SheetScan editor, youmust reconstruct it manually.

Checking for Monotonicity in X

Maxwell requires that characteristics bemonotonically increasing along the X-axis. In other words,
successive data pointsmust have increasing X-values, while Y-valuesmay both increase and
decrease. You can check for monotonicity in X as follows:

1. SelectCurve>Check Monotonicity.
If the characteristic curve ismonotonically increasing in X-value, the check completeswithout
notice. Typical examples of curves that meet monotonicity criteria are shown below.

2. If the characteristic curve is not monotonically increasing in X-value, a dialog box displays
informing you that errors were found. ClickYes to have SheetScan automatically correct the
errors.

Related Topics

Defining a Characteristic Curve in SheetScan

Importing Characteristic Data into SheetScan

SheetScan supports data import from the following file types: Simplorer Characteristic (*.mdx,
*.mda), Microsoft Access (*.mdb), Microsoft Excel (*.xls), text (*.txt), comma separated value (*.csv),
Spice (*.out), Comtrade (*.cfg), and TEK Oscilloscope (*.dat).
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1. To import characteristic curve data into SheetScan, select File>Import.
2. In the fileOpen dialog box, select the desired data file and clickOK.

a. Selecting a .xls file containingmultiple sheets opens a Table Properties dialog where
you can choose the desired sheet from a drop-down list. Otherwise, selecting a .xls file
imports the data immediately into theAdd Dataset dialog box.
Note l Only the first two columns of data are imported, the left-most column

containing the X-coordinate values. The x-coordinate values for
successive data pointsmust increase within ten significant digits. Non-
numeric entries are assigned a value of zero.

l The first row of data is assumed to contain column headings and is
ignored.

b. Selecting a .txt, .tab, or .csv file opens an Import dialog box in which you can specify how
to settings for reading the data in the file for import. You can choose theSeparator(s) and
Decimal Symbol, as well as the line at which to begin the import. The dialog box shows
both the original text and the text as it would appear when imported based on the current
import settings.

When satisfied with the import settings, clickOK to import the data.

A Curve Settings dialog box opens.

3. ChangeCurve Settings as needed and clickOK to complete the data import.
The new characteristic curve is added to the current SheetScan sheet.

Exporting SheetScan Data

You can export SheetScan curve data directly to aMaxwell or RMxprt Dataset.
1. To export the curve data, choose File>Export.
2. In theSavedialog box, chooseCurrent Curve (default) to export current curve data, or

Curves if you wish to choose the curve(s) whose data you wish to export. ChoosingCurves
reveals a list box showing all of the curves available for export. Check theExport box for the
desired curves.
Note TheMultidimensional Table option is not currently

supported.

3. ChooseEquidistant if you want to set theStart andStopX-Channel values and aSample
Rate orNumber of samples for the exported dataset(s),

4. ChooseDataset to export curve data directly to the project’s dataset file.
Note Exporting data to a file via the File button is not currently

supported.

Related Topics

Adding Datasets
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Defining Mathematical Functions

Amathematical function is an expression that references another defined variable. A function's
definition can include both expressions and variables.
The followingmathematical functionsmay be used to define expressions:

Basic
functions

/, +, -, *, mod (modulus), ** (exponentiation), - (Unaryminus), == (equals), ! (not),
!= (not equals), > (greater than), < (less than), >= (greater than equals), <= (less
than equals),&& (logical and), || (logical or)

Intrinsic
functions

if, abs, exp, pow, ln (natural log), log10, sqrt

Trigonometric
expressions

sin, cos, tan, asin, acos, atan, sinh, cosh, tanh

The predefined variables X, Y, Z, Phi, Theta, R, and Rhomust be entered as such. X, Y, and Z are
the rectangular coordinates. Phi, Theta, and Rho are the spherical coordinates. R is the cylindrical
radius, and Rho is the spherical radius.
If you do not specify units, all trigonometric expressions expect their arguments to be in radians, and
the inverse trigonometric functions’ return values are in radians. If you want to use degrees, you
must supply the unit name deg. When the argument to a trigonometric expression is a variable, the
units are assumed to be radians. These function names are reserved andmay not be used as
variable names.
As far as expression evaluation is concerned: units are conversion factors (that is, from the given unit
to SI). Note also that the evaluated value of an expression) is always interpreted as in SI units.

Related Topics

Setting Coordinate Systems
Expressing Cartesian, Cylindrical or Spherical Coordinates

Defining an Expression

Expressions aremathematical descriptions that typically contain intrinsic functions, such as sin(x),
and arithmetic operators, such as +, -, *, and /, well as defined variables. For example, you could
define: x_size = 1mm, y_size = x_size + sin(x_size). Defining one variable in terms of another makes
a dependent variable. Dependent variables, though useful in many situations, cannot be the subject
of optimization, sensitivity analysis, tuning, or statistical analysis.
The Constants tab of theProject Variables dialog lists the available predefined constants.These
may not be reassigned a new value.

Name Value Description
Boltz 1.3806503E-023 Boltzmann constant (J/K)
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Name Value Description
c0 299792458 Speed of light in vacuum (m/s)
e0 8.854187817e-012 Permittivity of vacuum (F/m)
elecq 1.602176462e-019 Electron charge (C)
eta 376.730313461 Impedance of vacuum (Ohm)
pi 3.14159265358979 Ratio of circle circumference to

diameter
u0 1.25663706143582e-

066
Permeability of vacuum (H/m)

Numerical valuesmay be entered in ANSYS’ shorthand for scientific notation. For example, 5x107
could be entered as 5e7.

Note Maxwell 2D, 3D, and RMxprt do not support expressions that include the combination of
array and intrinsic variables.

Related Topics

DefiningMathematical Functions
Using Valid Operators for Expressions
Using Intrinsic Functions for Expressions
Using Piecewise Linear Functions for Expressions
Using Dataset Expressions

Using Valid Operators for Expressions

The operators that can be used to define an expression or function have a sequence in which they
are performed. The following list shows both the valid operators and the sequence in which they are
accepted (listed in decreasing precedence):

( ) parenthesis 1
! not 2
^ (or **) exponentiation

(If you use "**" for exponentiation, as in previous software
versions,
it is automatically changed to "^".)

3

- unaryminus 4
* multiplication 5
/ division 5
+ addition 6

Working with Maxwell Projects and Designs 5-126
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

- subtraction 6
== equals 7
!= not equals 7
> greater than 7
< less than 7
>= greater than or equal to 7
<= less than or equal to 7
&& logic and 8
|| logic or 8

Related Topics

Defining an Expression

Using Intrinsic Variables

Maxwell recognizes a set of intrinsic variables that can be used to define expressions. Intrinsic
variable names are reserved andmay not be used as user-defined variable names.
User-defined variables cannot depend on any intrinsic variables.
The following intrinsic variablesmay be used to define expressions:

Variable Units Description
_I1 through _I9 mA Terminal current in an interpretive user-definedmodel
_t Variable to define a parametric equation based curve
_u Variable to define a parametric equation based surface
_v Variable to define a parametric equation based surface
_V1 through _V9 mV Port voltage in an interpretive user-definedmodel
Ang deg Post-processing variable (cannot be set by the user)
Budget_Index Post-processing variable (cannot be set by the user)
Distance mm
ElectricalDegree deg Electrical degree of the rotatingmachine (cannot be set by the

user)
F GHz Frequency of the circuit/system analysis
F1 GHz Frequency of tone 1 in the harmonic balance analysis
F2 GHz Frequency of tone 2 in the harmonic balance analysis
F3 GHz Frequency of tone 3 in the harmonic balance analysis
FNoi GHz Offset noise frequency in the harmonic balance noise analysis
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Freq GHz Post-processing variable (cannot be set by the user)
Ia and Ib mA Post-processing variable (cannot be set by the user)
Index Post-processing variable (cannot be set by the user)
IWavePhi deg Post-processing variable (cannot be set by the user)
IWaveTheta deg Post-processing variable (cannot be set by the user)
Normalized
Deformation
Normalized Distance Post-processing variable (cannot be set by the user)
OP mW Post-processing variable (cannot be set by the user)
Pass Post-processing variable (cannot be set by the user)
Phase deg Post-processing variable (cannot be set by the user)
Phi deg Post-processing variable (cannot be set by the user)
R mm Post-processing variable (cannot be set by the user)
Rho Post-processing variable (cannot be set by the user)
RSpeed rpm Speed of themachine (cannot be set by the user)
Spectrum GHz Post-processing variable (cannot be set by the user)
Temp cel/deg Analysis temperature (deg)
Theta deg Post-processing variable (cannot be set by the user)
Time ns Time point in a transient analysis
Vac mV Post-processing variable (cannot be set by the user)
Vbe mV Post-processing variable (cannot be set by the user)
Vce mV Post-processing variable (cannot be set by the user)
Vds mV Post-processing variable (cannot be set by the user)
Vgs mV Post-processing variable (cannot be set by the user)
X, Y, and Z mm Post-processing variable (cannot be set by the user)
ZAng and ZRho deg Post-processing variable (cannot be set by the user)

Using Intrinsic Functions in Expressions

Maxwell recognizes a set of intrinsic trigonometric andmathematical functions that can be used to
define expressions. Intrinsic function names are reserved andmay not be used as variable names.
The following intrinsic functionsmay be used to define expressions:

Function Description Syntax
abs Absolute value (|x|) abs(x)
sin Sine sin(x)
cos Cosine cos(x)
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tan Tangent tan(x)
asin Arcsine asin(x)
acos Arccosine acos(x)
atan Arc tangent. Takes a tangent value as an argument. Because there are two

angles in a circle that can have the same tangent value, and atan can return
only one value, it returns a value in the range between -90 degrees and +90
degrees (or between -pi/2 and pi/2 in radians).

atan(x)

atan2 A two-argument version of the atan function. Takes the y and x coordinates
(including sign information) of a point as arguments and returns the angle
from the X-axis. Can return angle values for the full circle (-180 degrees to
+180 degrees or -pi to +pi in radians).

atan2
(y,x)

asinh Hyperbolic Arcsine asinh(x)
atanh Hyperbolic Arctangent atanh(x)
sinh Hyperbolic Sine sinh(x)
cosh Hyperbolic Cosine cosh(x)
tanh Hyperbolic Tangent tanh(x)
even Returns 1 if integer part of the number is even; returns 0 otherwise. even(x)
odd Returns 1 if integer part of the number is odd; returns 0 otherwise. odd(x)
sgn Sign extraction sgn(x)
exp Exponential (ex) exp(x)
pow Raise to power (xy) pow(x,y)
if If if(cond_

exp,true_
exp,
false_
exp)

pwl Piecewise Linear with linear extrapolation on x pwl
(dataset_
exp,
variable)

pwlx Piecewise Linear x with linear extrapolation on x pwlx
(dataset_
exp,
variable)

pwl_
periodic

Piecewise Linear with periodic extrapolation on x pwl_
periodic
(dataset_
exp,
variable)

sqrt Square Root sqrt(x)
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ln Natural Logarithm
(The "log" function has been discontinued. If you use "log(x)" in an
expression, the software automatically changes it to "ln(x)".)

ln(x)

log10 Logarithm base 10 log10(x)
int Truncated integer function int(x)
nint Nearest integer nint(x)
max Maximum value of two parameters max(x,y)
min Minimum value of two parameters min(x,y)
mod Modulus mod(x,y)
rem Fractional part (remainder) rem(x.y)

Note If you do not specify units, all trigonometric functions interpret their arguments as radians.
Likewise, inverse trigonometric functions' return values are in given in radians.When the
argument to a trigonometric expression is a variable, the units are assumed to be radians.
If you want values interpreted in degrees, supply the argument with the unit name deg.

Related Topics

Defining an Expression

Using Piecewise Linear Functions in Expressions

The following piecewise linear intrinsic functions are accepted in expressions:
pwl (dataset_expression, variable)
pwlx (dataset_expression, variable)
pwl_periodic (dataset_expression, variable)

The pwl and pwlx functions interpolate along the x-axis and returns a corresponding y value. The
pwl_periodic function also interpolates along the x-axis but periodically.

Related Topics

Adding Datasets
Adding a Design Variable
Modifying Datasets
Using Dataset Expressions

Using Dataset Expressions

Dataset expressions take the following form:
dset((x0,y0), ..., (xn,yn))
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These expressionsmay be used as the first parameter to piecewise linear (pwl, pwlx and pwl_
periodic) functions, andmay also be assigned to variables, in which case the variablemay be used
as the second parameter to pwl, pwlx and pwl_periodic functions.
Dataset expressions are derived from a series of points in a plot created in theDatasets dialog box.
Each plot consists of straight line segments whose vertices represent their end points. A curve is
fitted to the segments of the plot, and an expression is derived from the curve that best fits the
segmented plot. The created expression is then used in the piecewise linear intrinsic functions.

Related Topics

Adding Datasets
Adding a Design Variable
Modifying Datasets
Using Piecewise Linear Functions in Expressions

Assigning Variables

To assign a variable to a parameter in Maxwell:
l Type the variable name or mathematical expression in place of a parameter value in aValue
text box.
If you typed a variable name that has not been defined, theAdd Variable to DesignName
dialog boxwill appear, enabling you to define the design variable.
If you typed a variable name that included the $ prefix, but that has not been defined, theAdd
Variable dialog box appears, enabling you to define the project variable.

Note You can assign a variable to nearly any design parameter assigned a numeric value in
Maxwell. See theMaxwell online help about the specific parameter you want to vary to
determine if can be assigned a variable.

Related Topics

Working with Variables

Choosing a Variable to Optimize

Before a variable can be optimized, youmust specify that you intend for it to be used during an
optimization analysis in theProperties dialog box.

1. If the variable is a design variable, clickMaxwell 2D (orMaxwell 3D, orRMxprt)>Design
Properties.
If the variable is a project variable, clickProject>Project Variables.
TheProperties dialog box appears.
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2. Click the tab that lists the variable you want to optimize.
3. Click the row containing the variable you want to optimize.

Note Dependent variables cannot be
optimized.

4. Select theOptimization/ Design of Experiments option.
5. For the variable you want to optimize, select Include.

The selected variable is now available for optimization in an optimetrics setup defined in the
current design or project.

Note Complex numbers are not allowed for variables to be used in anOptimetrics sweep, or for
optimization, statistical, sensitivity or tuning setups.

6. Optionally, override the default minimumandmaximum values that Optimetrics uses for the
variable in every optimization analysis. During optimization, the optimizer does not consider
variable values that lie outside of this range.

7. ClickOK.

Related Topics

Setting up anOptimization Analysis

Including a Variable in a Sensitivity Analysis

Before a variable can be included in a sensitivity analysis, youmust specify that you intend for it to be
used during a sensitivity analysis in theProperties dialog box.

1. If the variable is a design variable, clickMaxwell 2D (orMaxwell 3D, orRMxprt)>Design
Properties.
If the variable is a project variable, clickProject>Project Variables.
TheProperties dialog box appears.

2. Click the tab that lists the variable you want to include in the sensitivity analysis.
3. Click the row containing the variable you want to include in the sensitivity analysis.

Note Dependent variables cannot be included in a sensitivity
analysis.

4. Select theSensitivity option.
5. For the variable you want to include in the sensitivity analysis, select Include.

The selected variable is now available for sensitivity analysis in a sensitivity setup defined in
the current design or project.

Note Complex numbers are not allowed for variables to be used in anOptimetrics sweep, or for
optimization, statistical, sensitivity or tuning setups.

6. Optionally, override the default minimumandmaximum values that Optimetrics uses for the
variable in every sensitivity analysis. During sensitivity analysis, Optimetrics does not consider
variable values that lie outside of this range.
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7. Optionally, override the default initial displacement value that Optimetrics uses for the variable
in every sensitivity analysis. During sensitivity analysis, Optimetrics will not consider a variable
value for the first design variation that is greater than this step size away from the starting
variable value.

8. ClickOK.

Related Topics

Setting up a Sensitivity Analysis

Choosing a Variable to Tune

Before a variable can be tuned, youmust specify that you intend for it to be tuned in theProperties
dialog box.

1. If the variable is a design variable, clickMaxwell 2D (orMaxwell 3D, orRMxprt)>Design
Properties.
If the variable is a project variable, clickProject>Project Variables.
TheProperties dialog box appears.

2. Click the tab that lists the variable you want to tune.
3. Click the row containing the variable you want to tune.

Note Dependent variables cannot be
tuned.

4. Select the Tuning option.
5. For the variable you want to tune, select Include.

Note Complex numbers are not allowed for variables to be used in anOptimetrics sweep,
or for optimization, statistical, sensitivity or tuning setups.

6. ClickOK.
The selected variable is now available for tuning in the Tune dialog box.

Related Topics

Tuning a Variable

Including a Variable in a Statistical Analysis

Before a variable can be included in a statistical analysis, youmust specify that you intend for it to be
used during a statistical analysis in theProperties dialog box.

1. If the variable is a design variable, clickMaxwell 2D (orMaxwell 3D, orRMxprt)>Design
Properties.
If the variable is a project variable, clickProject>Project Variables.
TheProperties dialog box appears.
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2. Click the tab that lists the variable you want to include in the statistical analysis.
3. Click the row containing the variable you want to include in the statistical analysis.

Note Dependent variables cannot be included in a statistical
analysis.

4. Select theStatistics option.
5. For the variable you want to include in the statistical analysis, select Include.

The selected variable is now available for statistical analysis in a statistical setup defined in the
current design or project.

Note Complex numbers are not allowed for variables to be used in anOptimetrics sweep, or for
optimization, statistical, sensitivity or tuning setups.

6. Optionally, override the distribution criteria that Optimetrics uses for the variable in every
statistical analysis.

7. ClickOK.

Related Topics

Setting up a Statistical Analysis

Exporting Variables for Documentation

By right-clicking in the Project Variables dialog, you can copy a a list of variables and their values to
the clipboard. You can then paste these variables elsewhere.

The pasted variables appear in a tab separated column format. Fields that do not contain values are
left blank.:
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Name Value Unit "Evaluated
Value

"Description Read-
only

Hidden

$width 14.8570192 mm 14.8570192mm false false
$length 7.824547736 mm 7.824547736mm false false
$height 0.45*$width 6.68565864mm false false

Related Topics

Assigning Variables
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6 - Setting Up a Maxwell Design
After you insert a design, you do not need to perform the basic steps sequentially, but they all must
be completed before a solution can be generated.
To set up aMaxwell design, follow this general procedure:

1. Insert a Maxwell design into a project. After you insert the design, you can then set themodel's
units of measurement and the backgroundmaterial.

2. Draw themodel geometry.
3. Specify the solver type.
4. Assignmaterial characteristics to objects.
5. Assign boundaries and excitations.
6. (For Transient SolutionsOnly) Set upmotion.
7. Add parameters for which you want to solve.
8. Specifymesh settings.
9. Specify how Maxwell will compute the solution.
10. (Optional) Set up any optimetrics you want to run.
11. Run the simulation.
12. View solution results, post-process results, view reports, and create field overlays.
13. (Optional) Export the circuit to generate a circuit equivalent of themodel.

Inserting a Maxwell Design
The first step in setting up aMaxwell Project is to add a design to the active project.
To insert a design:

1. ClickProject and select one of the following:
l Insert Maxwell 3D Design
l Insert Maxwell 2D Design
l Insert RMxprt Design

2. The new design is listed in the project tree. It is namedMaxwell3DDesignn,
Maxwell2DDesignn, or RMxprtDesignn by default, where n is a number signifying the order in
which the design was added to the project.
TheModeler window appears to the right of the Project Manager. You can now create the
model geometry.

Note Click the plus sign to the left of the design icon in the project tree to expand the project tree
and view specific data about themodel.

Related Topics

Setting the Project Tree to Expand Automatically
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Setting the Model's Units of Measurement
You can specify the units of measurement for drawing geometricmodels. After the units of
measurement have been specified, they are assigned to the objects in theModeler window. You
can then choose to display themodel's dimensions in the new units, or rescale themodel's
dimensions to the new units.
To set themodel's units of measurement:

1. ClickModeler>Units.
TheSet Model Units dialog box appears.

2. Select the new units for themodel from theSelect units pull-down list.
3. Specify how the change in units affects themodel:

l Select theRescale to new units option to rescale the dimensions to the new units. For
example, selecting centimeters (cm) as the new unit of measurement results in a dimension
of 10millimeters (mm) becoming 10 cm.

l Clear theRescale to new units option (the default) to convert the dimensions to the new
units without changing their scale. For example, selecting cm as the new unit of
measurement results in a dimension of 10mmbecoming 1 cm.

4. ClickOK to apply the new units to themodel.

Design Settings
TheDesign Settings dialog allows you to specify how the simulator will deal with some aspects of the
design. The tabs present in this dialog, and the options available on each tab, vary with the solution
type.

l Set theMaterial Thresholds for treatingmaterials as conductors/insulators.
l Set theMaterial Override (Maxwell3D only) to allow metals to automatically override
dielectrics.

l Set theMatrix Computationmethod for Magnetostatic Solutions.
l Set theMatrix Computation to compute the inductancematrix for Transient solutions.
l Set the SymmetryMultiplier for Transient and Eddy current solutions.
l Set Preserve Transient Solution options (Transient solutionsOnly).
l Set transient coupling with Simplorer on the Advanced Product Coupling tab (Transient
solutionsOnly).

l Set theModel Settings (Maxwell2D XY Transient, and 2D Eddy current solutionsOnly).
l Set Skew Model options (Maxwell2D XY Transient solutionswith cylindrical rotational motion
Only).

l Set the default Backgroundmaterial (Maxwell2D solutions only).
l Set Export Options (RMxprt Only).

Set Material Threshold Tab

Maxwell3D and Maxwell2D Material Thresholds:
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Thematerial thresholds tell theMaxwell 2D andMaxwell 3D solvers how to deal with conductors
and insulators. Materials with conductivities above thePerfect Conductor threshold are treated as
having infinite conductivity and surface current only. Materials with conductivity values below the
Insulator/Conductor threshold are treated as insulators with no conductivity and no current
carrying capability. Materials that fall between the two thresholds are treated as normal conductors
that can carry current throughout the volume of thematerial.

1. ClickMaxwell>Design Settings. TheDesign Settings dialog box appears.
Thematerial thresholds are set in theSet Material Thresholds tab.

2. Type a value in thePerfect Conductor text box.
3. Type a value in the Insulator/Conductor text box.
4. ClickOK.

RMxprt Material Thresholds:
1. ClickRMxprt>Design Settings.

TheDesign Settings dialog box appears with theSet Material Threshold tab selected.
2. Type a value in theConductivity Threshold text box (Default=10,000).
3. Type a value in thePermeability text box (Default=100).

Note RMxprt will treat materials with conductivity greater than 10,000 as conductors, and
materials with Permeability greater than 100 as steels.

4. If you want these values to be the default, change the values by clicking the
Tools>Options>RMxprt Optionsmenu and setting thematerial thresholds in theRMxprt
Options dialog.

5. ClickOK.

Related Topics

SettingMaxwell 3D Options
SettingMaxwell 2D Options
Setting RMxprt Options

Set Material Override Tab

TheMaxwell3D>Design Settings command brings up a dialog with text note and a check box to
Enable material override.
Normally, themodeler considers any intersection between 3D objects to be an error. But, if you
check this option, themodeler allows ametal object to intersect a dielectric, and just gives a warning.
Intersections between twometals or two dielectrics will still be errors.
In themesher, the dielectrics are "subtracted" from themetals in the intersecting region. That is, the
part of the dielectric that is inside themetal is removed, and if the dielectric is completely inside, the
whole object disappears.
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The purpose of this feature is to allow you to avoid doing explicit subtraction in themodeler. One
example application is a via that passes throughmany dielectric layers--with the option turned on,
the via does not have to be subtracted from the layers.

Note Usersmust be careful: this setting changes the "ground rules" of themodeler, andmay
have unexpected results.

Related Topics

AnalyzeObjects
Analyze Interobject Misalignment
Analyze SurfaceMesh
Healing an Imported Object
Materials

Matrix Computation Tab

TheMatrix Computation tab provides unique options for Magnetostatic designs, and for Transient
designs.

Matrix Computation Settings for Magnetostatic Solutions

Maxwell 2D/3D provides twoMatrix Computationmethods for calculating the inductance of
current-carrying coils for magnetostatic solutions:Apparent and Incremental.

l Apparent inductance is defined as the ratio of flux to current at a certain operating
condition. Alternatively, this can be expressed as the slope of a line from the origin to the
operating point on the BH curve. Apparent inductance is commonly used in nonlinear
magnetic applications and in circuit analysis, and is the default method used byMaxwell.

l Incremental inductance is defined as the ratio of delta flux to delta current at a certain
operating condition. This is equivalent to the slope of the tangent to the BH curve at the
operating point. Incremental inductance is commonly used in physical design because it is
easy tomeasure.

To set thematrix computationmethod:
1. ClickMaxwell>Design Settings.

l Alternatemethod: In the project tree, right-click <Design_name>, and selectDesign
Settings.

TheDesign Settings dialog box appears.
2. On theMatrix Computation tab, select the desiredmethod:Apparent or Incremental.

Note If you change the computationmethod after solving, all matrix results of both
AdaptivePass and LastAdaptive solutionswill be invalidated. Then, on the next
simulation, thematrix of the last solved passwill be re-computed with the new method. If
there arematrix expression caches for the AdaptivePass solution, then the cached
values of previous passeswill not be available because only the last pass is re-simulated.
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3. Optionally, if you checkSave as default, newly inserted designswill be set to use the
specified computationmethod.

4. When finished changing settings, clickOK.

Related Topics

Design Settings

Matrix Computation Settings for Transient Solutions

Maxwell 2D/3D provides an option on theMatrix Computation tab for computing the inductance
matrix for transient solutions.When theCompute inductance matrix option is selected, the
computedmatrix quantities will be available at all time steps. Thematrix quantities are listed in the
reporter and thus are available for post-processing, output variables creation, andOptimetrics
studies.

Note During the inductance calculation in the transient solver:
l Eddy effects for all objects are turned-off even if “Eddy Effect” is checked in the "Set
Eddy Effects" dialog. However, the field solution and all other results will consider the
eddy effects as set in the interface.

l For a field systemwithmultiple stranded windings, after all nonlinear materials are
frozen, one winding is supplied with 1A DC current while the other winding is open
(all other sources are turned-off).

The size of the computed inductancematrix is equal to the number of winding setups, i.e., thematrix
will beN xN when there areN winding setups; and the total number of inductance-related quantities
will beN2. Components of the full matrix are available for plots andOptimetrics calculation even
though thematrix will always be symmetric. You can choose to access only the upper right half of the
matrix by selecting the corresponding quantities as listed in the reporter dialog. For example, the
upper half of a 2x2matrix will be the L11, L12 and L22 quantities.
Maxwell 2D/3D provides twoMatrix Computationmethods for calculating the inductance of
windings for transient solutions:Apparent and Incremental.

l Apparent inductance is defined as the ratio of flux to current at a certain operating
condition. Alternatively, this can be expressed as the slope of a line from the origin to the
operating point on the BH curve. Apparent inductance is commonly used in nonlinear
magnetic applications and in circuit analysis, and is the default method used byMaxwell.

l Incremental inductance is defined as the ratio of delta flux to delta current at a certain
operating condition. This is equivalent to the slope of the tangent to the BH curve at the
operating point. Incremental inductance is commonly used in physical design because it is
easy tomeasure.

To enable thematrix computation for transient solutions:
1. ClickMaxwell>Design Settings.
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l Alternatemethod: In the project tree, right-click <Design_name>, and selectDesign
Settings.

TheDesign Settings dialog box appears.
2. On theMatrix Computation tab, selectCompute inductance matrix, and select the

desiredmethod:Apparent or Incremental.

Note l The default is NOT to compute the inductancematrix. Changing the setting for an
existing design does not affect the solution for the previous simulation. For example,
if a transient solve setup has 1 second set as the end time and is solved with the
Compute inductance matrix option off (unchecked) and a plot of matrix quantities
is created vs. time, the plot will not show any values because nomatrix quantities
were computed. Subsequently, if the compute option is enabled (checked) and the
end time extended to 2 seconds, after simulation, matrix quantities will be available
from > 1 second to 2 seconds, at all solved time steps.

l If you change the computationmethod after solving, all matrix results of both
AdaptivePass and LastAdaptive solutionswill be invalidated. Then, on the next
simulation, thematrix of the last solved passwill be re-computed with the new
method. If there arematrix expression caches for the AdaptivePass solution, then the
cached values of previous passeswill not be available because only the last pass is
re-simulated.

3. Optionally, if you checkSave as default, newly inserted designswill use the specified setting.
4. When finished changing settings, clickOK.

Related Topics

Design Settings
Inductance Computation for 2D and 3D Transient Solutions

Setting a Symmetry Multiplier

(Transient and EddyCurrent SolutionsOnly)
If you are using symmetry and/or master/slave boundary conditions in your solution, youmay need to
specify amultiplier (so that the other part of themodel, which is not included in the solution domain,
can be properly taken into account). This symmetrymultiplier will be automatically applied to all input
quantities including: input voltage, inductance, resistance, load torque, mass, damping, external
circuit; and all output quantities including: induced voltages, flux linkages in every winding, stranded
loss, solid loss, core loss, torque and force.
To specify amultiplier:

1. SelectMaxwell>Design Settings from themainmenu to open the Design Settings dialog,
then select theSymmetry Multiplier tab.
l You can also right-clickModel in the Project Manager tree, and selectSet Symmetry
Multiplier; or selectMaxwell>Model>Set Symmetry Multiplier, to open the Design
Settings dialog to theSymmetry Multiplier tab.

Setting Up aMaxwell Design 6-6
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

2. Enter a numerical value in the Symmetry Multiplier text box, and clickOK.

Related Topics

Modifying theModel View
Assigning Boundaries and Excitations for 3D Designs
Assigning a Symmetry Boundary for a Transient Solver
Assigning a Symmetry Boundary for the EddyCurrent Solver
Assigning a Symmetry Boundary for a 2D Transient Solver
Assigning a Symmetry Boundary for the 2D EddyCurrent Solver

Export Options Tab

To set the Export options for RMxprt:
1. Choose which options to use when exporting a design fromRMxprt to Maxwell3D:

l Periodic
l Difference
l Band Arc
l Teeth-Teeth
l Segmented Arc

Note These optionsmay also be set on theExport Options tab of the RMxprt Options
dialog box. Using the Tools>Options>RMxprt Options command changes the
default for the current design and all future designs.

Youmay also set the defaultDesign Sheet for use with RMxprt by entering the path and filename or
by browsing to the Excel file using the ellipsis button.

Related Topics

Generating a CustomDesign Sheet for RMxprt

Model Settings Tab

(Maxwell2D XY Transient and 2D EddyCurrent DesignsOnly)
For Maxwell2D XY transient and 2D Eddy current designs, torque, flux linkage, back EMF, etc. are
scaled by the length provided in theModel Depth field on theModel Settings tab. The scaled
results are used to calculate output quantities.
(Maxwell2D XY Transient solutionswith cylindrical rotational motion Only)
For Maxwell 2D transient designswith cylindrical rotational motion setup, the transient solver can
take into account the effects of skewed rotor slots by using amulti-slicemodel.
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To enable use of themulti-slice skew model:
1. Right-click onModel in the Project Tree and selectSet Skew Model on the context menu to

open theDesign Settings dialog to theModel Settings tab. You can also clickMaxwell
2D> Design Settings to open theDesign Settings dialog, then select theModel Settings
tab.

2. Check theUse Skew Model check box to enable the parameter fields below it.

3. Enter theSkew Angle of the rotor. Entries are non-negative real numbers in the range of 0 to
180 degrees inclusive (or equivalent values in units of measure such as radians). The default
value is 5 degrees. You can also enter a variable name.

4. Enter theNo. of Slices that you want themulti-slice rotor model divided into in the in Z-
direction. The input must be a positive odd integer value greater than zero. The default is 5.
You can also enter a variable name.

5. Enter aPlot Field on Slice number – an integer value representing the slice on which the
you want the solver to output the field result. The input can be between -(N-1)/2 and (N-1)/2,
inclusive, where N is the number of slices. The default value is 0 (themiddle slice). Choose the
desired slice number from the range of values in the drop-downmenu. You can also enter a
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variable name.
In the example, the skew angle of 5 degrees is divided into 5 equal slices - each slice spanning
1 degree. Angle values shown in the pull-down are calculated assuming the point along the
rotor in the Z-direction that is equidistant from the rotor ends to be at 0 degrees, with slices to
one side having positive angle values, while slices to the other side have negative angle
values. Themiddle slice (slice 0) spans the degree from -0.5 to 0.5, with itsmidpoint of 0 deg
assigned as the angle for the slice. Slice 1 spans the degree from 0.5 to 1.5, with itsmidpoint
at 1 deg assigned for the slice. Slice 2 spans the degree from 1.5 to 2.5, with itsmidpoint at 2
deg used for the slice. Values for Slice -1 and Slice-2 are calculated in similar fashion.

6. When finished, clickOK to close the dialog.

Background Material Tab

(Maxwell2D DesignsOnly)
The area of amodel not enclosed within specific objects is termed the background. Thematerial
assigned to this area is vacuum by default.
To change the default setting:

1. ClickMaxwell2D>Design Settings.
The Design Settings dialog is displayed.

2. Select theBackground tab.
3. Click theBackground button listing the current material setting.

TheSelect Definition dialog is displayed with theMaterial Database.
4. Locate thematerial desired and click on theName in the table.
5. ClickOK to return to theDesign Settings dialog.
6. TheBackground button will now list the newly selectedmaterial indicating that it will be used

as the backgroundmaterial.
7. ClickOK to finalize the change and dismiss the dialog.

Preserve Transient Solution Tab

For Transient solutions, you have the option of enabling thePreserve solution after dataset
edits function on this tab.
Datasetsmay be used to describematerial and source behavior in Maxwell. Enabling thePreserve
solution after dataset edits function allows source, material, or other parameters that depend
upon datasets to bemodified without deleting the transient solution data. The transient solver may
then be restarted from the final time step of the previous simulation.
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Advanced Product Coupling Tab

For Transient solutions, this tab provides the option toEnable transient-transient link with
Simplorer components.
Maxwell designsmay be dynamically coupled to Simplorer components through the Simplorer user
interface. The Simplorer interface allows 2D, 3D, and RMxprt designs to be linked as dynamic
components. Source windings set toExternal are available as conservative pins in Simplorer.
Dynamically linked components provide the ability to have Simplorer vary a variable in aMaxwell
design and haveMaxwell solve the design at the new design point and provide the solution data back
to Simplorer for use in the circuit simulation.
For more information, refer to the Online Help for Simplorer V8 and later.

Related Topics

Assigning aWinding Setup for a Transient Solver
Assigning aWinding Setup for a 2D Transient Solver
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7 - Specifying the Solver Type
Before you begin to draw themodels in your project, choose which field solver to use for it. Each
solver requires a different type of problem setup. If you later change the solver, all problem setups
become invalid, and all solutions are deleted. Because of this, it is a good idea to decide on a solver
before starting.
To specify a solver:

1. ClickMaxwell 2D>Solution Type or Maxwell 3D>Solution Type.
TheSolution Type window appears with the solvers generally split betweenMagnetic and
Electric solver types.

2. For Maxwell3D designs, select one of the following solver types:
l Magnetostatic
l Eddy Current
l Transient
l Electrostatic
l DC Conduction, either with or without Insulator Field
l Electric Transient

3. For Maxwell2D designs, select one of the following solver types:
l Magnetostatic
l Eddy Current
l Transient
l Electrostatic
l AC Conduction
l DC Conduction

Note For Maxwell2D designs, youmust also specify the geometrymode, either
Cartesian, XY orCylindrical about Z.

4. ClickOK.

Related Topics

Disconnected Solution Domains
Specifying Solution Settings
Post-ProcessedQuantities

Magnetostatic Solver
Themagnetostatic field simulator computes staticmagnetic fields in 2D or 3D. The source of the
staticmagnetic field can be:

l DC currents in conductors.
l Static external magnetic fields represented by boundary conditions.
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l Permanent magnets.
The quantities for which themagnetostatic field simulator solves are themagnetic field,H, and the
current distribution, J; themagnetic flux density,B, is automatically calculated from theH-field.
Derived quantities such as forces, torques, energy, and inductancemay be calculated from these
basic field quantities.

Related Topics

Technical Notes: 3D Magnetostatic Field Calculation
Technical Notes: 2D Magnetostatic Field Simulation
Technical Notes: MagnetostrictionModeling of MagneticMaterial
Magnetostriction and InverseMagnetostriction

Eddy Current Solver
The eddy current (AC magnetics) field simulator computes electromagnetic fields in the frequency
domain in 2D or 3D. The sources of the electromagnetic field can be:

l AC currents in conductors.
l Time-harmonic external magnetic fields represented by boundary conditions.

The quantity for which the eddy current field simulator solves is themagnetic field,H. Themagnetic
flux density,B, is automatically calculated from theH-field. Optionally, the eddy current solver can
incorporate displacement currents into the solution even in non-conducting domains, thereby
allowing the solution of the full system of Maxwell's equations and the recovery of the electric fieldE
everywhere including the non-conducting regions. Derived quantities such as forces, torques,
energy, losses, and impedancesmay be calculated from these basic field quantities at the solution
frequencies.

Related Topics

Technical Notes: 3D FrequencyDomain (EddyCurrent) Solver
Technical Notes: 2D EddyCurrent Field Simulation

Transient Solver
The transient field simulator computes the time-domainmagnetic fields in 2D or 3D. The source of
themagnetic fields can be:

l Moving or non-moving time varying currents and voltages.
l Moving or non-moving permanent magnets and/or coils.
l Moving or non-moving external circuit coupling.

The quantities for which the transient field simulator solves are themagnetic field,H, and the current
distribution, J; themagnetic flux density,B, is automatically calculated from the H-field. Derived
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quantities such as forces, torques, energy, speed, position, winding flux linkage, and winding
induced voltagemay be calculated from these basic field quantities.

Related Topics

Technical Notes: 3D Transient Excitations (Sources)
Technical Notes: 2D Transient Simulation
Technical Notes: MagnetostrictionModeling of MagneticMaterial
Magnetostriction and InverseMagnetostriction

Electrostatic Solver
The electrostatic field simulator computes static electric fields in 2D or 3D due to:

l Stationary charge distributions.
l Applied potentials.

The quantity for which the electrostatic field simulator solves is the scalar electric potential, φ; the
electric field (E-field) and the electric flux density (D-field) are automatically calculated from the
potential. Derived quantities such as forces, torques, energy, surface charge density, and
capacitancematrixmay be calculated from these basic field quantities.

Related Topics

Technical Notes: 3D Electrostatic Field Calculation
Technical Notes: 2D Electrostatic Field Simulation

AC Conduction
The AC conduction field simulator computes steady-state 2D electric fields in conductors due to:

l Applied potentials.
The AC conduction field solver allows you to analyze conduction currents due to time-varying electric
fields in conductors and lossy dielectrics. Use it to analyze current distributions, electric field
distributions and potential differences, admittances, lossymaterials, and stored energy. For
instance, the admittancematrix associated with a structure can be computed using the AC
conduction field solver. In addition, any quantity that can be derived from the basic electromagnetic
quantities can then be analyzed.
The AC conduction field solver can compute conduction currents for cartesian (XY) and
axisymmetric (Cylindrical about Z) models. It assumes that all sources are sinusoids oscillating at the
same frequency. Optionally, youmay specify different phase angles for different sources.
You are expected to specifymaterial properties and the electric potential at one or more object
interfaces or boundaries in themodel. The AC conduction field solver then computes the electric
potential, φ(t), for themodel. From the electric potential, it derives the electric field,E(t), the electric
flux density,D(t), and the current density, J(t).
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Related Topics

Technical Notes: 2D AC Conduction Field Simulation

DC Conduction Solver
The electric conduction field simulator computes steady-state 2D or 3D electric fields in conductors
due to:

l Current excitations.
l Applied potentials.

The quantity for which the electric conduction field simulator solves is the electric potential, φ; the
electric field (E-field) and the current density (J-field) are automatically calculated from the potential.
The resistancematrix, a derived quantity, may be calculated from these basic field quantities. As an
additional option, perfect insulators, that is, non-conduction regions, surrounding the conductors can
also be added to the simulation domain allowing to calculate the electric field everywhere including
the insulators.

Related Topics

DC Conduction Boundaries and Excitations
Technical Notes: 2D DC Conduction Field Simulation

Electric Transient Solver
The 3D electric transient field simulator computes time-varying electric fields excited by:

l Time-varying applied potentials.
l Total charge and volume charge density.
l Time-varying current excitations.

The quantity for which the electric transient field simulator solves is the electric potential, φ; the
electric field (E-field), the current density (J-field) and the electric flux density (D-field) are
automatically calculated from the potential. Derived solution parameters such as the electric energy,
Ohmic loss, surface charge density andmaximumelectric field can be obtained for each solid.

Disconnected Solution Domains
There are two ways to create a problem that containsmultiple disconnected solution domains:
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l By not creating or by excluding (not solving in) the background object, when the included
objects are not all touching.

l By using excluded objects or perfect conductors that cut the included objects into different
regions.

TheMaxwell solver identifiesmultiple disconnected solution domains.
For the electric solvers (electrostatic, conduction, and conduction+electrostatic), the solution is
allowed even if multiple disconnected solution domains are detected. In this case, an error message
appears only if a solution domain with inconsistent or unsolvable solution setup is detected.
For themagnetic solvers (magnetostatic, eddy current, and transient EM), an error message
appears whenmultiple disconnected solution domains are detected.
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8 - Drawing a Model
After you insert a design into the current project, you can draw amodel of the electromagnetic
structure. The general strategy is to build themodel as a collection of 3D objects. You can assign any
singlematerial to each 3D object.
You can create 3D objects by using themodeler’sDraw commands or you can draw 1D and 2D
objects, and thenmanipulate them to create 3D objects. Objects are drawn in the 3D Modeler
window. You can also import objects from other systems.
To open a new 3D Modeler window, do one of the following:

l Insert a new design into the current project.
l Double-click a design in the project tree.

If a 3D Modeler window is not open, do one of the following:
l On theMaxwell menu, click 3D Model Editor.
l Right-click the design name in the project tree, and then click 3D Model Editor on the
shortcut menu.

Themodel you draw is saved with the current project when you clickFile>Save.

Note If you access your machine via Remote Desktop, if Maxwell is running and one or more
modeler windows are open, thosemodeler windows automatically close. Themessage
manager window displays amessage indicating that Maxwell closed themodeler windows.

Whenworking with multiple projects, or when a project hasmultiple designs, youmay havemultiple
Modeler windows available. To switch to themodeler window associated with a specific design:

1. In the Project Manager window, select theDesign of interest.
2. ClickMaxwell3D Model Editor to focus themodeling window on the selected design.

Note If themenu command is unavailable, then the selected design is already in the
modeler window.

Related Topics

DrawingObjects
Model Analysis
Design Settings
Setting the Temperature of Objects
Creating a 3D Component from an ExistingModel
3D Component Library
Creating a User Define Primitive
Modifying Objects
Selecting Objects
Choosing theMovement Mode
Choosing the Snap Settings
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MeasureModes for Objects
Setting Coordinate Systems
Setting theModel’s Units of Measurement
Model Preparation Commands

Drawing Objects
You can draw one-, two-, or three-dimensional objects using theDraw commands. You can alter
objects individually or together to create the geometry of your structure. In the Tools>Modeler
Options, Drawing tab, you can set a default to either draw objects directly with themouse or by
invoking aProperties dialog in which you can enter the values for the object dimensions. The
Dialog mode drawing feature workswith the equation based line, and all two and three dimensional
objects. You can toggle toPointmode via the F3 function key and toDialogmode via the F4
function key.When you use the Dialogmode for drawing objects theEdit property of new
primitives setting is ignored.
One-dimensional (1D) objects in themodeler include straight line, arc line, center-point arc, and
spline segments, or a combination of these - called polylines. One-dimensional objects are open
objects; their boundaries do not enclose a region, unless you connect their endpoints. They have
length, but no surface or volume. Generally they are used as temporary objects fromwhich to create
2D objects.
Two-dimensional (2D) objects in themodeler include objects such as equation based surfaces,
rectangles, ellipses, circles, and regular polygons. Two-dimensional objects are closed sheet
objects; their boundaries enclose a region. You can create 2D sheet objects by covering the
enclosed region. In many applications (FSS, antennas) it is essential to calculate net power flow
through a surface.
You can also edit the properties of a polyline from the history tree to assign it a Cross Section
property as line or rectangular. If you then assign it either a height or a width, the polyline becomes a
sheet object.
By default, the history tree organizes sheet objects according to their boundary assignments. To
change this, select theSheets icon, and right-click to display theGroup Sheets by Assignment
check box.Within the calculator sheet objects are listed under surface.
Three-dimensional (3D) objects in themodeler include objects such as boxes, cylinders, regular
polyhedra, cones, spheres, torii, and helices. These objects have boundaries that enclose a region
with volume.
You can create 3D objects bymanipulating 2D objects along a plane or by using the appropriate
Draw commands. You can also edit the properties of a polyline from the history tree to assign it a
Cross Section property as circle rectangular. If you then assign it an appropriate diameter or both
height or a width, the polyline becomes a 3D object.
By default, the history tree organizes 3D objects bymaterial. To change this, select theObjects icon,
and right click to display theHistory Tree Layout Commands. You can also useGroup
Commands for Modeler Objects.
While you draw objects you can also:
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l Select Movement Mode as 3D, In Plane, Out of Plane, Along X, Y or Z axis.
l Select Grid Plane as XY, YZ, or XZ.
l Set SnapMode
l Set Reference Point for themovement mode
l Adjust the View

After you draw an object in the 3D Modeler window, you canmodify the object’s properties, such as
its position, dimensions, or color, in theProperties dialog box. Most object properties can be
assigned to variables that can then bemanipulated during the solve to test their effect on the
solution.

Note If you access your machine via Remote Desktop, if Maxwell is running and one or more
modeler windows are open, thosemodeler windows automatically close. Themessage
manager window displays amessage indicating that Maxwell closed themodeler
windows.

Related Topics

Assigning a Cross Section and Dimension to a Polyline
Modifying Objects
Drawing a Region
Setting the Temperature of Objects

Drawing a Straight Line Segment

To create an object with one or more straight line segments, use theDraw>Line command.

1. ClickDraw>Line .
2. Select the first point of the line in one of the following ways:

l Click the point.
l Edit the point’s coordinates in theX, Y, and Z boxes in the status bar.
To delete the last point that was entered, clickUndo Previous Segment on the shortcut
menu. After using the undo feature, you can also use Redo Previous Segment on the
shortcut menu.

3. Select the endpoint of the line by clicking the point or typing the coordinates in the text boxes in
the status bar.
The endpoint serves as the start point for a subsequent line segment.
To delete all points and start over, pressESC or clickEscape Draw Mode on the shortcut
menu.

4. Complete the line in one of the following ways:
l Double-click the endpoint.
l ClickDone on the shortcut menu.
l PressEnter.
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If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s attributes. Those listed under the Command
tab describe the commands used to create the object. These commands also appear in the
History tree. The Properties listed as line attributes include Name, Orientation, whether a
Model object, whether to DisplayWireframe, Color, Transparency, and whether to Show
Direction as arrows. The Show Direction property ismost helpful to unambiguously show the
line start orientation when plotting fields along a line.

5. ClickOK to close the Properties dialog.
Note While drawing a polyline, you can switch between straight line, arc line, or spline

segments using theSet Edge Type commands on the shortcut menu.

Related Topics

Setting the Reference Point
Deleting Polyline Segments
Converting Polyline Segments
Drawing a Three-Point Arc
Drawing a Center-Point Arc Line
Drawing a Spline
Drawing a Polyline

Drawing a Three-Point Arc Line

In themodeler, a three-point arc line segment is an arced line defined by three points on its curve.
Use theDraw>Arc>3 Point command to create a polyline object with one or more arc line
segments.

1. ClickDraw>Arc>3 Point .
2. Select the start point of the arc in one of the following ways:

l Click the point.
l Type the point’s coordinates in theX, Y, and Z text boxes in the status bar.

3. Select themidpoint of the arc by clicking the point or typing the coordinates in theX, Y, and Z
text boxes in the status bar.
To delete the last point that was entered, clickUndo Previous Segment on the shortcut
menu. After using the undo feature, you can also use Redo Previous Segment on the
shortcut menu.
To delete all points and start over, pressESC or clickEscape Draw Mode on the shortcut
menu.

4. Select the endpoint of the arc by clicking the point or typing the coordinates in theX, Y, and Z
text boxes in the status bar.
The endpoint serves as the start point for a subsequent arc line segment.

Drawing aModel 8-4
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

5. If the endpoint is the last point of the polyline object, double-click the point to complete the
polyline or clickDone on the shortcut menu.
If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s attributes. Those listed under the Command
tab describe the commands used to create the object. These commands also appear in the
History tree. The Properties listed as line attributes include Name, Orientation, whether a
Model object, whether to DisplayWireframe, Color, Transparency, and whether to Show
Direction as arrows. The Show Direction property ismost helpful to unambiguously show the
line start orientation when plotting fields along a line.

6. ClickOK.
Based on the three points you specified, themodeler calculates the center point and radius of
the arc and draws an arced line through the three points.

Note While drawing a polyline, you can switch between arc line, straight line, or spline segments
using theSet Edge Type commands on the shortcut menu.

Related Topics

Setting the Reference Point
Drawing a Straight Line
Drawing a Spline
Drawing a Center-Point Arc Line
Drawing a Polyline
Deleting Polyline Segments
Converting Polyline Segments

Drawing a Center-Point Arc Line

In themodeler, a center-point arc line segment is an arced line defined by a center point, start point
and angle. Use theDraw>Arc>Center Point command to create a polyline object with one or more
center-point arc line segments.

1. ClickDraw>Arc>Center Point .
2. Select the center point of the arc in one of the following ways:

l Click the point.
l Type the point’s coordinates in theX, Y, and Z text boxes in the status bar.

3. Select the start point, or radius, of the arc by clicking the point or typing the coordinates in the
X, Y, and Z text boxes in the status bar.
To delete the last point that was entered, clickUndo Previous Segment on the shortcut
menu. After using the undo feature, you can also use Redo Previous Segment on the
shortcut menu.
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To delete all points and start over, pressESC or clickEscape Draw Mode on the shortcut
menu.

4. Sweep the angle, or endpoint, of the arc by clicking the point or typing the coordinates in theX,
Y, and Z text boxes in the status bar.

5. If the endpoint is the last point of the polyline object, double-click the point to complete the
polyline or clickDone on the shortcut menu.
If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s attributes.

6. ClickOK.
Note While drawing a polyline, you can switch between arc line, straight line, or spline

segments using theSet Edge Type commands on the shortcut menu.

Related Topics

Setting the Reference Point
Drawing a Straight Line
Drawing a Spline
Drawing a Polyline
Deleting Polyline Segments
Converting Polyline Segments
Drawing a Three-Point Arc

Drawing a Spline

A spline is a curved line defined by three points. Themodeler uses a natural spline type: a piece wise
cubic spline with an end condition that has a derivative of zero. Use theDraw>Spline command to
create a polyline object with one or more spline segments.

1. ClickDraw>Spline .
2. Select the spline’s start point in one of the following ways:

l Click the point.
l Type the point’s coordinates in theX, Y, and Z text boxes in the status bar, and then press
Enter.

To delete the last point entered, clickUndo Previous Segment on the shortcut menu.After
using the undo feature, you can also use Redo Previous Segment on the shortcut menu.
To delete all selected points and start over, pressESC or clickEscape Draw Mode on the
shortcut menu.

3. Select themidpoint of the spline by clicking the point or typing the coordinates in theX, Y, and
Z text boxes in the status bar.

4. Select the endpoint of the spline by clicking the point or typing the coordinates in theX, Y, and
Z text boxes in the status bar.
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The endpoint serves as the start point for a subsequent spline segment.
5. Complete the spline in one of the following ways:

l Double-click the endpoint.
l ClickDone on the shortcut menu.
l PressEnter.
If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s attributes. Those listed under the Command
tab describe the commands used to create the object. These commands also appear in the
History tree. The Properties listed as line attributes include Name, Orientation, whether a
Model object, whether to DisplayWireframe, Color, Transparency, and whether to Show
Direction as arrows. The Show Direction property ismost helpful to unambiguously show the
line start orientation when plotting fields along a line.

6. ClickOK.
Note While drawing a polyline, you can switch between spline, straight line, or arc line

segments using theSet Edge Type commands on the shortcut menu.

Related Topics

Setting the Reference Point
Drawing a Polyline
Drawing a Center-Point Arc Line
Deleting Polyline Segments
Converting Polyline Segments

Drawing a Polyline

A polyline is a single object that includes any combination of straight line, arc line, or spline segments.
The endpoint of one segment is the start point for the next segment. Use the shortcut menu’sSet
Edge Type commands to switch between straight line, arc line, or spline segments while drawing a
polyline.
In thePolyline section ofOperation tab of theModeler Options, select or clear theAutomatically
cover closed polylines check box.
If checked, closed polylines become sheet objects, and are listed as such in the History tree. If
unchecked, closed polylines are listed under lines in the History tree.

1. ClickDraw>Line .
2. Right-click in the 3D Modeler window to access the shortcut menu, and then point toSet

Edge Type.
3. ClickStraight, Spline, 3 Point Arc, orCenter Point Arc depending on which type of

polyline segment you want to draw.
4. If you clickedStraight, follow the procedure for drawing a straight line.
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If you clickedSpline, follow the procedure for drawing a spline.
If you clicked 3 Point Arc, follow the procedure for drawing a three-point arc line.
If you clickedCenter Point Arc, follow the procedure for drawing a center-point arc line.

5. Repeat steps 2 and 3 for each segment of the polyline object. The endpoint of the previous
segment serves as the start point for the next segment.
The shortcut menu lets you do the following for each segment:
Undo Previous Segment orRedo Previous Segment.

6. Complete the polyline in one of the following ways:
l Double-click the endpoint of the final segment.
l ClickDone on the shortcut menu.

Note To connect the polyline’s start and endpoints, clickClose Polyline on the
shortcut menu.

If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s attributes. Those listed under the Command
tab describe the commands used to create the object. These commands also appear in the
History tree. The Properties listed as line attributes include Name, Orientation, whether a
Model object, whether to DisplayWireframe, Color, Transparency, and whether to Show
Direction as arrows. The Show Direction property ismost helpful to unambiguously show the
line start orientation when plotting fields along a line. Notice that by going to the History tree
selecting Create Polyline for that object, you can assign a cross section and dimensions to a
polyline.

7. ClickOK.

Related Topics

Setting the Reference Point
Assigning a Cross Section and Dimension to a Polyline
Drawing a Straight Line
Drawing a Three-Point Arc
Drawing a Center-Point Arc Line
Drawing an Equation-Based Curve
Drawing a Spline
Deleting Polyline Segments
Converting Polyline Segments
Generate History
SettingModeler Options: Operations Tab

Drawing aModel 8-8
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Assigning a Cross Section and Dimensions to a Polyline

By viewing the History tree property of a polyline, you can assign either a line, circle or rectangle or
isosceles trapezoid cross section to a polyline. This assignment enables editable dimension
properties of width for a line, diameter for a circle, and height and width for a rectangle. To assign a
cross section to a polyline:

1. In the History tree of theModeler window, right-click on the polyline that you want to give a
cross section.
This selects the polyline, displays the polyline properties in the docked properties (if you have if
displays) and displays a shortcut menu where you can chooseProperties... to display the
undocked Properties window for the polyline.

2. In a Properties window (either docked or undocked) for the selected polyline click onNone on
the Type line under Cross Section to display the choices for Line, Circle, Rectangle or
Isosceles Trapezoid.

3. Select one of Line, Circle, Rectangle, or Isosceles Trapezoid as the cross section.
l Selecting Line causes the Cross Section area of the polyline properties to display editable
fields for Orientation andWidth.

l SelectingCircle causes the Cross Section area of the polyline properties to display an
editable field for diameter.

l SelectingRectangle causes the Cross Section area of the polyline properties to display
editable fields for Orientation,Width and Height.

l Selecting Isosceles Trapezoid causes the Cross Section area of the polyline properties to
display editable fields for Orientation,Width/Diameter, TopWidth and Height.

4. If you select Line, Rectangle or Isosceles Trapezoid, you can edit the Orientation as Auto, X,
Y, or Z. This provides the direction in which the dimension extends.

5. Specify the dimensions and select the units for the Cross section.
Type a value in the dimension field(s) and select units from the drop downmenu.
The dimensionsmust be reasonable relative to the specified shape and orientation of the
polyline. If the polyline cannot be extended into current Orientation for the given dimension(s),
you will receive a warning. If you receive a warning, check theOrientation, dimension and
units.
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When themodeler can extend the dimensions legally, it displays themodified object, and lists it
in the History tree as either a Sheet object (Line or one dimensional Rectangle) or as a Solid
object (Circle or two dimensional Rectangle).

6. You canmodify the new polyline either by editing the properties, or by using the History tree to
select one of the line objects that make up the polyline, and right clicking to display the popup
menu showing commands to Insert,Delete, or display editable segmentProperties.

A segment that you select in the Project tree is indicated in theModeler window by a line in the
dimensioned object. If you insert a new segment, it adopts the dimensions you specified for
the polyline object.

Related Topics

Setting the Reference Point
Drawing a Polyline
Drawing an Equation-Based Curve
Deleting Polyline Segments
Inserting Line Segments
Drawing a Center-Point Arc Line
Drawing a Straight Line
Drawing a Three-Point Arc

Inserting Line Segments

You can insert line segments of various kinds for existing line objects.
1. Select the line object in theHistory tree (not themodeler window).

This highlights the object and enables the InsertLine Segment commands in theDrawmenu
and short-cut menu.
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2. Use the cascademenu from theDraw>Line Segment command to or the right-clickmenu to
select whether to Insert Before Line Segment or InsertAfter Line Segment.

3. Use the next cascademenu to specify the kind of segment to add. These can be: Straight,
Spline. 3 Point Arc, or Center Point Arc.

4. If you clickedStraight, follow the procedure for drawing a straight line.
If you clickedSpline, follow the procedure for drawing a spline.
If you clicked 3 Point Arc, follow the procedure for drawing a three-point arc line.
If you clickedCenter Point Arc, follow the procedure for drawing a center-point arc line.

5. Repeat steps 2 and 3 for each segment of the polyline object. The endpoint of the previous
segment serves as the start point for the next segment.

6. Complete the polyline in one of the following ways:
l Double-click the endpoint of the final segment.
l ClickDone on the shortcut menu.

Note To connect the polyline’s start and endpoints, clickClose Polyline on the
shortcut menu.

If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s attributes. Those listed under the Command
tab describe the commands used to create the object. These commands also appear in the
History tree. The Properties listed as line attributes include Name, Orientation, whether a
Model object, whether to DisplayWireframe, Color, Transparency, and whether to Show
Direction as arrows. The Show Direction property ismost helpful to unambiguously show the
line start orientation when plotting fields along a line.

7. ClickOK.

Related Topics

Drawing a Center-Point Arc Line
Deleting Polyline Segments
Converting Polyline Segments

Drawing an Equation-Based Curve

Any line that can be described by an equation in three dimensions can be drawn.

1. ClickDraw>Equation Based Curve .
TheEquation Based Curve dialog box opens.
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2. Type equations for X(_t), Y(_t), and Z(_t).
Note You can also define an equation by doing the following:

1. Click the ... button.
The Edit Equation dialog box appears.

2. Do one or more of the following to define the equation:
• Type a numerical value or expression directly in the text box.
• Select a function to insert from the pull-down list, and select Insert Function.
• Select an operator from the pull-down list, and select Insert Operator.
• Select a quantity from the pull-down list, and select Insert Quantity.

3. When you are finished defining the equation, clickOK to close theEdit
Equation dialog box and return to theEquation Based Curve dialog box.

l Any unitless value input in equation based curve is taken asmodel units. For example, for Y
(_t) = 1, the y value is taken as 1model units (saymm). If a value has units, then it is
converted tomodel units and used. For example, if we specify Y(_t) = 1cm, then y value will
be correctly taken as 10mm.

l While parsing expressions, equation based curves convert each variable separately to
model units and assume that the resulting expression is in model units.

l Equation based curves depend on the variable value library to correctly evaluate the units of
expression.

3. Select a start value from theStart_t pull-down list.
4. Select an end value from theEnd_t pull-down list.
5. Select the number of points in the curve from thePoints pull-down list.

If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s attributes. Those listed under the Command
tab describe the commands used to create the object. These commands also appear in the
History tree. The Properties listed as line attributes include Name, Orientation, whether a
Model object, whether to DisplayWireframe, Color, Transparency, and whether to Show
Direction as arrows. The Show Direction property ismost helpful to unambiguously show the
line start orientation when plotting fields along a line.

6. ClickOK on theProperties dialog box.

Related Topics

Setting the Reference Point
Assigning a Cross Section and Dimension to a Polyline

Drawing a Circle

Draw a circle by selecting a center point and a radius. Circles are drawn as true surfaces in the
modeler.
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1. On theDrawmenu, click Circle .
2. Select the center point of the circle in one of the following ways:

l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.

3. Specify the radius by selecting a point on the circle’s circumference in one of the following
ways:
l Click the point.
l Type the coordinates of the point relative to the center point in the dX, dY, and dZ boxes,
where d is the distance from the previously selected point.

If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s attributes.

4. ClickOK.
If theAutomatically cover closed polyline option is selected in theModeler Options
window, the circle will be covered, resulting in a 2D sheet object. Otherwise it will be a closed
1D polyline object.

Note The 3D GeometryModeler permits drawing of true-curved objects. However, the solution
will be obtained with a tetrahedral mesh which conforms to the true surface only within the
limits identified by certain mesh settings. Themodeler has default settings for this
conformance which is a reasonable trade-off between solution speed and solution quality
for most objects, but may not be ideal for all such objects. High-aspect ratio curves
structures, such as heliceswith narrow and curved cross-sections, may benefit from user
control of the faceting values. For details about these commands see:
Technical Notes, "Surface Approximations" and related sections, "Modifying Surface
Approximations," and "Guidelines for Modifying Surface Approximations"

Related Topics

Setting the Reference Point
Surface Approximation
Creating SegmentedGeometry
Covering Lines

Drawing an Ellipse

Draw an ellipse by specifying a center point, base radius, and secondary radius.

1. On theDrawmenu, click Ellipse .
2. Select the center point of the ellipse in one of the following ways:

l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.
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3. Specify the base radius of the ellipse. If the current drawing plane is xy, then x is the base
radius direction. If the drawing plane is yz, then y is the base radius direction. If the drawing
plane is xz, then z is the base radius direction. Select the point in one of the following ways:
l Click the point. Maxwell constrainsmousemovement to the base radius direction.
l Type the coordinates of a point relative to the center point in the dX, dY, or dZ box, where d
is the distance from the previously selected point.

4. Specify the secondary radius of the ellipse. Select the point in one of the following ways:
l Click the point. Maxwell constrainsmousemovement to a point on the plane orthogonal to
the base radius direction.

l Type the coordinates of a point relative to the center point in the dX, dY, or dZ box.
If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s properties.
TheRatio value represents the aspect ratio of the secondary radius to the base radius.

5. ClickOK.
If theAutomatically cover closed polyline option is selected in theModeler Options
window, the ellipse will be covered, resulting in a 2D sheet object. Otherwise it will be a closed
1D polyline object.

If the base radius is larger than the secondary radius, the ellipse’s longer axis will lie along the default
base radius direction. If the secondary radius is larger than the base radius, the ellipse’s longer axis
will lie perpendicular to the default base radius direction. To create an ellipse with an arbitrary
orientation, rotate or move the ellipse after drawing it.

Note The 3D GeometryModeler permits drawing of true-curved objects. However, the solution
will be obtained with a tetrahedral mesh which conforms to the true surface only within the
limits identified by certain mesh settings. Themodeler has default settings for this
conformance which is a reasonable trade-off between solution speed and solution quality
for most objects, but may not be ideal for all such objects. High-aspect ratio curves
structures, such as heliceswith narrow and curved cross-sections, may benefit from user
control of the faceting values. For details about these commands see:
Technical Notes, "Surface Approximations" and related sections, "Modifying Surface
Approximations," and "Guidelines for Modifying Surface Approximations"

Related Topics

Setting the Reference Point
Modifying Surface Approximation Settings
Creating SegmentedGeometry
Covering Lines

Drawing a Rectangle

Draw a rectangle (or square) by selecting two diagonally opposite corners.
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1. ClickDraw>Rectangle .
2. Select the first diagonal corner in one of the following ways:

l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.
To delete the selected point and start over, pressESC or clickEscape Draw Mode on the
shortcut menu.

3. Select the second corner of the rectangle in one of the following ways:
l Click the point.
l Type the coordinates of the point relative to the first diagonal corner in the dX, dY, and dZ
boxes, where d is the distance from the previously selected point.

If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s properties.

4. ClickOK.
If theAutomatically cover closed polyline option is selected in theModeler Options
window, the rectangle will be covered, resulting in a 2D sheet object. Otherwise it will be a
closed 1D polyline object.

Related Topics

Setting the Reference Point
Covering Lines

Drawing a Regular Polygon

A regular polygon is a 2D object with three or more equal sides. Regular polygons are useful for
drawing faceted 2D objects.

1. ClickDraw>Regular Polygon .
2. Select the center point of the polygon in one of the following ways:

l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.

3. Specify the polygon’s radius, the distance from the center point to one of the polygon’s
vertices, in one of the following ways:
l Click the point.
l Type the coordinates of the point relative to the center point in the dX, dY, and dZ boxes,
where d is the distance from the previously selected point.

4. In theSegment number dialog box, enter theNumber of segments in the polygon, and
then clickOK.
If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s properties.
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5. ClickOK.
Note The radius ismeasured from the center point to a corner of the polygon, or the

intersection of two edges. It is notmeasured from the center point to themidpoint of
an edge.

If theAutomatically cover closed polyline option is selected in theModeler Options
window, the polygon will be covered, resulting in a 2D sheet object. Otherwise it will be a
closed 1D polyline object.

Related Topics

Setting the Reference Point
Covering Lines

Drawing an Equation-Based Surface

Any surface that can be described by an equation in three dimensions can be drawn.

1. ClickDraw>Equation Based Surface .
TheEquation Based Surface dialog box opens.

2. Type equations for X(_u, _v), Y(_u, _v), and Z(_u, _v).
Note You can also define an equation by doing the following:

1. Click the ... button.
The Edit Equation dialog box appears.

2. Do one or more of the following to define the equation:
• Type a numerical value or expression directly in the text box.
• Select a function to insert from the pull-down list, and select Insert Function.
• Select an operator from the pull-down list, and select Insert Operator.
• Select a quantity from the pull-down list, and select Insert Quantity.

3. When you are finished defining the equation, clickOK to close theEdit
Equation dialog box and return to theEquation Based Surface dialog box.

l Any unitless value input in equation based curve is taken asmodel units. For example, for Y
(_t) = 1, the y value is taken as 1model units (saymm). If a value has units, then it is
converted tomodel units and used. For example, if we specify Y(_t) = 1cm, then y value will
be correctly taken as 10mm.

l While parsing expressions, equation based curves convert each variable separately to
model units and assume that the resulting expression is in model units.

l Equation based curves depend on the variable value library to correctly evaluate the units of
expression.

3. Select start values from theStart_u andStart_v pull-down lists.
Select end values from theEnd_u andEnd_v pull-down lists.If theModeler option for editing
properties of new primitives is checked, theProperties dialog box appears, in which you can
modify the object’s properties.
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4. ClickOK on theProperties dialog box.

Related Topics

Setting the Reference Point
Assigning a Cross Section and Dimension to a Polyline
Drawing an Equation Based Curve

Drawing a Sphere

Draw a sphere by selecting a center point and a radius. Spheres are drawn as true surfaces in the
modeler.

1. ClickDraw>Sphere .
2. Select the center point of the sphere in one of the following ways:

l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.

3. Specify the radius by selecting a point on the sphere’s circumference in one of the following
ways:
l Click the point.
l Type the coordinates of the point relative to the center point in the dX, dY, and dZ boxes,
where d is the distance from the previously selected point.

If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s properties.

4. ClickOK.
Note The 3D GeometryModeler permits drawing of true-curved objects. However, the

solution will be obtained with a tetrahedral mesh which conforms to the true surface
only within the limits identified by certain mesh settings. Themodeler has default
settings for this conformance which is a reasonable trade-off between solution
speed and solution quality for most objects, but may not be ideal for all such objects.
High-aspect ratio curves structures, such as heliceswith narrow and curved cross-
sections, may benefit from user control of the faceting values. For details about
these commands see:
Technical Notes, "Surface Approximations" and related sections, "Modifying
Surface Approximations," and "Guidelines for Modifying Surface Approximations"

Drawing a Cylinder

Draw a cylinder by selecting a center point, radius, and height. Cylinders are drawn as true surfaces
in themodeler.
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1. ClickDraw>Cylinder .
2. Select the center point of the cylinder’s base circle in one of the following ways:

l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.

3. Specify the radius by selecting a point on the base circle’s circumference in one of the
following ways:
l Click the point.
l Type the coordinates of the point relative to the center point in the dX, dY, and dZ boxes,
where d is the distance from the previously selected point.

4. Specify the cylinder’s height by selecting a point on the axis perpendicular to the base circle’s
plane. Select the point by clicking the point or typing the coordinates in the dX, dY, and dZ
boxes.
Note If you create a cylinder with a height of zero, Maxwell draws a circular sheet

object.

If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s attributes.

5. ClickOK.

Note The 3D GeometryModeler permits drawing of true-curved objects. However, the solution
will be obtained with a tetrahedral mesh which conforms to the true surface only within the
limits identified by certain mesh settings. Themodeler has default settings for this
conformance which is a reasonable trade-off between solution speed and solution quality
for most objects, but may not be ideal for all such objects. High-aspect ratio curves
structures, such as heliceswith narrow and curved cross-sections, may benefit from user
control of the faceting values. For details about these commands see:
Technical Notes, "Surface Approximations" and related sections, "Modifying Surface
Approximations," and "Guidelines for Modifying Surface Approximations"

Related Topics

Setting the Reference Point
Assigning a Cross Section and Dimension to a Polyline
Modifying Surface Approximation Settings
Creating SegmentedGeometry

Drawing a Box

Draw a box by selecting two diagonally opposite corners of the base rectangle, then specifying the
height.

1. ClickDraw>Box .
2. Select the first diagonal corner of the base rectangle in one of the following ways:
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l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.
To delete the selected point and start over, pressESC or clickEscape Draw Mode on the
shortcut menu.

3. Select the second corner of the base rectangle in one of the following ways:
l Click the point.
l Type the coordinates of the point relative to the first diagonal corner in the dX, dY, and dZ
boxes, where d is the distance from the previously selected point.

4. Specify the height of the box by selecting a point on the axis perpendicular to the base
rectangle. Select the point by clicking the point or typing the coordinates in the dX, dY, and dZ
boxes.
If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s properties.

5. ClickOK.

Related Topics

Setting the Reference Point

Drawing a Regular Polyhedron

In themodeler, regular polyhedrons are 3D objects with regular polygon faces; each face has three
or more equal sides. Regular polyhedrons are useful for drawing faceted 3D objects.

1. ClickDraw>Regular Polyhedron .
2. Select the center point of the polyhedron in one of the following ways:

l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.

3. Select the radius of the polyhedron, the distance from the center point to one of the
polyhedron’s vertices, in one of the following ways:
l Click the point.
l Type the coordinates of the point relative to the center point in the dX, dY, and dZ boxes,
where d is the distance from the previously selected point.

4. In theSegment number dialog box, enter theNumber of segments in the polyhedron, and
then clickOK.
If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s properties.

5. ClickOK.
Note The radius ismeasured from the center point to a corner of the polygon, or the

intersection of two edges. It is notmeasured from the center point to themidpoint of
an edge.
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If theAutomatically cover closed polyline option is selected in theModeler Options
dialog box, the polygon will be covered, resulting in a 2D sheet object. Otherwise it will be a
closed 1D polyline object.

Related Topics

Setting the Reference Point
Covering Lines

Drawing a Cone

Draw a cone by selecting the center point and radius of the cone’s base circle, then specifying the
radius of the cone’s top circle and the cone’s height. Cones are drawn as true surfaces in the
modeler.

1. ClickDraw>Cone .
2. Select the center point of the cone’s base circle in one of the following ways:

l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.

3. Specify the radius of the cone’s base circle by selecting a point on the base circle’s
circumference. Select the point in one of the following ways:
l Click the point.
l Type the coordinates of the point relative to the center point in the dX, dY, and dZ boxes,
where d is the distance from the previously selected point.

4. Specify the radius of the cone’s top circle by selecting a point on its circumference. Select the
point by clicking it or typing its coordinates in the dX, dY, and dZ boxes.
To create an apex, select the same center point as the cone’s base circle.

5. Specify the height of the cone by selecting a point on the axis perpendicular to the base circle’s
plane. Select the point by clicking the point or typing the coordinates in the dX, dY, and dZ
boxes.
If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s properties.

6. ClickOK.

Note The 3D GeometryModeler permits drawing of true-curved objects. However, the solution
will be obtained with a tetrahedral mesh which conforms to the true surface only within the
limits identified by certain mesh settings. Themodeler has default settings for this
conformance which is a reasonable trade-off between solution speed and solution quality
for most objects, but may not be ideal for all such objects. High-aspect ratio curves
structures, such as heliceswith narrow and curved cross-sections, may benefit from user
control of the faceting values. For details about these commands see:
Technical Notes, "Surface Approximations" and related sections, "Modifying Surface
Approximations," and "Guidelines for Modifying Surface Approximations"
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Related Topics

Setting the Reference Point

Drawing a Torus

Draw a torus by selecting its center point, major radius, andminor radius. Themodeler then sweeps
a circle around a circular path. Toruses are drawn as true surfaces in themodeler.

1. ClickDraw>Torus .
2. Select the center point of the torus in one of the following ways:

l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.

3. Specify themajor radius by selecting a point in one of the following ways:
l Click the point.
l Type the coordinates of the point relative to the center point in the dX, dY, and dZ boxes,
where d is the distance from the previously selected point.

Themajor radius determines the diameter of the torus.
4. Specify theminor radius by selecting a point relative to themajor radius point.

Theminor radius determines the diameter of the "donut hole".
If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s properties.

5. ClickOK.

Note The 3D GeometryModeler permits drawing of true-curved objects. However, the solution
will be obtained with a tetrahedral mesh which conforms to the true surface only within the
limits identified by certain mesh settings. Themodeler has default settings for this
conformance which is a reasonable trade-off between solution speed and solution quality
for most objects, but may not be ideal for all such objects. High-aspect ratio curves
structures, such as heliceswith narrow and curved cross-sections, may benefit from user
control of the faceting values. For details about these commands see:
Technical Notes, "Surface Approximations" and related sections, "Modifying Surface
Approximations," and "Guidelines for Modifying Surface Approximations"

Drawing a Helix

A helix is a 3D spiral object created by sweeping a 1D or 2D object along a vector. Sweeping a 1D
object results in a hollow 3D object. Sweeping a 2D sheet object results in a 3D solid object.

1. Select the 1D or 2D object you want to sweep to form a helix.
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2. ClickDraw>Helix .
3. Draw the vector you want to sweep the object along. The two points that describe the vector

affect axis direction only and not the helix length. The helix length is determined when you
enter the pitch and number of turns in thePitch and Turns text boxes. The initial radius of the
helix is determined by the axis position relative to the object being swept.
a. Select the start point by clicking the point or typing its coordinates in theX, Y, and Z text

boxes.
b. Select the endpoint by clicking the point or typing its coordinates relative to the start point

in the dX, dY, and dZ boxes.
TheHelix dialog box appears.

4. For Turn Direction, selectRight hand if the turn direction is clockwise and Left hand if the
turn direction is counter-clockwise.

5. In thePitch text box, type the distance between each turn in the helix, and click a unit in the
pull-down list.

6. In the Turns text box, type the number of complete revolutions the object will make along the
vector.

7. In theRadius Change per Turn text box, type a number for the increase in the radius and
select the units from the pull-down list.
After you set these values, the selected object is swept along the vector to form a helix. The
original object you swept is deleted.
If theModeler option for editing properties of new primitives is checked, theProperties dialog
box appears, in which you canmodify the object’s properties.

8. ClickOK.

Note The 3D GeometryModeler permits drawing of true-curved objects. However, the solution
will be obtained with a tetrahedral mesh which conforms to the true surface only within the
limits identified by certain mesh settings. Themodeler has default settings for this
conformance which is a reasonable trade-off between solution speed and solution quality
for most objects, but may not be ideal for all such objects. High-aspect ratio curves
structures, such as heliceswith narrow and curved cross-sections, may benefit from user
control of the faceting values. For details about these commands see:
Technical Notes, "Surface Approximations" and related sections, "Modifying Surface
Approximations," and "Guidelines for Modifying Surface Approximations"

Related Topics

Setting the Reference Point
Drawing a Segmented Helix with Polygon Cross-Section using a User-Defined Primitive
Drawing a Segmented Helix with Rectangular Cross-Section using a User Defined Primitive.
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Drawing a Segmented Helix with Polygon Cross-Section Using a User
Defined Primitive

ANSYS provides you with a DLL to define the parameters of a segmented helix with a polygon
cross-section.

1. ClickDraw>User Defined Primitive>SysLib>SegmentedHelix>PolygonHelix.
TheCreate User Defined Part dialog box appears. TheParameters tab permits you to edit
the parameters. An Info tab contains information about the user defined primitive, its purpose,
the company/author who created it, the date created and the version number.

2. Specify the values for the following parameters:

PolygonSegments Number of segments in the polygon cross-section. Enter zero (0) for
true circle

PolygonRadius Radius of the polygon cross-section.

StartHelixRadius The radius of a segmented helix is defined from the helix center of
rotation to the center of the helix cross-section at segment transitions.
The first and last segments of the helix are half segments. See this
figure.

RadiusChange The radius change per turn of the helix.

Pitch Distance between helix turns.

Turns The number of turns in the helix.

SegmentsPerTurn The number of segments constructing each turn. Enter zero (0) for
true curve.

RightHanded Helix winding direction. Enter non-zero value for right-handed helix.

3. ClickOK.

Related Topics

Setting the Reference Point
Creating a User Defined Primitive
Drawing a Segmented Helix with Rectangular Cross Section Using a User Defined Primitive

Drawing a Segmented Helix with Rectangular Cross-Section Using a User
Defined Primitive

ANSYS provides you with a DLL to define the parameters of a segmented helix with a rectangular
cross-section.

1. ClickDraw>User Defined Primitive>SysLib>SegmentedHelix>RectHelix.
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TheCreate User Defined Part dialog box appears. TheParameters tab permits you to edit
the parameters. An Info tab contains information about the user defined primitive, its purpose,
the company/author who created it, the date created and the version number.

2. Specify the values for the following parameters:

RectHeight Height of rectangular cross-section.

RectWidth Width of rectangular cross-section.

StartHelixRadius The radius of a segmented helix is defined from the helix center of
rotation to the center of the helix cross-section at segment transitions.
The first and last segments of the helix are half segments. See this
figure.

RadiusChange The radius change per turn of the helix.

Pitch Distance between helix turns.

Turns The number of turns in the helix.

SegmentsPerTurn The number of segments constructing each turn. Enter zero (0) for
true curve.

RightHanded Helix winding direction. Enter non-zero value for right-handed helix.

3. ClickOK.
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Related Topics

Setting the Reference Point
Creating a User Defined Primitive
Drawing a Segmented Helix with Polygon Cross-Section using a User-Defined Primitive

Drawing a Spiral

A spiral is a 2D or 3D spiral object created by sweeping an object around a vector. Sweeping a 1D
object results in a 2D sheet object. Sweeping a 2D sheet object results in a 3D solid object.

1. Select the 1D or 2D object you want to sweep to form a spiral.

1. ClickDraw>Spiral .
2. Draw the vector you want to sweep the object around:

a. Select the start point by clicking the point or typing its coordinates in theX, Y, and Z text
boxes.

b. Select the endpoint by clicking the point or typing its coordinates relative to the start point
in the dX, dY, and dZ boxes.
TheSpiral dialog box appears.

3. SelectRight hand if the turn direction is clockwise and Left hand if the turn direction is
counter-clockwise.

4. In theRadius Change text box, type the difference in radius between each turn of the spiral.
The radius of the first turn ismeasured from the center point of the 1D or 2D object you are
sweeping to the vector you drew.

5. Click a unit for the radius in the pull-down list.
6. In the Turns text box, type the number of complete revolutions the object will make around the

vector.
The selected object is swept around the vector to form a spiral. The original object you swept is
deleted.If theModeler option for editing properties of new primitives is checked, the
Properties dialog box appears, in which you canmodify the object’s properties.

7. ClickOK.
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Figure 8-1 This 3D spiral was created from a 2D circle drawn at z = 0. The turn direction
was right hand, the radius change was set at 2, and the number of turns was set at 2.

Note The 3D GeometryModeler permits drawing of true-curved objects. However, the solution
will be obtained with a tetrahedral mesh which conforms to the true surface only within the
limits identified by certain mesh settings. Themodeler has default settings for this
conformance which is a reasonable trade-off between solution speed and solution quality
for most objects, but may not be ideal for all such objects. High-aspect ratio curves
structures, such as heliceswith narrow and curved cross-sections, may benefit from user
control of the faceting values. For details about these commands see:
Technical Notes, "Surface Approximations" and related sections, "Modifying Surface
Approximations," and "Guidelines for Modifying Surface Approximations"

Related Topics

Setting the Reference Point
Drawing a Spiral Using User Defined Primitives

Drawing a Spiral Using User Defined Primitives

ANSYS provides you with a DLL to define the parameters of a rectangular spiral.
1. ClickDraw>User Defined Primitive>SysLib>Examples>RectangularSpiral.
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TheCreate User Defined Part dialog box appears. TheParameters tab permits you to see
edit the parameters. An Info tab contains information about the user defined primitive, its
purpose, the company/author who created it, the date created and the version number.

2. Specify the values for the following parameters:

Xpos Type the location of the starting point in the X direction.

Ypos Type the location of the starting point in the Y direction.

TurnSep Type the separation distance between turns.

Turns Type the number of complete revolutions the object will make around the vector

Width Type a value for the width of the spiral.

Height Type a value for the height of the spiral. If you specify the height as zero, the
modeler draws a sheet object.

3. ClickOK.
This creates the primitive and displays theProperties dialog for the new object.

Hint To see newly created DLLs, clickDraw>User Defined Primitive>Update Menu.
To see the primitives that you have created, clickDraw>User Defined
Primitive>UserLib.

Related Topics

Setting the Reference Point
Creating a User Defined Primitive
Drawing a Spiral

Sweeping Objects Around an Axis, Along a Vector, or Along a Path

Use the following three commands (found on theDrawmenu in the desktop) to sweep a spiral or
other object:

l Draw>Sweep>Around Axis
l Draw>Sweep>Along Vector
l Draw>Sweep>Along Path

Drawing a Bondwire

A bondwire is a thin metal wire that connects ametal signal trace with a chip. Please see the topic
Bondwires in the Technical Notes before drawing a bondwire.

1. ClickDraw>Bondwire .
2. Select the bond pad point in one of the following ways:
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l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.

3. Select the lead point by clicking the point or typing the coordinates in the text boxes in the
status bar.
TheBondwires dialog box appears.

4. In the Type list, click the JEDEC modeling standard shape you want the bondwire to have:
JEDEC 4-point, JEDEC 5-point, or Low.
The Type selection changes the dialogue bondwire graphic, and shows options for that type.

5. Enter the number of facets in the bondwire in theNo. of Facets text box.
Theminimum value is 3. The value describes the number of faces that make up the
circumference of the bondwire.

6. In the diameter field, specify a diameter value and select the units from the pull-downmenu.
7. Enter the height between the bond pad and the top of the loop in the h1 text box. Include the

height’s unit of length.
8. The value in the h2 text box is the height between the bond pad and the lead point. It was

calculated byMaxwell based on the lead point you selected. If youmodify the value of h2, the
lead point will bemodified.
Optionally, type a new value in the h2 text box. Include the height’s unit of length.

9. If you selected JEDEC 5-point or Low do the following:
a. Type the angle between the horizontal plane and the wire at the bond pad point in the

alpha text box.
b. Type the angle between the horizontal plane and the wire at the lead point in the beta text

box.
10. ClickOK.

Related Topics

Setting the Reference Point
Technical Notes:Bondwires

Drawing a Point

Drawing a point object within the problem region enables you to plot fields or perform field
computations at that point. Points are always considered non-model objects by themodeler.

1. ClickDraw>Point .
2. Select the point in one of the following ways:

l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.
The point is listed under Points in the history tree.
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Related Topics

Setting the Reference Point
ModifyingMarkers on Point Plots
Drawing Non-Model Objects

Drawing a Plane

A plane object is a cutplane through the problem region. You can plot fields or perform field
computations on its surface. Planes are always considered non-model objects by themodeler.

1. ClickDraw>Plane .
2. Select the origin in one of the following ways:

l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.
To delete the selected point and start over, pressESC.

3. Select a normal point in one of the following ways:
l Click the point.
l Type the coordinates of the point relative to the origin in the dX, dY, and dZ boxes, where d
is the distance from the previously selected point.

The plane is created. Its center point is located at the origin you specified and oriented
perpendicular to the normal point you specified. The plane is listed under Planes in the history
tree.

Note You only need to draw a plane that does not lie on a predefined xy, yz, and xz plane.
Default planes are created on the xy, yz, and xz planes of the global coordinate system as
well as any new coordinate system you create.

Related Topics

Drawing Non-Model Objects

Inserting a Line Segment

To create an object with one or more straight line segments after another object, use theDraw>Line
Segment command.
1. ClickDraw>Line Segment>Insert Segment Before orDraw>Line Segment>Insert

Segment After.
A submenu appears.

2. Select one of the following:
l Straight
l Spline
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l 3 Point Arc
l Center Point Arc

3. Select the first point of the line in one of the following ways:
l Click the point.
l Type the point’s coordinates in the text boxes in the status bar.

4. Select the endpoint of the line by clicking the point or typing the coordinates in the text boxes in
the status bar.
The endpoint serves as the start point for a subsequent line segment.
To delete all points and start over, pressEsc or clickEscape Draw Mode on the shortcut
menu.

5. Complete the line in one of the following ways:
l Double-click the endpoint.
l ClickDone on the shortcut menu.
l PressEnter.
TheProperties dialog box appears, enabling you tomodify the object's attributes.

6. ClickOK.
Note While drawing a polyline, you can switch between straight line, arc line, or spline

segments using theSet Edge Type commands on the shortcut menu.

After drawing a polyline, you can select any segment in the history tree and edit it by changing
coordinates, inserting a segment before or after, deleting the start or end point, andmaking other
modifications.

Related Topics

Deleting Polyline Segments
Converting Polyline Segments

Creating Segmented Geometry

For some structures, youmaywant to create segmented as opposed to smooth (or True) surfaces.
The figure below shows a comparison of a cylinder created with true surfaces and with segmented
surfaces.
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The followingmodel objects can be created as segmented structures:

Circle, Ellipse, Cylinder See SegmentedObjects
Polyline, Arc, Line Segment SeeConverting Polyline Segments

Segmented Objects

To create segmented circles, ellipses, and cylinders use theNumber of Segments parameter on
the Command Tab of theProperties dialog as shown below. To convert an object from true surface
to segmented, do the following:

1. Select the circle, ellipse, or cylinder in themodeler window or in the history tree.
2. In the command tab of the properties window (shown docked below), change theNumber of
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Segments to an integer value of three or greater and pressEnter.

Values of 1 and 2 are not valid values for the circle, ellipse, or cylinder command and will cause
an error.

Related Topics

Surface Approximation
Creating SegmentedGeometry

Drawing Non-Model Objects

If you want to create an object that does not affect the geometricmodel, define the object as non
model. This ensures that the object is used for analysis only; it will not affect the solution process.
After drawing the non-model object, assuming it lies in the problem region, you can use it in the
reporter as a place on which to plot field quantities. For example, draw a non-model line across the
design, then (in the reporter) plot Mag_E on every point along that line.
Following are examples of using non-model objects to analyze a solution:

l Draw a polyline along which to plot fields or perform field computations. Note that when you
create a value versus distance plot, by default, the line will be divided into 100 equally spaced
points. You canmodify the number of points into which the line is divided in theEdit Sweeps
dialog box.For more information, seeSpecifying Variable Values for a SweepDefinition.

l Draw a rectangle upon which to plot fields or perform field computations.
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l Draw a volume box to analyze fields in areas of the problem region that are not occupied by an
object or that consist of parts of several objects.

l Draw a plane, which is always a non-model object.
l Draw a point object, which is always a non-model object, in order to plot fields or perform field
computations at that point.

What do you want to do?
Switch to non-model drawingmode. Objects you draw in non-model mode will not be included in the
solution process.
Modify an existingmodel object to be a non-model object.

Selecting Non-Model Drawing Mode

To switch to non-model drawingmode:
1. ClickModeler>New Object Type>Non Model.

Alternatively, clickNon Model on the drawingmodel pull-down list in the 3D Modeler Draw
toolbar:

2. Draw the object.

Related Topics

Changing anObject to NonModel
Drawing Non-Model Objects

Changing an Object to Non-Model

Tomodify an existing object to be a non-model object:
1. Select the object you want to modify.
2. In theProperties dialog box, clear theModel option.

The object will not be included in the solution process. If the object lies in the problem region,
you can plot solution quantities on it.

Related Topics

Selecting Non-Model DrawingMode
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Drawing Non-Model Objects

Drawing a Region

To draw a region encompassing the objects in the current project:

1. ClickMaxwell>Draw>Region or click the icon on the tool bar.
This displays theRegion dialog. You can define the region padding as a percentage, relative
position, or absolute position.

2. For the Padding data, you can select either Pad all directions similarly, Pad individual
directions, or Transverse padding.
If you selectPad all directions similarly you can specify the Padding type by selecting either
Percentage Offset orAbsolute Offset from the drop downmenu, requiring a single Value
that affects all directions. If you selectAbsolute Offset, you also specify the units by selecting
from a drop downmenu.
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SelectingPad individual directions displays the Padding Percentage as a table of Positive
and Negative X, Y, and Z coordinates, permitting you to specify padding for each direction. In
this case, you can specify the Padding type by selectingPercentage Offset,Absolute
Offset, orAbsolute Position from the drop downmenu.
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Selecting Transverse paddingmeans that padding in one direction is controlled by
dimensions in the other two directions. One direction (for example, X) is padded with a user-
specified percentage of diagonal length of the other two directions (Y and Z).

3. Specify the Padding values in the fields and select the units from the drop-down list.
4. If desired, click the check box to save the values asDefault.
5. ClickOK to close the dialog and create the region.

The region is drawn, selected, and displayed in the History tree. It is created using the current
coordinate system. The Properties dialog for the region has a Commands tab that shows the
coordinate system and Padding values, and the Attributes tab includes properties for Name,
Material (Default, vacuum), Solve inside, Orientation, Model, Color, DisplayWireframe, and
Transparency. You can edit all of these values.

If you try to create a region that does not contain all of the objects in your model, the region is
automatically expanded to cover all objects. The region also updates automatically as your geometry
changes.
Only one region can be created for a single project using theDraw>Region command. If you try to
create a second region, thePropertieswindow appears for the existing region, allowing you to
change operation parameters and attributes.

Group Commands for Modeler Objects
The 3D Modeler allows you to group objects in the History tree. Besides pre-defined folders under
History Tree Layout for solids, sheets, andmaterial assignments, a set ofGroup commands let
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you create groups, un-group objects, flatten a selected group's hierarchy, and delete empty groups.

TheGroup commands support the following features:
l Group objects in the history tree.When objects are grouped, they show up under a sub-item in
the history tree.

l Groups can contain sub-groups and sub-group containing further sub-groups.
l Groups permit moving objects from one group to any other group at any time.
l Groups are purely for organization of the history tree. They do not affect the solution in any
way.

l Groups permit you to bring in MCAD assemblies and sub-assemblies as groups. See
Importing 3D Model Files.
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l Groups can contain objects, submodels (for example, UDM, 3D Component, CAD links) and
groups. Coordinate systems, planes etc will not have any parent group.

Object groups have the following important differences from 3D components.
l Groups do not encapsulate history of objects. They do not encapsulate parameters used by
those objects.

l Groups do not have history tree operations. For example, Arrange operations apply to all
objects of the group rather than the group.

l Groups are not independent. Deletion of an object in one group could cause the object in
another group to be deleted also.

Accessing the Group Commands
You can access theGroup commands in several ways: via theModeler>Group menu, by right-
clicking onModel in the History tree to see the short-cut menu, the right-click context menu in the
Modeler window, and using theGroup icons in the toolbar.

Group Command Descriptions
Group>Createworkswith selection or no selections. If there are no selections, an empty group is
created under model. If there are selections, then a new group is created under same group as all
the selections, provided all selections are under one group. Once a group is created, all selections
move under new group. If selections are under different groups, then a new group is created under
model. Selections could be objects, groups, 3D Components, or User DefinedModel. TheGroup>
Create command tries to find amore suitable group namewhere possible based on names of all
selections. If not, default group names are Group1, Group2 and so on. You can edit group names
later.
Group>Ungroup is enabled only when you select one or more groups. Upon ungroup, all the
contents of the selected groupmove under group’s parent and the selected group is deleted. Note
thatGroup>Ungroup is not recursive; it only affects the selected group is and all its children groups
remain intact. Ungroup is also different fromDelete (under Edit>Delete) which deletes a selected
group and everything under it.
Group>FlattenFlatten Group is enabled when you select a group selection. You can select multiple
groups at different levels. All of the selected group's contents (that is, objects, sub-groups, and so
forth ) come directly under selected group. In a sense this is a recursive ungroup operation as all the
children and grandchildren groups of selected group are ungrouped.
Group>Delete Empty deletes all empty groups under the selected group. If a selected group is
empty it is deleted. This command is helpful to clean up empty groups after you havemoved objects
from one group to another.
Operations on Groups
Edit/Delete: Delete operations delete group and all the children, including sub-groups, under the
group.
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Copy and Paste of Objects in Groups
When you copy and paste objects with groups to another design, group information is carried over,
that is, new group in target design is created. If a group with the exact name exists, then the objects
aremoved under that group and no new group is created.When pasted in the same design, the
pasted object moves under same parent group as original object.
Copy and Paste of Groups
When you copy and paste one or more groups in same design or to another design, a new group is
created with unique name derived from original group name. Everything under that group, including
any sub-groups, is copy/pasted aswell.
Copy and Paste of Groups and Objects
If youmulti-select a few objects and groups, all of them are pasted correctly. If you select a group and
a few objects under that group, copy and paste includes the complete group structure. Thismeans
that selection of objects under the selected group is ignored. If you want to only copy and paste few
objects from group, you should only select those objects and NOT select the group.
Arrange Operations on Groups
You can select group to enable arrange operations likemove, rotate andmirror. Note that arrange
operationsworks directly on objects under selected group. So after arrange operation is done, the
History tree shows the arrange operation under every object of that group.
Duplicate Operations on Groups
You can select groups to enable duplicate operations. Afterward, the History tree shows a duplicate
operation under every object of that group. Newly created objects appear under a new group. There
will be new group for every instance of duplicate.
Other Operations on Groups and Objects in Groups
Modeling operations that create new objects, such asCreate from Face or Edge, aswell as Simplify
and Separate. The newly created objects appear under a new group created under the original
object's group, based on the tool option settings. See 3D Modeler Options: GroupOptions.

Group Properties
A Group’s Property tab is shownwhen you select a group in the history tree. TheGroup’s properties
include Name and parent Group.
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Object, group and submodel properties have aGroup property. You can edit the Group Property and
this provides another way of setting an object’s (or group’s) group. You can select any of the existing
groups listed or create a new group.
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Related Topics

Select Objects in the History Tree

User Customization through User Defined Primitives (UDPs)
User Defined Primitives (UDPs) allow users to add customized geometricmodeling commands to
theMaxwell Desktop. UDPs are compiled libraries that can be added to the desktop interface and
shared between users with commonmodeling needs.
To create a UDP, see Creating a User Defined Primitive for requirements and the procedure for
building a proper DLL.
In order to share UDPs between users, an existing DLLmay be copied into the userlib>User
Defined Primitives subdirectory which can be found in theMaxwell installation directory. Placing
an appropriately constructed DLL in this subdirectory will automatically add a new menu item in the
Draw>User Defined Primitivesmenu to allow access to the UDP.
If desired, users can also create aUser Defined Primitives subdirectory in their PersonalLib
directory, and store UDPs there. ThePersonalLib directory path is specified on theDirectories
panel underGeneral in the Options dialog.
Refer toMaxwell User Defined Primitives for additional information.

Related Topics

Creating a User Defined Primitive
Drawing a Segmented Helix with Polygon Cross-Section Using a User Defined Primitive
Drawing a Segmented Helix with Rectangular Cross-Section Using a User Defined Primitive
Drawing a Spiral Using User Defined Primitives
User Defined Primitives (UDPs) for Motor Geometries
Parameters for RMxprt User Defined Primitives

Creating a User Defined Primitive

Themodeler allows you to generate user-defined primitives, primitives customized to suit any
application. User-defined primitives are accessed using DLLs that you build and compile.
Example C++ source and header files that can be used to generate DLLs are located in the
UserDefinedPrimitives/Examples subdirectory under the ANSYS Electromagnetics Suite
installation directory.
As an example, create the primitivemyUDP.dll usingMicrosoft Visual C++ Developer Studio:

1. Create a directory to store all of the workspace information, call it UDPDir.
2. Use the sample workspaceRectangularSpiral.dsw as a template:

a. CopyRectangularSpiral.dsw andRectangularSpiral.dsp from the
UserDefinedPrimitives/Examples directory to this new directory.
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b. Make sure the new files have write permissions.
c. Rename the files tomyUDP.dsw andmyUDP.dsp respectively.
d. Open the .dsw and .dsp files in a text editor, and replace every occurrence of

RectangularSpiralwithmyUDP.
e. SavemyUDP.dsp andmyUDP.dsw.

3. In the UDPDir directory, create a Headers subdirectory.
4. Copy theUserDefinedPrimitiveStructures.h andUserDefinedPrimitiveDLLInclude.h

files from the UserDefinedPrimitives/Headers directory.
Note The header files include information on themethods that are available for use in your

source code. Theymust be included when you compile the DLL.

5. In the UDPDir directory, create a Sources subdirectory.
6. Use the sample source fileRectangularSpiral.cpp as a template:

a. CopyRectangularSpiral.cpp from the UserDefinedPrimitives/Examples
directory to this new directory.

b. Make sure the new file haswrite permission.
c. Rename the file tomyUDP.cpp.

The resulting directory structure will appear similar to the following:

7. OpenmyUDP.dsw usingMicrosoft Visual C++ Developer Studio, and edit the source code to
create your desired primitive. Youmay also add additional headers and source files as
appropriate.
The UDP dll contains a data structure called UDPPrimitiveTypeInfo. This contains information
about the udp, its purpose, company/author who created it, date created and the version
number. When you select a primitive from your library, you see theCreate Primitive dialog
with aParameters tab for setting the parameters, and an Info tab with the information from
this data structure.

8. BuildmyUDP.dll using theWin32 Release configuration.
9. Copy the resulting filemyUDP.dll to the

Maxwell/userlib/UserDefinedPrimitives directory.
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Optionally, copy the resulting file to the UserDefinedPrimitives directory in your
PersonalLib. ThePersonalLib directory path is specified on theDirectories panel under
General in the Options dialog.

10. To view your primitives, clickingDraw>User Defined Primitive>UserLiborDraw>User
Defined Primitive>PersonalLib.
Note On Linux, youmay use the same example directory structure, source, and header

files to build and compile a shared library using C++. The resulting shared library
needs to be placed in the same
Maxwell/userlib/UserDefinedPrimitives directory.
Aswith theWindowsDLL, the compiled library will work only on the operating
system onwhich it was built.

Related Topics

User Defined Primitives for Motor Geometries
Drawing a Spiral Using User Defined Primitives
Drawing a Segmented Helix with Polygon Cross-Section Using a User Defined Primitive
Drawing a Segmented Helix with Rectangular Cross-Section Using a User Defined Primitive

Specifying UDP Parameters

TheUser Defined Primitive Operation dialog box allows you to set the specific parameters
required for a UDP.
In theParameters tab, a list of the parameters associated with the UDP is displayed along with the
value, unit, evaluated value, and description for each parameter. To change a parameter:

1. Select theValue cell in the row corresponding to the parameter to be changed. The cell
becomes editable. Enter the desiredValue for the parameter.

2. Click on the cell underUnit to obtain a list of the available units for the parameter. Select the
desiredUnit.

3. When the desired changes have beenmade, clickOK to create the geometry defined by the
UDP and the parameters you have entered.

The Info tab provides information about the UDP.

Related Topics

Drawing a Segmented Helix with Polygon Cross-Section Using a User Defined Primitive
Drawing a Segmented Helix with Rectangular Cross-Section Using a User Defined Primitive
Drawing a Spiral Using User Defined Primitives
Parameters for RMxprt User Defined Primitives
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Updating the User Defined Primitives Menu

When new User Defined Primitives have been created or provided for your use, they should be
placed in theMaxwell/userlib/UserDefinedPrimitives directory. Optionally, user defined
primitives can be placed in your PersonalLib. ThePersonalLib directory path is specified on the
Directories panel underGeneral in the Options dialog.TheUpdate Menu command scans the
disk and createsmenu items for new UDPs. To createmenu items for new UDPs:

1. Place new UDPs in either of the directories listed above. Organizing UDPs using
subdirectories is permitted.

2. SelectDraw>User Defined Primitive>Update Menu.
The new UDPsmay now be run directly from theMaxwellmenu.

Related Topics

User Customization Through User Defined Primitives
Creating a User Defined Primitive

User Defined Primitives (UDPs) for Motor Geometries

When designing amotor or other machine in either Maxwell or RMxprt, multiple stator, rotor, and
pole geometries are available.

Related Topics

Parameters for RMxprt User Defined Primitives
Stator Geometries
Rotor Geometries
Pole Geometries
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Stator Geometries

Drawing aModel 8-45
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

Rotor Geometries

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters
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Pole Geometries

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters
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Parameters for RMxprt User Defined Primitives

In theDraw/User Defined Primitive/syslib/RMxprtmenu, the following User Defined Primitives
exists for creating elements of motors.
Select the primitive of interest to see the parameters required.

Band
ClawPoleCore
ConCoil
DCMCore
DiskCoil
DiskPMCore
DiskSlotCore
DoubleCage
IPMCore

LapCoil
LinearMCore
NonSalientPoleCore
PMCore
PMDamperCore
RacetrackSlotCore
SalientPoleCore
SlotCore
SquirrelCage

SRMCore
SynRMCore
TransCoil
TransCore
UnivMCore
VentSlotCore
WaveCoil

RMxprt/Band

Property Description
DiaGap Band diameter in gap center, DiaGap < DiaYoke for outer band
DiaYoke Band diameter on yoke side, DiaYoke < DiaGap for inner band
Length Band Length
SegAngle Angle per segment of band (0.1 ~ 5 degrees)
Fractions Number of circumferential fractions, 1 for circular region
InfoCore 0: band; 100: outer region or shaft

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/ClawPoleCore

See graphic below for definitions.

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaShaft for outer cores
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DiaShaft Core diameter on shaft side, DiaShaft < DiaGap for inner cores
Length Core Length
Poles Number of poles
EmbraceTip Embrace of pole tip
EmbraceRoot Embrace of pole root
ThickTip Thickness of pole tip
ThickRoot Thickness of pole root
ThickShoe Thickness of side shoes
DepthSlot Depth of slot between two poles
ThickYoke Thickness of yoke
LengthPole Length of pole from tip to tip
LengthMag Length of magnet or the second air-gap
LenRegion Region length
InfoCore 0: core; 1: core&coil; 2: coil; 3: magnet; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters
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RMxprt/ConCoil

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores
Length Core Length
Skew Skew angle in core length range
Slots Number of slots
SlotType Slot Type: 1 to 7
Hs0 Slot opening height
Hs1 Slot wedge height
Hs2 Slot body height
Bs0 Slot opening width
Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth, 0 for parallel teeth
Rs Slot body bottom fillet
FilletType 0: a quarter circle; 1: tangent connection
LayerLoc 0: whole; 1: middle; 2: top; 3: bottom
CoilPitch Coil pitchmeasured in slots
EndExt One-side end extended length
LayerExt Span layer extension in the axial direction
LayerDiff Span layer difference in the radial direction
AltEnd 0: same end layers; 1: alternate end layers
LenRegion Region length
InfoCoil 0: coil; 1: terminal1; 2: terminal2; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/DCMCore

See graphics below for definitions.

Property Description
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DiaGap Core diameter on gap side, or Dmin, theminimum inner diameter
DiaYoke Core diameter on yoke side, or frame outer diameter
Length Main pole length, 0 for 2D geometry
Skew Skew angle in pole length range
FrameWidth Overall width of a racetrack frame
FrameThick Frame thickness
FrameLength Frame length
Poles Number of poles
PoleType Pole Type: 1 or 2
Dmax Diameter of shoe tip with maximumair gap length
Bp0 Pole arc width with uniform air gap, 0 for eccentric air gap
Bp1 Total pole width (the width between shoe tips)
Bp2/Rp0 Bp2 (max shoe width for pole type 1), or Rp0 (shoe fillet radius for pole type 2)
Bp3/Rp1 Bp3 (min shoe width for pole type 1), or Rp1 (pole fillet radius for pole type 2)
Hp Pole body height
Bm Pole bodywidth
FieldWndgs Number of field windings, 2 for both series and shunt windings
EndExt Coil one-side end extended length
SlotsPerPole Compensating slots per pole distributed under pole arc surface
Bc0 Opening width of compensation slots
Hc0 Opening height of compensating slots
Bc2 Width of compensating slots
Hc2 Height of compensating slots
CmpEndExt One-side end extended length of compensating coils
ComPoleWidth Width of the commutating poles
ComPoleHeight Height of the commutating poles
ComPoleLength Length of the commutating poles
ComShoeWidth Shoe width of the commutating poles
ComShoeHeight Shoe height of the commutating poles
ComShoeLength Shoe length of the commutating poles
ComGap2 Air gap length between commutating poles and the frame
CmtEndExt One-side end extended length of commutating coils
LenRegion Region length
InfoCore 0: core&coil; 1: poles; 2: frame; 3: com poles; 4: shunt coil; 5: series coil; 6: com

coil; 100: region
InfoTerm 0: whole coil; 1: terminal1; 2: terminal2
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Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/DiskCoil

Property Description
DiaOuter Core outer diameter
DiaInner Core inner diameter
Thickness Core thickness
Gap Gap between the core and xy plane, <0 for lower core
Skew Skew angle
Slots Number of slots
SlotType Slot type: 1 to 7
Hs0 Slot opening height
Hs1 Slot wedge height
Hs2 Slot body height
Bs0 Slot opening width
Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth. 0 for parallel teeth
Rs Slot body bottom fillet
FilletType 0: a quarter circle; 1: tangent connection
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Layers Number of winding layers
CoilPitch Coil pitchmeasured in slots
EndExt One-side end extended length
EndClr Clearance between two end spans; 0 for no span
InfoCoil 0: all coils; 1: one coil only
SegAngle Angle per segment of end span: 5~15 degrees

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/DiskPMCore

Property Description
DiaOuter Core outer diameter
DiaInner Core inner diameter
Thickness Core thickness
Gap Gap between the core and xy plane, <0 for lower core
Skew Skew angle
Poles Number of poles
Embrace Pole embrace
ThickMag Magnet thickness
InfoCore 0: core only; 1: all PMs; 2: one PMonly

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/DiskSlotCore

Property Description
DiaOuter Core outer diameter
DiaInner Core inner diameter
Thickness Core thickness
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Gap Gap between the core and xy plane, <0 for lower core
Skew Skew angle
Slots Number of slots
SlotType Slot type: 1 to 6
Hs0 Slot opening height
Hs01 Slot closed bridge height
Hs1 Slot wedge height
Hs2 Slot body height
Bs0 Slot opening width
Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth. 0 for parallel teeth
Rs Slot body bottom fillet
FilletType 0: a quarter circle; 1: tangent connection
HalfSlot 0: symmetric slots; 1: half slots
RingLength One-side radial ring length
RingHeight Axial ring height
InfoCore 0: core only; 1: squirrel cage only

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/DoubleCage

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores
Length Core Length
Skew Skew angle in core length range
Slots Number of slots
SlotType Slot Type: 1 to 4
Hs0 Slot opening height
Hs01 Slot closed bridge height
Hs1 Slot wedge height
Hs2 Slot body height
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Bs0 Slot opening width
Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth, 0 for parallel teeth
Rs Slot body bottom fillet
FilletType 0: a quarter circle; 1: tangent connection; 2 & 3: arc bottom
HalfSlot 0: symmetric slots; 1: half slots
BarEndExt One-side bar end extended length
RingLength One-side radial ring length
RingHeight Radial ring height
RingDiaGap Ring diameter on gap side
DoubleCage 0: normal squirrel cage; 1: double squirrel cage
BSlotType Bottom slot type: 1 to 4
BHs0 Slot opening height
BHs1 Slot wedge height
BHs2 Slot body height
BBs0 Slot opening width
BBs1 Slot wedgemaximumwidth
BBs2 Slot body bottomwidth, 0 for parallel teeth
BRs Slot body bottom fillet
CastRotor 0: insert-bar; 1: cast-rotor
LenRegion Region length
InfoCoil 0: bar & rings; 1: bars; 2: rings; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/IPMCore

Property Description
DiaGap Core diameter on gap side, or outer diameter
DiaYoke Core diameter on yoke side, or inner diameter
Length Core Length
Poles Number of poles
PoleType Pole Type: 1 or 3
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D1 Limited diameter of PM ducts
O1 Bottomwidth for separate or flat-bottom duct
O2 Distance from duct bottom to shaft surface
B1 Duct thickness
Rib Rib width
HRib Rib height
DminMag Minimumdistance between sidemagnets
ThickMag Magnet thickness
WidthMag Total width of all magnet per pole
LenRegion Region length
InfoCoil 0: core; 1: magnets; 2: ducts; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/LapCoil

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores
Length Core Length
Skew Skew angle in core length range
Slots Number of slots
SlotType Slot Type: 1 to 7
Hs0 Slot opening height
Hs1 Slot wedge height
Hs2 Slot body height
Bs0 Slot opening width
Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth, 0 for parallel teeth
Rs Slot body bottom fillet
FilletType 0: a quarter circle; 1: tangent connection
Layers Number of winding layers
CoilPitch Coil pitchmeasured in slots
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EndExt One-side end extended length
SpanExt Axial length of end span; 0 for no span
SegAngle Angle per segment of end span: <5 for true-surface end span
LenRegion Region length
InfoCoil 0: winding; 1: coil; 2: terminal1; 3:terminal2; 100:region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/LinearMCore

Property Description
WidthCore Core width in motion direction
ThickCore Core thickness
Length Core length
SlotPitch The distance between two slots
Slots Number of slots
SlotType Slot Type: 1 to 7
Hs0 Slot opening height
Hs1 Slot wedge height
Hs2 Slot body height
Bs0 Slot opening width
Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth, 0 for parallel teeth
Rs Slot body bottom fillet
Layers Number of winding layers
CoilPitch Coil pitchmeasured in slots
EndExt One-side end extended length
SpanExt Axial length of end span; 0 for no span
InfoCore 0: core only; 1: core & all coils; 2: one coil only

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters
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RMxprt/NonSalientPoleCore

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores
Length Core Length
Skew Skew angle in core length range
IndexingSlots Number of indexing slots for slot pitch calculation
ActualSlots Number of actual slots: ActualSlots <= IndexingSlots
SlotType Slot Type: 1 to 7
Hs0 Slot opening height
Hs1 Slot wedge height
Hs2 Slot body height
Bs0 Slot opening width
Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth, 0 for parallel teeth
Rs Slot body bottom fillet
FilletType 0: a quarter circle; 1: tangent connection; 2 & 3: arc bottom
Poles Number of poles
TangentDucts Number of surface tangential vent ducts
TDuctWidth Width of surface tangential vent ducts
TDuctDepth Depth of surface tangential vent ducts
TDuctPitch Pitch of surface tangential vent ducts
AxialDucts Number of axial vent ducts per pole
ADuctWidth Width of axial vent ducts in main tooth
ADuctDepth Depth of axial vent ducts in main tooth
LenRegion Region length
InfoCore 0: core; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/PMCore
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Property Description
DiaGap Core diameter on gap side, or outer diameter
DiaYoke Core diameter on yoke side, or inner diameter
Length Core Length
Poles Number of poles
PoleType Pole Type: 1 or 5
Embrace Pole embrace (not for type 4)
ThickMag Max thickness of magnets
WidthMag Magnet width (for types 4 & 5)
Offset Pole arc offset (for types 1, 2, & 3)
Bridge Bridge thickness (for type 5 only)
Rib Rib width (for type 5 only), Rib=0 for rectangular ducts
LenRegion Region length
InfoCoil 0: core; 1: magnets; 2: magnet; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/PMDamperCore

Property Description
DiaGap Core diameter on gap side, or outer diameter
DiaYoke Core diameter on yoke side, or inner diameter
Length Core Length
Skew Skew angle in core length range
Slots Number of damper slots per pole
SlotType Slot type: 1 to 4
Hs0 Slot opening height
Hs01 Slot closed bridge height
Hs1 Slot wedge height
Hs2 Slot body height
Bs0 Slot opening width
Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth, 0 for parallel teeth
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Rs Slot body bottom fillet
FilletType 0: a quarter circle; 1: tangent connection; 2 & 3: arc bottom
Poles Number of poles
PoleType Pole Type: 1 or 8
D1 Limited diameter of PM ducts
O1 A locating dimension of PM ducts, for pole types 3, 4, 7 & 8
O2 A locating dimension of PM ducts, for pole types 1, 3, 5, 6, 7 & 8
B1 Barrier width, for pole types 1, 2 & 3
Rib Rib to hold PM ducts, for pole types 1 to 7
ThickMag Magnet thickness
WidthMag Total width of all magnet per pole
BarEndExt One-side damper bar end extended length
RingLength One-side axial ring length
RingHeight Radial ring height
LenRegion Region length
InfoCore 0: core; 1: magnets; 2: damper; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/RacetrackSlotCore

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores
Length Core Length
Skew Skew angle in core length range
Slots Number of slots
SlotType Slot type: 1 to 7
Hs0 Slot opening height
Hs01 Slot closed bridge height
Hs1 Slot wedge height
Hs2 Slot body height
Bs0 Slot opening width
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Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth, 0 for parallel teeth
Rs Slot body bottom fillet
FilletType 0: a quarter circle; 1: tangent connection; 2 & 3: arc bottom
Poles Number of poles
WidYoke Racetrackwidth for 2/4-pole cores
MidSlots Number of middle-size slots for 2/4-pole cores
MidHs2 Middle-size slot body height for 2/4-pole cores
MidBs2 Middle-size slot body bottomwidth for 2/4-pole cores
SmlSlots Number of small-size slots for 2/4-pole cores
SmlHs2 Small-size slot body height for 2/4-pole cores
SmlBs2 Small-size slot body bottomwidth for 2/4-pole cores
LenRegion Region length
InfoCore 0: core; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/SalientPoleCore

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores
Length Core Length
Skew Skew angle in core length range
Slots Number of damper slots per pole
SlotType Slot type: 1 to 4
Hs0 Slot opening height
Hs01 Slot closed bridge height
Hs1 Slot wedge height
Hs2 Slot body height
Bs0 Slot opening width
Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth, 0 for parallel teeth
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Rs Slot body bottom fillet
FilletType 0: a quarter circle; 1: tangent connection; 2 & 3: arc bottom
SlotPitch Slot pitch in mechanical degrees, refer to offset point
CenterPitch Center slot pitch in mechanical degrees, refer to offset point
Poles Number of poles
WidthShoe Pole shoe width
HeightShoe Pole shoe height (maximum)
WidthBody Pole bodywidth
HeightBody Pole body height
AirGap2 Second air gap length
Offset Pole arc offset
Off2_x The second pole arc offset perpendicular to the pole-center line
Off2_y The second pole arc offset parallel with the pole-center line
CoilEndExt One-side coil end extended length
EndRingType 0: whole press board; 1: pole press board; 2: pole ring; 3: whole ring
BarEndExt One-side damper bar end extended length, for types 2 & 3 only
RingLength One-side axial ring length, or conductor press board thickness
RingHeight Radial ring height, for types 2 & 3 only
LenRegion Region length
InfoCore 0: core; 1: core & coils; 2: coil; 3:damper; 4:terminal1; 5: terminal2;

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/SlotCore

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores
Length Core Length
Skew Skew angle in core length range
Slots Number of slots
SlotType Slot type: 1 to 6
Hs0 Slot opening height
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Hs01 Slot closed bridge height
Hs1 Slot wedge height
Hs2 Slot body height
Bs0 Slot opening width
Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth, 0 for parallel teeth
Rs Slot body bottom fillet
FilletType 0: a quarter circle; 1: tangent connection; 2 & 3: arc bottom
HalfSlot 0 for symmetric slot, 1 for half slot
LenRegion Region length
InfoCore 0: core; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/SquirrelCage

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores
Length Core Length
Skew Skew angle in core length range
Slots Number of slots
SlotType Slot type: 1 to 4
Hs0 Slot opening height
Hs01 Slot closed bridge height
Hs1 Slot wedge height
Hs2 Slot body height
Bs0 Slot opening width
Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth, 0 for parallel teeth
Rs Slot body bottom fillet
FilletType 0: a quarter circle; 1: tangent connection; 2 & 3: arc bottom
HalfSlot 0 for symmetric slot, 1 for half slot
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BarEndExt One-side bar end extended length
RingLength One-side axial ring length
RingHeight Radial ring height
RingDiaGap Ring diameter on gap side
CastRotor 0:insert-bar; 1: cast-rotor
LenRegion Region length
InfoCore 0: bars & rings; 1: bars; 2: rings; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/SRMCore

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores
Length Core Length
Poles Number of poles
ThkYoke Toke thickness
Embrace Pole embrace (the ratio of pole arc to pole pitch)
EndExt Coil one-side end extended length
LenRegion Region length
InfoCore 0: core; 1: core & coils; 2: coil; 3: terminal1; 4:terminal2; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/SynRMCore

Property Description
DiaGap Core diameter on gap side, or outer diameter
DiaYoke Core diameter on yoke side, or inner diameter
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Length Core Length
Poles Number of poles
PoleType 1: ALA; 2: arc; 3: hyperbolic; 4: hyperbolic line
Barriers Barriers per pole, for PoleType 2 & 3 only
H Bridge thickness, for PoleType 2 & 3 only
W Rib width, for PoleType 2 & 3 only
R Barrier fillet radius, for PoleType 2 & 3 only
R0 Radius of the bottom barrier arch, for PoleType 2 & 3 only
Rb Barrier bottomminimum radius
Y0 Yoke bottom thickness
B0 Barrier bottom thickness, for PoleType 2 & 3 only
LenRegion Region length
InfoCore 0: core; 1: one barrier; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/TransCoil

Property Description
DistLeg Leg center to center distance
CoilType Coil type: 1 for solenoid coil; 2 for pancake coil
WidthIn Coil width between two inner sides
DepthIn Coil depth between two inner ends
RadiusIn Coil inner fillet radius
ThickCoil Coil thickness of one side
HighCoil Coil Height
Layers Number of layers
GapLayer Gap between two layers
InfoCore 0: all coils; 1: one coil only

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters
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RMxprt/TransCore

Property Description
DiaLeg Outer diameter of leg cross-section
DistLeg Leg center to center distance
DistYoke Yoke center to center distance
Stages Number of stages of leg cross-section
ThickCore Core thickness, only used for Stages=1
WidthYoke Yoke width, =0 for same cross-section as leg's
InfoCore 0: whole core; 1: legs only; 2: yokes only

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/UnivMCore

See graphic below for definitions.

Property Description
DiaGap Core diameter on gap side, or outer diameter
DiaYoke Core diameter on yoke side, or inner diameter
Length Core Length
Skew Skew angle in core length range
Poles Number of poles
PoleType Pole type: 1 to 2
WidthCore Overall width of a racetrack core
Embrace Pole embrace (the ratio of pole arc to pole pitch)
Offset Pole arc offset
WidthPole Minimumwidth at pole root
Ty Yoke thickness
Ts Shoe-tip thickness
R1 Radius of the screw holes in pole center
R2 Radius of the side fillet arc at pole root
R3 Radius of the side fillet arc center layout circle
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R4 Radius of the shoe connecting arc, 0 for auto-design
R5 Inner radius of the screw holes in between two poles
R6 Outer radius of the screw holes in between two poles
EndExt Coil one-side end extended length
LenRegion Region length
InfoCore 0: core; 1: coils; 2: one coil; 3: terminal1; 4: terminal2: 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/VentSlotCore

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores
Length Core Length
Skew Skew angle in core length range
Slots Number of slots
SlotType Slot type: 1 to 7
Hs0 Slot opening height
Hs01 Slot closed bridge height
Hs1 Slot wedge height
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Hs2 Slot body height
Bs0 Slot opening width
Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth, 0 for parallel teeth
Rs Slot body bottom fillet
FilletType 0: a quarter circle; 1: tangent connection; 2 & 3: arc bottom
HalfSlot 0 for symmetric slot, 1 for half slot
VentHoles Number of axial vent holes per row
HoleDiaIn Diameter of inner vent holes
HoleDiaOut Diameter of outer vent holes
HoleLocIn Diameter of inner vent hole center layout circle
HoleLocOut Diameter of outer vent hole center layout circle
VentDucts Number of radial vent ducts
DuctWidth Axial width of radial vent ducts
DuctPitch Center-to-center distance between two adjacent ducts
LenRegion Region length
InfoCore 0: core; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

RMxprt/WaveCoil

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores
Length Core Length
Skew Skew angle in core length range
Slots Number of slots
SlotType Slot type: 1 to 7
Hs0 Slot opening height
Hs1 Slot wedge height
Hs2 Slot body height
Bs0 Slot opening width
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Bs1 Slot wedgemaximumwidth
Bs2 Slot body bottomwidth, 0 for parallel teeth
Rs Slot body bottom fillet
FilletType 0: a quarter circle; 1: tangent connection
Layers Number of winding layers
CoilPitch Coil pitchmeasured in slots
EndExt One-side end extended length
SpanExt Axial length of end span; 0 for no span
SegAngle Angle per segment of end span; 0 for true-surface end span
PolePitch Pole pair pitchmeasured in slots
LenRegion Region Length
InfoCoil 0: winding; 1: one coil; 100: region

Related Topics

Parameters for RMxprt User Defined Primitives
Specifying UDP Parameters

3D Component Library
The 3D Modeler lets you access predefined 3D component libraries and create 3D components
with:

l Geometry – objects, parameters, and coordinate systems.
l Design data, boundaries, excitations andmesh operations.
l Material assignment and definition for components are separate from project material and
other component materials. They do not appear in the Project Treematerials list under
Definitions. Component materials cannot be edited in the project in which they are inserted.

l Component parameters, including variables used by geometries, design data, andmaterial
properties. These are displayed separately on the Parameters tab.

l Optional logo or icon image to display with components in themodeler window.
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l Optional encryption with password definition, or internal key as a password.

The ability to create components frommodels lets you easily share and reuse components. You can
add components to a library and share components with other users. Once you insert a component
into the target design, you can directlymanipulate whole components using Arrange operations such
asMove,Rotate andMirror or Duplicate operations likeDuplicate Along Line,Duplicate
Around Axis andDuplicate Mirror.

Note 3D Component Libraries can contain components created using theCreate 3D
Componentmenu command in bothMaxwell 2D andMaxwell 3D projects. 3D
Components created inMaxwell 2D projects cannot be used inMaxwell 3D projects, and
vice-versa.

Instances of an inserted component are grouped by definition in themodel history. Multiple instances
of identical components permit mesh reuse.

Note Except where noted, the following sections apply to component libraries and components
created in bothMaxwell 2D andMaxwell 3D projects.

The documentation includes the following sections:
Creating a 3D Component from an ExistingModel
Inserting a 3D Component into a Design
Viewing Properties of 3D Components
3D Components in the Project Manager Window
3D Components in the History Tree
Editing 3D Component Properties
Editing 3D Component Definitions
Updating 3D Component Definitions
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Related Topics

Fit All Objects in a View Window.
Fit Selected objects in a View Window.
ShowingOnly SelectedObjects in All or Active Views
Hiding Objects fromView

Creating a 3D Component from an Existing Model

To create a 3D component, select an existing object or model, right-click, and selectCreate 3D
Component. You can also clickDraw>3D Component Library>Create 3D Component.
This opens theCreate 3D Component dialog. TheModel tab lists all of objects selected before you
invokedCreate 3D Component.

Note TheCreate 3D Component menu command can be used to create components in both
Maxwell 2D andMaxwell 3D projects. 3D components created inMaxwell 2D cannot be
used inMaxwell 3D projects, and vice-versa.
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The tabs let you view the component features organized according to geometry, design data, and
settings:

l Info tab
l Model tab
l Boundaries tab
l Excitations tab
l MeshOperations tab
l Coordinate Systems tab
l Parameters tab
l Encryption tab
l Image tab

Note 3D components selected from the SysLib libraries include tabs only for Parameters,
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Image, and Info.

Include or Exclude Feature from Component
You can view the various tabs and select which features to Include or Exclude in creating the
component. You can use the check boxes in the Include column for this purpose. You can also use
the text field. Type a feature Namewhich you can then use the command buttons to Include or
Exclude.

Object selection for Include or Exclude impacts selection in other tabs. For example, if you exclude
an object from the component creation, the design data, parameters, and coordinate systems
corresponding to that object are also excluded.
Sorting Columns Using the Headers
The features listed for each tab include columns for the Name, check boxes for whether to include,
and properties. You can click on the column headers to sort by Name, Model, or other feature listed
for each tab. Click the column header to select the column to sort. Click again to invert the column.
You can sort lists by using all columns except Include.

Notes on Design Data
l DC thickness on selected objects is always included in components. It is not listed in
Boundaries tab.
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l TheCreate 3D Component dialog does not list design data without an assignment (for
example, a winding inMaxwell).

l The parent of any included boundary/excitation is included, as long as the parent does not
require assignment (for example, a winding inMaxwell).

l Design settings likematerial overrides are not included.
Once you havemade the Include and Exclude settings, and have specified the Image and Info you
clickOK to Save 3D Component File. When you clickOK, the component is validated for everything
that is included in the component. For example, you cannot include boundaries if the object on which
the boundaries have been created is not included. After validation, a dialog for saving the component
to a location appears.

Create 3D Component: Model Tab

TheModel tab lists all of objects selected before you invokedCreate 3D Component. These
correspond to the selected objects listed in the history tree.

l Use the check boxes or text field to Include or Exclude objects for the component.
l Material and Type columns are read only.
l For Encrypted components, you can also chose which objects to hide. The hide column is only
enabled if you have the Hide Contained option selected on Encryption tab.
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Create Component Boundaries Tab

The list is populated with all the boundaries for the selected objects.
l Use the check boxes or text field to Include or Exclude boundaries for the component.
l Type and Description columns are read only.
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Create Component, Excitations Tab

The list is populated with all the excitations for the selected objects.
l Use the checkbox to Include or Exclude excitations in the component. You can also use the
edit box and Include/Exclude buttons to filter excitations.

l Type and Description columns are read only.

Create Component Mesh Operations Tab

The list is populated with all themesh operations for the selected objects.
l Use the checkbox to Include or Excludemesh operations. You can also use the edit box and
Include/Exclude buttons to filter mesh operations.

l Type and Description columns are read only
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Create Component Coordinate Systems Tab

The list is populated with all the Coordinate Systems for the selected objects. By default, only the
Coordinate Systems used to define the object orientations are included. You can include Coordinate
Systems created on specificmodel parts.

l Use the checkbox to Include or Exclude coordinate systems. You can also use the text field
and Include/Exclude buttons. Global CS cannot be included in the component.

l You can select any of the CS as a component reference.
l By default, the current working CS is the component reference CS.
l Reference CSmust be included in themodel (except for global).
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The coordinate Reference system that you specify affects the orientation of the component upon
insertion.

Create Component Parameters Tab

Component properties can be parameterized by assigning variables. The parameters list is
populated with all the variables used by objects (and Coordinate Systems, design data, andmaterial
properties) included in the component.

l Use the checkbox to Include or Exclude variables. You can also use the text field and
Include/Exclude buttons.

l You can fill in the description field, if desired.
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If you create non-geometry variablesmaterials or boundaries, these are listed separately:

If you exclude any geometry, boundary or material associated with a variable, the associated
variable is automatically excluded on theParameters tab.

Create Component Encryption Tab

TheEncryption tab includes a checkbox for you to define a user access password to use the
component.
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Encryption is a common technique for encoding information in amanner that is very difficult for
unauthorized users to decode.When this option is enabled for 3D Components, the contents of the
component file are encrypted to protect them from external viewing or editing.

l If the encrypted component is created with an Internal Key, it can be used without additional
authorization.

l If the encrypted component is created with aUser Password, that passwordmust be entered
when the component is used in a design.

l It is not possible to edit the definition of an encrypted component within the Electronics
Desktop.

l If theShow All Contents option is selected, the geometry and other contents will be shown
when the component is used. Geometry export and links will operate as for general geometry.

l TheHide Selected Contents option can be used to further protect access to an encrypted
component’s details. When this option is selected, hidden contents will not appear in the
Electronics Desktop user interface.

l All geometry will be hidden, except for objects that the user specifies as visible during
component creation.

l Hidden geometry will not be visible in themodel window or included in the history tree.
l Geometry export and links will not be allowed.
l Materials, boundaries, and other setup data will also be hidden, with limited exceptions
such as excitation settings that must be accessed in order to control the simulation and
post processing of the design.

l Note that names of objects, materials, boundaries, and other setup datamay appear in
progress updates, messages, and other informational text. Themesh statistics will also
include entries for hidden objects. Sensitive names should be changed before exporting
the component.

l For components with hidden contents, all geometry will be excluded from field
calculations and from plots of fields andmeshes. Plots in surrounding volumeswill
extend to, and can include, the outer surfaces of the component, but not the containing
volume.
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l Note: Such plotsmay indirectly reveal component content by providing a view of the
surfaceswhere the plots terminate. To prevent such exposure, include additional
modeled objects that surround the hidden contents of the component and havematerial
of the surroundingmaterial environment (e.g. air, vacuum).

l When a project contains one or more encrypted 3D Components, the project file is encrypted
in order to protect its contents. This encryption uses an internal key, so that you can open the
project file without entering a password.

Note Note that there are some additional considerationswith respect to projects using encrypted
components. The component itself will always be stored in encrypted form.When an HFSS
or HFSS-IE design contains an encrypted component with hidden contents, it will also
protect other project files containing data that could be used to extract component
information. As of the R18 release, other design types, such asMaxwell or Q3D, do not
support this additional security.

Checking theEncrypt File box enables theSet Password button, and selection buttons for
whether the password is toControl Access Only, or toHide Contents. You can also specify a
securitymessage. If you provide amessage, it is displayed at component insertion, and when the
project containing the component is opened.

Clicking theSet Password button opens a dialog with fields for Password, andConfirm.This
dialog also opens automatically when you checkEncrypt File.
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If you specify andOK the fields, the password is set. If you cancel, you will be prompted to provide a
password before you save the 3D component.
SelectingWith Internal Key disables thePassword andConfirm fields. If you selectWith
Internal Key, you don’t have to specify the password when you use the component.
If you changeAllow Component Edit with User Password, you also specify aPassword and
confirmation. The password for Allow component edit does not have to be the same as the password
for Allow component use. If either confirm entry does not match the corresponding password, you
will be prompted to correct the situation.
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If you then attempt to edit the definition of an encrypted component for which editing is allowed, you
will be prompted to enter the Password. You will have three tries to enter the correct password.

You have a choice regarding whether toShow All Contents or whether toHide Selected
Contents. If you selectHide Selected Contents, you then specify whether to display the
component outline as aBounding Box orNone.
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You can also control the visibility per model object by using the Hide check boxes in theModel tab.

You can specify aSecurity Message in the text field. The text you provide displayswhen you insert
a component and when you open a project containing the component.

When you insert an encrypted component, you are presented with an Authentication dialog in which
you enter a password. A user gets three attempts to enter the correct password.
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After authentication, the component is inserted for use. If you have specified a securitymessage,
that is displayed.
If you choose to edit the definition for the inserted component, you will be prompted to enter the Edit
password.
If you decide to open an encrypted but editable 3D Component file using File>Open, you are
required to enter both the use password (unless encrypted with an internal key) , and the edit
password.

Create Component Image Tab

The Image tab shows the preview image for the component, based on the reference Coordinate
System. The image also respondswhen you Include or Exclude objects from theModel tab.

l You can right-click for amenu to change the view of the preview image.
l Changing the preview orientation does not affect themodeler window view.

Drawing aModel 8-85
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

If you use the Encryption tab and/or Model tab settings to hide/show themodel or specifiedmodel
objects, the Image tab displays accordingly.
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If you use the Encryption tab to display only an object outline, the Image tab displays accordingly.
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Create Component Info Tab

On the Info tab you can view and edit component information, as well as add notes. The Name in the
first field is used when the component is inserted into a design.

You can also included a .bmp format image file to display in the upper right area of the 3D modeler
whenever the component is used. The image file typically contains a company logo. Click Browse to
open a window to navigate your file system select the image.
The image cannot be removed from themodeler window while the component is used.
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Save 3D Component File

When youOK theComponent File dialog, anExport File dialog displays. By default the Save in
field shows themodel source directory. ClickPersonalLib orUserLib to display a 3D Components
directory.

The default File name is the Component name specified in the Info tab.

Inserting a 3D Component in a Design

Once you save one or more components to a library, and create target coordinate systems in the
design where you intend to place the component, you can either right click on the 3D component icon
in the Project tree or use, or the Draw>3D Component Library command to browse your folders
or libraries, or use theView>Component Libraries to display a Component Libraries window to
navigate installed libraries.
From the Component Libraries window, you can navigate the directory of installed components, as
well as any in your Personal Library. The Hierarchical tree display includes Favorites andMost
Recently Used branches.
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You can select any component from the library, and drag and drop to insert it in the design. Double-
click on anymodel in the component libraries to view the Insert 3D Component Instance dialog
opened to theParameters tab. You can also view the Image and Info tabs, and select the target
coordinate system.
SelectingBrowse 3D Components lets you navigate directories via a browser window.

Selecting Insert Instance displays further menu selections for pre-defined components in other
libraries such as the Antennas library and the Rectangular Waveguide library. If you have added
components to PersonalLib or UserLib, these also appear after you refresh themenu.
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You can also clickDraw>3D Component Library to access theBrowse and Insert Instance
menus to select a component to insert into a design.
Before inserting a component in a design, it can be helpful to create a target coordinate system to
provide a location for the component. In the following 3D project example, the design includes two
additional coordinate systems:

Selection of a coordinate system in the History tree displays a potential location for inserting a
component.

To Insert a 3D Component from the Menus
1. Right-click on the 3D Component icon in theProject tree to open shortcut menu. You can

select Browse to use a browser window navigate the file system to the component.
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Selecting the *.a3dcomp file displays the component image and file name.
Note 3D components created inMaxwell 2D cannot be used inMaxwell 3D projects, and vice-

versa. A message displays if you attempt to insert a component that is incompatible with
the active design.

If you have previously inserted a component into a Project, the shortcut menu for the 3D
Component displays that component so that you can easily insert another instance of the
same component.

2. If you have used Browse, select a component and click theOpen button. If you use the Insert
Instancemenu, select the component name.
If the component has been encrypted, youmust provide a password. If you insert another
instance of the same component, you do not need to enter the password again for that
component again.
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You have three tries to enter the correct password. Upon successfully entering the password,
the Insert 3D Component dialog openswith the Encryption tab displayed.
You see the Insert 3D Component dialog opened on the Parameters tab.

Tabs let you view the Parameters, Image, and Info. You can edit parameter values, and
assign variables or expressions for parameters

3. Use themenu to select the Target Coordinate System if any have been defined in addition to
the Global coordinate system. The target coordinate system that you select is highlighted in
themodeler window.
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4. When you clickOK the component is placed at the coordinate system you selected.

5. If the component has a logo defined, the image is always displayed in the upper right of the
modeler window.
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Related Topics

Show, Show Only, Hide and Fit features, helpful in working with 3D components are described here:
Fit All Objects in a View Window.
Fit Selected objects in a View Window.
ShowingOnly SelectedObjects in All or Active Views
Hiding Objects fromView

Viewing Properties of 3D Components

The Properties displayed for a selected 3D component depends on how you select that component.
For a complete display of Properties, right click on the selected component (Project tree, History
tree, or Modeler window) and clickProperties on the shortcut menu, or clickEdit>Properties.This
displays a Properties window with tabs for all component properties.

Selecting a 3D component in the Project tree displays docked properties with tabs for General,
Materials and Component data.
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If you select a component in theProject window, then right-click and selectEdit>Properties, you
can view theProperties window. If you choose theMaterials tab, you can then select any listed
material and the parts of the component made of that material are highlighted in theModeler
window.
Selecting a 3D component in the History tree displays docked properties with tabs for General and
Parameters.

Selecting a 3D component in theModeler window displays docked properties with a tab for
Attributes.
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Component materials do not appear in the Project Tree Definitions list. If you select the icon for an
inserted component, the Properties window contains aMaterials tab that shows theMaterials
defined for the selected component.

3D Components in the Project Manager Window

TheProject Manager window organizes any components that you add to a design under the 3D
Components icon in theProject tree.

Selecting these inserted components populates the Properties window which has tabs that display
the instance attributes.
Excitations included in the 3D Components appear in the Project tree. This gives you the ability to
edit Post Processing settings.
Boundaries defined inside the component do not appear in the project tree. However, boundary
properties can be when you select the component in the Project tree and view the Component
properties under the Component Data tab.
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Also, you can useMaxwell>Boundaries>Reprioritize to set the priorities of all boundaries relative
to non-component boundaries.

Related Topics:

Fit All Objects in a View Window.
Fit Selected objects in a View Window.
ShowingOnly SelectedObjects in All or Active Views
Hiding Objects fromView

3D Components in the History Tree

You can group all instances of a component by component definition in the History tree.

To disable this grouping, right click on an instance, and uncheckGroup Components byDefinition.

Drawing aModel 8-98
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

This causes the display to show numbered instances listed without the icon for the primary
component.

Component Operations in the History Tree
l Component operations appear under that component folder toward the end.

l Component operations act on parts aswell as CS.
l Boundaries andmesh operations are duplicated with duplicate and copy/paste operations,
provided that you check theDuplicate boundaries/mesh operations with geometry
option to do so (see Tools>Options/<design type options>).

Related Topics

Fit All Objects in a View Window.
Fit Selected objects in a View Window.
ShowingOnly SelectedObjects in All or Active Views
Hiding Objects fromView

Editing 3D Component Properties
l Edit component parameters, if defined for that component. Editing the parameters of one
component instance affects only that instance. If a component includesNon-Geometry
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Parameters, these are grouped separately on the Parameters tab.

l Edit excitations by suppressing their use on the Excitations tab in the Properties window.

Checking Suppress in the Properties window removes the port on the selected instance from
the Excitations list on the Project tree. Unchecking Suppress activates that port for themodel
and causes the port to appear in the Excitations list.

l Edit excitation Post Processing such as deembed distance, renormalization.
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l Edit Sources for Post Processing

l Edit component attributes like component name, part names, material assignment, and
model/non-model flags.

l Edit boundaries, excitation andmesh operations for the component on the corresponding tabs
in the Properties window.

l Add additional boundaries/excitations on parts coming from component
However, operations on individual parts of component are not allowed.

l Copy/Paste component
l Delete component
l Arrange component: Move, Rotate, andMirror
l Duplicate component: Along Line, Around Axis, andMirror
l Edit Attributes for DisplayWire frame, Color, and Transparency.
l UseEdit>Select>Submodel to quickly select component
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Editing a 3D Component Definition

The Edit Component definition feature allows you to create new version of component definition just
by using previous 3D component file. This should also allow you to quickly create new version
without having to go through all the creation steps. For 3D Components that are not encrypted you
can edit the definition. Software will automatically create new project in the existing session. The
Project will have one design of same type as original design fromwhich edit definition was initiated.
All 3D component data from the file will be read in ‘exploded’ form in that design. Component
materials will be added at the project level, variables will be added at the project and design level,
geometry will create detailed history for all objects in the component and design data will be added to
respective folder in the project tree in the detailed form.
TheEdit Definition command creates a new project named for the component. You can see the
project in theProject Manager window.

You can then edit this new project. When you save the edited component to your library, you can
Update 3D Component Definition for component instances inserted in your designs.
To edit a 3D Component definition.
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1. You can begin editing a 3D component definition from either the History tree or the Project
tree.
l To begin from theHistory tree, select the component,, and right-click to display the
shortcut menu and clickEdit Definition.

For unencrypted components, this creates a new project in theProject window named for
the component. For encrypted components, youmust first supply the edit password.

l To begin from theProject window, select the 3D Components icon and right click to
display the short cut menu. Then selectDefinitions.

This displays the 3D Component Definitionswindow in which you can select the
component and then clickEdit Definition.
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2. For 3D Components that are not encrypted, you can edit the definition. Software will
automatically create a new project in the existing session. The Project will have one design of
same type as the original design fromwhich edit definition was initiated. You can now edit the
design with component data as required without any restrictions. All the component details are
available in their respective folders. Complete geometry history is available in history tree.
Material properties are added to the project definition folder. Boundaries, excitations, etc., go
to their respective folders in the project tree and component parameters become project or
design variables.

3. You can use File/Save to update the original component definition file. TheUpdate 3D
Component dialog will come after File/Save.
TheUpdate 3D Component dialog is populated with all entities - objects, boundaries,
excitation etc. in the “component-edit” design. In addition, previous settings like reference
coordinate system, component name, owner etc. from the Info tab, as well as encryption
settings, are preserved.

If you use File/Save As to save to a new component definition file, you also have the option to
Save AsANSYS Electronics Desktop file.
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4. Once you have saved the updated component version, you can go back to the original design
and update all the instances using that component. Note that update definition is not automatic
even though component definition edit was triggered from that design. Instead when an
assembly design becomes active, it prompts you to update the 3D component definition. You
can then select to update the definition.

You can also open the 3D definitionswindow to select a component, and view the Definition
Status column. If an update is available, you can select the component and clickUpdate
Definition.

5.
See Update 3D Component Definition

6. After editing is done, you also select themodel and then use theCreate 3D Component
command.
See Creating a 3D Component from an ExistingModel.

Drawing aModel 8-105
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

The component data is loaded from component definition file. The Info tab version
automatically increments. Before saving, you have the option toKeep project open for
edit/save, or Save definition and close project.

7. You can selectEdit File Path to update the file path for component definition. This opens a
browser window that lets you navigate your file system and select a file path to be used for the
new component definition.

Updating 3D Component Definitions

If you create or obtain from a vendor a new version of a component, and then open a project that
contained an earlier version of that component, you can right-click on the component in the History
tree and selectUpdate Definition to replace the older version of the component with the newer one
This updates all the instances of the component using that definition. Update Definition is grayed out
if a newer definition is unavailable.

You can also accomplish this by right-clicking on the 3D Component icon in the Project Tree and
selecting Definitions from the shortcut menu. This displays a dialog listing available component
definitions. The Definition status column lets you know if an undated definition is available.
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All instances and component operations in the design are updated
l Parameter values are preserved
l New parts are generated in all instances
l Deleted parts are deleted from all instances
l Edited parts are changed in all instances
l Design data, materials, coordinate systems can also be updated
l Undo is supported, command is scriptable
l Definitions dialog provides complete list of definitions in the design
l Definitions can be updated from the dialog

Legacy Projects with 3D Components

Components created in earlier projects do not have the same degree of encapsulization and are not
compatible with the current version of Maxwell.

SpaceClaim Integration
ANSYS Electronics Desktop can import geometry from a SpaceClaim document using the
SpaceClaim Link feature. SpaceClaim Link can be used: if the SpaceClaimDirect Modeler
(SCDM) is part of an ANSYS installation that is of the same version as ANSYS Electronics Desktop;
or if a standalone installation of the SpaceClaimmodeler exists on the samemachine.
SpaceClaim Link is only available onWindows, and provides the following functionality:
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ANSYS Electronics Desktop can import geometry from the SpaceClaimmodeler. To use
SpaceClaim Linkwith ANSYS Electronics Desktop, youmust install the SpaceClaimmodeler on
the sameWindowsmachine. SpaceClaim Link provides following functionality:

l Browse and select SpaceClaim documents to import geometry directly.
l Import geometry by connecting to a active SpaceClaim session.
l The SpaceClaim geometry is imported as a User DefinedModel (UDM) along with geometry
parameters with units, rendering attributes, andmaterial assignments.

l For a SpaceClaim link for a UDMalready in the design, you can launch a SpaceClaim session
fromAEDT and open the corresponding SpaceClaim document.

l A SpaceClaim document referenced by a SpaceClaim link UDM is included in project archive
automatically.

l By option you can break a connection to SpaceClaim. In this case, all UDMparts are then
converted to imported objects. This feature lets you use SpaceClaim just for its healing
capacity.

Importing SpaceClaim geometry into ANSYS Electronics Desktop
1. ClickModeler>SpaceClaim Link>Browse to open a file browse dialog.
2. Select a SpaceClaim .scdoc document file and import the geometry.

The imported geometry is shown in the History tree as a User DefinedModel (UDM).
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The Properties window of a SpaceClaim link UDMhas 3 tabs.
l TheGeneral tab shows general information such as SpaceClaim document path.

l TheParameters tab shows all parameters.
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l TheOptions tab shows supported options.

Options Include:
l Import Solid Bodies: Default is ON
l Import Surface Bodies: Default is ON
l Parameters: Default is ON (It imports parameters).
l Parameter Key: A string that is used to filter out parameters. Default is no string - i.e. all
SpaceClaim parameters will be imported.

l Rendering Attribute: We import color of objects. By default the option is ON.
l Material assignment: By default we import material assignment. Note that material
properties are not imported. A material with exact namemust already exist. Otherwise,
validation issues a violation.
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Connecting to an Active SpaceClaim session:
If one or more SpaceClaim sessions are running on themachine,SpaceClaim Link can connect to
them to import geometry directly.
When you click theConnect to Active Sessionmenu item, ANSYS Electronics Desktop opens a
dialog showing all active SpaceClaim sessions, their document name and status.

You can select a session with “Not Connected” status and press theConnect button to import
geometry from that session. Once connected, that session is used to regenerate the corresponding
SpaceClaim link UDM.
The dialog is empty if no sessions are running.

Launching a SpacClaim session from ANSYS Electronics Desktop
The context menu of a SpaceClaim linked UDM shown in the History tree allows you to Launch
SpaceClaim and toBreak Connection.
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When you select Launch SpaceClaim:
l If no SpaceClaim session is open, a new SpaceClaim session is opened, and the document
corresponding to SpaceClaim link will be opened in it.

l If a SpaceClaim session is already open, the document will be opened in that session.
All refresh/regenerates of the linked SpaceClaim document use the session that is opened.
The session closeswhen ANSYS Electronics Desktop closes.

Breaking Connection with SpaceClaim Link:
When you select theBreak Connection command in the context menu of the SpaceClaim link
UDM:

l BreakConnection converts the UDMbodies to imported objects. The UDMwill be removed.
l Any operation that you had performed on UDMbodies is preserved.
l Parameters of the UDMare lost. You lose the ability to create parametric variationswith
SpaceClaim parameters. Note that parameters for subsequent history operations on
SpaceClaim parts will be retained.

l Attributes such as rendering attributes, materials, etc., are preserved.

Archive a Project containing SpaceClaim link
If you want to share a project with a SpaceClaim linked document with other users, you need to
archive the project. Sharing the project file only is not sufficient because the SpaceClaim document
is not included in the project.

l SpaceClaim documents corresponding to the link will be included in the project archive
automatically.
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l If any SpaceClaim document refers to other documents (e.g., an assembly document might
refer to individual part documents), these indirectly referenced documents will also be
included in the ANSYS Electronics Desktop project archive.

l When an archive is unarchived, referenced SpaceClaim documents will be put in a “restored_
files” subfolder in the project directory. All definition paths are updated to refer to the reference
files in the “restored_files” folder.

Handling SpaceClaim document Save
When you launch a SpaceClaim session fromANSYS Electronics Desktop or connect to a live
session, whenever the project is saved, the SpaceClaim document corresponding to the
SpaceClaim link UDM is automatically saved if any unsaved changes exist in that document.
If unsaved changes in SpaceClaimwere not imported into ANSYS Electronics Desktop before
saving, theywill be imported the next time that the SpaceClaim link UDM is regenerated.
Youmust ensure that the geometry in ANSYS Electronics Desktop and that in SpaceClaim are in
sync.

Related Topics

"User DefinedModel (UDM)" on page 18-36

Model Analysis
For somemodels it may be beneficial to remove unnecessary small entities and to fix object
misalignments to avoid potential mesh issues. Maxwell includesModel Analysis functions to help you
evaluatemodels you have imported or created. SelectModeler> Model Analysis to see themenu
options. Depending on the design and the current selection, some featuresmay not be enabled. The
menu includes the following commands.

l AnalyzeObjects
l Analyze Interobject Misalignment
l Analyze SurfaceMesh
l Heal
l Show Analysis Dialog
l Align Faces
l Remove Faces
l Remove Edges

Note Before runningmodel analysis, youmust remove all command history for the
selected object by using the Purge History command. If you need to save the object
history, save a separate copy.

1. After import, you typically perform validation check. This lets you focus on objects and object
pairs that have errors and or warnings. The objects that fail should be analyzed by using the
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Modeler>Model Analysis>Analyze Objectsmenu item.
2. Select the objects and invokeModeler>Model Analysis>Analyze Objects.

This displays theAnalysis Options dialog to allow you to specify settings for entity check
level, and small feature detection.
When youOK this dialog, the initial analysis executes and theModel Analysis dialog is
displayed.

3. Choose the objects that have "Invalid Entities Found" andPerform>Heal Objects.
In most cases, the objects will be healed and the errors fixed.

4. If errors still persist, choose the edges and faces and click onDelete.
This will replace the selected face/edge object by a tolerant edge/vertex respectively. In some
cases the replacement of the face/edge by tolerant edge/vertex will fail.

Whenmodels pass the initial validity checks, mesh generation could still fail. The following errors can
be present in models: (Refer to Detecting Errors.)

1. Non-manifold topology. These are non-manifold edges and vertices that are present in the
model.
Note One of the requirements for valid mesh generation is that the surfacemeshmust be

manifold, that is, a plot of all the surface triangles of a 3D solid object should not
have any “holes.” Such amesh is often referred to as awatertightmesh. If there is
a hole and you were to fill the object with water, the water would leak out of that hole
– themesh would not bewatertight. Zero-area holes (often called cracks) will also
“leak.” Havingmultiple triangles cover the same patch also results in amesh that is
not manifold.
Refer toHealingModels, and the list ofRelated Topics below for information on
detecting and correcting such errors.

2. Object pair intersection. This detects whether pairs of objects intersect.
3. Small feature detection – small edge length, small face area and sliver face detection.
4. Mis-aligned entities detection – detects pairs of faces from objects that can be aligned to

remove object intersections. This improves the probability of mesh success.
5. Mesh failure error display. This is available for single object, object pairs and last simulation

run (all objects in amodel). Errors reported by themeshingmodule are reported to the user.
Errors of type 3 and 4 should be resolved before you invoke themeshing for themodel.
By default, theHeal command is automatically applied to imported objects.

Related Topics

Set Material Override
Analysis OptionsDialog
Healing
Healing Non-manifold Objects
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Healing Options
Technical Notes: HealingModels
Technical Notes: Healing andMeshing
Technical Notes:Detecting and AddressingModel Problems to ImproveMeshing

Analysis Options Dialog

To perform analysis on an object according to specified features and tolerance values:
1. Select the object you want to analyze and clickModeler> Model Analysis>Analyze

Objects.
This displays the Analysis Options dialog, with the Analysis Options tab selected.
SelectingModeler>Model Analysis>Heal also displays this dialog. If, during
Modeler>Import... you selectHeal Imported Objects andManual on the file browser
dialog, you also see this dialog.

2. If desired, check thePerform Entity Check Errors check box.
This enables theCheck Levelmenu. The setting can beBasic, Strict, orComprehensive.
SeeModeler Validation Settings for more explanation.

3. If desired, click the check boxes to enable and set the Detect Feature settings:
l Detect Holes, and specify theMaximumRadius.
l Detect Chamfers, and specify theMaximumWidth.
l Detect Blends, and specify theMaximumRadius.

4. If desired set theDetect Small Entities features and tolerance values.
l Small Edges, length less than
l Small Faces, area less than
l Sliver Faces, which enables:

l Object Bounding Box Scale Factor
l Sliver EdgeWidth

5. Click theProperties tab to see a listing of the geometric properties of the selected object.
6. ClickingOK on this dialog displays theModel Analysis dialog which contains the results of

the analysis.

Related Topics

Healing an Imported Object
Model Analysis Dialog
Set Material Override

Analyzing the Surface Mesh

To set the options to analyze the surfacemesh:
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1. Select an object of interest.
This enables the Analyze SurfaceMesh command in themenu.

2. ClickModeler>Model Analysis>Analyze Surface Mesh.
TheSurface Mesh Analysis Options dialog box appears. This dialog box allows you to set
parameters to remove.
l You can also open theSurface Mesh Analysis Options dialog box from theModel
Analysis dialog box via thePerform pull-downmenu on theObjects tab.

3. Select or clear thePerform Object Pairs Analysis check box. Selecting this option
evaluates themesh for all combinations of the selected objects.

4. Select or clear the Ignore Objects Separated by greater than check box, and enter a value
in the text box. Selecting this optionmeans that object pairs are disregarded from analysis if
their separation is greater than the specified value.

5. ClickOK to perform the analysis with the selected options.
TheModel Analysis dialog box appears, displaying the results of the analysis.

Related Topics

Healing an Imported Object
ViewingModel Analysis Results (Model Analysis Dialog Box)

Model Analysis Dialog

This dialog contains results for all model analysis, including diagnostic information relating tomesh
issues. To view the analysis options:

1. ClickModeler> Model Analysis>Show Analysis Dialog.
A submenu appears.

2. Select one of the following from the submenu:
l Objects
l Objects Misalignment
l Surface Mesh
l Last Simulation Mesh
TheModel Analysis dialog box appears. (This dialog box also appears automatically after
clickingOK in theAnalysis Options dialog box.)

3. Select theAuto zoom to selection check box to automatically zoom to the item selected on
theObjects tab.

4. Make the desired changes on each tab in theModel Analysis dialog box :
l Objects tab
l Objects Misalignment tab
l Surface Mesh (Single/Pairs) tab
l Last Simulation Mesh tab

5. ClickClose to close theModel Analysis dialog box.
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Related Topics

Healing an Imported Object
Analyzing Objects
Analyzing the SurfaceMesh
Set Material Override
Technical Notes: Healing andMeshing
Technical Notes:Detecting and AddressingModel Problems to ImproveMeshing

Objects Tab

All results relating tomodel analysis of specific objects are presented under theObjects tab. The
Objects tab for theModel Analysis dialog lets you view the following information:

1. The results table contains the following information.
l Name - column listing the objects in the current design.
l Last Analysis status - column giving the analysis status of the listed objects. Objects can
have the following status:
l Good - the object contains no invalid geometry entities given the tolerance values
specified in theAnalysis Options dialog.

l Null Body - the object is non-existent.
l Analysis not performed - the object was not selected for analysis.
l Invalid entity errors - these are api_check_entity() errors and non-manifold errors
whichmust be fixed prior to meshing.

l Small entity errors - small faces, sliver faces and small edges that are optionally
detected based on the tolerance limits specified in theAnalysis Options dialog.

2. Select any object name in the table which contains errors to display a set of radio buttons in
the panel and a list of corresponding faces, edges and vertices.
Note Auto Zoom to Selection -- if this option is checked, themodeler automatically

zooms to the item selected in theModel Analysis dialog box.

3. Select the face, edge or vertex entity from the list to view the error description in the
Description field.

4. Select theDelete button if you want to remove a selected face or edge entity.
5. Select thePerform button to list the commands that you can execute on the selected objects

in the Results table.
l Heal Objects - repairs invalid geometry entities for the selected objects within the specified
tolerance settings. The Healing Analysis dialog will appear.

l Analyze Objects - evaluates the object status. Selecting this displays the Analysis Options
dialog.
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l Analyze Surface Mesh - invokes amesh for each selected object and reports analysis
results under theSurface Mesh (Single/Pairs) tab. Selecting this option displays a dialog
with radio buttons to select.
l PerformObject Pairs Analysis - evaluatesmesh for all combinations of the selected
objects.

l Ignore objects separated by greater than a specified value - object pairs are disregarded
from analysis if their separation is greater than the specified value.

l ClickOK to perform the analysis with the selected options.
l Analyze Interobject Misalignment - determines anymisalignments between two
selected objects in the results table. The results are reported under theObjects
Misalignment tab.

l Display Healing Log -- checking this causes theModel Analysis dialog to display a
healing log which includes information about operations performed on an object during the
healing process.

Related Topics

AnalyzeObjects
Analyze Interobject Misalignment
Analyze SurfaceMesh
Healing
Set Material Override

Objects Misalignment Tab

The table in this panel displays results of an Interobject Misalignment analysis. All misaligned face
pairs corresponding to the analyzed objects are listed in the table.

l Align Faces - select a face pair in the table and click theAlign Faces button to align selected
faces.

l Clear All Analysis Data - this button removes all information from the tables.
l Auto Zoom to Selection -- if this option is checked, themodeler automatically zooms to the
item selected in the table.

After validation check is performed, the pairs of objects that intersect are chosen for analysis. Use
the analysis results to find whether objects have faces that can be aligned.
Choose all the bodies that intersect with another body.

1. From theModel Analysis dialog choose perform/Analyze Interobject misalignment. Or you
can runModeler>Model Analysis>Analyze Interobject Misalignment.
If the analysis finds object pairs that can be aligned, theywill be displayed in theObjects
Misalignment tab.

2. You can select individual or multiple rows and performAlign Faces. In some cases, face
alignment will fail if the topology of the body changes by a large factor after alignment.

3. Identify individual bodies and body pairs that fail to mesh.
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4. PerformMesh analysis on individual objects and object pairs.
5. Review the reports and fix the errors.

Related Topics

AnalyzeObjects
Analyze Interobject Misalignment
Analyze SurfaceMesh
Healing
Technical Notes: Healing andMeshing
Set Material Override

Surface Mesh (Single/Pairs) Tab

The panel displays the results of a surfacemesh analysis.
1. You can display results for:

l Individual Objects
l Object Pairs

Note Auto Zoom to Selection -- if this option is checked, themodeler automatically
zooms to the object or object pair selected.

2. The results table contains the following information:
l Object - column listing object name or a pair of object names.
l Last Analysis Status - column stating themeshing status of the object or object pair.

l Mesh Success
l Mesh Failure

l Error Type - this column gives the category of error that caused themesh failure.
l Error Detail - provide specific geometry information regardingmesh error location.
Display options include:

l Display Mesh Analysis log check box -checking this displays further details concerning each
error to be listed.

l Auto Zoom to Selection -- checking this causes themodeler to automatically zoom to
objects or faces corresponding to the error.

Related Topics

AnalyzeObjects
Analyze Interobject Misalignment
Analyze SurfaceMesh
Healing
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Last Simulation Mesh Tab

The table in this panel lists all model errors as viewed by themesher.
l Error Type - this column gives the category of error that caused themesh failure.
l Error Detail - provide specific geometry information regardingmesh error location.

Display options include:
l Display Mesh Analysis log check box -checking this displays further details concerning each
error to be listed.

l Auto Zoom to Selection -- checking this causes themodeler to automatically zoom to
objects or faces corresponding to the error.

Related Topics

AnalyzeObjects
Analyze Interobject Misalignment
Analyze SurfaceMesh
Healing

Model Preparation Commands
Use theModeler>Model Preparation> commands to prepare amodel.
These commands include:

l Simplify
l Heal
l Stitch Sheets
l Align Faces
l Remove Faces
l Remove Edges
l PerformExplicit Subtractions

Related Topics

Model Analysis
Modifying Objects
DrawingObjects

Simplify Command

Use theModeler>Model Preparation>Simplify command to converts a complexMCAD object
into simpler primitiveswhich are easy tomesh and solve. The operation can be applied on any
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selected object and not just imported objects. You can specify the type of simplification as Bounding
Box, Primitive Fit, or Polygon Fit.
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The History tree shows theSimplify command as being applied to the object.

Any parameters you specify in the dialog you can also edit in the Properties dialog for the History tree
Simplify command to get a different simplification. The properties display in the docked properties
includes only the parameters that are used by your currently selectedSimplify command type.
None of the parameters of simplify operation accept variables.
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1. Select an object.
This enables the Simplify command on theModeler>Model Preparation submenu.

2. ClickModeler>Model Preparation>Simplify
This opens theSimplify Bodies dialog. A drop downmenu lets you select the degree of
simplification, fromBounding Box, Primitive Fit, or Polygon Fit.
Bounding Box Simplify Type
If you select Bounding Box as the Simplify Type, there are no additional parameters. The
object is replaced by its exact bounding box as e computed in operation’s coordinate system.
You can change the operation CS to get a bounding box in an appropriate orientation.

Primitive Fit Simplification
For Primitive Fit simplification the object is replaced by a set of primitives shapes like Prism,
Cylinder, Cone and so forth. This simplification type typically produces the simplest geometry
with highest number of primitives. Primitive fit has the following options: Cleanup and Allow
Splitting, whether to Separate Bodies and Purge History, and if so, whether to clone original
objects before the operation.

For Primitive Fit, the parameters are:
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l Whether to Cleanup - This option allows you to clean themodel before performing
simplification. Cleanup include removing small features like rounds, fillets, chamfers in a
solid body. It is recommended to set this option to get more simplified result.

l Whether to Allow Splitting - This option controls if object should be split during during
simplification. If this option is selected, complex object will first split into multiple pieces and
each piece will be further simplified. Setting this option will result in an object which will
matchmore closely with original object. It is recommended to set this option.

l See theSeparate Bodies and Purge History description below.
Polygon Fit Simplification
For Polygon Fit simplification, the object is replaced by set of polygon swept along normal and
other primitives like box and cylinder. This simplification type typically produces geometry
closest to original object with highest number of primitives. If you select Polygon Fit as the
Simplify Type, the parameters are Clean Up, Allow Splitting, Extrusion Axis, Interior Points on
Arc, andLength Threshold, whether to Separate Bodies and Purge History, and if so, whether
to clone original objects before the operation. See theSeparate Bodies and Purge History
description below.

For Polygon Fit, you specify parameters for
l Whether to Cleanup - This option allows you to clean themodel before performing
simplification. Cleanup include removing small features like rounds, fillets, chamfers in a
solid body. It is recommended to set this option to get more simplified result.
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l Whether to Allow Splitting - This option controls if object should be split during during
simplification. If this option is selected, complex object will first split into multiple pieces and
each piece will be further simplified. Setting this option will result in an object which will
matchmore closely with original object. It is recommended to set this option.

l Extrusion Axis, whether Auto selected, or X, Y, or Z. - This option specified a normal plane
in which polygon profile is looked for. The default is Auto which allows an algorithm to
determine best possible plane for polygon profile. You can specify a axis to help the
algorithm, particularly when there is a draft or chamfer in the extrusion direction. The
polygon profile is then swept in the extrusion direction.

l Interior Points on Arc - This specifies number of interior points created when a curve on the
polygon profile is represented by line segments. The range is 1 to 100 with default being 3.
Total number of points used to represent a curve is 5 when number of interior points is 3.
This number specifies themaximumnumber of interior points to add. The number of points
added could be less if the Length Threshold is alreadymet.

l Length Threshold% - This specifies the length of edge as percentage of maximum length of
an edge in the profile. It is specified as percentage of maximumedge length. If length of
edge ismore than the specified threshold, more interior points are added until the number
of “Interior Points on Arc” ismet.

l Whether to Separate Bodies and Purge History, and if so, whether to clone original objects
before the operation. See theSeparate Bodies and Purge History description below.

Separate Bodies and Purge History Option for Primitive Fit or Polygon Fit
Separate bodies and purge history option is available when simplification type is Primitive fit or
Polygon fit.

With this option selected, the input body is simplified intomultiple primitives (or polygon shapes) and
a new part is created for each simplified shape. This option also purges the history of original part
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and it is not possible Edit Properties of the Simplify operation. You can choose to clone original
object before simplification to retain history of original part.

Use of Coordinate System
By default, the current working CS is used as the Simplify operation CS, but you can also change
operation CS through theSimplify command property window or Property dialog.

Related Topics

Healing

Heal

TheHeal command provides a way to correct geometric violations and to remove specific kinds of
small features. Whenmodels are imported, two types of errors can occur – geometry errors and
topology errors. Geometry errors are errors in definition of the underlying geometry while topology
errors are errors in how the underlying components like faces, edges and vertices are connected.
ANSYS recommends that these be fixed before you invokemesh generation.
Imported objects which have only one operation on the history tree, can be healed. (Use the Purge
History command to remove unwanted history operations before usingHeal.)

Note If you need to save the object history, save a separate copy for that purpose before you
heal the object.

Healing can be invoked in different ways.
l Themenu commandModeler>Model Healing>Heal command applies to a selected object.
l Some formats permit healing duringModeler>Import. These are: 3D Modeler file (*.sm3),
SAT file (*.sat), STEP file (*.step,*. stp), IGES file (*.iges, *.igs), ProE files (*.prt, *.asm),
CATIA (*.model, *.CATpart), and Parasolid file (*.x_t, and *.x_b).
Selecting any of these formats enables a check box at the bottom of this window, "Validation
and Healing Options."
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See this table for details. TheQuick option allows you to switch off healing to speed up the
import process.

l TheModel Analysis dialog that appears after runningModeler>Model Analysis>Analyze
Objects, orModeler>Model Analysis>Show Analysis dialog includes aPerform action
menuwithHeal Objects as a selection.

Any of these approaches leads to the same heal process.

Basic Steps in the Heal Process
There are several steps that are performed on selected objects.

1. Entity check, according to theAnalysis Options settings.
2. Basic healing. This is done for all selected objects. Basic healing consists of fixing surface

normals in the object and updating the orientation (to avoid having an object with negative
volume).

3. Advanced healing. This is auto-heal. This is invoked on objects that require healing, that is,
bodies that have errors, including have non-manifold errors.

4. Feature Removal. If you choose in the Healing Options to remove small holes, chamfers,
blends, small edges, small faces and/or sliver faces, the actions are performed on all selected
objects. There is no guarantee that small feature removal will be successful. (Also see
Modifying theModel Resolution for defeaturing through the Auto Simplify andModel
Resolution settings there.)

The above actions are performed on the selected objects. If you choose objects for healing which
have not been analyzed, analysis is performed to determine its state (that is, whether it has invalid
entities, small entities, and so forth). Invalid objects have all the above steps performed. Advanced
healing is not performed on objects that do not require it.
While working on analyzing complex bodies, it is sometimes useful to examine faces, edges and
vertices. In particular it is useful to find the connected faces for a face or edge or vertex, connected
edges for a face/edge/vertex and connected vertices for a face/edge/vertex. The additional selection
modes are available under Edit->Select and via the toolbar icons.

Related Topics

Align Faces
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Remove Faces
Remove Edges
Healing Non-manifold Objects
Healing Options
Modifying theModel Resolution
Technical Notes: RemovingObject Intersections
Technical Notes: Healing andMeshing
Technical Notes: Detecting and AddressingModel Problems to ImproveMeshing

Validation and Healing Options for Import File

The Import File dialog contains shows differentValidation and Healing Options for the seven file
types listed here. TheQuick option is allows you to import these formats without healing.

File Type Validation and Healing Options Available
3D Modeler file
(*.sm3),

Quick Strict

SAT file (*.sat), Quick Strict Auto or
manual

STEP file (*.step,*.
stp),

Quick Strict Auto or
Manual

Stitch Tolerance

IGES file (*.iges,
*.igs)

Quick Strict Auto or
Manual

Stitch Tolerance

ProE files (*.prt,
*.asm)

Quick Strict Auto or
Manual

Import Free Surfaces. This imports such
surfaces aswell as parts.

CATIA (*.model,
*.CATpart)

Quick Strict Auto or
Manual

Stitch Tolerance

Parasolid file (*.x_t,
and *.x_b)

Quick Strict Auto or
Manual

Related Topics

Healing
Healing Options
Technical Notes: RemovingObject Intersections
Technical Notes: Healing andMeshing
Technical Notes: Detecting and AddressingModel Problems to ImproveMeshing
Technical Notes:Mixed Dimensionality.
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Healing Stage One: Validation Check

After import an object, you should perform a validation check. This lets you focus on objects and
object pairs that prevent themesh from being invoked. The objects that fail api_check_entity() should
be analyzed via theAnalyze Objectsmenu item.
1. Select the objects, and clickModeler >Model Analysis >Analyze Objects.

TheAnalysis Options dialog box appears, allowing you to perform small feature detections.
Once you have completed this, clickOK. TheModel Analysis dialog box appears.

2. In theModel Analysis dialog box, select the objectsmarked with "Invalid Entities Found",
and clickPerform>Heal Objects. TheHealing Options dialog box appears, allowing you to
remove parameters. ClickOK. TheModel Analysis dialog box reappears.
Note In most cases, the objects are healed, and the errors are

fixed.

3. If errors persist, select the edges and faces still containing errors, and clickDelete.
This replaces each selected face/edge object by a tolerant edge/vertex, respectively. In some
cases, the replacement of the face/edge by tolerant edge/vertex fails.

Whenmodels pass the initial validity checks, mesh generation could still fail. The following errors can
be present in models: (See Detecting Errors.)

1. Non-manifold topology. These are non-manifold edges and vertices that are present in the
model.

2. Object pair intersection. This detects whether pairs of objects intersect.
3. Small feature detection – small edge length, small face area and sliver face detection.
4. Mis-aligned entities detection – detects pairs of faces from objects that can be aligned to

remove object intersections. This improves the probability of mesh success.
5. Mesh failure error display. This is available for single object, object pairs and last simulation

run (all objects in amodel). Errors reported by themeshingmodule are reported to the user.
Errors of type 3 and 4must be resolved before themesh can be invoked on themodel.
By default, theHeal command is automatically applied to imported objects.

Related Topics

Healing
Fix Intersections BetweenObjects (Healing Stage 2)
FixObject Pair Intersections (Healing Stage 3)
Analysis Phase (Healing Stage 4)
Healing Non-manifold Objects
Healing Options
Set Material Override
Technical Notes: Healing andMeshing
Technical Notes:Detecting and AddressingModel Problems to ImproveMeshing
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Healing Stage Two: Fix Intersections Between Objects

The second stage in healing is to fix intersections between objects. After validation check is
performed, the pairs of objects that intersect are chosen for analysis. Use the analysis results to find
whether objects have faces that can be aligned.
Choose all the bodies that intersect with another body.

1. From theObjects tab of theModel Analysis dialog box, clickPerform>Analyze
Interobject Misalignment.
l Alternatively, you can clickModeler>Model Analysis>Analyze Interobject
Misalignment.

If the analysis finds object pairs that can be aligned, they are displayed on theObjects
Misalignment tab.

2. You can select individual or multiple rows, and align the faces. In some cases, face alignment
fails if the topology of the body changes by a large factor after alignment.

3. Identify individual bodies and body pairs that fail to mesh.
4. Perform amesh analysis on individual objects and object pairs.
5. Review the reports and fix the errors.

Related Topics

Healing
Validation Check (Healing Stage 1)
FixObject Pair Intersections (Healing Stage 3)
Analysis Phase (Healing Stage 4)
Healing Non-manifold Objects
Healing Options
Set Material Override
Technical Notes: Healing andMeshing
Technical Notes:Detecting and AddressingModel Problems to ImproveMeshing

Healing Stage Three: Fix Object Pair Intersections

The next stage of healing is to fix object-pair intersections. The healing process in stage twomight fix
some of these errors (by alignment).

1. If these errors are still present, youmust remove them either by using theRemove Faces
command (Modeler>Model Analysis>Remove Faces) or by performing a Boolean
subtraction.

2. Overlap between objects is too large to be fixed by healing or by face alignment. Boolean
intersect shows the common portion between the bodies. In this case, use a subtract
operation to remove overlaps.
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Related Topics

Healing
Validation Check (Healing Stage 1)
Fix Intersections BetweenObjects (Healing Stage 2)
Analysis Phase (Healing Stage 4)
Healing Non-manifold Objects
Healing Options
Set Material Override
Technical Notes: Healing andMeshing
Technical Notes:Detecting and AddressingModel Problems to ImproveMeshing

Healing Stage Four: Analysis Phase

If the last simulation run contains errors, they are displayed in theModel Analysis dialog box, on the
Last Simulation Mesh tab.

Related Topics

Healing
Validation Check (Healing Stage 1)
Fix Intersections BetweenObjects (Healing Stage 2)
FixObject Pair Intersections (Healing Stage 3)
Healing Non-manifold Objects
Healing Options
Set Material Override
Technical Notes: Healing andMeshing
Technical Notes:Detecting and AddressingModel Problems to ImproveMeshing

Healing Non-Manifold Objects

Non-manifold objects, in simple terms, are non-physical objects or objects that cannot be
manufactured. For example, objects that intersect themselves (like the symbol for infinity in 2d) are
clearly non-manifold. In addition objects that touch themselvesmay be non-manifold such aswhen a
2D object touches itself at a vertex, or a 3D object touches itself at a point or edge. These cases are
shown in the figure below.
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Another type of non-manifold object hasmixed dimensionality. For example, a pair of 2D objects
connected by a 1D line segment, or a pair of 3D objects connected by a 2D sheet object. These
cases are illustrated below.
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The criteria for manufacturability is a simplemanifestation of a complexmathematical concept that
must be adhered to in the solid modeling system.When creating geometry, either directly, or through
boolean operations, you should always consider whether or not the resulting operation will result in
an object that could not bemanufactured. If this is the case, then the object will cause an error in the
modeler or in themeshing system.
To heal non-manifold objects:

1. Identify an edge that is non-manifold.
2. Select the connected faces.

You can use the Face selection toolbar icons.
3. Create a face coordinate system on the planar face.
4. Create a small box to cover the non-manifold edge.
5. Either do a union or a subtraction to remove the faces that contain the non-manifold edge.

The non-manifold edge is now removed. Youmay also remove or add a small portion of the
model.

6. Repeat the above steps for all the non-manifold edges.

Related Topics

Healing
Validation Check (Healing Stage 1)
Fix Intersections BetweenObjects (Healing Stage 2)
FixObject Pair Intersections (Healing Stage 3)
Analysis Phase (Healing Stage 4)
Healing Options
Set Material Override
Technical Notes:Healing andMeshing
Technical Notes:Detecting and AddressingModel Problems to ImproveMeshing

Related Topics

Healing
Technical Notes:RemovingObject Intersections
Healing Options
Technical Notes: Healing andMeshing
Technical Notes:Detecting and AddressingModel Problems to ImproveMeshing
Technical Notes:Mixed Dimensionality
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Setting the Healing Options

TheHealing Options let you control how healing proceedswith respect to a variety of features and
issues.

1. ClickModeler>Model Healing>Heal to open theHealing Options dialog. You can also
open theHealing Options dialog from theModel Analysis dialog via theObjects tab drop
downmenu.
TheHealing Options dialog contains three tabs:
l Healing Options
l Feature Removal Options
l Properties, which lists the geometric properties of the currently selected object.

2. Select the Healing Options tab on theHealing Options dialog to specify the following:
l Heal Type as:Auto Heal (default),Manual Heal, orNo Heal.
SelectingManual Heal enables theManual Heal Options:
l Perform Tolerant Stitching check box.

This enables a field for theStitch Tolerance value, and a check box toStop After First
Error.

l Perform Geometry Simplification

This enables fields for Simplification Tolerance andMaximum Generated Radius values.

You can also select radio buttons toSimplify Curves, Surfaces, or Both.

l Tighten Gaps settings.

A check box to selectPerform Tighten Gaps

A field to specifyTighten Gaps Within a given value inmm.

3. Select the Feature Removal Options tab to specify the following:
Here you can specify the following Feature Removal Options.
l Remove Holes check box andMaximum Radius value.
l Remove Chamfers check box andMaximum Width value.
l Remove Blends check box andMaximum Radius value.
You can specify the followingRemove Small Entity Options:
l Small Edges, Length Less Than, less than a specified value.
l Small Faces Area e Less Than, less than a specified area.
l Sliver Face Width Less Than, less than either:

l Object Bounding box Scale Factor, less than a specified scale factor
l Sliver Edge Width, less than a specified value.

Note Sliver faces have amaximumdistance among the long edges that is smaller
than the specified tolerance and have at least one short edge and at most three
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long edges. A short edge has a length less than the specified tolerance. A long
edge has a length greater than the specified tolerance. You can give the
tolerance as a absolute value or a factor of the bounding box containing the
face.

You canControl Object Properties Change according to the following settings:
l Allowable Change in Surface Area check box, and percent value.
l Allowable Change in Volume check box, and percent value.

4. Select theProperties tab to view the geometric properties of the currently selected object.
5. ClickOK to apply the specified Healing options and to open the Analysis dialog.

Related Topics

Healing
Validation Check (Healing Stage 1)
Fix Intersections BetweenObjects (Healing Stage 2)
FixObject Pair Intersections (Healing Stage 3)
Analysis Phase (Healing Stage 4)
Healing Non-manifold Objects
Set Material Override
Technical Notes: Healing andMeshing
Technical Notes:Detecting and AddressingModel Problems to ImproveMeshing

Related Topics

Healing
Stitch Sheets
Technical Notes:RemovingObject Intersections
Healing Non-manifold Objects
Modifying theModel Resolution
Technical Notes: Healing andMeshing
Technical Notes:Detecting and AddressingModel Problems to ImproveMeshing

Stitch Sheets

Use theModeler>Model Healing>Stitch Sheets command to stitch selected sheets.
1. Select two or more sheet objects.

This enables the Stitch Sheets command on theModeler>Model Healing submenu.
2. ClickModeler>Model Healing>Stitch Sheets
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This displays a Stitch dialog with aMaximumStitch Tolerance field. The default value (auto)
comes from theHealing dialogOptions tab with Manual Healing selected. Youmay edit the
value in the Stitch dialog or in the Healing Options.

3. ClickOK.
This closes the dialog and attempts to perform stitching on the selected sheets. If the sheets
are separated beyond the stitch tolerance, stitching is not performed and a warning is issued.

Related Topics

Healing

Removing Selected Faces

Use theModeler>Model Healing>Remove Faces command to remove the selected faces. You

can also use the toolbar icon when you havemade an appropriate face selection .
If you find object-pair intersections that healing does not fix, or that can be fixed (by alignment), you
can correct the problem by one of the followingmethods.

1. Use theRemove Faces command (Modeler>Model Healing>Remove Faces) or by
performing Boolean subtract.

2. If overlap between objects is too large to be fixed by healing or by face alignment. Boolean
intersect shows the common portion between the bodies. In this case, use a subtract
operation to remove overlaps.

Related Topics

Align Faces
Analyzing Objects
Analyzing Interobject Misalignment
Analyzing SurfaceMesh
Healing an Imported Object
Healing
Technical Notes: Healing andMeshing
Technical Notes: HealingModels
Technical Notes: Error Types
Technical Notes: Detecting Errors

Removing Selected Edges

Use thisModeler>Model Healing>Remove Edges command to remove the selected edges. You

can also use the toolbar icon when you havemade an appropriate edge selection .
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Related Topics

Analyzing Objects
Analyzing Interobject Misalignment
Analyzing SurfaceMesh
Healing an Imported Object
Technical Notes: Healing andMeshing
Technical Notes: HealingModels
Technical Notes: Error Types
Technical Notes: Detecting Errors

Aligning Selected Faces

Use theModeler>Model Healing>Align Faces command to align the selected faces. You can

also use the toolbar icon when you havemade an appropriate face selection .

Related Topics

Technical Notes: Healing andMeshing
Analyzing Objects
Analyzing Interobject Misalignment
Analyzing SurfaceMesh
Healing an Imported Object
Healing
Technical Notes: HealingModels
Technical Notes: Error Types
Technical Notes: Detecting Errors
Set Material Override

Performing Explicit Subtractions

Use theModeler>Model Preparation>Perform Explicit Subtractions command to subtract
selected selected history tree objects.

1. Select two or more history objects.
This enables the Stitch Sheets command on theModeler>Model Preparation>Perform
Explicit Subtractions submenu. For example, consider the followingmodel.
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2. PerformExplicit Subtraction can be performed.

The results appear in the History tree as shown:
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TheMessage window also reports this action.

Modifying Objects
You can quicklymodify the position, dimensions, and other characteristics of objects created in the
Modeler window.

What do you want to do?
l Assign color to an object
l Assign transparency to an object
l Assigning a Cross Section and Dimension to a Polyline
l Copy and paste objects
l Delete objects
l Delete Last Operation
l Cutting Objects
l Move objects
l Rotate objects
l Change theOrientation of an object
l Mirror objects about a plane
l Offset an object (move every face of an object)
l Duplicate objects
l Scale the size of objects
l Sweeping objects
l Cover lines
l Cover faces
l Uncover faces
l Detach faces
l Detach edges
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l Create a new object by taking a cross-section of a 3D object
l Connect objects
l Move faces
l Move Edges
l Unite objects
l Subtract objects
l Create objects from intersections
l Create an object from a face
l Create an object from an edge
l Split objects
l Separate objects
l Convert polyline segments.
l Round the edge of an object (Fillet)
l Flatten the edge of an object (Chamfer)
l Wrap Sheet Command
l Imprint Projection Commands
l Imprinting anObject
l View and Edit Commands on History TreeObjects
l Purge History
l Generate History

Assigning Color to Objects

1. Select the object to which you want to assign a color.
Note If thePropertieswindow not visible on the desktop, clickView>Properties

Window.

2. In thePropertieswindow on the desktop, click theAttribute tab.
3. ClickEdit in theColor row.

TheColor palette appears.
4. Select a color from theColor palette, and then clickOK.

The color is assigned to the selected object.
5. ClickOK to close theProperties dialog box.

Related Topics

Setting the Default Color of Objects
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Setting the Default Color of Objects

1. ClickTools>Options>Modeler Options.
2. Click theDisplay tab.
3. SelectObject from theDefault color pull-down list.
4. Click the color button beside theDefault color pull-down list.

TheColor palette appears.
5. Select a color from theColor palette, and then clickOK.

Any objects you draw after this point are assigned the default color you selected.

Setting the Default Color of Object Outlines

1. ClickTools>Options>Modeler Options.
2. Click theDisplay tab.
3. SelectObject Wire from theDefault color pull-down list.
4. Click the color button beside theDefault color pull-down list.

TheColor palette appears.
5. Select a color from theColor palette, and then clickOK.

The outlines of any objects you draw after this point are assigned the default color you
selected.

Assigning Transparency to an Object

1. Select the object to which you want to assign a transparency.
Note If thePropertieswindow not visible on the desktop, clickView>Properties

Window or use Edit>Properties.

2. In theProperties dialog box, click theAttribute tab.
3. Click the value in the Transparency row.

TheSet Transparencywindow appears.
4. Move the slider to the right to increase the transparency of the object. Move the slider to the

left to decrease the transparency of the object.
5. ClickOK.

Related Topics

Setting the Default Transparency of Objects
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Setting the Default Transparency of Objects

1. Click Tools>Options>Modeler Options.
2. Click theDisplay tab.
3. Move theDefault transparency slider to the right to increase the transparency of objects.

Move the slider to the left to decrease the transparency of objects.
Any objects you draw after this point are assigned the default transparency you selected.

Copying and Pasting Objects

To copy objects and paste them in the same design or another design, use theEdit>Copy and
Edit>Paste commands. For data link purposes, where you want to include thematerial assignments
aswell as the geometry, you can use the Import fromClipboard command.
1. Select the objects you want to copy.

2. ClickEdit>Copy .
The objects are copied to the Clipboard, a temporary storage area. The selected items are not
deleted.

3. Select the design into which you want to paste the objects. It can be the same design from
which you copied the items.

4. Click in theModeler window.
5. Select the working coordinate system. Objects are pasted relative to the current working

coordinate system.

6. ClickEdit>Paste .
The objects appear in the new window.

Items on the Clipboard can be pasted repeatedly. The items currently stored on the Clipboard are
replaced by the next items that are cut or copied.

Related Topics

Duplicating Boundaries and Excitationswith Geometry

Copying an Image to the Clipboard

Use this command to copy a 3D view of the design, field plots, or 2D reports to the Clipboard and
paste it into another document, such asWord or PowerPoint.
To copy an image to the Clipboard:

1. Make the window of the image you wish to copy active.
This enables theEdit>Copy Image command in themenu bar.
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2. ClickEdit>Copy Image, or right click on the active window to display the shortcut menu and
selectCopy Image.
The report is copied to the Clipboard as an image.

3. Select and open the application into which you want to paste the objects, and paste the image.

Deleting Objects

1. Select the objects to delete.

2. ClickEdit>Delete .
l Alternatively, pressDelete.
The objects are deleted.

Note Tomaintain valid boundaries, excitations, or other parameters that were associated with
the deleted object, reassign them to other objects.

Related Topics

Deleting Start Points and Endpoints

Deleting Start Points and Endpoints

If you select a polyline in the history tree, theDelete Start Point andDelete End Point
commandsmay be enabled. These permit you to delete portions of the line.

1. In the history tree, locate the polyline that contains the segment you want to delete. Expand
this part of the history tree.

2. In the history tree, select the polyline you want to edit.
The segment is highlighted.

3. On theEditmenu or the shortcut menu, click eitherDelete Start Point to remove the
leading segments or Delete End Point to remove the following segments.
The designated segment is removed, and the line changes.

Deleting Last Operation

To delete the last operation on an object:
1. Select the object.
2. ClickModeler>Delete Last Operation.

This undoes the last operation, including removing that operation from the history, and
updating the context for theUndo andRedo commands.
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Related Topics

Undoing Commands
Redoing Commands

Cutting Objects

1. Select the objects to cut.
2. ClickEdit>Cut.

The objects are copied to the Clipboard and deleted from the design.

Moving Objects

1. Select the objects to move.

2. ClickEdit>Arrange>Move .
3. Select an arbitrary anchor point in one of the following ways:

l Click the point.
l Enter the point's coordinates in theX,Y, and Z boxes.

4. Select a target point in one of the following ways:
l Click the point.
l Type the coordinates of a point relative to the anchor point in the dX, dY, and dZ boxes,
where d is the distance from the previously selected point.

All selected objectsmove the distance determined by the offset between the anchor point and
the target point.

Rotating Objects

Rotate objects about the x-, y-, or z-axis using theEdit>Arrange>Rotate command.
To rotate objects about an axis:

1. Select the objects to rotate.

2. ClickEdit>Arrange>Rotate .
TheRotate dialog box appears.

3. Select the axis about which to rotate the objects:X, Y, or Z.
4. Type the angle to rotate the objects in theAngle box.

A positive angle causes the object to be rotated in the counter-clockwise direction. A negative
angle causes the object to be rotated in the clockwise direction.

5. ClickOK.
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The selected objects are rotated about the axis.
To rotate andcopy objects, use theEdit>Duplicate>Around Axis command.

Changing the Orientation of an Object

Each object has anOrientation property that specifies the coordinate system it uses is Global, or a
user defined orientation relative to the Global coordinate.
This property is useful in dealing with anisotropicmaterials. The properties of anisotropicmaterials
are specified relative to the objects orientation. Changing the orientation of an object provides a way
for objectsmade of the samematerial to be orientated differently.
To change an object’s orientation.

1. Define the coordinate systems you want to have available.
2. Open the properties window for the object.
3. Click on theOrientation property, and select from the Drop down list. If no Orientations other

thanGlobal have been defined, none appear on the list.
4. ClickOK to close the dialog and apply the changes.

Related Topics

AssigningMaterial Property Types
Setting Coordinate Systems
Creating a Relative Coordinate System

Mirroring Objects

Mirror an object about a plane using theEdit>Arrange>Mirror command. The plane is selected by
defining a point on the plane and a normal point. This command allows you tomove an object and
change its orientation.

Note The distance between the point on themirror plane and the point along the normal does
not matter — only the vector directionmatters.

Tomirror an object about a plane:
1. Select the object you want to mirror. You can select multiple objects.

1. ClickEdit>Arrange>Mirror .
2. Select a point on the plane on which you want to mirror the object.

You can do this by clicking a point, or typing coordinates in the X, Y, and Z boxes in the status
bar.
If you select a point on the object, themirroring is relative to that point on the object. In the
following example, the first point clicked after selectingEdit>Arrange>Mirror was on the
right-rear bottom corner of the selected object. So the axis of rotation as youmove the cursor
is that corner. As youmove the cursor, it drags a diamond-shape on a vector extending from
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the initial point. The distance along the vector does not matter. Moving themouse rotates an
outline of the object to new orientations. Clicking themousemoves the object to location
indicated by the outline.

In this second example, the initial point is at a distance from the original object, designated by
the triad fromwhich the handle for rotation extends to the dragging cursor.

3. Select a normal point in one of the following ways:
l Click the point.
l Type the coordinates of a point relative to the first point in the dX, dY, and dZ boxes, where
d is the distance from the previously selected point. As you type in the values, the outline
moves to the coordinates. Press the Enter key to complete the command.
Note For 2D designs, movement is restricted to the XY or RZ

plane.

The selected object ismoved to the plane you specified and oriented relative to the normal
point you specify.

Tomirror and copy objects about a plane, use the Edit>Duplicate>Mirror command.

Related Topics

Duplicating andMirroring Objects
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Offsetting Objects

Move every face of a 3D object in a direction normal to its surface using theEdit>Arrange>Offset
command. The faces aremoved a specified distance normal to their original planes. This command
enables you tomove every face of a solid object without having to individually select andmove each
face. Use theSurfaces>Move Faces>Along Normal command if you want to move just one or
more faces of an object.
To offset every face of an object:

1. Select the object you want to offset.
2. ClickEdit>Arrange>Offset.

TheOffset dialog box appears.
3. Type the distance you want to move the object faces from their origins, and then select a unit

from the pull-down list.
4. ClickOK.

The selected object's faces aremoved the distance you specified.

Duplicating Objects

You can duplicate objects within a design using theEdit>Duplicate commands. Duplicates are
dependent upon the parameters of their parent object at the time theywere created, that is, they
share the parent object's history at the time of creation. The command hierarchy in the history tree
shows the duplication command, illustrating which commands affect all duplicates (those performed
before the duplication) and which commands do not affect the duplicates (those performed after the
duplication). For example, if youmodify the radius of a parent object's hole, the change is applied to
the holes of the object's duplicates because they share the radius specification history, but if you
move the faces of the parent object, its duplicates are not affected because this operation took place
after the duplicateswere created.
Operations performed on duplicates are independent. For example, if you duplicate a cylinder twice,
creating a row of three, and then split the second cylinder, the first and third cylinders are not affected
by the split.
When creating duplicates, the parent object is duplicated along a line or around an axis the number
of times you specify. You can also create a single duplicate that mirrors the parent object about a
plane.
Choose from the following commands:

Edit>Duplicate>Along Line Duplicates the parent object along a straight line.
Edit>Duplicate>Around Axis Duplicates the parent object around an axis.
Edit>Duplicate>Mirror Duplicates amirror image of the parent object about a

plane.

To copy objects to another design, use theEdit>Copy andEdit>Paste commands.
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Note There is currently nomethod for dissolving the parent/duplicate relationship once a
duplicate has been created.

Duplicating Objects Along a Line

You can duplicate an object along a straight line using theEdit>Duplicate>Along Line command.
The line along which the object is duplicated can be vertical, horizontal, or lie at an angle.

1. Select the object you want to duplicate.

2. Click Edit>Duplicate>Along Line ..
3. Specify the vector along which the object is to be duplicated:

a. Select an arbitrary anchor point in one of the following ways:
l Click the point.
l Type the point's coordinates in the in theX, Y, and Z boxes.

Any point in the drawing region can be selected; however, selecting an anchor point on the
object's edge or within the object makes it easier to select the duplication line.

b. Select a second point in one of the following ways:
l Click the point.
l Type the coordinates of a point relative to the anchor point in the dX, dY, and dZ boxes.

This point defines the direction and distance from the anchor point to duplicate the object.

TheDuplicate along line dialog box appears.

4. Type the total number of objects, including the original, in the Total number box.
5. By option check theAttach to Original Object check box. If this is checked, no ports or

boundary conditions are duplicated for the child.
6. ClickOK.

The duplicates are placed along the vector you specified.

Duplicating Objects Around an Axis

To duplicate an object around the x-, y-, or z-axis, use theEdit>Duplicate>Around Axis
command.

1. Select the object you want to duplicate.

2. ClickEdit>Duplicate>Around Axis .
TheDuplicate Around Axis dialog box appears.

3. Select the axis around which you want to duplicate the object:X, Y, or Z.
4. Type the angle between duplicates in theAngle box.

A positive angle causes the object to be pasted in the counter-clockwise direction.

Drawing aModel 8-148
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

A negative angle causes the object to be pasted in the clockwise direction.
5. Type the total number of objects, including the original, in the Total number box.
6. By option check theAttach to Original Object check box. If this is checked, no ports or

boundary conditions are duplicated for the child.
7. ClickOK.

The object is duplicated around the axis at the angle you specified.

Duplicating and Mirroring Objects

To duplicate andmirror an object about a plane, use theEdit>Duplicate>Mirror command. The
plane is selected by defining a point on the plane and a normal point. This command allows you to
duplicate an object and specify the duplicate's position.
This command is similar toEdit>Arrange>Mirror, except that this command duplicates an object,
rather thanmoves it.

1. Select the object you want to mirror.

2. ClickEdit>Duplicate>Mirror .
3. Select a point on the plane on which you want to mirror the object.

A line drawn from this point to themirror plane will be perpendicular to the plane. The distance
between the point onmirror plane and point along the normal does not matter; only the vector
directionmatters

4. Select a normal point on the plane in one of the following ways:
l Click the point.
l Type the coordinates of a point relative to the first point in the dX, dY, and dZ boxes, where
d is the distance from the previously selected point.
Note For 2D designs, movement is restricted to the XY or RZ

plane.

A duplicate of the object appears on the plane you specified, oriented according to the normal
point you specified.

Related Topics

Mirroring Objects

Scaling Objects

Scale an object's dimensions in one or more directions using theEdit>Scale command.
The scale of an object is determined by the distance of each of its vertices from the origin of the
model coordinate system.When an object is scaled, the distance of each vertex from the origin is
multiplied by the scaling factor, causing the object to be resized and/or moved.
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For example, if you specify a scaling factor of 2 in the x direction, each vertex in themodel ismoved
so that the distance to its origin is doubled. A vertex located at the origin cannot not move. You can
alter an object's proportions by scaling it in one direction.
To scale an object's dimensions in one or more directions:

1. If necessary, set a different working coordinate system to achieve the desired scaling.
2. Select the object to scale.
3. ClickEdit>Scale.

TheScale dialog box appears.
4. Type the scale factor for each axis.
5. ClickOK.

The object is scaled about the working coordinate system's origin.

Related Topics

Modifying Object Attributes using the PropertiesWindow

Sweeping Objects

You can sweep a 2D object around an axis, along a vector, or along a path to create a 3D solid
object. Objects that can be swept include circles, arcs, rectangles, trapezoids, polylines, or any 2D
object created in the 3D Modeler window. The 2D object need not be orthogonal to the sweep path.
You can also thicken sheets tomake a 3D object.
You can also sweep open 1D objects, such as polylines. This results in open 2D sheet objects.
You can also sweep one or more faces of a 3D object to create a new object. See Sweep Faces
Along Normal.

Related Topics

Assigning a Cross Section and Dimension to a Polyline
Sweeping Around an Axis
Sweeping Along a Vector
Sweep Along a Path
Sweep Faces Along Normal
Thicken Sheet

Sweeping Around an Axis

Sweep a 1D or 2D object around the x-, y-, or z-axis using theDraw>Sweep>Around Axis
command. Sweeping circles around an axis is a convenient way to create an open coil loop.
Before using this command, keep the following guidelines in mind:
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l The object and the axis you are sweeping aroundmust lie in the same plane. For example, if
you are sweeping an object around the z-axis, the object must lie in a plane that includes the z-
axis, such as xz or yz.

l The normal of the object's plane facesmust be perpendicular to the axis around which you are
sweeping.

l The object may not cross the axis around which it is being swept.
To sweep an object around an axis:

1. Select the object you want to sweep.
2. ClickDraw>Sweep>Around Axis.

TheSweep Around Axis dialog box appears.
3. SelectX, Y, or Z as the Sweep axis.
4. Type an angle in theAngle of sweep text box, and select the unit of measurement. The value

must be between -360 and 360 degrees.
5. Type an angle in theDraft angle text box, and select the unit of measurement. This is the

angle to which the object's profile, or shape, is expanded or contracted as it is swept.
6. Select one of the following draft types from the pull-down list. The draft type instructs the

modeler how to fill in gaps created by expanding or contracting a profile with a draft angle.

Extended The edges of the new profile are extended with straight tangent lines until they
intersect. The facetting of the faceswill be displayed.

Round The edges of the new profile are rounded.

Natural The edges of the new profile are extended along their natural curves until they
intersect. For example, if the original object had sharp edges, the new profile
will have sharp edges.

7. Type the number of segments in theNumber of segments text box.
Note The default number of segments is zero, which creates a true path. A positive value

results in a segmented sweep, while a negative value results in an error.
If the sweep angle is 360 degrees, the number of segments is equal to the value
specified. If the sweep angle is less than 360 degrees, half segments appear at the
ends.
Projects and scripts from previous software versions are treated as if the number of
segments were zero.

8. ClickOK.
The object is swept around the axis. The new object has the properties of the original object.

Sweeping Along a Vector

Sweep a 1D or 2D object along a vector using theDraw>Sweep>Along Vector command.
1. Select the object you want to sweep.
2. ClickDraw>Sweep>Along Vector.
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3. Draw the vector you want to sweep the object along:
a. Select the start point by clicking the point or typing its coordinates in theX, Y, and Z boxes.

b. Select the endpoint in one of the following ways:
l Click the point.
l Type the coordinates of a point relative to the start point in the dX, dY, and dZ boxes.

TheSweep Along Vector dialog box appears.

4. Type the draft angle.
This is the angle to which the profile is expanded or contracted as it is swept.

5. Select one of the following draft types from the pull-down list box:

Extended The new object has sharp edges like the original object. The facetting of the
faces is displayed.

Round The new object has rounded edges.

Natural The new object has sharp edges like the original object

6. ClickOK.
The object is swept along the vector. The new object has the name and color of the original
profile.

Sweeping Along a Path

Sweep a 1D or 2D object along a path that is defined by an open or closed polyline using the
Draw>Sweep>Along Path command.

Note If the path curve is tangential to the sweep profile, then the sweep will
fail.

To sweep an object along a path:
1. Create the polyline you want to use as a path.
2. Select the object you want to sweep, and then select the new polyline.
3. ClickDraw>Sweep>Along Path.

TheSweep Along Path dialog box appears.
4. Type the angle of the twist in the path.

This is the number of degrees the profile will rotate as it is swept through the complete path.
5. Type the draft angle.

This is the angle to which the profile is expanded or contracted as it is swept.
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6. Select one of the following draft types from the pull-down list box:

Extended The new object has sharp edges like the original object. The facetting of the
faces is displayed.

Round The new object has rounded edges.

Natural The new object has sharp edges like the original object

7. ClickOK.
The object is swept along the path. The polyline object used as the path is deleted. The new
object has the properties of the original object. TheProperties dialog box appears, enabling
you tomodify the object’s properties.

Sweeping Faces Along Normal

To create a new object by sweeping select 3D object’s face a specified distance in a direction normal
to its original plane, use theModeler>Surface>Sweep Faces Along Normal command. Note that
the adjoining faceswill not be sheared or bent.
This command is useful for extruding faces, resizing holes, and removing rounded corners.
To sweep selected object faces in a normal direction:

1. ClickSelect Faces on the shortcut menu.
2. Select the faces of the object you want to sweep.
3. ClickModeler>Surface>Sweep FacesAlong Normal.
4. TheSweep FacesAlong Normal dialog box appears.
5. Type the distance you want to sweep the object face from its origin.
6. ClickOK.

The face is swept the distance you specified to create a new object.

Related Topics

Moving Faces Along the Normal

Thicken Sheet

To thicken a sheet object to make a 3D object:
1. Select the sheet.
2. ClickModeler>Surface>Thicken Sheet.

The Thicken Sheet dialog appears.
3. Specify the thickness by typing in the field.
4. Specify the units by selecting from the drop downmenu.
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5. If you want to thicken both sides, use the check box.
6. ClickOK.

The dialog closes and the sheet is changed into a 3D object of the desired thickness.

Wrap Sheet Command

You can useModeler>Surface>Wrap Sheet command to wrap a sheet object around a suitable
3D object. The sheet object does not have to be in contact with the 3D object. It should have smaller
dimensions than the 3D object.
When the sheet to be wrapped and the target body do not touch, the wrap sheet command chooses
among several different methods for bringing them into contact.

l If an edge from the sheet body and the target body are close enough and at a small angle (10
degrees), the edges are brought into alignment before the wrap.

l If a vertex from the sheet body and an edge on the target body are close enough, the vertex is
moved to the target edge.

l If the previous criteria are not matched, a vertex from the sheet body ismoved to the closest
face of the target body.

If both the sheet to be wrapped and the target face are both planar and have the same or opposite
normal, the closest vertex from the sheet body ismoved to the target face. Nomovement to or
alignment of edges is performed.
If the sheet body hasmultiple lumps, a single rectangle is fitted around all of the lumps. The rectangle
ismoved to the target surface using the above procedure.
If the sheet object does not overlap the corners of the 3D object, the wrap is straightforward, as
shown in the figure.

If you delete the 3D object, the wrapped sheet retains the form it tookwhen wrapped.
A sheet object that overlaps cornersmay not wrap in straightforward fashion, depending on both the
angle(s) involved, and the sheet object. While it is possible, it is not recommended.
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Examples:
The following figure illustrates wrapping on a target surface with the snap to an edge. The surface
will snap to an edge if close relative to length of edge. If the angle between the edge is less than 10
degrees, the edge to be wrapped will be aligned to the target body. In the example on the left, the
lower sheet has an edge anglemore than 10 degrees. The vertex will be snapped to the edge. The
top sheet in the picture has an edge angle of less than 10 degrees. The vertex is snapped to the
target edge and the sheet edge is aligned to the target. To avoid snapping to an edge or edge
alignment the wrap sheet can be put into contact with the target surface. In that case the sheet will
vertex will not bemoved to target edge unless it is within modeling tolerances.

The following figure shows the situation when youmove the edge to the edge before wrapping.

The following figure shows the situation when youmove a vertex to an edge before wrapping.
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The following figure shows the situation where youmove a vertex to a face before wrapping.

The figure below illustrates wrapping sheet onto cone. The sheet does not have line contact.

The following figure shows the situation when youmove amultilump sheet to touch the target body.
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The next figure illustrates wrapping to a non-developable surface. The area of sheet changed from
0.7000mm^2 before wrap to 0.6986mm^2 after.

The following figure illustrates wrapping on a target surface which has tolerant edges. The tolerant
edge is at the beginning of the wrap. The tolerant edge is not evident visually.

Limitations/Error Conditions:
l Wrapping on non-developable surfaces creates distortion in lengths.
l Wrapping is not allowed across curved boundaries between faces.
l Working with tolerant edgeswill work only if the gaps can be tightened sufficiently for the
operation.

l Wrapping on the pole of a surface (such as sphere or cone) is not supported. A warning is
given:WrapSheet: Wrapping sheet contacted pole of target surface. Recommendmoving
sheet and splitting out pole from target surface.

l The choice of method for how the sheet body ismoved to touch the target face is not directly
selectable by the user. If the sheet to be wrapped and target body touch, then the sheet body
is only rotated at point of contact.
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To wrap a sheet object:
1. Create a sheet close to an appropriate 3D object.
2. Select both objects.
3. ClickModeler>Surface>Wrap Sheet.

The sheet object wraps around the 3D object. You can select the wrapped sheet object and
the 3D object separately, and assign properties separately.
If the object cannot wrap, theMessage window contains a warning and description.
You can wrapmultiple sheets on the same 3D object.
If you delete the 3D object, the wrapped sheet retains the form it tookwhen wrapped.

You can use the Tools>Options>ModelerOptions to automatically perform a
Modeler>Boolean>Imprint command after performing aWrap.

Related Topics

Imprinting anObject
Modeler Options: Operation Tab

Covering Lines

To cover a closed 1D polyline object with a face, use theModeler>Surface>Cover Lines
command. The polyline object becomes a 2D sheet object.
To convert a polyline object to a sheet object:

1. Select the closed polyline object you want to cover.
2. ClickModeler>Surface>Cover Lines.

The object is now covered. It is now a 2D sheet object that can be swept to form a 3D solid
object.

Note If you want themodeler to automatically cover all closed polyline objects you draw,
including circles, ellipses, rectangles, and regular polygons, select theAutomatically
cover closed polylines option in theModeler Options dialog box. A closed polyline
object can also be created by using boolean unite operations on two or more polylines.

Covering Faces

To cover object faces, the facesmust be united into a 3D sheet object. To cover the face of a 2D or
3D object, use theModeler>Surface>Cover Faces command.
Covering the face of an open 2D sheet object that had previously been uncovered results in a 3D
solid object. For example, for a box, when you select and uncover a face, the solid box becomes a
sheet with five faces.When you then select that sheet body box and use the Cover Faces
command, the box becomes a solid again with six faces.
To cover the faces of objects:
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1. Select the faces of the objects you want to cover.
2. ClickModeler>Surface>Cover Faces.

The object faces are now covered.

Uncovering Faces

Uncover a surface of a 3D object using theModeler>Surface>Uncover Faces command.
Uncovering the surface of a 3D solid object results in an open 2D sheet object.
To uncover the face of a 3D object:

1. Switch to face selectionmode: ClickEdit>Select>Faces.
2. Select a face of the object you want to uncover.
3. ClickModeler>Surface>Uncover Faces.

The selected face is uncovered, leaving an open face on the object.
Note You can uncover one face of a 3D object at a time. If you select multiple faces, only the first

face will be uncovered.

Detaching Faces

TheModeler>Surface>Detach Faces command enables you to remove the face of a 3D object,
resulting in two separate objects.
To detach the face of an object:

1. Switch to face selectionmode: ClickEdit>Select>Faces.
2. Select the face of the object you want to detach. You can select multiple faces to detach.
3. ClickModeler>Surface>Detach Faces.

The selected face is now detached, resulting in two 2D sheet objects.

Detaching Edges

The Modeler>Edge>Detach Edges command enables you to remove an edge of a wire object,
resulting in two separate wire objects.
To detach an edge of an object:

1. Switch to edge selectionmode: ClickEdit>Select>Edges.
2. Select the edge of the object you want to detach. You can select multiple edges to detach.
3. ClickModeler>Edge>Detach Edges.

The selected edge is now detached, resulting in multiple wire objects.
Note Only edges fromwire bodies can be used in a detach edge

operation.
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Creating a Cross-Section

You can take a cross-section of a 3D object to create a new 2D object. This is done using the
Modeler>Surface>Section command.
Use this command to create cross-sections of 3D objects on the xy, yz, or xz plane. The cross-
sections are created as 2D closed polyline objects.
To create a cross-section of an object:

1. Make sure the working coordinate system you want to use for the cross-sectioning plane is
set.

2. Select the object fromwhich you want to create a cross-section.
3. ClickModeler>Surface>Section.
4. Select the section plane you plan to use to divide the object:XY, YZ, or ZX.
5. ClickOK.

A closed polyline object is created from the object that was sliced by the selected plane. The
original, sectioned object is unmodified.

Related Topics

Setting theWorking Coordinate System

Connecting Objects

Use theModeler>Surface>Connect command to perform the following operations:
l Connect two or more 1D polyline objects. Maxwell will modify the first polyline you select to be
a 2D sheet object that connects to the second and any subsequently selected polylines. The
second and subsequent polylines selected are deleted.

l Connect two or more 2D sheet objects. Maxwell will modify the first 2D object you select to be
a 3D solid object that connects to the second and any subsequently selected objects. The
second and subsequent objects selected are deleted.

To connect objects:
1. Select the objects you want to connect.
2. ClickModeler>Surface>Connect.

A new object is created that connects the objects you selected. The first object you selected
wasmodified to create the new object and all subsequently selected objects were deleted.

Moving Faces

You canmove the faces of a 3D object in a normal direction using theModeler>Surface>Move
Faces commands. Moving object faces enables you to resize, reshape, or relocate an object.
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Related Topics

Moving Faces Along the Normal
Moving Faces Along a Vector
Offsetting Objects
Moving Edges Along the Normal

Moving Faces Along the Normal

Tomove a 3D object’s face a specified distance in a direction normal to its original plane, use the
Modeler>Surface>Move Faces>Along Normal command. The faces that adjoin the original face
are extended or shortened along their own planes tomeet the new face. Note that the adjoining
faceswill not be sheared or bent.
This command is useful for extruding faces, resizing holes, and removing rounded corners, as
shown below.
Tomove an object face in a normal direction:

1. ClickSelect Faces on the shortcut menu.
2. Select the face of the object you want to move.
3. ClickModeler>Surface>Move Faces>Along Normal.
4. TheMove facesalong normal dialog box appears.
5. Type the distance you want to move the object face from its origin.
6. ClickOK.

The face ismoved the distance you specified.

Tomove every face of an object normal to its surface, use theEdit>Arrange>Offset command.

Related Topics

Moving Faces Along a Vector
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Offsetting Objects
Moving Edges Along the Normal

Moving Faces Along a Vector

Tomove the faces of a 3D object a specified distance along a vector use the
Modeler>Surface>Move Faces>Along Vector command. Each selected face ismoved along the
vector, normal to its original plane. The faces that adjoin the original face are extended or shortened
along their own planes tomeet the new face. Note that the adjoining faceswill not be sheared or
bent.
This command is useful for relocating holes in an object, as shown below.
Tomove an object face along a vector:

1. ClickSelect Faces on the shortcut menu.
2. Select the face of the object you want to move.
3. ClickModeler>Surface>Move Faces>Along Vector.
4. Specify the vector along which the face is to bemoved:

a. Select an arbitrary anchor point in one of the following ways:
l Click the point.
l Type the point's coordinates in the in theX, Y, and Z boxes.

Any point in the drawing region can be selected; however, selecting an anchor point on the
object's edge or within the object makes it easier to select the vector.

b. Select a second point in one of the following ways:
l Click the point.
l Type the coordinates of a point relative to the anchor point in the dX, dY, and dZ boxes,
where d is the distance from the previously selected point.

This point defines the direction and distance from the anchor point to move the face.

The face ismoved along the vector you specified.

Tomove every face of an object normal to its surface, use theEdit>Arrange>Offset command.
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Related Topics

Moving Faces Along the Normal
Offsetting Objects
Moving Edges Along the Normal

Moving Edges Along Normal

Tomove a 2D object’s edge a specified distance in a direction normal to its original plane, use the
Modeler>Edge>Move Edge command. The edge is extended or shortened along its own plane.
Note that the adjoining faceswill not be sheared or bent. The edge can be on a rectangle, an ellipse,
a circle, a regular polygon, or an equation based surface.
This command is useful for extending or shrinking faces and resizing holes.
Tomove an object edge in a normal direction:

1. ClickSelect Edge on the shortcut menu.
2. Select the edge of the object you want to move.
3. ClickModeler>Edge>Move Edge.

TheMove FacesAlong Normal dialog box appears.
4. Type the distance you want to move the object face from its origin.
5. ClickOK.

The edge of the object ismoved based on the value you specified.

Related Topics

Select Edges.
Moving Faces Along the Normal
Moving Faces Along a Vector
Offsetting Objects

Uniting Objects

To join two or more objects into one object, use theModeler>Boolean>Unite command. The new
object has the name, color, boundary, andmaterial assignment of the first object selected. The
objects are united at the point of intersection.
You can unite objects that do not touch.
To unite two or more objects:

1. Select the objects you want to join.

2. ClickModeler>Boolean>Unite ..
The objects are united.

Drawing aModel 8-163
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Note By default, the objects being joined to the first object selected are not preserved for later
use. If you want to keep a copy of the objects being joined to the first object selected, do
one of the following:

l Copy the objects, and then paste them back into the design after uniting them.
l SelectClone before unite in theModeler Options dialog box. This option instructs
themodeler to always keep a copy of the original objects being joined.

Subtracting Objects

1. Select the object fromwhich you want to subtract other objects.
2. Hold down theCtrl key and select the objects you want to subtract.

3. ClickModeler>Boolean>Subtract .
TheSubtract dialog box appears.
Objects listed in the Tool Parts list are subtracted from the object or objects listed in theBlank
Parts list.

4. Optionally, select an object name in either list, and use the left and right arrow buttons tomove
the object name to the opposite list.
l Alternatively, type the name of object you want to subtract in the empty box below the Tool
Parts list, and then type the name of the object fromwhich you want to subtract it in the
empty box below theBlank Parts list.

5. Optionally, selectClone tool objects before subtract. This instructsMaxwell to always
keep a copy of the original objects being subtracted.

6. ClickOK.
The new object retains the name, color, andmaterial of the first object selected.
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Note By default, the objects being subtracted from the first object selected are not preserved for
later use. If you want to keep a copy of the objects being subtracted from the first object
selected, do one of the following:

l Copy the objects, and then paste them back into the design after subtracting them.
l SelectClone before subtract in theModeler Options dialog box. This option
instructsMaxwell to always keep a copy of the original objects being subtracted.

Creating New Objects By Intersecting Objects

To create a new object from the intersection of two or more objects, use the
Modeler>Boolean>Intersect command.
To create an object from an intersection:

1. Select the objects fromwhich you want to take the intersection.

Warning If the objects you selected do not overlap, the result is a null object, and all objects
vanish.

2. ClickModeler>Boolean>Intersect .
The original objects vanish, leaving only the new object that was formed from their
intersection.
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Note By default, the original intersecting objects are not preserved for later use. If you want to
keep a copy of the objects that intersect the first object selected, do one of the following:

l Copy the objects, and then paste them back into the design after creating the new
object from the intersection.

l SelectClone before intersect in theModeler Options dialog box. This option
instructs themodeler to always keep a copy of the original objects that intersect the
first object selected.

Creating an Object from a Face

TheModeler>Surface>Create Object From Face command copies a selected face, resulting in a
new 2D sheet object.
To create a new object from a face:

1. Right-click in themodeler window, and selectSelect Faces on the shortcut menu.
2. Select the object face you want to copy. If you select multiple faces, each becomes a new

object.
3. ClickModeler>Surface>Create Object From Face.

The face is copied, resulting in a new 2D sheet object.

Hint This command is useful for assigning a boundary to the intersection of two faces. To do this,
first select the faces, and then create an object from them using the procedure above. Next,
make sure the Clone before intersect option is clear in theModeler Optionswindow, and
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then use theModeler>Boolean>Intersect command tomodify the object so that it includes
only the intersection of the two faces. Then assign the boundary to the new object.

Related Topics

Assigning a Cross Section and Dimension to a Polyline
Creating anObject from an Edge

Creating an Object from an Edge

TheModeler>Edge>Create Object From Edge command copies a selected edge, resulting in a
new 2D sheet object.
To create a new object from an edge:

1. Right-click in themodeler window, and selectSelect Edges on the shortcut menu.
2. Select the object edge you want to copy. If you select multiple edges, each becomes a new

object.
3. ClickModeler>Edge>Create Object From Edge.

The edge is copied. The resulting object appears in the history tree as a line object.

Related Topics

Assigning a Cross Section and Dimension to a Polyline
Creating anObject from a Face

Splitting Objects

To delete parts of an object that lie on the xy, yz, or xz plane, use theModeler>Boolean>Split
command.

1. Select the object you want to split. You can select more than one.

2. ClickModeler>Boolean>Split .
TheSplit dialog box appears.

3. Select theSplit plane that you plan to use to split the object.
4. SelectXY, YZ, or XZ as theSplit plane.
5. Select one of the followingKeep fragments options to specify which object fragments you

want to keep (those on the positive side of the selected plane, those on the negative side of the
plane, or all pieces on both sides of the plane):
l Positive side
l Negative side
l Both

6. Select one of the followingSplit objects options:

Drawing aModel 8-167
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l Split entire selection
Select this option if you do not want to preserve objects that are not crossing the split plane
and still part of the selection.

l Split objects crossing split plane
Select this option so that objects of the selection that do not cross the split plane are
preserved after the split operation is performed.
Note In previous versions of Maxwell, the split operation only affected the selected

objects that crossed the selected split plane. Other objects were ignored during
the operation. In complex geometries, youmaywant to select everything and
perform a split. In some cases, operations are still performed on selected objects
that do not cross the split plane (i.e., both parts are retained, yielding the original
object and an invalid object). Also, depending on the options specified, some
objects not crossing the split may be deleted.
TheSplit objects crossing split plane option allows you to identify selected
objects that do not cross the split plane and ignore them for the operation. For a
multiple selection, only those objects that cross the split plane are split; others are
kept intact. By design, splits in existing designs from previous versions are not
changed.

7. ClickOK.
The objects are divided along the split plane.

Separating Bodies

To separate an object with multiple lumps into individual bodies:
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1. Select the object you want to separate.
2. ClickModeler>Boolean>Separate Bodies.

The object is separated.

Converting Polyline Segments

A polyline is a single object that includes any combination of straight line, arc line, or spline segments.
You can convert a polyline segment from one type to another. The following conversions are
supported:

l Straight line segments to arc line or spline segments.
l Arc line segments to straight line or spline segments.
l Spline segments to straight line segments.

To convert polyline segments:
1. In the history tree, locate the polyline that contains the segment you want to convert. Expand

this part of the history tree.
2. In the history tree, right-click the polyline segment operation you want to change, and then

clickProperties.
The Properties dialog appears.

3. In theProperties dialog box, click in theValue box of theSegment Type row.
4. Select the desired polyline segment type from the pull-down list.

The polyline segment you selected is changed to the new type.
Note Converting an arc line or spline segment to a straight line segment results in two straight

line segments; one segment is created between the start point andmidpoint, and one
segment is created between themidpoint and endpoint.
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5. By default, curved surfaces are treated as smooth (True) surfaces. If segmented surfaces are
desired, enter an integer number in theNumber of Segments parameter.

6. ClickOK to dismiss the properties panel and implement the changes.
If the changes are not what was expected, undo the change using theEdit>Undo command
or pressCTRL-Z.

Related Topics

Assigning a Cross Section and Dimension to a Polyline
Creating SegmentedGeometry
Surface Approximation

Rounding the Edge of an Object (Fillet Command)

Note The Fillet commandmay only be applied to edges of 3D solid objects. Therefore, the
command is only available when working on a 3D Project.

The fillet command rounds the object at the original edges and vertices. Thismeans that the edges
and vertices are going to be replaced by new rounded surfaces, so that the original faces of the
object reconnect in a smoothmanner.

Vertices are only going to be replaced by new rounded surfaces if all the edges connecting to the
original vertex are selected; otherwise, the vertex is preserved but moved (if necessary). The edges
are replaced by quarter-cylindrical surfaces, of which the radius can be customized (see the Fillet
Radius property). Vertices are replaced bymore complicated new faces. You can control the
setback distance.
The fillet command is disabled if an edge is not selected.
To switch to edge selectionmode:

l Right-click the desktop, and selectSelect Edges from the shortcut menu.
To round an object's edge:

1. Select the edge you want to change.
The edge is highlighted, and the Fillet command is enabled.

2. ClickModel>Fillet, or click the Fillet the selected edges icon on the 3D Modeler
Blending toolbar.
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The Fillet Properties dialog box appears.
3. Enter a value for the Fillet Radius in the text field and select units from the drop downmenu.

The default ismillimeters.
4. Enter a value for the setback distance.

The setback distance controls the shape of the vertex. It is the distance of the cross curve from
the vertex at the end of the edge. If it is less than the fillet radius it has no effect. You will get an
error if it is greater than the length of the edge.

Note The setback feature works only on corners where three or more edgesmeet and only if all
edgesmeeting at the vertex are selected.

5. ClickOK to apply the change to the edge.
The dialog closes and the object is rounded by the radius value relative to the edge you
selected.

Flattening the Edge of an Object (Chamfer Command)

Note TheChamfer commandmay only be applied to edges of 3D solid objects. Therefore, the
command is only available when working on a 3D Project.

The chamfer command flattens the edges and vertices of the object. Thismeans that the edges and
vertices are replaced by new flat surfaces, so that the original faces of the object reconnect through
the newly introduced flat surfaces. Vertices are replaced by new flat surfaces only if all the edges
connecting to the original vertex are selected; otherwise, the vertex is preserved but moved (if
necessary).
Chamfers can be symmetric, or asymmetric.

The chamfer command is disabled if an edge is not selected.
To switch to edge selectionmode:

l Right-click the desktop, and selectSelect Edges from the shortcut menu.
To flatten an object's edge.

1. Select the edge you want to change.
The edge is highlighted, and theChamfer command is enabled.
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2. ClickModeler>Chamfer or click theChamfer the selected edges icon on the 3D
Modeler Blending toolbar.
TheChamfer Properties dialog box appears.

3. Type a value in the Left Distance text box, and select the units from the pull-down list.
4. ClickOK to apply the change to the edge.

TheChamfer Properties dialog box closes, and the object is flattened by the radius value
relative to the edge you selected.

To flatten an object’s edge for an asymmetric chamfer:
1. Select one or more edges and clickModeler>Chamfer to open theChamfer Properties

dialog.
2. Use the Chamfer type drop downmenu to select the type:

You control an asymmetric chamfer by selecting a type that defines the chamfer asymmetry as
Left-Distance Right Distance, as Left Distance-Angle, or asRight Distance Angle. Notice that
red directional arrows on the selected edges provide the direction against which left distance
and right distance are determined.
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Figure 8-2 Left Distance-RightDistance

Figure 8-3 Left Distance Angle
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Figure 8-4 Right Distance-Angle

Only symmetric and left distance-right distance chamfers are supported for edges formed by a
curved surface.

Angle-distance chamfers are not supported in such cases and do not appear on the Chamfer
Type drop downmenu.

3. ClickOK to apply the chamfer to the selected edges.

Imprinting an Object

TheBoolean>Imprint command lets you imprint the geometry of one object upon another. For
example, you could draw a polyhedron intersecting a cylinder, and then imprint the intersecting lines
on the cylinder.
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You can select the faces of the imprinted surface separately and assign properties as needed.

To imprint one object with another:
1. Select the intersecting objects.
2. ClickModeler>Boolean>Imprint...

This displays the Imprint dialog in which you designate which objects are the Blank Parts, and
which the Tool Parts. If necessary, you can select the objects in lists, and use the arrow keys
tomove them. If desired, you can clone the tool objects before the imprint operation.
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3. ClickOK.
This closes the dialog and performs the boolean imprinting.

After you perform the imprinting, the History tree retains the Imprint Object command and the create
command for the imprinted object

If you select the Imprint command in the History tree, you can suppress the command via the
Properties window. If you select the Create <object> icon for the object, you can edit the properties
of that object. The changes applied to the object carry over to the imprinting.

Related Topics

View and Edit Commands on History TreeObjects
Imprint Projection Commands

Imprint Projection commands

TheBoolean>Imprint Projection commands lets you project the form of one object to another
surface. The receiving surface can be curved or faceted.
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If the surface is curved, the dimensions of the projection will be affected.You can select the faces of
the imprinted object separately, and edit properties as needed.

If projected shape extends beyond the face of the receiving object, the shape wraps.
1. Select the intersecting objects.
2. ClickModeler>Boolean>Imprint Projection>Along Normal or

Modeler>Boolean>Imprint Projection>Along Direction...
If you selectAlong Normal, the projection occurs along the normal. If you select Along
Direction, you need to specify two points that describe the direction. Once you have defined a
line by clicking two points, you see a dialog for specifying the distance for the projection.

3. Specify a distance and select units from the drop downmenu and clickOK.
This closes the dialog and performs the boolean imprinting.

After you perform the imprinting, the History tree shows the Imprint Object command and the create
command for the imprinted object
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If you select the Imprint Projection command in the History tree, you can suppress the command via
the Properties window. If you select the Create <object> icon for the object, you can edit the
properties of that object. The changes applied to the object carry over to the imprinting.

Related Topics

View and Edit Commands on History TreeObjects
Imprinting anObject

Purging the History

Each object is a sequence of modeler-based operations. The history for each object is shown under
its name in themodel tree. You can use the Purge History command to remove the history of
operationswhile not affecting the geometry itself. This is useful when you want to perform healing
operations on the object. If there is an object for which you want to keep the history, you shouldmake
a copy of the object for that purpose before purging.
To purge the history:

1. Select the object.
2. SelectModeler>Purge History.

The history for themodel is purged, and the context for theUndo andRedo commands is updated.

Related Topics

Working with the History Tree
Generating History to Reproduce Portions of aModel

Generating History to Reproduce Portions of a Model

If a polyline object (line, spline, or arc), circle, or ellipse is imported or history was previously purged,
you can click on the polyline object and selectGenerate History to reproduce the individual line
segments used to create the polyline in themodel history tree.
To reproduce the line segments in themodel history tree:

1. Select the polyline object.
2. ClickModeler>Generate History.

Related Topics

Purging the History
Draw Polyline
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Modifying the Model View
You canmodify the view of contents in theModeler window without changing their actual
dimensions or positions.

What do you want to do?
l Change themodel view with Alt+double-click on areas in themodeler window.
l Set the View Options
l Rotate the view.
l Pan the view.
l Spin the view.
l Zoom in or out.
l Viewing 3D User InterfaceOptions
l Fit contents in the view window.
l Show or Hideobjects.
l Render objects aswireframes, flat-shaded, or smooth-shaded solids.
l Modify the view orientation.
l Modify the lighting.
l Set the projection view.
l Set the background color.
l Modify the appearance of the coordinate system axes.
l Modify the appearance of the grid.
l Set the Surface Visualization
l Setting a symmetrymultiplier
l UseClip Planes

Related Topics

Assigning Color to anObject
Assigning Transparency to anObject

Changing the Model View with Alt+Double Click Areas
In the following figure, the orientation of the colored boxes shows the ninemodel orientations you
can obtain by usingAlt + double click in the corresponding area of theModeler window.
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Related Topics

Rotate the view.

Apply an Orientation to the Current View
Right-click in theModeler window to see the View shortcut menu with theApply Orientation
command.
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You can also use the equivalent toolbar icons.

Possible orientations are Top, Bottom, Right, Left, Front, Back, Trimetric, Dimetric, and Isometric.
These last three differ as shown below.

After applying an orientation, you canView>Undo View:Orientation.
You can also use the right-clickView shortcut menu toAdd New Orientation.

Drawing aModel 8-181
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

The Name that you assign will appear on the ApplyOrientation commandmenu. You can specify
whether to Include Zoom/Pan and whether to SaveGlobal.

Related Topics

Change themodel view with Alt-double click on areas in themodeler window.

Viewing 3D User Interface Options

Use theView>Options command to open the 3D UI Options dialog box. This lets you set defaults
for the following view options:

l Stereo mode (Default is disabled)
Thismode is designed for stereo shutter glasses. It should remain disabled when not in use as
it causes blurring of the screen. Thismode requires special graphics hardware and drivers for
OpenGL page flipping. If you hardware does not support thismode, you will receive an error.

l Drag Optimization(Default is disabled)
l Show Ansoft logo in prints (Default is disabled)
l Default Color Key height - themaximumnumber of values displayed (Default is 16)
l UnderWhen there is a selection, youmay set the following:

l Selection always visible (Default is enabled)
l Set transparency of selected objects (Default is enabled with value set at 0.1)
l Set transparency of non-selected objects (Default is enabled with value set at 0.9)

l UnderDefault Rotation About, youmay select one of the following:
l Screen Center (Default)
l Current Axis
l Model Center
l Cursor

Rotating the View

You can rotate the view relative to theModel Center, the Screen Center, or the Current Axis.
When you select one of these as the View>Options default, theView>Rotate selectionmenu
changes to show that the Alt-Drag combination attaches to your selection.
To rotate themodel center from themenus or icons:

1. ClickView>Rotate>Rotate Model Center or click the icon on the toolbar.
2. Drag themouse in the direction you want to rotate the view.

The view rotates until you release themouse button.
3. To exitRotatemode, clickView>Rotate>Rotate Model Center again, or click the icon

again or pressESC.

Hint Alternatively, rotate the view using one of the followingmethods:
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l Hold down theALT key as you drag themouse.
l Right-click in the view window, and then clickView>Rotate on the shortcut
menu.

To rotate the view around the current axis:
1. ClickView>Rotate>Rotate Current Axis.

l Alternatively, right-click in the view window, and then clickView>Spin.

l Or, click the spin icon on the toolbar .
2. Drag themouse left or right at the speed you want to spin the view.

The view spins continually in the direction and at the speed you dragged themouse.
3. To stop spinning the view, click in the view window.
4. To endSpinmode, clickSpin again on theViewmenu or pressESC.

To rotate the view around the screen center:

1. ClickView>Rotate>Rotate Screen Center or click the rotate icon on the toolbar.
2. Drag themouse up and down at the speed you want to rotate the view.
3. To endRotatemode, clickView>Rotate>Rotate Screen Center, or click the icon again or

pressESC.

Related Topics

Pan the view

Panning the View

Tomove (pan) the view:

1. ClickView>Pan .
2. Drag themouse in the direction you want to pan the view.

The view will pan until you release themouse button.
3. To exit Panmode, clickPan on theViewmenu again or pressESC.

Hint Alternatively, pan the view using one of the followingmethods:
l Hold down theSHIFT key as you drag themouse.
l Right-click in the view window, and then clickView>Pan on the shortcut
menu.

Spinning the View

1. ClickView>Spin.
2. Click-and-drag themouse in the direction and at the speed you want to spin the view.

The view spins continually in the direction and at the speed you dragged themouse.
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3. To stop spinning the view, click in the view window.
4. To endSpinmode, clickView>Spin again, or pressEsc.

Hint Alternatively, right-click in the view window, and then clickView>Spin on the shortcut
menu.

Zooming In and Out

You canmagnify (zoom in) or shrink (zoom out) the contents in the view window using hot keys or
mouse zoommode.
To zoom in using hotkeys:

l Press the plus sign (+) or (=) keys or pressCtrl-E keys.
The view zooms in 5 percent.

To zoom out using hotkeys:
l Press theminus sign (-) key or press the Ctrl-F keys.
The view zooms out 5 percent.

To zoom using themouse.

1. ClickView>Zoom .
2. To zoom in, drag themouse towards the top of the view window. The contents of the view

expand as you drag.
To zoom out, drag themouse towards the bottom of the view window. The contents of the
view decrease in size as you drag.
When zooming on a view of model objects, the absolute size of themodel does not change.
When zooming on a 2D report, axis labels and ticks will adjust automatically during the zoom
operation and will rescale to their final value after the zoom operation is complete.

3. To end Zoommode, clickView>Zoom again, or pressEsc.

Hint Alternatively, zoom in or out on the view using one of the followingmethods:
l Hold down theALT+SHIFT keys as you drag themouse.
l Right-click in the view window, and then clickView>Zoom on the shortcut
menu.

Related Topics

Zooming In or Out on a Rectangular Area
Fitting Objects in the View Window

Zooming In or Out on a Rectangular Area

Tomagnify or shrink a specific rectangular area in the view window:
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1. ClickView>Zoom In or View>Zoom Out .
l Alternatively, right-click in the view window, and then clickView>ZoomIn or View>Zoom
Out on the shortcut menu.

2. Use themouse to draw a rectangle (or square) by selecting two diagonally opposite corners.
This is the area of magnification to be increased or decreased.
The rectangular area ismagnified or decreases in size.
When zooming on a view of model objects, the absolute size of themodel does not change.
When zooming on a 2D report, axis labels and ticks will adjust after the zoom operation is
complete.

3. To end Zoommode, clickZoom In or Zoom Out on theViewmenu again, or pressEsc.

Related Topics

Zooming In andOut
Fitting Objects in the View Window

Zooming In or Out using a Mousewheel

By clicking in theModeler window you can use themousewheel to zoom in and out of the 3D
Modeler window. The cursor location becomes the center relative to the zoom, rolling the wheel
forward increases the zoom, and rolling the wheel backwards decreases the zoom. If the window
includes a ruler display, this adjusts as you scroll in and out.

Fitting Objects in the View Window

What do you want to do?
l Fit all objects or traces in a view window.
l Fit selected objects in a view window.

Fitting All Objects in a View Window

To fit all the views: clickView>Fit All>All Views.
All view windows displaying the active design change to include all model objects.

To fit only the active view: clickView>Fit All>Active View.
The view in the activeModeler window changes to include all model objects.

Hint Alternatively, fit all objects in the active view window using one of the following
methods:

l PressCTRL+D.
l Right-click in the view window, and then clickView>Fit All on the shortcut menu.
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When Fit All is used in a report view, the window is automatically rescaled to fit all traces in the
window and the axis label and ticks are rescaled.

Related Topics

Fitting a Selection in a View Window

Fitting Selected Objects in a View Window

To fit one or more selected objects, 3D Components, or User DefinedModels in theModeler window
or to fit traces selected in the Reporter:

1. When you are working on amodel view, select the objects, 3D Components, or User Defined
Models you want to fit in the view.When you are working on a report, select the traces you
want to fit.
l To fit the selection in the active view window:Click View>Fit Selection>Active View.
l To fit the selection in every open view window of the active design:Click View>Fit
Selection>All Views.
Hint Alternatively, fit the selection in the active view window by clickingView>Fit

Selection on the shortcut menu.

To fit one or more objects or components selected in the History tree:
1. Select the objects or components of interest, and right click to display themenu.
2. Select View>Fit in Active View or Fit in All Views:

The view adjusts to fit the select objects.

Related Topics

Fitting All Objects in a View Window
ShowingOnly SelectedObjects in All or Active Views

Hiding Objects from View

To hide selected objects.
1. Select the object you want to hide from view.
2. ClickView>Visibility>Hide Selection and one of the following commands:

l All Views to hide the selected object in every open view window.
l Active View to hide the selected object in the active view window. You can also use CTRL-
H to hide a selected object.

You can also right-click in themodeler window for a short-cut menu and use theView
commands forHide Selection, or Show Only Selection.
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You can also use theHide icons in the toolbar to hide selected objects in all views or the active
view.

The objects you selected are hidden.
If there aremany objects, youmay find it easier to hide objects using theActive View
Visibilitydialog box. You can also chose to show only selected objects in all or active views,
effectively hiding all unselected objects.

Note Hiding boundaries also turns off a check for boundary overlaps during boundary
assignment. In the case of very largemodels with many boundaries, hiding boundaries can
prevent delays during boundary assignment. Full model validation will subsequently check
for boundary overlaps.

Object visibility is saved with the project.

Related Topics

ShowingObjects
ShowingOnly SelectedObjects in All or Active Views
Active View Visibility

Showing Objects

To show one or more objects that are currently hidden:

1. ClickView>Visibility>Active ViewVisibility , or click the toolbar visibility icon .
TheActive View Visibilitydialog box appears.

2. Select the tab for the objects you want to show or hide. The dialog contains tabs for:
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l 3D Modeler Objects
l ColorKeys
l MotionSetup Indicators
l Boundary Indicators
l Excitations Indicators
l Parameter Indicators
l FieldsReporter

3. Under the tab you need, select theVisibility option for the objects you want to show in the
active view window.
l For designswith large numbers of objects, you can resize the dialog for easier selection.
l By default, objects are listed in alphabetical order. You can invert the order by clicking the
Name bar above the Name fields. A triangle in the bar indicates the direction of the listing.

l You can also use theName field to type in an object name and apply the visibility via the
Show andHide buttons.

The objects you select and designate as Visible (by selecting the property or using Show)
reappear.

To show all objects that are currently hidden:
1. ClickView>Visibility>Show All and one of the following commands:

l All Views to show all objects in every open view window
l Active Views to show all objects in the active view window.
The selected objects reappear.

To show selected objects that are currently hidden:
1. Select the object. Hidden items are selected once the node corresponding to them is clicked in

the history tree.
2. ClickView>Show Selection and one of the following.

l All Views to show selected objects in every open view window
l Active Views to show selected objects in the active view window.
You can also use the toolbar icons toShow selected objects in all views andShow
selected objects in active views.
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The selected objects reappear.
To show one or more 3D components that are currently hidden:

1. In the history tree, select one or more 3D components. This activates the toolbar Hide/Show
icons and the View menu selections.

2. You can right click to display the shortcut menu and selectView>Show in Active View or
Show in All Views.

3. You can also use the Show/Hide toolbar icons.
Object visibility is saved with the project.

Related Topics

Hiding Objects
ShowingOnly SelectedObjects in All or Active Views
Active View Visibility

Active View Visibility Dialogue

If there aremany objects, it may be easier to show or hide objects using theActive View Visibility
dialog

1. ClickView>Visibility>Active View Visibility, or click the Hide/Show icon on themenu
bar.
TheActive View Visibility dialog box appears.
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2. Select the tab for the objects you want to show or hide. The dialog contains tabs for 3D
Modeler objects, Color Key objects, Boundaries, Excitations, and Fields Reporter objects.
l For designswith large numbers of objects, you can resize the dialog for easier selection.
l By default, objects are listed in alphabetical order. You can invert the order by clicking the
Name bar above the Name fields. A triangle in the bar indicates the direction of the listing.

l You can also use theName field to type in an object name and apply the visibility via the
Show andHide buttons.

3. Under the tab, clear theVisibility option for the objects you want to hide in the active view
window.
The objects you designate are hidden.

Note Hiding boundaries also turns off a check for boundary overlaps during boundary
assignment. In the case of very largemodels with many boundaries, hiding boundaries can
prevent delays during boundary assignment. Full model validation will subsequently check
for boundary overlaps.

Object visibility is saved with the project.

Related Topics

ShowingObjects
ShowingOnly SelectedObjects in All or Active Views
Hiding Objects

Showing Only Selected Objects in All or Active Views

To show only selected objects:
1. Select the object from the Project tree or history tree. Hidden items are selected once the

node corresponding to them is clicked in the history tree.
2. ClickView>Visibility>Show Selection and one of the following.

l All Views to show selected objects in every open view window
l Active Views to show selected objects in the active view window.
You can also right click, and use the shortcut menu:

3. You can right click to display the shortcut menu and selectView>Show in Active View or
Show in All Views.
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You can also use the toolbar icons toShow selected objects in all views andShow
selected objects in active views.

The selected objects reappear.

Active View Visibility Dialogue

If there aremany objects, it may be easier to show or hide objects using theActive View Visibility
dialog

1. ClickView>Visibility>Active View Visibility, or click the Hide/Show icon on themenu
bar.
TheActive View Visibility dialog box appears.

2. Select the tab for the objects you want to show or hide. The dialog contains tabs for 3D
Modeler objects, Color Key objects, Boundaries, Excitations, and Fields Reporter objects.
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l For designswith large numbers of objects, you can resize the dialog for easier selection.
l By default, objects are listed in alphabetical order. You can invert the order by clicking the
Name bar above the Name fields. A triangle in the bar indicates the direction of the listing.

l You can also use theName field to type in an object name and apply the visibility via the
Show andHide buttons.

3. Under the tab, clear theVisibility option for the objects you want to hide in the active view
window.
The objects you designate are hidden.

Note Hiding boundaries also turns off a check for boundary overlaps during boundary
assignment. In the case of very largemodels with many boundaries, hiding boundaries can
prevent delays during boundary assignment. Full model validation will subsequently check
for boundary overlaps.

Object visibility is saved with the project.

Related Topics

ShowingObjects
ShowingOnly SelectedObjects in All or Active Views
Hiding Objects

Rendering Objects as Wire Frames or Solids

To render (display) all objects in the view window aswireframe outlines or smooth-shaded solids:
1. ClickView>Render.
2. On theRendermenu, click one of the following:

l Wire Frame. The objects in the view window are displayed as skeletal structures, enabling
you to see all sides of the objects at one time.

You can also use the F6 key or the shade icon to toggle the display to wireframe.

l Smooth Shaded. The objects in the view window are displayed as shaded objects with
smooth edges.

You can also use the F7 key or the shade icon to toggle the display to smooth shaded.

To render a single object in the view window as awireframe outline:
1. Select the object you want to render as a wireframe:
2. In theProperties dialog box, under theAttribute tab, select the check box for theDisplay

Wireframe property.

Hint You can also pressF6 (Wire Frame) and F7 (Smooth Shaded) to toggle between
these two views.
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Related Topics

Setting the Default RenderingMode
Setting the Curved Surface Visualization

Setting the Default Rendering Mode

To set a default renderingmode for all objects created in the active design and in future designs:
1. ClickTools>Options>Modeler Options.

The Modeler Options dialog box appears.
2. Click theDisplay tab.
3. Select one of the following from the Default render mode pull-down list.

l Wire Frame. The objects in the view window are displayed as skeletal structures, enabling
you to see all sides of the objects at one time.

l Smooth Shaded. The objects in the view window are displayed as shaded objects with
smooth edges.

4. ClickOK.
The renderingmode is applied to all new objects you create.

Setting the Curved Surface Visualization

Maxwell allows you to specify the faceting for rendering true curves by using the
View>Render>Curved Object Visualization command. There are two options for control--
Maximum surface deviation andMaximumnormal deviation. This resembles theMesh surface
approximation settings. Reduce either or both of the allowed deviations to improve the image quality.
Improved image quality comes at the cost of increased CPU consumption. Changes apply to the
current model until they are changed again. Any changes reset the default.
This releasemoves to an ACIS R21 faceting algorithm and has new defaults:

l Relative 0.002mmsurface deviation and 30 degree normal deviation for 3D design
l Relative 0.002mmsurface deviation and 2 degree normal deviation for 2D design

Legacy projects with non default settings are approximately converted to new settingswith warning.
Overall faceting timemay be around 20%more but number of triangles should reduce.
The default gives satisfactory results (i.e. cpu/memory consumption vs. graphical display) for various
model complexities.
When you change CurvedObject Visualization settings and apply them to a design, those settings
are saved with design unless you change it again. That meanswhen you open the design again, it
will apply saved visualization settings and NOT the default settings. Because this affects the CPU
andmemory required to open the project, typically, you should not save a project with other than the
default settings.
To set the CurvedObject Visualization settings for the activemodeler window:
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1. ClickView>Render>Curved Object Visualization.
This command displays theCurved Object Visualization dialog for the activemodeler
window. The dialog contains areas for setting theMaximumDeviation, and theMaximum
Normal deviation.

2. Set theMaximumDeviation by first selecting from the radio buttons for Ignore, set as
Relative Deviation or set asAbsolute Deviation. Selecting the later two radio buttons
enables the value field.
When set asRelative Deviation, the actual surface deviation depends on themodel size. For
example, sphere with a radius of 10 has same number of facets as a sphere with a radius of 1.
Thismeans that CPU cost does not increase based on themodel dimension.
When set asAbsolute Deviation, themaximum surface deviation for both the sphereswill be
approximately same since a bigger sphere hasmore facets than a smaller one. Thismeans
that themost CPU cost applies to the larger objects.

3. If you selected the radio buttons for Relative or Absolute Deviation for MaximumDeviation,
enter a value in the field.

4. To change theMaximum Normal Deviation, enter a value in the text field. Units are
degrees.
Note Wire bodies cannot be rendered with aMaximumNormal Deviation value less than

1 degree.When using a setting less than 1 degree all wire bodies will be rendered
with a setting of 1 degree and all closed bodieswill be rendered with the dialog box
setting.

5. TheSave As Default button lets you Save any values you change to the drop downmenus
for the fields.

6. TheRestore Defaults button lets you return to the original values. Any values you provided
throughSave As Default remain on the drop downmenus for the fields for surface and
normal deviations

7. ClickApply to apply the current values to the activemodeler window, andClose orCancel to
close the dialog without changing settings.

Related Topics

Rendering Objects asWireframes or Solids

Using Clip Planes

TheView>Clip Plane command lets you define a clip plane that you can use to interactivelymake
any desired cut-away view of amodel. If you useEdit>Copy Image or Modeler>Export>image
formatwith the clip plane active, the image shows the clipped plane.When parts of themodel are
hidden by a clip plane, model selection works as though only the visible parts are present.
To add a clip plane:

1. ClickView>Clip Plane...
This displays theClip Plane dialog with the Plane tab selected.
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2. The Add button contains a drop downmenuwith choices for Specify center, normal, and
Use selection. Of you want to use selection, youmust first select a face or a cut plane.

l If you first select a face or cut plane, and then clickAdd>Use Selection, the clip plane is
added on that face.

a. If you selectAdd>Specify center, normal, this launches aMeasure dialog and enters a
mode for you click to first define the start location, shown as a triad. When youmove the
cursor, a rectangle represents the clip plane, and a vector the current direction.
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b. Click again to set the reference position.

After the second click, the clip plane is active. The handle is visible as a circle with a sphere
at the center, and an arrow pointing the normal for the plane. TheClip Planes dialog
shows the clip plane name, that it is enabled, shows the cap (which is the plane surface),
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and shows the handle.The Flip selection lets you reverse the direction of the clip plane. If
you uncheckShow cap and/or Show Handle, they disappear from the display.

3. With Show Handle enabled, you can use the handle tomanipulate the location and orientation
of the clip plane. The handle changes appearance and function relative to the position of the
cursor. Dragging the cursor makes use of the current function.

4. TheOptions tab for theClip Planes dialog contains four options.
l Force opaque for the unclipped portion.
l Disable clip plane when drawing a new clip plane.
l Plane handle color

The button shows the current color. Click the button to display a color selection dialog.
Select a default or custom color and clickOK.

l Plane handle radius.
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This slider lets you resize the radius of the handle to themost convenient size. The radius
resizes dynamically. When you close and reopen themodeler window, the last selected
size persists.

You can save your choices as new defaults.

Modifying the View Orientation

To change the orientation of the view (the viewing direction) in the view window:
1. ClickView>Modify Attributes>Orientation List.

TheUpdate View Orientation dialog box appears. It includes a table of names of nine basic
orientations (Top, Bottom, Right, Left, Front, Back, Trimetric, Dimetric, Isometric), any
additional orientations that you have added, and a section for adding new orientations. The
table includes columns that show the input angles, and the equivalent vector components.

2. Apply a default orientation to the view, or create and apply a new orientation.
3. ClickApply to View for the selected view to appear in the view window.

You can use theReset View Orientation button to restore the view to the original angle.
4. ClickMake Default if you want the selected viewing direction to be the initial viewing direction

when aModeler window is opened, either in the current project or future projects.
5. ClickClose to dismiss the dialog box.

The orientation you set is saved with the design. New orientations assigned to other designs
after this point do not affect this orientation.

Related Topics

Applying a Default View Orientation
Applying a New Orientation
Removing anOrientation

Applying a Default View Orientation

To apply a default viewing direction to the active view window:
1. ClickView>Modify Attributes>Orientation List.

TheUpdate View Orientation dialog box appears.
2. Click one of the orientation names listed in the orientation list.

l To view the associated vector components for the orientation you selected, select Input
vector components underAdd Orientation to List.

The Vx, Vy, and Vz components are displayed in the boxes on the left.

l To view the associated input angles for the orientation you selected, select Input angles
underAdd Orientation to List.
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The psi, phi, and theta components of the selected orientation are listed in the boxes on the
left.

3. ClickApply to View.
The selected orientation is applied to the active view window.
You can use theReset View Orientation button to restore the view to the original angle.

4. ClickClose.

Related Topics

Applying a New Orientation
Removing anOrientation

Applying a New View Orientation

To create and apply a new viewing direction to the active view window:
1. ClickView>Modify Attributes>Orientation.

TheUpdate View Orientation dialog box appears.
2. To create a viewing direction that is based on a default viewing direction, click the existing

orientation name in the viewing directions list.
To create a viewing direction based on the current view in theModeler window, clickGet
Current View Direction.
l Tomodify the selected orientation’s vector components, select Input vector components
underAdd Orientation to List, and thenmodify the values in theVx, Vy, or Vz text boxes,
and the Up vector boxes for Ux, Uy, and Uz.

l Tomodify the selected orientation’s input angles, select Input angles underAdd
Orientation to List, and thenmodify the values in the psi, theta, and phi text boxes.

3. Type a name for the new orientation in theName box.
4. ClickAdd/Edit.

The new orientation is added to the list of viewing directions.
5. ClickMake Default if you want the new viewing direction to be the initial viewing direction

when aModeler window is opened in the current project or future projects.
6. ClickClose.

Related Topics

Applying a Default View Orientation
Removing anOrientation
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Removing an Orientation

To remove a viewing direction from the list in the orientation settings dialog box:
1. ClickView>Modify Attributes>Orientation.

TheUpdate View Orientation dialog box appears.
2. Click the name of the viewing direction you want to delete from the orientation list.
3. ClickRemove.
4. ClickClose.

The viewing direction is removed from the list.
Note This operation cannot be

undone.

Related Topics

Applying a Default View Orientation
Applying a New Orientation

Modifying the Lighting

You have the option to emit the following types of light on a design:
l Ambient lighting surrounds themodel evenly with light. All objects are lit evenly in every
direction by a color of light that you specify.

l Distant lighting directs a ray of light at themodel in a direction you specify. By default, two
distant light vectors are in effect for every new view window.

Tomodify the lighting:
1. ClickView>Modify Attributes>Lighting.

The Lighting Properties dialog box appears.
2. SelectDo not use lighting to turn off ambient and distant lighting.

Clear this option to activate ambient and distant lighting.
3. To surround themodel with light, click theAmbient Light Properties color button, and then

select a color for the surrounding light from theColor palette.
4. Tomodify the distant light on amodel, do one of the following:

a. Add a new distant light by clickingAdd.
b. Copy an existing distant light that you intend tomodify by first selecting it from theDistant

Light Vectors table, and then clickingClone.
c. Select a default distant light to modify by selecting it in theDistant Light Vectors table.

5. For the selected distant light vector, specify the vector direction:
a. Tomodify the direction by specifying Cartesian coordinates, do one of the following:

l Enter the new Cartesian coordinates in theX, Y, and Z boxes.
l Use theVx, Vy, andVz sliders to specify the Cartesian coordinates dynamically.
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b. Tomodify the direction by specifying the spherical coordinates, do one of the following:
l Enter the new spherical coordinates in the φ and θ boxes.
l Use the φ and θ sliders to specify the spherical coordinates dynamically.

6. To revert to the default ambient and distant light settings, clickReset.
7. ClickSave as default if you want the new lighting settings to be the defaults for allModeler

windows, either in the current project or future projects.
8. ClickOK.

The lighting settings are saved with the design.

Note New lighting applied to other designs after this point, including new default settings, do not
affect these lighting settings.

Setting the Projection View

Tomodify the projection of model objects (the camera angle) in the view window:
1. ClickView>Modify Attributes>Projection.

TheSelect Projection Typewindow appears.
2. SelectPerspective to change the camera angle of the view.

l Move the slider to the right to increase the proximity, or widen, the view. Move the slider to
the left to decrease the proximity, or flatten, the view.

Objects that are closer appear larger relative to objects that are farther away.
3. SelectOrthographic to view themodel without distortion.

The slider is disabled because a distortion scale is no longer applicable.
4. ClickReset to return themodel to its original view.
5. ClickClose to accept the projection setting and dismiss the window.

TheSelect Projection Typewindow closes. The last view you specified in the projection
window remains visible in the view window.

The projection view you set is saved with the design.

Note New projection views assigned to other designs after this point do not affect this projection
setting.

Setting the Background Color

To set the color of the background in the view window:
1. ClickView>Modify Attributes>Background color.

TheSelect Background Color window appears.
2. To assign a solid background color, do the following:

a. SelectPlain Background.
b. Modify the background color in one of the following ways:
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l Click theBackground Color button, and then select a color from theColor palette.
l ClickOK.
l Use the RGB sliders underChange View Color Dynamically to specify the color's red,
green, and blue values.

3. To assign a background color that gradually changes from one color to another, do the
following:
a. SelectGradient Background.
b. Specify the background color at the top and bottom of the view window in one of the

following ways:
l Under Select Background Type, click the Top Color button, and select a color from
theColor palette. ClickOK. Then click theBottomColor button, and select a color from
theColor palette. Then clickOK.

l UnderChange View Color Dynamically, clickTop Color orBottom Color, and use
the RGB sliders to specify the color's red, green, and blue values.

4. ClickReset to revert to the default background colors.
5. ClickSave As Default if you want the new background color to be the background color for

allModeler windows in either the current project or future project.
6. ClickOK.

The background color you set is saved with the design.

Note New background color settings assigned to other designs after this point, including new
default settings, do not affect this design.

Modifying the Coordinate System Axes View

What do you want to do?
l Show or hide the coordinate system axes.
l Show the coordinate system axes for selected objects.
l Enlarge or shrink the size of the coordinate system axes.
l Show or hide the triad axes.

Showing or Hiding the Axes

1. ClickView>Coordinate System, then click one of the following:
l Hide to hide the x-, y-, and z-axes in the active view window.
l Show to display the x-, y-, and z-axes in the active view window.

Show the Axes for Selected Objects

1. ClickTools>Options>Modeler Options.
This displays theModeler Options dialog.
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2. Select theDisplay tab.
3. SelectShow orientation of selected objects.
4. ClickOK to close the dialog.

Enlarging or Shrinking the Axes

1. ClickView>Coordinate System, then click one of the following:
l Large to display the x-, y-, and z-axes as extending to the edges of the active view window.
l Small to display the x-, y-, and z-axes in a smaller size in relative to the edges of the active
view window.

Showing or Hiding the Triad Axes

The triad is a secondary depiction of the coordinate system that appears at the lower right of the
Modeler window. It shows the orientation of the currently selected working coordinate system. It can
be shown or hidden separately from the selected coordinate system.
To show the triad:

1. ClickView>Coordinate System>Triad, then click one of the following:
l Hide to hide the triad x-, y-, and z-axes at the lower right of the active view window.
l Show to display the triad x-, y-, and z-axes in the lower right active view window.
l Auto to generally hide the triad axes.

Choosing Grid Settings

The grid displayed in theModeler window is a drawing aid that helps to visualize the location of
objects.
For Cartesian grids, the location of points on the grid are defined by intersections of planes that are
perpendicular to and along the x-, y-, and z-axes. The division (the distance between neighboring
parallel planes perpendicular to the same axis) can be set.

For polar grids, the location of points on the grid are defined by intersections of planes that are
perpendicular to the local radius and angle coordinates. The division (the distance between
neighboring parallel planes perpendicular to the same radius and angle) can be set.
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Grid spacing is set according to the current project's drawing units.
You can control the following aspects of the grid:

l Type (rectangular or circular)
l Style (dots or lines)
l Grid Extent
l Density
l Spacing
l Visibility
l Snap settings
l Grid plane

Setting the Grid Type

1. ClickView>Grid Settings.
TheGrid Spacingwindow appears.

2. Select aGrid type for the active view window:Cartesian for a rectangular grid or Polar for a
circular grid.
The grid in the active view window is centered at the origin of the working coordinate system.

l For Cartesian grids, define a coordinate by specifying its relative distance from the
previously selected point in the dX, dY, and dZ text boxes.

l For polar grids, define a coordinate by specifying its radius from the origin in theR text
box and its angle from the x-axis in the Theta text box or its relative distance from the
previously selected point in the dR and dTheta text boxes.

Setting the Grid Style

1. ClickView>Grid Settings.
TheGrid Spacingwindow appears.
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2. Select one of the followingGrid styles for the active view window:

Dot Displays each grid point as a dot.

Line Displays lines between grid
points.

3. To show aminimal grid around existing objects, checkAuto adjust grid extents. To display
a grid as a plane, uncheck Auto adjust grid extents.

4. ClickOK.

Setting the Grid Density and Spacing

1. ClickView>Grid Settings.
TheGrid Spacingwindow appears.

2. If you want to change the density of the grid in the active view window as you zoom in or out on
objects, do the following:

a. SelectAuto adjust density to.
b. Specify a distance between grid points by typing a value in the pixels box.

The default is set to 30 pixels, which is generally the best setting for displaying objects.
The distance between grid points will increase and decrease proportionately as you zoom in
and out in the active view window.

3. If you do not want the grid density to change when you zoom in or out, but instead want to
specify a constant grid spacing, do the following:

a. Clear theAuto adjust density to option.
b. Specify the grid's spacing in the active design's units.

If you selected a Cartesian grid type, type the values of dX, dY, and dZ. These values
represent the difference between one grid point and the next in the x, y, and z
directions, respectively.
If you selected a polar grid type, type the values for dR and dTheta. dR represents the
difference between each radius. dTheta is the difference between angles.

4. ClickOK.

Setting the Grid's Visibility

To hide the grid, click the Grid toolbar icon: . Click it again to show the grid.
Alternatively:

1. ClickView>Grid Settings.
TheGrid Spacingwindow appears.
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2. To set Grid visibility:
l SelectShow to make the grid always visible in the active 3D Modeler window.
l SelectHide to make the grid always invisible in the active 3D Modeler window.
l SelectAuto so the grid appears only while you are drawing an object in the 3D Modeler
window.

3. ClickOK.

Related Topics

Setting the Grid Plane

Setting the Grid Plane

To specify the plane on which you want to display the grid in the active view window, do one of the
following:

l ClickModeler>Grid Plane, and then select a grid plane:XY, YZ, or XZ.
l Select a grid plane from the pull-down list on the 3D Modeler Draw toolbar.

Related Topics

ChoosingGrid Settings

Setting the Color Key Visibility

The color key (shown below) displays the range of plotted field values for a field overlay plot. It
displays the colors that correspond to the range of field values on the plot.

1. ClickView>Active ViewVisibility .

TheActive View Visibility dialog box appears.

2. Click theColor Keys tab.
3. In theVisibility column, select the field overlay or mesh plots in which you want to display the

color key. Clear the plots for which you want to hide the color key from view.
4. ClickDone to close the dialog box.

Alternatively, to hide the color key, right-click on the color key in the view window, and then
clickHide from the shortcut menu.
Only the color keys in the selected plots are visible.
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Related Topics

Modifying Field Plot Colors
Moving the Color Key

Setting a Plot's Visibility

To display or hide a field overlay or mesh plot from view in the 3D Modeler window:

1. ClickView>Active View Visibility . Alternatively, you can select the Active View
Visibility icon from the toolbar.
TheActive View Visibility dialog box appears.

2. Click the FieldsReporter tab.
3. In theVisibility column, select the field overlay or mesh plots you want to display. Clear the

plots you want to hide from view.
4. ClickDone.

Only the selected plots are visible.

Selecting Items in the Modeler Window
Tomodify or learnmore about an item's properties, youmust first select it. All commands you choose
while an item is selected are performed on or in reference to the selected item.
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What selection mode do you want to use?
l Select Objects.
l Select Faces.
l Select Edges.
l Select Vertices.
l Select Multi (a mode for selecting objects, faces, edges or vertices)
l Coordinates in the drawing space.
l Select By Area
l Select by Variable
l Selecting Objects byName
l Select by History Tree Folder
l Selecting the Face or Object Behind

Selecting Objects

By default, themodeler is in object selectionmode. Click an object in the view window or an object
name in the history tree to select it. All other objects become relatively transparent.
When themouse hovers over an object in the view window, the object is highlighted. This indicates
that it will be selected when you click it. Selected objects become the color specified under the
Display tab of theModeler Options dialog box.
Tooltips, as you hover the cursor over an entity, indicate the type/ID of entity (object name in the case
of objects, Face_id in the case of faces, and so on). This feature helps you distinguish between face-
of-sheet-object pick versus sheet-object pick.
If themodeler is not currently in object selectionmode, you can switch to it using one of the following
methods:

l Press the shortcut keyO.
l Right-click in the view window, and then clickSelect Objects.
l ClickEdit>Select>Objects.
l SelectObject from the pull-down list on the 3D Modeler Selection Mode toolbar.

Related Topics

Selecting Several Objects
Selecting Objects byName
Selecting All Faces of anObject
Creating anObject List
Selecting the Face, Edge, Vertex, or Object Behind
Select Edges.
Select Vertices.
Select Multi (a mode for selecting objects, faces, edges or vertices)
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Select By Area
Selecting Objects and Surfaces that Lie Inside Other Objects
Clearing a Selection

Selecting Several Objects

1. If you are selecting objects in theModeler window make sure that themodeler is in object
selectionmode by pressing the shortcut keyO. You can always select objects in the History
tree.

2. Select multiple objects in one of the following ways:
l Hold downCtrl, and click the objects in the view window that you want to select.
l Hold downCtrl, and click the object names in the history tree that you want to select.
l In the History tree, select a range of objects by first clicking one object to select it, and then
Shift-click to extend the selection of visible items.

l In the History tree, under Lists, select AllObjects. This is an automatically created list that
lets you selects all objects.

l ClickEdit>Select All to select all objects that were drawn in the active view window,
including objects that are not currently visible.

l ClickEdit>Select All Visible (or pressCtrl+A) to select all objects that are visible in the
active view window.

Selected objects become the color that is specified for selected objects under theDisplay tab
of theModeler Options dialog box. Use Tools>Options>Modeler Options to display the
dialog and set the default color. By default, the selected objects are opaque and all other
objects become relatively transparent.The settings for the relative opacity and transparency of
selected and non-selected objects also appear in the 3D UI Options dialog box. Use
View>Options to display the 3D UI Options dialog.

To deselect all objects, do one of the following:
l ClickEdit>Deselect All.
l PressCtrl+Shift+A.

Related Topics

Selecting Objects byName
Selecting All Faces of anObject
Creating anObject List
Selecting the Face or Object Behind
Select Edges.
Select Vertices.
Select Multi (a mode for selecting objects, faces, edges or vertices)
Select By Area
Selecting All Objects in a History Tree Folder
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Selecting Objects by Name

1. Make sure that Maxwell is in object selectionmode by pressing the shortcut keyO.

2. ClickEdit>Select>By Name

or in the toolbar, selectObject from the drop-downmenu to the right of the icon, then
click the icon.
TheSelect Object dialog box appears.

3. In theName list, click the name of the object you want to select. Use theCtrl key to select
more than one.
l Alternatively, type the name of an object you want to select in the empty text box, click the
right-arrow button, and select either Select orDeselect.

4. ClickOK.
The object is selected.

Related Topics

Selecting Several Objects
Selecting Objects byName
Selecting All Faces of anObject
Creating anObject List
Selecting the Face or Object Behind
Select Edges.
Select Vertices.
Select Multi (a mode for selecting objects, faces, edges or vertices)
Select By Area

Select By Area

You can select items by area in theModeler window clicking and rubber-band dragging around
objects. Rubber-band selection works differently depending on the drag direction.

l From right to left: Selects all the items that are wholly or partly enclosed within the rubber
band.
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l From left to right: Selects all the itemswholly enclosed within the rubber band.

Select By Areaworkswith Selectionmode for Objects, Faces, Edges, and Vertices, but not for
Select Multi. By default, only itemswith external surfaces are selected.
However you can control which objects to include or exclude from area selection based onmaterial,
object names, or object types.
To do this:

1. ClickEdit>Select By Area Filter to display this dialog:

2. CheckMaterial filters to enable the Include andExclude radio buttons. Use the text field to
specify filters by name, or use the ellipsis [...] button to display theMaterialsmanager for
selections.

3. CheckObject name filters to enable theExclude and Include check boxes, and text fields
in which you can specify object names.

4. CheckObject type filters to enable the check boxes for includingSolids, Sheets, and/or
Lines.
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5. CheckSelect front entities only to select only objects that are in front.
6. If you clickSave As Default, the settings persist for the project until you change the settings

andSave as Default again.
7. ClickOK to close the dialog.

Now, when you left-click and drag around an area, those objects whichmeet the filter criteria are
highlighted in theModeler window, and those objects are shown as selected in the History tree.

Related Topics

Selecting Items in theModeler Window
SelectingMultiple Objects
Selecting Objects byName
Selecting All Faces of anObject
Creating anObject List

Selecting All Objects in a History Tree Folder

The history tree organizes objects in several categories. Right click on the group for solids, sheets,
lines, non-model objects, or unclassified objects to see a shortcut menu command that lets you
Select Allmembers of that category.
Under each folder, you can alsoSelect All for objects of the same thematerial or parts of the same
assignment at once.When you right-click on a solid folder, themenu lets you checkwhether to
organize objects by assignment. For example, this history tree has Solids organized by object.

This history tree hasOrganize Objects byMaterial selected.

This history tree organizes Sheet objects by object.
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This history tree hasOrganize Sheets by Assignment selected.

Selected objects are highlighted in themodeler window view area.

Related Topics

SelectingMultiple Objects
Selecting Objects byName
Select By Area
Selecting All Faces of anObject
Creating anObject List
Setting the Default Color and Transparency of SelectedObjects
Setting the Default Color of HighlightedObjects
Working with the History Tree

Setting the Default Color and Transparency of Selected Objects

To set the color of objects when they are selected:
1. ClickTools>Options>Modeler Options.

TheModeler Options dialog box appears.
2. Click theDisplay tab.
3. ClickSelect on theDefault color pull-down list.
4. Click the color button beside theDefault color pull-down list.

TheColor palette appears.
5. Select a color from theColor palette, and then clickOK.

Any objects you select after this point will temporarily become the default color you selected.
By default, Maxwell shows selected objects as nearly opaque and shows non-selected objects as
nearly transparent. This features helps you distinguish between selected and non-selected objects.
To set the transparency of selected and non-selected objects:

1. ClickView>Options.
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The 3D UI Options dialog appears. TheWhen there is a selection region contains check
boxes for setting the transparency for selected and non-selected objects.

2. Click the check box for the value you want to change.
This enables the value field. The default transparency for selected objects is 0.1, whichmakes
them almost opaque. The default transparency for non-selected objects is 0.9, whichmakes
them highly transparent.

3. Enter a new value, and clickOK to apply the new transparency values.

Setting the Default Color of Highlighted Objects

1. ClickTools>Options>Modeler Options.
TheModeler Options dialog box appears.

2. Click theDisplay tab.
3. ClickHighlight on theDefault color pull-down list.
4. Click the color button beside theDefault color pull-down list.

TheColor palette appears.
5. Select a color from theColor palette, and then clickOKto return to the Modeler Options

dialog box.
6. ClickOK.

Outlines of all object you hover over temporarily become the default color you specified above.

Creating an Object List

Create an object list when you want to define a list of objects. Creating an object list is a convenient
way to identify and select a group of objects for a field plot or calculation. Objects in a list can still be
treated as separate objects. The same object can be included in several different lists.
To create an object list:

1. If you are selecting in theModeler window, make sure that themodeler is in object selection
mode by pressing the shortcut keyO. This is not necessary for selecting in the History tree.

2. Select the objects you want to include in the list.
3. ClickModeler>List>Create>Object List.

The object list is created with the default nameObjectlistn. It is listed in the history tree under
Lists. Selecting an object list displays the properties of that list in the Properties window. One
of the properties is a list of objects contained in the list.
To rename theObject list, edit the Name property in thePropertieswindow for the list. Object
lists are sorted in alphanumeric order.

The object list is treated as one volumewhen you are plotting and performing fields calculations. It is
listed in theGeometrywindow of the Fields Calculator when you selectVolume.
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There is an automatically created list called AllObjects. Selecting it selects all objects. If a list contains
mixed types of geometry, for example, volume and sheet objects, the volume calculation only uses
the geometry of the highest dimension in plots or integral, and so forth.
Example: To plot the E-field on a surface formed by the intersection of the xy-plane and several
objects, first define a list of these objects. Then, when plotting fields, select the object list name from
theGeometrywindow of the Fields Calculator. Fields are plotted only at the intersection of the plane
and the objects in the list.

Related Topics

ReassigningObjects to Another Object List
Using or Viewing List Objects

Reassigning Objects to Another Object List

You can assign objects after you have created object lists. Creating an object list is a convenient way
to identify and select a group of objects for a field plot or calculation. Objects in a list can still be
treated as separate objects. The same object can be included in several different lists.
To reassign objects to an existing object list:

1. If you are selecting in theModeler window, make sure that themodeler is in object selection
mode by pressing the shortcut keyO. This is not necessary for selecting in the History tree.

2. Select the objects you want to reassign.
3. ClickModeler>List>Reassign

A dialog with the existing object lists is displayed. (They appear in the history tree under Lists.)
One of the Properties in for the List shows the objects contained in the list.

4. Select the list to which you want to assign the select object and clickOK.
The object is reassigned to the selected list, replacing previous list members. TheObjects
Property in for the List shows the objects contained in the list.

The object list will be treated as one volumewhen you are plotting and performing fields calculations.
It will be listed in theGeometrywindow of the Fields Calculator, when you selectVolume.

Related Topics

Creating anObject List
Using or Viewing List Objects

Using or Viewing List Objects

To view the objects included in anObject list:
1. In themodel tree, expand the Lists tree.
2. Right-click the list you want to select, and clickSelect Assignment.
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The objects that are included in that list are highlighted in themodeler, and the properties
appear in the desktop.

To view the properties of the object list (including a list of the objects included):
1. In themodel history tree, expand the Lists tree.
2. Under Lists, right-click the list object you want to view, and clickProperties.

ThePropertieswindow appears for that object list. The objects included are listed in the
Objects row.

3. ClickOK orCancel to close thePropertieswindow.
To use an object from a list in another operation:

1. In themodel tree, expand the Lists tree.
2. Right-click the list you want to select, and clickSelect Assignment.

The objects that are included in that list are highlighted in themodeler, and the properties
appear in the desktop.

3. Select any other objects you want to use in the operation.
4. Complete the operation.

For example, you could select an object list and another object, and then specify one of the boolean
commands (such as unite or subtract).

Selecting Faces

If themodeler is in face selectionmode, click an object face in the view window to select it. To select
multiple faces, hold theCtrl key as you click the faces. You also have the option to create face lists,
which define a list of object faces, or you canmake face selections from a Face ID list in the By Face
dialog.
Switch to face selectionmode using one of the followingmethods:

l ClickEdit>Select>Faces.

l Select Face from the pull-down list to the right of the select objects icon in the 3D
Modeler Selection toolbar.

l Right-click in the view window, and then clickSelect Faces. (Not available when working on a
2D Design)

l Press the shortcut keyF. (Not available when working on a 2D Design)
You can also select faces in the Select Multi mode.
When themouse hovers over a face in the view window, that face is highlighted, which indicates that
it will be selected when you click. Selected faces become the color specified under theDisplay tab of
theModeler Options dialog box. All other objects and faces become relatively transparent.
To select faces touching the current selection:

l ClickEdit>Select>Select Connected Faces.
To select faces that touch each other:
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l ClickEdit>Select>Select Face Chain. This option allows faces that are part of a
"protrusion" to be selected.

You can also use theBy Face dialog to select from a list of faces associated with an object:
1. To use the dialog, no objects should be selected to start.

2. ClickEdit>Select>By Face or in the toolbar, select Face or Multi from the drop-down

menu to the right of the icon, and click the icon.
This displays theSelect Face dialog. This contains a list of the available objects.

3. Select an object in the Object Name list.
The Face ID list is then populated with the faces in that object.

4. Selecting a face ID from the list highlights the face in the 3D window. Use Ctrl-click to select
additional faces, or shift-click to select a range of faces.

Related Topics

Selecting All Faces of anObject
Selecting the Face, Edge, Vertex, or Object Behind
Selecting Faces byName
Selecting Faces by Plane
Creating a Face List
Face Selection Toolbar Icons
Select Edges.
Select Vertices.
Select Multi (a mode for selecting objects, faces, edges or vertices)

Selecting All Faces of an Object

This option allows you to select all faces of an object after first selecting the object or a single face.

Note This options is not available when working on a 2D
Design.

1. Optionally, select the object (or objects, faces, edges or vertices) with the faces you want to
select.

2. Switch to face selectionmode by pressing the shortcut keyF.
3. If an object is not selected, click a face on the object of interest.
4. ClickEdit>Select>All Object Faces.

l Alternatively, right-click in the view window, and then clickAll Object Faces on the
shortcut menu.

l As another alternative, you can use the face selection toolbar icons.
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All the faces of the object are selected. If you selectedmultiple objects, all faces of those
objects are selected.

Related Topics

Selecting Faces
Selecting the Face or Object Behind
Creating a Face List
Face Selection Toolbar Icons

Selecting Faces by Name

1. Make sure that themodeler is in face selectionmode by pressing the shortcut keyF.

2. ClickEdit>Select>By Name or in the toolbar, select Face from the drop-downmenu to

the right of the object selection icon and click the icon.
TheSelect Face dialog box appears.

3. In theObject name list, click the name of the object with the face you want to select.
The object’s faces are listed in the Face ID column.

4. Click the face you want to select in the Face ID column. You can select more than one.
The face is selected in the view window.

5. ClickOK.

Related Topics

Selecting Faces
Creating a Face List

Selecting Faces by Plane

To select a face that is aligned with a global plane, use one of the following twomethods.
1. Make sure that themodeler is in face selectionmode by pressing the shortcut keyF.
2. In the History Tree, expand thePlanes icon. Left-click on a plane (Global:XY, Global:YZ, or

Global:XZ) to display the selected global plane.
3. On theEditmenu, point toSelect, and then clickFaces on Plane.

The selected faces are highlighted.
Alternativemethod:
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1. In the History Tree, expand thePlanes icon.
2. Right-click on a plane (Global:XY, Global:YZ, or Global:XZ) to select the global plane and

display a pull-downmenu.
3. On the pull-downmenu, clickFaces on Plane.

The selected faces are highlighted.

Related Topics

Selecting Faces
Creating a Face List
Select Multi (a mode for selecting objects, faces, edges or vertices)

Face Selection Toolbar Icons

While working on analyzing complex objects, it is sometimes useful to examine faces, edges and
vertices. In particular it is useful to find the connected faces for a face or edge or vertex, connected
edges for a face/edge/vertex and connected vertices for a face/edge/vertex. The additional selection
modes are available under Edit->Select and via the toolbar icons.
Selecting an object face enables the face selection icons in the toolbar.

You can use these icons tomodify the selection:
l Select face chain selects faces that touch each other. It allows faces that are part of a
"protrusion" to be selected.

l Select connected faces selects faces connected to the current selection.
l Select connected edges selects the edges of the selected face or faces.
l Select vertices selects the vertices of the selected face or faces.

Related Topics

Selecting All Faces of anObject
Selecting the Face or Object Behind
Selecting Faces byName
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Selecting Faces by Plane
Creating a Face List
Select Edges.
Select Vertices.
Select Multi (a mode for selecting objects, faces, edges or vertices)

Creating a Face List

Create a face list when you want to define a list of object faces. Creating a face list is a convenient
way to identify and select a specific set of surfaces for a field plot or calculation. The same face can
be included in several different lists.
To create a face list:

1. Make sure that themodeler is in face selectionmode by pressing the shortcut keyF.
2. Select the object faces you want to include in the face list.
3. ClickModeler>List>Create>Face List.

The face list is created. It is listed in the history tree under Lists. The default name is Facelistn.
The lists appear in alphanumeric order. To change the name of a face list (for example, to a
name describing the listed faces as ports or boundaries), select the list in the History Tree and
Edit Properties. Editing the Name property changes the name. If necessary, the list order in
the History tree changes for the new name.

The face list is treated as one selection of surfaceswhen you are plotting and performing fields
calculations. The face list will be listed in theGeometrywindow of the Fields Calculator when you
selectSurface.

Selecting Edges

If themodeler is in edge selectionmode, simply click an object's edge in the view window to select it.
To select multiple edges, hold theCTRL key as you click the edges.
When themouse hovers over an edge in the view window, that edge is highlighted, indicating it is
click-able. Selected edges become the color specified under theDisplay tab of theModeler
Options dialog box. All other objects become relatively transparent.
Switch to edge selectionmode using one of the followingmethods:

l ClickEdit>Select>Edges.
l SelectEdge from the pull-down list in theModeler Selection Mode toolbar.
l Right-click in themodeler window, and then clickSelect Edges.
l Press the shortcut keyE.

Selecting an edge enables the following toolbar icons.
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You can use these icons tomodify the current selection.
l Select edge chain selects the edges that touch the selected edge.
l Select connected faces selects faces touching to the current selection.
l Select connected edges selects the edges that touch the current selection.
l Select vertices selects the vertices of the selected edge or edges.

Related Topics

Moving Edges Along the Normal
Selecting All Faces of anObject
Selecting the Face or Object Behind
Selecting Faces byName
Selecting Faces by Plane
Creating a Face List
Select Edges
Selecting All Edges of anObject
Select Vertices
Select Multi (a mode for selecting objects, faces, edges or vertices)

Selecting All Edges of an Object or Face

This option allows you to select all edges of an object or face after first selecting the object or face.
1. Select the object or face with the edges you want to select.

Youmay also select a single edge of the object or face.
2. ClickEdit>Select>All Object Edges or Edit>Select>All Face Edges.

l Alternatively, right-click in the view window, and then clickAll Object Edges or All Face
Edges on the shortcut menu.

All the edges of the object or face are selected. If you selectedmultiple objects, all edges of
those objects are selected.
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Related Topics

Selecting Faces
Selecting the Face or Object Behind
Creating a Face List
Face Selection Toolbar Icons

Selecting Vertices

If themodeler is in vertex selectionmode, simply click an object's vertex in the view window to select
it. To select multiple vertices, hold theCtrl key as you click the vertices.
When themouse hovers over a vertex in the view window, that vertex is highlighted, which indicates
that it will be selected when you click. Selected vertices become the color specified under the
Display tab of theModeler Options dialog box. All other objects become relatively transparent.
Switch to vertex selectionmode using one of the followingmethods:

l ClickEdit>Select>Vertices.
l SelectVertex from the pull-down list in theModeler Selection toolbar.
l Press the shortcut keyV.

Selecting a vertex enables the following selection icons.

You can use these icons tomodify the current selection.
l Select connected faces selects faces touching to the current selection.
l Select connected edges selects the edges that touch the current selection.
l Select vertices selects the vertices of edges that touch the current selection.

Related Topics

Selecting All Faces of anObject
Selecting the Face or Object Behind
Selecting Faces byName
Selecting Faces by Plane
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Creating a Face List
Select Edges
Select Vertices
Select Multi(a mode for selecting objects, faces, edges or vertices)

Selecting Multi (a Mode for Selecting Objects, Faces, Vertices or Edges)

The Select Multi mode permits you to select objects, faces, vertices, or edges, depending on where
you click. This very useful in conjunction with MeasureMode, for measuring the distances between
different entities. Enter Select Multi mode by one of the followingmethods:

l Press the shortcut keyM.
l Right-click in the view window, and then clickSelect Multi.
l On theEditmenu, point toSelect, and then clickMulti.
l SelectMulti from the pull-down list in the 3D Modeler Selection toolbar.

With Multi mode active:
l To select a vertex, click near a vertex, within 10 pixel radius.
l To select an edge, click near an edge (and 10 pixels away from vertex).
l To select an object, click little farther from edge, between 10 and 20 pixels.
l To select a face, click anywhere else on the interior of face.

Tooltips, as you hover the cursor over an entity, indicate the type/ID of entity (object name in the case
of objects, Face_id in the case of faces, and so on). This feature helps you distinguish between face-
of-sheet-object pick versus sheet-object pick.
By holding down the Ctrl key, you canmakemultiple selections.

Related Topics

Controlling the Selection in Multi Mode

Controlling the Selection in Multi Mode

You can control the behavior of thismode by clickingEdit>Select Multi Mode Settings. This
displays a dialog with check boxes for Object, Face, Edge, and Vertex. Unchecking a box cancels
the selection behavior for that category.
You can also control the behavior of thismode by clicking the icons for Object, Face, Edge, and
Vertex to the right of theMulti mode selectionmenu. To add theMulti Mode selectionmenu and
icons to the toolbar:

1. Select Tools>Customize.
This displays theCustomize dialog with the Toolbars tab selected.

2. Select 3D Modeler Selectionmode from the toolbars list by checking it.
This adds theMode selectionmenu and icons to the toolbar.
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You can also add theMode selectionmenus from the Commands tab by selecting 3D Modeler
Selection from the Category list, and dragging the icons to the toolbar.

3. WhenMulti is selected as themode, you can enable or disable Object, Face, Edge, or Vertex
selection by clicking the associated icon.

Related Topics

Selecting All Faces of anObject
Selecting the Face or Object Behind
Selecting Faces byName
Selecting Faces by Plane
Creating a Face List
Select Edges
Select Vertices
Selecting the Face or Object Behind
Clearing a Selection
MeasureModes

Selecting Groups and Submodels

With group selectionmode, the parent group of selected object is selected. Selecting group
highlights all children under the group in theModeler window. If you click an object that has not been
assigned to a group, nothing is selected.To select multiple groups, hold theCTRL key as you click
the groups.
To set the selectionmode to Group:

l From themenu bar, clickEdit>Select>Groups
l Press the "G" key to enter group selectionmode.
l From the 3D Modeler window context menu, selectGroup

If your design contains submodels, you can set the selectionmode to Submodel.
l From themenu bar, clickEdit>Select>Submodel
l Press the "U" key to enter Group selectionmode.
l From the 3D Modeler window context menu, selectSubmodel

Related Topics

Selecting the Face or Object Behind
Select Multi (a mode for selecting objects, faces, edges or vertices)

Clearing a Selection

To clear an object, face, edge, or vertex selection, do one of the following:

Drawing aModel 8-224
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l Click the view window at a location where no objects exist.
l To clear an object selection, click a point away from the object name in the history tree.
l ClickEdit>Deselect All.
l PressCtrl+Shift+A.
The items are no longer selected.

Selecting the Face, Edge, Vertex, or Object Behind

To select the face, edge, vertex, or object behind another selected face, edge, vertex, or object, do
one of the following:

l ClickEdit>Select>Next Behind.
l Right-click in the view window and clickNext Behind.
When there aremultiple faces behind, the one selected is relatively close to where you right-
click.

l Press the shortcut keyB.
When there aremultiple faces behind, the one selected is relatively close to the cursor.

l PressCtrl+B.
This option is useful when you are trying to select a face, edge, vertex, or object that is in the
interior of amodel, or when you do not want to change themodel view to select an item.

Related Topics

Selecting Objects and Surfaces that Lie Inside Other Objects

Selecting the Edges of the Problem Region

If you have excluded the background object from your model, do not assign boundary conditions or
sources to it.

Selecting Objects and Surfaces That Lie Inside Other Objects

To select objects and surfaces that lie inside other objects (such as an object that lies within an air
box, a conductive shield, or the background object), do one of the following:

l Make the objects on the outside of themodel invisible using theView>Visibility commands.
This is useful when you want to select objects using themouse. Since themouse cannot
select invisible objects, you can select the interior surfaces or objects by clicking on them.

l Use theEdit>Select>By Name command to select objects or surfaces inside themodel.
l Use theNext Behind command on the shortcut menu. This selects the object that lies behind
the one you initially selected. This command does nothing if no objects have previously been
selected.
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Related Topics

Selecting the Face or Object Behind

Using the Mouse to Select Objects

To select objects or surfaces, do one of the following:
l Click the object directly.
l Right-click an object or surface, and use one of theSelect commands on the shortcut menu.

The following commands appear on the shortcut menu:
l Select Objects
l Select Faces
l Next Behind: Use this command to select the object or face that lies behind the currently
selected object or face. This command chooses objects or faces depending on the
graphical pickmode.Next Behind does nothing if no object has previously been selected
or if the object you select has nothing behind it. You can also use the keyboard shortcutB.

l All Object Faces
l Faces on Plane

The snapmode defines how items are selected by themouse. By default,Grid andVertex snaps
are enabled.

Selecting Objects by Variable

You can select an object based on a variable that affects it. If your design includes variables, you do
so as follows:

1. ClickEdit>Select>By Variable.
This displays the Select by Variable dialog, which lists the variables in your design. Both
columns are sortable by clicking the header. You can resize andmove the dialog.When you
next open it, it uses that size and location.

2. Select the variable of interest, and clickOK.
The dialog closes, and the object affected by the variable is highlighted in theModeler window.
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TheMessage window contains a reference that you can select and use to go to the affected
object.

If you execute the command again, without clearing the current selection(s), the additional
object can be highlighted. You can resize andmove the dialog.When you next open it, it uses
that size and location.

Assigning Coordinates to New Objects
When you insert and draw new 3D, 2D, or 1D objects in the geometrymodel, you need to define
coordinate systems and locations of points, distances between objects, and other geometry items.

l Setting the Reference Point
l Defining Cartesian Coordinates
l Defining Cylindrical Coordinates
l Defining Spherical Coordinates
l Defining Relative Coordinates
l Defining Absolute Coordinates

Setting the Reference Point

When you draw objects, the cursor’s location is always relative to a reference point. The reference
point is displayed with amini xyz-axis:

To change the reference point:
1. Select the drawing command to use.

TheMeasure Data dialog opens. As youmove the cursor over themodeler window, the top
line in themeasure dialog shows the coordinates of the current reference point.

2. Move the cursor to the desired reference point and pressCtrl+Click or right click and select
Set Reference Point from the short cut menu.
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Thismoves the reference point marker to the new location. TheMeasure Data dialog
updates. The coordinates boxes in the Status bar change to accept relative distance
information. If you choose, rather than setting the reference point with the cursor, you can
press Tab to activate a text cursor in the status bar fields, and enter coordinates directly.

Related Topics

Assigning Coordinates to New Objects
Choosing theMovement Mode
Choosing Snap Settings
DrawingObjects

Defining Cartesian Coordinates

When drawing an object, define a point using Cartesian coordinates by typing its distance from the
origin in theX, Y, and Z boxes, respectively. When defining a second point, specify its distance from
the previously defined point in the x, y, and z directions in the dX, dY, and dZ boxes, respectively.

1. Select the desired drawing command.
2. SelectCartesian from the pull-down list on the status bar.
3. Type the point's x-, y-, and z-coordinates in theX, Y, and Z text boxes.

Hint PressTab to move from one coordinate text box to the next. PressShift+Tab to move
to the previous coordinate text box.

l Alternatively, click the point in the view window.
4. When drawing objects other than polylines, the second point you select is relative to the first

point. Type the second point's distance from the previously selected point in the dX, dY, and
dZ boxes.

Related Topics

Selecting Cylindrical Coordinates
Selecting Spherical Coordinates

Defining Cylindrical Coordinates

To define a point using cylindrical coordinates, specify the point's radius, measured from the origin, in
theR box, the angle from the x-axis in the Theta box, and the distance from the origin in the z
direction in the Z box.When defining a second point, specify its distance from the previously defined
point in the in dR, dTheta, and dZ boxes.

1. After clicking the desired drawing command, selectCylindrical from the pull-down list on the
status bar.
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2. Type the point's r-, theta-, and z-coordinates in theR, Theta, and Z boxes.

Hint PressTab to move from one coordinate box to the next. PressShift+Tab to move to
the previous coordinate box.

l Alternatively, click the point in the view window.
3. When drawing objects other than polylines and helices, the second point you select is relative

to the first point. Type the second point's distance from the previously selected point in the dR,
dTheta, and dZ boxes.

Related Topics

Selecting Cartesian Coordinates
Selecting Spherical Coordinates

Defining Spherical Coordinates

To define a point in spherical coordinates, specify the point's radius, measured from the origin, in the
R box, the angle from the z-axis in the Theta box, and the angle rotated counter-clockwise (CCW)
from the x-axis in thePhi box.When defining a second point, specify its distance from the previously-
defined point in the in dR, dTheta, and dPhi boxes.

Note Even though you are inputting spherical coordinates, all data is internally stored in
Cartesian coordinates.

To define a point in spherical coordinates:
1. After clicking the desired drawing command, selectSpherical from the pull-down list on the

status bar.
2. Type the point's r-, theta-, and phi-coordinates in theR, Theta, andPhi boxes.

Hint PressTab to move from one coordinate box to the next. PressShift+Tab to move to
the previous coordinate box.

l Alternatively, click the point in the view window.
3. When drawing objects other than polylines and helices, the second point you select is relative

to the first point. Type the second point's distance from the previously selected point in the dR,
dTheta, and dPhi boxes.

Related Topics

Selecting Cartesian Coordinates
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Selecting Cylindrical Coordinates

Using Absolute Coordinates

When entering a point's coordinates, you can specify them in absolute or relative coordinates.
Absolute coordinates are relative to the working coordinate system's origin (0, 0, 0). This is the
default setting for the first point you select after clicking a drawing command. Relative coordinates
are relative to the reference point, or the previously selected point, represented by a small coordinate
system on the user interface.
To enter a point's absolute coordinates:

1. Click the desired drawing command.
2. SelectAbsolute from theAbsolute/Relative pull-down list on the status bar.
3. Specify the point's coordinates in one of the following ways:

l Click the point.
l Type the point's coordinates in the appropriate boxes on the status bar.

Note When drawing objects other than polylines and helices, by default, the second
point you select is relative to the first point;Relative is automatically selected in
theAbsolute/Relative pull-down list in the status bar. Be sure to select
Absolute from theAbsolute/Relative pull-down list in the status bar if you want
the second point to be relative to the working coordinate system.

Related Topics

Selecting Relative Coordinates

Using Relative Coordinates

When entering a point's coordinates, you can specify them in absolute or relative coordinates.
Relative coordinates are relative to the reference point, or the previously selected point. Absolute
coordinates are relative to the working coordinate system's origin (0, 0, 0).
To enter a point's relative coordinates:

1. Click the desired drawing command.
2. SelectRelative from theAbsolute/Relative pull-down list on the status bar.

When you are in relativemode, the text boxes for a coordinate show an “d” before the
coordinate description, to indicate “distance from” the working reference. For example:

3. Specify the point's coordinates in one of the following ways:
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l Click the point.
l Type the point's coordinates in the appropriate boxes in the status bar.

Related Topics

Selecting Absolute Coordinates

Choosing the Movement Mode
When drawing objects, the cursor's location is always relative to a reference point. The reference
point is displayed with amini xyz-axis:

To change the reference point, move the cursor to the desired point and pressCtrl+Enter.
You canmove the cursor to one of the following points:

l In the same plane as the reference point (in-planemovement mode).
l Perpendicular to the reference point (out-of-planemovement mode).
l If an object is present to snap to a point in 3D space (3D movement mode).
l Along the x-axis
l Along the y-axis
l Along the z-axis

Changes youmake to themovement mode persist until you change them again.

Moving the Cursor In Plane

Tomove the cursor to a point on the same plane as the reference point:
1. Click the desired drawing command.
2. Do one of the following:

l ClickModeler >Movement Mode>In Plane.
l Click In Plane in themovement mode pull-down list in the 3D Modeler Draw toolbar.
The next point you select will be on the same plane as the reference point.

The cursor's location, displayed with a black diamond that indicates it has snapped to the grid, is on
the same plane as the reference point.
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Moving the Cursor Out of Plane

Tomove the cursor to a point on a line that is perpendicular to the drawing plane and that intersects
the reference point:

1. After clicking the desired drawing command.
2. Do one of the following:

l clickModeler>Movement Mode>Out of Plane.
l ClickOut of Plane in themovement mode pull-down list in the 3D Modeler Draw toolbar.
A dashed line is displayed between the reference point and the cursor's location, which is now
on a line that is perpendicular to the drawing plane and that intersects the reference point.

The cursor's location, displayed with a black diamond that indicates it has snapped to a grid, is on a
line that is perpendicular to the drawing plane and that intersects the reference point.

Moving the Cursor in 3D Space

Tomove the cursor to a point in 3D space relative to the reference point:
1. Click the desired drawing command.
2. Do one of the following:

l ClickModeler>Movement Mode>3D.
l Click 3D in themovement mode pull-down list in the 3D Modeler Draw toolbar.

If one of an object's snapping centers is within snapping range, the cursor snaps to the nearest
point in 3D space occupied by the object.
If any of the objects has a snapping center not within snapping range, the 3D movement mode
is identical to the in-planemovement mode.
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The cursor's location, displayed by a circle that indicates it has snapped to a face center, is
(0.5, 0.5, 1.0), a point in 3D space.

Moving the Cursor Along the X-Axis

Tomove the cursor to a point away from the reference point in the x direction:
1. Click the desired drawing command.
2. Do one of the following:

l ClickModeler>Movement Mode>Along X Axis.
l Press and hold down the shortcut keyX.
l SelectAlong X Axis from theMovement mode pull-down list on theModeler Draw
toolbar.

The next point you select will be on the same plane as the reference point in the positive or
negative x direction.
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Moving the Cursor Along the Y-Axis

Tomove the cursor to a point away from the reference point in the y direction:
1. Click the desired drawing command.
2. Do one of the following:

l ClickModeler>Movement Mode>Along Y Axis.
l Press and hold down the shortcut keyY.
l SelectAlong Y Axis from theMovement mode pull-down list on theModeler Draw
toolbar.

The next point you select will be on the same plane as the reference point in the positive or
negative y direction.

Moving the Cursor Along the Z-Axis

Tomove the cursor to a point away from the reference point in the z direction:
1. Click the desired drawing command.
2. Do one of the following:

l ClickModeler>Movement Mode>Along Z Axis.
l Hold the shortcut keyZ.
l SelectAlong Z Axis from theMovement mode pull-down list on theModeler Draw
toolbar:

The next point you select will be on the same plane as the reference point in the positive or
negative z direction.
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Choosing Snap Settings
By default, the selection point and graphical objects are set to "snap to", or adhere to, a point on the
grid when the cursor hovers over it. The coordinates of this point are used, rather than the exact
location of themouse. The cursor changes to the shape of the snapmodewhen it is being snapped.
To change the snap settings for the active design, you can use either theModelermenu or the
toolbar icons :

1. ClickModeler>Snap Mode or click the toolbar icons.
If you select themenu command, theSnap Mode dialog box appears.

2. Specify the snapmode settings you want.

l If you want the cursor to snap to a point on the grid, selectGrid or the icon .

l To snap to a vertex, selectVertex or the icon .

l To snap to the center point of an edge, selectEdge Center or the icon . The center
point may be on a 1D, 2D, or 3D object edge.

l To snap to the center of an object face, select Face Center or the icon .

l To snap to the nearest quarter point on an edge, selectQuadrant or the icon .

l To snap to the center of an arc, selectArc Center or the icon .
When the cursor snaps to a point, it changes to one of the following snapmode shapes:

Note By default, themouse is set to snap to the grid, a vertex, an edge center, a face center, and
the nearest quadrant. Tomodify the default snap settings for the active design and all new
designs, modify the selections on theSnap panel under the 3D Modeler options.
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Related Topics

Snap Setting Guidelines

Snap Setting Guidelines

For each object (3D, 2D, or 1D), you can define snapping points. Then, whenmoving in theModeler
window, if the cursor approaches a snap point (gets closer in terms of screen coordinates, not 3D
coordinates), the snap point is highlighted. If you then click it, it becomes selected, even if that point is
out of the plane you are working in (for example, even if the point has 3D coordinateswhen you are
working in a 2D plane).
In general, select at least one of the snap options in theSnap Mode dialog box. If none of these
options are selected, the software is in "freemode" and selects whatever point you click, regardless
of its coordinates. This can cause problemswhen you are trying to create closed objects. Although
the point you select may appear to be the vertex point of an open object, youmay not have actually
clicked the exact coordinates of the point.

Measure Modes for Objects
TheMeasuremodes lets youmeasure the position, length, area, and volume of objects. With two
faces selected, with two edges selected, or with an edge and a face selected, theMeasureMode
displays the angle and distance between them. TheMeasure Positionmode dynamicallymeasures
the distance between a reference point and the cursor location. You can Pause dynamic tracking in
order to copy text information from theMeasure Data dialog, and then Resume dynamic updating.

1. To access theMeasuremode, either:
l SelectModeler>Measure.
l Right-click and selectMeasure from the short-cut menu.
After you selectMeasure, a cascadingmenu appears for Position, Edge, Face and Object.
You can also select using the equivalent toolbar icons:

2. SelectPosition to obtain location and distance formation between a specified reference point
and the cursor location.
TheMeasure Information dialog box appears.
WithMeasure>Position selected, the information displayed includes:
l The location of the reference point. (Position1)
l The current cursor location. (Position2)
l The distance between the Reference and Current location.
l The X distance.
l The Y distance.
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l The Z distance.
l The angle between the current reference point and the current cursor location.

Note As youmove the cursor, theMeasure Information dialog displays the current
cursor location andmeasurement information from the reference. Clicking on a
new vertex updates the reference to the new location.

To pause the dynamic tracking, either right-click and selectPause, or press P.

While paused, you canmove the cursor without changing theMeasure Data. You can also cut
and paste.

Press P or right-click and selectResume to resume cursor tracking.
With Measure>Edge, Face, orObject selected, the information displayed for each selected
object is the name and:
l The area and volume of a 3D object.
l The area of a face.
l The length of a polyline (in edge selectionmode, you can still see this if you select the
polyline in the History tree)
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l The length of an edge
l The location of a vertex.
For more information on cursor and reference point behavior in thismode, seeMeasuring
Position and Distance

3. To useMeasure>Edge, Face, orObject to measure the distance and angle between two
selected items:
l Select two points. Click the first and Ctrl-click to select the second.

TheMeasure Information dialog displays the coordinates of each point, the distance
between the points and the angle betweenOrigin-P1, Origin-P2 line.

l Select two faces, theMeasure Information dialog displays the angle/distance between
them.

l The function is similar when you select two edges and when you select an edge and a face.
l You can alsomeasure distance between vertex/face, vertex/edge. In these cases, use the
Select Multi mode.

4. To exit theMeasuremode, clickClose on theMeasure Information dialog.

Related Topics

Measuring Position and Distance
Setting Coordinate Systems
Modifying the Coordinate SystemAxes View
Choosing Snap Settings
ChoosingMovement Mode (3D, in plane, X, Y, or Z)
Select Multi (a mode for selecting objects, faces, edges or vertices)

Measuring Position and Distance

Tomeasure the distance between any cursor location relative to a designated reference point:
l SelectModeler>Measure>Position or use the equivalent toolbar icon:

This enables theMeasure Positionmode and opens theMeasure Data dialog. The dialog lists
the coordinates of the current reference point (Position1)and the cursor location (Position2). If
you click, it shows the last position as a red square, and the current position as a black cursor.
It also lists the distance between those points, the X, Y, and Z distances, and the angle
between them. You can Pause dynamic tracking in order to copy text information from the
Measure Data dialog, and then Resume dynamic updating.
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The shortcut menu displays the Hints item.WhenHints are on (the default), a text display in
the lower right of the 3D Modeler window, explaining how to set the reference point, and ways
to control themovement mode.

l The reference point is displayed as amini x-y-z-axis:

Use Ctrl-Click to set the reference point at a new location.
l The cursor leads a diamond-shape selectionmarker that snaps from grid point to grid point.
TheMeasure Data dialog also provides a text identification of the current grid points. If you
drag the cursor off design objects, by default, it moves in the xy-plane. You can restrict
movement to in a specific plane, out of plane, or z,x, or y. Besides the context menu for
movement, you can also use the X, Y, and Z keys to restrict movement. SeeChoosing a
Movement Mode. for further details.
If you drag the selectionmarker over an object, it follows the 3D surfaces of the object,
dropping a dashed reference line to a point on the current plane. The cursor changes shape to
provide information about the object at the corresponding coordinate:

Tomeasure the distance between two points:
1. SelectModeler>Measure>Position to enter Measure Positionmode.
2. Ctrl-click to set the reference point.
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The reference point displaymoves to the selected point. This becomes the coordinate for
Position1 in theMeasure Data dialog.

3. Drag the cursor to the second point.
The value of the Position2 dynamically changes as you drag the cursor. You do not need to
click. The values shown include:
l Distance.
l X distance
l Y Distance.
l Z Distance.

4. You can click P or right-click and selectPause from the shortcut menu to stop dynamic
tracking. You can then copy text from theMeasure Data dialog.

5. To resume dynamic tracking, either press P or right click and select Resume.
6. To close the dialog box and exitMeasuremode, click theClose button. You can also use the

ESC key to exit Measuremode.

Related Topics

MeasureModes for Objects
Setting Coordinate Systems
Modifying the Coordinate SystemAxes View
Choosing Snap Settings
ChoosingMovement Mode (3D, in plane, X, Y, or Z)
Select Multi (a mode for selecting objects, faces, edges or vertices)

Setting Coordinate Systems
Themodeler has three types of coordinate systems that enable you to easily orient new objects:

l A global coordinate system.
l A relative coordinate system.
l A face coordinate system.
l An object coordinate system.
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Every coordinate system (CS) has an x-axis that lies at a right angle to a y-axis, and a z-axis that is
perpendicular to the xy plane. The origin (0,0,0) of every CS is located at the intersection of the x-, y-,
and z-axes.The default Global coordinate system and any additional coordinate systems that you
create for a project appear in the History tree of themodeler window.

l The globalcoordinate system (CS) is the fixed, default CS for each new project. It cannot be
edited or deleted.

l A relativeCS is user-defined. Its origin and orientation can be set relative to an existing CS.
Relative CSs enable you to easily draw objects that are located relative to other objects. If you
modify a relative CS, all objects drawn on that CS will be affected and change position
accordingly. You can define a relative CS to be offset and/or rotated from an existing CS. This
feature provides a way for objectsmade of the same anisotropicmaterials to have different
orientations.
When you set a new relative coordinate system, you specify whether to express the
coordinates as Absolute or Relative Coordinates. Absolute uses the specified values in terms
of the global coordinate system. Relative interprets the values as differences from the current
working CS.
You have choices for expressing the coordinates asCartesian, Cylindrical, or Spherical.
These are evaluated as cartesian for the coordinate system properties.

l A faceCS is also user-defined. Its origin is specified on a planar object face. Face CSs enable
you to easily draw objects that are located relative to an object’s face.

Switch between global, relative, object, and face CSs by changing theworkingCS. Simply click the
CS you want to use in the history tree. The working CS is indicated by a redW that appears at the
lower-left corner of the CS name in the history tree. TheProperties dialog box lists the CS
associated with an object as the Orientation. By default, this is Global, but if you have created the
object under a different coordinate system, that will be the orientation. You can click on the current
orientation to see a drop down list of other orientation that you can assign for an object.
User-defined CSs are saved with the active project. When you open a project, it uses the CS
designated asworking CS when you last saved.

Related Topics

Creating a Relative Coordinate System
Creating a Face Coordinate System
Setting theWorking Coordinate System
Modifying the Coordinate SystemAxes View
Change theOrientation of an object
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Setting the Working Coordinate System

Theworking coordinate system is the current CS with which objects being drawn are associated.
The working CS can be the global CS or a user-defined relative CS or face CS. Select the working
CS by clicking its name in the history tree, or do the following:

1. ClickModeler>Coordinate System>Set Working CS.
TheSelect Coordinate System dialog box appears.

2. Click a CS in the list.
3. ClickSelect.

A redW appears at the lower-left corner of the CS name in the history tree, indicating that it is
the working CS.
Objects that you draw from now on are drawn in and associated with the CS you selected.

Related Topics

Setting Coordinate Systems

Creating a Relative Coordinate System

When creating a relative CS, you have the following options:
l You can create an offset relative CS, that is, a relative CS whose origin lies a specified
distance from another CS’s origin. Bymoving a CS’s origin, you can enter coordinates relative
to an existing object, without having to add or subtract the existing object’s coordinates.

l You can create a rotated relative CS, that is, a relative CS whose axes are rotated away from
another CS’s axes. By rotating the axes of a CS, you can easily add an object that is turned at
an angle relative to another object.

l You can also create a relative CS that is both offset and rotated.

Creating an Offset Relative CS

To create a relative CS with an origin that lies a specified distance from another CS's origin:
1. In the history tree, click the CS upon which you want to base the new relative CS, making it the

working CS.
2. ClickModeler>Coordinate System>Create>Relative CS>Offset.

3. On theRelative CSmenu, clickOffset .
4. Select the origin in one of the following ways:

l Click the point.
l At the lower right of themodeler window, use the drop downmenu to select the system for
expressing coordinates (Cartesian, Cylindrical, or Spherical), select either relative or
absolute coordinates, then select the units, and type the CS origin coordinates in boxes.
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To select a point that does not lie in the current plane, use theMovement Mode commands
on the shortcut menu.
The new relative CS is created. Its origin hasmoved from the previousworking CS, but its
axes remain the same. It is listed in the history tree underCoordinate Systems. It
automatically becomes the working CS; objects that you draw hereafter will be based on the
coordinates of this relative CS. Default planes are created on its xy, yz, and xz planes.

Related Topics

Creating a Relative Coordinate System
Creating anOffset and Rotated Relative CS

Creating a Rotated Relative CS

To create a new relative CS with its axes rotated away from another CS's axes:
1. In the history tree, select the CS upon which you want to base the new relative CS, making it

the working CS.

2. ClickModeler>Coordinate System>Create>Relative CS>Rotated .
3. Specify the x-axis by selecting a point in one of the following ways:

l Click the point.
l At the lower right of themodeler window, use the drop downmenu to select the system for
expressing coordinates (Cartesian, Cylindrical, or Spherical), select either relative or
absolute coordinates, then select the units, and type the CS origin coordinates in boxes.

To select a point that does not lie in the current plane, use theMovement Mode commands
on the shortcut menu.

4. Specify the xy plane by selecting any point on it in one of the following ways:
l Click the point.
l Type the coordinates of a point that is relative to the previously selected point in the dX, dY,
and dZ boxes, where d is the distance from the previously selected point.

You do not need to specify the z-axis. It is automatically calculated so that the axes form a
right-handed Cartesian coordinate system.
The new relative CS is created. It has the same origin as the previousworking CS, but its axes
are rotated. It is listed in the history tree underCoordinate Systems. It automatically
becomes the working CS; objects that you draw hereafter are based on the coordinates of this
relative CS. Default planes are created on its xy, yz, and xz planes.

Related Topics

Creating a Relative Coordinate System
Creating anOffset and Rotated Relative CS
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Creating an Offset and Rotated Relative CS

To create a new relative CS that is both offset and rotated from an existing CS:
1. In the history tree, select the CS upon which you want to base the new relative CS, making it

the working CS.
2. Point toModeler>Coordinate System>Create>Relative CS.

3. On theRelative CSmenu, clickBoth .
4. Select the origin in one of the following ways:

l Click the point.
l At the lower right of themodeler window, use the drop downmenu to select the system for
expressing coordinates (Cartesian, Cylindrical, or Spherical), select either relative or
absolute coordinates, then select the units, and type the CS origin coordinates in boxes.

To select a point that does not lie in the current plane, use theMovement Mode commands
on the shortcut menu.

5. Specify the x-axis by selecting a point on the axis in one of the following ways:
l Click the point.
l Type the coordinates of a point that is relative to the origin in the dX, dY, and dZ boxes,
where d is the distance from the previously selected point.

6. Specify the xy plane by selecting any point on it in one of the following ways:
l Click the point.
l Type the coordinates of a point that is relative to the previously selected point in the dX, dY,
and dZ boxes.

You do not need to specify the z-axis. It is automatically calculated so that it is at a right angle
to the y-axis.
The new relative CS is created. It is listed in the history tree underCoordinate Systems. It
automatically becomes the working CS; objects that you draw hereafter are based on the
coordinates of this relative CS. Default planes are created on its xy, yz, and xz planes.

Related Topics

Creating a Relative Coordinate System

Creating a Face Coordinate System

1. Select the object face upon which you want to create the face CS.

2. ClickModeler>Coordinate System>Create>Face CS .
3. Select the origin in one of the following ways:

l Click the point on the face.
l Type the point's coordinates in theX, Y, and Z boxes.

4. Specify the x-axis by selecting a point on the object face in one of the following ways:
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l Click the point.
l Type the coordinates of a point that is relative to the previously selected point in the dX, dY,
and dZ boxes, where d is the distance from the previously selected point.

You do not need to specify the y- or z-axes. Themodeler assumes that the z-axis is normal to
the object face and the y-axis is automatically calculated to be at a right angle to the z-axis.
The new face CS is listed in the history tree underCoordinate Systems. It automatically
becomes the working CS; objects that you draw hereafter are referenced to the coordinates of
this face CS. Default planes are created on its xy, yz, and xz planes.

Only operations listed in the history tree before the face CS's creation affect the face CS, and in turn,
affect objects dependent upon that face CS. A face CS, or objects created on it, are not affected by
operations that occur after it is created.
For example, suppose you create a box, then a face CS on a face of the box, and then a cylinder on
the face CS. If you then edit the box's dimensions in theProperties dialog box, the cylinder moves
accordingly. But if you rotate the box using theEdit>Arrange>Rotate command, the boxmoves,
but the cylinder does not because the operation occurs later in the history tree.

Related Topics

Automatically Creating Face Coordinate Systems
Setting theWorking Coordinate System
Modifying Coordinate Systems
Setting Coordinate Systems

Automatically Creating Face Coordinate Systems

You can instruct Maxwell to automatically create a new face CS every time you draw on an object's
face.

1. ClickTools>Options>Modeler Options.
TheModeler Options dialog box appears.

2. In the Operation tab, selectAutomatically switch to face coordinate system.
3. ClickOK.

Now, when you select a face, and then click any drawing command, a new face CS is created. The
modeler automatically sets the new face CS as the working CS. The object you draw is oriented
according to the new face CS.

Note Themodeler does not automatically create a new face CS if a face CS has already been
assigned to the selected face.

Related Topics

Creating a Face Coordinate System
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Creating an Object Coordinate System

You can create coordinate systems based on any object of solid, sheet, or wire type. The
Modeler>Coordinate System>Create>Object CS command is enabled when you select an
object. AnObject CS can beOffset, Rotated or both. Executing one of the Object CS commands
changes the cursor to the selectionmarker mode.
As you drag the selectionmarker over an object, it follows the 3D surfaces of the object, dropping a
dashed reference line to a point on the current plane. The cursor changes shape to provide
information about the object at the corresponding coordinate:

For example, in this case, the cursor showsEdge Center triangles as valid selection points for an
Modeler>Coordinate Systems>Create Object CS>Offset command.

Only operations listed in the history tree before the Object CS’s creation will affect the Object CS,
and in turn, affect objects dependent upon that Object CS. AnObject CS, or objects created on it, is
not affected by operations that occur after it is created. Also see theMove CS to End command.
For example, suppose you create a box, then anObject CS on a face of the box, and then a cylinder
on theObject CS. If you then edit the box’s dimensions in theProperties dialog box, the cylinder will
move accordingly. But if you rotate the box using theEdit>Arrange>Rotate command, the boxwill
move, but the cylinder will not move because the operation occurs later in the history tree.
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Related Topics

Creating a Face Coordinate System
Move CS to End
Creating anOffset Object CS
Creating a RotatedObject CS
Creating anObject CS that is both Rotated andOffset
Expressing Cartesian, Cylindrical, or Spherical Coordinates

Creating an Offset Object CS

To create anOffset Object coordinate system (CS):
1. Select the working CS.
2. Select the object, and clickModeler>Coordinate System>Create>Object>Offset.

l You can select any snap point on object based on current snappingmode to select origin of
the CS.When you hover themouse over a valid point, a coordinate system preview is
shown.

l The point must be on selected object.
l X axis is taken as {1,0,0} and Y Axis as {0,1,0} to create anObject CS. The axis coordinates
can be later edited through the Properties dialog.

l When you select the point, validation displays an appropriatemessage. Points where CS
preview is available are always valid.

Related Topics

Creating a Face Coordinate System
Move CS to End
Creating anOffset Object CS
Creating a RotatedObject CS
Creating anObject CS that is both Rotated andOffset
Expressing Cartesian, Cylindrical, or Spherical Coordinates
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Creating a Rotated Object CS

To create a RotatedObject coordinate system (CS):
1. Select the working CS.
2. Select the object, and clickModeler>Coordinate System>Create>Object>Rotated

l The origin is taken as {0,0,0}. You can edit this later through the Properties window.
l TheGUI is in multi select mode where you define the direction by picking any of vertex,
straight edge, planar face or conical face.
l If you select vertex, direction from origin to vertex defines the axis.
l If you select a straight edge, the edge direction defines the axis.
l If you select a planar face, face normal defines the axis.
l If you select a conical face, the face axis defines the CS axis.

l The selected vertex, edge or facemust be on the selected object.
3. You are prompted to first select X axis. A preview of X axis is shown for valid selections.
4. You are later prompted to select to define the XY plane. Another direction (edge or face

selection) or point (i.e. vertex selection) helps to define the plane.
l During 2nd XY plane selection, a CS preview shows as the cursor hovers over valid
selections. The preview includes the three CS axes and the XY plane.

l In 2D modeler, you are prompted to select only X axis. The Y axis is defined based on 2D
modeler type. This resemblesRelative CS behavior. Face picking is not available in 2D
modeler as it defines the direction out of plane.

Related Topics

Creating a Face Coordinate System
Move CS to End
Creating anOffset Object CS
Creating a RotatedObject CS
Creating anObject CS that is both Rotated andOffset
Expressing Cartesian, Cylindrical, or Spherical Coordinates
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Creating an Object CS that is Both Offset and Rotated

To create anObject CS that is both offset and rotated:
1. Set the working CS.
2. Select the object

l Behavior is combination of offset and rotated object CS. You are first prompted to select
origin as inObject CS>Object and then axes as inObject CS>Rotated.

l In 2D modeler, you are asked to select only the origin and X axis. The Y axis is computed as
forObject CS>Rotated. Face picking is not available in 2D modeler as it defines the direction
out of plane.

Related Topics

Creating a Face Coordinate System
Move CS to End
Creating anOffset Object CS
Creating a RotatedObject CS
Creating anObject CS that is both Rotated andOffset
Expressing Cartesian, Cylindrical, or Spherical Coordinates

Move CS to End Command for History Tree

Only operations listed in the history tree before the Object CS’s creation will affect the Object CS,
and in turn, affect objects dependent upon that Object CS. AnObject CS, or objects created on it, is
not affected by operations that occur after it is created. It is sometimes useful to have the coordinate
system affected after any other operations that might have edited, moved or rotated the object.
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If you have at least one History operation after a Face or Object CS in the History tree, selecting a
Face or Object CS enables theMove CS to End command in theModeler>Coordinate System
cascademenu and the History Tree shortcut menu.

Executing the commandmoves the selected CreateObject CS to the end position in the History tree
and updates associated items (other CS, object history, any dependent parts etc.).

Related Topics

Creating a Face Coordinate System
Move CS to End
Creating anOffset Object CS
Creating a RotatedObject CS
Creating anObject CS that is both Rotated andOffset

Modifying Coordinate Systems

Keep inmind that when you edit a CS, the following are also affected:
l All objects drawn in the CS.
l All CSs that were defined relative to that CS.
l All objects drawn on a CS that was defined relative to that CS.

There are two ways tomodify a coordinate system: you can select the coordinate system in the
history tree in themodeler window, and open its properties dialog. This approach does not also allow
you to change whether the coordinate system is Absolute or Relative, or to change how you express
the coordinates (asCartesian, Cylindrical, or Spherical).
If you want to alsomodify the whether the coordinate system is Absolute or Relative, and to change
how your express the coordinate, do the following:

1. ClickModeler>Coordinate System>Edit.
TheSelect Coordinate System dialog box appears.

2. Click the CS you want to modify.
3. ClickSelect.

Drawing aModel 8-250
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

This selects that coordinate system and enables the editable fields at the lower right of the
Modeler window. After you click the cursor in the first field, you can type in values, and tab to
the next fields.

4. You can select Absolute or Relative as the Coordinate system If you selected a relative CS,
follow the directions for creating a relative CS.
If you selected a face CS, follow the directions for creating a face CS.

5. You select the coordinate system from the drop downmenus asCartesian, Cylindrical, or
Spherical.

6. Select the units from the drop downmenu.
The value you give here is translated to Cartesian coordinates in the Properties for the
Coordinate system.

Related Topics

Setting Coordinate Systems
Creating a Relative Coordinate System
Creating a Face Coordinate System
Modifying the Coordinate SystemAxes View

Expressing Cartesian, Cylindrical, or Spherical Coordinates

You have choices for expressing the coordinates for asCartesian, Cylindrical, or Spherical. In each
case, you also specify whether to enter the coordinates as Absolute or Relative to the working
coordinate system. Click the cursor in the first text field to begin entering values or variables. Tab to
the next fields, and Enter when your are done. After you enter values or variables in the text fields,
they are evaluated asCartesian for the Properties window for that coordinate system.

l Cartesian, that is the point’s distance from the origin in the x, y, and z directions in theX, Y,
and Z text boxes.
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l Cylindrical, that is, the point’s radius, measured from the origin, in theR text box, the angle
from the x-axis in the Theta text box, and the distance from the origin in the z direction in the Z
text box.

l Spherical, that is, in the point’s radius, measured from the origin, in theRho text box, the
angle from the x-axis in the Theta text box, and the angle from the origin in the z direction in
thePhi text box.

Related Topics

Defining Absolute Coordinates
Defining Relative Coordinates
Defining Cartesian Coordinates
Defining Cylindrical Coordinates
Defining Spherical Coordinates

Deleting Coordinate Systems

1. Click the name of the CS you want to delete in the history tree.

2. ClickEdit>Delete .
l Alternatively, pressDelete.
The CS is deleted and all objects drawn on it are deleted. Further, anyCS that depended on
the deleted CS is deleted and any objects that were drawn in the dependent CS are also be
deleted.

Related Topics

Setting Coordinate Systems
Creating a Relative Coordinate System
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Creating a Face Coordinate System
Modifying the Coordinate SystemAxes View

Setting the Drawing Plane
TheDrawing plane pull-down list is available on theModeler Draw toolbar, next to theMovement
mode pull-down list.

To set the drawing plane, do one of the following:
l SelectXY from theDrawing plane pull-down list on theModeler Draw toolbar.
l ClickModeler>Grid Plane, and then select a grid plane:XY, YZ, or XZ.
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9 - Maxwell User Defined Primitives
User Defined Primitives (UDPs) are compiled libraries of commonly used geometricmodels in
electromechanical energy devices and power systems that can be added to the desktop interface
and shared between users with commonmodeling needs. UDPs allow you to add customized
geometricmodels to theMaxwell Desktop.

l In Maxwell, many commonly used UDPs have been defined, especially for RMxprt UDPs. For
more information, see RMxprt UDPs and Helix UDPs.

l You can also define your ownUDPs bywriting source code and then generating .dll files for
UDPs. For more information, see Source Code Files.

Maxwell User Defined Primitives
User Defined Primitives (UDPs) are compiled libraries of commonly used geometricmodels in
electromechanical energy devices and power systems that can be added to the desktop interface
and shared between users with commonmodeling needs. UDPs allow you to add customized
geometricmodels to theMaxwell Desktop.

l In Maxwell, many commonly used UDPs have been defined, especially for RMxprt UDPs. For
more information, see RMxprt UDPs and Helix UDPs.

l You can also define your ownUDPs bywriting source code and then generating .dll files for
UDPs. For more information, see Source Code Files.

Launching a UDP from Maxwell Desktop

In theMaxwell desktop, clickDraw>User Defined Primitive to choose a UDP. For example, a
band UDP is launched as follows:

Maxwell Online Help
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1. ClickDraw>User Defined Primitive>RMxprt>Band, as shown in the following figure.

Figure 9-1 Create a band

A User Defined Primitive Operation dialog opens.
On theParameters tab, you can view and edit the parameters. An Info tab contains
information about the user defined primitive, its purpose, the company/author who created it,
the date created and the version number.
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2. Assign the values in theParameters tab, and then clickOK to finish setting parameters.

Figure 9-2 Assign parameters values

A UDPmodel appears in the coordinate systemwindow.

Figure 9-3 A band UDP is created
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RMxprt UDPs
RMxprt UDPs are 2D and 3D geometries created for finite element analysis of electrical machines.
RMxprt UDPs consist of the following types:

l UDPs for Band and Regions
l UDPs for Slot Cores and Coils
l UDPs for Pole Cores and Coils
l UDPs for Other Cores and Coils

UDPs for Bands and Regions

RMxprt includes two types of UDPs for defining bands and regions:
l BandUDP
l Core regions

Band UDP

The Band UDP is used to create:
l A region to include all moving objects, which is called a “band”
l An outer region to include all moving and static objects
l A region used as a subtract tool to derive a partial model
l Master and slave boundaries

Property Description
DiaGap Band diameter in gap center, DiaGap < DiaYoke for outer

band
DiaYoke Band diameter on yoke side, DiaYoke < DiaGap for inner

band
Length Band Length
SegAngle Angle per segment of band (0.1 ~ 5 degrees)
Fractions Number of circumferential fractions, 1 for circular region
HalfAxial 0: full model; 1: half model in axial direction.
InfoCore 0: band; 1: tool; 2: master; 3: slave; 100: region

These parameters are used in the following 2D inner band and 2D outer band examples:

Figure 9-4 Inner band
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Figure 9-5 Outer band

Figure 9-6 Inner band half

Figure 9-7 Inner band semi

Parameters such asSegAngle, Length andHalfAxial are shown in the following 3D figures:
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Figure 9-8 Inner band (full model)

Figure 9-9 Inner band (half model)

Creating a Band

Maxwell provides you with a .dll file to define the parameters of a band.
1. ClickDraw>User Defined Primitive>RMxprt>Band.

TheUser Defined Primitive Operation dialog box appears.
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Figure 9-10 Change values of parameters when creating a UDP

TheParameters tab permits you to see and edit the parameters. An Info tab contains
information about the user defined primitive, its purpose, the company/author who created it,
the date created and the version number.

2. Specify the values for the parameters.
3. ClickOK.

Creating an Outer Region

An outer region can be assigned by setting the InfoCore property to 100 either when creating the
band or after creating it. Themethod for assigning during band creation is discussed in Creating a
Band. Themethod for assigning after the band is created is as follows:

1. For assigning an outer region after the band is created, clickCreateUserDefinedPart in the
history tree under the specific band, as shown in Figure 9-11 . You can change the InfoCore
property to 100 underCommand tab.
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2. For an outer region, set DiaGap < DiaYoke. For a shaft, setDiaGap > DiaYoke.

Figure 9-11 CreateUserDefinedPart in the history tree

Creating a Tool

When you are defining parameters, the InfoCore property can be assigned to 1, whichmeans the
band is used as a tool. This property can be assigned either when creating the band or after creating
it. Themethod for assigning during band creation is discussed in Creating a Band. For assigning
after the band is created, clickCreateUserDefinedPart in the history tree under the specific band,
as shown in Figure 9-11 . You can then change the InfoCore property to 1 underCommand tab.

Note To be assigned as a tool, the bandmust be an outer band, whichmeans the band’s
DiaGap valuemust be less than DiaYoke value.

A tool ismainly used for subtraction in themodel.
For example, if a half model of NonSalientPoleCore UDP is needed, a tool is necessary to be used
to subtract half of NonSalientPoleCore.
First, create a tool.

1. ClickDraw>User Defined Primitive>RMxprt>Band.
2. ChangeDiaGap andDiaYoke values to set theDiaGap value to be less than theDiaYoke

value.
3. Set InfoCore value to 1 and change theColor of the tool to another one in order to distinguish
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the tool from the NonSalientPoleCore, which is created later.

Figure 9-12 Set the values of parameters to create a tool

Figure 9-13 Change the color of the tool

Then, create a non-salient pole core.
1. ClickDraw>User Defined Primitive>RMxprt>NonSalientPoleCore.
2. ClickOK to finish setting the parameter.
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The coordinate systemwindow looks similar to the following figure:

Figure 9-14 Non-Salient Pole Core (gray) with a tool

Change the Fractions of the tool to 2.
1. ClickCreateUserDefinedPart in the history tree under the tool (named Band1 in the figure).
2. Change the value of Fractions to 2.
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3. ClickOK to finish setting the parameter.

Figure 9-15 Change the value of Fractions of Non-Salient Pole Core (gray)

The last step is to subtract the non-salient pole core using the tool.
1. Choose NonSalientPoleCore1 and Band1 (tool) simultaneously by pressingCtrl on the

keyboard.
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2. ClickModeler>Boolean>Subtract to do the subtraction.

Figure 9-16 Subtraction of two objects

A Subtract window appears.
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3. Choose NonSalientPoleCore1 as theBlank Parts and Band1 as the Tool Parts.
4. ClickOK to finish subtraction.

Figure 9-17 Set Blank Parts and Tool Parts

The final Non-Salient Pole Core is shown in the coordinate systemwindow in the following figure:

Figure 9-18 A non-salient pole core after subtraction
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Creating 3D Master and Slave Boundaries

There are two ways to create 3D master and slave boundaries:
l Creating a new band and changing the entire band to amaster or slave boundary
l Selecting one of the planar faces of an existing band in the coordinate window and assigning
the face to amaster or slave boundary

The process of changing an entire band to amaster or slave boundary is similar to creating a tool.
When creating a new band or after creation of a band, you can assign the InfoCore property to 2 (for
master) or 3 (for slave). After clickingOK, the band is changed to a face.
The process of assigningmaster and slave boundaries on an existing face follows:

1. ClickCreateUserDefinedPart in the history tree under the band for which you are assigning
boundaries. Set the Fractions property of the band to an integer larger than 1 tomake the
band have a planar face.

2. ClickEdit>Select>Faces or right-click anywhere in the coordinate window to chooseSelect
Faces, which are shown separately in the following figures.
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Figure 9-19 Select Faces

3. Select a planar face of the band by right-clicking the face. Then select
AssignBoundary>Master (orBoundary>Slave after theMaster boundary has been set
up). When assigning amaster boundary, aMaster Boundarywindow appears. Otherwise a

Introduction 9-15
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Slave Boundarywindow appears.

Figure 9-20 Assign Master Boundary

4. Build up a tiny coordinate system of the face by setting the U vector and V vector to indicate
the direction of the face. The U vector needs to be set using an arrow on the coordinate, and
then the V vector is set automatically on the face (you can chooseReverse Direction of
default V vector). Note that the U vectors and V vectors of a relatedmaster and slavemust
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have the same orientation.

Figure 9-21 Set up U vector and V vector

5. When creating a slave boundary, you also need to set itsmaster boundary and itsmagnetic
field strength (either Hm or –Hm).

6. ClickOK to finishmaster or slave boundary creation.

Creating Core Regions

Most core UDPs, which are covered in UDPs for Slot Cores and Coils, UDPs for Pole Cores and
Coils, and UDPs for Other Cores and Coils, can be changed to core regions. The ways to change
them into regions are similar. This section gives a general introduction of how to change those core
UDPs into core regions.
Inner and outer cores are defined as follows:

l An inner core is a core for which theDiaGap value is greater than theDiaYoke value.
l An outer core is a core for which theDiaGap value is less than theDiaYoke value.

Creating an Inner Core Region

Because the properties and parameters of an inner core region should be the same as the
corresponding inner core, an inner core region is usually created by replicating an inner core and
changing the new object’s InfoCore property to 100. The detailed steps are as follows:
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1. Select the inner core in the history tree. Then right-click to chooseEdit>Copy.

Figure 9-22 Copy a SalientPoleCore

2. Right-click the same object in the history tree to chooseEdit>Paste. This process is shown in
the following figure:

Figure 9-23 Paste a SalientPoleCore

3. ClickCreateUserDefinedPart, and set InfoCore property to 100 in the pop-up window.
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Figure 9-24 Change the value of InfoCore of SalientPoleCore

4. ClickOK.

Creating an Outer Core Region

Because the properties and parameters of an outer core region should be the same as the
corresponding outer core, an outer core region is usually created by replicating an outer core and
changing the new object’s InfoCore property to 100. The detailed steps are as follows:

1. Select the outer core in the history tree. Then right-click to chooseEdit>Copy.

Figure 9-25 Copy a SalientPoleCore
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2. Right-click the same object in the history tree to chooseEdit>Paste. This process is shown in
the following figure:

Figure 9-26 Paste a SalientPoleCore

3. ClickCreateUserDefinedPart, and set InfoCore property to 100 in the pop-up window.

Figure 9-27 Change the value of InfoCore of SalientPoleCore

4. ClickOK.
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UDPs for Slot Cores and Coils

UDPs for defining slot cores and coils include:
l SlotCore UDP
l VentSlotCore UDP
l RacetrackSlotCore UDP
l NonSalientPoleCore UDP
l LapCoil UDP
l ConCoil UDP
l WaveCoil UDP
l SquirrelCage UDP
l DoubleCage UDP

SlotCore UDP

The SlotCore UDP is used to create a stator or rotor core with a distributed AC winding, or a DC
commutating winding, or a squirrel-cage winding for the followingmachine types:

l Single-phase or multi-phase inductionmachines
l Wound-field or PM synchronousmachines
l Brush-commutatingmachines, such aswound-field or PMDC machines, as well as universal
motors

l BrushlessDC machines, and others
Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores.
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner

cores.
Length Core length.
Skew Skew angle in core length range.
Slots Number of slots.
SlotType Slot Type: 1 to 6.
Hs0 Slot opening height.
Hs01 Slot closed bridge height.
Hs1 Wedge height.
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
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Property Description
Fillet Type 0: a quarter circle; 1: a tangent connection; 2&3: arc bottom.
HalfSlot 0 for symmetric slot; 1 for half slot.
SegAngle Deviation angle for slot arches (10~30, <10 for true surface).
LenRegion Region length.
InfoCore 0: Core; 100: region.

These parameters are used in the following 2D SlotCore example:

Figure 9-28 Diameters of SlotCore when HalfSlot is 0
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Figure 9-29 Diameters of SlotCore when HalfSlot is 1

3D figures of a slot core are shown in the following examples:

Figure 9-30 SegAngle and Length of SlotCore
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Figure 9-31 Skew of SlotCore

Six common slot types and their related parameters are shown in the following figures:

Figure 9-32 Slot Type 1
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Figure 9-33 Slot Type 2

Figure 9-34 Slot Type 3

Figure 9-35 Slot Type 4
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Figure 9-36 Slot Type 5

Figure 9-37 Slot Type 6

Slot cores or coils with aSlotType parameter can choose one of these slots.

Creating an Inner or Outer Slot Core

Set the value ofDiaYoke andDiaGap asDiaYoke<DiaGap to create inner cores or
DiaGap<DiaYoke for outer cores. You can set the values either when creating the core or after
creating it, as described in Creating a Band and Creating anOuter Region, respectively.
Set the InfoCore value to 0.

VentSlotCore UDP

The VentSlotCore UDP can create the same core that the SlotCore UDP does. However, the
VentSlotCore UDP can create coreswith radial vents and axial holes. If you want to create a slotted
core without radial vents or axial holes, use the SlotCore UDP to have less data input.

Introduction 9-26
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores.
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner

cores.
Length Core length.
Skew Skew angle in core length range.
Slots Number of slots.
SlotType Slot Type: 1 to 6.
Hs0 Slot opening height.
Hs01 Slot closed bridge height.
Hs1 Wedge height.
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
Fillet Type 0: a quarter circle; 1: a tangent connection; 2&3: arc bottom.
HalfSlot 0 for symmetric slot; 1 for half slot.
VentHoles Number of axial vent holes per row.
HoleDiaIn Diameter of inner vent holes.
HoleDiaOut Diameter of outer vent holes.
HoleLocIn Diameter of inner vent hole center layout circle.
HoleLocOut Diameter of outer vent hole center layout circle.
VentDucts Number of radial vent ducts.
DuctWidth Axial width of radial vent ducts.
DuctPitch Center-to-center distance between two adjacent ducts.
SegAngle Deviation angle for slot arches (10~30, <10 for true surface).
LenRegion Region length.
InfoCore 0: Core; 100: region.

These parameters are used in the following inner VentSlotCore example:
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Figure 9-38 Parameters on cross-section of VentSlotCore
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Figure 9-39 Parameters on axial direction of VentSlotCore

Note For parameters such asSkew, Fillet Type, SegAngle,HalfSlot and parameters related
to slots, refer to SlotCore UDP parameters.

Creating an Inner or Outer Vent Slot Core

Set the value ofDiaYoke andDiaGap asDiaYoke<DiaGap to create inner cores or
DiaGap<DiaYoke for outer cores. You can set the valueswhen creating the core or after creating it,
as described in Creating a Band and Creating anOuter Region, respectively.
Set the InfoCore value to 0.

RacetrackSlotCore UDP

TheRacetrackSlotCore UDP is used to create a stator core with a single-phase concentric AC
winding for single-phase inductionmachines. The stator may have up to three different slot sizes.

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores.
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner

cores.
Length Core length.
Skew Skew angle in core length range.
Slots Number of slots.
SlotType Slot Type: 1 to 6.
Hs0 Slot opening height.
Hs01 Slot closed bridge height.
Hs1 Wedge height.
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
Fillet Type 0: a quarter circle; 1: a tangent connection; 2&3: arc bottom.
Poles Number of poles.
WidYoke Racetrackwidth for 2/4-pole cores.
MidSlots Number of middle-size slots for 2/4-pole cores.
MidHs2 Middle-size slot body height for 2/4-pole cores.
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Property Description
MidBs2 Middle-size slot body bottomwidth for 2/4-pole cores.
SmlSlots Number of small-size slots for 2/4-pole cores.
SmlHs2 Small-size slot body height for 2/4 pole cores.
SmlBs2 Small-size slot body bottomwidth for 2/4-pole cores.
SegAngle Deviation angle for slot arches (10~30, <10 for true surface).
LenRegion Region length.
InfoCore 0: Core; 100: region.

These parameters are used in the following outer Racetrack SlotCore example:

Figure 9-40 Parameters on cross-section of RacetrackSlotCore
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Figure 9-41 Parameters on axial direction of RacetrackSlotCore

Note For parameters such asSkew, Fillet Type, SegAngle and parameters related to slots,
refer to SlotCore UDP parameters.

Creating an Outer Racetrack Slot Core

Generally, Racetrack Slot Cores are used as outer cores. Set the value ofDiaYoke andDiaGap as
DiaGap<DiaYoke for outer cores. You can set the valueswhen creating the core or after creating it,
as described in Creating a Band and Creating anOuter Region, respectively.
Set the InfoCore value to 0.

NonSalientPoleCore UDP

TheNonSalientPoleCore UDP is used to create non-salient rotor cores for non-salient rotor
synchronousmachines. This core typemay include surface tangential vent ducts, axial vent ducts, as
well as a damper.

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores.
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner
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cores.
Length Core length.
Skew Skew angle in core length range.
IndexingSlots Number of indexing slots for slot pitch calculation.
ActualSlots Number of actual slots: ActualSlots <= IndexingSlots.
SlotType Slot Type: 1 to 7.
Hs0 Slot opening height.
Hs1 Slot wedge height.
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
Fillet Type 0: a quarter circle; 1: a tangent connection; 2&3: arc bottom.
Poles Number of poles.
TangentDucts Number of surface tangential vent ducts.
TDuctWidth Axial width of surface tangential vent ducts (or damper rings).
TDuctDepth Radial depth of surface tangential vent ducts (or damper rings).
TDuctPitch Pitch of surface tangential vent ducts (or damper bar

extension).
AxialDucts Number of axial vent ducts per pole.
ADuctWidth Width of axial vent ducts in main tooth.
ADuctDepth Depth of axial vent ducts in main tooth.
SegAngle Deviation angle for slot arches (10~30, <10 for true surface).
LenRegion Region length.
InfoCore 0: Core; 100: region.

These parameters are used in the following inner Non-Salient SlotCore example:
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Figure 9-42 Parameters on cross-section of NonSalientPoleCore

Figure 9-43 Parameters on axial direction of NonSalientPoleCore
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Note For parameters such asSkew, Fillet Type, SegAngle and parameters related to slots,
refer to SlotCore UDP parameters.

Creating an Inner Non-Salient Pole Core

Generally, Non-Salient Pole Cores are used as inner cores. Set the value ofDiaYoke andDiaGap
asDiaGap>DiaYoke for inner cores. You can set the valueswhen creating the core or after creating
it, as described in Creating a Band and Creating anOuter Region, respectively.
Set the InfoCore value to 0.

Creating a Non-Salient Pole Core with a Q-Axis Damper

In general, this process is realized by a subtraction of two objects. Several steps are needed to finish
the procedure.

1. ClickProject>Insert Maxwell 2D Design to create aMaxwell2D Design in a project.

Figure 9-44 Insert a 2D design to create a Non-Salient Pole Core

2. ClickDraw>User Defined Primitive>RMxprt>NonSalientPoleCore to draw aNon-
Salient Pole Core UDP. In order to show it in a 2D dimension, set the Length to 0. Also set
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AxialDucts to 0 for subtraction, as shown in the following figure.

Figure 9-45 Parameter settings of NonSalientPoleCore

3. Create a damper. Make a copy of the NonSalientPoleCore, and then paste it and rename it to
damper.
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Figure 9-46 Make a copy of NonSalientPoleCore and paste it

Figure 9-47 Rename the new NonSalientPoleCore to “Damper”

4. Change the InfoCore value to 1 to make a damper. Also change theColor of the damper to
distinguish it from the NonSalientPoleCore.
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Figure 9-48 Change the InfoCore value to make it a damper

The objects appear as follows in the coordinate systemwindow.
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Figure 9-49 Non-Salient Pole Core (gray) with a damper (red)

5. You can also change the damper’sSlotType and slot parameters if necessary. For instance,
SlotType is reset to 1 and slot parameters are reassigned as in the following figure.

Introduction 9-38
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Figure 9-50 Change the slot-related parameters of the damper

After youmodify the parameters, the objects in the coordinate systemwindow appear as in the
following example:
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Figure 9-51 Results after changing the slot-related parameters of the damper

6. Select both objects (Damper and NonSalientPoleCore) in the history tree simultaneously by
pressingCtrl on the keyboard. ClickModeler>Boolen>Subtract. A Subtract window
appears.

Figure 9-52 Subtraction of two objects

7. Move NonSalientPoleCore toBlank Parts and Damper to Tool Parts, and check the Clone
tool objects before operation box. ClickOK to finish subtraction.
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Figure 9-53 Set Blank Parts and Tool Parts

8. The final history tree and coordinate systemwindow are shown in the following example:

Figure 9-54 Objects after subtraction
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Creating a Non-Salient Pole Core with a Uniform-Distributed Damper

This process relies on subtraction of two objects and is very similar to Creating a Non-Salient Pole
Core with a Q-Axis Damper. Themajor difference is that you create a squirrel cage instead of
copying a NonSalientPoleCore to create a damper.

1. ClickProject>Insert Maxwell 2D Design to create aMaxwell2D Design in a project.
2. ClickDraw>User Defined Primitive>RMxprt>NonSalientPoleCore to draw aNon-

Salient Pole Core UDP. To show it in a 2D dimension, set the Length to 0. Also set
AxialDucts to 0 for subtraction, as shown in Figure 9-55 .

3. ClickDraw>User Defined Primitive>RMxprt>SquirrelCage to draw a squirrel cage UDP.
Set the Length to 0, change itsColor to a different one, and rename it to “Damper.” Then
objects in the coordinate systemwindow appear as in the following figure:

Figure 9-55 Non-Salient Pole Core with a damper (red)

4. You can also change the damper’sSlotType and slot parameters if necessary. For instance,
SlotType is reset to 1 and slot parameters are reassigned as in the following figure.
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Figure 9-56 Change the slot-related parameters of the damper

5. After youmodify the parameters, the objects in the coordinate systemwindow appear as in
the following figure:

Figure 9-57 Results after changing the slot-related parameters of the damper
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6. Select both objects (Damper and NonSalientPoleCore) in the history tree simultaneously by
pressingCtrl on the keyboard. ClickModeler>Boolean>Subtract. A Subtract window
appears.

7. Move NonSalientPoleCore toBlank Parts and Damper to Tool Parts, and check the Clone
tool objects before operation box. ClickOK to finish subtraction.

8. The final history tree and coordinate systemwindow are shown in the following figure:

Figure 9-58 Non-Salient Pole Core with a uniform-distributed damper

LapCoil UDP

The LapCoil UDP is used to create a coil for lap-type distributed AC windings or lap-type DC
commutating windings in a slotted core created by the SlotCore or VentSlotCore UDP. This UDP
can also create a coil cross-section used as a terminal for current assignment.

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores.
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores.
Length Core length.
Skew Skew angle in core length range.
Slots Number of slots.
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Property Description
SlotType Slot Type: 1 to 7.
Hs0 Slot opening height.
Hs1 Slot wedge height.
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
Fillet Type 0: a quarter circle; 1: a tangent connection.
Layers Number of winding layers.
CoilPitch Coil pitchmeasured in slots.
EndExt One-side end extended length.
SpanExt Axial length of end span; 0 for no span.
SegAngle Deviation angle for slot arches (5~15, <5 for true surface).
LenRegion Region length.
InfoCoil 0: winding; 1: coil; 2 terminal1; 3: terminal2; 4:insulation; 100:

region.

A single coil ismuch easier to be described with a slot core as reference. In the following figures,
coils are in gray and slot cores are orange. The lap coil’s InfoCoil property is set to 1 to use a single
coil to show parameters of lap coil.

Figure 9-59 Single Lap Coil with Coil Pitch set to 2
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Figure 9-60 Single Lap Coil with Coil Pitch set to 4

Figure 9-61 Axial Single Lap Coil with Coil Pitch set to 4

Creating a Whole Lap Winding

A whole lap winding is created by default or bymanually setting the property of InfoCoil to 0. You
can assign the value of this property either when creating the lap coil or after creating it, as described
in Creating a Band and Creating anOuter Region, respectively.
An example of a whole lap winding with an orange slot core is shown in the following figure:
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Figure 9-62 Whole Lap Winding

Creating a Single Lap Coil and its Terminals

1. Create a single lap coil bymanually setting the property of InfoCoil to 1. Figure 9-59 ,Figure
9-60 , and Figure 9-61 show the single lap coil from different angles.

2. For the terminals of the lap coil, set the property of InfoCoil to 2 or 3 (terminal1 or terminal2).
Figure 9-63 shows terminal1 in the coordinate system.

You can assign the value of this property either when creating the lap coil or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-63 Terminal 1 of LapCoil

Creating a 3D Open Insulation

A 3D open insulation is created bymanually setting the property of InfoCoil to 4. In the history tree,
the object changes from a solid to a sheet.
You can assign the value of this property either when creating the lap coil or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
A 3D open insulation is shown in Figure 9-64 . Note that it is a sheet instead of a solid: it is empty if
you observe it carefully.
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Figure 9-64 3D open insulation of LapCoil

ConCoil UDP

TheConCoil UDP is used to create a coil for concentric distributed AC windings or concentric DC
field windings in a slotted core created by the SlotCore, VentSlotCore, RacetrackSlotCore, or
NonSalientPoleCore UDP. This UDP can also create a coil cross-section used as a terminal for
current assignment.

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores.
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner

cores.
Length Core length.
Skew Skew angle in core length range.
Slots Number of slots.
SlotType Slot Type: 1 to 7.
Hs0 Slot opening height.
Hs1 Slot wedge height.
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Property Description
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
Fillet Type 0: a quarter circle; 1: a tangent connection.
LayerLoc 0: whole; 1: middle; 2: top; 3: bottom.
CoilPitch Coil pitchmeasured in slots.
EndExt One-side end extended length.
LayerExt Span layer extension in the axial direction.
LayerDiff Span layer difference in the radial direction.
AltEnd 0: same end layers; 1: alternate end layers.
LenRegion Region length.
InfoCoil 0: coil; 1 terminal1; 2: terminal2; 100: region.

The following four 2D figures show the parameter LayerLocwith different values. Slot cores are
used as references to help better understand concoils.

Figure 9-65 LayerLoc set to 1
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Figure 9-66 LayerLoc set to 2

Figure 9-67 LayerLoc set to 3
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Figure 9-68 LayerLoc set to 0

The following four 3D figures illustrate parameters of ConCoil such asLayerExt, LayerDiff and
AltEnd.

Figure 9-69 Reference 3D ConCoil
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Figure 9-70 3D ConCoil with a different LayerExt than shown in Figure 9-69 .

Figure 9-71 3D ConCoil with a different LayerDiff than shown in Figure 9-69 .
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Figure 9-72 3D ConCoil with a different AltEnd than shown in Figure 9-71 .

Note For parameters such asSkew, Fillet Type and parameters related to slots, refer to
SlotCore UDP parameters.

Creating a Single Concentric Coil and its Terminals

You create a single concentric coil bymanually setting the property of InfoCoil to 0.Figure 9-65
through Figure 9-69 show the single concentric coil.
For the terminals of a concentric coil, set the property of InfoCoil to 1 or 2 (terminal1 or terminal2).
Figure 9-71 shows terminal 1 of a concentric coil.
You can assign the value of this property either when creating a concentric coil or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-73 Terminal 1 of ConCoil

WaveCoil UDP

TheWaveCoil UDP is used to create a wave-type coil in a slotted core created by the SlotCore or
VentSlotCore UDP.

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores.
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner

cores.
Length Core length.
Skew Skew angle in core length range.
Slots Number of slots.
SlotType Slot Type: 1 to 7.
Hs0 Slot opening height.
Hs1 Slot wedge height.
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
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Property Description
Fillet Type 0: a quarter circle; 1: a tangent connection.
Layers Number of winding layers.
CoilPitch Coil pitchmeasured in slots.
EndExt One-side end extended length.
SpanExt Axial length of end span; 0 for no span.
SegAngle Deviation angle for slot arches (5~15, <5 for true surface).
PolePitch Pole pair pitchmeasured in slots.
LenRegion Region length.
InfoCoil 0: winding; 1: one coil; 100: region.

The following three figures illustrate these parameters of wave coil.

Note l A slot core (orange) is used as reference to better present the parameters and
position of the wave coil.

l Most parameters in a wave coil are similar or exactly the same as those in a lap coil
exceptPolePitch. Figure 9-74 shows the definition of the parameter PolePitch.
Figure 9-75 presents a winding wave coil that can be compared with a single wave
coil in Figure 9-74 . Further, Figure 9-76 gives an overview of parameters in axial
direction.

l For parameters such asSkew, Fillet Type, SegAngle and parameters related to
slots, refer to SlotCore UDP parameters.

Figure 9-74 One Wave Coil

Introduction 9-56
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Figure 9-75 A Whole Winding Wave Coil

Figure 9-76 Parameters of Wave Coil in axial direction

Creating a Whole Wave Winding

You can create a whole wave winding bymanually setting the property of InfoCoil to 0.
You can assign the value of this property either when creating a wave coil or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
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An example is shown in Figure 9-75 .

Creating a Single Wave Coil

In Maxwell, wave coil is set to a single wave coil by default when being created (InfoCoil is equal to
1).
You can assign the value of this property either when creating a wave coil or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
Examples are shown in Figure 9-74 and Figure 9-76 .

SquirrelCage UDP

The SquirrelCage UDP is used to create a squirrel-cage winding in a core created by the SlotCore
or VentSlotCore UDP for single-phase or multi-phase inductionmachines..

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores.
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner

cores.
Length Core length.
Skew Skew angle in core length range.
Slots Number of slots.
SlotType Slot Type: 1 to 7.
Hs0 Slot opening height.
Hs01 Slot closed bridge height.
Hs1 Slot wedge height.
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
Fillet Type 0: a quarter circle; 1: a tangent connection.
HalfSlot 0: symmetric slots; 1: half slots.
BarEndExt One-side bar end extended Length.
RingLength One-side axial ring length.
RingHeight Radial ring height.
RingDiaGap Ring diameter on gap side.
CastRotor 0: insert-bar; 1: cast-rotor.
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Property Description
SegAngle Deviation angle for slot arches (10~30, <10 for true surface).
LenRegion Region length.
InfoCoil 0: bars & rings; 1: bars; 2: rings; 100: region.

These parameters are used in the following figures:

Note 1. RingDiaGap is set to 95mmwhereasDiaGap is 100mm to distinguish these two
parameters in the following figures.

2. In the following 3D figure, a slot core is drawn to show theBarEndExt and Length
of Squirrel Cage.

3. For parameters such asSkew, Fillet Type, SegAngle and parameters related to
slots, refer to SlotCore UDP parameters.

Figure 9-77 Parameters of squirrel cage on cross-section
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Figure 9-78 Parameters of squirrel cage on axial direction

Creating a Whole Squirrel-Cage Winding

A whole squirrel cage winding is set by default when being created (InfoCoil is equal to 0). An
example is shown in Figure 9-78 as a blue object.
You can assign the value of this property either when creating a squirrel cage or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.

Creating Bars Only (Squirrel Cage)

You can create bars of a squirrel cage bymanually setting the property of InfoCoil to 1. Figure 9-79
shows bars of a squirrel cage.
You can assign the value of this property either when creating a squirrel cage or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-79 Bars of squirrel cage

Creating Two Rings Only

You can create two rings of a squirrel cage bymanually setting the property of InfoCoil to 2. Figure
9-80 shows rings of a squirrel cage.
You can assign the value of this property either when creating a squirrel cage or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-80 Rings of squirrel cage

DoubleCage UDP

TheDoubleCage UDP is used to create a double squirrel-cage winding in a slotted core created by
the SlotCore UDP or VentSlotCore UDP for inductionmachineswith a double squirrel-cage rotor.
The created double squirrel-cage winding can also be used as a subtract tool to derive a core with
top and bottom slots.

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores.
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner

cores.
Length Core length.
Skew Skew angle in core length range.
Slots Number of slots.
SlotType Slot Type: 1 to 7.
Hs0 Slot opening height.
Hs01 Slot closed bridge height.
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Property Description
Hs1 Slot wedge height.
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
Fillet Type 0: a quarter circle; 1: a tangent connection.
HalfSlot 0: symmetric slots; 1: half slots.
BarEndExt One-side bar end extended Length.
RingLength One-side axial ring length.
RingHeight Radial ring height.
RingDiaGap Ring diameter on gap side.
DoubleCage 0: normal squirrel cage; 1: double squirrel cage.
BSlotType Bottom slot type: 1 to 4.
BHs0 Slot opening height.
BHs1 Slot wedge height.
BHs2 Slot body height.
BBs0 Slot opening width.
BBs1 Slot wedgemaximumwidth.
BBs2 Slot body bottomwidth, 0 for parallel teeth.
BRs Slot body bottom fillet.
CastRotor 0: insert-bar; 1: cast-rotor.
SegAngle Deviation angle for slot arches (10~30, <10 for true surface).
LenRegion Region length.
InfoCoil 0: bars & rings; 1: bars; 2: rings; 100: region.

Themain difference between double cage and squirrel cage is that a double cage has double slots
instead of single slots. The following 2D figure shows the bottom slot, which is connected to the
normal slot. The parameters for a bottom slot are similar to those of a normal slot. Other parameters
are exactly the same as a squirrel cage.

Note For parameters such asSkew, Fillet Type, SegAngle and parameters related to slots,
refer to SlotCore UDP parameters.
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Figure 9-81 Parameters of double cage on cross-section

Figure 9-82 Parameters of double cage on axial direction

Creating a Whole Double-Cage Winding

A whole double-cage winding is set by default when being created (InfoCoil is equal to 0). An
example is shown in Figure 9-82 as a blue object.
You can assign the value of this property either when creating a squirrel cage or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
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Creating Bars Only (Double Cage)

You can create bars of a double cage bymanually setting the property of InfoCoil to 1. Figure 9-83
shows bars of a double cage.
You can assign the value of this property either when creating a double cage or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.

Figure 9-83 Bars of double cage

Creating Two Rings Only (Double Cage)

You can create two rings of a double cagemanually by setting the property of InfoCoil to 2. The
following figure shows rings of a double cage.
You can assign the value of this property either when creating a double cage or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-84 Rings of double cage

UDPs for Pole Cores and Coils

UDPs defined for pole cores and coils include:
l SalientPoleCore UDP
l DCMCore UDP
l ShadedPoleCore UDP
l UnivMCore UDP
l SRMCore UDP
l SynRMCore UDP
l ClawPoleCore UDP
l PMCore UDP
l IPMCore UDP
l PMDamperCore UDP

SalientPoleCore UDP

The SalientPoleCore UDP is used to create a salient-pole core, a field winding, and a damper for
salient-pole synchronousmachines. It can also create a coil cross-section used as a terminal for
current assignment.

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores.
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Property Description
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores.
Length Core length.
Skew Skew angle in core length range.
Slots Number of slots.
SlotType Slot Type: 1 to 4.
Hs0 Slot opening height.
Hs01 Slot closed bridge height.
Hs1 Slot wedge height.
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
Fillet Type 0: a quarter circle; 1: a tangent connection; 2&3: arc bottom.
SlotPitch Slot pitch in mechanical degrees, refer to offset point.
CenterPitch Center slot pitch in mechanical degrees, refer to offset point.
Poles Number of poles.
Width Shoe Pole shoe width.
HeightShoe Pole shoe height (maximum).
FilletShoe Pole shoe tip fillet radius.
WidthBody Pole bodywidth.
HeightBody Pole body height.
AirGap2 Second air gap length.
Offset Pole arc offset.
Off2_x The second pole arc offset perpendicular to the pole-center line.
Off2_y The second pole arc offset parallel with the pole-center line.
Off2_a The angle between the first pole arc and the second pole line.
CoilEndExt One-side coil end extended length.
EndRingType 0: whole press board; 1: pole press board; 2: pole ring; 3: whole ring.
BarEndExt One-side damper bar end extended Length; for types 2 & 3 only.
RingLength One-side axial ring length, or conductor press board thickness.
RingHeight Radial ring height, for types 2 & 3 only.
SegAngle Deviation angle for slot arches (10~30, <10 for true surface).
LenRegion Region length.
InfoCore 0: core; 1: core & coils; 2: coil; 3: damper; 4: terminal1; 5: terminal2; 6:poles; 7:

yoke; 100: region.
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These parameters are used in the following figures. In figureswith both gray and red objects, the
gray objects are used as references.

Figure 9-85 Salient Pole Core (InfoCore set to 0)

Figure 9-86 3D Salient Pole Core (InfoCore set to 1)
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Figure 9-87 SalientPoleCore damper (InfoCore set to 3)

Creating an Inner or Outer Salient Pole Core

Set the value ofDiaYoke andDiaGap asDiaYoke<DiaGap to create inner cores or
DiaGap<DiaYoke for outer cores.
An example of an inner salient pole core is shown in Figure 9-85 . For an outer salient pole core, see
Figure 9-88 .
You can set the values either when creating the core or after creating it, as described in Creating a
Band and Creating anOuter Region, respectively.
Set the InfoCore value to 0.
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Figure 9-88 Outer salient pole core

Creating a Coil and its Terminals (Salient Pole)

You can create a coil of a salient pole core bymanually setting the property of InfoCoil to 2. An
example is shown in Figure 9-89 .
Its terminals are createdmanually by setting the property of InfoCoil to 4 or 5 (Terminal1 or
Terminal2). Figure 9-90 shows terminal 1 of the coil.
You can assign values for these properties either when creating a salient pole core or after creating
it, as described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-89 A coil of a salient pole core

Figure 9-90 Terminal 1 of a coil

Creating a Damper (Salient Pole)

You can create a damper of a salient pole core bymanually setting the property of InfoCoil to 3. An
example is shown in Figure 9-87 as a red object.
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Figure 9-91 ,Figure 9-92 , Figure 9-93 , and Figure 9-94 illustrate the shapes of the damper
(InfoCore set to 3) with different EndRingType values. Gray objects are used as references.
You can assign the value of these properties either when creating a salient pole core or after creating
it, as described in Creating a Band and Creating anOuter Region, respectively.

Figure 9-91 Damper with EndRing Type set to 3

Figure 9-92 Damper with EndRing Type set to 2
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Figure 9-93 Damper with EndRing Type set to 1

Figure 9-94 Damper with EndRing Type set to 0

Creating Poles or the Yoke

You can create poles or the yoke of SalientPoleCore UDP through assigning the InfoCore
parameter to 6 or 7, respectively.
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You can assign the value of this property either when creating a Salient Pole Core or after creating it,
as described in Creating a Band and Creating anOuter Region, respectively.
Examples of poles and the yoke are shown in Figure 9-95 and Figure 9-96 , respectively.

Figure 9-95 Poles of salient pole core

Figure 9-96 Yoke of salient pole core

Introduction 9-74
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

DCMCore UDP

TheDCMCore UDP is used to create a stator core with or without a compensating winding, a shunt
and/or a series field winding, and a commutating pole with a commutating winding for DC machines.
It can also create coil terminals for all windings for current assignment.

Property Description
DiaGap Core diameter on gap side, DiaGap < DiaYoke for outer cores.
DiaYoke Core diameter on yoke side, DiaYoke < DiaGap for inner cores.
Length Core length.
Skew Skew angle in core length range.
FrameWidth Overall width of a racetrack frame.
FrameThick Frame thickness.
FrameLength Frame length.
Poles Number of poles.
PoleType Pole type: 1 to 2.
Dmax Diameter of shoe tip with maximumair gap length.
Bp0 Pole arc width with uniform air gap; 0 for eccentric air gap.
Bp1 Total pole width (the width between shoe tips).
Bp2/Rp0 Bp2 (max shoe width for pole type 1), or Rp0 (shoe fillet radius for pole type 2).
Bp3/Rp1 Bp3 (min shoe width for pole type 1), or Rp1 (pole fillet radius for pole type 2).
Hp Pole body height.
Bm Pole bodywidth.
FieldWndgs Number of field windings, 2 for both series and shunt windings.
EndExt Coil one-side end extended length.
SlotsPerPole Compensating slots per pole distributed under pole arc surface.
Bc0 Opening width of compensating slots.
Hc0 Opening height of compensating slots.
Bc2 Width of compensating slots.
Hc2 Height of compensating slots.
CmpEndExt One-side end extended length of compensating coils.
ComPoleWidth Width of the commutating poles.
ComPoleHeight Height of the commutating poles.
ComPoleLength Length of the commutating poles.
ComShoeWidth Shoe width of the commutating poles.
ComShoeHeight Shoe height of the commutating poles.
ComShoeLength Shoe length of the commutating poles.
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Property Description
ComGap2 Air gap length between commutating poles and the frame.
CmtEndExt One-side end extended length of commutating coils.
LenRegion Region length.
InfoCore 0: core & coils; 1: poles; 2: frame; 3: com poles; 4: shunt coil; 5: series coil; 6:

com coil; 100: region.
Info Term 0: whole coil; 1: terminal1; 2: terminal2.

The DC Machine core is complex compared with other UDPs.When creating a DCM core in a
Maxwell 3D design, it looks at first like the following figure in the coordinate systemwindow.

Figure 9-97 Initial DCM Core

In order to better describe the parameters in this UDP, a slot core was added inside the DCM core
and their lengthswere set to be 0. Also theDiaGap of slot core was changed to 92 to show the air
gap between two UDPs. Themodel now looks like the following example:
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Figure 9-98 DCM Core Sheet (gray) with Slot Core Sheet (red)

The following figures show two different overviews of the gray, transparent DCM core and the
referencing red slot core from different angles.

Figure 9-99 Transparent DCM core (gray) with Slot Core from different angles
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Figure 9-100 Transparent DCM core (gray) with Slot Core from different angles

The following figures show the parameters of a DCM core.

Note 1. A slot core in red is drawn as reference.
2. Because the structure of a DCM core is complicated and there aremany parameters,

figures are drawn using different InfoCore values of DCM core UDP to clearly
describe parameters.

3. Figure 9-101 and Figure 9-102 show parameters of two different pole types in the
DCM core UDP. In these two figures,Bp0 is not 0, whereas in Figure 9-103 Bp0 is
0, whichmeans the air gap is eccentric.

4. Dmax, by definition, is the diameter of shoe tip with maximumair gap length, which
meansDmax=Drout+2*Gmax. “Drout” means the outer diameter of the rotor (which
meansDiaGap of slot core in this example and is shown in Figure 9-103 ), and
“Gmax” is themaximumair gap between poles and rotor, which is shown in Figure 9-
101 and Figure 9-102 .

5. Correspondingly, there isDmin (which is calledDiaGap in DCMUDP and Figure 9-
103 ) andGmin. Their relationship isDmin=Drout+2*Gmin. They are also shown
inFigure 9-101 , Figure 9-102 , and Figure 9-103 .

6. The value ofComGap2 in Figure 9-103 is 0, whereas it is positive in Figure 9-104 .
In order to make the value ofComGap2 larger than 0, make sure to reserve enough
space forComGap2. This can be done by reducing the value ofComPoleHeight or
ComShoeHeight or both.
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Figure 9-101 Parameters of PoleType 1

Figure 9-102 Parameters of PoleType 2
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Figure 9-103 Parameters of DCM Core on 2D plane
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Figure 9-104 Parameters of a commutating pole (when ComGap is non-zero)

Figure 9-105 Length of poles

Figure 9-106 Axial parameters of poles and field windings
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Figure 9-107 Length of frame

Figure 9-108 Axial parameters of commutating poles and commutating coils

Creating an Outer DC Machine Core and All Coils

This core is used only as outer core, whichmeans the value ofDiaYoke is larger than that of
DiaGap. Also, set both InfoCore and Info Term values to be 0. You can set the value either when
creating the core or after creating it, as described in Creating a Band and Creating anOuter Region,
respectively.
An example of an outer DC machine core is shown in the following figure:

Introduction 9-82
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Figure 9-109 Outer DC Machine core and all coils

Creating Main Poles, Frame and Commutating Poles Separately

You can create themain poles of a DC Machine core bymanually setting the property of InfoCore to
1 and Info Term to 0. The result is shown as the gray object in Figure 9-105 and Figure 9-106 .
You can create the frame of a DC Machine core bymanually setting the property of InfoCore to 2
and Info Term to 0. The result is shown as the gray object in Figure 9-107 .
You can create the commutating poles of a DC Machine core bymanually setting the property of
InfoCore to 3 and Info Term to 0. The result is shown as the gray object in Figure 9-108 .
You can assign the values of these properties either when creating a DC Machine core or after
creating it, as described in Creating a Band and Creating anOuter Region, respectively.

Creating a Shunt Coil and its Terminals

You can create a shunt coil of a DC Machine core bymanually setting the property of InfoCore to 4
and Info Term to 0. The result is shown as a blue object in Figure 9-106 .
You can also create its terminals by setting the property of InfoCore to 4 and Info Term to 1 or 2 (for
terminal1 and terminal2, respectively).
You can assign the values of these properties either when creating a DC Machine core or after
creating it, as described in Creating a Band and Creating anOuter Region, respectively.
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Creating a Series Coil and its Terminals

You can create a series coil of a DC Machine core bymanually setting the property of InfoCore to 5
and Info Term to 0. An example is shown in the following figure.
You can also create its terminals by setting the property of InfoCore to 5 and Info Term to 1 or 2 (for
terminal1 and terminal2, respectively).
You can assign the values of these properties either when creating a DC Machine core or after
creating it, as described in Creating a Band and Creating anOuter Region, respectively.

Figure 9-110 A series coil of DCM Core

Creating a Commutating Coil and its Terminals

You can create a commutating coil of a DC Machine core bymanually setting the property of
InfoCore to 6 and Info Term to 0. The result is shown as a blue object in Figure 9-108 .
You can also create its terminals by setting the property of InfoCore to 6 and Info Term to 1 or 2 (for
terminal1 and terminal2, respectively).
You can assign the values of these properties either when creating a DC Machine core or after
creating it, as described in Creating a Band and Creating anOuter Region, respectively.
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ShadedPoleCore2 UDP

The ShadedPoleCore2 UDP is used to create the stator core for shaded-pole inductionmotors.

Figure 9-111 Shaded pole induction motor example 1

Figure 9-112 Shaded pole induction motor example 2

Property Description
DiaGap Core diameter on gap side, or inner diameter.
HighCore Core height in d-axis direction.
WidthCore Core width in q-axis direction.
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Property Description
WidthPole WidthPole = DiaGap + 2 * (pole bridge thickness).
Length Core length in the axial direction.
WidthYoke1 Width of the winding-core yoke.
WidthYoke2 Width of the parallel yokes.
Slots Number of slots per pole (1 or 2).
Hs0 Slot opening height.
Bs0 Slot opening width.
Bs1 Slot diameter.
DiaCond Diameter of the short-circuit solid conductor.
AngleOff Angle offset in mechanical degrees from the first slot to d-axis.
SlotPitch Slot pitch in mechanical degrees for two slots.
Dist1 Outer-slot center-to-center distance when Slots = 2.
DiaS2 Additional outer-slot diameter.
Dist2 Additional outer-slot distance.
InfoEnd 0: Separated end connectors; 1: Jointed end connectors.
GapDelta Maximumgap - minimumgap.
AngleBegin Begin angle of maximumgap inmechanical degrees.
AngleEnd End angle of maximumgap inmechanical degrees.
RadFillet Radius of outer-corner fillet.
RadDelta Step depth in outer-corner fillet.
DiaHole Diameter of holes for shaft bearing covers.
SpanHole Hole span in d-axis direction.
LenRegion Region length.
InfoCore 0: Core; 1: All; 2: Coil; 3: Cond1; 4: Cond2; 5: Hole filler; 100:

Region.
InfoTerm 0:Whole coil; 1: Terminal1; 2: Terminal2.

These parameters are used in the following figures.

Note l The number of parameters is large in this UDP, so different colors are used to
indicate different parameters in the stator bore (area of the circle ofDiaGap). Each
parameter is shownwith an arc/line and text in the same color.

l For parameters such asLength and parameters related to slots, refer to SlotCore
UDP parameters.
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Figure 9-113 Parameters of ShadedPoleCore2 (InfoCore set to 1, Info Term set to 0)

Creating an Outer Shaded Pole Core

This core is used only as an outer core. There is noDiaYoke parameter in this UDP, so to create an
outer shaded pole core, set both InfoCore and Info Term values to be 0. You can set the values
either when creating the core or after creating it, as described in Creating a Band and Creating an
Outer Region, respectively.
An example of the core for a ShadedPoleCore2 is shown in the following figure.
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Figure 9-114 Core of ShadedPoleCore2

Creating a Coil and its Terminals (Shaded Pole Core)

A coil of a shaded pole core is created bymanually setting the property of InfoCore to 2 and Info
Term to 0. An example of the coil for a ShadedPoleCore2 UDP is shown in Figure 9-115 .
You can create its terminals by setting the property of InfoCore to 2 and Info Term to 1 or 2 (for
terminal1 and terminal2 respectively). Figure 9-116 gives an example of a terminal.
You can assign the values of these properties either when creating a shaded-pole core or after
creating it, as described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-115 A coil of a ShadedPole Core

Figure 9-116 A terminal of a coil for a ShadedPole Core

Creating a Jointed or a Separated Shaded Conductor and Its Terminals

You can create a jointed conductor bymanually setting the parameter InfoCore to 3 and Info Term
to 0. At the same time, set InfoEnd to 1 tomake the conductor connected. An example of a jointed
conductor is shown in the following figure.
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Figure 9-117 A jointed shaded conductor for a ShadedPole Core

You create a separated conductor by changing InfoEnd to 0. Set InfoCore to 3 or 4 to create
conductor 1 or 2, respectively. Info Term remains 0. The following figure provides an example of the
separated conductor.

Figure 9-118 A separated shaded conductor for a ShadedPole Core

Introduction 9-90
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

You create terminals of a conductor by changing the Info Term to 1 or 2 for terminal1 or terminal2,
respectively. At the same time, InfoCore should be 3 or 4. Figure 9-119 shows the results of setting
the parameters.

Figure 9-119 A terminal of conductor for a ShadedPole Core

Creating a Core with Poly Holes

Normally a Shaded Pole Core UDP has only one pair of holes. In order to create a poly-hole Pole
Core UDP, you need to use subtraction andmove commands. Detailed steps are as follows.
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1. Create a core as described in Creating anOuter Shaded-Pole Core.

Figure 9-120 Original ShadedPoleCore

2. Make a copy of the current core.
3. Select the desired inner core in the history tree, and right-click to chooseEdit>Copy.

Figure 9-121 Copy ShadedPoleCore

4. Then right-click the same object in the history tree to chooseEdit>Paste. This process is
shown in the following figure:

Introduction 9-92
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Figure 9-122 Paste ShadedPoleCore

5. Change the new object to a Hole filler.
Click onCreateUserDefinedPart of ShadedPoleCore2 object and set InfoCore property to
5 in the pop-up window. The objects in the coordinate systemwindow are shown in the
following figure:

Figure 9-123 Change the InfoCore of the second ShadedPoleCore
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6. Move the hole filler to another position for subtraction.
7. Select the hole filler (ShadedPoleCore2) in the history tree.
8. ClickEdit>Arrange>Move from themenu. Themodeler switches tomovemode and

prompts you for a reference point in the status bar.

Figure 9-124 Move the position of the hole filler

9. Enter a reference point by clicking at the origin. Another option is to enter (0, 0, 0) in the
keyboard entry area of the status bar, and pressEnter.

10. Enter a target point along the Z-axis by clicking themouse along the axis. Another option is to
enter (30, 0, 0) in the keyboard entry area, and pressEnter, which is shown in the following
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figure.

Figure 9-125 Enter a target position

11. Choose the core (ShadedPoleCore1) and the hole filler (ShadedPoleCore2) to make a
subtraction.

12. Select both the core and hole filler by pressingCtrl on the keyboard.
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13. ClickModeler>Boolean>Subtract to subtract the two selected objects.

Figure 9-126 Choose Subtract operation from Boolean operation

14. In theSubtractwindow, put core (ShadedPoleCore1) in theBlank Parts and hole filler
(ShadedPoleCore2) in Tool Parts.
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Figure 9-127 Select the Blank Parts and Tool Parts

15. ClickOK to finish subtraction. The core look likes the following figure:

Figure 9-128 Finish subtraction

Another option is to copy and pastemultiple cores, change them to hole fillers andmove them to
different positions to create a core with more than 2 pairs of holes. The following figure shows a
sample hole:
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Figure 9-129 ShadedPoleCore with multiple poles

UnivMCore UDP

TheUnivMCore UDP is used to create the stator core and the field winding of a universal motor. It
can also create a coil terminal for current assignment.

Property Description
DiaGap Core diameter on gap side, or inner diameter.
DiaYoke Core diameter on yoke side, or outer diameter.
Length Core length.
Skew Skew angle in core length range.
Poles Number of poles.
PoleType Pole type: 1 to 2.
WidthCore Overall width of a racetrack core.
Embrace Pole embrace (the ratio of pole arc to pole pitch).
Offset Pole arc offset.
WidthPole Minimumwidth at pole root.
Ty Yoke thickness.
Ts Shoe-tip thickness.
R1 Radius of the screw holes in pole center.
R2 Radius of the side fillet arc at pole root.
R3 Radius of the side fillet arc center layout circle.
R4 Radius of the shoe connecting arc, 0 for auto-design.
R5 Inner radius of the screw holes in between two poles.
R6 Outer radius of the screw holes in between two poles.
EndExt Coil one-side end extended length.
LenRegion Region length.
InfoCore 0: core; 1: coils; 2: one coil; 3: terminal1; 4: terminal2; 100:

region.

These parameters are used in the following figures:

Note l In figureswith both gray and red objects, gray objects are used as references.
l Universal motor core is used as outer core, whichmeans the value of DiaYoke is
larger than that of DiaGap.

l Although R4 is drawn in Figure 9-130 , it is not easy to be understood. It is the radius
of a circle which is externally tangential to the circle of radius R2 and internally
tangential to the circle of diameter of Ts on the same side of a pole. R4 and the two

Introduction 9-98
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

circles that it is tangential to aremarked in red.When the value of R4 is 0, the length
of it is automatically designed.

Figure 9-130 Parameters in UnivM Core
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Figure 9-131 Two UnivM Core with different InfoCore value

Creating an Outer Universal Motor Core

This core is used only as an outer core. You can set the value ofDiaYoke andDiaGap as
DiaYoke>DiaGap to create an outer universal motor core. You can set the values either when
creating the core or after creating it, as described in Creating a Band and Creating anOuter Region,
respectively.
Set the InfoCore value to 0.
The following figure shows the results.

Figure 9-132 Outer universal-motor core

Creating All Coils (UnivMCore)

You can create all coils of a universal-motor coremanually by setting the property of InfoCoil to 1.
You can assign the value of this property either when creating a universal-motor core or after
creating it, as described in Creating a Band and Creating anOuter Region, respectively.
The following figure gives an example of all coils for this UDP.
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Figure 9-133 Coils of Universal-Motor Core

Creating a Coil and its Terminal (UnivMCore)

You can create a coil of a universal-motor coremanually by setting the property of InfoCoil to 2,
shown in Figure 9-131 as a red object.
You can create its terminals by setting the property of InfoCoil to 3 or 4 (for terminal1 and terminal2
respectively).Figure 9-134 showswhat a terminal looks like.
You can assign the value of this property either when creating a universal-motor core or after
creating it, as described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-134 A terminal of a coil of Universal-Motor Core

SRMCore UDP

The SRMCore UDP is used to create the stator core, a stator winding, and the rotor core for
switched reluctancemotors. It can also create a coil terminal for current assignment.

Property Description
DiaGap Core diameter on gap side, DiaGap<DiaYoke for outer cores.
DiaYoke Core diameter on yoke side, DiaYoke<DiaGap for inner cores.
Length Core length.
Poles Number of poles.
ThkYoke Yoke thickness.
Embrace Pole embrace (the ratio of pole arc to pole pitch).
EndExt Coil one-side end extended length.
LenRegion Region length.
InfoCore 0: core; 1: core & coils; 2: coil; 3: terminal1; 4: terminal2; 100:

region.

These parameters are used in the following figures.
Figure 9-137 shows the parameter EndExt, which is a parameter of a coil. The InfoCore value of
EndExt is 1 (core & coils) to better describe the parameter.
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Figure 9-135 Inner core of SRM Core (InfoCore set to 0)

Figure 9-136 Outer core of SRM Core (InfoCore set to 0)
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Figure 9-137 Core & coils of SRM Core (InfoCore set to 1)

Creating an Inner or Outer Core for Switched Reluctance Machines

You can set the value ofDiaYoke andDiaGap asDiaYoke<DiaGap to create inner cores or
DiaGap<DiaYoke for outer cores. You can set the values either when creating the core or after
creating it, as described in Creating a Band and Creating anOuter Region, respectively.
Set the InfoCore value to 0.
Examples of inner SRM core are shown in Figure 9-135 and Figure 9-138 . For outer core, refer to
Figure 9-136 and Figure 9-139 .
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Figure 9-138 3D inner core of SRM Core (InfoCore set to 0)

Figure 9-139 3D outer core of SRM Core (InfoCore set to 0)

Creating Core and All Coils (SRMCore)

You can create a core and all coils of an SRMCoremanually by setting the value of InfoCoil to 1.
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You can assign the value of this property either when creating an SRM core or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
Core and all coils can be created only when the core is an outer core (value ofDiaYoke > DiaGap).
Examples of this core are shown in Figure 9-137 and Figure 9-140 .

Figure 9-140 3D core and coils of SRM Core (InfoCore set to 1)

Creating a Coil and its Terminal (SRMCore)

You can create a coil of an SRM coremanually by setting the value of InfoCoil to 2. An example is
shown in Figure 9-141 .
You can create a terminal manually by setting the property of InfoCoil to 3 or 4, for terminal1 or
terminal2 respectively. An example is shown in Figure 9-142 .
You can assign the value of this property either when creating an SRM core or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-141 A single coil of an SRM Core

Figure 9-142 A terminal of a single coil

SynRMCore UDP

The SynRMCore UDP is used to create the rotor core for synchronous reluctancemachines.
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Property Description
DiaGap Core diameter on gap side, or outer diameter.
DiaYoke Core diameter on yoke side, or inner diameter.
Length Core length.
Poles Number of poles
PoleType 1: ALA; 2: arc; 3: hyperbolic; 4: hyperbolic line.
Barriers Barriers per Pole, for PoleType 2&3 only.
H Bridge thickness, for PoleType 2&3 only.
W Rib width, for PoleType 2&3 only.
R Barrier fillet radius, for PoleType 2&3 only.
R0 Radius of the bottom barrier arch, for PoleType 2

only.
Rb Barrier bottomminimum radius.
Y0 Yoke bottom thickness.
B0 Barrier bottom thickness, for PoleType of 2&3 only.
LenRegion Region length.
InfoCore 0: core; 1: one barrier; 100: region.

These parameters are used in the following figures:
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Figure 9-143 SynRM Core with PoleType set to 4

Creating an Inner Core for a Synchronous Reluctance Machine

You can set the value ofDiaYoke andDiaGap asDiaYoke<DiaGap to create inner cores. You can
set the value either when creating the core or after creating it, as described in Creating a Band and
Creating anOuter Region, respectively.
Set the InfoCore value to 0.
Figure 9-144 gives an example of an inner core for SynRM.

Figure 9-144 3D SynRM Core

Creating a SynRMCore with Different Barriers

You can create a SynRMCore with different barriers through several steps, as follows.
1. Create a SynRMCore as shown in Creating an Inner Core for a SynchronousReluctance

Machine.
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2. Change the value of Barriers to 1. The result is shown in the following figure.

Figure 9-145 A SynRMCore with one barrier

3. Change the value ofDiaGap to be larger andmake the value of Y0 smaller to make enough
space for other barriers. You canmodify these values by clicking onCreateUserDefinedPart
in the history tree under the SynRMCore, as shown in the following figure.
As an example, the values ofDiaGap andY0 are changed to 130 and 5, respectively.
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Figure 9-146 Changing the values of DiaGap and Y0

4. Make a copy (or multiple copies if more than 1 barrier is needed) of the current SynRMCore
object.
In the history tree, clickSynRMCore1, pressCtrl+C, and then pressCtrl+V to duplicate the
SynRMCore. After these processes, the history tree looks like the following figure (only for 1
copy situation):

Figure 9-147 Make a copy of SynRMCore

5. Change the value of InfoCore of SynRMCore2 to 1 to create a barrier.
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Figure 9-148 Changing the value of InfoCore of SynRMCore2

The result of this change is shown in the following figure.

Introduction 9-112
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Figure 9-149 Result of InfoCore of SynRMCore2 being changed

6. Change the value ofRb of SynRMCore2 (barrier) to make it larger, and thusmake the barrier
away from the center of the core.
As an example, the value ofRb of SynRMCore2 is changed from 15 to 25 by clicking on
CreateUserDefinedPart in the history tree under the SynRMCore2, as shown in the
following figure.
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Figure 9-150 Changing the value of Rb of SynRMCore2

Another option is to change other values of SynRMCore2 (barrier) according to different
needs, such as set the value ofW to 0.
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7. Then rotate the coordinate system. Objects in it should look like those in the following figure:

Figure 9-151 Before subtraction of two objects

8. Make a subtraction for two objects
Choose both objects simultaneously by pressingCtrl and clicking on two objects in the history
tree on the screen.
Then clickModeler>Boolean>Subtract to do the subtraction.
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Figure 9-152 Make a subtraction

The SynRMCore1 should be inBlank Partswhereas SynRMCore2 is in Tool Parts, as
shown in the follow figure.
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Figure 9-153 Choosing Blank Parts and Tool Parts

9. ClickOK to finish subtraction. A SynRMCore with different barriers is shown in the following
figure.
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Figure 9-154 After subtraction

Tomake the barriers look different, you can change the parameters of barriers likeW andB0. Also,
repeating the processes canmakemultiple barriers.

ClawPoleCore UDP

TheClawPoleCore UDP is used to create the claw-pole rotor core, a field winding and/or a PM for
claw-pole alternators. It can also create a coil terminal for current assignment.

Property Description
DiaGap Core diameter on gap side, DiaGap<DiaShaft for outer cores.
DiaShaft Core diameter on shaft side, DiaShaft<DiaGap for inner cores.
Length Core length.
Poles Number of poles.
EmbraceTip Embrace of pole tip.
EmbraceRoot Embrace of pole root.
ThickTip Thickness of pole tip.
ThickRoot Thickness of pole root.
ThickShoe Thickness of side shoes.
DepthSlot Depth of slot between two poles.
ThickYoke Thickness of yoke.
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Property Description
LengthPole Length of pole from tip to tip.
LengthMag Length of magnet or the second air-gap.
SegAngle Deviation angle for skewed pole sides (1~10, <1 for true

surface).
LenRegion Region length.
InfoCore 0: core; 1: core & coil; 2: coil; 3: magnet; 4: terminal; 100: region.

These parameters are used in the following figures. Figure 9-156 is in transparent to show
parametersEmbraceTip andEmbraceRootwhich otherwise are hard to show. For LengthMag
parameter, refer to Figure 9-161 .

Figure 9-155 Claw Pole Core (InfoCore set to 0)
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Figure 9-156 Transparent Claw Pole Core (InfoCore set to 0)

Figure 9-157 3D Claw Pole Core (InfoCore set to 0)
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Creating an Inner Claw Pole Core

Set the value ofDiaShaft andDiaGap asDiaShaft<DiaGap to create an inner claw pole core. You
can set the value either when creating the core or after creating it, as described in Creating a Band
and Creating anOuter Region, respectively.
Set the InfoCore value 0.
Examples of inner claw-pole core are shown in Figure 9-155 , Figure 9-156 , and Figure 9-157 .

Creating a Coil and its Terminal (Claw Pole)

You can create a coil of a claw pole coremanually by setting the value of InfoCoil to 2. An example
is shown inFigure 9-158 .
You can create a terminal of a claw pole coremanually by setting the value of InfoCoil to 4. Figure 9-
159 gives an example of this terminal.
You can assign the value of this property either when creating a claw-pole core or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.

Figure 9-158 Coil of a claw-pole core
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Figure 9-159 A terminal of coil in this claw-pole core

Creating a Magnet (Claw Pole)

To create amagnet, you need to set the value of LengthMag larger than 0 (by default, it is 0) and
value of InfoCore to be 3. An example is shown in the following figure.

Figure 9-160 A magnet of ClawPoleCore

The following figure visualizes the LengthMag parameter.
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Figure 9-161 LengthMag of a magnet of ClawPoleCore

You can assign the value of these properties either when creating a claw-pole core or after creating
it, as described in Creating a Band and Creating anOuter Region, respectively.

PMCore UDP

The PMCore UDP is used to create a PM stator/rotor core and a PM for PM commutating DC
machines, PM adjustable-speed synchronousmachines, or PM brushlessDC motors.

Property Description
DiaGap Core diameter on gap side, DiaGap<DiaYoke for outer cores.
DiaYoke Core diameter on yoke side, DiaYoke<DiaGap for inner

cores.
Length Core length.
Poles Number of poles.
PoleType Pole type: 1 to 5.
Embrace Pole embrace (not for type 4).
ThickMag Max thickness of magnets.
WidthMag Magnet width (for types 4 & 5).
Offset Pole arc offset (for types 1, 2 & 3).
Bridge Bridge thickness (for type 5 only).
Rib Rib width (for type 5 only), Rib=0 for rectangle ducts.
LenRegion Region length.
InfoCore 0: core; 1: magnets; 2: magnet; 100: region.

These parameters are used in the following figures:
Figure 9-163 shows theOffset parameter when value of PoleType is 3.
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Figure 9-162 PM Core with PoleType set to 5 (InfoCore set to 0)

Figure 9-163 PM Core with PoleType set to 3 (InfoCore set to 0)
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Creating an Inner or Outer PM Core

Set the value ofDiaYoke andDiaGap asDiaYoke<DiaGap to create inner cores or
DiaGap<DiaYoke for outer cores. In addition, r to create an outer core, thePole Typemust be 1 or
2. You can set the values either when creating the core or after creating it, as described in Creating a
Band and Creating anOuter Region, respectively.
Set the InfoCore value to 0.
An inner PM core and an outer PM core are shown in Figure 9-164 and Figure 9-165 , respectively.

Figure 9-164 Inner PM core with PoleType set to 5 (InfoCore set to 0)
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Figure 9-165 Outer PM core with PoleType set to 2 (InfoCore set to 0)

Creating All Magnets (PMCore)

You can create all magnets of a PM coremanually by setting the value of InfoCore to 1. An example
is shown in the following figure.
You can assign the value of this property either when creating a PMCore or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-166 All magnets of a PM core

Creating a Magnet (PM Core)

You can create amagnet of a PM coremanually by setting the value of InfoCore to 2. An example is
shown in the following figure.
You can assign the value of this property either when creating a PM core or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-167 A magnet of PM Core

IPMCore UDP

The IPMCore UDP is used to create an IPM core and a PM for IPM synchronousmachines or IPM
brushlessDC motors.

Property Description
DiaGap Core diameter on gap side, or outer diameter.
DiaYoke Core diameter on yoke side, or inner diameter.
Length Core length.
Poles Number of poles.
PoleType Pole type: 1 to 6.
D1 Limited diameter of PM ducts.
O1 Bottomwidth for separate or flat-bottom duct (for types 3~6).
O2 Distance from duct bottom to shaft surface (for types 2~6).
B1 Duct thickness.
Rib Rib width.
HRib Rib height (for types 3~5).
DminMag Minimumdistance between sidemagnets (for types 3~5).
ThickMag Magnet thickness.
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Property Description
WidthMag Total width of all magnet per pole.
LenRegion Region length.
InfoCore 0: core; 1: magnets; 2: ducts; 3: one-polemagnet; 100:

region.

Most parameters of IPMCore UDP are shown in the following figure except those common
parameters likeDiaGap,DiaYoke and Length.

Figure 9-168 Parameters of IPM Core

Creating an Inner IPM Core

Set the value ofDiaYoke andDiaGap asDiaYoke<DiaGap to create an inner IPM core. You can
set the value either when creating the core or after creating it, as described in Creating a Band and
Creating anOuter Region, respectively.
Set the InfoCore value to 0.
An example is shown in the following figure.
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Figure 9-169 Inner IPM Core

Creating All Magnets (IPM Core)

You can create all magnets of an IPM coremanually by setting the value of InfoCoil to 1.
You can assign the value of this property either when creating an IPMCore or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
An example is shown in the following figure.
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Figure 9-170 All magnets of IPM core

Creating One-Pole Magnets

You can create one-polemagnets of an IPM coremanually by setting the property of InfoCoil to 3.
You can assign the value of this property either when creating an IPM core or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
The following figure shows an example of one-polemagnets.

Figure 9-171 One-pole magnets of an IPM Core

PMDamperCore UDP

The PMDamperCore UDP is used to create the PM rotor core with damper for line-start PM
synchronousmachines.

Property Description
DiaGap Core diameter on gap side, or outer diameter.
DiaYoke Core diameter on yoke side, or inner diameter.
Length Core length.
Skew Skew angle in core length range.
Slots Number of damper slots per pole.
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Property Description
SlotType Slot type: 1 to 4.
Hs0 Slot opening height.
Hs01 Slot closed bridge height.
Hs1 Slot wedge height.
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
FilletType 0: a quarter circle; 1: tangent connection; 2&3: arc bottom.
Poles Number of poles.
PoleType Pole type: 1 to 8.
D1 Limited diameter of PM ducts.
O1 A locating dimension of PM ducts, for pole types 3, 4, 7 & 8.
O2 A locating dimension of PM ducts, for pole types 1, 3, 5, 6, 7 &

8.
B1 Barrier width, for pole types 1, 2 & 3.
Rib Rib to hold PM ducts, for pole types 1 to 7.
ThickMag Magnet thickness.
WidthMag Total width of all magnet per pole.
BarEndExt One-side damper bar end extended length.
RingLength One-side axial ring length.
RingHeight Radial ring height.
SegAngle Deviation angle for slot arches (10~30, <10 for true surface).
LenRegion Region length.
InfoCore 0: core; 1: magnets; 2: damper; 100: region.

These parameters are used in the following figures:

Note l ParametersO1 andO2 are locating dimensions of PM ducts. Theymay have
different meanings in different pole types. For example, Figure 9-172 showswhat
O1 andO2 refer to in PMDamper Core with Pole Type 3.

l In Figure 9-173 and Figure 9-174 , the gray object (a PMDamperCore with InfoCore
set to 0) is used as reference to show the red object (a PMDamperCore with
InfoCore set to 2)

l For parameters such asDiaGap, DiaYoke, Length,Skew, Fillet Type, SegAngle
and parameters related to slots, refer to SlotCore UDP parameters.
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Figure 9-172 PMDamperCore with Pole Type set to 3

Figure 9-173 Damper of PMDamperCore (red)
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Figure 9-174 3D Damper of PMDamperCore (red)

Creating an Inner PM Damper Core

Set the value ofDiaYoke andDiaGap asDiaYoke<DiaGap to create an inner PM damper core.
You can set the value either when creating the core or after creating it, as described in Creating a
Band and Creating anOuter Region, respectively.
Set the InfoCore value to 0.
An example is given in the following figure.
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Figure 9-175 Inner PM damper core

Creating a Damper (PM Damper Core)

You create a damper of a PM damper coremanually by setting the value of InfoCoil to 2.
You can assign the value of this property either when creating a PMdamper core or after creating it,
as described in Creating a Band and Creating anOuter Region, respectively.
Examples are shown in Figure 9-174 as a red object and Figure 9-176 .
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Figure 9-176 A damper

Creating all Magnets (PM Damper Core)

You can create all magnets of a PM damper coremanually by setting the value of InfoCoil to 1.
You can assign the value of this property either when creating a PMdamper core or after creating it,
as described in Creating a Band and Creating anOuter Region, respectively.
An example is shown in the following figure. Note that this example is realized when the value of
PoleType is 3.

Figure 9-177 All Magnets

Creating a Magnet (PM Damper Core)

You can create amagnet of a PM damper core by setting the InfoCore value to -1, -2 or -3
according to the number of magnets for each pole of the core.
For instance, whenPole Type is equal to 3 (which is shown in Figure 9-177 ), there is only 1magnet
for a pole. In this situation, setting the value of InfoCore to be -1 can create amagnet. An example is
shown in the following figure.
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Figure 9-178 A magnet when Pole Type is set to 3

When there are 2magnets for a pole of a PM damper core (for example, whenPole Type is 5),
setting the value of InfoCore to be -1 can create one of these 2magnets while setting the value of
InfoCore to be -2 can create another one.
For instance, Figure 9-179 shows all magnets of a PM damper core whenPole Type is 5, whereas
Figure 9-180 and Figure 9-181 present one of twomagnets for a pole, by setting InfoCore value to
be -1 and -2 respectively.

Figure 9-179 A PM damper core when Pole Type is 5 and InfoCore is 1
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Figure 9-180 A PM damper core when Pole Type is 5 and InfoCore is -1

Figure 9-181 A PM damper core when Pole Type is 5 and InfoCore is -2

Similarly, when a pole of PM damper core has 3 or moremagnets (such aswhen InfoCore is 6), you
can create a singlemagnet by setting the value of InfoCore to -1, -2, -3 and so on.
You can assign the value of these properties either when creating a PMdamper core or after
creating it, as described in Creating a Band and Creating anOuter Region, respectively.

UDPs for Other Cores and Coils

UDPs defined for other cores and coils include:
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l DiskSlotCore UDP
l DiskCoil UDP
l DiskPMCore UDP
l LinearMCore UDP
l TransCore UDP
l TransCoil UDP
l TransTwist UDP

DiskSlotCore UDP

TheDiskSlotCore UDP is used to create a stator/rotor core for axial-fluxmachines. It can also create
a squirrel-cage winding of the axial-flux type.

Property Description
DiaOuter Core outer diameter.
DiaInner Core inner diameter.
Thickness Core axial thickness per side.
Gap Gap between core & xy plane (>0: upper; <0: lower; =0: double-

sided).
Skew Skew angle.
Slots Number of slots.
SlotType Slot type: 1 to 6.
Hs0 Slot opening height.
Hs01 Slot closed bridge height.
Hs1 Slot wedge height.
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
FilletType 0: a quarter circle; 1: tangent connection.
HalfSlot 0: symmetric slots; 1: half slots.
RingLength One-side radial ring length.
RingHeight Axial ring height.
SegAngle Deviation angle for slot arches (10~30, <10 for true surface).
InfoCore 0: core only; 1: squirrel cage only.

These parameters are used in the following figures.
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Note l For parameters such asSkew, Fillet Type, SegAngle,HalfSlot and parameters
related to slots, refer to SlotCore UDP parameters.

l Figures are shown in pairs to compare parameters when the InfoCore value varies.

Figure 9-182 Overview of DiskSlotCore (InfoCore set to 0)
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Figure 9-183 DiskSlot Core (InfoCore set to 0)

Figure 9-184 DiskSlot Core (InfoCore set to 1)
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Figure 9-185 3D DiskSlot Core (InfoCore set to 0)

Figure 9-186 3D DiskSlot Core (InfoCore set to 1)

Creating an Upper or Lower Axial-FluxSlot Core (DiskSlot Core)

You can create an axial-flux slot core of a DiskSlot Coremanually by setting the value of InfoCore to
0.
For an upper core, set the value ofGap to be larger than 0, as shown in Figure 9-182 and Figure 9-
185 ; for a lower core, set this value to be smaller than 0, which is shown in Figure 9-187 .
You can assign the value of this property either when creating a DiskSlot core or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-187 Lower axial-flux slot core

Creating a Squirrel-Cage Winding

You can create squirrel-cage winding of a DiskSlot coremanually by setting the property of
InfoCore to 1. An example of squirrel-cage winding is shown in Figure 9-184 .
You can assign the value of this property either when creating an axial-flux slot core or after creating
it, as described in Creating a Band and Creating anOuter Region, respectively.

DiskCoil UDP

TheDiskCoil UDP is used to create a lap-type coil in an axial-flux slotted core created by the
DiskSlotCore UDP for axial-fluxmachines. It can also create a coil terminal for current assignment.

Property Description
DiaOuter Core outer diameter.
DiaInner Core inner diameter.
Thickness Core axial thickness per side.
Gap Gap between core & xy plane (>0: upper; <0: lower; =0: double-

sided).
Skew Skew angle.
Slots Number of slots.
SlotType Slot type: 1 to 7.
Hs0 Slot opening height.
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Property Description
Hs1 Slot wedge height.
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
FilletType 0: a quarter circle; 1: tangent connection.
Layers Number of winding layers.
CoilPitch Coil pitchmeasured in slots.
EndExt One-side radial end extended length.
EndClr Clearance between two end spans; 0 for no span.
SegAngle Deviation angle for end span (5~15, <5 for true surface).
InfoCoil 0: winding; 1: coil; 2: terminal.

Note l For parameters such asSkew, Fillet Type, SegAngle,HalfSlot and parameters
related to slots, refer to SlotCore UDP parameters.

l Figure 9-189 can be used in comparison to Figure 9-188 to show CoilPitch
parameter.

l A DiskSlot core is used as reference in Figure 9-190 to show EndExt andEndClr
parameters.
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Figure 9-188 All disk coils (InfoCore set to 0)

Figure 9-189 One disk coil (InfoCore set to 1)
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Figure 9-190 EndExt and EndClr parameters (InfoCore set to 0)

Figure 9-191 Gap and Thickness parameters (InfoCore set to 0)

Creating a Whole Winding (Upper or Lower)

You can create a whole winding of a DiskCoil Coremanually by setting the property of InfoCoil to 0.
For an upper core, set the value ofGap to be larger than 0, which is shown in Figure 9-191 ; for a
lower core, set this value to be smaller than 0, which is shown in Figure 9-192 .You can assign the
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value of this property either when creating the DiskCoil or after creating it, as described in Creating a
Band and Creating anOuter Region, respectively.

Figure 9-192 Lower whole winding

Creating a Lap Coil and its Terminals

You can create a lap coil of a DiskCoil manually by setting the value of InfoCoil to 1. An example is
shown in Figure 9-189 .
You can create a terminal of a DiskCoil manually by setting the value of InfoCoil to 2. An example is
shown in Figure 9-193 .
You can assign the value of this property either when creating a DiskCoil or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.

Introduction 9-147
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Figure 9-193 A terminal of a DiskCoil UDP

DiskPMCore UDP

TheDiskPMCore UDP is used to create a PM core of the axial-flux type for axial-flux PMmachines.

Property Description
DiaOuter Core outer diameter.
DiaInner Core inner diameter.
Thickness Core axial thickness per side.
Gap Gap between core & xy plane (>0: upper; <0: lower; =0: double-

sided).
Skew Skew angle.
Poles Number of poles.
Embrace Pole embrace.
ThickMag Magnet axial thickness per side.
InfoCore 0: core only; 1: all PMs; 2: one PMonly.

Note There are two objects in each of the following figures. Both objects in each figure are
DiskPMCore. The value of InfoCore of one DiskPMCore is 1 (red object), the other’s is 0
(gray object).
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Figure 9-194 DiskPM core parameters on x-y plane

Figure 9-195 DiskPM core parameters in axial direction
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Creating an Upper or Lower Axial-Flux PM Core

You can create an axial-flux PM core of a DiskPM coremanually by setting the value of InfoCore to
0.
For an upper core, set the value ofGap to be larger than 0; for a lower core, set this value to be
smaller than 0.
An example of an upper core is shown in Figure 9-196 , whereas a lower core is in Figure 9-197 .
You can assign the value of this property either when creating a Disk PM core or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.

Figure 9-196 . Upper axial-flux PM core

Figure 9-197 Lower axial-flux PM core
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Creating All Magnets (Disk PM Core)

You can create all magnets of a disk PM coremanually by setting the value of InfoCoil to 1. An
example of all magnets is shown in Figure 9-194 and Figure 9-195 as a red object.
You can assign the value of this property either when creating a disk PM core or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.

Creating One Magnet Only (Disk PM Core)

You can create a singlemagnet of a disk PM coremanually by setting the property of InfoCoil to 2.
An example of onemagnet is shown in Figure 9-198 .
You can assign the value of this property either when creating a disk PM core or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.

Figure 9-198 One magnet of disk PM core

LinearMCore UDP

The LinearMCore UDP is used to create themover core and the armature winding for linear motors.
It can also create a coil terminal for current assignment.

Property Description
WidthCore Core width in motion direction.
ThickCore Core thickness.
Length Core length.
SlotPitch The distance between two slots.
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Property Description
Slots Number of slots.
SlotType Slot type: 1 to 7.
Hs0 Slot opening height.
Hs1 Slot wedge height.
Hs2 Slot body height.
Bs0 Slot opening width.
Bs1 Slot wedgemaximumwidth.
Bs2 Slot body bottomwidth, 0 for parallel teeth.
Rs Slot body bottom fillet.
Layers Number of winding layers.
CoilPitch Coil pitchmeasured in slots.
EndExt One-side end extended length.
SpanExt Axial length of end span; 0 for no span.
SegAngle Deviation angle for slot arches (10~30, <10 for true

surface).
InfoCore 0: core only; 1: core & all coils; 2: one coil only.

Note l For parameters such asSegAngle and parameters related to slots, refer to SlotCore
UDP parameters.

l The InfoCore values of the following two figures are both 1 to better describe other
parameters such asEndExt andSpanExt.
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Figure 9-199 Parameters of LinearMCore in x-y plane (InfoCore set to 1)

Figure 9-200 Parameters of LinearMCore in axial direction (InfoCore set to 1)

Creating a Linear Machine Core

You can create a linear machine coremanually by setting the value of InfoCore to 0.
An example of a linear machine core is shown in Figure 9-201 .
You can assign the value of this property either when creating a linear-machine core or after creating
it, as described in Creating a Band and Creating anOuter Region, respectively.

Figure 9-201 Linear Machine Core (InfoCore set to 0)
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Creating a Core and All Coils (Linear Machine Core)

You can create a core and all coilsmanually by setting the value of InfoCore to 1. An example of a
core and all coils of a linear-machine core is shown in Figure 9-202 .
You can assign the value of this property either when creating a linear machine core or after creating
it, as described in Creating a Band and Creating anOuter Region, respectively.

Figure 9-202 A core and all coils of a linear machine core (InfoCore set to 1)

Creating One Coil Only (Linear Machine Core)

You can create a one coil onlymanually by setting the value of InfoCore to 2.
An example of a coil of a linear machine core is shown in Figure 9-203 .
You can assign the value of this property either when creating a linear machine core or after creating
it, as described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-203 One coil of a linear machine core (InfoCore set to 2)

TransCore UDP

The TransCore UDP is used to create a three-leg transformer core for three-phase transformers.

Property Description
DiaLeg Outer diameter of leg cross-section.
DistLeg Leg center to center distance.
DistYoke Yoke center to center distance.
Stages Number of stages of leg cross-section.
ThickCore Core thickness, only used for Stages = 1.
WidthYoke Yoke width, =0 for same cross-section as

leg's.
InfoCore 0: whole core; 1: legs only; 2: yokes only.

Note Figure 9-204 , Figure 9-205 , and Figure 9-206 show a TransCore UDP with different
values of Stages andWidthYoke.
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Figure 9-204 TransCore when Stages is not 1 and WidthYoke is 0

Figure 9-205 TransCore when Stages is not 1 and WidthYoke is not 0
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Figure 9-206 TransCore when Stages is 1 and WidthYoke is not 0

Figure 9-207 Parameters of TransCore in axial direction (when Stages is 1 and WidthYoke
is not 0)
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Creating a Three-Leg Transformer Core

You can create a three-leg transformer coremanually by setting the value of InfoCore to 0.
Examples of a three-leg transformer core are shown in Figure 9-204 , Figure 9-205 , Figure 9-206 ,
and Figure 9-207 .
You can assign the value of this property either when creating a three-leg transformer or after
creating it, as described in Creating a Band and Creating anOuter Region, respectively.

Creating Three Legs Only

You can create three legs of the coremanually by setting the value of InfoCore to 1.
An example of three legs is shown in Figure 9-208 .
You can assign the value of this property either when creating a three-leg transformer core or after
creating it, as described in Creating a Band and Creating anOuter Region, respectively.

Figure 9-208 Three legs of TransCore (InfoCore set to 1)

Creating Two Yokes Only

You can create two yokes of the coremanually by setting the value of InfoCore to 2.
An example of two yokes is shown in Figure 9-209 .
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You can assign the value of this property either when creating a three-leg transformer core or after
creating it, as described in Creating a Band and Creating anOuter Region, respectively.

Figure 9-209 Two Yokes of TransCore (InfoCore set to 2)

TransCoil UDP

The TransCoil UDP is used to create a coil in a three-leg transformer core created by the TransCore
UDP for three-phase transformers. It can also create a coil terminal for current assignment.

Property Description
DistLeg Leg center to center distance.
CoilType Coil type: 1 for solenoid coil; 2 for pancake

coil.
WidthIn Coil width between two inner sides.
DepthIn Coil depth between two inner ends.
RadiusIn Coil inner fillet radius.
ThickCoil Coil thickness of one side.
HighCoil Coil height.
Layers Number of layers.
GapLayer Gap between two layers.
InfoCore 0: all coils; 1: one coil only.
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Note The key tomaking the cross-section of each layer of a coil to be a circle is to set the value of
WidthIn equal to that ofDepthIn and at the same time set the value ofRadiusIn to be half
of that ofWidIn. That is,WidthIn=DepthIn=2*RadiusIn.
The cross-section of a layer could be a non-circle if the value ofWidthIn is not equal to that
ofDepthIn orRadiusIn’s value is not half ofWidthIn’s. Figure 9-212 shows a situation
where a layer is a non-circle.

Figure 9-210 Overview of TransCoil (InfoCore set to 0)

Figure 9-211 Parameters of TransCoil in x-y plane (InfoCore set to 0)
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Figure 9-212 RadiusIn of TransCoil

Figure 9-213 Parameters of TransCoil in axial direction (InfoCore set to 0)

Creating Coils for All Three Legs

You can create coils for three legsmanually by setting the value of InfoCore to 0.
Examples of coils for TransCoil UDP are shown in Figure 9-210 , Figure 9-211 , and Figure 9-213 .
You can assign the value of this property either when creating a TransCoil UDP or after creating it,
as described in Creating a Band and Creating anOuter Region, respectively.
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Creating One-Leg Coil Only

You can create a one-leg coil manually by setting the value of InfoCore to 1.
An example of a one-leg coil for a TransCoil UDP is shown in Figure 9-214 .
You can assign the value of this property either when creating a TransCoil UDP or after creating it,
as described in Creating a Band and Creating anOuter Region, respectively.

Figure 9-214 One-leg coil for TransCoil UDP

TransTwist UDP

Property Description
CoreType 1: shell-type; 2: core-type.
WidthOut Core outer width.
DepthOut Core outer depth in coil turn direction.
RadiusOut Core outer fillet radius.
WidthIn Core window width.
DepthIn Core window depth in coil turn direction.
RadiusIn Core window fillet radius.
DistCenters Window center-to-center distance, for shell-type only.
HeightCore Core height.
Coils Number of coils: 1 or 2.
WiresCoil Wires per coil: 1, 2, 3, or 4 (no twist for 1 wire).
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Property Description
TurnsCoil Number of turns per coil.
TurnsTwist Total twist turns in one coil turn; 360 degrees in one twist turn.
DiaWire Wire diameter.
Segments Polygon segments for wire cross section: <=2 for true circle.
InsType Insulator type: 1: round insulator; 2: filleted square insulator.
ThickIns Outer minimum thickness of insulator.
GapWires The gap between two round wire profiles.
GapEndTurns The gap between two end turns of round insulator profiles.
GapCoreIns The gap between core and round insulator profiles inside two windows and at two

ends.
LeadExt Lead extension from lead terminal to core end terminal.
InfoCore 0: All; 1: Core; 2: Insulator; 3-6: Wires of coil#1; 7-10:Wires of coil#2.
InfoTerm 0: 3D wire; 1: 2D go-term; 2: 2D re-term (for InfoCore = 3-10 only).

Figure 9-215 Overview of TransTwist UDP (without wires)
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Figure 9-216 Overview of TransTwist UDP (with colorful wires)

Note l Figure 9-215 and Figure 9-216 give an overview of the TransTwist UDP. The
difference between them is Figure 9-216 has 4 colorful wires inside the insulator
whereas Figure 9-215 has nothing in its insulator.

l InFigure 9-215 and Figure 9-216 and also other figures like Figure 9-220 , objects in
different colors are all TransTwist UDP but with different InfoCore values. For
example, in Figure 1-6 , the gray object is a TransTwist UDP whose InfoCore value
is 1(core), while red, blue, green and yellow objects (wires) are also TransTwist
UDPswhose InfoCore values are 3, 4, 5, and 6 respectively. Also, the value of the
InfoCore of pink tube that covers the wires is 2 (insulator). To draw this kind of
figure, copy and paste the TransTwist UDP (or manually createmultiples of this
UDP) and then change their InfoCore values and colors.

l The reason for making colorful figures here is to show the parameters of the
TransTwist UDPmore clearly.

l The difference between Figure 9-218 and Figure 9-219 is the parameter
TurnsCoil, whichmeans the number of turns for each coil (only one coil in each
figure). There are 2 turns for the coil in Figure 1-4 whereas there is only 1 turn for the
coil in Figure 9-219 .

l The purpose ofFigure 9-221 is to show the concept of the parameterCoils. Note
that when the value ofCoils is 2 in this figure, the two coils are disconnected. For a
comparison, see the one coil shown in Figure 9-220 .

l The purpose of Figure 9-222 is to show the parameter ofGapEndTurns, which is
useful only when the value of TurnsCoil is larger than 2.

l The results of parameter TurnsTwist are difficult to show in a figure. It is used to
define the number of twist turns in one coil turn for each coil (or wire). As shown in

Introduction 9-164
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Figure 9-224 , the green wire is twisted 0.5 turn at the bottom of the core. Then, for
the entire coil turn, it may be twisted 3 to 3.5 twist turns (0.5 to 1 turn on the top of the
core, and 1 turn on each side of the core).

Figure 9-217 2D parameters of TransTwist UDP (InfoCore set to 1)

Figure 9-218 3D parameters of TransTwist UDP (gray Object: InfoCore set to 1, Red
Object: InfoCore set to 2)
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Figure 9-219 3D parameters of TransTwist UDP (gray Object: InfoCore set to 1, Red
Object: InfoCore set to 2)
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Figure 9-220 Gaps-related parameters of TransTwist UDP (gray Object: InfoCore set to 1,
Red Object: InfoCore set to 2, Colorful Wires: InfoCore set to 3 to 6)

Figure 9-221 Coil-related parameters of TransTwist UDP (gray Object: InfoCore set to 1,
Red Object: InfoCore set to 2)

Figure 9-222 GapEndTurns of TransTwist UDP (gray Object: InfoCore set to 1, Red
Object: InfoCore set to 2)
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Figure 9-223 Wires-related parameters of TransTwist UDP (gray Object: InfoCore set to 1,
Red Object: InfoCore set to 2, Colorful Wires: InfoCore set to 3 to 6)

Figure 9-224 LeakEndExt of TransTwist UDP (gray Object: InfoCore set to 1, Red Object:
InfoCore set to 2, Colorful Wires: InfoCore set to 3 to 6)
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Creating a Core and All Twist Coils

You can create a core and all twist coilsmanually by setting the value of InfoCore to 0, which is set by
default in Maxwell.
An example of a core and all twist coils is shown in Figure 9-225 .
You can assign the value of this property either when creating the UDP or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.

Figure 9-225 TransTwist UDP (InfoCore set to 0)

Creating a Twist Wire and its Terminals

You can create a twist wire of a TransTwist manually by setting the value of InfoCore to 3 to 6 (or 7-
10 for coil #2) and Info Term to 0. Examples are shown in Figure 9-216 , Figure 9-219 , Figure 9-
223 , and Figure 9-224 as red, green, blue and yellow objects.
You can create a terminal of a wiremanually by setting the value of InfoCore to 3 to 6 (or 7-10 for
coil #2) and Info Term to 1 or 2 (for 2D go-term and 2D re-term respectively). An example is shown
in Figure 9-226 below.
You can assign the value of this property either when creating a TransTwist or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.

Introduction 9-169
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Figure 9-226 2D go-terminal of a wire

Creating a Twist Insulator of All Coils

You can create an insulator of all coilsmanually by setting the value of InfoCore to 2 and Info Term
to 0. An example is shown in Figure 9-227 .
You can assign the value of this property either when creating a TransTwist or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.
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Figure 9-227 Twist insulator of all coils
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Helix UDPs
Helix UDPs are shapes of inductance design and are widely used in electronic devices and signal
integrity area.
Helix UDPs consist of the following types:

l PolygonHelix UDP
l RectHelix UDP

PolygonHelix UDP

The shape of the cross-section of a PolygonHelix is a polygon.

Property Description
PolygonSegments Number of cross-section polygon segments, 0 for

circle.
PolygonRadius Outer radius of cross-section polygon.
StartHelixRadius Start radius from polygon center to helix center.
RadiusChange Radius change per turn.
Pitch Helix pitch.
Turns Number of turns.
SegmentsPerTurn Number of segments per turn, 0 for true surface.
RightHanded Helix direction, non-zero for right handed.
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Figure 9-1 Overview of PolygonHelix UDP

Note Figure 9-1 is an overview of the PolygonHelix UDP. “Polygon” means the cross-section of
the helix is a polygon, which by default is a square (PolygonSegments set to 4).
Polygon helices in Figure 9-2 and Figure 9-3 have the default settings of this UDP,
whereas each of the polygon helices in Figure 9-4 to Figure 9-8 has only one parameter
value that is different from the defaults shown in Figure 9-2 and Figure 9-3 .
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Figure 9-2 Parameters of PolygonHelix UDP on x-y plane.

Figure 9-3 Parameters of PolygonHelix UDP on axial direction.
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Figure 9-4 Different RadiusChange value (non-zero); the value in Figure 9-2 is 0.

Figure 9-5 Different SegmentsPerTurn value (24); the value in Figure 9-2 is 36.
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Figure 9-6 Left-handed (RightHanded set to 0) helix; Figure 9-3 shows a right-handed
helix.

Figure 9-7 Different PolygonSegments value (6); the value in Figure 9-3 is 4.

Helix UDPs 9-5
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Figure 9-8 Different Turns value (3); the value inFigure 9-3 is 2.

Creating a Right-Handed or Left-Handed Polygon Helix

You can create a right-handed polygon helixmanually by setting the value ofRightHanded to 1 (or
any non-zero value), which is set by default in Maxwell.
You can create a left-handed polygon helix by settingRightHanded to 0.
Examples of right- and left-handed polygon helices are shown in Figure 9-3 and Figure 9-6 ,
respectively.
You can assign the value of this property either when creating the UDP or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.

RectHelix UDP

The shape of the cross-section in a RectHelix is a rectangle.

Property Description
RectHeight Cross-section rectangle height in z direction.
RectWidth Cross-section rectangle width in r direction.
StartHelixRadius Start radius from rectangle center to helix

center.
RadiusChange Radius change per turn.
Pitch Helix pitch.
Turns Number of turns.
SegmentsPerTurn Number of segments per turn, 0 for true

surface.
RightHanded Helix direction, non-zero for right handed.
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Figure 9-9 Overview of RectHelix UDP

Note l Themajor difference between the RectHelix UDP and the PolygonHelix UDP is the
shape of the cross-sections of the helices. In RectHelix, the shape of its cross-section
is a rectangle whereas that of PolygonHelix is a polygon.

l Except forRectHeight andRectWidth, parameters are the same as those in the
Polygon Helix UDP. The one figure in this section describesRectHeight and
RectWidth.

l For all other parameters, refer to Polygon Helix UDP.
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Figure 9-10 RectHeight and RectWidth in RectHelix UDP

Creating a Right-Handed or Left-Handed Rectangle Helix

You can create a right-handed rectangle helixmanually by setting the value ofRightHanded to 1 (or
any non-zero value), which is set by default in Maxwell.
You can create a left-handed rectangle helix by settingRightHanded to 0.
Examples of right-handed and left-handed rectangle helices are shown in Figure 9-8 and Figure 9-
11 , respectively.
You can assign the value of this property either when creating the UDP or after creating it, as
described in Creating a Band and Creating anOuter Region, respectively.

Figure 9-11 Left-handed rectangle helix
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Information about Coding UDPs
This chapter uses an example of a Band UDP to provide information about how to write source code
for a new UDP classwhen needed.

l Intrinsic Head Files presents some of the intrinsic structures and functions for all UDPs
l Code Implementation uses a Band UDP to illustrate what functions or procedures are needed
to create a new UDP

Intrinsic Head Files

The following sections provide information on Intrinsic Structure Definitions and Intrinsic Function
Declarations.

Head File for Intrinsic Structure Definition

Many intrinsic structures are written in C++ for UDPs. These intrinsic structures are provided in the
UserDefinedPrimitiveStructures.h file (under directory: AnsysEM\Maxwell
[x.x]\Win64\UserDefinedPrimitives\Examples\Headers).
Here are some common intrinsic structures that you need to know before starting coding for UDPs:
UDPPosition
Defines themost common and basic structure in a coordinate system, which is used to describe a
point in the system.

struct UDPPosition
{
double x;
double y;
double z;
};

UDPPolylineDefinition
Defines the structure of polyline in a UDP, which is used to create sheets or lines in a UDP.

struct UDPPolylineDefinition
{
int noOfPoints;
struct UDPPosition* arrayOfPosition;
int noOfSegments;
struct UDPPolylineSegmentDefinition* arrayOfSegmentDefinition;
int isClosed;
int isCovered; /* Only if it is closed, then it can be covered
*/
};

UDPPrimitiveParameterDefinition
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Defines the parameter/property definition of each UDP, such asDiaGap,DiaYoke and Length in the
Properties window of each UDP. A definition for a parameter includes the name of the parameter,
description of the parameter, unit of parameter, and default value of it.

struct UDPPrimitiveParameterDefinition
{
char* name; /* Name of the parameter */
char* description; /* some description of the parameter */
UDPUnitType unitType; /* No unit/length/angle */
double defaultValue;
};

UDPPolylineSegmentDefinition
Defines line segments used to form a polyline.

struct UDPPolylineSegmentDefinition
{
UDPPolylineSegmentType segmentType;
int segmentStartIndex;

/* Below information is required to be set only if you are
using Spline */
int numberOfPoints;

/* Below information is required to be set only if you are
using Angular Arc */
double angle; /* in degrees */
UDPPosition centerPoint;
UDPCoordinateSystemPlane arcPlane;
};

UDPSweepOptions
Sweep is a kind of operation tomove an object from one position to another andmeanwhile creating
another object based on the track of themovement. For instance, sweep operations can be used to
create a sheet from a line or a 3D object from a sheet. Different kinds of sweep types (and sweep
angles) are used in SweepAlongAxis and SweepAroundAxis functions tomake a sheet or a 3D
object.

struct UDPSweepOptions
{
UDPSweepDraftType draftType;
double draftAngle;
double twistAngle;
};

UDPVector
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Vector structures are used in UDP coding, mainly for rotation, moving or other kinds of
transformations of geometry.

struct UDPVector
{
double x;
double y;
double z;
};

Head File for Intrinsic Function Declaration

Intrinsic function declarations are inside the same file (UserDefinedPrimitiveStructures.h) as intrinsic
structure definitions. Functions are declared by ‘typedef’ keyword and function pointer. Some
function declarations are shown below as examples:
Add a message to the message window, with desired severity level
This declaration is used in the DisplayInfo function in UDPs.

typedef void (*UDPAddMessageFP)
(
UDPMessageSeverity, /* Message severity */

const char*, /* message string */
void* /* callbackData */
);

Function pointers used to create primitives
/* The return type for all primitives (except for spiral and
helix) is the ID of
* the body created -1 is an invalid ID, which means the

operation failed.
*
* Spiral and helix are like sweep operations and operate on a

profile.
* The return value indicates if the operation succeeded,
* return value 0 means operation failed, any other value
* means operation succeeded.
*/

/* 1D/2D ENTITIES */
typedef long (*UDPCreatePolylineFP)
(
const struct UDPPolylineDefinition* , /* polylineDefinition */
void* /* callbackData */
);

/* 3D ENTITIES */
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typedef long (*UDPCreateCylinderFP)
(
UDPCoordinateSystemAxis, /* axis */
const struct UDPPosition*, /* center */
double, /* radius */
double, /* height */
void* /* callbackData */
);

Sweep functions
Sweep functions are used to create a sheet from a line or create a solid (3D object) from a sheet, as
shown below.

/* Sweep operations (Sweep along vector, around axis and
* along path) modify the profile body. The resultant body
* id is same as the profile id.
*
* In case of path sweep, the path body is consumed during the
* sweep operation.
*
* The return value indicates
* if the operation succeeded, return value 0 means operation
* failed, any other value means operation succeeded.
*/

/* SweepAlongPath is used to sweep along a specific path to
create a sheet (from a line) or a solid (from a sheet)*/
typedef long (*UDPSweepAlongPathFP)
(
long, /* profileID */
long, /* pathID */
const struct UDPSweepOptions*, /* sweepOptions */
void* /* callbackData */
);

/* SweepAroundAxis is used to sweep around a specific axis (x,
y or z) to create a sheet (from a line) or a solid (from a
sheet)*/
typedef long (*UDPSweepAroundAxisFP)
(
long, /* profileID */
UDPCoordinateSystemAxis, /* sweepAxis */
double sweepAngle, /* sweepAngle */
const struct UDPSweepOptions*, /* sweepOptions */
void* /* callbackData */
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);

Transform operations
The following two functions are used for transformations.

/* Transform operations (Translate i.e.move, rotate, mirror
and
* scale) modify the part body. The resultant body
* id is same as the part id. The return value indicates
* if the operation succeeded, return value 0 means operation
* failed, any other value means operation succeeded.
*/

/* Translate function is used to do translational motion for a
given object. */
typedef long (*UDPTranslateFP)
(
long, /* partID */
const struct UDPVector*, /* translation vector */
void* /* callbackData */
);

/* Rotate function is used to rotate a given object. */
typedef long (*UDPRotateFP)
(
long, /* partID */
UDPCoordinateSystemAxis, /* axis */
double, /* angle */
void* /* callbackData */
);

Duplicate operation
/* Duplicate operations (Duplicate along line, around axis
* and duplicate and mirror) create new bodies.
*
* In case of duplicate and mirror, only 1 duplicate can be
* created. The ID of the duplicate body is returned by the
* function. ID of -1 means the operation failed.
*
* For the other two cases multiple duplicates can be created.
* The IDs of all such duplicates are returned in the function
* parameter. The function return value indicates if the

operation
* succeeded, return value 0 means operation failed, any other
* value means operation succeeded.
*/
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/* Duplicate an object around a given axis (of course can be
used to create either single or multiple copies around the
axis) */
typedef long (*UDPDuplicateAroundAxisFP)
(
long, /* partID */
UDPCoordinateSystemAxis, /* axis */
double, /* angle */
int, /* num of clones (including original) */
long*, /* returned clone ids */
void* /* callbackData */
);

Boolean operations
Boolean operations are used to unite, subtract, or intersect two objects.

/* Boolean operations (unite, subtract and intersect) modify
the
* blank body. The resultant body id is same as the blank id.
* Tool bodies are consumed during the operation.
* The return value indicates if the operation succeeded,
* return value 0 means operation failed, any other value
* means operation succeeded.
*/

/* Unite two objects */
typedef long (*UDPUniteFP)
(
long*, /* objectIDs */
int, /* numObjects */
void* /* callbackData */
);

/* Subtract two objects */
typedef long (*UDPSubtractFP)
(
long*, /* blankIDs */
int, /* numBlanks */
long*, /* toolIDs */
int, /* numTools */
void* /* callbackData */
);

Function library with a collection of UDP functions
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When coding for a UDP, you should declare an instance of UDPFunctionLib in the UDP and then
use functions directly when needed.
For example:

UDPFunctionLib* functionLib;
functionLib->addMessage(kUDPInfoMessage, msg0, callbackData);

struct UDPFunctionLib
{
/* Utility functions */
UDPAddMessageFP addMessage;
UDPNameAFaceFP nameAFace;
UDPNameAEdgeFP nameAEdge;
UDPNameAVertexFP nameAVertex;
UDPGetFaceIDFromPositionFP getFaceIDFromPosition;
UDPGetEdgeIDFromPositionFP getEdgeIDFromPosition;
UDPGetTempDirPathFP getTempDirPath;
UDPGetInstallDirPathFP getInstallDirPath;
UDPGetSysLibDirPathFP getSysLibDirPath;
UDPGetUserLibDirPathFP getUserLibDirPath;
UDPGetPersonalLibDirPathFP getPersonalLibDirPath;
UDPSetProgressFP setProgress;

/* Primitives */
/* 1D/2D ENTITIES */
UDPCreatePolylineFP createPolyline;
UDPCreateRectangleFP createRectangle;
UDPCreateArcFP createArc;
UDPCreateCircleFP createCircle;
UDPCreateEllipseFP createEllipse;
UDPCreateRegularPolygonFP createRegularPolygon;
UDPCreateEquationBasedCurveFP createEquationBasedCurve;
UDPCreateEquationBasedSurfaceFP createEquationBasedSurface;
UDPCreateSpiralFP createSpiral;

UDPGetProjectPathFP getProjectPath;

/* BEGIN - RESERVED FOR FUTURE 1D/2D PRIMITIVES */
/* DO NOT INVOKE THESE RESERVED FUNCTIONS IN YOUR UDP DLL
CREATION CODE */
UDPReservedForFutureFP reserved1D2DPrimitive5;
UDPReservedForFutureFP reserved1D2DPrimitive6;
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UDPReservedForFutureFP reserved1D2DPrimitive7;
UDPReservedForFutureFP reserved1D2DPrimitive8;
UDPReservedForFutureFP reserved1D2DPrimitive9;
UDPReservedForFutureFP reserved1D2DPrimitived10;
/* END - RESERVED FOR FUTURE 1D/2D PRIMITIVES */

/* 3D ENTITIES */
UDPCreateBoxFP createBox;
UDPCreateSphereFP createSphere;
UDPCreateCylinderFP createCylinder;
UDPCreateConeFP createCone;
UDPCreateTorusFP createTorus;
UDPCreatePolyhedronFP createPolyhedron;
UDPCreateHelixFP createHelix;

/* BEGIN - RESERVED FOR FUTURE 3D PRIMITIVES */
/* DO NOT INVOKE THESE RESERVED FUNCTIONS IN YOUR UDP DLL
CREATION CODE */
UDPReservedForFutureFP reserved3DPrimitive2;
UDPReservedForFutureFP reserved3DPrimitive3;
UDPReservedForFutureFP reserved3DPrimitive4;
UDPReservedForFutureFP reserved3DPrimitive5;
UDPReservedForFutureFP reserved3DPrimitive6;
UDPReservedForFutureFP reserved3DPrimitive7;
UDPReservedForFutureFP reserved3DPrimitive8;
UDPReservedForFutureFP reserved3DPrimitive9;
UDPReservedForFutureFP reserved3DPrimitive10;
/* END - RESERVED FOR FUTURE 3D PRIMITIVES */

/* Operations */
/* Booleans */
UDPUniteFP unite;
UDPSubtractFP subtract;
UDPIntersectFP intersect;

/* Sweeps */
UDPSweepAlongVectorFP sweepAlongVector;
UDPSweepAroundAxisFP sweepAroundAxis;
UDPSweepAlongPathFP sweepAlongPath;

/* Transformation */
UDPTranslateFP translate;
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UDPRotateFP rotate;
UDPMirrorFP mirror;
UDPScaleFP scale;

/* Duplicate */
UDPDuplicateAlongLineFP duplicateAlongLine;
UDPDuplicateAroundAxisFP duplicateAroundAxis;
UDPDuplicateAndMirrorFP duplicateAndMirror;

/* Connect */
UDPConnectFP connect;

/* Offset */
UDPOffsetFP offset;

/* Section */
UDPSectionFP section;

/* Split */
UDPSplitFP split;

/* Import native body */
UDPImportNativeBodyFP importNativeBody;

/* Clone */
UDPCloneFP clone;

/* Delete part */
UDPDeletePartFP deletePart;

/* Create Object From Face */
UDPCreateObjectFromFaceFP createObjectFromFace;

/* Fillet/Chamfer */
UDPFilletFP fillet;
UDPChamferFP chamfer;

/* Detach Faces/Edges */
UDPDetachFacesFP detachFaces;
UDPDetachEdgesFP detachEdges;

UDPCreateObjectFromEdgeFP createObjectFromEdge;
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UDPSheetThickenFP sheetThicken;

UDPSweepFaceAlongNormalFP sweepFaceAlongNormal;

/* cover/uncover */
UDPCoverLineFP coverLine;
UDPCoverSurfaceFP coverSurface;
UDPUncoverFacesFP uncoverFaces;

UDPSeparateBodiesFP separateBodies;

UDPMoveFacesFP moveFaces;
UDPWrapSheetFP wrapSheet;
UDPImprintFP imprint;
UDPImprintProjectionFP imprintProjection;

/* Import ansoft geometry */
UDPImportAnsoftGeometryFP importAnsoftGeometry;

/* correctly rerurns part ids */
UDPImportNativeBody2FP importNativeBody2;

UDPTransformFP transform;

/* BEGIN - RESERVED FOR FUTURE OPERATIONS */
/* DO NOT INVOKE THESE RESERVED FUNCTIONS IN YOUR UDP DLL
CREATION CODE */
UDPReservedForFutureFP reservedOperation20;
/* END - RESERVED FOR FUTURE OPERATIONS */
};

Code Implementation

This section provides several sample functions and structures to show how to write real code for a
UDP. All codes are from a sample source file written for Band UDP.
There are two files, UDPBase.h and UDPBase.cpp files, that include basic structures and functions
for all UDPs. All UDPs should be built based on these two files.

Define UDP Parameters and Default Values

A structure is needed for parameters and default values at the beginning of each UDP. In the
following code, UDPPrimitiveParameterDefinition, an intrinsic structure of UDP shown in Head File
for Intrinsic Structure Definition, is used to create an array of parameters for a UDP.
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struct UDPPrimitiveParameterDefinition primParams[] =
{
{"DiaGap", "Band diameter in gap center, DiaGap<DiaYoke for
outer band",
kUDPLengthUnit, 101},
{"DiaYoke", "Band diameter on yoke side, DiaYoke<DiaGap for
inner band",
kUDPLengthUnit, 40},
{"Length", "Band length", kUDPLengthUnit, 200},
{"SegAngle", "Deviation angle for band (0.1~5 degrees).",
kUDPAngleUnit, 3},
{"Fractions", "Number of circumferential fractions, 1 for
circular region.",
kUDPNoUnit, 1},
{"HalfAxial", "0: full model; 1: half model in axial
direction.", kUDPNoUnit, 0},
{"InfoCore", "0: band; 1: tool; 2: master; 3: slave; 100:
region.", kUDPNoUnit, 0}
};

ValidateParameters()

/* To check parameters one by one to see if their values are
valid */
char* CBand::ValidateParameters()
{
if (!paramValues) return 0;

if (diaYoke < 0) diaYoke = 0;
if (diaGap <= 0) return "DiaGap must be larger than 0.";
if (length < 0) length = 0; // length==0 for 2D geometry
infoOut = diaYoke>diaGap ? 1 : -1;

if (numFras < 1) numFras = 1;
if (segAng > 5) segAng = 5;
if (segAng <= 0) segAng = 0;
else if (segAng < 0.1) segAng = 0.1;
if (segAng > 0) {
numSegs = (int)(360/segAng + 0.5);
int remain = numSegs % numFras;
if (remain > 0) numSegs += numFras - remain;
segAng = 360.0 / numSegs;
}
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else numSegs = 0;

if (infoCore < 100) {
if (infoCore < 0) infoCore = 0;
if (infoCore > 3) infoCore = 3;
}

if (infoCore >= 100) {
if (diaYoke <= 0) return "DiaYoke must be larger than 0.";
}
else if (infoCore >= 1) { // for tool; master & slave
if (diaYoke <= diaGap) return "DiaYoke must be larger than
DiaGap.";
}

return 0;
}

The function inside band UDP

int AreParameterValuesValid(char ** error, double*
paramValues)
{
obj.IniParameters(paramValues, numOfParameters);
return obj.AreParametersValid(error);
}

IniParameters() and AreParametersValid() are twomember functions, which are defined in the
UDP base class (in UDPBase.cpp file) and shown below.

Initialize parameters and check for validity

First initialize parameters using IniParameters(), and then check the validity of values for
parameters. These two functions are inside the UDPBase class and do not need to be implemented.

// set oriParams pointer, and make a copy of data to
paramValues
void CUDPBase::IniParameters(double* paramValues0, int num)
{
oriParams = paramValues0; // set oriParams pointer
numOfParams = num;
delete[] paramValues;
paramValues = new double [num];
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for (int i=0; i<num; i++) paramValues[i] = oriParams[i]; //
make a copy
}

The following function is not required to be implemented, but it calls three other functions,
GetParameters(), ValidateParameters and PutParameters(), which should be implemented in the
new UDP class.

int CUDPBase::AreParametersValid(char ** error)
{
GetParameters(); // the implementation is shown below
checkOK = 0;
char *err = ValidateParameters(); // the implementation is
shown below
if (err) {
*error = err;
return 0;
}
PutParameters(); // the implementation is shown below
checkOK = 1;
return 1;
}

Parameter Validation Functions

This section covers the three functions that you need to implement in the new UDP classes. The
functions could be used as templates for new UDP classes.
These functions are very straightforward. You should follow the examples to add or remove
parameters for a new UDP.

GetParameters()

/* To get the values from array of parameters*/
void CBand::GetParameters()
{
diaGap = diaYoke = 0;
length = 0;
infoCore = 0;
infoOut = -1;

segAng = 3;
numFras = 1;
infoHalf = 0;
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for (int i=0; i<numOfParams; i++) {
if (GetValue(i, "DiaGap", diaGap)) continue;
if (GetValue(i, "DiaYoke", diaYoke)) continue;
if (GetValue(i, "Length", length)) continue;

if (GetValue(i, "SegAngle", segAng)) continue;
if (GetValue(i, "Fractions", numFras)) continue;
if (GetValue(i, "HalfAxial", infoHalf)) continue;
if (GetValue(i, "InfoCore", infoCore)) continue;
}
rRegion = diaYoke / 2;
}

PutParameters()

/* To store the values into array of parameters*/
void CBand::PutParameters()
{
for (int i=0; i<numOfParams; i++) {
if (PutValue(i, "DiaGap", diaGap)) continue;
if (PutValue(i, "DiaYoke", diaYoke)) continue;
if (PutValue(i, "Length", length)) continue;

if (PutValue(i, "SegAngle", segAng)) continue;
if (PutValue(i, "Fractions", numFras)) continue;
if (PutValue(i, "InfoCore", infoCore)) continue;
}
}

ValidateParameters()

/* To check parameters one by one to see if their values are
valid */
char* CBand::ValidateParameters()
{
if (!paramValues) return 0;

if (diaYoke < 0) diaYoke = 0;
if (diaGap <= 0) return "DiaGap must be larger than 0.";
if (length < 0) length = 0; // length==0 for 2D geometry
infoOut = diaYoke>diaGap ? 1 : -1;
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if (numFras < 1) numFras = 1;
if (segAng > 5) segAng = 5;
if (segAng <= 0) segAng = 0;
else if (segAng < 0.1) segAng = 0.1;
if (segAng > 0) {
numSegs = (int)(360/segAng + 0.5);
int remain = numSegs % numFras;
if (remain > 0) numSegs += numFras - remain;
segAng = 360.0 / numSegs;
}
else numSegs = 0;

if (infoCore < 100) {
if (infoCore < 0) infoCore = 0;
if (infoCore > 3) infoCore = 3;
}

if (infoCore >= 100) {
if (diaYoke <= 0) return "DiaYoke must be larger than 0.";
}
else if (infoCore >= 1) { // for tool; master & slave
if (diaYoke <= diaGap) return "DiaYoke must be larger than
DiaGap.";
}

return 0;
}

Implement Main Function to Create Primitive

In this part, functions are used to create the UDP. You need to write two functions for UDP creation.
l The first function is themain function to create this UDP. It calls two other functions, one of
which is shown in part 2.

extern "C" DLLEXPORT
long CreatePrimitive(struct UDPFunctionLib* functionLib, void*
callbackData,
double* paramValues)
{
obj.SetParameterPointer(paramValues);
return obj.CreatePrimitive(functionLib, callbackData);
}

Information about Coding UDPs 9-15
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l The following function is used to create a UDP based on different InfoCore values. For
instance, a region is created when InfoCore is equal to 100 while a tool is created when
InfoCore is equal to 2.
For functions to create specific object like region, tool andmaster, refer to Source Code Files
for more detail.

long CBand::CreatePrimitive(UDPFunctionLib* functionLib, void*
callbackData)
{
if (!checkOK) return 0;

// display infomation of modified parameters
SetFunctionLib(functionLib, callbackData);
DisplayInfo();

// create region
if (infoCore == 100) {
long region = CreateRegion();
return region==-1 ? 0 : 1;
}

// create tool
if (infoCore == 1) {
long tool = CreateTool();
return tool==-1 ? 0 : 1;
}

// create master
if (infoCore == 2) {
long master = CreateMaster();
return master==-1 ? 0 : 1;
}

// create slave
if (infoCore == 3) {
long slave = CreateMaster(false);
return slave==-1 ? 0 : 1;
}

// create band
long band = CreateBand();
return band==-1 ? 0 : 1;
}
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Map Parameters between Different Versions

Parametersmapping function is used when the UDP version changes or some new parameters are
added into a UDP.

l You should implement the following functionMapParametersDefinitionVersions(). It calls two
other functions IniParameters() andMapParameters(), which is in the UDPBase class.

extern "C" DLLEXPORT
int MapParametersDefinitionVersions(double** newParamValues,
char* oldVersion,
int oldNumberOfParams, struct UDPPrimitiveParameterDefinition*
oldParamDefinition)

{
obj.IniParameters(*newParamValues, numOfParameters);
obj.MapParameters(oldParamDefinition, oldNumberOfParams);//
map para by keywords

int verN = getVerNum(oldVersion);
if (verN < 200) {
obj.SetDefaultParameter(*newParamValues, "HalfAxial", 0);
}

return 1;
}

l The following function is theMapParameters() function, which has already been implemented
in the UDPBase class.

// map parameter values of old version to new version based on
keywords,
// which is written in UDPBase class and does not need to be
implemented by user
void CUDPBase::MapParameters(UDPPrimitiveParameterDefinition*
params, int oldNum)
{
if (!primParams) return;
int i, j, j0=0;
for (i=0; i<numOfParams; i++) {
oriParams[i] = primParams[i].defaultValue;
if (j0<oldNum && strcmp(primParams[i].name, params
[j0].name)==0) {
oriParams[i] = params[j0++].defaultValue;
continue;
}
for (j=0; j<oldNum; j++) {
if (strcmp(primParams[i].name, params[j].name) == 0) {
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oriParams[i] = params[j].defaultValue;
j0 = j+1;
break;;
}
}
}
}

Source Code Files
This section provides examples for the following:

l UDPBase.h
l UDPBase.cpp
l Band.h
l Band.cpp

UDPBase.h
// File: UDPBase.h

#if !defined (UDP_BASE_H)
#define UDP_BASE_H

#include <math.h>
#include <string.h>
#include <stdio.h>

#include "../Headers/UserDefinedPrimitiveDLLInclude.h"

//***************************************
// Basic functions
//***************************************
// get version number * 100
int getVerNum(char *ver);

// get the distance of two points
double getDistance(UDPPosition p0, UDPPosition p1);

// filter segments with length < minD from a polyline
void purifyPolyline(UDPPolylineDefinition& polylineDefinition,
double minD);
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//***************************************
// Base class for any UDP
//***************************************
class CUDPBase
{
protected:
double minD;

int numOfParams;
double *oriParams;
double *paramValues;
bool checkOK; // 1: check OK; 0: check failed

UDPFunctionLib* functionLib;
void* callbackData;

protected:
bool GetValue(int i, char *s, double& v);
bool PutValue(int i, char *s, double& v);
bool GetValue(int i, char *s, int& v);
bool PutValue(int i, char *s, int& v);
bool GetValue(int i, char *s, bool& v);
bool PutValue(int i, char *s, bool& v);

virtual void GetParameters() = 0;
virtual void PutParameters() = 0;
virtual char *ValidateParameters() = 0; // return NULL if
initialize OK
void SetFunctionLib(UDPFunctionLib* functionLib0, void*
callbackData0);

// display messages
void DisplayInfo(char *msg=0);

// create lines
long CreateLine(UDPPosition startPos, UDPPosition endPos);
long CreatePolyLine(UDPPosition *pos, int numPos);
long CreateZAxisPath(double z0, double z1);

// create sheets
long CreateSheet(UDPPosition *pos, int numPos, int isSheet=1);

// create solids
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long SweepAlongAxis(long obj, UDPCoordinateSystemAxis axis,
double v0, double v1);
long SweepAroundAxis(long obj, UDPCoordinateSystemAxis axis,
double angle);

// edit objects
long RotateAroundZVector(long obj, double angle, double x0=0,
double y0=0);
long DuplicateAroundAxis(long obj, UDPCoordinateSystemAxis
axis, int num,
double angle=0);
long AddObject(long objBase, long objAdd);
long SubObject(long objBase, long objSub);

public:
CUDPBase();
~CUDPBase() {delete[] paramValues;}

void IniParameters(double* paramValues0, int num);
void SetParameterPointer(double* paramValues0) {oriParams =
paramValues0;}
void MapParameters(UDPPrimitiveParameterDefinition* params,
int oldNum);
void SetDefaultParameter(double *returnParam, char *key,
double defVal);
int AreParametersValid(char ** error);

virtual long CreatePrimitive(UDPFunctionLib* functionLib,
void* callbackData) = 0;
};

#endif //if !defined (UDP_BASE_H)

UDPBase.cpp
#include <math.h>
#include <stdlib.h>

#include "../Headers/UDPBase.h"

// used to get parameter names in DisplayInfo() function
extern UDPPrimitiveParameterDefinition primParams[];
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const double PI = 3.1415926535897932;

//***************************************
// Basic functions
//***************************************
int getVerNum(char *ver)
{
if (!ver) return 0;
double verD = 0;
sscanf(ver, "%lf", &verD);
return int(verD*100 + 0.5);
}

double getDistance(UDPPosition p0, UDPPosition p1)
{
double dx = p0.x - p1.x;
double dy = p0.y - p1.y;
double dz = p0.z - p1.z;

return sqrt(dx*dx + dy*dy + dz*dz);
}

// filter segments with length < minD from a polyline
void purifyPolyline(UDPPolylineDefinition& polylineDefinition,
double minD)

{
int noOfSegments = polylineDefinition.noOfSegments;
int noOfPoints = polylineDefinition.noOfPoints;
UDPPosition* pos = polylineDefinition.arrayOfPosition;
UDPPolylineSegmentDefinition* edge =
polylineDefinition.arrayOfSegmentDefinition;

int i0=0, j0=0, i, j;
for (j=0; j<noOfSegments; j++) {
int i1 = edge[j].segmentStartIndex;
int i2 = i1 + 1;
if (edge[j].segmentType == kUDPArcSegment) i2++;
double length = getDistance(pos[i1], pos[i2 % noOfPoints]);
if (length <= minD) continue;
if (j0 == j) {j0++; i0=i2; continue;}

edge[j0].segmentStartIndex = i0;
edge[j0++].segmentType = edge[j].segmentType;
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for (i=i1+1; i<=i2; i++) pos[++i0] = pos[i % noOfPoints];
}
polylineDefinition.noOfPoints = i0;
polylineDefinition.noOfSegments = j0;
}

//***********************************************
// Member function definition for base class
//***********************************************
CUDPBase::CUDPBase() {
minD = 0;

paramValues = 0;
checkOK = 0;

functionLib = 0;
callbackData = 0;
}

bool CUDPBase::GetValue(int i, char *s, double& v)
{
if (strcmp(primParams[i].name, s) == 0) {
v = paramValues[i];
return 1;
}
return 0;
}

bool CUDPBase::PutValue(int i, char *s, double& v)
{
if (strcmp(primParams[i].name, s) == 0) {
paramValues[i] = v;
return 1;
}
return 0;
}

bool CUDPBase::GetValue(int i, char *s, int& v)
{
if (strcmp(primParams[i].name, s) == 0) {
v = (int)paramValues[i];
return 1;
}
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return 0;
}

bool CUDPBase::PutValue(int i, char *s, int& v)
{
if (strcmp(primParams[i].name, s) == 0) {
paramValues[i] = v;
return 1;
}
return 0;
}

bool CUDPBase::GetValue(int i, char *s, bool& v)
{
if (strcmp(primParams[i].name, s) == 0) {
v = paramValues[i] > 0;
return 1;
}
return 0;
}

bool CUDPBase::PutValue(int i, char *s, bool& v)
{
if (strcmp(primParams[i].name, s) == 0) {
paramValues[i] = v ? 1.0 : 0;
return 1;
}
return 0;
}

// set oriParams pointer, and make a copy of data to
paramValues
void CUDPBase::IniParameters(double* paramValues0, int num)
{
oriParams = paramValues0;
numOfParams = num;
delete[] paramValues;
paramValues = new double [num];
for (int i=0; i<num; i++) paramValues[i] = oriParams[i];
}

// map parameter values of old version to new version based on
keywords
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void CUDPBase::MapParameters(UDPPrimitiveParameterDefinition*
params, int oldNum)
{
if (!primParams) return;
int i, j, j0=0;
for (i=0; i<numOfParams; i++) {
oriParams[i] = primParams[i].defaultValue;
if (j0<oldNum && strcmp(primParams[i].name, params
[j0].name)==0) {
oriParams[i] = params[j0++].defaultValue;
continue;
}
for (j=0; j<oldNum; j++) {
if (strcmp(primParams[i].name, params[j].name) == 0) {
oriParams[i] = params[j].defaultValue;
j0 = j+1;
break;;
}
}
}
}

// set default values based the keyword of *key
void CUDPBase::SetDefaultParameter(double *returnParam, char
*key, double defVal)
{
for (int i=0; i<numOfParams; i++) {
if (strcmp(primParams[i].name, key) == 0) {
returnParam[i] = defVal;
return;
}
}
}

int CUDPBase::AreParametersValid(char ** error)
{
GetParameters();
checkOK = 0;
char *err = ValidateParameters();
if (err) {
*error = err;
return 0;
}
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PutParameters();
checkOK = 1;

return 1;
}

void CUDPBase::SetFunctionLib(UDPFunctionLib* functionLib0,
void* callbackData0)
{
functionLib = functionLib0;
callbackData = callbackData0;
}

void CUDPBase::DisplayInfo(char *msg0)
{
if (msg0) {
functionLib->addMessage(kUDPInfoMessage, msg0, callbackData);
return;
}

char msg[BUFSIZ];
for (int i=0; i<numOfParams; i++) {
double err = primParams[i].unitType==kUDPLengthUnit ? minD :
1e-6;
if (fabs(paramValues[i] - oriParams[i]) <= err) continue;
sprintf(msg, "%s is modified from %g to %g",
primParams[i].name, oriParams[i], paramValues[i]);
functionLib->addMessage(kUDPInfoMessage, msg, callbackData);
}
}

// create a line from startPos to endPos
long CUDPBase::CreateLine(UDPPosition startPos, UDPPosition
endPos)
{
UDPPosition posArray[2] = {startPos, endPos};
UDPPolylineSegmentDefinition SegArray = {kUDPLineSegment, 0};
UDPPolylineDefinition lineDef = {2, posArray, 1, &SegArray, 0,
0};
return functionLib->createPolyline(&lineDef, callbackData);
}

// create a polyline
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long CUDPBase::CreatePolyLine(UDPPosition *pos, int numPos)
{
if (numPos <= 1) return -1;

long IDs[2] = {-1, -1};
for (int i=0; i<numPos-1; i++) {
IDs[1] = CreateLine(pos[i], pos[i+1]);
IDs[0] = AddObject(IDs[0], IDs[1]);
}

return IDs[0];
}

// Create a path on z-axis symmetrically with given length for
sweeping along a path
long CUDPBase::CreateZAxisPath(double z0, double z1)
{
UDPPosition startPos = {0, 0, z0};
UDPPosition endPos = {0, 0, z1};
return CreateLine(startPos, endPos);
}

// create a cover sheet of straight line edges
long CUDPBase::CreateSheet(UDPPosition *pos, int numPos, int
isSheet)
{
if (isSheet == 0) return CreatePolyLine(pos, numPos);

int numSeg = isSheet==1 ? numPos : numPos-1;
UDPPolylineSegmentDefinition *seg = new
UDPPolylineSegmentDefinition [numSeg];
for (int i=0; i<numSeg; i++) {
seg[i].segmentType = kUDPLineSegment;
seg[i].segmentStartIndex = i;
}

UDPPolylineDefinition profile = {numPos, pos, numSeg, seg,
isSheet, isSheet};
purifyPolyline(profile, minD);
if (profile.noOfPoints < 3) return -1;
long sheet = functionLib->createPolyline(&profile,
callbackData);
delete[] seg;
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return sheet;
}

// sweep along the specified axis within (v0, v1)
long CUDPBase::SweepAlongAxis(long obj,
UDPCoordinateSystemAxis axis,
double v0, double v1)
{
if (obj == -1) return obj;
if (functionLib==0 || callbackData==0) return obj;
if (v0 == v1) return obj;

UDPPosition startPos = {0, 0, 0};
UDPPosition endPos = {0, 0, 0};
if (axis == kUDPXAxis) {
startPos.x = v0;
endPos.x = v1;
}
if (axis == kUDPYAxis) {
startPos.y = v0;
endPos.y = v1;
}
if (axis == kUDPZAxis) {
startPos.z = v0;
endPos.z = v1;
}

UDPSweepOptions sweepOptions = {kUDPRoundDraft, 0.0, 0.0};
long sweepPath = CreateLine(startPos, endPos);
if (sweepPath == -1) return obj;
functionLib->sweepAlongPath(obj, sweepPath, &sweepOptions,
callbackData);

return obj;
}

// sweep around the specified axis for ang degrees without
twist
long CUDPBase::SweepAroundAxis(long obj,
UDPCoordinateSystemAxis axis, double angle)
{
if (obj == -1) return obj;
if (functionLib==0 || callbackData==0) return obj;
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if (angle == 0) return obj;

UDPSweepOptions sweepOptions = {kUDPRoundDraft, 0.0, 0.0};
functionLib->sweepAroundAxis(obj, axis, angle, &sweepOptions,
callbackData);

return obj;
}

// rotate around a vector through (x0, y0) in parallel with Z
axis
long CUDPBase::RotateAroundZVector(long obj, double angle,
double x0, double y0)
{
if (obj == -1) return obj;
angle -= floor(angle/360) * 360;
if (angle == 0) return obj;

UDPVector vector = {-x0, -y0, 0};
functionLib->translate(obj, &vector, callbackData);
functionLib->rotate(obj, kUDPZAxis, angle, callbackData);
UDPVector vector2 = {x0, y0, 0};
functionLib->translate(obj, &vector2, callbackData);
return obj;
}

// duplicate an object around given axis and return the united
part
long CUDPBase::DuplicateAroundAxis(long obj,
UDPCoordinateSystemAxis axis,
int num, double angle)
{
if (obj == -1) return obj;
if (num == 1) return obj;

long *IDs = new long [num];
if (angle==0) angle = 360.0 / num;
long bSuccess = functionLib->duplicateAroundAxis(obj, axis,
angle, num, IDs,
callbackData);

long id = IDs[0];
if (bSuccess == 1) {
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IDs[num - 1] = obj;
bSuccess = functionLib->unite(IDs, num, callbackData);
}
delete[] IDs;

return bSuccess==0 ? obj : id;
}

// add objAdd to objBase and unite them together
long CUDPBase::AddObject(long objBase, long objAdd)
{
if (objAdd < 0) return objBase;
if (objBase < 0) return objAdd;

long IDs[] = {objBase, objAdd};
functionLib->unite(IDs, 2, callbackData);
return objBase;
}

// subject objSub from objBase
long CUDPBase::SubObject(long objBase, long objSub)
{
if (objSub < 0) return objBase;
if (objBase < 0) return -1;

long bSuccess = functionLib->subtract(&objBase, 1, &objSub, 1,
callbackData);
if (bSuccess == 0) return -1;

return objBase;
}

Band.h
// File: Cores.h

#if !defined (CORES_H)
#define CORES_H

#include "../Headers/UDPBase.h"

//***************************************
// Basic class for Band
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//***************************************
class CBand : public CUDPBase
{
protected:
double diaGap; // diameter at the gap side
double diaYoke; // diameter at the yoke side
double length; // core length or model depth: length = 0 for
2D

int numSegs; // nmuber of segments of whole circular band
int numFras; // number of circumferential fractions
int infoHalf; // 1 for half model in axial direction
int infoCore; // information for drawing different parts of
the object
int infoOut; // information for an inner or outer core

double rRegion; // region radius
double segAng; // angle per segment

protected:
virtual void GetParameters();
virtual void PutParameters();
virtual char *ValidateParameters();

long SweepAlongZAxis(long obj);

long CreateBand();
long CreateTool();
long CreateMaster(bool isMaster=true);
long CreateRegion(double r0=0, int fras=0);

public:
virtual long CreatePrimitive(UDPFunctionLib* functionLib,
void* callbackData);
};

#endif //if !defined (CORES_H)

Band.cpp
#include "../Headers/Band.h"

const double PI = 3.1415926535897932;
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static struct UDPPrimitiveTypeInfo primitiveInfo =
{
"Band",
"Create a band, shaft or outer region",
"Ansys Incorporation",
"06-01-2012",
"2.0"
};

extern "C" DLLEXPORT
struct UDPPrimitiveTypeInfo* GetPrimitiveTypeInfo()
{
return &primitiveInfo;
}

struct UDPPrimitiveParameterDefinition primParams[] =
{
{"DiaGap", "Band diameter in gap center, DiaGap<DiaYoke for
outer band",
kUDPLengthUnit, 101},
{"DiaYoke", "Band diameter on yoke side, DiaYoke<DiaGap for
inner band",
kUDPLengthUnit, 40},
{"Length", "Band length", kUDPLengthUnit, 200},

{"SegAngle", "Deviation angle for band (0.1~5 degrees).",
kUDPAngleUnit, 3},
{"Fractions", "Number of circumferential fractions, 1 for
circular region.",
kUDPNoUnit, 1},
{"HalfAxial", "0: full model; 1: half model in axial
direction.", kUDPNoUnit, 0},
{"InfoCore", "0: band; 1: tool; 2: master; 3: slave; 100:
region.", kUDPNoUnit, 0}
};

static int numOfParameters = sizeof(primParams)/sizeof
(primParams[0]);

extern "C" DLLEXPORT
int GetPrimitiveParametersDefinition(struct
UDPPrimitiveParameterDefinition**
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paramDefinition)
{
*paramDefinition = primParams;
return numOfParameters;
}

extern "C" DLLEXPORT
char* GetLengthParameterUnits()
{
return "mm";
}

static CBand obj;

// In case of error this function should return 0
extern "C" DLLEXPORT
int AreParameterValuesValid(char ** error, double*
paramValues)
{
obj.IniParameters(paramValues, numOfParameters);
return obj.AreParametersValid(error);
}

extern "C" DLLEXPORT
int MapParametersDefinitionVersions(double** newParamValues,
char* oldVersion,
int oldNumberOfParams, struct UDPPrimitiveParameterDefinition*
oldParamDefinition)

{
obj.IniParameters(*newParamValues, numOfParameters);
obj.MapParameters(oldParamDefinition, oldNumberOfParams);//
map para by keywords

int verN = getVerNum(oldVersion);
if (verN < 200) {
obj.SetDefaultParameter(*newParamValues, "HalfAxial", 0);
}

return 1;
}

extern "C" DLLEXPORT
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long CreatePrimitive(struct UDPFunctionLib* functionLib, void*
callbackData, double* paramValues)
{
obj.SetParameterPointer(paramValues);
return obj.CreatePrimitive(functionLib, callbackData);
}

//***************************************************
// Member function definition for class CBand
//***************************************************
void CBand::GetParameters()
{
diaGap = diaYoke = 0;
length = 0;
infoCore = 0;
infoOut = -1;

segAng = 3;
numFras = 1;
infoHalf = 0;

for (int i=0; i<numOfParams; i++) {
if (GetValue(i, "DiaGap", diaGap)) continue;
if (GetValue(i, "DiaYoke", diaYoke)) continue;
if (GetValue(i, "Length", length)) continue;

if (GetValue(i, "SegAngle", segAng)) continue;
if (GetValue(i, "Fractions", numFras)) continue;
if (GetValue(i, "HalfAxial", infoHalf)) continue;
if (GetValue(i, "InfoCore", infoCore)) continue;
}
rRegion = diaYoke / 2;
}

void CBand::PutParameters()
{
for (int i=0; i<numOfParams; i++) {
if (PutValue(i, "DiaGap", diaGap)) continue;
if (PutValue(i, "DiaYoke", diaYoke)) continue;
if (PutValue(i, "Length", length)) continue;

if (PutValue(i, "SegAngle", segAng)) continue;
if (PutValue(i, "Fractions", numFras)) continue;
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if (PutValue(i, "InfoCore", infoCore)) continue;
}
}

char* CBand::ValidateParameters()
{
if (!paramValues) return 0;

if (diaYoke < 0) diaYoke = 0;
if (diaGap <= 0) return "DiaGap must be larger than 0.";
if (length < 0) length = 0; // length==0 for 2D geometry
infoOut = diaYoke>diaGap ? 1 : -1;

if (numFras < 1) numFras = 1;
if (segAng > 5) segAng = 5;
if (segAng <= 0) segAng = 0;
else if (segAng < 0.1) segAng = 0.1;
if (segAng > 0) {
numSegs = (int)(360/segAng + 0.5);
int remain = numSegs % numFras;
if (remain > 0) numSegs += numFras - remain;
segAng = 360.0 / numSegs;
}
else numSegs = 0;

if (infoCore < 100) {
if (infoCore < 0) infoCore = 0;
if (infoCore > 3) infoCore = 3;
}

if (infoCore >= 100) {
if (diaYoke <= 0) return "DiaYoke must be larger than 0.";
}
else if (infoCore >= 1) { // for tool; master & slave
if (diaYoke <= diaGap) return "DiaYoke must be larger than
DiaGap.";
}

return 0;
}

long CBand::SweepAlongZAxis(long obj)
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{
if (obj == -1) return obj;
if (functionLib==0 || callbackData==0) return obj;
if (length == 0) return obj;

double z0 = infoHalf==0 ? -length/2 : 0;
UDPSweepOptions sweepOptions = {kUDPRoundDraft, 0.0, 0.0};
long sweepPath = CreateZAxisPath(z0, length/2);
if (sweepPath == -1) return obj;
functionLib->sweepAlongPath(obj, sweepPath, &sweepOptions,
callbackData);

return obj;
}

long CBand::CreateBand()
{
long band = -1;
double r0 = diaGap / 2;
if (numSegs == 0) band = CreateRegion(r0);
else {
double angle = 2*PI / numSegs;
int n = numSegs / numFras;
double x0 = r0 * cos(angle);
double y0 = r0 * sin(angle);

UDPPosition pos[] = { 0, 0, 0,
r0, 0, 0,
x0, y0, 0};
band = CreateSheet(pos, 3);
band = SweepAlongZAxis(band);
band = DuplicateAroundAxis(band, kUDPZAxis, n, angle*180/PI);
}
if (diaYoke <= diaGap) return band;

long region = CreateRegion();
return SubObject(region, band);
}

long CBand::CreateTool()
{
UDPPosition p0 = {0, 0, -length/2};
double r0 = 0.55 * diaYoke;

Information about Coding UDPs 9-35
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

long tool = functionLib->createCylinder(kUDPZAxis, &p0, r0,
length, callbackData);
long region = CreateRegion();
return SubObject(tool, region);
}

// Create master or slave
long CBand::CreateMaster(bool isMaster)
{
double r0 = 0.5 * diaYoke;
UDPPosition startPos = {0, 0, 0};
UDPPosition endPos = {r0, 0, 0};
long master = CreateLine(startPos, endPos);
if (!isMaster) RotateAroundZVector(master, 360.0/numFras);
return SweepAlongZAxis(master);
}

long CBand::CreateRegion(double r0, int fras)
{
if (r0 == 0) r0 = diaYoke/2;
if (fras == 0) fras = numFras;
UDPPosition startPos = {0, 0, 0};
UDPPosition endPos = {r0, 0, 0};
long region = CreateLine(startPos, endPos);
region = SweepAlongZAxis(region);
return SweepAroundAxis(region, kUDPZAxis, 360.0/fras);
}

long CBand::CreatePrimitive(UDPFunctionLib* functionLib, void*
callbackData)
{
if (!checkOK) return 0;

// display infomation of modified parameters
SetFunctionLib(functionLib, callbackData);
DisplayInfo();

// create region
if (infoCore == 100) {
long region = CreateRegion();
return region==-1 ? 0 : 1;
}
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// create tool
if (infoCore == 1) {
long tool = CreateTool();
return tool==-1 ? 0 : 1;
}

// create master
if (infoCore == 2) {
long master = CreateMaster();
return master==-1 ? 0 : 1;
}

// create slave
if (infoCore == 3) {
long slave = CreateMaster(false);
return slave==-1 ? 0 : 1;
}

// create band
long band = CreateBand();
return band==-1 ? 0 : 1;
}
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10 - Assigning Materials
You can add, remove, and edit materials in twomain ways:

l Using the Tools>Edit Libraries>Materials menu command.
l Right-clickingMaterials in the project tree and selectingEdit Library.

Editing definitions from the project window does not modify the configured libraries for any particular
design. To consider the current design, use the Tools>Edit Libraries option. Doing so ensures that
new libraries are added to the configured list for the current design. If you edit materials from this
command for the current and then export them, theywill also be available to assign to objects in other
designs.
To assign amaterial to an object, follow the general procedure:

1. Select the object to which you want to assign amaterial.

2. ClickModeler>Assign Material .
TheSelect Definition dialog box appears. When theShow all libraries check box is
selected, the window lists all of thematerials in Maxwell’s global material library aswell as the
project’s local material library.
You can also open theSelect Definitionwindow in one of the following ways:
l In theProperties dialog box for the object, click thematerial name under theAttributes
tab. A drop-downmenu shows anEdit... button that opens theSelect Definitionwindow.

Themenu also listsmaterials included in the current project. Selecting one of thesematerials
provides another way to assignmaterials to an object.

l Right-clickModel in the project tree, and then clickAssign Material on the shortcut menu.
l Right-click the object in the history tree, and then clickAssign Material on the shortcut
menu.

3. Select amaterial from the list.
Note You can search the listedmaterials by name or property

value.

The list displays the currently set values for many of amaterial’s properties such asRelative
Permeability, Bulk Conductivity, and Composition. If thematerial you want to assign is not
listed, you can add a new material to the global or local material library, and then select it.

4. ClickOK.
Thematerial you chose is assigned to the object.

Note In the history tree, by default, Maxwell groups objects bymaterial. To change the default,
select the object icon and right-click to display theGroup Objects by Material check box.

Related Topics

Solve Inside or On a Surface
Adding New Materials
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RemovingMaterials
ValidatingMaterials
SortingMaterials
Viewing andModifyingMaterial Attributes
CopyingMaterials
FilteringMaterials
ExportingMaterials to a Library
Calculating Properties for Core Loss (BP Curve)
Defining VariableMaterial Properties
DefiningMaterial Properties as Expressions
Defining Functional Material Properties
Importing and ConvertingMaterials
Searching for Materials
Permanent Magnets
Nonlinear Materials
Working with Material Libraries
Working with Materials in RMxprt
Setting the Temperature of Objects
Setting the Deformation of Objects

Solving Inside or on the Surface
For Maxwell designs, when you assign amaterial to an object, you can specify whether to generate a
field solution inside the object or on the surface of the object. If you elect to generate a solution inside
the object, Maxwell will create amesh inside the object and generate a solution from themesh. If you
elect to generate a solution on the surface of the object, Maxwell will create only a surfacemesh for
the object.
If you want a solution to be generated inside an object, selectSolve Inside in theProperties
window. Conversely, if you want a solution to only be generated on the surface of an object, clear the
Solve Inside option in thePropertieswindow.
By default,Solve Inside is selected for all objects with a bulk conductivity less than 105
siemens/meter and for perfect insulators. By default, theSolve Inside option in theProperties
window is clear for perfect conductors.

Searching for Materials
If there is a specificmaterial or material property value that you want to assign to an object, you can
search thematerials in theSelect Definitionwindow by name or bymaterial property.
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Searching by Material Name

1. In theSearch Criteria area of theSelect Definition dialog box, select by Name.
2. In theSearch Parameters area, type amaterial name in theSearch by Name box.

The row containing thematerial namemost similar to the one you typed is selected.
If the selectedmaterial is not the one you are searching for, do one of the following:

l Use the keyboard's arrow keys to scroll up or down the list of materials.
l Type a new material name in theSearch by Name box.

Searching by Material Property

1. In the Search Criteria area of theSelect Definition dialog box, select by Property.
2. Select amaterial property from the pull-down list.

Note By default, not all of the available properties are displayed in thematerials table.
Only the properties commonly used by the product are displayed. To view the
complete table of properties, see FilteringMaterials.

3. In theSearch Parameters area, type a value for the property in theSearch by Property
box, and then clickSearch.
Thematerials are sorted according to the value you entered. Thematerial with the property
value closest to the one you typed is selected.

If the selectedmaterial is not the one you are searching for, do one of the following:
l Use the keyboard's arrow keys to scroll up or down the list of materials.
l Type a new value in theSearch by Property box.

Adding New Materials
You can add a new material to a project or to the global user-definedmaterial library. Tomake the
new project material available to all projects, youmust export thematerial to a global user-defined
material library.
Materials are added using theView/Edit Material dialog box, which can be opened from either the
Select Definition dialog box or theEdit Libraries dialog box.
To open theSelect Definition dialog box:

l ClickModeler>Assign Material.
TheSelect Definition dialog box appears.

To open theEdit Libraries dialog box:
l ClickTools>Edit Libraries>Materials. (In the project tree, you can also right-click
Materials, and selectEdit Library.)
TheEdit Libraries dialog box appears.

To add a new material:
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1. From either theSelect Definition dialog box or theEdit Libraries dialog box, clickAdd
Material.
TheView/Edit Material dialog box appears.

2. Type a name for thematerial in theMaterial Name text box, or accept the default.
3. Select one of the following from theMaterial Coordinate System Type pull-down list:

l Cartesian (default)
l Cylindrical
l Spherical

4. Under View/Edit Material for select:
l Active Design to display properties used in the active design.
l Active Project to display properties used in the active project.
l All Properties to display all properties available. This enlarges the table of properties to
show all properties possible for the selected Physics type(s). You can use the scroll bars or
size the dialog to see all properties.
SelectingAll Properties also enables the threePhysics check boxes:Electromagnetic,
Thermal, andStructural. These check boxes are used to filter the properties displayed in
the table by physics type. Clearing a check box hides properties of that physics type.

5. You can also enable theView/ Edit Modifier check box for Thermal Modifier.
Checking this box causes the Thermal Column to display at the right side of the Properties of
theMaterial table. Selecting Edit rather thanNone causes display of the Edit Thermal
Modifier dialog.

6. Type a new name for thematerial in theMaterial Name text box or accept the default.
7. Select amaterial property type –Simple (i.e., linear),Anisotropic,Nonlinear, Vector, or

Custom – for each property from the Type pull-down list; Composition valueSolid or
Lamination.
Available selections vary with the property and solution type, and with theView/Edit selection
as described above.

8. For example, for an EddyCurrent active design, if thematerial isSimple (i.e., linear), enter
values for the followingmaterial properties in theValue boxes:
l Relative Permeability (See alsoRelative Permeability in the Technical Notes.)
l Relative Permittivity
l Bulk Conductivity
l Dielectric Loss Tangent
l Magnetic Loss Tangent
l Core LossModel
l Composition:Solid or Lamination.
l MassDensity
If thematerial is a ferrite, enter a value greater than 0 in theMagnetic SaturationValue box.
Youmay also choose to enter values in the LandeGFactor and Delta HValue boxes.
Because Delta H values aremeasured at specific frequencies, you should also enter a -
Measured Frequency value (default 9.4 Ghz).
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Note Youmay enter a variable name or mathematical expression in theValue
box.

9. Tomodify the units for amaterial property, click theUnits box, and then select a new unit
system.

10. Below the list, in theCalculate Properties for pull-down list, do the following if your project
contains a permanent magnet:
a. SelectPermanent Magnet.

TheProperties for Permanent Magnet dialog box appears.
b. Select which parameters you want to define (Mu,Hc,Br,Mp).
c. Type values in the text boxes, and select the units.
d. ClickOK.

Note An error message displays if your project type does not support permanent
magnets.

11. For transient and 3D eddy current projects, youmay also be able to set the core loss from the
Calculate Properties for pull-down list.

12. ClickValidate Material.
13. ClickOK.

The new material is added to the local material library.

Related Topics

Defining VariableMaterial Properties
Importing and ConvertingMaterials
Working with Material Libraries
FilteringMaterials
CopyingMaterials
RemovingMaterials
Searching for Materials

Assigning Material Property Types

Eachmaterial property can be assigned one of the followingmaterial property types:

Simple Thematerial is homogeneous and linear.
Anisotropic Thematerial’s characteristics vary with direction.

l If thematerial property isAnisotropic, its characteristics are defined by its
anisotropy tensor. Youmust define three diagonals for: anisotropic permittivity,
electric loss tangent, conductivity, permeability, andmagnetic loss tangent.
Each diagonal represents a tensor of your model along an axis.
These tensors are relative to the coordinate system specified as the object’s
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Orientation property. By specifying different orientations, several objects can
share the same anisotropicmaterial but be oriented differently.

Nonlinear Thematerial’s relative permeability varies according to its associated BH curve.
Refer toRelative Permeability for aMaxwell or RMxprt Material for details on using
nonlinear relative permeability.

Vector For Magnetic Coercivity:
l If the Relative Permeability Type is either Simple or Anisotropic, enter a Value
for theMagnitude.

l If the Relative Permeability Type is Nonlinear, Magnitude becomes uneditable,
and three additional fields of Type Unit Vector: X Component, Y Component,
and Z Component appear in which you can enter values or specify functions.

For Electric Coercivity, enter a Value for theMagnitude.
Custom Magnetostriction can be Linear, Nonlinear, or Anisotropic. InverseMagnetostriction

can be either Linear or Nonlinear. Refer to Magnetostriction and Inverse
MagnetostrictionMaterials for details on using these properties.

Select amaterial property type from the Type pull-down list. Of the possibilities, only those
applicable to the namedmaterial will be listed. Somematerial properties only use theSimple type.
Others include several types.

l If thematerial property isAnisotropic, its characteristics are defined by its anisotropy tensor.
Youmust define three diagonals for: relative permittivity, dielectric loss tangent, bulk
conductivity, relative permeability, andmagnetic loss tangent. Each diagonal represents a
tensor of your model along an axis.
These tensors are relative to the coordinate system specified as the object’s Orientation
property. By specifying different orientations, several objects can share the same anisotropic
material but be oriented differently.

l TheRelative Permeability property can also be assigned aNonlinear property type. Refer to
Relative Permeability for aMaxwell or RMxprt Material for details on using nonlinear relative
permeability.

l Magnetostriction and Inversemagnetostriction areCustom properties. Refer to
Magnetostriction and InverseMagnetostrictionMaterials for details on using these properties.

Related Topics

Setting Coordinate Systems
Creating a Relative Coordinate System
Change theOrientation of an object
Defining Anisotropic Relative Permeability Tensors
Defining Anisotropic Relative Permittivity Tensors
Defining Anisotropic Conductivity Tensors
Defining Anisotropic Dielectric Loss Tangent Tensors
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DefiningMagnetic Loss Tangent Tensors

Defining Anisotropic Relative Permeability Tensors

Eddy or frequency domain solutions only.
The relative permeability of materials is assumed to be a complex quantity expressed as the
following:

where is the real part of the complex permeability (same as the usual relative permeability),
is the imaginary part of the complex permeability, and j is the imaginary unit.
The relationship above can also be written as the following:

where is themagnetic loss tangent.
For anisotropicmagneticmaterials, a tensor material property needs to be used. The anisotropic
relative permeability tensor has the following expression:

Magnetostatic, Eddy, and transient solutions only.
Maxwell allows the anisotropicmagneticmaterial to exhibit nonlinear characteristics (magnetostatic,
Eddy, and transient solutions only) on all three principle axes of the chosen coordinate system, in
which case the respective nonlinear characteristicsmust be specified.
For example, for laminationswith anisotropic behavior in the plane of the lamination, the
Anisotropic type of material should be specified for theRelative Permeability property, and the
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two respective B-H curves should be entered. For the third direction (lamination stacking direction),
one of the specified two B-H curves should also be applicable. The composition field should be set to
lamination, and the stacking factor and stacking direction should be specified (see also lamination
model).
General
If thematerial property is anisotropic, its characteristics are defined by its anisotropy tensor. You
must define three diagonals for anisotropic permeability. Each diagonal represents a tensor of your
model along an axis.
These tensors are relative to the coordinate system specified as the object’s Orientation property. By
specifying different orientations, several objects can share the same anisotropicmaterial but be
oriented differently.

1. In theRelative Permeability row in theView/Edit Materialwindow, selectAnisotropic
from the Type pull-down list.
Three rows named T(1,1), T(2,2) and T(3,3) are added below theRelative Permeability
row.

2. Enter the relative permeability along one axis of thematerial’s permeability tensor in theValue
box of the T(1,1) row.

3. Enter the relative permeability along the second axis in theValue box of the T(2,2) row.
4. Enter the relative permeability along the third axis in theValue box of the T(3,3) row.

If the relative permeability is the same in all directions, use the same values for each axis.
These values can also be defined as variables.

Related Topics

Setting Coordinate Systems
Creating a Relative Coordinate System
Change theOrientation of an object
Defining Anisotropic Relative Permittivity Tensors
Defining Anisotropic Conductivity Tensors
Defining Anisotropic Dielectric Loss Tangent Tensors
DefiningMagnetic Loss Tangent Tensors

Defining Anisotropic Relative Permittivity Tensors

Eddy or frequency domain solutions only.
The relative dielectric permittivity of dielectrics is assumed to be a complex quantity, expressed as
the following:
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where is the real part of the complex permittivity (the same as the usual relative dielectric

constant), is the imaginary part of the complex permittivity, and j is the imaginary unit.
The relationship above can also be written as the following:

where is the dielectric loss tangent.
For anisotropic dielectrics, a tensor material property needs to be used. The anisotropic relative
permittivity tensor has the following expression:

If thematerial property is anisotropic, its characteristics are defined by its anisotropy tensor. You
must define three diagonals for anisotropic permittivity. Each diagonal represents a tensor of your
model along an axis.
These tensors are relative to the coordinate system specified as the object’s Orientation property. By
specifying different orientations, several objects can share the same anisotropicmaterial but be
oriented differently.

1. In theRelative Permittivity row in theView/Edit Materialwindow, selectAnisotropic from
the Type pull-down list.
Three rows named T(1,1), T(2,2) and T(3,3) are added below theRelative Permittivity row.

2. Enter thematerial’s relative permittivity along one tensor axis in theValue box of the T(1,1)
row.
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3. Enter the relative permittivity along the second axis in theValue box of the T(2,2) row.
4. Enter the relative permittivity along the third axis in theValue box of the T(3,3) row.

If the relative permittivity is the same in all directions, use the same values for each axis.
These values can also be defined as variables.

Related Topics

Setting Coordinate Systems
Creating a Relative Coordinate System
Change theOrientation of an object
Defining Anisotropic Relative Permeability Tensors
Defining Anisotropic Conductivity Tensors
Defining Anisotropic Dielectric Loss Tangent Tensors
DefiningMagnetic Loss Tangent Tensors

Defining Anisotropic Conductivity Tensors

Electric conductivity can be simple or anisotropic. In either case, the corresponding values are
entered in S/m (Siemens per meter).
If thematerial property is anisotropic, its characteristics are defined by its anisotropy tensor. You
must define three diagonals for anisotropic conductivity. Each diagonal represents a tensor of your
model along an axis.
These tensors are relative to the coordinate system specified as the object’s Orientation property. By
specifying different orientations, several objects can share the same anisotropicmaterial but be
oriented differently.

1. In theBulk Conductivity row in theView/Edit Materialwindow, selectAnisotropic from
the Type pull-down list.
Three rows named T(1,1), T(2,2) and T(3,3) are added below theBulk Conductivity row.

2. Enter the conductivity along one axis of thematerial’s conductivity tensor in theValue box of
the T(1,1) row.

3. Enter the conductivity along the second axis in theValue box of the T(2,2) row.
4. Enter the conductivity along the third axis in theValue box of the T(3,3) row.

The values of the conductivity along the first and second axis apply to all axes that lie in the xy cross-
section beingmodeled. The values of the conductivity along the third axis applies to the z-
component. These values affect current flowing in dielectrics between the conductors.
These values can also be defined as variables.

Related Topics

Setting Coordinate Systems
Creating a Relative Coordinate System
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Change theOrientation of an object
Defining Anisotropic Relative Permeability Tensors
Defining Anisotropic Relative Permittivity Tensors
Defining Anisotropic Dielectric Loss Tangent Tensors
DefiningMagnetic Loss Tangent Tensors

Defining Anisotropic Dielectric Loss Tangent Tensors

To represent a dielectric that dissipates the power of a high-frequency electric field, enter a dielectric

loss tangent, , property value for thematerial. The smaller the loss tangent, the less lossy the
material.
If thematerial property is anisotropic, its characteristics are defined by its anisotropy tensor. You
must define three diagonals for electric loss tangent. Each diagonal represents a tensor of your
model along an axis.
These tensors are relative to the coordinate system specified as the object’s Orientation property. By
specifying different orientations, several objects can share the same anisotropicmaterial but be
oriented differently.
If electric loss tangent is anisotropic, do the following:

1. In theDielectric Loss Tangent row in theView/Edit Materialwindow, selectAnisotropic
from the Type pull-down list.
Three rows named T(1,1), T(2,2) and T(3,3) are added below theDielectric Loss Tangent
row.

2. Enter the ratio of the imaginary relative permittivity to the real relative permittivity in one
direction in theValue box of the T(1,1) row.

3. Enter the ratio of the imaginary relative permittivity to the real relative permittivity in the second
direction in theValue box of the T(2,2) row.

4. Enter the ratio of the imaginary relative permittivity to the real relative permittivity in the third
orthogonal direction in theValue box of the T(3,3) row.

If the electric loss tangent is the same in all directions, use the same values for each direction.
These values can also be defined as variables.
The dielectric loss tangent may vary with frequency. To simulate the variances, define a function for
the dielectric loss tangent.

Related Topics

Setting Coordinate Systems
Creating a Relative Coordinate System
Change theOrientation of an object
Defining Anisotropic Relative Permeability Tensors
Defining Anisotropic Relative Permittivity Tensors
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Defining Anisotropic Conductivity Tensors
DefiningMagnetic Loss Tangent Tensors

Magnetic Loss Tangent

To represent amagneticmaterial such as ferrite that dissipates the power of a high-frequency
magnetic field, enter amagnetic loss tangent, µ′′/µ′, property value for thematerial. The smaller the
loss tangent, the less lossy thematerial.

Note If you plan to do a fast frequency sweep for a design that includes dielectrics, make sure
that the dielectric or magnetic loss tangent does not vary significantly over the requested
frequency range. If they do, the resultsmay not be what you expect. In caseswhere the
loss tangent does vary significantly over the frequency range in which you are interested,
copy and solve the design several times, adjusting the loss tangent and associated
frequency range for the copied design so that the loss tangent is relatively stable over the
design’s requested frequency range.

Imaginary Permeability
EddyCurrent
Somematerials exhibit a permeability that includes both a real and imaginary component. The
imaginary component is used tomodel magnetic losses in a time-varying field using the relationship:

where:

is the real component of the relative permeability.

is the imaginary component of the relative permeability.
is the permeability of free space.

As shown below, a complex relative permeability causes the B field to lag behind the H field – similar
to the behavior of a nonlinear, lossymaterial. The power loss during this cycle (the color shaded
area) is approximately equal to the hysteresis loss (the area within the blue lines). The hysteresis
curve for amaterial with a constant, real permeability (the straight yellow line) is shown as a
reference.
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When the nature of losses is also due tomagnetic hysteresis, Maxwell allows you tomodel such
effects using complex permeability by allowing the specification of the tangent of magnetic loss.
When a linear material exhibits hysteresis effects, it should be characterized using a complex
permeability, as below:

where is themagnetic loss tangent,
Enter the imaginary relative permeability of amaterial, μ’’, in the Imag. Permeability field. The
default imaginary permeability of zero is that of amaterial that exhibits nomagnetic loss in a time-
varying field.

Defining Magnetic Loss Tangent Tensors

If thematerial property is anisotropic, its characteristics are defined by its anisotropy tensor. You
must define three diagonals for anisotropicmagnetic loss tangent. Each diagonal represents a
tensor of your model along an axis.
These tensors are relative to the coordinate system specified as the object’s Orientation property. By
specifying different orientations, several objects can share the same anisotropicmaterial but be
oriented differently.

1. In theMagnetic Loss Tangent row in theView/Edit Materialwindow, selectAnisotropic
from the Type pull-down list.
Three rows named T(1,1), T(2,2) and T(3,3) are added below theMagnetic Loss Tangent
row.

2. Enter the ratio of the imaginary relative permeability to the real relative permeability in one
direction in theValue box of the T(1,1) row.
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3. Enter the ratio of the imaginary relative permeability to the real relative permeability in the
second direction in theValue box of the T(2,2) row.

4. Enter the ratio of the imaginary relative permeability to the real relative permeability in the third
direction in theValue box of the T(3,3) row.

If themagnetic loss tangent is the same in all directions, use the same values for each direction.
These values can also be defined as variables.

Related Topics

Setting Coordinate Systems
Creating a Relative Coordinate System
Change theOrientation of an object
Defining Anisotropic Relative Permeability Tensors
Defining Anisotropic Relative Permittivity Tensors
Defining Anisotropic Conductivity Tensors
Defining Anisotropic Dielectric Loss Tangent Tensors

Defining Variable Material Properties

When defining or modifying amaterial's properties, eachmaterial property value in theView/Edit
Materialwindow can be assigned a project variable. Simply type the project variable's name in the
appropriateValue box. Project variables are used for material properties becausematerials are
stored at the project level.
For example, define a project variable with the nameMyPermittivity and define its value as 4. To
assign this property value to amaterial, type $MyPermittivity in theValue box for thematerial. Be
sure to include the prefix $ before the project variable name, which notifiesMaxwell that the variable
is a project variable.

Note By default, not all of the available properties are displayed in thematerials table. Only the
properties commonly used by the product are displayed. To view the complete table of
properties, see FilteringMaterials.

Related Topics

Working with Variables
AssigningMaterial Property Types
Specifying ThermalModifiers

Specifying Thermal Modifiers

To specify Thermalmodifiers for amaterial:

AssigningMaterials 10-14
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

1. In the View/ Edit materials dialog youmust enable the View/ Edit Modifier check box for
ThermalModifier.
This causes the Properties of theMaterial table to expand to include a ThermalModifier
column. By default, the ThermalModifier property is set toNone.

2. Selecting Edit... from the drop downmenu, rather thanNone causes theEdit Thermal
Modifier dialog to appear.

3. SelectExpression radio button to display theParameters Modifier text field or the
Quadratic radio button to display the tabs forBasic Coefficient Set andAdvanced
Coefficient Set.
l WithExpression selected, you can write an equation for a thermal modifier in the
ParametersModifier text field.
CheckingUse temperature dependent data set disables theModifier text field. You
can then use the drop downmenu to select Add/Import Dataset. This lets you define the
thermal modifier as a data set.

l With theQuadratic radio button selected, in theBasic Coefficient tab, you can edit fields
for the TempRef and units, and fields for C1 and C2 for the following equation:
P(Temp) = Pref[1+ C1(Temp - TempRef) + C2(Temp - TempRef)^2]
where the Pref is defined as the reference relative permittivity.

l With theQuadratic radio button selected, in theAdvanced Coefficient Set tab, you can
edit fields for lower and upper temperature limits (TL and TU respectively) and select their
units from the drop down.
You can also edit the constant value limit for the thermal modifier values outside the limits.
By default, these are automatically calculated. Uncheck the Auto Calculate TML and TMU
to specify new values for thermal modifier lower (TML) and thermal modifier upper (TMU).

4. ClickOK to accept the edits and return to the View/ Edit materials dialog.

Related Topics

Adding Datasets
View/ Edit materials dialog

Defining Material Properties as Expressions

When defining or modifying amaterial's properties, eachmaterial property value in theView/Edit
Materialwindow can be assigned amathematical expression. Simply type the expression in the
appropriateValue box. Expressions typically contain intrinsic functions, such as sin(x), and
arithmetic operators, such as +, -, *, and /, but do not include project variables.

Note By default, not all of the available properties are displayed in thematerials table. Only the
properties commonly used by the product are displayed. To view the complete table of
properties, see FilteringMaterials.
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Related Topics

Defining VariableMaterial Properties

Defining Functional Material Properties

Anymaterial property that can be specified by entering a constant can also be specified using a
mathematical function. This is useful when you are defining amaterial property whose value is given
by amathematical relationship— for instance, one relating it to frequency or another property's
value.When defining or modifying amaterial's properties, simply type the name of the function in the
appropriateValue box.

Note By default, not all of the available properties are displayed in thematerials table. Only the
properties commonly used by the product are displayed. To view the complete table of
properties, see FilteringMaterials.

Related Topics

DefiningMathematical Functions
Defining VariableMaterial Properties

Material Coordinate Systems

Maxwell supports the following three types of coordinate systems, which can be used to define some
vector or anisotropicmaterial properties:

l Cartesian (defined by the X, Y, and Z axes)
l Cylindrical (defined by the R, Phi, and Z axes)
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l Spherical (defined by the Rho, Theta, and Phi axes)

To get the fields for the vector magnetic coercivity vector, a non-zero valuemust first be specified for
themagnitude of the vector. Themagnitude can also be functional. Themagnitude of themagnetic
coercivity is expected to be < 0. If you use a positive value, the direction used will be the opposite of
the unit vector specified.

Lamination Modeling

Laminationmodeling allows you to specify a stacking factor and stacking direction, which represents
the direction perpendicular to the plane of the lamination. Cartesian, cylindrical, or spherical
coordinate systems can be used to specify the stacking direction.
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This laminationmodel is an alternative way of specifying anisotropic behavior when using
laminations (which is a special case that is frequently done). For the frequently encountered case of
isotropic laminations (where the global model is anisotropic due to the existence of laminations but
the laminations themselves are isotropic), the above picture shows a possible setup. Choose a
nonlinear behavior for thematerial of the lamination with a user specified B-H curve, while the global
anisotropy ismodeled by specifying a stacking factor and the stacking direction, which is
perpendicular to the plane of laminations. In this way, Maxwell can consider a global anisotropywith
two orientations— one in the plane of the lamination, and the other in the corresponding orthogonal
direction.

Note If a stacking factor less than 1 is applied to amagnetic core, the flux density plotted will
represent the AVERAGE flux density in both the air and the steel (and not the flux density
in the steel laminations). The average flux density is reduced as the stacking factor is
reduced.

Note Laminationmodeling is supported for magnetostatic and transient solutions only, where
the stacking value is between 0 and 1. Please use appropriatematerials with suitable
lamination definitions for the solver. Other solvers will ignore the lamination definition in the
material.

Note When a stacking factor (SF) is used, users need tomodify the electrical steel core loss
coefficients based on the stacking factor as shown below. As the stacking factor decreases
< 1, the core loss coefficients increase.
Kh_scaled = Kh / SF
Kc_scaled = Kc / SF
Ke_scaled = Ke / sqrt(SF)

Related Topics

Stacking Direction
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Stacking Direction

When defining a laminationmodel, the stacking directionmust be specified. The direction depend
upon theMaterial Coordinate SystemType chosen as follows:

Cartesian
Coordinates

Cylindrical
Coordinates

Spherical
Coordinates

V(1) X r r
V(2) Y θ θ
V(3) Z Z φ

Core Loss Model for a Maxwell Material

Specify the following settings and units for core lossmodel:

Name Value
None No core loss is to be calculated for thismaterial.
Electrical
Steel

The following parameters appear:
l Kh
l Kc
l Ke
l Kdc (not used for EddyCurrent solution type)

Selecting Electrical Steel also enables the Calculate Properties for Core Loss
Coefficient pull-down list at the bottom of the dialog box. SelectingCore Loss
Coefficient opens theBP Curve window.

Power
Ferrite

The following parameters appear:
l Cm
l X
l Y
l Kdc (not used for EddyCurrent solution type)

Hysteresis
Model

The following parameters appear:
l Intrinsic Coercivity Hci
l Remanence Br
l Kc

Selecting Hysteresis Model also enables the Calculate Properties for Hysteresis
Loop pull-down list item at the bottom of the dialog box. Selecting theHysteresis
Loop opens theProperties for Hysteresis Loopwindow.

Some additional considerations:
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DC-biased effects
The core loss computation is based on the traditional three core loss coefficientsKh,Kc andKe,
plus the optionalKdc. In order to properly consider the impact of DC-biased hysteresis loss, a
general rule to automatically compute Kdc is applied to improve the core loss from the classic
Steinmetz equation. If the user leaves the default value of Kdc as zero, this indicates that Kdcwill be
determined automatically by the software; otherwise, the software will use the user-input Kdc value
to consider the impact of DC-bias.

Note The use of Kdcwhen computing DC-biased effects has no effect on the hysteresismodel-
based core loss computation approach since in such a case, the hysteresismodel has
inherently consider the impact of DC-biased effects on hysteresis loss.

Hysteresis model-based core loss computation approach
Using this approach, the computation of the hysteresis loss component is based on the input of a
hysteresis loop, and the computation of the eddy current loss component based on the classic eddy
current loss coefficient Kc. Thismeans that the impact of classic excess lossmust be included in the
hysteresis loss (sometime called: dynamic hysteresis loss). There are two ways to enable
computation of core loss for the hysteresismodel-based approach:

l Define the descending limiting branch of the hysteresis loop in the nonlinear BH curve input
panel together with the input ofKc, which is defined by choosingElectrical Steel as theCore
Loss Model on theProperties of the Material panel. Please note that any values entered
forKh andKewill be ignored.
Note This approach requires use of amaterial that has a vector magnitude direction set to

(0,0,0) to enable the hysteresis loss calculation; andmust also have itsCore Loss
Setting checked in theSet Core Loss dialog to include the eddy current
component of core loss.

l Define the hysteresis loop by the input of a normal nonlinear BH curve together with the
selection ofHysteresis Model as theCore Loss Model and the input of values for Intrinsic
Coercivity Hci,Remanence Br (optional) andKc.
Note The second approach is able tomore accuratelymodel minor loop loss

behavior.

Additional eddy current loss component due to flux normal to the lamination
As an engineering approximation, almost all existing core loss computation approaches ignore the
impact of the flux component that is normal to the lamination. This is because the value of the flux
component that is normal to the lamination in a “normal” operating condition is quite small and it is
also not easy to compute. However, it can play amajor role when saturation goes very high or when
operating under other abnormal conditions. Maxwell takes the impact of this normal flux component
into account when computing core loss for 3D transient solutions. This additional loss component is
computed automatically based on the conductivity of thematerial and is then added to the eddy
current loss component, and thus the total core loss density distribution element-by-element.
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Additional core loss due to flux normal to laminations
When the laminationmodel is used in theMaxwell 3D transient solver, an additional component of
core losswill be automatically calculated due to the normal component of flux (Bn) on the lamination
stack and will be added to the total core loss, if conductivity > 0 has been specified in thematerial
manager.

l Thematerial conductivity is taken from the project material library (not from the core loss
input panel).

l The eddy effect must always be turned off for laminated objects.
l The additional component of core loss is independent of area normal to the flux, as
indicated in the above equation. In such a case, the induced eddy current due to normal flux
has been assumed to flow freely. Therefore, this approach will not take into account the
splitting of the core laminations into individual packets (such as cutting along XZ or YZ plane
in the above diagram).

Related Topics

Calculating Properties for Core Loss (BP Curve)
Core LossCoefficients for Electrical Steel
Core LossCoefficient Extraction
Setting Core Loss for Transient and EddyCurrent Solvers

Calculating Properties for Core Loss (BP Curve)
To be able to extract parameters from the loss characteristics (B-P Curve), you first set theCore
Loss Model of thematerial toElectrical Steel or Power Ferrite as amaterial property in theView
/ EditMaterial dialog box. (If the Core LossModel is set to Hysteresis Loop, refer toCalculating
Properties Using a Hysteresis Loop inMaxwell.)
To calculate core loss properties for an electrical steel material:

1. ClickTools>Edit Configured Libraries>Materials.
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l Alternatively, in the project tree, you can right-clickMaterials, underDefinitions, and
selectEdit All Libraries.

TheEdit Libraries dialog box appears.
2. ClickAdd Material.

TheView / Edit Material dialog box appears.
3. In theCore Loss Model row, selectElectrical Steel or Power Ferrite from theValue pull-

down list.
Additional parameters appear in the table below Core Loss Model (Kh,Kc,Ke, andKdc for
electrical steel, andCm, X, Y, andKdc for power ferrite). For Electrical Steel, theCore
Loss Coefficient selection in theCalculate Properties for pull-down list at the bottom of
the dialog box is also enabled. This allows the coefficientsKh,Kc,Ke, andKdc to be derived
from amanufacturer-provided core loss curve.

Note TheKdc core loss quantity is not used for the EddyCurrent solution
type.

4. If you selected Electrical Steel, do the following:
a. SelectCore Loss Coefficient from theCalculate Properties for pull-down list at the

bottom of the dialog box.
TheBP Curve dialog box appears.

b. Do one of the following to specify a BP curve:
l Import the curve from a saved file.
l Enter the coordinatesmanually.

Note The accuracy in inputting the data for B-P Curve for the electrical steel material
has significant effect on the correctness of the analyses to the electromagnetic
devices. You should input the data for B-P Curve according to accurate data
provided bymaterial manufacturers. Typically corematerial suppliers provide
the average loss over a cycle for a peak B, of sinusoidal nature. Therefore for
BP curve input in Maxwell, B(Tesla) should be peak and P should be average.

c. Select the units in which the B-P curve ismeasured from theCore Loss Unit pull-down
list.

d. Type values and select units for the following:
l Mass Density
l Frequency
l Thickness
l Conductivity
As the input data changes, the following parameters are dynamically updated with both
the specified unit and the standard unit (w/m^3):

l Kh - Hysteresis Coefficient
l Kc - Classical EddyCoefficient
l Ke - ExcessCoefficient
l Kdc - Coefficient Considering DC Bias Effects (not used for EddyCurrent solution type)
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e. ClickOK.
The View / Edit Material dialog box reappears. The property values forKh,Kc,Ke, and
Kdc are updated as new default values.

5. If you selectedPower Ferrite, do the following:
a. Select a type forCm, X, Y, andKdc from the Type column.
b. Type vAlues for the coefficientsCm, X, Y, andKdc in theValue column.

6. ClickOK to close theView / Edit Material dialog box.
7. ClickOK to close theEdit Libraries dialog box.

Related Topics

Core LossModel for aMaxwell Material
Core LossCoefficients for Electrical Steel
Core LossCoefficient Extraction
Setting Core Loss for Transient and EddyCurrent Solvers
Calculating Properties Using a Hysteresis Loop inMaxwell

Core Loss Coefficients for Electrical Steel

Under sinusoidal flux conditions, core loss is computed in the frequency domain as the following:

When a DC component exists in the flux density, the core loss ismodified to the following:

where
l Bm is the amplitude of the AC flux component,
l f is the frequency,
l Kh is the hysteresis core loss coefficient,
l Kc is the eddy-current core loss coefficient, and
l Ke is the excess core loss coefficient.

Cdc is computed from the following equation:
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where
l Bdc is the DC flux component, and
l Kdc is the coefficient considering the DC flux bias effects.

Related Topics

Core LossCoefficient Extraction

Core Loss Coefficient Extraction

The principles of the computation algorithm forKh,Kc, andKe are summarized as below.

Note Since themanufacturer-provided loss curve is obtained under sinusoidal flux conditions at
a given frequency, these coefficients can be derived in the frequency domain.

The iron-core losswithout DC flux bias is expressed as the following:

where

The classical eddy-current loss coefficient is calculated directly as
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where σ is the conductivity and d is the thickness of one lamination sheets.
Minimize the quadratic form to obtainK1 andK2.

wherePvi,Bmi – the i-th point of the data on themeasured loss characteristics curve.
The other two loss coefficients are obtained as

where f0 is the testing frequency for Loss Curve.

Related Topics

Core LossCoefficients for Electrical Steel

Importing a BP Curve From a File

For the loss characteristics (B-P Curve), you first set the Core LossModel of thematerial to
Electrical Steel as amaterial property in the View Edit window.When you do so, this enables the
Calculate Properties selection for drop down at the bottom of the window. Select “Core Loss
Coefficient” from the drop downmenu to open the B-P Curve window.
Do the following in the BP Curve dialog box:

1. Click Import from file.
The Import data dialog box appears.

2. Find and select the tab separated points file containing the BP curve data points.
3. ClickOpen.
4. Optionally, clickSwap X-Y Data to switch the B values and P values if they are in the wrong

columns.
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Manually Specifying BP Curve Coordinates

For the loss characteristics (B-P curve), you first open theView / Edit window and set theCore
Loss Model of thematerial toElectrical Steel as amaterial property. Doing so enables theCore
Loss Coefficient selection in theCalculate Properties for pull-down list at the bottom of the
dialog box.
SelectCore Loss Coefficient from theCalculate Properties for pull-down list to open theBP
Curve dialog box.
Do the following in theBP Curve dialog box:

l EnterB andP values in each row of theCoordinates table.
Note The value of B must increase along the curve.

Placing the cursor in the field in theCoordinates table enables theAdd Row and
Delete Row buttons.

As you enter values, the graph is updated.
To add or edit rows, click the following buttons:

l Add Row Above
l Add Row Below
l Append Rows (In the dialog box that appears, specify the number of rows to append to the
table, and clickOK.)

l Delete Rows

Assigning Materials from the Object Properties Window
The Properties dialog for each object includes amaterials property. If you click on the current
material property you see a drop-down list that includes an Edit command and a list of materials in
the current project. You can select from the list of current materials to assign the selectedmaterial to
that object.
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Related Topics

AssigningMaterials

Viewing and Modifying Material Attributes
1. In theSelect Definition dialog box or theEdit Libraries dialog box, select thematerial you

want to view or modify.
2. ClickView/Edit Materials.

TheView/Edit Material dialog box appears. Thematerial name and its property values are
listed.

Note By default, not all of the available properties are displayed in thematerials table.
Only the properties commonly used by the product are displayed. To view the
complete table of properties, see FilteringMaterials.

3. Under View/Edit Material for, select:
l Active Design to display properties used in the active design.
l Active Project to display properties used by this project.
l All Properties to display all properties available. This enlarges the table of properties to
show all properties possible. You can use the scroll bars or size the dialog to see all
properties.

4. You canmodify thematerial as follows:
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a. Provide a new name for thematerial in theMaterial Name text box.
b. Under Type, specify whether amaterial property isSimple,Anisotropic, Vector and

Vector Mag, or for Relative Permeability,Nonlinear, as required for that property.
For Simple, you provide a value or variable.
ForAnisotropic, you provide tensor values.
For Vector, you provide aVector Mag, orUnit Vector X, Y, and Z Component values.
ForNon-Linear, you provide a Data Set.

c. Provide new material property values in theValue boxes.
d. Change the units for amaterial property.

Note Maxwell's global material library cannot bemodified. Materials from the library
can bemodified, but not saved back to the system library. They can be saved to
a User Library or Personal Library.

5. ClickOK to save the changes and return to theSelect Definition or Edit Libraries dialog
box.

Warning If youmodify amaterial that is assigned in the active project after generating a
solution, the solution becomes invalid.

Related Topics

ValidatingMaterials
Defining VariableMaterial Properties
CopyingMaterials
RemovingMaterials
Export Materials to a Library
SortingMaterials
FilteringMaterials
Working with Materials Libraries

Setting the Material Threshold
Thematerial thresholds tell theMaxwell 2D andMaxwell 3D solvers how to deal with conductors
and insulators. Materials with conductivities above thePerfect Conductor threshold are treated as
having infinite conductivity and surface current only. Materials with conductivity values below the
Insulator/Conductor threshold are treated as insulators with no conductivity and no current
carrying capability. Materials that fall between the two thresholds are treated as normal conductors
that can carry current throughout the volume of thematerial.

1. ClickMaxwell>Design Settings. TheDesign Settings dialog box appears.
Thematerial thresholds are set in theMaterial Thresholds tab.

2. Type a value in thePerfect Conductor text box.
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3. Type a value in the Insulator/Conductor text box.
4. ClickOK.

Validating Materials
Maxwell and RMxprt can validate amaterial's property parameters for an ANSYS Electromagnetics
software product. For example, it checks if the range of values specified for eachmaterial property is
reasonable.
If a material's property parameters are invalid, an error message will appear in the lower-right corner
of theView/Edit Materialwindow. If the parameters are valid, a green checkmarkwill appear there.
To validate thematerial attributes listed in theView/Edit Materialwindow:

l Select a name from theProperties of the Material list, and then clickValidate Material.

Copying Materials
1. In theSelect Definition dialog box or theEdit Libraries dialog box, select thematerial you

want to copy.
2. ClickClone Material(s).

TheView/Edit Material dialog box appears.
3. Tomodify thematerial's attributes, follow the directions for modifyingmaterials.
4. ClickOK to save the copy in the active project'smaterial library.

Removing Materials
1. In theSelect Definition dialog box or theEdit Libraries dialog box, select amaterial you

want to remove from the active project'smaterial library.
2. ClickRemove Material(s).

A message appears asking if you want to continue.
3. ClickYes.

Thematerial is deleted from the project material library.
Note The followingmaterials cannot be deleted:

l Materials stored in ANSYS Electromagnetics global material
library.

l Materials that have been assigned to objects in the active
project.

In a project library, youmaywant to use theProject>Remove Unused Definitions
command to remove selectedmaterials definitions that your project does not require.
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Exporting Materials to a Library
1. In theSelect Definition dialog box or theEdit Libraries dialog box, select thematerial you

want to export.
2. ClickExport to Library.

TheSave As file browser appears.
3. Do one of the following to specify the location:

l ClickPersonalLib to export thematerial to a local project directory, accessible only to the
user that created it.

l ClickUserLib to export thematerial to a library that is shared bymore than one user,
usually in a central location.

4. Type the library's file name.
5. ClickSave.

Sorting Materials
You can change the order of thematerials listed in theSelect Definition dialog box or theEdit
Libraries dialog box. You can sort the list of materials by name, library location, or material property
value.
To change the order of the listedmaterials:

l Click the column heading bywhich you want to order thematerials.
If the arrow in the column heading points up, thematerial data are listed in ascending order (1 to 9, A
to Z) based on the values in the column you chose. If you want thematerial data to be listed in
descending order (9 to 1, Z to A), click the column heading again. The arrow then points down.

Note By default, not all of the available properties are displayed in thematerials table. Only the
properties commonly used by the product are displayed. To view the complete table of
properties, see FilteringMaterials.

TheMaterial Filters tab of theEdit Libraries dialog box allows you to specify the default for
whether to filter for This Product orAll Products.

Filtering Materials
If you want to remove certain materials or material properties from the list in theSelect Definition
window, use the filter options under theMaterial Filters tab.
You can filter out materials based on the product or library with which they are associated. You can
also filter out material properties and types of material properties. And you can remove the filtering in
order to see all availablematerial properties.
To filter materials or material properties listed in theSelect Definitionwindow, using the choices in
theMaterials tab:
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1. The field under Libraries lists the libraries for the project. Selecting the listed library highlights
it and cause the table to display thematerials in that library.

2. Above the Libraries area, you can check or uncheck boxes to show or hide Project definitions
and all libraries.
l With both unchecked, nothing appears in thematerials table. With both checked, the table
shows all materials and highlights those used in the project.

l With only Project Definitions checked, thematerials table shows only thematerials used in
the project.

l With All Libraries checked, the table displays all materials, but may not show all available
properties.

To filter out or show additional material properties in theMaterials tab:
1. Click theMaterial Filters tab.
2. Under Show Materials and Properties for, select one of the radio buttons:

l Active Design to display properties used in the active design.
l Active Project to display properties used by the current project.
l All Materials and Properties to display all availablematerials and properties. Selecting
this enlarges the table of properties shown under theMaterials tab to show all properties
possible. You can use the scroll bars or size the dialog to see all properties.

3. Under Show Material Types, clickSelect All to select all of the products listed. ClickClear
to clear all product selections.

4. Click theMaterials tab to save your selections.
ClickCancel to revert back to the last saved selections.

Related Topics

ValidatingMaterials
CopyingMaterials
RemovingMaterials
Export Materials to a Library
SortingMaterials
Working with Materials Libraries

Working with Material Libraries
There are two different kinds of materials libraries in Maxwell, a system library and a user library.

Related Topics

Editing Libraries
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Working with the System Material Library

The library files that ship with Maxwell are stored under the syslib directory. These libraries are
intended to be read-only and should not bemodified. They are available for anymaterial assignment
in any project.

Working with User Material Libraries

In addition to the system libraries, Maxwell recognizes two user-configurable library structures: the
User Library and the Personal Library. These are used to add user (or company) definedmaterials.
Typically, userlib is a network repository for proprietary or corporate definitions available to all seats
in an enterprise. personalLib contains project and design-specific libraries as needed by individual
designs.
A root library directory is set up at installation. If none is specified, the default is the root Maxwell
directory.
Materials from libraries in both the User Library and Personal Library, as well as the System Library,
are available for use in projects.

Editing Libraries

There are two different methods of editing libraries.
l Using right-click onMaterials in the project window and selecting theEdit Library shortcut to
display theEdit Libraries window.
Editing definitions from the project window does not modify the configured libraries for any
particular design, since this is editing in general.

l Using Tools>Edit Libraries>Materials from themenu bar takes the current design into
account and adds any new libraries to the configured list for the design.

Related Topics

Adding New Materials
EditingMaterial Definitions
ExportingMaterials to a Library
Permanent Magnets
Nonlinear Materials

Editing Material Definitions

When editingmaterial definitions or adding amaterial to the user/personal library, use themenu
command (Tools>Edit Libraries>Materials) rather than the project tree. Editing or defining
definitions by right-clicking in the project tree window does not modify the configured libraries for any
particular design – it only edits thematerial in general. When you use themenu command, the
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current design is considered, and any new materials aremade available to assign in that current
design. New or modifiedmaterials can also be exported to a library in the User Library or Personal
Library from theEdit Libraries dialog.
To edit a material's definition:

1. ClickTools>Edit Libraries>Materials.
TheEdit Libraries dialog appears.

2. In theSearch Parameters section under Libraries, select the library database. By default
the [sys] Materials system library is selected.

3. Select thematerial you want to edit, and clickView/Edit Materials.
TheView/Edit Material dialog appears.

4. Make the desired changes to theMaterial Name, theMaterial Coordinate System Type,
and the properties listed in theProperties of the Material section.

5. From theView/Edit Material for section, select whether the changes shall apply to the
(Active Design,Active Project, or All Properties).

6. For 3D Designs only: Youmay optionally set a ThermalModifier to specify that certain
material properties have characteristics that vary with temperature.

7. ClickValidate Material to make sure your changes are valid.
If thematerial properties are valid, a green checkmark appears below theValidate Material
button.

8. Optionally, use theCalculate Properties for... drop down list to calculate properties for a
permanent magnet or a Non-Linear Permanent Magnet.

9. Optionally, to calculate properties for core loss, selectCore Loss Coefficient from the
Calculate Properties for... drop down list.

10. When you are donemaking changes to thematerial properties, clickOK.
TheEdit Libraries dialog reappears.

11. If you are finished in theView/Edit Material dialog, clickOK to close it.

Setting a Thermal Modifier

Materials used in 3D Designs and for sheet objects in 2D Designsmay have a ThermalModifier
assigned to change specificmaterial properties with temperature, primarily for use when coupling to
ePhysics.
To specify Thermalmodifiers for amaterial:

1. In the View/ Edit materials dialog youmust enable the View/ Edit Modifier check box for
ThermalModifier.
This causes the Properties of theMaterial table to expand to include a ThermalModifier
column. By default, the ThermalModifier property is set toNone.

2. Selecting Edit... from the drop downmenu, rather thanNone causes theEdit Thermal
Modifier dialog to appear.
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3. Select theExpression radio button to display theParameters Modifier text field or the
Quadratic radio button to display the tabs forBasic Coefficient Set andAdvanced
Coefficient Set.
l WithExpression selected, you can write an equation for a thermal modifier in the
ParametersModifier text field.
CheckingUse temperature dependent data set disables theModifier text field. You
can then use the drop downmenu to select Add/Import Dataset. This lets you define the
thermal modifier as a data set.

l With theQuadratic radio button selected, in theBasic Coefficient Set tab, you can edit
fields for the TempRef and units, and fields for C1 and C2 for the following equation:
P(Temp) = Pref[1+ C1(Temp - TempRef) + C2(Temp - TempRef)^2]
where the Pref is defined as the reference relative permittivity.

l With theQuadratic radio button selected, in theAdvanced Coefficient Set tab, you can
edit fields for lower and upper temperature limits (TL and TU respectively) and select their
units from the drop down.
You can also edit the constant value limit for the thermal modifier values outside the limits.
By default, these are automatically calculated. UncheckAuto Calculate TML, TMU to
specify new values for thermal modifier lower (TML) and thermal modifier upper (TMU)
limits.

4. ClickOK to accept the edits and return to the View/ Edit materials dialog.

Related Topics

Adding Datasets
View/ Edit materials dialog
Set Ambient Temperature

Setting the Temperature of Objects
To set the temperature of temperature dependent objects:

1. Use theMaxwell>Set Object Temperature command to display the Temperature of
Objects dialog box.
This dialog box includes a table of the objects in the design. The first column lists theObject
Name. The second column lists theMaterial. The Temperature Dependent column displays
a check box to show whether that object has temperature dependent features. The remaining
columns give the object Temperature andUnit of measure.
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2. Maxwell allows you to enable/disable temperature dependency independently for each design
in the same project. To include temperature dependency and enable the editing features,
check Include Temperature Dependence.
Thismakes the table objects selectable. The headers for theObject Name column and the
Material column include sort direction arrows. You can invert the sort direction in each column
by clicking the header. If the list is longer than the display, you can use a scroll bar on the right
of the table.
With the dialog enabled, you can use the Select by name field. Enter the name of the object
you want and clickSelect.
Selected objects are highlighted. You canmakemultiple selections.

3. To set the initial Temperature for a selected Temperature Dependent object or objects,
type the value or an existing variable name in the text field; then select the unit of measure
from the drop downmenu.

4. ClickSet to apply the value to the selected temperature dependent objects, or clickSet
Default to make the specified values the default.
If you clickSet Default, the row(s) for the selected object(s) display the Temperature value
and units.
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5. When temperature dependence is enabled, you can edit thematerial for an object by clicking
on thematerial for the row to display a drop downmenu listing thematerial and anEdit...
menu item.
SelectEdit... to display theMaterials dialog in which you can edit thematerial for the selected
object. When finished, close the dialog to return to the Temperature of Objects dialog

6. TheEnable Feedback check box appears whenMaxwell is used with the ANSYS
Workbench. If checked, you can perform thermal analysis based on aMaxwell solution.

7. To close the Temperature of Objects dialog and accept the changes, clickOK.

Related Topics

Reverting Objects to Initial Temperature

Reverting Objects to Initial Temperature

When a design is enabled for thermal feedback, aRevert to Initial Temperaturemenu item is
added to the context menu of the solution setup item and analysis setup folder in the project tree.
Thismenu item is enabled when there are exported thermal data fromMechanical or when thermal
data has been incorporated into the current Maxwell solution. ChoosingRevert to Initial
Temperature reverts the temperatures of objects to their initial temperatures.

Setting Deformation of Objects for Stress Feedback
For Maxwell systems that are coupled to ANSYS Structural viaWorkbench., users can enable
objects for stress feedback in theDeformation of Objects dialog box.
To set the deformation of stress dependent objects:

1. Use theMaxwell>Deformation of Objects command to display theDeformation of
Objects dialog box.
This dialog box includes a table of objects in the design. The first column lists theObject
Name. The second column lists theMaterial. TheDeformation Dependent column displays
a check box to show whether that object has deformation-dependency enabled.
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Objects without an assignedmaterial, non-model objects, non-3D objects in Maxwell 3D
designs, and non-2D objects in Maxwell 2D designs cannot be handled by the solver and thus
do not appear in the table.

2. To include deformation dependency, checkEnable Stress Feedback.
Thismakes the table objects selectable. The headers for theObject Name column and the
Material column include sort direction arrows. You can invert the sort direction in each column
by clicking the header. If the list is longer than the display, you can use a scroll bar on the right
of the table.

3. Check theDeformation Dependent check box for those objects you wish to include in the
stress feedback analysis.
Note Switching the state of Enable Stress Feedback orDeformation Dependent for

any object invalidates the existing solution. Existing solutions include all field and
non-field solutions, such as force and torque.When these options are switched from
on to off, existing field solutions include previously incorporated displacement data.
On the next simulation, the design will re-solve the last solved pass.

4. To close theDeformation of Objects dialog box and accept the changes, clickOK.

Related Topics

Reverting Objects to Zero Displacement
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Reverting Objects to Zero Displacement

When a design is enabled for stress feedback, aRevert to Zero Displacementmenu item is added
to the context menu of the solution setup item and analysis setup folder in the project tree. Thismenu
item is enabled when there are exported displacement data from structural or when displacement
data has been incorporated into the current Maxwell solution. ChoosingRevert to Zero
Displacement reverts the displacement values of objects to zero.

Permanent Magnets
A permanent magnet is defined as amaterial that generates amagnetic flux due to permanent
magnetic dipoles in that material.

Related Topics

Non-Linear vs. Linear Permanent Magnets
Characteristics andMain Parameters of Permanent-magneticMaterials
Calculating the Properties for a Permanent Magnet
Calculating the Properties for a Non-Linear Permanent Magnet
Calculating Properties Using a Hysteresis Loop inMaxwell

Nonlinear vs. Linear Permanent Magnets

In general, permanent magnets are nonlinear and should bemodeled via a B-H curve as shown
below. Themagnetic coercivity, Hc, is defined as the B-H curve's H-axis intercept, and themagnetic
remanence, Br, as its B-axis intercept.
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Inmany applications, however, the permanent magnet's behavior can be approximated using a
linear relationship betweenB andH. In these cases, there is no need to create a nonlinear material.
Simply enter the appropriate values of Br or Hc for thematerial when defining its properties.

Compute Remanent Br from B-H curve

The value of the remanent Br of the individual element after themagnetization field is computed is
determined in such a way: after having located the operating point on the original non-remanent B-H

curve, draw a line which is parallel to the original recoil curve with the slope of and passes the
operating point, the intersection of this line with B-axis is the remanent Br as the result of the applied
magnetization field.
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Temperature Dependent Nonlinear Permanent Magnets

To consider the temperature dependence of the demagnetization behavior, the demagnetization
curve is described by temperature dependent parameters, which can be derived from supplier
datasheets. For a better representation of any types of magnets by a function, it is advantageous to
work with an intrinsic flux densityBi versusH curve, instead of a flux densityB vsH curve. The
relationship betweenBi andB is:

(1)

The temperature dependency of an intrinsic BH curve can be specified by two temperature
dependent parameters: remanent flux densityBr and intrinsic coercivityHci. HereBr is the value of Bi
(andB) whenH=0 andHci is the value ofH at B=0. BothBr andHci can be described using second
order polynomials of temperature T as:

(1)

and

(1)

where T0 is the reference temperature, and α1, α2, β1, and β2 are coefficients which can be
identified from supplier datasheets. In general, the thermal modifiersP(T) andQ(T) also can be
described by any user-defined function of temperature T, in addition to the above second order
polynomials.
Consequently, once aBi-H curve is constructed by a function using certain techniques, such as
curve fitting at the reference temperature T0, anyBi-H curves at other temperatures can be
dynamically reconstructed in terms of the temperature dependence of Br(T) andHci(T). Finally, the
B-H curve in the second and the third quadrants can be further derived through the conversion using
equation (1).
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Since themodel specifies two temperature dependent parameters: remanent flux densityBr (α) and
intrinsic coercivityHci(β), the thermal modifier P(T) is specified in the field associated with the input of
relative permeability (or Bi-H curve), and the thermal modifierQ(T) is specified in the field associated
with themagnitude of coercivity forHci.

Characteristics and Main Parameters of Permanent-magnetic Materials

The permanent-magneticmaterial belongs to hard-magneticmaterial. It is characterized with "fat"
hysteresis loop, which encloses large area as shown in the figure. Whenmagnetized, it keeps high
magnetic property with the external magnetic field removed, therefore is used in the permanent-
magnet electricmachine to producemagnetic field. The characteristics of the permanent-magnetic
material are represented with itsmain parameters: residual flux densityBr, coercive field forceHc
andmaximummagnetic energy product (BH)max.

Figure 10-1 "Fat" Hysteresis Loop

Related Topics

Demagnetization Curve
Calculating the Properties for a Permanent Magnet
Calculating the Properties for a Non-Linear Permanent Magnet
Calculating Properties Using a Hysteresis Loop inMaxwell
Temperature Dependent Nonlinear Permanent Magnets

Demagnetization Curve

The part of themaximumhysteresis loop of the permanent-magneticmaterial in the second
quadrant is called the demagnetization curve as shown in the next figure. It is the basic
characteristics curve of the permanent-magneticmaterial. On the demagnetization curve, the
magnetic flux density has positive values, but themagnetic field intensity has negative values. It
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means that the permanent-magneticmaterial is applied with demagnetizationmagnetic field
intensity. SinceHm andBm are in opposite directions, when themagnetic flux goes through the
permanent-magneticmaterial, themagnetic potential difference along the direction of themagnetic
flux does not drop, but rises. Therefore, the permanent-magneticmaterial is amagnetic source,
similar to the electric source in the electric circuit.

The two extreme positions on the demagnetization curve are the two significant parameters to
represent themagnetic characteristics of the permanent-magneticmaterial. On the demagnetization
curve, the value of themagnetic flux density corresponding to zeromagnetic field intensityH is
termed residual flux densityBr, on the other hand, the value of themagnetic field intensity
corresponding to zeromagnetic flux densityB is termed coercive field forceHc. The produce of the
magnetic flux density and themagnetic field intensity at any point on the demagnetization curve is
termedmagnetic energy product (BH), which is proportional to themagnetic energy density
possessed by the permanent magnet at the given operating situation. At the two extreme positions
(B = Br, H = 0) and (B = 0, H = Hc), themagnetic energy product is equal to zero. Somewhere at an
intermediate position, themagnetic energy reaches itsmaximum value and is termedmaximum
magnetic energy product (BH)max, which is another significant parameter to represent themagnetic
characteristics of the permanent-magneticmaterial. To some permanent-magneticmaterials with
linear demagnetization curve, it is obvious that at (B = Br / 2, H = Hc / 2), themagnetic energy
product reaches itsmaximum value, i.e. (BH)max = BrHc / 4.

Recoil Lines

The relationship between themagnetic flux density and themagnetic field intensity represented by
the demagnetization curve only exists when themagnetic field intensity varies in the same direction.
In fact, when the permanent magnet electricmachine is working, the demagnetization field intensity
varies repeatedly in both directions.When demagnetization field is applied to themagnetized

AssigningMaterials 10-42
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

permanent magnet, themagnetic flux density decreases along the curly segmentBrP on the
demagnetization curve as shown in the figure

If the external demagnetization field intensityHp is removed when themagnetic flux density reaches
the pointP, themagnetic flux density will increase not along the original demagnetization curve, but
along another curvePVR. If the external demagnetization field intensity is reapplied, themagnetic
flux density will decrease along the new curveRUP. By repeatedly applying the demagnetization
field intensity, a localized loop is formed and is termed local hysteresis loop. On the local hysteresis
loop, the rising segment and the dropping segment are quite close to each other, therefore can be
approximated by the straight linePR, which is termed recoil line withP as the starting point. If
demagnetization field with intensityHq not exceeding the original valueHp is applied thereafter, the
magnetic flux density will vary reversibly along the recoil linePR. IfHq > Hp, themagnetic flux density
drops to a new starting pointQ. It will vary along the new recoil lineQS, but not the previous onePR.
This sort of irreversible variation in magnetic flux density causes instability in the characteristics of
electricmachines and complicates the design computation of permanent magnet electricmachines,
therefore should be avoided as possible.

Calculating the Properties for a Permanent Magnet

From the View/Edit Materialswindow:
1. Set theRelative Permeability toSimple.

This enables theCalculate Properties for... drop downmenu at the bottom of the window.
2. ClickPermanent Magnet from the drop-downmenu.

This displays theProperties for Permanent Magnet dialog. This contains the following
fields.

Mu (enabled by Provide a value for relative permeability.
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default)

Hc (enabled by
default)

Coercive field forceHc in the units specified. Provide a value and select units
from the drop-downmenu.

Br/Mp (disabled by
default)

Checking this enables the radio buttons that let you specify either Br or Mp.

Br Residual flux densityBr, in Tesla.
If enabled, provide a value and select units from the drop-downmenu.

Mp Permanent MagnetizationMp, in A/m.
If enabled, provide a value and select units from the drop-downmenu.

3. ClickOK to close the dialog and return to theView/Edit Materials window.
The values forRelative Permeability andMagnitude underMagnetic Coercivity are
updated as new default values.

Related Topics

Non-Linear vs. Linear Permanent Magnets
Characteristics andMain Parameters of Permanent-magneticMaterials
Calculating the Properties for a Non-Linear Permanent Magnet
Temperature Dependent Nonlinear Permanent Magnets

Calculating the Properties for a Non-Linear Permanent Magnet

Non-linear permanent magnet propertiesmay be specified in one of two ways.

First, a BH curve may be input directly as follows:
1. Click theView/Edit Materials… button in theEdit Libraries dialog box.

TheView/Edit Material dialog box appears.
2. The nonlinear BH curve is defined by setting theRelative PermeabilityType either to

Nonlinear orAnisotropic.
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If you select Anisotropic, each of its components can be selectedNonlinear and can be
specified by aBH Curve.

A B-H Curve button appears in the nonlinear property’sValue column
3. Input the BH curve by clicking theB-H Curve button in the propertyValue column.

This opens theBH Curve dialog box in which you can input (or modify) curve data. (Refer to
Adding Datasets for general information on working with datasets.
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l For aNormalBH curve, the slope of the curve can not be less than that of free space
anywhere along the curve.

l For an IntrinsicBH curve, the slope of the curve can not be less than 0.
Note l The IntrinsicBH curve is supported only in Maxwell 2D/3D magnetostatic

and transient design types. A material property defined using an Intrinsic BH
curve will fail validation check in all the other product/design types.

l When an IntrinsicBH curve is added, theRelative Permeability Value
button label changes toBi-H Curve as visual indication of the type of curve
currently defined for thematerial.

When youOK the dialog, an error message displays if a slope is out of tolerance, identifying
the data points between which the slope is less than that of free space.
The operations to input a nonlinear demagnetization curve are the same as entering a BH
curve for Steel material. When a BH curve goes through the second quadrant or third
quadrant, the curve is treated as a demagnetization curve.

4. Tomodel temperature dependency for a nonlinear permanent magnet youmust:
l Use an IntrinsicBH curve tomodel theRelative Permeability
l Specify a ThermalModifier for bothRelative Permeability and theMagnitude of
Magnetic Coercivity. Apply a thermal Modifier by selecting the Thermal Modifier check
box. Checking this box causes the Thermal Modifier column to display at the right side of
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theProperties of the Material table. SelectingEdit rather thanNone causes display of
theEdit Thermal Modifier dialog.

Alternatively, a non-linear BH curve can be modeled by the following four parameters:
l residual flux densityBr
l coercive field forceHc
l maximumenergy product (BH)max
l relative recoil permeability µr

From the View/Edit Materialswindow:
1. Set theRelative Permeability toNonlinear.

This enables theCalculate Properties for... drop downmenu at the bottom of the window.
2. ClickNon-Linear Permanent Magnet from the drop downmenu.

This displays theProperties for Non-Linear Permanent Magnet dialog box, which
contains the following fields into which you enter the appropriate values.

Mur Provide a value for relative permeability.

Hc Coercive field forceHc in the units specified. Provide a value and select units from the drop
downmenu.

Br Residual flux densityBr, in Tesla.
If enabled, provide a value and select units from the drop downmenu.

BH
max

Maximummagnetic energy product (BH)max
If enabled, provide a value and select units form the drop downmenu.
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3. ClickOK to close the dialogue and return to theView/Edit Materials window.
The values forRelative Permeability andMagnitude underMagnetic Coercivity are
updated as new default values.

Related Topics

Non-Linear vs. Linear Permanent Magnets
Characteristics andMain Parameters of Permanent-magneticMaterials
Calculating the Properties for a Permanent Magnet
Temperature Dependent Nonlinear Permanent Magnets

Calculating Properties Using a Hysteresis Loop in Maxwell

For amaterial whose Relative Permeability is Nonlinear (refer toCalculating the Properties for a
Non-Linear Permanent Magnet), and whoseMagnitude ofMagnetic Coercivity is zero, you can
calculate core loss properties using a hysteresis loop as follows:

1. ClickTools>Edit Configured Libraries>Materials. to open theEdit Libraries dialog box.
l Alternatively, in the project tree, you can right-clickMaterials, underDefinitions, and
selectEdit All Libraries.

2. ClickAdd Material to open theView/ Edit Material dialog box.
3. In theCore Loss Model row, selectHysteresis Model from theValue pull-down list.

If you select either View/Edit Material for: This Product orAll Products radio button,
additional parameters appear in the table below Core Loss Model (Intrinsic Coercivity
Hci,Remanency Br andKc).You can input these values directly. You can also supply the
Hci andBr values in theProperties for Hysteresis Loop dialog box as described below.
TheHysteresis Loop selection in theCalculate Properties for pull-down list at the bottom
of the dialog box is also enabled. This allows the coefficientsHci, andBr to be derived from a
manufacturer-provided core loss curve.

4. SelectHysteresis Loop from theCalculate Properties for pull-down list at the bottom of
the dialog box to open theProperties for Hysteresis Loop dialog box The current BH
Curve coordinates are loaded by default.Hci andBr values from the Intrinsic Coercivity
Hci,Remanency Br fields in theView / Edit Material dialog box are also displayed.

AssigningMaterials 10-48
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

5. Do one of the following to specify the hysteresis loop curve:
l Enter theB andH values in each row of theCoordinates table manually. The graph
updates as you enter values. Buttons allow you Add, Append, and Delete table rows as
needed.
Note l The value ofBmust increase along the curve.

l The accuracy of input data for the curve has significant effect on the
correctness of the analyses of the electromagnetic devices. You should
ensure curve data provided bymaterial manufacturers is accurate.

l You can also import the hysteresis loop coordinates from a saved file.
a. Click Import Dataset to open the Import Dataset dialog box.
b. Find and select either the BH Data .bh file, or the tab-delimited .tab file containing the

curve data points. ClickOpen to import the data.
c. Optionally, clickSwap X-Y Data to switch the B and H values if they are in the wrong

columns.
6. Optionally, enter theHci andBr values and choose appropriate units for them. Input Brmust

be enabled to enable theBr entry box; otherwise, the default zero value indicates thatBr will
be determined automatically by the software. (These fieldsmay already have values in them if
previously supplied in theView / Edit Material dialog box.) Disabling Input Br resets theBr
value to zero.

7. Optionally, select eitherNormal (the default) or Intrinsic for BH curve input and plot display.
When changing fromNormal to Intrinsic (or vice-versa) the following dialog displays, allowing
you to choose whether or not to convert B values.
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8. Optionally, you can export data for the descending and ascending curve of the hysteresis loop.
You can also export the BH curve aswell as the smoothed BH curve.

9. ClickOK to close theProperties for Hysteresis Loop dialog.
The values ofMagnetic Coercivity Magnitude,Hci, andBr are updated in theView/Edit
Material dialog.

Note In theView/Edit Material dialog, if theMagnetic Coercivity Magnitude is changed to a
non-zero value bymodifying theRelative Permeability B-H Curve property, theCore
Loss Model property is reset fromHysteresis Model toNone.

10. ClickOK to close theView / Edit Material dialog box.
11. ClickOK to close theEdit Libraries dialog box.

Magnetostriction and Inverse Magnetostriction
Magnetostriction is a property of ferromagneticmaterials that causes their deformation during the
process of magnetization. The structure of suchmaterials is divided into domains, each of which is a
region of uniformmagnetic polarization.When amagnetic field is applied, the domains rotate
causing a change in thematerial's dimensions. This change in thematerial's dimensions is due to the
anisotropic crystalline structure of thematerial – it takesmore energy tomagnetize a crystalline
material in one direction than another. For example, the steel used for the thin laminations in
transformers ismanufactured by passing it through a series of rollers to achieve the desired
thickness. Consequently its crystalline structure – and associatedmagnetic domains – differs along
the direction in which it was rolled (the rolling direction) versus the transverse direction.
Magnetostriction – and InverseMagnetostriction – can be regarded as an energy transduction (or
transformation) frommagnetic to mechanical and vice-versa. It can also be described as a
bidirectional magneto-mechanical coupling between themechanical andmagnetic fields in the
magnetostrictivematerial. It is magnetostriction that causes the low-pitched humming sound that can
be heard coming from transformers – caused by the changingmagnetic field produced by oscillating
AC currents. For detailed information on these properties, refer toMagnetostrictionModeling of
MagneticMaterials in the technical notes section.
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l Magnetostriction/inversemagnetostriction properties can be applied toMaxwell 2D/3D
magnetosatic and transient solutions through customizableMagnetostriction and Inverse
Magnetostrictionmaterial properties.

l Maxwell desktop supplies theMagnetostriction and InverseMagnetostrictionmaterial
properties to theMaxwell solver. The solver then calculates force density with
magnetostriction force components included.

l For Maxwell Magnetostatic solutions, if anymaterial used has the InverseMagnetostriction
property defined, Maxwell desktop saves the initial H field, which is generated by the solver
without exterior stress/strain applied, in the project results.

l Magnetostriction and inversemagnetostriction are applicable toMaxwell 2D/3D Magnetosatic
design one-way and two-way coupling with AnsysMechanical system.

Related Topics

Calculating Properties for Magnetostriction
Calculating Properties for InverseMagnetostriction
MagnetostrictionModeling of MagneticMaterial

Calculating the Properties for Magnetostriction

Themagnetostriction property supports threemodels: Linear, Nonlinear, and Anisotropic. The
property values you enter typically come frommanufacturer data sheets.
To define thesemodel properties, from theView/Edit Material dialog:

1. Click theEdit button to the right ofMagnetostriction Custom to open theMagnetostriction
properties dialog.

2. Choose aProperty type from the drop-downmenu: Linear,Nonlinear, orAnisotropic and
do one of the following:
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a. For Linear, enter values forMagnetostrictive Coefficient,H max, andH min.

b. ForNonlinear, click theMulti-curves button

to add one or more Stress dependent Lambda-H curves.
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Enter a stress value in theEdit text box and clickAdd, then clickEdit Dataset to open
theEdit Dataset dialog, in which you enter coordinate values for theMagnetic Field
(H) and strain (Lambda).
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When finished, clickOK to close the dialogs and return to theMagnetostriction dialog.
c. ForAnisotropic, select either Linear orNonlinear from theRolling Direction and

Transverse Direction drop-downmenus. Rolling Direction refers to the alignment of
the crystalline structure (and associatedmagnetic domains) in the direction along which
thematerial (such as the steel laminations used in transformers) passed through the
rollers duringmanufacture. Transverse Direction is at right angle to the Rolling
Direction. Magnetostriction property values typically differ in each direction.

Note The type you select for each of the directions need not be the same. For
example, you could select Linear for Rolling Direction and Nonlinear for the
Transverse Direction, and vice versa.
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l For Linear, enter values forMagnetostrictive Coefficient,H max, andH min;
and forRolling Direction only, enter theX, Y, and Z coordinate values.

Note The X, Y, and Z components of the Rolling Direction correspond to
theMaterial Coordinate System Type set in theView/Edit
Material dialog.

l ForCartesian: X=X, Y=Y, Z=Z
l ForCylindrical: X=R, Y=Phi, Z=Z
l For Spherical: X=Rho, Y=Theta, Z=Phi

l ForNonlinear, click theMulti-curves button to add one or more Stress
dependent Lambda-H Curves.
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Enter a stress value in theEdit text box and clickAdd, then clickEdit Dataset to
open theEdit Dataset dialog, in which you enter coordinate values for the
Magnetic Field (H) and strain (Lambda).
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When finished, clickOK to close the dialogs and return to theMagnetostriction dialog.
3. ClickOK to close theMagnetostriction dialog and return to theView/Edit Materialsdialog.

Related Topics

MagnetostrictionModeling of MagneticMaterial
Magnetostriction and InverseMagnetostriction
Calculating the Properties for InverseMagnetostriction

Calculating the Properties for Inverse Magnetostriction

The inversemagnetostriction property supports twomodels: Linear, and Nonlinear. The property
values you enter typically come frommanufacturer data sheets.
To define thesemodel properties, from theView/Edit Materialwindow:

1. Click theEdit button to the right of Inverse Magnetostriction Custom to open the Inverse
Magnetostriction properties dialog box.
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2. Choose aProperty type from the drop-downmenu: Linear, orNonlinear, and do one of the
following:

a. For Linear, enter values for Inverse Coefficient, Sigma max, andSigma min,
where sigma representsmechanical stress.

b. ForNonlinear, click theMulti-curves button

to add one or more Stress dependent B-H curves, or H dependent B-Sigma curves.
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l ForB-H curves versus Stress (as shown above) – Enter a stress value in the
Edit text box and clickAdd; then clickEdit Dataset to open theEdit Dataset
dialog, in which you enter coordinate values for theMagnetic Field (H) and
Magnetic Induction(B).
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l For B-Sigma curves versus H (as shown below) – Enter amagnetic field
strength value in theEdit text box and clickAdd;
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then clickEdit Dataset to open theEdit Dataset dialog, in which you enter
coordinate values for theStress (Sigma) andMagnetic Induction(B).
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When finished, clickOK to close the dialogs and return to the Inverse
Magnetostriction dialog.

3. ClickOK to close the dialog and return to theView/Edit Materials window.

Related Topics

MagnetostrictionModeling of MagneticMaterial
Magnetostriction and InverseMagnetostriction
Calculating the Properties for Magnetostriction

Nonlinear Materials
Magnetostatic
If a material has a permeability that varies with the flux density, aB vs.H curve (B-H curve) such as
the one below is needed to describe thematerial's nonlinear behavior.
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In nonlinear materials, the B-field (magnetic flux density) is a function of itself:

where µr(B), the relative permeability, depends on themagnitude of the B-field at each point in the
material. Therefore, to model themagnetic behavior of thematerial, a curve relating the B-field
directly to the H-field is used to describe the nonlinear relationship.
See also Advanced Nonlinear Options for Magnetostatic Solutions or Magnetization for Transient
Solutions for more information about permeability andmagnetization settings.

Perfect Conductors
Perfect conductors are used inMaxwell to approximate the following:

l Magnetic field effects at a conductor surface when current flow is restricted to the conductor
surface. This condition can exist in conductors with very high conductivity.

l Themagnetic field at the surface of a conductor carrying high frequency current, modeled in
the eddy current solver when the frequency is very high. Perfect conductors are used in
conjunction with Impedance Boundaries in the EddyCurrent solvers to handle the following
conditions:
a. The skin depth in the conductor is less than two orders of magnitude smaller than the

dimensions of the structure. In models like this, themeshmaker may not be able to create
a fine enoughmesh in the conductor to compute eddy currents.

b. Themagnetic field decaysmuchmore rapidly inside the conductor in the direction that’s
normal to the surface than it does in directions that are tangential to the surface.

c. The AC current source is relatively far away from the surface where eddy currents occur,
compared to the size of the skin depth.

l Conductors in the Electrostatic solver where the voltage is constant in the conductor and there
is no electric field penetration in the conductor.

l In the DC Conduction solver where amaterial contains a high conductivity.
l In conjunction with boundaries requiring thematerial on one side of the boundary to be the
background region such as impedance or resistance boundaries.
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Because of the special treatment of perfect conductors, no field solution is performed in these
objects, saving time and computer resourceswhen the approximation does not significantly change
the field solution outside the conductor.
In order to define an object as a perfect conductor, do one of the following:

l Assign the Perfect Conductor material to the object in theMaterial Manager.
l Set the object to have amaterial with a conductivity greater than the conductivity defined in the
Material Threshold section of the Design Settings dialog.
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11 - Assigning Boundaries and Excitations for 3D
Designs

For every project, you need to assign boundaries and excitations. For 3D designs, you can use the
Maxwell3Dmenu or the project tree to do the following:

l Define boundary conditions that control how the electric or magnetic field behaves at object
faces, planes of symmetry and periodicity, and edges of the problem region.

l Define excitations of voltage, charge, coil, and current.
l Identify conductors in which eddy currents are induced.
l For magnetic transient projects, set up a winding and an external circuit connection.

Each field solver requires you to specify excitations of electric or magnetic fields and references for
computing these fields.

l Magnetostatic Boundaries and Excitations
l Electrostatic Boundaries and Excitations
l DC Conduction Boundaries and Excitations
l EddyCurrent Boundaries and Excitations
l Transient Boundaries and Excitations
l Electric Transient Boundaries and Excitations

Youmust specify at least one of the boundary conditions or excitations listed in these sections, so
that the simulator can compute accurate values for fields and parameters.

Related Topics

Specifying the Solver Type

Selecting Objects and Faces in the Geometry
Before creating a boundary or excitation, youmust specify its location by selecting the object or
surface on which to assign the boundary condition or source excitation.

Defining Boundary Conditions
To assign a boundary condition:

1. Select the section of the geometry on which you want to apply the boundary condition.
2. ClickMaxwell 3D>Boundaries>Assign, or right-clickBoundaries in the project tree and

clickAssign.
3. Select the desired boundary type from the sub-menu. The specific boundary types you can

define depend on the solver you have chosen for your project.
l Magnetostatic Boundary Conditions
l Electrostatic Boundary Conditions
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l DC Conduction (Electric) Boundary Conditions
l EddyCurrent Boundary Conditions
l 3D Transient Boundary Conditions

4. Enter the name for the boundary or accept the default.
5. Depending on the boundary type, youmay need to define additional parameters.
6. ClickOK to create the new boundary.

The new boundary is added to the boundary list in the project tree.

Related Topics

Setting a SymmetryMultiplier

Defining Excitations
The specific excitations you can define depend on the solver you have chosen for your project.

l Magnetostatic Excitations
l Electrostatic (Electric) Excitations
l DC Conduction (Electric) Excitations
l EddyCurrent Excitations
l 3D Transient Excitations
l Electric Transient Excitation

To assign an excitation:
1. Select the section of the geometry on which you want to apply the excitation.
2. ClickMaxwell>Excitations>Assign, or right-clickExcitations in the project tree and click

Assign.
A submenu appears.

3. Select an excitation type from the submenu. The choices vary depending on the solver type
you have chosen. Choices include:
l Voltage
l Voltage Drop
l Charge
l VolumeCharge Density
l Current Density
l Current
l Permanent Magnet Field

4. Enter the name for the excitation type or accept the default.
5. Enter the desired parameter values, units, and other settings for the excitation in the dialog.

You can also enter amathematical function to determine values for voltage, current density,
charge density, and other parameters. The Permanent Magnet Field excitation also requires
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you set up a link to a source project.
Note When entering current, current density terminals, or coil terminals, the arrow

associated with current in the selected object shows the direction as if a positive
value is entered for the current. If a negative value is entered the actual current flow
direction is opposite to what the arrow shows. ClickSwap Direction if you want to
reverse the direction of the arrow.

6. ClickOK to create the new excitation.
The new excitation is added to the excitation list in the project tree.

Viewing Boundaries and Excitations
To view a list of all boundaries or excitations set for the project:

1. In the project tree, right-clickBoundaries or Excitations.
A shortcut menu appears.

2. Select List from the shortcut menu.
TheDesign List window appears, with the tab page visible for the item you selected. This
window contains tabs forModel,Boundaries, Excitations, Parameters,Mesh
Operations, andAnalysis Setup.

3. To view the properties for an item in the list, select the item, and clickProperties.
4. To delete an item from the list, select the item, and clickDelete.
5. When you are finished in theDesign Listwindow, clickDone to close it.

Setting the Visibility for Boundaries and Excitations

To show or hide a boundary:
1. ClickView>Active View Visibility.

TheActive View Visibility dialog box appears.
2. Click the Boundaries tab.
3. Select or clear theVisibility check box for each boundary listed.
4. ClickDone.

To show or hide a excitation:
1. ClickView>Active View Visibility.

TheActive View Visibility dialog box appears.
2. Click the Excitations tab.
3. Select or clear theVisibility check box for each excitation listed.
4. ClickDone.

Functional Boundaries and Excitations
Functional boundaries and excitations can be used to do the following:
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l Define the value of a boundary or excitation quantity (such as the voltage, magnetic field, or
current density) using amathematical relationship— such as one relating its value to that of
another quantity.

l Define the value of a boundary or excitation as a function of position.
l Current Density Excitation (Magnetostatic or EddyCurrent solver type)
l Voltage Excitation (Electric solver types)
l VolumeCharge Density Excitation (Electrostatic or Electrostatic + DC solver types)

l If the parametric analysis capability was purchased, identify which boundary or excitation
quantities are to be varied during a parametric sweep. These variables are always set to
constant values in the parametric analysis.

Setting Eddy Effects and Displacement Current
(EddyCurrent and/or Transient Solvers)
For both eddy current and transient solvers, youmay need to specify the following additional setting:

l The behavior of eddy currents and the AC magnetic field in conductors. When you activate the
Eddy Effect setting, the solver computes the induced eddy currents.

For eddy current solvers only, youmay need to specify the following additional setting:
l TheDisplacement Current on the objects in themodel.

Typically, background objects are excluded from eddy and displacement current settings.
To set eddy effects:

1. Select the elements of the geometry on which you want to apply the excitation.
2. ClickMaxwell3D>Excitations>Set Eddy Effects.

TheSet Eddy Effect dialog box appears.
3. For each object in the list, select or clear the check boxes for Eddy Effect andDisplacement

Current. When selectingmultiple entries, the changes are synchronized for all selected rows.
Note Multi-select is supported by holding theCTRL or Shift keywhile

clicking.

4. Click theSelect Object By Name button to enter the name of a specific object for selection.
5. Optionally, click theUse suggested values button to set theEddy Effects for all elements

recommended byMaxwell3D.
6. ClickOK.

TheDeselect All button will deselect all selected objects in the list.

Related Topics

Technical Notes: FrequencyDomain (EddyCurrent) Solver
Technical Notes: 3D Transient Excitations (Sources)
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Setting Core Loss for Transient and Eddy Current Solvers
For a Transient, or an EddyCurrent solver, youmay include core loss in the simulation on any object
that has a corresponding core loss definition (with core loss coefficient settings) in thematerial
library.
To set core loss, in theGeneral tab of the dialog box:

1. ClickMaxwell>Excitations>Set Core Loss.
TheSet Core Loss dialog box appears.
You can also open theSet Core Loss dialog box by right-clickingExcitations in the Project
Manager, then selectingSet Core Loss on the context menu; or by right-clicking in the
Modeler window and selectingAssign Excitation> Set Core Loss.

2. For eachObject in the list, select or clear the check box forCore Loss Setting (if a
corresponding core loss definition has been set). When selectingmultiple entries, the changes
are synchronized for all selected rows.
Note Multi-select is supported by holding theCTRL or Shift keywhile

clicking.

TheDefined in Material column indicateswhether thematerial assigned to each object
contains a core loss definition.

3. Click theSelect By Name button to enter the name of a specific object for selection. Regular
expressions are also supported.

4. Optionally, click theDeselect All button to deselect all selected objects in the list.
5. For 3D and 2D Transient solvers only, on theAdvanced tab of the dialog box, youmay select

the option toConsider core loss effect on field. When selected, this option will estimate
the core loss and subsequentlymodify the field solution, causing the resulting fields to be
affected by the presence of the core loss. This option provides improved solution accuracy for
materials exhibiting high core loss at the expense of increased solution time.
Note If the core lossmodel “hysteresismodel” is chosen, then the “Consider core loss

effect on field” checkbox is ignored, as the hysteresismodel alwaysmodels the
effects of the hysteresis loss.

The default is to exclude this effect. In this case, the field calculation is performedwithout the
core loss and the loss calculation is performed after the field solution is complete.

6. ClickOK.

Related Topics

Core LossCoefficient Extraction
Technical Notes: 3D Transient Excitations (Sources)
Technical Notes: 2D Sources/Excitations
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Permanent Magnet Field Excitations for 2D and 3D Transient and
Magnetostatic Solvers
(Maxwell 2D/3D Transient andMagnetostatic Solvers)
Links to demagnetization andmagnetization computation source designs can be added as
permanent magnet field excitations in target designs. A permanent magnet field excitation can be
either object-based (assigned to geometry) or design-based (not assigned to geometry).

To add or edit a permanent magnet field excitation:

Note The following procedure assumes that a source design, in which the
demagnetization or magnetization computations of themagnet has been
modeled, is available for linking.

1. Do one of the following:
l If you are adding a new design-based permanent magnet field excitation, select
Maxwell 2D or 3D>Excitations>Assign> Permanent Magnet Field. Alternatively,
in the Project Manager you can right-clickExcitations to open its context menu, then
selectAssign>Permanent Magnet Field.

l If you are adding a new object-based permanent magnet field excitation, select one or
more objects (magnets) that you wish to include in the permanent magnet field
excitation, then either selectMaxwell 2D or 3D>Excitations>Assign> Permanent
Magnet Field, right-clickExcitations in the Project tree to open its context menu and
selectAssign>Permanent Magnet Field.

l If you are editing an existing permanent magnet field excitation, right-click on the
excitation in the project tree and selectProperties from the context menu.

2. In thePermanent Magnet Field dialog, enter (or edit) theName for the excitation - or accept
the default.
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3. Choose eitherDemagnetization orMagnetization for the excitation type, then clickSetup
Link.

4. By default, theSetup Link dialog opens on theGeneral tab with only the This project radio
button selected.
Note If a link had previously been set up, theSetup Link dialog opens inView Only

modewith all settings disabled.

To enable settings, you can selectEdit Link.

5. To select a source project do one of the following:
l To use the current project as the source, checkUse This Project. This disables the
Save source path relative to: radio buttons and the ellipsis [...] button and its
associated text field.

l To specify a source project file other than the current project click the ellipsis [...] button
to open a file browser window.When you have selected the project, click theOpen
button to accept the project file for the setup. You can use the check box toOpen as
read only.
Use the radio buttons to specify whether to save the source path relative to The project
directory of selected product or This project.

6. When you select a source project file, theSource Design and theSource Solution fields
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are filled in with default values, and their drop downmenus contain any available designs and
solutions. You can use the drop downmenus to choose from the available designs and
solutions.
The “Default” solution is the product-dependent solution of the first Setup. That is the setup
listed first in the source design's project tree (alphanumerical order). A product-specific
solution of this setup becomes the default solution. In most products, it is “LastAdaptive.”

7. Use the check box to specify whether toSimulate source design as needed.
8. Use the check box to specify whether toPreserve source design solution. Note that in the

extractor mode, the source project will be saved upon exit. Extractor modemeans that the
software is opened during the link solely for the purpose of solving.

9. TheVariable Mapping tab lets you view any variables contained in the selected Project.
When there are variables in the source design, you can choose to “map” these variables to
constant values, expressions or variables in the target designs. Variablemapping becomes
more important when the datalink type requires source and target design to be geometrically
identical and source design is geometrically parameterized.
For linked designswith variables of the same name, you can clickMap Variable by Name to
automaticallymap same named variables.

10. For object-based permanent magnet field excitations only, theObject Mapping tab lets you
map objects in the target design to objects in the source design.

11. ClickOK to close the Setup Link dialog box and return to thePermanent Magnet Field
dialog.

12. Optionally, theDefaults tab allows you either to save the user-defined data for the excitation
as the default for initializing new excitations of this type, or to clear any existing user-defined
defaults and revert to standard defaults.

13. When finished, clickOK to accept the settings and close the dialog.

Related Topics

"Permanent Magnets " on page 10-38
"Setting Demagnetization/Magnetization Computations for Source Designs" on the facing page
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Setting Demagnetization/Magnetization Computations for Source
Designs
(2D and 3D Magnetostatic and Transient Solvers)
When amagnetic device with permanent magnets is overloaded, or after a short circuit, irreversible
demagnetizationmay occur due tomagnetic field and temperature changes. As a result, the
subsequent operating point will no longer lie along the original BH curve, but along the
demagnetized recoil line at the worst operating condition.
This process can bemodeled inMaxwell usingSet Demagnetization/Magnetization
Computations. The demagnetization/magnetization process of themagnet ismodeled in the
source design, and the practical normal application ismodeled in the target design.
The linked demagnetization or magnetization designs act as sources (excitations) in the target
design. These links aremanaged as Permanent Magnet Field excitations. Users can setup either
object-based or design-based links. The Hc outputs from the source design aremapped to the target
designmesh, thus eliminating the restriction of target/source designs employing the same
geometries.

Note Thismapping is straightforward for non-hysteresis basedmodels because the Hc output
from the source design is a single value plus direction per mesh element. For hysteresis-
basedmodels, the Hc output from the source design is a demagnetizing curve per mesh
element, and amapping approach is non-trivial. Thus this process is not applicable when
the design has any object modeled with hysteresismaterials.
Demagnetization/magnetization links for this type of design continues to require the
samemesh between target and source designs.

Limitations

l A design can only be the target for either magnetization or demagnetization, but not
both.

l A design can compute either magnetized or demagnetized operating points, but not
both.

l Object-based and design-based links cannot coexist.
l Object-based links are not supported when there is any object assigned with a
hysteresis-basedmaterial model.

For themagnetization computation, Maxwell provides two possibilities: anisotropic
magnetization, and isotropic magnetization.
For anisotropic magnetization themagnetization direction is determined by the direction
specified by the user in the field for the Unit Vector input of Magnetic Coercivity on the panel of
View/Edit Material duringmaterial setup.
For isotropic magnetization, themagnetization direction is determined by the orientation of
the computedmagnetizing field from the field solution. In such a case, the user has to set all
three components of the Unit Vector input of Magnetic Coercivity to zero (0) on the panel of
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View/Edit Material duringmaterial setup so that Maxwell knows the direction is computed,
rather than specified by user.

General Procedure for Setting Demagnetization/Magnetization Computations for Source
Designs

To set demagnetization/magnetization process computations for a source design:

Note Demagnetization/Magnetization points computation settings specific to the Hysteresis
Model-BasedMagnetization Approach are described in theUsing the HysteresisModel-
BasedMagnetization Approach section.

1. ClickMaxwell>Excitations>Set Magnetization Computation to open theSet
Demagnetization/Magnetization Computations dialog box. You can also open the dialog
box by right-clickingExcitations in the Project Manager, then selectingSet Magnetization
Computation on the context menu; or by right-clicking in theModeler window and selecting
Assign Excitation> Set Magnetization Computation.

By default,No operating points computation is selected.
2. Select either theCompute demagnetized operating points orCompute magnetized

operating points radio button. At least one object must be selected to compute data if
Compute magnetized operating points is selected.

Note Multi-select is supported by holding theCTRL or Shift keywhile
clicking.

Note An object coordinate system (CS) must be created and assigned to each
magnet object in the history tree.
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3. ClickOK to accept the settings and close the dialog.
The configured source design can now be linked to if you want to create "Permanent Magnet Field
Excitations for 2D and 3D Transient andMagnetostatic Solvers" on page 11-6 .

Related Topics

Using the HysteresisModel-BasedMagnetization Approach
"Magnetostatic Solver Settings" on page 16-8
"Permanent Magnet Field Excitations for 2D and 3D Transient andMagnetostatic Solvers" on
page 11-6
Technical Notes: 3D Transient Excitations (Sources)
Technical Notes: 2D Sources/Excitations

Using the Hysteresis Model-Based Magnetization Approach

(Transient Solver Only)
With the introduction of vector hysteresismodeling capability in the transient solver, it is now
possible to simulate the hysteresismodel-basedmagnetization process if a user defines a
normal nonlinear BH curve in the 1st quadrant together with the input of Hc (or additional Br
for better accuracy of hysteresis loop construction) by selectingHysteresis Model under
Core Loss Model for thematerial.

In such a case, magnetization is always considered as isotropicmagnetization, that is,
magnetization direction is determined by the orientation of the computed field. If a user defines
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only a normal nonlinear BH curve in the 1st quadrant without defining the Hysteresismodel,
the transient solver will use the “classic” approach to simulatemagnetization process.

Classic Magnetization Approach

Using the classicmagnetization approach, if the geometry in the source and target designs is the
same, Maxwell maps the computedmagnetization data element–by–element. However, the
geometry in the source and target designs need not be identical, in which case the geometries in the
two designswill bemapped by the solver using the object name. For example, magnetization data
on “Box1” in the source design will be applied to the object called “Box1” in the target design. The
user must ensure that the source and target object names are identical. The source design will
computemagnetization data on the selected objects, while the target design will use the dynamic
data in its simulation.

Hysteresis Model-Based Magnetization Approach

Using the hysteresismodel-basedmagnetization approach, after the completion of the last time step
before stop, the hysteresismodel for each element will generate the element-based
demagnetization curve originated at the last operating point. As a result, the output from the
magnetizationmodeling process is an element-based demagnetization curve, rather than a
constant. Consequently an additional demagnetization process is required based on the element-
based demagnetization curve. In this approach, use of the samemesh between the source and the
two target designs is required due to the use of the element-based demagnetization curve as the
output of magnetization simulation.

Note l If an object is defined as hysteresismodel, but not selected for magnetization, the
object is no longer considered as a hysteresismaterial becausemagnetization and
hysteresismodeling cannot be conducted in the same design.

l Hysteresis basedmagnetization is always considered as isotropicmagnetization,
that is, its direction is determined by the orientation of the computed field.

l For objects that have been selected for magnetization, but not defined as hysteresis
models, the existing classic approach (simple data in the diagram above) will be
used. Mixing hysteresismodel-basedmagnetizationmethod with the classic
magnetizationmethod is supported.

l For the classic approach, no demagnetization step is required; while for the
hysteresismodel-basedmagnetization approach, a demagnetization step is normally
required. For the demagnetization step, the input is the element-based
demagnetization curve derived from themagnetization run.
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l WhenClean Stop is invoked for projects in which a TDM transient source design is
linked to a transient target design, after completion of the source design the solution
process can continue from the target design. In such a case, the target designmust
be non-TDM.

Design Criteria
l The source designmust have objects assigned with non-linear, non-permanent-magnet
material properties.

l The same design cannot be the source for bothmagnetization and demagnetization links.
l The source design cannot also be a target of a demagnetization link.
l The target design cannot also be a target or source of a demagnetization link.

The hysteresismodel-basedmagnetization approach requires three designs.

First Design: Set up a Hysteresis-based magnetization computation design (the source
design)

1. Create aMaxwell 2D or 3D magnetic transient design (theHysteresis-basedmagnetization
design in the figure shown above).

2. ClickMaxwell>Excitations>Set Magnetization Computation to open theSet
Demagnetization/Magnetization Computations dialog box .
You can also open theSet Demagnetization/Magnetization Computations dialog box by
right-clickingExcitations in the Project Manager, then selectingSet Magnetization
Computation on the context menu; or by right-clicking in theModeler window and selecting
Assign Excitation> Set Magnetization Computation.

3. SelectCompute magnetized operating points, and select the objects for magnetization
and/or hysteresis-basedmagnetization computation, then clickOK to accept the settings and
close the dialog.
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4. Solve the design and the solution will include the element-basedmagnetization data, and/or
Hysteresis-based demagnetization curve if the design uses nonlinear materials with non-zero
Hc defined.

Second Design: Set up a Demagnetization design using the output of the Hysteresis-
based magnetization computation

1. Create another Maxwell 2D or 3D magnetic transient design to be used as the
Demagnetization design (highlighted above).

2. In the Project tree, right-clickExcitations and selectAssign> Permanent Magnet Field.
3. In thePermanent Magnet Field dialog, selectMagnetization, then clickSetup Link.
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4. Set up a link to theHysteresis-basedmagnetization computation source design (the first
design you set up), which provides the hysteresis-basedmagnetization solution data. Check
Simulate source design as needed andPreserve source design solution. If the source
design is not set up toCompute magnetized operating points, an error message will be
issued.

5. Right-clickExcitations in the Project tree and selectSet Magnetization Computation on
the context menu to open theSet Demagnetization/Magnetization Computations dialog,
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and selectCompute demagnetized operating points.

6. Open theSolve Setup dialog and select Import mesh on theAdvanced tab to open the
Setup Link dialog.

7. In theSetup Link dialog, for theSource Design, choose theHysteresis-based
magnetization computation (the first design you set up).

8. Solve the design and the solution will include the element-based demagnetization distribution
curve (which is based on the Hysteresis-basedmagnetization data). If the source design has
not been solved, solving the current (demagnetization) design causes the source design to be
solved first.
Note To ensure that new data from the source design is used if the source design has

beenmodified, right-click the Analysis icon of the source design in the project tree,
and clickClear Linked Data. This flushes existing linked data so that solving the
current design will force the source design to be solved first.

Third Design: Set up the Target design

1. Create a third Maxwell 2D or 3D magnetic transient design to be used at the Target design
(highlighted above).

2. In the Project tree, right-clickExcitations and selectAssign> Permanent Magnet Field.
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3. In thePermanent Magnet Field dialog, selectDemagnetization, then clickSetup Link.

4. Set up a link to theDemagnetization design (the second design created above), which
provides the dynamic demagnetization distribution solution data (based on theHysteresis-
basedmagnetization solution data from the first design). Be sure to checkSimulate source
design as needed andPreserve source design solution.
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5. Open theSolve Setup dialog and select Import mesh on theAdvanced tab to open the
Setup Link dialog.

6. In theSetup Link dialog, for theSource Design, choose theDemagnetization design (the
second design created above).

7. Solve the Target design. If the source designs for Hysteresis-basedmagnetization
computation and Demagnetization are not yet solved, solving the current (target) design
causes the two source designs to be solved in sequence first.
Note To ensure that new data from the source designs is used if the source designs have

beenmodified, right-click the Analysis icon of each source design in the project tree,
and clickClear Linked Data. This flushes existing linked data so that solving the
current design will force the source designs to be solved first.

Related Topics

Setting Demagnetization/Magnetization Computations for Source Designs
Permanent Magnet Field Excitations for 2D and 3D Transient andMagnetostatic Solvers

Showing and Verifying Conduction Paths
To show the conduction paths in the geometry:

1. ClickMaxwell>Excitations>Conduction Paths>Show Conduction Paths.
TheConduction Path Visualizationwindow appears.
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2. Click a path in the list.
The path is highlighted in themodel.

3. ClickClosewhen you are done viewing conduction paths.
To verify conduction paths:

l ClickMaxwell>Excitations>Conduction Paths>Verify Conduction Paths.
The paths are traced in themodel diagram.

Related Topics

Recalculating Conduction Paths

Recalculating Conduction Paths

Conduction paths are not recalculated unless a design changes results in a different outcome.
You can force a recalculation by using theMaxwell>Excitations>Conduction
Paths>Recalculate Conduction Paths command.
TheRecalculate Conduction Paths command is similar to theVerify Conduction Paths
command. The only difference is that theRecalculate command recalculates every time, even if
there are no changes that influence the conduction paths.

Note TheRecalculate Conduction Paths command does not apply for electrostatic solution
types.

To recalculate conduction paths for the active project:
l ClickMaxwell>Excitations>Conduction Paths>Recalculate Conduction Paths.

Related Topics

Showing and Verifying Conduction Paths

Modifying Boundary Conditions and Excitations
Save your project beforemodifying boundary conditions and excitations. You canmodify boundary
conditions and excitations after a solution has been generated, but youmay lose some solution data.

Duplicating Boundaries and Excitations

To duplicate a boundary or excitation when its geometry is pasted or duplicated:
1. ClickTools>Options>General Options to open the Options dialog, displaying a

hierarchical list of options. Click the + next toMaxwell 2D and selectBoundary
Assignment.

2. SelectDuplicate boundaries/mesh operations with geometry.
3. ClickOK.
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All boundaries and excitations are duplicated with their associated geometries until you clear
this option.

Hint Use this option to copy and paste boundaries.
For example, do the following to use the same boundary onmultiple objects:
1. Select the face to which you want to assign the boundary.
2. ClickModeler>Surface>Create Object From Face to create a new object from the

existing face.
3. Assign the boundary to the new face object.
4. Copy and paste the new face object to copy and paste the boundary.

Related Topics

Copying and Pasting Objects

Showing and Hiding Boundaries and Excitations

You can choose to show or hide a boundary or excitation's geometry, name, or vectors, in the active
view window or in all view windows.

Showing and Hiding Boundaries and Excitations in Every View Window

1. ClickMaxwell>Boundaries>Visualization orMaxwell>Excitations>Visualization.
The Visualization Optionswindow appears.

2. Select one of the following from theSelect pull-downmenu:
l All
l All Boundaries
l All Excitations
l All Ports
l ByName

3. If you selectBy Name, enter a name in theSelect By Namewindow, and clickOK.
4. To clear the selection of all boundaries and excitations, clickDeselect All.
5. ClickClose to close the Visualization Optionswindow.

Setting Default Values for Boundaries and Excitations

When assigning a boundary or excitation, many of the fields in the boundary and excitation dialog
boxes have default values associated with them. These default values are initially set byMaxwell, but
can be overridden.
Tomodify the default values associated with a specific boundary or excitation type:
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1. Assign a boundary or excitation.
2. Modify any default values.
3. Close the boundary or excitation's dialog box.
4. Re-open the new boundary or excitation's dialog box. It now includes aDefaults tab.
5. Under theDefaults tab, clickSave Defaults.

The values assigned to this boundary are saved as the default values and are assigned when
new boundaries of this type are created.

6. Optionally, clickRevert to Standard Defaults.
The default values you set for this boundary type are cleared and will revert to the default
values set byMaxwell.

Reassigning Boundaries

You can reassign a boundary to another surface. This is useful when youmodify objects with
assigned boundaries, invalidating the boundaries. For example, if you unite two objects with
assigned boundaries, the second object's boundary becomes invalid because united objects
maintain the characteristics of the first object selected. In this case, you would need to reassign the
boundary or delete it.
To reassign a boundary:

1. Select the object or object face to which you want to assign an existing boundary.
2. ClickMaxwell>Boundaries>Reassign.

TheReassign Boundary window appears.

Hint Alternatively, select the object or object face to which you want to assign an existing
boundary. Right-click the existing boundary in the project tree, and then click
Reassign on the shortcut menu.

3. Select the boundary you want to reassign, and clickOK.
Note When reassigning a boundary that includes vectors in its definition, Maxwell

attempts to preserve the vectors with the new assignment, but this is not always
possible.

Reassigning Excitations

To reassign an excitation:
1. Select the object or object face to which you want to assign an existing excitation.
2. ClickMaxwell>Excitations>Reassign.

TheReassign Excitation window appears.

Hint Alternatively, select the object or object face to which you want to assign an existing
excitation. Right-click the existing excitation in the project tree, and then click
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Reassign on the shortcut menu.

3. Select the excitation you want to reassign, and clickOK.
Note When reassigning an excitation that includes vectors in its definition, Maxwell

attempts to preserve the vectors with the new assignment, but this is not always
possible.

Deleting All Boundaries and/or Excitations

To delete all boundaries or excitations:
l ClickMaxwell>Boundaries>Delete All orMaxwell>Excitations>Delete All.

Reprioritizing Boundaries

Each boundary you assign overwrites any existing boundary with which it overlaps. You can change
the priority of a previously assigned boundary to be greater than amore recently assigned boundary.
The order of boundaries and excitations is important because, for any given triangle of themesh,
only one boundary or excitation can be visible to the solvers. The highest priority boundary condition
applied on a certain surface overwrites the lower priority one(s) applied on the same surface. If any
surfaceswith boundary conditions have a partial overlap, then in the overlap region, the precedence
rule applies. The highest priority boundary condition takes precedence over the lower one(s) such
that for all mesh nodes on any surface carrying a boundary condition, only one boundary condition is
actually enforced and visible to the solver.
Excitations cannot be reprioritized. Only boundaries can be reprioritized.
To reprioritize boundaries:

1. ClickMaxwell>Boundaries>Reprioritize.
TheReprioritize Boundaries window appears.
Note The order the boundaries initially appear in theReprioritize dialog box list indicates

the order in which theywere defined. The lowest priority assignment always
appears at the top of the list.

2. Drag the boundary you want to change to the desired order of priority (to select the entity, click
in the left-most column).
Note The order of boundaries and excitations in the project tree is alphabetical. The order

does not correspond to the order in which boundaries and excitations are visible to
the solvers.

3. ClickOK.

Viewing and Editing Boundary or Excitation Properties

To open thePropertieswindow for a boundary or excitation that is already assigned:
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1. In the project tree, under eitherBoundaries or Excitations, right-click a specific boundary or
excitation, and selectProperties.
ThePropertieswindow for that boundary/excitation appears.

2. Make the desired changes, and clickOK.

Set Default Boundary/Excitation Base Name
When setting boundaries and excitations onmultiple selected surfaces, separate boundary or
excitation definitionsmay bemade automatically. Individual entries in theProject Treewill be
identified with aBase Name and assigned a sequential numerical value appended to the base
name.
TheSet Default Boundary/Excitation Base Name dialog allows the base names for all boundary
and excitation type to be specified for the current project. To set the base name for a boundary or
excitation type:

1. Scroll the table to the boundary or excitation of interest.
2. Select the value in theDefault Name column in the row of interest and enter the new base

name.
3. ClickOK to accept the changes and dismiss the dialog box.

All base namesmay be reset to the factory default list by clickingRevert All, or individualsmay be
reset by first selecting theDefault Name to be reset and clicking theRevert Selected button.

Magnetostatic Boundaries and Excitations
Define at least one of the following as a source of staticmagnetic fields:

l The current in a conduction path, which can be either stranded or solid.
Note For stranded conductors, it is assumed that the current density is uniform on the

cross-section of the respective conductors. Thus, the stranded option for current
excitations shouldmostly be used only in caseswhere the cross-section of
conductors is constant, consistently with the assumption that the respective object
is a coil built with strands of wire. For this reason, conductors (coils) could be
created by either sweeping around an axis using zero segments or sweeping
along a path having only true surface segments in order to create a smooth
surface coil having a completely uniform cross-sectional area over its entire
length.

l The current density in a conductor.
l The voltage differential across a conduction path.
l Themagnetic field on an outside surface.
l A permanent magnet.

If currents or current densities are the only sources of staticmagnetic fields in your model, set at least
one of the following as the outer boundary:
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l The default boundary conditions.
l An odd symmetry (flux tangential) boundary.
l An even symmetry (flux normal) boundary.

Related Topics

Technical Notes: Magnetostatic Field Calculation
Specifying the Solver Type

Magnetostatic Boundaries

Themagnetostatic field solver allows you to define the following types of boundaries:

Boundary Type H-Field Behavior Used to
model...

Default Boundary
Conditions
(Natural and
Neumann)

Field behaves as follows:
l Natural boundaries— H
is continuous across the
boundary.

l Neumann boundaries—
H is tangential to the
boundary and flux cannot
cross it.

Ordinary field
behavior.
Initially, object
interfaces are
natural
boundaries;
outer
boundaries, and
excluded objects
are Neumann
boundaries.

Zero Tangential H
Field

Flux is perpendicular if tangent
components are zero or if a
zero tangential H-field
boundary was applied.

External
magnetic fields.

Tangential H Field The tangential components of
H are set to pre-defined values.

External
magnetic fields.

Integrated Zero
Tangential H Field

For applications such as a
motor with the shaft excluded,
there remains a hole in the
middle. In such cases, on the
hole's boundary, neither the
Tangential H Field boundary
(where integration of the
tangential H field is non-zero),
nor the Zero Tangential H Field
boundary (where the tangential
H field is zero everywhere) can

Cases such as
the boundary
around the hole
that remains
when amotor's
shaft is
excluded.
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be applied because – for the
hole boundary case –
integration of the tangential H
field is zero, but the tangential H
field is not zero everywhere.
Integrated Zero Tangential H
Field can be used for such
applications.

Insulating Same asNeumann, except that
current cannot cross the
boundary.

Thin, perfectly
insulating sheets
between
touching
conductors.

Symmetry Field behaves as follows:
l Odd Symmetry (Flux
Tangential) — H is
tangential to the
boundary; its normal
components are zero.

l Even Symmetry (Flux
Normal) — H is normal to
the boundary; its
tangential components
are zero.

Planes of
geometric and
magnetic
symmetry.

Matching
(Master and
Slave)

The H-field on the slave
boundary is forced tomatch the
magnitude and direction (or the
negative of the direction) of the
H-field on themaster boundary.

Planes of
symmetry in
periodic
structureswhere
H is oblique to
the boundary.

Default Boundary Conditions for a Magnetostatic Solver

These boundary conditions are automatically defined for amagnetostaticmodel:
l Natural boundaries are assigned to the surfaces between objects.
l Neumann boundaries are assigned to the outside edges of the problem region.

To leave a surface set to its default boundary condition, do nothing. Deleted boundary conditions and
excitations automatically reset to the default boundary conditions.
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Assigning a Magnetic H Field for a Magnetostatic Solver

This type of boundary defines external magnetic fields in amodel. Assign it only to the outer surfaces
of the problem region.

Warning When using tangential magnetic field boundary conditions, always double-check that
Ampere's law is not violated.

Note The specific boundary types you can define depend on the solver you have chosen for your
project.

l Electrostatic Boundary Conditions
l DC Conduction Boundary Conditions
l Magnetostatic Boundary Conditions
l EddyCurrent Boundary Conditions

To define a zero tangential H field boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically a face).
2. ClickMaxwell>Boundaries>Assign>Zero Tangential H Field.

The Zero Tangential H Fieldwindow appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

To define a tangential H field boundary:
1. Select the section of the geometry on which you want to apply the boundary condition.
2. ClickMaxwell>Boundaries>Assign>Tangential H Field.

The Tangential H Fieldwindow appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. In theParameters section, enter the value of the field component in the x-direction in theU(X)

box and the value of the field component in the y-direction in theV(Y) box.
5. In theCoordinate System section, do the following to define the vectors:

a. SelectNew Vector from theU Vector pull-down list.
TheCreate Line message appears asking you to draw the U vector of the coordinate
system in the plane of the selected face.

b. Click two points to specify the vector.
The vector is set, and the Tangential H Fieldwindow reappears, withDefined listed for
U Vector.

c. To reverse the direction of the vector, click theReverse Direction check box.
6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK to assign the boundary to the selected object.

The new boundary is added to the boundary list in the project tree.
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Assigning an Integrated Zero Tangential H Field Boundary for a Magnetostatic Solver

This type of boundary is applied when the integral of the tangential H field is zero.

Warning When using integrated zero tangential magnetic field boundary conditions, always
double-check that Ampere's law is not violated.

To define an integrated zero tangential H field boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically a face).
2. ClickMaxwell 3D>Boundaries>Assign>Integrated Zero Tangential H Field.

The Integrated Zero Tangential H Fieldwindow appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

The new boundary is added to the boundary list in the project tree.

Assigning an Insulating Boundary for a Magnetostatic Solver

This boundary condition is used tomodel very thin sheets of perfectly Insulatingmaterial between
touching conductors. Current cannot cross an insulating boundary.
To set an insulating boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically a face).

2. ClickMaxwell>Boundaries>Assign>Insulating.
The Insulating Boundary window appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

Assigning a Symmetry Boundary Condition for a Magnetostatic Solver

This boundary condition defines a plane of geometric or magnetic symmetry in a structure. Assign it
only to the outer surfaces of the problem region.
To set a symmetry boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically a face).

2. ClickMaxwell>Boundaries>Assign>Symmetry.
TheSymmetry Boundary window appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Select one of the following as the type of symmetry:

Odd H is tangential to the boundary; its normal components are
zero.
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(Flux
Tangential)
Even
(Flux Normal)

H is normal to the boundary; its tangential components are
zero.

5. Optionally, clickUse Defaults to revert to the default values in the window.
6. ClickOK to assign the boundary to the selected object.

Warning When using even symmetry boundaries, double-check that Ampere's law is not
violated.

Assigning a Master Boundary for a Magnetostatic Solver

Master and slave boundaries enable you tomodel planes of periodicity where the H-field at every
point on the slave boundary surface is forced tomatch the H-field of every corresponding point on
themaster boundary surface. The transformation used tomap the H-field from themaster to the
slave is determined by specifying a coordinate system on both themaster and slave boundaries.
To set amaster boundary:

1. Select the face to which you want to assign themaster boundary.
2. ClickMaxwell>Boundaries>Assign>Master.

TheMaster Boundary window appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. In theCoordinate System section, do the following to define the coordinate system:

Note Youmust specify the coordinate system in the plane on which the boundary exists.
First draw the U vector of the coordinate system. Maxwell uses the U vector you
draw and the normal vector of the boundary face to calculate the v-axis. Then
specify the direction of the V vector.

a. SelectNew Vector from theU Vector pull-down list.
TheCreate Line message appears, asking you to draw the U vector of the coordinate
system in the plane of the selected face, and theMaster Boundary dialog box disappears
while you draw the U vector.

b. Select the U vector's origin, whichmust be on the boundary's surface, in one of the
following ways:
l Click the point.
l Type the point's coordinates in the in theX, Y, and Z boxes.

c. Select a point on the u-axis.
TheMaster Boundary dialog box reappears

5. To reverse the direction of the vector, select theReverse Direction check box.
6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK.
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Maxwell computes the H-field on this boundary andmaps it to the slave boundary using the
transformation defined by themaster and slave coordinate systems.

Assigning a Slave Boundary for a Magnetostatic Solver

Assigning a slave boundary is the second step in creatingmatching boundaries. The field on the
master boundary ismapped to the slave boundary.

Note Youmust define amaster boundary before creating the slave boundaries that are
associated with it. Assign slave boundaries only to the outer surfaces of the problem
region.

To set a slave boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically a face).
2. ClickMaxwell>Boundaries>Assign>Slave.

TheSlave Boundary window appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. Select themaster boundary to which the slave is to be assigned from theMaster Boundary

pull-down list.
5. To specify the coordinate system, do the following in the Coordinate System section:

Note Youmust specify the coordinate system in the plane on which the boundary exists.
First draw the U vector of the coordinate system. Maxwell uses the U vector you
draw and the normal vector of the boundary face to calculate the v-axis. Then
specify the direction of the V vector.

a. SelectNew Vector from theU Vector pull-down list.
TheCreate Line message appears asking you to draw the U vector of the coordinate
system in the plane of the selected face, and theSlave Boundary dialog box disappears
while you draw the U vector.

b. Select the U vector's origin in one of the following ways:
l Click the point.
l Type the point's coordinates in the in theX, Y, and Z boxes.

Note TheU vector's origin must be on the boundary's
surface.

c. Select a point on the u-axis in the sameway.
When the second point is identified, the vector is set, and theSlave Boundary window
reappears, withDefined listed in theU Vector pull-down list.

d. To specify the direction of the V vector, select or clear theReverse Direction check box.
6. In theRelation section, select one of the following to specify the field behavior on the

boundary:

Hs =
Hm

Click this radio button if the slave andmaster boundaries have the samemagnitude
and direction.
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Hs =
-Hm

Click this radio button if the slave boundary field has the samemagnitude as but the
opposite direction from themaster boundary field.

7. Optionally, clickUse Defaults to revert to the default values in the window.
8. ClickOK to assign the boundary to the selected object.

Note The origin must be a vertex point of one of the
objects.

Magnetostatic Excitations

The following excitations of magnetic fields are available for magnetostatic problems:

Excitation Type of Excitation
Voltage The DC voltage on a surface or a sheet object.

Voltage
Drop

The voltage drop across a sheet object.

Current
Density

The known current density distribution in a conductor. In this case, the current
density terminal must also be defined.

Current The total current in a conductor.

In addition, permanent magnets serve as sources of magnetic fields.

Warning If voltage sources are used as excitations, for current to flow, youmust define aminimum
of two voltage excitations or a voltage drop per conduction path. Each excitationmust
be set to a different voltage. Current flows from surfaces at higher voltages to surfaces at
lower voltages.

Note When a source conductor touches an outer boundary, Maxwell assumes current will flow
perpendicular to the boundary. If you do not want current to cross the outer boundary, an
insulating boundary should be used.

Assigning a Voltage Excitation for a Magnetostatic Solver

This type of excitation sets the voltage on a surface to a specific value. Use it to set up a voltage drop
across a conduction path to cause current to flow.
To set a voltage excitation:

1. Select the section of the geometry on which you want to apply the excitation (typically a 2D
object).

2. ClickMaxwell>Excitations>Assign>Voltage.
TheVoltage Excitation window appears.

3. Enter a name for the excitation in theName box, or accept the default.
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4. In theParameters section, enter a value for the voltage in theValue box, and select the units
from the pull-down list.

5. Optionally, clickUse Defaults to revert to the default values in the window.
6. ClickOK to assign the excitation to the selected object.

Warning For current to flow, youmust define aminimumof two voltage excitations or a
voltage drop. Each excitationmust be set to a different voltage. Current flows from
surfaces at higher voltages to surfaces at lower voltages.

Assigning a Voltage Drop Excitation for a Magnetostatic Solver

This type of excitation sets the voltage drop across a sheet object to a specific value. The voltage
drop applies only to sheet objects:
To set a voltage drop:

1. Select the section of the geometry on which you want to apply the excitation (typically a 2D
object).

2. ClickMaxwell>Excitations>Assign>Voltage Drop.
TheVoltage Drop Excitation window appears.

3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the voltage drop on the surface in theValue box, and select

the units from the pull-down list.
5. To change the direction of the voltage drop, clickSwap Direction.
6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK to assign the excitation to the selected object.

Assigning a Current Density Excitation for a Magnetostatic Solver

This command specifies the x-, y-, and z-components of the current density in a conduction path. If
the current density is a function of position, the value is entered in ampere/m2, even if you change the
units in the problem.
To define the current density:

1. Select the section of the geometry (i.e., the conductor) on which you want to apply the
excitation (typically a 3D object).

2. ClickMaxwell>Excitations>Assign>Current Density.
TheCurrent Density Excitation window appears.

3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, specify the following options:

a. Enter theX Component, Y Component, and Z Component values to define the
respective components of the current density vector.

b. Do the following in the twoCoordinate System pull-down lists:
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l From the first pull-down list, select eitherGlobal orRelativeCSx (where x = 1,2,3… if
any relative coordinate systems have been defined).

l From the second pull-down list, selectCartesian,Cylindrical, or Spherical.
5. Optionally, clickUse Defaults to revert to the default values in the window.
6. ClickOK to assign the excitation to the selected object.

To complete the current density definition, you also need to specify any related current density
terminals, whichmust be assigned to a 2D object or face of the respective conduction path.
To define a current density terminal:

1. Select the 2D object or face to which to assign the terminal.
2. ClickMaxwell>Excitations>Assign>Current Density Terminal.

TheCurrent Density Terminal Excitation window appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. ClickOK to assign the excitation to the selected object.

Assigning a Current Excitation for a Magnetostatic Solver

Specifies the total current in a conduction path. The conduction pathmay be contained completely
within the problem region (for example, a coil), or may touch the edges of the problem region.
To set a current excitation:

1. Select the section of the geometry (i.e., the conductor) on which you want to apply the
excitation (typically a face or other 2D planar object).

2. ClickMaxwell>Excitations>Assign>Current.
TheCurrent Excitation window appears.

3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, specify the following options:

a. Enter a value for the current in theValue box, and select the units from the pull-down list.
b. SelectSolid or Stranded as the Type of conductor. For a stranded conductor, a

uniformly distributed current density is assumed.
c. ClickSwap Direction to change the direction of the current flow.

5. Optionally, clickUse Defaults to revert to the default values in the window.
6. ClickOK to assign the excitation to the selected object.

Electrostatic Boundaries and Excitations
Specify at least one of the following excitations as a source of electric fields:

l The charge on a surface or object.
l The volume charge density inside an object.
l The voltage difference between conducting surfaces and objects. Define the electric potential
on each surface and object using a voltage excitation.

Include at least one of the following as a reference for computing the electric potential:
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l A voltage excitation.
l An odd symmetry (flux normal) boundary.

Note If a conductor is not assigned any excitation, it is automatically assigned a floating
excitation with zero charge.

Related Topics

Technical Notes: Electric Field Calculation
Specifying the Solver Type
Electrostatic Boundaries
Electrostatic Excitations

Electrostatic Boundaries

The following boundary conditions are available for 3D electrostatic problems:

Boundary
Type E-Field Behavior Used to model...

Default
Boundary
Conditions
(Natural and
Neumann)

Field behaves as follows:
l Natural boundaries— The normal
component ofD changes by the
amount of surface charge density.
No special conditions are
imposed.

l Neumann boundaries— E is
tangential to the boundary. Flux
cannot cross a Neumann
boundary.

Ordinary E-field behavior on boundaries.
Object interfaces are initially set to
natural boundaries; outer boundaries are
initially set to Neumann boundaries.

Symmetry Field behaves as follows:
l Even Symmetry (Flux Tangential)
— E is tangential to the boundary;
its normal components are zero.

l Odd Symmetry (Flux Normal) — E
is normal to the boundary; its
tangential components are zero.

Planes of geometric and electrical
symmetry.

Matching
(Master and
Slave)

The E-field on the slave boundary is
forced tomatch themagnitude and
direction (or the negative of the
direction) of the E-field on themaster
boundary.

Planes of symmetry in periodic structures
whereE is oblique to the boundary.

Insulating E-fields can be discontinuous across the
insulating boundary.

Thin layer with two input values: relative
permittivity and thickness of the thin
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layer.

Default Boundary Conditions for an Electrostatic Solver

These boundary conditions are automatically defined for an electrostaticmodel:
l Natural boundaries are assigned to the surfaces between dielectrics.
l Neumann boundaries are assigned to the outside edges of the problem region.

To leave a surface set to its default boundary condition, do nothing. Deleted boundary conditions and
excitations automatically revert to the default boundary conditions.

Assigning a Symmetry Boundary Condition for an Electrostatic Solver

This boundary condition defines a plane of geometric or electric symmetry in a structure. Assign it
only to the outer surfaces of the problem region.
To set a symmetry boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically a face).

2. ClickMaxwell>Boundaries>Assign>Symmetry.
TheSymmetry Boundary window appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Select one of the following as the type of symmetry:

Odd
(Flux Normal)

E is normal to the boundary; its tangential components are
zero.

Even
(Flux
Tangential)

E is tangential to the boundary; its normal components are
zero.

5. Optionally, clickUse Defaults to revert to the default values in the window.
6. ClickOK to assign the boundary to the selected object.

Assigning a Master Boundary for an Electrostatic Solver

Master and slave boundaries enable you tomodel planes of periodicity where the E-field at every
point on the slave boundary surface is forced tomatch the E-field of every corresponding point on the
master boundary surface. The transformation used tomap the E-field from themaster to the slave is
determined by specifying a coordinate system on both themaster and slave boundaries.
To set amaster boundary:
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1. Select the face to which you want to assign themaster boundary.
2. ClickMaxwell>Boundaries>Assign>Master.

TheMaster Boundary window appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. In theCoordinate System section, do the following to define the coordinate system:

Note Youmust specify the coordinate system in the plane on which the boundary exists.
First draw the U vector of the coordinate system. Maxwell uses the U vector you
draw and the normal vector of the boundary face to calculate the v-axis. Then
specify the direction of the V vector.

a. SelectNew Vector from theU Vector pull-down list.
TheCreate Line message appears, asking you to draw the U vector of the coordinate
system in the plane of the selected face, and theMaster Boundary dialog box disappears
while you draw the U vector.

b. Select the U vector's origin, whichmust be on the boundary's surface, in one of the
following ways:
l Click the point.
l Type the point's coordinates in the in theX, Y, and Z boxes.

c. Select a point on the u-axis.
TheMaster Boundary dialog box reappears

5. To reverse the direction of the vector, select theReverse Direction check box.
6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK.

Maxwell computes the H-field on this boundary andmaps it to the slave boundary using the
transformation defined by themaster and slave coordinate systems.

Assigning a Slave Boundary for an Electrostatic Solver

Assigning a slave boundary is the second step in creatingmatching boundaries. The field on the
Master boundary ismapped to the slave boundary.

Note Youmust define aMaster boundary before creating the slave boundaries that are
associated with it. Assign slave boundaries only to the outer surfaces of the problem
region.

To set a slave boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically a face).
2. ClickMaxwell>Boundaries>Assign>Slave.

TheSlave Boundary window appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. Select themaster boundary to which the slave is to be assigned from theMaster Boundary
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pull-down list.
5. To specify the coordinate system, do the following in the Coordinate System section:

Note Youmust specify the coordinate system in the plane on which the boundary exists.
First draw the U vector of the coordinate system. Maxwell uses the U vector you
draw and the normal vector of the boundary face to calculate the v-axis. Then
specify the direction of the V vector.

a. SelectNew Vector from theU Vector pull-down list.
TheCreate Line message appears asking you to draw the U vector of the coordinate
system in the plane of the selected face, and theSlave Boundary dialog box disappears
while you draw the U vector.

b. Select the U vector's origin in one of the following ways:
l Click the point.
l Type the point's coordinates in the in theX, Y, and Z boxes.

Note TheU vector's origin must be on the boundary's
surface.

c. Select a point on the u-axis in the sameway.
When the second point is identified, the vector is set, and theSlave Boundary window
reappears, withDefined listed in theU Vector pull-down list.

d. To specify the direction of the V vector, select or clear theReverse Direction check box.
6. In theRelation section, select one of the following to specify the field behavior on the

boundary:

Es =
Em

Click this radio button if the slave andmaster boundaries have the samemagnitude
and direction.

Es =
-Em

Click this radio button if the slave boundary field has the samemagnitude as but the
opposite direction from themaster boundary field.

7. Optionally, clickUse Defaults to revert to the default values in the window.
8. ClickOK to assign the boundary to the selected object.

Note The origin must be a vertex point of one of the
objects.

Assigning an Insulating Boundary for an Electrostatic Solver

To set an insulating boundary:
1. Select the geometry face on which you want to apply the insulating boundary condition.
2. ClickMaxwell 3D>Boundaries>Assign>Insulating.

The Insulating Boundary dialog box appears.
3. On the Insulating Boundary tab, enter a name for the boundary in theName box, or accept

the default.
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4. TheParameters section of the Insulating Boundary tab allows you to set the relative
permittivity and thickness of the insulating boundary. Values can be defined using variables
and also support Optimetrics.
a. Enter the desired value forRelative Permittivity, or accept the default value of 1.
b. Enter the desired value for Thickness, or accept the default value of 0.
Note that changing data valueswill invalidate the solutions.

5. Optionally, clickUse Defaults to revert to the default values in the window.
6. ClickOK to assign the boundary to the selected object.

Electrostatic Excitations

The following excitations are available for electrostatic problems:

Excitation Type of Excitation
Voltage The DC voltage on a surface or object. This excitation type is available for both

electrostatic and DC conduction Electric solvers.

Charge The total charge on a surface or object (dielectric). This excitation type is available
for electrostatic solvers only.

Floating Used tomodel conductors at unknown potentials. This excitation type is available
for electrostatic solvers only.

Volume
Charge
Density

The volume charge density in an object. This excitation type is available for
electrostatic solvers only.

Note If a conductor is not assigned any excitation, it is automatically assigned a floating
excitation with zero charge.

Assigning a Voltage Excitation for an Electrostatic Solver

Voltage excitations are identical to voltage boundaries in previous versions of Maxwell. Maxwell no
longer has voltage boundaries in the electric solvers. Instead, a voltage excitation can be assigned to
any surfaces, 2D objects, or solids. These assignments could include spatial functions. This type of
excitation sets the electric potential (voltage) on a surface to a specific value.

Note When calculating capacitance, a voltage source should be assigned to an
entire object, not just a single face located on that object.

To set a voltage excitation:
1. Select the section of the geometry on which you want to apply the excitation.
2. ClickMaxwell>Excitations>Assign>Voltage.

TheVoltage Excitation window appears.
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3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the electric potential in theValue box, and select the units

from the pull-down list. You can enter a numerical value or a spatial function.
5. For a spatial function, select a coordinate system from theCoordinate System pull-down list.

6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK to assign the excitation to the selected object.

Assigning a Charge Excitation for an Electrostatic Solver

This type of excitation defines the total charge on a surface or object. The potential on the charge is
computed during the solution.
To define a charge excitation:

1. Select the section of the geometry on which you want to apply the excitation.
2. ClickMaxwell>Excitations>Assign>Charge.

TheCharge Excitation window appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the charge in theValue box.
5. Optionally, clickUse Defaults to revert to the default values in the window.
6. ClickOK to assign the excitation to the selected object.

Assigning a Floating Excitation for an Electrostatic Solver

This type of excitationmodels conductors at unknown potentials and specifies the total charge on the
conductor.
To define a floating conductor:

1. Select the section of the geometry on which you want to apply the excitation. This can be a 2D
surface or a 3D solid.

2. ClickMaxwell>Excitations>Assign>Floating.
The Floating Excitation window appears.

3. Click theGeneral tab.
4. Enter a name for the excitation in theName box, or accept the default.
5. In theParameters section, enter the charge on the boundary in theValue box.
6. Optionally, clickUse Defaults to revert to the default values in the window. You can also click

theDefaults tab to save new default settings or to revert to the standard default values.
7. ClickOK to assign the excitation to the selected object.
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Assigning a Volume Charge Density Excitation for an Electrostatic Solver

This type of excitation defines the volume charge density on an object.
To define the charge density on a 3D object:

1. Select the 3D section of the geometry on which you want to apply the excitation.
2. ClickMaxwell>Excitations>Assign>Volume Charge Density.

TheVolume Charge Density Excitation window appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the charge density in theValue box.
5. In theParameters section, select the type of coordinate system from theCoordinate

System pull-down list.
6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK to assign the excitation to the selected object.

DC Conduction Boundaries and Excitations
The following excitations can be specified as the source of electric fields:

l The voltage difference between surfaces and objects. Define the electric potential on each
surface and object using a voltage excitation.

l Using the current excitation, define the total current flowing through a surface or a 2D object.
l Using the sink excitation, define a collection of surfaces or 2D objects as a sink. We apply sink
excitationswhen only current excitations are defined in a conduction path and there is no
voltage excitation. In fact, in this case, a sink excitation has to be defined and it ensures that
the total current flowing through the outside surface of a conduction path is exactly zero.

Include at least one of the following as a reference for computing the electric potential:
l A voltage excitation.
l A sink excitation.
l An odd symmetry (flux normal) boundary.

Related Topics

Technical Notes: Electric Field Calculation
Specifying the Solver Type

DC Conduction Boundaries

The following boundary conditions are available for DC conduction electric problems:

Boundary
Type E-Field Behavior Used to model...

Default Field behaves as follows: Ordinary E-field behavior on
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Boundary
Conditions
(Natural and
Neumann)

l Natural boundaries— The normal
component ofD changes by the
amount of surface charge density. No
special conditions are imposed.

l Neumann boundaries— E is
tangential to the boundary. Flux
cannot cross a Neumann boundary.

boundaries. Object interfaces are
initially set to natural boundaries; outer
boundaries are initially set to Neumann
boundaries.

Insulating Same asNeumann, except that current
cannot cross the boundary. An insulating
boundary is only available for electrostatic
solutions that include a DC conduction
analysis.

Thin, perfectly insulating sheets
between touching conductors.

Symmetry Field behaves as follows:
l Even Symmetry (Flux Tangential) —
E is tangential to the boundary; its
normal components are zero.

l Odd Symmetry (Flux Normal) — E is
normal to the boundary; its tangential
components are zero.

Planes of geometric and electrical
symmetry.

Matching
(Master and
Slave)

The E-field on the slave boundary is forced
tomatch themagnitude and direction (or
the negative of the direction) of the E-field
on themaster boundary.

Planes of symmetry in periodic
structureswhereE is oblique to the
boundary.

Default Boundary Conditions for a DC Conduction Solver

These boundary conditions are automatically defined for a DC conductionmodel:
l Natural boundaries are assigned to the surfaces between objects.
l Neumann boundaries are assigned to the outside edges of the problem region.

To leave a surface set to its default boundary condition, do nothing. Deleted boundary conditions and
excitations automatically revert to the default boundary conditions.

Assigning an Insulating Boundary for a DC Conduction Solver

This boundary condition is used tomodel very thin sheets of perfectly insulatingmaterial between
touching conductors. Current cannot cross an insulating boundary.
An insulating boundary is only available for electrostatic solutions that include a DC conduction
analysis.
To set an insulating boundary:
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1. Select the section of the geometry on which you want to apply the boundary condition
(typically a face).

2. ClickMaxwell>Boundaries>Assign>Insulating.
The Insulating Boundary window appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

Assigning a Symmetry Boundary Condition for a DC Conduction Solver

This boundary condition defines a plane of geometric or electric symmetry in a structure. Assign it
only to the outer surfaces of the problem region.
To set a symmetry boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically a face).

2. ClickMaxwell>Boundaries>Assign>Symmetry.
TheSymmetry Boundary window appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Select one of the following as the type of symmetry:

Odd
(Flux Normal)

Current flows in opposite directions on either side of the symmetry
plane.

Even
(Flux
Tangential)

Current flows in the same direction on both sides of the symmetry
plane.

5. Optionally, clickUse Defaults to revert to the default values in the window.
6. ClickOK to assign the boundary to the selected object.

Warning When using even symmetry boundaries, double-check the following two points:
l Do not violate Ampere's law!
l All magnetic field boundariesmust be connected to each other. Defining
disconnectedmagnetic field boundaries and even symmetry boundaries can
produce unexpected results, as there is no unique solution to such
problems.

Assigning a Master Boundary for a DC Conduction Solver

Master and slave boundaries enable you tomodel planes of periodicity where the H-field at every
point on the slave boundary surface is forced tomatch the H-field of every corresponding point on
themaster boundary surface. The transformation used tomap the H-field from themaster to the
slave is determined by specifying a coordinate system on both themaster and slave boundaries.
To set amaster boundary:
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1. Select the face to which you want to assign themaster boundary.
2. ClickMaxwell>Boundaries>Assign>Master.

TheMaster Boundary window appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. In theCoordinate System section, do the following to define the coordinate system:

Note Youmust specify the coordinate system in the plane on which the boundary exists.
First draw the U vector of the coordinate system. Maxwell uses the U vector you
draw and the normal vector of the boundary face to calculate the v-axis. Then
specify the direction of the V vector.

a. SelectNew Vector from theU Vector pull-down list.
TheCreate Line message appears, asking you to draw the U vector of the coordinate
system in the plane of the selected face, and theMaster Boundary dialog box disappears
while you draw the U vector.

b. Select the U vector's origin, whichmust be on the boundary's surface, in one of the
following ways:
l Click the point.
l Type the point's coordinates in the in theX, Y, and Z boxes.

c. Select a point on the u-axis.
TheMaster Boundary dialog box reappears

5. To reverse the direction of the vector, select theReverse Direction check box.
6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK.

Maxwell computes the E-field on this boundary andmaps it to the slave boundary using the
transformation defined by themaster and slave coordinate systems.

Assigning a Slave Boundary for a DC Conduction Solver

Assigning a slave boundary is the second step in creatingmatching boundaries. The field on the
Master boundary ismapped to the slave boundary.

Note Youmust define aMaster boundary before creating the slave boundaries that are
associated with it. Assign slave boundaries only to the outer surfaces of the problem
region.

To set a slave boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically a face).
2. ClickMaxwell>Boundaries>Assign>Slave.

TheSlave Boundary window appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. Select themaster boundary to which the slave is to be assigned from theMaster Boundary
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pull-down list.
5. To specify the coordinate system, do the following in the Coordinate System section:

Note Youmust specify the coordinate system in the plane on which the boundary exists.
First draw the U vector of the coordinate system. Maxwell uses the U vector you
draw and the normal vector of the boundary face to calculate the v-axis. Then
specify the direction of the V vector.

a. SelectNew Vector from theU Vector pull-down list.
TheCreate Line message appears asking you to draw the U vector of the coordinate
system in the plane of the selected face, and theSlave Boundary dialog box disappears
while you draw the U vector.

b. Select the U vector's origin in one of the following ways:
l Click the point.
l Type the point's coordinates in the in theX, Y, and Z boxes.

Note TheU vector's origin must be on the boundary's
surface.

c. Select a point on the u-axis in the sameway.
When the second point is identified, the vector is set, and theSlave Boundary window
reappears, withDefined listed in theU Vector pull-down list.

d. To specify the direction of the V vector, select or clear theReverse Direction check box.
Note When entering current, current density terminals, or coil terminals, the arrow

associated with current in the selected object shows the direction as if a positive
value is entered for the current. If a negative value is entered the actual current
flow direction is opposite to what the arrow shows. ClickReverse Direction if
you want to reverse the direction of the arrow.

6. In theRelation section, select one of the following to specify the field behavior on the
boundary:

Es =
Em

Click this radio button if the slave andmaster boundaries have the samemagnitude
and direction.

Es =
-Em

Click this radio button if the slave boundary field has the samemagnitude as but the
opposite direction from themaster boundary field.

7. Optionally, clickUse Defaults to revert to the default values in the window.
8. ClickOK to assign the boundary to the selected object.

Note The origin must be a vertex point of one of the
objects.

DC Conduction Excitations

The following excitations are available for electric DC conduction problems:
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Excitation Type of Excitation
Voltage The DC voltage on a surface or object. This excitation type is available for both

electrostatic and DC conduction solvers.

Current The current across a 2D object. This excitation type is available for DC conduction
solvers only. A current excitationmust be applied across a 2D surface.

Sink This excitation type is available for DC conduction solvers only.

For a DC conduction solution, if a current excitation is assigned, at least one sink or voltage
excitationmust also be defined. However, you cannot define both a voltage excitation and a sink
excitation at the same time.

Assigning a Voltage Excitation for a DC Conduction Solver

This type of excitation sets the electric potential (voltage) on a surface or object to a specific value.
To set a voltage excitation:

1. Select the section of the geometry on which you want to apply the excitation.
2. ClickMaxwell>Excitations>Assign>Voltage.

TheVoltage Excitation window appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the electric potential in theValue box, and select the units

from the pull-down list. You can enter a numerical value or a spatial function.
5. For a spatial function, select a coordinate system from theCoordinate System pull-down list.

6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK to assign the excitation to the selected object.

Assigning a Current Excitation for a DC Conduction Solver

To define a current across a surface:
1. Select the 2D section of the geometry on which you want to apply the excitation.
2. ClickMaxwell>Excitations>Assign>Current.

TheCurrent Excitation window appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the current strength in theValue box.
5. Optionally, to change the direction of the current flow, clickSwap Direction.
6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK to assign the excitation to the selected object.
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Assigning a Sink Excitation for a DC Conduction Solver

To define a sink excitation on a surface:
1. Select the section of the geometry on which you want to apply the excitation (typically a 2D

object).
2. ClickMaxwell>Excitations>Assign>Sink.

TheSink Excitation window appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. ClickOK to assign the excitation to the selected object.

DC Conduction + Electrostatic Boundaries and Excitations
In the case of a problemwhen you are interested in the electric solution in both the conductors and
the insulators, you can define aDC Conduction + Electrostaticsolution type. The
Insulator/Conductor threshold defineswhich objects are conductors or insulators. The solver first
solves the conduction problem in all conduction paths and then, using the calculated voltage on the
conductors as a voltage excitation, computes the electrostatic field in the insulators. As a
consequence, you can define the DC-conduction excitations and boundary conditions in the
conducting regions and the electrostatic excitations and boundary conditions in the insulators.

Related Topics

Technical Notes: Electric Field Calculation
Specifying the Solver Type

Eddy Current Boundaries and Excitations
Specify at least one of the following as a source of AC magnetic fields in your model:

l The current in a conduction path, which can be either stranded or solid.
Note For stranded conductors, it is assumed that the current density is uniform on the

cross-section of the respective conductors. Thus, the stranded option for current
excitations shouldmostly be used only in caseswhere the cross-section of
conductors is constant, consistently with the assumption that the respective object
is a coil built with strands of wire. For this reason, conductors (coils) could be
created by either sweeping around an axis using zero segments or sweeping
along a path having only true surface segments in order to create a smooth
surface coil having a completely uniform cross-sectional area over its entire
length.

l The current density in a conductor.
l Themagnetic field on an outside surface.

If currents or current densities are the only sources of AC magnetic fields in your model, set at least
one outer boundary to the following:
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l The default boundary conditions.
l An odd symmetry (flux tangential) boundary.
l An even symmetry (flux normal) boundary.

Related Topics

3D EddyCurrent Boundaries
3D EddyCurrent Excitations
Technical Notes: FrequencyDomain (EddyCurrent) Solver
Specifying the Solver Type

Eddy Current Boundaries

The eddy current field solver allows you to define the following types of boundaries:

Boundary
Type H-Field Behavior Used to

model…
Default
Boundary
Conditions
(Natural
and
Neumann)

Field behaves as follows:
l Natural boundaries— H is continuous across the boundary.
l Neumann boundaries— H is tangential to the boundary and
flux cannot cross it.

Ordinary field
behavior.
Initially, object
interfaces are
natural
boundaries;
outer
boundaries and
excluded
objects are
Neumann
boundaries.

Zero
Tangential
H Field

Flux is perpendicular if tangent components are zero or if a zero
tangential H-field boundary condition was applied.

External AC
magnetic fields.

Tangential
H Field

The tangential components ofH are set to pre-defined values. External AC
magnetic fields

Integrated
Zero
Tangential
H Field

For applications such as amotor with the shaft excluded, there
remains a hole in themiddle. In such cases, on the hole's
boundary, neither the Tangential H Field boundary (where
integration of the tangential H field is non-zero), nor the Zero
Tangential H Field boundary (where the tangential H field is zero
everywhere) can be applied because – for the hole boundary case
– integration of the tangential H field is zero, but the tangential H
field is not zero everywhere. Integrated Zero Tangential H Field

Cases such as
the boundary
around the hole
left when a
motor's shaft is
excluded.
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Boundary
Type H-Field Behavior Used to

model…
can be used for such applications.

Insulating Same asNeumann, except that current cannot cross the
boundary.

Perfectly
insulating
sheets between
conductors.

Symmetry Field behaves as follows:
l Odd Symmetry (Flux Tangential) — H is tangential to the
boundary; its normal components are zero.

l Even Symmetry (Flux Normal) — H is normal to the
boundary; its tangential components are zero.

Planes of
geometric and
magnetic
symmetry.

Matching
(Master
and Slave)

The H-field on the slave boundary is forced tomatch the
magnitude and direction (or the negative of the direction) of the H-
field on themaster boundary.

Planes of
symmetry in
periodic
structures
whereH is
oblique to the
boundary.

Radiation No restrictions on the field behavior. Unbounded
eddy currents.

Impedance Includes the effect of induced currents beyond the boundary
surface.

Conductors
with very small
skin depths.

Default Boundary Conditions for the Eddy Current Solver

These boundary conditions are automatically defined for an eddy current model:
l Natural boundaries are assigned to the surfaces between objects.
l Neumann boundaries are assigned to the outside edges of the problem region.

To leave a surface set to its default boundary condition, do nothing. Deleted boundary conditions and
excitations automatically reset to the default boundary conditions.

Assigning a Magnetic H Field for the Eddy Current Solver

This type of boundary defines external magnetic fields in amodel. Assign it only to the outer surfaces
of the problem region. Regardless of themodel's drawing units, magnetic field values are entered in
s/m.

Warning When using tangential magnetic field boundary conditions, always double-check that
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Ampere's law is not violated!

To define a zero tangential H field boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically a face).
2. ClickMaxwell>Boundaries>Assign>Zero Tangential H Field.

The Zero Tangential H Fieldwindow appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

To define a tangential H field boundary:
1. Select the section of the geometry on which you want to apply the boundary condition.
2. ClickMaxwell>Boundaries>Assign>Tangential H Field.

The Tangential H Fieldwindow appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. In theParameters section, enter the value of the field component in the x-direction in theU(X)

box and the value of the field component in the y-direction in theV(Y) box.
5. In theCoordinate System section, do the following define the vectors:

a. SelectNew Vector from theU Vector pull-down list.
TheCreate Line message appears asking you to draw the U vector of the coordinate
system in the plane of the selected face.

b. Click two points to specify the vector.
The vector is set, and the Tangential H Fieldwindow reappears, withDefined listed for
U Vector.

c. To reverse the direction of the vector, click theReverse Direction check box.
6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK to assign the boundary to the selected object.

The new boundary is added to the boundary list in the project tree.

Assigning an Integrated Zero Tangential H Field Boundary for the Eddy Current Solver

This type of boundary is applied when the integral of the tangential H field is zero.

Warning When using integrated zero tangential magnetic field boundary conditions, always
double-check that Ampere's law is not violated!

To define an integrated zero tangential H field boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically a face).
2. ClickMaxwell 3D>Boundaries>Assign>Integrated Zero Tangential H Field.

The Integrated Zero Tangential H Fieldwindow appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

The new boundary is added to the boundary list in the project tree.
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Assigning an Insulating Boundary for the Eddy Current Solver

This boundary condition is generally used tomodel very thin sheets of perfectly insulatingmaterial
between touching conductors, as well as infinitely thin cracks inside conductors. Current cannot
cross an insulating boundary.
To set an insulating boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically a face).

2. ClickMaxwell>Boundaries>Assign>Insulating.
The Insulating Boundary window appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

Note An insulating boundary condition can be used to control the flow of induced eddy
currents inside conductors that contain sheet objects with an applied insulating
boundary condition. In case you apply the insulating boundary condition on sheet
objects (inside conductors), alwaysmake sure that the respective entities are
selected as faces and not as objects before attempting to assign the insulating
boundary condition to them.

Assigning a Symmetry Boundary for the Eddy Current Solver

This boundary condition defines a plane of geometric or magnetic symmetry in a structure. Assign it
only to the outer surfaces of the problem region.
To set a symmetry boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically a face).

2. ClickMaxwell>Boundaries>Assign>Symmetry.
TheSymmetry Boundary window appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Select one of the following as the type of symmetry:

Odd
(Flux
Tangential)

H is tangential to the boundary; its normal components are
zero.

Even
(Flux Normal)

H is normal to the boundary; its tangential components are
zero.

5. Optionally, clickUse Defaults to revert to the default values in the window.
6. ClickOK to assign the boundary to the selected object.

Warning When using even symmetry boundaries, always double-check that Ampere's law
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is not violated!

Related Topics

Setting a SymmetryMultiplier

Assigning a Master Boundary for the Eddy Current Solver

Master and slave boundaries enable you tomodel planes of periodicity where the H-field at every
point on the slave boundary surface is forced tomatch the H-field of every corresponding point on
themaster boundary surface. The transformation used tomap the H-field from themaster to the
slave is determined by specifying a coordinate system on both themaster and slave boundaries.
To set amaster boundary:

1. Select the face to which you want to assign themaster boundary.
2. ClickMaxwell>Boundaries>Assign>Master.

TheMaster Boundary window appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. In theCoordinate System section, do the following to define the coordinate system:

Note Youmust specify the coordinate system in the plane on which the boundary exists.
First draw the U vector of the coordinate system. Maxwell uses the U vector you
draw and the normal vector of the boundary face to calculate the v-axis. Then
specify the direction of the V vector.

a. SelectNew Vector from theU Vector pull-down list.
TheCreate Line message appears, asking you to draw the U vector of the coordinate
system in the plane of the selected face, and theMaster Boundary dialog box disappears
while you draw the U vector.

b. Select the U vector's origin, whichmust be on the boundary's surface, in one of the
following ways:
l Click the point.
l Type the point's coordinates in the in theX, Y, and Z boxes.

c. Select a point on the u-axis.
TheMaster Boundary dialog box reappears

5. To reverse the direction of the vector, select theReverse Direction check box.
6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK.

Maxwell computes the H-field on this boundary andmaps it to the slave boundary using the
transformation defined by themaster and slave coordinate systems.
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Assigning a Slave Boundary for the Eddy Current Solver

Assigning a slave boundary is the second step in creatingmatching boundaries. The field on the
master boundary ismapped to the slave boundary.

Note Youmust define amaster boundary before creating the slave boundaries that are
associated with it. Assign slave boundaries only to the outer surfaces of the problem
region.

To set a slave boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically a face).
2. ClickMaxwell>Boundaries>Assign>Slave.

TheSlave Boundary window appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. Select themaster boundary to which the slave is to be assigned from theMaster Boundary

pull-down list.
5. To specify the coordinate system, do the following in the Coordinate System section:

Note Youmust specify the coordinate system in the plane on which the boundary exists.
First draw the U vector of the coordinate system. Maxwell uses the U vector you
draw and the normal vector of the boundary face to calculate the v-axis. Then
specify the direction of the V vector.

a. SelectNew Vector from theU Vector pull-down list.
TheCreate Line message appears asking you to draw the U vector of the coordinate
system in the plane of the selected face, and theSlave Boundary dialog box disappears
while you draw the U vector.

b. Select the U vector's origin in one of the following ways:
l Click the point.
l Type the point's coordinates in the in theX, Y, and Z boxes.

Note TheU vector's origin must be on the boundary's
surface.

c. Select a point on the u-axis in the sameway.
When the second point is identified, the vector is set, and theSlave Boundary window
reappears, withDefined listed in theU Vector pull-down list.

d. To specify the direction of the V vector, select or clear theReverse Direction check box.
Note When entering current, current density terminals, or coil terminals, the arrow

associated with current in the selected object shows the direction as if a positive
value is entered for the current. If a negative value is entered the actual current
flow direction is opposite to what the arrow shows. ClickReverse Direction if
you want to reverse the direction of the arrow.

6. In theRelation section, select one of the following to specify the field behavior on the
boundary:

Assigning Boundaries and Excitations for 3D Designs 11-51
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Hs =
Hm

Click this radio button if the slave andmaster boundaries have the samemagnitude
and direction.

Hs =
-Hm

Click this radio button if the slave boundary field has the samemagnitude as but the
opposite direction from themaster boundary field.

7. Optionally, clickUse Defaults to revert to the default values in the window.
8. ClickOK to assign the boundary to the selected object.

Note The origin must be a vertex point of one of the
objects.

Assigning a Radiation Boundary for the Eddy Current Solver

To simulate problems that allow fields to radiate infinitely far into space, you can define surfaces to
be radiation boundaries. The system absorbs the field at the radiation boundary, essentially
ballooning the boundary infinitely far away from the structure. In a far field region, field components
are expressed by:

where:

and Z is the component of the E-field that is tangential to the surface.
Using the field impedance, the equation becomes:

which is used as a radiation boundary. The radiation boundary condition should be placed far
enough from the source of radiation so that the approximation of the far field in the region of the
boundary holds.
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The second-order radiation boundary condition is an approximation of free space. The accuracy of
the approximation depends on the distance between the boundary and the object fromwhich the
radiation emanates.
A radiation surface does not have to be spherical. However, it should be exposed to the background,
convexwith regard to the radiation source, and located at least one-quarter of a wavelength away
from the radiating sources. In some cases youmaywant to use smaller distances.
To assign a radiation boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically a face).

2. ClickMaxwell>Boundaries>Assign>Radiation.
TheRadiation Boundary window appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Optionally, clickUse Defaults to revert to the default values in the window.
5. ClickOK to assign the boundary to the selected object.

Assigning an Impedance Boundary for the Eddy Current Solver

This boundary condition is used to simulate the effect of induced currents in a conductor without
explicitly computing them. Since the conductor must be excluded from themodel (saving time
needed tomesh and solve for currents), assign the impedance boundary condition to an outside
edge of the problem region or to an excluded object.
To define an impedance boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically a face).

2. ClickMaxwell 3D>Boundaries>Assign>Impedance.
The Impedance Boundary window appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Do one of the following:

l If theUse Material check box is unchecked, enter the conductivity (in inverse ohm-meters)
in theConductivity field, and the conductor's relative permeability in thePermeability
field.
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l If you wish to select amaterial from the library, check theUse Material check box, then use
the button to select the desiredmaterial.
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If you select amaterial that has nonlinear permeability, the non-linear coefficient is computed
automatically.

The nonlinear relative permeability of thematerial is determined by the B-H curve. If the
desired B-H curve of the permeability belongs to an existingmaterial, you can directly use that
existingmaterial.

Otherwise, you can edit a new material with the desired B-H curve.
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Refer toRelative Permeability for aMaxwell or RMxprt Material for details on using nonlinear
relative permeability.

5. Optionally, clickUse Defaults to revert to the default values in the window.
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TheDefaults tab allows you to control default values. TheSave Defaults button saves the
values currently defined on theGeneral tab as the defaults to be assigned to new impedance
boundaries.Revert to Standard Defaults clears existing user-defined values and replaces
themwith the standard default values.

6. ClickOK to assign the boundary to the selected object.
The Project Manager lists the newly assigned impedance boundary in the tree. You can select
the boundary in the tree to view and edit its properties in the PropertiesWindow. You can also
double-click the boundary entry in the tree to open it for editing in the Impedance Boundary
dialog box.
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Related Topics

Impedance Boundary

Impedance Boundary

Impedance boundaries allow you to simulate the effect of induced currents in a conductor without
explicitly computing them. Use this boundary condition for models where:

l The skin depth in the conductor is less than two orders of magnitude smaller than the
dimensions of the structure. In models like this, themeshmaker may not be able to create a
fine enoughmesh in the conductor to compute eddy currents.

l Themagnetic field decaysmuchmore rapidly inside the conductor in the direction that’s
normal to the surface than it does in directions that are tangential to the surface.

l The AC current source is relatively far away from the surface where eddy currents occur,
compared to the size of the skin depth.

The conductor itself must be excluded from the solution region.When setting up themodel, do one of
the following:

l For external boundaries, when drawing themodel, make the surface along which eddy
currents are to be computed an outer surface of the problem region.

Assigning Boundaries and Excitations for 3D Designs 11-58
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l For internal boundaries: assign a perfect conductor to the object in theMaterial Manager, and
also exclude the object from the solution by uncheckingSolve Inside under the object
attributes. The solver does not find solutions inside a perfect conductor.

Then, when defining boundaries, assign an impedance boundary to the individual surfaces of the
problem region (for external boundaries) or to the entire object (for internal boundaries). By entering
the conductivity, s, and the relative permeability, mr, of the object, you specify the skin depth of
induced eddy currents. The simulator uses this skin depth value when computing the
electromagnetic field solution. It assumes that the H-field falls off exponentially inside the conductor.
The ohmic loss due to induced currents can then be computed from the tangential components of the
H-field along the impedance boundary— the surface of the object that you are interested in.

Note An impedance boundary only approximates the effect of eddy currents acting at a shallow
skin depth. It does not directly compute them. In general, the fieldsmodeled using an
impedance boundary will closelymatch the field patterns that would actually occur in the
structure. However, at discontinuities in the surface (such as corners), the field patterns
may be different.

Related Topics

When to use Impedance Boundaries

When to Use Impedance Boundaries

A typical situation where impedance boundaries can be used to reduce the complexity of amodel is
shown below. Suppose you want to compute eddy current losses in the conductor next to the current
source shown below on the left. If the source carries AC current at a frequency of 1MHz, the skin
depth in the conductor is 6.6 x 10–5meters. This is several orders of magnitude smaller than the
conductor’s thickness. Since the conductor where currents are induced is also relatively far away
from the current source, an impedance boundary can be used tomodel the induced currents— as
shown on the right.
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The conductor itself must be excluded from themodel. Instead, the outside boundary of themodel is
moved to the inside surface of the conductor. This outside surface is defined as an impedance
boundary, using the conductivity and permeability specified previously. Since the simulator does not
have to actually compute a solution inside the conductor, the field solution is computedmore quickly
and uses lessmemory. After solving, you can compute the ohmic loss for the surface using the
solution calculator and plot the loss density on the boundary.

Eddy Current Excitations

The eddy current solver allows you to define the following sources of AC magnetic fields:

Excitation Type of Excitation
Current Density The current density in a conductor. In this

case, youmust also define the current
density terminals for the conductor.

Current Density Terminal Specifies the cross section of the conductor
where current density is specified, to be
used as a terminal object. Current Density
and Current Density Terminal are required
to be used in conjunction.

Current The total current in a conductor.

Coil Terminal Used to define one or moremodel
windings.
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WindingWith Current Current for both a stranded and solid
conductor.

WindingWith Voltage Voltage for both a stranded and solid
conductor.

WindingWith External
Circuit Connection

External circuit connection for both a
stranded and solid conductor.

Note When entering current, the arrow associated with current in the selected object shows the
direction as if a positive value is entered for the current. If a negative value is entered the
actual current flow direction is opposite to what the arrow shows. ClickReverse Direction
if you want to reverse the direction of the arrow.

Note When a source conductor touches an outer boundary, Maxwell assumes current will flow
perpendicular to the boundary. If you do not want current to cross the outer boundary, an
insulating boundary should be used.

Assigning a Current Density Excitation for the Eddy Current Solver

This command specifies the x-, y-, and z-components of the AC current density in a conduction path.
If the current density is a function of position, the value is entered in ampere/m2, even if you change
the units in the problem.
To define the current density:

1. Select the section of the geometry (i.e., the conductor) in which you want to apply the
excitation (typically a 3D object).

2. ClickMaxwell>Excitations>Assign>Current Density.
TheCurrent Density Excitation window appears.

3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, specify the following options:

a. Enter theX Component, Y Component, and Z Component values to define the
respective components of the current density vector.

b. Do the following in the twoCoordinate System pull-down lists:
l From the first pull-down list, select eitherGlobal orRelativeCS1 (where x = 1,2,3… if
any relative coordinate systems have been defined).

l From the second pull-down list, selectCartesian,Cylindrical, or Spherical.
c. Enter the phase angle, θ, of the current density in thePhase field.

5. Optionally, clickUse Defaults to revert to the default values in the window.
6. ClickOK to assign the excitation to the selected object.

To complete the current density definition, you also need to specify any related current density
terminals, whichmust be assigned to a 2D object or face of the respective conduction path.

Note Select the names of the sheet objects to serve as the current density terminals. This object
must form an exact cross-section of the current density conduction path.Youmust create
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2D objects which represent locationswhere current flows into and out of the problem
region, or branches at any location in the conduction path. In current loops, any exact 2D
cross-sectionmay serve as a terminal.

Related Topics

Assigning a Current Density Terminal

Assigning a Current Density Terminal Excitation for the Eddy Current Solver

To define the current density terminal:
1. Select the section of the geometry (i.e., the conductor) in which you want to apply the

excitation (typically a 3D object).
2. ClickMaxwell>Excitations>Assign>Current Density Terminal.

TheCurrent Density Terminal Excitation window appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. ClickOK to assign the excitation to the selected target(s).

Related Topics

Assigning a Current Density Excitation

Assigning a Current Excitation for the Eddy Current Solver

Specifies the total AC current in a conduction path. The conduction pathmay be contained
completely within the problem region (for example, a coil), or may touch the edges of the problem
region.
To specify the total AC current:

1. Select the 2D section of the geometry on which you want to apply the excitation.
2. ClickMaxwell>Excitations>Assign>Current.

TheCurrent Excitation window appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. Enter the current strength in theValue box.
5. Enter the phase for the current in thePhase box.
6. Select either Solid or Stranded to define the Type for the conductor. For a stranded

conductor, a uniformly distributed current density is assumedwithout considering eddy
effects.

7. Optionally, clickSwap Direction to change the direction of the current flow.
8. Optionally, clickUse Defaults to revert to the default values in the window.
9. ClickOK to assign the excitation to the selected object.
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Assigning a Coil Terminal for an Eddy Current Solver

To assign a coil terminal as an Eddy current excitation:
1. Select the section of the geometry on which you want to apply the excitation (typically a 2D

planar object).
2. ClickMaxwell>Excitations>Assign>Coil Terminal. (You can also right-click an existing

winding in the project tree, and selectAssign Coil Terminal.)
TheCoil Terminal Excitation dialog box appears.

3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the number of conductors for the coil terminal in the

Number of Conductors box. For a solid winding, the number should be 1.
Note This value represents only the number of conductors inside of the

selected geometry. If the Coil Terminal is cut due to symmetry, then only
enter the Number of Conductors in the portionmodeled.

5. If you want to switch the direction for the coil terminal, click Swap Direction.
Note The direction is shown in themodel by a bold red

arrow.

6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK to assign the coil terminal to the selected object.

Note To add a coil terminal to an existing winding, do the following:
1. In the project tree, right-click the coil terminal, and selectAdd to

Winding.
The Add to Winding dialog box appears.

2. Select the winding to which you ant to add the coil terminal, and click
OK.

Note To remove a coil terminal from an existing winding, do the following:
l In the project tree, right-click the coil terminal, and selectRemove
from Winding.
The terminal is removed from the winding andmoved up one level in
the project tree (directly beneathExcitations).

Assigning a Winding Setup for an Eddy Current Solver

Note If you wish to define a winding for a Transient solution type, refer to
"Assigning aWinding Setup for a Transient Solver" on page 11-75 .

You can use the pre-defined coil terminal(s) to define one or more current or voltage windings.
To define a winding for your model:

1. ClickMaxwell>Excitations>Add Winding. to open theWinding dialog box.
2. Enter a name for the winding in theName box, or accept the default.
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3. In theParameters section:
a. SelectCurrent, Voltage, or External from the Type pull-down list. The winding type

selected enables only those fields (Initial Current, Resistance, Inductance, Voltage,
Phase) applicable for the chosen type.

b. Select theSolid or Stranded radio button to specify the type of conductor.
c. Enter values in the following fields (enabled according to winding type), and select the

desired units. You can also type a function as an expression for any of these fields
except Initial Current.

For a current winding For a voltage winding1 For an external winding
Current Resistance (no settings required)
Phase Inductance

Voltage
Phase

d. Enter a value in theNumber of parallel branches text box.
4. Optionally, clickUse Defaults to revert to the default values in the dialog box.
5. Optionally, on the Defaults tab, clickSave Defaults to save the current settings or click

Revert to Standard Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the excitation to the selected object.

A winding is now defined for your model.

Note For an external winding, youmust also set up an external circuit connection.

Note To add a coil terminal to this winding, do the following:
1. In the project tree, right-click the winding, and selectAdd Terminals. The Add

Terminals dialog box appears, listing all coil terminals that do not already belong to
that winding.

2. Select the coil terminal (s) you want to add. To select multiple terminals, pressCTRL
and click each terminal.

3. ClickOK.
To assign a coil terminal excitation and add it to this winding, do the following:
1. Select the section of the geometry on which you want to apply the coil terminal

excitation.
2. In the project tree, right-click the winding, and selectAssign Coil Terminal. The

Coil Terminal Excitation dialog box appears.
3. ClickOK to assign the coil terminal excitation.

The coil terminal excitation is assigned and is added to the winding.
To delete all coil terminal excitations that belong to this winding, do the following:

l In the project tree, right-click the winding, and select Delete All Terminals. All coil
terminal excitations are removed from the winding and deleted from the excitations.
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1. For a solid winding, the resistance term can represent: the resistance of a portion of the
winding which is not modeled (for instance, end-effects), the leads connecting the winding to
the source, or the source resistance. (Themain winding resistance is calculated directly by the
solver.) For a stranded winding, the resistance term is the complete DC resistance of the
winding (since the solver does not determine resistance of a stranded winding) aswell as the
resistance of the end-effects, leads, source, etc. For both solid and stranded windings, the
inductance term can represent: the extra inductance for a portion of the winding of the winding
which is not modeled (for instance, end-effects), the leads connecting the winding to the
source, or the source inductance. (Themain winding inductance itself is calculated directly by
the solver.)

External Circuit Setup for 3D Eddy Current

TheMaxwell Circuit design editor is used to setup the external circuit excitation for windings in
Maxwell 2D and 3D Eddy current solutions. Because the Eddy current solver is a frequency domain
solver, only linear circuit components are supported, which include Resistance, Inductance,
Capacitance, and Transformer. In addition, only sinusoidal sources should be used as sources.
Sinusoidal Current Source and Sinusoidal Voltage Source, designed for transient solutions, can also
be used for eddy current solutions. For example, to use the sinusoidal current source, you should set
the parameters as follows:

l Set I0, Td, andDf to zero, where I0 is offset current in Amps, Td is the delay time in seconds,
and Df is the damping factor in 1/seconds.

l Set TIME as the Type.
l Use Ia to set the peak amplitude in Amps.
l Use IFreq to set the signal frequency. Note that setting IFreq is not necessary as it will be
internally set to the frequency defined in theMaxwell design setup.

l UsePhase to set the phase delay.
With these specifications, the time signal can be written as:

Note that “Phase” is the signal phase delay. The complex source in the eddy current solver is
represented in phasor form as:

and the time signal can be written in terms of (Ia, θ) as:

In the complex expression, θ is defined as phase, while in Maxwell Circuit,Phase is defined as phase
delay. Thus:

As a result, you should enter the negative of phase of the complex signal as the Phase value.
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An example of such a setup for is shown below.

An example of an external circuit excitation for the winding for an Eddy current solver is shown
below.

Note For frequency domain eddy current solutions, only linear circuit components are supported,
which include Resistor, Inductor, Capacitor, and Transformer. Only sinusoidal sources
should be used as sources.

To set up an external circuit connection for an External winding type:
1. ClickMaxwell 3D>Excitations>External Circuit>Edit External Circuit to open theEdit

External Circuit dialog box. You can also right-click onExcitations in the Project tree and
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selectExternal Circuit>Edit External Circuit.
a. If no external winding connections have been set up for your model, theWinding

Information tab lists the external winding(s) in the design. Continue with step 2.

b. If external windings have already been set up, continue with step 7.
2. On theWinding Information tab, clickCreate Circuit to add a circuit design to the project.

The new circuit design automatically opens for editing in theMaxwell Circuit Editor. The circuit
includes one inductor for each external winding in the original Maxwell transient design. The
example below is for a design having one external winding.

3. Add the components needed to complete the external circuit design such as shown the
example below.
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4. When the circuit design is finished, clickMaxwell Circuit>Export Netlist and export the
netlist .sph file to the desired location.

5. Return to theMaxwell design and clickMaxwell 3D>Excitations>External Circuit>Edit
External Circuit to open theEdit External Circuit dialog. You can also right-click on
Excitations in the Project tree and selectExternal Circuit>Edit External Circuit.

6. On theWinding Information tab, click Import Circuit to import the circuit.
7. To view a list of inductors in the imported circuit, click theAvailable Inductors tab.
8. To view the sources used in the externally connected windings, click theSource Type tab.
9. If variables are used in the imported circuit, they and their design values are listed on the

Parameter Values tab. You can link to variables within the imported circuit as follows:
a. On theParameter Values tab, click in theValue column of the parameter to be

mapped.
b. Enter a new local variable name and press the Enter key to open theAdd Variable

dialog.
c. Select aUnit Type andUnit, and enter aValue for the variable and clickOK. The new

Maxwell variable is now mapped to the variable in the imported circuit, and can be
varied directly byMaxwell or used for Optimetrics analyses.

10. If the imported file is a .sph file, you can click theCircuit Path tab to view the original project
and design names.

11. ClickOK to close the Edit External Circuit dialog box.

Related Topics

"Assigning aWinding Setup for an EddyCurrent Solver" on page 11-63

Transient Boundaries and Excitations
Define at least one of the following as a source of magnetic fields:

l The stranded or solid windings, with a voltage or current supply or connected to an external
circuit winding.
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Note For stranded conductors, it is assumed that the current density is uniform on the
cross-section of the respective conductors. Thus, the stranded option for current
excitations shouldmostly be used only in caseswhere the cross-section of
conductors is constant, consistently with the assumption that the respective object
is a coil built with strands of wire. For this reason, conductors (coils) could be
created by either sweeping around an axis using zero segments or sweeping
along a path having only true surface segments in order to create a smooth
surface coil having a completely uniform cross-sectional area over its entire
length.

l A permanent magnet.
Youmay need to set at least one outer boundary to the following:

l The default boundary conditions.
l An odd symmetry (flux tangential) boundary.
l An even symmetry (flux normal) boundary.

Related Topics

Technical Notes: 3D Transient Excitations (Sources)
Specifying the Solver Type

Transient Boundaries

The transient field solver allows you to define the same types of boundary conditions as
magnetostatic ones.

Boundary
Type H-Field Behavior Used to

model...
Default
Boundary
Conditions
(Natural
and
Neumann)

Field behaves as follows:
l Natural boundaries— H is continuous across the boundary.
l Neumann boundaries— H is tangential to the boundary and
flux cannot cross it.

Ordinary field
behavior.
Initially, object
interfaces are
natural
boundaries;
outer
boundaries, and
excluded objects
are Neumann
boundaries.

Zero
Tangential
H Field

The tangential components ofH are set to zero. Flux is
perpendicular.

External
magnetic fields.

Integrated For applications such as amotor with the shaft excluded, there Cases such as
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Zero
Tangential
H Field

remains a hole in themiddle. In such cases, on the hole's boundary,
neither the Tangential H Field boundary (where integration of the
tangential H field is non-zero), nor the Zero Tangential H Field
boundary (where the tangential H field is zero everywhere) can be
applied because – for the hole boundary case – integration of the
tangential H field is zero, but the tangential H field is not zero
everywhere. Integrated Zero Tangential H Field can be used for
such applications.

the boundary
around the hole
that remains
when amotor's
shaft is
excluded.

Insulating Same asNeumann, except that current cannot cross the boundary. Thin, perfectly
insulating sheets
between
touching
conductors.

Symmetry Field behaves as follows:
l Odd Symmetry (Flux Tangential) — H is tangential to the
boundary; its normal components are zero.

l Even Symmetry (Flux Normal) — H is normal to the
boundary; its tangential components are zero.

Planes of
geometric and
magnetic
symmetry.

Matching
(Master
and Slave)

The H-field on the slave boundary is forced tomatch themagnitude
and direction (or the negative of the direction) of the H-field on the
master boundary.

Planes of
symmetry in
periodic
structures
whereH is
oblique to the
boundary.

Default Boundary Conditions for a Transient Solver

These boundary conditions are automatically defined for a transient model:
l Natural boundaries are assigned to the surfaces between objects.
l Neumann boundaries are assigned to the outside edges of the problem region.

To leave a surface set to its default boundary condition, you do not need to set any boundary
conditions. Deleted boundary conditions and excitations automatically reset to the default boundary
conditions.

Assigning a Zero Tangential H Field Boundary for a Transient Solver

This type of boundary defines external magnetic fields in amodel.

Warning When using zero tangential magnetic field boundary conditions, always double-check
that Ampere's law is not violated!

To define a zero tangential H field boundary:
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1. Select the section of the geometry on which you want to apply the boundary condition
(typically a face).

2. ClickMaxwell>Boundaries>Assign>Zero Tangential H Field.
The Zero Tangential H Fieldwindow appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

Assigning an Integrated Zero Tangential H Field Boundary for a Transient Solver

This type of boundary is applied when the integral of the tangential H field is zero.

Warning When using integrated zero tangential magnetic field boundary conditions, always
double-check that Ampere's law is not violated!

To define an integrated zero tangential H field boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically a face).
2. ClickMaxwell 3D>Boundaries>Assign>Integrated Zero Tangential H Field.

The Integrated Zero Tangential H Fieldwindow appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

Assigning an Insulating Boundary for a Transient Solver

This boundary condition is used tomodel very thin sheets of perfectly insulatedmaterial between
touching conductors. Current cannot cross an insulating boundary.
To set an insulating boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically a face).

2. ClickMaxwell>Boundaries>Assign>Insulating.
The Insulating Boundary window appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

Note An insulating boundary condition can operate on the source current. It can also be
used to control the flow of induced eddy currents.

Assigning a Symmetry Boundary for a Transient Solver

This boundary condition defines a plane of geometric or magnetic symmetry in a structure. Assign it
only to the outer surfaces of the problem region.
To set a symmetry boundary:
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1. Select the section of the geometry on which you want to apply the boundary condition
(typically a face).

2. ClickMaxwell>Boundaries>Assign>Symmetry.
TheSymmetry Boundary window appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Select one of the following as the type of symmetry:

Odd
(Flux
Tangential)

H is tangential to the boundary; its normal components are
zero.

Even
(Flux Normal)

H is normal to the boundary; its tangential components are
zero.

5. Optionally, clickUse Defaults to revert to the default values in the window.
6. ClickOK to assign the boundary to the selected object.

Warning When using even symmetry boundaries, always double-check that Ampere's law
is not violated!

Related Topics

Setting a SymmetryMultiplier

Assigning a Master Boundary for a Transient Solver

Master and slave boundaries enable you tomodel planes of periodicity where the H-field at every
point on the slave boundary surface is forced tomatch the H-field of every corresponding point on
themaster boundary surface. The transformation used tomap the H-field from themaster to the
slave is determined by specifying a coordinate system on both themaster and slave boundaries.
To set amaster boundary:

1. Select the face to which you want to assign themaster boundary.
2. ClickMaxwell>Boundaries>Assign>Master.

TheMaster Boundary window appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. In theCoordinate System section, do the following to define the coordinate system:

Note Youmust specify the coordinate system in the plane on which the boundary exists.
First draw the U vector of the coordinate system. Maxwell uses the U vector you
draw and the normal vector of the boundary face to calculate the v-axis. Then
specify the direction of the V vector.

a. SelectNew Vector from theU Vector pull-down list.
TheCreate Line message appears, asking you to draw the U vector of the coordinate
system in the plane of the selected face, and theMaster Boundary dialog box disappears
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while you draw the U vector.
b. Select the U vector's origin, whichmust be on the boundary's surface, in one of the

following ways:
l Click the point.
l Type the point's coordinates in the in theX, Y, and Z boxes.

c. Select a point on the u-axis.
TheMaster Boundary dialog box reappears

5. To reverse the direction of the vector, select theReverse Direction check box.
6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK.

Maxwell computes the H-field on this boundary andmaps it to the slave boundary using the
transformation defined by themaster and slave coordinate systems.

Assigning a Slave Boundary for a Transient Solver

Assigning a slave boundary is the second step in creatingmatching boundaries. The field on the
master boundary ismapped to the slave boundary.

Note Youmust define amaster boundary before creating the slave boundaries that are
associated with it. Assign slave boundaries only to the outer surfaces of the problem
region.

To set a slave boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically a face).
2. ClickMaxwell>Boundaries>Assign>Slave.

TheSlave Boundary window appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. Select themaster boundary to which the slave is to be assigned from theMaster Boundary

pull-down list.
5. To specify the coordinate system, do the following in the Coordinate System section:

Note Youmust specify the coordinate system in the plane on which the boundary exists.
First draw the U vector of the coordinate system. Maxwell uses the U vector you
draw and the normal vector of the boundary face to calculate the v-axis. Then
specify the direction of the V vector.

a. SelectNew Vector from theU Vector pull-down list.
TheCreate Line message appears asking you to draw the U vector of the coordinate
system in the plane of the selected face, and theSlave Boundary dialog box disappears
while you draw the U vector.

b. Select the U vector's origin in one of the following ways:
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l Click the point.
l Type the point's coordinates in the in theX, Y, and Z boxes.

Note TheU vector's origin must be on the boundary's
surface.

c. Select a point on the u-axis in the sameway.
When the second point is identified, the vector is set, and theSlave Boundary window
reappears, withDefined listed in theU Vector pull-down list.

d. To specify the direction of the V vector, select or clear theReverse Direction check box.
6. In theRelation section, select one of the following to specify the field behavior on the

boundary:

Hs =
Hm

Click this radio button if the slave andmaster boundaries have the samemagnitude
and direction.

Hs =
-Hm

Click this radio button if the slave boundary field has the samemagnitude as but the
opposite direction from themaster boundary field.

7. Optionally, clickUse Defaults to revert to the default values in the window.
8. ClickOK to assign the boundary to the selected object.

Note The origin must be a vertex point of one of the
objects.

Transient Excitations

After defining the coil terminals for themodel, you can use these terminals to define one or more
windings using theMaxwell>Excitations>Add Winding option. Transient problems use the
following sources of magnetic fields:

Excitation Type of Excitation
Coil Terminal Used to define one or moremodel windings.

WindingWith Current Current for both a stranded and solid conductor.

WindingWith Voltage Voltage for both a stranded and solid conductor.

WindingWith External Circuit
Connection

External circuit connection for both a stranded and solid
conductor.

Note A winding is a flexible excitation. Six different combinations can be used: Current, Voltage,
and External Circuit — each with a solid or stranded conductor. The Coil Terminal type of
excitation is needed to set up a winding.

Note When a source conductor touches an outer boundary, Maxwell assumes current will flow
perpendicular to the boundary. If you do not want current to cross the outer boundary, an
insulating boundary should be used.
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In addition, permanent magnets serve as sources of magnetic fields.

Assigning a Coil Terminal for a Transient Solver

To assign a coil terminal as a transient excitation:
1. Select the section of the geometry on which you want to apply the excitation (typically a 2D

planar object).
2. ClickMaxwell>Excitations>Assign>Coil Terminal. (You can also right-click an existing

winding in the project tree, and selectAssign Coil Terminal.)
TheCoil Terminal Excitation dialog box appears.

3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the number of conductors for the coil terminal in the

Number of Conductors box.
Note This value represents only the number of conductors inside of the selected

geometry. If the Coil Terminal is cut due to symmetry, then only enter the Number of
Conductors in the portionmodeled.

5. If you want to switch the direction for the coil terminal, click Swap Direction.
Note The direction is shown in themodel by a bold red

arrow.

6. Optionally, clickUse Defaults to revert to the default values in the window.
7. ClickOK to assign the coil terminal to the selected object.

Note To add this coil terminal to an existing winding, do the following:
1. In the project tree, right-click the coil terminal, and selectAdd to

Winding.
The Add to Winding dialog box appears.

2. Select the winding to which you ant to add the coil terminal, and click
OK.

Note To remove a coil terminal from an existing winding, do the following:
l In the project tree, right-click the coil terminal, and selectRemove from
Winding.
The terminal is removed from the winding andmoved up one level in the
project tree (directly beneathExcitations).

Related Topics

"Assigning aWinding Setup for a Transient Solver" below

Assigning a Winding Setup for a Transient Solver

Note If you wish to define a winding for an EddyCurrent solution type, refer to
"Assigning aWinding Setup for an EddyCurrent Solver" on page 11-63
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.

You can use the pre-defined coil terminal(s) to define one or more current or voltage windings.
To define a winding for your model:

1. ClickMaxwell>Excitations>Add Winding. to open theWinding dialog box.
2. Enter a name for the winding in theName box, or accept the default.
3. In theParameters section:

a. SelectCurrent, Voltage, or External from the Type pull-down list. The winding type
selected enables only those fields (Initial Current, Current, Resistance, Inductance,
Voltage) applicable for the chosen type.

Note Maxwell transient designs can be dynamically coupled to Simplorer
components through the Simplorer user interface. You can enable this
feature on the Advanced Product Coupling tab of theDesign Settings dialog
box. Source windings set toExternal are available as conservative pins in
Simplorer. For more information, refer to the Online Help for Simplorer
Version 8 and later.

b. Select theSolid or Stranded radio button to specify the type of conductor.
c. Enter values in the following fields (enabled according to winding type), and select the

desired units. You can also type a function as an expression for any of these fields
except Initial Current.

For a current winding For a voltage winding1 For an external winding
Current Resistance Initial Current

Inductance
Voltage
Phase

d. Enter a value in theNumber of parallel branches text box.
4. Optionally, clickUse Defaults to revert to the default values in the window.
5. ClickOK to assign the excitation to the selected object.

A winding is now defined for your model.

Note For an external winding, youmust also set up an external circuit connection.

Note To add a coil terminal to this winding, do the following:
1. In the project tree, right-click the winding, and selectAdd Terminals.

The Add Terminals dialog box appears, listing all coil terminals that do not already
belong to that winding.

2. Select the coil terminal (s) you want to add. To select multiple terminals, pressCTRL
and click each terminal.

3. ClickOK.
To assign a coil terminal excitation and add it to this winding, do the following:
1. Select the section of the geometry on which you want to apply the coil terminal
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excitation.
2. In the project tree, right-click the winding, and selectAssign Coil Terminal.

TheCoil Terminal Excitation dialog box appears.
3. ClickOK to assign the coil terminal excitation.

The coil terminal excitation is assigned and is added to the winding.
To delete all coil terminal excitations that belong to this winding, do the following:

l In the project tree, right-click the winding, and select Delete All Terminals.
All coil terminal excitations are removed from the winding and deleted from the
excitations.

Related Topics

"Assigning a Coil Terminal for a Transient Solver" on page 11-75
"Setting Up an External Circuit Connection for an ExternalWinding Type" below

1. For a solid winding, the resistance term can represent: the resistance of a portion of the
winding which is not modeled (for instance, end-effects), the leads connecting the winding to
the source, or the source resistance. (Themain winding resistance is calculated directly by the
solver.) For a stranded winding, the resistance term is the complete DC resistance of the
winding (since the solver does not determine resistance of a stranded winding) aswell as the
resistance of the end-effects, leads, source, etc. For both solid and stranded windings, the
inductance term can represent: the extra inductance for a portion of the winding of the winding
which is not modeled (for instance, end-effects), the leads connecting the winding to the
source, or the source inductance. (Themain winding inductance itself is calculated directly by
the solver.)

Setting Up an External Circuit Connection for an External Winding Type

TheMaxwell Circuit design editor is used to setup the external circuit excitation for windings in
Maxwell 2D and 3D transient solutions.

Note External circuits intended for use with the TimeDecompositionMethod (TDM) can only
support basic circuit elements that are solution-independent. This is because, for TDM, all
time steps (or all time steps in a subdivision) are solved simultaneously - and thus the circuit
topology and its parametersmust be known before solving. Therefore some circuit
elements, such as solution-dependent switches, diodes, capacitors, and inductors which
are not directly connected to windings in series, are not supported.

To set up an external circuit connection for an External winding type:
1. ClickMaxwell 3D>Excitations>External Circuit>Edit External Circuit to open theEdit

External Circuit dialog box. You can also right-click onExcitations in the Project tree and
selectExternal Circuit>Edit External Circuit.
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a. If no external winding connections have been set up for your model, theWinding
Information tab lists the external winding(s) in the design. Continue with step 2.

b. If external windings have already been set up, continue with step 7.
2. On theWinding Information tab, clickCreate Circuit to add a circuit design to the project.

The new circuit design automatically opens for editing in theMaxwell Circuit Editor. The circuit
includes one inductor for each external winding in the original Maxwell transient design. The
example below is for a design having one external winding.

3. Add the components needed to complete the external circuit design such as shown the
example below.
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4. When the circuit design is finished, clickMaxwell Circuit>Export Netlist and export the
netlist .sph file to the desired location.

5. Return to theMaxwell design and clickMaxwell 3D>Excitations>External Circuit>Edit
External Circuit to open theEdit External Circuit dialog. You can also right-click on
Excitations in the Project tree and selectExternal Circuit>Edit External Circuit.

6. On theWinding Information tab, click Import Circuit to import the circuit.
7. To view a list of inductors in the imported circuit, click theAvailable Inductors tab.
8. To view the sources used in the externally connected windings, click theSource Type tab.
9. If variables are used in the imported circuit, they and their design values are listed on the

Parameter Values tab. You can link to variables within the imported circuit as follows:
a. On theParameter Values tab, click in theValue column of the parameter to be

mapped.
b. Enter a new local variable name and press the Enter key to open theAdd Variable

dialog.
c. Select aUnit Type andUnit, and enter aValue for the variable and clickOK. The new

Maxwell variable is now mapped to the variable in the imported circuit, and can be
varied directly byMaxwell or used for Optimetrics analyses.

10. If the imported file is a .sph file, you can click theCircuit Path tab to view the original project
and design names (which are removed after you import a non-sph file).

11. ClickOK to close the Edit External Circuit dialog box.
Note For Transient designs, the user-set time steps can bemodified when external

circuits are used to drive the windings of a transient finite element model. Following
is a list of situations that will lead to a time step change:
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l All power electronic switching instances that do not coincide with user-
specified solve times request a new solution time from the transient solver. The
respective switching generating a new solve time request for the transient
solver can be time, position, or speed dependent.

l When current and/or voltage sourceswith a piecewise linear variation are
used, a new solution time is requested from the transient solver at each (time)
definition point used in the corresponding source definition table.

l When the change in anywinding inductance value is excessive, a new time
step (smaller) is calculated and a new solution generated (re-calculated)
accordingly.

If a user-specified save field time ismissed because of the above reasons, the next
solved time step fields are saved instead.

Related Topics

"Assigning aWinding Setup for a Transient Solver" on page 11-75

Using the AC_Model Component to Speed Up Analysis

Use of the AC_Model component when setting up an external circuit design can improve transient
analysis time to steady state significantly.
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In the above example the AC_Model is associated with ALL three of the phase windings. The AC_
Model modifies currents for the AC windings at the beginning of each period without interrupting the
transient process - thus improving the analysis time.

Setting Up an External Circuit Using Simulink

In addition to using theMaxwell Circuit Editor to set up an external circuit, you also can useMatlab®
Simulink® to set up an external circuit for bothMaxwell 2D and 3D transient designs.

Assigning Boundaries and Excitations for 3D Designs 11-81
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l Supported Simulink versions are: R2012b, R2013a, R2013b, R2014a, R2014b, and R2015a.
In addition to winding sources, motion sources can also be linked in the external circuit.

l Winding sources ("External" type only): voltage, current, and flux linkage.
l Motion sources: speed, position, and force/torque

To set up an external circuit using Simulink:
1. In theMaxwell Project Manager, right-clickExcitations and selectSetup Co-Simulation

with Simulink to open theSetup Co-Simulation with Simulink dialog box. You can also
open the dialog box from themainMaxwell 2D or 3D>Excitationsmenu. If an external
Simulink circuit has already been created and linked, To Simulink and From Simulink
connections information is shown. Otherwise, these table cells are empty.

2. On theMaxwell-Simulink Link tab, click theEdit Circuit button to launch Simulink. The
Maxwell sources are listed in the in theMaxwell Link Assignment Dialog box. If a circuit
has already been created, the circuit also displays in the Simulink circuit editor window.
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3. Add and Link SIMULINK - IN and SIMULINK- OUT connections to the desiredMaxwell
parameters to set up theMaxwell component ports. You can alsoUnlink connections as
needed. ClickOK once the ports are set up. The ports will show in the Simulink circuit editor
window.
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If changes are needed, clickEdit Circuit to reopen theMaxwell Link Assignment dialog
box.

4. Modify (or create) the circuit in the Simulink circuit editor window as needed, and save the
Simulink circuit project.
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5. In theMaxwellSetup Co-Simulation with Simulink dialog, click the Import Circuit button
to import the Simulink circuit project into theMaxwell project. The linked connections appear in
theEdit External Circuit dialog. TheCircuit Path tab shows the path to the location from
which the Simulink circuit file was imported.
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Note You can alsomodify an existing Simulink circuit by opening the circuit file directly
in Simulink, and then importing themodified circuit file back into theMaxwell
design.

6. When you start theMaxwell design analysis, the co-simulations are started betweenMaxwell
and Simulink .

Note l Making changes to theMaxwell winding andmotion setups invalidate the
external circuit.

l Making changes to the external Simulink circuit setup invalidates the
solutions.

Related Topics

"Setting Up an External Circuit Using theMaxwell Circuit Editor" on page 27-53

Electric Transient Solver Boundaries and Excitations
Specify at least one of the following excitations as a source of electric fields:
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l The total charge on object.
l The volume charge density inside an object.
l The current.
l Define the electric potential on each surface using a voltage excitation.

Related Topics

Electric Transient Excitations
Specifying the Solver Type
Electric Transient Solver

Electric Transient Excitations

The following excitations are available for the electric transient problems:
l Charge – defines the total charge on an object.
l VolumeCharge Density – defines the volume charge density on an object.

Related Topics

Specifying the Solver Type
Electric Transient Solver

Assigning a Charge Excitation for an Electric Transient Solver

To define a charge excitation:
1. Select the section of the geometry on which you want to apply the excitation.
2. ClickMaxwell>Excitations>Assign>Charge.

TheCharge Excitation dialog box appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the charge in theValue box.
5. Optionally, clickUse Defaults to revert to the default values.
6. ClickOK to assign the excitation to the selected object.

Related Topics

Electric Transient Excitations
Specifying the Solver Type
Electric Transient Solver

Assigning Boundaries and Excitations for 3D Designs 11-87
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Assigning a Volume Charge Density Excitation for an Electric Transient Solver

To define a volume charge density excitation:
1. Select the section of the geometry on which you want to apply the excitation.
2. ClickMaxwell>Excitations>Assign>Volume Charge Density.

TheVolume Charge Density Excitation dialog box appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the volume charge density in theValue box.
5. Optionally, clickUse Defaults to revert to the default values.
6. ClickOK to assign the excitation to the selected object.

Related Topics

Electric Transient Excitations
Specifying the Solver Type
Electric Transient Solver
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12 - Assigning Boundaries and Excitations for 2D
Designs

For every design, you need to assign boundaries and excitations. You can use the Maxwell 2D
menu or the project tree to do the following:

l Define boundary conditions that control how the electric or magnetic field behaves planes of
symmetry, periodicity, or edges of the problem region.

l Define solution type specific excitations of voltage, charge, coil, and current.
l For magnetic transient designs, if needed, set up a winding and an external circuit connection.

Each field solver requires you to specify excitations of electric or magnetic fields and references for
computing these fields.

l Magnetostatic Boundaries and Excitations
l Electrostatic Boundaries and Excitations
l AC Conduction Boundaries and Excitation
l DC Conduction Boundaries and Excitations
l EddyCurrent Boundaries and Excitations
l Transient Boundaries and Excitations

Youmust specify at least one of the boundary conditions or excitations listed in these sections so that
the simulator can compute accurate values for fields and parameters.

Related Topics

Specifying the Solver Type

Selecting Objects and Faces in the 2D Geometry
Before creating a boundary or excitation, youmust specify its location by selecting the object or
surface on which to assign the boundary condition or source excitation.

Defining Boundary Conditions in 2D
To assign a boundary condition:

1. Select the section of the geometry on which you want to apply the boundary condition.
2. ClickMaxwell 2D>Boundaries>Assign, or right-clickBoundaries in the project tree and

clickAssign.
3. Select the desired boundary type from the sub-menu. The specific boundary types you can

define depend on the solver you have chosen for your project.
l Magnetostatic Boundary Conditions
l Electrostatic Boundary Conditions
l AC Conduction (Electric) Boundary Conditions
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l DC Conduction (Electric) Boundary Conditions
l EddyCurrent Boundary Conditions
l 2D Transient Boundary Conditions

4. Enter the name for the boundary or accept the default.
5. Depending on the boundary type, youmay need to define additional parameters.
6. ClickOK to create the new boundary.

The new boundary is added to the boundary list in the project tree.

Defining 2D Excitations
The specific excitations you can define depend on the solver you have chosen for your design.

l Magnetostatic Excitations
l Electrostatic (Electric) Excitations
l AC Conduction (Electric) Excitations
l DC Conduction (Electric) Excitations
l EddyCurrent Excitations
l 2D Transient Excitations

To assign an excitation:
1. Select the section of the geometry on which you want to apply the excitation.
2. ClickMaxwell 2D>Excitations>Assign, or right-clickExcitations in the project tree and

clickAssign.
A submenu appears with choices that depend upon the solver type.

3. Select one of the following excitation types from the submenu:
l Voltage
l Charge
l Floating
l Charge Density
l Current Density
l Current
l Coil
l EndConnection
l Permanent Magnet Field

4. Enter the name for the excitation type or accept the default.
5. Enter the desired parameter values, units, and other settings for the excitation in the dialog.

You can also enter amathematical function to determine values for voltage, current density,
charge density, and other parameters. The Permanent Magnet Field excitation also requires
you set up a link to a source project.
Note When entering current, or coil terminals, the arrow associated with current in the

selected object shows the direction as if a positive value is entered for the current. If
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a negative value is entered the actual current flow direction is opposite to what the
arrow shows. ClickSwap Direction if you want to reverse the direction of the
arrow.

6. ClickOK to create the new excitation.
The new excitation is added to the excitation list in the project tree.

Related Topics

Specifying the Solver Type

Viewing 2D Boundaries and Excitations
To view a list of all boundaries or excitations set for the design:

1. In the project tree, right-clickBoundaries or Excitations.
A shortcut menu appears.

2. Select List from the shortcut menu.
TheDesign List dialog box appears, with the tab page visible for the item you selected. This
dialog box contains tabs forModel,Boundaries, Excitations, Parameters,Mesh
Operations, andAnalysis Setup.

3. To view the properties for an item in the list, select the item, and clickProperties.
4. To delete an item from the list, select the item, and clickDelete.
5. When you are finished in theDesign List dialog box, clickDone to close it.

Setting the Visibility for 2D Boundaries and Excitations

To show or hide a boundary:
1. ClickView>Active View Visibility.

TheActive View Visibility dialog box appears.
2. Click the Boundaries tab.
3. Select or clear theVisibility check box for each boundary listed.
4. ClickDone.

To show or hide a excitation:
1. ClickView>Active View Visibility.

TheActive View Visibility dialog box appears.
2. Click the Excitations tab.
3. Select or clear theVisibility check box for each excitation listed.
4. ClickDone.
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Functional Boundaries and Excitations in 2D
Functional boundaries and excitations can be used to do the following:

l Define the value of a boundary or excitation quantity (such as the voltage, magnetic field, or
current density) using amathematical relationship— such as one relating its value to that of
another quantity.

l Define the value of a boundary or excitation as a function of position.
l Current Density Excitation (Magnetostatic or EddyCurrent solver type)
l Voltage Excitation (Electric solver types)
l VolumeCharge Density Excitation (Electrostatic or Electrostatic + DC solver types)

l If the parametric analysis capability is installed, identify which boundary or excitation quantities
are to be varied during a parametric sweep. These variables are always set to constant values
in the parametric analysis.

Setting Eddy Effects and Displacement Current in 2D
(2D EddyCurrent and/or Transient Solvers)
For both eddy current and transient solvers in 2D, youmay need to specify the following additional
settings:

l The behavior of eddy currents and the AC magnetic field in conductors. When you activate the
Eddy Effect setting, the solver computes the induced eddy currents.

l For 2D Transient, source settings override the eddy effect settings. Objects assigned as
“solid” sourceswill have eddy effects turned on, while objects assigned as “stranded” sources
will have eddy effects turned off (regardless of the eddy effect settings). The eddy effect
settingswill be respected for non-sources.

Typically, background objects are excluded from eddy current settings.
To set eddy effects:

1. Select the section of the geometry on which you want to apply the excitation.
2. ClickMaxwell2D>Excitations>Set Eddy Effects.

TheSet Eddy Effect dialog box appears showing only objects which are valid for eddy effect
calculation, specifically objects with conductivity greater than 1.

3. For each object in the list, select or clear the check boxes for Eddy Effect. When selecting
multiple entries, the changes are synchronized for all selected rows.
Note Multi-select is supported by holding theCTRL or Shift keywhile

clicking.

4. Click theSelect By Name button to enter the name of a specific object for selection. Multiple
objectsmay be selected using the * and ? wildcards.

5. Optionally, click theUse suggested values button to set theEddy Effects for all elements
recommended byMaxwell2D.

6. ClickOK.
TheDeselect All button will deselect all selected objects in the list.
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Related Topics

Technical Notes:EddyCurrent Field Simulation
Technical Notes: Transient Simulation

Modifying 2D Boundary Conditions and Excitations
Save your project beforemodifying boundary conditions and excitations. You canmodify boundary
conditions and excitations after a solution has been generated, but youmay lose some solution data.

Related Topics

Duplicating 2D Boundaries and Excitations
Setting Default Values for 2D Boundaries and Excitations
Reassigning 2D Boundaries
Reassigning 2D Excitations

Duplicating 2D Boundaries and Excitations

To duplicate a boundary or excitation when its geometry is pasted or duplicated:
1. ClickTools>Options>Maxwell 2D Options.

TheMaxwell 2D Options dialog box appears.
2. Click theGeneral Options tab.
3. SelectDuplicate boundaries with geometry.
4. ClickOK.

All boundaries and excitations are duplicated with their associated geometries until you clear
this option.

Hint Use this option to copy and paste boundaries.
For example, do the following to use the same boundary onmultiple objects:
1. Select the face to which you want to assign the boundary.
2. ClickModeler>Surface>Create Object From Face to create a new object from the

existing face.
3. Assign the boundary to the new face object.
4. Copy and paste the new face object to copy and paste the boundary.

Related Topics

Copying and Pasting Objects
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Showing and Hiding Boundaries and Excitations in 2D

You can choose to show or hide a boundary or excitation's geometry, name, or vectors, in the active
view window or in all view windows.

Related Topics

Showing and Hiding 2D Boundaries/Excitations in Every View Window

Showing and Hiding 2D Boundaries and Excitations in Every View Window

1. ClickMaxwell 2D>Boundaries>Visualization orMaxwell
2D>Excitations>Visualization.
TheBoundary Visualization Options dialog box appears.

2. Select one of the following from theSelect pull-downmenu:
l All
l All Boundaries
l All Excitations
l ByName

3. If you selectBy Name, enter a name in theSelect By Name dialog box, and clickOK.
4. To clear the selection of all boundaries and excitations, clickDeselect All.
5. ClickClose to close theBoundary Visualization Options dialog box.

Setting Default Values for 2D Boundaries and Excitations

When assigning a boundary or excitation, many of the fields in the boundary and excitation dialog
boxes have default values associated with them. These default values are initially set byMaxwell
2D, but can be overridden.
Tomodify the default values associated with a specific boundary or excitation type:

1. Assign a boundary or excitation.
2. Modify any default values.
3. Close the boundary or excitation's dialog box.
4. Re-open the new boundary or excitation's dialog box by right-clicking the boundary or

excitation in the project manager and selectingProperties. The dialog now includes a
Defaults tab.

5. Under theDefaults tab, clickSave Defaults.
The values assigned to this boundary are saved as the default values and are assigned when
new boundaries of this type are created.

6. Optionally, clickRevert to Standard Defaults.
The default values you set for this boundary type are cleared and will revert to the default
values set byMaxwell 2D.
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Reassigning 2D Boundaries

You can reassign a boundary to another surface. This is useful when youmodify objects with
assigned boundaries, invalidating the boundaries. For example, if you unite two objects with
assigned boundaries, the second object's boundary becomes invalid because united objects
maintain the characteristics of the first object selected. In this case, you would need to reassign the
boundary or delete it.
To reassign a boundary:

1. Select the object or object face to which you want to assign an existing boundary.
2. ClickMaxwell 2D>Boundaries>Reassign.

TheReassign Boundary dialog box appears.

Hint Alternatively, select the object or object face to which you want to assign an existing
boundary. Right-click the existing boundary in the project tree, and then click
Reassign on the shortcut menu.

3. Select the boundary you want to reassign, and clickOK.
Note When reassigning a boundary that includes vectors in its definition, Maxwell

attempts to preserve the vectors with the new assignment, but this is not always
possible.

Related Topics

Reassigning 2D Excitations

Reassigning 2D Excitations

To reassign an excitation:
1. Select the object or object face to which you want to assign an existing excitation.
2. ClickMaxwell 2D>Excitations>Reassign.

TheReassign Excitation dialog box appears.

Hint Alternatively, select the object or object face to which you want to assign an existing
excitation. Right-click the existing excitation in the project tree, and then click
Reassign on the shortcut menu.

3. Select the excitation you want to reassign, and clickOK.
Note When reassigning an excitation that includes vectors in its definition, Maxwell

attempts to preserve the vectors with the new assignment, but this is not always
possible.

Related Topics

Reassigning 2D Boundaries
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Deleting All 2D Boundaries and/or Excitations

To delete all boundaries or excitations:
l ClickMaxwell 2D>Boundaries>Delete All orMaxwell 2D>Excitations>Delete All.

Viewing and Editing 2D Boundary or Excitation Properties

To open theProperties dialog box for a boundary or excitation that is already assigned:
1. In the project tree, under eitherBoundaries or Excitations, right-click a specific boundary or

excitation, and selectProperties.
TheProperties dialog box for that boundary/excitation appears.

2. Make the desired changes, and clickOK.

Related Topics

Assigning Boundaries and Excitations for 2D Designs
Modifying 2D Boundary Conditions and Excitations

2D Magnetostatic Boundaries and Excitations
Define at least one of the following as a source of staticmagnetic fields:

l The current in a conduction path, which can be either stranded or solid.
l The current density in a conductor.
l Themagnetic field on an outside surface.

Related Topics

2D Magnetostatic Boundaries
2D Magnetostatic Excitations
Technical Notes: Magnetostatic Field Calculation
Specifying the Solver Type
Permanent Magnet Excitations

2D Magnetostatic Boundaries

Themagnetostatic field solver allows you to define the following types of boundaries:

Boundary
Type H-Field Behavior Used to model...

Default
Boundary

Field behaves as follows:
l At the interface between objects, the

Initially, object interfaces are natural
boundaries; outer boundaries, and
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Conditions
(Natural
and
Neumann)

H tangent and B normal are
continuous.

l On outer boundaries, B field is
normal. As a rule, this behavior needs
to bemodified at least for some
portions of the outer boundary to
insure uniqueness of the solution.

excluded objects are Neumann
boundaries.

Vector
Potential

Sets themagnetic vector potential , or
, on the boundary. The behavior of H

depends on whether or is
constant or functional.

Outer boundaries at specific vector
potentials; externally appliedmagnetic
fields.

Balloon This boundary is considered to be far away
from the other sources in the problem.

Actual behavior is context dependent. In
general, if a Dirichlet BC is not applied
elsewhere to insure uniqueness, the
"balloon" will be assigned a Dirichlet
boundary condition.

Symmetry Field behaves as follows:
l Odd Symmetry (Flux Tangential) —
Magnetic Field is tangential to the
boundary; its normal components are
zero.

l Even Symmetry (Flux Normal) —
Magnetic Field is normal to the
boundary; its tangential components
are zero.

Planes of geometric andmagnetic
symmetry.

Master and
Slave
(Matching)

TheMagnetic Field vector on the slave
boundary is forced tomatch themagnitude
and direction (or the negative of the
direction) of theMagnetic Field vector on
themaster boundary.

Planes of symmetry in periodic
structureswhereMagnetic Field is
oblique to the boundary.

Default Boundary Conditions for a 2D Magnetostatic Solver

These boundary conditions are automatically defined for amagnetostaticmodel:
l Natural boundaries are assigned to the surfaces between objects. At the interface between
objects, the H tangent and B normal are continuous.

l Neumann boundaries are assigned to the outside edges of the problem region. On outer
boundaries, B field is normal. As a rule, this behavior needs to bemodified at least for some
portions of the outer boundary to insure uniqueness of the solution.

To leave a surface set to its default boundary condition, do nothing. Deleted boundary conditions and
excitations automatically reset to the default boundary conditions.
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Assigning a Vector Potential for a 2D Magnetostatic Solver

To define a vector potential boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically an edge).Maxwell2D requires that the Vector Potential be assigned on a 1D object
such as an edge or a line.

2. ClickMaxwell2D>Boundaries>Assign>Vector Potential.
TheVector Potential Boundary dialog box appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. In theParameters section, enter the value of the potential. The valuemay be specified as a

single numeric value or a functional value.
5. If a functional value is specified, select aCoordinate System from the pull-down list:
6. Optionally, clickUse Defaults to revert to the default values in the dialog box.
7. ClickOK to assign the boundary to the selected object.

The new boundary is added to the boundary list in the project tree.

Assigning a Symmetry Boundary Condition for a 2D Magnetostatic Solver

This boundary condition defines a plane of geometric or magnetic symmetry in a structure. Assign it
only to the outer surfaces of the problem region.
To set a symmetry boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically an edge).

2. ClickMaxwell2D>Boundaries>Assign>Symmetry.
TheSymmetry Boundary dialog box appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Select one of the following as the type of symmetry:

Odd
(Flux
Tangential)

Magnetic Field is tangential to the boundary; its normal components
are zero.

Even
(Flux Normal)

Magnetic Field is normal to the boundary; its tangential components
are zero.

5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the boundary to the selected object.

Assigning a Balloon Boundary Condition for a 2D Magnetostatic Solver

To set a balloon boundary:

Assigning Boundaries and Excitations for 2D Designs 12-10
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

1. Select the section of the geometry on which you want to apply the boundary condition
(typically an edge).

2. ClickMaxwell2D>Boundaries>Assign>Balloon.
TheBalloon Boundary dialog box appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

Assigning a Master Boundary for a 2D Magnetostatic Solver

Master and slave boundaries enable you tomodel planes of periodicity where theMagnetic Field at
every point on the slave boundary surface is forced tomatch theMagnetic Field of every
corresponding point on themaster boundary surface.
To set amaster boundary:

1. Select the edge to which you want to assign themaster boundary.
2. ClickMaxwell2D>Boundaries>Assign>Master.

TheMaster Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. To reverse the direction of the vector, select theSwap Direction check box.
5. ClickOK.

Assigning a Slave Boundary for a 2D Magnetostatic Solver

Assigning a slave boundary is the second step in creatingmatching boundaries. The field on the
master boundary ismapped to the slave boundary.

Note Youmust define amaster boundary before creating the slave boundaries that are
associated with it. Assign slave boundaries only to the outer surfaces of the problem
region.

To set a slave boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically an edge).
2. ClickMaxwell2D>Boundaries>Assign>Slave.

TheSlave Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. Select themaster boundary to which the slave is to be assigned from theMaster Boundary

pull-down list.
5. In theRelation section, select one of the following to specify the field behavior on the

boundary:

Bs
=

Click this radio button if themagnetic fields on the slave andmaster boundaries have
the samemagnitude and direction.
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Bm
Bs
= -
Bm

Click this radio button if themagnetic fields on the slave boundary have the same
magnitude as but the opposite direction from themaster boundary.

6. Optionally, clickUse Defaults to revert to the default values in the dialog box.
7. ClickOK to assign the boundary to the selected object.

2D Magnetostatic Excitations

The following excitations of magnetic fields are available for magnetostatic problems:

Excitation Type of Excitation
Current
Density

The known current density distribution in the cross-section of a
conductor.

Current The total current in a conductor.

In addition, permanent magnetsmaterials serve as sources of magnetic fields.

Assigning a Current Density Excitation for a 2D Magnetostatic Solver

This command (depending upon solution type, either X-Y orR-Z) specifies the applicable
components of the current density in the cross-section of an object. If the current density is a function
of position, the value is entered in ampere/m2, even if you change the units in the problem.
To define the current density:

1. Select the section of the geometry (i.e., the conductor) on which you want to apply the
excitation (typically a 2D object).

2. ClickMaxwell2D>Excitations>Assign>Current Density.
TheCurrent Density Excitation dialog box appears.

3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, specify the following options:

a. Enter a value for the current density in theValue box. The valuemay be a single numeric
quantity or a functional quantity.

b. If a functional quantity is entered in theValue box, which depends on the applicable
coordinates, select aCoordinate System from the pull-down list.

5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the excitation to the selected object.
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Assigning a Current Excitation for a 2D Magnetostatic Solver

Specifies the total current in the cross-section of an object.
To set a current excitation:

1. Select the section of the geometry (i.e., the conductor) on which you want to apply the
excitation (typically a face or other 2D planar object).

2. ClickMaxwell2D>Excitations>Assign>Current.
TheCurrent Excitation dialog box appears.

3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, specify the following options:

a. Enter a value for the current in theValue box, and select the units from the pull-down list.
b. SelectPositive orNegative as theRef. Direction.

5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the excitation to the selected object.

2D Electrostatic Boundaries and Excitations
Specify at least one of the following excitations as a source of electric fields:

l The charge on a surface or object.
l The charge density inside an object.
l Define the electric potential on each surface and object using a voltage excitation.

Include at least one of the following as a reference for computing the electric potential:
l A voltage excitation.
l An odd symmetry (flux normal) boundary.

Related Topics

2D Electrostatic Boundaries
2D Electrostatic Excitations
Technical Notes: Electric Field Calculation
Specifying the Solver Type

2D Electrostatic Boundaries

The following boundary conditions are available for electrostatic problems:

Boundary
Type E-Field Behavior Used to model...

Default
Boundary

Field behaves as follows:
l Natural boundaries— The normal

Ordinary E-field behavior on boundaries.
Object interfaces are initially set to natural
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Conditions
(Natural
and
Neumann)

component ofD changes by the
amount of surface charge density,
tangent component of E is
continuous. No special conditions
are imposed.

l Neumann boundaries— E is
tangential to the boundary. Flux
cannot cross a Neumann boundary.

boundaries; outer boundaries are initially
set to Neumann boundaries.

Symmetry Field behaves as follows:
l Even Symmetry (Flux Tangential)
— E is tangential to the boundary;
its normal components are zero.

l Odd Symmetry (Flux Normal) — E
is normal to the boundary; its
tangential components are zero.

Planes of geometric and electrical
symmetry.

Balloon Two options are available:
Charge— The charge at “infinity”
balances the charge in the drawing
region. The net charge is zero.
(Use for capacitance calculations)

Voltage— The voltage at “infinity” is
zero.

Electrically insulated structures (Charge
option) or electrically grounded structures
(Voltage option). For the voltage case, the
balloon boundary will not be equipotential
in general.

Master and
Slave
(Matching)

The E-field vector on the slave boundary
is forced tomatch themagnitude and
direction (or the negative of the direction)
of the E-field vector on themaster
boundary.

Planes of symmetry in periodic structures
whereE is oblique to the boundary.

Default Boundary Conditions for a 2D Electrostatic Solver

These boundary conditions are automatically defined for an electrostaticmodel:
l Natural boundaries are assigned to the interfaces between objects. The normal component of
D changes by the amount of surface charge density, tangent component of E is continuous.

l Neumann boundaries are assigned to the outside edges of the problem region.E is tangential
to the boundary. Flux cannot cross a Neumann boundary.

To leave a surface set to its default boundary condition, do nothing. Deleted boundary conditions and
excitations automatically revert to the default boundary conditions.
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Assigning a Symmetry Boundary Condition for a 2D Electrostatic Solver

This boundary condition defines a plane of geometric or electric symmetry in a structure. Assign it
only to the outer surfaces of the problem region.
To set a symmetry boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically an edge).

2. ClickMaxwell2D>Boundaries>Assign>Symmetry.
TheSymmetry Boundary dialog box appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Select one of the following as the type of symmetry:

Odd
(Flux Normal)

E is normal to the boundary; its tangential components are
zero.

Even
(Flux
Tangential)

E is tangential to the boundary; its normal components are
zero.

5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the boundary to the selected object.

Assigning a Balloon Boundary Condition for a 2D Electrostatic Solver

To set a balloon boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically an edge).
2. ClickMaxwell2D>Boundaries>Assign>Balloon.

TheBalloon Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. SelectVoltage orCharge as theBalloon Type.
5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the boundary to the selected object.

Assigning a Master Boundary for a 2D Electrostatic Solver

Master and slave boundaries enable you tomodel planes of periodicity where the E-field vector at
every point on the slave boundary surface is forced tomatch the E-field vector of every
corresponding point on themaster boundary surface. The transformation used tomap the E-field
from themaster to the slave is determined by specifying the orientation of a local, predefined
coordinate system, indicated by an arrow, on both themaster and slave boundaries.
To set amaster boundary:
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1. Select the edge to which you want to assign themaster boundary.
2. ClickMaxwell2D>Boundaries>Assign>Master.

TheMaster Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. To reverse the direction of the vector, select theSwap Direction check box.
5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK.

Assigning a Slave Boundary for a 2D Electrostatic Solver

Assigning a slave boundary is the second step in creatingmatching boundaries. The field on the
Master boundary ismapped to the slave boundary.

Note Youmust define aMaster boundary before creating the slave boundaries that are
associated with it. Assign slave boundaries only to the outer surfaces of the problem
region.

To set a slave boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically an edge).
2. ClickMaxwell2D>Boundaries>Assign>Slave.

TheSlave Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. Select themaster boundary to which the slave is to be assigned from theMaster Boundary

pull-down list.
5. In theRelation section, select one of the following to specify the field behavior on the

boundary:

Es =
Em

Click this radio button if the slave andmaster boundaries have the samemagnitude
and direction.

Es =
-Em

Click this radio button if the slave boundary field has the samemagnitude as but the
opposite direction from themaster boundary field.

6. Optionally, clickUse Defaults to revert to the default values in the dialog box.
7. ClickOK to assign the boundary to the selected object.

2D Electrostatic Excitations

The following excitations are available for electrostatic problems:

Excitation Type of Excitation
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Voltage The DC voltage on a surface or object.

Charge The total charge on a surface or object.

Floating Used tomodel conductors at unknown
potentials.

Charge
Density

The charge density over an object (dielectric).

Assigning a Voltage Excitation for a 2D Electrostatic Solver

Voltage excitations are identical to voltage boundaries in previous versions of Maxwell. A voltage
excitation can be assigned to any surfaces or 2D objects. These assignments could include spatial
functions.
This type of excitation sets the electric potential to a specific value.
To set a voltage excitation:

1. Select the section of the geometry on which you want to apply the excitation.
2. ClickMaxwell2D>Excitations>Assign>Voltage.

TheVoltage Excitation dialog box appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the electric potential in theValue box, and select the units

from the pull-down list. You can enter a numerical value, parameter (design or project
variable) or a spatial function.

5. For a spatial function, select a coordinate system from theCoordinate System pull-down list.

6. Optionally, clickUse Defaults to revert to the default values in the dialog box.
7. ClickOK to assign the excitation to the selected object.

Assigning a Charge Excitation for a 2D Electrostatic Solver

This type of excitation defines the total charge on a surface or object. The potential distribution on the
object with charge excitation is computed during the solution.
To define a charge excitation:

1. Select the section of the geometry on which you want to apply the excitation.
2. ClickMaxwell2D>Excitations>Assign>Charge.

TheCharge Excitation dialog box appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the numerical value, parameter (design or project variable)

or a spatial function in theValue box.
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5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the excitation to the selected object.

Assigning a Floating Excitation for a 2D Electrostatic Solver

This type of excitationmodels conductors at unknown potentials and specifies the total charge on the
conductor.
To define a floating conductor:

1. Select the section of the geometry on which you want to apply the excitation. This can be a 2D
or 1D geometry entity. If it is a 2D object, it doesn’t have to be a conductor (but it will behave
like one when the solution becomes available).

2. ClickMaxwell2D>Excitations>Assign>Floating.
The Floating Excitation dialog box appears.

3. Click theGeneral tab.
4. Enter a name for the excitation in theName box, or accept the default.
5. In theParameters section, enter the charge value or parameter in theValue box.
6. Optionally, clickUse Defaults to revert to the default values in the dialog box. You can also

click theDefaults tab to save new default settings or to revert to the standard default values.
7. ClickOK to assign the excitation to the selected object.

Assigning a Charge Density Excitation for a 2D Electrostatic Solver

This type of excitation defines the volume charge density on an object.
To define the charge density on a dielectric object:

1. Select the object on which you want to apply the excitation.
2. ClickMaxwell2D>Excitations>Assign>Charge Density.

TheCharge Density Excitation dialog box appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the charge density in theValue box. You can enter a

numerical value, parameter (design or project variable) or a spatial function.
5. For a spatial function, select the type of coordinate system from theCoordinate System pull-

down list.
6. Optionally, clickUse Defaults to revert to the default values in the dialog box.
7. ClickOK to assign the excitation to the selected object.

2D AC Conduction Boundaries and Excitations
The following excitations can be specified as the source of electric fields:
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l The voltage difference between surfaces and objects. Define the electric potential on each
surface and object using a voltage excitation.

Include at least one of the following as a reference for computing the electric potential:
l A voltage excitation.
l An odd symmetry (flux normal) boundary.

Related Topics

2D AC Conduction Boundaries
2D AC Conduction Excitations
Technical Notes: AC Conduction Field Calculation
Specifying the Solver Type

2D AC Conduction Boundaries

The following boundary conditions are available for AC conduction electric problems:

Boundary
Type E-Field Behavior Used to model...

Default
Boundary
Conditions
(Natural
and
Neumann)

Field behaves as follows:
l Natural boundaries - The normal component
of J and the tangential component of E are
continuous across discontinuity surfaces. No
special conditions are imposed.

l Neumann boundaries - E and J vectors are
tangential to the boundary. Flux cannot cross
a Neumann boundary.

Object interfaces are initially set
to natural boundaries; outer
boundaries are initially set to
Neumann boundaries.

Symmetry Field behaves as follows:
l Even Symmetry (Flux Tangential) - E and J
vectors are tangential to the boundary; its
normal components are zero.

l Odd Symmetry (Flux Normal) - E and J
vectors are normal to the boundary; its
tangential components are zero.

Planes of geometric and
electrical symmetry.

Balloon Balloon boundariesmodel the region outside the
drawing space as being nearly “infinitely” large—
effectively isolating themodel from other voltage
sources.

Electrically insulated structures,
equipotential lines can cross this
type of boundary. In general,
they are neither tangent nor
perpendicular to the balloon
boundary.

Master
and Slave

The E-field on the slave boundary is forced to
match themagnitude of the E-field on themaster

Planes of symmetry in periodic
structureswhereE is oblique to
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(Matching)
boundary if the "plus" sign is used. If the "minus"
sign is used, the field on the Slave boundary will
oscillate with opposite phase angle (180 degrees
phase shift).

the boundary.

Default Boundary Conditions for a 2D AC Conduction Solver

These boundary conditions are automatically defined for a AC conductionmodel:
l Natural boundaries are assigned to the surfaces between objects. The normal component of J
and the tangential component of E are continuous across discontinuity surfaces.

l Neumann boundaries are assigned to the outside edges of the problem region.E and J
vectors are tangential to the boundary. Flux cannot cross a Neumann boundary.

To leave a surface set to its default boundary condition, do nothing. Deleted boundary conditions and
excitations automatically revert to the default boundary conditions.

Assigning a Symmetry Boundary Condition for a 2D AC Conduction Solver

This boundary condition defines a plane of geometric or electric symmetry in a structure. Assign it
only to the outer surfaces of the problem region.
To set a symmetry boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically an edge).

2. ClickMaxwell2D>Boundaries>Assign>Symmetry.
TheSymmetry Boundary dialog box appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Select one of the following as the type of symmetry:

Odd
(Flux Normal)

Voltages have opposite sign on the two sides of the symmetry
plane.

Even
(Flux
Tangential)

Voltages have same sign on the two sides of the symmetry plane.

5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the boundary to the selected object.

Assigning a Balloon Boundary Condition for a 2D AC Conduction Solver

To set a balloon boundary:
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1. Select the section of the geometry on which you want to apply the boundary condition
(typically an edge).

2. ClickMaxwell2D>Boundaries>Assign>Balloon.
TheBalloon Boundary dialog box appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

Assigning a Master Boundary for a 2D AC Conduction Solver

Master and slave boundaries enable you tomodel planes of periodicity where theE-field at every
point on the slave boundary surface is forced tomatch theE-field of every corresponding point on the
master boundary surface.
To set amaster boundary:

1. Select the edge to which you want to assign themaster boundary.
2. ClickMaxwell2D>Boundaries>Assign>Master.

TheMaster Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. To reverse the direction of the vector, select theSwap Direction check box.
5. ClickOK.

Maxwell computes the E-field on this boundary andmaps it to the slave boundary.

Assigning a Slave Boundary for a 2D AC Conduction Solver

Assigning a slave boundary is the second step in creatingmatching boundaries. The field on the
Master boundary ismapped to the slave boundary.

Note Youmust define aMaster boundary before creating the slave boundaries that are
associated with it. Assign slave boundaries only to the outer surfaces of the problem
region.

To set a slave boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically an edge).
2. ClickMaxwell2D>Boundaries>Assign>Slave.

TheSlave Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. In theParameters section, select themaster boundary to which the slave is to be assigned

from theMaster Boundary pull-down list.
5. UnderRelation, select one of the following to specify the field behavior on the boundary:

Es =
Em

Click this radio button if the slave andmaster boundaries have the samemagnitude
and oscillate in phase.
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Es =
-Em

Click this radio button if the slave boundary field has the samemagnitude as the
master boundary field and oscillate 180 degrees out of phase.

6. To reverse the direction of the vector, select theSwap Direction check box.
7. Optionally, clickUse Defaults to revert to the default values in the dialog box.
8. ClickOK to assign the boundary to the selected object.

2D AC Conduction Excitations

The following excitations are available for electric AC conduction problems:

Excitation Type of Excitation
Voltage The AC voltage on a surface or object. This excitation type is available for all three of

the electric solvers.

Note All field quantities oscillate with the same frequency, equal to the frequency specified in the
solution setup. The phase of quantities computed in the solution space however will be
different in general.

Assigning a Voltage Excitation for a 2D AC Conduction Solver

This type of excitation sets the electric potential (voltage) on a surface or object to a specific value.
To set a voltage excitation:

1. Select the section of the geometry on which you want to apply the excitation.
2. ClickMaxwell2D>Excitations>Assign>Voltage.

TheVoltage Excitation dialog box appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the electric potential in theValue box, and select the units

from the pull-down list. You can enter a numerical value or a spatial function.
5. For a spatial function, select a coordinate system from theCoordinate System pull-down list.

6. Enter a value in thePhase text box, and select a unit from the pull-down list.
7. Optionally, clickUse Defaults to revert to the default values in the dialog box.
8. ClickOK to assign the excitation to the selected object.

2D DC Conduction Boundaries and Excitations
The following excitations can be specified as the source of electric fields:
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l The voltage difference between surfaces and objects. Define the electric potential on each
surface and object using a voltage excitation.

Include at least one of the following as a reference for computing the electric potential:
l A voltage excitation.
l An odd symmetry (flux normal) boundary.

Related Topics

2D DC Conduction Boundaries
2D DC Conduction Excitations
Technical Notes: DC Conduction Field Calculation
Specifying the Solver Type

2D DC Conduction Boundaries

The following boundary conditions are available for DC conduction electric problems:

Boundary
Type E-Field Behavior Used to model...

Default
Boundary
Conditions
(Natural and
Neumann)

Field behaves as follows:
l Natural boundaries— Normal component
of J and tangential component of E are
continuous across discontinuity surfaces.
No special conditions are imposed.

l Neumann boundaries— E and J vectors
are tangential to the boundary. Flux cannot
cross a Neumann boundary.

Object interfaces are initially set
to natural boundaries; outer
boundaries are initially set to
Neumann boundaries.

Symmetry Field behaves as follows:
l Even Symmetry (Flux Tangential) — E and

J vectors are tangential to the boundary;
their normal components are zero.

l Odd Symmetry (Flux Normal) — E and J
vectors are normal to the boundary; their
tangential components are zero.

Planes of geometric and
electrical symmetry.

Balloon Balloon boundariesmodel the region outside the
drawing space as being nearly “infinitely” large
— effectively isolating themodel from other
voltage sources.

Electrically insulated structures.

Resistance A resistance boundarymodels a very thin layer of
resistivematerial (such as that caused by
deposits, coatings or oxidation on ametallic
surface) on a conductor at a known potential.

Use this boundary condition
when the resistive layer’s
thickness ismuch smaller than
the other dimensions of the
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model.
Master and
Slave
(Matching)

TheE-field on the slave boundary is forced to
match themagnitude and direction (or the
negative of the direction) of theE-field on the
master boundary.

Planes of symmetry in periodic
structureswhereE is oblique to
the boundary.

Default Boundary Conditions for a 2D DC Conduction Solver

These boundary conditions are automatically defined for a DC conductionmodel:
l Natural boundaries are assigned to the surfaces between objects. Normal component of J
and tangential component of E are continuous across discontinuity surfaces. No special
conditions are imposed.

l Neumann boundaries are assigned to the outside edges of the problem region.E and J
vectors are tangential to the boundary. Flux cannot cross a Neumann boundary.

To leave a surface set to its default boundary condition, do nothing. Deleted boundary conditions and
excitations automatically revert to the default boundary conditions.

Assigning a Symmetry Boundary Condition for a 2D DC Conduction Solver

This boundary condition defines a plane of geometric or electric symmetry in a structure. Assign it
only to the outer surfaces of the problem region.
To set a symmetry boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically an edge).

2. ClickMaxwell2D>Boundaries>Assign>Symmetry.
TheSymmetry Boundary dialog box appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Select one of the following as the type of symmetry:

Odd
(Flux Normal)

Voltages have opposite signs on the two sides of the symmetry
plane.

Even
(Flux
Tangential)

Voltages have same signs on the two sides of the symmetry plane.

5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the boundary to the selected object.
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Assigning a Balloon Boundary Condition for a 2D DC Conduction Solver

To set a balloon boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically an edge).
2. ClickMaxwell2D>Boundaries>Assign>Balloon.

TheBalloon Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

Assigning a Resistance Boundary Condition for a 2D DC Conduction Solver

To set a resistance boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically a face).

2. ClickMaxwell2D>Boundaries>Assign>Resistance.
TheResistance Boundary dialog box appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. In theParameters section, do the following:

a. Enter theConductivity.
b. Enter the Thickness, and select a unit.
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c. Enter aVoltage, and select a unit.
d. Select aCoordinate System from the pull-down list if any of the fields contain an intrinsic

spatial variable such as X, Y or Z.
5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the boundary to the selected object.

Note The resistive boundary condition should only be applied on the outer edges of the
solution space. The net effect of this condition is that of an anisotropicmaterial with
the assigned value of conductivity in direction normal to the edge carrying it and zero
in the tangential direction.

Assigning a Master Boundary for a 2D DC Conduction Solver

Master and slave boundaries enable you tomodel planes of periodicity where theE-field at every
point on the slave boundary surface is forced tomatch theE-field of every corresponding point on the
master boundary surface.
To set amaster boundary:

1. Select the edge to which you want to assign themaster boundary.
2. ClickMaxwell2D>Boundaries>Assign>Master.

TheMaster Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. To reverse the direction of the vector, select theSwap Direction check box.
5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK.

Assigning a Slave Boundary for a 2D DC Conduction Solver

Assigning a slave boundary is the second step in creatingmatching boundaries. The field on the
master boundary ismapped to the slave boundary.

Note Youmust define aMaster boundary before creating the slave boundaries that are
associated with it. Assign slave boundaries only to the outer surfaces of the problem
region.

To set a slave boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically an edge).
2. ClickMaxwell2D>Boundaries>Assign>Slave.

TheSlave Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. Select themaster boundary to which the slave is to be assigned from theMaster Boundary

pull-down list.
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5. In theRelation section, select one of the following to specify the field behavior on the
boundary:

Es
=
Em

Click this radio button if theE field on the slave andmaster boundaries have the
samemagnitude and direction.

Es
= -
Em

Click this radio button if theE field on the slave boundary field has the same
magnitude as but the opposite direction from themaster boundary field.

6. Optionally, clickUse Defaults to revert to the default values in the dialog box.
7. ClickOK to assign the boundary to the selected object.

2D DC Conduction Excitations

The following excitations are available for electric DC conduction problems:

Excitation Type of Excitation
Voltage The DC voltage on a surface or

object.

Assigning a Voltage Excitation for a 2D DC Conduction Solver

This type of excitation sets the electric potential (voltage) on a surface or object to a specific value.
To set a voltage excitation:

1. Select the section of the geometry on which you want to apply the excitation.
2. ClickMaxwell2D>Excitations>Assign>Voltage.

TheVoltage Excitation dialog box appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the electric potential in theValue box, and select the units

from the pull-down list. You can enter a numerical value or a spatial function.
5. For a spatial function, select a coordinate system from theCoordinate System pull-down list.

6. Optionally, clickUse Defaults to revert to the default values in the dialog box.
7. ClickOK to assign the excitation to the selected object.

2D Eddy Current Boundaries and Excitations
Specify at least one of the following as a source of AC magnetic fields in your model:
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l The current in the cross-section (object), which can be either stranded or solid.
l The current to be divided among several parallel conductors.
l The current density in an object.
l The external magnetic field.

If currents or current densities are the only sources of AC magnetic fields in your model, set at least
one outer boundary to the following:

l The default boundary conditions.
l An odd symmetry (flux tangential) boundary.
l An even symmetry (flux normal) boundary.

Related Topics

2D EddyCurrent Boundaries
2D EddyCurrent Excitations
Technical Notes: EddyCurrent Field Simulation
Specifying the Solver Type

2D Eddy Current Boundaries

The eddy current field solver allows you to define the following types of boundaries:

Boundary
Type H-Field Behavior Used to model…

Default
Boundary
Conditions
(Natural
and
Neumann)

Field behaves as follows:
l Natural boundaries— TangentialH and normalB
are continuous across surfaceswithout current
density distribution; tangentialH has a jump if the
surface has current density distribution.

l Neumann boundaries—Magnetic Field is
tangential to the boundary and flux cannot cross it.

Initially, object interfaces
are natural boundaries;
outer boundaries and
excluded objects are
Neumann boundaries.

Vector
Potential

Sets themagnetic vector potential , or , on the

boundary. The behavior of H depends on whether or
is constant or functional.

Magnetically isolated
structures.

Impedance Includes the effect of induced currents beyond the
boundary surface based on tangent component ofH along
the impedance boundary.

Conductors with very
small skin depths.

Symmetry Field behaves as follows:
l Odd Symmetry (Flux Tangential) —Magnetic Field
is tangential to the boundary; its normal components
are zero.

l Even Symmetry (Flux Normal) —Magnetic Field is

Planes of geometric and
magnetic symmetry.
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Boundary
Type H-Field Behavior Used to model…

normal to the boundary; its tangential components
are zero.

Balloon Models the case where the structure is “infinitely” far away
from other magnetic fields or current sources.

Magnetically isolated
structures.

Master and
Slave
(Matching)

TheMagnetic Field on the slave boundary is forced to
match themagnitude and direction of theMagnetic Field
on themaster boundary. If a 'plus" sign is used, the fields
oscillate in phase, if a minus sign is used the fields will
oscillate 180 degrees out of phase.

Planes of symmetry in
periodic structures
whereMagnetic Field is
oblique to the boundary.

Default Boundary Conditions for the 2D Eddy Current Solver

These boundary conditions are automatically defined for an eddy current model:
l Natural boundaries are assigned to the surfaces between objects. TangentialH and normalB
are continuous across surfaceswithout current density distribution; tangentialH has a jump if
the surface has current density distribution.

l Neumann boundaries are assigned to the outside edges of the problem region.Magnetic
Field is tangential to the boundary and flux cannot cross it.

To leave a surface set to its default boundary condition, do nothing. Deleted boundary conditions and
excitations automatically reset to the default boundary conditions.

Assigning a Vector Potential for the 2D Eddy Current Solver

To define a vector potential boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically an edge).
2. ClickMaxwell2D>Boundaries>Assign>Vector Potential.

TheVector Potential Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. In theParameters section, enter the value of the potential. The valuemay be specified as a

single numeric value or as a spatial function.
5. If a functional value is specified, select aCoordinate System from the pull-down list:
6. Enter a value in thePhase text box, and select a unit from the pull-down list.
7. Optionally, clickUse Defaults to revert to the default values in the dialog box.
8. ClickOK to assign the boundary to the selected object.

The new boundary is added to the boundary list in the project tree.
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Assigning an Impedance Boundary for the 2D Eddy Current Solver

This boundary condition is used to simulate the effect of induced currents in a conductor without
explicitly computing them. Since the conductor must be excluded in themodel (saving time needed
tomesh and solve for currents), assign the impedance boundary condition to an outside edge of the
problem region or to an excluded object. Exclude the object from the problem region andmake the
object a perfect conductor in theMaterial Manager.
To define an impedance boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically an edge).

2. ClickMaxwell2D>Boundaries>Assign>Impedance.
The Impedance Boundary dialog box appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Enter the conductivity (in inverse ohm-meters) in theConductivity field.
5. Enter the conductor's relative permeability in thePermeability field.
6. Optionally, clickUse Defaults to revert to the default values in the dialog box.
7. ClickOK to assign the boundary to the selected object.

Related Topics

Impedance Boundary

2D Impedance Boundary

Impedance boundaries allow you to simulate the effect of induced currents in a conductor without
explicitly computing them. Use this boundary condition for models where:

l The skin depth in the conductor is less than two orders of magnitude smaller than the
dimensions of the structure. In models like this, themeshmaker may not be able to create a
fine enoughmesh in the conductor to compute eddy currents.

l Themagnetic field decaysmuchmore rapidly inside the conductor in the direction that’s
normal to the surface than it does in directions that are tangential to the surface.

l The AC current source is relatively far away from the surface where eddy currents occur,
compared to the size of the skin depth.

The conductor itself must be excluded from the solution region.When setting up themodel, do one of
the following:

l For external boundaries, when drawing themodel, make the surface along which eddy
currents are to be computed an outer surface of the problem region.

l For internal boundaries: assign a perfect conductor to the object in theMaterial Manager, and
also exclude the object from the solution by uncheckingSolve Inside under the object
attributes. The solver does not find solutions inside a perfect conductor.

Then, when defining boundaries, assign an impedance boundary to the individual surfaces of the
problem region (for external boundaries) or to the entire object (for internal boundaries). By entering
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the conductivity, s, and the relative permeability, µr, of the object, you specify the skin depth of
induced eddy currents. The simulator uses this skin depth value when computing the
electromagnetic field solution. It assumes that theMagnetic Field falls off exponentially inside the
conductor. The ohmic loss due to induced currents can then be computed from theMagnetic
Vector Potential along the impedance boundary - on the surface of the object that you are
interested in - according to the formula below or by using the quantityEdgeLossDensity in the 2D
calculator.

where:

= z component of theMagnetic Vector Potential

= complex conjugate of the z component of theMagnetic Vector Potential

= permeability of free space

= relative permeability of the impedance boundary

= conductivity of the impedance boundary (S/m)
f = frequency (Hz)

Youmay also useEdgeLossDensity to plot the loss along an edge containing an impedance
boundary.

Note An impedance boundary only approximates the effect of eddy currents acting at a shallow
skin depth. It does not directly compute them. In general, the fieldsmodeled using an
impedance boundary will closelymatch the field patterns that would actually occur in the
structure. However, at discontinuities in the surface (such as corners), the field patterns
may be different.

Related Topics

When to Use Impedance Boundaries
Assigning an Impedance Boundary for the 2D EddyCurrent Solver

When to Use Impedance Boundaries in 2D

A typical situation where impedance boundaries can be used to reduce the complexity of amodel is
shown below. Suppose you want to compute eddy current losses in the conductor next to the current
source shown below on the left. If the source carries AC current at a frequency of 1MHz, the skin
depth in the conductor is 6.6 x 10–5meters. This is several orders of magnitude smaller than the
conductor’s thickness. Since the conductor where currents are induced is also relatively far away
from the current source, an impedance boundary can be used tomodel the induced currents— as
shown on the right
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The conductor must be excluded from themodel bymaking it a perfect conductor. The outside
boundary of themodel ismoved to the inside surface of the conductor. This outside surface is
defined as an impedance boundary, using the conductivity and permeability specified previously.
Since the simulator does not have to actually compute a solution inside the conductor, the field
solution is computedmore quickly and uses lessmemory. After solving, you can compute the ohmic
loss for the surface using the solution calculator and plot the loss density on the boundary.

Related Topics

Assigning an Impedance Boundary for the 2D EddyCurrent Solver

Assigning a Symmetry Boundary for the 2D Eddy Current Solver

This boundary condition defines a plane of geometric or magnetic symmetry in a structure. Assign it
only to the outer surfaces of the problem region.
To set a symmetry boundary:

1. Select the section of the geometry on which you want to apply the boundary condition
(typically an edge).

2. ClickMaxwell2D>Boundaries>Assign>Symmetry.
TheSymmetry Boundary dialog box appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Select one of the following as the type of symmetry:

Odd Magnetic field is tangential to the boundary; its normal components are
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(Flux
Tangential)

zero.

Even
(Flux Normal)

Magnetic field is normal to the boundary; its tangential components are
zero.

5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the boundary to the selected object.

Related Topics

Setting a SymmetryMultiplier

Assigning a Balloon Boundary Condition for the 2D Eddy Current Solver

To set a balloon boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically an edge).
2. ClickMaxwell2D>Boundaries>Assign>Balloon.

TheBalloon Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

Assigning a Master Boundary for the 2D Eddy Current Solver

Master and slave boundaries enable you tomodel planes of periodicity where theMagnetic Field at
every point on the slave boundary surface is forced tomatch theMagnetic Field of every
corresponding point on themaster boundary surface. The transformation used tomap theMagnetic
Field from themaster to the slave is determined by specifying a coordinate system on both the
master and slave boundaries.
To set amaster boundary:

1. Select the edge to which you want to assign themaster boundary.
2. ClickMaxwell2D>Boundaries>Assign>Master.

TheMaster Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. To reverse the direction of the vector, select theSwap Direction check box.
5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK.
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Assigning a Slave Boundary for the 2D Eddy Current Solver

Assigning a slave boundary is the second step in creatingmatching boundaries. The field on the
master boundary ismapped to the slave boundary.

Note Youmust define amaster boundary before creating the slave boundaries that are
associated with it. Assign slave boundaries only to the outer surfaces of the problem
region.

To set a slave boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically an edge).
2. ClickMaxwell2D>Boundaries>Assign>Slave.

TheSlave Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. Select themaster boundary to which the slave is to be assigned from theMaster Boundary

pull-down list.
5. In theRelation section, select one of the following to specify the field behavior on the

boundary:

Bs
=
Bm

Click this radio button if themagnetic fields on the slave andmaster boundaries have
the samemagnitude and the fields oscillate in phase.

Bs
= -
Bm

Click this radio button if themagnetic fields on the slave boundary have the same
magnitude as themaster boundary field but the fields oscillate 180 degrees out of
phase.

6. Optionally, clickUse Defaults to revert to the default values in the dialog box.
7. ClickOK to assign the boundary to the selected object.

2D Eddy Current Excitations

The eddy current solver allows you to define the following sources of AC magnetic fields:

Excitation Type of Excitation
Current The total current in a conductor.

Parallel Current The total current to be divided among several
conductors in parallel. Themethod of dividing the
current depends upon the choice of solid or
stranded.

Current Density The current density in a conductor. In this case,
youmust also define the current density
terminals for the conductor.
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Coil Used to define one or moremodel windings.

End Connection End connection is used tomodel details of the
"squirrel cage" winding of inductionmachines,
dampers in synchronousmachines, etc.

WindingWith Current Current for both a stranded and solid conductor.

WindingWith Voltage Voltage for both a stranded and solid conductor.

WindingWith External
Circuit Connection

External circuit connection for both a stranded
and solid conductor.

Assigning a Current Excitation for the 2D Eddy Current Solver

Specifies the total AC current in a conduction path. The conduction pathmay be contained
completely within the problem region (for example, a coil), or may touch the edges of the problem
region.
To specify the total AC current:

1. Select the 2D section of the geometry on which you want to apply the excitation.
2. ClickMaxwell2D>Excitations>Assign>Current.

TheCurrent Excitation dialog box appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. Enter the current strength in theValue box.
5. Enter the phase for the current in thePhase box.
6. Select theSolid or Stranded radio button to specify the type of conductor.
7. Select either Positive orNegative as theRef. Direction for the conductor.
8. Optionally, clickUse Defaults to revert to the default values in the dialog box.
9. ClickOK to assign the excitation to the selected object.

Assigning a Parallel Current Excitation for the 2D Eddy Current Solver

Specifies the total AC current in a parallel conduction path consisting of at least two conductors.
To specify the total AC current:

1. Select the 2D sections of the geometry on which you want to apply the excitation. At least two
sectionmust be specified

2. ClickMaxwell2D>Excitations>Assign>Parallel Current.
TheParallelCurrent Excitation dialog box appears.

3. Enter a name for the excitation in theName box, or accept the default.
4. Enter the current strength in theValue box.
5. Enter the phase for the current in thePhase box.
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6. Select theSolid or Stranded radio button to specify the type of conductor.
Note For parallel solid conductors, the current split will be based upon the overall field

solution including eddy effects (the currents in individual parallel conductors will
have complex values, which are proportional with the respective admittances, and in
general will have different phase angles between them). If stranded conductors are
specified, the current is split based upon the relative areas of the selected
conductors.

7. Select either Positive orNegative as theRef. Direction for the conductor.
8. Optionally, clickUse Defaults to revert to the default values in the dialog box.
9. ClickOK to assign the excitation to the selected object.

Assigning a Current Density Excitation for the 2D Eddy Current Solver

This command specifies the applicable component (depending on XY or RZ solution type) of the AC
current density. If the current density is a function of position, the value is entered in ampere/m2,
even if you change the units in the problem.
To define the current density:

1. Select the section of the geometry (i.e., the conductor) in which you want to apply the
excitation (typically a 2D object).

2. ClickMaxwell2D>Excitations>Assign>Current Density.
TheCurrent Density Excitation dialog box appears.

3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, specify the following options:

a. Enter the current strength in theValue box. The valuemay be a single numeric value or a
spatial function.

b. If the value is specified as a spatial function, select theCoordinate System from the pull-
down list.

c. Enter the phase angle, θ, of the current density in thePhase field, and select a unit from
the pull-down list.

5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the excitation to the selected object.

Assigning a Coil for a 2D Eddy Current Solver

To assign a coil as an Eddy current excitation:
1. Select the section of the geometry on which you want to apply the excitation (typically a 2D

object).
2. ClickMaxwell2D>Excitations>Assign>Coil. (You can also right-click an existing winding in

the project tree, and selectAssign Coil.)
TheCoil Excitation dialog box appears.
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3. On theGeneral tab, enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the number of conductors for the coil in theNumber of

Conductors box.
5. Select one of the following for thePolarity:

l Positive
l Negative
l Function

6. If you selected Function as thePolarity, enter a function in the text box.
7. Optionally, on the Defaults tab, clickSave Defaults to save the current settings or click

Revert to Standard Defaults to revert to the default values in the dialog box.
8. ClickOK to assign the coil to the selected object.

Note To add this coil to an existing winding, do the following:
1. In the project tree, right-click the coil terminal, and selectAdd to Winding.

The Add to Winding dialog box appears.
2. Select the winding to which you ant to add the coil terminal, and clickOK.

Note To remove a coil terminal from an existing winding, do the following:
l In the project tree, right-click the coil terminal, and selectRemove from
Winding. The terminal is removed from the winding andmoved up one level in
the project tree (directly beneathExcitations).

l Alternatively, all coils assigned to a windingmay be deleted by right-clicking
the winding in the project tree and selectingDelete All Coils.

Assigning an End Connection for a 2D Eddy Current Solver

To define an end connection:
1. Select the section of the geometry (i.e., the conductor) acrosswhich you want to apply the

excitation.
2. ClickMaxwell 2D>Excitations>Assign>End Connection.

TheEnd Connection Excitation dialog box appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, specify the following options:

a. Enter theEnd resistance between adjacent conductors, and select a unit of
measurement from the pull-down list.

b. Enter theEnd inductance between adjacent conductors, and select a unit of
measurement from the pull-down list.

5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the excitation to the selected object.
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Assigning a Winding Setup for a 2D Eddy Current Solver

Note If you wish to define a winding for a 2D transient solution type, refer
to "Assigning aWinding Setup for a 2D Transient Solver" on
page 12-50 .

You can use the pre-defined coil terminal(s) to define one or more current or voltage windings.
To define a winding for your model:

1. ClickMaxwell 2D>Excitations>Add Winding to open theWinding dialog box.
2. Enter a name for the winding in theName box, or accept the default.
3. In theParameters section:

a. SelectCurrent, Voltage, or External from the Type pull-down list. The winding type
selected enables only those fields (Initial Current, Resistance, Inductance, Voltage,
Phase) applicable for the chosen type.

b. Select theSolid or Stranded radio button to specify the type of conductor.
c. Enter values in the following fields (enabled according to winding type), and select the

desired units:

For a current winding For a voltage winding1 For an external winding
Current Resistance (no settings required)
Phase Inductance

Voltage
Phase

Note You can also type a function as an expression for any of these fields except Initial
Current.

d. Enter a value in theNumber of parallel branches text box.
4. Optionally, clickUse Defaults to revert to the default values in the dialog box.
5. Optionally, on the Defaults tab, clickSave Defaults to save the current settings or click

Revert to Standard Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the excitation to the selected object.

The definition of a winding is final only after specifying the coils which belong to it.

Note To add a coil terminal to this winding, do the following:
1. In the project tree, right-click the winding, and selectAdd Coils. The Add

Terminals dialog box appears, listing all coil terminals that do not already belong to
that winding.

2. Select the coil terminal (s) you want to add. To select multiple terminals, pressCTRL
and click each terminal.

3. ClickOK.
To assign a coil terminal excitation and add it to this winding, do the following:
1. Select the section of the geometry on which you want to apply the coil terminal
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excitation.
2. In the project tree, right-click the winding, and selectAssign Coil.

TheCoil Excitation dialog box appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the number of conductors for the coil in the

Number of Conductors box.
Note: This value represents only the number of conductors inside of the selected
geometry. If the Coil Terminal is cut due to symmetry, then only enter the Number of
Conductors in the portionmodeled.

5. Select one of the following for thePolarity:
•Positive
•Negative
• Function

6. If you selected Function as thePolarity, enter a function in the text box.
7. Optionally, clickUse Defaults to revert to the default values in the dialog box.
8. ClickOK to assign the coil terminal excitation. The coil terminal excitation is assigned

and is added to the winding.
To delete all coil terminal excitations that belong to this winding, do the following:

l In the project tree, right-click the winding, and select Delete All Coils. All coil
terminal excitations are removed from the winding and deleted from the excitations.

Related Topics

"Assigning a Coil for a 2D EddyCurrent Solver" on page 12-36

1. For a solid winding, the resistance term can represent: the resistance of a portion of the
winding which is not modeled (for instance, end-effects), the leads connecting the winding to
the source, or the source resistance. (Themain winding resistance is calculated directly by the
solver.) For a stranded winding, the resistance term is the complete DC resistance of the
winding (since the solver does not determine resistance of a stranded winding) aswell as the
resistance of the end-effects, leads, source, etc. For both solid and stranded windings, the
inductance term can represent: the extra inductance for a portion of the winding of the winding
which is not modeled (for instance, end-effects), the leads connecting the winding to the
source, or the source inductance. (Themain winding inductance itself is calculated directly by
the solver.)

External Circuit Setup for 2D Eddy Current

TheMaxwell Circuit design editor is used to setup the external circuit excitation for windings in
Maxwell 2D and 3D Eddy current solutions. Because the Eddy current solver is a frequency domain
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solver, only linear circuit components are supported, which include Resistance, Inductance,
Capacitance, and Transformer. In addition, only sinusoidal sources should be used as sources.
Sinusoidal Current Source and Sinusoidal Voltage Source, designed for transient solutions, can also
be used for eddy current solutions. For example, to use the sinusoidal current source, you should set
the parameters as follows:

l Set I0, Td, andDf to zero, where I0 is offset current in Amps, Td is the delay time in seconds,
and Df is the damping factor in 1/seconds.

l Set TIME as the Type.
l Use Ia to set the peak amplitude in Amps.
l Use IFreq to set the signal frequency. Note that setting IFreq is not necessary as it will be
internally set to the frequency defined in theMaxwell design setup.

l UsePhase to set the phase delay.
With these specifications, the time signal can be written as:

Note that “Phase” is the signal phase delay. The complex source in the eddy current solver is
represented in phasor form as:

and the time signal can be written in terms of (Ia, θ) as:

In the complex expression, θ is defined as phase, while in Maxwell Circuit,Phase is defined as phase
delay. Thus:

As a result, you should enter the negative of phase of the complex signal as the Phase value.

An example of such a setup for is shown below.
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An example of an external circuit excitation for the winding for an Eddy current solver is shown
below.

Note For frequency domain eddy current solutions, only linear circuit components are supported,
which include Resistor, Inductor, Capacitor, and Transformer. Only sinusoidal sources
should be used as sources.

To set up an external circuit connection for an External winding type:
1. ClickMaxwell 2D>Excitations>External Circuit>Edit External Circuit to open theEdit

External Circuit dialog box. You can also right-click onExcitations in the Project tree and
selectExternal Circuit>Edit External Circuit.
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a. If no external winding connections have been set up for your model, theWinding
Information tab lists the external winding(s) in the design. Continue with step 2.

b. If external windings have already been set up, continue with step 7.
2. On theWinding Information tab, clickCreate Circuit to add a circuit design to the project.

The new circuit design automatically opens for editing in theMaxwell Circuit Editor. The circuit
includes one inductor for each external winding in the original Maxwell transient design. The
example below is for a design having one external winding.

3. Add the components needed to complete the external circuit design such as shown the
example below.
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4. When the circuit design is finished, clickMaxwell Circuit>Export Netlist and export the
netlist .sph file to the desired location.

5. Return to theMaxwell design and clickMaxwell 2D>Excitations>External Circuit>Edit
External Circuit to open theEdit External Circuit dialog. You can also right-click on
Excitations in the Project tree and selectExternal Circuit>Edit External Circuit.

6. On theWinding Information tab, click Import Circuit to import the circuit.
7. To view a list of inductors in the imported circuit, click theAvailable Inductors tab.
8. To view the sources used in the externally connected windings, click theSource Type tab.
9. If variables are used in the imported circuit, they and their design values are listed on the

Parameter Values tab. You can link to variables within the imported circuit as follows:
a. On theParameter Values tab, click in theValue column of the parameter to be

mapped.
b. Enter a new local variable name and press the Enter key to open theAdd Variable

dialog.
c. Select aUnit Type andUnit, and enter aValue for the variable and clickOK. The new

Maxwell variable is now mapped to the variable in the imported circuit, and can be
varied directly byMaxwell or used for Optimetrics analyses.

10. If the imported file is a .sph file, you can click theCircuit Path tab to view the original project
and design names.

11. ClickOK to close the Edit External Circuit dialog box.

Related Topics

"Assigning aWinding Setup for a 2D EddyCurrent Solver" on page 12-38

2D Transient Boundaries and Excitations
Define at least one of the following as a source of magnetic fields:

l The stranded or solid windings, with a voltage or current supply or connected to an external
circuit.

l Permanent magnet(s).
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You will need to set at least one outer boundary to the following:
l Value (vector potential) boundary conditions.
l An odd symmetry (flux tangential) boundary.
l An even symmetry (flux normal) boundary.

Related Topics

2D Transient Boundaries
2D Transient Excitations
Technical Notes: Transient Simulation
Specifying the Solver Type
Permanent Magnet Excitations

2D Transient Boundaries

The transient field solver allows you to define the same types of boundary conditions as
magnetostatic ones.

Boundary
Type H-Field Behavior Used to model...

Default
Boundary
Conditions
(Natural and
Neumann)

Field behaves as follows:
l Natural boundaries— TangentialH and
normalB are continuous across surfaces
without current density distribution.
TangentialH has a jump if the surface has
current density distribution.

l Neumann boundaries—Magnetic field is
normal to the boundary.

Initially, object interfaces have
natural boundaries; outer
boundaries, and excluded
objects have Neumann
boundaries.

Vector
Potential

Sets themagnetic vector potential , or ,
on the boundary. The behavior of H depends on
whether or is constant or functional.

Outer boundaries at specific
vector potentials; externally
appliedmagnetic fields.

Symmetry Field behaves as follows:
l Odd Symmetry (Flux Tangential) —
Magnetic Field is tangential to the
boundary; its normal components are zero.

l Even Symmetry (Flux Normal) —Magnetic
Field is normal to the boundary; its
tangential components are zero.

Planes of geometric and
magnetic symmetry.

Balloon Models the case where the structure is “infinitely”
far away from other magnetic fields, permanent
magnets, or current sources.

Magnetically isolated
structures.
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Master and
Slave
(Matching)

TheMagnetic Field on the slave boundary is
forced tomatch themagnitude and direction (or
the negative of the direction) of theMagnetic
Field on themaster boundary.

Planes of symmetry in periodic
structureswhereMagnetic
Field is oblique to the
boundary.

Default Boundary Conditions for a 2D Transient Solver

These boundary conditions are automatically defined for a transient model:
l Natural boundaries are assigned to the surfaces between objects. TangentialH and normalB
are continuous across surfaceswithout current density distribution. TangentialH has a jump if
the surface has current density distribution.

l Neumann boundaries are assigned to the outside edges of the problem region. Magnetic field
is normal to the boundary.

To leave a surface set to its default boundary condition, you do not need to set any boundary
conditions. Deleted boundary conditions and excitations automatically reset to the default boundary
conditions.

Assigning a Vector Potential for a 2D Transient Solver

To define a vector potential boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically an edge).Maxwell 2D requires that the Vector Potential be assigned on a 1D object
such as an edge or a line.

2. ClickMaxwell2D>Boundaries>Assign>Vector Potential.
TheVector Potential Boundary dialog box appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. In theParameters section, enter the value of the potential. The valuemay be specified as a

single numeric value or a spatial function.
5. If a functional value is specified, select aCoordinate System from the pull-down list:
6. Optionally, clickUse Defaults to revert to the default values in the dialog box.
7. ClickOK to assign the boundary to the selected object.

The new boundary is added to the boundary list in the project tree.

Assigning a Symmetry Boundary for a 2D Transient Solver

This boundary condition defines a plane of geometric or magnetic symmetry in a structure. Assign it
only to the outer surfaces of the problem region.
To set a symmetry boundary:
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1. Select the section of the geometry on which you want to apply the boundary condition
(typically an edge).

2. ClickMaxwell2D>Boundaries>Assign>Symmetry.
TheSymmetry Boundary dialog box appears.

3. Enter a name for the boundary in theName box, or accept the default.
4. Select one of the following as the type of symmetry:

Odd
(Flux
Tangential)

Magnetic Field is tangential to the boundary; its normal components are
zero.

Even
(Flux Normal)

Magnetic Field is normal to the boundary; its tangential components are
zero.

5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the boundary to the selected object.

Related Topics

Setting a SymmetryMultiplier

Assigning a Balloon Boundary Condition for a 2D Transient Solver

To set a balloon boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically an edge).
2. ClickMaxwell2D>Boundaries>Assign>Balloon.

TheBalloon Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. ClickOK to assign the boundary to the selected object.

Assigning a Master Boundary for a 2D Transient Solver

Master and slave boundaries enable you tomodel planes of periodicity where theMagnetic Field at
every point on the slave boundary surface is forced tomatch theMagnetic Field of every
corresponding point on themaster boundary surface.
To set amaster boundary:

1. Select the edge to which you want to assign themaster boundary.
2. ClickMaxwell2D>Boundaries>Assign>Master.

TheMaster Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. To reverse the direction of the vector, select theSwap Direction check box.
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5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK.

Maxwell computes theMagnetic Field on this boundary andmaps it to the slave boundary using the
transformation defined by themaster and slave coordinate systems.

Assigning a Slave Boundary for a 2D Transient Solver

Assigning a slave boundary is the second step in creatingmatching boundaries. The field on the
master boundary ismapped to the slave boundary.

Note Youmust define amaster boundary before creating the slave boundaries that are
associated with it. Assign slave boundaries only to the outer surfaces of the problem
region.

To set a slave boundary:
1. Select the section of the geometry on which you want to apply the boundary condition

(typically an edge).
2. ClickMaxwell2D>Boundaries>Assign>Slave.

TheSlave Boundary dialog box appears.
3. Enter a name for the boundary in theName box, or accept the default.
4. Select themaster boundary to which the slave is to be assigned from theMaster Boundary

pull-down list.
5. In theRelation section, select one of the following to specify the field behavior on the

boundary:

Bs
=
Bm

Click this radio button if themagnetic field on the slave andmaster boundaries have
the samemagnitude and direction.

Bs
= -
Bm

Click this radio button if themagnetic field on the slave boundary has the same
magnitude as but the opposite direction from themaster boundary field.

6. Optionally, clickUse Defaults to revert to the default values in the dialog box.
7. ClickOK to assign the boundary to the selected object.

2D Transient Excitations

Transient problems use the following types of excitations:

Excitation Type of Excitation
Current The total current in a conductor

Current Density The known current density distribution in a conductor.
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Coil Used to define one or moremodel windings.

End Connection End connection is used tomodel details of the "squirrel cage" winding of
inductionmachines, dampers in synchronousmachines, etc.

WindingWith Current Current for both a stranded and solid conductor.

WindingWith Voltage Voltage for both a stranded and solid conductor.

WindingWith
External Circuit
Connection

External circuit connection for both a stranded and solid conductor.

Note A winding is a versatile type of excitation. Six different combinations can be used: Current,
Voltage, and External Circuit — each with a solid or stranded conductor. The Coil Terminal
type of excitation needs to be defined prior to setting up a winding.

In addition, permanent magnet materials serve as sources of magnetic fields.

Assigning a Current Excitation for a 2D Transient Solver

Specifies the total transient current in an object.
To specify the total transient current:

1. Select the 2D section of the geometry on which you want to apply the excitation.
2. ClickMaxwell2D>Excitations>Assign>Current.

TheCurrent Excitation dialog box appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. Enter the current magnitude, time dependent, in theValue box, and select a unit from the pull-

down list.
5. Select theSolid or Stranded radio button to specify the type of conductor.
6. Select either Positive orNegative as theRef. Direction for the conductor.
7. Optionally, clickUse Defaults to revert to the default values in the dialog box.
8. ClickOK to assign the excitation to the selected object.

Assigning a Current Density Excitation for a 2D Transient Solver

This command specifies the applicable component (depending on the XY or RZ type of application)
of the transient current density in an object. If the current density is a function of position, the value is
entered in ampere/m2, even if you change the units in the problem.
To define the current density:

1. Select the section of the geometry (i.e., the conductor) in which you want to apply the
excitation (typically a 2D object).

2. ClickMaxwell2D>Excitations>Assign>Current Density.
TheCurrent Density Excitation dialog box appears.
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3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, specify the following options:

a. Enter the current strength in theValue box. The valuemay be a single numeric value or a
spatial function.

b. If a spatial function is entered for theValue, select theCoordinate System from the pull-
down list.

5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the excitation to the selected object.

Assigning a Coil for a 2D Transient Solver

To assign a coil as a transient excitation:
1. Select the section of the geometry on which you want to apply the excitation (typically a 2D

object).
2. ClickMaxwell2D>Excitations>Assign>Coil. (You can also right-click an existing winding in

the project tree, and selectAssign Coil.)
TheCoil Excitation dialog box appears.

3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the number of conductors for the coil in theNumber of

Conductors box.
5. Select one of the following for thePolarity:

l Positive
l Negative
l Function

6. If you selected Function as thePolarity, enter a function in the text box.
7. Optionally, clickUse Defaults to revert to the default values in the dialog box.
8. ClickOK to assign the coil to the selected object.

Note To add this coil to an existing winding, do the following:
1. In the project tree, right-click the coil terminal, and selectAdd to

Winding.
The Add to Winding dialog box appears.

2. Select the winding to which you ant to add the coil terminal, and click
OK.

Note To remove a coil terminal from an existing winding, do the following:
l In the project tree, right-click the coil terminal, and selectRemove from
Winding.
The terminal is removed from the winding andmoved up one level in the
project tree (directly beneathExcitations).

l Alternatively, all coils assigned to a windingmay be deleted by right-clicking
the winding in the project tree and selectingDelete All Coils.
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Related Topics

"Assigning aWinding Setup for a 2D EddyCurrent Solver" on page 12-38

Assigning an End Connection for a 2D Transient Solver

To define an end connection:
1. Select the section of the geometry (i.e., the conductor) acrosswhich you want to apply the

excitation.
2. ClickMaxwell 2D>Excitations>Assign>End Connection.

TheEnd Connection Excitation dialog box appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, specify the following options:

a. Enter theEnd resistance between adjacent conductors, and select a unit of
measurement from the pull-down list.

b. Enter theEnd inductance between adjacent conductors, and select a unit of
measurement from the pull-down list.

5. Optionally, clickUse Defaults to revert to the default values in the dialog box.
6. ClickOK to assign the excitation to the selected object.

Related Topics

Technical Notes: End Connections in 2D Transient

Assigning a Winding Setup for a 2D Transient Solver

Note If you wish to define a winding for a 2D EddyCurrent solution type, refer
to "Assigning aWinding Setup for a 2D EddyCurrent Solver" on
page 12-38 .

You can use the pre-defined coil terminal(s) to define one or more current or voltage windings.
To define a winding for your model:

1. ClickMaxwell 2D>Excitations>Add Winding to open theWinding dialog box.
2. Enter a name for the winding in theName box, or accept the default.
3. In theParameters section, selectCurrent, Voltage, or External from the Type pull-down

list.
Note Maxwell transient designs can be dynamically coupled to Simplorer components

through the Simplorer user interface. You can enable this feature on the Advanced
Product Coupling tab of theDesign Settings dialog box. Source windings set to
External are available as conservative pins in Simplorer. For more information,
refer to the Online Help for Simplorer Version 8 and later.

4. Select theSolid or Stranded radio button to specify the type of conductor.
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5. Enter values in the following fields, and select the desired units:
For a current winding For a voltage winding1 For an external winding
Current Initial Current Initial Current

Resistance
Inductance
Voltage

Note You can also type a function as an expression for any of these items except initial
current.

6. Enter a value in theNumber of parallel branches text box.
7. Optionally, clickUse Defaults to revert to the default values in the dialog box.
8. ClickOK to assign the excitation to the selected object

The definition of a winding is final only after specifying the coils which belong to it.

Note To add a coil terminal to this winding, do the following:
1. In the project tree, right-click the winding, and selectAdd Coils.

The Add Terminals dialog box appears, listing all coil terminals that do not already
belong to that winding.

2. Select the coil terminal (s) you want to add. To select multiple terminals, pressCTRL
and click each terminal.

3. ClickOK.
To assign a coil terminal excitation and add it to this winding, do the following:
1. Select the section of the geometry on which you want to apply the coil terminal

excitation.
2. In the project tree, right-click the winding, and selectAssign Coil.

TheCoil Excitation dialog box appears.
3. Enter a name for the excitation in theName box, or accept the default.
4. In theParameters section, enter the number of conductors for the coil in the

Number of Conductors box.
Note: This value represents only the number of conductors inside of the selected
geometry. If the Coil Terminal is cut due to symmetry, then only enter the Number of
Conductors in the portionmodeled.

5. Select one of the following for thePolarity:
•Positive
•Negative
• Function

6. If you selected Function as thePolarity, enter a function in the text box.
7. Optionally, clickUse Defaults to revert to the default values in the dialog box.
8. ClickOK to assign the coil terminal excitation.

The coil terminal excitation is assigned and is added to the winding.
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To delete all coil terminal excitations that belong to this winding, do the following:
l In the project tree, right-click the winding, and select Delete All Coils.
All coil terminal excitations are removed from the winding and deleted from the
excitations.

Related Topics

Setting up a Y Connection

1. For a solid winding, the resistance term can represent: the resistance of a portion of the
winding which is not modeled (for instance, end-effects), the leads connecting the winding to
the source, or the source resistance. (Themain winding resistance is calculated directly by the
solver.) For a stranded winding, the resistance term is the complete DC resistance of the
winding (since the solver does not determine resistance of a stranded winding) aswell as the
resistance of the end-effects, leads, source, etc. For both solid and stranded windings, the
inductance term can represent: the extra inductance for a portion of the winding of the winding
which is not modeled (for instance, end-effects), the leads connecting the winding to the
source, or the source inductance. (Themain winding inductance itself is calculated directly by
the solver.)

Setting up a Y Connection in 2D Transient Designs

The Y Connection function available in 2D Transient solution types allowsmultiple windings to be
connected in a classical Y (sometimes referred to aswye) configuration with the negative terminals
connected to a common node as illustrated below.
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Setup Y Connection requires voltage winding definitions be set and the negative voltage terminal
for each winding will be connected to form the common node of the circuit.
Each voltage source specified in the winding description drives the positive side of the coil. Y
Connections are commonly used inmotor and transformer applications driven by 3-phase voltage;
however, any number of windingsmay be connected to a common node inMaxwell2D.

Note Only one Y connection is allowed in a givenMaxwell
design.

To define a Y-connection:
1. ClickMaxwell2D>Excitations>Setup Y Connection.

TheSetup Y Connection dialog appears.
2. In theWinding list on the left, select the windings to be grouped into a Y connection.
3. Click theGroup button to create a Y Connection group with the selected windings.
4. ClickOK when all required grouping have been created.

Related Topics

Assigning aWinding Setup for the Transient Solver

Setting Up an External Circuit in 2D Transient

Note Use of external circuits is indicated whenmore complex excitation circuits such as rectifiers,
inverters, etc., containing components such as diodes, transistors, complex sources, etc.
are needed. There is no need to use an external circuit for simple current or voltage sources
supplying the windings.

Note External circuits intended for use with the TimeDecompositionMethod (TDM) can only
support basic circuit elements that are solution-independent. This is because, for TDM, all
time steps (or all time steps in a subdivision) are solved simultaneously - and thus the circuit
topology and its parametersmust be known before solving. Therefore some circuit
elements, such as solution-dependent switches, diodes, capacitors, and inductors which
are not directly connected to windings in series, are not supported.

An external circuit netlist can be complex as shown in the example below.
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To set up an external circuit connection for an External winding type:
1. ClickMaxwell 2D>Excitations>External Circuit>Edit External Circuit to open theEdit

External Circuit dialog box. You can also right-click onExcitations in the Project tree and
selectExternal Circuit>Edit External Circuit.

a. If no external winding connections have been set up for your model, theWinding
Information tab lists the external winding(s) in the design. Continue with step 2.
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b. If external windings have already been set up, continue with step 7.
2. On theWinding Information tab, clickCreate Circuit to add a circuit design to the project.

The new circuit design automatically opens for editing in theMaxwell Circuit Editor. The circuit
includes one inductor for each external winding in the original Maxwell transient design. The
example below is for a design having one external winding.

3. Add the components needed to complete the external circuit design such as shown the
example below.
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4. When the circuit design is finished, clickMaxwell Circuit>Export Netlist and export the
netlist .sph file to the desired location.

5. Return to theMaxwell design and clickMaxwell 2D>Excitations>External Circuit>Edit
External Circuit to open theEdit External Circuit dialog. You can also right-click on
Excitations in the Project tree and selectExternal Circuit>Edit External Circuit.

6. On theWinding Information tab, click Import Circuit to import the circuit.
7. To view a list of inductors in the imported circuit, click theAvailable Inductors tab.
8. To view the sources used in the externally connected windings, click theSource Type tab.
9. If variables are used in the imported circuit, they and their design values are listed on the

Parameter Values tab. You can link to variables within the imported circuit as follows:
a. On theParameter Values tab, click in theValue column of the parameter to be

mapped.
b. Enter a new local variable name and press the Enter key to open theAdd Variable

dialog.
c. Select aUnit Type andUnit, and enter aValue for the variable and clickOK. The new

Maxwell variable is now mapped to the variable in the imported circuit, and can be
varied directly byMaxwell or used for Optimetrics analyses.

10. If the imported file is a .sph file, you can click theCircuit Path tab to view the original project
and design names.

11. ClickOK to close the Edit External Circuit dialog box.

Note The user-set time steps can bemodified when external circuits are used to drive the
windings of the transient finite element model. Following is a list of situations that will lead
to a time step change:

l All power electronic switching instances that do not coincide with user-specified solve
times request a new solution time from the transient solver. The respective switching
generating a new solve time request for the transient solver can be time, position, or
speed dependent.

l When current and/or voltage sourceswith a piecewise linear variation are used, a
new solution time is requested from the transient solver at each (time) definition point
used in the corresponding source definition table.
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l When the change in anywinding inductance value is excessive, a new time step
(smaller) is calculated and a new solution generated (re-calculated) accordingly.

If a user-specified save field time ismissed because of the above reasons, the next solved
time step fields are saved instead.

Related Topics

"Assigning aWinding Setup for a 2D Transient Solver" on page 12-50
"Setting Up an External Circuit Using Simulink " on page 11-81
"Setting Up an External Circuit Using theMaxwell Circuit Editor" on page 27-53

Setting Up an External Circuit for 2D Transient using Simulink

In addition to using theMaxwell Circuit Editor to set up an external circuit, you also can useMatlab®
Simulink® to set up an external circuit for bothMaxwell 2D and 3D transient designs.

l Supported Simulink versions are: R2012b, R2013a, R2013b, R2014a, R2014b, and R2015a.
Refer to "Setting Up an External Circuit Using Simulink " on page 11-81 for detailed information.

Related Topics

"Setting Up an External Circuit in 2D Transient" on page 12-53
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13 - Setting Up Motion for Transient Projects
For Maxwell 2D or 3D projects where you selected transient as the solution type, you can define how
themodel componentsmove in relation to one another. This is accomplished by assigning a
MotionSetup to aBand object.

l For Maxwell 3D projects, only onemotion bandmay be assigned.
l For Maxwell 2D designs only, two or moremotion bandsmay be assigned, each with its own
independent motion characteristics. Multiple motion bands are used primarily for certain types
of motors wheremultiple rotorsmay rotate about a common central axis; however, other
applications are possible as shown in the following examples.

Example - Two Bands of Motion
The project shown below is comprised of two rectangular magnets, each surrounded by a band
object with aMotionSetup assigned to it. When onemagnet moves, the other magnet realigns itself.
Also note that the solution context display shows the position and speed for bothmotion setups.

Note The twomoving bandsmay not touch each other. Theremust be some stationary region
between the two bands, even if it is filled only with vacuum.

Example - Multiple Bands of Motion
Themagnet project shown below is comprised of five bar magnets. When the center magnet
(MotionSetup1) moves, the other magnets alsomove.
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Note Themoving bandsmay not touch each other. Theremust be some stationary region
between the bands, even if it is filled only with vacuum.

Related Topics

Assigning a Band of Motion
Showing and HidingMotion Objects
Technical Notes: 3D Transient
Technical Notes:Meshing Aspects for 3D Transient ApplicationsWithMotion

Assigning a Band of Motion
You can assign a band of motion in bothMaxwell 2D andMaxwell 3D projects.

l For Maxwell 3D projects, only onemotion bandmay be assigned.
l For Maxwell 2D designs, two or moremotion bandsmay be assigned.

For both rotational and translational problems, the band object must always enclose all of themoving
objects. For rotational problems, thismeans the band object should be a solid cylinder or a solid
wedge— not a hollow shell or segment of a shell. If the band object encloses all moving aspects, it is
easier to identify themoving objects and reduces errors related tomis-identifying them.

Note An inner region enclosed by the band can normally be used as a “fake” moving object for
two reasons:

l The first is to avoid creating holes inside the band which would result in the band
havingmultiple connected domains.
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l The second is due to the torque/force computation being carried out by one layer of
elements inside the band region that directly touchesmoving objects. If an inner
region is not included, the torque/force computation will be very sensitive tomesh
noise - thus leading to an inaccurate solution.

To assign the band of motion:
1. Select the band object.
2. ClickMaxwell>Model>Motion Setup>Assign Band.

TheMotion Setupwindow appears.
3. On the Type tab: select either Translation orRotation as theMotion Type.

l ForRotation about a fixed point youmay select theNon-Cylindrical check box.
l For Translation, youmay select thePeriodic check box.

For Periodicmotion, youmust definemaster and slave boundary conditions. Both band and
the object(s) inside it move, and both should touch themaster and slave boundaries as shown
in the example below.

4. Set themotion direction:
a. For Translation (includingPeriodic), select the desired X, Y, or Z (for 3D) axis of motion

from theMoving Vector pull-down list; then select either Positive orNegative direction.
b. ForRotation, from theMoving Axis pull-down list, select an axis of rotation. Use the

radio buttons to select either Positive orNegative rotation.
Note l For 2D XY rotation, onlyPositive rotation is allowed.

l If the expectedmoving vector does not exist, clickModeler>Coordinate
System>Create>Relative CS to create a new coordinate system.
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5. On theData tab: type a value in the Initial Position box, and select the units from the pull-
down list.

6. To set themotion limits, do the following in the Translate Limit orRotate Limit section:
Note For Periodicmotion, you do not need to definemotion limits because the solver does

not consider the limits for periodicmotion; thus the Translate Limit section is not
present.

a. For rotational motion, click theRotate Limit check box.
b. For translational (non-Periodic) or rotational motion, type a value in theNegative box,

and select the units from the pull-down list.
c. For translational (non-Periodic) or rotational motion, type a value in thePositive box, and

select the units from the pull-down list.
7. On theMechanical tab, do one of the following to specify the object velocity (dynamic or

constant):
Note When you selectConsider Mechanical Transient, you are telling the solver to use

the calculated force and user-specifiedmass, damping, and other parameters to
dynamically determine how the object moves, rather than giving it a constant
velocity.

Note l For Maxwell 2D/3D designs for motor applications, the computed output
mechanical power at given constant speedmay not reach the desired rated
power. Therefore, it is useful to apply constant power as themechanical load.
In Maxwell 2D/3D designs created byRMxprt, themechanical transient is set
up according to the ratedmechanical output power, and equivalent damping is
added to accelerate the process approaching to the rated output power. This
setup is visible whenConsider Mechanical Transient is checked.

l 2D/3D designs generated fromRMxprt include the setup data, butConsider
Mechanical Transient is unchecked initially. To ensure that the setup data is
preserved, make sure that you checkConsider Mechanical Transient
before saving the project.

l To dynamically change how the object moves, click theConsider Mechanical Transient
check box, complete the following fields, and select any corresponding units:
l Initial Velocity (translational) or Initial Angular Velocity (rotational)
l Mass (translational) orMoment of Inertia (rotational)
Use theCalculate button to haveMaxwell calculate theMass or Moment of Inertia with
the following restrictions:
l For 2D problems, themoving bodies are assumed to be of model-unit thinness.
l Rotating bodiesmust be symmetric about the axis of rotation. Partial models (e.g., half
a motor with implied symmetry) are not supported.

l Damping (rotational motion) – A value for damping for rotational motion (for electric
machines) can be calculated by the windage and friction loss inWatts divided by the
speed in rad/sec (at which those losses are defined); this is Damping with resulting units
of (W / (rad/sec)^2) or (N*m * sec/rad).
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l Damping (linear motion) – A value for damping for linear motion can be calculated by
the windage and friction loss inWatts divided by the speed inm/sec (at which those
losses are defined); this is Damping with resulting units of (W / (m/sec)^2) or (N*m *
sec/m).

l Load Force (translational) or Load Torque (rotational)
Note l For translational motion, the load force is positive if it is applied in the

same direction as themoving vector and negative if applied in the
opposite direction.

l For rotational motion, the load torque sign is determined based on the
moving vector, using the right-hand rule. Point your thumb in the direction
of themoving vector. If the load torque is applied in the same direction as
your fingers, then the load torque is positive. If it is applied in the opposite
direction, then the load torque is negative.

l To set a constant velocity (and disable themechanical transient), clear theConsider
Mechanical Transient check box, type a value in theVelocity orAngular Velocity box,
and select the units from the pull-down list.

8. For translational motion, aPost-Processingtab is available to set the coordinate system for
post processing calculation.

9. ClickOK.
l AMotionSetupx is created and added to theModel folder in theProject Manager
window.

l For Maxwell 3D projects only, if cylindricalRotationwas specified and aCylindricalGap
mesh operation does not already exist, aCylindricalGapmesh operation is automatically
added to theMesh Operations folder. Only oneCylindricalGapmesh operation is
permitted.

Related Topics

Non-Cylindrical Rotational Motion
Showing and HidingMotion Objects
Reassigning a Band of Motion
Motion Variables Tab
Creating Animations

Modifying Motion Setup Properties

Tomodify existingmotion setup properties:
1. In the Project Manager Model folder, right-click onMotionSetupx and selectProperties from

the context menu to open theMotion Setup dialog box.
l Alternatively, you can double-click theMotionSetupx icon.

2. Edit the desired properties in theMotion Setup dialog box. Refer toAssigning a Band of
Motion for detailed information on the variousMotion Setup dialog box settings.
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Note For Maxwell 3D projects only:
l If you change themotion type to cylindricalRotation and aCylindricalGap
mesh operation does not already exist, aCylindricalGapmesh operation is
automatically added to theMesh Operations folder. Only one
CylindricalGapmesh operation is permitted.

l If you change a cylindricalRotationmotion type to another motion type, the
CylindricalGapmesh operation remains in theMesh Operation folder.

l Alternatively, you can edit many of themotion setup properties in thePropertieswindow.

Related Topics

Non-Cylindrical Rotational Motion
Showing and HidingMotion Objects
Reassigning a Band of Motion

Non-Cylindrical Rotational Motion

With cylindrical rotation, themoving objects are free to rotate completely, and themesh remains
fixed as themoving objects rotate. With non-cylindrical motion, the geometry shape of the band
region changes as themoving objects rotate, and themesh is recreated.
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l Amotor is an example of cylindrical motion.
l A relay is an example of non-cylindrical motion.

Reassigning a Band of Motion
When aMotionSetup has been created, the object that the setup is assigned to is changed using
theReassign command, allowing you to identify themotion setup parameters with a new object
without losing themotion setup parameters themselves. To reassign aMotionSetup:

1. Select the object that theMotionSetupwill be reassigned to in themodeler window or in the
history tree.

2. Right-click onMotionSetupx in the Project Manager window and selectReassign.
Note l An existingCylindricalGapmesh operation’s assignment will be synced up to

a rotational cylindrical motion setup's assignment when you reassign the band
object of themotion setup.
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Related Topics

Assigning a Band of Motion

Adding and Deleting Objects from a Band of Motion
To add objects to, or delete objects from amotion setup without changing the parameters of the
MotionSetup do the following:

1. Select the object to be added or deleted from theMotionSetup in themodeler window or in
the history tree.

2. Right-clickModel>MotionSetupx>Movingx in the Project Manager window and choose
Add Selected Objects orRemove Selected Objects from the shortcut menu.

3. To verify the addition or deletion of the object from the MotionSetup definition, use
Select Assignment from the shortcut menu to view the objects assigned to the
band.

Related Topics

Assigning a Band of Motion

Showing and Hiding Motion Objects
1. ClickMaxwell>Model>Motion Setup>Visualization.

TheMotion Setup Visualization Optionswindow appears.
2. SelectAll,Band, orMoving from theSelect pull-down list.
3. ClickDeselect All to hide all motion objects.
4. ClickClose to close the window.

Related Topics

Setting the Visibility for Motion Objects

Setting the Visibility for Motion Objects

To show or hide a parameter:
1. ClickView>Active View Visibility.

TheActive View Visibility dialog box appears.
2. Click the Motion tab.
3. Select or clear theVisibility check box for eachmotion object listed.
4. ClickDone.
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Modeling Maxwell Motion Eccentricity
You canmodel motion eccentricity for Maxwell 2D and 3D transient designs that have cylindrical
rotational motion set up. ANSYS Electronics Desktop provides aMaxwell Eccentricity Wizard
with settings for:

l Rotating part eccentricity
l Rotation axis eccentricity

For rotating part eccentricitymodeling, the eccentricity is only applied to rotating objects, not to a
motion axis. More specifically, these rotating objects are all objects enclosed by the band, but not the
band itself.
For rotation axismodeling, the eccentricity is only applied to themotion axis, which is equivalent to
moving the band itself, but not any rotating objects inside the band.
Using these two basic settings, you canmodel the following physics.

l Static eccentricity: Tomodel static eccentricity, you need to set the rotating part eccentricity
and rotation axis eccentricity to the same values.

l Dynamic eccentricity: Tomodel dynamic eccentricity, set the rotating part eccentricity
values only.

l Mixed eccentricity: This is the combination of static and dynamic eccentricities. Tomodel
mixed eccentricity, set both rotating part eccentricity and rotation axis eccentricity, but with
different values.

Related Topics

Using theMaxwell EccentricityWizard
Working with the ExtensionsWindow
Non-Cylindrical Rotational Motion
Showing and HidingMotion Objects
Reassigning a Band of Motion
Motion Variables Tab
Creating Animations

Using the Maxwell Eccentricity Wizard

You can use theMaxwell Eccentricity wizard tomodel both 2D and 3D transient designs that have
cylindrical rotational motion set up.

Note If you want to generate a 3D rotational eccentricitymotor design from an
RMxprt-generatedMaxwell 3D design, youmust enter Eccentricity 1 in the
RMxprtDesign Setting dialogUser Defined Data tab for the RMxprt design
before generating theMaxwell 3D design.
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1. SelectView>Extensions to open the Extensionswindow.
2. Click theWizards button to open theWizards page, then clickMaxwell Eccentricity to load

theMaxwell Eccentricity setup page.
3. Select theProject andDesign you want to use.

Note l TheUpdate button synchronizes the Project and Design
selection lists with those currently loaded in the Desktop.

l You can clickExit Wizard to close the eccentricity wizard
and return to the wizard start page without executing any
changes.

4. Depending on whether your design is 2D or 3D, do one of the following:
l For a 2D Maxwell project, enter the desired dx and dy translation values to setup the
Rotating Part Eccentricity and Rotation Axis Eccentricity. The unit of measure for
translation values is themodel’s unit, which is set usingModeler>Units.
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l For a 3D Maxwell project, enter the desired dx, dy , and dz translation values, the offset
angle, and the tilting angle for the rotating part eccentricity axis and rotation axis. The
unit of measure for translation values is themodel’s unit, which is set using
Modeler>Units.

5. Click the Finish button at the bottom of the page. The page closes and the wizard adds a new
design in the same project, in which theMaxwell geometry has been updated in accordance
with the eccentricity setup values you entered as follows:
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For 2D designs

l Design variables are created for each of the data entered in the wizard.
For rotating part eccentricty:
_Eccentricity_translation_of_moving_parts
For rotation axis eccentricity:
_Eccentricity_translation_of_rotating_axis

l Themoving parts in the designmotion setup are shifted according to the data defined
forRotating Part Eccentricity in theWizard. New coordinate systems are generated
as the object coordinate systems for moving parts, according to the same operations.

l The band is translated according to the data defined forRotation Axis Eccentricity in
the wizard.

l TheMoving Vector entry in the design’smotion setup is replaced with the new
direction (represented by an axis of a new coordinate system) generated according to
the data defined for Rotation Axis Eccentricity in theWizard.

l New design coordinate systems are created.
_Eccentricity_rotating_axis_translation_CS
_Eccentricity_moving_part_translation_CS
_Eccentricity_moving_part_CS_<part name> – one for eachmoving part

Note l All the above operations of translation, as well as the creation of new
coordinate systems, are dependent on the eccentricity design variables.

l You canmodify these design variables to adjust the eccentricity.
l The newly added coordinate systems should not be changedmanually
by the user.
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l Using the wizard tomodify a design that has already been set up for
eccentricity is not recommended.

For 3D designs

l Design variables are created for each of the data entered in the wizard.
For rotating part eccentricty:
_Eccentricity_offset_angle_of_moving_parts
_Eccentricity_translation_of_moving_parts
_Eccentricity_tilting_angle_of_moving_parts
For rotation axis eccentricity:
_Eccentricity_offset_angle_of_motion_axis
_Eccentricity_translation_of_motion_axis
_Eccentricity_tilting_angle_of_motion_axis

l Themoving parts in the designmotion setup are rotated and shifted according to the
data defined forRotating Part Eccentricity in theWizard. New coordinate systems
are generated as the object coordinate systems for moving parts, according to the same
operations.

l The band is rotated and translated according to the data defined forRotation Axis
Eccentricity in the wizard.

l TheMoving Vector entry in the design’smotion setup is replaced with the new
direction (represented by an axis of a new coordinate system) generated according to
the data defined for Rotation Axis Eccentricity in theWizard.

l New design coordinate systems are created.
For themotionmoving vector:
_Eccentricity_motion_axis_CS
_Eccentricity_motion_axis_tilting_axis_CS
For themoving parts:
_Eccentricity_moving_part_tilting_axis_CS
_Eccentricity_moving_part_translation_CS
_Eccentricity_moving_part_CS_<part name> – one for eachmoving part

Note l All the above operations of rotation and translation, as well as the
creation of new coordinate systems, are dependent on the eccentricity
design variables.

l You canmodify these design variables to adjust the eccentricity.
l The newly added coordinate systems should not be changedmanually
by the user.

l Using the wizard tomodify a design that has already been set up for
eccentricity is not recommended.
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Note Whenmodelingmotion eccentricity, the position and direction of themoving objects and/or
band are adjusted based on the eccentricity setup. In such cases, all the adjustments are
referenced to the original position and direction of the geometry of each object, As a result,
after you finish the eccentricity setup and click the Finish button, all the geometries in the
design created by the wizard are updated to new positions based on the eccentricity setup.
If you want to edit geometry, you should do so in the original design. After editing the
geometry, you can then re-do the eccentricity setup to create a new design.

Related Topics

ModelingMotion Eccentricity
Working with the ExtensionsWindow

Setting UpMotion for Transient Projects 13-14
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



14 - Adding Solution Parameters
When you assign a solution parameter, the solver calculates the parameter value as part of the
solution process. The table shows the solution parameters that may be calculated based upon the
solver type.

Parameter 3D Solvers 2D Solvers

Force/Torque

Magnetostatic
Electrostatic
EddyCurrent
Transient
Electric Transient

Magnetostatic
Electrostatic
EddyCurrent
Transient

Matrix

Magnetostatic
Electrostatic
EddyCurrent

Magnetostatic
Electrostatic
EddyCurrent
AC Conduction

Assigning a Force Parameter
To solve for a force parameter:

1. Select the object on which you want to apply the parameter.
2. ClickMaxwell3D or Maxwell2D, and then select Parameters>Assign>Force. You can

also right-click on Parameters in the Project tree, and then selectAssign>Force from the
context menu.
The Force Setupwindow appears.

3. Type a name for the force in theName box.
4. ForMaxwell3D projects only, selectVirtual or Lorentz as the Type for the force.

Note For 3D Transient and Electric Transient solvers, onlyVirtual Force is
calculated.

5. Select thePost-Processing tab to specify the coordinate system reference for calculating the
force parameter.

6. Select the appropriate coordinate system from theReferenceCS pull-down list.
7. ClickOK.

Note Force parameters are available for calculation in the 2D and 3D Magnetostatic,
Electrostatic, EddyCurrent and Transient solvers, and for the 3D Electric Transient
solver only.
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Assigning a Torque Parameter
To solve for a torque parameter:

1. Select the object on which you want to apply the parameter.
2. ClickMaxwell3D or Maxwell2D, and then select Parameters>Assign>Torque. You can

also right-click on Parameters in the Project tree, and then selectAssign>Torque from the
context menu.
The Torque setup window appears.

3. Type a name for the torque in theName box.
4. SelectVirtual or Lorentz as the Type for the torque.

Note For 3D Transient and Electric Transient solvers, onlyVirtualTorque is
calculated.

5. To assign an axis:
a. Select the axis from theAxis pull-down list.
b. Select either thePositive orNegative radio button.

6. ClickOK.
Note Torque parameters are available for calculation in the 2D and 3D Magnetostatic,

Electrostatic, EddyCurrent, and Transient solvers, and for the 3D Electric Transient
solver only.

Assigning a Matrix
To solve for a capacitance, inductance, or impedancematrix:

1. ClickMaxwell3D or Maxwell2D, and then select Parameters>Assign>Matrix.
TheMatrix dialog box appears.

2. Click theSetup tab.
3. Type a name for thematrix in theName box.
4. To specify the sources to be included in thematrix, select or clear the Include check box for

any sources listed.
5. ForMaxwell2D designs, the return path for each sourcemay be specified. By default, the

return path is at infinity; however, any conductor with a source specified can act as the return
path.

6. Click thePost Processing tab (present for magnetostatic and eddy current solution types).
7. If more than one source is listed on the left side, you can click thePost Processing tab and

Group them to organizemultiple sources into a single group. The calculations defined in the
Post Processing tab do not impact the field solution and can be set up or changed after the
solution has been completed.
ToGroupmultiple sources together:
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a. If desired, set the number of Turns for each source.
b. Select the sources to group in the list Entry list. Multiple source can be selected by holding

theCTRL key and clicking each source line.
c. With all sources selected, clickGroup to combine the sources into one series winding.
d. Set the number of parallelBranches the winding should be divided into and clickOK.
e. The results of the post processing calculation on thematrix can be seen by selecting

PostProcessed on theMatrix tab of the solutions dialog box.
8. ClickOK.

Note l For amatrix setup, the elements are defined based on excitations, not solids.
Only excitationswill be available in theMatrix dialog, regardless of the current
geometry selection. Also, changesmade to the excitations after matrix setup
will not be flagged until the setup validation performed prior to the solution
process.

l Matrix setups are recognized when couplingMaxwell designs to Simplorer
components such as Equivalent Circuit, Dynamic Inductance and
Capacitance, and State Space. For more information on couplingMaxwell
designs to Simplorer components, refer to theMaxwell Component
Subcircuits topic in the Simplorer Online Help.

In amatrix calculation:
l For coil terminals, all terminals are listed and can be selected.
l For outer terminals, the solver can only handle a conduction path with two terminals, and only
one terminal is listed for each conduction path:
l If they are current terminals, the listed terminal is in the “in” direction.
l If they are current density terminals, the first terminal is listed and can be selected.

l When setting up an inductancematrix, the sourcemust be a current excitation. Voltage
sources cannot be used in this case.

l In 2D matrix calculations the solver calculates loop currents; therefore, the direction of return
path current is always opposite of the source current. If a conductor with excitation is specified
as the return path, the polarity setting of the excitation in the nominal problem setup is not
respected.

Related Topics

ViewingMatrix Data
CapacitanceMatrix for an Electric Field Solution
InductanceMatrix for aMagnetostatic Field Solution
Grouping InductanceMatrix Elements
ImpedanceMatrix for an EddyCurrent Solution
Post-ProcessedQuantities

Reassigning Parameters
To reassign the geometry a parameter applies to:
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1. Select the new object to which you want to assign an existing parameter.
2. ClickMaxwell3D or Maxwell2D, and then select Parameters>Reassign.

TheReassign Parameter window appears.
3. Select the force or torque you want to reassign from theReassign Geometry for list.
4. ClickOK.

The parameter is reassigned to the new object.

Viewing Parameter List
To view a list of all parameters in the design:

1. ClickMaxwell3D or Maxwell2D, and then select Parameters>List.
TheDesign List window appears, with theParameters tab visible.

2. To view other design choices, click one of the following tabs:
l Model
l Boundaries
l Excitations
l MeshOperations
l Analysis Setup

Deleting All Parameters
To delete all parameters assigned in themodel:

l ClickMaxwell3D or Maxwell2D, and then select Parameters>Delete All.
All parameters are deleted.
Warning Maxwell provides no warning or option to stop deletion. If you accidentally delete

all parameters, clickEdit>Undo Delete All Parameters before you take any
other action.

Showing and Hiding Solution Parameters
1. ClickMaxwell3D or Maxwell2D, and then select Parameters>Visualization.

TheParameter Visualization Optionswindow appears.
2. Select the type of parameter you want to view from theSelect pull-down list, or click the row in

the table. Choices includeAll,All Forces,All Torques,All Matrices, andBy Name.
The object is highlighted in the geometry.

3. Select or clear the check boxes for each parameter to show or hide geometry, name, and
vectors for each force or torque parameter.

4. ClickDeselect All to hide all parameters.
5. ClickClose to close the window.
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Setting the Visibility for Parameters

To show or hide a parameter:
1. ClickView>Active View Visibility.

TheActive View Visibility dialog box appears.
2. Click the Parameters tab.
3. Select or clear theVisibility check box for each parameter listed.
4. ClickDone.

Changing the Parameter Setup
To change a parameter's setup:

1. In the project tree, open theParameters section.
2. Right-click the parameter you want to change.

A shortcut menu appears.
3. SelectProperties from the shortcut menu.
4. Make the desired changes, and then clickClose.
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15 - Defining Mesh Operations
In Maxwell, mesh operations are optional mesh refinement settings that provideMaxwell with mesh
construction guidance. This technique of guidingMaxwell’smesh construction is referred to as
"seeding" themesh. Seeding is performed using theMesh Operations commands on the
Maxwell3D or Maxwell2D menu.
When defining amesh, you typically assign themesh operations first (using theMaxwell3D>Mesh
Operations or Maxwell2D>Mesh Operations commands) and then create themesh (using the
Maxwell3D or Maxwell2D menu and selecting Analysis Setup>Apply Mesh Operations
command). However, you can also refine themesh after the initial mesh has been created.
You can instruct Maxwell to refine the length of tetrahedral elements on a surface or within a volume
until they are below a certain value (length-basedmesh refinement) or you can instruct Maxwell to
refine the surface triangle length of all tetrahedral elements on a surface or volume to within a
specified value (skin depth-basedmesh refinement). In some circumstances, youmay also want to
create amesh operation that modifiesMaxwell's surface approximation settings for one or more
faces. In some circumstances, youmay also want to assign a cylindrical gap treatment mesh
operation. For Maxwell 2D, when the TAU mesher is selected in the Initial Mesh Settings dialog, you
can define the Skin Depth Layersmesh setting corresponding to the selected edges.
Surface approximation settings are only applied to the initial mesh (themesh that is generated the
first time a design variation is solved). The other types of mesh operations (refining themesh) can be
performed on either the initial mesh or on themost recently generatedmesh (the current mesh) if you
are updating a previously-createdmesh.

Note Mesh operations at the target design of amu (permeability) link are
ignored.

You can also choose to override automatic choice of whichmesher Maxwell uses, by using the
Maxwell>MeshOperations>Initial Mesh Settings command.

What do you want to do?
l Perform length-basedmesh refinement on object faces.
l Perform length-basedmesh refinement inside objects.
l Perform skin depth-basedmesh refinement on object faces.
l Assigning Cylindrical Gap Treatment
l Apply Skin Depth Layers Settings
l Modify surface approximation settings for one or more faces.
l Modifying theModel Resolution (Maxwell3D only)
l Applymesh operations
l Specify the initial mesh settings

Related Topics

ApplyingMeshOperationsWithout Solving
Monitoring the Solution Process
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ViewingMesh Statistics
Plotting theMesh
Technical Notes: Meshing Aspects for 3D Transient ApplicationsWithMotion
Technical Notes: TheMeshGeneration Process
Technical Notes:Seeding theMesh
Technical Notes:Guidelines for Seeding theMesh
Technical Notes: Surface Approximation Settings

Assigning Length-Based Mesh Refinement on Object Faces
1. Select the faces you want Maxwell to refine.

Alternatively, select an object if you want Maxwell to refine every face on the object.
2. ClickMaxwell>Mesh Operations>Assign>On Selection>Length Based.

The Element Length BasedRefinement dialog box appears.
3. Type a name for themesh operation in theName box, or accept the default name.
4. To restrict the length of tetrahedra edges touching the faces:

a. SelectRestrict Length of Elements.
b. Type themaximum length of the tetrahedral edges touching the faces in theMaximum

Length of Elements box, and select the units.
Note Maxwell refines the element edges touching the selected faces until their lengths

are equal to or less than this value. The default value is set to 20% of the
maximumedge lengths of the bounding boxes of each selected face.

5. To restrict the number of elements added during refinement of the faces:
a. SelectRestrict the Number of Elements.
b. Enter theMaximum Number of Elements to be added.

6. ClickOK.
When themesh is generated, the refinement criteria you specified are used.When themaximum
number of elements is reached, some elementsmay exceed the requestedmaximumelement
length.
You can also specify Initial Mesh Settings to apply to all objects; however, if you apply separate
surface approximationmesh operations to specific objects, the object settings take precedence over
the general setting.

Related Topics

Assigning Length-BasedMesh Refinement Inside Objects
ApplyingMeshOperationswithout Solving
Plotting theMesh
Technical Notes:Length-BasedMesh Refinement
Technical Notes: TheMeshGeneration Process
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Technical Notes:Seeding theMesh
Technical Notes:Guidelines for Seeding theMesh

Assigning Length-Based Mesh Refinement Inside Objects
Length-basedmesh operations inside volumes can be applied to non-model box primitives. If an
error occurs, youmay be trying to assign amesh to a non-model box that is not a box primitive (such
as boxeswith chamfers or non-model cylinders).
To instruct Maxwell to refine every face of an object and its interior:

1. Select the object you want Maxwell to refine.
2. ClickMaxwell>Mesh Operations>Assign>Inside Selection>Length Based.

The Element Length BasedRefinement dialog box appears.
3. Type a name for themesh operation in theName box, or accept the default name.
4. To restrict the length of the tetrahedral element edges inside the object:

a. SelectRestrict Length of Elements.
b. Type themaximum length of the edges inside the object in theMaximum Length of

Elements box, and select the units.
Note Maxwell refines the element edges inside the object until they are equal to or

less than this value. The default value is set to 20% of themaximumedge
lengths of the bounding boxes of each selected object's faces.

5. To restrict the number of elements added during the refinement inside the object:
a. SelectRestrict the Number of Elements.
b. Enter theMaximum Number of Elements to be added.

6. ClickOK.
When themesh is generated, the refinement criteria you specified are used.When themaximum
number of elements is reached, some elementsmay exceed the requestedmaximumelement
length.
You can also specify Initial Mesh Settings to apply to all objects; however, if you apply separate
surface approximationmesh operations to specific objects, the object settings take precedence over
the general setting.

Related Topics

Assigning Length-BasedMesh Refinement onObject Faces
ApplyingMeshOperationswithout Solving
Plotting theMesh
Technical Notes:Length-BasedMesh Refinement
Technical Notes: TheMeshGeneration Process
Technical Notes:Seeding theMesh
Technical Notes:Guidelines for Seeding theMesh
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Assigning Skin Depth-Based Mesh Refinement on Object Faces
1. Select the faces you want to be refined.

Alternatively, select an object if you want Maxwell to refine every face on the object.
Note It is possible to select a body and convert it by selecting all faces of the body. You can use

thismethod to select all faces and toggle a few faces out of selection. Selecting the whole
bodymight select very large regions for refinement and increase the element count
significantly.

2. ClickMaxwell>Mesh Operations>Assign>On Selection>Skin Depth Based.
The Skin Depth BasedRefinement dialog box appears.

3. Type a name for themesh operation in theName box, or accept the default name.
4. Type the skin depth within which to refine themesh in theSkin Depth box.

Alternatively, do the following to calculate the skin depth based on the object'smaterial
permeability and conductivity and the frequency at which themesh is to be refined:
a. ClickCalculate Skin Depth.

TheCalculate Skin Depth dialog box appears.
b. Type thematerial'sRelative Permeability andConductivity.
c. Type the Frequency at which to refine themesh, and select the frequency units.
d. ClickOK.

Maxwell calculates the skin depth and enters its value in theSkin Depth box of theSkin
Depth Based Refinement dialog box.

5. In theNumber of Layers of Elements box, type the number of layers to add perpendicular
to the object's surface.
Maxwell adds an equivalent number of mesh points to each layer. For example, if Maxwell
adds 10 points to satisfy theSurface Triangle Length, it will add 10 points to each layer.

6. Type themaximumedge length of the surfacemesh in theSurface Triangle Length box,
and select the units.
Note Maxwell refines the surface trianglemesh (the faces of the tetrahedra touching the

surface) until their edge lengths are equal to or greater than the specified value.
The default value is set to 20% of themaximumedge lengths of the bounding boxes
of each selected face.

7. To restrict the number of elements added during refinement on the faces:
a. SelectRestrict the Number of Surface Elements.
b. Enter theMaximum Number of Surface Elements to be added.

8. ClickOK.
When themesh is generated, the refinement criteria you specified will be used. This operation will be
approximately the same as having slabs of tetrahedra, but it is not guaranteed to prevent tetrahedra
from crossing slab interfaces. Caution should be used with thismesh operation, as very thin layers
may cause a reduction in mesh quality or unnecessarily cause the generation of a very largemesh.
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Further regions refined under this operation and their close neighbors do not participate in solution
adaptive refinement. This is another reason to use this seeding operation with caution.
You can also specify Initial Mesh Settings to apply to all objects; however, if you apply separate
surface approximationmesh operations to specific objects, the object settings take precedence over
the general setting.

Related Topics

ApplyingMeshOperationswithout Solving
Plotting theMesh
Technical Notes: Skin Depth-BasedMesh Refinement
Technical Notes: TheMeshGeneration Process
Technical Notes:Seeding theMesh
Technical Notes:Guidelines for Seeding theMesh

Assigning Cylindrical Gap Treatment
1. Select the object you want Maxwell to refine.
2. ClickMaxwell 3D>Mesh Operations>Assign>Cylindrical Gap Treatment.

A CylindricalGapxmesh operation is applied to the selected object, and aCylindricalGapx
icon appears in the Project Manager MeshOperations folder.
The CylindricalGap operation only works for TAU (tolerant) mesher. It is a specificmesh
operation assigned to the “Band” object for the rotational transient simulation.
While you can select any object and assign the CylindricalGap operation to it in anyMaxwell
simulation, the CylindricalGap operation is effective only for rotational transient simulations for
which cases the TAU (tolerant) mesher will be chosen as the default mesher; or for which you
havemanually selected the TAU(tolerant) mesher.
The TAU (tolerant) mesher analyzes the “Band” object, calculates the surface normal angle
for the band rotational surface, and automatically assigns the desiredmesh operation; or
adjusts the existingmesh operations to the adjacent true surfaces at both static andmoving
sides to ensure a smooth and uniformmesh for the “Band” mesh.
If the “CylindricalGap” mesh operation is assigned to a regular object, TAU analysis finds the
object is not suitable for transient mesh, in which case the regular TAU mesh will be applied. A
Warningmessage is then displayed in themessage window.

Note l There can be only one cylindrical gap operation per
design.

l The operation cannot be assigned tomultiple
objects.

3. If you wish to change the name of themesh operation, you can double-click on the
CylindricalGapx icon to open the Cylindrical Gap Mesh Operation dialog box in which you
can type a name for themesh operation in theName box.
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Optionally for 3D transient simulations of rotational models only, if you wish to apply a clone
mesh operation, checkClone Mesh. This option is unchecked by default. If themodel is not
suitable tomake a clonemesh or the clonemesh process fails, Maxwell automatically falls
back to the regular TAU 3D mesher. Because the clonemesh is generated in the initial mesh,
the initial mesh is deleted and regenerated once this option is changed and you clickOK.

Related Topics

3D CloneMeshGeneration
Assigning a Band of Motion
Reassigning a Band of Motion

3D Clone Mesh Generation

The 3D clonemesh is generated only when the following three conditions aremet:
l TheCloneMesh check box is checked.
l TheCylindricalGapmesh operation has been assigned.
l Themodel has a non-skewed stator with more than two teeth.

Note WhenCloneMesh is used, the only additional mesh operation that can be used is
surface approximation. If any other mesh operation is used, the clonemesh
operation will be ignored.

The solid bodies adjacent to the band are detected to identify the clone object. If the object has
more than two teeth that are close to the band, the teeth will be verified to see they have the
identical geometric features. If the teeth are skewed, TAU will fall back to the regular mesh.
Otherwise the region from the radius of teeth to the outer edge of the object will be further
classified and verified to see if the object has themultiple 3D identical sub-regions.
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If a 3D clone region has been identified, TAU will classify the 3D rotational model into a static
region and amoving region by the band object radius. The Static region includes the clone
region and skewed coils regions at one side or two sides. Clonemeshmethod will then be
used to generate themesh in the clone region, while the TAU regular meshmethod will be
used to generate themesh at other skewed regions.
Themoving region includes skewed coils regions in which the TAU regular meshmethod is
used to generate themesh, and also the non-skewed sweep regions in which the TAU sweep
meshmethod is used tomake themesh.

3D Clone Mesh
A 3D clone regionmay have only one simple object, or several sections of clone objects with
the gap between as shown in the following images.
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To ensure the identical volumemesh in each sub-region, the volumemesh is generated in the
Master region, then by using a copy-and-pastemethod to duplicate themesh at all child
regions. In the 3D master region, if the region is also symmetric, then a symmetricmesh is
generated. “Sweepingmesh” technology is used tomake the volumemesh in themaster
region. In the half of themaster region, a surfacemesh is generated at the axis side. The
volumemesh is generated by sweeping the surfacemesh in the axis direction to fulfill the
clonemaster region.
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The volumemesh will bemirrored to the other half of themaster region to produce the
symmetricmesh in themaster region.
The volumemesh in themaster region is then duplicated and translated to the child regions
with copy and paste technology in TAU to complete the 3D clone regionmesh.

3D TAU Mesh
Beyond the 3D clone region, normally the regions have skewed coils. Therefore TAU regular
mesher will be used tomake themesh.

DefiningMeshOperations 15-9
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

3D Sweep Mesh
The rotational model for amoving regionmay have different structures. It may have all skewed
coils and rotors. In this case, the TAU regular mesh will be used tomake themesh.

At the axis direction, themoving region can be classified into several specific regions. If the
region has skewed objects, it is called a “regular section,” and the TAU regular mesh is
applied. If the region can be geometrically sweeping at the axis direction, the region is called a
“sweep region,” and the TAU sweepmeshmethod is applied.
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For the “sweep section,” a surfacemesh is generated at the side, then the volumemesh is
made by sweeping the surfacemesh in the axis direction. This ensures a uniformmesh in the
rotational direction, while maintaining the long aspect ratio in the axis direction to keep the
mesh size small.

The volumemesh for the rest of the regions ismade by the TAU regular mesher.
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Related Topics

Assigning Cylindrical Gap Treatment
Assigning a Band of Motion
Reassigning a Band of Motion

Skin Depth Layers Setting for 2D
You can apply these settings only to the edges of sheet bodies in Maxwell 2D when the TAU mesher
has been selected in the Initial Mesh Settings dialog.

Note Any changes youmake using these settingswill invalidate the initial mesh, aswell as the
current mesh and solutions, if any.

1. Select the edge of a sheet body, and clickMaxwell2D>Mesh Operations>Assign>On
Selection>Skin Depth Based... to open theSkin Depth Layers Setting dialog:
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2. Type a name for themesh operation in theName text box or accept the default name.
3. Type the skin depth within which to refine themesh in theSkin Depth text box.

Alternatively, calculate the skin depth based on the object'smaterial permeability and
conductivity and the frequency at which themesh will be refined:
a. ClickCalculate Skin Depth.

TheCalculate Skin Depth dialog box appears.

b. Enter thematerial'sRelative Permeability andConductivity.
c. Specify the Frequency at which to refine themesh.
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d. ClickOK.
Maxwell calculates the skin depth and enters its value in theSkin Depth text box.

4. In theNumber of Layers of Elements text box, type the number of layers to add
perpendicular to the object's surface.
Maxwell will add an equivalent number of mesh points to each layer. For example, if Maxwell
added 10 points to satisfy theSurface Triangle Length, it will add 10 points to each layer.

Note Caution should be used with thismesh operation, as very thin layersmay cause a
reduction in mesh quality or unnecessarily cause the generation of a very largemesh.
Furthermore, regions refined under this operation and its close neighbors do not
participate in solution adaptive refinement. This is another reason to use this seeding
operation with caution.

Related Topics

DefiningMeshOperations
Specifying Initial Mesh Settings
TAU 2D Skin Layer MeshGeneration

Modifying Surface Approximation Settings
Maxwell applies surface approximation settingswhen it generates the initial mesh. If youmodify
Maxwell's default settings after the initial mesh has been generated, they do not affect themesh for
that design variation. Surface approximation is useful, for example, for curved surfaces, for which the
mesh will not exactly reproduce the surface shape. It also can be used to restrict the aspect ratio of
triangles on planar surfaces.

1. Select the faces for which you want to modify the surface approximation settings.
l Alternatively, select an object if you want to modify the surface approximation settings of
every face on the object.

2. ClickMaxwell>Mesh Operations>Assign>Surface Approximation. to open the Surface
Approximation dialog box.
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3. Type a name for the group of settings in theName box, or accept the default name.
4. Under Curved Surface Meshing, you can selectUse Slider or specifyManual Settings.

The slider includes a visual representation of the resolution you choose, ranging fromCoarse
Resolution with a Small Mesh Size through a nine position scale to a fine resolution with a
LargeMesh Size.

5. If you chooseManual Settings, the dialog changes to show text fields.

6. If you selectSurface Deviation (length), type the distance between the true surfaces of the
selected faces and themeshed faces in the text box, and select the units.

7. If you selectNormal Deviation (angle), type the angular distance between the normal of the
true surface and the correspondingmesh surface, and select the units.

8. If you selectAspect ratio, type a value in the box. This value determines the shape of the
triangles. The higher the value, the thinner the triangles. Values close to 1 result in well-
formed, wide triangles.

9. ClickOK.
The settings are applied to the initial mesh generated on the selected surface. The group of
settings is listed in the project tree underMesh Operations.
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You can also specify Initial Mesh Settings to apply to all objects; however, if you apply separate
surface approximationmesh operations to specific objects, the object settings take precedence over
the general setting.

Related Topics

Plotting theMesh
Technical Notes: Surface Approximation Settings
Technical Notes: Guidelines for Modifying Surface Approximation Settings
Technical Notes: TheMeshGeneration Process

Surface Approximation

Object surfaces inMaxwell may be planar, cylindrical or conical, toroidal, spherical, or splines. The
original model surfaces are called true surfaces. To create a finite element mesh, Maxwell first
divides all true surfaces into triangles. These triangulated surfaces are called faceted surfaces
because a series of straight line segments represents each curved or planar surface.
For planar surfaces, the triangles lie exactly on themodel faces; there is no difference in the location
or the normal of the true surface and themeshed surface.When an object's surface is non-planar,
the faceted triangle faces lie a small distance from the object's true surface. This distance is called
the surface deviation, and it ismeasured in themodel's units. The surface deviation is greater near
the triangle centers and less near the triangle vertices.
The normal of a curved surface is different depending on its location, but it is constant for each
triangle. (In this context, "normal" is defined as a line perpendicular to the surface.) The angular
difference between the normal of the curved surface and the correspondingmesh surface is called
the normal deviation and ismeasured in degrees.
The aspect ratio of triangles used in planar surfaces is based on the ratio of circumscribed radius to
the in-radius of the triangle. It is unity for an equilateral triangle and approaches infinity as the triangle
becomes thinner.
You canmodify the surface deviation, themaximumpermitted normal deviation, and themaximum
aspect ratio of triangles settings on one or more faces at a time in theSurface Approximation
dialog box. (ClickMaxwell>Mesh Operations>Assign>Surface Approximation.)
The surface approximation settings are applied to the initial mesh.

Note For the initial mesh, all the vertices of the triangles lie on the true surfaces. Duringmesh
refinement, all the points are first added to the faceted surface for all products, not to the
true surfaces. Then, for all Maxwell projects, and for curvilinear meshing enabled HFSS
and HFIE projects, the points on the faceted surfaceswill bemoved to the curved surface
locationswhen suchmovement does not degrade the quality of themesh.
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Guidelines for Modifying Surface Approximation Settings

If you intend tomodify the surface approximation settings for an object face or faces, keep the
following guidelines in mind:

l When necessary, override the default surface approximation settings to represent curved
surfacesmore accurately. More accurate representation will increase themesh size and
consumemore CPU time andmemory. The default settings are adequate for most
circumstances.

l If you want to obtain a faster solution by using a cruder representation of curved surfaces,
set the coarser setting for the whole object, not just a single face.

l It is difficult for Maxwell to satisfy aspect ratio demands if the aspect ratio value is set close
to 1 because an arbitrary shape cannot be filled with only equilateral triangles. Therefore,
setting the aspect ratio to 1 can lead to unreasonably largemeshes. Maxwell limits the
aspect ratio to 4 for planar objects and 1.2 for curved objects.

Related Topics

Modifying Surface Approximation Settings
Technical Notes: Surface Approximation Settings

Cloning a Mesh
(Cloning aMesh applies toMaxwell2D Designs only)
The clonemesh operation allows users to use themesh data from a user-specified parent region of a
Maxwell 2D design to apply identical meshes to its cloned regions. In the example shown below,
three cloned regions have been generated with an angular spacing of 90 degrees from the user-
drawn parent region.

Note For non-Transient solution types, this operation is applied only on the initial mesh. If you do
adaptive refinement, themesheswill no longer match; the operation is not reapplied during
adaptive refinement.
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Clonemesh operations are performed after all other mesh operations are done.
1. To begin a clonemesh operation, selectMaxwell 2D>Mesh Operations>Assign>Clone

Mesh... to open theClone Mesh dialog box.
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2. First set up aParent Region. (Refer to the figure below.)

To set up the parent region, define the following parameters:
l Inner Radius
l Outer Radius
l Start Angle (default=0)
l End Angle
l Symmetry in Region - treat the region (parent and clone) as symmetric inside the region

3. Specify how to clone the parent region by defining the following parameters:
l Gap Angle (default=0) - angular spacing between clones
l Number of clones - number of periodic regions (including the parent)

4. Like other mesh operations, the user can enter aName, which can be enabled and disabled.
Multiple clonemesh operations (with different names) can be created.

5. When finished, clickOK.
6. To edit the clonemesh setup data, use the dialog or the Properties window.

Modifying the Model Resolution
(SettingModel Resolution applies toMaxwell3D Designs only)
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Themodel resolution parameter is used by themeshmaker to distinguish large features from small
features in themodel. This setting controls how large a featuremust be to be resolved by the
meshmaker. For example, if you set themodel resolution length to 20mm, anymodel features
smaller than 20mmare not represented in themesh. Neither themodel nor themodel files are
changed. The resolution only controls how themesh for themodel is represented.
While removing small details, if themeshmaker finds that the representation of themodel is not
accurate enough, it returns an error condition. Themeshmaker then starts with themost accurate
representation and prunes away the details smaller than themodel resolution length. It returns an
error if the specifiedmodel resolution length forces the final representation to deviate too greatly
from themodel.
You can set Model Resolution on one or more objects to remove unnecessary details from themesh
representation. This can be used to reduce themesh complexity of the selected objects.
A cautionary note is needed concerning the use of model resolution. It can sometimesmakemodel
faces fail to be represented in themesh, which can effectively remove some of your boundary
conditions. This can only happen if faces are closer together than themodel resolution distance you
specify.
Tomodify themodel resolution:

1. Select the object or objects on which to specify aModel Resolution operation.
2. ClickMaxwell 3D>Mesh Operations>Assign>Model Resolution.

The Model Resolution Mesh Operation dialog box appears.
Alternatively, you can display the same dialog if you:
a. Right-click on eitherMesh Operations in the Project Tree, or right-click in theModeler

window to display the respective shortcut menu.
b. Click onAssign>Model Resolution in theProject Treemenu or click onAssign Mesh

Operation>Model Resolution on the shortcut menu.
TheModel Resolution Mesh Operation dialog contains text fields for themesh operation
Name and radio buttonswith choices for the following
l Auto Simplify Using Effective Thickness

Themesher calculates the resolution length based on each object’s effective thickness.
Onemesh operation can be assigned tomany objects, and each will be simplified based
on its own dimensions. Use theAuto Simplify selection:

l To removemany details while retaining an object’s overall shape and size
l For objects of generally uniform thickness
l To assign onemesh operation tomany objects

l Use Model Resolution length
This enables fields for you to specify the resolution value and units. Use this selection for:

l Tighter control of mesh accuracy.
l Objects of non-uniform thickness. For example, the thin section of the object shown
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below might be lost withAuto Simplify.

3. After defining the operation, clickOK.
This adds the namedModel Resolution operation under theMesh Operations icon in the
Project Tree.

Note SettingModel Resolution will invalidate any existing solutions.
When two objects in contact have different model resolution lengths, the smaller length will
apply for the common regions.

Related Topics

Plotting theMesh
Setting the Healing Options
Technical Notes:Model Resolution

Reverting to the Initial Mesh
The initial mesh is themesh that is generated the first time a design variation is solved. It includes
surface approximation settings but does not include definedmesh operations.
If you havemodified the design setup, and do not want to use the existing current mesh, revert to the
initial mesh before solving.
To revert to the initial mesh before solving:

l ClickMaxwell>Analysis Setup>Revert to Initial Mesh.
Reverting to the initial mesh is useful when you want to evaluate how a different solution frequency
affects themesh generated during an adaptive analysis. You lose all solution data for a solve setup
and all of its sweepswhen you revert to the initial mesh for that setup. You can do this for all solve
setups at once by selecting the command through Analysis in themenu system or project tree, or for
a specific solve setup via its right mouse clickmenu in the project tree.

Related Topics

Plotting theMesh
Technical Notes: TheMeshGeneration Process
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Applying Mesh Operations Without Solving
Themesh is automatically created when you run a solution analysis.
If you want to refine themesh on a face or volume but do not want to generate a solution at the time,
you can apply themesh operations you have assigned without running the full analysis. Applying
mesh operationswithout solving enables you to experiment with mesh refinement in specific
problem regionswithout losing design solutions. You cannot undo the appliedmesh operations, but
you can discard them by closing the project without saving it.
To refine themesh without solving, do one of the following after definingmesh operations:

l ClickMaxwell>Analysis Setup>Apply Mesh Operations.
l In the project tree, underAnalysis, right-click the desired solution setup, and selectApply
Mesh Operations.

The same solvemachine rules that apply to solving any other setup also apply here. Themesh
operation will be sent to the default solvemachine, or theMaxwell Server Setup dialogmay appear
to allow you to interactively specify a solvemachine if "Prompt for analysismachine when launching
analysis" is selected under Tools>Options>General Options>Analysis Options tab.

l If a current mesh has been generated, Maxwell refines it using the definedmesh operations.
l If a current mesh has not been generated, Maxwell applies themesh operations to the initial
mesh.

l If an initial mesh has not been generated, Maxwell generates it and applies themesh
operations to the initial mesh.

l If the definedmesh operations have been applied to the selected face or object, the current
mesh is not altered.
Hint Define a new mesh operation rather thanmodify an existingmesh operation. Maxwell

does not re-apply amodifiedmesh operation.

Note Mesh operations at the target design of amu (permeability) link are
ignored.

Related Topics

Plotting theMesh
Technical Notes: TheMeshGeneration Process
Setting HPC and Analysis Options
Remote Analysis

Specifying Initial Mesh Settings
You can specify the initial mesh settings, including the surface approximation and themeshing
approach for bothMaxwell 3D andMaxwell 2D designs. For most Maxwell 3D designs, you can let
Maxwell automatically choose which of twomeshing approaches to take. Maxwell predicts which
one gives the best results, balancingmesh reliability, speed, quality, size and design characteristics.
In most cases, Maxwell usesTAU Mesh, rather than theClassic Mesh. In general, it looks for
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specific features (for example, stacks of large planar parallel facets with small gaps) and situations
where the initial TAU mesh is 4 times larger than the Classic. In a few cases, youmay decide to
override the automatic choice and designate themesher to use. To do so:

1. Select Maxwell>Mesh Operations>Initial Mesh Settings... or in the Project tree, right-click
onMeshOperations, and select Initial Mesh Settings from the shortcut menu.
The Initial Mesh Settings dialog box appears with theSurface Approximation tab
selected.

2. Type a name for the group of settings in theName text box or accept the default name.
3. UnderMaximum Surface Deviation, do one of the following:

l Select Ignore if you do not want to use surface deviation settings for the selected faces.
l SelectSet maximum surface deviation (length), and then type the distance between
the true surfaces of the selected faces and themeshed faces in the text box.

4. UnderMaximum Surface Normal Deviation, do one of the following:
l SelectUse defaults if you want to useMaxwell’s default normal deviation setting for the
selected faces, which is 15 degrees.

l SelectSet maximum normal deviation (angle), and then type the angular distance
between the normal of the true surface and the correspondingmesh surface in the text box.

5. UnderMaximum Aspect Ratio, do one of the following:
l SelectUse defaults if you want to useMaxwell’s default aspect ratio settings for the
selected faces, which are 10 for curved surfaces and 200 for planar surfaces.

l SelectSet aspect ratio, and then type a value in the text box. This value determines the
shape of the triangles. The higher the value, the thinner the triangles. Values close to 1 will
result in well-formed, wide triangles.

6. Tomake your choice the default, use theSave as default check box.
7. Select theMeshing Method tab.

For Maxwell 3D, the tab contains radio buttons for:
l Auto (the default) – Maxwell automatically selects themesher. In most cases, this will be
TAU Mesh.

l TAU Mesh – this includesSurface representation (works for TAU tolerant)

Tolerant uses a looser tolerance for surface representation, whichmay be better for dirty or
very complex geometry. TAU(tolerant) starts with the geometricmodel as-is even if it has non-
manifold nodes, cracks, overlapping, twisted triangles. It uses a looser meshing tolerance of
5.e-5 of the longest model dimension as the first attempt, then 1.e-4 of the longest model
dimension as the second attempt if it fails. Therefore, for very large scalemodels with tiny
features inside, those tiny features or gapsmay get lost if they are smaller than themeshing
tolerance by TAU(tolerant) mesher. It is important to check the critical regions or objects for
suchmodels. If they are critical and very important for the simulation, then High Surface
Representationmesh operations have to be assigned to those objects to be well preserved in
themesh.

Strict performs stitching, and resolves surfaces and contactsmore accurately, but takesmore
time andmay cause issues for dirtymodels. TAU (strict) needs a clean geometricmodel to
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start with. It performs the stitching first with the ACIS union functions. If it fails, then it
automatically falls back to TAU(tolerant) mesher. Also, TAU(strict) uses a tight meshing
tolerance of 1.e-4 of user unit. It will preserve thin, narrow gaps or tiny features better.

l Classic Mesh – this is based on the Ansoft 11mesher.
For Maxwell 2D, it contains radio buttons for:
l TAU Mesh – The TAU 2D mesh is a fully automated initial mesh generationmethod that
creates a uniform, high quality, solver-drivenmesh. It is designed for the solvers without
adaptive passes, or demanding high qualitymesh. Several meshing technologies can be
found only in the TAU 2D mesh, such as skin depth layer mesh, clonemesh, rotational
sweepmesh, and remeshing.

l Classic Mesh – this is based on the Ansoft 11mesher.
8. Tomake your choice the default, use theSave as default check box.
9. ClickOK to apply your choices.

The settingswill be applied to the initial mesh generated on the selected surface.

Related Topics

DefiningMeshOperations
TAU 2D MeshGeneration

TAU 2D Mesh Generation
TheMaxwell TAU (Triangular Adaptive Uniform) 2D mesher provides a fully-automated initial mesh
generationmethod that creates a uniform, high quality, solver-drivenmesh. It is designed for solvers
without adaptive passes, or demanding high qualitymesh. Several meshingmethods are used by
the TAU 2D mesher, such as skin depth layer mesh, clonemesh, rotational sweepmesh, and
remeshing.
To benefit from thesemeshing technologies for Maxwell 2D designs, youmust select TAU Mesh on
the Initial Mesh Settings dialogMeshing Method tab by right-clicking theMesh icon in the Project
Manager and selectingMesh Operations>Initial Mesh Setting.
When TAU 2D mesh is selected, itsmeshingmethods are applied to specific local regions. The local
regional meshes are then assembled as the final step for the simulation.
The following sections describe TAU 2D mesh generationmethods for rotational models, for non-
rotational models; and the Skin Depth Layer MeshGenerationmethod, which can be applied to any
model.

Related Topics

TAU 2D MeshGeneration for Rotational Models
TAU 2D Regular MeshGeneration (Non-Rotational Models)
TAU 2D Skin Depth Layer MeshGeneration
TAU 2D Mesh Assembly

DefiningMeshOperations 15-25
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

TAU 2D Mesh Generation for Rotational Models

If themesher determines that amodel is a rotational model, rotational mesh generation is used, in
which the clonemesh and rotational sweepmeshmethods described below are used.
To determine if themodel is a rotational model, the curves around the origin are calculated. The
smallest rotational gap is defined as the “Band” gap. Themodel shown below is an example of a
rotational transient model.

Twomajor regions: a static region and amoving region are classified by the Band gap.

TAU 2D Clone Mesh Generation
The static geometricmodel in the local rotational region is analyzed to determine whether it has
multiple duplicate sub-regions. If a model has duplicate sub-regions, the TAU clonemeshing is
automatically activated to generate themesh so that each sub-region has the topologically identical
mesh. The example below shows a static clone region with six identical sub-regions - amaster and
clone regions.

In the Clone region, theMaster region is calculated and analyzed. If theMaster region has the
symmetric feature, the symmetricmesh is generated.
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As shown above, a uniformmesh will be generated in one half of theMaster region first, then the
mesh ismirrored about the symmetric central line to generate the symmetricmesh in theMaster
region.
Because all the child regions have identical geometric features, themesher uses copy-paste to
replicate theMaster mesh at each of the child regions, rotating it to the appropriate angles.

This ensures the identical mesh in the different regions, especially for the teeth.
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TAU 2D Rotational Sweep Mesh Generation
If the local region does not have identical geometric sub-regions and thus the clonemesh is not
generated, then geometric analysis is performed to verify whether the region is rotational.
Around the rotational center, if a region has two or more rotational curves, this region can be defined
as a “rotational” region. In this case, “Rotational sweep” mesh generation is used proceeding in the
radial direction with layers while using uniform sweep elements in the rotational direction. This
meshingmethod controls the aspect ratio in the radial direction, while maintaining the uniform sweep
in the rotational direction.
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Related Topics

TAU 2D Regular MeshGeneration (Non-Rotational Models)
TAU 2D Skin Depth Layer MeshGeneration
TAU 2D Mesh Assembly

TAU 2D Regular Mesh Generation (Non-Rotational Models)

If themodel is not identified as a rotational model, the TAU 2D regular mesher is used to generate
themesh. TAU 2D mesher does not use ACIS union as the Classicmesher does. Instead it reads
the objects individually as-is. Remesh technology is used to get the best representation of the curves
with minimummesh points.

The TAU 2D regular mesher uses a top downmeshing algorithm that starts themesh from a uniform
basemesh, then adapts themesh in the necessary regions, and does the boundary recovery later.
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Mesh quality is controlled andmaintained during the entire meshing process. Tomaintain a uniform
mesh, 1:2 splittingmethod is used for the transitions from small elements to large elements.

In most cases, users do not need to add any additional seed refinement mesh operations. Themesh
can be directly used to do the transient simulation. For solvers with adaptive passes, a few passes
can be saved for the convergence although the initial mesh is larger since it is high quality and
uniform.

Related Topics

TAU 2D MeshGeneration for Rotational Models
TAU 2D Skin Depth Layer MeshGeneration
TAU 2D Mesh Assembly

TAU 2D Skin Depth Layer Mesh Generation

For thismesh generationmethod, the number of layers and the thickness can be specified by
selecting one or more body edges. Theywill be exactly respected in the TAU mesh unless the layer
thickness is too large, or layers from other directions overlap, intersect, or leave a narrow gap.
The layer mesh starts from the specified edges, and advances towards the direction of the body
region layer-by-layer. If two bodies contact each other, the edges from these two bodies at the
contact regionmay coincide, appearing as one edge even though there actually are two or more
edges. Therefore, please be careful when picking the edges inmultiple body contact regions. In such
cases, it is recommended that you hide all other bodies and only display the desired body, then
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make the edge selections. Remesh technology is then used to generate themesh on the edges
based on the thickness of the first layer to maintain themesh quality.

The aspect ratio in the layer mesh is defined by the element length in the tangential and normal
directions. The ratio will be in the range of 1 to 40 based on the smallest thickness in the layers.
Different layer meshmethods are using depending on the ratios. If the ratio is smaller than 4.0, the
middle points of the edges are used to advance layers forward as shown below.

If the ratio ismore than 4.0, edge points are used to advance layers.

Messages are displayed if the thickness is too small or too large.

DefiningMeshOperations 15-31
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Related Topics

Skin Depth Layers Setting for 2D
TAU 2D MeshGeneration for Rotational Models
TAU 2D Regular MeshGeneration (Non-Rotational Models)
TAU 2D Mesh Assembly

TAU 2D Mesh Assembly

The final step to get a conformal mesh for the entire model, assembles the local regionmeshes
generated by the clonemesh, rotational sweepmesh, and skin depth layer meshmethodswith the
mesh generated by the TAU 2D regular meshingmethod as the final step.

Related Topics

TAU 2D MeshGeneration for Rotational Models
TAU 2D Regular MeshGeneration (Non-Rotational Models)
TAU 2D Skin Depth Layer MeshGeneration
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Rotational 3D Layer Mesh Generation
Rotational 3D Layer Mesh can only be applied to non-skewed bodies in Maxwell rotational models in
which the CylindricalGapmesh operation is used.

l Only body level selection is allowed.
l Rotational Layer mesh can only be generated on non-skewed objects for current release.
l User can select multiple bodies, and assign a layer mesh operation to all of them.
l Rotational layer mesh is only generated for bodies near the band.
l For selected bodies, no layer mesh will be generated in the axial direction, or for matching
boundaries.

There are three types of rotational layer meshes:
l EdgeCut Layer Mesh
l Rotational Layer Mesh
l EdgeCut + Rotational Layer Mesh

Related Topics

"Assigning Cylindrical Gap Treatment" on page 15-5
"Changing Properties and ReassigningMeshOperations" on page 15-39

Edge Cut Layer Mesh Generation

EdgeCut Layer Mesh creates one layer of mesh on the bodieswith the layer thickness defined by
user input. Layer mesh will not be created at the top or bottom of the axial direction andmatching
boundary faces. If the object has clone feature, the layer mesh will be coupled with the clonemesh.
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To apply Edge Cut Layer Mesh:
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1. Select the desired bodies near the band.
2. Right click to open the context menu, and selectAssign Mesh Operation>Inside

Selection>Edge Cut.

3. In theEdge Cut Based Refinement dialog box, you can rename themesh operation, and
specify the layer thickness. The recommended layer thickness is the band gap distance.

4. ClickOK.

Related Topics

"Rotational 3D Layer MeshGeneration" on page 15-33
"Rotational Layer MeshGeneration" on the next page
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"Edge Cut + Rotational Layer MeshGeneration" on page 15-38
"Changing Properties and ReassigningMeshOperations" on page 15-39

Rotational Layer Mesh Generation

Rotational Layer Mesh creates up to three layers in the radial direction starting from the facesmost
adjacent to the “Band”. You can define theNumber of Layers (up to three) and Total Layer
Thickness.

To apply Rotational Layer Mesh:
1. Select the desired bodies near the band.
2. Right click to open the context menu, and selectAssign Mesh Operation>Inside

Selection>Rotational Layer Mesh.
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3. In theRotational Layer Based Refinement dialog box, you can rename themesh
operation, specify the number of layers (maximumof 3), and the total thickness of all the layers
combined.

4. ClickOK.
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Related Topics

"Rotational 3D Layer MeshGeneration" on page 15-33
"Edge Cut Layer MeshGeneration" on page 15-33
"Edge Cut + Rotational Layer MeshGeneration" below
"Changing Properties and ReassigningMeshOperations" on the facing page

Edge Cut + Rotational Layer Mesh Generation

These settings are a combination of Edge Cut Layer Mesh and Rotational Layer Mesh esttings, and
as such has the properties of both. One layer of edge cut mesh will be generated first, then extra
multiple layers will be added by the rotational layer mesh settings.

To apply Edge Cut + Rotational Layer Mesh:
1. Select the desired bodies near the band.
2. Right-click to open the context menu, and selectAssign Mesh Operation>Inside

Selection>Edge Cut.
3. In theEdge Cut Based Refinement dialog box, you can rename themesh operation, and

specify the layer thickness. The recommended layer thickness is the band gap distance.
4. Reselect the same bodies.
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5. Right-click to open the context menu, and selectAssign Mesh Operation>Inside
Selection>Rotational Layer Mesh.

6. In theRotational Layer Based Refinement dialog box, you can rename themesh
operation, specify the number of layers (maximumof 3), and the total thickness of all the layers
combined.

7. ClickOK.

Related Topics

"Rotational 3D Layer MeshGeneration" on page 15-33
"Edge Cut Layer MeshGeneration" on page 15-33
"Rotational Layer MeshGeneration" on page 15-36
"Changing Properties and ReassigningMeshOperations" below

Changing Properties and Reassigning Mesh Operations

To alter themesh settings, find the entry under MeshOperations in the Project Manager. Double
click to bring up the dialog box. Change the layer thickness or number of layers as necessary.

To reassign which bodies themesh operations are applied to, first select all the bodies you would like
to assign the bodies to. Then right click themesh operation in the Project Manager and select
“Reassign.” Themesh operation will now be reassigned to the selected objects.
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Related Topics

"Edge Cut Layer MeshGeneration" on page 15-33
"Assigning Cylindrical Gap Treatment" on page 15-5
"Edge Cut + Rotational Layer MeshGeneration" on page 15-38
"Rotational 3D Layer MeshGeneration" on page 15-33

Deleting All Previously-Assigned Mesh Refinements
To delete previously-assignedmesh refinement data:

l ClickMaxwell>Mesh Operations>Delete All.
Note This will not alter any existingmeshes that have alreadymade use of one or moremesh

refinement operations. However, deletedmesh operationswill not be used again after
reverting to the initial mesh.

Viewing List of Mesh Operations
To list all mesh operations for the project, do the following from the project tree:

1. Right-clickMesh Operations.
A shortcut menu appears.

2. Select List from the shortcut menu.
TheDesign List dialog box appears, with the Mesh Operations tab displayed.

3. ClickDone to close this dialog box.

Reassigning a Mesh Operation
To reassign a previously-assignedmesh setup, do the following in the project tree:
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1. Select the object or objects to which you want to reassign themesh operation.
2. UnderMesh Operations, right-click themesh refinement you had previously completed.

A shortcut menu appears.
3. SelectReassign from the shortcut menu.

Themesh operation is reassigned to the currently selected objects.
To view the objects to which amesh operation is assigned:

1. In the Project tree, select themesh operation.
2. Right-click themesh refinement you had previously completed.

A shortcut menu appears.
3. SelectSelect Assignment from the shortcut menu.

The objects to which the operation is assigned are selected.

Related Topics

DefiningMeshOperations

Viewing Mesh Properties
To view mesh properties, do the following in the project tree:

1. UnderMesh Operations, right-click themesh refinement you had previously completed.
A shortcut menu appears.

2. SelectProperties from the shortcut menu.
The dialog box for the type of mesh operation associated with the selectedmesh refinement
appears.
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16 - Specifying Solution Settings
Specify how Maxwell computes a solution by adding a solution setup to the design. You can define
more than one solution setup per design.

Each solution setup includes:
l General data about the solution's generation.
l Adaptivemesh refinement parameters if you want themesh to be refined iteratively in areas of
highest error.

To add a solution setup to a design:
1. Select a design in the project tree.
2. ClickMaxwell3D>Analysis Setup>Add Solution Setup orMaxwell2D>Analysis

Setup>Add Solution Setup.
l Alternatively, right clickAnalysis in the project tree, and then clickAdd Solution Setup on
the shortcut menu.

TheSolve Setup dialog box appears containing several tabs.
For Non-Transient Solutions
The following tabs are present for non-transient solutions:

General Includes general solution settings. Also contains a button for settingHPC and
Analysis Options, which allows you to select or create an analysis configuration.

Convergence Includes settings for convergence.

Expression
Cache

Contains an optional list of expressions that you can specify for convergence
criteria.

Solver Includes settings for nonlinear residual andmatrix solver type.

Frequency
Sweep

Includes setting for varying the frequency of an EddyCurrent or AC Conduction
solution.
NOTE: This tab is present only for EddyCurrent and AC Conduction solutions.

Defaults Enables you to save the current settings as the defaults for future solution setups
or to revert the current settings toMaxwell's standard settings.

For Transient Solutions
The following tabs are present for transient solutions:
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General Includes general solution settings. Also contains a button for settingHPC and
Analysis Options, which allows you to select or create an analysis configuration.

Save
Fields

Enables you to create a time point list for saving field solutions.

Advanced Supports user control program, import mesh options, and starting/continuing from a
previously solved setup.

Solver Includes settings for nonlinear residual solver type, for enabling the solver to fast
reach steady-state, and for selecting the TimeDecompositionMethod.

Expression
Cache

Contains an optional list of expressions that you can specify for evaluating solutions.

Defaults Enables you to save the current settings as the defaults for future solution setups or
to revert the current settings toMaxwell's standard settings.

For Electric Transient Solutions
The following tabs are present for electric transient solutions:

General Includes general solution settings. Also contains a button for settingHPC and
Analysis Options, which allows you to select or create an analysis configuration.

Solver Includes settings for initial condition, temporal tolerance, computing power loss data,
and importing amesh.

Expression
Cache

Contains an optional list of expressions that you can specify for evaluating solutions.

Defaults Enables you to save the current settings as the defaults for future solution setups or
to revert the current settings toMaxwell's standard settings.

3. Specify the desired settings on the tabs.
4. If you want to disable an individual analysis, uncheck theEnabled check box. Refer to

Disabling and Enabling an Analysis Setup for additional information.
5. If you want to use the default values, clickUse Default.
6. ClickOK.

Related Topics

Analysis Parameters
Setting Analysis Parameters for Non-Transient Solutions
Setting Analysis Parameters for Transient Solutions
Setting Analysis Parameters for Electric Transient Solutions
Disabling and Enabling an Analysis Setup
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Resetting Analysis to Time Zero
ChangingMemory Settings
Specifying the Solver Type
Technical Notes:Meshing Aspects for 3D Transient ApplicationsWithMotion
DefiningMeshOperations
Copying a Solution Setup

Analysis Parameters
During adaptive analysis the system iteratively refines the startingmesh in order to reduce the size of
individual elements in areas of high error — thus improving the accuracy of the solution.

When an adaptive analysis is performed:
l Maxwell generates a field solution using the specifiedmesh.
l It then analyzes the accuracy of the solution by calculating an energy value based on the error
in the solution. The exact mechanism for evaluating the error varies by solution type. For
example, in magnetostatic it can use Curl H to find the current density and then subtract all
input currents and other sources. For a perfect solution the result would be zero, for a real,
finite mesh the result is some amount of residual current density. An energy value calculated
from this residual current density is called the error energy. The “Energy Error %” is the error
energy as a percentage of the total energy (calculated with the original sources).

l If more than 1 pass has been completed, the software also calculates the change in total
energy from the previous pass. The percentage difference is the “Delta Energy (%)”. Adaptive
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refinement continues until both the “Energy Error %” and the “Delta Energy (%)” are below
the target Percent Error specified by the user (or until it reaches theMaximumNumber of
Passes requested).

l When the error targets are not satisfied themesh is refined. This is generally done by
subdividing the elements with the highest error energy into smaller elements.

l The user can optionally request to “UseOutput Variable Convergence”. This is an additional
stopping criterion. The Energy Error % and the Delta Energymust still be below the target
Percent Error, but the software will also compute the specified Output Variable for each
adaptive pass and will calculate the percentage change in that value for each pass after the
first (this is the “Output Var. Delta (%)”). The solution will continue until the energy error
criteria aremet and theOutput Var. Delta is below the target “Max. Delta Per Pass” specified
by the user for output variable convergence (or until MaximumNumber of Passes).

Related Topics

Setting Analysis Parameters for Non-Transient Solutions
Setting Analysis Parameters for Transient Solutions

Setting Analysis Parameters for Non-Transient Solutions
When you set up an analysis, define the parameters on the following tabs of theSolve Setup dialog
box (which appears when you clickMaxwell>Analysis Setup>Add Solution Setup):

l General (Name, Adaptive Setup, Parameters)
l Convergence
l Expression Cache
l Solver
l Frequency Sweep (EddyCurrent and AC Conduction solutions only)
l Defaults

Defining Settings on the General Tab for Non-Transient Solutions

The following settings can be defined on theGeneral tab of theSolve Setup dialog box for non-
transient solutions:

l Setup Name
l Adaptive Setup
l Parameters

Setup Name for Non-Transient Solutions

By default,Setup1 appears as the name of the first analysis you set up.
To change the name of the setup, type the new name in theName text box on theGeneral tab of the
Solve Setup dialog box.
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To disable the setup, uncheck theEnabled check box. Refer toDisabling and Enabling an Analysis
Setup for additional information.

Adaptive Setup for Non-Transient Solutions

To specify adaptive settings, click theGeneral tab in the Solve Setup dialog box and use the
options in theAdaptive Setup section. Adaptive settings include the following:

l Maximum Number of Passes. TheMaximum Number of Passes is themaximum
number of mesh refinement cycles you would likeMaxwell to perform. This value is a stopping
criterion for the adaptive solution; if themaximumnumber of passes has been completed, the
adaptive analysis stops. If themaximumnumber of passes has not been completed, the
adaptive analysis continues unless the convergence criteria are reached.
Note The size of the finite element mesh— and the amount of memory required to

generate a solution— increaseswith each adaptive refinement of themesh. Setting
themaximumnumber of passes too high can result in Maxwell requestingmore
memory than is available or taking excessive time to compute solutions.

l Percent Error. ThePercent Error allows you to control the desired solution accuracy.
Smaller values producemore accurate (but slower) solutions; larger values produce less
accurate (but faster) solutions. At each step in the adaptive process, the energy and error
energy are computed, and you can view themost recent solutions as soon as they are
completed. After themesh is refined, thematrix is calculated on the refinedmesh. The relative
change between the previousmatrix and the current matrix is then computed and reported as
thematrix delta; the target matrix delta is thePercent Error. A small delta indicates that
further mesh refinement will probably not change the solution.

Parameter Settings

On theGeneral tab of theSolve Setup dialog box, if you want to solve for fields only and no other
parameters, then click theSolve Fields Only check box.
When this check box is cleared, the following options are available:

l Solve Matrix. SelectAfter last pass orOnly after converging.

Defining Settings on the Convergence Tab for Non-Transient Solutions

To set the convergence data, click theConvergence tab in theSolve Setup dialog box.
Convergence settings can be standard or optional. Standard convergence settings include the
following:

l Refinement Per Pass – The percent you set forRefinement Per Pass determines how
many tetrahedra are added at each iteration of the adaptive refinement process. The
tetrahedra with the highest error are refined.

l Minimum Number of Passes – Theminimumnumber of adaptive passes even if the
convergence criteria are reaches.
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l Minimum Converged Passes – Theminimumnumber of adaptive passes to continue after
the convergence criteria are reached.

Optionally, convergence criteria can also be based on the value of an output variable. This condition
is in addition to the normal stopping criteria. To base the convergence criteria on an output variable
value, refer to Defining Expressions for Non-Transient Solutions.
For 2D EddyCurrent solutions only, improved accuracymay be obtained by including loss in the
convergence criteria. To include the loss calculation in convergence, select theUse Loss
Convergence check box.

Note Maxwell 2D versions prior to version 12 did not use loss in the convergence
calculation.

Related Topics

Defining Expressions for Non-Transient Solutions

Defining Expressions for Non-Transient Solutions

You can specify additional convergence criteria through the use of expressions and output variables.
TheMaximum Delta or theMaximum Percent Delta defined for expression convergence
represents the difference in values of the expressions between consecutive adaptive passes. If the
difference in the value of the expression between consecutive passes is less than theMaximum
Delta or theMaximum Percent Delta value this part of the convergence criteria is satisfied.
To set expressions as convergence criteria:

1. Right-click on the Analysis icon in the Project tree to open theSolution Setup dialog box.
2. Click theExpression Cache tab and click theAdd... button to open theAdd to Expression

Cache dialog box.
3. Specify the Context for the expression, includingReport Type, Solution,Geometry, and

Points.
4. Under the Trace tab, select from theCategory,Quantity, and Function lists to create

expressions.
Selecting a listed category lists the Quantities and Functions available for each category. If you
have defined one or more output variables, you can see them by selecting theOutput
Variables category. The Output Variables button opens a dialog box that lets you define
output variables. See Specifying Output Variables.
When you have created an expression, it appears in theExpression field of the Trace tab. If
desired, you can use theRange Function button to select range functions to apply to the
expression.
Under theCalculation Range tab, you can view the values of available sweep variables.
Clicking the ellipsis [...] button in theEdit column opens a list of values fromwhich you can
select.

5. When finished defining the expression that you want to add to the cache, click theAdd
Calculation button.
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This adds the selected expression and the associated context to a table in theExpression
Cache tab. You can define additional expressionswith contexts and add them in the same
way.

6. When finished adding expressions, clickDone to close theAdd to Expression Cache dialog
box.
TheExpression Cache tab lists the expressions you have added in a table.
l The Title field is editable, by default showing the name as built from the expression (with
underscores removed).

l TheExpression field shows the full expression. If necessary, you can resize theSolution
Setup dialog box. You can also resize each columns in the table.

l TheContext column showsNone for Modal solutions, or the appropriate geometry for
Fields calculations.

l The Intrinsics column shows a clickable button that opens anEdit Calculation Range
dialog box. If the Intrinsics column button showsNone you cannot edit the value. If the
button shows variables, click the ellipsis [...] in theEdit column to display a list of the
variable values fromwhich you can select. ClickOK to close theEdit Calculation Range
dialog box and apply your selections to the Expression Cache.

7. To designate one or more expressions for convergence, click the field for theConvergence
column for each expression.
This opens anAdaptive Convergence dialog box. CheckUse this expression for
convergence to enable the radio buttons. You can then specify theMaximum Delta (an
absolute change in value between passes) or theMaximum Percent Delta (a percentage
change in value between passes) criteria. TheMaximum Delta provides a way around a
potential issue if your expression is essentially zero and the numeric noise from pass to pass
causes themaximumpercentage delta to remain high. In that case adaptive refinement
continues until you get to themaximumnumber of passes.

8. Optionally, buttons allow you toEdit andRemove selected expressions, and toRemove All
expressions in the table.

9. For EddyCurrent only check boxes allow you to save the expression cache either with
Evaluate Cache vs. Pass, Evaluate Cache vs. Freq, or both.

10. When finished defining expressions, clickOK to close theSolution Setup dialog box.

Related Topics

Viewing Convergence Data
Viewing theOutput Variable Convergence
Specifying Output Variables

Defining Settings on the Solver Tab for Non-Transient Solutions

The settings on theSolver tab of theSolve Setup dialog box depend on the solution type selected
for that project.
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l Magnetostatic Solver Settings
l EddyCurrent Solver Settings
l Electrostatic Solver Settings

Magnetostatic Solver Settings

For magnetostatic solutions, you can define the following settings on theSolver tab of theSolve
Setup dialog box:

l Enter a value in theNonlinear Residual text box.
l For 3D magnetostatic designs only, you can Enable Iterative Solver.
l Advanced Option settings allow you to performmore sophisticated simulations of the
magnetostatic field.

l Use pre-computed permeability data (for general soft magneticmaterials) uses a
previously solvedmu (apparent permeability) distribution from a linked source design.
Selecting this option enables theSetup Link button, and automatically opens the
Setup Link dialog in which you setup the link. Optionally, you can override the solved
muwith a user-specified program, which you can specify on theAdvance tab of the
Setup Link dialog. Select the Including magnets check box if magnets are included
in the distribution. Refer to "Permeability Options for Magnetostatic Solutions" on the
facing page for details on using these settings.

l The Import mesh check box can be selected in the target design if themesh for the
same geometry in the linked source design is to be used in the analysis. Selecting this
option enables theSetup Link button, and automatically opens theSetup Link dialog
in which you setup the link. Refer to "Import Mesh for Non-Transient Solutions" on
page 16-19 for details on using this setting.

l If an advanced option has previously been set up, you can click theSetup Link button
to open theSetup Link dialog and edit the link settings.
Note The data link used to link source and target designs uses data caching

technology. Therefore, if the design changes, to make sure the new data
(from the source design) is used in the target design, right-click theAnalysis
field of the target design in the project tree, and selectClear Linked Data.
This flushes existing data.

Related Topics

"Enabling the Iterative Solver" on page 16-23
"Import Mesh for Non-Transient Solutions" on page 16-19
"Permeability Options for Magnetostatic Solutions" on the facing page
"Setup Link for Non-Transient Solutions" on page 16-20
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Permeability Options for Magnetostatic Solutions

To set permeability options in theSolve Setup dialog box:
1. ClickMaxwell>Analysis Setup>Add Solution Setup to open theSolve Setup dialog box.
2. Click theSolver tab.
3. In theAdvanced Option section, selectUse pre-computed permeability data, which uses

a previously solvedmu (apparent permeability) distribution from a linked source design.
Selecting this option enables theSetup Link button, and theSetup Link dialog opens,
allowing you to specify the source project, design, and solution containing the desired
information. Themesh between the two linked designs is the same. You can use the apparent
permeability that has been frozen from a previously solved source design.
By default, theSetup Link dialog opens on theGeneral tab with only the This project radio
button selected.

Note If a link had previously been set up, theSetup Link dialog opens inView Only
modewith all settings disabled.

To enable settings, you can selectEdit Link.

4. To select a source project do one of the following:
l To use the current project as the source, checkUse This Project. This disables the
Save source path relative to: radio buttons and the ellipsis [...] button and its
associated text field.

l To specify a source project file other than the current project click the ellipsis [...] button
to open a file browser window.When you have selected the project, click theOpen
button to accept the project file for the setup. You can use the check box toOpen as
read only.

Use the radio buttons to specify whether to save the source path relative to The project
directory of selected product or This project.

5. When you select a source project file, theSource Design and theSource Solution fields
are filled in with default values, and their drop downmenus contain any available designs and
solutions. You can use the drop downmenus to choose from the available designs and
solutions.
The “Default” solution is the product-dependent solution of the first Setup – the setup listed
first in the source design's project tree (alphanumerical order). A product-specific solution of
this setup becomes the default solution. In most designs, it is LastAdaptive.

6. Use the check box to specify whether toSimulate source design as needed.
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7. Use the check box to specify whether toPreserve source design solution. Note that in the
extractor mode, the source project will be saved upon exit. Extractor modemeans that the
software is opened during the link solely for the purpose of solving.

8. TheVariable Mapping tab lets you view any variables contained in the selected Project.
When there are variables in the source design, you can choose to “map” these variables to
constant values, expressions or variables in the target designs. Variablemapping becomes
more important when the datalink type requires source and target design to be geometrically
identical and source design is geometrically parameterized.
For linked designswith variables of the same name, you can clickMap Variables by Name to
automaticallymap same named variables. In this example the variables “height” and “weight”
aremapped to the Source, whereas the “current” variable does not have a same named
counterpart, and retains its value in the source design.

9. Optionally, you can override the solvedmuwith a user-specified control program, which you
can specify on theAdvance tab of theSetup Link dialog. Additionally, because the non-
linear characteristics of manymagneticmaterials are too complex to be defined through the
definition of a BH-Curve, an advanced feature allows the permeability characteristic of the
target design to be obtained bymathematical manipulation of the permeability from the source
design via a user-defined control program. To use this feature:

a. CheckEnable user program.
b. Specify theAbsolute path of program to the user control program.
c. Specify anyAdditional arguments needed by the user control program.

Note For detailed information on using this feature, refer toUsing the Advanced
Permeability Option.

10. ClickOK to accept the setup and close the Setup Link dialog and return to the Solve Setup
dialog.
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11. After setting up the link, you can select the Including magnets check box if magnets are
included in the distribution.

12. When you are finished specifying solution settings, clickOK to close theSolve Setup dialog
box and finalize the solution setup.
Note The usual way to create the linked designs is by copying and pasting an existing

design from the project of your choice once the design is complete. Occasionally an
existing design (possibly from a different project) can be used as a source.
The data link automatically attempts to solve the linked (source) design if necessary
(if no solution exists), then automatically copies themesh and necessary data
(calculated distribution of permeability), and finally performs the requested
calculation in the target design. This data link allows you to calculate themagnetic
field to be performed in a design with, for example, modified sourceswhile keeping
the permeability in a "frozen" state calculated in a different design (the same
geometry andmesh but with different sources).

Using the Advanced Permeability Option

The non-linear characteristics of manymagneticmaterials are too complex to be defined through the
definition of a BH-Curve. This feature enhances the existing permeability-link by enabling the
permeability characteristic of the target design to be obtained bymathematical manipulation of the
permeability from the source design. The nonlinear “apparent” permeability from the source design
is frozen (linearized) and used by the target design. Because the permeability in the target design is
linear, the apparent and the incremental permeabilities will be identical and the apparent and
incremental inductanceswill alsomatch.
Thismanipulation is done via a user-supplied control program. A user-specified executable is
launched at the beginning of target design simulation and the linked permeability data (i.e., the
“frozen” mu) from the source design is overridden by the values calculated by the user control
program. The target design solver is then launched and uses the overridden value in its calculation.
The user control executable program is launched with two file names as arguments:

1. Per mesh element permeability value. This is the solvedmu (i.e., the apparent
permeability not the incremental permeability) from the source design. Note that the format of
this file is different between 2D and 3D designs.

2. Per mesh element information. Information includes the centroid location (x, y, z), Bx, By,
Bz at the centroid and Hx, Hy, Hz at the centroid. The format of this file is the same between
2D and 3D designs.
Note Refer to Advanced Permeability Option File Formats for information on these file

formats.

Considerations for using this feature

1. To setup the advanced user control program option for permeability, selectSetup Link on the
Solver tab to open the Setup Link dialog.
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2. Specify theSource Design on theGeneral tab.
3. On theAdvance tab, select the check boxEnable user program and provide the absolute

path to the executable, and provide anyAdditional arguments needed by the user program.

4. Simulate the target design.
Simulation of the source design will be automatically started if it is not already simulated. The
user-supplied executable is launched. Additional information is logged inSetup>Profile
regarding the launch of user executable.

5. Simulation of the target design continues after user executable exits.

Specifying Solution Settings 16-12
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Note the following:

l Field post processing of target design will use the user-overriddenmu.
l Editing boundary/excitation setup in the target design invalidates the current solution in target
design.

l Linked data remains valid when boundary/excitation is changed. On next simulation of the
target design, the prior user-overridden permeability will be used.

l Edit of the link setup (this includes the path to the user control program, or “removing” the user
control programwill invalidate the current solution and also the cached linked data. On the
next simulation of the target design, the “frozen” permeability will be extracted again from the
source design. If the link setup has opted to enable the user control program, the currently
designated user programwill be launched. If the link setup has opted not to override the linked
data, the extractedmu from the source design will be used as-is.

l Clear Linked Data in the target design invalidates the current solution and cached linked
data in the target design.

l On the next simulation of the target design, the frozen permeability will be extracted again
from the source design. The user executable will be launched to allow the permeability to be
overridden.

l Editing the source design has no effect on the existing solution in the target design. Users
need toClear Linked Data in target design if a new simulation in the target design is desired.

l After the simulation of the target design, the user-overridden “mu” becomes part of the
solution of the target design and this target design can then be used as the source of another
design. This is explained inmore detail with the following work flow.

Advanced Permeability Option File Formats

The following are the file formats for this feature:

3D Per mesh element permeability value.

This is the solvedmu (i.e., the apparent permeability not the incremental permeability) from the 3D
source design.
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In the above example, SolidID, h, and E_DATA are keywords. “6” is the object ID. “14” is the number
of elements in the object with ID “6”. “230”, “231”, etc. are element IDs.
Note that there could bemultiple "blocks" of the above data if there aremultiple non-linear objects in
the design, as illustrated below.

2D Per mesh element permeability value.

This is the solvedmu from the 2D source design.
The format is:

<number of total elements>
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<objectID> <elementID> <X/R center position of element> <Y/Z center
position of element> <mu>

For example, the following solvedmu indicates that there is ONE object that has TWOmesh
elements. The first element has amu value of 2.7482 and the second element has amu of 2.76553.

The following solvedmu indicates a total of 16mesh elements that belong to two objects.

Per mesh element centroid location (x, y, z), Bx, Bx, By, Hx, Hy, Hz at the centroid.
(All values in SI units.)

SolidID 6 14

h 230 x y z Bx By Bz Hx Hy Hz

.

.

.

E_DATA

Related Topics

"Using the Advanced Permeability Option" on page 16-11

Eddy Current Solver Settings

For an eddy current solution:
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1. Enter a frequency value in theAdaptiveFrequency text box, and select the desired units.
2. For 2D and 3D designs, enter a value in theNonlinear Residual text box.
3. For 3D designs, you can optionally Enable an Iterative Solver.
4. For 3D designs, you can optionally choose toUse higher order shape functions. Enabling

the higher order option gains better accuracy for eddy current regions.
5. For 3D designs, you can optionally choose toUse pre-computed permeability data. Refer

to Using the Permeability LinkOption for EddyCurrent Solutions for details on this option.
6. If desired, you can Import Mesh.

Related Topics

Using the Permeability LinkOption for EddyCurrent Solutions
Import Mesh
Enabling the Iterative Solver

Using the Permeability Link Option for Eddy Current Solutions

For projects with materials whose permeability is nonlinear, setting the permeability link in a 3D Eddy
Current design enables it to use the permeability data calculated in a source 3D magnetostatic
design. In this scenario, the nonlinear analysis is only performed in the 3D magnetostatic source
design. In the 3D EddyCurrent target design, the nonlinear material is treated as linear material
using the “frozen” permeability data from the source design. The target design will be solved based
on themesh and permeability data imported from the source design. Small signal analysis is a typical
application for this feature.
Prerequisites

l Source design - Maxwell 3D Magnetostatic
l Target design - Maxwell 3D EddyCurrent
l The geometry of the source and target designsmust be identical.

To set up and use the pre-computed permeability link for projects with nonlinear material:
1. Create a 3D Magnetostatic source design using nonlinear material.
2. Solve the 3D Magnetostatic design.
3. Create a 3D EddyCurrent target design, whose geometry andmaterials are identical to the

sourcemagnetostatic design.
4. On the EddyCurrentSolve Setup dialog,Solver tab, selectUse pre-computed

permeability data, to use the permeability data that has been frozen from a previously solved
3D magnetostatic source design. Selecting this option enables theSetup Link button, and
theSetup Link dialog opens, allowing you to specify the 3D magnetostatic source project,
design, and solution containing the desired information. Themesh between the two linked
designs is the same.
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By default, theSetup Link dialog opens on theGeneral tab with only the This project radio
button selected.

Note If a link had previously been set up, theSetup Link dialog opens inView Only
modewith all settings disabled.

To enable settings, you can selectEdit Link.

5. On theSetup Link dialogGeneral tab, select the source 3D magnetostatic design and
solution. The geometry of the source and target designsmust be identical.

l To use the current project as the source, checkUse This Project. This disables the
Save source path relative to: radio buttons and the ellipsis [...] button and its
associated text field.

l To specify a source project file other than the current project click the ellipsis [...] button
to open a file browser window.When you have selected the project, click theOpen
button to accept the project file for the setup. You can use the check box toOpen as
read only.

Use the radio buttons to specify whether to save the source path relative to The project
directory of selected product or This project.

6. Use the check box to specify whether toSimulate source design as needed.
7. Use the check box to specify whether toPreserve source design solution. Note that in the

extractor mode, the source project will be saved upon exit. Extractor modemeans that the
software is opened during the link solely for the purpose of solving.

8. TheVariable Mapping tab lets you view any variables contained in the selected Project.
When there are variables in the source design, you can choose to “map” these variables to
constant values, expressions, or variables in the target designs. Variablemapping becomes
more important when the datalink type requires source and target design to be geometrically
identical and the source design is geometrically parameterized.
For linked designswith variables of the same name, you can clickMap Variables by Name to
automaticallymap same named variables. In this example the variables “height” and “weight”
aremapped to the Source, whereas the “current” variable does not have a same named
counterpart, and retains its value in the source design.
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9. ClickOK to accept the setup and close the Setup Link dialog and return to the Solve Setup
dialog.

10. When you are finished specifying solution settings, clickOK to close theSolve Setup dialog
box and finalize the solution setup.

11. Solve the target 3D EddyCurrent design.

Note If the geometry of the source and target designs is not identical, an error message
displays.

Related Topics

EddyCurrent Solver Settings

Electrostatic Solver Settings

For an electrostatic solution you can:
l For 3D designs, you can Enable an Iterative Solver.
l Import Mesh.

AC Conduction Solver Settings

1. Enter a frequency value in theAdaptiveFrequency text box, and select the desired units.
2. If desired, you can Import Mesh.

DC Conduction Solver Settings

For a DC Conduction solution:
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1. If desired, you can Import Mesh.
2. For 3D designs: optionally Enable an Iterative Solver.

Import Mesh for Non-Transient Solutions

The Import mesh check box can be selected in the “target” design if themesh for the same
geometry is to be used in the analysis. This setup is designed to be generally applicable to all
solutions.
If the Import mesh feature is selected, theSetup Link button becomes active, theSetup Link
dialog box automatically appears, and themesh will be imported from the source design to the target
design.

Note The usual way to create geometrically equivalent designs is by copying all geometry
objects from one design and then using Import From Clipboard in the other design.

1. By default, theSetup Link dialog opens on theGeneral tab with only the This project radio
button selected.
Note If a link had previously been set up, theSetup Link dialog opens inView Only

modewith all settings disabled.

To enable settings, you can selectEdit Link.

2. To select a source project do one of the following:
l To use the current project as the source, checkUse This Project. This disables the
Save source path to: radio buttons and the ellipsis [...] button and its associated text
field.

l To specify a source project file other than the current project click the ellipsis [...] button
to open a file browser window.When you have selected the project, click theOpen
button to accept the project file for the setup. You can use the check box toOpen as
read only.
Use the radio buttons to specify whether to save the source path relative to The project
directory of the selected project or This project.

3. When you select a source project file, theSource Design and theSource Solution fields
are filled in with default values, and their drop downmenus contain any available designs and
solutions. You can use the drop downmenus to choose from the available designs and
solutions.
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The “Default” solution is the product-dependent solution of the first Setup. That is the setup
listed first in the source design's project tree (alphanumerical order). A product-specific
solution of this setup becomes the default solution. In most products, it is “LastAdaptive.” In a
Transient solution type, it is “Transient.”

4. Use the check box to specify whether toSimulate source design as needed.
5. Use the check box to specify whether toPreserve the source design solution. Note that in

the extractor mode, the source project will be saved upon exit. Extractor modemeans that the
software is opened during the link solely for the purpose of solving.

6. TheVariable Mapping tab lets you view any variables contained in the selected Project.
When there are variables in the source design, you can choose to “map” these variables to
constant values, expressions or variables in the target designs. Variablemapping becomes
more important when the datalink type requires source and target design to be geometrically
identical and source design is geometrically parameterized.
For linked designswith variables of the same name, you can clickMap Variables by Name to
automaticallymap same named variables. In this example the variables “height” and “weight”
aremapped to the Source, whereas the “current” variable does not have a same named
counterpart, and retains its value in the source design.

7. You can select theAdditional mesh refinements tab to eitherApply mesh operation in
target design on the imported mesh (default), or Ignore mesh operations in target
design.

8. ClickOK to accept the setup and close theSetup Link dialog box.

Setup Link for Non-Transient Solutions

If you selected theUse pre-computed permeability data option (refer toPermeability Options for
Magnetostatic Solutions or toUsing the Permeability LinkOption for EddyCurrent Solutions), or

Specifying Solution Settings 16-20
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Import mesh, do the following to specify the source project, design, and solution containing the
information you want to use. You can also view andmap variables and, for Import Mesh, specify
additional mesh refinements.

General Tab
1. By default, theSetup Link dialog opens on theGeneral tab with only the This project radio

button selected.
Note If a link had previously been set up, theSetup Link dialog opens inView Only

modewith all settings disabled.

To enable settings, you can selectEdit Link.

2. To select a source project do one of the following:
l To use the current project as the source, checkUse This Project. This disables theSave
source path to: radio buttons and the ellipsis [...] button and its associated text field.

l To specify a source project file other than the current project click the ellipsis [...] button to
open a file browser window.When you have selected the project, click theOpen button to
accept the project file for the setup. You can use the check box toOpen as read only.

Use the radio buttons to specify whether to save the source path relative to The project
directory of the selected project or This project.

3. When you select a source project file, theSource Design and theSource Solution fields
are filled in with default values, and their drop downmenus contain any available designs and
solutions. You can use the drop downmenus to choose from the available designs and
solutions.
The “Default” solution is the product-dependent solution of the first Setup. That is the setup
listed first in the source design's project tree (alphanumerical order). A product-specific
solution of this setup becomes the default solution. In most products, it is “LastAdaptive.” In a
Transient solution type, it is “Transient.”

4. Use the check box to specify whether toSimulate source design as needed.
5. Use the check box to specify whether toPreserve the source design solution. Note that in

the extractor mode, the source project will be saved upon exit. Extractor modemeans that the
software is opened during the link solely for the purpose of solving.

Variable Mapping Tab
TheVariable Mapping tab lets you view any variables contained in the selected Project.
When there are variables in the source design, you can choose to “map” these variables to
constant values, expressions or variables in the target designs. Variablemapping becomes
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more important when the datalink type requires source and target design to be geometrically
identical and source design is geometrically parameterized.

For linked designswith variables of the same name, you can clickMap Variables by Name to
automaticallymap same named variables. In this example the variables “height” and “weight”
aremapped to the Source, whereas the “current” variable does not have a same named
counterpart, and retains its value in the source design.

Additional mesh refinements Tab
Note This tab is present only for Import mesh link operations.

If you are setting up an Import mesh link you can use the radio buttons on theAdditional
mesh refinements tab to eitherApply mesh operation in target design on the
imported mesh (default), or Ignore mesh operations in target design.

Advance Tab

Note This tab is present only when using "Permeability Options for
Magnetostatic Solutions" on page 16-9 .

If you are setting up a link for themagnetostatic solverUse pre-computed permeability
data option, you can select theAdvance tab to override the solvedmu value from the source
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file with a user-specified control program. Refer to "Permeability Options for Magnetostatic
Solutions" on page 16-9 for details on using this feature:

Related Topics

"Permeability Options for Magnetostatic Solutions" on page 16-9
Using the Permeability LinkOption for EddyCurrent Solutions
"Import Mesh for Non-Transient Solutions" on page 16-19

Enabling the Iterative Solver

The iterative solver provides an alternative to the direct solver. When you select theEnable
Iterative Solver option, Maxwell invokes the iterative solver. Maxwell automatically switches to the
direct solver if the iterative solver fails in convergence.

Note For C-matrix calculations, the direct solver usually ismore efficient (in terms of cpu time)
than the iterative solver. In such cases, even if Enable Iterative Solver is turned on, the
solver still automatically chooses the direct solver.

For more detail, see the technical notes for IterativeMatrix Solver.
To enable the iterative solver:

1. On theSolution Setup dialog boxSolver tab, check theEnable Iterative Solve check box.
This enables theRelative Residual input field.

2. Enter a value for theRelative Residual. The residual measures the convergence of the
iterative solver. The default value is 1e-6 for themagnetostatic and electrostatic solvers and
1e-4 for the eddy current solver.

Related Topics

Technical Notes: IterativeMatrix Solver Technical Details

Defining Settings on the Frequency Sweep Tab for Eddy Current
Solutions

To add one or more frequency sweeps, do the following on the Frequency Sweep tab of theSolve
Setup dialog box:

1. Select a sweep type (Linear Step, Linear Count or Log Scale) from the Type pull-down
list in theSweep Setup section.

2. Enter a start and stop time in theStart andStop fields and select the units.
3. For a linear step sweep, enter theStep Size and select the units.
4. For a linear count sweep, enter theCount.
5. For a log scale sweep, enter the number of Samples.
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6. Select or clear the Save Fields (All Frequencies) check box.
7. To add the single time step only, click theAdd Single Point button.

The new frequency step appears in the Frequency list.
8. To append a range of time steps to an existing list of time steps, click theAdd to List button.

The new added frequency steps appear in the Frequency list. Duplicated frequency points
are automatically eliminated.

9. To replace an existing Frequency list with a new Frequency list, clickReplace List.
10. To delete selected frequency points, clickDelete Selection.
11. To clear the entire Frequency list, clickClear All.
12. ClickUndo Last Change to undo the last operation (can only be done once).

Defining Settings on the Defaults Tab for Non-Transient Solutions

Default analysis parameters are used to initialize the data for new setups.
To set up the default analysis parameters, define the following parameters under theDefaults tab of
theSolve Setup dialog box:

1. ClickSave Defaults if you want to save the defaults based on the data for the current setup.
2. ClickRevert to Standard Defaults to clear the existing values.
3. ClickOK.

Setting Analysis Parameters for Transient Solutions
When you set up an analysis, define the parameters on the following tabs of theSolve Setup dialog
box (which appears when you clickMaxwell>Analysis Setup>Add Solution Setup):

l General
l Save Fields
l Advanced
l Solver
l Expression Cache
l Defaults

Defining Settings on the General Tab for Transient Solutions

The following settings can be defined on theGeneral tab of theSolve Setup dialog box for transient
solutions:

l Setup Name
l Transient Setup (2D) or Transient Setup (3D)
l HPC and Analysis Options
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Setup Name for Transient Solutions

By default,Setup1 appears as the name of the first analysis you set up.
To change the name of the setup, type the new name in theName text box on theGeneral tab of the
Solve Setup dialog box.
To disable the setup, uncheck theEnabled check box. Refer toDisabling and Enabling an Analysis
Setup for additional information.

Transient Setup (2D)

To set up a 2D transient analysis, define the following parameters on theGeneral tab of theSolve
Setup dialog:

Adaptive Time Step
1. Determine whether you want the software to adaptively alter the time step during the

simulation to optimize the solution for speed and accuracy. If so, check theAdaptive Time
Step check box. If not, continue with step _ .

2. Enter theStop Time, which is the value at which the solution will stop, and select the units.
3. Enter the Initial Time Step. This will be the time step used to start the simulation and begin

the adaptive process.
4. Enter theMaximum Time Step andMinimum Time Step to set the allowable range the

adaptive process use to alter the time step
5. Enter a value for theError Tolerance. Generally this value should be smaller than the

minimum time step specified by at least an order of magnitude.

Non-Adaptive Time Step
1. Enter theStop Time, which is the value at which the solution will stop, and select the units.
2. Enter the Time Step for the analysis, which defines the time increments, and select the units.

The time step can also be defined as the function of time, speed, and position.

Note When you have an external circuit, the Time Step is controlled from the circuit simulator,
and the time step settings in the solution setup dialog are ignored. This can be controlled
using theMaxwell 2D>Excitations>External Circuit>Set Minimum Time Step
command.
Time Step settings in the solution setup dialog box are also ignored for transient-transient
simulation in which caseSimplorer controls the time step.

Transient Setup (3D)

To set up a 3D transient analysis, define the following parameters on theGeneral tab of theSolve
Setup dialog box:
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1. Enter theStop Time, which is the value at which the solution will stop, and select the units.
2. Enter the Time Step for the analysis, which defines the time increments, and select the units.

The time step can also be defined as the function of time, speed, and position.
Note When you have an external circuit, the Time Step is controlled from the circuit

simulator, and the time step settings in the solution setup dialog are ignored. This
can be controlled using theMaxwell 3D>Excitations>External Circuit>Set
Minimum Time Step command.
Time Step settings in the solution setup dialog box are also ignored for transient-
transient simulation in which caseSimplorer controls the time step.

Defining Settings on the Save Fields Tab for Transient Solutions

To add one or more time sweeps, do the following on theSave Fields tab of theSolve Setup dialog
box:

1. Select a sweep type (Linear Step or Linear Count or Log Scale) from the Type pull-down
list in theSweep Setup section.

2. Enter a start and stop time in theStart andStop fields and select the units.
3. For a linear step sweep, enter theStep Size and select the units.
4. For a linear count sweep, enter theCount.
5. For a log scale sweep, enter the number of Samples.
6. To add the single time step only, click theAdd Single Point button.

The new time step appears in the Time list.
7. To append a range of time steps to an existing list of time steps, click theAdd to List button.

The new added time steps appear in the Time list. Duplicated time points are automatically
eliminated.

8. To replace an existing Time list with a new Time list, clickReplace List.
9. To delete selected time points, clickDelete Selection.
10. To clear the entire Time list, clickClear All.
11. ClickUndo Last Change to undo the last operation (can only be done once).

Defining Settings on the Advanced Tab for Transient Solutions

The following settings can be defined on theAdvanced tab of theSolve Setup dialog box:
l Control Program
l Start/Continue from a previously solved setup
l Import mesh

Related Topics

Nonlinear Materials
"Setup Link for Transient Solutions" on page 16-30

Specifying Solution Settings 16-26
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Using a 2D EddyCurrent Solution as the Initial Condition for a Transient Solution

Using a Control Program in Transient Solutions

User control programs are externally created executables that are called after each time step and
allow you to control the source input, circuit elements, mechanical quantities, time step, and stopping
criteria, based on the updated solutions.
The output variable values are output to a file with a fixed name of outputvar.ctl. The file contents
use the following format:

<output variable name> <output variable value>
<output variable name> <output variable value>
...

The solver maintains a copy of the previous solution in a file called previous.ctl because youmay
need first derivative information for its control purpose.
The user control program uses the file with fixed name user.ctl to output control parameters to
control the execution of the transient solver. Each file must use a predefined syntaxwhich is flexible
enough to cover a wide range of items. The process can be summarized as:

1. The transient solver reads control parameters from user.ctl.
2. The transient solver solves the current time step.
3. The transient solver copies the previous solution to previous.ctl and writes out solution

information to solution.ctl.
4. The transient solver calls the user control program.
5. The user-control programwrites control information to file user.ctl.
6. Return to the transient solver if the control program succeedswith exit status 0 or fails with exit

status non-zero.
7. Return to step 1 for the next time step.

Activating a Control Program in Transient Solutions

Use the following steps to access and invoke a user-control program to use with the transient solver.
To specify a control program to use to generate the solution:

1. Select theUse Control Program check box.
The control program field becomes active, allowing you to enter the name of the user control
program.

2. Click the ... button to select the user control program you want to use during the solution
generation process.
TheOpenwindow appears.

3. Select the control program, and clickOpen to return to theAdvanced tab of theSolve Setup
dialog box.
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4. Enter the arguments to pass to the control program in theArguments text box. The solver
calls the program in the following format:

program_name specified_arguments

5. ClickConfigure. This option can be used to initialize data before the solver is called.
The control program is called, with the -configure flag prepended to any arguments specified
in theArguments box.

6. Select or clear theCall after last time step for post processing check box. This option
instructs the software to invoke the specified user control program after the solution has
completed the final time step. This option prepends the -post flag to the list of arguments. The
solver calls the program in the following format:

program_name -post specified_arguments

The control program is called if the solve finishes normally without any errors or if you choose
Stop during the solution process. It is not called if you chooseAbort during solution
generation.

7. ClickOK to accept the configuration orCancel to ignore the settings. You return to theSolve
Setupwindow.

Control Program File Format in Transient Solutions

The user control programs have their own file formats, which should be followed when creating
control program files.

Solution and Previous Control File Formats

The solution.ctl and previous.ctl files are created by the transient solver and uses the following
format:

begin_data
time <current_time>
forceT <tangential force>
forceN <normal force>
torque <torque>
speed <speed>
position <position>
windingI <winding_name> <current_value>
windingV <winding_name> <voltage_value>
windingEMF <winding_name> <back_emf_value>
windingFlx <winding_name> <flux_linkage_value>
...
...
barI <current_value>
barV <voltage_value>
solidI <object_name> <current_value_for_an_active_solid_
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conductor>
...
...
condPwrLoss <total_power_loss_in_solid_conductor>
end_data

User Control File Format

The user.ctl file is created by the user control program and uses the following format:
begin_data
windingSrc <winding_name> <source_value>
windingR <winding_name> <resistance_value>
windingL <winding_name> <inductance_value>
...
...
...
loadTorque <value>
loadForce <value>
damping <value>
stop <0 or 1>
timeStep <value>
loadInertia <value>
end_data

Note The "loadTorque" and "loadForce" keywords are interchangeable for the solver, and are
assigned to the same variable. Whether the load is a force or a torque is determined by the
motion type. It is recommended that users set values only for those parameters being
used.

Start/Continue from a Previously Solved Setup

Enabling theStart/Continue from a previously solved setup option allows the source design
solution to be linked to a set of different target designs, where the user can continue the solution
based on a different parameter/circuit setup. For example, you can use this option to link a 2D Eddy
Current solution as the initial condition for a transient solution.
If theStart/Continue from a previously solved setup check box is selected, theSetup Link
button becomes active, and theSetup Link dialog box automatically appears in which the user can
link the current design to a project solution set based on a different parameter/circuit setup. Refer to
"Setup Link for Transient Solutions" on the next page for details on setting up this link.

Note Power loss and Force density distribution cannot be computed whenStart/Continue
from a previously solved setup is enabled.
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Related Topics

Using a 2D EddyCurrent Solution as the Initial Condition for a Transient Solution
Setup Link for Transient Solutions

Import Mesh for Transient Solutions

The Import mesh check box can be selected in the "target" design if themesh for the same
geometry is to be used in the analysis. This setup is designed to be generally applicable to all
transient solutions. This feature is not necessarily related to the dynamic demagnetization
distribution capability.
If the Import mesh feature is selected, theSetup Link button becomes active, theSetup Link
dialog box, which includes anAdditional mesh refinements tab automatically appears, and the
mesh will be imported from the source design to the target design. Refer to "Setup Link for Transient
Solutions" below for details on setting up this link.

Note The usual way to create geometrically equivalent designs is by copying all geometry
objects from one design and then using Import From Clipboard in the other design.

Setup Link for Transient Solutions

If you selectedStart/Continue from a previously solved setup, or Import mesh, do the
following to specify the source project, design, and solution containing the information you want to
use. You can also view andmap variables and, for Import Mesh, specify additional mesh
refinements.

1. If theSetup Link dialog is not already open, clickSetup Link (located at the bottom of the
Solve Setup dialog boxAdvanced tab) to open theSetup Link dialog box.

2. By default, theSetup Link dialog opens on theGeneral tab with only the This project radio
button selected.
Note If a link had previously been set up, theSetup Link dialog opens inView Only

modewith all settings disabled.

To enable settings, you can selectEdit Link.

3. To select a source project do one of the following:
l To use the current project as the source, checkUse This Project. This disables the
Save source path relative to: radio buttons and the ellipsis [...] button and its
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associated text field.
l To specify a source project file other than the current project click the ellipsis [...] button
to open a file browser window.When you have selected the project, click theOpen
button to accept the project file for the setup. You can use the check box toOpen as
read only.
Use the radio buttons to specify whether to save the source path relative to The project
directory of selected product or This project.

4. When you select a source project file, theSource Design and theSource Solution fields
are filled in with default values, and their drop downmenus contain any available designs and
solutions. You can use the drop downmenus to choose from the available designs and
solutions.
The “Default” solution is the product-dependent solution of the first Setup. That is the setup
listed first in the source design's project tree (alphanumerical order). A product-specific
solution of this setup becomes the default solution. In most products, it is “LastAdaptive.”

5. Use the check box to specify whether toSimulate source design as needed.
6. Use the check box to specify whether toPreserve source design solution. Note that in the

extractor mode, the source project will be saved upon exit. Extractor modemeans that the
software is opened during the link solely for the purpose of solving.

7. TheVariable Mapping tab lets you view any variables contained in the selected Project.
When there are variables in the source design, you can choose to “map” these variables to
constant values, expressions or variables in the target designs. Variablemapping becomes
more important when the datalink type requires source and target design to be geometrically
identical and source design is geometrically parameterized.
For linked designswith variables of the same name, you can clickMap Variable by Name to
automaticallymap same named variables.

8. TheAdditional mesh refinements tab, which is present only if you chose Import Mesh on
theSolve Setup dialogSolver tab, allows you to choose either toApply mesh operations
in target design on the imported mesh (default) or Ignore mesh operations in target
design.

9. ClickOK to close the Setup Link dialog box and return to theSolve Setup dialog box
Advanced tab.

Related Topics

Using a 2D EddyCurrent Solution as the Initial Condition for a Transient Solution
"Start/Continue from a Previously Solved Setup" on page 16-29
"Import Mesh for Transient Solutions" on the previous page
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Using a 2D Eddy Current Solution as the Initial Condition for a Transient
Solution

In order to speed up the process of a 2D transient solution reaching a steady state, you can set the
solution from a 2D Eddy solver as the initial condition for the transient solver.

Note Since the eddy current solution corresponds to a stationary operating condition (zero
speed), in order to generate the initial condition for the transient solution with non-zero
speed, a transformation of conductivity on themoving objects where eddy current is taken
into account is required in the eddy current simulation. The transformation is:

where σ0 is the transformed conductivity from speed n to speed zero, which is to be set in
the eddy current simulation, σ is the real conductivity in transient simulation, and sn is the
slip, defined as:

where ns is the synchronous speed.
If there is an end connection, the end resistanceR used in the transient simulation also has
to be referred to the valueR0 associated with zero speed before being used in the eddy
current solution by:

Prerequisites
l Source design - Maxwell 2D EddyCurrent (Last Adaptive solution only)
l Target design - Maxwell 2D Transient
l The source and target designsmust be identical (identical geometries, boundaries,
excitations, windings, etc).

To setup and use a 2D EddyCurrent solution as the initial condition for a 2D Transient solution:
1. Create a 2D EddyCurrent source design, and ensure that Solve Matrix: After last pass is

selected on theGeneral tab of the Eddy currentSolve Setup dialog.
2. Solve the 2D Eddy current design.
3. Create a 2D Transient target design, whose geometry, boundary conditions, excitations,

windings, etc., are identical to the the source Eddy current design.
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4. On theSolve Setup dialog,Advanced tab for the transient target design, click
Start/Continue from a previously solved setup to open theSetup Link dialog.

5. On theSetup Link dialogGeneral tab, select the source Eddy current design and solution.
Refer to "Setup Link for Transient Solutions" on page 16-30 for details on setting up this link.

6. Solve the target 2D transient design.

Note l If the source and target designs are not identical, an error message displays.
l If the 2D Eddy current source design has not been solved, an error message
displays.

Related Topics

Start/Continue from a Previously Solved Setup
Setup Link for Transient Solutions

Defining Expressions for Transient Solutions

You can specify additional evaluation criteria through the use of expressions and output variables.
To set expressions as evaluation criteria:

1. Right-click on the Analysis icon in the Project tree to open theSolve Setup dialog box.
2. Click theExpression Cache tab and click theAdd... button to open theAdd to Expression

Cache dialog box.
3. Specify the Context for the expression, includingReport Type, Solution, andParameter.
4. Under the Trace tab, select from theCategory,Quantity, and Function lists to create

expressions.
Selecting a listed category lists the Quantities and Functions available for each category. If you
have defined one or more output variables, you can see them by selecting theOutput
Variables category. The Output Variables button opens a dialog box that lets you define
output variables. See Specifying Output Variables.
When you have created an expression, it appears in theExpression field of the Trace tab. If
desired, you can use theRange Function button to select range functions to apply to the
expression.
Under theCalculation Range tab, you can view the values of available sweep variables.
Clicking the ellipsis [...] button in theEdit column opens a list of values fromwhich you can
select.

5. When finished defining the expression that you want to add to the cache, click theAdd
Calculation button.
This adds the selected expression and the associated context to a table in theExpression
Cache tab. You can define additional expressionswith contexts and add them in the same
way.

6. When finished adding expressions, clickDone to close theAdd to Expression Cache dialog
box.
TheExpression Cache tab lists the expressions you have added in a table.

Specifying Solution Settings 16-33
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l The Title field is editable, by default showing the name as built from the expression (with
underscores removed).

l TheExpression field shows the full expression. If necessary, you can resize theSolve
Setup dialog box. You can also resize each columns in the table.

l TheContext column for non-field types lists the parameter type specifying the force, torque
or matrix setup. For these types the context also can be given as part of the expression. For
example, the expression Force1.Force_xwith a context ofNone is equivalent to an
expression of Force_xwith a context of Force1.

For field quantities theContext can be the geometry on which to evaluate the field quantity - a
point or line. If you use a line you need to use some range function to reduce the
dimensionality to a single value (or use the Calculation Range tab to specify a single point
along the line). Note that, if you create a named expression in the field calculator that already
evaluates to a single value, then theContext here will likely beNone.

l The Intrinsics column shows a clickable button that opens anEdit Calculation Range
dialog box. If the Intrinsics column button showsNone you cannot edit the value. If the
button shows variables, click the ellipsis [...] in theEdit column to display a list of the
variable values fromwhich you can select. ClickOK to close theEdit Calculation Range
dialog box and apply your selections to the Expression Cache.

The Intrinsics field lists the values youmay have set in theCalculation Range tab when you
added the expression. This is used to set the values of “other” sweeps. Usually there are no
other sweeps because the values of the variables are set in the definition of each variation. In
some cases youmay need to specify the values of “other” sweeps. For field valueswith a line
for the context, you can specify the (normalized) distance along the line For eddy current field
quantities you can also specify the phase for the calculation.

7. In theEvaluation Time Step panel, set how often the solver is to output field solutions. Select
Constant to output solutions at a preset time interval (e.g., every 0.1 s); orNumber of solve
steps to output solutions each preset number of time steps (e.g., every 3 time steps).

8. Optionally, buttons allow you toEdit andRemove selected expressions, and toRemove All
expressions in the table.

9. When finished defining expressions, clickOK to close theSolution Setup dialog box.

Related Topics

Specifying Output Variables

Defining Settings on the Solver Tab for Transient Solutions

To define solver settings on theSolver tab of the Solve Setup dialog box for transient solutions:
1. Enter a residual value in theNonlinear Residual text box.

To specify a time-dependent non-linear residual, you can simply type in a function of TIME,
such as sin (TIME), or enter an expression that uses a dataset, such aspwlx(<name of
dataset>, TIME). A time-dependent variable can also be used.
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You can save the time-dependent expression as the default for the non-linear residual by
clicking theSave Defaults button on the Defaults tab of the Solve Setup dialog. A new solve
setup will then use the user-saved default if the expression can be evaluated. A value of “0”
will be used when the expression cannot be evaluated. as, for example, if the expression
depends on a variable that is not yet defined in the design/project.
Changing the definition of the residual will NOT invalidate any existing solution; and the next
simulation will continue from the stop time of the last simulation.
Changing the definition of a variable used for the residual value will NOT invalidate any
existing solution. The next simulation will be for a different “design variation”.
Changing the definition of a dataset used for the residual will NOT invalidate any existing
solution. The next simulation will continue from the stop time of the last simulation.
If a variable is used, you can choose to plot a family of curves based on the solved variations of
the variable.

2. Select or clear theOutput error check box.When this check box is selected, the transient
solver generates the output error data, which is then sent back to the desktop. The data can
be viewed or used in the post processor, just as other transient solution data (such as power
loss or winding).
Note Output error is the percentage error in the total energy of the solution. This is a

measure of the accuracy of the finite element approximation and can be used to
judge if themesh is good enough. Output error is calculated by finding the residual
energy (the left-over energy calculated from the field after subtracting out the
sources) divided by the total energy including the sources. Computing output error
uses significant computation time.

3. For 3D Transient analysis only, select the desiredScalar Potential shape function: either
Second Order (default), or First Order, from the pull-down list. (You can also select the
desired Scalar Potential on the Solver tab in the Properties window.)
Use of the First Order scalar shape function, rather than the SecondOrder shape function,
may be desirable for any of the following cases:

l If computational time is amain concern and solution accuracy is secondary. Thismight
be useful for the initial design stage, before switching to using themore time consuming,
andmore accurate, second order scalar shape function.

l If the contour of the geometry is very complicated, it may not be possible to use the
higher second order shape function due to the inability of relatively larger element size
to properly represent the original geometry shape

l If the gradient of themagnetic field changes sharply, it may not be possible to use the
higher second order shape function with large element size. Using a larger element size
may not be able to adequatelymodel the large change of material property with large
element size, and nonlinear convergencemay be difficult to achieve.

4. For 2D Transient analysis only, select the algorithm for the Time Integration Method using
the pull-down list.
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l Backward Euler - Default
l Runge-Kutta - third order algorithm for greater accuracy

5. Select or clear the Fast Reach Steady State check box.
For transient simulationswhose winding excitations are an AC voltage source, the DC flux
linkage component may take a very long time to decay, especially for a device with a large time
constant. Selecting Fast Reach Steady State adds an additional voltage component to the
original voltage definition during the first half-cycle to quickly eliminate the DC flux linkage,
thus speeding up the solution process. Youmust also provide a Frequency of Added
Voltage Source value that is greater than zero. The default value for Frequency of Added
Voltage Source is 60 Hz. This frequency value is applied to all winding voltage sources.

Note This speedup capability is only applicable to voltage sourceswhose integration of
voltage quantity over one period is zero. Thismeans the DC component of all
voltage sources is zero.

6. As needed for your design, select or clear settings in the Time Decomposition Method
Option panel.
The TimeDecompositionMethod (TDM) is an HPC distributed analysis type based on domain
decomposition along the time-axis, (rather than the normal geometry division) to parallelize
the transient solution. Instead of solvingMaxwell transient problems sequentially for each time
step, TDMenables time steps to be solved simultaneously in parallel. Thus, TDM can be
implemented on distributedmemory parallel platforms based onMPI. TDMhas very good
scalability, resulting in significant speedup for both 2D and 3D transient solutions.
If you have enabled theUse Automatic Settings option in the Analysis Configuration
dialog, or if you have enabled the Transient Solver distribution type in theAnalysis
Configuration dialog (Refer to "Editing DistributedMachine Configurations for Maxwell and
RMxprt" on page 21-9 .), you can:

l SelectPeriodic, which is the TDMmethod intended for use in steady-state simulation.
In such a case, all the setup and solutions at the first time step will be the same as those
at the last time step of one period. Setup includes source, boundary, and position in
electrical degrees. The solutions include all electrical andmagnetic quantities.
To use thismethod, all current in windings and all induced eddy currents in the
conducting region should have the same time period. For example, an induction
machine cannot be solved using the Periodicmethod because the time period of the
currents in the stator winding is different from the time period of induced eddy current in
the rotor bars.

l For general transient (Non-Periodic) TDMapplications, selectGeneral Transient.
Using thismethod, TDM solves a collection of many time steps simultaneously.

Related Topics

"TimeDecompositionMethod for Maxwell Transient Designs" on the facing page

Specifying Solution Settings 16-36
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Time Decomposition Method for Maxwell Transient Designs

If a Maxwell 2D or 3D transient design problem is too large to solve efficiently on onemachine,
Maxwell can use the Time Decomposition Method (TDM). The TimeDecompositionMethod
(TDM) is an HPC distributed analysis type based on domain decomposition along the time-axis
(rather than the normal geometry division) to parallelize the transient solution. Instead of solving
Maxwell transient problems sequentially for each time step, TDMenables time steps to be solved
simultaneously in parallel. Thus, TDM can be implemented on distributedmemory parallel platforms
based onMPI. TDMhas very good scalability, resulting in significant speedup for both 2D and 3D
transient solutions.
Maxwell supports two time decompositionmethods:

l Periodic – Thismethod is intended for use in steady-state simulation. In such a case, all the
setup and solutions at the first time step will be the same as those at the last time step of one
period. Setup includes source, boundary, and position in electrical degrees. The solutions
include all electrical andmagnetic quantities.
To use thismethod, all current in windings and all induced eddy currents in the conducting
region should have the same time period. For example, an inductionmachine cannot be
solved using the Periodicmethod because the time period of the currents in the stator winding
is different from the time period of induced eddy current in the rotor bars.

l General Transient (Non-Periodic) – Thismethod is intended for general transient
applications.
For thismethod, TDM solves a collection of many time steps simultaneously – a collection of
many time steps being defined as one time sub-division. For example, if the end time of the
entire transient simulation is 4 seconds, and if we want to solve all time step solutions together
for every 1 second, then this 1 second is defined as one time sub-division, and the total time
sub-divisions is 4. For the same problem, we can also define every 2 seconds as one time sub-
division. Accordingly, the total time sub-divisions becomes 2.

To use TDM youmust:
l Have and use the HPC license Pool option (Refer to "Setting HPC and Analysis Options for
Maxwell and RMxprt Designs" on page 5-49 ).

l Set the total number of Tasks, N, (at least three Tasks) for the solve pool. The actual number
of Tasks for parallel computation is N-1 (slave tasks), since the first Task is used as the
master, which is responsible for task assembly, slave task control, synchronization, etc.

l Enable the Transient Solver distribution type in theAnalysis Configuration dialog (Refer
to "Editing DistributedMachine Configurations for Maxwell and RMxprt" on page 21-9 .)

Limitations to using TDM
l Non-constant time stepping is not allowed.
l Mechanical transient is not supported for the same reason. Thismeans all moving positions
for every time step have to be known in advance so that FEA will take place at that pre-
determined position.

l The solution at a time step cannot depend on the arbitrary history of previous time steps
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(allowed for previous couple of time step solutions required due to the time integration scheme
itself). Traditional core loss computation is supported because core loss computation is done
in post-processing.
Strictly speaking, TDM cannot support hysteresismodeling. But for soft hysteresismaterials,
especially for lamination core loss computation, the hysteresis loop, or the coercivity Hc, is
very small. In such a case, the impact of hysteresis on the nonlinear operating point can be
ignored. Thismeanswe can decouple the nonlinear iteration processwith consideration of
hysteresis impact. For the first step of the nonlinear iteration process, distributed parallel TDM
can still be applied. After the nonlinear iteration has converged, that is, the nonlinear problem
has been linearized for all time steps (or all time steps in the sub-division), the second step is
applied to take into account the impact of hysteresis. In such a case, the solution process is
sequential – to consider the impact of hysteresis behavior from the previous time-step solution
on the solution at current time step. It can be expected that the results with TDMenabled and
with TDMdisabledmight differ slightly due to ignoring the impact of hysteresis on the
nonlinear operating point. However, from a practical application point of view, the solutions
can be considered as sufficiently accurate –especially for lamination core loss computation.

l The purpose of the demagnetization process in a transient simulation is to find the worst
operating point during the entire transient simulation. After a new worst operating point is
discovered, a linearized representation of the permanent magnet characteristic will be used to
construct a new recoil line, which is applied to the simulation for subsequent time steps. Thus,
strictly speaking, TDM cannot support demagnetizationmodeling because all time steps (or all
time steps in a subdivision) are solved simultaneously. However, as a reasonable
approximation, we can solve all time steps in one subdivision simultaneously based on
distributed parallel TDM– and then search for the worst operating point among the solutions
of these just-solved time steps. Thereafter, this new worst operating point is used to construct
a new recoil line which is applied to all time steps in the next subdivision. Thismeans the
impact of previous solutions on subsequent searches for the worst operating point is taken into
account subdivision-by-subdivision, rather than time step-by-time step.
It can be expected that the results of the discovered finalworst operating point might differ
slightly between TDM- enabled solutions and TDM-disabled solutions. However, from a
practical application point of view, the solutions can be considered as sufficiently accurate.
This error can be reduced with the use of few time steps in one subdivision.

Stopping and Restarting TDM Analyses

l For TDManalyses, invokingClean Stop stops the analysis after completion of the current
time subdivision, instead of after completion of the current time step. As a result, continuation
of the solution processwill start from the next time subdivision after clickingAnalysis. In such
a case, the stop time cannot bemodified when TDM is used.

l WhenClean Stop is invoked for projects in which a TDM transient source design is linked to a
transient target design, after completion of the source design the solution process can
continue from the target design. In such a case, the target designmust be non-TDM.

l TDM Restart does not work when you Use Automatic Settingswhen Editing Distributed
Machine Configurations for Maxwell.
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Related Topics

"Setting HPC and Analysis Options for Maxwell and RMxprt Designs" on page 5-49
"Editing DistributedMachine Configurations for Maxwell and RMxprt" on page 21-9
"Defining Settings on the Solver Tab for Transient Solutions" on page 16-34

Defining Settings for Output Variables for Transient Solutions

Any output quantity or expression within either the Transient Report or Field Report type can be
defined as an output variable in theOutput Variables dialog box, accessed viaResults in the
project tree.
To add an output variable to output with time:

l ClickAdd to select the output variables to be added to the list for output with time.
The newly defined variable is added to the list.
Note TheAdd button will not be enabled if there are no variables defined in the

project.

To delete an output variable:
l Select the variable from the list, and clickDelete.

Do one of the following in theEvaluation Time Step section on theOutput Variables tab of the
Solve Setup dialog box:

l SelectUsing Constant, type a value, and select the units. Select this option if you want to
use a constant value for when you calculate output variable values.

l SelectEvaluate every Nth time step, and type a value. Select this option if you want to
evaluate the output variable after a certain number of solution time steps (i.e., instead of
calculating the output variable every fixed time interval, you want to calculate it every certain
number of time steps). For example, if you want to evaluate the output variable every third
time step, type 3 in this text box.

Defining Settings on the Defaults Tab for Transient Solutions

Default analysis parameters are used to initialize the data for new setups.
To set up the default analysis parameters, define the following parameters under theDefaults tab of
theSolve Setup dialog box:

1. ClickSave Defaults if you want to save the defaults based on the data for the current setup.
2. ClickRevert to Standard Defaults to clear the existing values.
3. ClickOK.

Setting Analysis Parameters for Electric Transient Solutions
When you set up an electric transient analysis, define the parameters on the following tabs of the
Solve Setup dialog box (which appears when you clickMaxwell>Analysis Setup>Add Solution
Setup):
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l General (Name, Transient Setup)
l Expression Cache
l Solver
l Defaults

Defining Settings on the General Tab for Electric Transient Solutions

The following settings can be defined on theGeneral tab of theSolve Setup dialog box for transient
solutions:

l Setup Name
l Time Steps Setup

Setup Name for Electric Transient Solutions

By default,Setup1 appears as the name of the first analysis you set up.
To change the name of the setup, type the new name in theName text box on theGeneral tab of the
Solve Setup dialog box.
To disable the setup, uncheck theEnabled check box. Refer toDisabling and Enabling an Analysis
Setup for additional information.

Time Steps Setup for Electric Transient Solutions

To set up a transient analysis, define the following parameters on theGeneral tab of theSolve
Setup dialog box:

1. Enter theStop Time, which is the value at which the solution will stop, and select the units.
2. Enter the Initial Time Step, which is the time step used to start the simulation and begin the

adaptive process.
3. Also enter theMaximum Time Step to set the allowable range the adaptive process use to

alter the time step.
4. CheckSave Fields to enable saving the fields data.

Defining Expressions for Electric Transient Solutions

You can specify additional evaluation criteria through the use of expressions and output variables.
To set expressions as evaluation criteria:

1. Right-click on the Analysis icon in the Project tree to open theSolution Setup dialog box.
2. Click theExpression Cache tab and click theAdd... button to open theAdd to Expression

Cache dialog box.
3. Specify the Context for the expression, includingReport Type, andSolution.
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4. Under the Trace tab, select from theCategory,Quantity, and Function lists to create
expressions.
Selecting a listed category lists the Quantities and Functions available for each category. If you
have defined one or more output variables, you can see them by selecting theOutput
Variables category. The Output Variables button opens a dialog box that lets you define
output variables. See Specifying Output Variables.
When you have created an expression, it appears in theExpression field of the Trace tab. If
desired, you can use theRange Function button to select range functions to apply to the
expression.
Under theCalculation Range tab, you can view the values of available sweep variables.
Clicking the ellipsis [...] button in theEdit column opens a list of values fromwhich you can
select.

5. When finished defining the expression that you want to add to the cache, click theAdd
Calculation button.
This adds the selected expression and the associated context to a table in theExpression
Cache tab. You can define additional expressionswith contexts and add them in the same
way.

6. When finished adding expressions, clickDone to close theAdd to Expression Cache dialog
box.
TheExpression Cache tab lists the expressions you have added in a table.
l The Title field is editable, by default showing the name as built from the expression (with
underscores removed).

l TheExpression field shows the full expression. You can resize theSolution Setup dialog
box, and also each column in the table, to view the contents of the fields.

l TheContext column for non-field types lists the parameter type specifying the force, torque
or matrix setup. For these types the context also can be given as part of the expression. For
example, the expression Force1.Force_xwith a context ofNone is equivalent to an
expression of Force_xwith a context of Force1.

For field quantities theContext can be the geometry on which to evaluate the field quantity - a
point or line. If you use a line you need to use some range function to reduce the
dimensionality to a single value (or use the Calculation Range tab to specify a single point
along the line). Note that, if you create a named expression in the field calculator that already
evaluates to a single value, then theContext here will likely beNone.

l The Intrinsics column shows a clickable button that opens anEdit Calculation Range
dialog box. If the Intrinsics column button showsNone you cannot edit the value. If the
button shows variables, click the ellipsis [...] in theEdit column to display a list of the
variable values fromwhich you can select. ClickOK to close theEdit Calculation Range
dialog box and apply your selections to the Expression Cache.

The Intrinsics field lists the values youmay have set in theCalculation Range tab when you
added the expression. This is used to set the values of “other” sweeps. Usually there are no
other sweeps because the values of the variables are set in the definition of each variation. In
some cases youmay need to specify the values of “other” sweeps. For field valueswith a line
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for the context, you can specify the (normalized) distance along the line For eddy current field
quantities you can also specify the phase for the calculation.

7. In theEvaluation Time Step panel, set how often the solver is to output field solutions. Select
Constant to output solutions at a preset time interval (e.g., every 0.1 s); orNumber of solve
steps to output solutions each preset number of time steps (e.g., every 3 time steps).

8. Optionally, buttons allow you toEdit andRemove selected expressions, and toRemove All
expressions in the table.

9. When finished defining expressions, clickOK to close theSolution Setup dialog box.

Related Topics

Specifying Output Variables

Defining Settings on the Solver Tab for Electric Transient Solutions

To define solver settings on theSolver tab of the Solve Setup dialog box for transient solutions:
1. Enter a value in the Temporal Tolerancetext box.
2. For the Initial Condition, select either a presetValue or aStatic Field.

If Static Field is selected, theSetup Link button becomes active, and theSetup Link dialog
box automatically appears, and the field will be imported from the source design to the target
design.

3. The Import mesh check box can be selected in the "target" design if themesh for the same
geometry is to be used in the analysis.
If the Import mesh feature is selected, theSetup Link button becomes active, theSetup
Link dialog box automatically appears, and themesh will be imported from the source design
to the target design.

Note The usual way to create geometrically equivalent designs is by copying all geometry
objects from one design and then using Import From Clipboard in the other design.

Setup Link for Electric Transient Solutions

If you selected Import mesh or Static Field, do the following to specify the project, design,
and solution containing themesh information you want to use:

1. ClickSetup Link in theSolve Setup dialog box).

TheSetup Link dialog box appears.

2. Click theGeneral tab.
3. Select the project from theProject File pull-down list.
4. Select the saved design from theDesign pull-down list.
5. Select the specific solution you want to link to from theSolution pull-down list.
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6. Click theParameters tab.
7. Optionally, edit theValue andUnit columns for any of the parameters listed
8. ClickOK to close the Setup Link dialog box and return to theSolve Setup dialog box.

Defining Settings on the Defaults Tab for Electric Transient Solutions

Default analysis parameters are used to initialize the data for new setups.
To set up the default analysis parameters, define the following parameters under theDefaults tab of
theSolve Setup dialog box:

1. ClickSave Defaults if you want to save the defaults based on the data for the current setup.
2. ClickRevert to Standard Defaults to clear the existing values.
3. ClickOK.

Resetting Analysis to Time Zero
Resetting the analysis to time zero invalidates the current solution and causes you to start over from
the beginning the next time you analyze the simulation.
To reset the analysis, do one of the following:

l ClickMaxwell>Analysis Setup>Reset to Time Zero from theMaxwell menus.
l In the project tree, right-clickSetup underAnalysis, and selectReset to Time Zero from the
shortcut menu.

Changing Memory Settings
TheMaxwell solver has tomake trade-offs between the solution time and the amount of memory
used in the solution process.
The software automatically determines the amount of RAM installed on the computer, assuming that
it can use up to 75% of this during the solution process. You can override this choice by changing the
following twomemory settings:

l Desired RAMLimit
l MaximumRAMLimit

Generally, set the RAM value as high as possible to obtain the fastest solutions.
These settings are not an absolute limit on the amount of RAM to be used.When solving small
problems, Maxwell tries to respect this limit by choosing to runmore slowly with a smaller amount of
RAM.When solving a large problem, Maxwell may be unable to use lessRAM than the specified
limit. In this case, the amount of memory used exceeds the specified limit but tries tominimize how
far it goes beyond.
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Specifying the Desired RAM Limit

TheDesired RAM Limit setting requests a restriction on the amount of physical random access
memory (RAM) theMPS solver used inMaxwell may use before it must stop solving on-core -
solving processes entirely in RAM - and start solving off-core. In off-coremode, Maxwell creates
temporary solution files to which it spills, or shifts, data fromRAM, instead of relying on the operating
system to start disk swapping. The location of these temporary files is specified in the General
Options (Tools>Options>General Options). TheMPS solver is finely tuned at handling its own
memory, and can optimize loading only those blocks of memory required for its immediate needs.
Using this optionmay help to keep the entire solver from being swapped out in the normal course of
processmanagement on your computer. This kind of control may be especially important when
multiple solvers are running on the samemachine. Of course, if the total memory requirement of all
processes grows large enough, the operating systemwill be forced into disk swapping.

Note The Iterative solver doesn't go off-core for efficiency reasons. Because the Desired RAM
Limit (the soft memory limit) is used for off-core run, it is not appropriate for the iterative
solver. Instead, the iterative solver uses theMaximumRAMLimit (the hardmemory limit).
Once the limit is exceeded, the iterative solver will issue an "Out of memory" error
message.

Regardless of this setting, processes are limited to 4TB of address space on 64 bit operating
systems - nomatter how much physical memory is installed.

Note Regardless of theDesired RAM Limit setting, if allocation fails, theMaxwell solver
automatically switches to off-coremode.

In case you receive an error message regarding insufficient memory on a 64-bit operating system,
youmay have reached a point where the sum of physical RAMplus available swap space exceeds
theminimumamount of RAMneeded by the off-core solver. Even for the off-core solver, the RAM
usage cannot bemade arbitrarily small. In that case you can consider increasing the swap space
(the virtual memory) in the settings of your system.
To specify the Desired RAMLimit of themachine on whichMaxwell is installed refer to theHPC and
Analysis Options section.

Specifying the Hard Memory Limit

TheMaximum RAM Limit setting specifies the absolute limit on the amount of physical memory
that the solver can use. If the solver attempts to allocatemorememory than this setting, the solution
process terminates abnormally, and incorrect error messagesmay appear.
To specify theMaximum RAM Limit for the current user andmachine refer to theHPC and
Analysis Options section.

1.
Note ANSYS recommends that you use theDesired RAM Limit setting if you want to

limit the RAM the solver may allocate.
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Setting View Context for Transient Solutions
To set the view context:

1. ClickView>Set Solution Context.
TheSet View Context dialog box appears.

2. Select a solution from the Solution Name pull-down list.
3. Select a time instance from the Time pull-down list.
4. In theView area of the dialog, you can choose the location to display theSolution Context

within themodeler window.
5. The position and speed valuesmay be displayed in theSolution Context by selecting the

Display Speed and Position values check box.
6. ClickOK.

Note You can also change the view context by double-clicking the solution context text
label in the bottom left of themodel window.
Example of text label showing solution view context:

Time='0s'

Speed and Position Display Settings

To set the display setting for speed and position in the view context:
1. ClickView>Set Solution Context.

TheSet View Context dialog box appears.
2. Select theMotion View Format tab.
3. In the Format Speed Unit section:

a. Specify the Unit Type from the pull-down list.
b. Specify the Field Width for the display and the number of digits of Precision to display.
c. If you prefer Scientific Notation, select the check box.

4. In the Format Position Unit section:
a. Specify the Unit Type from the pull-down list.
b. Specify the Field Width for the display and the number of digits of Precision to display.
c. If you prefer Scientific Notation, select the check box.

5. ClickOK.
Note You can also change the view context by double-clicking the solution context text

label in the bottom left of themodel window.
Example of text label showing solution view context:

Time='0s'

Renaming a Solution Setup
Do the following to rename a solution setup:
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1. In the project tree, underAnalysis, right-click the setup you want to rename.
A shortcut menu appears.

2. SelectRename from the shortcut menu.
The setup name text is highlighted in the project tree.

3. Type the new name for the setup, and pressEnter.
You can also rename the solution setup by changing the text in theName text box of theSolve
Setup dialog box.

Related Topics

Copying a Solution Setup

Copying a Solution Setup
Solution setupsmay be copied and pasted within a design or across designs of the same type. This
is beneficial for setups having a large number of parameters to specify such as an RMxprt design, or
whereminor changes to a setup are being evaluated.

Note Setups cannot be pasted across solution types, across geometrymodes such as from 3D
to 2D, or acrossmachine types in RMxprt.

Do the following to copy a solution setup:
1. In the project tree, underAnalysis, right-click the setup you want to copy.

A shortcut menu appears.
2. SelectCopy from the shortcut menu.

The setup parameters are copied to the clipboard.
3. In the project tree, right-click on theAnalysis folder to receive the copied setup.

A shortcut menu appears.
4. SelectPaste from the shortcut menu.

The setup parameters are copied to theAnalysis folder as a new setup.

Related Topics

Renaming a Solution Setup

Disabling and Enabling an Analysis Setup
To disable anAnalysis setup definition without deleting it:

1. Expand the tree hierarchy under the Analysis icon in the project tree.
2. Right-click on the icon for the setup definition. In the shortcut menu that appears, click Disable

Setup.
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You can also disable an analysis setup by selectingProperties from the shortcut menu to
open theEdit Propertieswindow. In the upper right corner of the Edit Properties window,
uncheck theEnabled box. Then clickOK.

To reactivate anAnalysis setup:
1. Expand the tree hierarchy under theAnalysis icon in the project tree.
2. Right-click on the icon for the setup definition. In the shortcut menu that appears, clickEnable

Setup.
You can also reactivate the analysis setup by selectingProperties from the shortcut menu for
the sweep to open theEdit Propertieswindow. Check theEnabled box in the upper right
corner, and clickOK to apply the change and close the window.

Setup Link Dialog
TheSetup Link dialog permits you to link the current project to another as described in the following
topics:

l Setup Link for Non-Transient Solutions
l Import Mesh for Non-Transient Solutions
l Setup Link for Transient Solutions
l Import Mesh for Transient Solutions
l Setup Link for Electric Transient Solutions

TheGeneral andVariable Mapping tabs are common to all Setup Link dialog boxes.

Depending on the type of link being set up, other tabs such asAdditional Mesh Refinements, and
Advancemay also appear. Details of the use of the various tab settingsmay be found in the topics
linked above.

Clearing Linked Data
If you have previously setup links, theMaxwell>Analysis Setupmenu contains an option toClear
Linked Data. This removes the linked data for all links in a target design, therefore invalidating the
solutions. Clearing linked data for some link types requiresMaxwell to revert to the initial mesh.
Thus, in some cases, this command removes the current mesh of the target design.
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Setting the Report Updating During Analysis Options
Updating numerous reportsmay take a significant amount of time. Updating reports during the
analysis process can impact the overall time to solution. Youmaywant to vary the timeswhen your
reports get updated relative to the impact on overall solve time.
Four options exist for updating reports during solutions:

l After each variation - when performing anOptimetric or parametric analysis, all reports are
updated after analysis of each variation has been completed.

l Automatically - the default. It means updatemost things immediately.
For "AdaptivePass" plot context, plots are updated at the end of each solution pass. For
"LastAdaptive" or "Transient" the plot is updated at the end of the transient or adaptive
solution.
This option balances report and field plot updating with solution time. For example, reports
may be updated after each adaptive pass but field plots will not be updated until the solution is
complete.

l Immediately - update reports and plots as soon as data comes from the solver.
This option will have the greatest impact on the overall solution time but will have themost
rapid updating of reports and field plots. Caution should be used in selecting this option. Some
types of reports and field plotsmay take a long time to update, especially as themesh size
increases.

l Never - onlymanual intervention updates reports.
This option will prevent updates from impacting the solution time.

l OnCompletion - aswith Never, but a single update is done when the solve completes. This
option should be considered when using dynamic links to other products to provide best
solution time with the final data available for the link.

To change the setting for the current project, see Desktop Performance options.

Specifying Solution Settings 16-48
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



17 - Maxwell Coupling
Coupling is provided in specific contexts betweenMaxwell and the following products:

l ANSYS Workbench
Coupling of Maxwell2D/3D with ANSYSWorkbench is supported via theWorkbench
schematic. The following types of coupling withWorkbench are supported:

l Thermal feedback is supported for Maxwell magnetostatic, eddy current, and transient
solution types.

l Stress feedback is supported for Maxwell magnetostatic, eddy current, and electrostatic
solution types.

l Harmonic force is supported for Maxwell transient and Eddy current solutions.
l Partial Model Coupling

For more information, see “Maxwell to ANSYS Thermal Coupling” and “Maxwell to ANSYS
Stress FeedbackCoupling,” and "CouplingMaxwell with Both ANSYS Thermal and
Structural viaWorkbench."

l HFSS
There are two possible couplingmechanisms between HFSS andMaxwell:

l Near field coupling.
l Magnetic bias source coupling.

While they serve different application objectives, they are similar in neither requires the
geometry in the coupled designs to be identical.
For more information, see “Near Field Coupling betweenMaxwell and HFSS” and "Magnetic
Bias Source Coupling betweenMaxwell and HFSS."

l Simplorer
Coupling betweenMaxwell and Simplorer 8 and above can take the following forms (initiated
through the Simplorer user interface):

l Export a parametricmatrix fromMaxwell to an ECEmodel file for placement in
Simplorer.

l Dynamically link aMaxwell capacitance or inductance project to a component in
Simplorer.

l Dynamically link aMaxwell Transient design to Simplorer to perform Transient-Transient
cosimulation.

l Dynamically link aMaxwell design to Simplorer to performState Space cosimulation.
l Dynamically link to RMxprt through Dynamic SML.

Because the thermal and/or stress solutions are derived from the distributed power loss and
force density, they are likely to bemore accurate than analyses based on average
losses/force.
For more information, see "CouplingMaxwell to a Simplorer Component."

l ANSYS Fluent

Maxwell Online Help
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Coupling without using ANSYSWorkbench is supported between ANSYS Fluent and
Maxwell 3D magnetostatic and Eddy current designs inMaxwell. A transient ANSYS Fluent
simulation can use aMaxwell solution to simulate themagnetic effect in the electric arc of
contactors.
For more information, see "CouplingMaxwell Magnetostatic and EddyCurrent Designswith
ANSYS Fluent."

l LMS Virtual.Lab™
Maxwell supports one-way coupling with Siemens® LMS Virtual.Lab™.

Related Topics

Maxwell to ANSYS Thermal Coupling
Setting the Temperature of Objects
Maxwell to ANSYS Stress FeedbackCoupling
Maxwell to ANSYS Harmonic Force Coupling
Near Field Coupling betweenMaxwell and HFSS
Magnetic bias source coupling betweenMaxwell and HFSS
CouplingMaxwell to a Simplorer Component
Coupling aMaxwell Magnetostatic or EddyCurrent Design with ANSYS Fluent

Maxwell to ANSYS Thermal Coupling
CouplingMaxwell2D/3D with ANSYS R16 is supported via theWorkbench schematic. Thermal
feedback is supported for Maxwell magnetostatic, eddy current, and transient types. Users also
need to setup the design and geometry appropriately. An appropriate design should be temperature-
dependent, and have one or more solve setups that are enabled for thermal feedback.

Note AMaxwell system can also be coupled with both thermal and stress systems via
Workbench.

Maxwell-Specific Considerations
l If there is thermal feedback, each frequency point in an eddy current sweep will be solved
with the same feed-back data.

l Temperature distribution data that has already been exported fromANSYS Thermal will be
invalidated when users continue theMaxwell solution in a way such that theMaxwell mesh
is being regenerated.

l Once theMaxwell solution has been integrated with a thermal effect, the adaptive process
of a static simulation will be disabled. Usersmust thenmanually invalidate the temperature
data in the existing solution before the adaptive processwill be re-enabled.

l Maxwell solutions can incorporate feedback from both thermal and stress.
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Maxwell 2D Coupling Considerations
For Maxwell2D in RZmode, geometry either must be exported into the XY plane, or the geometry
must be rotated into the XY plane after it is imported intoANSYS Mechanical. This is because
Mechanical 2D requires geometry to be in XY plane.
There are twomodes in ANSYS Thermal 2D. The default mode is calledPlaned Stresswhere zero
stress and non-zero strain are assumed in the z-direction. This is similar to the XY mode inMaxwell
2D. The other mode is calledAxisymmetric. Thismode will be used when a 3D model can be
generated by revolving a 2D section 360 degree. This is similar to the RZmode inMaxwell 2D.
Usersmust ensure that they use the correct geometrymode in Thermal 2D. Invalid geometrymode
selection is prohibited by the Thermal2D interface.
There are two types of Import Load in Mechanical:Heat Generation andHeat Flux.Heat
Generation is used whenmapping losses from objects in Maxwell2D/3D andHeat Flux should be
used tomap the loss from the edges of objects in Maxwell 2D/3D.Heat Flux is supported only for
eddy current designswith impedance boundary. Users can insert multipleHeat Generation orHeat
Flux loads via the Imported Load (Maxwell2D/3DSolution) objects.

Related Topics

CouplingMaxwell Designswith ANSYS Thermal viaWorkbench
Setting The Temperature of Objects

Coupling Maxwell Designs with ANSYS Thermal via Workbench

CouplingMaxwell2D/3D with ANSYS 16 is supported via theWorkbench schematic. Thermal
feedback is supported for Maxwell magnetostatic, eddy current, and transient types. Users also
need to setup the design and geometry appropriately. An appropriate design should be temperature-
dependent, and have one or more solve setups that are enabled for thermal feedback.

1. The easiest way to add aMaxwell 2D or 3D design to aWorkbench schematic is to import a
working design viaWorkbenchFile>Import. The imported design is placed in the
Workbench schematic after it is successfully imported.

2. Next, insert aSteady-State Thermal system and change itsAnalysis Type to 2D or 3D,
(depending on theMaxwell design type) by right clicking on theGeometry cell and selecting
Properties. It is important to change theSteady-State Thermal system's analysis type
before setting up its geometry.
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3. To setup theSteady-State Thermal system's geometry, youmust first export theMaxwell
geometry using sat or step format as follows:
a. Select theModeler>Exportmenu item.
b. Select the desiredmodel geometry format (sat or step), and the save location in the

dialog box and save the file for use by ANSYSWorkbench.
4. Import the file via theGeometrymodule of theSteady-State Thermal system.

a. To access theGeometrymodule, double click on theGeometry cell in theSteady-State
Thermal system to launchDesignModeler.

b. Select File>Import External Geometry File and browse for the geometry file exported
fromMaxwell.

c. After the geometry file is imported, right-click on the root folder of themodeler project tree
and selectGenerate. (When the geometry file is of aMaxwell 2D RZ design, users can
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rotate the geometry inDesignModeler by creating a body operation.)

5. CloseDesignModeler and refresh theModel cell of theSteady-State Thermal system by
right-clicking theModel cell and selectingRefresh.

6. The geometrymode of theSteady-State Thermal system can be changed via the ANSYS
Mechanical user interface.
a. LaunchMechanical by double clicking theSetup cell of theSteady-State Thermal

system.
b. SelectGeometry in the project tree and theDefinition ofGeometrywill be shown in the

Detailwindow.
c. Select either Plane Stress orAxisymmetric as the value for the property 2D (or 3D)

Behavior.
7. To set up the coupling, drag theSolution cell of theMaxwell system and drop it on theSetup

cell of theSteady-State Thermal system.
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8. Note that theMaxwellSolution cell is tagged with a “Lighting Bolt” symbol. Right-click on the
MaxwellSolution cell and selectUpdate. This will initiate aMaxwell simulation if it is not
already solved. OnceMaxwell's solution is available, the “Lighting Bolt” changes to a “Green
Check”symbol.

9. To “push” the coupling intoSteady-State Thermal, right-click on theSteady-State Thermal
Setup cell and selectRefresh.

10. After refresh is finished, you can launch ANSYSMechanical by double-clicking theSetup
cell to finish the coupling setup.

11. In the ANSYSMechanical application project tree, an Imported Load
(Maxwell2DSolution), or (Maxwell3DSolution), item should already be inserted. Select the
Imported Load folder to view its details. Because the insertedMaxwell2D (or 3D) system
supports thermal feedback, theDetailswindow shows information regarding how the
temperature result should be exported, and what type of meshmapping should be used.

Maxwell Coupling 17-6
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

12. To finish the coupling setup, youmust insert either an imported Heat Generation or an
imported Heat Flux boundary condition.Heat Generation is used whenmapping loss from
objects in Maxwell; andHeat Flux should be used tomap the loss from the edges of objects in
Maxwell. Users can insert multipleHeat Generation orHeat Flux loads via the Imported
Load (Maxwell2DSolution), or Imported Load(Maxwell3DSolution) objects.

13. To insert aHeat Generation, useBody select by clicking the icon in theMechanical
Toolbar. Then click on the objects where the EM loss should be imported. After all the desired
objects are selected, right-click on Imported Load (Maxwell2DSolution)> Insert > Heat
Generation, or Imported Load(Maxwell3DSolution) > Insert > Heat Generation.
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A sub-item named Imported Heat Generationwill appear in the project tree.
14. Click on the Imported Heat Generation tree item to view its details.

15. In the Transfer Definition section, users can set up the sourceMaxwell solution by pulling
down theAnsoft Solution combo box and select one of the listedMaxwell solutions.

16. Right-clicking on Imported Heat Generation > Import Load will import loss from the
Ansoft Solution selected for this load. After import has completed, the Import Heat
Generation item becomes a folder, and an entry called Imported Load Transfer Summary
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is listed. Select the Imported Load Transfer Summary entry and the scaling factors used to
export the load fromMaxwell will be displayed in theCommentwindow.

17. Selecting Import Heat Generation should show an overlay-plot of the imported load. The
lossmapping fromMaxwell can be verified by comparing this overlay-plot with anOhmic-Loss
field overlay plot in Maxwell.

18. Create aConvection boundary to complete the thermal setup. UseEdge select by clicking
the icon at theMechanical Toolbar and thenEdit > Select All. With the edges
selected, right-click on theSteady-State Thermal project tree item and insert aConvection.
With theConvection item selected, change itsFilm Coefficient to 5 W/m2 via theDetail
window. Right-click on theSolution tree item and selectSolve. After the thermal solution is
finished, users can insert a Temperature plot by right-clicking onSolution and selecting
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Insert > Thermal > Temperature. Right-click on the newly inserted Temperature item and
selectEvaluate All Results.

19. To export the thermal result to Maxwell, right-click on the Imported Load
(Maxwell2DSolution), or Imported Load(Maxwell3DSolution) and selectExport
Results.

20. To fully utilize the automation capabilities provided inANSYS Workbench, select Imported
Load (Maxwell2DSolution), or Imported Load(Maxwell3DSolution); and in itsDetail
window, selectYes for Export after Solve. With this option selected, users can continue the
iteration betweenMaxwell/Thermal simulations from theWorkbench schematic.
To “push” the exported thermal results back toMaxwell, right-click onMaxwell'sSolution cell
on theWorkbench schematic and selectEnable Update. Then, right-click again onMaxwell's
Solution cell and selectUpdate. This will trigger Maxwell to re-simulate its solution with
thermal results.
To continue the solve iterations, repeat the following steps as needed:
a. Right-click on Thermal'sSetup cell and selectRefresh.
b. Right-click on Thermal'sSetup cell and selectUpdate.
c. Right-click onMaxwell'sSolution cell and selectEnable Update.
d. Right-click onMaxwell'sSolution cell and selectUpdate.
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Maxwell to ANSYS Stress Feedback Coupling
Maxwell 2D/3D supports stress feedback coupling for non-transient designs via theWorkbench
schematic. Any static design type that can support one-way stress coupling can support stress
feedback. For both 2D and 3D, the supported design types are: magnetostatic, eddy current, and
electrostatic.

Note AMaxwell system can also be coupled with both thermal and stress systems via
Workbench.

Maxwell-Specific Considerations
l Usersmust select object/s (i.e., geometry) in Maxwell upon which displacement data from
ANSYSMechanical should be considered. This is done to avoid applying displacement to
the wholemodel while only certain part(s) are sensitive to stress. This is a per-design
setting similar to the Set Object Temperature setting for thermal feedback.

l Each frequency point in an eddy current sweep will be solved with the same feedback data.
l Displacement data that has already been exported fromANSYSMechanical Stress is
invalidated when theMaxwell design is edited such that the previously simulated solution is
considered as invalid or non-current. These edits include:
a. Modifying the geometries or selecting “Revert To Initial Mesh.”
b. Modifying the boundary/excitation settings, such as changing the value of a “Current

excitation” in amagnetostatic design.
l Maxwell solutions can incorporate feedback from both thermal and stress.
l Once theMaxwell solution has been integrated with displacement/temperature, the
adaptive simulation process of a static simulation is disabled. Usersmust thenmanually
invalidate the displacement/temperature data in the existing solution before the adaptive
simulation process is re-enabled.

l Simulation iteration is controlled by user.

Related Topics

CouplingMaxwell Designswith ANSYS Structural viaWorkbench
Setting the Deformation of Objects
Maxwell to ANSYS Thermal Coupling
Force Densities in Maxwell
Force Density Calculation in Maxwell

Maximum force density (AC) components calculation

In Maxwell, there are two options to couple the eddy solver with theMechanical structure static
solver. You can choose either DC force density or Maximum force density. Themaximum force
density includes the contribution fromAC components.
In Maxwell stress tensor,
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The DC(averaged) components of BiBj is calculated by

and the AC (fluctuation) components

where

And is the complex conjugate of . Themaximum force is calculated as:

Coupling Maxwell Designs with ANSYS Structural via Workbench

Stress feedback coupling betweenMaxwell2D/3D and ANSYS Structural 16 is supported via the
Workbench schematic. Stress feedback is supported for Maxwell magnetostatic, eddy current, and
transient types. Users also need to setup the design and geometry appropriately. An appropriate
design has one or more solve setups that are enabled for stress feedback. The process for stress
feedback coupling betweenMaxwell and ANSYS Structural is similar to that described in “Coupling
Maxwell Designswith ANSYS Thermal viaWorkbench”.

1. The easiest way to add aMaxwell 2D or 3D design to aWorkbench schematic is to import a
working design viaWorkbenchFile>Import. The imported design is placed in the
Workbench schematic after it is successfully imported.

2. Next, insert aStatic Structural system and change itsAnalysis Type to 2D or 3D,
(depending on theMaxwell design type) by right clicking on theGeometry cell and selecting
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Properties. It is important to change theSteady-State Thermal system's analysis type
before setting up its geometry.

3. To setup theStatic Structural system's geometry, youmust first export theMaxwell
geometry using sat or step format as follows:
a. Select theModeler>Exportmenu item.
b. Select the desiredmodel geometry format (sat or step), and the save location in the

dialog box and save the file for use by ANSYSWorkbench.
4. Import the file via theGeometrymodule of theStatic Structural system.

a. To access theGeometrymodule, double click on theGeometry cell in theStatic
Structural system to launchDesignModeler.

b. Select File>Import External Geometry File and browse for the geometry file exported
fromMaxwell.

c. After the geometry file is imported, right-click on the root folder of themodeler project tree
and selectGenerate. (When the geometry file is of aMaxwell 2D RZ design, users can
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rotate the geometry inDesignModeler by creating a body operation.)

5. CloseDesignModeler and refresh theModel cell of theStatic Structural system by right-
clicking theModel cell and selectingRefresh.

6. The geometrymode of theStatic Structural system can be changed via the ANSYS
Mechanical user interface.
a. LaunchMechanical by double clicking theSetup cell of theStatic Structural system.
b. SelectGeometry in the project tree and theDefinition ofGeometrywill be shown in the

Detailwindow.
c. Select either Flexible orRigid as the value for the property 2D (or 3D) Stiffness

Behavior.
7. To setup the coupling, drag theSolution cell of theMaxwell system and drop it on theSetup

cell of theStatic Structural system.
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8. Note that theMaxwellSolution cell is tagged with a “Lighting Bolt” symbol. Right-click on the
MaxwellSolution cell and selectUpdate. This will initiate aMaxwell simulation if it is not
already solved. OnceMaxwell's solution is available, the “Lighting Bolt” changes to a “Green
Check”symbol.

9. To “push” the coupling intoStatic Structural, right-click on theStatic Structural Setup cell
and selectRefresh.

10. After refresh is finished, you can launch ANSYSMechanical by double-clicking theSetup
cell to finish the coupling setup, which is similar to that described in “CouplingMaxwell
Designswith ANSYS Thermal viaWorkbench”.

stress Stress

Coupling Maxwell with Both ANSYS Thermal and Structural via
Workbench
AMaxwell system can also be coupled with both thermal and stress systems viaWorkbench. The
thermal system then serves as an “up-stream” system for the stress system. Thismeans that the
stress analysis takes both electromagnetic and thermal forces into consideration. In this scenario the
user must select the same object(s) in the thermal and stress systems to apply the respective
imported loads.
To setup the coupling, drag the “Solution” cell of theMaxwell system and drop it at the “Setup” cell of
a Thermal and Static Structural (Stress) system. The user also needs to couple the Thermal and
Static Structural systems to capture the effect of thermal force.
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The coupling framework is built on top of the existing Thermal Feedback. The Stress systemwill
have additional Export Definition andMapping Settings like Thermal.

Example 1: “One” iteration

The image below illustrates a coupling setup where both the Thermal and Stress system are ready
to be Updated. TheMaxwell adaptive solution has converged in 3 passes. TheMaxwell system has
both thermal and stress feedback enabled.
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1. Right click on theSolution cell of Stress (Static Structural) and selectUpdate.
a. TheSetup of Thermal will be Updated with “em” loss fromMaxwell.
b. TheSolution of Thermal will be Updated and temperature will be exported toMaxwell.
c. TheSetup of Stresswill be Updated with thermal force from Thermal and force density

fromMaxwell.
d. Displacement will be exported toMaxwell after Stress finishes simulation.

2. Right click on theSolution cell of Maxwell and selectEnable Update.
3. Right click on theSolution cell of Maxwell and selectUpdate.

a. Maxwell re-simulates the 3rd passwith itsmesh and the temperature/displacement
feedback.
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b. The profile will show information about the feedback

c. Both Revert to Initial Temperature and Revert to Zero Displacement menus are present in
the analysis setup context menu.

Maxwell Coupling 17-18
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Example 2: Manual iteration

The image below illustrates theWorkbench schematic after Example 1, where the 1st iteration has
completed.
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1. Right click on theSolution cell of Stress and selectUpdate.
a. TheSetup of Thermal will be Refreshed and Updated with “em” loss fromMaxwell.
b. TheSolution of Thermal will be Updated and temperature will be exported toMaxwell.
c. TheSetup of Stresswill be Refreshed and Updated with thermal force from Thermal and

force density fromMaxwell.
d. Displacement will be exported toMaxwell after Stress finishes simulation.

2. Right-click on theSolution cell of Maxwell and selectEnable Update.
3. Right-click on theSolution cell of Maxwell and selectUpdate.

a. Maxwell re-simulates the 3rd passwith itsmesh and new temperature/displacement
feedback.
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b. The profile will show information about the feedback.

Note that the delta temperature and displacement is being reported in the profile.

Example 3: Revert Maxwell Solution

The temperature and displacement in theMaxwell solution can be reverted separately.
1. Users selectRevert to Initial Temperature in Maxwell.

A warningmessage displays notifying users about the invalidation of solution.
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2. Right-click onMaxwell analysis setup and selectAnalyze.
Maxwell re-simulates the 3rd passwith itsmesh and displacement that was previously
exported fromMechanical, but without temperature.
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3. Users selectRevert to Zero Displacement in Maxwell, followed by right-clicking onMaxwell
analysis setup and selectingAnalyze.
Maxwell re-simulates the 3rd passwith itsmesh without either temperature nor displacement.

Example 4: Only Stress Feedback

The coupling setup is the same as in Example 1, with either one of the following differences:
l TheMaxwell system is not enabled for thermal feedback (via SetObjectDisplacement).
Note that sinceMaxwell is not enabled to support feedback, the “Export Result” properties
should be available in the thermal system.

l TheMaxwell system is enabled for thermal feedback, but users choose not to “Export
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Result’ in the thermal system. This is to disable the automatic “Export Results”.

1. Right click on theSolution cell of Stress and selectUpdate.
a. TheSetup of Thermal will be Updated with “em” loss fromMaxwell.
b. TheSolution of Thermal will be Updated.
c. TheSetup of Stresswill be Updated with thermal force from Thermal and force density

fromMaxwell.
d. Displacement will be exported toMaxwell after Stress finishes simulation.

2. Right-click on theSolution cell of Maxwell and selectEnable Update.
3. Right-click on theSolution cell of Maxwell and selectUpdate.

a. Maxwell re-simulates the 3rd passwith itsmesh and the displacement feedback.
b. The profile shows information about the feedback andRevert to Zero Displacement will
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be available in the solve setup context menu.
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Maxwell Harmonic Force Coupling
Maxwell 2D/3D supports one-way harmonic force coupling via ANSYSWorkbench for transient and
Eddy current designs. Maxwell enables you to select multiple objects for force calculations for
harmonic coupling withWorkbench projects.
Maxwell also supports one-way coupling with LMS Virtual Lab for transient designs.

Related Topics

"Maxwell to ANSYS Harmonic Force Coupling" below
"Maxwell to LMS Virtual.Lab Coupling" on page 17-34
Force Densities in Maxwell
Force Density Calculation in Maxwell

Maxwell to ANSYS Harmonic Force Coupling

Maxwell 2D/3D supports one-way harmonic force coupling for transient andEddy current designs
via theWorkbench schematic. Maxwell enables the user to select multiple objects for force
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calculations for harmonic coupling withWorkbench.
For detailed information on setting up and using harmonic force coupling inWorkbench, refer to the
Workbench help topics: Importing Data into a Harmonic Analysis and Importing Data into a Thermal
or Structural (Static or Transient) Analysis.
To enable harmonic force calculations in Maxwell for use inWorkbench:

1. Either selectMaxwell 2D (orMaxwell3D)>Enable Harmonic Force Calculation, or right-
click on the Design in the project tree and selectEnable Harmonic Force Calculation to
open theEnable Harmonic Force Dialog box.

l For Eddy current designs, the dialog has two tabs:General, andAdvanced.
l For transient designs, the dialog has three tabs:General,Advanced, and Link to
LMS.

Note l The Link to LMS tab is not used for Maxwell to ANSYS harmonic force
coupling.

l The Link to LMS tab is used only for one-way coupling with LMS
Virtual Lab.

2. On theGeneral tab, check the objects for which force calculations are desired.

3. TheAdvanced tab provides additional settings to allow you to control collection of data from
the force calculations.
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l For transient designs that include rotational motion, theCollect samples at completion
setting allows you to choose the Number of cycles from the end for which data is collected.
For example, if one cycle equals 1 second, and you solve for 3.5 seconds, setting the
Number of cycles from the end to 2 results in data being collected for the period from 1.5
seconds to 3.5 seconds. Alternatively, you can selectCollect samples within a window,
for which you can set a data collectionStart at time and a data collectionStop option -
either stop data collection after a user-specified number of cycles or at a user-specified stop
time.

l For transient non-rotational motion designs, theAdvanced tab allows you to set the data
collectionStart time andStop time.
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l For Eddy current designs, the Advanced tab allows you to set the Rotation Axis and the axis
direction so that theMaxwell solver can generate a full model if a partial model is used in the
design. You can create relative coordinate systems to addmore axes.
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OnceMaxwell is linked to the Harmonic product, it can export the harmonic force results to
theWorkbench Harmonic design. Harmonic Eddy force solutions are kept as part of
Maxwell design solutions. If Workbench harmonic design settings are changed, the
Maxwell solutionswill be invalidated.

4. ClickOK to close the dialog.

Related Topics

Force Densities in Maxwell
Force Density Calculation in Maxwell

Force Densities in Maxwell

Let be theMaxwell stress tensor (refer to reference [1] for detail of theMaxwell stress tensor).
Then the force acting on an object can be calculated by:

(1)

Application of the divergence theorem to volume integral gives:
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(2)

Note that
is the force per unit area transmitted across the surface. Namely, it is the surface force density, which
is denoted as:

(3)

Also, from (1), you can define a volume force density by stress tensor as:

(4)

For amagnetostatic field (similar forms for electric field), the explicit form of theMaxwell stress
tensor is:

(5)

So the surface force density can be calculated as:

(6)

The volume force density can be calculated by (4) and using the virtual work principle (refer to
reference [2] for details).
Reference [1] J.D. Jackson, Classical Electrodynamics, 3rd edition, Wiley, 1999.
Reference [2] A. Bossavit: "Eddy-currents and forces in deformable conductors", in Mechanical
Modellings of New ElectromagneticMaterials (Proc. IUTAMSymp., Stockholm, April 1990, R.K.T.
Hsieh, ed.), Elsevier (Amsterdam), 1990, pp. 235-42.

Force Density Calculation in Maxwell

Maxwell solvers can be coupled with ANSYSMechanical either one-way or two-way. Maxwell
solvers provide volumetric force density/surface force density as load of Mechanical solvers. Force
density is calculated byMaxwell stress tensor.
Maxwell stress tensor for magnetic fields:
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Where
The force on a surface can be calculated as:

Where is outward normal direction of the face.
The surface force density is calculated from:

WhereA is the area of the surface.
The volumetric force density in an element is calculated from:

WhereV is volume of the element, andN is the number of surfaces (sides in 2D) of this element.

Harmonic Force calculation from Maxwell

Maxwell can calculate the harmonic force on each tooth of a rotatingmachine. This feature enables
the one-way coupling betweenMaxwell and Harmonic Response of ANSYS. The force is object
based, not element based. The harmonicmomentum reference to the geometric center of the object
is also provided at the same time. This feature is also extended to any individual object.
There are two options to calculate the force of an individual tooth:

a. Split the stator/rotor to form separate tooth object, and integrate forces on all out surfaces
of this tooth except the splitting surfaces.

b. Draw an arc (2D) or a cylindrical face (3D) near the tooth in the air gap, and integrate
forces on this face.

Discrete Fourier Transform (NDFT) with non-uniform time interval

In the general case, the definition of the Non-uniformDiscrete Fourier Transform (NDFT) is the
same as the definition with constant time interval, taking into consideration that the samples can be
taken at irregular intervals in time (tn). That is to say that the samples x(k) of the irregular Fourier

transform are taken at multiples of a quantity , which is a fixed quantity in the Fourier domain.

The fixed quantity in the regular case corresponds to . The extension from regular to
irregular sampling, therefore, depends on the duration of the signal x(t) and not on the fact that the
samples are taken at regular or irregular intervals.
A finite samplemeasured atN points in a period of T:
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The definition of the nonuniform discrete Fourier transform (NDFT)is as follows:

The inverse NDFT is given by:

Data collection:

The solver records the components of force andmomentum at all teeth at every time step.

If , then keep records.

Generate harmonic force from partial model to full model

With symmetry-multiplier (period in 3D)>1, Maxwell solvers automatically generate harmonic force
for the full model from the partial model

Where r is the vector to be rotated, r* is the vector after rotation. The rotationmatrix in 3D:
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The rotationmatrix in 2D:

Vectors that need to be rotated: position (r), force (F) andmoment (M)

Maxwell to LMS Virtual.Lab Coupling

Maxwell supports one-way coupling with Siemens® LMS Virtual.Lab™.
To enable output of Maxwell solutions for use in Virtual.Lab:

1. Either selectMaxwell 2D (orMaxwell3D)>Enable Harmonic Force Calculation, or right-
click on the Design in the project tree and selectEnable Harmonic Force Calculation to
open theEnable Harmonic Force Dialog box.

2. On theGeneral tab, to enable output of Maxwell solutions for Virtual.Lab, check only one
object. The informational text informs you that harmonic force calculation is disabled, and
confirms that only one object has been selected.

3. On the Link to LMS tab, enter the path to theOutput directory you want to use for the
Virtual.Lab files generated byMaxwell.
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4. Export settings to allow you to control collection of data for export to Virtual.Lab. You can
choose to includeNo steps orAll steps. TheSteps from end setting allows you to choose
the number of steps from the end for which data is collected. Alternatively, you can select a
Range of steps, for which you can set a data collectionStart step and a data collectionEnd
step.

5. ClickOK to close the dialog box.
6. Solve theMaxwell project.

The two Virtual.Lab .unv files generated byMaxwell will be in the output directory you
specified.

Maxwell Partial Model Coupling with Workbench
This feature allowsMaxwell 2D and 3D partial model coupling withWorkbench applications such as
Mechanical and Thermal. The full model geometry and solution can be extracted through symmetry
from the partial model. Symmetry boundary conditions are used to solve problemswith symmetry
and, thus, allow the users to take advantage of the significantly reduced problem size for a given
accuracy.
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The following conditionsmust be observed for theMaxwell partial model:
l Themodel must be physically correct.
l Master and slave boundariesmust be planar. If there ismore than one pair of master and
slave boundaries, all masters are coplanar and all slaves are coplanar.

l There are at most threemirroring symmetries, which are orthogonal to each other. If there
is a pair of master and slave boundaries, then only onemirroring symmetry is allowed and it
must be perpendicular to the axis of themaster and slave boundaries.

l When theMaxwell side is a partial model and theMechanical side is full model, full model
loss / force will bemapped to theMechanical side.

l When theMaxwell side is a partial model and theMechanical side is also a partial model,
only partial model loss / force will bemapped to theMechanical side.

The user must ensure that theMaxwell partial model is physically correct, and that the full model in
WorkbenchMechanical, Thermal, etc. matches the partial model. The loss/force data from the
partial Maxwell model is thenmapped to the full model inWorkbenchMechanical, etc. for solving.
Themapping is handled implicitly.
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Related Topics

Symmetry for aMagnetostatic Field Solution
Matching (Master/Slave) Boundary for aMagnetostatic Field Solution
Symmetry for an Electric Field Solution
Matching (Master/Slave) Boundary for an Electric Field Solution
Symmetry for a Transient Solution
Matching (Master/Slave) Boundary for a Transient Solution
2D Symmetry Boundaries

Near Field Coupling between Maxwell and HFSS
The purpose of this coupling is to allowMaxwell3D frequency domain solutionmagnetic fields to be
used as a near field source in the coupledHFSS design at exactlymatched frequency.

Note There is no Far Field Wave coupling datalink betweenHFSS and
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Maxwell.

The suggested sequence of steps to create the link betweenMaxwell andHFSS is as follows.
1. Create and solve theMaxwell3D frequency domain application at the chosen frequency.
2. Create theHFSSmodel.
3. Add "mapping" object toHFSSmodel.
4. Select all faces of themapping object and apply a radiation boundary:

l check theAdvanced Options check box.
l select theEnforced field radio button.

5. ClickHFSS>Excitations>Assign>Incident Wave>Near Field Wave.
The Incident Wavewizard appears. In the wizard:
l Enter a name for the source or accept the default name and clickNext;
l In the Incident Wave Source: Near Field Wave Options dialog:
a. Leave the translation and rotation data fields at their default zeros if the objects in the

coupled designs have the desired location / orientation or change the values as needed;.

Note You can change the location of the source design origin and orientation
(rotation) to perform differentHFSS simulationswithout re-solving the
Maxwell design.

b. Click theSetup Link button to specify the location of the source, Maxwell design.

SelectOK to exit theSetup Link dialog.

l Select Finish to finalize the Near Field link setup.

Magnetic Bias Source Coupling between Maxwell and HFSS
HFSS designs featuring ferrite materials can take advantage of non-uniform, staticmagnetic biasing
fields to provide accurate design and simulation results. To achieve this goal it is possible to set up a
coupling datalink betweenHFSS (target design) and aMaxwell3Dmagnetostatic design (source).
The suggested sequence of steps to create the link between theHFSS andMaxwell3D designs is
as follows:

1. Create and solve theMaxwell3D design which contains the ferrite object and the
corresponding non-uniform biasing fields.

2. Create theHFSS design which can have entirely different geometry but which contains the
ferrite object(s) present in the linkedMaxwell3D design;
Note Make sure that in the coupled designs (HFSS andMaxwell) the ferrite objects have

the same position and orientation in the global coordinate system.

3. InHFSS design, assign appropriate ferrite material property to object.
4. InHFSS design set themagnetic bias source (only one allowed perHFSS design):

l Select the object(s) to be assign the non-uniformmagnetic bias.
l ClickHFSS>Excitation>Assign>Magnetic Bias in themenu.
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TheMagnetic Bias Source dialog appears:

a. Enter aName for the source.
b. Select theNon-Uniform radio button.
c. Click theSetup Link button to specify the applicableMaxwell3D project, design and

solution for the link.
SelectOK when done.

d. Select Finish to finalize theMagnetic Bias link setup.
Hint It is possible to have the datalink create theMaxwell project automatically if it doesn’t exist.

When selecting the “Setup Link” button above, entering non-existentMaxwell project and
design nameswill result in the creation of the neededMaxwell entities with the entireHFSS
geometry included. All unneededHFSS objects can be removed and the rest of theMaxwell
model can be built around the ferrite object(s).

Coupling Maxwell to a Simplorer Component
Maxwell designsmay be dynamically coupled to Simplorer components through the Simplorer user
interface. The Simplorer interface allowsMaxwell 2D, 3D, and RMxprt designs to be linked as
dynamic components. Source windings set toExternal are available as conservative pins in
Simplorer. Transient couping linksmust be enabled inMaxwell on theDesign Settings>Advanced
Product Coupling tab for Transient Cosimulation with Simplorer.
Dynamically linked components provide the ability to have Simplorer vary a variable in aMaxwell
design and haveMaxwell solve the design at the new design point and provide the solution data back
to Simplorer for use in the circuit simulation.
For more information on couplingMaxwell designs to Simplorer components, refer to theMaxwell
Coupling Components andRMxprt Dynamic Coupling Component topics in theSimplorer Online
Help.

Related Topics

Advanced Product Coupling Tab (for Transient-Transient coupling only.)

Coupling Maxwell Magnetostatic and Eddy Current Designs with ANSYS
Fluent
Coupling is supported between ANSYS Fluent andMaxwell 3D magnetostatic and Eddy current
designs. For example, a transient Fluent simulation can use aMaxwell solution to simulate the
magnetic effect of the electric arc of contactors. This coupling supports designs that have a datalink
defined, such asmesh, demagnetization, and so on. A design that is enabled for thermal and stress
feedback is not supported.
In ANSYS Fluent, during a transient simulation that requires exchanging data with Maxwell, a user-
defined function (UDF) invokes theMaxwell solver. ANSYS Fluent andMaxwell exchange inputs
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and solution data in a coupling directory that you specify. Maxwell calculates the B field based on the
mesh-based conductivity (andmeshed-based permeability in eddy current designs); and current
excitation provided by ANSYS Fluent. ANSYS Fluent calculates flow field, temperature, and
feedback electrical conductivity (and permeability in eddy current designs) to Maxwell.TheMaxwell
GUI does not provide direct access to the data in this coupling directory.
Follow these steps to set up the coupling:

1. Set up themagnetostatic or Eddy current project in Maxwell 3D.
2. In the project tree, right-clickSetup underAnalysis and selectConfigure Fluent

Conductivity Coupling.
3. In theConfigure Fluent Conductivity Coupling dialog, browse to select the coupling

directory or type a path, and clickOK. You can enter a local directory, such aswhereMaxwell
desktop is running, or you can enter amapped network location.
l If you enter an existing directory that contains files, a warning notifies you that all files in that
directory will be permanently deleted. ClickYes to use that directory and delete all files
contained in it. ClickNo if you do not want to select that directory. When you click No, the
dialog box stays open for you to enter a different directory.

l If the directory you entered does not exist, Maxwell creates the directory. If the directory is
not successfully created, the dialog remains open.
Note l If there are errors during the process or if you terminate the process, the

coupling directory is not configured.
l If there is version incompatibility between ANSYS Fluent andMaxwell, the
process is stopped and an error message is displayed.

l If you Clean Stop the process and there is enough solution data to configure
the directory, the coupling directory will still be configured.

4. Set up the ANSYS Fluent project as described in theANSYS Fluent User’s Guide.
5. Build and load the UDF that was developed for your application. For more information about

UDFs, see theANSYS Fluent UDFManual.
6. In the input.txt file that is specific to the UDF, provide the information that is required by the

UDF. For more information about the required information and format, see Sample Input.txt
File Format.
The UDF is invoked during the transient simulation. When there is a need to exchange data,
the UDF invokes theMaxwell solver.

Related Topics

Sample Input.txt File Format

Sample Input.txt File Format

The input.txt file is used by the UDF during the coupling between ANSYS Fluent andMaxwell.
The following example shows the format and provides information about the parts of the file.
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Related Topics

Determining the Zone ID in ANSYS Fluent
Determining the Face ID in ANSYS Fluent
Determining theObject ID inMaxwell

Determining the Zone ID in ANSYS Fluent

You can determine the Zone ID in ANSYS Fluent as follows:
1. In the navigation pane under Solution Setup, selectCell Zone Conditions.
2. Select a zone on the task page.

The ID of the zone you selected is displayed in the ID text box.

Related Topics

Sample Input.txt File Format

Determining the Face ID in ANSYS Fluent

You can determine the Face ID in ANSYS Fluent as follows:
1. In the navigation pane under Solution Setup, selectBoundary Conditions.
2. Select a boundary on the task page.

The ID of the face assignment is displayed in the ID text box.

Related Topics

Sample Input.txt File Format

Maxwell Coupling 17-41
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Determining the Object ID in Maxwell

You can determine theObject ID inMaxwell as follows:
1. ClickTools>Open Command Window.
2. In the IronPython Command Window, query the object ID by its name.

Related Topics

Sample Input.txt File Format

Magnetostriction in Maxwell to Workbench Mechanical Coupling
Maxwell supportsmagnetostriction and inversemagnetostriction forces inWorkbenchMechanical
coupling for Maxwell 2D/3D Magnetosatic designs. Both one-way and two-way coupling are
supported.

One-way coupling
l TheMaxwell solver calculates force density which includesmagnetostriction force data. The
force density data includingmagnetostriction force data is output to theWorkbench
Mechanical system .

Two-way coupling

l Maxwell provides force density data to theMechanical system as it does for one-way coupling.
l TheWorkbenchMechanical system solves and sends stress/strain data (plus displacement
data) to Maxwell, which will be used in theMaxwell solution for the next iteration.
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Related Topics

Magnetostriction and InverseMagnetostriction
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18 - ANSYS Workbench Integration Overview
ANSYSWorkbench combines the strength of its core product solvers with the project management
tools necessary tomanage project workflow. In ANSYSWorkbench, analyses are built as systems,
which can then be combined into a project. The project is driven by a schematic workflow that
manages the connections between the systems.
From the schematic, you can interact with applications (called workspaces) that are native to
ANSYSWorkbench and that display within the ANSYSWorkbench interface. Native workspaces
include: Project Schematic, Engineering Data, and Design Exploration (Parameters and Design
Points).
You can also launch applications that are data-integrated with ANSYSWorkbench, meaning the
application’s interface remains separate, but the data from the application communicateswith the
native ANSYSWorkbench data. Thus, data can be passed back and forth between any ANSYS
Electromagnetics product on aWorkbench Project Schematic and any supported ANSYS or
ANSYS Electromagnetics desktop product. Depending on the application, data integration can
include basic actions such as saving projects, as well asmore complex actions such as the coupling
of ANSYS Electromagnetics product variables toWorkbench Design Exploration parameters.
Data-integrated applications include the following ANSYS Electromagnetics products: Circuit,
HFSS, Maxwell/RMxprt, Q3D Extractor, and Simplorer.

Note For detailed information on working with ANSYSWorkbench, please refer to the
Workbench documentation.

Integrating ANSYS Electromagnetics Products with ANSYSWorkbench
Workbench Data Integration Overview
ANSYS Electromagnetics - ANSYSMultiphysics Coupling
ANSYS Electromagnetics CAD Integration ThroughWorkbench
WorkbenchMaterial Data Transfer
ANSYS Electromagnetics to ANSYS Geometry Transfer
User DefinedModel (UDM) for ANSYSWB Integration
Feedback Iterator

Integrating ANSYS Electromagnetics Suite Products with ANSYS
Workbench
You can integrate ANSYS Electromagnetics products with ANSYSWorkbench in one of two ways:

l During product installation, or
l After product installation

Maxwell Online Help
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Integration with ANSYS Workbench during ANSYS Electromagnetics
Product Installation

You can choose to integrate ANSYS Electromagnetics products with ANSYS 18.0 during
installation as follows:

1. If you have not already installed ANSYS 18.0, do so before proceeding. Refer to the ANSYS
documentation for instructions on installing the ANSYS 18.0 software.

2. LaunchAutorun.exe or Setup.exe for the ANSYS Electromagnetics product you wish to
install.

3. Proceed through the installation dialogs.
4. When the Integration with ANSYS 18.0 dialog displays, select theYes radio button to have

the installer automatically integrate the ANSYS Electromagnetics product with ANSYS 18.0.

Note If you choose not to integrate the product with ANSYS 18.0 during installation, you can
perform this step after installation.

4. Complete the product installation and exit the installer.

Integration with ANSYS Workbench after ANSYS Electromagnetics
Product Installation

If you want to integrate ANSYS Electromagnetics Suite with ANSYS 18.0 after installation, do the
following:

1. SelectPrograms>ANSYS Electromagnetics>ANSYS Electromagnetics Suite
[version]>Modify Integration with ANSYS 18.0 from theStartmenu.

2. In the Integration with ANSYS 18.0 dialog box, ensure that theYes radio button is selected,
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then clickOK to complete the integration process. ThenOK the information dialogue.

You can confirm that ANSYS 18.0 is “aware” of the ANSYS Electromagnetics Electronics Desktop
application via the ANSYSWorkbenchOptions dialog, which shows the Electronics Desktop install
path.
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The Journal Recording Language option permits you specify the default journal recording language.
l The default language is IronPython. You can change the recording language to VB.
l Changes in the recording language option apply to any ANSYS Electromagnetics desktop
launched after the change.

l Any open ANSYS Electromagnetics desktop will continue recording in the language that was
in effect when it was launched.

Workbench Data Integration Overview
ANSYS Electromagnetics data-integrated applications can reside on aWorkbenchProject
Schematic as shown below.
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Objects, such as instances of ANSYS Electromagnetics projects, that are placed on aWorkbench
Project Schematic are referred to as systems. ANSYS Electromagnetics circuit/system products:
RMxprt, Circuit, and Simplorer, appear onWorkbench Project Schematics as systemswith two
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“cells” –Setup andSolution. ANSYS Electromagnetics field products: HFSS, Maxwell, andQ3D
Extractor add an additionalGeometry cell. If you invoke ANSYS DesignXplorer to use variables
for refining a design, aParameters cell is added with a link to the associatedWorkbenchParameter
Set. Refer to the ANSYS 18.0Workbench help for details on working with systems, cells, and
parameter sets.

ANSYS Electromagnetics desktop products integrate withWorkbench commands, services, and
DesignXplorer in a similar manner. Here are some of the ways in which ANSYS Electromagnetics
products integrate withWorkbench:

l Adding new analysis systems
l Importing existing desktop projects
l Editingmodels
l Analyzingmodels
l Performing parameter studies
l Scripting

In addition to thesemajor features, Workbench also allows you to Archive, Save, Backup, Duplicate,
and Delete ANSYS Electromagnetics projects used in aWorkbench project. Progress information
andmessages from integrated ANSYS Electromagnetics projects are also displayed inWorkbench.

Note Detailed information for how to use ANSYSWorkbench 18.0 for these operations can be
found in the ANSYS 18.0 documentation and online help.

Adding New ANSYS Electromagnetics Analysis Systems

A new ANSYS Electromagnetics Analysis System can be added to aWorkbench Project Schematic
either by dragging and dropping it from the Toolbox:
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or by selecting it from the context menu in theWorkbench Project Schematic window:

Related Topics

Workbench Data Integration Overview
Importing ANSYS Electromagnetics Projects into ANSYSWorkbench
Editing ANSYS ElectromagneticsModels inWorkbench
Analyzing ANSYS ElectromagneticsModels inWorkbench
Performing Parameter Studies inWorkbench
Scripting inWorkbench
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Importing ANSYS Electromagnetics Projects into ANSYS Workbench

You can import existing ANSYS Electromagnetics desktop projects to aWorkbench Project
Schematic. When you do, a copy of the ANSYS Electromagnetics project is put into theWorkbench
Project folder. The original ANSYS Electromagnetics project remains intact.

Related Topics

Workbench Data Integration Overview
Adding New ANSYS Electromagnetics Analysis Systems
Editing ANSYS ElectromagneticsModels inWorkbench
Analyzing ANSYS ElectromagneticsModels inWorkbench
Performing Parameter Studies inWorkbench
Scripting inWorkbench

Editing ANSYS Electromagnetics Models in Workbench

You can edit various properties and parameters (geometry, setup, solution, etc.) of the ANSYS
Electromagnetics project either by right-clicking on the project inWorkbench and selectingEdit on
the context menu; or by double-clicking the project. Doing so launches the ANSYS Electromagnetics
desktop application and loads the project so that you can setup your project in a familiar desktop
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environment. Changesmade to the ANSYS Electromagnetics project are saved to the project
instance in theWorkbench project folder.

Related Topics

Workbench Data Integration Overview
Adding New ANSYS Electromagnetics Analysis Systems
Importing ANSYS Electromagnetics Projects into ANSYSWorkbench
Analyzing ANSYS ElectromagneticsModels inWorkbench
Performing Parameter Studies inWorkbench
Scripting inWorkbench

Analyzing ANSYS Electromagnetics Models in Workbench

You can useWorkbench’sUpdate command to run analyses in the integrated ANSYS
Electromagnetics project. Progress information is also shown inWorkbench.
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Related Topics

Workbench Data Integration Overview
Adding New ANSYS Electromagnetics Analysis Systems
Importing ANSYS Electromagnetics Projects into ANSYSWorkbench
Editing ANSYS ElectromagneticsModels inWorkbench
Performing Parameter Studies inWorkbench
Scripting inWorkbench

Performing Parameter Studies in Workbench

WorkbenchParameter Sets allow you to change parameter values, or add new parameters.
Parameter data is passed back to the ANSYS Electromagnetics application for updated analyses.
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Note BecauseWorkbench and ANSYS Electromagnetics Desktop have different unit systems,
units defined in Desktop are Dimensionless in theWorkbench Parameters table and thus
cannot be changed. Refer to theANSYS DesignModeler User’s Guide > Project
Schematic Operations > Parameters in Project Schematic > Parameter Units topic for
additional information.

Parameters from the ANSYS Electromagnetics project are exposed toWorkbench through the
DesignXplorer setup. The ANSYS Electromagnetics system’s cell status on theWorkbench project
is updated as changes aremade in the ANSYS Electromagnetics application desktop.
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Related Topics

Workbench Data Integration Overview
Adding New ANSYS Electromagnetics Analysis Systems
Importing ANSYS Electromagnetics Projects into ANSYSWorkbench
Editing ANSYS ElectromagneticsModels inWorkbench
Analyzing ANSYS ElectromagneticsModels inWorkbench
Scripting inWorkbench

Scripting in Workbench

Scripts that include ANSYS Electromagnetics projects can be recorded and played back via
Workbench.
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Related Topics

Workbench Data Integration Overview
Adding New ANSYS Electromagnetics Analysis Systems
Importing ANSYS Electromagnetics Projects into ANSYSWorkbench
Editing ANSYS ElectromagneticsModels inWorkbench
Analyzing ANSYS ElectromagneticsModels inWorkbench
Performing Parameter Studies inWorkbench

ANSYS Electromagnetics - ANSYS Multiphysics Coupling
Data integration provides improvedmultiphysics workflow between ANSYS Electromagnetics
designs and ANSYS applications such asMechanical and Thermal. Coupling is provided through
project schematic links. Heat losses and force data are automatically transferred to ANSYS
Mechanical - there is no need to export/import “transfer xml files”. Edits youmake in ANSYS
Electromagnetics applications are automatically transferred to the ANSYS application through a
WorkbenchRefresh command.Workbench commands also enable easier automation of iterative
coupling of thermal feedback. The following sections provide some examples of multiphysics
coupling.
Multiphysics Coupling onWorkbench with ANSYS Thermal
Multiphysics Coupling onWorkbench with ANSYS Structural
Multiphysics Coupling between ANSYS Electromagnetics Field Systems onWorkbench
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Multiphysics Coupling on Workbench with ANSYS Thermal

Using data integration, HFSS, Maxwell, andQ3D Extractor provide heat losses (heat generation
and heat flux) to ANSYS Thermal. You first need to enable feedback as described in Setting the
Temperature of Objects.
Note how the HFSS design is linked visually to ANSYS Thermal on theWorkbench project
schematic.

A geometry from the Component Systems in the Toolbox inWorkbench Schematic can be shared as
shown in the image below.

In this example, HFSS coaxmodel Solution provides heat loss data as a thermal load to the ANSYS
Thermal Setup. The resulting analysis shows a thermal “hotspot”, providing the user with the
information needed to adjust the design’smaterial to fix the problem.
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You enable this feature by checking Enable Feedback in the dialog for Setting the Temperature of
Objects.

Related Topics

Feedback Iterator

Multiphysics Coupling on Workbench with ANSYS Structural

Using data integration, Maxwell 2D andMaxwell 3Dcan provide forces to ANSYS Structural.

In this example, theMaxwell 3D electromagnetic force densitySolution is used as the load in
ANSYS Structural to determine how these forces deform themotor’s stator and coils.
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Multiphysics Coupling between ANSYS Electromagnetics Field Systems
on Workbench

You can setup links between ANSYS Electromagnetics field systems that reside on aWorkbench
project schematic. Linking is setup in the ANSYS Electromagnetics application as shown in the
example below.
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CAD Integration through Workbench
ANSYS Electromagnetics CAD integration is aWorkbench feature available for ANSYS
Electromagnetics 3D Products - HFSS, Maxwell, andQ3D, as the ANSYS Framework for ANSYS
Electromagnetics package. The feature is available only throughWorkbench, not available with
standalone ANSYS Electromagnetics products.
ANSYS Electromagnetics CAD integration provides a bi-directional dynamic link through
Workbench, whichmakes it possible to get updated geometry fromCAD and tomodify CAD
parameters in ANSYS Electromagnetics products to return updated geometry. The feature is non-
associative due to a need to reassign boundaries if modified CAD model is to be used. The process
creates a User DefinedModel (UDM) for each geometry source
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The User DefinedModel (UDM) format makes it possible to exchange parameters.

Note The parameters shown in the previous example all have aDS prefix. This is the default for
theWorkbench Tools>Options forGeometry Import. If you want to import parameters
with different prefixes or names, you should assign an appropriate prefix, or clear the
Filtering Prefixes field, depending on your needs.
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See here for further description of the UDM feature and function.
ANSYS Electromagnetics CAD integrationmakes it possible to consume geometry frommultiple
upstream source which can be anyCAD or ANSYS Electromagnetics product. This feature
supports direct interfaceswith all major CAD systems.

l Pro/EWildfire
l UGNX
l CATIA V5
l SolidWorks
l Autodesk Inventor
l ANSYS DesignModeler (DM)
l ANSYS SpaceClaimDirect Modeler (SCDM)

CAD softwaremust be installed on user machine
l Not required on solve nodes

PlatformsSupported
l Windows 64 bit
l Linux

See the following sections:
CAD Integration andGeometry Sharing
Bi-Directional CAD Integration
CAD IntegrationModel Edits
Multiple Geometry Links for CAD Integration
CAD Integration Functionality
Healing with CAD Integration
Important GeometryOptions for CAD Integration
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CAD Integration and Geometry Sharing

CAD model comes into ANSYS Electromagnetics asUser DefinedModel (UDM).
The input to ANSYS Electromagnetics fromCAD is:

l Geometry/Topologywith persistent IDs
l CAD parameters
l Material assignment
l Attributes like name, and color

For example, inWorkbench, a Pro/E Model can be linked to HFSS.

The geometry can then be viewed in HFSS as a UDM.

The CAD orWBmodel parameters appear in theWorkbench:
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Though the ANSYS Electromagnetics CAD Integration, the linked UDM includes the same
parameters.

Note The parameters shown in these examples all have a “DS” prefix. This is the default for the
Workbench Tools>Options forGeometry Import. If you want to import parameters with
different prefixes or names, you should assign an appropriate prefix, or clear the Filtering
Prefixes field, depending on your needs.
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Once you import a geometry with parameters to an Electromagnetics application in the desktop, you
need tomap them to local variables. That is, in the target Electromagnetics application, select the
geometry associated with the parameters. Update the geometry, and view the Parameters tab in the
Property window. The Values columnwill show the values of the imported parameters. You then
type names for local variables in the values column.

Once you have local variables for the imported DesignModeler parameters, you are ready to use
Design Xplorer for multiple design parameters.
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Related Topics

ANSYS Electromagnetics CAD Integration ThroughWorkbench
Bi-Directional CAD Integration
CAD IntegrationModel Edits
Multiple Geometry Links for CAD Integration
CAD Integration Functionality
Healing with CAD Integration
Important GeometryOptions for CAD Integration

Bi-Directional CAD Integration

ANSYS Electromagnetics CAD Integrations usesRefresh (or Generate) CAD Model to pass
updates.
For example, you canmake an edit in a CAD application and either runRefresh on an ANSYS
ElectromagneticsGeometry Cell or runGenerate on the UDM in the ANSYS Electromagnetics
window
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Refresh pulls the current state of CAD model (geometry, parameters, materials etc) and updates the
corresponding data in the ANSYS Electromagnetics application.
If you edit UDM (CAD) parameters in the ANSYS Electromagneticsmodeler window you can run
theSend Parameters and Generate command

The command passes the edited parameters to the linked CAD application and then pulls
corresponding CAD geometry.

Related Topics

ANSYS Electromagnetics CAD Integration ThroughWorkbench
CAD Integration andGeometry Sharing
CAD IntegrationModel Edits
Multiple Geometry Links for CAD Integration
CAD Integration Functionality
Healing with CAD Integration
Important GeometryOptions for CAD Integration

CAD Integration Model Edits

Several modeling operations are allowed on a CAD model in the ANSYS ElectromagneticsModeler
window. Operationswill included in the History tree and retained duringmodelRefresh.

The following operations are not allowed:
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l Non-history tree operations like Heal or defeature.
l Operationswhich use UDMparts as Tool such as Sweep, or Boolean operations like Split or
Unite (but allowed when you select the clone tool option).

The following part attributes can bemodified for UDMparts.
l Model/NonModel flag
l Solve Inside flag
l Part orientation
l Color
l DisplayWireframe

It is not possible to delete individual parts of UDM

Related Topics

ANSYS Electromagnetics CAD Integration ThroughWorkbench
CAD Integration andGeometry Sharing
Bi-Directional CAD Integration
Multiple Geometry Links for CAD Integration
CAD Integration Functionality
Healing with CAD Integration
Important GeometryOptions for CAD Integration
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Multiple Geometry Links for CAD Integration

With CAD Integration you can consume geometry frommultiple upstream sources. The Source can
be any of CAD or ANSYS Electromagnetics products. This creates a UDM for each geometry
source.
For example, the following figure shows a DMModel, a Maxwell model, and ProE model linked to
HFSS inWorkbench, and displayed in the HFSS History tree as three UDMs.

Related Topics

ANSYS Electromagnetics CAD Integration ThroughWorkbench
CAD Integration andGeometry Sharing
Bi-Directional CAD Integration
CAD IntegrationModel Edits
CAD Integration Functionality
Healing with CAD Integration
Important GeometryOptions for CAD Integration

CAD Integration Functionality
l WBUpdate Project
l WBUpdate All Design Points

ANSYSWorkbench Integration Overview 18-26
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l DX analysis
l Parametric Analysis with DSO
l Animation
l Geometry
l Field Plots

For Explicit Subtraction
l ANSYSMechanical does not do implicit subtraction
l ANSYS Electromagneticsmodeler commandModeler>Model Preparation>Perform
Explicit Subtraction can do explicit subtractions before sending geometry to ANSYS.

For example, consider the followingmodel.

PerformExplicit Subtractions can be performed.

The results appear in the History tree as shown:
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TheMessage window reports this action.

Related Topics

User DefinedModel (UDM) for ANSYSWB Integration
UDM compared to User Defined Primitives
Insert UDMCommand on Draw Menu
UDMProperties
Library of Models for CAD Integration
ANSYS to ANSYS ElectromagneticsGeometry Transfer
CAD IntegrationMaterial Assignment Transfer
Geometry Transfer through ANSYS DesignModeler (DM)

Healing with CAD Integration

It is not possible to use the Heal command in ANSYS ElectromagneticsModeler. Instead similar
healing options are available under UDMproperties option tab.
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The Healing options are: None, Auto andManual. By default healing is off (None) and should be
turned on only if required.

Related Topics

ANSYS Electromagnetics CAD Integration ThroughWorkbench
CAD Integration andGeometry Sharing
Bi-Directional CAD Integration
CAD IntegrationModel Edits
Multiple Geometry Links for CAD Integration
CAD Integration Functionality
Important GeometryOptions for CAD Integration

Important Geometry Options for CAD Integration

Select a Geometry Cell inWorkbench to see options in Properties window.
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l Control dimension of bodies coming fromCAD

l Make sure parameters is checked and parameter key (filter) is appropriate to bring CAD
parameters.

This (default) parameter key filteringmeans that only parameters whose names start with DS
will come through. Notice that the Parameter Key value (default DS) is set via theWorkbench
Tools>Options... dialog, under Parameters, in the Filtering Prefixes and Suffixes field.

l Attributes key should be empty or Color to bring in CAD Colors

l Material propertiesmust be checked to bring in thematerial assignment.

l TheMixed import resolution option is used to resolve parts with mixed dimension (typically
fromPro/E)

Refer to ANSYSWorkbench Help for details.
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Related Topics

ANSYS Electromagnetics CAD Integration ThroughWorkbench
CAD Integration andGeometry Sharing
Bi-Directional CAD Integration
CAD IntegrationModel Edits
Multiple Geometry Links for CAD Integration
CAD Integration Functionality
Healing with CAD Integration

ANSYS Electromagnetics to ANSYS Geometry Transfer
ANSYS Electromagnetics CAD Integration transfersmodel information based onWorkbench links.

The following figure shows how the information is transferred between simulators.

The information transferred includes:
l Geometry
l ANSYS Electromagnetics lists andmaterial assignment asNamed Selection
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l Material assignment

The CAD Integration geometry link is
l Dynamic because you can get updated geometry fromANSYS Electromagnetics
l Associative because IDs persist between ANSYS Electromagneticsmodel and ANSYS
model duringmodel refresh.
Boundary conditions in ANSYS are preserved.

Related Topics

User DefinedModel (UDM) for ANSYSWB Integration
UDM compared to User Defined Primitives
Insert UDMCommand on Draw Menu
UDMProperties
Library of Models for CAD Integration
CAD IntegrationMaterial Assignment Transfer
Geometry Transfer through ANSYS DesignModeler (DM)
CAD Integration Functionality

CAD Integration Material Assignment Transfer

Prerequisite for assignment transfer
l Engineering Data should havematerials used in ANSYS Electromagneticsmodel and
material names shouldmatch with case.

l Material Properties in GeometryOptionsmust be checked
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Prerequisite for transfer as named selection
l Named Selection in GeometryOptionsmust be checked

l Named Selection Key should either be empty or include ‘Material’

Related Topics

User DefinedModel (UDM) for ANSYSWB Integration
UDM compared to User Defined Primitives
Insert UDMCommand on Draw Menu
UDMProperties
Library of Models for CAD Integration
ANSYS to ANSYS ElectromagneticsGeometry Transfer
Geometry Transfer through ANSYS DesignModeler (DM)
CAD Integration Functionality

Geometry Transfer through ANSYS DesignModeler (DM)

It is possible to edit geometry in ANSYS DesignModeler (DM) before consuming inMechanical
l Useful when geometry needs preprocessing for ANSYS simulation
l Can take advantage of geometry commands available in DM

For example, consider an HFSSmodel linked to DM through theWorkbench.
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In this case, the figure below shows how a chamfer operation on geometries is imported.

It is possible to edit geometry in ANSYS DesignModeler (DM) before consuming inMechanical
l Useful when geometry needs preprocessing for ANSYS simulation
l Can take advantage of geometry commands available in DM

Related Topics

User DefinedModel (UDM) for ANSYSWB Integration
UDM compared to User Defined Primitives
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Insert UDMCommand on Draw Menu
UDMProperties
Library of Models for CAD Integration
ANSYS to ANSYS ElectromagneticsGeometry Transfer
CAD IntegrationMaterial Assignment Transfer
CAD Integration Functionality

Workbench Material Data Transfer
A link can now be created from an ANSYS Electromagnetics Desktop project (HFSS, Maxwell, etc.)
geometry cell to a downstreamEngineering Data (ED) cell. When the downstreamED cell is
refreshed, it will be updated with materials data (names and properties defined in the upstream
project) that are used by the upstream project. This ensures that the geometry-to-geometry link
connecting the same two systems, which specifies thematerial assignments for various parts, refers
to the correct materials and their properties.

Detailed Behavior
The geometry-to-ED link can be created, for example, by dragging the ANSYS Electromagnetics
Desktop project geometry cell to the ED cell of a downstream system.When the downstream
system's ED cell is refreshed, the upstream system generates aMatML formatted XML file which is
used byWorkbench to update the downstream system. This file is stored in the workbench project
files according to design point. Note thatWorkbench ED cell material names are case-sensitive, as
arematerial nameswithin the ANSYS Electromagnetics Desktop designs.
For thematerial assignments to work with the ED in the downstreammodel, the downstream
geometry cell must have theMaterial Properties checkbox selected/checked. A convenient way to
do this is to have this property checked by default, by setting it in Tools>Options>Geometry
Import. Designs created after this default option is set will haveMaterial Properties checked
automatically for the geometry cell.

ANSYSWorkbench Integration Overview 18-35
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

When the downstreammodel cell is refreshed or updated, thematerial properties from the ED in the
same system are used in themodel'smaterials, based on thematerial assignments set during the
geometry cell refresh. Note that if material assignment fails, theWorkbench default material
Structural Steel will be used.
Workbench resolves name conflicts by changing the name of anymaterials being transferred over
from the upstream system. For example, if the upstreamANSYS Electromagnetics Desktop design
uses amaterial named “Structural Steel”, this will conflict with the existing downstream default
material with the same name. The update will result in the ANSYS Electromagnetics Desktop
material being named “Structural Steel 2", which will silently break thematerial assignment, because
the resultingmodel will refer to "Structural Steel" as it originally did, and use the default workbench
property values, instead of using the properties which were supplied by ANSYS Electromagnetics
Desktop. If this occurs, rename thematerial in the ANSYS Electromagnetics Desktop project (in
such a way that there is nomore conflict), reset the downstreamED cell, reset the downstream
geometry cell, and then refresh those cells in the downstream system.
Note that somematerialsmay not satisfy all of the requirements for the downstream system physics.
For example, vacuum has no thermal conduction coefficient, but downstream steady state thermal
systems require a non-zero value for this property. Material properties in theWorkbench ED cell of
the downstream system can be edited/modified after the refresh to ensure that validity criteria can be
met. Any property added to amaterial in the downstreamED will be preserved in subsequent ED
cell updates. However, any existing property (i.e., a property that was given by the upstream system
material definition) that is edited in the downstreamED will be overwritten by a subsequent ED cell
update.

Related Topics

ANSYS Electromagnetics CAD Integration ThroughWorkbench
Bi-Directional CAD Integration
CAD IntegrationModel Edits
Multiple Geometry Links for CAD Integration
CAD Integration Functionality
Healing with CAD Integration
Important GeometryOptions for CAD Integration

User Defined Model (UDM)
A User DefinedModel (UDM) is collection of externally defined parts imported into an ANSYS
Electromagnetics 3D Modeler.

l UDM includes part attributes (like name, color etc) andmaterial assignment
l UDMcan also have external coordinate systems and corresponding planes
l UDMparts can be parameterized andmanipulated in ANSYS Electromagneticsmodeler just
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like any other part

UDM can either represent Static geometrymodels or
l Dynamic links tomodels of external geometry editors
l Used for supporting CAD integration inWorkBench
UDMuses same plugin technology asUser Defined Part (UDP)

Related Topics

UDMcompared to User Defined Primitives
Insert UDMCommand on Draw Menu
UDMProperties
Library of Models for CAD Integration
ANSYS to ANSYS ElectromagneticsGeometry Transfer
CAD IntegrationMaterial Assignment Transfer
Geometry Transfer through ANSYS DesignModeler (DM)
CAD Integration Functionality

UDM compared to User Defined Primitives

User DefinedModels (UDM) resemble User Defined Primitives (UDP):
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l ANSYS Electromagnetics products can be extended by users through new UDMs.
l UDMplugins are discovered by searching standard directory paths.
l Plugins for static UDM can build model using ‘callback interfaces’ (like create-box, create-
cylinder, subtract etc) similar to UDP.

l UDMs run inside ANSYS Electromagnetics application.
l UDMs provide geometry, topology, persistence and parameters.

In contrast to UDP:
l UDMprovidesmultiple Parts/CS/etc.
UDP provides primitive operation only for a single Part.

l UDMprovides part attributes andmaterial assignment.
UDP does not define part attributes or material.

UDMProperties have four tabs – Definitions, Parameters, Options and Info.
l Definition tab has:
UDMname
Coordinate system used to position UDM
May have external reference to file

l Info tab has:
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UDMdll name, dll location, version etc.
l Option tab:
may have options

Related Topics

User DefinedModel (UDM) for ANSYSWB Integration
Insert UDMCommand on Draw Menu
UDMProperties
Library of Models for CAD Integration
ANSYS to ANSYS ElectromagneticsGeometry Transfer
CAD IntegrationMaterial Assignment Transfer
Geometry Transfer through ANSYS DesignModeler (DM)
CAD Integration Functionality

Insert UDM Command on Draw Menu

To insert a UDM into a design, use the User DefinedModel command on the Draw menu for
theModeler window.

Related Topics

User DefinedModel (UDM) for ANSYSWB Integration
UDM compared to User Defined Primitives
UDMProperties
Library of Models for CAD Integration
ANSYS to ANSYS ElectromagneticsGeometry Transfer
CAD IntegrationMaterial Assignment Transfer
Geometry Transfer through ANSYS DesignModeler (DM)
CAD Integration Functionality
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UDM Properties

UDMProperties have four tabs – Definitions, Parameters, Options and Info.

Definition tab has
l UDMname
l Coordinate system used to position UDM
l May have external reference to file

Info tab has:
l UDMdll name, dll location, version etc

Option tab:
l may have options if any

UDMParameters
UDMPart Edits

Related Topics

User DefinedModel (UDM) for ANSYSWB Integration
UDM compared to User Defined Primitives
Insert UDMCommand on Draw Menu
Library of Models for CAD Integration
ANSYS to ANSYS ElectromagneticsGeometry Transfer
CAD IntegrationMaterial Assignment Transfer
Geometry Transfer through ANSYS DesignModeler (DM)
CAD Integration Functionality

UDM Parameters

UDMgeometry can bemanipulated through its parameters
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l Can bemapped to design or project variable for animation, parametric analysis
l IDs are persisted (allowing to retain boundaries) during parameter edit

UDMgeometry is not dynamically updated upon parameter edits
l UDMshows a lightning bolt icon by themodel namewhen parameters are edited.

l Youmust run theSend Parameters and Generate command to synchronize parameters
with geometry

Related Topics

UDMProperties
UDMPart Edits

UDM Part Edits

Several modeling operations are allowed on UDMparts
l Operationswill be part of history tree and retained duringmodel refresh

The following operations are not allowed
l Non history tree operations like healing, defeature.
l Operationswhich use UDMparts as tool, such as sweep or boolean (but allowed when clone
tool option is selected)

Following part attributes can bemodified for UDMparts
l Model/NonModel flag
l Solve Inside flag
l Part orientation

Related Topics

UDMProperties
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UDMParameters

Library of Models for CAD Integration

UDM technology allows library of models
l AnyANSYS Electromagneticsmodel can be exported as ‘Ansoft Geometry File’

l An Ansoft Geometry File can be imported back as a UDM.

l AnyDesign/project variables associated with model are brought in asUDMparameters.
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Geometry computation for UDM (and also UDP) can be specified in theModeler options as either
done on.

l Engine side (default):
Requires deployment of UDMon each node

l Desktop side:
UDMneed not be deployed on each engine
Desktop will be busy during parametric analysis

Related Topics

User DefinedModel (UDM) for ANSYSWB Integration
UDM compared to User Defined Primitives
Insert UDMCommand on Draw Menu
UDMProperties
ANSYS to ANSYS ElectromagneticsGeometry Transfer
CAD IntegrationMaterial Assignment Transfer
Geometry Transfer through ANSYS DesignModeler (DM)
CAD Integration Functionality
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Feedback Iterator

Background Information
Prior to the introduction of the Feedback Iterator, ANSYSWorkbench supported a two-way loose-
coupling protocol with ANSYS Electromagnetics products.

l SystemCoupling uses the word “coupling” to mean low-level solver coupling. Existing
ANSYS Electromagnetics coupling is “loose” when compared to SystemCoupling and is
limited to file transfers at the end of a complete solve in a stand-alone system/product. No
communication occurs during a solve.

l The coupling is two-way:
The one way portion (Upstream source component to Downstream target component) is
handled via existingWorkbench data/transfer connectionmechanism.

The round trip is handled by a separate protocol agreed upon by the participating systems
when the downstream system exports a set of file to a location specified by the upstream
system (via its one way transfer). This exported data is then incorporated by the upstream
system in its next update.
If the user chooses to run the next coupled solve iteration, the user invokes the Enable Update
command as shown below and then updates all systems involved. These steps (Enable
Update, Update Project) are continued as long as needed
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The Feedback Iterator system automates this process as detailed in the following related topics:
The Feedback Iterator System
Feedback Iterator in Use
Feedback Iterator Component Properties
Feedback Iterator GUI Operations
Callback Interface
Example Scenarios for Feedback Iterator

The Feedback Iterator System

ANSYS Electromagnetics Suite provides the Feedback Iterator system for automating themanual
steps needed for driving a feedback utilizing system-pair to convergence. In addition to automating
feedback incorporation over a user-specified number of iterations, the Feedback Iterator also allows
you to control the number of iterations (decide iteration termination criteria) and set target
temperature and displacement convergence criteria.
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The Feedback Iterator appears in theWorkbench Toolbox user interface under Component
Systems.

If you drag and drop an instance of the Feedback Iterator intoWorkbench Schematic, the default
system name is Feedback Iterator.

Feedback Iterator in Use

You attach the Feedback Iterator system to theWorkbench schematic like any other system. For
example, given aMaxwell system providing AnsoftHeatLossData to a Thermal system, if you drop
theMaxwell setup cell onto the Feedback Iterator component, the following links result

ANSYSWorkbench Integration Overview 18-46
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

While the examples deal with Maxwell and Steady-State Thermal. the Feedback Iterator add-in
functions the samewaywith Maxwell or HFSS as sources and Fluent or Structural as targets –
essentially all systems that participate in Electromagnetics two-way loose coupling.

Feedback Iterator Component Properties

The Feedback Iterator's primary role is to control iterative solves and its properties support this end.
For Maxwell and HFSS, the Feedback Iterator properties are as shown below:
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l Iterations Completed: displays the number of iterations completed. A “read-only” property.
l Max Iterations: sets themaximumnumber of iterative solve loops to perform before
terminating iterations in case the Target Delta Temperature % or Target Delta
Displacement % is not achieved. Default value is 100.

l Target Delta Temperature %: specifies themaximum Target Delta Temperature % which
signifies convergence. Default value is 5%. Valuemust be 0.01 or greater.
Note l The delta temperature error is calculated base on the SI unit: Kelvin.

l TheMaxwell and HFSS design Profile tabs display absolute/relative delta
data, while the delta temperate inWorkbenchmeans the relative delta
(expressed as%).

l Target Delta Displacement %: specifies themaximum Target Delta Displacement %
which signifies convergence. Default value is 5%. Valuemust be 0.01 or greater.

The Feedback Iterator properties also display themost recently achieved Latest Delta
Temperature % and Latest Delta Displacement % values, allowing the user to manually abort
when suitably satisfied with the achieved deltas.

Note Both the Temperature and Displacement Convergence properties sections are always
shown irrespective of which feedback types are actually enabled for the project.

When we run a two-way feedback simulation fromWB, and keep theMaxwell or HFSS Profile tab
open (right-click on Results in the Project Manager and select Solution Data, then select Profile tab),
you will see that the 3D solver keeps track of two feedback related quantities:
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l MaximumAbsolute/Relative Delta Temperature (if temperature feedback is enabled)
Note The delta temperature error is calculated base on the SI unit:

Kelvin.

l MaximumAbsolute/Relative Delta Displacement (if displacement feedback is enabled)

These signify themaximumdifference on the solutionmesh of the quantity in question from one
feedback iteration to the next (thus the value is only available from iteration #2 onward). This data is
the basis for the convergence controls in the Feedback Iterator. These controls allow the user to
base the termination of the feedback iterations based on a target max delta T and/or max delta
displacement. Thus the target max delta forms the convergence condition.

Feedback Iterator GUI Operations

When you project is ready to run, right-clicking on the Feedback Iterator component and selecting
Single Iteration Update allows you to run a single iteration worth of updates. A Single Iteration
Update operates as follows:

l The Electromagnetics product system (Maxwell, etc.) is updated, which will incorporate any
previous feedback from the downstream system.

l The downstream system (Fluent, Thermal, etc.) is updated.
l All coupled systems: Electromagnetics product, Electromagnetics product Downstream and
the Feedback Iterator will then be in the UpToDate state.

l The Feedback Iterator's Iterations Completed property will increment by 1.
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Right-clicking on the Feedback Iterator component and selectingUpdate allows you to run iterations
automatically. Iterations continue to run either until convergence criteria aremet, or until theMax
Iterations value is reached.

Callback Interface

The callback interface allows you to react to each step of the iteration process as implemented by the
Feedback Iterator component. This is useful for you to implement special iterations or even solve
transient simulations (with a limited scope). To this end, there are four main API features provided:

l Callback functionswhich the Feedback Iterator calls at various points in each iteration
l Utility functions that the Callback functions can use to extract properties of the containers
being processed

l Output functions that allow you to debug the script or supply additional messages
l Limited statemanagement allowing the script to store and retrieve state across callback
functions and iterations

Related Topics

Callback and State API

Callback and State API

State is managed somewhat simply but in a limited fashion. All the API methods take a final
dictionary argument. This dictionary is limited to using string keys and number or string values.
Within this limitation, simply add new keys, read old keys, clear the dictionary, etc., and it will be
persisted across functions calls and even acrossUpdates. When the Iterations Completed
property is rest, the dictionary is also cleared out.
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It is advisable for the callback script to initialize the dictionary at Iteration 1.

All the API methods use a subset of the following arguments:

iterationNumber An integer representing the current iteration. This always starts from 1.
ContainerList A python list of containers (DataContainerReference). This is the entire list of the

coupled containersmanaged by the Feedback Iterator. You typically loop
through them and using the utilitymethods listed below, identities them.

Container A single container that is being processed. This is a DataContainerReference
State A read/write python dictionary that is used tomaintain state across function calls

and iterations.

Only return values fromBeforeIterationEx are processed. Returns from all other functions are
discarded.

1. BeforeIteration(IterationNumber, ContainerList, State): Thismethod is called before each
iteration. Ideally used to initialize the state dictionary, open editors as required, or initialize
setups as needed for each iteration.

2. BeforeIterationEx(IterationNumber, ContainerList, State): Similar to the BeforeIteration
method except that this allows you to control the number of iterations via the return value.
l Return: “more” to request onemore iteration
l Return “last” to indicate that this is the last iteration
l Any other return (including none) will be treated as a return of “last” and terminate
iterations.

3. AfterIteration(IterationNumber, ContainerList, State): Thismethod is called after each
iteration. This can be used to copy result files over, check results, implement any possible
convergence calculations, logging of results, etc.

4. BeforeContainerRefresh(IterationNumber, Container, ContainerList, State): Is called before
each of the coupled containers is refreshed. The “Container” argument represents the
container about to be refreshed.

5. AfterContainerRefresh(IterationNumber, Container, ContainerList, State): Is called after
each of the coupled containers is refreshed. The “Container” argument represents the
container just refreshed.

6. BeforeContainerUpdate(IterationNumber, Container, ContainerList, State): Is called before
each of the coupled containers is Update (after a refresh). The “Container” argument
represents the container about to be updated.

7. AfterContainerUpdate(IterationNumber, Container, ContainerList, State): Is called after each
of the coupled containers is updated. The “Container” argument represents the container just
updated.

If the callback scripts uses other files to send commands to various containers (vb, js, apdl, python,
etc.), all of those files are best saved under the user_files directory. This allows you to use the
FBGetUserFilePath(str) to get the absolute path of the file and allows the files to be packaged with
any created archive.
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Utility Functions

FBSystemForContainer
(container)

system Given a container, returns the system it belongs to.

FBSystemDisplayName
(system)

string Given a system, returns its display name on the schematic.

FBSystemID(system) string Given a system, returns its ID. This is the same as the
UniqueDIrectory for the system.

FBGetUserFilesPath
(relativePath)

Given a relative path located under the user_files directory, say
"hello.py", this returns the absolute path of the file.

Output/Debugging Functions

FBAddInfoMessage(string) Adds an infomessage to theWBmessage window.
FBAddWarningMessage
(string)

Adds a warningmessage to theWBmessage window.

FBAddErrorMessage(string) Adds an error message to theWBmessage window.
FBMessageBox(string) Pops up a dialog with the supplied string with an “OK”

button.

Example Scenarios for Feedback Iterator

This section describes several scenarios for using the Feedback Iterator.
Set up Iteration with Feedback Iterator
User Breaks Iteration Control
Start an Iterative Update
Run a Single Iteration
Interrupt an Iterative Loop
Resume an Interrupted Iterative Loop
Modify any of the Systems Involved in Iteration (coupled clients)
Iterating to Convergence

Set up Iteration with Feedback Iterator

Scenario Steps to execute Outcome
Electromagnetics
product solution

l Drop Feedback
Iterator system on

Electromagnetics product Setup component is
connected to the Iterator.
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Scenario Steps to execute Outcome
provides solution
data to a single
downstream
setup

the Setup
component of the
Electromagnetics
product

OR
l Create Feedback
iterator system and
connect
Electromagnetics
product setup
component to the
Feedback Iterator
component

AND
User clicks on the Iterator
component and sets the
desired Feedback Iterator
properties.

Electromagnetics product solution and
downstreamSetup and Solution components are
coupled as clients to the iterator. The iterator
component is the coupledmaster and the rest are
coupled clients. Any coupling changes schematic
visuals:

l Coupled cells including couplingmaster are
colored differently from normal cells.

l Coupled cell icons change to reflect the icon
of the couplingmaster.

l Coupled client cells no longer display the
Update context menu item and cannot be
updated via script commands either.

l The cell states of all coupled cells (master and
clients) are synchronized to be themost
pessimistic state among any of them. e.g.,
after an update, anymodification will set all of
them to the “Modified” state.

Electromagnetics
product Solution
provided to
multiple
downstream
setup cells

same as above All the downstream components (Setup and
Solution in each downstream system) are coupled
as clients.
The update order in this case depends on any
additional data-flow connections between the
systems that consume the upstream
Electromagnetics product solution data.

Electromagnetics
product Solution
cell does not
have any
downstream
targets

same as above No changes occur beyond what is expected when
you create a new connection (no coupling).
Coupling only occurs when Electromagnetics
product Solution cell has a downstream
connection. If a downstream connection is added
after the link to the iterator, coupling will be
performed as described in the first row.

User Breaks Iteration Control

Scenario Steps to execute Outcome
Iterator coupled to Electromagnetics
product solution cell and downstream
setup/solution cells

l Break
Electromagnetics
product Solution

In addition to what is
normally expected from the
user actions, all coupled
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Scenario Steps to execute Outcome
cell's provides
link

-or-
l Break
Electromagnetics
product Setup
link to Feedback
Iterator

-or-
l Delete
Electromagnetics
product Solution
consumer
system

-or-
l Delete Feedback
Iterator system

clients are de-coupled (their
icons and colors on UI are
restored).

Electromagnetics product Setup cell is
connected to the Feedback Iterator but the
Electromagnetics product solution does not
provide anything. No components are
coupled to the Feedback Iterator

l Break
Electromagnetics
product Setup
link to Feedback
Iterator

l Delete Feedback
Iterator system

No coupling exists in this
scenario so nothing visible
changes beyond what is
expected from the user
actions.

Start an Iterative Update

Scenario Steps to execute Outcome
Standard
update
scenario

l Right-click
on
Feedback
Iterator
component
and select
Update
operation

-or-
l Update
Project

-or-

For each iteration, the Electromagnetics product solution is updated
followed by the downstream setup and the downstream solution.
Each of the client component updates display their progressmonitor
and can be aborted (resulting in aborting the current iteration).
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Scenario Steps to execute Outcome
l Update all
design
points

-or-
l DX Update

Run a Single Iteration

Scenario Steps to execute Outcome
NumCompleted
< NumIterations

Right-click on Feedback Iterator
component and select Single Iteration
Update

One iteration is run. “Iterations
Completed” property is
incremented.

NumCompleted
>=
NumIterations

same as above same as above
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Interrupt an Iterative Loop

Currently, there is no special progress or interruption control. The progressmonitor of the individual
components is displayed as they are updated, and any control they choose to provide (interrupt,
abort or both) are available. If the user chooses to abort any of the client component updates, the
current iteration is aborted and the Completed Iterations property remains unchanged from the
previous iteration.

Resume an Interrupted Iterative Loop

Scenario Steps to execute Outcome
Single
step

Right-click on Feedback Iterator
component and select Single
Iteration Update

One iteration is always run and the “Iterations
Completed” property is incremented.

Run until
completion

l Right-click on iterator
component and select
Update

or-
l Select the Project Update
menu option from the
toolbar etc.

If the user specified number of operations are
already completed, nothing is done. Otherwise, the
remaining iterations are run.

Modify any of the Systems Involved in Iteration (coupled clients)

When the user modified any of the coupled client components either inWorkbench by changing
some non-extrinsic property, design point etc or in an external editor, the coupled clients andmaster
will bemarked asmodified. Additionally, the Completed Iterations property will be set to 0.

Iterating to Convergence

Scenario Steps to execute Outcome
Standard
update
scenario

l Right-click
on the
Feedback
Iterator
component
and select
Update

-or-

For each iteration, the Electromagnetics product solution is updated
followed by the downstream setup and the downstream solution.
Each of the client component updates display their progressmonitor
and can be aborted (resulting in aborting the current iteration).
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Scenario Steps to execute Outcome
l Update
Project

-or-
l Update all
design
points

-or-
l DX Update

The following temperature convergence example uses a Feedback Iterator with aMaxwell design
coupled with a Steady-State Thermal component. Iterating to convergence operates similarly for
HFSS projects.

The example uses defaults of 5% for the convergence targets and a value of 100max iterations.
Recall that themax iterations value is set as a “safety” measure to ensure that iterations do not
continue indefinitely if the solution does not converge. Aswe progress through the iterations, we
observe the following:
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End of Iteration #1
The first iteration, since it has no previous iteration, cannot return ameaningful delta value.

At the end of this iteration, the Latest Delta value will still be listed asNot Available.

Convergence Achieved
In this example, convergence has been achieved by the third iteration.
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When the convergence criteria aremet, the simulation stops. If you attempt to do an update after
convergence has been achieved, the simulation will not be launched since the current solutions
satisfy the convergence criteria.
You can alsomonitor the iteration progress by opening theMaxwell editor and from the Results
menu, select the Solution data dialog. Choose the Profile tab and keep the dialog open. As you solve
each iteration, you can observe the reported Delta-T (with thermal feedback) and/or delta-
displacement (with displacement feedback) and abort the iterations (or stop single iteration updates)
when the values reach acceptable convergence levels.
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19 - Exporting Equivalent Circuit Data
You can export lumped R, L, C data from aMaxwell solution to ANSYS SIMPLORER or Saber
format. Importing the new data file to SIMPLORER or Saber enables you to include wave effects in
the circuit simulations.
An equivalent circuit can be exported from a parametric solution or from an imported table.

Note You can only export an equivalent circuit from a parametric solution when the following two
criteria aremet:

l The solution type isMagnetostatic or Electrostatic.
l A parametric setup exists.

Exporting a Circuit From a Parametric Solution
To create a circuit from parametric solutions, you first need to set up and solve a problem that
contains a parametric sweep. Any force, torque, andmatrix solutions are automatically available to
use in the equivalent circuit. Other solutions can be treated as extra inputs/outputs if they have been
added as calculations in the parametric setup— that is, extra inputs/outputs come from the
parametric table.

Note In Maxwell, global variable names begin with the $ character. However, when you are
creating an ECE .smlmodel, this character causes the circuit to fail when importing it to
SIMPLORER. To resolve this, when the circuit is exported, the $ character is replaced by
the _ character. For example, the project variable $MyVar is converted to _MyVar.

To export a circuit from a parametric solution:
1. ClickMaxwell3D>Export Equivalent Circuit>From Parametric Solutions or

Maxwell2D>Export Equivalent Circuit>From Parametric Solutions.
TheGeneralwindow appears, allowing you to specify basic information about the circuit
model.

Note This command is enabled only when the following two criteria are
met:

l The solution type isMagnetostatic or Electrostatic.
l A parametric setup exists.

2. Select one of the following from theModel Type pull-down list depending upon the Design
Type(2D or 3D):
l Linear Motion
l Rotational Motion
l Transformer
l Matrix
l Lookup Table

3. Select aParametric Setup from the pull-down list.
4. Select aSolution Setup from the pull-down list.

Maxwell Online Help
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5. Select aMatrix Setup from the pull-down list.
6. Select a Force Setup or a Torque Setup from the pull-down list, depending on which

parameter you have set up for your design.
7. For the force or torque setup, selectX, Y, or Z as the Component.
8. Select eitherAmpere-Turns orAmperes as theCurrent Source Variables option.
9. ClickNext.

The Tablewindow appears, allowing you to set up the inputs and outputs for the circuit
equivalent. Most of the values have been automatically filled in, based on your design. You
can keep the defaults or change the selections and values for the various parameters.

10. To apply deep spline interpolation to all inputs in the circuit PWLmodel, select theUse Bezier
Interpolation check box.

11. To export the data to a table that you can edit and use to export an equivalent circuit at a later
time, do the following:
a. ClickExport Table.

TheSave As dialog box appears.

b. Select a location, and type a name in the File name box.
c. ClickSave.

The Tablewindow reappears. The file that is created contains header rowswith information
such as name, i/o, and type, plus all of the actual data. Youmay export the table to view or use
in external programs. You can alsomodify the exported table file and then re-import it to
create an equivalent circuit. On import, the information in the header rows is used as default
settings in the circuit export dialog box.

Note The Tablewindow is the last step for the Lookup Tablemodel type. For all other model
types, there is onemore step: the Terminalswindow.

12. For model typesLinear Motion,Rotational Motion, Transformer andMatrix, clickNext.
The Terminalswindow appears, allowing you to set up terminals, which are nodeswith
"through" and "across" data. Most of the values have been automatically filled in, based on
your design. You can keep the defaults or change the selections and values for the various
parameters.
1. Enter aScaling Factor in the text box. The scaling factor is applied to all output quantities

and can be used, for example, to scale data from partial models that take advantage of
symmetry.

2. Optionally, specify theModel depth for 2D XYmodels for scaling.
3. Optionally for 2D XY Rotational Motionmodel type, specify theSkew angle.

When a stator core or rotor core is skewed for a 2D Rotational Motionmodel, the flux

linkages and torque of the look-up table will bemodified based on the skew angle .

For any output of the look-up table, , where is rotor position, themodified output will
be:
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4. Specify the Terminals:
l To specify a coil terminal:
a. Select aSource for the Flux orCharge, depending on whether your design is

mechanical or electrical.
b. Enter aResistance.
c. Enter the number of Turns in the coil winding.
d. Enter the number ofBranches.

l To specify amechanical terminal:
a. Select the Force or Torque variable from the pull-down list.
b. Select thePosition variable from the pull-down list.
c. Optionally for Rotational Motionmodel type, selectUse rotational velocity.

5. ClickFinish to export the equivalent circuit.

Types of Equivalent Circuit Models

Currently, you can generate the followingmodel types:
l Linear Motion - Models inductance (or capacitance) and force as functions of current (or
voltage) and position. The parametric solution should cover the range of motion and
conductor current (or voltage).

l Rotational Motion - Models using rotational rotor position sweep.
l Transformer - For one coil only, models nonlinear mutual (magnetizing) inductance with a
linear leakage inductance branch. Therefore, thismodel is only valid for 1-phase
transformers. The parametric solution should cover the range of current for one coil only in
an open-circuit test. Nonlinear mutual inductances for 3-phase (or more) transformers are
better solved using the transient solver.

l Matrix - Models an inductance or capacitancematrix for one or more conductors, as a
function of current or voltage. The parametric solution should cover the range of each
conductor’s current or voltage.

l Lookup Table - This option creates a lookup tablemodel in either Simplorer or Saber
formats.

Exporting a Circuit From an Imported Table
To create a circuit from an imported table, you need to have a table file containing tabular data. The
first row in the file must contain the column names. The table export feature writes other useful
information into subsequent rows, but the import succeedswhether or not this information is present.
The rows of tabular data come next.
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Note In Maxwell, global variable names begin with the $ character. However, when you are
creating an ECE .smlmodel, this character causes the circuit to fail when importing it to
SIMPLORER. To resolve this, when the circuit is exported, the $ character is replaced by
the _ character. For example, the project variable $MyVar is converted to _MyVar.

To export a circuit from an imported table:
1. ClickMaxwell3D>Export Equivalent Circuit>From Imported Table or

Maxwell2D>Export Equivalent Circuit>From Imported Table.
The Select File dialog box appears.

2. Find and select the file containing the table you want to use.
3. ClickOpen.

TheGeneralwindow appears, allowing you to specify basic information about the circuit
model.

4. Select one of the following from theModel Type pull-down list:
l Linear Motion
l Rotational Motion
l Matrix
l Lookup Table

5. Select eitherAmpere-Turns orAmperes as theCurrent Source Variables option.
6. ClickNext.

The Tablewindow appears, allowing you to set up the inputs and outputs for the circuit
equivalent. Most of the values have been automatically filled in, based on your design. You
can keep the defaults or change the selections and values for the various parameters.

7. To apply deep spline interpolation to all inputs in the circuit PWLmodel, select theUse Bezier
Interpolation check box.

8. To export the data to a table that you can edit and use to export an equivalent circuit at a later
time, do the following:
a. ClickExport Table.

TheSave As dialog box appears.
b. Select a location, and type a name in the File name box.
c. ClickSave.

The Tablewindow reappears. The file that is created contains header rowswith
information such as name, i/o, and type, plus all of the actual data. Youmay export the
table to view or use in external programs. You can alsomodify the exported table file and
then re-import it to create an equivalent circuit. On import, the information in the header
rows is used as default settings in the circuit export dialog box.

Note The Tablewindow is the last step for the Lookup Tablemodel type. For all other model
types, there is onemore step: the Terminalswindow.

9. For model typesLinear Motion,Rotational Motion, andMatrix, clickNext.
The Terminalswindow appears, allowing you to set up terminals, which are nodeswith
“through” and “across” data. Most of the values have been automatically filled in, based on
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your design. You can keep the defaults or change the selections and values for the various
parameters.
1. Enter aScaling Factor in the text box. The scaling factor is applied to all output quantities

and can be used, for example, to scale data from partial models that take advantage of
symmetry.

2. Optionally, specify theModel depth for 2D XYmodels for scaling.
3. Optionally for 2D XY Rotational Motionmodel type, specify theSkew angle.

When a stator core or rotor core is skewed for a 2D Rotational Motionmodel, the flux

linkages and torque of the look-up table will bemodified based on the skew angle .

For any output of the look-up table, , where is rotor position, themodified output will
be:

4. Specify the Terminals:
l To specify a coil terminal:
a. Select aSource for the Flux orCharge, depending on whether your design is

mechanical or electrical.
b. Enter aResistance.
c. Enter the number of Turns in the coil winding.
d. Enter the number ofBranches.

l To specify amechanical terminal:
a. Select the Force (or Torque) variable from the pull-down list.
b. Select thePosition variable from the pull-down list.
c. Optionally for Rotational Motionmodel type, selectUse rotational velocity.

5. ClickFinish to export the equivalent circuit.

Setting Up Current Variables
For problemswith current, theCurrent Variables Represent setting allows you to specify one of
the following two options:

l Ampere-Turns
l Amperes

This setting provides flexibility in setting up current sourceswith different numbers of turns and
branches.
In Maxwell, current source values are specified in Ampere-turns, meaning that if a given source is
driven with 2 Amps through 100 turns, then the source valuemust be set to 200. Inductance is
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calculated per-turn; therefore, to calculate EMF, the fluxmust be scaled by the number of turns to
give the total flux.
You can create two kinds of circuit models:

l Amodel format where the data table is based on current in Amp-turns and flux per turn. This
model internally converts currents and fluxes using the specified turn ratio. Thismodel format
was the only one available in versions of Maxwell beforeMaxwell 11.

l Amodel format where the data table is based on current in Amps and total flux. Thismodel
does no internal scaling of values, since the data is already in a form the outside circuit
expects. Thismodel format is available in Maxwell 11 and later versions.

For either model type, you can view the inductance setup to obtain information about the specified
groups, turns, and branches.

Current Variables Represent Ampere-Turns

How to use this format:
l Apply variables directly to sources.Source1 value = Current1.
l Sweep variable values in Ampere-turns.Current1 sweeps from 100 to 200.
l In an inductance setup, specify the number of turns consistent with the source setup. Make
sure all sources in a group have the same number of turns.

When to use this format:
l If all sources in a group have the same number of turns.
l If you want to be able tomodify the number of turns in the exported circuit.
l If you aremore comfortable thinking of variables in Ampere-turns.

When using this format, the grouping is taken from the inductance setup. The number of turns and
branches per group from the inductance setup are used as a default but can bemodified either
before exporting the circuit or in the exported circuit.

Current Variables Represent Amperes

How to use this format:
l Define sources as the current variable times turns.Source1 value = 100*Current1.
l Sweep variable values in Amperes.Current1 sweeps from 1 to 2.
l In an inductance setup, specify the number of turns consistent with the source setup.

When to use this format:
l In caseswhere one current is applied through sourceswith different numbers of turns.
l If you doNOT need tomodify the number of turns in the exported circuit.
l If you aremore comfortable thinking of variables in Amperes.

When using this format, the groups, turns, and branches are taken from the inductance setup and
are used as is. You will not be able tomodify them during circuit export or in the exported circuit.
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Setting Inputs and Outputs in the Table Window
The table includes rows for all of the following that are appropriate to themodel type:

l Swept variables from the parametric setup.
l Components of flux or charge from the selectedmatrix.
l Force or torque.
l Calculations from the parametric setup.

Where possible, the columns are set with reasonable defaults based on the information from the
design. In many cases, you should not have to change anything.
Additional information about the columns:

l Under I/O, the choices are Input,Output, orUnused.Unusedmeans that the quantity will
not be included in the circuit.

l Under Type, the choices arePosition,Rotation,Current, Voltage, Flux,Charge, Force,
Torque, andOther. These choices affect the terminal setup in the next window.Other is
typically used for extra inputs/outputs.

l Under Extrapolate, the choices are all standard extrapolations plusNone. For inputs, the
Extrapolate column is automatically set toNone and is disabled.

Linear This option takes the last two points of the data and generates a straight line
extending beyond the range of the parametric sweep.

Periodic repeat the data outside the range of the parametric sweep.

HalfPeriod mirror then repeat the waveform outside the range of parameter sweep.
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Constant extrapolate a constant value from the last point in the interpolation.

Even repeat the wave outside the range of parametric sweep.

Odd repeat a reflection of the waveform outside the range of the parametric sweep.
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Setting Coil and Mechanical Terminals
There are currently two types of terminals:

l Coil Terminals
l Mechanical Terminals

For models with motion, themechanical terminal setup determineswhich force (or torque) causes
themotion and which position (or rotation) is affected.
When setting up coil terminals, flux and current are used for magneticmodels, and charge and
voltage are used for electricmodels.
In the coil terminal setup, there is one row for each flux (or charge) group. In theCurrent (or
Voltage) column, each cell is a selection boxwhere you can choose the current (or voltage) that
applies to that flux (or charge) group. Usually the software can choose the correct current by default,
based on the source setup in the design. TheResistance column is set to 0 by default; you can enter
any value here. The Turns andBranches columns only appear for magneticmodels where current
variables represent Ampere-turns. These columns are initialized with the turns and branches
specified in the inductancematrix setup.
In theCurrent column, in addition to each current, there is another choice, <Dependent>. This
feature allows you to solve some problems using fewer parametric rows. This is explained using the
following example:

Suppose you are working on a three phasemachine. You create three sources, CurrentA,
CurrentB, and CurrentC. In previous versions of Maxwell (before version 11), you would have
to create three current variables, iA, iB, and iC, and sweep all three of these variables— even
though for this type of machine iC is always equal to -(iA + iB). Thismeans that if you want to
sweep through 10 values of current, the parametric table would have 1000 rows. In Maxwell
11 and beyond, you can create only variables iA and iB and then set the value of CurrentC to
-(iA + iB). The parametric table will have 10 values each for iA and iB, so it will only have 100
rows.When exporting the circuit, you would set the current for Flux[CurrentA] to iA, Flux
[CurrentB] to iB, and Flux[CurrentC] to <Dependent>. In the circuit model, the PWL table will
contain two input currents (iA and iB), but it will contain all three fluxes. So it will look up all

Exporting Equivalent Circuit Data 19-9
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

three flux values based on only the two current values. As long as you always connect a
current of -(iA + iB) to CurrentC, thismodel will be valid.

Note A dependent source can have a different number of turns from the sources that it depends
on (in the example above, CurrentA, CurrentB, and CurrentC can all have different
numbers of turns). But, in this case, you would have set up the current variables as
Amperes instead of Ampere-turns— otherwise there would be no way to obtain the
correct scaling of currents iA and iB for both their own current sources and for CurrentC.
Therefore, this is another case where specifying current variables in Amperes (rather than
in Ampere-turns) is useful.
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20 - Scripting in Maxwell
Maxwell uses theMicrosoft® Visual Basic® Scripting Edition (VBScript) scripting language to record
macros. VBScript is based on theMicrosoft Visual Basic programming language.
Using scripts is a fast, effective way to accomplish tasks you want to repeat.
You can write a script using any text editor, or you can record a script fromwithin theMaxwell
interface. After recording the script fromwithin Maxwell, you can thenmodify it using a text editor.
For information on how to create, edit, and use scripts in Maxwell, see the Scripting online help,
which you can access fromMaxwell via the followingmenu options:

l Help >Maxwell Scripting Help
l Help >Maxwell PDFs >Maxwell Scripting

Recording a Script
You can choose either to record a script to a file, or to record a script to the Project. Once you start to
record a script, your subsequent actions are added to the script. Each interface command has one or
more associated script commands that are recorded to the script.
To record a script to the project:

1. ClickTools>Record Script to Project to open theSave Script to Project dialog box.
2. In theSave Script to Project dialog box, type the name of the script and clickOK.
3. Perform the steps that you want to record.
4. When you have finished recording the script, clickTools>Stop Script Recording. The script

is recorded to a text file in .vbs (VBScript) file format and placed in the Project Manager
Definitions>Scripts folder.

To record a script to a file:
1. ClickTools>Record Script to File.

TheSave As dialog box appears.
2. Use the file browser to locate and select the folder in which you want to save the script.
3. Type the name of the script in the File name text box and choose the file type (IronPython

Script .py, or Visual Basic Script .vbs), and then clickSave to save script in the folder you
selected and begin recording.

4. Perform the steps that you want to record.
5. When you have finished recording the script, clickTools>Stop Script Recording.

Editing a Script
You can edit a script that was saved to a file, or edit a script that was saved to the project.
To edit a script that was saved to the project:
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1. In the Project Manager Definitions>Scripts folder, right-click on the script you want to run to
open the context menu.

2. SelectEdit Script to open the script in the text editor.
3. When finished editing, selectScript> Save Script.

To edit a script that was saved to a file:
1. Open the script file in any text editor.
2. When finished editing, save the script.

Stopping Script Recording
To stop recording a script:

l ClickTools>Stop Script Recording.
Maxwell stops recording to the script.

Running a Script
To run a script from the Project Manager:

1. In the Project Manager Definitions>Scripts folder, right-click on the script you want to run to
open the context menu.

2. SelectRun Script.
To run a script fromMaxwell:

1. ClickTools>Run Script.
TheOpen dialog box appears.

2. Use the file browser to locate the folder in which you saved the script, and then double-click
the folder's name.

3. Type the name of the script in the File name text box, or click its name, and then clickOpen.
Maxwell executes the script.
Note To supply script arguments when running from Tools>Run Script, use the edit field

at the bottom of the file selection dialog. You can access the script arguments using
the AnsoftScriptHost.arguments collection from vbscript. This is a standard COM
collection.

To run a script form a command line:
1. Type one of the following command line options at the command line:

-runscriptandexit or -runscript

2. PressEnter.
You can also pass the -scriptargs parameter to the script and specify arguments.

Note If you run the script fromDOS prompt as a .vbs file (that is, you do not launchMaxwell, but
simply launch vbs directly, or use wscript.exe or cscript.exe), the arguments will be in the
WSH.arguments collection, not the AnsoftScriptHost.arguments collection. To handle this,
write the following:
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on error resume next
dim args
Set args = AnsoftScript.arguments
if(IsEmpty(args)) then
Set args = WSH.arguments
End if
on error goto 0
'At this point, args has the arguments no matter if you are
running
'under windows script host or Ansoft script host
msgbox "Count is " & args.Count
for i = 0 to args.Count - 1
msgbox args(i)
next

Pausing and Resuming a Script
To pause a script during its execution:

l ClickTools>Pause Script.
To resume a script after pausing it:

l ClickTools>Resume Script.

Stopping a Script
To stop a script:

l ClickTools>Stop Script.
Maxwell stops executing the script that has been paused.
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21 - Running Simulations
After you specify how Maxwell is to compute the solution, you need to begin the solution process. In
general, theAnalyze command applies to the selected setup and associated sweeps, if any, or to a
select sweep. To use this command, right-click on a setup or sweep in the Project tree, and click the
command on the context menu. TheAnalyze All command applies to all enabled setups at or below
the level invoked in the Project tree. To use this command, either clickMaxwell 2D or Maxwell
3D>Analyze All or right-click on the Analysis icon in the Project tree and selectAnalyze All from
the popupmenu.
What do you want to do?

l Solve a single setup with or without sweeps
l Solve a specific sweep
l Enable a queue so that multiple simulations can run sequentially as resources become
available.

l Runmore than one simulation, whether multiple setups, or multiple sweeps under a single
setup, or setupswith dependencies.

l Monitor queued simulations
l Configure and run remote analysis
l Configure and run distributed analysis
l RSM Integration with JobManagement UI
l Large Scale DSO for Parametric Analysis
l High Performance Computing (HPC) Integration
l Interactive Scheduler Jobs
l Monitor the solution process
l Change a solution priority for system resources
l Abort an analysis
l Re-solve after modifying a design
l Re-solve after ANSYSWorkbench Feedback

Related Topics

Running anOptimetrics Analysis
High Performance Computing (HPC) Integration
RunningMaxwell from aCommand Line
Technical Notes: The Solution Process
Solving a Single Setup
RunningMore ThanOne Simulation
Specifying Analysis Options
Remote Analysis
Monitoring the Solution Process
Aborting Analysis
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Running an RMxprt Simulation

Solving a Single Setup
To solve a single setup or sweep:

1. In the project tree, under the design you want to solve, select a solution setup.
2. Right-click and selectAnalyze from the shortcut menu.

Maxwell computes the 3D field solution inside the structure for a solution, and for a select
sweep, does so for the sweep variables.

To runmore than one analysis at a time, follow the same procedure while a simulation is running. If
you have enabled queuing, the next solution setup will be solved when the previous solution is
complete.

Note If a linked dependency in the setup is already simulating (for example, due to setup links to
the same external source for a near or far field wave, or amagnetic bias), Maxwell will not
allow another dependent simulation to start until the first use of the source has completed.

Related Topics

Running anOptimetrics Analysis

Running More Than One Simulation
To solve every enabled solution setup in a design:

1. In the project tree, under the design you want to solve, selectAnalysis.
2. ClickMaxwell3D>Analyze All orMaxwell2D>Analyze All.

Each enabled solution setup is solved in the order it appears in the project tree.

Note TheGeneral tab for the Setup includes anEnabled check box. By default, this is checked.
Unchecking theEnabled check box excludes a setup from running

Note You can also simulate all designs in a project by clickingProject>Analyze
All.

To solve two or more sweeps or two or more parametric analyses under a setup:
1. In the project tree, under the design you want to solve, right-click the setup icon that includes

the setups or sweeps of interest.
2. ClickAnalyze on the shortcut menu.

Each solution sweep under that setup is solved in the order it appears in the project tree, using
the availablemachines.

Related Topics

Technical Notes: Handling ComplicatedModels
Solving a Single Setup
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Specifying Analysis Options
Remote Analysis
Monitoring the Solution Process
Aborting Analyses
Running anOptimetrics Analysis

Monitoring Queued Simulations
If you havemultiple setups for a design, and have selectedAnalyze All, the simulations can be
queued until there is amachine available. You enable queuing in the HPC and Analysis Options:
Options tab. If queuing is enabled and you runmultiple setups, they are solved in the order that they
appear in the project tree. You can prioritize setups by changing the order in the queue.

1. To view the solution queue, clickTools >Show Queued Simulations or click theShow
Queue icon on the toolbar.
This displays a dialog that displays each simulation and its current status. You select and
remove any simulation from the queue.
You can also select any setup and use theMove up andMove down buttons to prioritize
them.

2. To remove a simulation from the queue, select the simulation, and clickRemove from
Queue.
This removes the selected simulation from the queue.

Remote Analysis
It is possible to solve a project on a different machine from the one on which you set up your designs.
This is particularly useful when you want to take advantage of amore powerful machine but it is not
convenient to access that machine. This process involves configuring themachine that is to perform
the solving (the remotemachine), as well as themachine fromwhich the simulation is to be launched
(the local machine). This can also be extended into distributed analysis, where a specified analysis, if
supported, is concurrently solved onmultiple remotemachines.
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Note Communication betweenmachines in remote analysis and distributed analysis can
drastically affect performance. Use of a high-speed network system, like Gigabit or
Infiniband, is recommended for optimal performance.

l Prerequisites for Remote and Distributed Analysis
l Configuring the Local Machine to Solve Remotely
l Remote Analysis Options
l Running Remote Analysis

The Tools>Options>Export Options Files commandwrites xml files containing theOptions settings
at all levels to the specified directory. The Tools>Options>Export Options feature is intended to
make it easier for different users to use ANSYS Electromagnetics tools installed on shared
directories or network drives. The Example Uses for Export Options Features section outlines some
use cases enabled by this feature.

Prerequisites for Remote and Distributed Analysis
1. Youmust have ANSYS Electromagnetics Remote SimulationManager (RSM) or a supported

High Performance Computing (HPC) management software program. (See High
Performance Computing (HPC) Integration). The list of currently-supported HPC software
includes
l Platform’s Load Sharing Facility or LSF (7.0.6; 8.0.1; 9.1.1)
l Altair’s PBS (PBSPro 10.1.0.91350; PBS/Torque 2.5.12)
l GridEngine (SGE: 6.2u6; OGS:GE 2011.11; Univa:8.1.3)
l Microsoft®Windows® Compute Cluster Server 2003
l Microsoft®Windows® HPC Server 2008 R2 SP4, HPC Server 2012

2. Maxwell must be accessible from all remotemachines aswell as accessible on the local
machine.
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3. If you use RSM, it must be accessible from all remotemachines. In addition, theMaxwell
enginesmust be registered with each initialization of RSM. To do this, on each remote
machine:
l OnWindows on the local and remotemachines, click
Start>All Programs>ANSYS Electromagnetics>ANSYS Electromagnetics Suite
[version]>Register with RSM. You can also run
RegisterEnginesWith RSM.exe, located in the product subdirectory (for example,
C:\ProgramFiles\AnsysEM\AnsysEM18.0\Win64\RegisterEnginesWithRSM.exe).

In each case, you see a dialog confirming the registration. OK the dialog.

l On Linux, runRegisterEnginesWithRSM.pl, located in the product installation directory.
(for example, /apps/AnsysEM/AnsysEM17/RegisterEnginesWithRSM.pl).

If the RSM service cannot run due to permission issues for the configuration file, it issues an error
message and exits. If your product is not registered with RSM, the analysis will run locally.

Configuring the Local Machine to Solve Remotely
To set the Analysis options in Maxwell see Configuring Distributed Analysis.

Remote Analysis Options
You also set the Remote Analysis Options in theGeneral options dialog,RSM Analysis Options
tab.

Select whether to run simulation processes as the user running RSM (Service User), or a Specified
User. If you select Specified user, youmust provide the User Name, Password, and any
Domain/Workgroup on which this user is defined. If the name or password is incorrect, theMessage
window issues a warningmessage, and the solver attempts to perform the analysis as the Service
User.

Running Remote Analysis
When you run a simulation remotely, you should see amessage in the Progresswindow identifying
the design name, and the specified remotemachine. You will see Progressmessages as the
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simulations continues.When the simulation is complete, you will see amessage in theMessage
window.

Related Topics

Setting Analysis Options
Distributed Analysis
Troubleshooting
Running from aWindowsRemote Terminal

Troubleshooting

Problem:When you try to solve from local to remotemachine, anMAXWELLCOMENGINE
process starts on the remotemachine, but theMaxwell user interface hangs indefinitely.
This occurs if the remote solve option is enabled after the COMdaemon is started, or when the
option "Don't allow exceptions" is selected for theWindows firewall.
Resolution: Remote solve needs either firewall exceptions to beON or firewall to be completely
turned off.
Problem:When you try to solve from a local to a remotemachine, you receive the following error
message:
[error] Unable to locate or start COMengine on 'nomachine' : Unable to reach AnsoftRSMService.
Check if the service is running and if the firewall allows communication. (10:57:13 PMAug 13, 2009)
Resolution:Thismessage can happen if themachine is not present, the network connection is
down, if there are firewall issues or if the service is not running.

Remote Solve Node = Windows
Error: "Unable to locate or start COMengine on <remote node> : Unable to reach
AnsoftRSMService. Check if the service is running and if the firewall allows communication."

1. Try disabling the firewall.
2. Confirm that you have not changed the Ansoft Service Port in Tools > Options > General

Options > Remote Analysis Options from the default 32958. If you have, change it back to
32958, restart Maxwell, and try to solve again.

3. Make sure that the local machine is able to contact the RSMport on the remote node. Open a
command prompt on the local machine and type telnet <remote node name> 32958. If the
terminal appears to be hanging then the connection was successful.

4. Check tomake sure the ANSYS Electromagnetics Communication Service is running. To do
this, go to theWindows Control Panel and chooseAdministrative Tools > Services.
Find the ANSYS Electromagnetics RSMService andmake sure its status says Started. If it is
not running, try to start it by right-clicking on the service and choosing Start. If it still does not
start, then check the username/password combination listed in the LogOn tab of the service
properties.

5. Make sure the user listed in the service is an administrator.
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6. Make sure the COMengine is registered with the ANSYS Electromagnetics RSMService.
From theWindowsmenu, chooseStart>All Programs>ANSYS
Electromagnetics>ANSYS Electromagnetics Suite [version]>Register with RSM to
register the engines.

Error: "Unable to locate or start COMengine on <remote node>: Engine is not registered with the
ANSYS Electromagnetics RSM service which is running on thismachine.”

l To register the engine, from theWindowsmenu, selectStart>All Programs>ANSYS
Electromagnetics>ANSYS Electromagnetics Suite [version]>Register with RSM.

Remote Solve Node = Linux
Error: "Unable to locate or start COMengine on <remote node>: Unable to reach
AnsoftRSMService. Check if the service is running and if the firewall allows communication."

1. Try disabling the firewall.
2. Confirm that you have not changed the Ansoft Service Port in Tools >Options >General

Options >Remote Analysis Options from the default 32958. If you have, change it back to
32958, restart the ANSYS Electromagnetics product, and try to solve again.

3. Make sure that the local machine is able to contact the RSMport on the remote node. Open a
command prompt on the local machine and type telnet <remote node name> 32958. If the
terminal appears to be hanging then the connection was successful.

4. Check tomake sure Remote SimulationManager is running. To do this:
a. Go to the 'rsm' subdirectory of the ANSYS Electromagnetics Remote SimulationManager

installation directory, <RSM installdir>/rsm.
b. Type ./ansoftrsmservice status.
c. If the status query indicates that the service is stopped, type ./ansoftrsmservice start.

5. Make sure the COMengine is registered with RSM. Type ./RegisterEnginesWithRSM.pl
status fromwithin theMaxwell installation directory. If the status query indicates "Not
registered", type:
./RegisterEnginesWithRSM.pl add.

Error: "Unable to locate or start COMengine on <remote node>: Engine is not registered with the
ANSYS Electromagnetics RSM service which is running on thismachine.”

l To register the engine, go to the ANSYS Electromagnetics product installation directory and
type:
./RegisterEnginesWithRSM.pl add.

Distributed Analysis
Distributed analysis allows users to split certain types of analyses and solve each portion of an
analysis simultaneously onmultiple machines. Simulation times can be greatly decreased by using
this feature.
Maxwell supports the following forms of distributed analysis:
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l Distributing rows of a parametric table, either as a regular DSO, or as Large Scale DSO
performed through command line. Large Scale DSOgenerates a reduced set of outputs.

l Distributing a single or discrete interpolating sweep.
Note Communication betweenmachines in remote analysis and distributed analysis can

drastically affect performance. Use of a high-speed network system, like Gigabit or
Infiniband, is recommended for optimal performance.

Related Topics

Configuring Distributed Analysis
Editing DistributedMachine Configurations
Selecting andOptimal Configuration for Distributed Analysis
Large Scale DSO for Parametric Analysis

Configuring Distributed Analysis

To configure distributed analysis you select a distributedmachine configuration. This is a list of
machines to use for a simulation, based on considerations such aswhether the simulation ismore
memory intensive or more CPU intensive, relative to the resources available on your network. (See
Selecting anOptimal Configuration for Distributed Analysis for a discussion of issues.) To create an
new distributedmachine configuration. or to edit an existing one, see Editing DistributedMachine
Configurations.
To select from an existing configuration:

1. Click the HPC and Analysis Options icon on the Toolbar or clickTools>HPC and Analysis
Options.

This opens theHPC and Analysis Options dialog. You can define and select configurations
for Maxwell 2D, 3D, and RMxprt design types separately. You can view a list of Available
configurations, and a report of the configuration details. From the current, list, you can select a
configuration toMake Active. You can alsoAdd a new configuration,Edit an existing one, or
Export as a ANSYS Configuration file (*.acf). You can also Import a configuration file. This
lists existing configurations, and shows all machines in the selected configuration, enabled or
not. You canCopy an existing configuration, typically to edit the name and contents for other
purposes.
In theOptions tab you can enable queuing, set the design type, set licensing options and
specify default process priority.
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For amore detailed discussion of this dialog, see Setting HPC and Analysis Options.

2. To define a new configuration, on theAnalysis Settings dialog, click theAdd button to open
theAnalysis Configuration dialog. See Editing DistributedMachine Configurations.

Related Topics

Editing DistributedMachine Configurations
Selecting anOptimal Configuration for Distributed Analysis
The Tools>Export Options Files commandwrites xml files containing theOptions settings at all levels
to the specified directory. The Tools>Options>Export Options feature is intended tomake it
easier for different users to use ANSYS tools installed on shared directories or network drives. The
Example Uses for Export Options Features section outlines some use cases enabled by this feature.

Editing Distributed Machine Configurations for Maxwell and RMxprt

To edit an existingmachine configuration:
1. ClickTools>Edit Active Analysis Configuration to open theAnalysis Configuration

dialog directly or click theEdit the active analysis configuration icon on the Toolbar.
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This opens theAnalysis Configuration dialog directly. You can also access this dialog from
theHPC and Analysis Options dialog by clicking theAdd..,, Edit..., orCopy... buttons.
If you selectAdd... from theHPC and Analysis Options dialog , the fields are empty. If you
selectEdit... or use Tools>Edit Active Analysis Configuration, or clickCopy from the
HPC and Analysis Options dialog, the fields show the selected configuration.

2. If youAdd a new configuration, youmust specify the name of the new or edited configuration.
It cannot be empty and cannot be a previously used name or a reserved word.
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3. If the solver supports automatic settings, you can select theUse Automatic Settings check-
box to assign resources automatically, or you can uncheck the box to specify job distribution
manually in the Job Distribution tab, as discussed below. For Maxwell, this setting currently
is supported only for 2D and 3D Transient designs.

SelectingUse Automatic Settings removes the Job Distribution tab, setting those
parameters automatically based on the best use of available resources for the current
analysis.

For 2D and 3D Transient designs, theUse Automatic Settings option distributes one
excitation to eachmachine listed in the configuration.When this option is enabled, aminimum
of 2 coresmust be assigned. Eachmachine uses all cores assigned to it while solving its
excitation. Unlike automatic frequency setup, themachines are assigned sequentially without
regard tomachine capability.

4. TheMachines Tab contains themachine list for the analysis configuration.
Here you can providemachine information, either by specifyingMachine Details, or by
importing a list of machines from a file. You can then remove, order, test, and enable
machines on the list. Control buttons let youAdd machine to List orRemovemachines
from the list.
Numbers of Tasks and Cores
If automatic settings are either not used or not available, note that eachmachine has an
associated number of tasks and number of cores. The number of tasks specifies the total
number of compute jobs that will be run on that machine simultaneously. Each separate solver
or engine instance is one task. The total cores specifies the total number of cores that will be
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used on the givenmachine. This is how you specifymultiprocessing. For example, if you want
to run two threads for each task, you specify Total Cores = 2 xNumber of Tasks. The number
of coresmust always be greater than or equal to the number of tasks. If the number of cores is
not an exact multiple of the number of tasks, some taskswill usemore cores than others. For
example, if Number of Tasks is 4 and Total Cores is 10, 2 taskswill use 3 cores, and 2 tasks
will use 2 cores.
RAM Limit (%)
Here you can specify themaximumpercentage of themachine's RAM to be used for
processing.
Import Machines from File...
You can import amachine list from a file, and an enhanced the file format handles the new
flexibility. Each line of the file can contain amachine specifier of the form:

<MachineName>:<NumTasks>:<NumCores>.

Note: this same format is used with the "-machinelist file=" command line option.
Local Machine Radio Button
To streamline the common case of running jobs on the current machine, use the dedicated
radio button to specify the local machine.

5. For eachmachine tomanually add to the list, under RemoteMachine Details, specify an IP
address, a DNS name, or a UNC name.
The remotemachinesmust have the same ANSYS Electromagnetics Suite version installed
in the sameOS and version, and have the RSM service active.
Once you have specified the remotemachine details, either directly or by Importing Machine
from a File, you select amachine from the table to enable the buttons toRemove amachine,
or toMove amachine up or down on the list.

The displayed list shows the order in which you entered them irrespective of the load on the
machines. To control the list order, select one or moremachines, and use theMove up or
Move down buttons.Move up andMove down are enabled when you select one or more
adjacent machine names.
Enabled Machines
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Eachmachine on the current list has anEnabled checkbox. Here you can enable or disable
the listedmachines according to circumstance. Above the table, the dialog gives a count of the
total enabled tasks, and the total enabled cores.
For distributed tasks, the software will allocate the total cores on a givenmachine to that
machine's tasks. If a machine with 8 cores is running 2 distributed tasks, the software will
automatically allocate 4 cores to each task. If it is running 4 distributed tasks, each gets 2
cores. And if it is running 3 distributed tasks, the first two tasks get 3 cores and the last task
gets 2 cores.
For a given variation (for example, frequency or geometry), you shouldmake assignments so
that each task has the same number of cores. This is because the solvers attempt to make
each task computationally balanced. For example, with twomachines, one with eight cores,
and another with four, assuming that thememory is proportionally equivalent, you could
assign two tasks for machine 1, and one task for machine 2, giving all tasks the same number
of cores.
In general, Maxwell usesmachines in the distributed analysismachines list in the order in
which they appear. If you select a distributed configuration (rather than Local) from the
Toolbar menu and you launchmultiple analyses from the sameUI, Maxwell selects the
machines that are running the fewest number of engines in the order in which themachines
appear in the list. For example, if the list contains 4machines, and you launch a simulation that
requires onemachineMaxwell chooses the first machine in the list. If another simulation is
launched while the previous one is running, and this simulation requires twomachines,
Maxwell choosesmachines 2 and 3 from the list. If the first simulation then terminates and we
launch another simulation requiring threemachines, Maxwell chooses 1, 4, and 2 (in that
order).

Test Machines
Test Machines- Whenmultiple users on a network are using distributed solve or remote solve, they
should check the status of their machines before launching a simulation to ensure no other ANSYS
Electromagnetics processes are running on themachine. To do this, you can select one or more
machines and click the Test Machines button. A Test Machines dialog opens.
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The test goes through the current machine list and gives a report on the status of eachmachine. A
progress bar shows how far testing has gone. An Abort button lets you cancel a test. When the test is
complete, you can Close the dialog. If you need to disable or Enablemachines from the list based on
the report, you can do so in the Distributed Analysis Machines dialog.

Job Distribution Tab
Use this tab tomanually enable specific job distribution types, and to enablemulti-level solves. The
Job distribution tab is disabled if you selectUse Automatic Settings. Job distribution types are
design type specific and will differ between products.

l Maxwell 2D and 3D design types can useOptimetrics Variations, Frequencies, and Transient
Solver distribution types.

l RMxprt can use onlyOptimetrics Variations.

Use the check boxes to enable/disable available distribution types. The job distribution list box allows
you to specify which job distribution types to allow for the current analysis configuration. At solve
time, the ANSYS Electromagnetics software automatically select the best distribution type from the
enabled distribution types. By enabling/disabling distribution types, you can control the job
distribution.
Enabling a distribution type does not necessarilymean it will be used. It must also be allowed by the
solve setup. For example, the Transient Solver distribution type that enables use of the Time
DecompositionMethod, will only be usedwithMaxwell 2D andMaxwell 3D transient designs. Note
that the enabled distribution typeswill apply to all setups of the given design type, so it is possible for
different setups in a design to be solved using different distribution types.
The distribution types that you enable here are listed in the HPC and Analysis Settings dialog in the
Configuration details pane when select that configuration from the list.
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If your solver permits, and you have selectedUse Automatic Settings, the Job Distribution notes
that Optimetrics Variationswill be solved sequentially. Other distribution typeswill be distributed
automatically.

For products that support two-level distribution, when the design is appropriate, you can turn on two
level distributed solves, and specify the number of engines to use for level 1.
Distribution Levels
The radio buttons let you specifySingle level only or Enable two level distribution.
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If you select Single level only, one distribution type will be applied at each stage of the solution
process. If multiple types are available, the higher level solution will generally be distributed. All
machine taskswill be used by the single-level distribution.
Single Level Distributions
Supported distribution types are Optimetrics Variations, Frequencies, and Transient Solver. Solver
distributions requireMPI.

l Parallel distribution types such asOptimetrics Variations and Frequencies are considered as
not required. If these types are not able to distribute, the simulation can be run sequentially.

l Transient Solver distribution types are considered as required. If these types are enabled the
software will assume that distribution is necessary to extend the simulation scale or add
fundamental solution capabilities.

Whenmultiple distribution types are available, the higher level solution will generally be distributed.
For example, Optimetrics Variationswill be distributed when both Optimetrics Variations and
Transient Solver are selected.
Two Level Distributions
Selecting Enable two level enables the Distributed Solutions at first level selection box.

The first level will distribute the specified number of solutions. Each solution will use a subset of
machine tasks to distribute the second level. The Transient Solver distribution typemust be available
for the second level; otherwise single-level distribution will be applied.
Types that can be distributed at Level 1 are Optimetrics Variations. Transient Solver distributions can
be distributed as Level 2.
The following is an example of a two-level distribution:
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l A parametric setup distributing Optimetrics Variations as level 1 and Transient Solver as level
2.

Preview Job Distribution
The Preview Job Distribution Setupmenu and field lets you view how the selected setup will be
distributed.

Options Tab (Analysis Configuration Dialog)
Use theOptions tab to specify options for the current analysis configuration. Different design types
may have different options available in their analysis configurations.

Note TheOptions tab is not displayed for RMxprt analysis configurations.

TheOptions grid contains the available option Names and editable Values.
These options settingswill be in effect only when all the following are true:

l A design is being solved whose design typematches this analysis configuration's
l This analysis configuration is the active configuration for its design type
l You have not specified corresponding batch options on the command line. Command line
batchoptions can be used to override the options specified by the active configuration.

Selecting an available option causes a display of a description of the option.
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Relation to Batchoptions
Analysis configuration option settings can be overwritten by specifying the option name and value
inside a -batchoption string. See -batchoptionhelp for a list of batchoption names and possible
values. You can also view all available and frequently used batchoptions in the JobManagement
Submit Job To: dialogue, by clicking theAdd... button under Analysis Options. This opens theAdd
Batchoption dialog, which gives access to all batchoptions.

Adding Configurations or Accepting Edits
ClickOK to accept the changes and close theAnalysis Configuration dialog. Onlymachines
checked asEnabled appear on the distributedmachinesConfiguration DetailsMachine list..
Regardless of themachine(s) on which the analysis is actually run, the number of processors and
RAMLimit (%), the Desired andMaximumRAMLimits, and the default process priority settings are
now read from themachine fromwhich you launch the analysis. See Setting HPC and Analysis
Options.
For more information, see distributed analysis.

Note The option is only active if there aremultiple rows listed in the parametric table, there are
multiple frequency sweeps listed under a given analysis setup, and the number of
distributed analysismachines is two or greater.

Related Topics

Configuring Distributed Analysis
Editing DistributedMachine Configurations
Selecting anOptimal Configuration for Distributed Analysis
"TimeDecompositionMethod for Maxwell Transient Designs" on page 16-37
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Selecting an Optimal Configuration for Distributed Analysis

With the distributed solve option (DSO) it is possible to assignmore than onemachine in the DSO
setup panel to a single computer - assuming the computer hasmultiple cores. For example, a quad
core computer can be listed 4 times in the DSOmachine list and each CPU will run a separate
simulation in the sweep. This raises the question of how to configure a distributed solution option
(DSO) in combination with themultiprocessing option to take optimal advantage of the available
hardware. The simplest answer is that for the overwhelmingmajority of situations the speed
improvement will be greater if additional machines are added to a DSO than if the sameCPU’s are
added asmultiple processors. That simple answer assumes that there is enoughmemory for the
DSOsimulations.
For multiple DSOsimulations on a singlemachine the total memory needed is the sum of the
memory used by each simulation. For example, assumewe are running discrete frequency sweep
and each frequency point needs 3.5GB. Our computer has only 8GB of RAMbut is a quad core
system. To keep the computer from going heavily into swap, which is highly inefficient, we would only
want to assign this computer twice to the list of machines in the DSOsetup. To take advantage of the
remaining 2 CPU’s then it wouldmake sense to set the number of distributed processors to 2. This
would be the optimum for this setup. In addition one would need to be sure that the amount of disk
space available is also sufficient to fit all the requested simulations - typically hard drive space is not
the limiting factor.

Related Topics

Configuring Distributed Analysis
Editing DistributedMachine Configurations

Large Scale DSO for Parametric Analysis
Large Scale DSO for parametric analysis operates through a non-graphical batch application called
desktopjob. You can run the desktopjob command-line to perform parametric analysis DSO. The
command-line interface supported by this batch program is consistent with the command-line used
for regular DSO jobs.
Large Scale DSO is used for 'large scale parallel' jobs, which either fail or scale poorly asRegular
DSO jobs. A Large Scale DSO job does not support the output of full parametric results, but
produces “reduced” datasets corresponding to predefined Rectangular plots. The extracted columns
of data are saved as .csv files. Typically, there is one .csv file per-trace, per-variation. These .csv
outputs can be used directly in downstream applications (for example, Excel, or custom programs
that parse .csv files). They can also be Imported asDataset Solutions for post processing. Non-
Rectangular plots of the design (such as statistical eye or digital plot) are not extracted). In order to
produce a new output youmust re-run the analysis.
The basic process involves:
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1. Prepare the project for Large Scale DSOAnalysis
2. Submit the Large Scale DSOJob through the Tools>JobManagement menu, or via a

command line.
3. Monitor the job’s progress
4. Post process the results

For details, refer to the following sections:
l Prerequisites for Large Scale DSO
l JobManagement Interface for Large Scale DSO
l Large Scale DSOExample
l Command Line Syntax
l Deployment/Configuration
l Results DatabaseOrganization
l Job outputs
l JobMonitoring
l Known Issues for Large Scale DSO
l Troubleshooting for Large Scale DSO

Related Topics

RunningMaxwell from aCommand Line
Distributed Analysis
High Performance Computing (HPC) Integration
Large Scale DSOTheory

Prerequisites for Large Scale DSO

General Prerequisites
l Maxwell must be installed on the cluster which runs either a supported scheduler or ANSYS
RSM.

l The cluster is compatible with large Scale DSORequirements
l There is a folder on a shared drive where the input projects are located.
l Every node of the cluster supports the disk space (in temp directory) andmemory
requirements of multiple engines that run in parallel.

l All themachines allocated to Large Scale DSO jobmust all come from the same platform,
Windows or LINUX.

Ansoft RSM Environment
On theWindows platform, RSM (ansoftrsm.exe) is started as an ’admin’ account, rather than
as a ’system’ account.

Note Large Scale DSOdoes not support RSMService running with ’system login’
credentials.
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l On eachmachine of the cluster, 'desktopjob' application is registered with Ansoft RSM service
using the command shown below:
Windows: <installation-directory>/<platform> desktopjob.exe -regserver
Linux: <installation-directory>/<platform>desktopjob -regserver

Note Detailed cluster configuration instructions are
here.

Scheduler Environment
l No extra configuration is needed.

Related Topics

Large Scale DSO for Parametric Analysis
Distributed Analysis
High Performance Computing (HPC) Integration

Job Management Interface for Large Scale DSO

Large Scale DSO jobs run only in non-graphical batchmode, irrespective of the scheduler
environment. This is in contrast to a Regular DSO job, which, in an RSMenvironment, can be
launched from a graphical Desktop. This consideration implies that an input project corresponding to
a Large Scale DSO jobmust be saved and closed, prior to job-submission. Secondly, the command
to submit a Large Scale DSO job is only available through the Tools>Job Managementmenu or a
commandwindow, while a Regular DSO job can be run in RSMenvironment by right-clicking
directly on the parametric setup. The JobManagement UI is accessed by running ANSYS
Electromagnetics product Desktop on the designated 'Postprocessing node' of the cluster. The
Desktop providesUI commands for Scheduler selection, Job submission and Job
monitoring/control. You access the Scheduler User Interface by clicking Tools>Job
Management>Select Scheduler...

Click Select Scheduler to display the selection dialog. A drop down lists potential schedulers, (which
can include RSM, lsf, or sge, depending on the environment).
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If you select a scheduler that is not supported in your environment, you receive a warningmessage.
After selecting a scheduler, you can click Refresh to display information for that scheduler.

Once you have selected a scheduler supported in your environment, you can go through the
following steps to submit a Large Scale DSO job.

1. Setup and preparemodel on local workstation
l Launch Desktop. Open project, for example, '/home/projects/spool/test.mxwl'
l Suppose the variations to solve come fromParametricSetup1 setup, Right-click on
ParametricSetup1 and runValidate for Large Scale DSO. Fix any validation errors.
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l If edits weremade, Save the project.
l Close the project.

2. Copy the input project (or folder, if the project references external files) from a personal
workstation to a shared-drive on cluster (for example, test.mxwl is copied to
/home/projects/spool/test.mxwl).
l In the RSMenvironment, you are required to specify amachine-list. (See Editing
DistributedMachine Configurations.) For example, say themachine-list is: 3 cores from
'm1' and 3 cores from 'm2', for a total of 6 engines. You select the list on the Compute
Resources tab described below.

l In a Linux scheduler environment, a cluster must have a designated 'postprocessing node'.
Open a remote-desktop session (or equivalent such as vnc session) on the designated
'post-processing node'. Say the name of this node is 'm1'. Launch Desktop graphically on
'm1'.

3. Open a remote-desktop session (or equivalent such as vnc session) on the node
corresponding to the first machine of job'smachine-list, 'm1' in this case. Launch Desktop
graphically on 'm1'.

4. (Optional step) Double-check that themodel is prepared correctly
l Open project '/home/projects/spool/test.adsn'
l Right-click on ParametricSetup1 and run 'Large Scale DSO/Validate'. Fix any validation
errors

l Save project, in case of edits. Close project
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5. Run Tools>Job Management>Submit Job... The standard Job Submission panel pops up.

The panels for LSF andGE have some differences. See separate sections for Job
Management User Interface for LSF and JobManagement User Interface for SGE.
l Enter all fields. Make sure to select 'ParametricSetupn' for analysis and check the Use large
scale DSOcheckbox.

l To see the command-line submitted to the scheduler, clickPreview Submission. This
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opens a dialogue showing the command to be sent to the scheduler.

The text can be copied to the clipboard, if desired.

l The Batchoptions field allows you to add additional -batchoptions parameters.
l If you select Show advanced options, you can see the fields for setting Environment
variables, and for using batch extract.

See the discussion on RunningMaxwell from aCommand line for a discussion of the solve
information available through batch extract.

l If you intend toMonitor the job through a user interface, youmust checkMonitor job. You
can thenmonitor this job through the Tools>Job Management>Monitor Jobs...
command or by checking the dialog that openswhen you submit the job.

6. The Compute Resources tab displays other parameters. Depending on the resources
available for a scheduler environment, some of the fieldsmay be disabled.
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l Specify node from the pulldown list.
l Specify Tasks, Cores, and RAMLimit (%).
The values you specify here represent minimal requirements for each condition that can
interact in leading to the total resources the Scheduler derives from them. The number of
Tasksmust be less than or equal to the number of Cores.

7. To submit the commandwith the specified parameters, clickSubmit Job.
Note TheRSMenvironment does not support queuing, so 'Submit Job' will immediately

start running the job.

A dialog displays in which you can check "Beginmonitoring this job now.

8. You canmonitor this job either automatically (by checking the option) or through the
Tools>Job Management>Monitor Jobs... command.
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The dialog contains fields reporting the Job status, Job ID, Messages, and Progress. You can filter
themessages for Errors, Warnings, and Info. You canClear Progress Messages. You can refresh
the jobManually or Automatically at specified intervals.

You can also perform aClean Stop for a simulation between time steps, orAbort Job.
The process for submitting andmonitoring Large Scale DSO jobs in LSF/SGE environments. is
generally similar.

1. Setup and preparemodel on local workstation
Launch Desktop. Open project '/home/projects/spool/test.adsn'
Suppose the variations to solve come fromParametricSetup1 setup, Right-click on
ParametricSetup1 and run 'Large Scale DSO/Validate'. Fix any validation errors
Save project, in case of edits
Close project
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2. Copy the input project (or folder, if the project references external files) from personal
workstation to shared-drive on cluster (say project is copied to
/home/projects/spool/test.adsn)
In the scheduler environment, a cluster must have a designated 'postprocessing node'. Open
a remote-desktop session (or equivalent such as vnc session) on the designated 'post-
processing node'. Say the name of this node is 'm1'. Launch Desktop graphically on 'm1'.

l (Optional step) Double-check that themodel is prepared correctly
Open project '/home/projects/spool/test.adsn'
Right-click on ParametricSetup1 and run Large Scale DSO/Validate. Fix any validation
errors
Save project, in case of edits. Close project

3. Run Tools>Job Management>Submit Job.... The standard Job Submission panel pops
up, which is documented as part of the scheduler-gui-integration feature.

4. Enter all fields. Make sure to select 'ParametricSetup1' analysis and turn ON 'Use large scale
DSO' checkbox

5. Click on 'Preview' to check (and/or copy to clipboard) job's command-line. Click on 'Submit
Job'

6. Monitor this job through the Tools>Job Management>Monitor Jobs... command.
See separate sections for JobManagement User Interface for LSF and JobManagement User
Interface for SGE.

Large Scale DSO Command Line Syntax

Large Scale DSO feature operates through a non-graphical batch application called 'desktopjob'.
You can run the desktopjob command-line to perform parametric analysis DSO. The command-line
interface supported by this batch program is consistent with the command-line used for current DSO
jobs. “desktopjob -help” lists all available command-line options as shown below:

Command Line Syntax:
desktopjob.exe <options> <project-path-on-shared-drive>

Options:
-help: Print this help text
-cmd: Specify command to run. Available choices: dso
-ng: Run analysis in non-graphical mode
-monitor: Output progress andmessages to standard output/error
-waitforlicense: Queue the job until the availability of licenses
-preserve: Preserve local storage space of the distributed job for investigation into job's run. If
local storage directory (aka, temp directory) is provisioned by scheduler, ensure it is also
configured to preserve job's local storage. (Note: this storage should be deletedmanually)
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-batchoptions: Override the Tools/Option entries through either a batchoptions file or
batchoptions string.

Example:
-batchoptions <config-file-on-shared-drive>
-batchoptions "'name1'='val1' 'n2'='v2'"

-machinelist:
l In the context ofAnsoft RSM:
Specifymachines for distributed analysis. Machine list is specified either inline (as a comma
separatedmachine names) or through a file. Multiple cores are specified by repeating the
name of machine or by embedding number of cores in themachine name, using a colon
separator.
Example 1:

-machinelist "list=m1,m1,m1,m2,m2,m3"

Example 2:
-machinelist "list=m1:3,m2:2,m3"

Example 2:
-machinelist "file=machines.txt"

l In the context of a scheduler such as LSF:
Specify the portion of total machines for distributed analysis. Use remaining for overhead or
sharedmemorymultiprocessing.
Example:

-machinelist "Num=10"

-usefolderasinput:Choose this option if the job's input represents the entire folder rather than just
the project file.
-maxfolderInMB: Specify themaximum size (MBytes) of input folder that is allowed for a valid job.
By default, themaximumsize allowed for input is 10MB. Specify a value of 0 to remove this size
restriction and enable inputs of any size. Note: this option applies when '-usefolderasinput' is used.
-workdir: Specify the shared drive folder for status and result files generated by analysis. By default,
the results folder of input project is used as the work directory.
-batchsolve: Solve the specified parametric setup. Syntax for the setup:

<design-name>:Optimetrics:<parametric-setup>

Related Topics

Large Scale DSO for Parametric Analysis
RunningMaxwell from aCommand Line

Large Scale DSO Job outputs

A large-scale-dso analysis does not support the output of full parametric results. Instead, it extracts
'subset' results using predefined Rectangular plots, which are created by user before job is run. The
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extracted columns of data are saved asCSV files. Typically, there is one CSV file per-trace, per-
variation. (Note: Non-Rectangular plots of the design (for e.g. statistical eye, digital plot) are not
extracted). The outputs can be either imported as datasets for post-processing in the desktop also as
function of parametric variations, or used directly in downstream applications (for example, Excel, or
custom programs that parse .csv files).

CSV File contents
The initial header rows of CSV file define the solved variation. For each such row, the first column
has variable name and the second column has variable's value. The row following variation rows has
the name of primary sweep and the name(s) of extracted quantities. Subsequent rows contain 'data'
- quantity values as a function of primary sweep. Below examples provide a context for the CSV file
contents:

l Traces of S-parameter report: The data portion of CSV file has 2 columns of data: first column
has Freq values and the second column has values for trace's s-parameter component

l Trace of a far field report: Suppose there is a farfield report with a trace ('magrE'), whose
primary sweep is 'phi' and secondary sweep is 'theta'. Further suppose that two values of
'theta' are chosen and 'all' values of 'phi' are chosen. For this trace, the data portion of CSV file
contains three columns of data: the first column has phi values, the second column hasmagrE
values for the first value of theta, the third column hasmagrE values for second value of theta.
ThemagrE output columns are titled as 'magrE_crv1', 'magrE_crv2' respectively

l (Advanced) 'Special' sweeps: In the case of a trace with 'special' primary sweep (such as the
trace of a time domain quantity), one CSV file is created per curve of trace, per variation.
These CSV files always have two columns, irrespective of the number of values chosen for
secondary/higher sweeps.

Related Topics

Large Scale DSO for Parametric Analysis
Import Large Scale DSODataset Solution

Large Scale DSO Example

This section provides an example of the use of Large Scale DSO to distribute parametric variations
of aMaxwell model across the nodes of a cluster or to multiple cores of a singlemachine.
This example presumes that your configuration satisfies the Prerequisites for Large Scale DSO. For
this example, pre-suppose that we have aWindows cluster. Further suppose that the shared drive
folder, which contains the input projects and computed results is at the location
\\sjo7na1\mxwlprojs

Major steps for Large Scale DSO Example
1. Prepare themodel for Large Scale DSOAnalysis
2. Submit the Large Scale DSOJob
3. Post process the results
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Preparing a Project for Large Scale DSO Analysis

1. Ensure that theMaxwell project is on the shared drive. For this example, the relay_
nominal.mxwl file is on "\\sjo7na1\mxwlprojs\relay_nominal.mxwl"

2. Set up a parametric table you wish to use.

3. On theOptions tab, ensure that Save Fields and Mesh is unchecked.

4. Outputs from Large Scale DSOcome from predefined rectangular plots that are created
before the Analysis command is issued. Non-rectangular plots of the design (digital plots, for
example) are not extracted. Follow the steps below:
a. Because these DSOoutputs come solely fromRectangular Plots, delete all other

postprocessing setups.
b. Use theReportwindow to define outputs for the desired rectangular plots.
c. Click on the Families tab and ensure that all variables are set toNominal, as shown

below.
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Note For Large Scale DSO, outputs are not extracted correctly unless all variables on
the Families tab are set to nominal.

d. Click theNew Report button to create the report.
5. Right-click on the parametric sweep, and selectValidate for Large Scale DSO.

A dialog reports any errors. The following are some typical messages:
[error] Please remove all the calculations in Parametric
Setup/Calculation page.
[error] Please turn off "Save Fields And Mesh" in Parametric
Setup/Options page.
[error] No rectangular plot exist in the design. Please create
a rectangular report.

6. Correct any errors, if necessary to pass validation.
7. Save and Close the project.

Submit the Large Scale DSO Job: Examples

This section includes examples of submitting a Large Scale DSO job using Ansoft RSMand a
Scheduler.

Using the Ansoft RSM Environment
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1. Before submitting the jobmake sure that the input project is not open in anyDesktop window.
2. For this example, suppose that there are two quad-coremachines on your cluster with the

names "m1" and "m2". Further suppose that there are two engines per machine, for a total of
four parallel engines. Let the number of processors allocated to each engine be 1.

3. From a command prompt, issue the following command:
<installation-directory>/<platform>desktopjob.exe -cmd dso -
machinelist "list=m1:2,m2:2" -batchoptions
\\sjo7na\mxwlprojs\mxwloptions.txt -batchsolve "relay_
nominal"Optimetrics:ParametricSetup1"
\\sjo7na\mxwlprojs\relay_nominal.mxwl

where the file \\sjo7na\mxwlproj\mxwloptions.txt has the following contents:
$begin Config

'Maxwell/Preferences/NumberOfProcessors'=1
'Maxwell/Preferences/NumberOfProcessorsDistributed'=1
'Maxwell/Preferences/NumberOfProcessorsPostProc'=1
'Maxwell/Preferences/UseHPCforMP'=0
'Maxwell/Preferences/SaveBeforeSolving'=0
'Maxwell/Preferences/MemLiimitHard'=0
'Maxwell/Preferences/MemLimitSoft'=0
'Maxwell/Preferences/HPCLicenceType'='pack'

#end 'Config'

4. Assume the above job is assigned ID "jobID".

Using a Scheduler Environment (such as LSF)
1. Suppose you want to solve variations using four parallel engines, each engine being assigned

a single core.
2. From a command prompt, run the following command:

bsub -n 4 <installation-directory>/<platform>/desktopjob.exe -
cmd dso -batchoptions \\sjo7na\mxwlprojs\mxwloptions.txt -
batchsolve "relay_
nominal:Optimetrics:ParametricSetup1"\\sjo7na\mxwlprojs\relay_
nominal.mxwl

where the file \\sjo7na\mxwlproj\mxwlptions.txt has the same contents as the RSMexample
above.

3. Assume the above job is assigned an ID "jobid"
Next
Large Scale DSOExample: Post Process the Results

Related Topics

Large Scale DSO for Parametric Analysis
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Large Scale DSO Example: Post Process the Results

Once the job is done, output is available in the ~\relay_nominal.mxwl\jobid\results folder. Each
variation creates a subfolder, which in turn has one csv file per trace of each report. See the detailed
information regarding jobmonitoring and the location of the analysis logs.
The figure below shows the results for 10 variations as located in 10 folders.

Within each folder will be csv files corresponding to the traces for each variation.
You have three options for post-processing csv files.

l Import Large Scale DSODataset Solution
l UseMicrosoft Excel or any other application that has csv post processing functionality.
l Parse the csv output into your custom program, for any downstream flow.

Related Topics

Large Scale DSO for Parametric Analysis

Import Large Scale DSO Dataset Solution

For post-processing Large Scale DSOdataset solutions in the desktop, you create a dataset solution
through the Import Large Scale DSO Solution command and pointing to Large Scale DSO job’s
top level results folder.

1. Import solved large scale DSOsolution. You can do this in two ways.
In the Project tree. right click onOptimetrics and from themenu click Import Large Scale
DSO Solution.
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This opens the Import Large Scale DSO Dataset Solution dialog.

From here you can browse to the results of a Large Scale DSO job and select a job folder.
Click the ellipsis button [...] to open the browser window. Navigate to the results directory to
see the results, organized by the scheduler prefix and job ID number. To select a results
dataset, double-click on the results folder name. See Large Scale DSOResults Database
Organization.
Click,OK to import the Dataset. If you have selected the solution folder correctly the dialog
closes. If not, an error dialog opens.

2. To View/Delete created dataset solutions:
In the Project tree, right click on Results and from themenu clickDataset Solutions....
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This displays the Dataset Solutions dialog.

The dialog lists any existing datasets. You can delete one or more by selecting from the list and
selectingDelete. The ImportLarge Scale DSO Solution button opens the dialog for
importing a dataset solution.

3. To create a Dataset Report
After you have imported one or more DSOsolutions, you can create a Dataset Report. Right
click on Results and from themenu selectCreate Dataset Report, and the type of report.
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This opens a reporter window fromwhich you can create a report. If you have previously
created an eye diagram report and it is included in the DSOsolution data extraction, you can
useCreate Dataset Report > Eye Diagram to recreate this report.

4. Cloning from aDataset Solution
If you re-open a project that was solved using large scale DSO, you can quickly clone a report
for a solved large scale DSOsolution by right-clicking in the Project tree on the report, and
choosing Clone fromDataset Solution..., provided this report is qualified for Large Scale DSO
data extraction. The provides a way that you can reuse the existing report definition and save
the work of creating new report.

Large Scale DSO Results Database Organization

A Large Scale DSOanalysis does not support the output of full parametric results. Instead, it extracts
'subset' results using predefined Rectangular plots, which are created by the user before the job is
run. The extracted columns of data are saved asCSV files. Typically, there is one CSV file per-trace,
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per-variation. (Note: Non-Rectangular plots of the design (for e.g. statistical eye, digital plot) are not
extracted)
The results of a Large Scale DSO job are located in the '<workdir>/<jobid>/results' folder. If 'workdir'
is not specified on the job command-line, it is same as the input project's results folder. For example
the default 'workdir' corresponding to '\\shared\projects\relay.mxwl' is
'\\shared\projects\relay.mxwlresults'. Within this results folder, there is one folder per variation. The
name of the variation's folder is an integer number corresponding to variation's index in the
parametric table. For example, a variation-folder named '4' has results for the fifth row of parametric
table, while a variation-folder named '0' has results for the first row of the table.
Below is a sample results folder showing the contents corresponding to results of first variation.
There are ten CSV files corresponding to ten predefined traces.

Related Topics

Large Scale DSO for Parametric Analysis

Large Scale DSO Job Monitoring

Large Scale DSOavoids detailed intra-variationmonitoring is avoided as it increases network traffic
for large-scale jobs. Large Scale DSO jobs aremonitored as below:

l Cluster monitoring tools: The resource usage (CPU, Memory, Network) of Large Scale DSO
jobs ismonitored using standard cluster monitoring tools. Such job-neutral resource
monitoring is ideal as it uses negligible network bandwidth, CPU/Memory.

l Detailedmonitoring of analysis of a variation: For any detailedmonitoring youmust examine
the information provided in the job's log files. Specifically, the large-scale-dso job writes
detailed logs conveying information regarding themachineswhere engines are running and
the local storage location of per-engine distributed database.With such information, you can
login to individual machines for deeper probing of each distributed engine. Following logs are
available:

l Per-node logs:
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There is one 'desktopjob.log' file per node assigned to the job. This log contains information
regarding the node such as name, local storage folder, number of engines started on this
node, etc. It is located in <workdir>/<jobid>/r<nodeIndex>. E.g. "<workdir>/<jobid>/r0" has
desktopjob.log corresponding to the engines running on the first node of job, while
"<workdir>/<jobid>/r2" has logs corresponding to engines running on third node

l Per-engine logs:
There is one desktopjob.log file per distributed engine. It is located in
<workdir>/<jobid>/r<nodeIndex>/r<coreIndex>. For example, "<workdir>/<jobid>/r0/r0" has
logs corresponding to first engine running on first node, while "<workdir>/<jobid>/r1/r2" has
logs corresponding to third engine running on second node. Engine unique information (such
as local storage of this engine) is logged here

l Parametric analysis log:
This log file is located in '<workdir>/<jobid>/r<nodeIndex>/r<coreIndex>' folder and
corresponds to Desktop's local-machine parametric 'batchsolve'. It is available only at the end
of analysis and contains information regarding the variations solved by this engine and any
info/warning/error messages.

l Root desktopjob.log:
This is the top-level log that logs job distribution information such as hierarchical activation and
the list of nodes assigned to this job

l GMspecific extraction
In R14, GMextraction is OFF, by default. It can be turned on through setting environment
variable “ANSOFT_ENABLE_GM_EXTRACTION” to a value of 1

Related Topics

Large Scale DSO for Parametric Analysis

Large Scale DSO Deployment/Configuration

Linux Cluster configuration
l Shared drive for projects: Cluster must provide a shared drive that hosts job inputs - the
submitted project must be located on a shared drive (for example, a sub-folder of user’s home
directory). The shared-drivemust accessible using the same path on every node of cluster

l 'Temp directory' configuration
Temp directory is either on ‘local storage’ or on storage that has equivalent speed
characteristics i.e. the I/O rates of the storage should be invariant to network traffic
Temp directory on a host has sufficient space to hold results database for the variations that
are solved on it. Note:
This storage is freed at the end of the analysis
The amount of required space depends on the number of engines per node and the
cumulative variations solved on this node
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The amount of required space depends on the project’s compression-options. For e.g. if ‘Save
Fields’ of a parametric setup isOFF, the space requirement is smaller by the amount of space
taken up by field solution data

l ANSYS Electromagnetics RSMenvironment: In the case of supported scheduler
environments, there is no extra configuration needed. In the case of Ansoft RSMenvironment,
following additional steps are needed:
Ansoft RSMmust be running on all the nodes of cluster. The credentials of ‘RSM service’
allow read/write to shared drive. Reason: the remote engine processes are launched using
the credentials of RSM service
Registration of 'desktopjob.exe' with RSM service: ‘desktopjob’ programmust be registered
with ANSYS Electromagnetics RSMusing 'desktopjob -regserver". To ensure that the
registration is successful, check that the ‘desktopjob’ entry in '<RSM-installation-
folder>/AnsoftRSMService.cfg' file is valid.

Note Linux-specific critical note: Edit AnsoftRSMService.cfg and replace ‘desktopjob.bin’ with
‘desktopjob’

Major limitation: In the Ansoft RSMenvironment, Large Scale DSOcan only be enabled for one
product.
Troubleshooting hints (Ansoft RSMenvironment only): “shared drive read/write” requirement is a
new constraint introduced in Large Scale DSO. So if a user runs into a situation where Regular DSO
jobs run and Large Scale DSO jobs fail, one possible cause for the failure: RSM service does not
have privileges to read and write to project folder located on shared-drive.

Windows Cluster configuration
All the above steps apply, except for steps that are stated as Linux-specific. Additional instructions:

l Ansoft RSMand ANSYS Electromagnetics products are either installed locally on each node
of cluster (i.e. local installation) OR installed on a single shared-drive available to all nodes of
cluster (i.e. network installation)

l Registration of 'desktopjob.exe' with RSM service:
l Network installation: desktopjob.exe is registered with RSM service once, on any of the nodes
of cluster

l Local installation: Since each node has it's ownRSM installation, desktopjob.exemust be
registered with RSMon each node.
Note IMPORTANT! Ansoft RSM servicemust be started using the credentials of a non-

system 'admin' account, which has read/write permissions to project's shared drive.
If RSM service runs as 'system' user, large-scale-dso jobswill fail

Heterogeneous Cluster configuration
Limitation: Currently heterogeneous cluster (with both linux and windows nodes) is not supported.
This is due to the shared drive requirement.

Related Topics

Large Scale DSO for Parametric Analysis
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Known Issues for Large Scale DSO

Cluster configuration (shared drive requirement): The input files (project, etc.) must be present on a
shared drive that is accessible from every node of the cluster.
Note: this item is actually listed as a requirement.

Related Topics

Large Scale DSO for Parametric Analysis

Troubleshooting for Large Scale DSO

(Linux only) Deployment/Installation errors (such asmainsoft related or related to deployment
configuration) are not captured. If there is such an issue, Large Scale DSO job will fail without useful
messages in the logs
Report-based extraction failsmysteriously if traces and parametric-setup are not 'prepared' as per
the Getting Started guides.

Job monitoring and control

Job Abort: When a Large Scale DSO job is aborted, all results are lost (this will be fixed in R14 patch)
Job re-start: There is no provision for stopping and re-starting a job. A new job does not reuse solved
results - always solves all rows in the table. So an abort or failure of a job re-starts from the
beginning, unless a new parametric table with the unsolved rows is created

Job outcome

Job status: The exit code of job doesn’t indicate success or failure correctly. The error messages
frommultiple log files needs to be combined to determine the reason for failure. In many situations,
the reason for a failure is apparent only after re-running the job after turning ON the 'debug logging'
In some Linux scenarios, the analysis appears to finish successfully with valid results, except that the
exit code is ‘134’. In this case, although the exit is abnormal, the failed exit code can be ignored
Load Balancing: For models with 'unbalanced variations table' (i.e. variations that take considerably
different amount of time to solve are clustered in few regions of table), job will take longer time to
solve than a Regular DSOas the job's overall completion time is determined by the slowest solving
region.
Workaround: rearrange the rows in the parametric table so that each region takes a similar time to
solve
GMSpecifics: themodel used for ‘Report-based extractor’ jobs is NOT compatible with the ‘ANSYS-
extractor-for-GM’ jobs. A valid model for ANSYS-extractor-for-GM cannot contain any of: reports,
overlay plots, optimetrics calculations.
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Related Topics

Large Scale DSO for Parametric Analysis

Large Scale DSO Theory
The parametric analysis command in Desktop computes simulation results as a function of model
parameters, such as geometry dimensions, material properties and excitations. The parametric
analysis is either performed on a local machine, where each variation is analyzed serially by a single
engine, or distributed acrossmachines through a DSO license. Desktop's DSOanalysis runs
multiple engines in parallel, thus generating results in a shorter time. In the Regular DSOalgorithm,
the parametric analysis job (Desktop) runs onmaster node, which in turn launches one or more
distributed-parallel engines on eachmachine allocated to the job. Desktop distributes parametric
variations among these engines running in parallel. As variations are solved, the progress/messages
and variation results are sent back to Desktop, where they are persisted into the common results
database onmaster node, as illustrated below:

Regular DSO Bottleneck
As per above illustration, Regular DSO's speedup is limited by the resources of the centralized
'Desktop' bottleneck. It's been observed that DSObecomes unreliable at a certain point, as the
number of engines and number of variations is increased. The term ‘large scale parallel’ can be used
to define this tipping point. For a givenmodel, a ‘large-scale parallel’ job denotes scenarios, in terms
of the number of distributed-parallel engines and the number of parametric variations, where the
Regular DSO runs into centralized bottlenecks that result in one or both of: progressively smaller
speedups, unreliability.
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With the advent of economical availability and timely provisioning of compute resources, product
designers have access to large compute clusters to run their simulations. And they are throwing
larger and larger number of compute resources at simulation jobs, in order to obtain results faster.
The parametric DSOneeds tomeet this challenge and target linear speedup for 'large-scale parallel'
jobs. The Large Scale DSO feature is targeted towards 100% reliability and linear speedup of large-
scale parallel DSO jobs.

Key Algorithms/Concepts for Large Scale DSO
l Embarrassingly Parallel algorithm: Large Scale DSOexploits the embarrassingly parallel
nature of parametric runs. The solve of each variation ismade fully independent of another
variation, by replacing Regular DSO's centralized database with per-engine distributed
databases

l Distributed databases: For each distributed-parallel engine, the database of the input model
is cloned to local storage of engine's compute node (as illustrated in the following picture).
Parallel analysis is performed on these clonedmodels and the analysis results also go the
corresponding location on local storage. As each engine has its own database, there is no
‘shared database’ contention between any two engines. There is negligible network traffic as
analysis/computations are contained in a singlemachine and use just the ‘local resources’.
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l Hierarchical activation of engines: In the Large Scale DSOalgorithm, engine activation is
done hierarchically, where the overhead of launching of engines is also shared across the
nodes. Such hierarchical activation improves reliability of the activation phase of large-scale
parallel jobs. A new 'desktopjob' program encapsulates hierarchical activation, as illustrated in
the below pictures. In this approach, the 'root' desktopjob (Root DJ) activates a 'level-one'
child desktopjob (DJ(L1)) for each unique node allocated to the DSO job. Each level-one
desktopjob activates one or more 'leaf' desktopjobs (DJ(L2)) equal to the number of
distributed engines per node. A leaf desktopjob in turn runsDesktop in batchmode, to perform
local-machine parametric analysis to solve the variations assigned to this engine.

l Decentralized Load balancing: A parametric table is divided into regions of equal number
of variations, with the number of regions equal to the number of engines. In the below
illustration, the analysis of 30 parametric variations is distributed among 5 engines. Each
engine solves it's assigned region as a ‘local machine’ parametric analysis. Large Scale DSO
job is considered done once all engines are done with their assigned variations.

l Distributed results postprocessing: As engine is done with the solve of a variation, it
extracts results for the solved variation before progressing to the analysis of next variation.
The extracted results are saved to the local storage.When the engine is done with analysis of
all variations, the extracted results are transferred from local storage to the results folder of the
input project.

Interactive Scheduler Jobs
This section includes information and guidelines for users running interactive scheduler jobs on
Linux.
In most cases jobs run under a scheduler run as a batch job. These jobsmay be submitted using the
ANSYS Electromagnetics Desktop job submission GUI, using cluster job submission commands on
a command line or using a cluster GUI, if available.
An alternativemethod for submission of scheduler jobs can be used. For convenience, such jobs are
referred to as “interactive scheduler jobs”. In this approach, the user submits an interactive job to the
scheduler. From the interactive job prompt, the user launches an ANSYS Electromagnetics Desktop
product, which starts in interactive (GUI) mode, not batchmode. The user then selects a project and
runs one or more analysis commands using theGUI. The intent is that these analysis commands
should use all resources allocated to the job, whether on the same host as the GUI or on other hosts.
This approach is supported on Linux, where the user may set up an XWindow System server for
interacting with the ANSYS Electromagnetics Desktop product GUI. The user needs to configure
the cluster environment and/or the interactive environment so that the user may view and interact
with the product GUI. This approach is not supported onMicrosoft Windows.

Related Topics

Specifying Options for Interactive Scheduler Jobs
DSOConfiguration for Interactive Scheduler Jobs
Design TypeOptions for Interactive Scheduler Jobs
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Specifying Options for Interactive Scheduler Jobs

Batch scheduler jobs use command line options for specifying options rather thanGUI controls. For
interactive scheduler jobs, optionsmay be specified on the command line, using GUI controls, or
obtained from the registry. Themachines specified in theConfigurations tab of theHPC and
Analysis Options dialog will be ignored for interactive scheduler jobs. If the command line used to
launch the product contains a list of specificmachines (using option -machinelist list=...), then the job
will use the specifiedmachines and cores. If the command line used to launch the product does not
contain a specificmachine list, then themachines and cores allocated to the job by the scheduler will
be used for the job. In general, the job distribution settings for interactive scheduler jobs should be
specified on the command line, instead of using theHPC and Analysis Options dialog.

l TheUI shows the settings that will be used for analysis, even if they come from the command
line, not the registry.

l If youmake changes to the settings in the UI, and the changed settingswill be used for the
analysis, even if the changed settings conflict with the command line (including batchoptions).

l If youmakes no changes to the settings in the UI, then the command line settings (including
batchoptions) will be used for analysis.

Batchoptions settingswhich are automatically generated for batch jobs submitted using the ANSYS
Electromagnetics job submission GUI will need to bemanually included in the product command
line. Some use cases require that certain settings bemade on the command line when the product is
launched, rather than using theGUI.

Batchoptions for Interactive Scheduler Jobs
For interactive scheduler jobs, only a limited set of batchoptions are supported. These batchoptions
correspond to the DSOconfiguration options, the batchoptions corresponding the design type
options, and the following additional options for each design type:

l NumCoresPerDistributedTask
l RAMLimitPercent
l RAMLimitPerCoreInGB
l SolveAdaptiveOnly
l TotalNumOfCores

Any other batchoptionswill result in a warningmessage and will be ignored.
Example

ansysedt -batchoptions " 'TempDirectory'='C:\\TEMP'

'HFSS/SelectedDSOConfiguration'='Local'

'Desktop/Settings/ProjectOptions/DoAutoSave'=1

'LargeScaleDSO/MaxFolderInMB'=100 "

The following sections includemore detailed information on these issues.
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DSO Configuration for Interactive Scheduler Jobs

When running an interactive scheduler job, there is only one DSOconfiguration available for each
design type. Each configuration is named “Interactive Scheduler Job”. This configuration is always
the active configuration for an interactive scheduler job. and it is the only configuration displayed in
the list of available configurations shown in theHPC and Analysis Options dialog. No
configurations can be added or removed, but the "Interactive Scheduler Job" configurationmay be
modified using the "Edit" button, which pops up theAnalysis Configuration dialog.
Because the “Interactive Scheduler Job” configuration is the only configuration accessible for
interactive scheduler jobs and it is not accessible in other modes, there is no sharing of the
"Interactive Scheduler Job" configuration settingswith other modes.

Major differences between interactive scheduler mode and batchmode or normal interactivemode
are:

l In interactive scheduler mode, DSOconfiguration settings and design type options in the UI
override command line options and batchoptions.

l When not in interactive scheduler mode, DSOconfiguration settings and design type options
specified on the command line (including batchoptions) override UI settings.

Analysis Configuration - Machines Tab
Themost obvious changes for interactive scheduler jobs are visible in theMachines tab of the
Analysis Configuration dialog. The grid of machine information is pre-populated with the list of
machines allocated to the job. It also contains an additional column in interactive scheduler mode.
This column, "Allocated Cores", indicates the number of cores allocated to the job by the scheduler
on each host. You cannot add or removemachines from the list, or modify the allocated cores for any
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machines. You canmodify the tasks, cores or RAM limit for anymachine, or specify that amachine is
enabled or disabled.

Analysis Configuration - Job Distribution Tab
The Job Distribution tab of theAnalysis Configuration dialog only appears if the "Use Automatic
Settings" checkbox is not checked. The state of this checkbox, and the settings shown on this tab are
initialized from the command line or from the registry. The command line options that affect the "Use
Automatic Settings" checkbox or the job distribution settings are:

l -distributed
l -local
l -auto
l -machinelist

The registry contains the last value of these settings for an interactive scheduler job for the same
user on the same host. Settings on the command line override settings from the registry. Any
changes in the GUI will override the initial settings, even if the initial settings are from the command
line. Any changes in the GUI also update the registry settings for the "Interactive Scheduler Job"
configuration for the current design type.
Example

ansysedt -distributed includetypes=default maxlevels=2 numlevel1=3
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Initial "Job Distribution" settings:

Analysis Configuration - Options Tab
You can use theOptions tab of theAnalysis Configuration dialog to examine or modify the DSO
configuration options. The DSOconfiguration options are handled like the design type options,
except that the Interactive Scheduler Job configuration settings are not shared with other modes.
The settings on this tab are initialized from the command line (using the -batchoptions
command line option) or from the registry. The registry contains the last value of these settings for an
interactive scheduler job for the same user on the same host. Settings on the command line override
settings from the registry. Any changes in the GUI will override the initial settings, even if the initial
settings are from the command line. Any changes in the GUI also update the registry settings for the
"Interactive Scheduler Job" configuration for the current design type.
Example

ansysedt -batchoptions 'HFSS/AllowOffCore'=0

Design Type Options for Interactive Scheduler Jobs

You can use theOptions tab of the HPC and Analysis Options dialog to examine or modify the
design type options. The settings on this tab are initialized from the command line (using the -
batchoptions command line option) or from the registry. The registry contains the last value of these
settings for the same user on the same host. Settings on the command line override settings from the
registry. Any changes in the GUI will override the initial settings, even if the initial settings are from
the command line. Any changes in the GUI also update the registry settings for the current design
type.
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These settings are shared between interactive scheduler mode and other modes.
Example:

-batchoptions 'HFSS/HPCLicenseType'='Pack'

Distribution Command Line Options

The user should include options specifying how the job should be distributed in the command line.
These command line optionswill override options specified using theHPC and Analysis Options
dialog or obtained from the registry. Refer toRunningMaxwell From aCommand Line for more
information on command line options.
For both scheduler batch jobs and interactive scheduler jobs, the -MachineList num=<num
distributed tasks> format is themost commonway to specify the number of tasks for the job. The
other formats (-MachineList list=... or -MachineList file=...) allow the user to specify the number of
tasks and cores to use on each host. These formatsmay be useful with clusters of heterogeneous
machines, by allowing the user to specify different numbers of tasks or cores for different hosts. If
either of the latter two formats is used, the user must ensure that the hosts and cores specified on the
product command line are compatible with the hosts and cores allocated to the job.

Batchoptions for Interactive Scheduler Jobs
For interactive scheduler jobs, only a limited set of batchoptions are supported. These batchoptions
correspond to the DSOconfiguration options, the batchoptions corresponding the design type
options, and the following additional options for each design type:
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l NumCoresPerDistributedTask
l RAMLimitPercent
l RAMLimitPerCoreInGB
l SolveAdaptiveOnly
l TotalNumOfCores

Any other batchoptionswill result in a warningmessage and will be ignored.
Example

ansysedt -batchoptions " 'TempDirectory'='C:\\TEMP'

'HFSS/SelectedDSOConfiguration'='Local'

'Desktop/Settings/ProjectOptions/DoAutoSave'=1

'LargeScaleDSO/MaxFolderInMB'=100 "

Batchoptions
Batchoptionsmay be specified in the command line used to launch the product. Any batchoptions
specified in the command line will override the associated registry settings. Batchoptionswill also
override options specified using HPC and Analysis Options dialog or other dialogs used to specify
options.

Setting the Number of Cores per Distributed Task
When submitting a job using the ANSYS Electromagnetics job submission GUI, the number of cores
per distributed task for a job is specified using the batchoption with pathname
'DesignType/NumCoresPerDistributedTask', where DesignType is the Design Type to analyze. The
batchoption setting is automatically included in the product command line when the job is submitted
to the scheduler. For interactive scheduler jobs, the user must include the associated batchoption
setting or settings in the product command line when the product is launched. Multiple batchoption
settings are required if the user analyzesmultiple design types using the same product process.
Batchoptions are the only way to specify this setting.

Setting the Ram Limit Per Core in GB
When cores and RAMper core are requested, the cores could be allocated in an arbitrary/non-
uniformway across nodes that themselves could be non-uniform/heterogeneous. For example,
nodes could range from 4 cores to 20 cores and from 64GB to 384GB. In such environments, the
RAMpercentage set in the HPC configuration, Job Submission Compute Resources, or batch
optionmay not be appropriate. In such cases, you can use the batchoption for
RAMLimitPerCoreInGB. This setting specifies theMaximumamount of RAMused for each core
allocated by the scheduler in GB. This batchoption cannot b e combined with RAM limit percent and
is only valid when solving in a Linux scheduler environment.
The scheduler GUI automatically passes this new batch option instead of percent limit. From a
scheduler GUI, such a request is available only for auto.
You can also use this new batch option for command line submission. The desktop does the
computations and passes the percent limit to product/solver.
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Setting the Remote Spawn Command Option to Scheduler
When submitting a job using the ANSYS Electromagnetics job submission GUI, the Remote Spawn
Command for an analysismay be specified using the batchoption with pathname
DesignType/RemoteSpawnCommand, whereDesignType is the Design Type to analyze. The
Remote SpawnCommand setting is onlymeaningful when running on the LinuxOperating System.
The value “Scheduler” is valid if the job is a scheduler job running under an LSF or SGE scheduler,
and only if theMPI Vendor is “Inte”'. To specify the value “Scheduler” for this option for an interactive
scheduler job, the Remote SpawnCommandmust be specified using the
DesignType/RemoteSpawnCommand batchoption in the product command line when the product is
launched. In addition, theDesignType/MPIVendor batchoptionmust be specified with value “Intel”
in the product command line when the product is launched. Batchoptions are the only way to specify
the value 'Scheduler' for the remote spawn command.

Monitoring the Solution Process
While a simulation is running, you canmonitor the solution's progress in theProgresswindow.
Above the green progress bar, messages describe the setup and step. The progress bar shows the
relative progress of each step. Under the bar, messages note the part of the design being solved,
and givememory estimates during the factoring process.
You can also view the following solution data at any time during or after the solution:

l The convergence data:
l Thematrices computed for the S-parameters, impedances, and propagation constants.
l A profile of status of the adaptive analysis, including the number of valid passes completed.

To view the Solutionswindow:
1. Right-click the solutionSetup in the project tree.

A shortcut menu appears.
2. Select Convergence, Solution, Matrix Data, Profile, or Mesh Statistics from the

shortcut menu.
TheSolutionswindow appears with the corresponding tab selected and the current data
displayed.

For "out of core" problems, quite different amounts of memorymay be used for factorization and for
solution. So if the amount for factorization is displayed under the progress bar and the amount used
is calculated for the profile at the end of the solution, theymay be quite different numbers.
To view the status of the adaptive analysis:

l ClickMaxwell>Results>Browse Solutions.
TheSolutions dialog box appears with theBrowse tab selected. It displays data about the
number of valid passes completed. It contains a tree structure showing the solutions listed
according to Setup, Solution, and Variation. A table lists the Setup, the solution, the sweep
variable, and the state of the solution.

l You can use theProperties button to display a dialog that lets you change the way the Setup,
Solution, and Variation are listed in the tree structure of theSolutions dialog.
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l TheStatistics tab of the Solutions dialog displays path information, as well as format,
number of files, and size.

l You can delete one or more solutions by selecting from the table and clickingDelete. Click on
a solution to select it, and use Ctrl-click to select multiple solutions, or Shift-click to select a
range of solutions. You can also select all solutions using theSelect All button.
Note If Maxwell loses its license, it waits for the license to be regained, checking every 2

minutes or until you abort.

Related Topics

Aborting Analyses
Deleting Solution Data
Post Processing andGenerating Reports
Creating Reports
Modifying Reports
Creating aQuick Report
Plotting theMesh
Plotting Field Overlays

High Performance Computing (HPC) Integration
ANSYS Electromagnetics products offer a direct integration with a number of High Performance
Computing (HPC) software programs. This direct integration does not require ANSYS
Electromagnetics RSMService. The list of currently-supported HPC software includes:

l Platform’s Load Sharing Facility (LSF)
l Microsoft Windows® HPC Server
l PBS Professional fromAltair Engineering
l Grid Engine (GE)
l ANSYS RSMCluster (ARC)

You can also do custom integration.

Note For additional information about high performance computing not in this guide, see the
ANSYS Electromagnetics HPC Administrator's Guide (HPC_Admin.pdf) in
<installdir>/AnsysEM<release_number>/[Win64 or Linux64]/Help.

A job scheduler may also be described as a batch system, a Distributed ResourceManagement
System (DRMS) or Distributed ResourceManager (DRM). The features supported on each
scheduler are included in the documents for each. For each job scheduler, the versions or revisions
that have been tested are included.
HPC Computing integration for ANSYS Electronics Desktop supports Lustre FS. However, ANSYS
doesn't support having Linux home directories stored on Lustre FS. (This is a limitation due to the
wayMainWin writes temporary/config files into the home directory.)
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A user may submit jobs using the command line tools or other tools provided by the scheduler. The
Desktop includes aGUI to help the user submit jobs to a job scheduler. This generic Job Submission
GUI is shared across the ANSYS Electromagnetics products.

The general procedure is to specify the scheduler and head node, describe and submit the job, and
monitor the results.
TheSubmit Job To dialog contains three tabs:
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l Analysis Specification--specify the Product path, Project name, the setups, and analysis
options such as batchoptions, or, for advanced users, Environment variables. The Project can
be an archive. The project file pathnamemust be a UNC path that is accessible from each
compute host used for ANSYS Electromagnetics jobs.
The Product path and Project fields support mapped drives. This is done through a checkbox
in the Specify Product Path dialog displayed when you click the ellipsis [...] button. A checkbox
lets you "Use converted UNC path if mapped drive specified." If you select a project or product
on amapped drive, and check the option, the converted UNC path equivalent to themapped
drive pathname is used.

l Compute Resources--specify whether to use automatic settings, resource selection
parameters, and if, you do not use automatic settings, job distribution parameters.

l Scheduler Options--specify for Job name and priority.
There are two ways that the GUI may be used to submit jobs.

l The first mode requires that the Desktop (UI) process run on a host which is also a submission
host for the job scheduler. Thismode is called local mode or workingmode.

l The secondmode is useful for cases in which the submission hosts are not able to run
graphical processes, such as the Desktop. The secondmode is only supported on Linux in the
ANSYS Electromagnetics Suite 18.0 release. In the secondmode, an administrator
configures the RSMService to act as an interface to the job scheduler, and starts the RSM
Service on a submission host for the cluster. The user runs the Desktop (UI) process on
another host (whichmay be called the postprocessing host). To submit a job, the user
specifies the host where the RSMService is running, and the Desktop process connects to
the RSMService over the network to submit the job. In thismode, some configuration is
required, and the RSMService typicallymust run as a privileged user (e.g., root), so that it can
launch processes as any user.

Import and Export Configurations
The bottom of the Job Submission GUI has buttons for Import..., Export..., and Import Configuration
let you save a configuration for each solver type.

l TheExport button exportsmost of the settings of this dialog (all tabs) to a file.
l The Import button updatesmost of the settings in this dialog (all tabs) from a file.
l The Import Configuration button updates the DSOsettings in this dialog from anyDSO
configuration as shown in theConfigurations tab of theHPC and Analysis Options dialog.
TheDesign Type of the DSOconfigurationmust match the design type of one of the designs
in the project, so the "Project" must be specified before using the Import Configuration
button. The batchoptions are also set from the specified DSOconfiguration or from the Design
Type options settings, which are shown in theOptions tab of theHPC and Analysis
Options dialog.
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TheExport and Import buttonsmay be used to save and then restore a frequently used collection
of job submission settings. TheSave Settings as Default buttonmay also be used to save the
current settings, but it always overwrites any previously saved settings. Using theExport button, the
user may savemultiple sets of settings, or may transfer the settings to another machine.
TheSelect Scheduler dialog also hasExport and Import buttons. These buttonsmay be used to
save the settings in this dialog to a file or restore them from a file.
An Exported configuration is namedSubmit_Job_Settings by default and has an .areg suffix. A file
browser window opens in the project folder and lets you name an exported file and location, and
select an .areg file to import.

Related Topics

Scheduler Terminology
What a Scheduler Does
Installation of ANSYS Electromagnetics Tools
ANSYS Electromagnetics Jobs
Submitting andMonitoring ANSYS Electromagnetics HPC Jobs

Scheduler Terminology
l Core: unit of processing
l Processor: consists of one or more cores
l Machine/Host/Node: consists of one or more processors, memory, disk, etc.
l Resource: Machines, licenses, etc. that are used by a Job
l Job: Application (also called: program, executable), with command line options, that uses
resources to produce useful results. For example, maxwell.exe –ng –BatchSolve…

l Serial Job: job that runs on a single core
l Parallel Job: job that runs onmultiple cores (belonging to same or different machines)
l Compute Cluster: network of machines on which Jobs run. Typically, consists of head node(s)
andmany compute nodes

l Service: Program that runs in the background (e.g., RSMService). ‘Listens’ on a ‘port’. OS
provides programming interface bywhich Applications communicate with service, once
machine and port number are known. Launching an executable on remotemachine, requires
a service to run on remotemachine.

ANSYS Electromagnetics Suite Terminology
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l Desktop: Themain application used to accomplish a task, such asMaxwell. The desktopmay
run as aGUI or it may run as a batch command.

l Engine: Application (the executable) that is launched by analysis commands, to generate
analysis results.

l Multi-processing: A single engine usesmultiple cores on the samemachine.
l Distributed-processing: Multiple engines are launched simultaneously (on samemachine or
different machines). Uses ansoft_distrib (and related) license.

Related Topic
What a Scheduler Does
Command Line Enhancements for ANSYS Electromagnetics Suite Desktop Products
High Performance Computing (HPC) Integration

What a Scheduler Does

l Enables effective/efficient utilization of cluster’s resources consistent with organization’s goals

l Maintains queue(s) of jobs
l Maximizes throughput of the jobs by processing all jobs as fast as possible
l Typically, one job per cpu policy
l Allows choice of various scheduling policies (e.g. First Come First Serve, Priority Based,
Preemption)

l Provides a suite of tools or utilities (graphical or command line) for end user to submit jobs,
monitor jobs, abort jobs, suspend jobs,…

l Manages a compute cluster by running various interacting ‘services’ on head nodes and
compute nodes

l Provides a programming interface to access ‘services’
Scheduler Managed Compute Cluster
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Head node(s) typicallymaintains queues. Compute nodes are typically on a high speed network, to
improve scalability of parallel jobs. Services running on nodes interact with each other to manage
resources. End user tools communicate with services to submit/abort/suspend/etc. jobs.
Related Topic
High Performance Computing (HPC) Integration
Command Line Enhancements for ANSYS Electromagnetics Desktop Products

Installation of ANSYS Electromagnetics Suite

ANSYS Electromagnetics Suite must be available on each cluster host where jobsmay be run.
l On a LINUX platform, ANSYS Electromagnetics Suite may be installed on a shared drive, that
is accessible to all machines in the cluster.

l On aWindows platform, ANSYS Electromagnetics Suite must be installed separately on each
host of the cluster.

The ANSYS Electromagnetics Suite must be accessible using the same path on each host. All
cluster users running ANSYS Electromagnetics jobsmust have permission to read and execute the
files in the installation directory and its subdirectories.
The Temp directory selected during installationmust be readable and writable by all user accounts
used to run the ANSYS Elctromagnetics Suite. This temp directory path should be the same on all
machines of the cluster and should be local to everymachine. For example, c:\temp onWindows,
/tmp on LINUX
Because HPC is offered as a direct integration, you need only install the ANSYS Electromagnetic
Suite software. No additional configuration is required.
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Example
Install the ANSYS Electromagnetics Suite in directory C:\ProgramFiles\AnsysEM\ on each node of
the cluster. The same directory pathnamemust be used on all hosts.

Related Topics

High Performance Computing (HPC) Integration
Firewall Configuration
Installation Directory Examples

Firewall Configuration

If firewall is turnedOFF between themachines of the cluster, there is no need for any configuration.
If firewall is turnedON, you, or a system administrator, should perform the steps below.

l Windows cluster: Configure firewall by adding exceptions that allow ANSYS
Electromagnetics Suite programs and services to communicate with each other. If you are
using standardWindows Firewall, this is automatically done for you, by the ANSYS
Electromagnetics installation program. On the other hand, if you are using a 3rd-party firewall
software, it needs to be configured in a similar manner.

l Linux cluster: Open up the firewall for range of ports denoting ephemeral (or dynamic) ports.
Checkwith your system administrator on how this can be done on eachmachine of cluster.

Related Topics

High Performance Computing (HPC) Integration
Installation Directory Examples
Using ANSYS EMHPC Diagnostics tool

Installation Directory Examples

Microsoft Windows Example
Install the ANSYS Electromagnetics Suite in directory C:\ProgramFiles\AnsysEM\AnsysEM18.0 on
each node of the cluster. The same directory pathnamemust be used on all hosts.

Linux Example
Install the ANSYS Electromagnetics Suite in a common directory that is accessible using the path:
/opt/AnsysEM/AnsysEM18.0 on each execution node of the cluster.

Related Topics

High Performance Computing (HPC) Integration
Firewall Configuration
ANSYS Electromagnetics Jobs
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Using ANSYS EMHPC Diagnostics tool

ANSYS Electromagnetics Jobs

For most cluster environments, an ANSYS Electromagnetics job will consist of an ANSYS
Electromagnetics Desktop running in non-graphical mode, performing a batch solve. The user will
submit the job to the scheduler, specifying an ANSYS Electromagnetics Desktop command line to
be executed on the cluster. For some schedulers, the user may or must specify a script to run instead
of specifying the ANSYS Electromagnetics Desktop command line; in these cases, the script will
contain the corresponding ANSYS Electromagnetics Desktop command line. When the resources
requested for the job are available to the job, the scheduler will start the job. In many cases, the user
submitting the job will not know which host or hosts are allocated to the job.With direct integration, if
the ANSYS Electromagnetics job is a distributed job, the ANSYS Electromagnetics Desktop will
query the scheduler for the hosts allocated to the job, and it will use the scheduler facilities to launch
the distributed engines.

Related Topics

High Performance Computing (HPC) Integration
RunningMaxwell from aCommand Line

Integration with Microsoft Windows® HPC Scheduler

TheWindowsHPC scheduler is only supported onWindows. Jobsmay be submitted in any of the
following ways:

l Using theWindowsHPC GUIs fromMicrosoft: JobManager or Cluster Manager
l Using theWindowsHPC command line tools (job, etc.)
l Using the Desktop UI commands for Scheduler selection, Job submission and Job
monitoring/control. You specify theWindowsHPC Scheduler User Interface for Submit Job
by clicking Tools>Job Management>Select Scheduler...

Before you can useSubmit Job, youmust clickSelect Scheduler as the one-time initial step. This
opens the Select Scheduler dialog
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Specify the following parameters:
l ChooseUse this computer if scheduler commands are enabled on the post-processing
node.
In the "Choose scheduler" combobox, select the scheduler. If WindowsHPC Integration with
the generic job submission GUI is not enabled, this itemwill not appear in the dropdown list.
Head node: this is the node on the cluster where scheduler commands are allowed to run.

l ChooseUse a computer on network if the cluster is configured in amanner as to disallow
job-submission from the post-processing node. Specify node name appropriately. the ellipsis
button[...] opens a dialog for you select from the network.

After specifying the job submission node, you can clickRefresh. This verifies that the head node
may be contacted, and displays the scheduler name, a brief description (including the head node
name), and the version of theWindowsHPC head node.
PressingCancel discards changesmade in this dialog. PressingOK verifies that the head node can
be contacted before accepting the changes. If no problem occurs, the dialog will be closed. If there is
a problem contacting the head node, the dialog will not be closed and the changes are not accepted.
Once you select a scheduler, you can access the interface for job submission, monitoring and
control. ClickOK to close the dialog.
See the ANSYS Electromagnetics SuiteWindows Installation Guide for additional information on
supported schedulers.

General Guidelines for Submitting ANSYS Electromagnetics Jobs
A Job submitted toWindowsHPC Cluster is defined by Job properties, Task List and Task
properties. Priority, resource requirements, node preferences, etc. come from Job properties. In the
case of ANSYS Electromagnetics jobs, Task List consists of a single task. Properties of this task
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specify command line that runs ANSYS Electromagnetics Desktop in non-graphical mode to
perform analysis of an ANSYS Electromagnetics project.

Specifying the Number of Compute Resource Units for HPC Jobs
In the old setup you had to list machinesmultiple times, and figure out how many cores per task on
eachmachine in order to set Number of Processors Distributed to the smallest of these. In the new
setup, you just enter the number of tasks and total cores per machine.

ANSYS Electromagnetics Project File and Project Directory for use with Windows HPC
Scheduler
ANSYS Electromagnetics Suite tools write their results to a subdirectory of the directory containing
the ANSYS Electromagnetics project file. The Project Directory (the directory containing the project
file) must be accessible to all of the cluster hosts that may run ANSYS Electromagnetics jobs. The
user account for the jobmust have permission to read the project directory, and to create andmodify
files and subdirectories of this directory. The pathname of the project file must be accessible to all
cluster hosts using the same path name, which is generally expressed as a UNC pathname.
Example:
The project file is on the user’s workstation (with hostname user1_PC) in directory
C:\user1\projects\new\project1.mxwl, and the directory C:\user1\projects is shared with sharename
projects.
Correct
When submitting the job, you should use the following pathname to specify the project file:

\\user1_PC\projects\new\project1.aedt

Incorrect
If a local pathname is used, the cluster hosts will not be able to find the user’s project on the
workstation

user1_PC: ' C:\user1\projects\new\project1.aedt'

Related Topics

Windows® HPC Job Templates
Selecting Computation Resource Units (Job Unit Type)
Windows® HPC Job Credentials

Submitting and Monitoring ANSYS Electromagnetics HPC Jobs

Jobsmay be submitted to theWindowsHPC Scheduler using any of the followingmethods:
l Using theSubmit HPC Job dialog
l Using theWindowsHPC JobManager GUI
l Using theWindowsHPC Command Line Tools
l Using theWindowsPowerShell
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Client Utilities from theMicrosoft HPC Pack, must be installed on the submit host to use any of these
methods to submit a job to a cluster. The Submit HPC Job dialog will be unable to contact the
cluster head node if the client utilities are not installed.
This document covers the first method. See theMicrosoft documentation for information on the other
threemethods.

l Submitting andMonitoring Jobs for WindowsHPC
l Specifying the Number of Compute Resource Units for HPC Jobs

Jobsmay be submitted from anyMicrosoft Windows host meeting the following requirements:
l For submitting jobs to theWindowsHPC scheduler, the Desktop processmust run on a node
that is configured for submission of jobs to theWindowsHPC cluster. That is, theWindows
HPC Client Utilitiesmust be installed on the node, and network communication from the
Desktop node to the head node of the cluster must be allowed. For ANSYS Electromagnetics
Suite 18.0, WindowsHPC Server 2008 R2 (or later) client utilities are required. Using a
computer on the network is not supported for submission of jobs to theWindowsHPC cluster.

l When submitting jobs to aWindowsHPC cluster, the user must also specify the head node of
the cluster to which the jobswill be submitted.When the user selects the "WindowsHPC"
scheduler in the "Choose scheduler" list, the Head Node edit control is enabled. The user may
enter theWindowsHPC cluster head node name into the edit box. Alternatively, the head
nodemay be selected using a "Browse for Computer" browser by pressing the "..." button.

l TheWindowsHPC Pack client utilities are installed on the submission host.
l Network communication between the submission host and theWindowsHPC Cluster head
node is permitted; there is a network connection between these hosts that is not blocked by
any firewall or the like.

l The submission user is permitted to submit jobs to theWindowsHPC Cluster.

Job Monitoring
WindowsHPC Jobsmay bemonitored using theMonitor Job dialog which is brought up by the
Tools > Job Management > Monitor Jobs... command. This dialogmay also be brought up by
checking theBegin monitoring this job now checkboxwhen a job is successfully submitting using
the job submission dialog. In addition to the above requirements to allow jobmonitoring the following
is also necessary:

l Network communication between the submission host and allWindowsHPC Cluster nodes
where the jobmay run is permitted; there is a network connection between these hosts that is
not blocked by any firewall or the like

Cluster Configuration
Any job running on aWindowsHPC Cluster that is distributed over multiple compute hosts requires
network communication between processes running on these hosts. The cluster must be configured
to allow this communication. Any firewall or other security softwaremust be disabled or configured to
allow communication between any of the compute hosts were a job could run.

Job Submission User Profile on Cluster Compute Nodes
In order for a job to run correctly, the submission user's profile must be accessible and properly
initialized on the cluster compute nodeswhere the job runs. If the Ansoft/temp subdirectory of the
user's "MyDocuments" directory does not exist or is not accessible on the compute cluster nodes
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where a job runs, the batchoptions for the job will not be processed correctly, resulting in job failure.
One way to ensure that this directory is created on each compute host is for the submission user to
login to each compute host and run the product GUI one time.

Submitting and Monitoring Jobs for Windows HPC

In order to submit jobs using theWindows HPC, youmust clickTools>Job Management>Select
Scheduler to open theSelect Scheduler dialog and specifyWindowsHPC as the Scheduler.

For WindowsHPC, the user must select theUse this computer radio button and then specify the
head node of the cluster.
After specifying the job submission node, you can clickRefresh. This verifies that the head node
may be contacted, and displays the scheduler name, a brief description (including the head node
name), and the version of theWindowsHPC head node.
PressingCancel discards changesmade in this dialog. PressingOK verifies that the head node can
be contacted before accepting the changes. If no problem occurs, the dialog will be closed. If there is
a problem contacting the head node, the dialog will not be closed and the changes are not accepted.
After setting the job submission node, select Tools>Job Management>Submit Job... to open the
Submit Job To: dialog. This contains three tabs:

l Analysis Specification--specify the Project name, the setups, and analysis options such as
batchoptions, or, for advanced users, Environment variables.

l Compute Resources--this tab can be populated either by predefined Analysis
Configuration, or specifying parameters in the fields resource selection, for job parallelization
and enabled forms of parallelization.
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l Scheduler Options--contains fields for Job name and priority. The customization options
shown by checking advanced are not used for WindowsHPC.

In theAnalysis Specification tab, enter the pathnames of the product path and of the project file in
the “Project” edit box. Thesemust be UNC paths that are accessible from each compute host used
for ANSYS Electromagnetics jobs. The Project can be an archive. The submission user must have
permission to write to the directory containing the project file.
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You can select which setups are analyzed in the Analyze Setups section of this dialog. There are
radio buttons to select:

l All setups in the project
l All setups in a specified design: you selects the design from the dropdown list
l Single setup

If you specifymultiple setups, theywill be processed sequentially in the order displayed in the edit
box.
The Analysis options include:

l Monitor job. Youmust enable this option tomonitor the job from the user interface.
l Wait for license- whether to wait until a license if available before starting a simulation.
l Batch options. You can optionally specify -Batchoptions in the text field. See detailed
discussion of -Batch Options beginning under RunningMaxwell from aCommand Line.

TheAdd... button opens theAdd Batchoption dialog.

This dialog provides access to all -Batchoption commands. The drop downmenu lets you select
specific categories, and you can choose to display only frequently used commands. You can edit and
remove any batch options you specify.
Select a Registry Key. in order to show the current Value for the type. The lower field explains the
meaning of the Type Value.
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Any batchoptions for which you select Add will be visible in theSubmit Job dialog.

If you have the Show advanced options box checked in theSubmit Job dialog, the Environment
field and theUse batch extract fields display.

The Environment field lets you specify any Environment variables. Click the ellipsis button [...] to
display theAdditional Job Options dialog.
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Click theAdd... button to open theNew Environment Variable dialog.

Here you can provide a Variable name and Variable value. ClickOK to display the Variable in the
Additional JobOptions dialog. Select a Variable to enables theRemove and Edit.. buttons. You can
also clickAdd Debug Environment Variables.

Any Variables that you add will be displayed in the Environment field of theSubmit Job dialog, if you
have also enabled Show Advanced options.

Use Batch Extract for Windows HPC
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Selecting Show advanced options for WindowsHPC also show theUse batch extract fields.

See the discussion on RunningMaxwell from aCommand line for a discussion of the solve
information available through batch extract.
ThePreview Submission button opens a window that shows the text commands that will be sent to
the scheduler.
For HFSS configurations, the Submit Job dialog includes a Use automatic settings checkbox that
simplifies theCompute Resources tab.
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For Use automatic settings, you can specify Resource selection parameters. The ellipsis button [...]
opens the Compute Resource Selection Parameters dialog. If you do not specify any parameters,
the default is Usingmachines from the entire pool.
TheMethod field of theSubmit Job To dialog has a drop downmenuwith two or three selections,
depending on whetherUse automatic settings is selected:
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Note If you select Use automatic settings, the solver does not support automatic distribution of
variations. The Use automatic settings option does not support Optimetrics variations. It
does distribute frequencies, domains, and use of multiple level domains.

If you do not select Use automatic settings, these twoMethods are listed:

EachMethod selection changes the available options listed.
l Specify Number of Cores and (Optional) RAM

Running Simulations 21-70
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l Number of Nodes and Cores

l Individual Nodes

l Number of Tasks and Cores ("Use automatic settings" is unchecked for this option. Checking
"Use automatic settings" means that you do not have to specify tasks or core parameters.)

Individual Node List
For WindowsHPC jobs, youmay either specify a node list, or specify job parallelization parameters,
but not both.
If you select the Individual NodesMethod, youmay specify a node list, and the Job parallelization
controls are disabled. In this case, the node list should only include cluster nodes that are valid for the
job. For each node, you enter the node name and add the node. In the table, you can specify the
number of cores and the RAM limit as a percentage. You can use the Remove, Move Up andMove
Down buttons to edit and order the list.
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Compute Resource Selection Dialog.
By default, you can draw from the entire pool. You can also click the ellipsis button [...] to open a
Compute Resource Selection dialog.

The resource selection parameters for WindowsHPC jobs are:
l JobTemplate: Job Template - The JobTemplatemay limit the job parameters or specify
defaults values for job parameters

l MinCoresPerNode: MinimumCores Per Node
l MaxCoresPerNode: MaximumCores Per Node
l MinMemoryPerNode: MinimumMemory (GB) Per Node
l MaxMemoryPerNode: MinimumMemory (GB) Per Node
l NodeGroup: Run job only on nodes in the node group
l NotifyOnStart: If True, send email notification when job starts. Email notificationsmust be
configured and enabled for the cluster by the administrator. (The cluster head nodemust run
WindowsHPC Server 2008 or above.)

l NotifyOnCompletion: If True, send email notification when job ends. Email notificationsmust
be configured and enabled for the cluster by the administrator. (The cluster head nodemust
runWindowsHPC Server 2008 or above.)

You can also use the text field to specify a node list.
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Job Parallelization
For WindowsHPC jobs, youmay either specify a node list, or specify the job parallelization
parameters, but not both.The Job parallelization fields let you specify

l Total number of tasks: The number of nodes requested for the job is the total number of tasks
divided by limit on the number of tasks per node, rounded up if it is not an integer.

l Cores per distributed task. This determines the amount of multiprocessing per task.
l Whether nodes are for exclusive usage by this job
l Whether to limit the number of tasks per node to a value. If the "Limit number of tasks per
node" checkbox is not checked, then the job is submitted with a job unit type of "Core".

Job Distribution
l Enabled types, such asOptimetrics Variations, Frequencies, etc.
l Click theModify button to display the Job Distribution dialog.

Enabled Distribution types canmodified here.
Scheduler Options
In theScheduler Options tab provides for specifying the job name and/or the job priority. While the
Show advanced options checkbox enables the display of Job submission options, no job submission
options should be specified for WindowsHPC.
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Preview Submission
The Preview Submission button opens a window that shows a text description of the job to be
submitted and the task used to start the product on one of the nodes.
The JOB PARAMETERS section contains information on parameter that apply to the job as a
whole.

l The "Job resource parameters" section indicateswhether the job has exclusive use of nodes,
the job unit type, and theminimumandmaximumnumber of units requested for the job.

l The "Job attributes" section displays the job name and job priority.
l The "User Specified Compute Resource Attributes" displays the Resource selection settings.

The TASK PARAMETERS section contains information on parameters that apply to the Desktop
task, which is themain task of the job.

l The "Desktop task resource parameters" section indicates the job unit type (which is the same
as in the JOB PARAMETERS), and theminimumandmaximumnumber of units requested
for the Desktop task.

l The "Command Line section" displays the desktop task command line, including all
arguments.

l The "Environment variables" section displays the environment variables that are set for the
Desktop task; the same environment variables will also apply to all other tasks of the job.

l The "Working directory" section indicates the working directory in which the Desktop taskwill
run.

Monitor Job
If you have checked theMonitor Job option on theSubmit Job To dialog,AnalysisSpecification
tab, you can invoke theMonitor Job window by clicking Tools>Job Management>Monitor
Jobs... This dialogmay also be brought up by checking theBegin monitoring this job now
checkboxwhen a job is successfully submitting using the job submission dialog.
Check boxes above themessage field let you filter themessages to include/exclude Errors,
Warnings and Info. You can choose toClear Progress Messages.
You can use check boxes at the lower left to Refreshmanually, or automatically at a specified
interval.
You also have command buttons to perform aClean Stop of a simulation between time steps, or to
Abort Job for a simulation.
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Related Topics

Submitting andMonitoring ANSYS Electromagnetics HPC Jobs
Specifying the Number of Compute Resource Units for HPC Jobs

Windows® HPC Job Templates

The job templates aremanaged by theWindowsHPC cluster administrator. Every cluster has at
least one job template, the "Default" job template. Every job has an associated job template. If no job
template is specified, then the "Default" job template is used. The job template controls two related
aspects of the job submission process.When a job is submitted, there are a number of job
parameters whichmay be specified. Each parameter has a set of valid values. For example, the
Priority parameter has five valid values, Highest, AboveNormal, Normal, BelowNormal, and Lowest.
The job template controls the default value of each parameter; this is the value that the parameter
has if it is not specifically overridden by the submitter. For example, in the Default job template, the
default value of the Priority parameter is Normal. The job templatemay also limit the allowed values
of each parameter to a subset of the valid values. For example, a job template for privileged users
could allow all five Priority values, which a job template for unprivileged users could limit the allowed
Priority values to Normal, BelowNormal and Lowest.
Each job template is aWindows object with access controlled by an ACL (access control list).
Instead of the usual "Read" or "Read & Execute" permissions, there is a "Submit Job" permission
which corresponds to the right to submit a job with this job template. The cluster administrator may
create job templates to limit or control access to cluster resources. For example, a job template with
limited allowed job run times, or access to a limited set of compute nodes could be created by the
cluster administrator. Specific users or user groups could be forced to use this limited job template by
omitting access to the other job templates or by adding a deny access entry for the specified user or
group to the other job templates. See theWindowsHPC Server 2008 Job Templateswhite paper
fromMicrosoft for additional details:
http://www.microsoft.com/en-us/download/confirmation.aspx?id=5659
Job templatesmay also be created to allow users to run jobswith limited knowledge of the
appropriate job parameters. The cluster administrator creates a job template which has reasonable
default values for the type of job to be run, and informs users which job template to use for each type
of job. The template could also limit some parameters to only the subset of all values that are useful
for the type of job associated with the template.

Related Topics

IntegrationWithMicrosoft Windows® HPC Scheduler
Windows® HPC Job Templates
Selecting Computation Resource Units (Job Unit Type)
Windows® HPC Job Credentials
High Performance Computing (HPC) Integration

Running Simulations 21-76
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.

http://www.microsoft.com/en-us/download/confirmation.aspx?id=5659


Maxwell Online Help

Selecting Computation Resource Units (Job Unit Type)

The Job Unit Type is the smallest unit of processing resources used to schedule the job. This is one
of themost important job properties. There are three options for the Job Unit Type: cores, nodes or
sockets.

l Cores: Jobs are scheduled in units of cores, whichmay be also described as a CPU cores,
logical processors, or CPUs. This is the smallest unit of granularity available. This selection
allows the scheduler to start multiple tasks on a processor, if the total number of cores needed
by the tasks is less than or equal to the number of cores on the processor. This selectionmay
also allow the scheduler to distributemore of the computational load to processors with more
cores than to processors with fewer cores.

l Nodes: Jobs are scheduled in units of nodes, hosts or machines. This is the coarsest level of
granularity that may be selected.When this option is selected, only one taskwill run on any
give node at any given time. This is useful in caseswhere it is not desirable to runmultiple
tasks on a single host. For example, if each task ismulti-threaded, runningmultiple tasks on
the same nodemay not be needed to fully utilize the computing resources on the node. This
may also be preferred if the tasks arememory intensive, andmultiple taskswould be
competing for the limitedmemory resources.

l Sockets: A socket (whichmay also be called a NUMA node) is a collection of cores sharing a
direct connection tomemory. A socket will contain at least one core, and it may contain several
cores. The socket concept may not necessarily correspond to a physical socket. Scheduling
at the socket level may be useful in cases in which each task requires extensive use of the
memory bus, and schedulingmultiple tasks on the same socket would result in excessive bus
contention.

Related Topics

IntegrationWithMicrosoft Windows® HPC Scheduler
Windows® HPC Job Templates
Selecting Computation Resource Units (Job Unit Type)
Windows® HPC Job Credentials

Windows® HPC Non-Exclusive Jobs

In previous releases, when submitting jobs to aWindowsHPC cluster using theSubmit Job To
dialog, the exclusive node usage property of the job is on theCompute Resources tab always set
to “true”.
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For many cases, this requirement prevents problems. One type of problem that can occur is related
to processor affinity. In general, EBU jobsmanage processor affinity on their own, and request a
single core for eachWindowsHPC task. If the cluster does set the affinity for the job, then the EBU
job cannot use all of the resources allocated to the job because the cluster sets the affinity to allow
only a single processor for eachWindowsHPC task.
Recent versions ofWindowsHPC allow three choices for the Cluster AffinityType setting:

l No Jobs: Affinity is not set for any jobs
l Non Exclusive Jobs (default): Affinity is not set for exclusive jobs
l All Jobs: Affinity is set for all jobs

If the AffinityType is set to “No Jobs”, then we can allow non-exclusive jobs inmany cases, but non-
exclusive jobswill be disallowed if you specify an explicit host list (because all resources on all
specified hosts are used), if you specify nodes and cores (to ensure that the job has exclusive access
to the specified number of nodes), or if you specifymulti-threading (to prevent a single task from
being split across hosts). If the AffinityType is set to “Non Exclusive Jobs”, then exclusive jobswill be
disallowed for all cases, the same as the restrictions for the previous release.
The previous job submission dialog always has the “exclusive” checkbox disabled for WindowsHPC
jobs, so that “exclusive” jobs cannot be submitted to aWindowsHPC cluster. The “exclusive”
checkbox is now enabled for WindowsHPC jobs. This allows you to submit exclusive jobs to a
WindowsHPC cluster. If this checkbox is checked, but the submission parameters andWindows
HPC cluster AffinityType do not allow submission of an exclusive job, then an error message is
displayed when you submit or preview the job.

Setting the Windows HPC Cluster Affinity Type

AWindowsHPC Cluster administrator is able tomodify the Affinity Type setting for the cluster. The
administrator should start theWindowsHPC Cluster Manager. The first step is to select the
Configuration button on the lower left pane, then select the Deployment To-do List in the upper left
pane. Then, the upper right pane displays the Deployment To-do List, as shown below.
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Next, the "Configure job scheduler policies and settings" should be selected. This is under the
heading "Optional deployment tasks".
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The "Job Scheduler Configuration" dialog pops up, as shown below.
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Next, select the "Affinity" tab should be selected.

The cluster administrator may now select a radio button to select the desired Affinity Type:
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l All jobs
l Non-Exclusive jobs
l No jobs

In order to submit non-exclusive jobs, the "No jobs" option should be selected. The "Non-Exclusive
jobs" optionmay be selected, but this will not allow non-exclusive ANSYS Electromagnetics jobs to
be submitted to the cluster. The "All jobs" option is not supported for ANSYS Electromagnetics jobs.
TheOK or Apply buttonsmay be used to apply the selected option to the cluster.

Examples with "Submissions with Nodes are for exclusive usage by this job" Unchecked
and Checked

Most of the following screen shots are for the same project file submitted to aWindowsHPC cluster
with the AffinityType set to "No Jobs". The scheduler resource selection parameters are the same for
all of these screen shots:

l MinCoresPerNode=4
l MaxCoresPerNode=4

The first set of screen shots show submission of a job to aWindowsHPC cluster in which the "Use
automatic settings" checkbox is not checked, and the resource selectionmethod is "Specify Number
of Tasks and Cores". The exclusive setting for the job is controlled by the "Nodes are for exclusive
usage by this job" checkbox. In previous releases, this checkboxwas always disabled and checked
for WindowsHPC jobs. Now, it is enabled, and the user may select whether it is checked or
unchecked. If it is checked, then the behavior is the same as previous releases. If it is unchecked,
then the job is submitted with the exclusive parameter for the job set to false.
The following screen shot shows this configuration with a Submit Job with Task and Cores specified
and nodes as non-exclusive
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The next figure showsPreview for the job submission indicating that the exclusive parameter for the
job is false.
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Jobsmay only be submitted using this resource selectionmethod with the exclusive parameter set to
false if all three of the following conditions aremet:

1. The cluster AffinityType is "No Jobs",
2. There is nomultiprocessing (i.e., the number of cores per task is one), and
3. There is no limit on the number of tasks per node.

If any of these requirements are not met, then the job is not submitted or previewed, and an error
message appears. The following figure shows this configuration.
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The following figure and screen shot ErrorMsgTasksAndCoresNonExMP.png shows the error
message box shown to the user.

The next example shows submission of a job to aWindowsHPC cluster in which the "Use automatic
settings" checkbox is checked, and the resource selectionmethod is "Specify Number of Nodes and
Cores". The exclusive setting for the job is controlled by the "Nodes are for exclusive usage by this
job" checkbox. In previous releases, this checkboxwas always disabled and checked for Windows
HPC jobs. Now, it is enabled, and the user may select whether it is checked or unchecked. If it is
checked, then the behavior is the same as previous releases. If it is unchecked, then the job is not
submitted or previewed because only exclusive jobs are allowed when using this resource selection
method, and an error message box is shown to the user in this case. The following figure shows this
configuration:
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The following figure shows the error message.

The next example show submission of a job to aWindowsHPC cluster in which the "Use automatic
settings" checkbox is checked, and the resource selectionmethod is "Specify Number of Cores and
(Optional) RAM". The exclusive setting for the job is controlled by the "Nodes are for exclusive usage
by this job" checkbox. In previous releases, this checkboxwas always disabled and checked for
WindowsHPC jobs. Now, it is enabled, and youmay select whether it is checked or unchecked. If it
is checked, then the behavior is the same as previous releases. The following figure shows this
configuration.
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The following figure shows the Job Preview for this case, indicating that the exclusive parameter for
the job is true.

If the exclusive checkbox is unchecked, then the job is submitted with the exclusive parameter set to
false. The following figure shows this configuration.
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The following figurescreen shot PreviewCoresAndRAMNonEx.png shows the Job Preview for this
case, indicating that the exclusive parameter for the job is false.

The last example resembles the previous one, except that theWindowsHPC cluster AffinityType is
set to "Non Exclusive Jobs" in this case. The job is submitted with the "Use automatic settings"
checkbox in the checked state, and the resource selectionmethod set to "Specify Number of Cores
and (Optional) RAM". Because the AffinityType is not "No Jobs", only exclusive jobsmay be
submitted to this cluster. If the exclusive checkbox is not checked, then the job is not submitted or
previewed, and an error message box is displayed to the user. The following figure shows this
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configuration.

The following figure shows the error message.

Related Topics

IntegrationWithMicrosoft Windows® HPC Scheduler
Windows® HPC Job Templates
Selecting Computation Resource Units (Job Unit Type)
High Performance Computing (HPC) Integration

Windows® HPC Job Credentials

Normally, a user will be prompted for the credentials used to submit a job. One way to simplify this
process is to use the "cluscfg setcreds" command to set the user’s credentials in the credentials
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cache. If this is done, then no password needs to be supplied for a job submitted for the specified
user. Here is a cluscfg command that may be used to set the user credentials in the credentials
cache:

cluscfg setcreds /password:* /scheduler:cluster_name
/user:domain\user_name

Here:
l cluster_name = the name of the cluster (hostname of the head node)
l domain = optional domain name; if omitted, the following \ should also be omitted
l user = user name

When this form of the command is used, the user is prompted for the password and also asked if the
password should be remembered (cached).
See the following web page for more information on the cluscfg setcreds command:
http://technet.microsoft.com/en-us/library/cc947669(WS.10).aspx

Related Topics

IntegrationWithMicrosoft Windows® HPC Scheduler
Windows® HPC Job Templates
Selecting Computation Resource Units (Job Unit Type)
Windows® HPC Job Credentials
High Performance Computing (HPC) Integration

Integration with Platform’s Load Sharing Facility (LSF)

ANSYS Electromagnetics products support Windows LSF cluster aswell as Linux LSF cluster.
Serial analysis, Multi Processing and Distributed Analysis is done on compute resource units
assigned by LSF. Models with parametric sweeps can use Large Scale DSO.With LSF, the ANSYS
Electromagnetics job doesn't require graphics. The ANSYS Electromagnetics job’s progress can be
monitored through LSF commands or through the dialog opened through Tools>Job
Management>Monitor Jobs.... If a temp directory is setup by the LSF cluster administrator,
analysis engines use this temp directory, overriding the setting in the ANSYS Electromagnetics
product.
Besides the command line interface, you can also use a JobManagement user interface to submit
jobs
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Related Topic
General Terminology for LSF
Installation of ANSYS Electromagnetics Tools on LSF Cluster
Integration of ANSYS Electromagnetics Products with LSF
LSF Job Submission Guidelines
JobManagement User Interface for LSF
LSF CommandUsed to Launch Remote Engine Processes
Submitting ANSYS Electromagnetics LSF Batch Jobs
CurrentWorking Directory with LSF
Quoting ANSYS Electromagnetics Command or Arguments for LSF
Monitoring LSF Batch Jobs
Terminating LSF Batch Jobs

Running Simulations 21-92
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Known Issues for LSF
Troubleshooting for LSF
Command Line Enhancements for ANSYS Electromagnetics Desktop Products

Installation of ANSYS Electromagnetics Tools on LSF Cluster

The LSF scheduler is supported on both Linux andWindows.
The lsf.conf should have this line present:

LSF_UNIT_FOR_LIMITS=MB

The administrator should have this line in the lsb.params file to ensure that memory reservations are
per-slot (per-core):

RESOURCE_RESERVE_PER_SLOT=Y

On Linux, jobsmay be submitted in any of the following ways:
l Using LSF commands (bsub, etc.)
l Using the generic scheduler GUI in local mode
l Using the generic scheduler GUI in servicemode

OnWindows, jobsmay be submitted in any of the following ways:
l Using LSF commands (bsub, etc.)
l Using the generic scheduler GUI in local mode

This release has been tested with the following versions of LSF:
l LSF 7.0.6, 8.0.1, and 9.1.1 onWindows
l LSF 7.0.6, 8.0.1, and 9.1.1 on Linux

Windows:
Install on every node of cluster
Set up ‘temp directory’ to a path that is same on all nodes. For example, c:\temp

Linux:
Install on a single node, on a shared drive.
Set up ‘temp directory’ to a path that is same on all nodes. For example, /tmp
Ensure that the product is available using the same path on all nodes

Permissions:
All users of the cluster should have read/write permissions to temp directory
All users should have read/execute permissions to installation directory

When a desktop scheduler GUI is run the same node as the job submission node, no other
configuration is necessary: installation is sufficient. You select the scheduler through the desktop
GUI. You need to ensure that scheduler commands are available in the path before you launch
desktop.

Note There is no need to install RSMunless the you are using the scheduler GUI on a post
processing node that is different than the than the job submission node. In this case, RSM
must be configured with the scheduler type and path.
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A post processing nodes is a node in the cluster that can run the ANSYS Electromagnetics
desktop in graphical mode. A job submission node is a node in the cluster in which job
submission commands are available.

Turn OFF firewall between cluster nodes.

Per-slot Resource Reservation
Set the cluster for per-slot resource allocation if the automatic cores and RAM resource selection
method is to be used. You can check the cluster to see if per-slot resource allocation is configured by
using the "bparams -a" command. Search the output for "RESOURCE_RESERVE_PER_SLOT" to
determine the setting (either "Y" or "N"). If set to "N" then consult the LSF administration guide on
how to change this to "Y".
Scenario 1: The post-processing node and job-submission node roles are served by
distinct machines.
In this case, perform the following configuration:
The job-submission node should be configured to run the AnsoftRSMService, which serves as a
proxy to scheduler. The AnsoftRSMService should be running as 'root' in order to facilitate jobs
running using the credentials of the job's owner. A configuration file in the RSM installation
folder should be edited to specify information regarding the scheduler that manages jobs on this
cluster. A block labeled 'Scheduler' must be included within the 'AnsoftCOMDaemon' block. This
block contains two string entries:

l SchedulerName: this contains the unique part of the scheduler proxy library name
l ConfigString: this contains a scheduler specific configuration string

The case of the SchedulerName string is significant on Linux because Linux file names are case
sensitive. The case of the SchedulerName string is not significant onMicrosoft Windows. In ANSYS
Electromagnetics Suite 18.0, the possible scheduler names are: lsf and sge. The ConfigString entry
is a scheduler specific configuration string, described below.
In addition, the AnsoftRSMServicemust be started with appropriate environment variables set.
Generally, the environment variablesmust be set the same as theywould be set for using the
scheduler via command lines.
LSF Details
For the LSF scheduler proxy library, the ConfigString entry in the ansoftrsmservice.cfg configuration
file is ignored. It may be empty or omitted entirely.
The AnsoftRSMServicemust be started with the environment set as it would be set for submitting
jobs to the LSF cluster.

l For Linux, the cshrc.lsf or the profile.lsf file may be sourced to set up the environment,
depending on the shell.

l For Microsoft Windows, the PATH environment variable should be set to include the directory
containing the LSF commands; this directory should be before any other directory containing
files with the same name as any LSF commands.

Example ansoftrsmservice.cfg configuration file:
$begin 'AnsoftCOMDaemon'
$begin 'Managed COM Servers'
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$end 'Managed COM Servers'
$begin 'Scheduler'
'SchedulerName'='lsf'
'ConfigString'=''
$end 'Scheduler'
$end 'AnsoftCOMDaemon'

Scenario 2: The post-processing node and job-submission node roles are served by the
same machine.
TheSelect Scheduler... command (as described in the JobManagement User Interface for LSF
section) is used to gather details about the scheduler. In this case, the Desktop process should be
started in an environment suitable for submitting jobs to the scheduler. See below for details.
LSF on Linux

The environment should be configured so that the following LSF environment variables are set
appropriately for the LSF cluster in use: LSF_BINDIR, LSF_SERVERDIR, LSF_LIBDIR, and
LSF_ENVDIR. In addition, the following LSF commands should be found in the LSF_BINDIR
directory: "bsub", "bjobs", "bkill", "lsid", "lsrun", "lshosts", "bmgroup", "bparams" and
"bqueues".

LSF on Microsoft Windows
The environment should be configured so that all LSF commands are found using the PATH
environment variable. In particular, search for the following commands in the PATH should
result in the LSF command being found: "bsub", "bjobs", "bkill", "lsid", "lsrun", "lshosts",
"bmgroup", "bparams" and "bqueues". No other commandwith the same name should appear
before the LSF command in the PATH.
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Desktop talks to the Scheduler Proxywhich in turn uses Scheduler commands. It is possible to add a
proxy dll to support new schedulers without changing Desktop.
Related Topic
Integration with Platform’s Load Sharing Facility (LSF)
General Terminology for LSF
What a Scheduler Does
Integration of ANSYS Electromagnetics Products with LSF
JobManagement User Interface for LSF
LSF Job Submission Guidelines
Known Issues for LSF
Troubleshooting for LSF
Workarounds for LSF
Command Line Enhancements for ANSYS Electromagnetics Desktop Products
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Integration of ANSYS Electromagnetics Products with LSF

With LSF you do not need to setup ‘Distributed AnalysisMachines’ or ‘RemoteMachine’ in the
Tools>General Options>Analysis Options tab. Instead, you submit aMaxwell job to LSF,
requesting appropriate resources for this job (number of processors, memory per processor, etc.).
For example:

bsub –n 1 maxwell.exe –Batchsolve –ng –local OptimTee.mxwl
bsub –n 4 maxwell.exe –Batchsolve –ng –Distributed
Optinew.mxwl

TheMaxwell job is queued by LSF until the requested resources are available. Upon resource
availability LSF startsmaxwell.exe with the specified command line on one of the allocated
machines. During analysis, Maxwell dynamically obtains the allocated ‘Distributed Analysis
Machines’ from LSF. Maxwell interfaceswith LSF to launch engines on remotemachineswithout
going through Ansoft RSM.

Related Topics

Integration with Platform’s Load Sharing Facility (LSF)
General Terminology for LSF
What a Scheduler Does
JobManagement User Interface for LSF
Installation of ANSYS Electromagnetics Tools on LSF Cluster
LSF Job Submission Guidelines
Known Issues for LSF
Troubleshooting for LSF
Command Line Enhancements for ANSYS Electromagnetics Desktop Products

LSF Job Submission Guidelines

l ANSYS Electromagnetics project should be available in a shared drive that is accessible to all
machines in the cluster

l ANSYS Electromagnetics project should be available using the same path on all machines of
cluster

l Ensure sufficient space in project directory and temp directories
l Ensure sufficient memory per engine
l Choose the number of compute resources (Distributed Analysismachines andMulti
Processing cores) so as to achieve desired scale factor and effective resource utilization

Stop aMaxwell job cleanly - ensures that the results obtained until now are preserved
bkill –s TERM <jobid>.

Stop aMaxwell job abruptly – results aremost likely lost. You have tomanually remove the project
lock file
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bkill <jobid>

Related Topics

Integration with Platform’s Load Sharing Facility (LSF)
JobManagement User Interface for LSF
Installation of ANSYS Electromagnetics Tools on LSF Cluster
Integration of ANSYS Electromagnetics Products with LSF
Known Issues for LSF
Troubleshooting for LSF
Command Line Enhancements for ANSYS Electromagnetics Desktop Products
Aborting an Analysis

Job Management User Interface for LSF

The JobManagement UI is accessed by running ANSYS Electromagnetics product Desktop on the
designated 'Postprocessing node' of the cluster. The Desktop providesUI commands for Scheduler
selection, Job submission and Jobmonitoring/control. You access the Scheduler User Interface by
clicking Tools>Job Management>Select Scheduler...

Before you can useSubmit Job, youmust clickSelect Scheduler as the one-time initial step. This
opens the Select Scheduler dialog.
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Specify the following parameters:
l Job submission node: this is the node on the cluster where scheduler commands (such as
LSF's bsub) are allowed to run.
ChooseUse this computer if scheduler commands are enabled on the post-processing
node.
ChooseUse a computer on the network if the cluster is configured in amanner as to
disallow job-submission from the post-processing node. Specify node name appropriately.
Pre-requisites: For this choice to work, the job-submission nodemust already be configured
with a running Ansoft RSM service, as documented in the 'Installation/Configuration' section

l Choose scheduler: Available choices vary, depending on your configuration. It is possible for
you to integrate a custom scheduler into this UI, through a scheduler proxy. When this is done,
more choiceswill be available in the combo-box, one per custom scheduler proxy that is
deployed in the installation.

After specifying the job submission node, you can clickRefresh. The scheduler information is then
listed in theScheduler info text field.
Once you select a scheduler, you can access the interface for job submission, monitoring and
control. ClickOK to close the dialog.
You access the Job submission UI by clicking Tools>Job Management>Submit Job.... This
command launches amulti-tab dialog.
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l TheAnalysis Specification tab has parameters to specify the product path, input project
model, the analysis setup and analysis options (including batchoptions) that affect analysis
algorithms.
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l TheCompute Resources tab specifies the amount of compute resources and how to select
specific resources from the available pool (for example, <queue_name> is an LSF parameter
that restricts job's candidate nodes to nodes in this queue).

l TheScheduler Options tab has analysis-independent parameters specific to the job, such
as name and priority.

Analysis Specification tab for LSF
This tab lets you specify the following:
Project:

You can use the ellipsis button [...] to use a navigation window to browse. The path should be
visible to all nodes in the cluster. The Project can be an archive.

Analysis Setups:
Specify All setups in the project, all in a design, or a single setup. If the setup includes a
parametric sweep, theUse large scale DSO check box is enabled.
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Analysis Options:
l You have check boxes for whether to Monitor Job through theGUI, and whether toWait for
license.

l You can also specify Batchoptions. Click theAdd... button to open a dialog for selecting the
Batchoptions.

The lower Value field shows the legal values for the selected registry key. You can type the
desired value into the upper text field under value. Click theAdd button to accept the selection
of the registry keywith the specified value. ClickDone close theAdd Batchoption dialog.
At the upper left, a drop downmenu lets you specify which registry key categories to display,
whether All, or selected category.
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A check box lets you choose between displaying only frequently used entries (the default), or
by unchecking, all options available for the selected group.
Note that for Large Scale DSOproblems, you also have the option to specify predefined
configurations.
The added registry keys and values are listed in the Batchoptions field of theSubmit Job
dialog.

Selecting from the list enables buttons for removing or editing registry key values. Selecting a
registry key and clickingEdit... opens theEdit Batchoptions dialog.
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Here you can edit the Value field and update the value for the selected registry key.
Environment:

If you check the Show advanced options check box, you can see the Environment field. This
permits specifying Environment Variables.

Click the ellipsis button [...] to open theAdditional Job Options dialog.
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TheAdd button permits you to specify your environment variables. Once, added, you can select
Remove or Edit. TheAdd Debug Environment Variables button adds variables of use in
working with support.

l TheSave Settings as Default button lets you save a current set of values as defaults the
next time you invoke the Scheduler GUI. This can simply subsequent job submissions.

Use Batch Extract for LSF
Selecting Show advanced options for LSF also show the Use batch extract fields.

See the discussion on RunningMaxwell from aCommand line for a discussion of the solve
information available through batch extract.

Compute Resources Specification Tab
This tab lets you provide Resource selection and Job parallelization parameters. You can elect to
User automatic settings for job distribution, specify aMethod and resource selection parameters, or
job distribution parameters.
For lsf, the non-automatic settings allow you to specify the total number of tasks, whether nodes are
for exclusive use by the job, the number of cores per distributed task, and a limit number of tasks per
node.
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If you checkUse automatic settings the options include Number of Cores and (Optional) RAMor
Number of Nodes and Cores. If you select Number of Cores and (Optional) RAM, you can specify:
Total number of cores, checkwhether Nodes are for exclusive usage by the job, and whether to use
a RAM constraint in GB per core.
If you chose to Specify the Number Nodes and Cores, the options are: Total number of nodes,
whether the nodes are for exclusive use by the job, and the total number of cores.
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Job Distribution
For non-automatic setups, click theModify button in the Job Distribution panel to display the Job
Distribution dialog.
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Enabled Distribution types canmodified here.

Resource Selection:
If you do not specify parameters for resource selection, LSFmay submit jobs to anymachine in the
entire pool that is available.

l Resource selection parameters.
Clicking the ellipsis button [...] opens a dialog for parameters specific to LSF, in this case
Queue. The Specify Parameter check box in the dialog enables a parameter, and you can
select the Value for the Queue parameter from a drop downmenu or specify values for the
other LSF parameters.
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The resource selection parameters for LSF are as follows:
l Queue - a drop downmenu lets you select Normal, chkpn_rerun_queue, idle, license, night,
normal_allow_excl, owners, priorituy, or short.

l MinCoresPerNode - minimumnumber of cores allowed on a node to be eligible for
selection; translates to bsub -R select[ncpus>=N]

l MaxCoresPerNode - maximumnumber of cores allowed on a node to be eligible for
selection; translates to bsub -R select[ncpus<=N]

l MinMemoryPerNode - minimumamount of physical memory (specified in integer
GigaBytes) allowed on a node to be eligible for selection; translates to bsub -R select
[maxmem>=M]

l MaxMemoryPerNode - maximumamount of physical memory (specified in integer
GigaBytes) allowed on a node to be eligible for selection; translates to bsub -R select
[maxmem<=M]

If you don’t specify a parameter, the scheduler handles the situation.
l Specify node list
Checking Specify node list enables the field for specifying a node list. In a computing
environment where the available cores are not uniform, you can use this to have control over
which resources your job will use.

In response to a set of minimal constraints, the Scheduler may increase the resources assigned
beyond theminimal values in order to meet the full set of requirements. For example, the scheduler
may indicate that more cores than requested will be used to get the correct node quantity in auto
nodes and cores.
Preview submission
This opens a screen showing the bsub command to be used to submit the job.

Submit job actually sends the batch command to the LSF cluster. A dialog reports a successful
submit and presents a check box for monitoring.
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Scheduler Options Tab
This tab lets you assign Job name and Priority

Also present are buttons that allow you toSave Settings As Default, Preview Submission, and
Submit Job
If you checkShow advanced options, you can also Customize Job submission.
The Job submission options permit you to customize a job submission in terms of addition job
submission options, or override a job submission command.
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When the "Override job submission" radio button is checked, the user specified options replacemost
of the job submission options, whereaswhen the "Additional job submission options" radio button is
checked, the user specified options are appended to the bsub command.
You can see the effects of any custom additions by clickingPreview Submission.

Related Topics

Integrated JobMonitoring for JobManagement Interface for LSF
Scheduler Proxy Interfaces

Integrated Job Monitoring for Job Management Interface for LSF

The jobmonitoring/control dialog is launched through the command Tools>Job
Management>Monitor Jobs... or by checkingBegin monitoring this job now in the information
window reporting successful job submission.

In response to either invocation, the Monitor Job dialog opens:
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In this dialog, you can select the job tomonitor from a pull down list of Recent jobs. If desired, you can
use the check boxes to filter themessages listed in terms of whether to monitor Errors, Warnings, or
Infomessages.
The lower left has corner of the dialog has options for manual refresh or automatically at a specified
interval. You can choose toClear Progress Messages. After refresh, themessages for the job are
displayed.

You also have command buttons to perform aClean Stop of a simulation between time steps, or to
Abort a simulation.

Related Topics

Scheduler Proxy Interfaces
JobManagement User Interface for LSF

LSF Command Used to Launch Remote Engine Processes

When using direct integration with LSF, the LSF lsrun command is used to launch remote engine
processes. This command does not allow the LSF scheduler to track the resources used by these
processes. As a result, the resource usage reported by the LSF bacct commandwill not include
resources used by the remote engine processes.

Submitting ANSYS Electromagnetics LSF Batch Jobs

The LSF bsub commandmay be used to submit ANSYS Electromagnetics jobs. The typical
command format is:

bsub bsub_argsansys_exeansys_args

where:
l bsub_args are the options of the bsub command,
l ansys_exe is the pathname of the ANSYS Electromagnetics Desktop executable to launch,
and

l ansys_args are the arguments to the ANSYS Electromagnetics Desktop executable.
Related Topic
JobManagement User Interface for LSF
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Current Working Directory with LSF

The current working directory of the ANSYS Electromagnetics Desktop processmust exist on all
compute hosts where analysismay be run. This is needed because the ANSYS Electromagnetics
job uses the LSF lsrun or blaunch commands to start the remote analysis engines.When these LSF
commands start a remote process they always change the working directory to the working directory
of the process submitting the command. If the directory does not exist on a remote host, then the
lsrun or blaunch commandwill fail on that host, and the remote analysis engine will not be started on
that host.

Quoting ANSYS Electromagnetics Command or Arguments for LSF

If the ANSYS Electromagnetics tool executable pathname (ansys_exe) or any of the arguments of
the ANSYS Electromagnetics tool command (ansys_args) contain characters which are interpreted
by the command shell, then these special charactersmust be properly quoted to ensure that the
correct command is launched by LSF. This is very common onWindows systems, wheremany
executable file pathnames contain embedded space characters. A similar problemmay occur on any
platform if any of the ansys_args require single quote, double quote or space characters. Note that
the ANSYS Electromagnetics desktop command is processed by the shell twice. It is processed by
the shell when the bsub command is processed, and again when the job is started.

bsub Arguments

The LSF bsub command has a large number of options that may be used to control the submission
process. Only a few optionswhich are often used with ANSYS Electromagnetics jobs arementioned
here. The following optionsmay be used to submit serial or parallel LSF jobs.

-nmin_proc, max_procor -nmin_proc

Submits a parallel job, specifying the number of processors (or slots) required for the job. Here,min_
proc is theminimumnumber of processors, andmax_proc is themaximumnumber of processors. If
nomaximum is specified, then exactlymin_proc processors are requested. If PARALLEL_SCHED_
BY_SLOT=Y in lsb.params, this option specifies the number of slots required to run the job, not the
number of processors. If the -n command line option is not specified, then the job is submitted as a
serial batch job.

-R "span[ptile=n]"

There aremanyways to use the -R "res_req" option to the bsub command.We only cover -R "span
[ptile=n]" here, because this option is very useful for ANSYS Electromagnetics jobs.When this
option is specified, the LSF scheduler will allocate n processors (or slots) on each host to this job,
even if more processors are available on the host.

-x

All hosts running this job operate in exclusive executionmode. The job will only run on a host having
no other jobs running on that host. No other batch jobswill be started on a host while this job is
running on that host. The -mhost_name option of the lsrun or lsgrun commandsmay be used to
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force an interactive job to run on a host in exclusivemode. The -mhost_name option of the brun
commandmay be used to force a batch job to run on a host in exclusivemode.
See the LSF documentation for a complete list of options for the bsub command.
Related Topic
JobManagement User Interface for LSF

Monitoring ANSYS Electromagnetics LSF Batch Jobs

The LSF bpeek commandmay be used tomonitor LSF batch jobs, if the Desktop command line for
the job includes the -monitor command line option. Also see Integrated JobMonitoring for Job
Management Interface for LSF.

ANSYS Electromagnetics Desktop -monitor Command Line Option
The ANSYS Electromagnetics -monitor command line option enables batch job output to the
standard output and standard error streams. The warning, info, and progressmessages are sent to
the standard output stream. The error and fatal messages are sent to the standard error stream.

LSF bpeek Command
The LSF bpeek commandmay be used tomonitor job progress. The command pbeek [ -f ] job_id
displays the standard output and standard error produced by the job with id job_id from the job start
to the current time (the time when the command is executed). This command is only valid for jobs
that have not yet finished.When used with the -f option on Linux, the output of the job is displayed
using the command tail -f, so that ongoing progressmay bemonitored.
In order to displaymessages to standard output and standard error, specify the -monitor command
line option on the ANSYS Electromagnetics tool command line. Then, thesemessages can be seen
using the LSF bpeek command.
Related Topic
JobManagement User Interface for LSF
Integrated JobMonitoring for JobManagement Interface for LSF

Terminating ANSYS Electromagnetics LSF Batch Jobs

To cancel or terminate an ANSYS Electromagnetics LSF batch job, we recommend the use of the
LSF bkill commandwith the -s SIGTERM command line option. Using this option to will allow the
ANSYS Electromagnetics batch job to shut down in an orderly fashion. Using the LSF bkill
commandwithout the -s SIGTERM option or simply terminating the job processesmay cause some
of the following problems:

l Some engine processes are not shut down, and continue to run
l LSF job is not fully removed
l Project lock file is not removed
l Linux only:MainWin core service processes (watchdog, mwrpcss and/or regss) are not
stopped
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Some of thesemay interfere with submission of additional ANSYS Electromagnetics LSF batch
jobs. For example, it may be necessary tomanually remove the project lock file to submit another
batch job for the same project. On Linux, MainWin core service processesmay also interfere with
starting subsequent ANSYS Electromagnetics batch jobs. Normally, these processes should
timeout and end 15 seconds after the ANSYS Electromagnetics product shuts down. AnyMainWin
core service processes (watchdog, mwrpcss and/or regss) that continue to run for more than 15
seconds after the product has stoppedmay be hung. The hung processesmay need to bemanually
killed, after ensuring that these processes are associated with an ANSYS Electromagnetics job that
has finished or terminated.

Related Topics

Integrated JobMonitoring for JobManagement Interface for LSF

Example LSF bsub Command Lines

The following Linux andWindows examples all useMaxwell as the ANSYS Electromagnetics
product, but similar command lineswill work for all ANSYS Electromagnetics products.

Linux Examples for LSF
If themaxwell command is included in the bsub command line, then the entire maxwell command
will be processed by the command shell two times. TheMaxwell command is processed when the
bsub command is processed by the shell. It will be processed again when theMaxwell command is
started by the scheduler.
Several examples show the entire Maxwell command line enclosed in double quotes (“), while the
double quote (“) characters within themaxwell command line are replaced by escaped double
quotes ("\""). This ensures that the quoted arguments of themaxwell command are processed
correctly. The last example shows how to use a shell script so that themaxwell command line will be
processed by the command processor only once. Themaxwell command is placed in the shell script,
and then the shell script pathname is placed in the bsub command line. Then, themaxwell
command is only processed by the command processor when the job is started.When using this
approach, the shell script should be accessible from all of the cluster hosts.

Serial job:
bsub -n 1 /opt/AnsysEM/AnsysEM18.0/ansysedt -ng -BatchSolve
~/projects/OptimTee.aedt

The -n 1 option indicates that this job runs on one core.

Serial job that needs a minimum of 4GB:
bsub -n 1 -R "select[mem>4000]"
/opt/AnsysEM/AnsysEM18.0/ansysedt -ng
-BatchSolve ~/projects/OptimTee.aedt

The -R "select[mem>4000]" option indicates that this needs aminimumof 4 GBmemory.
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Multi-processing job using 4 cores:
bsub -n 4 -R "span[ptile=4]"
"/opt/AnsysEM/AnsysEM18.0/ansysedt -ng -BatchSolve
-batchoptions
"\""'Maxwell3D/Preferences/NumberOfProcessors'=4"\""
~/projects/OptimTee.aedt"

l The -R "span[ptile=4]" option indicates that the four cores need to be on the samemachine.
l The -batchoptions option indicates that Maxwell should use four cores for multi-processing.
l The entire maxwell command is in double quotes, and the double quotes enclosing the -
batchoptions value are escaped. Each of these double quotes is replaced by the sequence
"\"".

Distributed processing job using 4 engines:
bsub -n 4 /opt/AnsysEM/AnsysEM18.0/ansysedt -ng -BatchSolve -
Distributed ~/projects/OptimTee.aedt

l The -n 4 option indicates that the four cores are needed for the job.
l The -Distributed option indicates that this is a DSO job, so that multiple engineswill be started.
Because 4 cores are allocated to the job, the job will run 4 engines. The -Distributed option
can have additional options, such as includetypes=xxx, excludetyeps=xxx, maxlevels=n, and
numlevel1=n, where n indicates and integer, and xxx indicates a list of distribution types or
"default".

Distributed processing and multi-processing job using 4 cores, with 2 cores for multi-
processing:

bsub -n 4 -R "span[ptile=2]" ~/projects/OptimTee.csh

Shell script (~/projects/OptimTee.csh):
#!/bin/csh
/opt/AnsysEM/AnsysEM18.0/ansysedt -ng -BatchSolve
-Distributed -machinelist num=2 -batchoptions
OptimTee.aedt

l The -n 4 option indicates that the four cores are needed for the job.
l The -R "span[ptile=2]" option indicates that the coresmust be allocated in groups of two
cores on the samemachine.

l The -machinelist num=2 option indicates that this is a DSO job and that a total of two
engineswill be started.

l Themaxwell command is placed in the shell script (~/projects/OptimTee.csh). In the bsub
command line, themaxwell command is replaced by the shell script pathname.

Windows Examples for LSF
If themaxwell command is included in the bsub command line, then the entire maxwell commandwill
be processed by the command processor cmd.exe two times. Themaxwell command is processed
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when the bsub command is processed by the command processor. It will be processed again when
themaxwell command is started by the scheduler.
The first three examples show the entire maxwell command line enclosed in double quotes ("), while
the double quote (") characters within themaxwell command line are replaced by escaped double
quotes (\"). This ensures that the quoted arguments of themaxwell command are processed
correctly. The remaining examples show how to use a batch file so that themaxwell command line
will be processed by the command processor only once. Themaxwell command is placed in a batch
file, and then the batch file pathname is placed in the bsub command line. Then, themaxwell
command is only processed by the command processor when the job is started.When using this
approach, the batch file should be accessible from all of the cluster hosts.

Serial job:
bsub -n 1 "\"C:\Program
Files\AnsysEM\AnsysEM18.0\Win64\ansysedt.exe\"
-Ng -BatchSolve \\host\share\projects\OptimTee.aedt"

l The -n 1 option indicates that this job runs on one core.
l The entire maxwell command is in double quotes, and the double quotes enclosing the
maxwell pathname are escaped. Each of these double quotes is replaced by the sequence \".

Serial job that needs a minimum of 4GB:
bsub -n 1 -R "select[mem>4000]"
"\"C:\Program Files\AnsysEM\AnsysEM18.0\Win64\ansysedt.exe\"
-Ng -BatchSolve \\host\share\projects\OptimTee.aedt"

l The -R "select[mem>4000]" option indicates that this needs aminimumof 4 GBmemory.
l The entire maxwell command is in double quotes, and the double quotes enclosing the
maxwell pathname are escaped. Each of these double quotes is replaced by the sequence \".

Multi-processing job using 4 cores:
bsub -n 4 -R "span[ptile=4]"
"\"C:\Program Files\AnsysEM\AnsysEM18.0\Win64\ansysedt.exe\"
-Ng -BatchSolve -batchoptions
\"'Maxwell3D/Preferences/NumberOfProcessors'=4\"
\\host\share\projects\OptimTee.aedt"

l The -R "span[ptile=4]" option indicates that the four cores need to be on the samemachine.
l The -batchoptions option indicates that Maxwell should use four cores for multi-processing.
l The entire maxwell command is in double quotes, and the double quotes enclosing the
maxwell pathname and the -batchoptions value are escaped. Each of these double quotes is
replaced by the sequence \".

Distributed processing job using 4 engines:
bsub -n 4 \\host\share\projects\OptimTee.bat

Batch File (\\host\share\projects\OptimTee.bat) Contents:
"C:\Program Files\AnsysEM\AnsysEM18.0\Win64\ansysedt.exe"
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-Ng -BatchSolve
-Distributed \\host\share\projects\OptimTee.aedt

l The -n 4 option indicates that the four cores are needed for the job.
l The -Distributed option indicates that this is a DSO job, so that multiple engineswill be started.
Because 4 cores are allocated to the job, the job will run 4 engines.

l Themaxwell command is placed in the batch file \\host\share\projects\OptimTee.bat. In the
bsub command line, themaxwell command is replaced by the batch file pathname.

Distributed processing and multi-processing job using 4 cores, with 2 cores for multi-
processing:

bsub -n 4 -R "span[ptile=2]"
\\host\share\projects\OptimTee.bat

Batch File (\\host\share\projects\OptimTee.bat) Contents:
"C:\Program Files\AnsysEM\AnsysEM18.0\Win64\ansysedt.exe" -Ng
-BatchSolve -Distributed -machinelist num=2 -batchoptions
"'Maxwell3D/Preferences/NumberOfProcessorsDistributed'=2
'Maxwell3D/Preferences/NumberOfProcessors'=2"
\\host\share\projects\OptimTee.aedt

l The -n 4 option indicates that the four cores are needed for the job.
l The -R "span[ptile=2]" option indicates that the coresmust be allocated in groups of two cores
on the samemachine.

l The -machinelist num=2 option indicates that this is a DSO job and that a total of two engines
will be started.

l The 'Maxwell3D/Preferences/NumberOfProcessorsDistributed=2 batchoption indicates that
the distributed analysis engines should use two cores for multi-processing.

l The 'Maxwell3D/Preferences/NumberOfProcessors=2 batchoption indicates that the portion
of the analysis that is not distributed should use two cores for multi-processing.

l Themaxwell command is placed in the batch file \\host\share\projects\OptimTee.bat. In the
bsub command line, themaxwell command is replaced by the batch file pathname.

Known Issues for LSF

l Desktop or remotemachine hasmultiple IP addresses, which we don’t support.
l There are core dump files at the end of job’s running. Results are computed correctly though.
l OnWindows, Maxwell should be installed on everymachine of the cluster.
l The firewall should be turned off on themachines in the cluster.
l UAC should be disabled on Vista (onlyWindows).
l Sometimes LSF kills aMaxwell job (for e.g. job gets preempted due to a high priority job).
Maxwell doesn't handle such a situation gracefully resulting in the presence of .lock file in the
project directory. User needs tomanually delete the lock file before continuing with further
analysis.
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l When an LSF job is killed, theMainWin services (watchdog, regss, andmwrcpss) could keep
running. The result is that later jobs cannot start on themachine. The fix is to kill off these
processes before starting a new job

l Analysis fails abruptly when running out of resources (cpu/memory/disk)
Related Topic
Integration with Platform’s Load Sharing Facility (LSF)
General Terminology for LSF
What a Scheduler Does
Installation of ANSYS Electromagnetics Tools on LSF Cluster
Integration of ANSYS Electromagnetics Products with LSF
LSF Job Submission Guidelines
Troubleshooting for LSF
Command Line Enhancements for ANSYS Electromagnetics Desktop Products

Troubleshooting for LSF

Ensure that the LSF lsrun command is enabled.
Make sure there is no user error. For example:

l Use correct path toMaxwell and full path to project
l Ensure sufficient resources (cpu/memory/disk) are allocated to job: check space in temp
directory, space in project directory (consider quotas)

l ANSYS Electromagnetics project to be available on the execution host
l Ensure job submitter has permissions to read/write to project directory and read/execute
permissions to installation directory

l Check for locked project
Find if this is a standalone product issue:

Run build of Maxwell interactively on themachine, outside of the scheduler, and see if it comes
up and analyzes.

Send the following logs to development:
l Output of LSF batch job corresponding to the analysis of ANSYS Electromagnetics project:
You can obtain this using LSF commands: use bacct if job’s output is not redirected to a file.
For example,

“bacct –l <jobid>”

l Batch log generated by ANSYS Electromagnetics product (typically, projectname.log, in the
same directory as the ANSYS Electromagnetics project file)

l Debug logs generated by ANSYS Electromagnetics product, during the running of LSF job.
You can set these Environment variables using the Submit Job dialog, by turning on
Advanced options to display the Environment field. Click the ellipsis button [...] access the Add
Debug Environment Variables button.

Set ANSOFT_DEBUG_MODE to 1
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It is good to collect another set of logswith above value set to 7
Create \\shared_drive\ansdebug directory that is accessible by all machines in the cluster
Set ANSOFT_DEBUG_LOG to a file in \\shared_drive\ansdebug’ directory, for example,

\\shared_drive\ansdebug\anslog
Set ANSOFT_DEBUG_LOG_SEPARATE to 1.

Set ANSOFT_LSF_LOG to a distinct file in \\shared_drive\ansdebug’ directory, for example,
\\shared_drive\ansdebug\lsf.log

l For each pair of themachines, between which the remote analysis fails, run "ping remote-
machine" and note the output

l For eachmachine in the network, dump the network interfaces (for e.g. run "ifconfig -a") and
note the output

l Email all 5 logs to development
- Job’s log generated by LSF
- Log generated by ANSYS Electromagnetics product
- Entire \\shared_drive\ansdebug folder
- Output from ping command
- Output related to compute node’s network interfaces

Related Topic
Integration with Platform’s Load Sharing Facility (LSF)
General Terminology for LSF
What a Scheduler Does
Installation of ANSYS Electromagnetics Tools on LSF Cluster
Integration of ANSYS Electromagnetics Products with LSF
LSF Job Submission Guidelines
Known Issues for LSF
Command Line Enhancements for ANSYS Electromagnetics Desktop Products
Aborting an Analysis
Known Issues for LSF
Wordarounds for LSF

Workarounds with LSF

l Some users reported ‘core’ dumps duringMaxwell analysis, though analysis results are fine.
Workaround: Limit size of core dumps to 0 through the following job submit option:

bsub -C 0 -n <number-of-cores> -q <queue-name>

Note Letter ‘C’ must be upper-
case
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Related Topics

Integration with Platform’s Load Sharing Facility (LSF)

Integration with PBS (Portable Batch System) Professional from Altair
Engineering

The PBS Pro and PBS/Torque schedulers are only supported on Linux. Jobsmay be submitted in
any of the following ways :

l Job Submission GUI (new for this release)
l Using PBS commands (qsub, etc.) or the PBS gui (xpbs)

ANSYS Electromagnetics software has been tested with the following version of PBS Pro:
l PBS Pro 10.1.0.91350
l PBS/Torque 2.5.12

Selecting the Scheduler for the Job Submission GUI
Before launching the product, the environment should be set for submitting a job to the scheduler.
The PBS scheduler is selected using the Select Scheduler dialog box. The Tools >Job
Management>Select Schedulermenu item opens the Select Scheduler dialog box. Select the
pbsmenu item and the software detects and reports whether PBSPro or PBS/Torque scheduler is
configured, as shown below:
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Clicking theRefresh button connects and loads information from the scheduler, including the variant
(PBSPro or PBS/Torque) and version information.
The example below shows the data displayed for PBSPro:

and the following example shows the data displayed for PBS/Torque:

JobManagement User Interface for PBS
Compute Resource Selection Parameters for PBS
Non Standard Installations for PBS
Limitations on Submitting Jobs in PBS
General PBS Limitations
Monitor Job using Graphical Interface for PBS
Submitting ANSYS EMPBS Batch Jobs
qsub Arguments
Monitoring ANSYS Electronics Desktop PBS Batch Jobs
Example PBS qsub Command Lines

Job Management User Interface for PBS

After setting the job submission node, select Tools>Job Management>Submit Job... to open the
Submit Job To: dialog. This contains three tabs:
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l Analysis Specification--specify the Product path, Project name, the setups, jobmonitoring,
and analysis options such as batchoptions, or, for advanced users, Environment variables.

l Compute Resources--this tab can be populated either by automatic settings, by predefined
Analysis Configuration, or specifying parameters in the fields for resource selection, for job
parallelization and enabled forms of parallelization.

l Scheduler Options--contains fields for Job name and priority. The customization options
shown by checking advanced are not used for WindowsHPC.
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In theAnalysis Specification tab, enter the pathnames of the product path and of the project file in
the “Project” edit box. Thesemust be UNC paths that are accessible from each compute host used
for ANSYS Electromagnetics jobs. The submission user must have permission to write to the
directory containing the project file. The Project can be an archive.
You can select which setups are analyzed in the Analyze Setups section of this dialog. There are
radio buttons to select:

l All setups in the project
l All setups in a specified design: you selects the design from the dropdown list
l Single setup:

If you specifymultiple setups, theywill be processed sequentially in the order displayed in the edit
box.
The Analysis options include:

l Monitor job. Youmust enable this option tomonitor the job from the user interface.
l Wait for license- whether to wait until a license if available before starting a simulation.
l Batch options. You can optionally specify -Batchoptions in the text field. See detailed
discussion of -Batch Options beginning under RunningMaxwell from aCommand Line.

TheAdd... button opens theAdd Batchoption dialog.
This dialog provides access to all -Batchoption commands. The drop downmenu lets you select
specific categories, and you can choose to display only frequently used commands. You can edit and
remove any batch options you specify.
Select a Registry Key. in order to show the current Value for the type. The lower field explains the
meaning of the Type Value.
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Any batchoptions for which you select Add will be visible in theSubmit Job dialog.

If you have the Show advanced options box checked in theSubmit Job dialog, the Environment
field and the Use batch extract fields display.

The Environment field lets you specify any Environment variables. Click the ellipsis button [...] to
display theAdditional Job Options dialog.
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Click theAdd... button to open theNew Environment Variable dialog.

Here you can provide a Variable name and Variable value. ClickOK to display the Variable in the
Additional JobOptions dialog. Select a Variable to enables theRemove and Edit... buttons. You
can also clickAdd Debug Environment Variables.

Any Variables that you add will be displayed in the Environment field of theSubmit Job dialog, if you
have also enabled Show Advanced options.

Use Batch Extract for PBS
Selecting Show advanced options for PBS also show the Use batch extract fields.
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See the discussion on RunningMaxwell from aCommand line for a discussion of the solve
information available through batch extract.
ThePreview Submission button opens a window that shows the text commands that will be sent to
the scheduler.

Compute Resource Selection for PBSPro and PBS/Torque
This section outlines how users will be able select compute resources for PBSPro and PBS/Torque
jobs using theGUI. Selections include:

l Use automatic settings. If you do not select this, you specify task and/or core parameters. If
you do, these task/core assignments aremade automatically.

l Resource selection parameters.
l Method - drop down list with selections for Number of tasks and cores, or Number of cores
and (optional) RAM, or Node List. Eachmethod has a different set of associated parameters.

l Task and Core parameters. The parameters offered depend onMethod selection.
l RAMparameters
l Job distribution.
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If you select Use automatic settingswith the Number of Cores and (Optional) RAM, the parameters
include Total number of cores, exclusive usage option, and RAMparameters. .
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Note If you select Use automatic settings, the solver does not support automatic distribution of
variations. The Use automatic settings option does not support Optimetrics variations. It
does distribute frequencies, domains, and use of multiple level domains.

If you select Use automatic settings and Number of Cores and (Optional) RAM, and do not select
Use RAM constraint, the text field is disabled

RAM Constraint
If you checkUse RAM Constraint, you can specify a GB RAM constraint.
In response to a set of minimal constraints, the Scheduler may increase the resources assigned
beyond theminimal values in order to meet the full set of requirements. Notice that a preview of the
Submit Job Results shows the number of resources assigned, and that the scheduler generated
code includes anMPI specification.
If you select Use automatic settings and Number of Nodes and Cores as theMethod, the choices are
for Number of Nodes and Cores.

No User Specified Node List
If you do not specify the "Individual nodes” method, then the node list edit control is disabled. The
user must specify resource selection parameters for nodes, cores, and tasks, depending on the
method selected. If the server is the default server, then an attempt ismade to determine if sufficient
resources to run the job are up and available to the job on the server before it is submitted. If the
server is the default server, and the queue is an execution queue, then an attempt ismade to
determine if sufficient resources to run the job are up and available to the job in the queue before the
job is submitted. If either check fails, the job is not submitted and an error message is returned. If the
server is not the default server, then there are no checks for sufficient resources before attempting to
submit the job.

Running Simulations 21-129
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

User Specified Node List for PBS
For PBSPro and PBS/Torque, a user specified explicit node list is supported when you select
Individual nodesmethod.

With Individual nodes selected, then youmay enter a list of nodeswith the number of cores and RAM
limit percentage. In this case, the qsub command requests exclusive access to each of these nodes
for the job. If the server for the job is the default server, then the node names are validated against
the execution nodes for the default server. If any of the requested nodes are not available for new
jobs, then the job is not submitted and an error message is returned. If the specified (or default)
queue is an execution queue, and any of the requested nodes are not available to this queue, then
the job is not submitted and an error message is returned. If the server is not the default server, then
the node names are not validated by the scheduler proxy. The total number of tasks and the cores
per distributed taskmay not be specified in this case.
If you specifymultiple individual nodes, you can use theMove Up andMove Down buttons to control
the order. Use the Remove button to delete the selected node.
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Scheduler Options tab for PBS
On the Scheduler options tab, you can specify a job name, and set a priority.

Running Simulations 21-131
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Related Topics

Integration with PBS (Portable Batch System) Professional fromAltair Engineering

Compute Resource Selection Parameters for PBS

The user may specify the following compute resource selection parameters using the grid control in
the GUI:

l Queue
l QueueAtServer
l NodeAttributes

These parameters are described inmore detail below.

Queue
The user can select a queue for the job from the list of queues configured for the default server. Only
queues that are enabled and that do not have the from_route_only attribute set to true are
listed.
The image below shows theCompute Resource Selection Parameters dialog with no
parameters specified:

The example below shows the user selecting the queueworkq from a dropdown list containing all of
the queues available at the default server.

Either the Queue or the QueueAtServer parameter may be specified, but bothmay not be specified.
If neither the Queue parameter nor the QueueAtServer parameter is specified, then the job is
submitted to the default queue at the default server.

QueueAtServer
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The user may specify a queue at the default server or at another server. The user may enter any text
into this field. The user may enter a string in one of the following forms:

1. queue_name
2. @server_name
3. queue_name@server_name.

Using the first form, the job is submitted to the queue with name queue_name at the default server.
Using the second form, the job is submitted to the default queue at the server with name server_
name. Using the third form, the job is submitted to the queue with name queue_name at the server
with name server_name. The destination value of the -q destination option on the qsub
command line is the user specified string. This string will not be validated by the scheduler proxy
library.
The example below shows how to enter a destination in which only a queue is specified:

The example below shows how to enter a destination in which only a server is specified:

Finally, the example below shows how to enter a destination in which both the queue and server are
specified:

Either theQueue or theQueueAtServer parameter may be specified, but bothmay not be
specified. If neither theQueue parameter nor theQueueAtServer parameter is specified, then the
job is submitted to the default queue at the default server.
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NodeAttributes
You can specify additional node attributes for the job using theNodeAttributes parameter. Any text
can be entered into this field. If you specifymultiple attribute, they should be separated by the colon
character.

l For PBSPro, the contents of this field are appended to each chunk in the select resource
specification of the job submission command. You can specify any resources that are valid for
chunks inside a select resource specification.

l For PBS/Torque, the contents of this field are appended to each chunk in a nodes resource
specification of the job submission command. In addition, only nodes that match all node
features (or properties) included in theNodeAttributes string can be used by this job.

These are the only nodes considered when the software distributes cores to nodes. The image
below shows how to specify two node attributes separated by a colon character.

The image below shows Job Preview output, which indicates how the node attributes appear in the
job submission command for a PBS/Torque cluster.
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Related Topics

Integration with PBS (Portable Batch System) Professional fromAltair Engineering

Non Standard Installations for PBS

PBSPro
If the environment variable PBS_DEFAULT is set, the value of this environment variable will be used
as the name of the default server, instead of obtaining the default server name from the PBSPro
configuration file. The default pathname of the PBSPro configuration file is: /etc/pbs.conf. The
environment variable PBS_CONFmay be used to specify a different pathname for the PBSPro
configuration file.

PBS/Torque
If the environment variable PBS_DEFAULT is set, the value of this environment variable will be used
as the name of the default server, instead of obtaining the default server name from the PBS/Torque
server file. The name of the PBS/Torque server file is server_name, and it is installed in the
TORQUEHOME directory. By default, TORQUEHOME is /var/spool/torque. To specify a
different TORQUEHOME directory, the environment variable ANSOFT_TORQUEHOME should be
set to the pathname of the desired directory.

Related Topics

Integration with PBS (Portable Batch System) Professional fromAltair Engineering

Limitations on Submitting Jobs in PBS

This section outlines some of the limitations or restrictionswhen submitting jobs.

Submitting Jobs Via Ansoftrsmservice on a Different Host
Before starting the ansoftrsmsevice as a daemon on a job submission host, the 'Scheduler' section
of the ansoftrsmservice.cfgmust be specified.
This section contains two settings, 'SchedulerName', whichmust be set the string 'pbs', and
'ConfigString', whichmust be set to the pathname of the directory containing the PBSPro or
PBS/Torque commands.
Here is an example ansoftrsmservice.cfg file, showing the format of this file and an example
'ConfigString' setting:

$begin 'AnsoftCOMDaemon'
$begin 'Managed COM Servers'
$end 'Managed COM Servers'
$begin 'Scheduler'
'SchedulerName'='pbs'
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'ConfigString'='/share/pbs/default/bin'
$end 'Scheduler'
$end 'AnsoftCOMDaemon'

General PBS Limitations

l There is no support for GPUswhen submitting jobs via the GUI.
l Support for PBSPro and PBS/Torque is only available on Linux;Windows is not supported.
l Staging of input or output files is not supported for jobs submitted using theGUI.
l All jobs submitted via the GUI are independent jobs. Neither job dependencies nor job arrays
are supported.

l If the user -specified server is not the default server, there is no check for sufficient resources
before submitting the job.

l If the user specified server is not the default server, the limit on the number of tasks per node is
ignored for both PBSPro and PBS/Torque. For PBS/Torque, only one taskwill be allocated
for each node. For PBSPro, the scheduler may allocate any number of tasks to a node,
provided that the node has sufficient cores for all of the tasks.

l For jobs submitted to a routing queue, the check for sufficient nodes and cores by the
scheduler proxy only verifies that there are sufficient nodes and cores associated with the
server.

l The queue attributes “resources_max” and “resources_min” are not checked when
determining whether there are adequate resources to run the job.

PBSPro Limitations

l For the current version to get the correct machine list for the job from the scheduler, the PATH
in the submission user’s default environment must include the directory containing the
PBSPro commands.

l No explicit support for failover is included for this release.
l HPC Basic Profile Jobs are not supported.
l Globus vnodes are not supported.When the scheduler proxy checks for sufficient nodes and
cores for the job, only nodes of type PBS are considered.

l For jobs submitted to an execution queue, the only vnode attribute used to determine if a
vnode is available to the job is the queue attribute.

PBS/Torque Limitations

l When the scheduler proxy checks for sufficient nodes and cores for the job, only nodes of type
cluster are considered.

l The exclusive checkbox has no effect for PBS/Torque.
l For PBS/Torque, even if a job is submitted to an execution queue at the default server, there is
no check for sufficient nodes and cores available to the queue. All of the server’s execution
nodes are assumed to be available for the job.
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l For PBS/Torque, there are significant limitationswhen submitting a job in which the number of
tasks and number of cores per task are specified. Unlike PBSPro, there is no capability to
specify that the cores should be allocated in “chunks”. Instead, the submission command
includes the number of groups of nodes and the number of processors per node (ppn) for
each node in the group. To determine the size of each group and the ppn setting for each
group, the server nodes are examined from largest number of cores to smallest. Thismay not
be optimal because some of these nodesmay not be usable by the queue specified for the job,
or because the nodeswith the largest number of coresmay be busy. Similar issues could
occur for PBSPro, but they should be less likely, because only the nodes usable by the queue
are considered.

Related Topics

Integration with PBS (Portable Batch System) Professional fromAltair Engineering

Monitor Job using Graphical Interface for PBS

If you have checked theMonitor Job option on theSubmit Job To dialog,AnalysisSpecification
tab, you can invoke theMonitor Job window by clicking Tools>Job Management>Monitor
Jobs... This dialogmay also be brought up by checking theBegin monitoring this job now
checkboxwhen a job is successfully submitting using the job submission dialog.
Check boxes above themessage field let you filter themessages to include/exclude Errors,
Warnings and Info. You can choose toClear Progress Messages.
You can use check boxes at the lower left to Refreshmanually, or automatically at a specified
interval.
You also have command buttons to perform aClean Stop of a simulation between time steps, or to
Abort Job for a simulation.
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Related Topics

Integration with PBS (Portable Batch System) Professional fromAltair Engineering

Submitting ANSYS Electromagnetics PBS Batch Jobs
The PBS qsub commandmay be used to submit ANSYS Electromagnetics batch jobs. The typical
command format is:

qsub qsub_argsscript

where:
l qsub_args are the options of the qsub command,
l script is the pathname of the job script.

The job script is a shell script containing the ANSYS Electromagnetics batch command or
commands to be run. If a batch command line contains any characters that are special to the shell
running the script, then these special characters should be quoted, as needed. The job script may
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also contain PBS directives on lines before the first executable line of the script. Anyqsub options on
the command line will take precedence over the PBS directives in the job script.
When a PBS batch job is started, the job script runs as the job user in a new shell. In this shell
environment, the pathmust include the directory containing the PBS commands

Note You should ensure that the PATH variable set in the shell startup script, i.e., .cshrc, .profile,
.bashrc, etc. includes the directory containing the PBS commands. For example:

export PATH=/opt/pbs/default/bin:$PATH

If the PATH variable is not set correctly, the job runs only locally, the batch log file shows
the list of allocated hosts as empty, and the error file shows an error (sh: qstat: command
not found.)

Further PBS directives need to be on top of the job script file. This is discussed in the PBS
documentation.

Serial PBS Batch Jobs

In the PBS documentation, serial batch jobs are also called single-node jobs. In general, any job
submitted without specifying the -l nodes=value command line argument, will run as a serial or
single-node job.
See the section onMonitoring ANSYS Electromagnetics PBS Batch Jobs for options that can
facilitate monitoring of ANSYS Electromagnetics batch jobs.

Parallel PBS Batch Jobs

In the PBS documentation, parallel batch jobs are also calledmulti-node jobs.When an ANSYS
Electromagnetics batch job is run as an PBS parallel job, the PBS scheduler will select the hosts for
the distributed analysis job based on the qsub command line arguments, the PBS resource
directives from the job script, and the status of the hosts when the job is run. The desktop processwill
be started on one of these hosts. The desktop processwill obtain the list of hosts allocated to the job
from the PBS scheduler, and start analysis processes on these hosts, as needed, using the PBS
scheduler facilities. To run a PBS parallel job, the jobmust be submitted with a -l nodes=value qsub
command line argument or with a -l nodes=value PBS directive in the job script.
See the section onMonitoring ANSYS Electromagnetics PBS Batch Jobs for options that can
facilitate monitoring of ANSYS Electromagnetics batch jobs.

Related Topics

Monitoring ANSYS Electromagnetics PBS Batch Jobs
Example PBS qsub Command Lines
What a Scheduler Does
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qsub Arguments

The PBS qsub command has a large number of options for control of the submission process. In this
section, we review the -l nodes=valuecommand line option with ANSYS Electromagnetics parallel
batch jobs.
This option or directive has the following format:

-l nodes=node_spec[+node_spec...][#suffix]

where node_spec is one of the following
nodename[:pc_spec[:pc_spec...]]

Host name of the specified node, followed by optional ppn or cpp specifiers.

[N][:property[:property...]][:pc_spec[:pc_spec...]]

Optional number of nodes, followed by optional node properties, followed by optional ppn or
cpp specifiers. If the numberN is omitted, then the default value of 1 host is used.

Here, the optional ppn or cpp specifiers pc_spec are of form:
ppn=X

Number of processes (tasks) per node. Default is 1 if not specified.

cpp=Y

Number of CPUs (threads) per process. Default is 1 if not specified.

The optional global suffix, #suffix, which applies to all hosts has one of the following values:
#excl

This suffix requests exclusive access to the allocated nodes.

#shared

This suffix requests shared (i.e., non-exclusive) access to the allocated nodes.

The total number of requested processes is determined by adding up the product of the number of
nodes and the number of processes per node for each node_spec. In general, this shouldmatch the
number of distributed engines specified in the ANSYS Electromagnetics desktop -Machinelist
num=num_distributed_enginescommand line option.
The number of CPUs per process (cpp) specified in the PBS qsub command line or in the PBS
directives in the script file should generallymatch the number of processors per engine specified in
the Desktop -batchoptions value.
See the PBS documentation for a complete list of options for the bsub command, and further
information on runningmulti-node jobs.

Related Topics

Integration with PBS (Portable Batch System) Professional fromAltair Engineering
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Monitoring ANSYS Electromagnetics PBS Batch Jobs
Example PBS qsub Command Lines

Monitoring ANSYS Electromagnetics PBS Batch Jobs

The suggestions below may be used for ANSYS Electromagnetics Batch jobs run under PBS.

PBS qstat Command
The PBS qstat commandmay be used to display information on jobs and queues. In this section,
several qstat command line options that may be used tomonitor job progress are described.

l The qstat -a command displays information about all jobs in the system.
l The qstat -r command displays information about all running jobs in the system.
l The qstat -s command resembles the qstat -r command; the only difference is that a
comment from the scheduler or batch administrator is also shown for each job.

l The qstat -au userid command displays information about all jobs owned by user userid.
l The qstat -f jobid command displays all available information about the job with id jobid.

See the PBSmanual pages for more information.

ANSYS Electromagnetics -monitor Command Line Option for PBS
The ANSYS Electromagnetics -monitor command line option enables batch job output to the
standard output and standard error streams. The warning, info, and progressmessages are sent to
the standard output stream. The error and fatal messages are sent to the standard error stream.
The PBS scheduler redirects the standard output and standard error streams of batch jobs to files
specified in the qsub -o [hostname:]pathname and the -e [hostname:]pathnamecommand line
options, respectively. If either option is not specified, then the associated stream is redirected to the
default file pathname for that stream.
The qsub -j join option controls whether the standard error stream for the job will bemerged with
the standard output stream for the job. A join value of oe indicates that the interleaved standard
output and standard error will be sent to the standard output file or stream. A join value of oe
indicates that the interleaved standard output and standard error will be sent to the standard error file
or stream. A join value of n indicates that the standard output and standard error streamswill not be
joined. If the qsub -j join option is not specified, then the standard error and standard output
streamswill not be joined.
A user canmonitor the progress of a job by checking the standard output file for progress, info and
warningmessages, and checking the standard error file for error and fatal messages.

Related Topics

Integration with PBS (Portable Batch System) Professional fromAltair Engineering
qsub Arguments
Example PBS qsub Command Lines
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Example PBS qsub Command Lines

All of the following examples show how to submit Linuxmaxwell jobs on PBS, but similar command
lines and job scripts will work for all ANSYS Electromagnetics products. Most of the following
examples are PBS "Single-node jobs." The last example is a PBS "multi-node jobs"; this examples
demonstrate how to specify the allocation of threads, tasks and nodes to a job.

Serial job:
qsub ~/pbs_scripts/OptimTee.sh

Job Script File:
#!/bin/sh
/opt/AnsysEM/AnsysEM18.0/ansysedt -ng -BatchSolve
~/projects/OptimTee.aedt

Serial job that needs a minimum of 4GB memory and two hours of real (wallclock) time:
qsub ~/pbs_scripts/OptimTee.sh

Job Script File:
#!/bin/sh
#PBS -l walltime=2:00:00
#PBS -l mem=4gb
/opt/AnsysEM/AnsysEM18.0/ansysedt -ng -BatchSolve
~/projects/OptimTee.aedt

Multi-processing job using 4 cores:
qsub ~/pbs_scripts/OptimTee.sh

Job Script File:
#!/bin/sh
#PBS -l ncpus=4
/opt/AnsysEM/AnsysEM18.0/ansysedt -ng -BatchSolve -
batchoptions "'Maxwell3D/Preferences/NumberOfProcessors'=4"
~/projects/OptimTee.aedt

l The #PBS -l ncpus=4 directive indicates that four cores or CPUs are allocated to this job.
l The -batchoptions option indicates that Maxwell should use four cores for multi-processing.

Distributed processing job using 4 engines on a single host:
qsub ~/pbs_scripts/OptimTee.sh

Job Script File:
#!/bin/sh
#PBS -l ncpus=4
/opt/AnsysEM/AnsysEM18.0/ansysedt -ng -BatchSolve -Distributed

-machinelist num=4
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~/projects/OptimTee.aedt

l The #PBS -l ncpus=4 directive indicates that four cores or CPUs are allocated to this job.
l The -Distributed option indicates that this is a DSO job, so that multiple engineswill be started.
Because 4 cores are allocated to the job, the job will run 4 engines. The -Distributed option
may now have additional options, such as includetypes=xxx, excludetypes=xxx, maxlevels=n,
and numlevel1=n, where n indicates and integer, and xxx indicates a list of distribution types or
"default".

Distributed processing and multi-processing job using 8 cores on two nodes, running 4
engines (two per node) with 2 cores for multi-processing:

qsub ~/pbs_scripts/OptimTee.sh

Job Script File:
#!/bin/sh
#PBS -l nodes=2:ppn=2:cpp=2#excl
/opt/AnsysEM/AnsysEM18.0ansysedt -ng -BatchSolve -Distributed
-machinelist num=4 -batchoptions
~/projects/OptimTee.aedt

l The PBS directive #PBS -l nodes=2:ppn=1:cpp=2#shared indicates that two nodes are
requested [2], two processes (engines) run on each node [ppn=2], and each processwill use
two cores [cpp=2]. The hosts allocated to this jobmay not be used for any other jobswhile this
job is running [#excl].

l The -machinelist num=4 option indicates that this is a DSO job and that a total of four
engineswill be started.

Related Topics

Integration with PBS (Portable Batch System) Professional fromAltair Engineering
qsub Arguments
Monitoring ANSYS Electromagnetics PBS Batch Jobs
Example PBS qsub Command Lines

Integration with Grid Engine (GE)

Before Sun was acquired byOracle, this job scheduler was an open source product, and it was
known as SunGrid Engine (GE). Since the acquisition, the product has been renamedOracle Grid
Engine (OGE), and new versions are expected to be closed source versions. TheOpenGrid
Scheduler project hosted on SourceForge plans to continuemaintaining an open source version.
Any of the versionsmay also be calledGrid Engine (GE).
TheGrid Engine scheduler is only supported on Linux.With GE, jobsmay be submitted in any of the
following ways:

l UsingGE commands (qsub, etc.) or the GE gui (qmon)
l Using the generic scheduler GUI in local mode
l Using the generic scheduler GUI in servicemode
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This release has been tested with the following versions of GE:
l SGE (Sun) 6.2u6
l OGS (Oracle) 2011.11
l Univa: 8.1.3

ANSYS Electromagnetics products support Grid Engine (GE) for Serial analysis, Multi Processing
and Distributed Analysis. Models with parametric sweeps can use Large Scale DSO.With GE, the
ANSYS Electromagnetics job doesn't require graphics. ANSYS Electromagnetics job progress can
bemonitored throughGE(SGE) commands or in the dialog opened through Tools>Job
Management>Monitor Jobs....
In addition to the command line interface, you can also use a JobManagement user interface to
submit jobs.

Related Topics

JobManagement User Interface for SGE
Command Line Enhancements for ANSYS Electromagnetics Desktop Products
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Installation of ANSYS Electromagnetics Tools on SGE

Windows:
Install on every node of cluster
Setup ‘temp directory’ to a path that is same on all nodes. For example, c:\temp

Linux:
Install on a single node, on a shared drive.
Setup ‘temp directory’ to a path that is same on all nodes. For example, /tmp
Ensure that the product is available using the same path on all nodes

Permissions:
All users of the cluster should have read/write permissions to temp directory
All users should have read/execute permissions to installation directory

When a desktop scheduler GUI is run the same node as the job submission node, no other
configuration is necessary: installation is sufficient. You select the scheduler through the desktop
GUI. You need to ensure that scheduler commands are available in the path before you launch
desktop.

Note There is no need to install RSMunless the you are using the scheduler GUI on a post
processing node that is different than the than the job submission node. In this case, RSM
must be configured with the scheduler type and path.
A post processing nodes is a node in the cluster that can run the ANSYS Electromagnetics
desktop in graphical mode. A job submission node is a node in the cluster in which job
submission commands are available.

Turn OFF firewall between cluster nodes.
Scenario 1: The post-processing node and job-submission node roles are served by
distinct machines.
In this case, perform the following configuration:
The job-submission node should be configured to run the RSM service, which serves as a proxy to
scheduler. The RSMService should be running as 'root' in order to facilitate jobs running using the
credentials of the job's owner. A configuration file in the RSM installation folder should be
edited to specify information regarding the scheduler that manages jobs on this cluster. A block
labeled 'Scheduler' must be included within the 'AnsoftCOMDaemon' block. This block contains two
string entries:

l SchedulerName: this contains the unique part of the scheduler proxy library name
l ConfigString: this contains a scheduler specific configuration string

The case of the SchedulerName string is significant on Linux because Linux file names are case
sensitive. The case of the SchedulerName string is not significant onMicrosoft Windows. In ANSYS
Electromagnetics Suite 18.0, the possible scheduler names are: lsf and sge. The ConfigString entry
is a scheduler specific configuration string, described below.
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In addition, the AnsoftRSMServicemust be started with appropriate environment variables set.
Generally, the environment variablesmust be set the same as theywould be set for using the
scheduler via command lines.
SGE Details
For SGE, the ConfigString entrymust contain the search path for the SGE commands. It may
contain a single directory, the directory containing the SGE commands. Alternatively, it may be a
path, with directories separated by the colon character ":", where the SGE command directory
appears before any other directory containing files with the same name as any SGE commands.
Example ansoftrsmservice.cfg configuration file:

$begin 'AnsoftCOMDaemon'
$begin 'Managed COM Servers'
$end 'Managed COM Servers'
$begin 'Scheduler'
'SchedulerName'='sge'
'ConfigString'='/opt/sge6.2u4/bin/lx24-amd64'
$end 'Scheduler'
$end 'AnsoftCOMDaemon'

Scenario 2: The post-processing node and job-submission node roles are served by the
same machine.
TheSelect Scheduler... command (as described in the JobManagement User Interface for SGE
section) is used to gather details about the scheduler. In this case, the Desktop process should be
started in an environment suitable for submitting jobs to the scheduler.
The environment should be configured so that all SGE commands are found using the standard
search path. In particular, search for the following commands in the search path should result in the
SGE command being found: "qsub", "qdel", "qstat", and "qconf". No other commandwith the same
name should appear before the SGE command in the search path.
Related Topic
JobManagement User Interface for SGE
Command Line Enhancements for ANSYS Electromagnetics Desktop Products

Job Management User Interface for SGE

The JobManagement UI is accessed by running ANSYS Electromagnetics product Desktop on the
designated 'Postprocessing node' of the cluster. The Desktop providesUI commands for Scheduler
selection, Job submission and Jobmonitoring/control. You access the Scheduler User Interface by
clicking Tools>Job Management>Select Scheduler.
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Before you can useSubmit Job, youmust clickSelect Scheduler as the one-time initial step. This
opens theSelect Scheduler dialog.

Specify the following parameters:
l Job submission node: this is the node on the cluster where scheduler commands (such as
SGE's qsub) are allowed to run.
ChooseUse this computer if scheduler commands are enabled on the post-processing
node.
ChooseUse a computer on network if the cluster is configured in amanner as to disallow
job-submission from the post-processing node. Specify node name appropriately.
Pre-requisites: For this choice to work, the job-submission nodemust already be configured
with a running RSM service, as documented in Installation of ANSYS Electromagnetics Tools
on SGE.

l Scheduler: Available choices, depending on your installations, are: RSM, lsf, WindowsHPC,
and SGE. It is also possible for you to integrate a custom scheduler into this UI, through a
scheduler proxy. When this is done, more choiceswill be available in the combo-box, one per
custom scheduler proxy that is deployed in the installation.

After specifying the job submission node, you can clickRefresh. The scheduler information is then
listed in the Scheduler info text field.

Running Simulations 21-147
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Once you select a scheduler, you can access the interface for job submission, monitoring and
control. ClickOK to close the dialog.
You access the Job submission UI by clicking Tools>Job Management>Other
Schedulers>Submit Job.... This command launches amulti-tab Submit Job To: dialog similar to
the one shown below.
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l TheAnalysis Specification tab has parameters to specify the input project model, the
analysis setup and analysis options (including batchoptions) that affect analysis algorithms.

l TheCompute Resources tab specifies the amount of compute resources and how to select
specific resources from the available pool (for example, ParallelEnvironment is an SGE
parameter).

l TheScheduler Options tab has analysis-independent parameters specific to the job, such
as name, priority.

Analysis Specification tab for SGE
This tab lets you specify the following:
Product Path:
You can specify the product path.
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Project:
You can use the ellipsis button [...] to use a navigation window to browse. The path should be
visible to all nodes in the cluster. The Project can be an archive.

Analysis Setups:
Specify All setups in the project, all in a design, or a single setup. If the setup includes a
parametric sweep, theUse large scale DSO check box is enabled.
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Analysis Options:
l You have check boxes for whether to Monitor Job through theGUI, and whether toWait for
license.

l You can also specify Batchoptions. Click theAdd... button to open a dialog for selecting the
Batchoptions.

The lower Value field shows the legal values for the selected registry key. You can type the
desired value into the upper text field under value. Click theAdd button to accept the selection
of the registry keywith the specified value. ClickDone close theAdd Batchoption dialog.
At the upper left, a drop downmenu lets you specify which registry key categories to display,
whether All, or selected category.
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A check box lets you choose between displaying only frequently used entries (the default), or
by unchecking, all options available for the selected group.
Note that for Large Scale DSOproblems, you also have the option to specify predefined
configurations.

The added registry keys and values are listed in the Batchoptions field of theSubmit Job
dialog.

Selecting from the list enables buttons for removing or editing registry key values. Selecting a
registry key and clickingEdit... opens theEdit Batchoptions dialog.
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Here you can edit the Value field and update the value for the selected registry key.
Environment:

If you check theShow advanced options check box, you can see the Environment field.

This permits specifying Environment Variables. Click the ellipsis button [...] to open the
Additional Job Options dialog.
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TheAdd button permits you to specify your environment variables. Once, added, you can select
Remove or Edit. TheAdd Debug Environment Variables button adds variables of use in
working with support.

l TheSave Settings as Default button lets you save a current set of values as defaults the
next time you invoke the Scheduler GUI. This can simply subsequent job submissions.

Use Batch Extract for Grid Engine
SelectingShow advanced options for Grid Engine also show theUse batch extract fields.

See the discussion on RunningMaxwell from aCommand line for a discussion of the solve
information available through batch extract.

Compute Resources Specification Tab
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This tab lets you provide Resource selection and Job parallelization parameters. Once you have
specified parameters, you can Save Settings asDefaults, Preview a Submission, and Submit a job.

You can also populate this page yourself by specifying Resource selection, Job Parallelization
parameters, and Job distribution parameters.
This tab lets you provide Resource selection and Job parallelization parameters. You can elect to
User automatic settings for job distribution, specify aMethod and resource selection parameters,
or job distribution parameters.

Note If you select Use automatic settings, the solver does not support automatic distribution of
variations. The Use automatic settings option does not support Optimetrics variations. It
does distribute frequencies, domains, and use of multiple level domains.

You can also uncheckUse automatic settings. Doing so requires you to also specify Cores per
distributed task and enables the Job distribution fields.

Running Simulations 21-155
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Resource Selection:
If you do not specify parameters for resource selection, SGEmay submit jobs to anymachine in the
entire pool that is available.

l Resource selection parameters.
Clicking the ellipsis button [...] opens a dialog for parameters specific to SGE, in this case
ParallelEnvironment. The Specify Parameter check box in the dialog enables a parameter,
and you can select the Value for the ParallelEnvironment parameter from a drop downmenu.
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If you don’t specify a parameter, the scheduler handles the situation.
l Specify node list
Checking Specify node list enables the field for specifying a node list. In a computing
environment where the available cores are not uniform, you can use this to have control over
which resources your job will use. If your Analysis configuration contains a node list, you can
use Populate this Page fromAnalysis Configuration.

Method
For theMethod, use the drop down to select Number of Cores and (Optional RAM) or Number of
Nodes and Cores.
Total Number of Cores
You can specify a Total number of cores, and whether the Nodes are exclusive to the job.
RAM Constraint and RAM Limit
If you checkUse RAMConstraint, you can specify a GB RAM constraint. You can also specify a
RAMLimit as a percent.
In response to a set of minimal constraints, the Scheduler may increase the resources assigned
beyond theminimal values in order to meet the full set of requirements. Notice that a preview of the
Submit Job Results shows the number of resources assigned, and that the scheduler generated
code includes anMPI specification.
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Job Distribution
l Enabled types, such asOptimetrics Variations, Frequencies, etc.

Preview submission
This opens a screen showing the qsub command to be used to submit the job.

Submit job actually sends the batch command to the SGE cluster.A dialog reports a successful
submit and presents a check box for monitoring.
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Scheduler Options Tab
This tab lets you give Job name and Priority
If you checkShow advanced options, you can also specify Job submission options.
The Job submission options permit you to customize a job submission in terms of addition job
submission options, or override a job submission command.
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When the "Override job submission" radio button is checked, the user specified options replacemost
of the job submission options, whereaswhen the "Additional job submission options" radio button is
checked, the user specified options are appended to the bsub command.
Text in the enabled field is appended to the bsub command. You can see the effects of any custom
additions by clickingPreview Submission.

Related Topics

Integrated JobMonitoring for JobManagement Interface for SGE
Scheduler Proxy Interfaces

Integrated Job Monitoring for Job Management Interface for SGE

The jobmonitoring/control dialog is launched through the command Tools>Job
Management>Monitor Jobs... or by checkingBegin monitoring this job now in the information
window reporting successful job submission.

In response to either invocation, the Monitor Job dialog opens:
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In this dialog, you can select the job tomonitor from a pull down list of recent jobs.

The lower left has corner of the dialog has options for manual refresh or to Automatically refresh
every specified number seconds. After refresh, themessages for the job are displayed.The lower left
has corner of the dialog has options for manual refresh or to Automatically refresh every specified
number seconds. After refresh, themessages for the job are displayed.
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You can choose toClear Progress Messages. TheClean Stop button lets you stop the simulation
cleanly between time steps.
TheAbort Job button lets you abort a job.

Related Topics

Scheduler Proxy Interfaces
JobManagement User Interface for SGE

SGE Command Line Interface

SGE Commands for Information About Jobs and Cluster Configuration
The following SGE commands are especially useful for getting information about the cluster
configuration or for getting information about running or completed jobs. This list only contains a few
of themost common commands. Consult the SGEman pages for a complete list andmore details.

qconf -help: The first line displays the SGE version
qacct -j job-id: Displays a log of the completed job with id job-id (if accounting is enabled)
qstat -j job-id: Displays a log of the running job with id job-id
qconf -sc: Show all complex attributes
qconf -spl: Show a list of all parallel environments
qconf -sp pe-name: Show details of parallel environment named pe-name
qconf -sql: Show a list of all queues
qconf -sq queue-name: Show details of queue named queue-name
qconf -sconf: Show configurations

Submitting ANSYS Electromagnetics SGE Batch Jobs
The SGE qsub commandmay be used to submit ANSYS Electromagnetics jobs. Typical command
formats are:

qsub qsub_argsansysEM_exeansys_args
qsub qsub_argsjob_script
qsub qsub_args[ -]

where:
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l qsub_args are the options of the qsub command,
l ansysEM_exe is the pathname of the ANSYS Electromagnetics tool executable to launch,
l ansys_args are the arguments to the ANSYS Electromagnetics tool command, and
l job_script is a shell script containing the ANSYS Electromagnetics desktop command to run.

In the first format, the ANSYS Electromagnetics desktop command and its arguments are specified
on the qsub command line. In the second format, the pathname of a shell script containing the
ANSYS Electromagnetics desktop command and its arguments is specified on the qsub command
line. In the third format, the command is omitted or replaced with a hyphen; this indicates that the
command or script will be taken from stdin.

Quoting ANSYS Electromagnetics Command or Arguments for SGE
If the ANSYS Electromagnetics tool executable pathname (ansys_exe) or any of the arguments of
the ANSYS Electromagnetics tool command (ansys_args) contain characters which are interpreted
by the command shell, then these special charactersmust be properly quoted to ensure that the
correct command is launched by SGE. This is especially important when using the first form of the
qsub command, as the ANSYS Electromagnetics desktop command is processed by the shell twice
in this case. It is processed by the shell when the qsub command is processed, and again when the
job is started.

Serial SGE Batch Jobs
In general, ANSYS Electromagnetics batch jobsmay be submitted as SGE serial jobswithout any
special considerations.
SeeMonitoring ANSYS Electromagnetics SGE Batch Jobs for options for monitoring ANSYS
Electromagnetics batch jobs.

Parallel SGE Batch Jobs
When an ANSYS Electromagnetics batch job is run as an SGE parallel job, the SGE scheduler will
select the hosts for the distributed analysis job, and start the desktop process on one of these hosts.
The desktop processwill obtain the list of hosts from the SGE scheduler, and start analysis
processes, as needed, using the SGE scheduler facilities. To run an SGE parallel job, the jobmust
be submitted to an SGE parallel environment (PE).
If the qmaster tcp port is not configured as a service, but rather via the environment variable SGE_
QMASTER_PORT, this variablemust be set in the ANSYS Electromagnetics batch job
environment. This is needed because the ANSYS Electromagnetics desktop uses the "qrsh -inherit"
command to launch engine processes.
SeeMonitoring ANSYS Electromagnetics SGE Batch Jobs for options for monitoring ANSYS
Electromagnetics batch jobs.

Setting Up an SGE Parallel Environment (PE)
To allow ANSYS Electromagnetics batch jobs to distribute analysis engines tomultiple hosts, the job
must be run in a parallel environment (PE) in which the control_slaves parameter is set to TRUE.
This setting is required to allow the ANSYS Electromagnetics desktop to start analysis engines on
hosts other than the local host, i.e., the host where the ANSYS Electromagnetics desktop is running.
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Here is a sample parallel environment configuration:
pe_name ans_test1
slots 999
user_lists NONE
xuser_lists NONE
start_proc_args /bin/true
stop_proc_args /bin/true
allocation_rule $round_robin
control_slaves TRUE
job_is_first_task FALSE
urgency_slots min
accounting_summary TRUE

The user_lists and xuser_lists parameters are ACLs (access control lists) used to control which
users have permission to use the parallel environment. The user_lists setting gives permission to use
the PE. The xuser_lists setting denies permission to use the parallel environment. The xuser_lists
settings override the user_lists settings.
The start_proc_args and stop_proc_args parameters contain the pathname and arguments for the
parallel environment startup and shutdown scripts. No startup or shutdown scripts are needed for
parallel ANSYS Electromagnetics batch jobs. The setting /bin/truemay be used as the value for
these scripts; this utility does nothing and returns an exit code indicating success (0).
The parallel environment allocation_rule parameter will affect how the analysis engine tasks are
distributed across the hosts allocated to the job. The $round_robin setting distributes the tasks
across the hosts in a round robin fashion, resulting in the load being relatively evenly distributed over
all of the hosts. The $fill_up setting allocates all slots on a host before distributing the tasks to another
host; the result is that most hosts are either fully utilized or completely unused. See the sge_peman
page for other settings for this parameter.
The control_slaves parameter must be set to TRUE, as described above.
The job_is_first_task parameter also affects how tasks are allocated.When submitting a job to run in
a parallel environment, the number of parallel tasks, n, is specified on the command line. If this
setting is TRUE, then the job process is considered one of the tasks, and only (n-1) additional tasks
are allocated to the job. If the setting is FALSE, then the job process is not considered to be one of
the tasks, and n additional tasks are allocated for the job.
See the sge_peman page for more information about these and other PE parameters.
A parallel environment does not run tasks directly. Instead, the tasks are distributed to queues
associated with the parallel environment. In order to complete the setup of a parallel environment,
one or more queues need to be associated with the parallel environment. The queue pe_list
parameter is used to specify the parallel environments (PEs) supported by the queue. This is an
important step; if no queues support a given PE, then jobs submitted to that PE will not
run.

Parallel Batch Job Command Line Considerations
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The number of engines run on a host will depend on the total number of distributed engines, and the
number of hosts allocated to the job. Thememory required on a host depends on the number of
engines running on the host and on thememory needed for each engine. The qsub command -l
resource=value,... or -q queue_list command line options specify that the parallel batch job run on
machineswith sufficient memory and other resources.

Related Topics

Monitoring ANSYS Electromagnetics SGE Batch Jobs
ANSYS Electromagnetics Desktop -monitor Command LineOption for SGE
Example SGE qsub Command Lines
Issue with MainWin Core Services for SGE
What a Scheduler Does
Recommended Practices for SGE Clusters

Monitoring ANSYS Electromagnetics SGE Batch Jobs

The suggestions below may be used for SGE serial jobs and for SGE parallel jobs.

SGE qstat Command
The SGE qstat commandmay be used to display information on jobs and queues. If the -j [job_list]
option is included, then information on jobs is displayed. If the -j [job_list] option includes a job list,
then the displayed information is limited to the jobs in the job list.
The -uuser,... option limits the output to jobs associated with users in the user list. If the -uuser,...
option is not specified, then information on queues or jobs of the current user are displayed.
The -t option displays extended information about the subtasks of each displayed job. This is
equivalent to the -g t option. The -r option displays extended information about the resource
requirements of the displayed jobs.
See the SGEmanual pages for more information.

Related Topics

Integration with SunGrid Engine (SGE)
JobManagement User Interface for SGE
Integrated JobMonitoring for JobManagement Interface for SGE
ANSYS Electromagnetics desktop -monitor Command LineOption for SGE
Example SGE qsub Command Lines
Issue with qrsh (SGE)
Issue with MainWin Core Services for SGE
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ANSYS Electromagnetics Desktop -monitor Command Line Option for SGE

The -monitor command line option enables batch job output to the standard output and standard
error streams. The warning, info, and progressmessages are sent to the standard output stream.
The error and fatal messages are sent to the standard error stream.
The SGE scheduler redirects the standard output and standard error streams of batch jobs to files
specified in the qsub -o [[hostname]:]path,... and the -e [[hostname]:]path,... command line
options, respectively. If either option is not specified, then the associated stream is redirected to the
default file pathname.
The qsub -j y[es] | n[o] controls whether the standard output and standard error streams are
merged. If the y or yes value is specified, then the standard error stream ismerged into the standard
output stream. If the -e host_and_path option is also specified in this case, the host_and_path setting
is ignored. If the n or no value is specified, or if this option is not specified, then the standard error
stream and standard output stream are not merged.
You canmonitor the progress of a job by checking the standard output file for progress, info and
warningmessages, and checking the standard error file for error and fatal messages.

Related Topics

Integration with SunGrid Engine (SGE)
Monitoring ANSYS Electromagnetics SGE Batch Jobs
Example SGE qsub Command Lines
Recommended Practices for SGE Clusters
Issue with qrsh (SGE)
Issue with MainWin Core Services for SGE

Example SGE qsub Command Lines

All of the following examples show how to submit LinuxMaxwell jobs on SGE, but similar command
lineswill work for other ANSYS Electromagnetics products.

Serial job using command line:
qsub -b y /AnsysEM/AnsysEM18.0/ansysedt -ng -BatchSolve
~/projects/OptimTee.aedt

l The -b y option indicates that electronics desktop is launched directly from the command line,
instead of using a script.

l No queue is specified, so the default queue will be used

Serial job with a hard runtime limit of 15 minutes:
qsub -b y -l h_rt=00:15:00 /opt/AnsysEM/AnsysEM18.0/ansysedt
-ng -BatchSolve ~/projects/OptimTee.aedt

l The -l h_rt=00:15:00 option indicates that this job has a "hard" runtime limit of 15minutes.
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Serial job using a script, with a runtime limit specified in the script:
qsub ~/sge/scripts/OptimTee.csh

l The -b y option is absent, so the script ~/sge/scripts/OptimTee.csh will be run when the job
starts.

l The script file OptimTee.cshmay contain SGE directives in addition to the command(s) to run.
In this example, a directive with a hard runtime limit if 15minutes is included in the script.

Script file contents:
#!/bin/csh
#$ -l h_rt=00:15:00
/opt/AnsysEM/AnsysEM18.0/ansysedt -ng -BatchSolve
~/projects/OptimTee.aedt

l The SGE directive #$ -l h_rt=00:15:00 is equivalent to including -l h_rt=00:15:00 on the qsub
command line.

Distributed processing job using 4 engines:
qsub -b y -pe pe1 4 /opt/AnsysEM/AnsysEM18.0/ansysedt
-ng -BatchSolve -Distributed -machinelist num=4
~/projects/OptimTee.aedt

l The -b y option indicates that maxwell is launched directly from the command line, instead of
using a script.

l The -pe pe1 4 command_line option indicates that this is a parallel job running under the pe1
parallel environment, and that 4 cores or processors are allocated to this parallel job.

l The "-machinelist num=n" option is now required for batch jobs.
l The -Distributed option indicates that this is a DSO job, so that multiple engineswill be
started. Because 4 cores are allocated to the job, the job will run 4 engines.

Related Topics

Integration with SunGrid Engine (SGE)
Monitoring ANSYS Electromagnetics SGE Batch Jobs
ANSYS Electromagnetics Desktop -monitor Command LineOption for SGE
Recommended Practices for SGE Clusters
Issue with qrsh (SGE)
Issue with MainWin Core Services for SGE

Recommended Practices for SGE Clusters

The following subsections contain recommendations on how to set up an SGE cluster for efficiently
running ANSYS Electromagnetics serial and parallel jobs. These recommendations require the
cluster administrator to make configuration changes.

Submitting Exclusive Jobs
ConsumableMemory Limits
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Serial Jobs in SGE
Parallel Jobs in SGE
UsingMultithreading with Parallel Jobs

Submitting Exclusive Jobs
In many cases, clusters are used to run "large" ANSYS Electromagnetics batch jobs. That is, these
are jobs that may require a large quantity of resources, such as processors, memory, disk space, or
run time. One way to ensure that the resources needed by the batch job are available to the job is to
run the job in an "exclusive" mode. That is, any host running the job is not available for use by any
other jobs. There is no SGE built in mechanism for specifying that a job is "exclusive". SGE is
extensible, and it is not difficult to configure the cluster to allow exclusive jobs. The steps below show
one way to do this. This example requires SGE 6.2u3 or later. Note that specifying a job as
"exclusive" may delay the start of the job if there are not enough hosts available to run the job
exclusively.

1. Use the command qconf -mcto add a new complex to the table of complexes. Recommended
attributes are:
l name : exclusive
l shortcut : excl
l type : BOOL
l relop : EXCL
l requestable : YES
l consumable : YES
l default : 0
l urgency : 0

2. Set the value of "exclusive" to TRUE for each execution host using the command qconf -me
hostname, where hostname is the name of the host. The values of all host configuration
parametersmay be displayed using the command qconf -se hostname. The "complex_values"
line should look similar to:
complex_values exclusive=TRUE, but other valuesmay also be included.

3. When submitting a job, the job will be "exclusive" if the value "excl" is included in the resource
list specified by the qsub -l option. If the resource list does not include "excl" then the job will
not be exclusive, and other jobsmay run on the same host or hosts as this job.

4. Example qsub command line for exclusive serial job:
qsub -b y -l excl /opt/AnsysEM/AnsysEM18.0/ansysedt -ng
-BatchSolve ~/projects/OptimTee.aedt.

Although serial jobs use only one slot, no other jobswill run on the host where this job is
running, even if additional slots are present.

5. Example qsub command line for exclusive parallel job using eight engines, each using a single
thread of execution:

qsub -b y -l excl -pe pe1 8 /opt/AnsysEM/AnsysEM18.0/ansysedt
-ng -BatchSolve -Distributed -machinelist num=8
~/projects/OptimTee.aedt

Running Simulations 21-168
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

None of the hosts used for this job will be allowed to run other jobswhile this job is running.

Consumable Memory Limits
SGE contains several built-in complexes related tomemory, includingmem_total, for example, but
none of these are "consumable". If a job is submitted with resource list including one of these non-
consumablememory complexes (such asmem_total), then the job will run on a host or hosts only if
sufficient memory is available. If a second job is submitted, thememory request for the second job is
compared to the original total when determining if the jobmay run on a host. Thismay result in both
jobs running out of memory. For example, if host A hasmem_total=16Gof memory, and two jobs are
submitting with option "-l mt=16G", then both jobs could run on host A, if sufficient slots are available
on host A.
SGE allows complexes to be "consumable" to avoid this type of problem. If a complex is consumable
and a job requests x amount of the complex in the -l resource list, then the available amount of the
resource is decreased by x for subsequent jobs. For the same example as above, if themem_total
complexwas consumable, then the first job would run on host A. This would decrease the available
mem_total from 16G to 16G-16G= 0. The second job could not run on host A because there is no
memory available for this job.
The steps below show how to set up a consumable resource called physical_memory to accomplish
the same thing.We do not recommend changing the behavior of the built-in complexes (such as
mem_total) because other scriptsmay expect normal behavior of the built-in complexes.

1. Use the command qconf -mcto add a new complex to the table of complexes. Recommended
attributes are:
l name : physical_memory
l shortcut : phys_mem
l type : MEMORY
l relop : <=
l requestable : YES
l consumable : YES
l default : 0
l urgency : 0

2. Set the value of "physical_memory" to an appropriate value for each execution host using the
command qconf -me hostname, where hostname is the name of the host. The appropriate
value is the actual physical memory on each host. Because the type isMEMORY, the K, M,
andG suffixesmay be used to represent kilobytes, megabytes and gigabytes. The values of all
host configuration parametersmay be displayed using the command qconf -se hostname. The
"complex_values" line should look similar to:
complex_values physical_memory=16G,
but other valuesmay also be included, and thememory value should be appropriate for the
host.

3. When submitting a job, the physical memory requirement per slot may be specified in the
resource list as follows: -l phys_mem=mem_needed. The number of slots assigned to the job
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on a specific host will be limited by the number of slots available on the host, and also by the
physical_memory available on the host.

Serial Jobs in SGE
If a serial job is submitted with the option -l phys_mem=mem_neededincluded, then the jobmay only
run on a host in which the remaining physical_memory is equal to or greater than themem_
neededvalue.
Example 1: Host A has physical_memory=16G, and host B has physical_memory=8G. If mem_
neededis 8G, the jobmay run on either host A or host B. If mem_neededis 16G, then the jobmay
only run on host A.
Example 2: Host A has physical_memory=16G, and host B has physical_memory=8G. Job 1 is
already running on host A, and it was submitted with option -l phys_mem=8G. If job 2 is submitted
with option -l phys_mem=16G, then job 2 cannot start until job 1 finishes, because only host A has
16GB of physical_memory. If job 2 is submitted with option -l phys_mem=8G, then job 2may start
immediately, and run on either host A or host B, because both hosts have 8Gof physical_memory
remaining.

Parallel Jobs in SGE
Because the consumable setting for physical_memory is YES (and not JOB), each slot of the job
requires a physical_memory of mem_needed. The number of slots on a host assigned to the job is
limited by the number of available slots on the host. It is also limited by the physical_memory
available on the host; the number of slots assigned to the job cannot exceed the available physical_
memory on the host divided by themem_neededspecification.
Example 1: Execution host A and execution host B both have 4 slots per host (configured in the
queue associated with the parallel environment). Host A has physical_memory=16Gand host B has
physical_memory=8G (shown by commands qconf -se Aand qconf -se B). If a a job is submitted that
requires 6 slots and 4Gper slot, it will be able to run, with 4 slots on host A and 2 slots on host B. The
qsub commandmight look like: qsub -l phys_mem=4G -pe pe_name 6 command args
Example 2: Same as example 1, except that 7 slots are requested. In this case, the job will never run.
Although there are 8 slots available on hosts A and B, only two of the slots on host B are usable by
this job because it only has physical_memory of 8G.With only 6 slots total available to this job (4 on
host A and 2 on host B), the job can not start. In this case the commandmight look like: qsub -l phys_
mem=4G -pe pe_name 7 command args

Using Multithreading with Parallel Jobs
For large jobs it may be useful to combinemultiprocessing with distributed processing. Distributed
processing refers to startingmultiple processes, in which each process performs a portion of the
analysis. These processesmay run on the same host or on different hosts. The number of processes
running at the same time is known as the number of "analysis engines". Multiprocessing refers to
usingmultiple threadswithin a single process to decrease the run time of the process.
Multiprocessingmay also be calledmulti-threaded processing.
As a concrete example of combiningmultiprocessing with distributed processing, an analysis could
run with four engines, where each engine uses two threads. In order to distribute the processing load
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so that no processor is overloaded, one slot is generally allocated per thread, so 8 slots would be
needed for this example (4 engines * 2 threads per engine = 8 threads). The four engines could all
run on a single host, or they could be distributed across 2, 3 or 4 hosts, depending on available slots.
Each engine represents a single process, so the two slots for each enginemust be allocated on the
same host.
This section describes how to set up an SGE cluster so that a specified number of slots per host may
be requested when a job is submitted. This procedure will require the cluster administrator
privileges. This capabilitymay be used to submit parallel jobs in which one engine runs on each host,
and the number of slots per host matches the number of threads used by each engine.

1. Let n be the largest number of slots available on any host used for the jobs. Create a separate
parallel environment for each value of the number of slots per host from 1 to n. For example,
pe_sph1 is a parallel environment in which one slot is allocated to the job per host, pe_sph2 is
a parallel environment in which two slots are allocated to the job per host, etc. The command
qconf -ap pe_namemay be used to create each new parallel environment. The allocation_rule
parameter should be set to the number of slots per host, an integer from 1 to n. The control_
slaves parameter should be set to TRUE, as described above. The slots parameter should be
set to themaximumnumber of slotsmanaged by this parallel_environment, which is typically
set to a large number, such as 999. The other parameters should be set to values appropriate
for the cluster. For example, the pe_sph2 parallel environment might have the following
parameters:
l pe_name : pe_sph2
l slots : 999
l user_lists : NONE
l xuser_lists : NONE
l start_proc_args : /bin/true
l stop_proc_args : /bin/true
l allocation_rule : 2
l control_slaves : TRUE
l job_is_first_task : FALSE
l urgency_slots : min
l accounting_summary : TRUE

2. When submitting a job, use the parallel environment where the slots per host matches the
number of threads per engine.

The batchoptions setting -machinelist num=n is required. This should be set to match the number of
slots per host. With any analysis, a portion of the analysismay not be distributed acrossmultiple
engines.
Example qsub command line for running distributed processing with four engines and
multiprocessing with two threads per engine:

qsub -V -b y -pe pe_sph2 8 "/opt/AnsysEM/AnsysEM18.0/ansysedt
-ng -BatchSolve -Distributed -machinelist num=4 -batchoptions
"projects/OptimTee.aedt"
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The -Voption indicates that the all environment variables in the submission environment should be
copied to the job environment.

l The -b y option indicates that Maxwell is launched directly from the command line, instead of
using a script.

l The -pe sph2 8 command_line option indicates that this is a parallel job running under the pe_
sph2parallel environment so that two slots are allocated to this job from each host, and that 8
slots in total are allocated to this parallel job.

l The -Distributed option indicates that this is a DSO job, so that multiple engineswill be started.
The -Distributed optionmay now have additional options, such as includetypes=xxx,
excludetypes=xxx, maxlevels=n, and numlevel1=n, where n indicates and integer, and xxx
indicates a list of distribution types or "default".

l The -machinelist num=4option indicates that a total of four engineswill be started.
l The entire Maxwell command is in double quotes, and the double quotes enclosing the -
batchoptions value are escaped. Each of these double quotes is replaced by the sequence
"\"".

Related Topics

Integration with SunGrid Engine (SGE)
Monitoring ANSYS Electromagnetics SGE Batch Jobs
ANSYS Electromagnetics Desktop -monitor Command LineOption for SGE
Issue with qrsh (SGE)
Issue with MainWin Core Services for SGE

Issue with qrsh (SGE)

ANSYS Electromagnetics parallel batch jobs use the SGE qrsh command to launch engine
processes on remote hosts. If the qrsh command is not working correctly, then the parallel job is
unable to launch engine processes on remote hosts. If this problem occurs, the batch log for the job
typically includes one or more error messages indicating that a COMengine was unable to be
started on a remote host. If this occurs, the user or cluster administrator should verify that the SGE
qrsh command is working correctly, and correct the problem if the SGE qrsh command is not
working correctly.
The qrsh commandmay be tested by running a simple command on a specified host, such asqrsh -
l hostname=host1 hostname or qrsh -l hostname=host1 ls /tmp, where host1 is the remote
host name. The first test should simply echo back the hostname of the remotemachine. The second
test should list the contents of the /tmp directory on the remotemachine.
The failures of the SGE qrsh command are associated with the following global sge configuration
parameters, listed below with values that may cause the failures:

qrsh_command /usr/bin/ssh -t
rsh_command /usr/bin/ssh -t
rlogin_command /usr/bin/ssh -t
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If these parameter settings are removed, then the SGE built-in mechanisms are used for qrsh, rsh,
and rlogin. No problemswith the built-in versions have been reported. The SGE qconf -sconf global
commandmay be used to view these parameter settings. The SGE qconf -mconf global command
may be used tomodify or remove these parameter settings.

Issue with MainWin Core Services for SGE

By default, SGE creates a temporary directory for each SGE batch job, and deletes this temporary
directory and its contents when the job finishes. SGE sets the TMP and TMPDIR environment
variables of the job environment to point to this temporary directory. ANSYS Electromagnetics
desktop software starts theMainWin Core Services on startup, if they are not already running. After
the ANSYS Electromagnetics desktop software finishes, theMainWin Core Services time out and
automatically shut down. TheMainWin Core Services use the TMP and/or TMPDIR directories to
store temporary data. If this temporary data is removed before the services shut down, then the
services do not shut down automatically. Normally, SGE will remove the temporary directory and its
contents before the services time out. The result is that these extraneous service processes run
forever. If this problem occurs, each ANSYS Electromagnetics batch job starts an additional set of
these services that never shut down. This can result in an excessive number of processes running on
the host where the ANSYS Electromagnetics desktop is started. The names of the service
processes are:

l watchdog
l regss
l mwrpcss

Workaround for Issue with MainWin Core Services
Oneway to avoid this problem is tomodify the environment in which the ANSYS Electromagnetics
desktop runs so that the TMP and TMPDIR environment variables do not point to the directory which
will be immediately removed by SGE when the job finishes. This can be done by copying the value of
the TMPDIR environment variable to the ANS_SGE_TMPDIR environment variable, and unsetting
the TMPDIR and TMP environment variables. The services ignore the ANS_SGE_TMPDIR
environment variable, but if this variable is set, then it will be used as the temporary directory for the
rest of the ANSYS Electromagnetics software.
Here is an example bash wrapper script that may be used to work around this issue. In this example,
the product ismaxwell, but the same approach will work for any ANSYS Electromagnetics product.
In this example, the script is named sge_maxwell and is in the AnsysEM software installation
directory. When an ANSYS Electromagnetics desktop job is submitted to the SGE scheduler, the
script (sge_maxwell, in this example) should be submitted instead of maxwell. The script will modify
the environment, as needed, then start maxwell. When the analysis finishes, the script returns the
exit status of maxwell.
An alternative is to place the script in an arbitrary directory, andmodify the script to include an
absolute path to the product (maxwell in this example).

Script contents:
#! /bin/bash
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# This script will not correctly process arguments containing
# spaces or other characters special to the shell.

# Create maxwell command line
# In this example, sge_maxwell and maxwell are in the same
directory
# An alternative is to use an absolute path for the maxwell
command
cmd0=$0
cmd="${cmd0/%sge_maxwell/maxwell} $@"

# Fix environment variables
export ANS_SGE_TMPDIR=${TMPDIR}
unset TMPDIR
unset TMP

# Run the maxwell command and return the exit status
${cmd}
exit $?

Related Topics

Integration with SunGrid Engine (SGE)
Monitoring ANSYS Electromagnetics SGE Batch Jobs
ANSYS Electromagnetics Desktop -monitor Command LineOption for SGE
Example SGE qsub Command Lines
Issue with MainWin Core Services for SGE
Recommended Practices for SGE Clusters

Integration with ANSYS RSM Cluster (ARC)

Jobsmay be submitted to an ANSYS RSMCluster using ANSYS EKM (Engineering Knowledge
Manager). Job submission to an ANSYS RSMCluster is not currently supported via a command line
or via the ANSYS Electronics DesktopGUI.
The ANSYS RSMCluster (ARC) scheduler may be used as alternative to third party job schedulers,
such asMicrosoft HPC or LSF. The ARC scheduler may be used to submit jobs to a singlemachine
or to run on a group of machines. Every ANSYS RSM installation has one predefined cluster
configuration, localhost, that allows the ARC scheduler to submit jobs to the local machine. This
configurationmay be used without requiring additional setup beyond what is needed for ANSYS
RSM installation.
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The ARC scheduling system operates in two distinct modes: basic and advanced. In basicmode,
jobs run on a single cluster node only, which can be the local machine or a single remotemachine. In
advancedmode, jobs can run on one or more remotemachines. This requires installation and
configuration of the cluster services on each of the cluster machines. See the ANSYS Remote Solve
Manager (RSM) documentation for details on configuring the ARC cluster.
In addition to configuring the ARC scheduling system, the EKMportal must be configured to allow
submission of jobs to the ARC scheduler. EKMqueuesmay be configured for submission of jobs to a
basic or advanced ARC scheduling system.
You can submit jobs to an ARC scheduler using EKM in amanner similar to submitting jobs to any
other cluster supported by EKM.
Here is a brief outline of the steps for submitting a job:

1. Login to the EKMportal.

2. Select Jobs in the dropdown list box in the upper left corner.
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3. In the Jobs screen, press theStart Job button just below the dropdown list box in the upper
left corner.
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4. In the Applications screen, press theElectronics Batch button.

5. In theCreate Job popup dialog, select the Tag, Job Name, andWorking Directory. Press the
Next button to continue.
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6. In theAdd Files popup dialog, specify the files for the job, whichmay be from the local
system, the server, or the EKMdata repository. PressNext to continue.
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7. In theSpecify Execution Settings popup dialog, specify the analysis parameters and the
compute resources for the job. Press the Finish button to submit the job.

For additional details on configuring an ANSYS RSMCluster, see the ANSYS Remote Solve
Manager (RSM) documentation.
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Command Line Information for ANSYS Electromagnetics Suite Desktop
Products

AnyTools>Options setting can be specified via command line, using corresponding registry keys.
This feature is available in all desktop products.
Examples

ansysedt.exe –batchsolve
-batchoptions -machinelist num=2
"'Maxwell/HPCLicenseType'=pool
projectname.aedt

This example demonstrates how to set the same options as the previous example, but here using a
registry.txt file:

ansysedt.exe –batchsolve –batchoptions registry.txt
projectname.aedt

Registry.txt contains:
$begin 'Config'-machinelist num=2
'Maxwell/HPCLicenseType'=pool
$end 'Config'

Distributed Jobs
An ANSYS Electromagnetics batch job which distributes the analysis over several hostsmay also be
called a distributed job. To submit a distributed job, the following ANSYS Electromagnetics desktop
command line options should be used:

l The -Distributed option should be present, and the -Local option should be absent. When
running as a batch job under one of the schedulers with direct integration, this option is a
directive to the job to 1) obtain the list of hosts allocated to the job, directly from the scheduler,
and to 2) use the scheduler to launch the analysis engines on the hosts allocated to the job.

l The -Machinelist num=num_distributed_enginesoption should be included, where num_
distributed_enginesis the total number of analysis engines to be started on the hosts assigned
to the job.

Other examples:
l Serial Job on a Single Processor
l Distributed Job using Four Processors
l Multiprocessing Job Using Four Cores
l Distributed Analysis andMulti-Processing in the Same Job

Serial Job on a Single Processor
SupposeMaxwell is installed at “C:\ProgramFiles\AnsysEM\AnsysEM18.0\Win64\” and you are
using AnsoftRSMService for remote-analysis/DSO:

C:\Program Files\AnsysEM\AnsysEM18.0\win64\ansysedt.exe –ng
–BatchSolve -machinelist num=2
–monitor \\shared_drive\projs\OptimTee.aedt
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User is using LSF for remote-analysis/DSO
bsub –n 1 C:\Program
Files\AnsysEM\AnsysEM18.0\win64\ansysedt.exe –ng –BatchSolve -
machinelist num=3 -monitor –local \\shared_
drive\projs\OptimTee.aedt

Distributed Job using Four Processors
Ansoft RSMService

C:\Program Files\AnsysEM\AnsysEM18.0\win64\ansysedt.exe–ng –
Batchsolve -monitor –Distributed
–machinelist list=“10.1.1.221, 10.1.1.222, 10.1.1.223,
10.1.1.224” \\shared_drive\projs\OptimTee.aedt

LSF
bsub –n 4 C:\Program
Files\AnsysEM\AnsysEM18.0\win64\ansysedt.exe –ng –Batchsolve –
monitor
–Distributed –machinelist num=4
\\shared_drive\projs\OptimTee.aedt

Multiprocessing Job Using Four Cores
Multi-processing job using 4 cores

bsub –n 4 –R “span[ptile=4]” C:\Program
Files\AnsysEM\AnsysEM18.0\win64\ansysedt.exe –ng -monitor
–Local –BatchSolve -machinelist num=4 –batchoptions \\shared_
drive\registry.txt \\shared_drive\projs\OptimTee.aedt

This requests 4 cores to come from the samemachine, asmulti-processing needs cores to be on the
samemachine

Distributed Analysis and Multi-Processing in the Same Job
Distributed-processing using 4 engines andmulti-processing using 4 cores, using a total of 16 cores

bsub –n 16 –R “span[ptile=4]” C:\Program
Files\AnsysEM\AnsysEM18.0\win64\ansysedt.exe –ng
–BatchSolve –Distributed –machinelist num=4
–batchoptions \\shared_drive\registry.txt
\\shared_drive\projs\OptimTee.aedt

Related Topics

RunningMaxwell from aCommand Line
Integration with Platform’s Load Sharing Facility (LSF)
General Terminology for LSF
What a Scheduler Does
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Installation of ANSYS Electromagnetics Tools on LSF Cluster
Integration of ANSYS Electromagnetics Products with LSF
LSF Job Submission Guidelines
Known Issues for LSF
Troubleshooting for LSF
Aborting an Analysis

Integrating ANSYS Electromagnetics Tools with Third Party Schedulers

This section indicates how to create a dynamically linked library to allow integration of ANSYS
Electromagnetics tools with an arbitrary scheduler environment. Each scheduler proxy library is
used for a single specific scheduler environment. If the library is installed with a valid name and in the
correct location, then it will automatically be loaded and used by ANSYS Electromagnetics tools.

l Introduction
l CommonRequirements for Running Jobs
l Using a Shared Library (Linux) or a DLL (Microsoft Windows)
l Scheduler Proxy Interfaces
l Using an IronPython Program for Scheduler Integration

Introduction
ANSYS Electromagnetics Software Toolsmay be run as serial or parallel jobs on a cluster under
control of a scheduler. Serial jobs are run using a single analysis engine at any one time on a single
host. If the tool performsmultiple analyses (for a frequency sweep or a parametric analysis, for
example), the analyses are performed one after the other. Parallel jobs are run usingmultiple
analysis engines running in parallel on the same host or on separate hosts. For parts of the analysis
(such asmeshing), the parallel jobmay use only a single analysis engine on a single host. Other
parts of the analysis (such as a frequency sweep, parametric analysis or DDM, for example) may be
distributed tomultiple analysis engines running in parallel.

l Serial Jobs
l Parallel Jobs

Serial Jobs
When an ANSYS Electromagnetics batch analysis runs as a serial job, the analysis engines run on
the same host as the desktop process. The desktop process does not need to interact with the
scheduler to get the names of hosts allocated to the job or to start processes on other hosts.

Parallel Jobs
For a parallel job, the desktop process startsmultiple analysis engines that run in parallel. These
enginesmay be started on the host where the desktop process is running, or on other hosts
allocated to the job. The desktop process interacts with the scheduler to obtain information on the
hosts that are allocated to the job, and to start engines on the local host or on other hosts allocated to
the job. This document provides information on how to facilitate this interaction between the desktop
process and the scheduler controlling the cluster.
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For some popular job schedulers in a standard configuration, ANSYS Electromagnetics provides an
"out of the box" integrated solution that will work with the scheduler. In this case, the ANSYS
Electromagnetics installation includes code that will determine if the analysis is running as a
scheduler job and communicate with the scheduler when needed. For other schedulers, the code to
obtain information about the hosts allocated to a job and to distribute portions of the job to hosts
assigned to the job is not provided in the installation. In order to facilitate using ANSYS
Electromagnetics software tools with other schedulers, the user may provide a way for ANSYS
Electromagnetics tools to interact with the scheduler. Currently, two general approaches are
available to users.
In the first approach, the user creates a shared library (on Linux) or a dynamically linked library (on
Microsoft Windows) to provide communication between the ANSYS Electromagnetics tool and the
scheduler. This library is loaded by the ANSYS Electromagnetics tool at runtime, and if the ANSYS
Electromagnetics tool is running as part of a scheduler job, the ANSYS Electromagnetics tool
interacts with the library to get information from the scheduler, and to start additional processes on
specified hosts. Each such library implements the same set of extern "C" functions needed to
mediate the interactions between the ANSYS Electromagnetics tool and the scheduler. The details
of these functions are described below.
In the second approach, the user creates an IronPython program to provide communication
between the ANSYS Electromagnetics tool and the scheduler. This program is loaded by the
ANSYS Electromagnetics tool at runtime, and if the ANSYS Electromagnetics tool is running as part
of a scheduler job, the ANSYS Electromagnetics tool uses the IronPython program to get
information from the scheduler, and to start additional processes on specified hosts. Each python
script contains a class implementing a specified interface, which contains functions needed to
mediate the interactions between the ANSYS Electromagnetics tool and the scheduler. The details
of the interface are described below. The IronPython interface is equivalent to the extern "C"
functions used in the first approach.

Common Requirements for Running Jobs

The following requirementsmust bemet for serial and parallel jobs to run successfully. They apply
whether using "out of the box" scheduler integration or scheduler integration using a library or using
an IronPython program.Whenwe refer to host requirements, the requirements apply to all hosts that
may be allocated to an ANSYS Electromagnetics serial or parallel batch job.

Installation Requirements
The ANSYS Electromagnetics installation directory treemust be accessible from all cluster hosts
using the same path. One way to achieve this is to place the ANSYS Electromagnetics installation on
a shared drive that is accessible to the cluster hosts using the same pathname. OnWindows, this
may require the use of UNC names to refer to the installation directory. Another option is to install the
ANSYS Electromagnetics tool locally on each cluster host using the same local directory pathname.

Project File and Directory Requirements
The directory containing the project file must also be available from all cluster hosts using the same
path. The project file and the containing directorymust be readable and writable by the user account
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used to run the job. The controlling process for a distributed job is called the Desktop process, and it
reads from and writes to the project file and other files in the same directory and its subdirectories.
Although only the Desktop process reads from and writes to this directory, the Desktop processmay
be started on any of the hosts allocated to the job, so all hosts should have access to this directory
using the same pathname.

Using a Shared Library (Linux) or a DLL (Microsoft Windows)

This section describes how to create a dynamically linked library to allow integration of Ansoft tools
with an arbitrary scheduler environment. Each scheduler proxy library is used for a single specific
scheduler environment. If the library is installed with a valid name and in the correct location, then it
will automatically be loaded and used by ANSYS Electromagnetics tools.

Installation Details
The scheduler proxy librarymust be installed in the schedulers subdirectory of the ANSYS
Electromagnetics installation directory. For example, if the ANSYS Electromagnetics installation
directory is C:\ProgramFiles\AnsysEM\AnsysEM18.0\Win64, then the scheduler proxy librarymust
be installed in directory C:\ProgramFiles\AnsysEM\AnsysEM18.0\Win64\schedulers.
The scheduler proxy library base namemust match "libprefix_scheduler" onWindows and
"liblibprefix_scheduler" on Linux. The extensionmust be a valid extension for a dynamically loaded
library on the platformwhere it is used. The scheduler proxy library name prefix libprefix shall be
unique, so it does not conflict with other scheduler proxy libraries in the same directory. To avoid
confusion, the scheduler proxy library name should be all lower case onOSswhere file names are
case sensitive.

Related Topics

Build Information for Scheduler Proxy Library
Implementation Details for CustomScheduler Integration
Testing Your Scheduler Integration
Troubleshooting CustomScheduler Integration

Build Information for Scheduler Proxy Library

This section contains the recommended compiler and linker settings for building a scheduler proxy
library.

l 32 Bit Microsoft Windows
l 64 Bit Microsoft Windows
l Linux

32 Bit Microsoft Windows
The proxy library should be compiled and linked as a 32 bit DLL, using the following recommended
compiler and linker options:
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Compiler Options
l Use of MFC: Use StandardWindows Libraries
l Character Set: UseMulti-Byte Character Set [/D "_MBCS"]
l Runtime Library: Multi-threaded DLL [/MD]
l Calling Convention: __cdecl [/Gd (default)]

Linker Options:
l Create a DLL [/DLL]
l 32 bit code [MACHINE:X86]

64 Bit Microsoft Windows
The proxy library should be compiled and linked as a 64 bit DLL, using the following recommended
compiler and linker options:
Compiler Options

l Use of MFC: Use StandardWindows Libraries
l Character Set: UseMulti-Byte Character Set [/D "_MBCS"]
l Runtime Library: Multi-threaded DLL [/MD]
l Calling Convention: __cdecl [/Gd (default)]

Linker Options:
l Create a DLL [/DLL]
l 32 bit code [MACHINE:X64]

Linux
The proxy library should be compiled and linked as shared library (*.so) file. The following compiler
and linker options are recommendedwhen building using gcc/g++:
Compiler Options

l Generate 32 bit code: [-m32]
l Generate position independent code, suitable for use in a shared library: [-fpic]
l Generate code compatible with pthreads library: [-pthread]

Linker Options:
l Create a shared object file: [-shared]
l Generate 32 bit code: [-m32]
l Generate position independent code, suitable for use in a shared library: [-fpic]
l Generate code compatible with pthreads library: [-pthread]

Implementation Details for Custom Scheduler Integration

Function Name Prefix
Each exported function will have a scheduler specific function name prefix. The function name prefix
will be the same as the library name prefix, except that it is converted to upper case. For example, if
the library name prefix is "lsf", then the function name prefix is "LSF". In the examples below, we use
FN_PREFIX to denote the function name prefix.
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The scheduler proxy librarymust provide implementations of the following extern "C" functions:
l IsProductLaunchedInYourEnvironment
l GetTempDirectory
l GetMachineListAvailableForDistribution
l LaunchProcess
l GetUseRsmForEngineLaunch
l GetThisJobID
l GetSchedulerDisplayName

IsProductLaunchedInYourEnvironment

Purpose
Determine if the program is running in the context of the scheduler for which this library was
written.

Signature
extern "C" bool FN_PREFIX_IsProductLaunchedInYourEnvironment
();

Arguments
None.

Return Value
Returns true if the current process is running as a job of the scheduler. Otherwise, false is
returned.

Notes
For many schedulers, the presence of certain environment variables or their valuesmay be checked
to determine if the current process is running as a job of the scheduler.

GetTempDirectory

Purpose
Get the pathname of the temporary directory provided by the scheduler for the current job. The
pathname is an empty string if the scheduler does not provide a temporary directory for the
current job.

Signature
extern "C" bool FN_PREFIX_GetTempDirectory(char * buffer,
unsigned int* length);

Arguments
buffer: Pointer to a character buffer to contain the temporary directory path name or NULL.
length: Pointer to a location to contain the length of the buffer. Must be a valid pointer to an
unsigned int.

Return Value
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If argument buffer is NULL, then the required length of the buffer is stored in the location to
which argument length points, and true is returned.
If argument buffer is not NULL, then the value to which argument length points (the buffer
length) is checked. If it is large enough to contain the pathname of the temporary directory,
including the terminal null byte, then the pathname is copied to the buffer and true is returned.
If the buffer length is insufficient for the pathname of the temporary directory, then the buffer is
unchanged, and false is returned.

Notes
To get the pathname of the temporary directory, the infrastructure first calls this function with a NULL
buffer, and obtains the required length of the buffer for the pathname. After creating a buffer of the
appropriate size, the infrastructure calls this function again, passing the pointer to the buffer in the
buffer argument and a pointer to the size of the buffer in the length argument.

GetMachineListAvailableForDistribution

Purpose
Get the list of hosts allocated to the current job. A host will appear in the list multiple times if the
scheduler has allocatedmultiple processors or cores on the host to the job. The number of
times the host appears in the list is equal to the number of processors or cores of the host that
are allocated to the current job. The list is a text string containing a space separated list of
hostnames.

Signature
extern "C" bool FN_PREFIX_
GetMachineListAvailableForDistribution(char * buffer, unsigned
int* length);

Arguments
buffer: Pointer to a character buffer to contain the list of machines available for distribution
or NULL.
length: Pointer to a location to contain the length of the buffer. Must be a valid pointer to an
unsigned int.

Return Value
If argument buffer is NULL, then the required length of the buffer is stored in the location to
which argument length points, and true is returned.
If argument buffer is not NULL, then the value to which argument length points (the buffer
length) is checked. If it is large enough to contain the lists of hosts, including the terminal null
byte, then the list is copied to the buffer and true is returned. If the buffer length is insufficient
for the list of hosts, then the buffer is unchanged, and false is returned.

Notes
To get the list of hosts for distribution, the infrastructure first calls this function with a NULL buffer,
and obtains the required length of the buffer for the list. After creating a buffer of the appropriate size,
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the infrastructure calls this function again, passing the pointer to the buffer in the buffer argument
and a pointer to the size of the buffer in the length argument.
The hostnames in the list provided by this function shall be used in calls to LaunchProcess(). These
host namesmust be in a format that is accepted by that function. See the section below on
LaunchProcess.

LaunchProcess

Purpose
Launch a local or remote process to run an analysis engine. This function is called by the
ANSYS Electromagnetics desktop application to launch an engine process on a specified
host. The hostname is one of the names in the list provided by the
GetMachineListAvailableForDistribution function. See the
GetMachineListAvailableForDistribution section above. If the hostname does not refer to the
local host, then this function shall use the scheduler to launch the engine on the specified host.
If the hostname refers to the local host, then the enginemay be started as a child process, or it
may be started using the scheduler.

Signature
extern "C" int FN_PREFIX_LaunchProcess(const char* hostName,
const char* exePathName, const char* arg1, const char* arg2);

Arguments
hostName: The name of the host where the process is to be launched.
exePathName: The pathname of the analysis engine executable to be started.
arg1: The first argument of the analysis engine command line.
arg2: The second argument of the analysis engine command line.

Return Value
Returns 0 on success. Returns a non-zero value if an error occurs.

Notes
The hostName argument will be one of the hostnames provided by the function
GetMachineListAvailableForDistribution().
If the hostName argument is the same as the current host, then the analysis engine processmay be
started as a child process. If the hostName argument is not the same as the current host, then the
analysis engine processwill be started on the remote host using the facilities available in the
scheduler environment. The command line of the analysis engine process is exePathName arg1
arg2. The command line arguments arg1 and arg2may contain newlines, tabs, spaces or other
characters that are interpreted by the command processor, such as single quote (') or double quote
(") characters, or dollar signs ($). Newlines or tabsmay be replaced by spaces, if the newline or tab
characters cannot be easily handled. If the analysis engine command is processed by a shell, then it
may be necessary to quote any special characters in the exePathName or in the arguments so that
the special meaning is removed. If a scheduler command is used to request the scheduler to launch
the command to start the engine process, the analysis engine commandmay be processed by the
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shell twice: once when the scheduler command is processed, and a second time when the analysis
engine process is started. If this is the case, then the quoting of special characters needs to account
for two passes through the command processor.

GetUseRsmForEngineLaunch

Purpose
This function is optional. If this feature is not needed, then the function need not be
implemented. Most schedulers should not need this feature.
For some schedulers, it may be desirable for the ANSYS Electromagnetics RSM service to
launch the engine processes instead of using the scheduler proxy library. For example, if the
scheduler proxy library is limited to launching one process per host, then the scheduler proxy
librarymay be used to launch one ANSYS Electromagnetics RSM service executable per
host, and the ANSYS Electromagnetics RSMexecutable will launch all of the engine
processes.
If the ANSYS Electromagnetics RSM service should be used to launch engine processes for
this scheduler, then this function shall be implemented and it shall return true.
If the ANSYS Electromagnetics RSM service should not be used to launch engine processes
for this scheduler, then this function is not required. If it is implemented, it should return false. If
it is not implemented, it will be treated the same as if it was implemented and returns false.

Signature
extern "C" bool FN_PREFIX_GetUseRsmForEngineLaunch(void)

Arguments
None.

Return Value
Returns true if the ANSYS Electromagnetics RSM service should be used to launch engine
processes for this scheduler. Returns false if the ANSYS Electromagnetics RSM service
should not be used to launch engine processes for this scheduler.

Notes
This function is optional. If not implemented, then it is treated the same as if it was implemented and
returns false.

GetThisJobID

Purpose
Get a string identifying the job currently running in the scheduler environment. This string is
displayed to the end user to identify the job.

Signature
extern "C" bool FN_PREFIX_GetThisJobID(char * buffer, unsigned
int* length);
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Arguments
buffer: Pointer to a character buffer to contain the Job ID or NULL.
length: Pointer to a location to contain the length of the buffer. Must be a valid pointer to an
unsigned int.

Return Value
If argument buffer is NULL, then the required length of the buffer is stored in the location to
which argument length points, and true is returned.
If argument buffer is not NULL, then the value to which argument length points (the buffer
length) is checked. If it is large enough to contain the string identifying the current job, including
the terminal null byte, then the job ID is copied to the buffer and true is returned. If the buffer
length is insufficient for the job ID, then the buffer is unchanged, and false is returned.

Notes
To get the job ID, the infrastructure first calls this function with a NULL buffer, and obtains the
required length of the buffer for the job ID. After creating a buffer of the appropriate size, the
infrastructure calls this function again, passing the pointer to the buffer in the buffer argument and a
pointer to the size of the buffer in the length argument.
For many schedulers, the job ID may be obtained from the value of an environment variable.

GetSchedulerDisplayName

Purpose
Get a string identifying the scheduler associated with the current scheduler proxy library. This
string is displayed to the end user to identify the scheduler.

Signature
extern "C" bool FN_PREFIX_GetSchedulerDisplayName(char *
buffer, unsigned int* length);

Arguments
buffer: Pointer to a character buffer to contain the scheduler display name or NULL.
length: Pointer to a location to contain the length of the buffer. Must be a valid pointer to an
unsigned int.

Return Value
If argument buffer is NULL, then the required length of the buffer is stored in the location to
which argument length points, and true is returned.
If argument buffer is not NULL, then the value to which argument length points (the buffer
length) is checked. If it is large enough to contain the scheduler display name, including the
terminal null byte, then the scheduler display name is copied to the buffer and true is returned.
If the buffer length is insufficient for the scheduler display name, then the buffer is unchanged,
and false is returned.

Notes
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To get the scheduler display name, the infrastructure first calls this function with a NULL buffer, and
obtains the required length of the buffer for the scheduler display name. After creating a buffer of the
appropriate size, the infrastructure calls this function again, passing the pointer to the buffer in the
buffer argument and a pointer to the size of the buffer in the length argument.
The scheduler display name is generally a fixed string.

Scheduler Proxy Interfaces

Scheduler proxy supports the following new graphical interface functions. The scheduler specific
prefix of each function is not shown in this listing.
void Initialize(const std::string& config):

Initialize the proxy library for scheduler interaction. The config argument contains scheduler
specific initialization information.

int CheckEnvironment(std::string& msg):
Check the environment in which the proxy library is running.
l Returns 0 (success) if the environment is appropriate for submitting jobs to the scheduler.
l Returns a non-zero error code if the environment is incorrect. If a non-zero error code is
returned, an error message to display to the user is written to themsg argument.

int GetSchedulerInfo(std::string& msg, std::string& schedulerName, std::string&
schedulerDescription, std::string& schedulerVersion):

This function returns some basic information about the scheduler with which the scheduler
proxy library interacts.
l On success, 0 is returned, and the scheduler name, scheduler description, and scheduler
version are written to the schedulerName, schedulerDescription and
schedulerVersion arguments.

l On failure, a non-zero error code is returned, and an error message to display to the user is
written to themsg argument.

int GetComputeResourceAttributes(std::string& msg, AttributeDefinitionsStruct&
attributeDefs):

TheCompute Resource Selection Parameters dialog allows the user to specify scheduler
specific resources. This function returns the information used to create and populate the
Compute Resources tab in the Submit Job To: dialog.
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Each line in the dialog is defined by a single attribute definition in the attributeDefs argument.
An attribute definition defines the name and description of an attribute, as well as information
about the allowed values and the default value. In general, only themost commonly specified
job attributes are included in the attributeDefs argument.
l On success, 0 is returned, and the attribute definitions are written to the attributeDefs
argument.

l On failure, a non-zero error code is returned, and an error message to display to the user is
written to themsg argument.

l If the scheduler proxy library does not support any attributes using this approach, the
attributeDefs argument will contain no attribute definitions, and 0 will be returned.

int AbortJob(std::string& msg, const std::string& jobID, bool force, const
SubmissionUserStruct& submissionUser):

This function requests the scheduler to abort a job identified by the jobID argument. If the
force argument is true, then errors should be ignored (the exact behavior is scheduler
specific). The submissionUser argument contains information about the client user (the user
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running the Desktop process). The request to abort the job should run in the context of this
user. If no user is specified, then the request to abort the job runs as the user of the process or
thread running the function.
l If the request is successfully submitted, then 0 is returned.
l If there is an error, then a non-zero error code is returned, and an error message to display
to the user is written to themsg argument.

int SubmitUniformJob(std::string& msg, std::string& jobID, const CmdLineStruct&
cmdLineInfo, const JobParallelizationStruct& jobParallelization, const
UniformComputeResourcesStruct& computeResources, const JobOptionsStruct&
jobOptions, const JobAtributesStruct& jobAttributes, const SubmissionUserStruct&
submissionUser,const IJobParameters* jobParametersCB):

This function submits a job to the scheduler.
l On success, 0 is returned, and the job identifier of the newly submitted job is written to the
jobID argument.

l On failure, a non-zero error code is returned, and an error message to display to the user is
written to themsg argument.

This function is used to submit jobs to the scheduler in which the resources allocated to the job
are uniformly distributed across the nodes allocated to the job. All other arguments are input
arguments, and they are described below:

The cmdLineInfo argument contains the command line arguments. The first argument is the
command name.
The jobParallelization argument contains information on how the job should be parallelized. It
contains the following integral parameters:

l the total number of distributed engines,
l the number of cores to allocate for each distributed engine,
l themaximumnumber of engines to allocate to a single node (optional), and
l the number of cores to allocated for the non-distributed portion of the analysis.
l It also contains a boolean parameter indicating whether nodes used for this job should be
exclusively allocated to this job.

The computeResources argument is a reference to an object of type
UniformComputeResourcesStruct. This struct contains zero or more resource attribute settings
for the job. Each resource attribute setting consists or a resource name and a resource value. The
resource name is the name of one of the resources defined in theAttributeDefinitionsStruct filled
in by theGetComputeResourceAttributes() function. The resource attribute value is the value
specified for the resource attribute by the user using theCompute Resource Selection
Parameters dialog. If no resource attributes are specified by the user in this dialog, then the
computeResources argument will contain no resource attribute settings.
The jobOptions argument contains the environment variable settings for the job.
The jobAttributes argument contains job submission attributeswhich are not necessarily related to
the compute resources allocated to the job. The job name and the requested job priority are included
in this data structure. TheSchedulerOptions tab of the Job Submission dialog allows the user to
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either specify additional job submission options or to specify all submission options, replacing the
settings from the other Job Submission dialog controls.

The user specified submission options are included in this data structure, as well as a boolean
setting indicating whether the user specified options are in addition to the automatically
generated options, or whether they replace the automatically generated submission options.
The submissionUser argument contains information about the client user (the user running
the Desktop process). The job is submitted to the scheduler to run as this user.
The jobParametersCB argument is a pointer to an object that implements the
IJobParameters interface. This interface allows the scheduler proxy library to get additional
information about the job. Specifically, theGetWorkingDirectory() interface function returns
the working directory to be used for the job.
The cmdLineInfo argument contains the command line arguments. The first argument is the
command name.
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int SubmitNonUniformJob(std::string& msg, std::string& jobID, const CmdLineStruct&
cmdLineInfo, const JobParallelizationStruct& jobParallelization, const
NonUniformComputeResourcesStruct& computeResources, const JobOptionsStruct&
jobOptions, const JobAtributesStruct& jobAttributes, const SubmissionUserStruct&
submissionUser,const IJobParameters* jobParametersCB):

This function submits a job to the scheduler.
l On success, 0 is returned, and the job identifier of the newly submitted job is written to the
jobID argument.

l On failure, a non-zero error code is returned, and an error message to display to the user is
written to themsg argument.

This function is used to submit jobs to the scheduler in which the nodes to use and the number
of engines to run on each node are specified by the user. All other arguments are input
arguments, as for theSubmitUniformJob() function. These input arguments are the same
as for theSubmitUniformJob() function, except that the computeResources argument is a
reference to aNonUniformComputeResourcesStruct, as described below:
The computeResources argument is a reference to an object of type
NonUniformComputeResourcesStruct. This object contains a vector of pairs, where each
pair consists of the name of a node in the cluster, and the number of engines to run on the
node.

int PreviewUniformJob(std::string& msg, std::string& preview, const CmdLineStruct&
cmdLineInfo, const JobParallelizationStruct& jobParallelization, const
UniformComputeResourcesStruct& computeResources, const JobOptionsStruct&
jobOptions, const JobAtributesStruct& jobAttributes, const SubmissionUserStruct&
submissionUser, const IJobParameters* jobParametersCB):

This function is similar to theSubmitUniformJob() function, but instead of submitting the job,
text representing how the job will be submitted is written to the preview argument. Typically
the preview text includes the job submission command and the contents of the job script
created for the job. For some schedulers, this content may not bemeaningful, so the text
returned could be different.
l On success, 0 is returned, and the job preview text is written to the preview argument.
l On failure, a non-zero error code is returned, and an error message to display to the user is
written to themsg argument.

The other arguments are input arguments with the samemeaning as for the
SubmitUniformJob() function. The submissionUser argument is ignored for this function.

Testing Your Scheduler Integration

Oneway to test these functions is to run the analysis for an ANSYS Electromagnetics product in
batchmode.When running in batchmode, a batch log file is created in the same directory as the
project file. The batch log file has the same base name is the project file, with an extension of ".log".
For example, if the project file is TestProject123.mxwl, then the batch file is TestProject123.log. The
batch log file contains useful information about the analysis run.
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See the product specific help for details on running the product in batchmode, and for the command
line options to use for distributed analysis.

l Testing IsProductLaunchedInYourEnvironment
l Testing GetSchedulerDisplayName andGetThisJobID
l Testing GetTempDirectory
l Testing GetMachineListAvailableForDistribution
l Testing LaunchProcess
l Testing GetUseRsmForEngineLaunch

Testing IsProductLaunchedInYourEnvironment

This function should be tested first. If the ANSYS Electromagnetics application is not able to
load and run this function, or if it returns false, then none of the other functionswill be called. If
the batch analysis is running in a scheduler environment, and this function returns true, then
there will be an "info" message near the beginning of the batch log indicating that the analysis
is running as a scheduler job. Thismessage will include the scheduler display name returned
by the function GetSchedulerDisplayName, and it will also include the job ID returned by the
function GetThisJobID. If the batch analysis is not running in a scheduler environment, then
none of themessageswill include a scheduler display name or job ID.
If thismessage does not appear when running in a scheduler environment, ensure that the
scheduler proxy library is named correctly, that it is built correctly, that it is installed in the
correct directory, and that the function name prefix is the same is the library prefix converted to
upper case.

Testing GetSchedulerDisplayName and GetThisJobID

As described above, when running a batch job in a scheduler environment, the scheduler
display name and the job ID will appear in an "info" message near the beginning of the batch
log. The values returned by these functions are copied to thismessage verbatim, so they can
be directly compared to the expected values.

Testing GetTempDirectory

Unfinished. The temp directory displayed in the batch log is the default installation setting, not
the one from the scheduler. The scheduler temp directory is set in
AnsoftCOMApplication::MainFunction(), so it happens for COMengines, but not for the
desktop.

Testing GetMachineListAvailableForDistribution

This function is used for distributed analysis. The analysismay be distributed across several
machines if portions of the analysis are independent. For example, frequency sweeps,
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parametric analysis and domain decomposition allow different portions of the analysis to be
distributed acrossmachines. The analysis in a batch job will be distributed tomultiple
processors or hosts if the analysis includes a setup that may be distributed (e.g., a frequency
sweep or parametric analysis) and the -Distributed option is included in the desktop
command line. The list of machines is displayed in an "info" message near the beginning of the
batch log. The list in the infomessage can be directly compared to the expected list of
machines.
To verify that themachine list is constructed correctly for a variety of cases, it may be
necessary to test several jobswith different resource requirements and verify that themachine
list is correct in each case. For example, onemay run batch analyseswith the following
resource requirements:

l One processor on one host
l Several processors on one host
l One processor on each of several hosts
l Several processors on each of several hosts

Testing LaunchProcess

This function is used to launch analysis engines in the case where the analysis is distributed across
multiple hosts. The analysismay be distributed across several machines if portions of the analysis
are independent. For example, frequency sweeps, parametric analysis and domain decomposition
allow different portions of the analysis to be distributed acrossmachines. The analysis in a batch job
will be distributed tomultiple processors or hosts if the analysis includes a setup that may be
distributed (e.g., a frequency sweep or parametric analysis) and the -Distributed option is included
in the desktop command line. The list of machines is displayed in an "info" message near the
beginning of the batch log. The batch logmay also contain infomessageswhen portions of the
analysis distributed to different machines start or finish. Thesemessages usually include the name of
the host when the analysis ran or will run. One can verify that the analysis is actually running on the
expected host or hosts using the Linux ps command or theWindows TaskManager.
In general, one analysis engine is started for each occurrence of each host in the list of machines
available for distribution. For example, if the list of hosts is "hostA hostA hostA hostB hostB", then a
total of 5 engineswould be started, three on hostA and two on hostB. In some cases, an additional
engine is started to perform the portion of the analysis which is not distributed; if this is the case, the
non-distributed engine is idle during the portion of the analysis which is distributed. If this occurs in
the case where the list of hosts is "hostA hostA hostA hostB hostB", then a total of 6 engineswould
be started, but at most 5 engineswould be active at any given time.When each analysis engine is
running, it may start additional child processes to do a portion of the analysis, but these are not
counted as additional analysis engines because the parent of the sub-engine is inactive (waiting for
the sub-engine results) when the sub-engine is active.
Testing should be sufficient to demonstrate that the scheduler proxy library can start multiple engine
processes on the desktop host, and can also start multiple engine processes on other hosts.
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Testing GetUseRsmForEngineLaunch

In most cases, this function will not be implemented or tested. If this function is implemented and
returns true, then the ANSYS Electromagnetics desktop application will not start the analysis
engines using the LaunchProcess function directly. Instead, the ANSYS Electromagnetics desktop
application will start one AnsoftRSMService process on each host using the LaunchProcess
function, and the engine processeswill be started by these AnsoftRSMService processes. Onemay
check for these processes using the Linux ps command or theWindows TaskManager. One
AnsoftRSMService process should run on each host. These processeswill be named
ansoftrsmservice.exe or AnsoftRSMService.exe. These processeswill be started on each host
before any analysis engine is started on the host, and will remain running until the job is complete.

Troubleshooting Custom Scheduler Integration
l None of the Proxy Functions are Called
l Troubleshooting IsProductLaunchedInYourEnvironment Function
l Troubleshooting GetSchedulerDisplayName
l Troubleshooting GetThisJobID
l Troubleshooting GetTempDirectory
l Troubleshooting GetMachineListAvailableForDistribution
l Troubleshooting LaunchProcess
l Troubleshooting GetUseRsmForEngineLaunch

None of the Proxy Functions are Called

There are several problemswhich could result in none of the proxy functions being called.
The scheduler proxy librarymust be installed in the schedulers subdirectory of the ANSYS
Electromagnetics installation directory. The installation directory is set in the registry entry HKEY_
CURRENT_
USER/Software/Ansoft/Product/Version/Desktop/InstallationDirectory,
where “Product” is the ANSYS Electromagnetics product name (for example, Maxwell) and
“Version” is the ANSYS Electromagnetics product version (for example, 14.0).
The scheduler proxy library namemust match "*_scheduler.dll" onWindows and "lib*_scheduler.so"
on Linux. If the library name does not match this format, then the library will not be loaded. In
addition, the function name prefixmust be the same as the library name prefix converted to upper
case. For example, if the library name prefix is "abc", then the function name prefix is "ABC". In this
example, the library name is "abc_scheduler.dll" onWindows, and "libabc_scheduler.so" on Linux. In
this example, the full name of the IsProductLaunchedInYourEnvironment function is ABC_
IsProductLaunchedInYourEnvironment onWindows and Linux, and it must have extern "C" linkage.
Verify that the compile and link flags follow the guidelines in the section "Build Information", above.
Incorrect compile or link flagsmay prevent the library from being loaded by the ANSYS
Electromagnetics product.
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If there is a problemwith calling the IsProductLaunchedInYourEnvironment function, then
none of the other functionswill be called. The other functions are only called if the
IsProductLaunchedInYourEnvironment function is successfully called and returns true.

Troubleshooting IsProductLaunchedInYourEnvironment Function

Verify that the conditions specified in the section "None of the Proxy Functions are Called" aremet.
Verify that this function returns true when called in an environment running under the scheduler, and
that it returns false when called in an environment not running under the scheduler.

Troubleshooting GetSchedulerDisplayName

Verify that the IsProductLaunchedInYourEnvironment function returns true when running
in the scheduler environment.
Verify that the scheduler display name is a valid ASCII string.
Verify that, if argument buffer is NULL, then the required length of the buffer is stored in the location
to which argument length points, and true is returned. The required buffer lengthmust include space
for the string null terminator.
Verify that, if argument buffer is not NULL and the value to which argument length points (the buffer
length) is large enough to contain the display name, including the terminal null byte, then the display
name is copied to the buffer and true is returned.

Troubleshooting GetThisJobID

Verify that the IsProductLaunchedInYourEnvironment function returns true when running
in the scheduler environment.
Verify that the job ID is a valid ASCII string.
Verify that, if argument buffer is NULL, then the required length of the buffer is stored in the location
to which argument length points, and true is returned. The required buffer lengthmust include space
for the string null terminator.
Verify that, if argument buffer is not NULL and the value to which argument length points (the buffer
length) is large enough to contain the job ID, including the terminal null byte, then the job ID is copied
to the buffer and true is returned.

Troubleshooting GetTempDirectory

Verify that the IsProductLaunchedInYourEnvironment function returns true when
running in the scheduler environment.
Verify that the temporary directory name is a valid ASCII string.
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Verify that, if argument buffer is NULL, then the required length of the buffer is stored in the location
to which argument length points, and true is returned. The required buffer lengthmust include space
for the string null terminator.
Verify that, if argument buffer is not NULL and the value to which argument length points (the buffer
length) is large enough to contain the temporary directory pathname, including the terminal null byte,
then the temporary directory pathname is copied to the buffer and true is returned.

Troubleshooting GetMachineListAvailableForDistribution

Verify that the IsProductLaunchedInYourEnvironment function returns true when running
in the scheduler environment.
Verify that the list of hosts is a valid ASCII string containing a space separated list of host names. A
host namewill appear in the list a number of times equal to the number of processors or cores
available to the job on that host.
Verify that, if argument buffer is NULL, then the required length of the buffer is stored in the location
to which argument length points, and true is returned. The required buffer lengthmust include space
for the string null terminator.
Verify that, if argument buffer is not NULL and the value to which argument length points (the buffer
length) is large enough to contain the list of hosts, including the terminal null byte, then the list of
hosts is copied to the buffer and true is returned.

Troubleshooting LaunchProcess

Verify that the IsProductLaunchedInYourEnvironment function returns true when running
in the scheduler environment.
The hostName argument is a host name from the list returned by the
GetMachineListAvailableForDistribution function. Verify that the LaunchProcess function can accept
host names in the format returned by theGetMachineListAvailableForDistribution function.
The exePathName argument is the pathname of the analysis engine executable to be started. This
pathnamemay contain spaces or other characters special to the shell. Ensure that the
LaunchProcess function is able to handle such cases.
The arg1 and arg2 argumentsmay contain newlines, tabs, single quotes, spaces, dollar signs, and
other characters whichmay be special to the shell. Ensure that the LaunchProcess function is able to
handle such cases. If needed, the newline charactersmay be replaced by other whitespace
characters. One or both of these arguments could also be an empty string; verify that the empty
string is correctly passed to the engine process command line.
If a scheduler command is used to launch the engine process on a remotemachine, the engine
command linemay be processed by the shell twice, once when the scheduler command is
processed by the shell, and again when the engine command is processed by the shell. In such
cases, the quoting of characters special to the shell will need to be take these two passes through the
shell into account. In some implementations, it may be necessary or convenient to use different
approaches for launching engine processes on the local machine and on remotemachines; if this is
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done, verify that the approach used to determine whether the hostName argument represents the
local machine is correct.

Troubleshooting GetUseRsmForEngineLaunch

In most cases, this function will not be implemented. If it is implemented, then follow the suggestions
below.
Verify that the IsProductLaunchedInYourEnvironment function returns true when
running in the scheduler environment.
If the RSM should be used for launching engines, verify that this function returns true. Otherwise,
verify that this function returns false.

Using an IronPython Program for Integration with a Scheduler

This section describes how to create an IronPython program for integration with a scheduler. Each
such program is used for a single specific scheduler environment. If the program is installed with a
valid name and in the correct location, then it will automatically be loaded and used by ANSYS
Electromagnetics tools.

Installation Details
The IronPython programmust be installed in the schedulers subdirectory of the ANSYS
Electromagnetics installation directory. For example, if the installation directory is C:\Program
Files\AnsysEM\AnsysEM18.0\Win64\, then the IronPython programmust be installed in directory
C:\ProgramFiles\AnsysEM\AnsysEM18.0\Win64\schedulers.
The program file extensionmust be ".py". Select the program name so that it does not conflict with
other IronPython programs in the same directory. If the Operating System or file system treat file
names in a case sensitivemanner, the file extension ".py" must be lower case.

Python Programming Notes
The scheduler programwill be run in the IronPython environment both onMicrosoft Windows and on
Linux. There are some differences between IronPython and CPython. The version of IronPython in
use as of June 9, 2011 is 2.6.1.

Implementation Details
The programmust contain the following:
Import the ISchedulerPluginExtension interface as follows:

from Ansys.Ansoft.SchedulerPluginDotNet import
ISchedulerPluginExtension

Define a classwhich implements the ISchedulerPluginExtension interface. In this document, this
class is named SamplePluginExtension, but any class namemay be used. The classmember
functions are described in the next section. The class definition will look similar to the following:

class SamplePluginExtension(ISchedulerPluginExtension):
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def GetName(self):
return "SamplePluginExtension"

def GetDescription(self):
return "Example python script plugin extension"
. . .

Include the following line in the program so that the class that you have defined,
SamplePluginExtension, is loaded by the infrastructure:

ExtensionRegistrar.RegisterPluginExtension
(SamplePluginExtension())

The infrastructure will make the EntensionRegistrar object available in the environment where the
program is loaded.
Each of the functions to be implemented in the SamplePluginExtension class is described below.

l GetName
l GetDescription
l IsProductLaunchedInYourEnvironment
l GetSchedulerDisplayName
l GetThisJobID
l GetUseRsmForEngineLaunch
l GetTempDirectory
l GetMessageStringToRegisterForSigTerm
l GetMachineListAvailableForDistribution
l LaunchProcess

GetName [IronPython]

Purpose
Return a short string containing the name of the plugin extension. This string is used to identify
the scheduler plugin extension in logs or program output.

Signature
GetName(self)

Arguments (excluding self)
None.

Return Value
Returns a string containing the name of the plugin extension.

Notes
The plugin extension name is generally a fixed string.
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GetDescription [IronPython]

Purpose
Return a string containing the description of the plugin extension. This string is used to identify
the scheduler plugin extension in logs or program output.

Signature
GetDescription(self)

Arguments (excluding self)
None.

Return Value
Returns a string containing the description of the plugin extension.

Notes
The plugin extension description is generally a fixed string.

IsProductLaunchedInYourEnvironment [IronPython]

Purpose
Determine if the program is running in the context of the scheduler for which this programwas
written.

Signature
IsProductLaunchedInYourEnvironment(self)

Arguments (excluding self)
None.

Return Value
Returns True if the current process is running as a job of the scheduler. Otherwise, False is
returned.

Notes
For many schedulers, the presence of certain environment variables or their valuesmay be checked
to determine if the current process is running as a job of the scheduler.

GetSchedulerDisplayName [IronPython]

Purpose
Get a string identifying the scheduler associated with the current plugin extension. This string
is used to identify the scheduler.

Signature
GetSchedulerDisplayName(self)

Arguments (excluding self)
None.
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Return Value
Returns a string containing the description of the scheduler for which this plugin extension was
written.

Notes
The scheduler display name is generally a fixed string.

GetThisJobID [IronPython]

Purpose
Get a string identifying the job currently running in the scheduler environment. This string is
displayed to the end user to identify the job.

Signature
GetThisJobID(self)

Arguments (excluding self)
None.

Return Value
Returns a string containing the Job ID for the current job.

Notes
For many schedulers, the job ID may be obtained from the value of an environment variable.

GetUseRsmForEngineLaunch [IronPython]

Purpose
For some schedulers, it may be desirable for the AnsoftRSMprogram to launch the engine
processes instead of using the scheduler plugin extension directly. For example, if the plugin
extension is limited to launching one process per host, then the plugin extensionmay be used
to launch one AnsoftRSMexecutable per host, and the AnsoftRSMexecutable will launch all
of the engine processes.
If AnsoftRSM should be used to launch engine processes for this scheduler, then this function
shall return True.
If AnsoftRSM should not be used to launch engine processes for this scheduler, then this
function shall return False.

Signature
GetUseRsmForEngineLaunch(self)

Arguments (excluding self)
None.

Return Value
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Returns True if AnsoftRSM should be used to launch engine processes for this scheduler.
Returns False if the plugin extension should be used to directly launch engine processes for
this scheduler.

Notes
If this function returns True, then the plugin extension will directly launch only one process on each
host.

GetTempDirectory [IronPython]

Purpose
Get the pathname of the temporary directory provided by the scheduler for the current job. The
pathname is an empty string if the scheduler does not provide a temporary directory for the
current job.

Signature
GetTempDirectory(self)

Arguments (excluding self)
None.

Return Value
Returns a string containing the pathname of the temporary directory provided by the scheduler
for the current job. Returns an empty string if no temporary directory is provided by the
scheduler for the current job.

Notes
If the return value is an empty string, then the temporary directory specified on the command line or
in the registry will be used.

GetMessageStringToRegisterForSigTerm [IronPython]

Purpose
Obsolete. This function should return an empty string.

Signature
GetMessageStringToRegisterForSigTerm(self)

Arguments (excluding self)
None.

Return Value
Returns an empty string.

Notes
This function should always return an empty string.
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GetMachineListAvailableForDistribution [IronPython]

Purpose
Get the names of the hosts allocated to the current job. A host namewill appear in the output
stringmultiple times if the scheduler has allocatedmultiple processors or cores on the host to
the job. The number of times the host name appears in the string is equal to the number of
processors or cores of the host that are allocated to the current job. The output is a text string
containing the host names separated by space characters.

Signature
GetMachineListAvailableForDistribution(self)

Arguments (excluding self)
None.

Return Value
A string containing the names of the hosts allocated to the job, separated by space
characterss. The number of times the host appears in the string is equal to the number of
processors or cores of the host that are allocated to the current job.

Notes
The hostnames in the string provided by this function shall be used in calls to LaunchProcess(). The
host namesmust be in a format that is accepted by that function. See the section below on
LaunchProcess.

LaunchProcess [IronPython]

Purpose
Launch a local or remote process to run an analysis engine. This function is called by the
ANSYS Electromagnetics desktop application to launch an engine process on a specified
host. The hostname is one of the names provided by the
GetMachineListAvailableForDistribution function. See the
GetMachineListAvailableForDistribution section above. If the hostname does not refer to the
local host, then this function shall use the scheduler to launch the engine on the specified host.
If the hostname refers to the local host, then the enginemay be started as a child process, or it
may be started using the scheduler.

Signature
LaunchProcess(self, hostName, exePathName, arg1, arg2)

Arguments (excluding self)
hostName: The name of the host where the process is to be launched.
exePathName: The pathname of the analysis engine executable to be started.
arg1: The first argument of the analysis engine command line.
arg2: The second argument of the analysis engine command line.

Return Value

Running Simulations 21-206
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Returns 0 on success. Returns a non-zero value if an error occurs.
Notes
The hostName argument will be one of the hostnames provided by the function
GetMachineListAvailableForDistribution().
If the hostName argument is the same as the current host, then the analysis engine processmay be
started as a child process. If the hostName argument is not the same as the current host, then the
analysis engine processwill be started on the remote host using the facilities available in the
scheduler environment. The command line of the analysis engine process is exePathName arg1
arg2. The command line arguments arg1 and arg2may contain spaces or other characters that are
interpreted by the command processor, such as backslash (\), single quote (') or double quote (")
characters, or dollar signs ($). If the analysis engine command is processed by a shell, then it may be
necessary to quote any special characters in the exePathName or in the arguments so that the
special meaning is removed. If a scheduler command is used to request the scheduler to launch the
command to start the engine process, and that command is processed by a command shell, then the
analysis engine commandmay be processed by the shell twice: once when the scheduler command
is processed, and a second time when the analysis engine process is started. If this is the case, then
the quoting of special characters needs to account for two passes through the command processor.
The command line arguments arg1 and arg2may be empty strings. These argumentsmust be
preserved, even if they are empty strings. In some versions of the IronPython subprocessmodule,
empty argument strings are discarded, resulting in an incorrect number of command line arguments.
A workaround for this issue is to replace an empty string argument by a string consisting of a single
space character.

RSM Integration with Job Management UI
ANSYS Electromagnetics supports its ownRemote SimulationManagement (RSM) software,
along with other High Performance Computing (HPC) softwaremanagement programs (see High
Performance Computing (HPC) Integration).

When do you need RSM?
RSM is in general required if you want to run remote or distributed simulations. However, if you have
a separate scheduling system that ANSYS Electromagnetics supports, and you plan to run
batchsolve simulations only, then youmay not need to install RSM. For details of installation and
configuration of RSM, see theANSYS Electromagnetics Installation Guides.

Job Management UI for RSM
You can use the JobManagement UI to submit batch jobs to RSM. The JobManagement UI is
accessed by running ANSYS Electromagnetics product Desktop on the designated 'Postprocessing
node' of the cluster. The Desktop providesUI commands for Scheduler selection, Job submission
and Jobmonitoring/control. You access the Scheduler User Interface by clicking Tools>Job
Management>Select Scheduler...
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Click Select Scheduler to display the selection dialog. A drop down lists potential schedulers, (which
can include RSM, lsf, WindowsHPC, or sge, depending on the environment).

If you select a scheduler that is not supported in your environment, you receive a warningmessage.
After selecting a scheduler, you can click Refresh to display information for that scheduler.

Once you have selected a scheduler supported in your environment, you can go through the
following steps to submit a batch job.

1. Setup and prepare themodel on local workstation.
2. Copy the input project (or folder, if the project references external files) from a personal

workstation to a shared-drive on cluster (for example, project is copied to
/home/projects/spool/test.mxwl).
l In the RSMenvironment, you are required to specify amachine-list. (See the Remote
Analysis options panel.) For example, say themachine-list is: 3 cores from 'm1' and 3 cores
from 'm2', for a total of 6 engines. You select the list on theCompute Resources tab of the
Submit Job to RSM dialog, as described below.
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3. Open a remote-desktop session (or equivalent such as vnc session) on the node
corresponding to the first machine of job'smachine-list, 'm1' in this case. Launch Desktop
graphically on 'm1'.

4. Select Tools>Job Management>Submit Job... to open theSubmit Job To dialog.

l TheAnalysis Specification tab has parameters to specify the input project model, the
analysis setup and analysis options (including batchoptions) that affect analysis algorithms.
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l TheCompute Resources tab specifies the amount of compute resources and how to select
specific resources from the available pool.

5. Use the ellipsis button [...] to open a browser to select the project. The Project can be an
archive.

6. In the Analysis setups field, you can select radio buttons for All setups in the project, All setups
in the design, or a Single setup. For instance, the Rotational_actuator.mxwl example includes
setups for Nominal, Parametric, andOptimization.

For Parametric setups, you have the option to select Use Large Scale DSO. For details on
how and when you use this feature, see JobManagement Interface for Large Scale DSO.

7. The Analysis options includes checkboxes for Monitoring the job, whether to wait for a license,
and a field for adding Batchoptions. via a graphical interface, or as text.
l If you intend toMonitor the job through a user interface, youmust checkMonitor job. You
can thenmonitor this job through the Tools>Job Management>Monitor Jobs...
command or by checking the dialog that openswhen you submit the job.

l The Batchoptions field allows you to add additional -batchoptions parameters, either as
text, or by using a dialog with selectionmenus. Click theAdd button to view theAdd
Batchoption dialog.
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The Show registry key entries field lets you filter the entries displayed, bymeans of drop down
menu selection, and a checkbox to Display only frequently used entries.
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l When you have selected a batchoption, you can type the value in the field, and click the
Add button to add the option to the batchcommand.

l In theSubmit Job To: dialog, you can enable Show advanced options to display additional
fields for Environment variables, and whether to Use batch extract.

This field is for environment variables, for instance, for debugging features or other variable
controlled features. Click the ellipsis [...] button to open a dialog forAdditional Job Options.

TheAdd... button opens a New Environment Variable dialog in which you can include a
variable name and value.
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Clicking theAdd Debug Environment Variables button automatically adds a set of debug
variables. This can be useful in working with ANSYS Application Engineering support.

Selecting a variable in the dialog enables the Remove and Edit buttons. The Edit button opens
a dialog where you can change the variable and value.

8. To see the command-line to be submitted to the scheduler, clickPreview Submission. This
opens a dialogue showing the command to be sent to the scheduler.

The text can be copied to the clipboard, if desired.

Use Batch Extract for RSM
Selecting Show advanced options for RSMalso shows the Use batch extract fields.

See the discussion on RunningMaxwell from aCommand line for a discussion of the solve
information available through batch extract.
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9. TheCompute Resources tab of theSubmit Job to: RSM dialog displays other
parameters. Depending on the resources available for a scheduler environment, some of the
fieldsmay be disabled.

If you select Use automatic settings, the Job distribution field is removed.

Note If you select Use automatic settings, the solver does not support automatic distribution of
variations. The Use automatic settings option does not support Optimetrics variations. It
does distribute frequencies, domains, and use of multiple level domains.
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Otherwise:
l Specify node list
Here you can specify a node list. In a computing environment where the available cores are
not uniform, you can use this to control which resources your job will use.

10. To submit the commandwith the specified parameters, clickSubmit Job.
Note TheRSMenvironment does not support for queuing, so 'Submit Job' will

immediately start running the job.

A dialog displays in which you can check "Beginmonitoring this job now."

11. You canmonitor this job either automatically (by checking the option) or through the
Tools>Job Management>Monitor Jobs... command.
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The dialog contains fields reporting the job status, job ID, messages issues, and progress. You
can filter themessages for Errors, Warnings, and Info. By option you refresh the jobmanually
or automatically at specified intervals.

12. To submit the commandwith the specified parameters, clickSubmit Job.
Note TheRSMenvironment does not support for queuing, so 'Submit Job' will

immediately start running the job.

A dialog displays in which you can check "Beginmonitoring this job now."
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13. You canmonitor this job either automatically (by checking the option) or through the
Tools>Job Management>Monitor Jobs... command.

The dialog contains fields reporting the job status, job ID, messages issues, and progress. You can
filter themessages for Errors, Warnings, and Info.
By option you refresh the jobmanually or automatically at specified intervals. You can choose to
Clear Progress Messages.

You also have command buttons to perform aClean Stop of a simulation between time steps, or to
Abort a simulation.

Windows to Linux Job Submission
Given a set of prerequisites, ANSYS Electronics Desktop can permit Windows to Linux job
submission as part of HPC.

Running Simulations 21-217
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Prerequisites for Job Submission

Directory Shared between Windows and Linux

For all jobs submitted to a Linux cluster, the project file is required to be in a directory that is
accessible from all execution hosts used by the job. For submission of jobs from aWindows host to a
Linux cluster, the project file must also be accessible from theWindows host where theGUI runs.
Theremust be a directory shared with bothWindows and Linux hosts, and the project file may be in a
subdirectory (at any level) of the shared directory.

Network Access from Windows Host to Linux Job Management Host

The job is submitted to the cluster from a Linux host configured for submission of jobs to the Linux
cluster. We call this Linux host the “JobManagement” host. The information about the job to be
submitted is transmitted to the JobManagement host over the network. As a result, theWindows
host where theGUI runsmust have network access to the JobManagement host. If this
communication is blocked, then job submission from aWindows host to the Linux cluster will not be
possible. Communication could be blocked if there is a firewall or if the Linux cluster is only on a
private network, for example.

Ansoft RSM Service Running on Job Management Host

The ansoftrsmservicemust be running on the Linux JobManagement host. Before the
ansoftrsmservice is started, it must be configured for submission of jobs to the cluster. The
SchedulerName and ConfigString fields in the Scheduler block of the ansoftrsmservice.cfg
configuration file must be specified. The contents of these fields are described in the table below:

Field Name Contents Examples
SchedulerName Identifier of Scheduler IBMPlatform LSF: ’lsf’

PBSPro or Torque: ’pbs’
Univa, SGE, etc.: ’sge’

ConfigString Directory containing
scheduler commands

IBMPlatform LSF: ’’ (not required)
PBSPro or Torque:
’/opt/pbspro/PBSPro_
13.0.0/default/bin’
Unive, SGE, etc.:
’/opt/univa/bin/lx-amd64’

The environment should be configured for job submission before starting the ansoftrsmservice. The
ansoftrsmservice should be run as a non-privileged user; no special privileges are required. It should
be run as a user without login privileges, so that only privileged users have access to this process.

Prerequisites for Job Monitoring
For jobmonitoring, all prerequisites for job submission are required. One additional requirement,
described below, is also required for jobmonitoring.
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Network Access from Windows Host to Linux Cluster Hosts

In order to obtain full monitoring information from a job, theWindows host needs access to some of
the job processes. That is, theWindowsmonitoring host requires network access to the processes
running on the Linux cluster execution hosts. If this communication is blocked, then only limited
monitoring information is available.

Supported Schedulers
This featuremay be used with all Linux schedulers for which job submission from theGUI is
supported:

l IBMPlatform LSF
l Univa Grid Engine (formerly SunGrid Engine, Oracle Grid Engine)
l PBSPro
l Torque

Select Scheduler Dialog
If you select theUse a computer on the network option, you can enter a username and
password. This username and password are used when the job is submitted to the Linux scheduler.
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Submit Job Dialog
In theSubmit Job dialog, youmust enter the Linux path to the product in the Product path edit
control. The browse button (labeled “...”) may not be used to browse for the product. There is no
requirement for the product installation directory to be accessible from theWindowsGUI host.
Youmust enter theWindows path of the project file in the Product path edit control or use the browse
button (labeled “...”) to select theWindows path of the project file. If the Linux path of the project file
can be determined from the specifiedWindows path and the directories shared betweenWindows
and Linux, then the Linux path of the project file is shown in the Linux project path edit control. This
edit control cannot be edited directly.

TheOptions button activates a dialog that you can use to specify archive options for a job. The lower
portion of this dialog allows you to specify one or more directories shared betweenWindows and
Linux. Themapping of directories betweenWindows and Linux is shown in a grid which displays the
Windows path and the Linux path for each shared directory. There are also buttons to add a new
shared directory, to edit an existing shared directory, or to delete one or more shared directories.
TheWindows path or the Linux path of any shared directorymay be selected in the grid and directly
edited, as well.
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If you specify a project in an archive, the dialog activated by theOptions buttonmay be used to
specify theWindows pathname of the project to be extracted from the archive. If this is done, the
Linux pathname of the target project is determined from the directories shared betweenWindows
and Linux and shown in the upper portion of this dialog.
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If you specify a batchextract script, the Linux path of the batchextract script is determined from the
Windows path of the batchextract script and the directories shared betweenWindows and Linux.
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User Passwords are Encrypted
Jobs are submitted to the Linux cluster using the user name and password entered in theSelect
Scheduler dialog. These settings are persistent; in general, these settings need to be entered only if
they change. To ensure security, user passwords are stored in an encrypted format. When a job is
submitted from aWindows host using the ansoftrsmservice running on a Linux submission host, the
user credentials are sent over the network in an encrypted format.
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Related Topics

Configuring Distributed Analysis
Editing DistributedMachine Configurations
Selecting anOptimal Configuration for Distributed Analysis
Large Scale DSO for Parametric Analysis
High Performance Computing (HPC) Integration

Monitor Job Window
The JobManagement tools include aMonitor Jobwindow. You can invoke the window either by
means of a check box in the dialog that reports a successful job submission, or by clicking
Tools>Job Management>Monitor Jobs.
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You can select the job tomonitor by using the pull-downmenu of recently submitted jobs. The job
can be an archive.
TheMonitor Job dialog contains fields reporting the job status, job ID, messages issues, and
progress.With the Show analysis checkbox enabled (the default), you will see theProfile and
Convergence tabs, similar to theSolution Data dialog.
You can filter themessages for Errors, Warnings, and Info.
You can choose either to refresh the job output manually, or automatically at specified intervals.
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By clicking on the right arrow menu by the progress bars, you can perform aClean Stop between
time steps. You can also performAbort Job.

Using the ANSYS EM HPC Diagnostics Tool
The ANSYS EMHPC diagnostics tool simplifies HPC troubleshooting by automating diagnosis of
routine issues. The diagnostics tool is run on the cluster as a scheduler managed job. Using its
HTML-based diagnostics report, the cluster administrator or ANSYS support staff can either resolve
the issue, or guide the user with steps for further troubleshooting. In some cases, ANSYS support
staff may request to rerun the diagnostics with additional diagnostics tests. The user may extend the
diagnostic scripts to suite their HPC environment.
The following sections describe how to use the diagnostics tool.

l Supported schedulers
l Running the diagnostics job
l Basic diagnostic job
l Using diagnostics scripts on Linux clusters
l UsingWindowsHPC job file
l Diagnostic report
l Site-specific diagnostics job
l Environment variables
l ANSYSEM_DIAG_PROD_DIR contents
l ANSYSEM_DIAG_RESULTS_DIR contents
l How does the diagnostic tool work

Supported schedulers
The tool supports diagnosis of issues on Linux and windows clustersmanaged by the following
schedulers:

l LSF
l SGE
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l PBS/Torque
l WindowsHPC

For the above schedulers, the tool includes standard diagnostic scripts. Further, if password-ssh has
been enabled, it also supports generic Linux clusters using ssh. Please note that currently
diagnostics tool does not support PBSPro and LSF/Windows.

Running the diagnostics job
The diagnostics are run as a scheduler managed job. Once the job finishes, you locate the resulting
HTML file and provide it to the cluster administrator or to ANSYS support staff. If there are any job or
test failures, please also provide the networking*.json files from the Hosts subdirectory aswell.

Basic diagnostic job
To run the basic diagnostics, submit a diagnostic job to the scheduler using a provided job
submission script. Each standard diagnostic job is a 12 core job with 4 cores per host. On Linux,
running this script submits a scheduler job to run the diagnostic tool on the cluster. OnWindows, you
need to submit a job using a job file.
Basic scripts for each supported scheduler are available in the diagnostics subdirectory of the
schedulers directory.
Linux:

.../Linux64/schedulers/diagnostics

Windows:
.../Win64/schedulers/diagnostics

Using diagnostics scripts on Linux clusters
The following standard scripts are provided in the diagnostics directory:

.../Linux64/schedulers/diagnostics.

These job submission scripts are scheduler specific.

Scheduler
Standard job
submission

script
Comment

LSF test_lsf Supports both lsrun and blaunch
SGE test_sge Supports both qrsh and rsh
PBS/Torque test_torque Requires changing the PATH and PBS_BINARY_PATH

environment variable
Generic
Linux cluster

test_ssh Supports only ssh. Requires password-less ssh. Requires
creating a file with the names of hosts and saving it in
${HOME}/ansysem_hostfile

Using Windows HPC job file
A sample job filewinhpctest.xml is available in the diagnostics directory:
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.../Win64/schedulers/diagnostics

To submit this diagnostic job, youmust change the job description to suite your environment as
following:

1. Select a directory for saving the diagnostic results. This directorymust be accessible at the
same path from all the hosts of the cluster.

2. Locate the directory for ANSYS EM installation. This directory alsomust be accessible at the
same path from all the hosts of the cluster.

3. Locate thewinhpctest.xml in the diagnostics subdirectory of schedulers directory in the
ANSYS EM installation.

4. Start WindowsHPC jobmanager, and choose “New job fromXML File…” action.
5. Select thewinhpctest.xml job file.
6. Change the value of both the following environment variables with the directories located in

the first two steps:
ANSYSEM_DIAG_PROD_DIR
ANSYSEM_DIAG_RESULTS_DIR

7. Now submit the job.

Note After making the above changes, you can also save the resulting XML file using "Submit
Job XML File…". Then you can submit the job using the job command as following:

job submit /jobfile: XMLfileName

Diagnostic report
The diagnostic report is an HTML file which (along with other related diagnostics results) is placed in
the following directory
Linux:

${HOME}/Ansoft/HPCDiag/Results/JOBID

Windows:
%ANSYSEM_DIAG_DIR%\Results\JOBID

Report file:
.../HTML/report.html

where JOBID is the job ID assigned by the scheduler. OnWindows, the user must specify
ANSSEM_DIAG_DIR directory.

Site-specific diagnostics job
To run a diagnostic job with job submission parameters of your choice, you need to create your own
job submission script. For example, youmaywant to specify a different LSF queue, or select a
different SGE parallel environment. To run such a job, you need to create your own job submission
script starting from the standard diagnostic scripts with the following steps:

1. Locate the relevant standard diagnostic script in the diagnostics subdirectory of schedulers
directory in ANSYS EM installation.
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2. Make a copy of the diagnostics script into a directory that is accessible from a submit host for
the cluster.

3. Edit the script file to change the value of ANSYSEM_DIAG_PROD_DIR environment
variable to point it to the installation directory (See below).

4. Modify the job submission parameters as needed.
5. Optionally, copy any site-specific diagnostic tests provided by ANSYS support staff in the

../Custom directory of ANSYSEM_DIAG_RESULTS_DIR directory.
6. Run the diagnostics script from a submit host for the cluster

Environment variables
The following environment variables are applicable for both Linux andWindows environment.
ANSYSEM_DIAG_PROD_DIR

Environment
variable ANSYSEM_DIAG_PROD_DIR

Description Location of the ANSYS EM installation. Thismust be available at the same path
from all the hosts of the cluster.

Windows
example

\\filer\AnsysEM\AnsysEM18.0\Win64

Linux example /shared/ansysem/AnsysEM18.0/Linux64

Comments Windows: Required.
Linux: Optional. Export this environment variable if youmake a copy of the
diagnostic script.

ANSYSEM_DIAG_RESULTS_DIR

Environment
variable ANSYSEM_DIAG_RESULTS_DIR

Description Location of the diagnostic report and other results on a shared drive. Thismust be
available at the same path from all the hosts of the cluster

Example \\filer\Home\User\Ansoft\HPCDiag

Linux
example

/shared/home/user/Ansoft/HPCDiag

Comments Windows: Required.
Linux: Optional. Export this environment variable if the home directory for the user
is not accessible from the cluster.

ANSYSEM_DIAG_CUSTOM_DIR

Running Simulations 21-229
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Environment
variable ANSYSEM_DIAG_RESULTS_DIR

Description Location of the configuration of product tests and other custom site-specific tests.
This locationmust be on a shared drive that is available at the same path from all the
hosts of the cluster

Example \\filer\Home\User\Ansoft\HPCDiag\Custom

Linux
example

/shared/home/user/Ansoft/HPCDiag/Custom

Comments Windows: Optional. Youmaywant to specify it if the path
%ANSYSEM_DIAG_RESULTS_DIR%\..\Custom is not suitable
Linux: Optional. Export this environment variable if the home directory for the user is
not accessible from the cluster.

How the diagnostic tool works
The diagnostics are run as a scheduler managed job. Running the diagnostic script submits a
scheduler job that runs the diagnostic tool on the hosts allocated to the job. Once the diagnostic job
starts, the tool executes a set of diagnostic tests. These tests run on each host allocated to the job,
collecting diagnostic information relevant for running HPC jobs. The tool combines the diagnostic
information to produce an HTML report. The tool saves the HTML diagnostic report and other results
in a shared drive, whichmust be available at the same path from all the hosts of the cluster. On Linux,
the default is Ansoft/HPCDiag subdirectory under the user's home directory. OnWindows, the user
must specify this location using the ANSYSEM_DIAG_RESULTS_DIR environment variable.

Related Topics

High Performance Computing (HPC) Integration

Changing a Solution Priority for System Resources
You canmodify the priority of Maxwell simulations so that system resources are allocated to other
computer processes before the solver. If you reduce the priority of Maxwell simulations, your other
software tools will respond as they normally would, but Maxwell simulationsmay take longer.

Note TheWindows TaskManager does not indicate a reduced priority for theMaxwell solver. It
only lists the priority of the enginemanager, which appears normal, not the actual engine.
The actual engine is in a separate thread, whose priority is not visible in theWindows Task
Manager.

To change the priority of simulations for the system’s resources:
1. While a solution is running, right-click theProgresswindow, and clickChange Priority on

the shortcut menu.
l To affect priority for future simulation runs, click the Tools>Options>HPC and Analysis
dialog box, and click theOptions tab.
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2. From theChange Prioritymenu (or theDefault Process Priority pull-downmenu), select
one of the following priorities:

Critical
Above Normal
Normal The

default.

Below Normal
Idle

3. ClickOK.

Related Topics

Monitoring Queued Simulations

Aborting Analyses
To end the solution process before it is complete:

l Right-click In theProgresswindow and clickAbort.
Maxwell ends the analysis immediately.

The data for the currently solving pass or frequency point is deleted. All previously solved solutions
are retained. For example, if you abort between the third and fourth adaptive pass, the solutions for
the third passwill be available, and any solutions for the fourth pass are discarded.
To stop the solution process after the current adaptive pass or solved frequency point is complete:

l Right-click theProgresswindow, and clickCleanStop on the shortcut menu.
Maxwell ends the analysis after the next solved pass or frequency point.

If you request a clean stop between the third and fourth adaptive pass, the solutions for the third and
fourth passwill be available once the fourth pass has finished solving.
ANSYS Electromagnetics Application as an LSF Job
If you have an ANSYS Electromagnetics application running as an LSF job, you can use the
command “bkill –s SIGTERM jobid” to terminate an ANSYS Electromagnetics application. Here
jobid is the LSF job id. The response will be “Job <jobid> is being signaled”. The response is the
samewhether the job is actually being signaled or not.
This works correctly on a 32 bit version ofWindowsXP, using a 32 bit version of LSF.
In caseswhere the SIGTERMparameter is ignored, the command kills the LSF job, but does not
clean the lock files, and other filesmay not be in a consistent state. See http://www.vital-
it.ch/support/LSF/programmer/advanced.html for a detailed description under Signal Handling in
Windows.
Unix/Linux
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For UNIX/Linux, you can use TERM commands. Sigterm handling for Unix is done in Desktop
library. You can abort a running batchsolve on Unix by sending a TERM signal to maxwell.exe

Related Topics

Integration with Platform’s Load Sharing Facility (LSF)

Re-solving a Problem
In some cases, if youmodify a design after generating a solution, the solution in memorywill no
longer match the design. In such cases you receive a warningmessage that "Solutions have been
invalidated. Undo to recover."
To generate a new solution after modifying a design, follow the procedure for running a simulation:
Also see Re-Solving with ANSYSWorkbench Thermal Feedback.

Re-solving after ANSYS Workbench Thermal Feedback
With the Enable Feedback box in Setting the Temperature of Objects dialog is checked, you can
manage analysis with feedback in ANSYSWorkbench. After solving aMaxwell design, after
performing the corresponding linked thermal analysis in ANSYSWorkbench, you can receive a
temperature distribution back from the thermal solution. ANSYSWorkbench will write the feedback
files directly to theMaxwell Project Solution directory.
After an analysis that includes thermal feedback fromANSYSWorkbench, you can see temperature
changes expressed in Temperature field overlays (both visually in the overlay and in the color key)
aswell as in the Solution data.

In the Solution data Profile tab you will see a new entry for MaximumDelta T, for the change in
temperature from the previous simulation. The solver calculates delta in the first iteration by
comparing the temperature distribution output from thermal with the initial temperature setting in
Maxwell. Subsequent simulation iterations provide a number for the temperature delta.
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This simulation feedback loop fromANSYS Electromagnetics to ANSYSWorkbench and back can
continue until you decide that Temperature delta reported in the Solution Report low and stable for
the designs.

Related Topics

Setting the Temperature of Objects
ANSYSWorkbench Integration Overview
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22 - Network Data Explorer
TheNetwork Data Explorer, ndExplorer, provides visualization, analysis, andmanipulation tools for
network data of 3D and 2D EddyCurrent solutions. It is enabled on the shortcut menu for a Setup in
the project tree if the simulated solution data can be converted into network data. This requires at
least oneMatrix setup. It can also be accessed through Tools > Network Data Explorer.

SelectingNetwork Data Explorer from the Setup shortcut menu automatically loads the data into
ndExplorer.

Maxwell Online Help
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The topics for ndExplorer include:
ndExplorer Overview
Loading Data Into ndExplorer
Exporting Data from ndExplorer
Edit Menu Commands
Data Display Pane Context Menus
Exploring Network Data andModifying the Display
Causality Checking and Plots
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ndExplorer Overview
To open the ndExplorer, clickTools > Network Data Explorer. The ndExplorer window is divided
into the following panes:

l Control Pane across the top
l Data View Pane to the right
l Data Selection Panes to the left — divided into Frequencies orMatrix Entries selection
andVariation Selection
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Control Pane

The control pane is used to select the network data to be viewed aswell as themanner in which it is
to be displayed.

l The Filemenu provides commands forOpen, Close andExit, as well as equivalents for
Browse, Check Causality, andCompare.

l TheEdit menu provides a range of commands for editing properties and display features.
l Network data file: Name of the currently active data set.
l Browse: Clear the current data sets and browse for a new file to load. Equivalent to
File>Open.

l Export: Quick buttons for export; same options as those accessed via the Filemenu.
l Check Causality: button to check causality for the active data set. Equivalent to
File>Check Causality. After a check, you can look in theMessage pane in the lower-left to
see the result.

l ThePlot>Log Frequencymenu toggles the log representation of matrix data.
l Compare matrix data: Lets you choose a comparison data set (or none at all). Equivalent
to File>Compare. See Comparing Network Data for an example.)

l Quantity: The quantity to display (parameter or statistical).
l Parameter type: S, Y, or Z parameters, Port Impedance, or Gamma.
l Format: The display function to apply to the data: magnitude/phase, real/imaginary,
dB/phase, magnitude, phase, dB, real, or imaginary.

Matrix, Model Scale, and Model Depth Selection

If you open Network Data Explorer from the Project Manager, the Control pane includes aMatrix
selectionmenu andModel Scale setting box.
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For Maxwell 2D solutionswhen the geometry is in XY mode, an additional Model Depth selection is
available.

The default Matrix selection is the alphabetically first definedmatrix parameter. TheModel Scale
setting default is 1. Model Depth setting default is 1meter. Changing the settings updates the plots
and quantities in ndExplorer.

Data View Pane

The data view pane supports both tabular views of thematrix data and graphical representations.
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Different context menus appear in the data view pane, depending on your view selections.

Data Selection Pane

The data selection pane allows you to choose to display data by frequency or bymatrix cell, and to
choose which frequencies or cells to display.

l The variation list box allows you to control which variations are currently active; this
affects all displays (table, plot, and statistics). When displayed by frequency, the entire
matrix is presented in the data view pane for each selected frequency; when bymatrix cell,
the data for the individually chosen cells is shown across all frequencies.

l Frequencies unavailable for a variation are dimmed and are not highlighted when
selected.

l CheckingSelect all causes all itemswithin the list box to be selected; the corresponding
data is displayed in the data view pane.
Note Given the volume of data in many network data sets, this displaymay take a

considerable time to generate, especially when the graph plot view is enabled.

Loading Data Into ndExplorer
When launching ndExplorer fromwithin Maxwell by using the right clickmenu on a Setup, the
current solution data is automatically loaded and ready for viewing. Alternatively, you can open a file
fromwithin ndExplorer.
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l The file browser may be accessed via the File > Open command or by clicking theBrowse
button.

The file browser allows you to openmultiple files at a time. However, the displayed data always
corresponds to the data set indicated in theNetwork data file field on the control pane. You can use
its drop-down list to switch between primary datasets.

l Use the Files of type pulldownmenu to select from the following file formats:
Touchstone Format, Touchstone 2 Format, Citifile, Neutral Format, or State Space File.

l All data sets are available for data comparison, and all data sets which are open for
comparison are also available as primary data sets.

l Opening one or more new files clears the current data sets. Additional data setsmay be
opened through theCompare matrix data control field, but this option does not clear the
current data sets. For more information see Comparing Network Data.

Exporting Data from ndExplorer
ndExplorer allows you to export data to a file in a variety of different formats. You can also create an
Nport Model, which exports the active data set back to the project.
The topics for this section include:
Scripting
Export SYZ Data
Export MacroModel

Scripting for ndExplorer

Scripting is available for each ndExplorer export method, whichmeans a script can be recorded to
duplicate the export process. ndExplorer can be invoked in the following contexts, and scripting is
available from the Project Context and the Solution Context (simulation setup):

l No design –When there is no design available, the export functionality is not available, and
so scripting is not available.

l Project Context – In the context of a project, you can open a touchstone file and then export.
Scripting is available.

l Solution Context – In the context of a solution (from the simulation setup in a design), you
can export the corresponding network data solution. Scripting is available.
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For more information, see ndExplorer Script Commands in theMaxwell Scripting Guide

Export SYZ Data

The active data set may be saved as a touchstone file (under a name different to the original) with the
File > Export SYZ Data command. At the time of export, you can select from the following options:

l Precision
l Type of data
l Renormalize data

Touchstone Export
After clicking File > Export SYZ Data and specifying a file name and Touchstone format (*.sNp) in
theSave File As dialog, theSpecify Export Options dialog opens:

You are then able to:
l Select the data
l Select the display format
l Enter the precision
l Reference Impedance to renormalize
l IncludeGamma and impedance comment

NMF Export
After clicking File > Export SYZ Data and specifying a file name and the NMF format (*.nmf) in the
Save File As dialog, theSpecify Export Options dialog opens:
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You are then able to:
l Select the data
l Select the display format
l Enter the precision
l Select/unselect the listed parameters
l Select the variations

Spreadsheet, Matlab, and Citifile Export
After clicking File > Export SYZ Data and specifying a file name and the format— Spreadsheet
(*.tab), Matlab( *.m), or Citifile(*.cit) — in theSave File As dialog, theSpecify Export Options
dialog opens:

Network Data Explorer 22-9
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

You are then able to:
l Select the data
l Select the display format

Export Macro Model

ndExplorer lets you export macromodel data in a variety of different formats. In the ndExplorer
window, clickFile > Export MacroModel and select eitherBroadband or Lumped (presently
unimplemented) to open an export dialog.
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The following controls are available:
l FileName – Use the default file name or browse to a different file/location.
l Full Wave Spice Format – Select the export format.
l Compare Fit. TheEdit description button opens a box for adding descriptive text.

l Use Common Ground – Select this box to use common ground.
l Enforce Passivity – Select this box to enforce passivity.
l Renormalize – Select this box to renormalize using the specified impedance.

Note l R and L valuesmay be quite sensitive to the values of the S-parameters.
This is an issue if the actual impedance value ismuch greater than (>>) or
much less than (<<) the reference impedance of the S-parameters.

l Since the resistances of power cables is typically in themilliohms range at
DC, using a reference impedance = 50 ohms is approximately 5000 times
higher. This causes any fitting errors in the state spacemodel to be
multiplied by approximately 5000 timeswhen the R and L values are
computed.

l As a general rule, for high power applications a reference impedance of 1
ohm is probably a better choice than 50 ohms.

Clicking theOK button begins the export, which is implemented by a standalone process --
genequiv.exe -- that is available from the designer installation. Additionally, for NexximState Space
and Touchstone formats, there is an option to automatically create an Nport model using the newly
created file.

Touchstone Options
When Touchstone 1.0 or Touchstone 2.0 is selected as the format, the following
TouchstoneOptions are displayed:
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Advanced Options
Click theAdvanced button to display the advanced options.

The following advanced options are available:
l Desired fitting error
l Maximumorder
l Passivity Options
l Column Fitting Options
l State Space Fitting Algorithm
l Enable relative error tolerance (works best with TWA State-Space Fitting algorithm, not
recommendedwith Iterative Rational Function fitting.)

l Enforce causality
State Space Fitting — Tsuk-White Algorithm
The "Tsuk-White Algorithm" (TWA) is an ANSYS-proprietarymethod for fitting a state spacemodel
to extracted s-parameter data. It uses techniques based on Singular Value Decomposition (SVD) to
quickly determine required number of poles for fitting amodel. It is also capable of simultaneously
finding sets of poles that matchmultiple matrix entries. This can result in amuch smaller state space
model at the end of the processwhich improves performance when themodel is a component in a
transient spice simulation. Due to itsmany benefits, TWA is the preferredmethod for state space
fitting.
The iterated rational fitting approach takes amatrix of S-parameter data and, for eachmatrix entry,
tries a succession of different pole-zero approximations (increasing the number of poles used at
each iteration) until it can find an acceptable fit to the data. For broad frequency sweeps and large
numbers of excitations this process can be time consuming because of all the iterations and is not
guaranteed to produce a good fit to the data. It is retained as a fallback if the TWA algorithm fails
Note that the Enable Relative Error Tolerance option works best with the TWA fitting algorithm, and
is not recommended for use with iterated rational fitting.
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ndExplorer Edit Menu Commands
TheEditmenu on theControl pane includes several commands..

The topics for this section include:
Data Sources
Set Display Format
Display Full Port Names
Save or Reset Default Settings
Magnitude Thresholding
Smooth All Frequencies
Cell Filtering
Edit Port Properties
Define Differential Pairs
Reset All Port Properties

ndExplorer Edit Data Sources

Click Edit>Data Sources to open theData Sources dialog.
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This shows the current status of the data sources, and lets you specify whether to Display plot traces
for all data sources.

ndExplorer Display Format

SelectEdit>Set Display Format to open theDisplay format dialog. TheDisplay format dialog
allows the user additional control over the display of values throughout ndExplorer.

l Field width: Theminimumnumber of characters used to display a number; values are
padded with blanks as necessary; use to increase the blank space displayed in the data
tables to force an increase in columnwidth.
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l Precision: The number of decimals to display.
l Use scientific notation: When checked, values are displayed using scientific notation,
e.g. 3.88124e-001.

l Post-format difference: When comparing data sets, subtract values after applying the
formatting function (e.g. dB, magnitude, etc.); the values displayed will be the difference
between themagnitude, dB, and so on.

l Pre-format difference: When comparing data sets, subtract values before applying the
formatting function (e.g. dB, magnitude, etc.); the values displayed will be themagnitude,
dB, etc., of the complex difference.

l Length: The default units used to display and interpret length values (e.g. de-embedding
length).

ndExplorer Display Full Port Names

By default, port names are displayed in an abbreviated form: P1, P2, etc. This applies to thematrix
display and to the cell list display. Use the Edit>Display Full Port Names command to toggle the
display of port names. Note that tool-tips always display the full port name..

ndExplorer Save or Reset Default Settings

UseEdit>Save Default Settings to create your own defaults, or Edit>Reset Default Settings to
return to the original settings.

ndExplorer Magnitude Thresholding Control

UseEdit>Magnitude Thresholding Control to open the Thresholding Control dialog.
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Thresholding is a way of reducingmatrix entries to zero based on a threshold value. Thresholding
applies to the displayed data, e.g. Magnitude(S), but it is the original matrix value that is reset to zero.
Hence, thresholding is affected by theParametertype and Format settings.
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Set the threshold value by sliding the control or by explicitly entering a value. The data range for the
slider is determined by the following dialog options:

l Value range based on selected frequencies only: When selected, the slider value
range is determined from the selected frequencies only, otherwise, the entire data set is
used to determine the range.

l Min to average: When selected, the slider data ranges extends from the dataminimum to
themean.

l Min to max: When selected, the slider data range extends over the entire data range, i.e.
from theminimum to themaximumdata values.

l Apply to selected frequencies only: When selected, theSaveedits button onlymodifies
the currently selected network datamatrices, otherwise, thematrix data for all frequencies
and variations are adjusted.

Smoothing

The data smoothing dialog is accessed via theSmooth All Frequencies option on theEditmenu.

A least-squares polynomial fit of the specified order is used to interpolate new data points for the
magnitude and phase components of the S-parameters. You can also choose to enforce causality
and to create a new data set that contains the smoothed data.

Cell Filtering

The cells available in the data selection panemay be restricted using theCell Filtering dialog by
selectingEdit > Cell Filter.

Network Data Explorer 22-17
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

TheCell filtering dialog filters are applied immediately to the cell list. Filtering remains in effect even
after the dialog has been closed.
For an n-port model with a total of 2n pins in the standard arrangement, the choices are:

l Show all the available cells. There are n-squared choices.
l Return loss, show S(i, i). There are n choices.
l Insertion loss, show S(i, i+1). There are n choices.
l Lower triangle, show S(i, j) for all j < i. There are n(n-1)/2 choices.

Three pin ordering arrangements are recognized:
l S(i, i+1) and itsReverse order, S(i, i-1)
l S(i, i+n) and itsReverse order, S(i, i-n)
l S(i, 2*n-i+1) and itsReverse order, S(i, 2*n-i-1)

Changing Port Properties and Reducing Matrix Size

Access thePortProperties dialog through theEdit PortProperties option on theEditmenu. The
normalization impedance, termination, port order, gamma values, and de-embedding distancemay
all be edited through this dialog.
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l Impedance values are specified in ohms andmay be complex, the accepted syntaxes are:
                    — real, e.g. 50
                    — real + imag i, e.g. 50+5i
                    — mag i, e.g. 5i

l Explicit unitsmay be used with the impedance value (e.g. 0.5kOhm) but will always be
shown in ohms (when the dialog is redisplayed).

l Reorder ports by clicking and dragging their row. To see the port names in the data view
displays, use theDisplay Full Port Namesmenu option.

l Terminated ports are eliminated from thematrix thereby reducing thematrix size. Existing
data sets with mismatching port numbers will no longer be available for data comparisons.

l Port propertiesmay be restored to their load time values using theReset All Port
Properties option on theEditmenu.

l The de-emebedding column only appears if gamma values are available. Values are
always displayed in the units indicated in the column header, however, valuesmay be
entered with specific units, e.g. “1.5in”. The default unitsmay be changed via theSet
Display Format dialog (available on theEditmenu or the right-click context menu).

Once the changes have been committed by selectingOK, themodifiedmatrix valuesmay be saved
to a file using the File > Save As option.

Displaying Mixed-Mode Parameters using Differential Pairs

Mixed-mode parameters are displayed in place of single-ended parameters when you define
Differential Pairs via theEdit>Define Differential Pairsmenu selection.

You can also edit the names and reference impedances of the differential pair.
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Reset All Port Properties

Edit>Reset All Port Properties resets Port Properties impedance values, termination settings,
and deembed values. It also disables differential pairs.

Data Display Pane Context Menus
TheData Display pane presents different right-clickmenus depending on the context. Some of the
commands are the same as those on the Edit menu. Others only appear in the context menus.

l Data Display Pane: Matrix Entries and Table Selected
l Data Display Pane: Frequencies and Table Selected
l Data Display Pane: Matrix Entries and Plot Selected
l Data Display Pane: Frequencies and Plot Selected

The ndExplorer commands unique to the context menus are:
l Multiple Frequency Statistics
l Highlight Min/Max
l Select Transpose
l Select Compare Variations
l Color Legend Attributes

ThePlot>Log Frequencymenu command also affects the display pane, and lets you toggle to log
frequency scale display of traces and values.
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Data Display Pane: Matrix Entries and Table Selected

The shortcut menu only provides commands included in the Edit menu.

Data Display Pane: Frequencies and Table Selected

The shortcut menu provides the following commands.

TheData Sources,Display Format, and Full Fort Names commands are the same as in the Edit
menu. The other commands accessed through this context menu are:

l Multiple Frequency Statistics
l Highlight Min/Max
l Select Transpose

Data Display Pane: Matrix Entries and Plot Selected

The right-click shortcut menu provides commands and submenus for editing the plot by adding
markers, text notes, changing the view, or copying the current image..
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l TheMarker submenu options includes the commands for addingmarkers to plots:

l The AddNote command opens a dialog for adding a text note:
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l The View submenu options include Zoom, Pan, Fit All, Visibility, etc.

TheVisibility command lets you select traces, notes, or legends for visibility. You can also
search traces by name and use theShow andHide buttons.
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l A right clickCopyImage is also available. The copied imagemay be pasted into external
documents.

l Holding the cursor over a trace will provide an identifying tool-tip. For multiple variations this
is the only way to distinguish between the curves for a particular cell.

l SelectingEdit>Properties opens a Properties dialog for the selected trace or plot object.
Selecting Table in the data view pane, switches the view to a tabular view of the trace object.

Data Display Pane: Frequencies and Plot Selected

The shortcut menu provides the following commands.
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TheData Sources command andMagnitude Thresholding are the same as on the Edit menu.
The other commands are:

l Multiple Frequency Statistics
l Highlight Min/Max
l Select Transpose
l Color Legend Attributes

Multiple Frequency Statistics

If you select Frequencies in the Data Control pane, and either Table or Plot in the Data View pane,
the shortcut menu includes the following commands:

TheMultiple Frequency Statistics option determines the statistical composite to display when
multiple frequencies have been selected for thematrix display. The statistical data is always the first
matrix displayed, followed bymatrices for each individual frequency. TheMultiple Frequency
Statistics also indicates the data to be used in the coloredmatrix plot whenmultiple frequencies
have been selected.
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l Average: Display the average of thematrix values across the selected frequencies.

l Minimum: Display theminimummatrix values across the selected frequencies.

l Maximum: Display themaximummatrix values across the selected frequencies.

Highlight Min/Max

This ndExplorer context menu option determineswhether theminimumandmaximummatrix entries
should be highlighted in thematrix table and color plot view.

Select Transpose

When selecting a cell in the table view of the Frequencies, this ndExplorer Editmenu option
determines if the transpose cell is to be highlighted aswell.

This feature also works for the plot view of the frequencies
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Changing the Color Scheme for a Matrix Color Plot

Double clicking thematrix color plot legend or right clicking within the plot itself and choosingColor
Legend Attributes, displays the LegendAttributes dialog. The dialog permits you to change the
granularity of the color scheme and the value range but not the colors themselves. Using a standard
range across all frequencies permits you to quantitatively compare plots; ndExplorer remembers
legend settings for each data-type/display-format pair.

l Number of colors: number of color entries in the legend, i.e. the number of divisions
between the start/end of the data range.

l Use the data minimum and maximum: automatically select the data range using the
minimumandmaximum values from either just the selectedfrequencies or
allfrequencies in the data set.

l Minimum & Maximum: when the range is not automatically determined, these fields
permit the user to manually enter hard values, e.g. for S parameter datamagnitude data, a
minimumof 0 and amaximumor 1 could be used.

Network Data Explorer 22-27
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Exploring Network Data and Modifying the Display
TheNetwork Data Explorer allows you to view data andmodify various aspects of the display,
including color plots, color coding, viewing across frequencies, and displaying individual statistics.
This section provides examples of variousways of using ndExplorer.

l Viewing the S, Y, or Z Matrix for a Selected Frequency
l Viewing a Color CodedMatrix Plot
l ViewingMatrix Cell Data Across All Frequencies
l Displaying aGraph of a Cell Across All Frequencies
l Displaying Statistics by Frequency
l Displaying Individual Statistics for All Frequencies
l Creating a Statistics Plot
l Comparing Network Data
l Comparing Variations
l Displaying Plot Traces fromMultiple Data Sources

Related Topics

Magnitude Thresholding
Smooth All Frequencies
Cell Filtering
Edit Port Properties
Display Differential Pairs as Post Process Selection

Viewing the S, Y, or Z Matrix for a Selected Frequency

1. SelectParametervalues in theQuantity control field.
2. Select Frequencies in the data selection pane at left.
3. Select Table in the data view pane at right.
4. Choose the frequencies and the variations to display.
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l Themaximum value (and its transpose) is highlighted in red and theminimum value in blue.
Complex values (regardless of the data format) are compared using their modulus. When
multiple frequencies or variations are selected, the first in the data display is either the
average, minimum, or maximumof all the frequencies selected— the selection type is set
via the right-clickmenu option,Multiple Frequency Statistics.

l UseParametertype in the control panel to choose the data type (S, Y, or Z) and Format to
specify how the data values are to be displayed (real, imaginary, dB, etc.).

l When the cursor is placed over a cell, tool-tip text reveals detail as to the content of the cell.
Whenmultiple variations are selected, use the tooltips to identify the variation being
displayed. Clicking in a cell will select it and its transpose. Double clicking a cell takes the
user to amatrix cell view in which values for all frequencies for that particular cell are
displayed; the double-clicked frequency is highlighted with solid red shading.

l SelectingPlot in the data view pane switches the view to a colored graphical
representation of the tabular data.
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Color Coded Matrix Plot

1. SelectParametervalues in theQuantity control field.
2. Select Frequencies in the data selection pane at left.
3. SelectPlot in the data view pane at right.
4. Choose the frequency and variation to display.

l Thematrix values are displayed in a color coded grid; if the current Format is a complex
value, only the real component is used to determine the display color. Use the
Parametertype selection in the control panel to choose the data type: S, Y, or Z parameter.
Whenmultiple frequencies or variations are selected, either theminimum, maximum, or
average value is displayed (as chosen with the right-clickmenu option,Multiple
Frequency Statistics).

l Themaximum value (and its transpose) is highlighted in red and theminimum value in
blue; the real value alone is used to determine these extremes.
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l When the cursor is placed over a cell, tool-tip text reveals detail as to the content of the cell.
Clicking in a cell will select it and its transpose. Double clicking a cell takes the user to the
matrix cell plot in which all frequency values for that matrix cell are displayed as a graph.

l Double clicking the legend or choosing the right-clickmenu optionColor Legend
Attributes allows you to select the data range and number of colors for each data type and
format. See Changing the Color Scheme for aMatrix Color Plot.

l Selecting Table in the data view pane, switches the view to amatrix representation of the
graphical data.

Viewing Matrix Cell Data Across All Frequencies

1. SelectParametervalues in theQuantity control field.
2. SelectMatrix entries in the data selection pane at left.
3. Select Table in the data view pane at right.
4. Choose the frequency and variation to display.
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l Values for all frequencies are displayed for eachmatrix cell selected. The data type and
format are determined by theParametertype and the Format settings in the control pane.

l When the cursor is placed over a table cell, tool-tip text revealsmore detail as to the content
of the cell. Clicking in a cell will select it. Double clicking a cell takes the user to thematrix
table view in which all cell values for the corresponding frequency are displayed; the
double-clicked cell is highlighted with solid red shading.

l Clicking on a column header in the data table highlights the column. The corresponding
trace in the plot view is also highlighted.

l SelectingPlot in the data view pane, switches the view to a graph of the cell data. The
graph shares the same color coding as the columns; highlighted columns are highlighted in
the plot.

Displaying a Graph of a Cell Across All Frequencies

1. SelectParametervalues in theQuantity control field.
2. SelectMatrix entries in the data selection pane at left.
3. SelectPlot in the data view pane at right.
4. Choose the cells and variations to display.
5. SelectPlot > Log Frequency to switch the X axis to a log scale.
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Displaying Statistics by Frequency

1. SelectMatrix statistics in theQuantity control field.
2. Select Frequencies in the data selection pane at left.
3. Select Table in the data view pane at right.
4. Choose the frequencies and variations to display.

l The various statistical measures for the currentParametertype and Format are displayed
for each frequency selected. Only real (not complex) data formats are offered for statistical
analysis.Passivity is only available for S-parameter data (comparisons inactive).NTI
refers to the number of trivial items; for S-parameters, this includes all zeros and ones; for
all other data (and data comparisons), only zeros are counted as trivial. Theminimum value
for each column is highlighted in blue; themaximum is highlighted with red.
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l When the cursor is placed over a cell, tool-tip text indicates the frequency and statistics
displayed. Clicking a cell selects the cell. Multiple variations are displayed as separate
entries in the table; use the tool-tip to identify the variation for a particular frequency.

l Clicking a column header sorts the data using that column for comparison; clicking again
reverses the order of the sort.

Displaying Individual Statistics for All Frequencies

1. SelectMatrix statistics in theQuantity control field.
2. SelectMatrix entries in the data selection pane at left.
3. Select Table in the data view pane at right.
4. Choose the statistics and variations to display.
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l The various statistical measures (for the currentParametertype and Format) are
displayed for all frequencies.Passivity is only available for S-parameters (comparisons
inactive).NTI refers to the number of trivial items; for S-parameters, this includes all zeros
and ones; for all other data (and data comparisons), only zeros are counted as trivial.

l When the cursor is placed over a cell, tool-tip text indicates the frequency and statistics
displayed. Clicking a cell selects the cell. Multiple variations are displayed as separate
entries in the table; use the tool-tip to identify the variation for a particular frequency.

l SelectingPlot in the data view pane, switches the view to a graph of the statistical data.
The graph shares the same color coding as the columns; highlighted columns are
highlighted in the plot.

Creating a Statistics Plot

1. SelectMatrix statistics in theQuantity control field.
2. SelectMatrix entries in the data selection pane at left.
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3. SelectPlot in the data view pane at right.
4. Choose the statistics and variations to display.

l A graph of each of the statistical measures selected (for the currentParametertype and
Format) is displayed across all frequencies.

l When the cursor is placed over a curve, tool-tip text indicates the statistical function, the
data format, the data type, and the variation of the graph being displayed.

l Selecting Table in the data view pane, switches the view to a tabular presentation of the
statistical data. The table columns share the same color coding as the plot traces.

Comparing Network Data

1. SelectBrowse in theCompare matrix data control field or theComparemenu option on
the Filemenu.
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2. Load a network data file to be compared with the currently active data. Multiple filesmay be
opened from the file browser dialog, however, only one file is compared against the primary
data set at any given time.

l The data displayed in all views is now of the primary Network data less the values for the
compare data set. The data format (magnitude, dB, etc.) is applied either before (pre) or
after (post) the subtraction depending on the corresponding setting in the
Displayformatsettings dialog (available on theEditmenu or the right-click context
menu).

l Multiple data-sets can be loaded for comparison though only one is active at any one time.
The compare data set may be changed by using theCompare matrix data control field;
comparisonsmay also be turned off by selectingNocompare.

l The primary data sourcemay be changed using theNetwork data file drop-down list
within the control pane. By so doing, a comparison data set may bemade the primary data
set, either for viewing as is, or for comparing with other network data.

l TheCompare matrix data dialog, accessed through theSelect Compare Variations
menu option, may also be used to switch comparison data sets. When a comparison is
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active, the data sets are restricted to one variation. The variation selected in the variation
list box applies to the primary data source alone, i.e. the one displayed in the
Networkdatafile field of the control pane.

Comparing Variations

1. SelectBrowse in theCompare matrix data control field or theComparemenu option on
the Filemenu.

2. Load the data for the same (or different) network data file. Please note, that currently only
".nmf" files support multiple variations.

3. UseEdit>Data Sources (Editmenu or the right-clickmenu, table view) to choose the
variations to compare.

l TheData Sources dialog displays a table of all the loaded data. Selecting a row changes
the comparison data set; the data view is updated when the dialog is dismissed with theOK
button. Note: it is not possible to compare a data set against itself, unless the data set has
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been loaded twice. Selecting the active data set row clears the comparison.
l The variations being usedmay be changed through the drop-down lists in theCompare
Variation column. Please note that when comparisons are inactive, all the variations for the
active data sourcemay be displayed (where relevant) in the data view; when comparisons
are active, only the one selected variation is displayed.

Displaying Plot Traces from Multiple Data Sources

1. Openmultiple data sets, either through themain file browser or through the data comparison
browser.

2. Use theEdit>Data Sources menu or the right-clickmenu to open the
SelectCompareVariations dialog.

3. Enable theDisplay plot traces for all data sources option.

l Traces for a given cell or statistical measure are displayed for all data sets; you can use tool
tips to distinguish between them.
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l If a single cell or statistical measure is displayed, different colors are used for each data
trace.

l If multiple cells or statistical measures are selected, a single color is used for all data traces
for each cell or statistical measure.

l If a data comparison is active, traceswill be shown for all data sets compared against it
(with the exception of the comparison data set). This is true for both cell and statistical
traces.

l Data sets with no variation information are always displayed.Withmultiple variation data
sets, only those with values for the currently selected variations are displayed. (Note that
the variation for the comparison data set is fixed by the selection that ismade in theSelect
Compare Variations dialog.)

Causality Checking and Plots
The ndExplorer can perform a causality check on S-parameter data from any source (solution or
file), and provide plots of the results in various formats.
When S-parameter data are loaded into ndExplorer, the CheckCausality button is enabled.

Click on the button to start the causality check. Depending on the size of the S-parameter data, the
causality checkmay take several minutes or longer to complete.
When the causality check is complete, a summary of the results appears in theMessage window.

Causality of a frequency response is determined by calculating the generalized Hilbert transform of
the data at all frequencies. A causal frequency response is equal to its generalized Hilbert transform.
The reconstruction error is the difference between the tabulated data and its transform at a given
frequency. Themessage shows themaximum reconstruction error tolerance for a causal frequency
response. The default tolerance of 0.01 is equal to the state-space fitting tolerance.
The second line reports themaximum causality error for all port pairs and all frequencies, along with
thematrix indices (port numbers) where themaximumnoncausality occurs. A noncausal response is
one where all matrix entries can be conclusively analyzed, and at least one entry exceeds the
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causality tolerance. In themessage shown above, the Touchstone file tline_noncausal.s2p has a
maximum reconstruction error of 0.0191544 in the response involving ports 1 and 2.
When all results are conclusive but nomatrix reconstruction error exceeds the tolerance, the
maximum causality error is reported as zero, and nomatrix entry is listed.
If the data does not contain enough frequency points to determine whether the data is or is not
causal, themessage will indicate the inconclusive result.

ndExplorer will report the data set as inconclusive if any cells are inconclusive, even if other entries
exhibit causality violations.
To see the results of the causality check, click in theQuantity field and selectCausality plots.
To view a summary diagram of the causality results, set thePlot Type toCausality violation.
The default mode is a rectangular Plot of dimension N xN, with color-coding to indicate the
causality status of each port pairing:
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In this plot, the cells go from (Port 1, Port 1) at the upper left to (Port N, Port N) at the lower right. The
result shows the causality over all frequencies in the data. In this example, thematrix is symmetric,
so that both S12 and S21 are noncausal, while S11 and S22 are causal.
To see the details for each frequency, clickTable for theView instead of Plot.
To plot the reconstructed frequency response generated by the causality checker, leave the
Quantity atCausality plots and set thePlot type toReconstructed data. The Format field
appears:

The default Format isdB. This plots the reconstruction error at each frequency divided by the
tolerance, 0.01 in this example. Here is the plot for the noncausal S12 data identified in the Causality
plot shown earlier.

The reconstruction error ratio for parameter S12 is positive for frequencies less than about 680MHz,
indicating a broad range of noncausal behavior.
To compare the real part of the reconstructed data to the real part of the actual data, set the Format
toReal.
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For a causal frequency response, the actual data (solid line) will be within the upper and lower
bounds of the reconstruction (dotted lines) at all frequencies.
To compare the imaginary part of the reconstructed data to the imaginary part of the actual data, set
the Format to Imaginary.
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For a causal frequency response, the actual data (solid line) will be within the upper and lower
bounds of the reconstruction (dotted lines) at all frequencies.
To view the frequency-dependent discretization error, set the Format toDiscretization.

The discretization error is the error that is due to the fact that the data are available only at discrete
frequencies rather than for a continuous spectrum. A discretization error near or greater than the
causality tolerance renders the causality check inconclusive. Data at more frequencies could reduce
the discretization error and render the analysis conclusive. This set of data exhibits low discretization
errors (<<0.01) at all frequencies, and the causality check is conclusive (conclusively noncausal in
this example).
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23 - Post Processing and Generating Reports
WhenMaxwell has completed a solution, you can display and analyze the results in the following
ways:

l View solution data including the following: convergence information, computing resources that
were used during the solution process, mesh statistics, andmatrices computed during each
adaptive, non-adaptive, or sweep solution.

l View analysis results for Optimetrics solutions.
l Plot field overlays - representations of basic or derived field quantities on surfaces or objects.
l Overlay Field Plots onModels
l Create 2D or 3D reports of RLC matrices and basic and derived field quantities.
l Plot the finite element mesh on surfaces or within 3D objects.
l Create animations of field quantities, the finite element mesh, and defined project variables.
l Use the Fields Calculator to perform computations using basic field quantities.

Note Except in the case of non-model boxes drawn in the global coordinate system (CS),
non-model objects cannot be used for any fields post processing operation You can
use non-model boxes drawn in the global CS for post processing operations,
including integration and solution domaining.

Related Topics

Viewing Analysis Results for Optimetrics Solutions

Viewing Solution Data
While Maxwell is generating a solution, or when it is complete, you can view the following information
about the solution:

l Convergence information.
l Computing resources, or profile information, that were used during the solution process.
l Output Variables computed during each adaptive, non-adaptive, or sweep solution.
l Output Parameters andMatrix Data computed during each adaptive, non-adaptive, or sweep
solution.

l Mesh data.
Note Since adaptivemesh refinement is not performed for transient solutions,

convergence data is not available for Transient analysis.
l The state of solved solutions.
l Winding results for Eddy current solutions.
l EndConnection results for Eddy current solutions.
l Loss results for Eddy current solutions.

To access theSolutions dialog box, in which the information above can be accessed, do one of the
following:
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l ClickMaxwell3D,Maxwell2D, or RMxprt and then selectResults>Solution Data .
l Right-clickResults in the project tree, and then clickSolution Data on the shortcut menu.

Related Topics

Viewing Solution Data for anOptimetrics Design Variation
Monitoring the Solution Process

Viewing Convergence Data

To view an adaptive solution's convergence information, either during or after the solution process:
1. In the project tree, right-click the solution setup of interest, and then clickConvergence on the

shortcut menu.
TheSolutions dialog box appears with theConvergence tab selected.

2. From theSimulation pull-down list, select the solution setup for which you want to view
convergence data.
By default, themost recently solved solution is selected.

3. Under theConvergence tab, depending on your design setup, you can review the following
convergence data:
l Whether the solution is converged or not converged.
l Number of adaptive passes completed and remaining.
l The number of tetrahedra or triangles created at each adaptive pass.
l Solution type dependent parameters such as Loss, Total Loss, Loss Error.
l Output Variable between two passes.

4. Select Table to display the convergence data in table format or Plot to plot the convergence
data on a rectangular (XY) plot.

5. If you selectSave Defaults, the current selection of either Table or Plot, and for Plot the
current X and Y axis selections, will be applied based on the design-type, each time you open
the desktop. You can also selectClear Defaults to reset to the original settings.

Related Topics

Viewing Solution Data for anOptimetrics Design Variation
Plotting aQuantity versus Adaptive Pass

Viewing the Number of Completed Passes

At any time during the solution process, you can view the number of adaptive passes (solve— error
analysis— refine cycles) that have been completed and that have yet to be completed.When the
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solution is complete, you can view the number of adaptive passes that were performed. If the
solution converged within the specified stopping criteria, fewer passes than requestedmay have
been performed.
To view the number of passes:

l In the project tree, right-click the solution setup of interest, and then clickConvergence on the
shortcut menu.
TheSolutions dialog box appears with theConvergence tab selected.
The number of completed and remaining passes is listed in theNumber of Passes area.

Viewing Output Variable Convergence

At any time during or after the solution process, you can view the values of the output variable.
To view the output variable convergence:

l In the project tree, right-click the solution setup of interest, and then clickConvergence on the
shortcut menu.
TheSolutions window appears. TheConvergence tab is selected.
TheOutput Var column lists the value of the output variable for each pass. TheOutput Var.
Delta (%) column lists the delta change between the current and previous passes as a
percentage of the previous pass value. If output variable convergence is not used, the
columns are not used in the table.

Related Topics

Specifying Output Variables

Plotting Convergence Data

To display convergence data vs. pass on a rectangular (x - y) plot:
1. In the project tree, right-click the solution setup of interest, and then clickConvergence on the

shortcut menu.
TheSolutions dialog box appears with theConvergence tab selected.

2. In the lower-left corner of the window, selectPlot as theView type.
3. Select the data you want to plot on the x-axis from theX pull-down list.
4. Select the data type you want to plot on the y-axis from theY pull-down list.
5. ClickClose.

The xy plot appears in the view window.

Viewing a Solution Profile

At any time during or after the solution process, you can examine the computing resources - or
profile data - that were used byMaxwell during the analysis. The profile data is essentially a log of the
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tasks performed byMaxwell during the solution. The log indicates the length of time each task took
and how much physical memory/diskmemorywas required.

l In the project tree, right-click the solution setup of interest, and then clickProfile on the
shortcut menu.

TheSolutions dialog box appears with theProfile tab is selected. The displayed data depends on
the type of problem and solution setup. In general, it includes the following information:

Task Lists the type of task that was performed. The Tasks lists included Start, various
Mesh tasks, Simulation Setup, Port Adaptation, Adaptive Pass tasks, including
simulation setup, Matrix Assembly, Solver tasks, and Field Recovery, Sweep tasks,
and Solution Process summary and Totals for time.

Real Time The difference in time between the start of the task and the end of the task (elapsed
time).

CPU Time The amount of CPU time required to perform the task.
Memory The peak amount of physical memory (RAM) used by the individual executable

running the task. Thememory is freed for other uses after each task is complete.
Information General information about the solution, for example, the number of tetrahedra used

in themesh, disk use, solver information, sweep information, the elapsed time, and
thememory used by theMaxwellComEngine, and totals.
The elapsed time is the difference between the time in theStart line and the time in
the Total line— how long the task actually took between whenAnalyzewas clicked
and when the simulation finished. The elapsed time is a little greater than theReal
Time given in the Total line. This is because the Total line contains the sum of all of
the real times reported by the individual processes and does not include the typically
small amount of time theMaxwell ComEngine uses before, after, and in between
calling the other executables.

Thematrix solver writes specific information in some of these fields as outlined below:

Task Thematrix solver task reports the type of solution performed by the solver, based
on the physics of the problem. It has the form "Solver pdsn" (e.g. Solver MRS2 or
Solver DCS4-L2), where

l p , the precision type is: M (mixed for direct solver) or D (double for iterative
solver).

l d , thematrix data type is: R (real) or C (complex)

l s , the symmetry type is: S (symmetric), A (asymmetric), or H (hermitian)

l n , the number of processors used. You specify the number of available
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processors on the local machine in theMaxwell options. If a solve does not
use all available processors (local or distributed), the number reportedmay
be less than the number available.

If a simulation uses the iterative solver, the Solver designation can include a level
indicator appended. to an Iterative solver designation (L2 in the example above).
The higher the Level number the lower thememory, you will never see L1 (this
would be equivalent to direct solver. And a first order solve will only display L2 since
it only has one level of order to go down for preconditioning. A second or mixed
order solvemay display L3 depending on themesh quality.
If the solver switches from the Iterative Solver to theMatrix solver, you see aMatrix
solver warning: Switch from Iterative Solver to Direct Solver.

Information: Thematrix solver information line includes, for example, Disk = 0 KBytes, matrix
size 11137 , matrix bandwidth 20.3 )

l Disk: The amount of hard disk space used during the calculation of thematrix
solution. If the disk usage for matrix solver is non-zero in profile, it usually
indicates off-corematrix solver. If thematrix solver must solve off-core,
smaller blocks of the data to be solved are created on disk, each block is then
solved in physical memory, and then thematrix solution is reassembled. As a
result of this additional processing, the time required to calculate a solution is
higher.

l matrix size: The size of thematrix that was solved (the number of unknowns)
l matrix bandwidth: An FEMmatrix is a sparsematrix. The solver only stores
the non-zero entries. Thematrix bandwidth is the average number of non-
zeros per row. It gives an idea of the sparsity of a FEMmatrix.Storage for the
sparsematrix is proportional to the total number of nonzeros = #rows x
bandwidth. The higher the bases order, the larger the bandwidth.

l In the case of the Iterative Solver, # Iterations

To Export the Profile data:
1. Open theSolutions dialog boxwith theProfile tab selected.
2. Click theExport... button.

This opens a file save dialog that lets you provide a file name and location.
3. Click Save.

The data is saved in a text file with a .prof extension.

Related Topics

Viewing anOptimetrics Solution's Profile Data

Viewing Matrix Data

To view matrix parameter data:
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1. In the project tree, right-click the solution setup of interest, and then clickSolutions on the
shortcut menu.
TheSolutions dialog box appears. Select theMatrix tab. A typical example is shown below.

2. TheDesign Variation box shows the current design.
Optionally, click the ... button, and choose a design variation solved during an optimization or
parametric analysis from theSet Design Variation dialog boxwhich lists all the solved
variations in the design.

3. In theSimulation pull-down lists:
l Select the solution setup from the left pull-down list.
l Select the solved pass data you wish to view from the right pull-down list, either the
LastAdaptive pass or an intermediateAdaptivePass. If you selectAdaptivePass you
must also select the desired intermediate pass form thePass pull-down list.

4. Select aParameter.
5. Select one of the items from the Type pull-down list. Items available in the Type list depend

upon the design’s solution type setting. For example:
l Inductance (for magnetostatic solutions)
l Re(Z), Im(Z) (for eddy current solutions)
l R, L (for eddy current solutions)
l G,C (for ACConduction solutions)
l Capacitance (for electrostatic solutions)
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l Flux Linkage (for magnetostatic and eddy current solutions)
l Inductive coupling coefficient (for magnetostatic and eddy current solutions)
l Capacitive coupling coefficient (for electrostatic and ACConduction solutions)
Depending on the solution type you selected, youmay have to specify theUnits in which to
display the information. The available units depend on thematrix type being displayed.
The bottom pane displays values for the selected type.

6. (Optional) The results of the post processing calculation, including grouped sources (defined
on theMatrix dialog Post Processing tab) on thematrix can be seen by selecting
PostProcessed.

7. (Optional) To export thematrix data (as specified by the Type list):
a. ClickExport Solution.

TheExport Solution dialog box appears.

b. Select a location for the solution data.
c. Type a filename in which to store the data in the File name text box.
d. ClickSave. The solution is saved as a data table in the specified file.

8. Youmay optionally export a circuit based on thematrix parameter type by clicking Export
Circuit. TheExport Circuit button appears in the dialog boxwhen a supported type is
selected.

Exporting a Circuit Model

To export the circuit:
1. In theSolutions dialog box, clickExport Circuit.

TheExport Circuit dialog box appears.
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2. In theEquivalent Circuit Settings section, select thematrix you want to export from the
Matrix pull-down list.

3. (Optional) Type a scaling factor in theScaling Factor text box. Youmaywant to provide a
scaling factor if you are using symmetry to analyze a portion of themodel.

4. For an inductionmatrix, type aResistance for each source listed in the table.
5. (Optional) If desired, drag table rows to re-order the circuit pins.
6. (Optional) The results of the post processing calculation (defined on theMatrix dialog Post

Processing tab) on thematrix can be included by selectingPostProcessed.
7. In the Circuit Export section, select a setup from the Solution Setup pull-down list.
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8. (Optional) Click the ... button to open theSet Design Variation dialog box to choose a
Variation.

9. Type the path and file name in the File name text box, or click the ... button to select the
desired location for the exported circuit.

10. (Optional) To view the netlist:
a. ClickPreview.

TheCircuit Model Preview dialog box appears. You can also clickExport Circuit from
within this dialog box.

b. ClickClose to close the netlist.
11. To export the circuit to the specified file, clickExport Circuit.
12. ClickOK to close theExport Circuit dialog box.
13. ClickClose to close theSolutions dialog box.

Coupling Coefficient Matrix

For amatrix with entriesMij, i, j = 1,..., N, the coupling coefficient for row i and column j is given by the
following equation:

This coefficient indicates how much flux in one coil is linked with the other coil.
If all the flux in one coil reaches the other coil, k = 1 (and coupling is 100%).
Inductors with k > 0.5 are tightly coupled. Inductors with k < 0.5 are loosely coupled.

Themutual inductance (M) falls between 0 and (the geometricmean of the
inductances).

Related Topics

Assigning aMatrix

Viewing Parameter Data

To view parameter solution data such as force and torque:
1. In the project tree, right-click the solution setup of interest in theParameters folder, and then

clickView Solution on the shortcut menu.
TheSolutions dialog box appears.
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2. TheDesign Variation box shows the current design.
Optionally, click the [...] button, and choose a design variation solved during an optimization or
parametric analysis from theSet Design Variation dialog box.

3. In theSimulation pull-down lists:
l Select the solution setup from the first pull-down list.
l Select the solved pass data you wish to view from the second pull-down list, either the last
adaptive pass or one of the intermediate passes.

4. On the desired parameter tab, such as Force or Torque, select aParameter and optionally an
adaptivePass to view.
Depending on the solution type you selected, youmay have to specify theUnits in which to
display the information. The available units depend on thematrix type being displayed.
Optionally, to export the parameter solution data:
a. ClickExport Solution to open theExport Solution dialog box appears.
b. Select a location for the solution data.
c. Type a filename in which to store the data in the File name text box.
d. ClickSave.

5. ClickClose to close theSolutions dialog box.

Related Topics

Adding solution Parameters

Viewing Mesh Statistics

To view an adaptive solution'smesh information, either during or after the solution process:
1. In the project tree, right-click the solution setup of interest, and then clickMesh Statistics on

the shortcut menu.
TheSolutions dialog box appears with theMesh Statistics tab selected.
The table lists the design elements and depending upon the solution typemay include: Num
Tets (tetrahedra), Min edge length, Max edge length, RMS edge length, min tet vol., max tet
vol., mean tet vol. and standard deviation (min elem area, max elem area, mean elem area
and standard deviation for 2D designs).
If mesh repairs have been performed, two additional columns appear in the table; Recovered
% andReparied%. These columns indicate the fraction of an object that was successfully
recovered and the fraction that needed some repair.

To toggle themesh statistics display from low to high values or visa versa:
1. Click on the column header.

This displays a shadowed triangle pointing down to indicate a list ordered from highest to
lowest, and a triangle pointing up to indicate a list ordered from lowest to highest. Clicking
again inverts the current order.
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Click on the blank cell above the object list to invert the order of objects, though in this case, the
cell does not display a directional triangle.

Related Topics

Technical Notes: Finite Element Analysis
Technical Notes:TheMeshGeneration Process

Viewing Winding Results (Eddy Current)

To view winding results for Eddy current solutions:
1. In the project tree, right-click theResults folder, and then clickSolution Data on the shortcut

menu.
TheSolutions dialog box appears.

2. TheDesign Variation box shows the current design.
Optionally, click the [...] button, and choose a design variation solved during an optimization or
parametric analysis from theSet Design Variation dialog box.

3. In theSimulation pull-down lists:
l Select the solution setup from the left pull-down list.
l Select the solved pass data you wish to view from the right drop-down list – either the
LastAdaptive pass, or an intermediateAdaptivePass. If LastAdaptive is selected, the
Freq drop-down list is enabled for you to choose frequency. If AdaptivePass is selected,
thePass drop-down list is enabled for you to choose the desired intermediate pass.

4. If the design includeswindings, theWinding tab displays the following columns: Flux
Linkage[Wb], Induced Voltage[V], Input Current[A], Input Voltage[V], andCurrent[A].
Results listed in these columns are complex quantities.
l For Current type windings: Flux Linkage, Induced Voltage, and Input Current results are
shown. The other quantities are shown asN/A (not applicable).

l For Voltage type windings: Flux Linkage, Induced Voltage, Input Current, and Current
results are shown. The other quantities are shown asN/A (not applicable).

l For External type windings: Flux Linkage, Induced Voltage, and Current results are shown.
The other quantities are shown asN/A (not applicable).

5. ClickClose to close theSolutions dialog box.

Viewing End Connection Results (2D Eddy Current)

To view end connection results for Maxwell 2D Eddy current solutions:
1. In the project tree, right-click theResults folder, and then clickSolution Data on the shortcut

menu.
TheSolutions dialog box appears.

2. TheDesign Variation box shows the current design.
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Optionally, click the [...] button, and choose a design variation solved during an optimization or
parametric analysis from theSet Design Variation dialog box.

3. In theSimulation pull-down lists:
l Select the solution setup from the left pull-down list.
l Select the solved pass data you wish to view from the right drop-down list – either the
LastAdaptive pass, or an intermediateAdaptivePass. If LastAdaptive is selected, the
Freq drop-down list is enabled for you to choose frequency. If AdaptivePass is selected,
thePass drop-down list is enabled for you to choose the desired intermediate pass.

4. If the design includes end connections, theEnd Connection tab displays columns for:
Induced Voltage[V], andCurrent[A]. Results listed in these columns are complex
quantities.

5. ClickClose to close theSolutions dialog box.

Viewing Loss Results (Eddy Current)

To view loss results for Eddy current solutions:
1. In the project tree, right-click theResults folder, and then clickSolution Data on the shortcut

menu.
TheSolutions dialog box appears.

2. TheDesign Variation box shows the current design.
Optionally, click the [...] button, and choose a design variation solved during an optimization or
parametric analysis from theSet Design Variation dialog box.

3. In theSimulation pull-down lists:
l Select the solution setup from the left pull-down list.
l Select the solved pass data you wish to view from the right drop-down list – either the
LastAdaptive pass, or an intermediateAdaptivePass. If LastAdaptive is selected, the
Freq drop-down list is enabled for you to choose frequency. If AdaptivePass is selected,
thePass drop-down list is enabled for you to choose the desired intermediate pass.

4. The Loss tab displays the following columns:Core Loss[W], Solid Loss[W], Stranded
Loss[W], andStranded Loss R[W]. Results listed in these columns are real quantities.

5. ClickClose to close theSolutions dialog box.

Cleaning Up Solutions
You can useClean Up Solutions to selectivelymake deletions, or remove all solutions from the
results.
To useClean Up Solutions:

1. Depending upon the project type, clickMaxwell3D, Maxwell2D, or RMxprt and then select
Results>Clean Up Solutions.
TheClean Up Solutions dialog box appears.
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2. Under Solutions, select whether you want to delete only fields data, only fields andmesh
data, only linked data, or all solution data. Deleting all solution data erases all mesh, matrix,
and fields data for all adaptive passes and frequency sweeps for the selectedVariations.
Optionally, you can Include Linked Data in the deletions.
Linked data can bemesh, field or some other post-processing data that the source design
generated. The target design for the link caches these data internally to minimize the need to
activate the source design.

3. Under Variations, select which solution data you want to delete:
l SelectAll Except Current Variation to delete all solution data that do not correspond to
the current project and design variable values for the current design.

l SelectAll Variations to delete all solution data for the current design.
l SelectSelect to specify the variations you wish to delete. ClickVariations to select the
variations for deletion.

4. ClickDo Deletions.
The solution data you selected are deleted. Any post processing reports or field overlays you
created that included data you deleted will bemarked with an X in the project tree. Theywill be
invalid until new solution data are generated.

Related Topics

Monitoring the Solution Process
Deleting Reports

Creating Animations
An animated plot is a series of frames that displays a field, mesh, or geometry at varying variable
values. To create an animated plot, specify the variable values of the plot that you want to include.
Each plot associated with a variable value is a frame in the animation. You specify how many frames
to include in the animation.

Note Each animation frame requiresmemory for storage which depends upon themesh size
and type of plot. Memory usagemay become very large during plot animations. To reduce
memory usage, specify theminimumnumber of frames possible. SeeGeneral Options for
more information.

You can export the animation to animatedGraphics Interchange Format (GIF) or to Audio Video
Interleave (AVI) format.

Related Topics

General Options: Desktop Performance
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Creating Geometry Animations
Creating Field Plot Animations
Controlling the AnimationsDisplay
Exporting Animations

Creating Geometry Animations

Geometry animationsmay be created to evaluate the effect of varying geometry variables on the
model. Youmust define at least one variable associated with the geometry prior to creating a
geometry animation. Following is the general procedure for creating an animation that varies a part
of themodel geometry:

1. Right-click in the view window, then clickView>Animate.
If multiple geometries can be varied in the design, theSelect Drawing dialog box appears,
proceed to step 2. If only one geometry is variable, proceed to step 3.
TheSetup Animation dialog box appears.

2. In theSelect Drawing dialog box:
a. Select the geometry variable to vary in the animation.
b. Select the object you want to animate.

Note If previous animations have been created for this project, theSelect Animation
dialog will appear. Youmay choose an animation setup from the list if one is
associated with the geometry variable of interest and the animation will start. If
no existing animation setup is acceptable, selectNew and continue at Step 3
below.

3. In theSetup Animation dialog box:
a. Type a name for the animation in theName text box or accept the default name.
b. Optionally, type a description of the animation in theDescription text box.
c. Under theSwept Variable tab, theSwept Variable list includes all of the defined

geometric project and design variables. Select the geometry variable that you want to
animate from theSwept Variable list.

d. Specify the values of the variable that you want to include in the animation:
4. Type the starting value of the variable in theStart text box.
5. Type the stopping value of the variable in theStop text box.
6. Type the number of Steps to include in the animation.

For example, if theStart value is 0.15in, theStop value is 0.45in, and the number of steps is
15, the animation will display the geometry at 15 values between 0.15 inches and 0.45 inches.
The animation will also include the start value, which will be the first frame displayed, resulting
in a total of 16 frames in the animation.
a. If the design hasmultiple project or intrinsic variables, click theDesign Point tab to set the

values of the non-animated variables.
4. Click theDesign Point tab.
5. Deselect theUse defaults check box.
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6. In the table, select the row corresponding to the variable setting of interest.
7. ClickOK.

The animation begins in the view window, displaying one frame for each variable value.
The play panel appears in the upper-left corner of the desktop, enabling you to stop, restart,
and control the speed and sequence of the frames.

Related Topics

Controlling the Animation's Display

Creating Field Plot Animations

To animate an existing field plot:
1. Right-click on the plot name in theProject Tree, and then selectAnimate.

TheSetup Animation dialog box appears.
Note If previous animations have been created for this project, theSelect Animation

dialog will appear. Youmay choose an animation setup from the list if one is
associated with the geometry variable of interest and the animation will start.
Otherwise selectNew and continue at Step 2 below.

2. Type a name for the animation in theName box, or accept the default name.
3. Optionally, type a description of the animation in theDescription box.
4. Under theSwept Variable tab, theSwept Variable list includes all of the defined project and

design variables. Select the variable that you want to animate from theSwept Variable pull-
down list.

5. TheSelect Values table lists all solved values for the variable selected inSwept Variable.
Select the values to include in the animation. By default, all solved valueswill be included.

6. (For Electric Transient Solver plots only)
a. Type the starting value of the variable in theStart box.
b. Type the stopping value of the variable in theStop box.
c. Type the number of steps to include in the animation in theSteps box.

For example, if theStart value is 0.15in, theStop value is 0.45in, and the step size is 15,
the animation displays the geometry at 15 values between 0.15 inches and 0.45 inches.
The animation also includes the start value, which is the first frame displayed, resulting in a
total of 16 frames in the animation.

7. If the design hasmultiple project or intrinsic variables, click theDesign Point tab to set the
values of the non-animated variables.
a. Deselect theUse defaults check box.
b. In the table, select the row corresponding to the variable setting of interest.
c. If intrinsic variables are available, select the value of interest in the Intrinsic variables

section of the dialog.
8. ClickOK.

The animation begins in the view window, displaying one frame for each variable value.
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The play panel appears in the upper-left corner of the desktop, enabling you to stop, restart,
and control the speed and sequence of the frames.

Related Topics

Controlling the Animation's Display

Controlling the Animation's Display

When an animation is displayed in the view window, theAnimationwindow, also called the play
panel, appears in the upper-left corner of the desktop. It has buttons that enable you to control the
speed and sequence of the frames, start and stop the animation and export the animation. Click an
area of the window below to learn its function.

Animation
slider

Each dot on the slider represents a frame in the animation. Drag the slider to the right
to display the next frame in the animated plot. Drag the slider to the left to display the
previous frame in the animation.
Plays the plot's animation sequence backwards.

Steps backward through the animated plot one frame at a time.
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Stops the animation.

Steps forward through the animated plot one frame at a time.

Plays the plot's animation sequence forwards.

Drag theSpeed slider to the top to increase the speed of the animation. Drag the
Speed slider to the bottom to decrease its speed.

Frame
information

The current frame and phase at which the plot is being displayed is listed below the
control buttons.

Enables you to export the animation to an animatedGraphics Interchange Format
(GIF) or to Audio Video Interleave (AVI) format.

Closes the animation window.

Show label
checkbox

If you select the Show checkbox, a label showing the swept variable value appears in
the animation. You can select the label with themouse and drag it to another
location.

Background
button.

Click the background button to open a color palette dialog that lets you set the
background for the swept variable label.
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The font button opens a font selection dialog that you can use to set the Font, Font
Style, and Size for the label. The Default is Arial Narrow 14pt.

Related Topics

Creating Animations

Exporting Animations

1. Create the animation you want to export.
2. In theAnimation play panel, clickExport.

TheExport File dialog box appears.
3. Follow the procedure for saving a new file. SelectAnimated GIF File (.gif) orAVI File (.avi)

as the file type.
TheAnimation Options dialog box appears.

4. To replace colors in the file with 256 shades of gray, selectGrayscale.
Grayscale animations use lessmemory than full color animations.

5. For AVI format export, specify theCompression factor (the default is 85) and one of the
followingCompression types:

INTEL Indeo
Cinepak
Microsoft Video 1
None

6. For GIF files, specify theNumber of loops.
7. ClickOK.

The animation is exported to the file format you specified.
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Creating Reports
After Maxwell has generated a solution, all of the results for that solution are available for analysis.
One of the ways you can analyze your solution data is to create a 2D or 3D report, or graphical
representation, that displays the relationship between a design’s values and the corresponding
analysis results. You create reports using either theCreate Quick Report command, or the
Create<type> Report commands. TheQuick Report feature lets you select from a list of
predefined categories (such as S-parameters) fromwhich to create a rectangular plot.
For each solution type (Electrostatic, Magnetostatic, AC Conduction(2D only), DC Conduction,
EddyCurrent, Transient, or Electric Transient(3D only), theResultsmenus present a list ofCreate
<type> Report commands based on the solution data of direct interest for the design. For example,
for theMagnetostatic solution type, theResultsmenu contains templates for Magnetostatic
parameters and for Fields.These appear on themenus asCreate Magnetostatic Report and
Create Fields Report. Each of theseCreate <type> Report menu items includes a further
cascadingmenu that lists the Display Types available for that report. For some reports you can
modify the Display Type from the Properties for that Report.
If you have created custom report templates (for example, including your company name or other
format changes), you can also create a report based on that template by selectingMaxwell 2D,
Maxwell 3D, or RMxprt>Results>Report Templates><templateName>. You can also access
previously defined templates usingReport2D>Report Templates>Apply Settings.
You can also use theReport2D>Export feature and select ReportData File (.rdat) format file which
you can then select forCreate Report from File.

Related Topics

Creating aQuick Report
Creating a New Report
Creating a Report from aReport Data File
Modifying Reports
Modifying the Background Properties of a Report
Creating CustomReport Templates
Selecting the Report Type
Selecting the Display Type
Selecting a Field Quantity to Plot
Working with Traces
Limit Lines in Cartesian Plots
Selecting a Function
Sweeping a Variable in a Report
Selecting a Parameter to Plot
Plotting Field Overlays
Using the Fields Calculator
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Plotting aQuantity versus Adaptive Pass
User DefinedOutputs
Exporting Reports

Creating a Quick Report

Following is the procedure for creating a quick report.
1. On the Project tree under "Analysis", select a setup or sweep icon, or theResults icon.
2. Right-click to display the shortcut menu and select Create Quick Report.

TheQuick Report dialog appears.

3. Select the one or more categories for the report from the list and clickOK. The list of
categories varies with the solution type.
A rectangular plot for each selected category displays. The new plot or plots appear in the
Project tree under the Results icon.

Related Topics

Creating Reports
Modifying Reports
Quick Report Categories
Creating Quick Reports in RMxprt

Quick Report Categories

When using theQuick Reports function for Solutions, the following report categoriesmay be
available depending upon the solution parameters requested, solution type, etc:

Category Description
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Coupling
Coeff

Reports values of the coupling coefficient.

Design Reports values of design variables.
Force Reports values of Force parameters such as ForceMagnitude and Components,

Load Force.
Torque Reports values of Torque parameters such as TorqueMagnitude and Components
L, Lnom Reports values of InductanceMatrix calculations.
MagFlux,
MagFluxNom

Reports values of magnetic flux calculations.

C Reports values of CapacitanceMatrix calculations.
R Reports values of ResistanceMatrix calculations.
Z Reports values of ImpedanceMatrix calculations.
Loss Reports values of Loss parameters such asCoreLoss, EddyCurrentLoss,

ExcessLoss, HysteresisLoss, SolidLoss, StrandedLoss, and StrandedLossR..
Misc
Solution

Reports values for the solution process such asDeltaT, Energy Error, and
Temporal Error

Position Reports Position of moving objects.
Speed Reports Speed of moving objects.
Winding Reports Flux Linkages, currents and voltages in coils.

Creating a New Report

Following is the general procedure for creating a new report:
1. On theMaxwell3D or Maxwell2Dmenu or the Project tree, point toResults, and then select

Create <type> Report and from the menu select the Display Type for that template.
The availableReport Types depend on the simulation setup.
If you have created custom report templates (for example, including your company name or
other format changes), you can also create a report based on that template by selecting
Maxwell 2D, Maxwell 3D, or RMxprt>Results>Report
Templates>PersonalLib><templateName>.
When you have selected the <type> and display type from theResultsmenu, theReport
dialog appears, with the Trace tab selected by default.

2. In theContext sectionmake selections from the following field or fields, depending on the
design and solution type.
a. Solution field with a drop down selection list. This lists the available setups and sweeps. As

aminimum, the LastAdaptive solution and AdaptivePass solution is available to choose.
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The AdaptivePass solution context can be selected to allow any value or parameter to be
plotted versus the adaptive pass. This function is usually used to evaluate the convergence of
the solution.

b. For Transient projects only. Domain field with a pull down selection list containing options
for plotting vs time (SweepDomain) or plotting vs frequency (Spectral Domain).

c. For Eddy projects only. Domain field with a pull down selection list containing options for
plotting vs frequency (Sweep Domain) or plotting vs time (TimeDomain).

d. Parameter field with a drop down selection list. Whether this field appears, and the
Parameters listed depend on the Solution type and the <type> selected.

e. Geometry field with a drop down selection list. For field reports, this applies the quantity to
a specific geometry.

3. In theY Component section of the dialogmake selections for the following:
a. Categories - depend on the Solution type and the design. For example, Magnetostatic

categories include: Torque, Output Variables, Inductance, and other user-selectable
solution parameters. Transient categories include: Loss, Output Variables, Variables, and
others. Eddy current categories include: Loss,Winding, End Connection, and others.

b. Quantities for Y are relative to the selected category. For example, Loss quantities include:
CoreLoss, EddyCurrentLoss, HysteresisLoss, and others. Winding quantities include:
Flux Linkage, Induced Voltage, and others - depending on the winding type.
Note TheQuantity text field can be used to filter the Quantity list by typing in text, or by

using the four predefined selections. This is useful if the Category selected
produces a lengthyQuantities list. See Filtering Quantity Selections for the
Reporter.
When thematrix is very large, the number of quantities can be correspondingly
huge. Therefore, the Quantities field can optionally use a tree structure to divide
matrix quantities into groups by their first element name. The initial display
shows groups, without initially listing groupmembers.

c. Function list to apply to the Y quantities.
d. The Y value field displays the currently specified Quantity and Function. You can edit this

field directly.
Note Color shows valid expression.

e. Range Function button -- opens theSet Range Function dialog. This applies currently
specified Quantity and Function.

4. In theX (Primary Sweep) section, make selections for the following:
a. Select the Primary sweep from the drop downmenu. By defaultAll of the chosen sweep’s

values are used. You can also select the browse [...] button to display a dialog box that lets
you select particular sweep values, specify a range of sweep values (for Time sweeps), or
Use all values (the default setting).
To select an X component that is different than the Primary Sweep, uncheck the Default
field to enable the X field and browse [...] button. Click the browse [...] button to display the
Select X Component dialog. This lets you specify the X component as you do the Y; that
is, in terms of Categories which define the selectable Quantities, and Functions to apply.
After making selections,OK the dialog to assign the X component.
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b. The Families tab provides a way to select from valid solutions for sweepswhere a
simulation hasmultiple variables defined (for example, for a parametric sweep). If so, the
variables other than the one chosen as the X (Primary sweep), are listed under the
Families tab with columns for the variable, the value, and an Edit columnwith an ellipsis
[...] button. See Using Families tab for Reports.

5. Update Report setting
l Real Time checked -- enable real time updates for all reports while the reports are being
edited.

l Real Time unchecked -- enables drop downmenu toUpdate All Reports orUpdate
Report. Reports will only be updated with one of these user selectable update options or
upon exiting the report dialog. This can be useful if you expect a trace to take time to display.
You can then add additional traceswithout having to wait.

6. TheReport dialog command buttons permit you create a new report with the settings you
provide, or to modify an existing report.
l Output Variables - opens the Output Variables dialog.
l Add Trace - this is enabled when you have created or selected a report. Add one or more
traces to include in the report.

l Update Trace - updates the selected traces in a report based on further processing or
changes.

l New Report. Adds a report to the Project tree under the Results icon. The new Report is
displayed in the Project window.

l Options - opens theReport Setup Options dialog. This contains a check box for using
the advancedmode for editing and viewing trace components. Thismode is automatic if the
trace requires it. It also contains a field for setting themaximumnumber of significant digits
to display for numerical quantities.

l Close - closes theReport dialog.
7. ClickNew Report to create a new report in the Project tree.

The report appears in the view window. It will be listed in the project tree under Reports.
Traceswithin the report also appear in the project tree. Some plotsmay take time to complete.
Performing a File>Save in such cases after the plot has been created will permit you to
review the plot later without having to repeat the calculation time when you reopen the project
later.

8. To speed redraw times for changed plots, perform aSave. This saves the data that comprises
expressions. If you do not do a save of a changed plot, the changed version is not stored.

Note Remember the evaluated value of an expression is always interpreted as in SI units.
However, when a quantity is plotted in a report, you have the option to plot values in units
other than SI. For example, the expression "1+ang_deg(S11)" represents an
‘angle'’quantity evaluated in radians, though plotted in degree units. To represent an angle
quantity in degrees, you would specify units as "1 deg + ang_deg(S11)".

Related Topics

Creating Reports
Modifying Reports

Post Processing andGenerating Reports 23-23
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Creating aQuick Report
Using Families tab for Reports
Plotting aQuantity versus Adaptive Pass

Using Families Tab for Reports

The Families tab of the Report dialog provides a way to select from valid solutions for sweepswhere
a simulation hasmultiple variables defined and solutions exist for multiple variable values (for
example, for a parametric sweep). If no variables are defined, or none have solutions for different
values, 0 families will be available. If so, the variables other than the one chosen as the X (Primary
sweep), are listed under the Families tab with columns for the variable, the solution value (which
may be All, Nominal, or a Specific value), and an Edit columnwith an ellipsis [...] button. Families
gives the number available. If an existing variable is specified asNominal, only that value is currently
available. You can set any solved variables asNominal, All, or select from values provided for
Available solutions.

When you select a variable with multiple solved values, a trace for each solved value appears in the
Report, with the variable value appended to the trace name in the Report legend.

You canmake selections for the following.:
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1. Select theSweeps radio button (the default) to list the swept variables you can select.
2. With theSweeps radio button selected, click the ellipsis [...] button to display a list of variable

values for a particular variable. You can use a scroll bar to navigate the list.
l To select all values, click the check box forUse all values. This writes “All” in the value field
for that variable. You can also select individual values by clicking on them.

l To select a range of values, hold down the shift key, and click again.
l To select intermittent additional values, hold the CTRL key and click additional. The values
you select are highlighted in the list, and are also listed in the Values column for that
variable.

l To select all, use theSelect All button. This highlights the complete list, as well as listing all
values for the variable in the Value field.

l To clear the selections, use theClear All button.
3. To edit the available list, click the ellipsis [...] button to display the Edit Sweep dialog. For the

selected variable, this lets you specify:
l a single value as value and units
l a linear step with start value, stop value, and step value, and units for each.
l a linear count, with start value, stop value with units, and a count.
l a decade count
l an octave count
l an exponential count.
Once you have specified the changes you want, you can add you change to the list by clicking
Add>> or replace the current list by clickingUpdate>>.

4. ClickOK to close theEdit Sweep dialog. Youmust still select the Edited radio button to be
able to select the from the edited list, rather than the Default selection. And youmust make
selections here tomove the new values to the variable value list in the Families tab.
.Select theAvailable variations radio button to list the choices that derive from variable
combination.
a. To select individual variations, check the select box.
b. Click theSelect button at the top of the column to check or clear all variations at once.
c. To invert the list order, click the triangle beside the variable name.
The Families Display tab has three radio button selections.
a. All Families
b. Statisticswhich lists a table statistical functions that you can select to apply to the plot.

The functions includeMin, Max, Avg, Mean, Variance, Std Dev, and Sum. You can use
the Select check boxes or the Select All and Clear All button.
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c. Histogramwhich lets you select the number of bins to use for a histogram plot, and the
sampling frequency to use.

Related Topics

Creating Reports
Modifying Reports
Modifying the Background Properties of a Report
Modifying the Legend in a Report
Creating CustomReport Templates
Working with Traces
Editing the Display Properties of Traces
Discarding Report Values Below a Specified Threshold
Adding Trace Characteristics
Adding DataMarkers to Traces

Filtering Quantity Selections for the Reporter

When a two port quantity Category is selected, four predefined filters are added to the combo box.
“Port1” is the first matrix element name found in the quantity list.
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l Only Self Terms -- Only display quantities when the first and second port are same.
l OnlyMutual Terms -- Only display quantities when the first and second port are different.
l (*,Port1) -- Only display quantities when the second element name is “Port1”. You can edit the
element name to display quantities for other elements.

l (Port1,*) – Only display quantities when the first element name is “Port1”. You can edit the
element name to display quantities for other element.

Creating a Report from a Report Data File

Using the Report Data File format, .rdat, a report can be saved (exported) from one design, and
subsequently imported into a different design (or even imported into the same design). This allows
you to take a static snapshot of a set of simulation data and view it at a later stage of the design
process, or view the same data set in one or more different designs.

To save a report to a Report Data File:
1. Create the report that you wish to save.
2. Right-click in the report window (or right-click on the desired report icon in the project tree) and

selectExport to open theExport Report dialog.
3. Select the Report Data files option (.rdat) in theSave as type selection drop down.
4. Navigate to the desired location and either create a file name or select an existing file for the

exported report; and then clickSave.

To create a report from an existing Report Data File:
1. Right-click on theResults folder in the project tree and selectCreate Report From File.
2. Browse to select the desired Report Data file (.rdat), and then clickOpen.
3. The selected report is added to the design and opens in a new report window.

Modifying Reports

Tomodify the data that is plotted in a report:
1. In the project tree, click the report you want to modify.
2. Right-clickModify Report.

TheReport dialog appears.
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3. TheReport dialog command buttons permit you create a new report with the settings you
provide, or to modify an existing report.
l Output Variables - opens the Output Variables dialog.
l Add Trace - this is enabled when you have created or selected a report. Add one or more
traces to include in the report.

l Update Trace - updates the selected traces in a report based on further processing or
changes.

l New Report. Adds a report to the Project tree under the Results icon. The new Report is
displayed in themain window.

l Options - opens theReport Setup Options dialog. This contains a check box for using
the advancedmode for editing and viewing trace components. Thismode is automatic if the
trace requires it. It also contains a field for setting themaximumnumber of significant digits
to display for numerical quantities.

l Close - closes theReport dialog.
The updated report appears in the view window.

4. Update Report setting
l Real Time checked -- enable real time updates for all reports while the reports are being
edited.

l Real Time unchecked -- enables drop downmenu toUpdate All Reports orUpdate
Report. Reports will only be updated with one of these user selectable update options or
upon exiting the report dialog. This can be useful if you expect a trace to take time to display.
You can then add additional traceswithout having to wait.

5. In theContext section youmake selections depending on the design and solution type.
a. Solution field with a drop down selection list. This lists the available setups and sweeps. As

aminimum, the LastAdaptive solution and AdaptivePass solution is available to choose.

The AdaptivePass solution context can be selected to allow any value or parameter to be
plotted versus the adaptive pass. This function is usually used to evaluate the convergence of
the solution.

b. For Transient projects only. Domain field with a pull down selection list containing options
for plotting vs time (SweepDomain) or plotting vs frequency (Spectral Domain).

c. For Eddy projects only. Domain field with a pull down selection list containing options for
plotting vs frequency (Sweep Domain) or plotting vs time (TimeDomain).

d. Parameter field with a drop down selection list. Whether this field appears, and the
Parameters listed depend on the Solution type and the <type> selected.

e. Geometry field with a drop down selection list. For field reports, this applies the quantity to
a specific geometry.

6. The Families tab provides a way to select from valid solutions for sweepswhere a simulation
hasmultiple variables defined (for example, for a parametric sweep). If so, the variables other
than the one chosen as the X (Primary sweep), are listed under the Families tab with
columns for the variable, the value, and an Edit columnwith an ellipsis [...] button. See Using
Families tab for Reports.

7. In theY Component section of the dialogmake selections for the following:
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a. Categories - those depend on the Solution type and the design. For example,
Magnetostatic categories include: Torque, Output Variables, Inductance, and other user-
selectable solution parameters. Transient categories include: Loss, Output Variables,
Variables, and others.

b. Quantities for Y are relative to the selected category. For example, Loss quantities include:
CoreLoss, EddyCurrentLoss, HysteresisLoss, and others.
Note TheQuantity text field can be used to filter the Quantity list by typing in text, or by

using the four predefined selections. This is useful if the Category selected
produces a lengthyQuantities list. See Filtering Quantity Selections for the
Reporter.
When thematrix is very large, the number of quantities can be correspondingly
huge. Therefore, the Quantities field can optionally use a tree structure to divide
matrix quantities into groups by their first element name. The initial display
shows groups, without initially listing groupmembers.

c. Function list to apply to the Y quantities.
d. Value field displays the currently specified Quantity and Function. You can edit this field

directly.
Note Color shows valid

expression.

e. Range Function button -- opens theSet Range Function dialog. This applies currently
specified Quantity and Function.

8. In theX (Primary Sweep) section, make selections for the following:
a. Select the Primary sweep from the drop downmenu. By defaultAll of the chosen sweep’s

values are used. You can also select the browse [...] button to display a dialog box that lets
you select particular sweep values, specify a range of sweep values (for Time sweeps), or
Use all values (the default setting).
With Use all values unchecked, you can select one or more by clicking an individual value,
dragging to select multiple values, or using Alt-Click to specify specific values.
You select either the Sweep radio button for Default or Edited selection.
You can also select the browse [...] button here to display the Edit Sweep dialog for Modify
Reports, which includes additional editing features.
To select an X component that is different than the Primary Sweep, uncheck the Default
field to enable the X field and browse [...] button. Click the browse [...] button to display the
Select X Component dialog. This lets you specify the X component as you do the Y; that
is, in terms of Categories which define the selectable Quantities, and Functions to apply.
After making selections,OK the dialog to assign the X component.

b. The Families tab provides a way to select from valid solutions for sweepswhere a
simulation hasmultiple variables defined (for example, for a parametric sweep). If so, the
variables other than the one chosen as the X (Primary sweep), are listed under the
Families tab with columns for the variable, the value, and an Edit columnwith an ellipsis
[...] button. See Using Families tab for Reports.

You can also view and edit the properties of Reports and their traces via their Properties
windows. SeeModifying the Background Properties of a Report.
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You can alsomodify the display type of an existing plot from the Properties dialog for that plot. Select
the Report icon in theProject tree to display theProperties dialog. Selecting the Display Type field
displays amenuwith selections available for that plot. Once youmake a selection, the plot display
updates for the current selection.

Note Remember that for many excitations of interest for plotting, you can control the default
base names through the dialog described here: Setting Default Boundary/Excitation Base
Names.
Thismay save you the need to edit individual names in the plots.

Related Topics

Modifying the Background Properties of a Report
Modifying the Legend in a Report
Creating CustomReport Templates
Working with Traces
Editing the Display Properties of Traces
Setting Default Boundary/Excitation Base Names
Discarding Report Values Below a Specified Threshold
Adding Trace Characteristics
Adding DataMarkers to Traces

Modify Report: Using the Edit Sweep Dialog

Clicking the browse [...] button at the lower right corner of the Use all values pane opens the Edit
Sweep dialog for Modify Report. The lets you edit the current Primary sweep variable values,
including radio button selections for Single value, Linear step or count, and Decade, Octave, or
Exponential Counts.
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You can specify start, stop and step values and units, and add specific values to the list of current
sweep values. TheAdd>> andUpdate>> buttons let you edit the value list.
You can use themouse click, drag, and Alt-Click to select values. You can also edit individual values.

Related Topics

Creating Reports
Modifying Reports

Zooming and Fitting Reports

The standard Zoom and Fit commands operate on reports. After clicking in an open report, you can
also use amouse wheel, to zoom in and out.

Related Topics

Modifying the Background Properties of a Report
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Modifying the Background Properties of a Report

Tomodify the appearance of a report, or the display properties an object in a report:
1. Open the report you want to modify.
2. Youmust select an editable object in the report to be able to edit its properties. Click on an

object to select it and to view its Properties in the docked properties window. To open a
floating Properties window, either double click on the selected object, or click
Edit>Properties on the toolbar.
The Properties tabs and options displayed for editable plot objects varies depending on the
report type (for example, whether 2D rectangular, Stacked, or 3D), and can include the
following:
l Cartesian -- this lets you edit the scrollbar and thumb properties for 2D rectangular plots.
l Header -- this lets you edit the Properties for the text displayed at the top of the report,
including the Title font, CompanyName, Show Design Name, Subtitle Font. The plot title is
tied to the report's name and is not a Header property. If you change the report name in the
Project tree, plot title synchronizes. The CompanyName and the Show Design Name
check box are grouped in the Properties dialog as Subtitle. Edits to the Subtitle Font
Property affects both of them.

l General -- this dialog (or General tab for other Report properties windows) lets you edit the
background color (the perimeter around the trace display) for the plot, the contrast color
(the trace display background), the Field width, the Precision, and whether to use scientific
notation for marker and delta marker displays. (X and Y notation display is set separately, in
the Axis property tabs.)

l Legend -- this lets you edit the Properties for whether to Show Trace Name, Solution
Name, and Variation Key. At least one of these threemust be selected. You can also edit
the Font, the background color of the Legend box, the Border Color, the Border Width, Grid
Color (for the lines between Trace descriptions), and theGrid line width. Also seeModifying
the Legend in a Report

l Color Key -- for 3D plots, to control the appearance of the color key (colors, transparency,
border appearance, fonts, number format, field withdth and precision.

l Contour -- for 3D plots, to control the appearance of the color map, includingmap type,
ramp color, spectrum, IsoValType, levels, number of contours, and values shown.

l Stacked -- for stacked plots, properties for X scrollbar, thumb properties, and stack layout,
auto fit, and stack height.

l Traces -- you can select traces either in the Legend or on the plot. The properties for traces
include: Color, Line Style, LineWidth, Trace Type, whether to Show a symbol, Symbol
Frequency, Symbol style, whether to Fill symbol, symbol color, and whether to Show
arrows. See Editing the Display Properties of Traces.

l X, Y, or ZAxis-- the defaults for most of these values are set in theReport 2D Options
Axis tab.
l Display name -- check box for whether to display the axis name.
l Specify name -- check box for specifying the Axis name.
l Name -- this describes the axis to which the following properties/options refer. These are
selected in the Report dialog.
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l Axis Color -- set the color by double clicking to display the Set color dialog. Select a
default or custom color and clickOK.

l Axis Font -- click the cell to display the Edit Text Font dialog. The dialog lets you select
from a list of available fonts, styles, sizes, effects, colors, and script. The dialog also
contains a preview field. OK the selections to apply the font edits and to close the dialog.

l Show Units -- this specifies whether to display units.
l Window (section)
l Window Mode-- can be Axis range, Continuousmoving window, or Stepmoving
window.

l WindowWidth (in) -- provide an integer value for the previous selection.
l Manual Format (section)
l Number format -- select from the drop downmenu, Auto, Decimal, or Scientific
notation.

l FieldWidth -- enter a real value.
l Field Precision -- enter a real value.

l X, Y, or Z ScalingTab -- These properties provide control over scaling.
l Axis Scaling -- use the drop downmenu to select scaling as Linear or Log. For the Y axis,
all zero or negative values are discarded before log scaling is applied.

l SpecifyMin -- check box
l Min -- text entry in same units as axis units. Saved as SI internally.
l SpecifyMax -- check box
l Max -- text entry in same units as axis units. Saved as SI internally.
l Specify Spacing -- check box
l Spacing -- text entry in same units as axis units. Saved as SI internally
l Manual Units (section)
l Auto Units -- use the check box compute the correct units for the axis.
l Units -- click on the cell to select from amenu of available units if you have not checked
Auto Units.

l Infinity Visualization (section)
l Map InfinityMode -- check box.

Each axis now can be set to treat infinity values in a user defined way.When you check the
Map InfinityMode, any infinity values in the input data get the infinityMap value (negative
infinity get the value*-1 and positive infinity the positive value specified). This can be useful if
there are zeros, or very small values that can be treated as zero, in the data, for example, dB
Gain.
l Map Infinity To -- enter a real value for theMap InfinityMode.

l Grid -- properties for grid labels and grid style, appearance, line styles, color, major and
minor lines, and scaling. For the 3D rectangular plots, there are separate tabs for the XY,
YZ and ZX axes.

3. Edit the properties, and clickOK to apply the changes.
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Related Topics

Modifying Reports
Working with Traces
Discarding Report Values Below a Specified Threshold
Modifying the Legend in a Report
Editing the Display Properties of Traces
Creating CustomReport Templates
Setting Report2D options

Modifying the Legend in a Report

The legend in a report is a list of the curves being plotted. For each curve, the legend gives the name,
shows the line color, and lists the setup and the adaptive pass used to generate the curve.
To show or hide a legend in a report:

1. Make the report the active view.
2. UseView>Active View Visibility or theShow/Hide icons on the toolbar to display or hide

the report.
Either command displays the Active View dialog.

3. Select the Legends tab.
This lists the legend (or legends) in the report.

4. Check the visibility check box, andOK the dialog to close it and apply the change.
To edit the display properties of a legend:

1. Select the legend in a report by clicking on the Curve Info panel to display a docked properties
window, or right-click on the legend and selectEdit>Properties to display the floating
properties window.
This lets you edit the Properties for whether to Show Trace Name, Solution Name, and
Variation Key. At least one of these threemust be selected.
You can also edit the Font by clicking the Font cell to display theEdit Text Font dialog. The
dialog lets you select from a list of available fonts, styles, sizes, effects, colors, and script. The
dialog also contains a preview field. OK the selections to apply the font edits and to close the
dialog
You can also edit the background color of the Legend box, the Border Color, the Border
Width, Grid Color (for the lines between Trace descriptions), and theGrid line width.

2. ClickOK to close the Properties window and apply the selections.
To change the display name for traces, see Editing Trace Properties.
Tomove a legend in a report:

1. Click and hold on the legend.
The cursor changes to crossed lineswith arrow tips.
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2. Still holding, drag the legend to a new location and release.
The legend is released and the crossed lines change back to amouse pointer.

To resize a legend in a report:
1. Position themouse tip over the edge you want to resize.

Themouse pointer changes to a horizontal or vertical line with arrow tips.
2. Click and drag the horizontal or vertical edge to the desire size.
3. Release.

Related Topics

Editing Trace Properties
ShowingObjects
Hiding Objects fromView
Modifying Reports
Creating CustomReport Templates
Discarding Report Values Below a Specified Threshold
Setting Report2D options
Editing the Display Properties of Traces

Creating Custom Report Templates

You can edit properties from any report type and save it as a template. This can save repeated
editing of properties (for example, the company name, or color schemes) when you create other
reports. Once you create templates, you can access them from theResults>Report Templates>
menu and the 2D Reports> Report Templates>Apply Settingsmenu.
SeeModifying the Background Properties of a Report for a discussion of format changes you can
make to any report.
To save an edited report as a template:

1. In the Project Tree, right-click on the report name of interest to display the shortcut menu and
clickReport Templates>Save. You can also clickReport2D>Report templates>Save.
This displays theReport Save As Report Template file browser. By default, the directory is
your AnsysEM\<productName>\userlib\ReportTemplates directory. You can also save to the
SysLib directory.

2. Typically, you accept the directory.
3. Youmust provide a file name, which will be given an .rpt extension.

It is good practice to give the template a descriptive name, showing both the kind of format you
begin with (such as XY Plot or 3D Plot) and apt description of the distinguishing edits (such as
for company name, or color scheme). Once saved, this namewill appear on thePersonalLib
menu.
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4. TheSave As Type field currently supports the Ansoft Report Format (.rpt) format.
5. ClickSave to save the template to the PersonalLib menu.

All .rpt templates in the directory appear on theResults>Report Templates>PersonalLibmenu.
Selecting a report from the PersonalLib menu opens a report that you can thenModify to add traces
or perform other edits. Templates in the SysLib directory appear on theReport Templatesmenu.

Related Topics

Modifying Reports
Setting Report2D options
Modifying the Background Properties of a Report
Modifying the Legend in a Report
Working with Traces
Editing the Display Properties of Traces
Discarding Report Values Below a Specified Threshold

Selecting the Report Type

TheReport Types available for creating a report depends on the simulation setup. Depending on
the design setup, you canmake a selection from the following report types.
Select from the following report types:

Magnetostatic Project variables, user specified Output Variables and Design data are available
to plot. Depending upon the solution parameters requested, torque datamay be
available to plot, as well as Inductance, andmagnetic flux. Quantities such as
Lnom, andMagFluxNommay also be available for plotting. See Post processed
Quantities for more details.

Electrostatic Project variables, user specified Output Variables and Design data are available
to plot. Depending upon the solution parameters requested, torque datamay be
available to plot, as well as Capacitance.

Eddy Current Project variables, user specified Output Variables and Design data are available
to plot. Depending upon the solution parameters requested, torque datamay be
available to plot, as well as Inductance, Resistance, Impedance. Quantities such
as Lnom, MagFlux, and variousWinding, Loss, and End Connection quantities
may also be available for plotting, depending on the design. See Post processed
Quantities for more details.

DC
Conduction

Project variables, Output Variables, and Design data are available for plotting, as
well as Resistancematrix data.

AC
Conduction
(2D Only)

Project variables, Output Variables, and Design data are available for plotting, as
well as Torque,Winding, Loss, and solution process data.
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Transient Project variables, Output Variables, and Design data are available for plotting, as
well as Force, Torque, Loss, and solution process data.

Electric
Transient
(3D Only)

Project variables, Output Variables, and Design data are available for plotting, as
well as Force, Torque, Loss, and solution process data.

Fields Project variables, Output Variables, and Design data are available for plotting, as
well as calculator expressions.

Selecting the Display Type

The information in a report can be displayed in several formats. Select from the followingDisplay
Type formats in theCreate Report dialog box:

Rectangular
Plot

A 2D rectangular (x-y) graph.

Rectangular
Stacked Plot

A series of 2D rectangular (x-y) graphs stacked vertically, sharing a common x-
axis scale, but with each trace having its own y-axis scale.

Data Table A spreadsheet with rows and columns that displays, in numeric form, selected
quantities against a swept variable or another quantity.

3D
Rectangular
Plot

A 3D rectangular (x-y-z) graph.

Rectangular
Contour Plot

A rectangular (x-y-z) graph. Contour plots are useful to visualize surfaces (for
e.g. Directivity as a function of phi/theta).

You can alsomodify the display type of an existing plot from thePropertieswindow for that plot.
Select the Report icon in the Project tree to display the Properties window. Selecting theDisplay
Type field displays amenuwith selections available for that plot.
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Once youmake a selection, the plot display updates for the current selection.

Creating 2D Rectangular Plots

A rectangular plot is a 2D, x-y graph of results.
1. On theResultsmenu (Maxwell menu or right-click onResults on the Project tree), click

Create <type> Report, and selectRectangular Plot.
The Report dialog appears.

2. In theContext sectionmake selections from the following field or fields, depending on the
design and solution type.
a. Solution field with a drop down selection list. This lists the available solutions, whether

sweeps or adaptive passes.
b. For Transient projects only. Domain field with a pull down selection list containing options

for plotting vs time (SweepDomain) or plotting vs frequency (Spectral Domain).
c. Parameter field with a drop down selection list. Whether this field appears, and the

Parameters listed depend on the Solution type and the <type> selected.
d. Geometry field with a drop down selection list. For field reports, this applies the quantity to

a geometry.
3. Under the Trace tab, Y component section, specify the information to plot along the y-axis:

a. In theCategory list, click the type of information to plot.
b. In theQuantity list, click the value to plot.
c. In the Function list, click themathematical function of the quantity to plot.
d. Value field displays the currently specified Quantity and Function. You can edit this field

directly.
Note Color shows valid

expression.

e. Range Function button -- opens theSet Range Function dialog. This applies currently
specified Quantity and Function.

4. On the Trace tab, X (Primary sweep) line, specify the quantity to plot along the x-axis in one of
the following ways:.
l Select the sweep variable to use from the drop down list.
l If sweeps are available, you can select the browse [...] button to display a dialog box that
lets you select particular sweep values, specify a range of sweep values (for Time sweeps),
orUse all values (the default setting). The quantity will be plotted against the primary
sweep variable listed.

5. On the Families tab, confirm or modify the sweep variables that will be plotted.
6. ClickNew Report.

This creates a new report in Project tree, displays the report with the defined trace, and
enables theAdd Trace button on theReport dialog.
The function of the selected quantity will be plotted against the swept variable values or
quantities you specified on an x-y graph. The plot is listed underResults in the project tree
and the traces are listed under the plot. When you select the traces or plots, their properties
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are displayed in the Properties window. These properties can be edited directly to modify the
plot.

7. Optionally, add another trace to the plot by following the procedure above, usingAdd Trace
rather than New Report.

You can alsomodify the display type of an existing plot from the Properties dialog for that plot. Select
the Report icon in the Project tree to display the Properties dialog. Selecting the Display Type field
displays amenuwith selections available for that plot.

Once youmake a selection, the plot display updates for the current selection.

Related Topics

Sweeping a Variable
Working with Traces
Adding Trace Characteristics
Delta Markers in 2DPlots
Modifying Background Properties of a Report
Discarding Report Values Below a Specified Threshold
Setting Report2D options
Plotting aQuantity versus Adaptive Pass

Creating a 2D Rectangular Stacked Plot

A rectangular stacked plot is a 2D, x-y graph of results, with each trace displayed on a separate plot.
1. On theResultsmenu (Maxwell menu or right-click onResults on the Project tree), click

Create <type> Report, and selectRectangular Stacked Plot.
The Report dialog appears.

2. In theContext sectionmake selections from the following field or fields, depending on the
design and solution type.
a. Solution field with a drop down selection list. This lists the available solutions, whether

sweeps or adaptive passes.
b. For Transient projects only. Domain field with a pull down selection list containing options

for plotting vs time (SweepDomain) or plotting vs frequency (Spectral Domain).
c. Parameter field with a drop down selection list. Whether this field appears, and the

Parameters listed depend on the Solution type and the <type> selected.
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d. Geometry field with a drop down selection list. For field reports, this applies the quantity to
a geometry.

3. Under the Trace tab, Y component section, specify the information to plot along the y-axis:
a. In theCategory list, click the type of information to plot.
b. In theQuantity list, click the value to plot.
c. In the Function list, click themathematical function of the quantity to plot.
d. Value field displays the currently specified Quantity and Function. You can edit this field

directly.
Note Color shows valid

expression.

e. Range Function button -- opens theSet Range Function dialog. This applies currently
specified Quantity and Function.

4. On the Trace tab, X (Primary sweep) line, specify the quantity to plot along the x-axis in one of
the following ways:.
l Select the sweep variable to use from the drop down list.
l If sweeps are available, you can also select the browse [...] button to display a dialog box
that lets you select particular sweep values, specify a range of sweep values (for Time
sweeps), orUse all values (the default setting). The quantity will be plotted against the
primary sweep variable listed.

5. On the Families tab, confirm or modify the sweep variables that will be plotted.
6. ClickNew Report.

This creates a new report in Project tree, displays the report with the defined trace, and
enables theAdd Trace button on theReport dialog.
The function of the selected quantity will be plotted against the swept variable values or
quantities you specified on an x-y graph. The plot is listed underResults in the project tree
and the traces are listed under the plot. When you select the traces or plots, their properties
are displayed in the Properties window. These properties can be edited directly to modify the
plot.

7. Optionally, add another trace to the plot by following the procedure above, usingAdd Trace
rather than New Report.
The new trace will appear as a separate plot “stacked” above the first plot. The stacked plots
share a common x-axis scale. However, each plot has its own independent y-axis scale.

You can alsomodify the display type of an existing plot from the Properties window for that plot.
Select the Report icon in the Project tree to display the Properties window. Selecting the Display
Type field displays amenuwith selections available for that plot.
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Once youmake a selection, the plot display updates for the current selection.

Related Topics

Sweeping a Variable
Working with Traces
Delta Markers in 2DPlots
Modifying Background Properties of a Report
Plotting aQuantity versus Adaptive Pass
Adding DataMarkers to Traces

Creating 3D Rectangular Plots

Below is an example of a 3D rectangular plot.

Interacting with a 3D Rectangular Plot

You can Rotate, Zoom and Pan a plot. When you rotate, the Cartesian grid responds so that the
curve always remains in front and the grids behind.
Clicking on a plot entity selects it, highlighting the selected entity in bold.
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Double-clicking anywhere in the plot brings up the Properties dialog. the properties are grouped
appropriately under various tabs, which correspond to plot entities:

l General: For general plot properties such as background color etc
l Header: Properties related to plot Header/Title
l Axis [X|Y|Z]: Properties related to the 3 axes
l Grid [XY|YZ|ZX]: Properties related to the 3 grids
l ColorKey: Properties related to ColorKey
l Contour: Properties related to contouring of all curves/surfaces
l Surface: Properties related to the curve

Selecting a property also displays it properties in the Property window. You can edit the properties to
customize the appearance of the plot.

Creating a 3D Rectangular Plot

1. On theResultsmenu (Maxwell menu or right-click onResults on the Project tree), click
Create <type> Report, and select 3D Rectangular plot from the report typemenu.
TheReport dialog appears.

2. In theContext sectionmake selections from the following field or fields, depending on the
design and solution type.
a. Solution field with a drop down selection list. This lists the available solutions, whether

sweeps or adaptive passes.
b. Geometry field with a drop down selection list. For field and radiated field reports, this

applies the quantity to a geometry or radiated field setup.
3. Under the Trace tab, ZComponent area, specify the information to plot along the z-axis:

a. In theCategory list, click the type of information to plot.
b. In theQuantity list, click the value to plot.
c. In the Function list, click themathematical function of the quantity to plot.
d. TheValue field displays the currently specified Quantity and Function. You can edit this

field directly.
Note Color shows valid

expression.

e. Range Function button -- opens theSet Range Function dialog. This applies currently
specified Quantity and Function.

4. On the Trace tab, Y (Secondary Sweep) lines, specify the information to plot along the y-axis
in one of the following ways:
l Select the sweep variable to use from the Secondary Sweep drop down list.
l If sweeps are available, you can also select the browse [...] button to display a dialog box
that lets you select particular sweep values, specify a range of sweep values (for Time
sweeps), orUse all values (the default setting). The quantity will be plotted against the
primary sweep variable listed.
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5. On the Trace tab, X (Primary Sweep) lines, specify the information to plot along the x-axis in
one of the following ways:
l Select the sweep variable to use from the Primary Sweep drop down list.
l If sweeps are available, you can also select the browse [...] button to display a dialog box
that lets you select particular sweep values, specify a range of sweep values (for Time
sweeps), orUse all values (the default setting). The quantity will be plotted against the
primary sweep variable listed.

6. On the Families tab, confirm or modify the sweep variables that will be plotted.
7. ClickNew Report.

This creates a new report in Project tree, displays the report with the defined trace, and
enables theAdd Trace button on theReport dialog.
The function of the selected quantity or quantities will be plotted against the values you
specified on an x-y-z graph. The plot is listed underResults in the project tree.When you
select the traces or plots, axis or grid labels, plot header, color key, or variable labels, their
properties are displayed in the Properties window. The properties for each plot element can
be edited directly to modify the plot content and appearance. SeeModifying the Background
Properties of a Report.

8. Optionally, add another trace to the plot by following the procedure above, usingAdd Trace
rather than New Report.

Related Topics

Sweeping a Variable
Working with Traces
Adding Trace Characteristics

Plotting a Quantity Versus Adaptive Pass

Any quantity that can be plotted in the reporter may be plotted versus the adaptive solution pass,
primarily to evaluate the convergence of the quantity versus themesh.

1. On theResultsmenu (Maxwell menu or right-click onResults on the Project tree), click
Create <type> Report, and select 3D Rectangular plot from the report typemenu.
TheReport dialog appears.

2. In theContext section, select theAdaptivePass context for the Setup of interest. The Trace
tabX value drop down list will contain an option to plot againstPass.

3. Under the Trace tab, Y component section, specify the information to plot along the y-axis:
a. In theCategory list, click the type of information to plot.
b. In theQuantity list, click the value to plot.
c. In the Function list, click themathematical function of the quantity to plot.
d. Value field displays the currently specified Quantity and Function. You can edit this field

directly.
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Note Color shows valid
expression.

e. Range Function button -- opens theSet Range Function dialog. This applies currently
specified Quantity and Function.

4. On the Families tab, confirm or modify the sweep variables that will be plotted.
5. ClickNew Report.

This creates a new report in Project tree, displays the report with the defined trace, and
enables theAdd Trace button on theReport dialog.
The function of the selected quantity will be plotted against the swept variable values or
quantities you specified on an x-y graph. The plot is listed underResults in the project tree
and the traces are listed under the plot. When you select the traces or plots, their properties
are displayed in the Properties window. These properties can be edited directly to modify the
plot.

6. Optionally, add another trace to the plot by following the procedure above, usingAdd Trace
rather than New Report.

Related Topics

Sweeping a Variable
Working with Traces
Adding Trace Characteristics

Creating Data Tables

A data table is a grid with rows and columns that displays, in numeric form, selected quantities
against a swept variable or other quantities.

1. On theMaxwell3D or Maxwell2Dmenu, point toResults, and then clickCreate <type>
Report, or right click on the Results icon in the Project tree and click Create <type>
Report.

2. In the display typemenu, clickData Table.
TheReport dialog box appears.

3. In theContext sectionmake selections from the following field or fields, depending on the
design and solution type.
a. Solution field with a drop down selection list. This lists the available solutions, whether

sweeps or adaptive passes.
b. Domain field with a drop down selection list. Whether this field appears, and the

domains listed depend on the Solution type and the <type> selected.
c. Geometry field with a drop down selection list. For field reports, this applies the quantity

to a geometry.
4. Under the Trace tab, Y component section, select the quantity you are interested in and its

associated function:
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a. On theCategory drop down list, click the type of information to plot.
b. On theQuantity list, click the values to plot. Use CTRL-click tomakemultiple selections.
c. In the Function list, click themathematical function to apply to the quantity for the plot.
d. TheValue field displays the currently specified Quantity and Function. You can edit this

field directly.
Note Color shows valid

expression.

e. Range Function button -- opens theSet Range Function dialog. This applies currently
specified Quantity and Function.

5. On the Trace tab, X (Primary Sweep) line, select the sweep variable from the drop down
list. By defaultAll of the chosen sweep’s values are used. You can also select the browse [...]
button to display a dialog box that lets you select particular sweep values, specify a range of
sweep values (for Time sweeps), orUse all values (the default setting).

6. On the Families tab, confirm or modify the sweep variables that will be plotted.
7. ClickNew Report.

This creates a new report in Project tree, displays the report with the defined trace, and
enables theAdd Trace button on theReport dialog.
The Y quantity will be listed at each variable value or additional quantity value you specified.
The data table is listed underResults in the project tree. The plot is listed underResults in
the project tree and the traces are listed under the plot. When you select the traces or plots,
their properties are displayed in the Properties window. These properties can be edited
directly to modify the plot.

8. Optionally, add another trace to the plot by following the procedure above, usingAdd Trace
rather than New Report.

You can alsomodify the display type of an existing plot from the Properties dialog for that plot. Select
the Report icon in the Project tree to display the Properties dialog. Selecting the Display Type field
displays amenuwith selections available for that plot.

Once youmake a selection, the plot display updates for the current selection.
If you choose to print a data table:

l Selecting print "All" prints the whole table for current data page (if there ismore than one data
page).

l Selecting print "Pages" prints user-specified pages.
l If the table is bigger than the screen view (that is, it has a scroll bar), printing first scrolls right,
prints until nomore scrolling occurs, and then scrolls down.
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l The Page number appears at the bottom of the page, aligned at center.
l The table layout of each page follows the screen, but without the scroll bar being printed, and
no data page bar as on screen.

Related Topics

Sweeping a Variable
Working with Traces
Adding Trace Characteristics

Creating Rectangular Contour Plots

This is an x-y-z graph of results. Any data that you can current plot in 3D (as 3D cartesian or 3D
polar) is a candidate for a contour plot.

1. On theResultsmenu (HFSSmenu or right-click onResults on the Project tree), clickCreate
<type> Report, and selectRectangular Contour plot from the report typemenu.
TheReport dialog appears.

2. In theContext sectionmake selections from the following field or fields, depending on the
design and solution type.
a. Solution field with a drop down selection list. This lists the available solutions, whether

sweeps or adaptive passes.
b. Geometry field with a drop down selection list. For field and radiated field reports, this

applies the quantity to a geometry or radiated field setup.
3. Under the Trace tab ZComponent area, specify the information to plot as contours:

a. In theCategory list, click the type of information to plot.
b. In theQuantity list, click the value to plot.
c. In the Function list, click themathematical function of the quantity to plot.
d. TheValue field displays the currently specified Quantity and Function. You can edit this

field directly.
Note Color shows valid

expression.

e. Range Function button -- opens theSet Range Function dialog. This applies currently
specified Quantity and Function.

4. On the Trace tabY (Secondary sweep) lines, specify the information to plot along the y-axis in
one of the following ways:
l Select the sweep variable to use from the Secondary Sweep drop down list.
l If sweeps are available, you can select the browse button to display a dialog that lets you
select particular values. The quantity will be plotted against the primary sweep variable
listed.

5. On the Trace tabX (Primary sweep) lines, specify the information to plot along the x-axis in
one of the following ways:
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l Select the sweep variable to use from the Primary Sweep drop down list.
l If sweeps are available, you can also select the browse [...] button to display a dialog box
that lets you select particular sweep values, specify a range of sweep values (for Time
sweeps), orUse all values (the default setting). The quantity will be plotted against the
primary sweep variable listed.

6. On the Families tab, confirm or modify the sweep variables that will be plotted.
7. ClickNew Report.

This creates a new report in Project tree, displays the report with the defined trace, and
enables theAdd Trace button on theReport dialog.
The function of the selected quantity or quantities will be plotted against the values you
specified on an x-y-z graph. The plot is listed underResults in the project tree.When you
select the traces or plots, their properties are displayed in the Properties window. These
properties can be edited directly to modify the plot.

8. Optionally, add another trace to the plot by following the procedure above, usingAdd Trace
rather than New Report.

Related Topics

Sweeping a Variable
Working with Traces
Adding Trace Characteristics

Delta Markers in 2D Reports

To view the difference between any twomarker points in a report:
1. Set the first marker by left-clicking and holding themouse button.
2. Move themouse; without releasing the left button, to another position, and then release the

left button to create the secondmarker.
In themarker text window, the difference between the twomarkers is displayed instead of the X, Y
value of the eachmarker.

Related Topics

Setting Report2D options
Working with Traces
Editing the Display Properties of Traces
Adding DataMarkers to Traces

Working with Traces

A trace in a 2D or 3D report defines one or more curves on a graph. A trace in a data table defines
part of the displayedmatrix of text values.
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The values used for a plot's axes, whichmay be X, Y, Z, phi, theta, or R depending on the display
type, can be variables in the design, such as frequency, or functions and expressions based on the
design's solutions. If you have solved one or more variables at several values, you can “sweep” over
some or all of those values, resulting in a curve in 2D or 3D space.
A report can include any number of traces and, for 2D Rectangular and Rectangular Contour plots,
up to 20 independent y-axes.Traces appear in the Project tree under their report. They can be
selected, copied and pasted.
When youmove a cursor over a trace in a report, the cursor changes to show that you canmake a
selection:

l For PC systems, the cursor changes to the color of the selectable trace.
l For Unix systems, the cursor changes to a solid black arrow, rather than the default black
outline.

In general, to add a trace to a report:
1. Select a report in the Project window and right-click and selectModify Report.
2. In theReport dialog specify the Y component information.

a. Specify the Category of information you want to plot from the drop downmenu.
The Category drop downmenu lists the available categories for the Solution type and the
current design. Selecting a category changes theQuantity and Function lists to represent
what is available for that category.

b. Specify the Quantity you want to plot by selecting from theQuantity list.
The selected quantity appears in the Value field, operated on any selected function.

c. Select the Function to apply to the specified quantity.
d. The Value field shows the trace being readied for plotting on the Y-axis. This field is

editable when the text cursor is present. You canmodify the information to be plotted by
typing the name of the quantity or sweep variable to plot along an axis directly in the text
boxes.
Note Color shows valid

expression.

e. Range Function button -- opens theSet Range Function dialog. This applies currently
specified Quantity and Function.

3. In theReport dialog specify the X axis information (for example Primary Sweep).
4. ClickAdd Trace.

A trace is added to the traces list under its report icon in the Project tree. The trace represents
the function of the quantity you selected and will be plotted against other quantities or swept
variable values. Selecting a Trace in the Project tree displays the Properties window for that
Trace.
Trace icons can be selected, copied, and pasted for their definitions or their data. They can be
selected and deleted from the Project tree.
By default, the Trace name is the definition (the category, quantity and function). The trace will
be visible in the report when you clickAdd Trace.
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Trace properties can be edited directly in the Properties window or edited in theReport
dialog. To change the name of definition of a trace, see Editing Trace Properties. To edit other
display properties of a trace, see Editing the Display Properties of Traces.

Related Topics

Removing Traces
Editing Trace Properties
Editing the Display Properties of Traces
Discarding Report Values Below a Specified Threshold
Adding Trace Characteristics
Adding DataMarkers to Traces
Setting Report2D options
Copy and Paste of Report and Trace Definitions
Copy and Paste of Report and Trace Data
Delta Markers in 2D Reports

Editing Trace Properties

You can edit trace properties such as the name, the Y Axis association, the component definition, the
context, or the variables select the trace in the Project tree.

To edit a trace name:
1. Select the trace in the Project tree.

This displays a docked Properties window for the Trace.
2. Check the Specify Name box.

This enables editing of either the Name field in the docked properties dialog, or the Trace label
text in the Project tree. Editing this name changes the display in the Legend and in the Project
tree, but not the underlying Y-component definition.

Note To control the display of the Solution Name and Variation Key in the Legend, see Report
2D: Legend Tab.

To edit the Y Axis associated with the trace (2D Rectangular and Rectangular Contour
plots):
1. Select the trace in the Project tree.
2. In the docked Properties window for the trace, select the Y Axis to be associated with the trace

from the drop downmenu. Up to 20 independent Y axes can be added to a plot.
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To edit a trace component definition:
1. Select the trace in the Project tree.
2. In the docked Properties window for the trace, select the component field of interest, and

select Edit... from the drop downmenu.
This displays the an edit Component field window.formwhich you can edit the category,
quantity and function.

3. ClickOK to apply the changes and close the dialog.

To edit a trace Context:
1. Select the trace in the Project tree to display the docked properties window.
2. In properties window, click the Solution field or the Domain field. If other selections are

possible, they can be selected from the drop downmenu.

To edit a variable for a trace:
1. 1. Select the trace in the Project tree to display the docked properties window.
2. 2. Under the -Variables category, on the Families line, click the Edit button to display the Edit

families dialog.
From this dialog, you can select the Sweeps or Variations radio buttons.
If other nominal values are available you can click the ellipsis button to select from a list.

Related Topics

Removing Traces
Editing the Display Properties of Traces
Discarding Report Values Below a Specified Threshold
Adding Trace Characteristics
Adding DataMarkers to Traces
Setting Report2D options
Copy and Paste of Report and Trace Definitions
Copy and Paste of Report and Trace Data
Delta Markers in 2D Reports

Editing the Display Properties of Traces

To edit the display properties of a trace:
1. Select a trace in an openReportwindow.
2. Click once on the trace to view aDocked Propertieswindow, or double click to open

Propertieswindow.
The display properties window for a trace includes aGeneral tab and anAttributes tab.
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TheGeneral tab properties apply to the general appearance of the plot. They include the
Background color, Contrast color, Field width, andWhether to use Scientific notation for
marker and delta marker displays. (X and Y notation display is set separately, in the Axis
property tabs.)
The Attributes Tab properties apply specifically to the trace. The defaults are set in the
Report2D options. They include:
l Name -- not editable by selecting the trace from the Report. It shows the characteristics of
the trace as defined in the Report dialog.

To edit a trace name, see Editing Trace Properties

l Color -- shows the Trace color. Double click to open a Color dialog. You can select from
Basic colors, or custom colors. You can define up to 16 custom colors by selecting or by
editing the Hue, Saturation, Luminescence, and the Red, Green, and Blue values.

l Line style -- a drop downmenu lets you select Solid, Dot, Dash, or Dot-dash.
l Line width -- a text field lets you edit the numeric value.
l Trace type -- he drop downmenu contains entries for Continuous, Discrete, Bar-Zero, Bar
Infinity, Stick Zero, Stick Infinity, Histogram, Step, Stair, and Digital.

Notice the difference between Stair and Digital is that each Stair centers on a data point with
transitions halfway between points, and Digital transitions from each data point to the next
value.
The next four properties work together to define whether to show a symbol on data points, the
symbol frequency, the symbol style, and whether to display the symbol as solid or hollow.

Post Processing andGenerating Reports 23-51
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l Show Symbol -- whether to show a symbol at the data points on the line.
l Symbol Frequency -- how often to show symbols on the trace, based on the number of
data points per symbol used. For example, specify 1 for one symbol per data point. Specify
10 for one symbol for every 10 data points.

l Symbol Style -- use a drop downmenu to select from box, circle, vertical ellipse, horizontal
ellipse, vertical up triangle, vertical down triangle, horizontal left triangle, horizontal right
triangle

l Fill Symbol -- use the check box to set the symbol display as a solid or as hollow.
l Symbol Arrows -- use the check box to use arrows on the curve ends.

Note So that curveswith single points always appear, Box is the default symbol. For
Maxwell 12, None cannot be selected.

3. Edit the properties of interest and clickOK to apply the changes and close the window.
To edit the display properties of a trace in a 3D report:

1. Double click on the trace. This opens a Properties dialog for the plot with a tab named for the
trace selected.

2. The editable properties include Point size, Point Style, whether to show points, whether to
show line, line width, and line style.

Related Topics

Setting Report2D options
Working with Traces
Editing Trace Properties
Adding Trace Characteristics
Adding DataMarkers to Traces
Removing Traces
Discarding Report Values Below a Specified Threshold
Copy and Paste of Report and Trace Definitions

Adding Data Markers to Traces

TheReporter includesReport 2D>Marker>menu commands and toolbar icons

that let you addmarkers to traces. A marker appears as “mN” at themarked point, whereN
increments from 1 as you place additional markers. Eachmarker can be selected and has editable
properties including name, font, background and color. As you placemarkers, one or moremarker
legendsmay be displayed, depending on theView>Active View Visibility settings for the legends.
Themainmarker legend appears in the upper left of the plot, and lists themarker names and their X
and Y values in a table. You can control the number format for the table values via the Properties
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window, General tab. Under Marker/Other Number format, you can specify field width, precision,
and whether to use scientific notation. This value is independent of the Axis tab number properties. A
separatemarker legend appears for Delta Markers, as described for theDelta Marker command.
When you enter Marker mode, the cursor arrow is accompanied by an “m” while a circle on the
selected trace shows the current position for a potential marker.
To endMarker mode, right-click to display the shortcut menu, and selectEnd Marker Mode.
The availableMarker mode commands and associated icons are the following:

l Add Marker – this command lets you place amarker at an arbitrary point on a selected
trace.

l Add Delta Marker – enters delta marker mode, placing a circle on the selected trace.
Clicking on the trace sets an initial point and subsequent clicks on arbitrary points on the trace
place additional markers until you leavemarker mode. Thesemarkers have their own legend,
which includes the following information for each pair of markers specified.:

l Export Marker Table – allows you to export themarker table data as a .csv or .tab file.
l Export Delta Marker Table – allows you to export the delta marker table data as a .csv or
.tab file.

l Add Maximum – places amarker at theMaximum value on the selected trace.

l Add Minimum – places amarker at theMinimum value on the selected trace.
l X Marker – this command adds up to 10movablemarkers at the origin of the plot with a
vertical line rising from the X axis. Each addedmarker has its own color and editable
properties. You can change the X marker value either by dragging themarker, or by editing
the X marker propertyX value. Tomove an X marker, click on the X label and drag it to the
desired location. The label at the bottom of the line gives the X coordinate, and a flag on the
vertical line identifies the Y coordinate on the trace. A Lock Drag trace property lets you lock
the drag feature to leave themarker in place. If more than one X marker is present, marker
properties include a connecting line between adjacent markers and the delta X value between
themarkers. The X markers are cleared by theClear All command.

l Bring X Marker into view – this command is enabled if an X Marker is not visible in the plot.
It allows you to select from a list of existing X Markers to bring into view.
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l Y Marker – this commands adds up to 10movablemarkers at the origin of the plot with a
horizontal line extending from the Y axis. Each addedmarker has its own color and editable
properties. You can change the Y marker value either by dragging themarker, or by editing
the Y marker propertyY value. Tomove a Y marker, click on the Y label and drag it to the
desired location. The label at the left of the line gives the Y coordinate, and a flag on the
horizontal line identifies the Y coordinate on the trace. A Lock Drag property lets you lock the
drag feature to leave themarker in place. If more than one Y marker is present, marker
properties include a connecting line between adjacent markers and the delta Y value between
themarkers. The Y markers are cleared by theClear All command. For more detail on Y
Markers and their use, see Y Markers in stacked XY plots.

l Bring Y Marker into view – this command is enabled if a Y Marker is not visible in the plot. It
allows you to select from a list of existing Y Markers to bring into view.

l Next Peak –moves a selectedmarker on the next peak on a trace. Youmust exit marker
mode and select amarker to enable this command.

l Next Minimum –moves a selectedmarker to the next minimumon a selected trace. You
must exit marker mode and select amarker to enable this command.

l Previous Peak –moves a selectedmarker on the previous peak on a selected trace. You
must exit marker mode and select amarker to enable this command.

l Previous Minimum – places amarker on the previousminimumon a selected trace.
Youmust exit marker mode and select amarker to enable this command.

l Go to Start (Right arrow) –moves a selected tracemarker to the first data point. Enabled by
leavingmarker mode and selecting amarker.

l Go to Previous (Left arrow) –moves a selected tracemarker to the previous data point.
l Go to Next –moves a selected tracemarker to the next data point.
l Go to End –moves a selected tracemarker to the last data point.
l Next Curve – selects the next curve in the report, based on the order in the trace legend.
l Previous Curve – selects the previous curve in the report, based on the order in the trace
legend.

l Clear All – clears all markers on a report.

Related Topics

Setting Report2D options
Working with Traces
Adding Trace Characteristics
Removing Traces
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Discarding Report Values Below a Specified Threshold
Modifying the Legend in a Report
Editing the Display Properties of Traces
Zooming in or out.
Fitting Objects in the view window.
ShowingObjects
Hiding Objects fromView
Delta Markers in 2D Reports
Y Markers in stacked XY plots

Y Markers in stacked XY plots

YMarkers allow for easy analysis and comparison of curves at a particular y-coordinate. Y Markers
can be used to compare stacked curves.

Creating Y Markers in Stacked Plots
There are two ways to create Y Markers in Stacked Plots. You can create a Y Marker for a particular
stack or for all stacks. Right clicking on any stack shows the following context menu:

Add Y Marker > Current Stack creates a Y marker for the stack on which the user performed right
mouse button click. The following figure shows that a Y Marker was added to the second stack only:
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Add Y Marker >All Stacks creates one Y marker in each stackwith the same value. Initially this
value is theminimumY value of the Y ranges in all the stacks. This is shown is the figure below:
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Notice that the Y Marker for All Stacks has a different appearance than the Y Marker for a particular
stack: that is, it has double parallel lines above and below the Y Marker textbox.

Synchronized Y Markers
All the "same" Y markers for all stacks are synchronized, that is to say that if one Y marker is dragged
or its value is changed, all the "same" Y markers in all the stackswill change their position too. The
figure below shows that when a Y marker in the bottom stackwas dragged, the Y marker in top
stacksmoved aswell:

Also if a property of any one Y Marker is changed, all the "same" Y Markers show the change in
property aswell. For example, the figure below shows that when the line color of a Y Marker in the
top stackwas changed to a red color, a Y Marker in the bottom stack shows the same line color as
well:
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Automatic Y Markers for the new stack
When a new curve is added to the plot, it gets all the Y Markers for all stacks in other stacks,
excluding the Y Marker for particular stacks.The figure below shows that when the new curve "dB(S
(Port3, Port1)" was added, a Y Marker was added to it with value -3.14 and it has all the same
properties as other "same" Y Markers in other stacks:
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Y Marker Delta Annotations
When twomore Y Markers are present in a Stacked Eye Diagram, then delta annotations are shown
between a pair of adjacent Y Markers in all the stacks, as shown in the figure below:
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Deleting a Y Marker
To delete a Y Marker, select a Y Marker in any stack and press the Delete key. This action will also
delete all the corresponding Y Markers in all the stacks. For example, when the Y Marker with value -
3.13 (red Y Marker) was deleted from the bottom-most stack, all of the corresponding Y Markers
were also deleted:
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Note that on deleting a stack, Y Markers in other stacks are not affected.

Converting Rectangular XY Plot to Rectangular Stacked XY Plot
The following figure shows a Rectangular XY Plot with two curves and a Y Marker with value -3.15
(blue Y Marker):

If you change the Display Type property of this plot to Rectangular Stacked Plot, then a Rectangular
Stacked XY Plot is created with each curve in its own stack and a Y Marker is shown in each stack
with value -3.15 (blue Y Marker):
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Similarly when you change a Rectangular Stacked XY Plot to a Rectangular XY Plot, then all the
"same" Y Markers in all the stacks are shown as a single Y Marker in the Rectangular XY Plot as
shown in following figures:

The Rectangular Stacked XY Plot in the previous figure, when converted to Rectangular XY Plot,
looks like the figure below:
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Related Topics

Adding DataMarkers to Traces
Rectangular Stacked Plot

Discarding Report Values Below a Specified Threshold

To prevent real small numbers from skewing a plot, you can discard small values (below a
specifiable threshold).

1. Double-click on the X or Y axis of interest on an open plot display.
This opens thePropertieswindow for the Axis

2. Under theAxis tab, use the scroll bar to find theSpecify Discard Values property.
3. Click the check box to enable the property.
4. Enter a value in theDiscard Below field. Units specified elsewhere in the Axis property are

applied to this value. The Discard Below text box is inactive if the Specify Discard Values
check box is not enabled.

5. ClickOK to apply the Discard Values to the report.

Related Topics

Working with Traces
Removing Traces
Editing the Display Properties of Traces
Modifying Background Properties of a Report
Modifying Reports
Adding Trace Characteristics

Adding Characteristics to a Trace

There are several options for adding characteristics to a trace.When you clickReport 2D>Trace
Characteristics, or right-click a selected trace, the short cut menu is displayed. The following
example shows themenuwith expandedRecent selections.

Adding a Recently Used Trace Characteristic
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Adding a Trace Characteristic from Favorites
Adding Trace Characteristics to your Favorites
Adding Characteristics using the Add Trace Characteristics Dialog
Removing All Trace Characteristics

Adding a Recently Used Trace Characteristic

If you recently used a characteristic, you can add it to a selected trace by selecting from a list of
recently used characteristics. A maximumof 10 is displayed in themenu, and they are sorted
alphabetically.
To add a recently used characteristic to a selected trace:

1. Select a trace in a report plot or legend.
2. ClickReport 2D>Trace Characteristics, or right-click on the selected trace to display the

short cut menu.
3. SelectRecent, and then select the function you want. The specified characteristic is added to

the trace.

Related Topics

Adding a Characteristic to a Trace
Adding a Trace Characteristic from Favorites
Adding Trace Characteristics to your Favorites
Adding Characteristics using the Add Trace Characteristics Dialog
Removing All Trace Characteristics

Adding a Trace Characteristic from Favorites

You can add a trace characteristic to a selected trace by selecting from a list of favorites. A maximum
of 10 is displayed in themenu, and they are sorted alphabetically.
To add a favorite characteristic to a selected trace:

1. Select a trace in a report plot or legend.
2. ClickReport 2D>Trace Characteristics, or right-click on the selected trace to display the

short cut menu.
3. Select Favorites, and then select the function you want. The specified characteristic is added

to the trace.

Related Topics

Adding a Characteristic to a Trace
Adding Trace Characteristics to your Favorites
Adding Characteristics using the Add Trace Characteristics Dialog
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Removing All Trace Characteristics
Adding a Recently Used Trace Characteristic

Adding Trace Characteristics to your Favorites

You can add trace characteristics to your list of favorites.
To add characteristics to your list of favorites:

1. Select a trace in a report plot or legend.
2. ClickReport 2D>Trace Characteristics, or right-click on the selected trace to display the

short cut menu.
3. SelectAll. This displays theAdd Trace Characteristics dialog box.

4. Click the Favorite check box in front of any function you want to add to Favorites. You can
define asmany favorites as you need, but nomore than 10 are displayed in themenu, and
they are displayed in alphabetical order.

5. ClickClose. You can view the current favorites by selecting Favorites in the Category drop-
down list
Note You can remove favorites by clearing the Favorite check box for one or more

functions, and clickingClose.
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Related Topics

Adding a Characteristic to a Trace
Adding Characteristics using the Add Trace Characteristics Dialog
Removing All Trace Characteristics
Adding a Recently Used Trace Characteristic
Adding a Trace Characteristic from Favorites

Adding Characteristics using the Add Trace Characteristics Dialog

You can add characteristics to a selected trace by selecting from theAdd Trace Characteristics
dialog box.
To add additional characteristics to a selected trace:

1. Select a trace in a report plot or legend.
2. ClickReport 2D>Trace Characteristics, or right-click on the selected trace to display the

short cut menu.
3. SelectAll. This displays theAdd Trace Characteristics dialog box.
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4. Select theCategory. The available categories depend on the plot, and the selecting of a
category displays its associated functions.

Category Functions
Recent Displays themost recent functions used, sorted by the time theywere

added.

Favorites Displays all favorites. The defaults are avg, max, min, and pk2pk.

All Displays all available functions.

Math avg, avgabs, integ, integabs, max, mean, min, pk2pk, pkavg, ripple, rms,
rmsAC, stddev, sum, variance, XatYMax, XatYMin, XatYVal,
XWidthAtYVal, YatXMax, YatXMin, YatXVal

PulseWidth pulsefall9010, pulsefront1090, pulsefront3090, pulsemax, pulsemaxtime,
pulsemin, pulsemintime, pulsetail50, pulsewidth5050, pw_minus, pw_
minus_avg, pw_minus_max, pw_minus_min, pw_minus_rms, pw_plus,
pw_plus_avg, pw_plus_max, pw_plus_min, pw_plus_rms

Overshoot/
Undershoot

overshoot, overshootAbs, undershoot, undershootAbs

TR & DC crestfactor, deadtime, delaytime, distortion, formfactor, fundamentalmag,
risetime, settlingtime

Error iae, ise, itae, itse

Period per, pmax, pmin, prms

AC gainmargin, phasemargin, gaincrossover, phasecrossover, lowercutoff,
uppercutoff, bandwidth, peakgain, peakgainfreq

Radiation lSidelobeY, rSidelobeY, lSidelobeX, rSidelobeX, xdb10Beamwidth,
xdb20Beamwidth

Eye
Measurements

EyeLevelZero, EyeLevelOne, EyeAmplitude, EyeHeight,
EyeSignalToNoise, EyeOpeningFactor, EyeWidth, EyeJitterP2P,
EyeJitterRMS, EyeRiseTime, EyeFallTime, MinEyeWidth,
MinEyeHeight

TDR Shunt_C_in_pF, Series_L_in_nH

For a selected function, theAdd Trace Characteristics dialog displays the function’s
purpose in a text field.

5. Some categories and functions call for you to specify one or two additional values in a table.
You can save these values using theSave as Default button. The Default column shows a Y
if there is a saved default value for the function.
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6. Select theCurrent sticky range overrides saved default check box if you do not want the
range value in the table to be changed when the function selection is changed: the current
range value becomes the “sticky range.” If the check box is not checked, the range value is
updated from the saved default values and becomes a new sticky range.

7. Click theAddTrace Characteristic button to add the specified characteristics to the trace.
8. Click Close.

Related Topics

Adding a Characteristic to a Trace
Adding Trace Characteristics to your Favorites
Removing All Trace Characteristics
Adding a Recently Used Trace Characteristic
Adding a Trace Characteristic from Favorites
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Removing All Trace Characteristics

1. Select a trace in a report plot or legend.
2. ClickReport 2D>Trace Characteristics, or right-click on the selected trace to display the

short cut menu.
3. Select Trace Characteristics>Clear All.

Trace characteristics are cleared from the selected trace.

Related Topics

Adding a Characteristic to a Trace
Adding Trace Characteristics to your Favorites
Adding Characteristics using the Add Trace Characteristics Dialog
Adding a Recently Used Trace Characteristic
Adding a Trace Characteristic from Favorites

Removing Traces

You can remove traces from the traces list in the following ways:
To remove one trace from the report:

l Select the trace you want to remove from the Project tree, and then clickDelete.
To remove all traces from the report:

l Select all the traces and clickDelete.

Related Topics

Working with Traces
Editing the Display Properties of Traces

Copy and Paste of Report and Trace Definitions

You can copy and paste report and individual trace definitionswithin a single design or across
designs. The report or trace definition will be evaluated within the context of the target design or
report.

Note If the report or trace definition contains properties that do not exist in the target design (for
example, a port name) an error will be posted that indicates a solution does not exist for
this trace

Note Youmust copy and paste trace definitions between the same report
types.

To copy a Report Definition:
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Right click on the report name in the project tree and selectCopy Definition from the shortcut
menu.
To paste the Report Definition:
Right click on Results in the project tree of the target design and selectPaste.
A new report is created and it contains the copied definitions.
To copy an individual Trace Definition(s):
Right click on the trace or traces under a report name in the project tree and selectCopy Definition.
To paste the Trace Definition(s):
Right click on the report in the target design to which you would like to copy the trace or traces and
selectPaste.
A new trace(s) is added to the report and it contains the copied trace definition(s).

Note If you copy and paste a report or trace definition to a design which contains a definition with
the same name, then an incremented number is appended to the pasted report or trace
name.

Related Topics

Copying to the Clipboard as Images
Copy and Paste of Report and Trace Data

Copy and Paste of Report and Trace Data

You can copy and paste report and individual trace data within a single design or across designs.
The report and trace definitions and all underlying data within the report or trace are copied and
pasted to the target design or report.
To copy all data from a report:
Right click on the report name in the project tree and select Copy Data, or use themenu bar
Edit>Copy Data, or right click within a plot to display a shortcut menu withCopy Data.
To paste copied report data:
Right click on Results in the project tree of the target design and selectPaste.
To copy data from an individual trace(s) in a report:
Right click on the trace or traces under a report name in the project tree and selectCopy Data.
To paste copied trace data:
Right click on the report in the target design to which you would like to copy the trace data and select
Paste.

Note If you copy and paste report or trace data which contains the same name definition as a
report or trace in the target design then an incremented number will be appended to the
pasted name
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Related Topics

Copying to the Clipboard as Images
Copy and Paste of Report and Trace Definitions

Limit Lines in Cartesian Plots

Limit lines are simple graphical representations of constraints on XY plots. These aremodeled as a
sequence of XY point pairs. For example, you can designate a single limit line to delineate either an
upper or lower limit, or two limit lines to delineate upper and lower limits. You can add asmany limit
lines as you want. You can control the display properties of the line including color and hatch width.

Note Limit lines are available only on Rectangular (XY) plots - not on XY-like plots such as Bode,
Rectangular Stacked, etc.)

You can create limit lines in the following ways:
l by specifying points to define the line(s)
l from a selected curve on the plot.

Related Topics

Specifying Points to Create Limit Lines
Creating Limit Lines From a Selected Curve
Editing Limit Lines
Modifying the Background Properties of a Report

Specifying Points to Create Limit Lines

1. ClickReport2D>Add Limit Line>Specify Points or right-click on an XY plot and select
Add Limit Line>Specify Points from the context menu to open theEdit Dataset dialog.
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You can use this dialog to:

l Enter the XY coordinate values directly.
l Import XY values from a tab-delimited .tab file.
l Export Dataset to a file.

If you require additional data points, you can use the buttons toAppend Rows to the
Coordinates table. If you select a row in the Coordinates table, you can then use the buttons
to add a row above or a row below the selected rows, or to delete rows.

You can use Shift+click to select multiple adjacent rows, or Ctrl+click to select any
combination of rows for deletion.

Note Each limit line is associated with a particular Y axis (since it has to be scaled the sameway
as all the curves associated with the axis, follow its log/linear scale, etc.). This Y axis
association defaults to the first available Y axis when the limit line is created. However, if
the plot containsmultiple Y axes, it can be associated with a different Y axis later via its
properties tab.

2. When you clickOK, the limit line you defined is added to the plot. The line divides the plot into
regionswithin the context of its length. By default, the region above the limit line is hatched.
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Related Topics

Creating Limit Lines From a Selected Curve
Editing Limit Lines
Modifying the Background Properties of a Report

Creating Limit Lines From a Selected Curve

1. To create limit lines from a selected curve youmust first click on the desired plot curve and
then select From Selected Curve to open the Limit Line From Curve dialog.
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2. The Limit Line From Curve dialog allows you to create limit lines over theRange of the
Entire Curve, or between specified X-axisStart andStop points.Create Mode controls
whether limit lines areAbove Curve,Below Curve, orAbove and Below Curve. You can
also specify aY Offset value, which sets a constant distance between the curve and limit line
(s); and aY Shift %, which shifts the limit line(s) by the specified percentage of the Y-axis
values. In the example below the upper limit line has a Y Offset value of 0.01 and no Y Shift %,
while the lower limit line has a Y Shift % of 30 and no Y Offset,

3. When you clickOK, the limit lines you defined are added to the plot. The lines divide the plot
into regionswithin the context of its length. By default, the region above a limit line is hatched.

Related Topics

Specifying Points to Create Limit Lines
Editing Limit Lines
Modifying the Background Properties of a Report

Editing Limit Lines

You can select a limit line in a plot to edit the following properties on the Limit Line tab of the plot
properties dialog.
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l Color – affects both line and hatching
l Style andWidth – affects only the line, not the hatching
l Y Axis Y– axis associated with the limit line
l Hatch Pixels – sets the length of the hatch lines
l Point Data – edit the data that defines the limit line
l Hatch Above – sets the direction of the hatch lines (above or below) the limit line

For example, if you add a second limit line, you could designate it as hatch below by
uncheckingHatch Above to produce a “tunnel” marking the upper and lower constraints.

Related Topics

Specifying Points to Create Limit Lines
Creating Limit Lines From a Selected Curve
Modifying the Background Properties of a Report
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Limit Line Violations

A plot feature can help you detect whether or not a curve violates the limits set by a limit
line. Consider the following plot, which shows two curves:

Suppose that the desired response cannot be below -30 dB at frequencies below 1.5 GHz and
below -50 dB above 1.5 GHz. If you add a limit line for these requirements in the plot, the plot
automatically calculates whether a curve violates this limit line requirement and displays it in the
legendswindow, as shown in following figure:

If a curve is selected, the plot shows the region of the curve that violates the limit line (shaded with
slanted red lines), as shown in following figure:
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If no curve violates a limit line, the limit line hatching is limited to 10 pixels, as shown in the following
figure. This is done to retain focus on the curves instead of the limit lines.

Error Handling
If plot encounters an error while calculating Limit Line Violations, the legend window showsNaN
(Limit Line name) in front of the curve in the Limit Line Violations column. This ensure that you do not
get misleading information about no-violationswhen the issue is actually a limitation in our code.

Related Topics

Modifying the Background Properties of a Report
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Sweeping a Variable in a Report

In Maxwell, a swept variable is an intrinsic, project, or design variable that typically hasmore than
one value. You can plot any calculated or derived quantity against one or more of the swept
variable's values.
To specify the swept variable values to plot a selected quantity against:

1. In theReport dialog, select the variable from the X (Primary Sweep) pull-downmenu.
2. Tomodify the values that will be plotted for a variable:

a. Click the ellipsis [...] button on theX (Primary Sweep) line of theReport dialog to
displays a popup list of the possible values.

b. SelectAll Values or click the Edited button to display a dialog that lets you
specify the sweeps to use.
All of the selected variable’s valueswill be plotted.

Sweeping Values Across a Distance

1. If you are plotting a field quantity along a line, define a polyline object in the problem region.
2. In theReport dialog box, click the line geometry of interest in theGeometry list.
3. Specify the quantities you want to plot along the axes.
4. For theX (Primary Sweep), select theDistance variable.

The values at which the selected quantity or quantities will be plotted are listed to the right. By
default, a post-processing polyline object is divided into 100 equally spaced points.

Related Topics

Sweeping a Variable in a Report

Selecting a Function

The value of a quantity being plotted depends upon itsmathematical function, which you select from
the Function list in theReport dialog box. The available, valid functions depend on the type of
quantity (real or complex) that is being plotted. The function is applied to the quantity which is
implicitly defined by all the swept and current variables. "Volume(Stator)" is the volume of themodel
object named Stator for every swept combination of variables ("height" and so forth).
These functions can also be applied to previously specified Quantities and Functions asRange
Functionswhen using theSet Range Function dialog.
Some of these functions can operate along an entire curve. These are: deriv, min, max, integ, rms,
pk2pk, cang_deg and cang_rad. These functions have syntax as follows:

l deriv(quantity) implicitly implies derivative over the primary sweep
l deriv(quantity, SweepVariable) explicitlymeans derivative over the sweep variable specified
in the second argument (such as "Freq").
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You can select from the following functions in the Trace tab Function list or type them directly into
the Yor X field, if necessary:

abs Absolute value of the simulation quantity which results in a number that is
always positive.

acos Arc cosine i.e. the inverse function of a cosine.
acosh Inverse hyperbolic arc cosine.
ang Magnitude of an angle.
ang_deg Angle (phase) of a complex number, cut at +/-180.
ang_rad Angle in radians.
arg Argument of a complex number. It is the angle the complex number makes

with the positive x axis. Same as ang_deg.
asin Arc sine i.e. inverse function of sine.
asinh Inverse hyperbolic sine.
atan Arc tangent. Takes a tangent value as an argument. Because there are two

angles in a circle that can have the same tangent value, and atan can return
only one value, it returns a value in the range between -90 degrees and +90
degrees (or between -pi/2 and pi/2 in radians).

atanh Inverse hyperbolic tan.
atan2(y,x) A two-argument version of the atan function. Takes the y and x coordinates

(including sign information) of a point as arguments and returns the angle
from the X-axis. Can return angle values for the full circle (-180 degrees to
+180 degrees or -pi to +pi in radians).

avgabs Returns themean of the absolute value of the selected quantity.
bandwidth Returns the 3dB bandwidth of the selected simulation quantity. For

bandwidth, the calculation is based on 3dB below themaximumpeak.
cang_deg Cumulative angle (phase) of the first parameter (a complex number) in

degrees, along the second parameter (typically sweep variable). Returns a
double precision value cut at +/-180.

cang_rad Cumulative angle of the first parameter in radians along a second parameter
(typically a sweep variable). Returns a double precision value.

cmplx(re, im)
A complex number, where re is the real part and im is the imaginary part.

conjg Conjugate of the complex number.
cos Cosine.
cosh Hyperbolic cosine.
crestfactor Returns the crest factor (peak/RMS) for the selected quantity.
cum_integ The cumulative integral function returns a set of values that have the same

length as the original set of points (the first element will always be zero).
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Element I of the set returned by cum_integ is the integral of elements 1
through I of the original data set.

cum_sum The cumulative sum function returns a data set that has the same length as
the original set of points. Element I of the set returned by cum_sum is the sum
of elements 1 through I of the original data set.

dB(x) 20*log10(|x|) to base 10.
dBc Decibels relative to the carrier. It is the power ratio of the signal to a carrier

signal. Gives the relative signal strength.
dBm(x) 10*log10(|x|) +30.
dBW(x) 10*log10(|x|).
dB10 10*log(|x|) to base 10.
dB10normalize 10*log [normalize(mag(x))].
dB20 20*log(x) to base 10.
dB20normalize 20*log [normalize(mag(x))].
deadtime Obtains the latest time when the qtyl is within a tolerance of zero.
delaytime Obtains the time from zero to 50% of the target point.
degel Conversion from degrees electrical to secondswith respect to Hz.
deriv Derivative of first parameter with respect to second parameter.
distortion Returns the total distortion for the selected simulation quantity and an

additional argument frequency, which is the frequency in Hz at which to
calculate the fundamental RMS of the simulation quantity.

even Returns 1 if integer part of the number is even; returns 0 otherwise.
exp Exponential function (the natural anti-logarithm) of the simulation quantity.
formfactor Returns the form factor (RMS/Mean Absolute Value) for the selected

quantity.
fundamentalmag Returns the RMS value of the fundamental frequency for the selected

quantity, and an additional argument, Frequency, which specifies the
fundamental frequency.

gaincrossover Returns the gain crossover frequency (where the gain is 0 dB) of the selected
simulation quantity in Hz.

gainmargin Returns the gainmargin in dB at the phase crossover frequency of the
selected simulation quantity. It also requires a reference simulation quantity to
which themeasured quantity is compared and the AC magnitude and phase
angle of the reference quantity. These are entered as the arguments
Reference Channel, Base SourceMagnitude, and Base Source Angle.

iae Returns the integral of the absolute deviation of the selected quantity from a
target value that is entered via the additional argument. To use this function,
you need to open the Add Trace Characteristics dialog and select the Error
category.
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if if(cond_exp,true_exp, false_exp).
im Imaginary part of the complex number.
int Truncated integer function.
integ Integral of the selected quantity. Uses trapezoidal area.
integabs Absolute value of integral.
ise Returns the integral of the squared deviation of the selected quantity from a

target value that is entered via an additional argument. To use this function,
you need to open the Add Trace Characteristics dialog and select the Error
category.

itae Returns the time-weighted squared deviation of the selected quantity from a
target value that is entered via an additional argument. To use this function,
you need to open the Add Trace Characteristics dialog and select the Error
category.

itse Returns the time-weighted squared deviation of the selected quantity from a
target value that is entered via an additional argument. To use this function,
you need to open the Add Trace Characteristics dialog and select the Error
category.

j0 Bessel function of the first kind (0th order).
j1 Bessel function of the first kind (1st order).
jn Bessel function of the first kind (nth order).
ln Natural logarithm.
log Natural logarithm (same as ln).
log10 Logarithm base 10.
lowercutoff Returns the lower 3dB frequency of the selected simulation channel in Hertz.
lsidelobeX The 'x' value for the left side lobe: the next highest value to the left of themax

value.
lsidelobeY The 'y' value for the left side lobe: the next highest value to the left of themax

value.
mag Magnitude of the complex number.
max Returnsmaximum value of the simulation quantity.
max_swp Returnsmaximum value of a sweep.
max2 Maximum value of the two simulation quantities. For example, max2(a,b)will

plot maximumof a and b for a particular instance.
mean Returns the average in the set of quantities selected.

mean = sum( all y-value) / (number of y-values)
min Returns theminimum value of the simulation quantity.
min_swp Returns theminimum value of a sweep.
min2 Minimum value of the two simulation quantities. For example, min2(a,b)will

plot minimumof a and b for a particular instance.
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mod Returns themodulus or absolute value of the simulation quantity.
nint Nearest integer.
none Returns null value.
normalize Divides each value within a trace by themaximum value of the trace. ex.

normalize(mag(x)).
odd Returns 1 if integer part of the number is odd; returns 0 otherwise.
overshoot Calculates peak overshoot given a threshold value and number of evenly

spaced points over entire time range.
peakgain Returns the peak value of gain of the selected simulation quantity in dB.
peakgainfreq Returns the frequency in Hz at which the peak gain of the selected simulation

quantity occurs.
polar Coverts the complex number in rectangular co-ordinates to polar co-

ordinates.
per Returns the period of a simulation quantity.
phasecrossover Returns the phase crossover frequency, at which the phase is -180 degrees,

in Hz for the selected simulation quantity.
phasemargin Returns the phase angle in degrees at the gain crossover frequency of the

selected simulation quantity.
pk2pk Peak to peak. Difference betweenmax andmin of the first parameter over

the second parameter. Returns the peak-to-peak value for the selected
simulation quantity.

pkavg Returns the ratio of the peak to peak-to-average for the selected quantity.
pmax Maximumperiod of the selected simulation quantity.
pmin Minimumperiod of the selected simulation quantity.
pow Raises x to the power of y; pow(x,y).
prms Period Root Mean Square.
pulsefall9010 Returns the pulse fall time of the selected quantity according to the 90%-10%

estimate.
pulsefront1090 Returns the pulse front time of the selected quantity according to the 10%-

90% estimate.
pulsefront3090 Returns the pulse front time of the selected quantity according to the 30%-

90% estimate.
pulsemax Returns the pulsemaximum from the front and tail estimates for the selected

quantity.
pulsemaxtime Returns the time at which themaximumpulse value of the selected quantity is

reached.
pulsemin Returns the pulseminimum from the front and tail estimates for the selected

quantity.
pulsemintime Returns the time at which theminimumpulse value of the selected quantity is
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reached.
pulsetail50 Returns the pulse tail time of the selected quantity from the virtual peak to

50%.
pulsewidth5050 Returns the pulse width of the selected quantity asmeasured from the 50%

points on the pulse front and pulse tail.
pwl Piecewise Linear.
pwl_periodic Piecewise Linear for periodic extrapolation on x.
pwlx Piecewise Linear x with linear extrapolation on x.
pw_minus Pulse width of the first negative pulse.
pw_minus_avg Returns the average of the negative pulse width input stream.
pw_minus_max Returns themaximumpulse width of the negative pulse of input stream.
pw_minus_min Returns theminimumpulse width of the negative pulse of input stream.
pw_minus_rms RMS of the negative pulse width input stream.
pw_plus Pulse width of the first positive pulse.
pw_plus_avg Average of the positive pulse width input stream.
pw_plus_max Max. Pulse width of the positive pulse of input stream.
pw_plus_min Min. Pulse width of the positive pulse of input stream.
pw_plus_rms RMS of the positive pulse width input stream.
re Real part of the complex number.
rect Converts the complex number in polar to rectangular co-ordinates.
rem Fractional part of the selected simulation quantity i.e. remainder.
ripple Returns the ripple factor (AC RMS/Mean) for the selected quantity.
risetime Obtains the time taken to go from 10% to 90% of target point.
rms Returns the root mean square value of the selected quantity.
rmsAC Returns the AC RMS for the selected quantity.
root nth root function.
rSidelobeX Returns the X value of right side-lobe occurrence.
rSidelobeY Returns the Y value of right side-lobe occurrence.
settlingtime Returns the latest time at which the value of the selected simulation quantity

fell outside its tolerance band. The target value of the quantity and the +/-
bandwidth of the tolerance band are the additional args.

sgn Sign extraction.
sin Sine.
sinh Hyperbolic sine.
slidingmean Returns themoving average value of the selected simulation quantity

(specified by the first argument). The average is calculated over a period
(specified by the second argument).

slidingrms Returns themoving RMS value of the selected simulation quantity (specified
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by the first argument). The RMS value is calculated over a period (specified
by the second argument).

sqr Square of the selected simulation quantity.
sqrt Square root of the selected simulation quantity.
stddev Returns the standard deviation of given values.
sum Returns the sum of the given values.
tan Tangent.
tanh Hyperbolic tangent.
undershoot Calculates peak undershoot given a threshold value and number of evenly

spaced points over entire time range.
uppercutoff Returns the upper 3dB frequency of the selected simulation channel in Hz.
variance Calculates the variance of the given values.
XAtYMax Threshold crossing time: report first time (x value) at which an output quantity

crosses YMax.
XAtYMin Threshold crossing time: report first time (x value) at which an output quantity

crosses a user definable threshold.
XAtYVal Returns the X value at the first occurrence of Y value.
XWidthAtYVal Returns the X width between the first 2 occurrence of Y value.
xdb10beamdwidth Width between left and right occurrences of values 'x' db10 frommax. Takes

'x' as argument (3.0 default). To use this function, you need to open the Add
Trace Characteristics dialog and select the Radiation category.

xdb20beamwidth Width between left and right occurrences of values 'x' db20 frommax. Takes
'x' as argument (3.0 default). To use this function, you need to open the Add
Trace Characteristics dialog and select the Radiation category.

YAtXMax Returns the X value at maximum value of Y.
YAtXMin Returns the Y value at minimum value of X.
YAtXVal Returns the Y value at the first occurrence of X value.
y0 Bessel function of the second kind (0th order).
y1 Bessel function of the second kind (1st order).
yn Bessel function of the second kind (nth order).

Related Topics

Adding Trace Characteristics
Set Range Function
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Selecting Solution Quantities to Plot

Each trace in a report includes a quantity that is plotted along an axis. The quantity being plotted can
be a value that was calculated byMaxwell, such as L11, or a value from a calculated expression.
To select a parameter to plot:

1. In theReport dialog box, select one of the solution type dependent categories. Some of the
available categories are listed below. The actual list you see will depend upon the solution type
and solution setup for your design.

Variables Intrinsic variables, such as frequency or theta, or user-defined project
variables, such as the length of a quarter-wave transformer.

Output
Variables

Derived quantities from the original field solution.

L or C Capacitance or Inductancematrix entries when thematrix parameter is
defined

Force or
Torque

Force or Torque valueswhen the parameter is defined.

Loss Loss quantities for 2D and 3D transient solutions include: CoreLoss,
EddyCurrentLoss, ExcessLoss, HysteresisLoss, SolidLoss, StrandedLoss,
and StrandedLossR.
NOTE: The availability of solution data for CoreLoss, EddyCurrentLoss,
ExcessLoss, and HysteresisLoss depends on thematerial definitions in the
design.

• If the design is hysteresismodel-based, the solver provides solution data
to plot only for HysteresisLoss, EddyCurrentLoss, and TotalLoss.
• If the design contains a non- hysteresis basedmodel, core lossmodel

type: Electrical Steel, the solver provides solution data to plot for all four
quantities (CoreLoss, EddyCurrentLoss, ExcessLoss, and HysteresisLoss
).
• For all other cases (for example: linear, power ferrite), the solver

provides solution data to plot only for CoreLoss.

Calculator
Expression

User expressions defined in the fields calculator.

2. Select a quantity to plot from theQuantity list. The available quantities depend on the
selected category and the setup of the design.

Selecting a Field Quantity to Plot

When plotting field quantities in theReport dialog box, the quantity can be a value that was
calculated byMaxwell, such as a value from a calculated expression.
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When you select Fields as theReport Type and select a line geometry from theSolutions pull-
down list, three options are available for plotting versus length:

l Plot vs. actual distance along the line (in the units you specified).
l Plot vs. normalized distance.
l Plot vs. actual coordinate values of the line.

Plotting Imported Solution Data

1. In theSolution pull-down list in theReport dialog box, click the imported data you want to
plot.

2. Follow the procedure for creating a report.

Post-Processed Quantities

Both pre-processing and post-processing quantities are available when creating reports.
For example, when you create aMagnetostatic Report for theMagnetostatic Solver the following
are four of the quantities that appear in theCategory list in theReport dialog box:

l L – The post-processed value of inductance (for example, the inductance of a 1-turn coil).
l Lnom – The inductance quantity that is solved with no post processing.
l MagFlux – The post-processed value of the total magnetic flux as seen by the coil (current
source) including all sources (current, magnets, etc.).

l MagFluxNom – The total magnetic flux quantity that is solved with no post processing as
seen by the coil (current source) including all sources (current, magnets, etc.)

Similarly, for an EddyCurrent Report, the following are three of the quantities that appear in the
Category list:

l Winding – If the design includeswindings, Flux Linkage, Induced Voltage, Input Current,
Input Voltage, and Current quantities are available (depending on the winding type). See also
"ViewingWinding Results (EddyCurrent)" on page 23-11 .

l Loss – Hysteresis Loss (Maxwell 2D Eddy current solutions only), Core Loss (Maxwell 3D
Eddy current solutions only), Solid Loss, Stranded Loss, and Stranded LossR. See also
"Viewing LossResults (EddyCurrent) " on page 23-12 .

l End Connection (Maxwell 2D Eddy current solutions only) – Induced Voltage, and Current.
See also "Viewing End Connection Results (2D EddyCurrent)" on page 23-11 .

Setting a Range Function

To apply a range function to the Y, Z, or Mag component of a trace:

Note All range functions are available in the list regardless of solution context. Youmust select a
function that is appropriate for the solution context and data type you are working with.

1. Click theRange Function button in theReports dialog.
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This opens theSet Range Function dialog. The functions available are the same as
described in the Selecting a Function section, with the exception of those for the Eye
Measurements category.

2. Click the Specified radio button on the Range function line.
This enables the Range Function fields.

3. Select theCategory, and then an associated Function to apply. The available categories
depend on the plot, and Category enables the display of associated functions.

Category Functions for the Category
Math max, min, pk2pk, rms, integ, integabs, avgabs, rmsAC, ripple, pkavg,

XatYMin, XatYMax, XatYVal

PulseWidth pulsefall9010, pulsefront9010, pulsefront3090, pulsemax, pulsemaxtime,
pulsemin, pulsemintime, pulsetail50, pulsewidth5050, pw_plus, pw_
plus_max, pw_plus_min, pw_plus_avg, pw_plus_rms, pw_minus_max,
pw_minus_min, pw_minus_avg, pw_minus_rms

Overshoot,
Undershoot

overshoot, undershoot.

TR & DC crestfactor, formfactor, distortion, fundamentalmag, delaytime, risetime,
deadtime, settlingtime,

Error iae, ise, itae, itse

Period per, pmax, pmin, prms

Radiation xdb10bandwidth, xdb20bandwidth, lSidelobeX, lSidelobeY, rSidelobeX,
rSidelobeY

Eye
Measurements

EyeLevelZero, EyeLevelOne, EyeAmplitude, EyeHeight,
EyeSignalToNoise, EyeOpeningFactor, EyeWidth, EyeJitterP2P,
EyeJitterRMS, EyeRiseTime, EyeFallTime

Given a selected Function, and Category, theSet Range Function dialog displays a text field
that explains the Purpose of the function. For a full list of functions and their definitions, see
Selecting a Function.
Selecting a function causes the display of a description in thePurpose field. If the function
requires a value (such as the XatYVal Math function or the pw_minus_maxPulseWidth
function), the table below the function field displays the name, editable value field, unit, and
description.

4. Use theOver Sweep drop downmenu to select from available sweeps.
5. To select from available Sweeps, or to edit them, click the ellipsis [...] button to display a dialog

box that lets you select particular sweep values, specify a range of sweep values (for Time
sweeps). By default,Use all values is selected.
l For sweeps other than Time, uncheckingUse all values enables a list of available sweep
values. You can use the buttons toClear All or Select All sweep values.
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a. Select the SweepsDefault or Edited radio buttons to specify whether to accept the
default or edited sweeps.

b. To edit the sweeps further, select the ellipsis [...] button to display anEdit Sweep dialog
box. For frequency variables, this lets you specify a single value, linear step, linear
count, decade count, octave count, or exponential count. You canAdd legal values to
the list of sweep values,Update the list for changes, orDelete selected entries.

c. When finished selecting/editing sweep values, close the dialog box. The sweep values
you select are displayed on theOver Sweep line.

l For Time sweeps:
a. Select theSpecify range radio button to enable theMin andMax value fields.
b. Enter the desiredMin andMax values, and choose the associated units of measure

from the drop down lists.
c. When finished, close the dialog box. The sweep values you select are displayed on the

Over Sweep line.
6. ClickOK to apply the range function.

Related Topics

Selecting a Function

Eye Measurement Range Function Parameters

The EyeMeasurement category of range functions provide themeans to evaluate several
characteristics of eye diagrams. Each of the EyeMeasurement functions includes the following
parameters. Specify the Value by editing the Value text field for the parameter name. Specify the unit
for the parameter by selecting from the Unit drop downmenu.

Name Default
Value

Default
Unit Description

Unit Interval 0 ns Unit interval of signal
Start Offset 0 ns Offset at beginning of signal
EndOffset 0 ns Offset at end of signal
Autocrossing
amplitude

1 Nonzero number means that crossing amplitude is
calculated automatically.

Crossing
amplitude

0 mV Specify crossing amplitude used for eyemeasurement
data computation.

Perform FFT on a Report

You can perform FFT on an existing 2D plot by using theResults>Perform FFT command. This
opens thePerform FFT on Traces in Reports dialog.

Post Processing andGenerating Reports 23-88
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

1. Select the report you want from the list in the dialog.
2. Select the FFTWindow type from a drop down list.

Select the window type to apply. Windowing functions cause the FFT of the signal to have
non-zero values away fromω. Each window function trades off the ability to resolve
comparable signals and frequencies versus the ability to resolve signals of different strengths
and frequencies.

3. Select the function to apply to complex data.
The new report displays and appears in the Project tree. The new report name prefixes FFT to the
name of the original report. Trace names are also prefixed with FFT.

Related Topics

FFTWindow Functions
Apply FFT to Report Functions
Perform TDR on aReport

FFT Window Functions

Thewindow type list for Perform FFT on Report includes:

Window
Function Preferred Use

Rectangular A low dynamic range function offering good resolution for signals of comparable

strength. Poor when signals have very different amplitudes.w (n )=1
.
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Window
Function Preferred Use

Tri A Bartlett window with the endpoints valued at zero.

Van Hann A moderate dynamic range function, designed for narrow band applications.

Blackman A high dynamic range function, with lower resolution, designed for wide band
applications.
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Window
Function Preferred Use

where a0 =(1-α)/2; α1=1/2; α2=α/2

Hamming A moderate dynamic range function, designed for narrow band applications. It
minimizes themaximum sidelobe.

Lanczos The Lanczoswindow offers a windowed form of the infinite sinc filter, providing the
central lobe of a horizontally-stretched sinc, sinc(x/a) for -a £ x £ a.
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Window
Function Preferred Use

Weber

Welch This approach applies a parabola-shaped window to the frequency domain data. It
is based on the Bartlett method but splits the signal into overlapping segments,
which are then windowed. The intent is to balance the influence of data in the center
of the function.

Related Topics

Perform FFT on a Report
FFTWindow Functions
Apply FFT to Report Functions
Perform TDR on aReport

Apply FFT to Report Functions

The choices include:

ang_deg Angle (phase) of a complex number, cut at +/-180
ang_rad Angle in radians
arg
cang_deg Cumulative angle (phase) of the first parameter (a complex number) in degrees,

along the second parameter (typically sweep variable). Returns a double precision
value cut at +/-180.

cang_rad Cumulative angle of the first parameter in radians along a second parameter
(typically a sweep variable) Returns a double precision value.

dB(x) 20*log10(|x|)
dB
10normalize

10*log [normalize(mag(x))]

dB
20normalize

20*log [normalize(mag(x))]

dBc
im Imaginary part of the complex number
mag Magnitude of the complex number
normalize Divides each value within a trace by themaximum value of the trace. ex. normalize

(mag(x))
re Real part of the complex number
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Related Topics

FFTWindow Functions
Perform FFT on a Report
Perform TDR on aReport

Perform TDR on Report

The idea behind Time-Domain Reflectometry (TDR) is to excite a structure with a step or impulse
function, and inspect the reflections as a function of time. Before you can examine the time domain,
youmust perform a sweep for a transient or eddy current solution. You can perform TDR on an
existing 2D plot by using theResults>Perform TDR on Report command. This opens aPerform
TDR On Traces in reports... dialog.

1. Select the report you want from the list in the dialog.
2. Specify the input signal as Step or Impulse and give the rise time.
3. Select the TDRWindow type from a drop down list.

Select the window type to apply. Windowing functions cause the FFT of the signal to have
non-zero values away fromω. Each window function trades off the ability to resolve
comparable signals and frequencies versus the ability to resolve signals of different strengths
and frequencies.
Youmay choose to specify a window width as a percentage.
If you select the Kaiser function, you can specify a Kaiser number.

The new report displays and appears in the Project tree. The new report name prefixes TDR to the
name of the original report. Trace names are also prefixed with TDR.

Related Topics

Perform FFT on a Report
TimeDomain Plots in Eddy (IFFT)

TDR Windowing Functions

Windowing functions cause the FFT of the signal to have non-zero values away fromω. Each
window function trades off the ability to resolve comparable signals and frequencies versus
the ability to resolve signals of different strengths and frequencies. The window type list
includes:

Window
Function Preferred Use

Rectangular A low dynamic range function offering good resolution for signals of comparable
strength. Poor when signals have very different amplitudes.w(n)=1.
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Window
Function Preferred Use

Bartlett A high dynamic range function, with lower resolution, designed for wide band
applications.

where a0=0.62; a1=0.48; a2=0.38

Blackman A high dynamic range function, with lower resolution, designed for wide band
applications.

where a0 =(1-α)/2; α1=1/2; α2=α/2
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Window
Function Preferred Use

Hamming A moderate dynamic range function, designed for narrow band applications. It
minimizes themaximum sidelobe.

Hanning
(default)

A moderate dynamic range function, designed for narrow band applications.
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Window
Function Preferred Use

Kaiser Selecting the Kaiser plot also enables a field to specify an associated Kaiser
parameter. The larger the Kaiser parameter, the wider the window. The parameter
controls the trade off between width of the central lobe and the area of the side
lobes.

Welch This approach applies a parabola-shaped window to the frequency domain data. It
is based on the Bartlett method but splits the signal into overlapping segments,
which are then windowed. The intent is to balance the influence of data in the center
of the function.

You can use theSave as Default to set the current values as a default, and the Use Defaults
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Spectral Domain Plots in Transient (FFT)

When plotting in the spectral domain, youmust specify the parameters for the Fast Fourier
Transform (FFT). The FFT function used byMaxwell useswindowing; therefore, the user must enter
a start and stop time within which the data is periodic.
To enter the FFT parameters:

1. In theReportwindow, be sure theDomain is set toSpectral.
2. In theContext section of the reporter dialog, clickFFT Options.

The FFT Options dialog appears.
3. Enter theStart Time for the window using the pull-downmenu.
4. Enter theEnd Time using the pull-downmenu.
5. Enter theWindow Type using the pull-downmenu.

The Samples and number of points are calculated based on the chosen start and end values. The
signal must be periodic during the time interval chosen or an error will result.

Related Topics

TimeDomain Plots in Eddy (IFFT)
Online Technical Library:FFT/IFFT Notes

Time Domain Plots in Eddy (IFFT)

When creating time domain plots from frequency domain data, youmust specify the parameters for
the Inverse Fast Fourier Transform (IFFT):

1. In theReportwindow, be sure theDomain is set to Time.
2. In theContext section of the reporter dialog, click IFFT Options.

The IFFT Options dialog appears.
3. In the Input Signal section of the dialog select either Impulse or Step signal to use in

performing the IFFT.
4. For Step signal, input the rise time for the pulse. The rise time should chosen so that the

frequency content is within the bandwidth of the available frequency sweep data.
5. Select theWindow Type from the pull-downmenu.
6. Enter the windowWidth in percent.

TheMaximum Plot Time and theDelta Time are calculated based on the solution data available.

Related Topics

Spectral Domain Plots in Transient (FFT)
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Specifying Output Variables
You can access theOutput Variableswindow in several ways.

l ClickMaxwell3D, Maxwell2D, orRMxprt and then selectResults>Output Variables.
l In the Project tree, right-click onResults and selectOutput Variables from the short-cut
menu.

l In theSolution Setup dialog, select theExpression Cache tab, click theAdd... button to
display theAdd to expression cache dialog, and click theOutput Variables button.

l Click theOutput Variables button theReports dialog.
TheOutput Variables window contains four sections:

l Context section,where you specify the Report type, the Solution, and for appropriate report
types, the Domain. Changing the Report type affects whether the Domainmenu appears, and
may affect the functions listed in the Calculation section.

l Output Variables section, where you can specify the name and expression for a new output
variable. Existing variables appear in the list at the top of the window. Clicking the triangle in
the Name bar inverts the sort order.
At top of theOutput Variableswindow, you can use a check box toValidate output
variable for selected context.

l Calculation section, where you can insert quantities into the Expression area of theOutput
Variables section.

l Function section, where you can insert completed expressions into the Expression area of
theOutput Variables section.

Related Topics

Adding a New Output Variable
Building an Expression Using Existing Quantities
Viewing theOutput Variable Convergence
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Adding a New Output Variable

To add an output variable:
1. ClickMaxwell3D, Maxwell2D, orRMxprt and then selectResults>Output Variables or, in

the Project tree, right-click onResults and selectOutput Variables from the short-cut menu,
or on theModify Report dialog, click the Output Variables button.
TheOutput Variableswindow appears. Variables defined using theResults>Output
Variables command appear in the list at the top of the window.

2. In theOutput Variables section, enter a name for the new variable in theName box.
3. To enter an expression, do one or both of the following:

a. Type part or all of the expression directly in theExpression area. Valid functions appear
in blue. Invalid functions appear in red.

b. Insert part or all of the expression using the options in the Calculation and Function
sections.

4. Optionally, choose toValidate output variables for selected context.
5. ClickAdd to add the new variable to the list.
6. Repeat steps 2 through 4 to add additional variables.
7. When you are finished adding output variables, clickDone to close theOutput Variables

window.

Related Topics

Deleting Output Variables
Building an Expression Using Existing Quantities
Viewing theOutput Variable Convergence

Building an Expression Using Existing Quantities

When you are entering an expression for a new output variable, you can insert part or all of the
expression using the options in theCalculation and Function sections of theOutput Variables
window.
To add an input variable by inserting part or all of the expression:

1. ClickMaxwell3D, Maxwell2D, orRMxprt and then selectResults>Output Variables or, in
the Project Tree, right-click onResults and selectOutput Variables from the short-cut
menu, or on theModify Report dialog, click the Output Variables button.
TheOutput Variableswindow appears.

2. In theOutput Variables section, enter a name for the new variable in theName box.
3. To insert a quantity:

a. From theReport Type pull-down list, select the type of report fromwhich you want to
select the quantity.
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b. From theSolution pull-down list, select the solution fromwhich you want to select the
quantity.

c. From theCategory list, select the type of quantity you want to enter.
d. From theQuantity list, select the quantity or the geometry.
e. From the Function list, select a ready-made function (this option is the same as inserting

the function from the Function section).
f. If applicable, from theDomain list, select the solution domain.
g. Click Insert Into Expression.

The selected quantity is entered into theExpression area of theOutput Variables
section.

4. To insert a function:
a. In the Function section, select a ready-made function from the pull-down list.
b. Click Insert Function into Expression.

The function appears in theExpression area of theOutput Variables section.
5. When you are finished defining the variable in theExpression area, clickAdd to add the new

variable to the list.
6. Repeat steps 2 through 5 to add additional variables.
7. When you are finished adding output variables, clickDone to close theOutput Variables

window.
Note Remember the evaluated value of an expression is always interpreted as in SI units.

However, when a quantity is plotted in a report, you have the option to plot values in
units other than SI.

Related Topics

Adding a New Output Variable
Building an Expression Using Existing Quantities

Function List for Output Variables

TheOutput Variables dialog includes a second function list containing functions to enter directly into
the Expression field. These functions can also be applied to previously specified Quantities and
Functions.
Some of these functions can operate along an entire curve. These are: deriv, min, max, integ, rms,
pk2pk, cang_deg and cang_rad. These functions have syntax as follows:

l deriv(quantity) implicitly implies derivative over the primary sweep
l deriv(quantity, SweepVariable) explicitlymeans derivative over the sweep variable specified
in the second argument (such as "Freq").

You can select from the following functions in theOutput Variables dialog Function list, or type
them directly into the Expression field, if necessary:

abs Absolute value
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acos Arc cosine
acosh Hyperbolic arc cosine
ang_deg Angle (phase) of a complex number, cut at +/-180
ang_rad Angle in radians
arg Argument of a complex number. It is the angle the complex number makeswith

the positive x axis. Same as ang_deg.
asin Arc sine
asinh Hyperbolic arc sine
atan Arc tangent. Takes a tangent value as an argument. Because there are two

angles in a circle that can have the same tangent value, and atan can return only
one value, it returns a value in the range between -90 degrees and +90 degrees
(or between -pi/2 and pi/2 in radians).

atan2(y,x) A two-argument version of the atan function. Takes the y and x coordinates
(including sign information) of a point as arguments and returns the angle from
the X-axis. Can return angle values for the full circle (-180 degrees to +180
degrees or -pi to +pi in radians).

atanh Hyperbolic arc tangent
avgabs Absolute value of average.
cang_deg Cumulative angle (phase) of the first parameter (a complex number) in degrees,

along the second parameter (typically sweep variable). Returns a double
precision value cut at +/-180.

cang_rad Cumulative angle of the first parameter in radians along a second parameter
(typically a sweep variable) Returns a double precision value.

cmplx(re, im)
A complex number, where re is the real part and im is the imaginary part.

conjg Conjugate of the complex number.
cos Cosine
cosh Hyperbolic cosine
crestfactor Peak/RMS (root mean square) for the selected simulation quantity
dB(x) 20*log10(|x|)
dB10 10*log(|x|) to base 10.
dBm(x) 10*log10(|x|) +30
dBW(x) 10*log10(|x|)
dBc Decibels relative to the carrier. It is the power ratio of the signal to a carrier signal.

Gives the relative signal strength.
db10normalize 10*log [normalize(mag(x))]
db20normalize 20*log [normalize(mag(x))]
degel Conversion from degrees electrical to secondswith respect to Hz.
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deriv Derivative of first parameter over second parameter.
even Returns 1 if integer part of the number is even; returns 0 otherwise
exp Exponential function (the natural anti-logarithm)
if if(cond_exp,true_exp, false_exp).
im Imaginary part of the complex number
int Truncated integer function
j0 Bessel function of the first kind (0th order)
j1 Bessel function of the first kind (1st order)
ln Natural logarithm
log Natural logarithm (same as ln).
log10 Logarithm base 10
mag Magnitude of the complex number
mod Returns themodulus or absolute value of the simulation quantity.
nint Nearest integer
normalize Divides each value within a trace by themaximum value of the trace. ex.

normalize(mag(x))
odd Returns 1 if integer part of the number is odd; returns 0 otherwise
polar Converts the complex number in rectangular to polar
pow Raise x to y power., pow(x,y).
pwl Piecewise Linear
pwl_periodic Piecewise Linear for periodic extrapolation on x
pwlx Piecewise Linear x with linear extrapolation on x.
re Real part of the complex number
rect Converts the complex number in polar to rectangular
rem Fractional part
root Take the y root of x, root(x,y)
sgn Sign extraction
sin Sine
sinh Hyperbolic sine
sliding mean slidingmean.
slidingrms sliding root mean square
sqr Square.
sqrt Square root
tan Tangent
tanh Hyperbolic tangent
y0 Bessel function of the second kind (0th order)
y1 Bessel function of the second kind (1st order)
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yn Bessel function of the second kind (nth order)

Related Topics

Adding Trace Characteristics
Set Range Function

Deleting Output Variables

To delete output variables:
1. Remove all references to the output variable in the project.
2. Save the project to erase the command history.
3. ClickMaxwell3D,Maxwell2D orRMxprt, and then selectResults>Output Variables or, in

the Project Tree, right-click onResults and selectOutput Variables from the short-cut
menu, or on theModify Report dialog, click theOutput Variables button.
This opens the Output Variables dialog.

4. Select the variable and click theDelete button.
5. ClickOK to close the dialog.

Related Topics

Adding a New Output Variable

Report Data
The follow sections describe how you can view, update, export, import, override, and delete various
values used for display in plots and reports.
The topics for this section include:
Updating Reports (Post-Processing Data)
Deleting Reports
Exporting Plot Data
Importing 2D Plot Data
Report File Formats
Exporting Graphics Files from a Plot
Plotting Imported Solution Data
Setting a Range Function
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Updating Reports (Post-Processing Data)

Tomanually update the report that is active in the design area using the latest simulation results,
right-click in the report and selectUpdate Report from themenu. Alternatively, you can right-click
on the report underResults in the Project Manager and selectUpdate Report from the context
menu.
If you wish to update all reports in the design, selectMaxwell 2D (or Maxwell
3D)>Results>Update All Reports. Alternatively, right-click on theResults icon in the Project
Manager and selectUpdate All Reports from themenu.

Deleting Reports
l To delete a single report, right-click on the report in theResults section of theProject
Manager window for the design, and clickDelete on themenu.
Warning Solution data that have been deleted cannot be

recovered!

l To delete all reports, either selectMaxwell 2D (or Maxwell 3D orRMxprt)>Results>Delete
All Reports, or right-click on theResults icon in theProject Manager window for the
design, and clickDelete All Reports on the pop-upmenu.
Warning Deletions occur as soon as you click this button and cannot be undone. If you

change your mind while in this window, clickCancelBEFORE clickingDo
Deletions.

Opening Reports
l To open a single report, right-click on the report in theResults section of theProject
Manager window for the design, and clickOpen Report on themenu.

l To open all reports, either selectMaxwell 2D (or Maxwell 3D)>Results>Open All Reports,
or right-click on theResults icon in theProject Manager window for the design, and click
Open All Reports on the pop-upmenu.

Exporting Reports

You can export reports in a variety of text and graphic formats. Youmust have an existing plot open
to see the corresponding Report2D or Report3D menu.

1. ClickReport2D orReport 3D on the topmenu, and then selectExport. Alternatively, right-
click on the plot, and then clickExport ... on the shortcut menu.
TheExport Report dialog box opens.

2. Use the file browser to find the directory where you want to save the file.
3. Type the name of the file in the File name box.
4. Select one of the following file formats from theSave as type pull-down list:
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l *.csv – Comma delimited data files.
l *.tab – Tab delimited data files.
l *.dat – Ansoft PlotData files (2D reports only).
l *.txt – Post processor format files (2D reports only).
l *.rdat – Ansoft Report Data format files.
l *.emf –Microsoft EMF files.
l *.gif –Graphics Interchange Format files.
l *.bmp – Bitmap files.
l *.wrl – Virtual RealityModeling Language (VRML) files.
l *.tif, *.tiff – Tagged Image File Format files.
l *.jpg, *.jpeg – Joint Photographics Experts Group files.

5. Optionally, for 2D reports, you can choose to Export UniformPoints, which enables fields in
which you can specify the start, stop, and step values and units to output uniformly spaced
point data.

6. ClickSave to export the report to the specified location in the selected data or graphical
format.

Related Topics

Importing 2D Plot Data
Creating a Report from aReport Data File
Report File Formats

Importing 2D Plot Data

To import 2D plot data to a report:
1. Left-clickReport2D on the topmenu, and then select Import Data.

TheOpen dialog box opens.
2. Browse to the directory where the data file is located.
3. Select the file format from the Files of type drop-down. Options include:

l *.csv – Comma delimited data files.
l *.tab – Tab delimited data files.
l *.dat – Ansoft PlotData files.
l *.txt – Post processor format files.
l *.rdat – Ansoft Report Data files.
For more information, see Report File Formats.

1. Select the filename.
2. ClickOpen to import and plot the data, or clickCancel to close the dialog boxwithout

importing any data.
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Related Topics

Exporting Reports
Creating a Report from aReport Data File
Report File Formats

Report File Formats

The following table provides information about the file formats that can be imported into plot data
reports:

File
Extension Information

csv l Uses a comma (,) as the separation character.
l The x-axis value is in the first column. Each curve’s Y-valuesmake up one
column, and the curves are in the same order as in the plot legend.

l The first row is the X-axis name [unit] and the information for each curve, which
is the same as the plot curve legend.

l Other rows are the X-axis value and the Y-value for each curve.

tab l Uses the tab character as the separation character.
l The x-axis value is in the first column. Each curve’s Y-valuesmake up one
column, and the curves are in the same order as in the plot legend.

l The first row is the X-axis name [unit] and the information for each curve, which
is the same as the plot curve legend.

l Other rows are the X-axis value and the Y-value for each curve.

txt l The txt file must begin with a header that contains the following:
• A first linemade of 92 equal signs (=)
• A second line that begins with the company name and endswith the date in

MM/DD/YY format
• A third line that begins with a plot name and endswith the time in hh:mm:ss

format
• A fourth line, which is empty
• A fifth linemade of 92 hyphens (-)

Note: Each header linemust be 92 characters in length, except the empty line.
l Each column has a fixed width, separated bywhite space.
l The x-axis value is in the first column. Each curve’s Y-valuesmake up one
column, and the curves are in the same order as in the plot legend.

l The first row is the X-axis name [unit] and the trace name [unit] for each curve,
which is the same as the plot curve legend.

l The second row is an empty column and the variable values for each curve,
which is the same as the plot curve legend.
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File
Extension Information

l Other rows are the X-axis value and the Y-value for each curve.

dat DAT is an ANSYS-specific format. ANSYS recommends that you do not generate
files using this format. Files imported with these formats should be exported only from
ANSYS products.

rdat RDAT is an ANSYS-specific format. ANSYS recommends that you do not generate
files using this format. Files imported with these formats should be exported only from
ANSYS products.

Related Topics

Importing 2D Plot Data
Exporting Reports

Exporting Reports as Graphics

You can export reports as figures in several formats. Youmust have an existing plot open to see the
Report2D or Report 3D menu.
To export a graphics file:

1. On theReport 2D orReport3D menu, clickExport.
TheExport Report dialog box opens:

2. Click theBrowse... button to open the Export Report browser window.
3. Specify the file location and name, and select a graphics format from the dropdown list.
4. Select the desired graphics file format from the Save as type drop-down list.
l *.jpg – Joint Photographics Experts Group files.
l *.gif –Graphics Interchange Format files.
l *.bmp – Bitmap files.
l *.tiff – Tagged Image File Format files.
l *.wrl – Virtual RealityModeling Language (VRML) files.
5. ClickSave. The file is exported to the specified location as a graphics file.

Related Topics

Exporting Reports

Copying Reports to the Clipboard as Images

You can copy images of reports to the clipboard, so that they can be pasted into other applications as
follows:
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1. Make the report the active window. Alternatively, for a plot-on-schematic, click on the plot to
select it.

2. ClickEdit>Copy Image, or right-click on the report window or plot-on-schematic and select
Copy Image on the context menu to copy the report to the clipboard as an image.

3. Open the application into which you want to paste the image, and paste the image.

Related Topics

Copy and Paste of Report and Trace Data
Copy and Paste of Report and Trace Definitions

Plotting Field Overlays
Field overlays are representations of basic or derived field quantities on surfaces or objects for the
current design variation. You can set the design variation via theSet Design Variation dialog. This
dialog box is accessible from theSolution Data window via by clicking the ellipsis button on the right
of the Design Variation field, and via theResults>Apply Solved Variation command.
To plot a basic field quantity:

1. Select a point, line, surface, or object to create the plot on or within. Youmay also select a
plane or object list in theHistory Tree.
Note For 2D Designs, a plane selectionmust be consistent with the drawing plane or an

error will result.

If it does not exist, create it.
2. ClickMaxwell3D or Maxwell2D and then select Fields>Fields.

A submenu appears.
3. On the Fields submenu, click the field quantity you want to plot.

If you select a scalar field quantity, a scalar surface or volume plot is created. If you select a
vector field quantity, a vector surface or volume plot is created. If the quantity you want to plot
is not listed, seeCalculating a Derived Field Quantity.
For projects with Temperature dependent materials, the Maxwell>Fields>Fields>Other...
menus selections include Temperature.
After you select the field quantity to plot, theCreate Field Plot dialog box appears.
The Specify Name field shows a name based on the field quantity you selected, and the
Quantity list shows the field quantity selected.

4. To specify a name for the plot other than the default, selectSpecifyName, and then type a
new name in theName box.

5. To specify a folder other than the default in which to store the plot, selectSpecify Folder, and
then click a folder in the pull-down list. Plot folders are listed under Field Overlays in the
project tree.
Note All plots (field overlays) in the same folder have the same scale settings. To plot the
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same field with a different scale, you can create or move the new plot to a separate
folder. By default, current density plots are stored in a folder called J, but you can
specify a different or new folder. Plots in different folders have a different plot keys.

6. Select the solution to plot from theSolution pull-down list.
7. Select the field type to plot in the Field Type pull-down list.
8. Under Intrinsic Variables, select the time at which the field quantity is evaluated.
9. Select the field quantity to plot from theQuantity list.
10. Select the volume or surface (region) in which to plot the field from the In Volume list.

This selection enables you to limit plots to the intersection of a volumewith the selected object
or objects. You can select and deselect any items in the In Volume list. You canmixmodel
objects with non-model boxes. For example youmight want to see a plot from part of two
model objects by restricting the region to a non-model box overlapping those parts.

Note Multiple selection should be used when there is a discontinuous field on a surface. If not,
the field on both sides of the surface is plotted and each interfereswith the other.

Note l Non-convex 3D non-model solids are not supported for Field Overlay Plots and
Fields Calculator computations.

l Object lists containing non-model object(s) are supported for Field Overlay Plots but
are not supported for Fields Calculator computations.

11. If you selected a vector quantity, you can use the check box to selectStreamline plot.
Streamlines are often used to indicatemagnetic flux lines, etc. in plots.

Note l Before creating the Streamline plot, select both starting and ending edges (in 2D) or
both surfaces (in 3D).

l In theCreating Field Plot dialog box, select In Volume: region, which is the region
in which the streamlineswill appear. Streamlines are outside of objects that are
excited (sources).

l To show more streamlines after the plot is created, on theModify attributes...
dialogPlots tab, reduce theSeeds density value. If no streamlines appear, reduce
this by a factor of 10 (or 100) because the default seeding was too large. See Setting
Field Plot Attributes for adjusting the Streamline display parameters.

See Setting Fields Reporter Options for setting Streamline defaults.
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12. Optionally, youmay select thePlot on surface only check box to obtain a plot around the
outside edge of selected objects.

13. ClickDone.
The field quantity is plotted on the surfaces or within the objects you selected. The plot uses
the attributes specified in thePlot Attributes dialog box.
The new plot appears in the view window. It is listed in the specified plot folder in the project
tree. If you have created a field plot on a simulation in progress, the field plot is updated after
the last adaptive solution.
If you want to update the field overlay before then, to view progress in the solution, select the
Field icon in the Project tree that contains the field plot of interest, right-click to display the
short cut menu, and selectUpdate Plots.
To turn off the display of the plot, right click on the plot and selectPlot Visibility from the
short-cut menu. UncheckingPlot Visibility turns off the plot display.

Related Topics

Plotting Standard Field Quantities
Plotting Derived Field Quantities
Creating 2D Reports FromNamed Expressions
Calculating a Derived Field Quantity
Named Expressions
Creating Reports
Using the Fields Calculator
Setting a Plot’s Visibility

Plotting Standard Field Quantities

Maxwell makes numerous quantities available for field plotting derived directly from the field solution.
The quantities available depend upon the solution type (magnetostatic, eddy current, etc), on the
design type (3D or 2D) and other parameters such as the use of lossymaterials. The chart below
lists the possible solution quantities available when usingMaxwell3D>Fields>Fields, or
Maxwell2D>Fields>Fields.

Description Quantity 2D 3D
Vector Potential Flux_Lines, A_

Vector
Magnetostatic, Eddy
Current, Transient

Magnetic Field
Intensity

Mag_H,
ComplexMag_H, H_
Vector

Magnetostatic, Eddy
Current, Transient

Magnetostatic, Eddy
Current, Transient
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Description Quantity 2D 3D
Magnetic Flux
Density

Mag_B,
ComplexMag_B,B_
Vector

Magnetostatic, Eddy
Current, Transient

Magnetostatic, Eddy
Current, Transient

Current JatPhase, Mag_J,
ComplexMag_J, J_
Vector, Jphi, Jz

Magnetostatic, Eddy
Current, Transient,
ACConduction,
DCConduction

Magnetostatic, Eddy
Current, Transient,
DCConduction, Electric
Transient

Electric Flux
Density

DatPhase, Mag_D,
ComplexMag_D, D_
Vector

EddyCurrent,
Electrostatic,
ACConduction

EddyCurrent,
Electrostatic,
DCConduction, Electric
Transient

Electric Field
Intensity

Mag_E,
ComplexMag_E, E_
Vector

Electrostatic,
ACConduction,
DCConduction

EddyCurrent,
Electrostatic,
DCConduction, Electric
Transient

Surface Charge
Density

QSurf Electrostatic,
DCConduction, Electric
Transient

Surface Current
Density
(on an
impedance
boundary)

Jsurf EddyCurrent

Voltage Voltage Electrostatic,
ACConduction,
DCConduction

Electrostatic,
DCConduction, Electric
Transient

Energy in the
Field
Electric
Magnetic

energy Magnetostatic, Eddy
Current, Transient,
Electrostatic

Magnetostatic, Eddy
Current, Transient,
Electrostatic,
DCConduction, Electric
Transient

Magnetic
CoEnergy

coEnergy Magnetostatic, Eddy
Current, Transient

Magnetostatic, Transient

appEnergy Magnetostatic, Eddy
Current, Transient

Magnetostatic, Transient

Ohmic Loss Ohmic_Loss Magnetostatic, Eddy
Current, Transient,
Electrostatic,
ACConduction,
DCConduction

Magnetostatic, Eddy
Current, Transient,
DCConduction, Electric
Transient
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Description Quantity 2D 3D
Total Loss Total_Loss Transient (Magnetic)

Hysteresis Loss Hysteresis_Loss EddyCurrent EddyCurrent

Dielectric Loss Dielectric_Loss EddyCurrent EddyCurrent

Surface Loss
Density

SurfaceLossDensity EddyCurrent

Edge Force
Density

edgeForceDensity Magnetostatic, Eddy
Current (DC component
only), Transient,
Electrostatic

Temperature Temp Magnetostatic, Eddy
Current, Electrostatic

Magnetostatic, Eddy
Current, Electrostatic

Surface Force
Density

surfaceForceDensity Magnetostatic, Eddy
Current (DC component
only), Transient,
Electrostatic

Magnetostatic, Eddy
Current (DC component
only), Transient,
Electrostatic, Electric
Transient

Volume Force
Density

volumeForceDensity Magnetostatic, Eddy
Current, Transient,
Electrostatic, Electric
Transient

Displacement Displacement_
Vector, Mag_
Displacement

Magnetostatic, Eddy
Current, Electrostatic

Magnetostatic, Eddy
Current, Electrostatic

Sum of Ohmic,
Hysteresis, and
Dielectric Loss

emloss EddyCurrent

Loss on
Impedance
boundary
applied to a
conductor

edgeLossDensity EddyCurrent

Related Topics

Plotting Derived Field Quantities
Creating 2D Reports FromNamed Expressions
Calculating a Derived Field Quantity
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Named Expressions
Creating Reports
Using the Fields Calculator

Force Density Quantities

Edge
Force
Density

The edge density is available only in Maxwell2D. It is available only on object outlines
adjacent to air or vacuum space. It is defined as:

whereB andE are themagnetic flux density and electric field intensity at themidpoint of
the edge, respectively, and n is the outward normal direction of the edge. For
electrostatic, AC, and DC solvers, only the electric field is included; while for
magnetostatic, Eddy current, andmagnetic transient solvers, only themagnetic field is
considered. For AC solver and Eddy current solver, edge force density is the averaged
(DC) force density.

Surface
Force
Density

In Maxwell2D, surface force density is defined as:

where N is the number of sides of the element, li is the length of side i of the element. For
the RZ case, ri and rc are the radius of side i and the radius of the element center,
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respectively. and are the permeability and permittivity in the ith neighboring element.
In the XY plane, ri and rc are set to 1.
In Maxwell3D, surface force density is only available on object faces adjacent to air or
vacuum space. It is defined as:

whereB andE are themagnetic flux density and electric field intensity at the center of the
surface face, respectively, and n is the outward normal direction of the surface face. For
electrostatic, AC, and DC solvers, only the electric field is included; while for
magnetostatic, Eddy current, andmagnetic transient solvers, only themagnetic field is
considered. For AC solver and Eddy current solver, surface force density is the averaged
(DC) force density.

Volume
Force
Density

Volume force density is only available in Maxwell3D. It is calculated as:

and are the permeability and permittivity in the ith neighboring element.Ai is area of
side i of element. For electrostatic, AC, and DC solvers, only the electric field is included;
while for magnetostatic, Eddy current, andmagnetic transient solvers, only themagnetic
field is considered. For AC solver and Eddy current solver, volume force density is the
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averaged (DC) force density.
Lorentz force density is calculated instead of volume force density fromEquation (7) in
pure conductors containing source current in magnetostatic, Eddy current, andmagnetic
transient solvers:

Loss Quantities

Ohmic
loss

Ohmic loss is always associated with conduction current distribution in conductors
which are not perfect. Thus the resistivity of conductors is responsible for the ohmic
power losswhen current flows in such conductors. It is also called the Joule-Lenz
effect. There is always a heating effect due to the ohmic loss, often called Joule
heating.

Total loss
Total loss is associated with loss density fields in 2D and 3D magnetic transient
solutions only. Total loss uses the total integrated loss output from the solver and
averages it over two consecutive times.

Hysteresis
loss

Hysteresis loss is associated with loss density fields in 2D and 3D eddy current
solutions only. Hysteresis loss is short for magnetic hysteresis loss and represents
power loss in somemagneticmaterials (electric steels or ferrites) in alternating
(sinusoidal) magnetic fields. This loss is due to a phenomenon called "magnetic
viscosity" which causes the B and H fields to have a phase shift between them. In the
B-H plane, for linear materials, the relationship between these two fields describes
an ellipse. The hysteresis loss is proportional to the area of the ellipse.

Dielectric
loss

Dielectric loss is associated with loss density fields in 2D and 3D eddy current
solutions only. Dielectric loss or electric hysteresis loss represents power loss in
ferroelectricmaterials (such as barium titanate, lead zirconate titanate) in alternating
(sinusoidal) electric fields. This loss is due to a phenomenon called "electric viscosity"
which causes the D and E fields to have a phase shift between them. In the D-E
plane, for linear materials, the relationship between these two fields describes an
ellipse. The dielectric loss is proportional to the area of the ellipse.

SurfaceLoss
Density

The surface loss density is associated with the induced eddy current on the
impedance boundary.

Emloss
(2D Eddy)

In 2D eddy emloss combines the ohmic loss, dielectric loss and hysteresis loss.

Edgeloss
density

Edge loss density represents losses associated with impedance boundary applied
on conductive surfaces on the boundary of the solution domain or on surface of
excluded objects. It assumes an exponential spatial decay (towards the interior of
the respectivematerial) of induced current magnitudes and of associated losses.
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Integrating the loss along the edge produces the entire loss associated with the
"edge".

Core
loss

The core loss combines eddy current losses and hysteresis losses for a transient
solution type. It is a post-processing calculation, based on already calculated
transient magnetic field quantities. It is applicable for the evaluation of core losses in
steel laminations (frequently used in applications such as electricmachines,
transformers) or in power ferrites.

Solid
Loss

The solid loss represents the resistive loss in a 2D or 3D volume and is calculated by:

For 2DXY designs, the length is given bySet Model Depth, while forRZ designs
the volume is based upon the rotation of the cross section around the symmetry axis.

Stranded
Loss

There are two types of stranded loss quantities,StrandedLoss and
StrandedLossR:

l StrandedLoss represents the resistive loss in a 2D or 3D volume and is
calculated by:

where J is the conductivity of thematerial. (Reported for a stranded voltage or
current source using an external circuit; assumeswinding fill factor = 100%.)

l StrandedLossR represents the loss based on I2 times the resistanceR
(Reported for a stranded voltage source not in an external circuit.)

Named Expressions

Named expressions can contain any combination of scalar, vector, or geometry functions.When you
plot a field overlay or create a report based on a named expression, only corresponding quantities
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are available.
For example, if you select a point for theGeometry and aCategory that is a named expression
based on the point (or other scalar, non-3D value), then theQuantity list only lists expressions that
returns a single scalar value. If you have added named expressions that take themagnitude of the
ScalarX(), ScalarY(), or ScalarZ() of a vector point value, then you can create output variables for
those expressions only in this case.
Named expressions can be plotted in the following three ways:
To create a field overlay of a named expression, the expressionmust be a real value (scalar or
vector) that has values everywhere in space (or at least on every point in the geometry you plan to
use for the field overlay).
To create a 2D report from a named expression that evaluates in the Fields Calculator as a single
scalar value, the expressionmust result in a single-valued, real, scalar value. A single-valued item
could be the value on a single point in space or the result of a function that returns a single value
(such as an integration, max/value, min/value, or other function).
To create a 2D report from a named expression that is evaluated (in the Fields Calculator) along a
polyline, the expressionmust be a real scalar that has values everywhere in space (or at least
everywhere on the line object you want to use to sample the values).
Named expressions can be created in the Fields Calculator.

Plotting Derived Field Quantities

Derived field quantities are field quantity representations that have been deduced from the original
field solution using the Fields Calculator.

1. Select a point, line, surface, or object to create the plot on or within. Youmay also select a
plane or object list in theHistory Tree.
Note For 2D Designs, a plane selectionmust be consistent with the drawing plane or an

error will result.

If it does not exist, create it.
2. ClickMaxwell3D or Maxwell2D and select Fields>Fields>Named Expression.

TheSelecting calculated expression dialog box appears.
3. Select the derived quantity you want to plot, and then clickOK.

TheCreate Field Plot dialog box appears.
4. To specify a name for the plot other than the default, selectSpecifyName, and then type a

new name in theName box.
5. To specify a folder other than the default in which to store the plot, selectSpecify Folder, and

then click a folder in the pull-down list. Plot folders are listed under Field Overlays in the
project tree.

6. Select the solution to plot from theSolution pull-down list.

Post Processing andGenerating Reports 23-117
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

7. Select the derived field quantity to plot from theQuantity list.
Note If you select a point for theGeometry and aCategory that is a named expression

based on the point (or other scalar, non-3D value), then theQuantity list only lists
expressions that returns a single scalar value. If you have added named expressions
that take themagnitude of the ScalarX(), ScalarY(), or ScalarZ() of a vector point
value, then you can create output variables for those expressions only in this case.

Note If you select a polyline for theGeometry and aCategory that is a named
expression based on the line, then theQuantity list only lists corresponding
expressions (i.e., will not list scalar valueswhen a line is selected as the geometry).

8. Select the volume or surface (region) in which to plot the field from the In Volume list.
This selection enables you to limit plots to the intersection of a volume and the selected object.

9. ClickDone.
The derived field quantity you created in the Fields Calculator is plotted on the surfaces or
objects you selected. The new plot is listed in the project tree under Field Overlays.

Creating 2D Reports From Named Expressions

You can create a 2D report from named expressions that evaluate as a single scalar value or that
evaluate along polylines.
To create a report from a named expression evaluating as a single scalar value:

1. ClickMaxwell2D or Maxwell3D>Results>Create Report.
TheCreate Report dialog box appears.

2. In the Target Design pull-down list, click the design containing the solution data you want to
plot.

3. Select Fields from theReport Type pull-down list.
4. In theDisplay Type pull-down list, select the type of report you want to create.
5. ClickOK.

The Traces dialog box appears.
6. In theSolution pull-down list, click the solution containing the data you want to plot.
7. Add one or more traces to include in the report.

Note If you select a point for theGeometry and aCategory that is a named expression
based on the point (or other scalar, non-3D value), then theQuantity list only lists
expressions that returns a single scalar value. If you have added named expressions
that take themagnitude of the ScalarX(), ScalarY(), or ScalarZ() of a vector point
value, then you can create output variables for those expressions only in this case.

8. ClickDone.
The report appears in the view window and is listed in the project tree. Once you have created
a report, additional options become available on theResults submenu.

To create a report from a named expression evaluating along a polyline:
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1. ClickMaxwell3D, Maxwell2D or RMxprt and select Results>Create Report.
TheCreate Report dialog box appears.

2. In the Target Design pull-down list, click the design containing the solution data you want to
plot.

3. Select Fields from theReport Type pull-down list.
4. In theDisplay Type pull-down list, select the type of report you want to create.
5. ClickOK.

The Traces dialog box appears.
6. In theSolution pull-down list, click the solution containing the data you want to plot.
7. Select the geometry you want to plot from theGeometry pull-down list.
8. Add one or more traces to include in the report.

Note If you select a polyline for theGeometry and aCategory that is a named
expression based on the line, then theQuantity list only lists corresponding
expressions (i.e., will not list scalar valueswhen a line is selected as the geometry).

9. ClickDone.
The report appears in the view window and is listed in the project tree. Once you have created
a report, additional options become available on theResults submenu.

Creating Scalar Field Plots

A scalar plot uses shaded colors or contoured lines to illustrate themagnitude of field quantities on
surfaces or volumes.

1. Do one of the following:
a. To create a scalar surface plot, select the faces on which you want to plot the fields.
b. To create a scalar volume plot, select the objects within which you want to plot the fields.

2. ClickMaxwell3D or Maxwell2D and then select Fields>Fields.
3. On the Fields submenu, click the scalar field quantity you want to plot.

TheCreate Field Plot dialog box appears.
4. Follow the procedure for plotting field overlays.

The new plot is listed in the specified plot folder in the project tree.

Related Topics

Modifying Field Plot Attributes

Working with Scalar Field Plot Markers

The field overlay plot marker feature enables you to create amarker at selected points in the scalar
field overlay plot geometry, and to obtain the field value at that point. The fieldsMarker sub-menu
enables you to:
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l AddMarker
l DeleteMarker
l Export Marker Table
l Clear All markers
l Edit Marker

Adding a Field Plot Marker

To add one or more field plot markers to a scalar field:
1. On themainmenu clickMaxwell3D or Maxwell2D and then select

Fields>Fields>Marker>AddMarker. Alternatively you can right-click anywhere in the
modeler window, or on the Field Overlays folder icon in the Project Manager, and select
Fields>Marker>AddMarker.
TheMeasure Data dialog box opens and a round dot appears at the tip of the cursor.

2. Drag the dot over the spot on the field overlay plot where you want to add amarker. The
Measure Data dialog shows detailed information for the spot currently under the dot.
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3. Click the desired point in the field overlay plot to add themarker at that location. Alternatively
you can select the position of themarker by entering the valuesmanually in the edit fields at
the bottom of the window as shown below.

A table showing themarker coordinates and associated field value is also created and added
to themodeler window.

4. Repeat as desired to add additional markers.
5. Press theEsc keywhen finished addingmarkers.

Deleting a Field Plot Marker

To delete a field plot marker:
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1. Click on themarker you want to delete to select it. The row corresponding to the selected
marker will be highlighted in themarker table.
Press and hold theCtrl key and click to select multiple markers.

2. On themainmenu clickMaxwell3D or Maxwell2D and then select
Fields>Fields>Marker>Delete Marker to delete the selectedmarker(s).
– Alternatively you can right-click anywhere in themodeler window, or on the Field Overlays
folder icon in the Project Manager, and select Fields>Marker>Delete Marker.
– You can also simply press theDelete key to delete the selectedmarker(s).

Exporting a Field Plot Marker Table

You can export a field plot marker table to either a comma- or tab-delimited file as follows:
1. On themainmenu clickMaxwell3D or Maxwell2D and then select

Fields>Fields>Marker>Export Marker Table.
Alternatively you can right-click anywhere in themodeler window, or on the Field Overlays
folder icon in the Project Manager, and select Fields>Marker>Export Marker Table.

2. In theExport As dialog box, choose the export format, either .csv or .tab, and save the file in
the desired location.
The exported file can then be imported into another application such as a spreadsheet.

Clearing All Field Plot Markers

To clear all field plot markers in the activemodeler window do one of the following:
l On themainmenu clickMaxwell3D or Maxwell2D and then select
Fields>Fields>Marker>Delete All.

l Alternatively you can right-click anywhere in themodeler window, or on the Field Overlays
folder icon in the Project Manager, and select Fields>Marker>Delete All.

Deleting all themarkers also removes themarker table.
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Editing Field Plot Markers

To edit field plot markers:
1. On themainmenu clickMaxwell3D or Maxwell2D and then select

Fields>Fields>Marker>Edit Marker.
Alternatively you can right-click anywhere in themodeler window, or on the Field Overlays
folder icon in the Project Manager, and select Fields>Marker>Edit Marker.

2. Click on themarker you wish to edit. The row corresponding to the selectedmarker is
highlighted in themarker table. The properties of themarker are displayed in the Properties
window.

3. You can changePosition of the selectedmarker by editing its coordinate values. Themarker
table changes to reflect the new value. You can also click theColor value bar to select a new
color for themarker.

4. Optionally, press theDelete key to delete themarker and its corresponding entry in the
marker table.

5. When finished editingmarkers, pressEsc to exit themarker editing function.

Creating Vector Field Plots

A vector plot uses arrows to illustrate themagnitudes of the x-, y-, and z-components of field
quantities. Vector plots can be created on surfaces or volumes.

1. Do one of the following:
a. To create a vector surface plot, select the faces on which you want to plot the fields.
b. To create a vector volume plot, select the objects within which you want to plot the fields.

2. ClickMaxwell3D or Maxwell2D and then select Fields>Fields.
3. On the Fields submenu, click the vector field quantity you want to plot.
4. Follow the procedure for plotting field overlays.

Note If you select a vector quantity, you can also check Streamline for the
plot.

Related Topics

Modifying Field Plot Attributes
Plotting Field Overlays
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Modifying Field Plots

1. ClickMaxwell3D or Maxwell2D and then select Fields>Modify Plots , or in the
Project tree, select the Field Overlays icon, right-click, and selectModify Plots or use the
"m" hotkey.
TheSelect Field Plot(s) dialog box appears.

2. Select the plot you want to modify from theSelect column, and then clickOK.
TheModify Field Plot dialog box appears.

3. Optionally, click a different solution to plot from theSolution pull-down list.
4. Optionally, click the Specify Name check box to enable the name field.
5. Optionally, specify a different folder in which to store the plot.
6. Optionally, select a different field quantity to plot from theQuantity list.

l To choose a calculated expression, selectCalculator from theCategory pull-down list.
l To choose a default field quantity, selectStandard from theCategory pull-down list.

7. Under Intrinsic Variables, specify the time at which the field quantity will be evaluated.
8. Select the volume, or region, in which the field is to be plotted from the In Volume list.

This selection enables you to limit plots to the intersection of a volume and the selected object.
9. ClickApply, and then click Done.

The field quantity is plotted on the surfaces or within the objects you selected. The new plot is
listed in the specified plot folder in the project tree.
The plot uses the attributes specified in thePlot Attributes dialog box.

Related Topics

Setting a Plot’s Visibility
Add Trace Characteristics
Setting Field Plot Attributes

Setting Field Plot Attributes

After creating a vector or scalar field overlay on a surface or volume, you canmodify its appearance
by changing the settings in thePlot Attributes dialog box.When youmodify the settings for a plot
folder, all plots in that folder aremodified with the same attributes.

1. ClickMaxwell3D or Maxwell2D and select Fields>Modify Plot Attributes , or in the
Project Manager window, select the Field Overlays icon, and selectModify Attributes.
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TheSelect Plot Folder window appears.
2. Select the field plot folder you want to modify, and then clickOK. You can also select the

specific plot in the Project tree, and selectModify Attributes from the right clickmenu. (For
mesh plots, refer toSettingMesh Plot Attributes.)
A dialog boxwith attribute settings for the selected plot appears.

3. Change the desired plot attributes. Under the following tabs in the dialog box, you can control
the following attributes:

Color map The number of colors used and how they are displayed.

Scale The scale of field quantities.

Marker/Arrow l The appearance of points (for scalar point plots).
l The appearance of arrows (for vector plots).

Deformation
Scale

l Select whether to show or hide the deformation and also scale the
plot. (Applicable only when stress feedback coupling with ANSYS
Structural is enabled.)

Plots
(if not
streamline)

l The plot selected.
l To display or hide themesh on the plot’s surface or volume.
l The type of isovalue display (for scalar plots.)
l The transparency based on solution value.
l Whether to add a grid (that is, a mesh overlay), and to set the grid
color.

l Specify the plot resolution asCoarse,Normal, Fine, or Very Fine.
This affects the use of memory for animating plots. For large plots with
more frames to animate, useCoarse orNormal to reducememory
requirements and improve performance. For smaller plots with few
frames, if higher resolution is required, use Fine or Very Fine.

l The spacing of arrows (for vector plots).

Plots
(if streamline
is checked)

l The plot selected
l The linestyle as solid or cylinder from drop-downmenu.
l Line width, specified using a slider.
l Whether to show marker on streamline.
l Seeds density spacing. This affects the number of stream lines used
to represent the quantity in the plot. Moving the slider to the left
decreases the spacing and increases the number of stream lines.
Moving the slider to the right increases the spacing and decreases
the number of lines used to represent the quantity.

l Min. andMax. values represented.

4. Optionally, clickSave as default if you want the tab's settings to apply to field overlay plots
created after this point.
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5. SelectReal time mode if you want the changes to take effect immediately in the view
window. If this option is cleared, clickApplywhen you want to see the changes.

6. ClickClose to dismiss the dialog box.

Related Topics

Setting a Plot’s Visibility
Plotting theMesh
SettingMesh Plot Attributes
Plotting Field Overlays

Modifying Field Plot Colors

1. ClickMaxwell3D or Maxwell2D and select Fields>Modify Plot Attributes , or in the
Project tree, right click on the Field Overlays icon and selectModify Plots from the short-cut
menu,.
TheSelect Plot Folder window appears.

2. Select the plot you want to modify, and then clickOK.
Note All plots in the selected folder are

modified.

A dialog boxwith attribute settings for the selected folder appears.
3. Click theColor map tab.
4. Select one of the following color types:

Uniform Field quantities are plotted in a single color. Select the plot color from theColor
palette.

Ramp Field quantities are plotted in shades of a single color. Select the plot color from
theColor palette. The shade of the color corresponds to its field value.

Spectrum Field quantities are plotted in multiple colors. Select a color spectrum from the
pull-down list. Each field value is assigned a color from the selected spectrum.

You can chooseSave as Default, if you want to use the current settings.
SelectReal time mode if you want these, or subsequent changes to take effect immediately
in the view window.
If this option is cleared, clickApplywhen you want to see the changes.

5. Click theScale Tab.
6. In theNum. Divisions field, enter the number of colors to use in the plot.

You can chooseSave as Default, if you want to use the current settings.
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SelectReal time mode if you want the changes to take effect immediately in the view
window.
If this option is cleared, clickApplywhen you want to see the changes.

7. ClickClose to dismiss the dialog box.

Related Topics

Setting a Plot’s Visibility
Setting the Color Key Visibility
Moving the Color Key

Setting the Color Key Visibility

The color key (shown below) displays the range of plotted field values for a field overlay plot. It
displays the colors that correspond to the range of field values on the plot.

1. ClickView>Active ViewVisibility .

TheActive View Visibility dialog box appears.

2. Click theColor Keys tab.
3. In theVisibility column, select the field overlay or mesh plots in which you want to display the

color key. Clear the plots for which you want to hide the color key from view.
4. ClickDone to close the dialog box.

Alternatively, to hide the color key, right-click on the color key in the view window, and then
clickHide from the shortcut menu.
Only the color keys in the selected plots are visible.
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Related Topics

Modifying Field Plot Colors
Moving the Color Key

Moving the Color Key

Click on the active field overlay plot's color key and drag it to a new location.

Related Topics

Setting the Color Key Visibility

Modifying the Field Plot Scale

To change how field quantities are scaled on the field overlay plot:

1. ClickMaxwell3D or Maxwell2D and select Fields>Modify Plot Attributes or in the
Project tree, right click on the Field Overlays icon and selectModify Plots from the short-cut
menu.
TheSelect Plot Folder window appears.
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2. Select the plot folder you want to modify, and then clickOK.
Note All plots in the selected folder are

modified.

A dialog boxwith attribute settings for the selected folder appears.
3. Click theScale tab.
4. Optionally, to change the number of divisions in the field plot scale, set theNum. Division

field to a new value. You can clickSave as Default, if desired.
5. Select one of the following scale options:

Auto The full range of field valueswill be plotted on the selected surface or volume.
SelectingAuto enables theAuto Scale Options and disables theMin andMax
fields. By default, precision is not limited and auto-min is the actual computedmin
on the plotted geometry.

Use
Limits

Only the field values between theminimumandmaximum valueswill be plotted.
Field values below or above these valueswill be plotted in the colors assigned to
theminimumor maximum limits, respectively. SelectingUse Limits enables the
Min andMax fields and disables theAuto Scale Options.
Field values have a precision of at most 6 decimal places (field solution files are
saved in floating precision), soMin/Max numbers are displayed to this precision.

Specify
Values

This enables aScale Values button.

a. If you selectedUse Limits, enter the lowest field value to be plotted in theMin. box and
the highest field value to be plotted in theMax. box.

b. If you selectedAuto, theAuto Scale Options are enabled. You should only change this
for caseswhere auto-min is a small number. Use the Limits Max/Min precision to check
box to enable setting the drop downmenu for the precision limit. The auto-min is the
greater of the following:
l Actual computedMin
l Max/pow(10, num digits of field precision)

c. If you selectedSpecify Values, you can click theScale Values button. This opens a
dialog with an editable, scrollable list of the current scale values. To apply the changes you
make, click theOK button. To close the dialog without make changes, clickCancel.

d. Optionally, when dB is checked, the dB scale is used for the plot.
6. Optionally, use theUnits drop downmenu to select the default unit of measure for the plot.

The units specified here appear on the Color map for the fields plot, and for the properties
dialog for the field quantities.

7. If you selectedAuto orUse Limits and without have dB checked, you can select one of the
following options:

Linear Field values are plotted on a linear scale.
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Log Field values are plotted on a logarithmic scale. If field plots have negative and
positive values and when auto-scale is selected, the log-scale choice automatically
sets theMin value as theMax/Min Ratio. (If field plots have all negative values, Log
is not allowed.)

8. Specify theNumber Format for the plot field values as Auto, Scientific or Decimal. You can
also specifyWidth and Precision if Number Format is Scientific or Decimal.

9. SelectReal time mode if you want the changes to take effect immediately in the view
window.
If this option is cleared, clickApplywhen you want to see the changes.

10. Optionally, you can use theSave As Default button to save the following to registry:
l Whether to limit field precision,
l The number of digits of field precision,
l Whether to use log/linear scale.
l Whether to use dB.
Auto scale is always be default for new plots. For scalar-in-volume plots, iso-surface (rather
than cloud) is the default display

11. ClickApply, and then clickClose to dismiss the window.

Modifying Vector Field Plot Arrows

To change the appearance of a vector field plot's arrows:

1. ClickMaxwell3D or Maxwell2D and selectFields>Modify Plot Attributes .
TheSelect Plot Folder window appears.

2. Select the plot folder you want to modify, and then clickOK.
Note All plots in the selected folder are

modified.

A dialog boxwith attribute settings for the selected folder appears.
3. Click theMarker/Arrow tab.
4. UnderArrow options, select one of the following arrow types from the Type pull-down list:

Line The arrows are displayed as 2D/flat.

Cylinder The arrow tails are displayed as cylinders. The arrowheads are displayed as
3D/round.

Umbrella The arrow tails are displayed as 1D lines. The arrowheads are displayed as
3D/round.
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5. Use theSize slider to increase (move to the right) or decrease (move to the left) the length and
dimensions of the arrows. The arrows are resized relative to the size of themodel geometry.

6. SelectMap size to scale the size of the arrows to themagnitude of the field quantity being
plotted.

7. SelectArrow tail to include tails on all arrows.
8. Click thePlots tab.

Note Maxwell plots arrows on a grid that is superimposed on the surface or object you
selected for the plot.

9. Under Vector plot, use theSpacing slider to increase (move to the right) or decrease (move
to the left) the distance between arrows (grid points.)

10. If you want the arrows to be spaced equally, selectUniform, and enter values in theMin and
Max boxes.

11. SelectReal time mode if you want the changes to take effect immediately in the view
window. If this option is cleared, clickApplywhen you want to see the changes.

12. ClickApply, and then clickClose to dismiss the window.

Setting the Mesh Visibility on Field Plots

To display or hide themesh on field plots or to change themesh's color:

1. ClickMaxwell3D or Maxwell2D and selectFields>Modify Plot Attributes .
TheSelect Plot Folder window appears.

2. Select the plot folder you want to modify, and then clickOK.
Note All plots in the selected folder are

modified.

A dialog boxwith attribute settings for the selected folder appears.
3. Click thePlots tab.
4. SelectAdd grid to display themesh.
5. Optionally, select a color for themesh from theColor palette.
6. SelectReal time mode if you want the changes to take effect immediately in the view

window.
If this option is cleared, clickApplywhen you want to see the changes.

7. ClickApply, and then clickClose.

Related Topics

Plotting theMesh
Setting a Plot’s Visibility
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Modifying Scalar Field Plot Isovalues

1. ClickMaxwell3D or Maxwell2D and selectFields>Modify Plot Attributes .
TheSelect Plot Folder window appears.

2. Select the plot folder you want to modify, and then clickOK.
Note All plots in the selected folder are

modified.

A dialog boxwith attribute settings for the selected folder appears.
3. Click thePlots tab.
4. If the plot is a scalar surface plot, do the following:

a. Select one of the following isosurface display types from the IsoValType pull-down list:

Line Lines are drawn along the isovalues.

Fringe Color is constant between isovalues.

Tone Color varies continuously between
isovalues.

Gourard Color varies continuously across the plot.

b. Optionally, if you selected Fringe or Tone, selectOutline to add a border line between
isovalues.

5. Use theMap transp. slider to increase (move to the right) or decrease (move to the left) the
transparency of the plot.
l If you selectMap transp., the transparency of field values increases as the solution values
decrease.

6. If the plot is a scalar volume plot, do the following:
a. Select one of the following display types:

IsoValSurface Color is drawn on the isovalues.

Cloud Field values are represented by points that illustrate the spatial
distribution of the solution. The higher the solution value, the greater
the cloud density.

b. Optionally, if you selectedCloud, use theCloud density slider to increase or decrease
the number of points that represent the density on the volume.

c. Optionally, if you selectedCloud, enter a point size for the clouds in thePoint size box.
7. Use theMap transp. slider to increase (move to the right) or decrease (move to the left) the

transparency of the plot.
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l If you selectMap transp., the transparency of field values increases as the solution values
decrease.

8. SelectReal time mode if you want the changes to take effect immediately in the view
window. If this option is cleared, clickApplywhen you want to see the changes.

9. ClickApply, and then clickClose to dismiss the window.

Mapping Scalar Field Plot Transparency to Field Values

1. ClickMaxwell3D or Maxwell2D and selectFields>Modify Plot Attributes .
TheSelect Plot Folder window appears.

2. Select the plot folder you want to modify, and then clickOK.
Note All plots in the selected folder are

modified.

A dialog boxwith attribute settings for the selected folder appears.
3. Click thePlots tab.
4. Use theMap transp. slider to increase (move to the right) or decrease (move to the left) the

transparency of the plot.
l If you selectMap transp., the transparency of field values increases as the solution values
decrease.

5. SelectReal time mode if you want the changes to take effect immediately in the view
window.
If this option is cleared, clickApplywhen you want to see the changes.

6. ClickApply, and then clickClose to dismiss the window.

Modifying Markers on Point Plots

For scalar point plots, a marker is used to represent a field quantity at a selected point. (For vector
point plots, arrows are used.) Modify the shape and size of markers in the plot attributeswindow.

1. ClickMaxwell3D or Maxwell2D and selectFields>Modify Plot Attributes.
TheSelect Plot Folder window appears.

2. Select the plot folder you want to modify, and then clickOK.
Note All plots in the selected folder are

modified.

A dialog boxwith attribute settings for the selected folder appears.
3. Click theMarker/Arrow tab in the plot attributeswindow.
4. UnderMarker options, select one of the followingmarker types to represent the field quantity

at the point:
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l Sphere
l Box
l Tetrahedron
l Octahedron

5. Use theSize slider to increase (move to the right) or decrease (move to the left) the size of the
marker.

6. SelectMap size to scale the size of themarker to themagnitude of the quantity being plotted.
7. SelectReal time mode if you want the changes to take effect immediately in the view

window. If this option is cleared, clickApplywhen you want to see the changes.
8. ClickApply, and then clickClose.

Related Topics

Drawing a Point

Viewing Data Markers

The difference between twomarkers can be viewed on a plot.
1. Click Report 2D>Data Marker.
2. Click the first point on the graph.
3. Hold-and-drag themouse and release at the second point.

Under the XY plot, you can see the difference between the twomarker points.

Modifying Line Plots

Field quantities can be plotted directly on a line object. Scalar quantities are plotted as 3D color-
shaded lines. Vector quantities are plotted as arrows that are based on the line.
Tomodify the appearance of line plots:

1. ClickMaxwell3D or Maxwell2D and selectFields>Modify Plot Attributes .
TheSelect Plot Folder window appears.

2. Select the plot folder you want to modify, and then clickOK.
Note All plots in the selected folder are

modified.

A dialog boxwith attribute settings for the selected folder appears.
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3. Click thePlots tab.
4. Select one of the following isosurface display types from the IsoValType pull-down list:

Fringe Color is constant between isovalues.

Tone Color varies continuously between
isovalues.

Gourard Color varies continuously across the plot.

5. Select one of the following styles for the line object from the Line style pull-down list:

Cylinder The line object is shaped like a cylinder.

Solid The line object is a 3D solid.

Dash-
Dash

The line object is represented by dashed black line segments.

Dot-Dot The line object is represented by a series of dots.

Dash-
Dot

The line object is represented by a a series of alternating dashed black line
segments and dots.

6. Use the Line width slider to increase (move to the right) or decrease (move to the left) the
thickness of the line.

7. By default, a polyline object is divided into 100 equally spaced points for post processing. To
modify the number of points on the line, type a new value in theNumber of points box.

8. SelectReal time mode if you want the changes to take effect immediately in the view
window. If this option is cleared, clickApplywhen you want to see the changes.

9. ClickApply, and then clickClose.

Related Topics

Drawing a Polyline

Setting a Plot's Visibility

To display or hide a field overlay or mesh plot from view in the 3D Modeler window:

1. ClickView>Active View Visibility . Alternatively, you can select the Active View
Visibility icon from the toolbar.
TheActive View Visibility dialog box appears.
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2. Click the FieldsReporter tab.
3. In theVisibility column, select the field overlay or mesh plots you want to display. Clear the

plots you want to hide from view.
4. ClickDone.

Only the selected plots are visible.

Saving a Field Overlay Plot

Field overlay andmesh plots are saved in the project file (.adsn); however, you can save a plot to a
Maxwell Field Plot File format (.dsp) and then open it in Maxwell.
To save field overlay or mesh plot data to a .dsp file:

1. In the project tree, click the plot you want to export.

2. ClickMaxwell3D or Maxwell2D and selectFields>Save as .
TheSelect Field Plot(s) dialog box appears.

3. Select the plots you want to export by checking theSelect box, and then clickOK.
A file browser appears.

4. Make sure that Field Plot Files (.dsp) is the selected file type.
5. Specify the name of the .dsp file and the location in which to save it.
6. ClickSave.

The plot is exported to the specified .dsp file.
The file you created can be opened inMaxwell version 9 and later. Simply clickMaxwell3D or
Maxwell2D and selectFields>Open.

Opening a Field Overlay Plot

To open a field overlay or mesh plot that you have saved toMaxwell Field Plot File format (.dsp) in
Maxwell version 9 and later:

1. ClickMaxwell3D or Maxwell2D and selectFields>Open .
A file browserOpen dialog box appears.

2. Make sure that Field Plot Files (.dsp) is the selected file type in the Files of type pull-down
list.

3. Browse to the location of the .dsp file you want to open, and then click the file name.
4. ClickOpen.

The plot appears in the view window and is listed under Field Overlays in the project tree.
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Deleting a Field Overlay Plot

1. ClickMaxwell3D or Maxwell2D and selectFields>Delete Plot .
TheDelete Plots dialog box appears.

2. Select the plot(s) you want to delete by checking theDelete check box in the appropriate row.
3. ClickOK.

The selected plots are deleted.
Alternatively, click the plot in the project tree that you want to delete, and then pressDelete.

Setting Field Plot Defaults

Each new field plot uses the default plot settings specified in theSet Plot Defaults dialog box.
Tomodify the default plot settings:

1. If a plot folder has not been created, clickField Overlays in the project tree.

2. ClickMaxwell3D or Maxwell2D and selectFields>Set Plot Defaults .
TheSet Plot Defaults dialog box appears.

3. Select the solution to plot from theSolution pull-down list.
4. Select the plot folder in which new plots will be stored from thePlot Folder pull-down list.

Select from one of the following options:

New
Folder

Each new plot is stored in a separate folder in the project tree.

Automatic Each new plot is stored in a folder determined byMaxwell as themost
appropriate based on the plotted field quantity. For example, all surface
magnitude E plots are stored in the same folder.

An
existing
folder

Select the existing folder in which you want to store new plots.

Note Plots stored in the same folder use the same color key. TheAuto scale setting is
based on themaximum field solution value present in a plot.

5. Under Intrinsic Variables, specify the frequency and phase angle at which the field quantity
is evaluated.

6. ClickOK.
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Renaming a Plot

To rename a plot, do the following in the project tree:
1. Under Field Overlays, expand the field type, and right-click the specific plot you want to

rename.
A shortcut menu appears.

2. SelectRename.
The text becomes editable in the project tree.

3. Type the new name, and pressEnter.

Using the Fields Calculator
The Fields calculator enables you to perform computations using basic field quantities. The
calculator computes derived quantities from the general electromagnetic field solution; writes field
quantities to files, locatesmaximumandminimum field values, and performs other operations on the
field solution.
The calculator allows you to define a series of calculations to be performed on the field solution but
does not actually perform the computations until data is required, for a field plot as an example. This
makes it more efficient, saving computing resources and time. You can do all the calculationswithout
regard to data storage of all the calculated points of the field. It is generally easier to do all the
calculations first, then plot the results.

Note InMaxwell2D, the Fields Calculator accounts for the difference between XY and RZ
models when handling data and results. For example, the integral commandwill perform
an XY integral on themodel assuming a 1meter depth, while for an RZmodel it will
perform an integral on the 360 degree equivalent volume.

Related Topics

Opening the Fields Calculator
Context Area
Calculator Stack
Registers
The StackCommands
Input Commands
General Commands
Scalar Commands
Vector Commands
Output Commands
Calculating DerivedOutput Quantities
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Named Expression Library

Opening the Fields Calculator

To open the Fields Calculator, do one of the following:

l ClickMaxwell3D or Maxwell2D and select Fields>Calculator .
l Right-clickField Overlays in the project tree, and then clickCalculator on the shortcut menu.

The Fields Calculator dialog box appears.
To view information on a command or screen area, click over the button or screen area on the
illustration below.
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Context Area

The panel at the upper right of the window identifies the context to be used for the calculations. The
top line identifies the design. Depending on the design, text entry boxes allow you to select a
Solution, Field Type, or Time.
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The Field Type here is not related to the edit sources. This is a general term among ANSYS
Electromagnetics products (HFSS, Maxwell, andQ3D). Some products havemore than one field
type for different solution types. If only one Field Type is available the box is grayed out.
TheChange Variable Values button opens aSet Variable Values dialog. By default it hasUse
Nominal Design checked. Unchecking the box lets you select another variable value.OK the dialog
to accept the selection.

Related Topics

Opening the Fields Calculator

The Calculator Stack

The calculator ismade up of a stack of registers, each of which can hold:
l Field quantities.
l Functional or constant scalars and vectors.
l Geometries— points, lines, surfaces, or volumes— onwhich a field quantity is to be
evaluated.

To perform a computation on the field solution, youmust first load a basic field quantity into a register
on the stack. Once a quantity is loaded into a register, it can be:

l Manipulated usingmathematical operations such as curls, gradients, cross products,
divergences, and dot products.

l Integrated over lines, surfaces, or subvolumes of the solution region— either predefined
surfaces, volumes, and lists, or lines, surfaces, and volumes that were defined using theDraw
commands.

l Plotted on a point, line, surface, or volume.
l Exported to a file, allowing you to superimpose saved solutions.

Related Topics

Registers
Using the Fields Calculator

Registers

Calculator registers hold field quantities, numbers, vectors, and geometries. No registers are
created until you load something into the calculator; therefore, this part of the window is initially
blank. As items are loaded into the calculator, it creates new registers to hold them.
Each register is labeled with its contents as follows:

Vec Vector quantities, which have both direction andmagnitude at each point in space. The
x-, y-, and z-components of these quantities are stored in the register.
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Scl Scalar quantities, which have amagnitude only.
CVc Complex vector quantities.
CSc Complex scalar quantities.
Pnt Points.
Lin Lines.
Srf Surfaces.
Vol Volumes.
SclLin Scalar value on a line.
VecLine Vector value on a line.
SclSrf Scalar value on a surface.
VecSrf Vector value on a surface.

When examining calculator registers, keep the following inmind:
l Tomove or delete calculator registers, use the stack commands.
l To save a register to a disk file, use theWrite command.

Related Topics

Enlarging the Register Display Area
Units of Measure

Enlarging the Register Display Area

If there are toomany registers to fit into the display area, do one of the following:
l Use the scroll bars to view the hidden registers.
l Enlarge the calculator window using the window’s borders.

Related Topics

Registers

Units of Measure

Unless you are prompted specifically for the unit of measure, all measurements should be assumed
to be in SI base units, not model units.

Related Topics

Registers
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Stack Commands

Use these commands tomanipulate the registers in the calculator stack.

Push
Reloads the quantity in the top register onto the top of the stack, creating a new register. The
contents of the top two registers are identical.

Pop
Deletes the top register from the stack.

RlUp
Rolls the top register to the bottom of the stack, moving the other registers up the stack.

RlDn
Rolls the bottom register to the top of the stack, moving the other registers down the stack.

Exch
Exchanges the top two registers in the stack.

Clear
Clears the contents of the stack.

Undo
Use this command to undo the effect of the last operation you performed on the contents of the top
register. SuccessiveUndo commands act on any previous operations.

Note You cannot undo a simple operation such as loading a field quantity, constant, function, or
geometry into the calculator. Instead, use thePop orClear commands to delete these
items from the calculator stack.

Related Topics

Using the Fields Calculator

Input Commands

Use the following commands to load data onto the top of the calculator stack:

Quantity Basic quantities, such as current, magnetic field, etc.
Geometry Geometries such as planes, points, polylines, and volumes.
Constant Predefined constants such as π, ε0, and conversion factors between various units of

measurement.
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Number Vector and scalar constants, including complex numbers.
Function Previously saved calculator registers containing field quantities.
Geom
Settings

Vector and scalar math functions.

Read Reads an input saved externally.

These quantities can bemanipulated using theStack commands,General commands,Scalar
commands, andVector commands. The results of these calculations can then be examined using
theOutput commands.

Related Topics

Using the Fields Calculator

Quantity Command

TheQuantity command loads a field quantity into the top register of the calculator. The quantities
available depend upon the solution and design type. These are the same field quantities available for
plotting from theMaxwell3D>Fields andMaxwell2D>Fieldsmenu.

Related Topics

Plotting Standard Field Quantities
Using the Fields Calculator

Geometry Command

The Fields CalculatorGeometry command opens a dialog that lets you select a geometry to load
into the top register of the calculator. Do this to:

l Find the value of derived field quantities on any point, line, surface, or volume.
l Plot quantities directly from the calculator.
l Display a previously defined isosurface, maximumor minimum field point using theDraw
command.

The following types of geometries are available:

Point - See drawing a point object. Points you draw are listed in the history tree, and in the
CalculatorGeometry dialog when you select Point.
Line- See drawing a line object. Lines you draw are listed in the history tree, and in the Calculator
Geometry dialog when you select Line. To set the number of points on a line, seeGeomSettings.
Surface - Sheet objects and face lists which you canmake, are listed under surface in the history
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tree and in the CalculatorGeometry dialog when you select Surface.
Due to the ambiguity of the normal vector of a sheet, the result may require amultiplication by ( 1 )
or ( -1 ).
Volume - 3D objects, Regions, and object lists of 3D objects including AllObjects are available in
the CalculatorGeometry dialog when you select Volume.
Coord -Coordinate systems are available in the CalculatorGeometry dialog when you select
Coord.

To load a geometry into the calculator:
1. In the Fields Calculator, clickGeometry.

TheGeometry dialog box appears.
2. Select a geometry type.

A list of all available geometries appears.
Note l Non-convex 3D non-model solids are not supported for Field Overlay Plots and

Fields Calculator computations.
l Object lists containing non-model object(s) are supported for Field Overlay Plots but
are not supported for Fields Calculator computations.

3. Click the geometry.
4. ClickOK to load the geometry.

Note Consider a box (Box2) that is completely enclosed in a bigger box (Box1), so that no
faces of Box2 are touching any faces of Box1.
If you explicitly subtract Box2 fromBox1, any calculation on the surface (faces) of
Box1 will use the 6 exterior faces and the 6 interior faces. Any calculation on the
volume of Box1 will use the difference in volume between Box1 and Box2.
If you do not explicitly subtract Box2 fromBox1, the inner box is only implicitly
subtracted. Any calculation on the surface of Box1 in this case will use only the 6
exterior faces of Box1. Any calculation on the volume of Box1 will use the entire
volumewithout subtracting the volume of Box2.

Related Topics

Using the Fields Calculator
Input Commands
Domain command
Export Command
GeomSettings
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Constant Command

TheConstant command loads one of these predefined constants or a conversion constant into the
top register of the calculator:

Pi π = 3.14159265358979
Epsi0 The permittivity of free space, ε0 = 8.85418782 x 10

–12 F/m.
Mu0 The permeability of free space, µ0 = 4π x 10–7 H/m.
C The speed of light in vacuum, c = 2.99792458 x 108m/s.
conversion
constant

Displays theEnter Units Conversion Factor dialog box. This dialog box lists a
range ofQuantities (such as frequency, resistance, and others) along with a list of
Units (Hz to Thz, and rps) to convert From and To. The ratio of theUnits from to the
Units to is displayed for the selected values as theConversion Factor.

Related Topics

Using the Fields Calculator
Input Commands

Number Command

TheNumber command enters one of the following into the top register of the calculator:

Scalar A scalar constant. To enter a constant scalar number:
1. ClickNumber.

The Input Number dialog box appears.
2. SelectScalar.
3. Type the scalar value in theValue box.
4. ClickOK to load the number into the top register.

Vector A vector constant.
To enter a constant vector:
1. ClickNumber.

The Input Number dialog box appears.
2. SelectVector.
3. Enter the x-, y-, and z-components of the vector.
4. ClickOK to load the vector into the top register.

Complex A complex constant. Complex constants are entered in the formC=A+jB, whereA
represents the real part of the constant andB represents the imaginary part.
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1. ClickNumber.
The Input Number dialog box appears.
2. SelectScalar or Vector.
3. SelectComplex.
4. Enter the real and imaginary components of the number.
5. ClickOK to load the number into the top register.

Related Topics

Using the Fields Calculator
Input Commands

Function Command

Any functions you usemust be defined before using this operation.
Enters one of the following into the top register of the calculator:

Scalar A scalar function.
To enter a function:
1. ClickFunction.

The Function dialog box appears.
2. SelectScalar.
3. Select the function from the list.
4. ClickOK to load the functional scalar into the top register.

Vector A vector function, in which the values of the vector's x-, y-, and z-components are given by
functions.
To enter a functional vector:
1. ClickFunction.

The Function dialog box appears.
2. SelectVector.
3. Select the function from the list.
4. For each component of the vector, clickSetX, SetY, andSetZ.
5. ClickOK to load the functional vector into the top register.

Note l The predefined variablesX, Y, Z,RHO, THETA, R, andPHI and any functions that
you created can be used to define functional scalar and vector quantities.

l Use of the Global Coordinate System is assumed. Local coordinate systems are not
used.
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Related Topics

Using the Fields Calculator
Input Commands

Geometry Settings

Clicking theGeom Settings button opens theGeometric Settings dialog box. The dialog box
allows you to specify the line discretization, the number of equally-spaced points used to integrate
fields and other quantities on a line. The default is 1000 points.
To set the line spacing for geometry settings:

1. In the Fields Calculator, clickGeom Settings.
TheGeometry Settings dialog box appears.

2. Enter a value in the Line Discretization box, and clickOK.

Related Topics

Using the Fields Calculator
Input Commands

Reading an External Input

This command copies the contents of a disk file into the top register. The register must be one that
has been saved using theWrite output command.
To read an external input into the register:

1. ClickRead.
TheOpen dialog box appears.

2. Use the file browser to specify the register’s file name and directory path. A .reg extension is
automatically assumed for register files, and clickOpen.
The contents of the file are copied to the top register in the stack.

Related Topics

Using the Fields Calculator
Input Commands

General Commands

Use these Fields Calculator commands to perform operations on both vector and scalar quantities.
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+ (Add) /
(Divide)

Smooth

-
(Subtract)

Neg Complex

* (Multiply) Abs Domain

+ (Add)
Adds the quantities in the top two registers of the calculator.

– (Subtract)
Subtracts the quantity in the top register from the quantity in the second register. The two
registersmust hold the same type of quantity (both scalar or both vector). You cannot subtract
a scalar from a vector (or vice versa).

* (Multiply)
Multiplies the quantity in the top register by the quantity in the second register. One of the two
registersmust contain a scalar value; the other register can be either a scalar or a vector.

/ (Divide)
Divides the quantity in the second register by the quantity in the top register. The second
register must contain a scalar value; the top register can be either a scalar or a vector.

Neg
Changes the sign of the quantity in the top register.

Abs
Takes the absolute value of the quantity in the top register.

Smooth
Smooths the quantity in the top register. Because of the numerical solution technique used,
field values are not always continuous across the boundaries of the individual elements that
make up the finite-element mesh. Smoothingmakes the values continuous. In general, use
smoothing before plotting a quantity.

Complex
These commands perform operations on a complex quantity in the top register. Complex
quantities are indicated by aC at the beginning of the register label. They can be represented
in terms of real and imaginary components, or in terms of magnitude and phase:

where:
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l A is the real part of the complex number.
l B is the imaginary part of the complex number.
l M is itsmagnitude, which is equal to sqrt(A2 + B2).
l φ is its phase, which is equal to atan(B/A).
TheComplex commands let you do the following:

Real Takes the real part of the complex quantity (A).
Imag Takes the imaginary part of the complex quantity (B).
CmplxMag Takes themagnitude of the complex quantity (M). Due to interpolation issues, the

sequence of calculationsmay cause a loss of accuracy. It is best to define the
points, separately obtain the value of the real part, then the imaginary part, and use
those values to calculate themagnitude and phase. For the sequence for using the
Fields Calculator to obtain the real and imaginary parts, see the procedure here.

CmplxPhase Takes the phase of the complex quantity (φ).
Conj Takes the complex conjugate of the quantity in the top register. If a complex number

is given byC = A + jB, its complex conjugate is given byC* = A – jB.
AtPhase Specify the phase angle,ωt, at which a field quantity is evaluated. These quantities

can be represented in the form:

where
l ω is the angular frequency at which the quantities are oscillating, specified
during the solution.

l θ(x,y,z) is the phase angle (the offset from a cosine wave that peaks at t=0).
Entering the phase angle lets you compute the real part of the field'smagnitude at
different points in its cycle.

CmplxReal Converts the real scalar of the top register to the real part of a complex number.
CmplxImag Converts the real scalar of the top register to the imaginary part of a complex

number.
ComplxPeak Calculates the peak value of a given complex vector. Intuitively, this calculates the

maximummagnitude of the equivalent real vector in a waveform.

Domain
This limits a calculation to the volume you specify. The domain filter works for scalars, vectors,
complex scalars and complex vectors. This operation requires the top two entries of the stack
to be a volume geometry and a numeric field quantity. To do this:
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1. Load the field quantity into the top register, and perform any necessary operations on it.
2. Load the volume using theGeometry command.
3. ClickDomain.

TheDomain command is often used to limit a calculation or plot to the intersection of a surface
and an object or group of objects. If you export a domain filtered numeric, points that are
filtered out by the domain will not be written out.

Related Topics

Using the Fields Calculator
Export Command
Steps for Calculating the Complex Vector Electric Field

Steps for Calculating the Complex Vector Electric Field

These are the field calculator steps to obtain the real part, the imaginary part, and themagnitude of
the x-directed, y-directed, and z-directed components of the phasor electric field. For each of these
vector components, themagnitude should be equal to sqrt(real^2+imag^2), but the need to
interpolate values and the calculation sequencemeans that HFSS does not give this value unless
the specified location is directly on amesh element node.

1. Calculate real part of complex vector electric field (in x, y, and z directions):
a. Qty > E
b. Complex > Real
c. Geometry > Point > fieldcalc_point
d. Value
e. Eval

2. Calculate imaginary part of complex vector electric field (in x, y, and z directions):
a. Qty > E
b. Complex > Imag
c. Geometry > Point > fieldcalc_point
d. Value
e. Eval

Use the real and imaginary components tomanually calculate themagnitude as the sqrt
(Real^2+imag^2).

Scalar Commands

Use these commands to perform operations on scalar quantities.

Vec? Makes the scalar quantity in the top register a vector component.
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1/x Takes the inverse of the scalar quantity in the top register.
Pow Raises a scalar quantity to the power you specify.
Square
Root

Takes the square root of the quantity in the top register.

Trig Takes a trigonometric value of the value in the top register of the calculator stack.
d/d? Takes the partial derivative of the quantity in the top register with respect to x, y, or z as

chosen in the pull-downmenu.
Integral Takes the integral of a scalar quantity over a volume, surface, or line.
Min Computes theminimumof a scalar field quantity on a line, surface, or volume.
Max Computes themaximumof a scalar field quantity on a line, surface, or volume.
Gradient Computes theminimumof a scalar field quantity on a line, surface, or volume.
Ln Calculates the log (base e) value.
Log Calculates the logarithmic value (base 10).

Related Topics

Using the Fields Calculator

Vec? Command

Makes the scalar quantity in the top register a vector component. Choose from the following:

VecX The x-component of a
vector.

VecY The y-component of a
vector.

VecZ The z-component of a
vector.

Related Topics

Using the Fields Calculator
Scalar Commands

1/x (Inverse) Command

Takes the inverse of the scalar quantity in the top register.
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Related Topics

Using the Fields Calculator
Scalar Commands

Pow Command

Raises a scalar quantity to the power you specify.
To raise a scalar quantity to a power:

1. Enter the quantity into the calculator.
2. Enter the exponent to which it is to be raised into the calculator.
3. ClickPow.

The results are displayed in the top register.

Related Topics

Using the Fields Calculator
Scalar Commands

(Square Root) Command

Takes the square root of the quantity in the top register.

Related Topics

Using the Fields Calculator
Scalar Commands

Trig

Takes one of the following trigonometric values of the value(s) in the top register(s) of the calculator
stack:

Sin Sine.
Cos Cosine.
Tan Tangent.
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ASin Arcsine.
ACos Arccosine.
ATan Arctangent.
ATan2 A two-argument version of theATan function. Takes the y and x coordinates of the point

(in the top two stack registers).

Related Topics

Using the Fields Calculator
Scalar Commands
d/d? (Partial Derivative) Command
Takes the partial derivative of the quantity in the top register:

d/dx Takes the partial derivative of the quantity with respect to
x.

d/dy Takes the partial derivative of the quantity with respect to
y.

d/dz Takes the partial derivative of the quantity with respect to
z.

Related Topics

Using the Fields Calculator
Scalar Commands

(Integral) Command

Takes the integral of a scalar quantity over a volume, surface, or line. The top register must contain a
geometry, and the second register must contain the scalar quantity to be integrated.
To perform an integration:

1. Load a quantity into the top register of the calculator, and perform any required operations on
it.

2. Use one of theGeometry commands to load the line, surface, or volume over which the
quantity is to be integrated.
Note If you computed the tangent or normal of the quantity to be integrated, you do not

have to load a geometry onto the calculator stack. Maxwell integrates the tangential
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or normal component of the quantity over the line on which you computed its
tangent, or the surface on which you computed its normal.

3. Click the Integral command to integrate the scalar quantity over the geometry. In 2D designs,
youmust further select either XY orRZ.

To find the numerical results of an integration, use theEval command.

Note InMaxwell2D, the Fields Calculator accounts for the difference between XY and RZ
models when handling data and results. The integral commandwill perform an XY integral
on themodel assuming a 1meter depth, while for an RZmodel it will perform an integral on
the 360 degree equivalent volume.

Related Topics

Using the Fields Calculator
Scalar Commands

Min Command

Computes theminimumof a scalar field quantity on a line, surface, or volume. Two options are
available:

Value Finds themagnitude of theminimum value of the field.
Position Finds the point where theminimum field value occurs. You can

then:
l Plot theminimum field value at the point using thePlot
command.

l Plot basic field quantities at the point.
l Load the point into the calculator.
l Change the point’s location.

These commands operate in the sameway as theMax commands. Use theEval command to
display the actual minimum field value or the coordinates of the point where it occurs.

Related Topics

Using the Fields Calculator
Scalar Commands

Max Command

Computes themaximumof a scalar field quantity on a line, surface, or volume. Two options are
available:
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Value Finds themagnitude of themaximum value of the field.
Position Finds the point where themaximum field value occurs. You can

then:
l Plot themaximum field at the point using thePlot command.
l Plot field quantities at the point.
l Load the point into the calculator.
l Change the point’s location.

To compute themaximum field value:
1. Load a field quantity into the calculator, and perform any necessary operations on it. Keep the

following inmind:
l You cannot find themaximum value of a vector quantity. Therefore, make sure that the
result is a scalar.

l Before computing themaximum value of a complex quantity, youmust convert it to a scalar
quantity using the Cmplex/Real or Cmplex/AtPhase commands.

2. Load a point, line, or volume into the calculator using one of theGeometry commands.
3. Do one of the following:

l ClickMax/Value to compute themaximum field value on the geometry.
l ClickMax/Position to identify the point at which this value occurs.

Use theEval command to display the actual maximum field value or the coordinates of the point
where it occurs.

Related Topics

Using the Fields Calculator
Scalar Commands

(Gradient) Command

Computes the gradient of the scalar quantity in the top register.

Related Topics

Using the Fields Calculator
Scalar Commands
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Ln Command

Takes the natural logarithm (base e) of the scalar quantity in the top register.

Related Topics

Using the Fields Calculator
Scalar Commands

Log Command

Takes the logarithm (base 10) of the scalar quantity in the top register.

Related Topics

Using the Fields Calculator
Scalar Commands

Vector Commands

Use these commands to perform operations on vector quantities.

Scal? Replaces the vector in the top register with a scalar quantity that is a component of the
vector.

Matl Multiplies or divides the vector field quantity in the top register by amaterial property.
Mag Takes themagnitude of the vector quantity in the top register. Themagnitude of a

complex vector is defined to be the length of the real vector resulting from taking the
modulus of each component of the original complex vector.

Dot Takes the dot product of the vector quantities in the top two registers
Cross Takes the cross product of the vector quantities in the top two registers.
Divg Takes the divergence of the vector quantity in the top register.
Curl Takes the curl of the vector quantity in the top register.
Tangent Computes the tangential component of a vector quantity along a line.
Normal Computes the normal component of a vector quantity on a surface such as a cutplane or

object surface.
Unit
Vec

Computes the normal or tangent unit vector. The unit vector is a "wild card" entry. The
context is specified at the time of plotting, integrating, or report generation.

XForm Transforms the vector quantity in the top register fromCartesian coordinates into either
Spherical or Cylindrical coordinates
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Scal? Command

Replaces the vector in the top register with a scalar quantity whose value is a component of the
vector. Choose from the following:

ScalarX Returns the x-component of the
vector.

ScalarY Returns the y-component of the
vector.

ScalarZ Returns the z-component of the
vector.

Related Topics

Using the Fields Calculator
Vector Commands

Matl Command

Multiplies or divides the vector field quantity in the top register by amaterial property. At each
tetrahedron, the field quantity ismultiplied or divided by the value of the selectedmaterial property—
taking the different material attributes of each object into account.
Tomultiply or divide a vector quantity by amaterial property:

1. ClickMatl.
TheMaterial Operation dialog box appears.

2. Select a property from theMaterial Properties list. Options include the following, depending
on what solution type is assigned:
l Permeability (mu): defined as µ0µr

where µ0 is the permeability of free space

l Differential Permeability (dmu)
l Conductivity (cond)
l Permittivity (epsi)
l MassDensity: based on the value of theMassDensitymaterial property. MassDensity is
treated like a named expression. SelectingMassDensity disables the Operation radio
buttons for Multiply or Divide in theMaterial Operations dialog.

l Admittivity
3. Select an operation—Multiply orDivide.
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4. ClickOK to multiply or divide the field quantity by amaterial property orCancel to stop the
operation. If you selectedMassDensity and clickOK, a scalar named expressionMassDensity
is pushed onto the stack.

Related Topics

Using the Fields Calculator
Vector Commands

Mag Command

Takes themagnitude of the vector quantity in the top register. Themagnitude of a complex vector is
defined to be the length of the real vector resulting from taking themodulus of each component of the
original complex vector.
With a complex vector on the calculator stack, theMag button returns a nonnegative scalar. In
previous software versions, this command returned a complex scalar.

Related Topics

Using the Fields Calculator
Vector Commands

Dot Command

Takes the dot product of the vector quantities in the top two registers.

Related Topics

Using the Fields Calculator
Vector Commands

Cross Command

Takes the cross product of the vector quantities in the top two registers.

Related Topics

Using the Fields Calculator
Vector Commands

Divg Command

Takes the divergence of the vector quantity in the top register.
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Related Topics

Using the Fields Calculator
Vector Commands

Curl Command

Takes the curl of the vector quantity in the top register.

Related Topics

Using the Fields Calculator
Vector Commands

Tangent Command

Computes the tangential component of a vector quantity along a line.

To take the tangent of a vector:
1. Load a vector quantity into the top register.
2. Load a line into the top register using the Geometry/Line command.
3. ClickTangent.

Related Topics

Using the Fields Calculator
Vector Commands

Normal Command

Computes the normal component of a vector quantity on a surface such as a cutplane or object
surface. This is the equivalent of taking the dot product of the quantity with the surface's unit normal
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vector:

To take the normal of a vector:
1. Load a vector quantity into the top register.
2. Load a surface into the top register using the Geometry/Surface command.
3. ClickNormal.

Note Because surface normals of sheets are not well defined the fields calculator can
produce incorrect results if an expression is evaluated on a sheet. To enforce the
correct direction of the surface normal of a sheet, a faceted 3D object (such as a
box) can be defined such that one of its planar faces is coincident with the sheet.
Because surface normals of a valid object are always defined in an outward
direction in Maxwell, the fields calculator uses the surface normal of the face of the
3D object that is coincident with the sheet.

Related Topics

Using the Fields Calculator
Vector Commands

Unit Vec Command

Computes the normal or tangent unit vector. The unit vector is a "wild card" entry. The context is
specified at the time of plotting, integrating, or report generation.
Select from the following:

Tangent Computes the unit vector tangent to the line in the top register of the calculator stack.
Normal Computes the unit vector normal to the surface in the top register of the calculator
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stack.
CoordSys
(X)

Computes the unit vector in the X-dimension of the relative coordinate system in the
top register of the calculator stack. Add the relative CS as a geometric object using the
Geometry/Coord command.

CoordSys
(Y)

Computes the unit vector in the Y-dimension of the relative coordinate system in the
top register of the calculator stack. Add the relative CS as a geometric object using the
Geometry/Coord command.

CoordSys
(Z)

Computes the unit vector in the Z-dimension of the relative coordinate system in the
top register of the calculator stack. Add the relative CS as a geometric object using the
Geometry/Coord command.

Related Topics

Using the Fields Calculator
Vector Commands

XForm Command

Fields are defined in the Cartesian coordinate system. Inmany applications it ismuchmore
convenient to use a cylindrical or spherical coordinate system – for example, when the object is of
cylindrical or spherical shape. The XForm command allows the user to transform vectors into either
the cylindrical or spherical coordinate system.
Select from the following:

ToSpherical Transforms the vector in the top register of the calculator stack into the spherical
coordinate system. AnOffset Values pop-up window allows the user to enter X,
Y, and Z offsets to be used as the origin of the new coordinate system. ClickingOK
applies the coordinate transformation to the vector quantity on the calculator stack.

ToCylindrical Transforms the vector in the top register of the calculator stack into the cylindrical
coordinate system. AnOffset Values pop-up window allows the user to enter X,
Y, and Z offsets to be used as the origin of the new coordinate system. ClickingOK
applies the coordinate transformation to the vector quantity on the calculator stack.

Related Topics

Using the Fields Calculator
Vector Commands
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Output Commands

Use these commands to compute or evaluate expressions and to output the data in the calculator.

Value
command

Computes the value of a field quantity at a point.

Eval
command

Numerically evaluates and displays the results of calculator operations.

Write
command

Saves the contents of the top register to a disk file.

Export
command

Saves field quantities in a format that can be read by other modeling or post-
processing software packages.

Related Topics

Using the Fields Calculator

Value Command

This computes the value of a field quantity at a point. Use it to find:
l Themagnitude of a scalar field quantity at that point.
l The x-, y-, and z-components of a vector field quantity at that point.

To find the value of a field quantity at a point:
1. Load the field quantity into the top register, and perform any needed operations on it.
2. Load the appropriate point into the calculator using the Geometry/Point command.
3. ClickValue.

To view the numerical results of this operation, use theEval command.
You can also use theValue command to access the intermediate SurfaceValue function
For example, after inputting an expression for a quantity, such as an E field, and then selecting a
surface geometry, the calculator stack displays something like this.

Clicking theValue command changes the display to the following, showing the intermediate
SurfaceValue function.

Post Processing andGenerating Reports 23-163
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

In this case SurfaceValue provides the x, y, z, coordinates of the FEMmesh and Lagrangian points
so you can useWrite to generate an .fld file containing an evaluated scalar quantity at those points.
In general for Value:

1. Enter any quantity onto the stack.
2. Enter a volume / surface / line / point onto the stack.
3. Press theValue button and you will get an appropriate geometry value on the stack.

Now you can perform suitable operations such asWrite, Integrate, etc. For PointValue you can also
doEval.

Related Topics

Using the Fields Calculator

Eval Command

This command numerically evaluates and displays the results of calculator operations such as
integrations, maximumor minimum field computations, field values at points, and so forth. The
quantity to be evaluatedmust be in the top register. TheEval command computes the numerical
results of the operation, which replace the contents of the register.
For instance, to find the current around a loop, youmust numerically evaluate the following integral

for that loop: .
SinceH and I are complex quantities, you first need to evaluate the real part ofH to obtain the real
part of I, then evaluate the imaginary part ofH to obtain the imaginary part of I. To do this:

1. LoadH into the calculator using theQty command.
2. Take the real part ofH using the Cmplex/Real command.
3. Load the rectangular loop using the Geom/Line command. Create the loop, a closed polyline,

to integrate over.
4. ClickTangent to get the component ofH along the line.

5. Take the integral around the loop using the command.
6. ClickEval to evaluate the integral. The real part of I appears in the top register.
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7. Repeat this process using the imaginary part ofH (found with theComplex/Imag command)
to obtain the imaginary part of I.

Related Topics

Using the Fields Calculator

Write Command

This command saves the contents of the top register to a disk file. Use this command to:
l Save registers for use during a later post-processing session.
l Save a field quantity for use when post processing a different model.

Note Use of the Global Coordinate System is assumed. Local coordinate systems are not
used.

To save a register:
1. ClickWrite.
2. If the register includes numeric with a constrained quantity (such as jsurf), you see a dialog

that gives a choice of constraining geometries. For example:

3. Select the geometry of interest, and selectOK.
This displays a file browser.

4. Use the file browser to specify the register’s file name and directory path. A .reg extension is
automatically assigned to register files and a .fld extension is assigned to field files. You can
choose to save both .reg and .fld files, or either one.

5. ClickOK.
The contents of the file are saved to the file you specified.
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Related Topics

Using the Fields Calculator

Export Command

This command opens theExport Solution dialog, fromwhich you can export the field quantity in the
top register to a file, mapping it to a grid of points. Use this command to save field quantities in a
format that can be read by other modeling or post-processing software packages. Two options are
available for defining the grid points on which to export:

Input grid
points
from file

Maps the field quantity to a customized grid of points. Before using this command, you
must create a file containing the points and units.

Calculate
grid
points

Maps the field quantity to a three-dimensional cartesian grid. You specify the
dimensions and spacing of the grid in the x, y, and z directions, with units that you
specify. The initial units are taken from themodel.

Note Use of the Global Coordinate System is assumed. Local coordinate systems are not
used.

To export a field quantity to a customized grid:
1. Load the quantity into the top register for the fields calculator, and perform any operations on

it.
2. If desired, load a volume using theGeometry command.

You can use the Domain command to limit the calculation to the volume you specify. If you
export a Domain filtered numeric, points that are filtered out by the domain will not be written
out.

3. Click theExport button in the Fields Calculator.
This opens theExport Solution dialog.

4. Type or select the name of the file in which the field quantity is to be saved in theOutput File
Name text box. You can use the file icon to open the file browser to specify the file name and
directory path. A .reg extension is automatically assigned to this file.

5. Click either the Input grid points from file button if you have a created a .pts file containing
the grid points, or click theCalculate grid points button.
l If you select Input grid points from file, either type the name and directory of the file
containing the points on which the field is to bemapped, or, click on the file icon and use the
file browser to locate the point file (.pts extension).
Note By default, the field calculator usesSI units. Optionally, you can also specify the

units that you want while exporting. Add a line in the beginning of the .pts file to
specify the units. For example, if you want to usemm, a sample file would like
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this:

Unit=mm
-5.5 -5.5 -5.21475
-5.5 -5.5 -5.14425
-5.5 -5.5 -5.07375
-5.5 -5.5 -5.021

l If you selectCalculate grid points button, you can specify the coordinate system as
Cartesian, Cylindrical, or Spherical.
Cartesian: for each grid dimension on X, Y, and Z, enter theMinimum, Maximum, and
grid point spacing.
Cylindrical: for each dimension Rho, Phi, and Z, enter theMinimum, Maximum, and grid
point Spacing. You can also specify an origin of Offset.
Spherical: for each dimension R, Theta, and Phi, enter theMinimum, Maximum, and grid
point Spacing. You can also specify an origin of Offset.

Note When you export fields on a 1D or 2D line/surface from the field calculator, the start and
stop valuesmust be the same for one or two of the coordinate system start/stop ranges. If
you specify a zero spacing for a dimension, the export uses only theminimum value.

The default coordinate system is Cartesian. The default offset will be all zeros. The length
units will default to model unit and default angle unit will be degree. At the start the
minimum/maximum/Spacing entries are blank. The user-entered values are not
remembered when the dialog is closed.

6. For larger files, youmaywant to uncheck the Include points in output file box. If you
uncheck the box, the file header will includeminimum, maximumand spacing information from
which you can recalculate the grid points.

7. ClickOK to export the file.
The field quantity ismapped to the grid and saved to the file you specified (.reg extension.).

Related Topics

Using the Fields Calculator
Input Commands
Domain command

Calculating Derived Field Quantities

TheNamed Expressions panel displays expressions that can be included in register definitions by
name. You can add additional expressions to the Named expression list by creating the expression
in the register display area, and the clicking the Add button. This lets you add to the Named
expression library.
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When aMaxwell design is open and a Solution Setup has been performed, numerous predefined
named expressionsmay be available depending upon the solution type. Generally, predefined
expressions related to electric or magnetic field magnitude, current magnitude, vector field values,
energy, and losses are available
Click on a named expression to select it. When a named expression has been selected, theCopy to
Stack button is activated. ClickCopy to Stack to push the expression on the top of the stack.

Related Topics

Named Expressions
Named Expression Library

Named Expression Library

The named expression library in the Fields Calculator provides a way to conveniently calculate
frequently used quantities. The library comeswith several predefined expressions. You can combine
calculator Input commands in any legal fashion, including complex quantities, to produce new named
expressions.

l Adding named expressions to the Fields Calculator expression library
l Copying named expressions to the Calculator Stack
l Saving named expressions to a Personal Library
l Loading named expressions
l Deleting named expressions that you added

To add a named expression of your own to the Fields Calculator list:
1. In the register display area, create the expression by using the calculator Input commands.

You can combine input commands in any legal fashion, including the use of complex
quantities. If you select an input command that is not legal for a current operation, you receive
an error message.

2. When you finish creating the expression, clickAdd in the Named Expressions panel.
TheNamed Expression dialog box appears.

3. Type a name for the expression in theName text box.
The new expression is added to the list of named expressions.

To copy a named expressions to the Calculator Stack
l You can scroll through the list, select any desired named expression, and clickCopy to Stack
to move it to the calculator stack, where you can use it to generate calculated outputs.

To delete named expressions that you added:
When theNamed Expression list contains one or more user-defined expressions, theDelete and
Clear All buttons are active (you cannot delete or clear the predefined named expressions.)
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l To delete the selected user-defined named expression, clickDelete. To delete all user-
defined named expressions, clickClear All.

To save one or more named expressions for the Fields Calculator to a personal Library:
1. Click theSave To button on the Fields Calculator.

TheSelect Expressions for Saving dialog displays.
2. If any new named expressions exist, you can select one or more to save to a file.
3. Give a file name, and clickOK to save the file.

To load named expressions for the Fields Calculator from a personal library:
1. From the Fields Calculator, clickLoad From.

This displays a file browser that you can use to search for existing .clc files.
2. Select the library to load and clickOK.

This loads the expression file you have selected.

Related Topics

Calculating Derived Field Quantities

Exiting the Fields Calculator

ClickDone to exit the Fields Calculator.

Related Topics

Using the Fields Calculator

Plotting the Mesh
Before or after the solution is complete, you can plot the finite element mesh on surfaces or within 3D
objects.
1. Select a surface or object to create themesh plot on or within.

If it does not exist, create it.
2. ClickMaxwell3D>Fields>Plot Mesh or Maxwell2D>Fields>Plot Mesh.

The Create Mesh Plot dialog box appears.
3. Enter a name, or accept the default name.
4. Select the solution to plot from theSolution pull-down list.
5. Select the field quantity to plot from the Field Type pull-down list.
6. ClickDone.

Themesh appears on the surface or object you selected. An icon for themesh also appears in
theProject tree under Field Overlays -- Mesh Plots.
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If a solution is ongoing, you can select theMesh Plots icon in the in the Project tree, right-click
to display the shortcut menu, and clickUpdate Plots. This updates themesh plot to latest
data available. After the last adaptive pass, theMesh plot is automatically updated.
If a mesh includes seeding, these effects appear at the start of the adaptive passes. Anymesh
adaptation at the start of a sub sequent pass is not plotted until after that pass is completed.
This delay ensures that mesh plots and actual solutions remain consistent with each other.
You canmodify an existing plot by selecting the plot and changing the properties.

Related Topics

SettingMesh Plot Attributes

Setting Mesh Plot Attributes

1. Select theMesh Plots icon under Field Overlays in the Project tree, right-click, and select
Modify Attributes to display theMesh Plots dialog.

You can also clickMaxwell 2D orMaxwell 3D>Fields>Modify Plot Attributes , after
which theSelect Folder window appears. Select the folder containing themesh plot you
want to modify, and then clickOK to display theMesh Plots dialog.
For Mesh plots, the following attributes can bemodified:

Plot A drop down list of available plots.

Scale Factor The size at which the tetrahedra are displayed. Scalingmay let you analyze
particular situations better. For example, a scale factor of 80% draws the
tetrahedra at 80% of their original size.
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Use theScale factor slider to increase (move to the right) or decrease (move to
the left) the percentage of the tetrahedra size.

Transparency The degree of transparency for the tetrahedra. This is useful for viewing objects
or plots behind the current plot.
Use the Transparency slider to increase (move to the right) or decrease (move
to the left) the transparency of the plot.

Mesh type Whether to display the tetrahedra aswire frame or shaded, and whether to Add
Grid.

Mesh Color
for Line and
Fill

The color for the tetrahedra edge lines and fill. Clicking the button for each
displays a color selection dialog.

Surface Only Whether to plot the surface only, or all tetrahedra inside selected objects.

Real Time Whether to show changes to amesh in real time.

2. Click theSave as default button if you want the tab’s settings to apply to mesh plots created
after this point.

3. SelectReal time mode if you want the changes to take effect immediately in the view
window.
If this option is cleared, clickApplywhen you want to see the changes.

4. ClickClose to dismiss the dialog box.

Related Topics

Plotting theMesh
Plotting Field Overlays

User Defined Outputs: Introduction
User defined outputs (UDOs) allow users to define calculations through IronPython scripts or any
.NET language (and used by the IronPython script). The UDOscripts need to be in the
UserDefinedOutputs directory under either of syslib, userlib or Personallibwith any directory
structure needed for organization. (The Lib directory name is special and its purpose will be
explained in a subsequent section.)
The UDOscripts that are in syslib/UserDefinedOutputs, userlib/UserDefinedOutputs, or
Personallib/UserDefinedOutputs become available to the user to create "User Defined Solutions"
through theResults>Create User Defined Solution menu.
UseResults>Create User Defined Solution>Update Menu to refresh themenu to include the
new UDOscripts that might have been copied to syslib, userlib or Personallib, or exclude them if they
have been deleted, after the launch of desktop. Once the user-defined-solution is created, the
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solution and the calculations defined byUDObecome available in Reporter as any other quantities in
a new "User Defined" report type.

Named Probes and Properties in User DefinedOutputs
Computation of Traces Based UDOCalculations
DimensionsReduction byUDOCalculations
Dynamic Probes

Related Topics

User DefinedOutputs: Python Script API
User DefinedOutputs: Script Organization

Named Probes and Properties in User Defined Outputs

UDOs allow processing data across traces, solutions and report types. A UDOspecifies the named
probes and properties for which user selects/enters the values at the time of creation of user defined
solution. Probes are very similar to traces except that the user selects the values of only intrinsic
variables for probes. The values of design/project variables are selected when a trace is created
based upon the user defined solution in reporter.
For example, you could create a user defined solution called UDS Distance Trace Arithmetic
Result1.
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You can then access this solution in the Reporter.

Related Topics

User DefinedOutputs: An Introduction
Computation of Traces Based UDOCalculations
DimensionsReduction byUDOCalculations
Dynamic Probes

Computation of Traces Based UDO Calculations

When traces that are based upon UDOoutputs are computed, the data for probes is computed and
passed to the UDOscript for each design variation. Along with the probe data, the values of
properties entered by user are also passed. The information about the UDOcalculations that need to
be computed is alsomade available. The UDO then performs the computation and passes the
results to reporter. Note that UDOs can compute and pass backmore calculations than have been
requested at that point of time. This allowsUDOs to compute a set of calculations that take almost
same amount of computational resources as any one calculation in that set and cache that with
reporter.

Note When those calculations are subsequently plotted by the user, reporter will use the cached
results instead of invoking the computation on UDO.
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Related Topics

User DefinedOutputs: An Introduction
Named Probes and Properties in User DefinedOutputs
DimensionsReduction byUDOCalculations
Dynamic Probes

Dimensions Reduction by UDO Calculations

The probes in a UDOcan have heterogeneous dimensions of data, for example, one probe in a
UDOcan have data that is function of n intrinsic variable, while another probe in sameUDOcan
have data that is a function ofm intrinsic variables, with n andm potentially being different. UDOs
allow reducing any number of these intrinsic variables e.g in above example UDOcalculations can
be function of any number of intrinsic variables including not being function of any intrinsic variable at
all. UDOcalculations can also be a function an intrinsic variable that none of the probes is function of.
The only restriction is that Freq cannot be reduced if any of the probes are on a Fields
report type.

Related Topics

User DefinedOutputs: An Introduction
Named Probes and Properties in User DefinedOutputs
DimensionsReduction byUDOCalculations
Dynamic Probes

Dynamic Probes

In addition to named probes and properties, UDOs can specify named dynamic probes. The
difference between probes and dynamic probes is that while the end-user of UDOspecifies the
complete trace definition for probe, the expression for dynamic probe is specified byUDOcode itself
and not by the end-user. This allowsUDOs to access the data for probeswithout having the end-
user enter each individual probe. For example a UDOcan access data for a huge S matrix for a 100
port design without requiring the end-user to enter the probe information for each of those 10,000
quantities. Each dynamic probe is associated with a named probe that is entered by the user; and
information about solution, context, and intrinsic variables is used from user-selected probe.
However multiple dynamic probes can be associated with the same user-selected probe. The
dynamic probes are enquired fromUDOs at the time of trace computation and not at the time of
creation of user-defined solution.

Post Processing andGenerating Reports 23-174
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Thismeans that you select solution, context, and values of intrinsic variables just once; and the same
information is used (in this case) for all clock and data signals. The expression for those signals
comes from the UDOcode.

Related Topics

User DefinedOutputs: An Introduction
Named Probes and Properties in User DefinedOutputs
Computation of Traces Based UDOCalculations
DimensionsReduction byUDOCalculations
Dynamic Probes

User Defined Outputs: Python Script API
A User DefinedOutput (UDO) extension is implemented as an IronPython script that defines a class
with a specific name:UDOExtension which derives from a specific base class
IUDOPluginExtension and implements its abstract methods.
UDOExtension IMPLEMENTATION
Optional Functions in IDOExtension Abstract Class
Data TypesUsed in Python Script
WorkingWith Properties for UDO
Other Application Specific ClassesUsed in Python Scripts
User DefinedOutputs: MessagingMethods
Using .NET Collection Classes and Interfaces in Python Scripts

Related Topics

User DefinedOutputs: An Introduction
User DefinedOutputs: Script Organization
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UDO Extension IMPLEMENTATION

The purpose, argument list and expected return types for each of the IUDOPluginExtension
abstract methods, which the UDOauthor is expected to implement are described below.
Import Statements
UDOExtension Class
IUDOPluginExtension Abstract Class

Related Topics

User DefinedOutputs: Python Script API

Import Statements

The base class to be used and the types it uses in turn are contained in .NET assemblies. The use of
these requires that the assemblies be imported into the UDOscript: the following import statements
should be added to the top of the python script:

fromAnsys.Ansoft.ModulePluginDotNet.Common.API import *
fromAnsys.Ansoft.ModulePluginDotNet.Common.API.Interfaces import *
fromAnsys.Ansoft.ModulePluginDotNet.UDO.API.Interfaces import *
fromAnsys.Ansoft.ModulePluginDotNet.UDO.API.Data import *

Related Topics

UDOExtension IMPLEMENTATION

UDOExtension Class

TheUDO itself should be implemented as an IronPython class calledUDOExtensionwhichmust
derive from the IUDOPluginExtension abstract base class (from the
Ansys.Ansoft.ModulePluginDotNet.UDO.API.Interfaces namespace).
Note that power users could derive a class hierarchy tuned toward a specific type of UDOs and that
they can derive from their own base classes. The only requirement is that directly or indirectly, the
UDOclassmust derive from IUDOPluginExtension.
Example:

def BaseClassUDO ((IUDOPluginExtension):
#base class implementation

…
def UDOExtension ((BaseClassUDO):
#UDOclass implementation
…
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Related Topics

UDOExtension IMPLEMENTATION

IUDOPluginExtension Abstract Class

The implementation of the IUDOPluginExtension classwill be described in this section using a
simple UDOexample that expects a single probe and reduces its dimension returning as its outputs,
themax, min and average of its input probe data. The script in its entirety will also be listed later on.

Required functions:
The IUDOPluginExtension abstract class declares the following abstract methods that must be
implemented in the UDOExtension class or one of its base classes. Not implementing any of these
methodswill result in a run-time error and a non functioning UDO. The UDS refers to user Defined
Solution parameters.
GetUDSName()
GetUDSDescription()
GetUDSSweepNames()
GetCategoryNames()
GetQuantityNames(string categoryName)
GetQuantityInfo(string quantityName)
GetInputUDSParams(List<UDSProbeParams> udsParams,
GetDynamicProbes(List<UDSDynamicProbes> dynamicProbes);
Compute(IUDSInputData inData,

Related Topics

UDOExtension IMPLEMENTATION

GetUDSName()

l Purpose: Return a string that is used as a prefix for all solution instances created using this
UDO.

l Returns: string.
Example:

def GetUDSName(self):

return "MinMaxAvg
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Related Topics

IUDOPluginExtension Abstract Class

GetUDSDescription()

l Purpose: Returns a description for the UDO, its purpose etc. This is used inmultiple UDO
related dialogs in the application to describe the UDO.

l Returns: string.
Example:

def GetUDSDescription(self):

return "Sample UDO for dimension reducing quantities

Related Topics

IUDOPluginExtension Abstract Class

GetUDSSweepNames()

l Purpose: Returns a list of sweep names to be used for the solution generated by the UDO.
These will appear in the sweeps list displayed in the standard reporter dialog when used to
create reports from the solution generated by the UDO.

l Returns: list of strings. If the UDOoutputs have no sweeps, return the empty list [].
Example:

# Returns list of sweeps names
#We have no sweeps aswe reduce them.
def GetUDSSweepNames(self):

return []

Related Topics

IUDOPluginExtension Abstract Class

GetCategoryNames()

l Purpose: The outputs that the UDOsolution provides/generates can be classified into
multiple categories (like how the application does as displayed in the report creation dialog).
These will be listed in the categories box in the dialog when creating reports from the UDO
generated solution data.

l Returns: list of strings.
Example:
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def GetCategoryNames(self):

return ["UDOOutputs"]

Related Topics

IUDOPluginExtension Abstract Class

GetQuantityNames(string categoryName)

l Purpose: For each of the category names returned from theGetCategoryNamesmethod,
this function is called to return a list of quantities to be organized under that category name.
Note that the quantity names must be unique across the categories: that is, no two
categories can have quantities with the same name.

l Parameters:
l categoryName (input python string) - category name.

l Returns: python list of strings.
Example:

# returns a list of quantity names for the supplied category name
def GetQuantityNames(self, catName):

if catName == "UDOOutputs":

return ["min_val", "max_val", "avg_val"]

else:

return []

Related Topics

IUDOPluginExtension Abstract Class

GetQuantityInfo(string quantityName)

l Purpose: For each quantity that the UDOcreates, it must also describe the quantity (unit and
other details). Thismethod is called for each quantity name (across all categories) as returned
from an earlier call of theGetQuantityNamesmethod.

l Parameters:
l quantityName (input string) - quantity name.

l Returns: Object of typeQuantityInfo.
Example:

# Returns an instance of QuantityInfo for the qtyName supplied or None if such a
# quantity could not be found
def GetQuantityInfo(self, qtyName):
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# All the quantities we have are simple doubles

# we can leave them unitless

return QuantityInfo(Constants.kDoubleParamStr)

Related Topics

IUDOPluginExtension Abstract Class

GetInputUDSParams(List<UDSProbeParams> udsParams,

IPropertyList propList,
List<UDSProbeParams> userSelectionForDynamicProbes)

l Purpose: This is themain definition part of the UDO. The supplied arguments are used to
populate details of the parameters to which the UDOuser will specify value, specify the probe
names and their types aswell as the dynamic probe selections.

l Parameters:
l udsParams - .NET list of UDSProbeParams objects: The UDOscript is expected to add
one instance of UDSProbeParams for each probe definition it wants displayed. The UDO
user will, when creating the UDOsolution assign amatching quantity to each such probe.

l propList - IPropertyList object: The propList object is used to add properties that should be
displayed to the user for data collection. These properties with the user supplied valueswill
be returned to the UDOscript in the Computemethods.

l userSelectionForDynamicProbes - .NET list of UDSProbeParam objects.
l Returns: boolean: True on success, False on failure.

Example:
# Returns list of UDSParams and list of dynamic properties
# Adds setup time properties to the propList
def GetInputUDSParams(self, udsParams, propList, userSelectedDynamicProbes):

# Add the probes.We need only one double quantity

param1 = UDSProbeParams("probe1",

"double quantity probe",
Constants.kDoubleParamStr,
"", "")

udsParams.Add(param1)

# Add the properties wewant the user to supply

Post Processing andGenerating Reports 23-180
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

# In this case, we will ask for a start/end range for

# X parameters. Since we cannot reasonably provide defaults

# aswe have no idea what the sweep limits will be, we will

# also ask if the limits are to be activated.

prop = propList.AddNumberProperty("X Min", "0")

prop.Description = "Start X value to consider"

prop = propList.AddNumberProperty("X Max", "1")

prop.Description = "End X value to consider"

# For menus, the first option is the default.

prop = propList.AddMenuProperty("Activate X Limits", ["No", "Yes"])

prop.Description = "Activate X range"

return True

The above function results in the following dialog when you clickReports>Create User Defined
Solution. Themapping from the UDSParams and the properties to the GUI elements should be
unambiguous. The name and description of the UDS are also displayed in this dialog.
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When a report is created from the UDOdialog, the category/quantity names specified by the UDO
are used (as shown below).

Related Topics

IUDOPluginExtension Abstract Class

GetDynamicProbes(List<UDSDynamicProbes> dynamicProbes);

l Parameters: dynamicProbes - .Net list of UDSDynamicProbes objects. Output parameter.
l Returns: True on success, False on failure.

Example:
# Returns list of UDSParams and list of dynamic properties
# output UDSDynamicProbeCollection probes
def GetDynamicProbes(self, probes):

pass

Related Topics

IUDOPluginExtension Abstract Class
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Compute(IUDSInputData inData,

IUDSOutputData outData,

IPropertyList propList,

IProgressMonitor progressMonitor)

l Purpose: This is themain computationmethod which generates the data for the quantities
that make up the UDOsolution.

l Parameters:
l inData - UDSInputData object: Used to get the input probe data.
l outData - UDSOutputData object: Used to set the UDOsolution quantity and sweep data.

l propList - IPropertyList object: Used to get the user entered values for each of the
properties defined during theGetInputUDSParams call.

l progressMonitor - IProgressMonitor object. This can be used to set progress for long
running calculations, check for user initiated abort etc.

l Returns: True on success, False on failure.
The data is received fromUI using IUDSInputDataAPI. It is processed and the result data is sent to
UI using IUDSOutputData API.
Example:
# IUserDefinedSolutionHandle API implementation.
# Calculates output values and sets them using IUDSInputData/IUDSOutputData API.
def Compute(self, inData, outData, propList, progMon):

# Get the sweeps associated with the probe and validate
# use the probe name that we had defined earlier
sweeps = inData.GetSweepNamesForProbe("probe1")
if( sweeps == None or sweeps.Count > 1):

AddErrorMessage(self.GetName() + "Unexpected sweep count 0 or > 1 in Compute")

return False

#Get the data associated with our probe
probeData = inData.GetDoubleProbeData("probe1")
sweepData = inData.GetSweepsDataForProbe("probe1", sweeps[0])

# Get the user specified properties.
# Note that ideally, these "X Min" etc names should be written as
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# constant membets and referred to in both the GetInputUDSParams
# and in Compute to reduce the change of typos.
useXRangeProp = propList.GetMenuProperty("Activate X Limits").SelectedMenuChoice
xRangeStart = propList.GetNumberProperty("X Min").ValueSI
xRangeEnd = propList.GetNumberProperty("X Max").ValueSI

# At this stage, one can look at the RequestedQuantities and create
# a dictionary to later check against. However, I am simply computing
# all the quantities.
minVal = 0
maxVal = 0
avgVal = 0

# Check if we need to perform range computation
if useXRangeProp == "Yes":

seenAny = False
avgSum= 0
count = 0

# zip is used since we also need to pull in sweep data

# an index and the array notation could also have been used

for probeVal, sweepVal in zip(probeData, sweepData):

if sweepVal < xRangeStart or sweepVal > xRangeEnd:
pass

# Note that in a better written script, this code would be
# refactored into it's own function to avoid code
# duplication
if not seenAny:
minVal = probeVal
maxVal = probeVal
avgSum= probeVal
seenAny = True
count = 1
else:
if probeVal < minVal:
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minVal = probeVal

if probeVal > maxVal:
maxVal = probeVal

avgSum+= probeVal
count += 1

if seenAny:
avgVal = avgSum/count

else:

seenAny = False
avgSum= 0
for probeVal in probeData:

if not seenAny:
minVal = probeVal
maxVal = probeVal
avgSum= probeVal
seenAny = True
else:
if probeVal < minVal:

minVal = probeVal

if probeVal > maxVal:
maxVal = probeVal

avgSum+= probeVal

if seenAny:
avgVal = avgSum/probeData.Count

# Finally set the output values. Note that these are always set as

# lists even if we have just one item.
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outData.SetDoubleQuantityData("min_val", [minVal])

outData.SetDoubleQuantityData("max_val", [maxVal])

outData.SetDoubleQuantityData("avg_val", [avgVal])

# And we are done.

return True

Related Topics

IUDOPluginExtension Abstract Class

Optional Functions in IDO Extension Abstract Class

The following functions, while a part of the IUDOExtension abstract class, havemeaningful default
implementations and are therefore optional. However, they can be overridden to take advantage of
advanced functionality.
Validate(List<string> errorStringList,

Related Topics

User DefinedOutputs: Python Script API

Validate(List<string> errorStringList,

List<UDSProbeParams> udsProbParams,
IPropertyList propList,
List<UDSProbeParams> userSelectionForDynamicProbes)

l Purpose: Thismethod is used to validate the user choices. The values of the properties
entered, the probes etc. can be checked for suitability.

l Parameters:
l udsProbParams - C# list of UDSProbeParams objects.
l propList - IPropertyList object.
l userSelectionForDynamicProbes - C# list of UDSProbeParams objects.
l errorStringList - C# list of python strings. Output parameter. Should be set only if validation
failed; ignored if validation is successful. One error string should be set per each validation
error.

l Returns: True on validation success, False on failure.
l Default implementation: always returns true.

Example:
def Validate(self, errorStringList,probeList,propList, dynamicProbes):
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if probeList == None or probeList.Count == 0:

errorStringList.Add("Empty probe list")
return False

return True

Related Topics

Optional Functions in IDOExtension Abstract Class

Data Types Used in Python Script

There are several types that youmust use while authoring the python script. Some of them are used
to pass data fromUI to python script and to provide interface for working with this data. Some are
used to pass data from python script to UI.
To pass data from python script to UI the objects of the C# classmust be created in python script
using their C# constructors. Then they can be set as functions return values or set to the output
parameters using their API.

Constants class

kTraceTypeStr : string constant used to specify an input of trace type
kSolutionTypeStr : string constant used to specify an input of solution type
kNumberTypeStr : string constant used to specify an input of number type
kTextTypeStr : string constant used to specify an input of text type
kBoolTypeStr : string constant used to specify an input of boolean type
kStandardReportStr : string constant to specify a standard report
kEyeDiagramReportStr : string constant to specify an eye diagram report
kUserDefinedReportStr : string constant to specify a user defined report
kSweepDomainStr : string constant to specify the sweep domain
kTimeDomainStr : string constant to specify the time domain

UDDInputParams class

The objects of this classmust be created in python script in theGetUDDInputParams() function
and theSetUDDInputParams() function.
Attributes :
Input Name (string)
Input Description (string)
Input Type ( Can be Boolean, Number, Text, Trace or Solution) (string)
BoolData (boolean)
DoubleData (double)
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TextData (string)
ReportType (string)
SolutionName (string)
DomainName (string)
Constructors:
UDDInputParams(string name, string description, string type)
UDDInputParams(string name, string description, string type, bool data)
UDDInputParams(string name, string description, string type, double data)
UDDInputParams(string name, string description, string type, string data)
UDDInputParams(string name, string description, string type, string reportType, string
solutionName, string domainName)
Property Accessors :
Name : Get/Set the name of an input
Description : Get/Set the desccription of an input
Type : Get/Set the type of an input
BoolData : Get/Set the data of a boolean input
DoubleData : Get/Set the data of a number input
TextData : Get/Set the data of a text input
ReportType : Get/Set the report type
SolutionName : Get/Set the name of the solution
DomainName : Get/Set the name of the domain

IProgressMonitor Abstract Class

The object of this class is a progressmonitor. It is used to display calculations progress in UI and
check is the user has requested an abort of the computation.
When displayed in the application, each progressmessage has four items:

A task name
A sub-task name
The progress amount
A button to abort the task in progress.

All of this functionality and abort interaction is achieved using the following functions.
SetTaskName (string taskName):
SetSubTaskName (string subTaskName)
BeginTask (string name)
SetTaskProgressPercentage(int progressPercent)

CheckForAbort(): If the quantities being generated are computationally expensive, the UDO
author can periodically call thismethod and then call EndTaskwith Fail and return False.
EndTask (bool passFail)
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Example:
progMon.BeginTask("Process DQS")
progMon.SetSubTaskName("Compute UI segments")
progMon.SetTaskProgressPercentage(33)
progMon.SetSubTaskName("Compute the rest")
progMon.SetTaskProgressPercentage(100)
progMon.EndTask(True)

IUDSInputData

The purpose of this class is to get data (probe and sweep) fromDesktop.
Examples in this section are just to show proper syntax of the function calls. For actual usage of the
class see Compute function example.
GetDoubleProbeData(probeName)
GetSweepsDataForProbe(probeName, sweepName)
GetComplexProbeData(probeName)
GetSweepNamesForProbe(probeName)
GetRequiredQuantities()
GetVariableValues()
GetInterpolationOrdersData(probeName);

Related Topics

Data TypesUsed in Python Script

GetDoubleProbeData(probeName)

l Purpose: This is the primarymechanism bywhich the UDOscript obtains the probe data (as
double precision values) for its compute process.

l Parameters:
l probeName: string representing the probe name for which data is requested. This has to be
one of themany probes supplied during a call to the UDO'sGetInputUDSParamsmethod.

l Returns: .NET double Array of data for the specified probe if the probe exists or null if the
probe is unknown.

Example:
# doubleData is a list of floats
doubleData = inData.GetDoubleProbeData("probe1")

Related Topics

Data TypesUsed in Python Script
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GetSweepsDataForProbe(probeName, sweepName)

l Purpose: All probe data that is supplied is associated with one oremore sweep (an intrinsic
quantity like Time, Frequency, Theta, Phi etc that is swept) quantities.

l Parameters:
l probeName - probe name for which which want the sweep data
l sweepName - sweep name

l Returns: .NET double Array of data for the specified probe and sweep.
Example:

# sweepData is C# Array of doubles (floats in python)
sweepData = inData.GetSweepsDataForProbe("FarFieldsProbe","Freq"])

Related Topics

Data TypesUsed in Python Script

GetComplexProbeData(probeName)

l Purpose: The primarymechanism bywhich the UDO retrieves data for its input probes (if it
expects complex data for the probe).

l Parameters:
l probeName - probe name for which complex data is requested

l Returns: .NET double Array (float in python) of data for the specified probe. Each pair of
floats represent one complex number: first value is for real part, second value for imaginary
part. For instance, array [10.0, 0, 5.1, 2.1] represents 2 complex numbers: (10.0, 0) and (5.1,
2.1).

Example:
# complexDataAsDouble is C# Array of doubles (floats in python)
# each pair of floats represents one complex number
complexDataAsDouble = inData.GetComplexProbeData("FarFieldsProbe")
# creating a list of complex numbers from complexDataAsDouble array
complexData = []
if complexDataAsDouble != None:

for i in xrange(0,complexDataAsDouble.Count , 2):

complexData.append(complex(complexDataAsDouble[i],complexDataAsDouble[i+1]))

Related Topics

Data TypesUsed in Python Script
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GetSweepNamesForProbe(probeName)

l Purpose: To obtain the list of sweep quantity names associated with a given probe. This also
indicates the dimensionality of the data. One name implies that the probe-data is 2D (probe-
quantity vs SweepQuantity) and two names implies 3D data ( probe-quantity vs Sweep 1 X
Sweep 2).

l Parameters:
l probeName - probe name.

l Returns: .NET IList<string> - list of sweep names for the current probe name.
Example:

# sweepNames is C# Array of strings
sweepNames = inData.GetSweepNamesForProbe("FarFieldsProbe")

Related Topics

Data TypesUsed in Python Script

GetRequiredQuantities()

l Purpose: A given UDOcan specify that it provides one of more computed quantities. The
user might choose to create a report from only a few among the various available UDO
outputs. This function, returns that list of the UDOoutput quantities that the user has
requested. Only these need be computed in the UDO's computemethod.

l Returns: .NET IList<string> - list of required quantities names.
Example:

# quantities is C# Array of strings
quantities= inData.GetRequiredQuantities()

Related Topics

Data TypesUsed in Python Script

GetVariableValues()

l Purpose: This allows the UDO to obtain the names and values of all the design variables for
which the UDOquantities are being requested.

l Returns: .NET IDictionary<string,string> of key-value pairs for variables. Both key and value
are strings.

Example:
# theDict is C# Dictionary<string, string>
theDict = inData.GetVariableValues()
if theDict != None:
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#varPair is of .Net KeyValuePair type

for varPair in theDict:

varName = varPair.Key #string
varValue = varPair.Value #string

Related Topics

Data TypesUsed in Python Script

GetInterpolationOrdersData(probeName);

l Purpose: Returns the interpolation orders that are associated with the probe-data. The probe
data is specified at each value of the various sweeps. Any value in between the sweep data
points, can use the interpolation data to get a possiblymore accurate (compared to linear
interpolation) inter-sweep value.

l Parameters:
l probeName (input python string) - probe name.

l Returns: NET byte Array of interpolation order for the specified probe. These are to be
treated as 8bit signed integers, that is, their values range from 0-127.

Example:
# interData is C# Array of bytes (integers in python)
interData = inData.GetInterpolationOrdersData(kProbeNames[0])

for interValue in theDict:

order = interValue # interValue and order are integers

Related Topics

Data TypesUsed in Python Script

IUDSOutputData

This type is a twin of the IUDSInputData in that it is used to store the values computed by the UDO's
computemethod.
Examples in this section are just to show proper syntaxis function calls. For actual usage of the class
see the Compute function example.
SetSweepsData(sweepName, sweepData)
SetDoubleQuantityData(qtyName,qtyData)
SetComplexQuantityData(qtyName, qtyData)
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Related Topics

Data TypesUsed in Python Script

SetSweepsData(sweepName, sweepData)

l Purpose: Each quantity that is computed by the UDOcan be associated with a sweep. If it is,
the values that make up the sweep's data pointsmust be specified using this call.

l Parameters:
l sweepName (string) - sweep name.
l sweepData (python list of floats) - sweep data for the specified sweep.

l Returns: True on success, False on failure.
Example:

sweepList = [12.3, 14.5, 16.7]
outData.SetSweepsData("Freq", sweepList)

Related Topics

Data TypesUsed in Python Script

SetDoubleQuantityData(qtyName,qtyData)

l Purpose: Thismethod is used to record the computed quantity data for each output that is
computed. Please note that unless all the sweeps are reduced, this should be used in
conjunction with SetSweepsData

l Parameters:
l qtyName (string) - quantity name.
l qtyData (python list of floats) - quantity data for the specified quantity.

l Returns: True on success, False on failure.
Example:

doubleList = [12.3, 14.5, 16.7]
outData.SetDoubleQuantityData("V1PlusV2", doubleList)

Related Topics

Data TypesUsed in Python Script

SetComplexQuantityData(qtyName, qtyData)

l Purpose: If the quantity computed is a complex quantity, use thismethod to set the quantity
values. Any sweep valuesmust be set separately via the SetSweepsDatamethod.
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l Parameters:
l qtyName (string) - quantity name.
l qtyData (python list of floats) - quantity data for the specified quantity. Complex numbers
are passed as pairs of floats

l Returns: True on success, False on failure.
Example:

doubleFromComplexList=[]
complexList = [(1+1j), (2+4j), (9.1+3.2j)]
for aComplex in complexList:

doubleFromComplexList.append(aComplex.imag)

doubleFromComplexList.append(aComplex.real)

outData. SetComplexQuantityData ("V1PlusV2", doubleFromComplexList)

Related Topics

Data TypesUsed in Python Script

Working With Properties for UDO

A property is the unit for collecting and using input from the user that is used to influence the UDO's
Compute. These are initially set up when the UDOsGetInputUDSParams method is called and
are retrieved in the UDO's Computemethod.
There are 3 supported property types that could be used in the UDOscript:

l INumberProperty to specify number properties (with unit support).
l IMenuProperty to allow the user to select from a list of options.
l ITextProperty to allow the user to enter text.

The IPropertyList type implements a collection for these properties.
IPropertyList Abstract class
IProperty Abstract class
INumberProperty Abstract class
ITextProperty Abstract class
IMenuProperty Abstract class

Related Topics

User DefinedOutputs: Python Script API

IPropertyList Abstract class

Attributes:

Post Processing andGenerating Reports 23-194
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l AllProperties (IEnumerable<IProperty> - see IProperty)
l NumProperties (int)

Functions:
l GetProperty(string propName): Returns a named property as an IProperty.
l GetMenuProperty (string propName): Returns the named property as an IMenuProperty.
l GetTextProperty (string propName): Returns the named property as an ITextProperty
l GetNumberProperty (string propName): Returns the named property as an INumberProperty

l DeleteProperty (string propName): Deletes an already added named property
l AddNumberProperty(string name, string numberWithUnits): Adds a new number property. If
a property with the same name already exists, it is overwritten.

l AddTextProperty(string name, string textValue): Adds a new named text property with the
supplied value. Any existing property with the same name is overwritten.

l AddMenuProperty(string name, IList<string> menuChoices): Creates a new namedmenu
property with the supplied list of choices. The default selection is set to item 0 (the first item).
Any property with the same name is overwritten.

IProperty Abstract class

Attributes:
l Name (string)
l Description (string)
l PropType (read-only EPropType - see Constants)

Constructor:
l IProperty(string name, EPropType type)

The class is used as base class for INumberProperty, IMenuProperty, and ITextProperty.

INumberProperty Abstract class

Base class:
l abstract class IProperty

Attributes:
l ValueSI (read-only double)
l ValueInUnits (read-only double)
l Units (read-only string)
l HasUnits (read-only bool)

Constructor:
l INumberProperty(string name)

Functions:
l Set(string numberWithUnits)
l SetDouble(double number, string unitString)
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ITextProperty Abstract class

Base class:
l abstract class IProperty

Attributes:
l Text (string)

Constructor:
l ITextProperty(string name)

IMenuProperty Abstract class

Base class:
l abstract class IProperty

Attributes:
l MenuSelection (int): This represents the index into theMenuChoices list.
l SelectedMenuChoice (string): This is the item in theMenuChoices list corresponding to the
MenuSelection index

l MenuChoices (IList<string>)
Constructor:

l IMenuProperty (string name)
Example:

# adding data to IPropertyList propList; used in Compute function
prop = propList.AddNumberProperty('Offset 1', '0')
prop.Description = 'Trace 1Offset'
prop = propList.AddNumberProperty("TRATE", "800MHz")
prop.Description = "Frequency"
prop = propList.AddTextProperty("Text", "The Text")
prop.Description = "Text Property"
prop = propList.AddMenuProperty('Operation', ['Add', 'Subtract', 'Max' ,'Min','Mean'])
prop.Description = 'Operationmenu'

# reading data from IPropertyList propList; used in Validate function
numOfNumberProperties = 0

if propList != None and propList.AllProperties != None:

for prop in propList.AllProperties:
if prop.PropType == Constants.EPropType.PT_NUMBER:
numOfNumberProperties ++
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Other Application Specific Classes Used in Python Scripts

This section describes other classes used in Python scripts:
Constants Class
UDSProbeParamsClass
UDSDynamicProbesClass
QuantityInfo Class
IProgressMonitor Abstract Class

Related Topics

User DefinedOutputs: Python Script API

Constants Class

The constants used in python script are defined in the Constants class.
Attributes:

l kDoubleParamStr : string constant used to specify double as the type of a quantity
l kComplexParamStr: string constant used to specify complex as the type of a quantity

EnumEPropType: (used to set property type)
EPropType.PT_NUMBER
EPropType.PT_TEXT
EPropType.PT_MENU

Example:
paramType = Constants.kDoubleParamStr
propType = Constants.EPropType.PT_NUMBER

Related Topics

Other Application Specific ClassesUsed in Python Scripts

UDSProbeParams Class

The objects of this classmust be created in python script inGetInputUDSParams function. They
are supplied to the Validate function if implemented.
Attributes:

l ProbeName (read-only string)
l ProbeDescription (read-only string)
l ParamType (read-only string)
l ReportTypeName (read-only string)
l ComponentExpression (read-only string)
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Constructor: UDSProbeParams(string probeName, string probeDescription, string paramType,
string reportTypeName, string componentExpression);

l probeName - required.
l probeDescription - optional (can be empty string).
l paramType - required; can be one of the Constants

l kDoubleParamStr
l kComplexParamStr

l reportTypeName - optional (can be empty string)
l ComponentExpression - optional (can be empty string)

Example:
udsProbParam = UDSProbeParams("probe1","", Constants.kDoubleParamStr, "", "",)

Related Topics

Other Application Specific ClassesUsed in Python Scripts

UDSDynamicProbes Class

Attributes:
l UDSParam (read-only UDSProbeParams)
l UserSelectedProbeName (read-only string)

Constructor: UDSDynamicProbes (UDSProbeParams udsParam, string
userSelectedProbeName.

l udsParam - required
l userSelectedProbeName - required

Example:
udsProbParam = UDSProbeParams("probe1","", Constants.kDoubleParamStr, "", "",)
selectedName = "probe1"
udsDynamicProbParam= UDSDynamicProbes(udsProbParam , selectedName )

Related Topics

Other Application Specific ClassesUsed in Python Scripts

QuantityInfo Class

Attributes:
l ParamType (read-only string)
l FullUnitType (read-only string)

Constructors:
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l QuantityInfo(string paramType)
l QuantityInfo(string paramType, string fullUnitType)
l Parameters:

l paramType can be one of the Constants

kDoubleParamStr

kComplexParamStr

l fullUnitType is a case insensitive string representing full unit type. It is not defined in
Constants. Instead you can use any of the units in string representation - for example, "mm"
or"ghz".

Example:
quantityInfo1 = QuantityInfo(Constants.kDoubleParamStr)
quantityInfo2 = QuantityInfo(Constants.kDoubleParamStr,"ghz")

Related Topics

Other Application Specific ClassesUsed in Python Scripts

IProgressMonitor Abstract Class

The object of this class is a progressmonitor. It is used to display calculations progress in UI and
check is the user has requested an abort of the computation.
When displayed in the application, each progressmessage has four items:

l A task name
l A sub-task name
l The progress amount
l A button to abort the task in progress.

All of this functionality and abort interaction is achieved using the following functions.
l SetTaskName (string taskName):
l SetSubTaskName (string subTaskName)
l BeginTask (string name)
l SetTaskProgressPercentage(int progressPercent)
l CheckForAbort(): If the quantities being generated are computationally expensive, the UDO
author can periodically call thismethod and then call EndTaskwith Fail and return False.

l EndTask (bool passFail)
Example:

progMon.BeginTask("ProcessDQS")
progMon.SetSubTaskName("Compute UI segments")
progMon.SetTaskProgressPercentage(33)
progMon.SetSubTaskName("Compute the rest")
progMon.SetTaskProgressPercentage(100)
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progMon.EndTask(True)

Related Topics

Other Application Specific ClassesUsed in Python Scripts

Using .NET Collection Classes and Interfaces in Python Scripts

Some of the API functions specified above use .Net collection classes and interfaces, that is, Array
class, IList interface, IEnumerable interface, and IDictionary interface. The following section
describes how to work with the .Net collection objects in Python scripts.
.NET Array, IEnumerable, and IList objects can be indexed and iterated over as if theywere Python
lists. You can also check for membership using 'in'. To get .Net Array and IList sizes you can use
python's 'len' or .Net 'Count'.
Example:

Getting size:

arraySize = doubleDataArray.Count

arraySize = len(doubleDataArray)

listSize = sweepsNamesList.Count

listSize = len(sweepsNamesList)

Iterating:

for sweep in sweepsNamesList:

print sweep

for in in xrange(listSize)

print sweepsNamesList[i]

Checking for membership:

if 'Time' in sweepsNamesList:

doThis()

else:

doThat()
For .NET IDictionary, the same as for Array and IList, you can get size with 'len' or 'Count' and check
for membership of the keys using 'in'. Getting values for the keys also works the sameway as in
python 'dict'.
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Example
Getting size:

varValuesSize = varValues.Count

varValuesSize = len(varValues)

Checking for membership:

if 'offset' in varValues:

print varValues['offset']
Getting value:

if 'offset' in varValues:

offsetValue = varValues['offset']
As for iteration .NET Dictionary is different from python dict. While iterating, python dict will return
keys, .Net Dictionary will return .Net KeyValuePair.
Example:

Iterating:
for .Net IDictionary:

for varPair in varValues: #varPair is of .Net KeyValuePair type

varName = varPair.Key
varValue = varPair.Value

for python dict:

for varName in varValues:

varValue = varValues[varName]
You can use python types instead of .Net types if you prefer. For this you need to cast .Net Array and
.Net iList to python list type and .Net Dictionary to python dict type.
Casting should not be used for data arrays - it can be extremely costly for thememory usage aswell
as time consuming.
Example:

aPythonList = list(dotNetArray)
aPythonList = list(dotNetList)
aPythonDict = dict(dotNetDictionary)

Related Topics

User DefinedOutputs: Python Script API
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User Defined Outputs: Messaging Methods

Messagingmethods are provided to convey additional information to the user from any of the UDOs
methods. The Compute function is the one typically location where such use is anticipated. Any
message sent via these functions are displayed in the application'smessage window using the
appropriate icon.
These functions can also be used for debugging purposes.

l AddErrorMessage(string): Call thismethod to convey an error condition to the user.
l AddWarningMessage(string): Call thismethod to convey a warningmessage: typically
used for conditions that are not ideal but can be tolerated by the script.

l AddInfoMessage(string): Call thismethod to convey an informational message to the user.
This is the call to use when outputtingmessages for debugging purposes.

##############################################################
# Imports
##############################################################
fromAnsys.Ansoft.ModulePluginDotNet.Common.API import *
fromAnsys.Ansoft.ModulePluginDotNet.Common.API.Interfaces import *
fromAnsys.Ansoft.ModulePluginDotNet.UDO.API.Interfaces import *
fromAnsys.Ansoft.ModulePluginDotNet.UDO.API.Data import *
class UDOExtension(IUDOPluginExtension):

def __init__(self):

pass

#--- IDA IUDOPluginExtension ------------------------
def GetUDSName(self):

return "MinMaxAvg"

#--- ISA IUDOPluginExtension ------------------------
def GetUDSDescription(self):

return "Sample UDO for dimension reducing quantities"

#--- ISA IUDOPluginExtension ------------------------
# Returns list of category names
def GetCategoryNames(self):

return ["UDOOutputs"]
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#--- ISA IUDOPluginExtension ------------------------
# returns a list of quantity names for the supplied category name
def GetQuantityNames(self, catName):

if catName == "UDOOutputs":

return ["min_val", "max_val", "avg_val"]

else:

return []

#--- ISA IUDOPluginExtension ------------------------
# Returns an instance of QuantityInfo for the qtyName supplied or None if such a
# quantity could not be found
def GetQuantityInfo(self, qtyName):

# All the quantities we have are simple doubles

# we can leave them unitless

return QuantityInfo(Constants.kDoubleParamStr)

#--- ISA IUDOPluginExtension ------------------------
# Returns list of UDSParams and list of dynamic properties
# Adds setup time properties to the propList
def GetInputUDSParams(self, udsParams, propList, userSelectedDynamicProbes):

# Add the probes.We need only one double quantity

param1 = UDSProbeParams("probe1",

"double quantity probe",
Constants.kDoubleParamStr,
"", "")

udsParams.Add(param1)

# Add the properties wewant the user to supply

# In this case, we will ask for a start/end range for

# X parameters. Since we cannot reasonably provide defaults

# aswe have no idea what the sweep limits will be, we will
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# also ask if the limits are to be activated.

prop = propList.AddNumberProperty("X Min", "0")

prop.Description = "Start X value to consider"

prop = propList.AddNumberProperty("X Max", "1")

prop.Description = "End X value to consider"

# For menus, the first option is the default.

prop = propList.AddMenuProperty("Activate X Limits", ["No", "Yes"])

prop.Description = "Activate X range"

return True

#--- ISA IUDOPluginExtension ------------------------
# Returns list of UDSParams and list of dynamic properties
# output UDSDynamicProbeCollection probes
def GetDynamicProbes(self, probes):

pass

#--- ISA IUDOPluginExtension ------------------------
# Returns list of sweeps names
#We have no sweeps aswe reduce them.
def GetUDSSweepNames(self):

return []

#---------------------------------------------------------------------------------
# IUserDefinedSolutionHandle API implementation.
# Calculates output values and sets them using IUDSInputData/IUDSOutputData API.
def Compute(self, inData, outData, propList, progMon):

# Get the sweeps associated with the probe and validate
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# use the probe name that we had defined earlier

sweeps = inData.GetSweepNamesForProbe("probe1")

if( sweeps == None or sweeps.Count > 1):

AddErrorMessage(self.GetName() + "Unexpected sweep count 0 or > 1 in Compute")
return False

#Get the data associated with our probe

probeData = inData.GetDoubleProbeData("probe1")

sweepData = inData.GetSweepsDataForProbe("probe1", sweeps[0])

# Get the user specified properties.
# Note that ideally, these "X Min" etc names should be written as
# constant members and referred to in both the GetInputUDSParams
# and in Compute to reduce the change of typos.
useXRangeProp = propList.GetMenuProperty("Activate X
Limits").SelectedMenuChoice
xRangeStart = propList.GetNumberProperty("X Min").ValueSI
xRangeEnd = propList.GetNumberProperty("X Max").ValueSI

# At this stage, one can look at the RequestedQuantities and create
# a dictionary to later check against. However, I am simply computing
# all the quantities.

minVal = 0
maxVal = 0
avgVal = 0

# Check if we need to perform range computation
if useXRangeProp == "Yes":

seenAny = False
avgSum= 0
count = 0

# zip is used since we also need to pull in sweep data
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# an index and the array notation could also have been used
for probeVal, sweepVal in zip(probeData, sweepData):
if sweepVal < xRangeStart or sweepVal > xRangeEnd:
pass

# Note that in a better written script, this code would be
# refactored into its own function to avoid code
# duplication
if not seenAny:
minVal = probeVal
maxVal = probeVal
avgSum= probeVal
seenAny = True
count = 1
else:
if probeVal < minVal:
minVal = probeVal

if probeVal > maxVal:
maxVal = probeVal

avgSum+= probeVal
count += 1

if seenAny:
avgVal = avgSum/count

else:
seenAny = False
avgSum= 0
for probeVal in probeData:
if not seenAny:
minVal = probeVal
maxVal = probeVal
avgSum= probeVal
seenAny = True
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else:
if probeVal < minVal:
minVal = probeVal

if probeVal > maxVal:
maxVal = probeVal

avgSum+= probeVal

if seenAny:
avgVal = avgSum/probeData.Count

# Finally set the output values. Note that these are always set as
# lists even if we have just one item.
outData.SetDoubleQuantityData("min_val", [minVal])
outData.SetDoubleQuantityData("max_val", [maxVal])
outData.SetDoubleQuantityData("avg_val", [avgVal])

# And we are done.
return True

Related Topics

User DefinedOutputs: Python Script API

User Defined Outputs: Script Organization
As described in the Introduction section, the UDOscripts should all reside under the
UserDefinedOutputs folder under either of the three library locations (system, user or personal).
Using Script Libraries
Additional .NET Assemblies

Related Topics

User DefinedOutputs: An Introduction
User DefinedOutputs: Python Script API
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Using Script Libraries

If you decide that you need base classes, additional data files, and etc., to organize your UDOs
better, you can do so. This type of library organization allows code reuse between similar UDOs and
can be very helpful. There is special support provided for this type of script-library organization:

l All script-library and other support files need to be in a Lib sub-directory under the
UserDefinedOutputs directory. Any .py files found in such Lib directories are ignored and
not displayed in the GUI as a valid UDOchoice.

l For a UDOscript at any given directory depth, all Lib directories in its parent directories will be
automatically added to the system include path (and so, any support script files from any Lib
directory till the top level UserDefinedOutputs directory can be imported)

Related Topics

User DefinedOutputs: Script Organization
Additional .NET Assemblies

Using additional .NET assemblies

Because the UDO functionality uses IronPython, we have access to the full .NET eco system. If
needed, any subset of the UDO functionality can be implemented in any .NET language and used by
the UDOscript. There are simple rules to follow to achieve this.

1. Build your .NET assembly for .NET 2.0 runtime.
2. Drop the built assembly in anyLib directory upstream of the UDOscript location: that is, if you

have your UDOscript inC:\Users\x\PersonalLib\UserDefinedOutputs\a\b\c\myudo.py and
have a .NET assembly called com.Acme.UDOLibYou can keep the .NET assembly under
l UserDefinedOutputs\Lib,
l UserDefinedOutputs \a\Lib,
l UserDefinedOutputs \a\b\Lib
l UserDefinedOutputs\a\b\c\Lib

3. Add the following line to your python script
l Import clr
l clr.AddReference("com.Acme.UDOLib")
l import com.Acme.UDOLib -or-- from com.Acme.UDOLib import * etc

If for some reason you cannot place the .NET assemblies into a Lib directory under
UserDefinedOutputs, you need to do a couplemore steps before step 3 listed above.

Import sys
sys.path.append("full path to your .NET assembly
location")
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Related Topics

User DefinedOutputs: Script Organization
Using Script Libraries

Toolkit
The Toolkit command in theMaxwell menu provides access to a design type-specific IronPython
script or amodule-specific task. The python script provides a default but customizable UI and canned
automations. The UDD format can be adjusted/extended as needed. The default UI is amodal
dialog.
This allowsMaxwell the flexibility to support changing standards or multiple standards. Similarly, you
can create new UDDs to customize the test report.
UDDs are saved in the project result directory. This type of report can be created prior to simulation,
but will only be populated when there is a solution.
Undo/Redo/Scripting is supported. If a script includesmultiple commands, it takesmultiple undo(s)
to revert all the changesmade by the python script. Also, note that the script playbackmight not work
if the baseline of the design has changed.
A directory called "Toolkits" appears in the syslib, userlib, and personallib of theMaxwell installation.
You can add product specific-directories (Maxwell2D, Maxwell3D, RMxprt) in Toolkits, and each
directory contains toolkits (scripts) that are specific for that product.

Use theMaxwell>Toolkit>Update Menu command to add newly added toolkit scripts to the Toolkit
menu. Menu items for files found in <installation>/syslib will be inserted at the first level of themenu.

Related Topics

Toolkit Examples

Toolkit Examples

Maxwell includes the following toolkits for generating 2D and 3D cable bundlemodels:
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l AutomotiveCableBundle
l Oil-GasCableBundle

Automotive Cable Bundle Toolkit

Towork with the Automotive Cable Bundle toolkit:
1. ClickMaxwell 2D (orMaxwell 3D)>Toolkit>CableModeling>AutomotiveCableBundle.

TheCable Modeling - Automotive dialog box appears with a default set ofCable Parameters
listed.

2. Type theName of the toolkit, and select theUnits to be used for displayed values.
3. Modify theCable Parameters:

a. Select the wireStandard. You can choose to use either ISO orAWG standard. TheWire
Type and Insulation Type fields are updated with menus of values corresponding to the
chosen standard.

b. Select theWire Type. TheConductor Diameter parameter updateswith the
corresponding standard value.

c. Optionally, modify the number of wires (#Wires) in the bundle that have this row’s set of
parameters

d. Optionally, modify theConductor Diameter.
e. Select theConductor Material.
f. Select the Insulation Type.
g. Optionally, modify the Insulation Thickness.
h. Optionally, modify the Insulation Material.

4. To add additional cable types, click the + button. A row is added in which you can define a new
set of cable parameters. Add asmany rows as needed to create a bundle consisting of several
different types of cable.

5. If you have previously imported a customized set of parameters, you can clickUse Defaults
to use the default values.

6. To export the cross section parameters into a .csv or .tab file, clickExport. TheExport Cable
Parameters dialog box appears. Specify the File name and type (either comma delimited
.csv or tab delimited .tab), and clickSave.

7. To read in either a comma delimited .csv or tab delimited .tab file and populate parameters in
the toolkit panel, click Import. The Import Cable Parameters dialog box appears. Specify
the File name and type, then clickOpen.

8. Specify theOuter Jacket Parameters: for the jacket that will encase the cable bundle.
a. Specify the Thickness value for the outer jacket.
b. Specify theMaterial to be used for the outer jacket.
c. Specify theSeeding for wire arrangement value. The value entered here is the seed

value for the pseudo-random number generator used in the conductor packing compute
process. Changing this value results in different arrangements of the conductors. This can
be useful for performing statistical analysis of the cables.
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d. When finished specifying all of the cable and outer jacket parameters for the bundle, click
Compute to calculate theminimal bundle diameter of the cable bundle.
Note Thewire radii are adjusted downward very slightly (on the order of 0.1%) at the

end of the packing process to eliminate any residual overlaps between the wires
and tomake themodel easier to mesh.

Note TheCircle Packing algorithm is used to compute the values. It tries to automatically pack
the conductors in the bundle tightly with aminimumof empty space between them. It
generates and tests a large number of random variations in the conductor positions and
attempts tominimize the overall diameter of the bundle.

1. To add new variables, clickVariables. This opens theEdit Variables dialog box. All
variables that are already present in the project and design levels are listed. ClickAdd to add
a new row to create new variables.

2. Optionally, for 3D designs only, clickExtrude. (TheExtrude button is not present for 2D
designs.) TheExtrude to 3D dialog box appears.
l ClickSweep Along Vector to extrude along the z axis. Z length is the input parameter.
l ClickSweep Along Path to extrude along a selected path.

Note 3D models of cables are hard to solve if the ratio of extruded length to cross-
section diameter is high.

3. ClickDraw to draw the 2D or 3D cross-section geometry. A validation check is run. This
catches errors like any variablemissing a value, or any parameter missing a value. For 3D
designs, if you chose toExtrude, the 3D geometry is drawn.

Oil-Gas Cable Bundle Toolkit

Towork with toolkits in the oil and gas industries:
1. ClickMaxwell 2D (orMaxwell 3D)>Toolkit>CableModeling>Oil-GasCableBundle.

TheCable Modeling - Oil & Gas dialog box appears.
2. Type theName of the toolkit, and select theUnits to be used for displayed values.
3. Modify the variousCable Parameters as needed.
4. If you have previously imported a customized set of parameters, you can clickUse Defaults

to use the default values.
5. To export the cross section parameters into a .csv or .tab file, clickExport. TheExport Cable

Parameters dialog box appears. Specify the File name and type (either comma delimited
.csv or tab delimited .tab), and clickSave.

6. To read in either a comma delimited .csv or tab delimited .tab file and populate parameters in
the toolkit panel, click Import. The Import Cable Parameters dialog box appears. Specify
the File name and type, then clickOpen.

7. To add new variables, clickVariables. This opens theEdit Variables dialog box. All
variables that are already present in the project and design levels are listed. ClickAdd to add
a new row to create new variables.
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8. Optionally, for 3D designs only, clickExtrude. (TheExtrude button is not present for 2D
designs.) TheExtrude to 3D dialog box appears.
l ClickSweep Along Vector to extrude along the z axis. Z length is the input parameter.
l ClickSweep Along Path to extrude along a selected path.

Note 3D models of cables are hard to solve if the ratio of extruded length to cross-
section diameter is high.

9. ClickDraw to draw the 2D or 3D cross-section geometry. A validation check is run. This
catches errors like any variablemissing a value, or any parameter missing a value. For 3D
designs, if you chose toExtrude, the 3D geometry is drawn.

User Defined Documents (UDDs)
User defined documents (UDDs) are custom reports that you define through IronPython scripts.
Once placed in a Lib directory, you can access the scripts via theCreate Document command. The
scripts describe aCreate User Defined Document dialog that lets you specify trace and solution
inputs. After you confirm your input selections, an xml, html and pdf document is generated. A web
browser window opens to display the generated html file. The created document appears in the
Project tree, under Results in the Documents folder.

The general UDD process flow is as follows.

The UDD python scriptsmust be placed in theUserDefinedDocuments directory under either of
syslib, userlib or Personallibwith any subdirectory structure needed. The Lib directory can
contain python scripts that have common code that other scripts can use.
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UseResults>Create Document>Update Menu to refresh themenu to include the new UDD
scripts that have been copied to syslib, userlib or Personallib, or to exclude them if they have been
deleted, after the launch of desktop.
The UDD scripts that are in syslib/UserDefinedDocuments, userlib/UserDefinedDocuments or
Personallib/UserDefinedDocuments become available through theResults >Create Document
menu.

Create User Defined Document Dialog Inputs
User defined documents allow data from traces, solutions and report types as inputs. A UDD can
specify the named inputs for which you select or enter the values in theCreate User Defined
Document dialog that displayswhen you runResults>Create Document><scriptName>.

Input Types can be of Boolean, number, text, trace or solution type. The boolean, number and text
type can be given a default value that you can interactively override when the document is created or
modified. For example, you can select a trace when you create or modify a UDD document. The
trace data is available to the user and can be accessed from the python script.
At the time of selection you can choose from theReporter dialog, the report type (Standard, Eye
Diagram, User Defined), solution name, context and the quantity for which you want the trace data.
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Input Type can also be Solution. You can select an entire solution when the document is created or
modified. The solution data in its entirety, is now available to the user and can be accessed from the
python script.
At the time of selection you can choose from the reporter dialog, the report type (Standard, Eye
Diagram, User Defined), solution name and context. A specific quantity cannot be selected since
data for all quantities in the solution are available.
(Note: The category/Quantity/Function portion of the dialog is disabled for user input)
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UDD Document Creation and Display
After all the input selections for a UDD are confirmed, based on the script, an xml, html and pdf
document is generated based on the inputs provided by the user. (The xml, html and pdf generation
is based on specific calls in the python script, which are explain in a following section). A web
browser window also opens to display the generated html file.
The created document will be placed under a new folder named "Documents" under the "Results"
folder. All documents that are created by the user for the design will be placed under this folder.
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Related Topics

Managing Documents Listed in the Project Window Under Results
Viewing UDDswith an HtmlWeb Browser
UDD Script Libraries
User Defined Documents: Python Script API

Managing Documents Listed in the Project Window Under Results

Right click on a user defined document displayed in the Project Manager tree to bring up amenu
where you can rename, delete the document.Open document opens the web browser with the
html document.Modify document opens the setup dialog where you can change the selections for
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the input. To view the xml and the pdf document simply choose the appropriatemenu items. There is
also amenu item to save the document in a different location.

Documents folder right click menu

Right click on the documents folder has themenu options to Update All Documents or Delete All
Documents. It also provides the option of creating a document from here.

Document folder Property window

When the documents folder is selected, the Property window shows the following properties
l XMLSchema File - File path to the XML schema file.
l XSLT StyleSheet (Html) - File path to the XSLT stylesheet file used for Html generation.
l XSLT StyleSheet (Fo) - File path to the XSLT stylesheet file used for Pdf generation.
l Fop Executable (Pdf) - File path the Fop executable used for Pdf generation.
l Clear Cache - Clears the cached XSL transform object and forces creation of a new one. (The
caching is done to save time during document generation, so subsequent generation or
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update of the document can use the cached transform object. But sometimes youmaywant to
force a recompile of the document if you change the stylesheet).

The XML, HTML and PDF generation require the XML schema file and XSLT stylesheets to
generate proper output. In addition, the PDF generation requires a FOP executable. You can use
the defaults provided in the installation or provide the file paths of your own preferred stylesheets and
fop executable installed in hismachine.

Viewing UDDs with an Html Web Browser

The XML and HTML documents can be viewed in a web browser with some basic functionality like
printing the document, searching the document for a phrase or sentence and saving the document.
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Related Topics

UDD Script Libraries
Base classes and data files shared between similar UDDs can be organized to reuse the code in a
better way. All script-library and other support files need to be in a Lib sub-directory under the
UserDefinedDefinitions directory. Any .py files found in such Lib directories are ignored and not
displayed in the GUI as a valid UDD choice. For a UDD script at any given directory depth, all Lib
directories in its parent directories will be automatically added to the system include path (and so,
any support script files from any Lib directory till the top level UserDefinedDefintions directory can be
imported)
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The UDD functionality uses IronPython so we have access to all the .NET assembles. If needed, any
subset of the UDD functionality can be implemented in any .NET language and used by the UDD
script. There are simple rules to follow to achieve this.

1. Build your .NET assembly for .NET 2.0 runtime.
2. Drop the built assembly in any Lib directory upstream of the UDD script location: that is, if you

have your UDD script in C:\Users\x\PersonalLib\UserDefinedDefintions\a\b\c\myudd.py and
have a .NET assembly called com.Acme.UDDLib You can keep the .NET assembly under
l UserDefinedDefintions\Lib,
l UserDefinedDefintions\a\Lib,
l UserDefinedDefintions\a\b\Lib
l UserDefinedDefintions\a\b\c\Lib

3. Add the following line to your python script
l Import clr
l clr.AddReference("com.Acme.UDDLib")
l import com.Acme.UDDLib -or-- from com.Acme.UDDLib import * etc
If for some reason you cannot place the .NET assemblies into a Lib directory under
UserDefinedDefintions, you need to do a couplemore steps before step 3 listed above.

Import sys
sys.path.append("full path to your .NET assembly location")

Related Topics

User Defined Documents: Python Script API

User Defined Documents: Python Script API
A User Defined Documents (UDD) extension is implemented as an IronPython script that defines a
classwith a specific name:UDDExtensionwhich derives from a specific base class
IUDDPluginExtension and implements its abstract methods.

Import Statements
The base class to be used and the types it uses in turn are contained in .NET assemblies. The use of
these requires that the assemblies be imported into the UDD script: the following import statements
should be added to the top of the python script:

from
Ansys.Ansoft.DocGeneratorPluginDotNet.DocGenerator.API.Data
import *
from
Ansys.Ansoft.DocGeneratorPluginDotNet.DocGenerator.API.Interfa
ces import *

UDDExtension Class
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The UDD itself should be implemented as an IronPython class calledUDDExtensionwhichmust
derive from the IUDDPluginExtension abstract base class (from the
Ansys.Ansoft.DocGeneratorPluginDotNet.DocGenerator.API.Interfaces namespace).
Note that power users could derive a class hierarchy tuned toward a specific type of UDDs and that
they can derive from their own base classes. The only requirement is that directly or indirectly, the
UDD classmust derive from IUDDPluginExtension.

Example:
def BaseClassUDD ((IUDDPluginExtension):
#base class implementation
…
def UDDExtension ((BaseClassUDD):
#UDD class implementation
…

Note All of the above text has been copied from the help section for the UDOs andmodified for
the UDDs. Since the UDDs aremodelled after the UDOs, the usage is also similar.

IUDDPluginExtension Abstract Class

Required functions:
The IUDDPluginExtension abstract class declares the following abstract methods that must be
implemented in the UDDExtension class or one of its base classes. Not implementing any of these
methodswill result in a run-time error and a non functioning UDD.
GetUDDName() : Return a string that is used as a prefix for all solution instances created using this
UDD.

Example:
def GetUDDName(self):
return "MinMaxAvg

GetUDDDescription() : Returns a description for the UDD, its purpose etc.

Example:
def GetUDDDescription(self):
return "Sample UDD"

ShowDefaultSetupDialog() : Returns True if the default dialog is to be shown. Return False if the
user does not want the default dialog. In this case the user might want to implement/show a
customized setup dialog.

Example:
def ShowDefaultSetupDialog(self):
return True

GetUDDInputParams(List<UDDInputParams> uddInputs) : Returns the list of inputs
parameters for the User Defined Document. Returns boolean: True on success, False on failure.
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The supplied input parameters are used to populate details of the parameters to which the UDD user
will specify value, specify the input names and their types.
uddInputs: .NET list of UDDInputParams objects. The UDD script is expected to add one instance
of UDDInputParams for each input definition it wants displayed. The UDD user will, when creating
the UDD, assign amatching value to each such input.

Example:
def GetUDDInputParams(self, uddInputs)
# Boolean input
param1 = UDDInputParams("Summary","Display Summary",
Constants.kBoolTypeStr, True)
uddInputs.Add(param1)
# Text input
param2 = UDDInputParams("Name","User Name",
Constants.kTextTypeStr , "Sita Ramesh")
uddInputs.Add(param2)
# Number input
param3 = UDDInputParams("Version","Script Version",
Constants.kNumberTypeStr, 1021)
uddInputs.Add(param3)
# Solution input
param5 = UDDInputParams("DLMetrics","Data Line
Metrics",Constants.kSolutionTypeStr)
uddInputs.Add(param4)
# Trace input
param5 = UDDInputParams("DQ0","DQ0",Constants.kTraceTypeStr)
uddInputs.Add(param5)

return True

Based on the input params the following dialog is displayed when you clickReports>Create
Document. The name and description of the UDD are also displayed in this dialog.
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Generate(List<UDDInputData> uddInputs, IUDDGenerator generator, IProgressMonitor
progressMonitor) : This is themainmethod which accesses the data from the uddInputs and
generates the document.
uddInputs: The list of inputs that the user setup in the dialog. They are now available to query for
data.
generator: This is the document generator object which we use to create different elements of the
document like titles, sections, tables, images and write the data too. This interface is explained in the
Document Generator Interface document.
progressMonitor : IProgressMonitor object. This can be used to set progress for long running
calculations, check for user initiated abort etc.

Example:
def Generate(self, input, docgen, progMon):

# Gather data from inputs
boolinput = input[0].Data()
textinput = input[1].Data()
dblinput = input[2].Data()

# Get document root
docroot = docgen.GetDocumentRoot()

Post Processing andGenerating Reports 23-223
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

# Add Section
section1 = docroot.AddSection("Summary", "Overall Results ")

# Add a table
table1 = section1.AddTable("Test Summary")

#Add a table group with 2 columns
tgroup1 = table1.AddTableGroup(2)

# get desktop application
oApp = self.GetUDDAppContext()
if oApp != None:
oDesktop = oApp.GetAppDesktop()
if oDesktop != None:
# version number
version = oDesktop.GetVersion()
text1 = tgroup1.AddContent()
text1 .Add(0, "Product Version")
text1 .Add(1, version)

oProject = oDesktop.GetActiveProject()
if oProject != None:
projectname= oProject.GetName()
text1 = tgroup1.AddContent()
text1 .Add(0, "Project")
text1 1.Add(1, projectname)

oDesign = self.GetUDDDesignContext()
if oDesign != None:
designname = oDesign.GetName()
text1 = tgroup1.AddContent()
text1 .Add(0, "Design")
text1 .Add(1, designname)

# Provides a script path
scriptpath = docgen.GetScriptPath()
text1 = tgroup1.AddContent()
text1 .Add(0, "Script Path")
text1 .Add(1, scriptpath )

#Provides the script version
text1 = tgroup1.AddContent()
text1 .Add(0, "Script Version")
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text1 .Add(1, str(dblinput ))

#Provides the output xml path
outputpath = docgen.GetOutputFilePath()
text1 = tgroup1.AddContent()
text1 .Add(0, "Output Path")
text1 .Add(1, outputpath )

#Provides the user information
text1 = tgroup1.AddContent()
text1 .Add(0, "User")
text1 .Add(1, textinput)

# Generate Xml output
docgen.Write(False)

# Generate Html output
docgen.WriteHTML()

# Generate PDF output
docgen.WritePDF()

return True

Optional functions:
SetupUDDInputParams(List<UDDInputParams> uddInputs) : Displays a customized dialog
and returns the user choices for the input params.
uddInputs- .NET list of UDDInputParams objects with values for each of them. These can be the
user choice for each input obtained through a custom dialog or some other non graphical
assignment.
We cannot process trace and solution types of input with a custom dialog because there is no way of
assigning solution data to the input without the invocation of the reporter dialog.

Example:
def SetupUDDInputParams(self, uddInputs)
udddialog = BaseExampleUDDDialog()
if udddialog.ShowDialog() == Forms.DialogResult.OK:

# Boolean input
param1 = udddialog.GetInput("Summary")
uddInputs.Add(param1)

# Text input
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param2 = udddialog.GetInput("Name")
uddInputs.Add(param2)

# Number input
param3 = udddialog.GetInput("Version")
uddInputs.Add(param3)

HandleUDDEvents(List<string> eventTags) : The tags associated with the event is received
by plugin using this abstract class.
Thismethod is the event handler for all link events set by the SetEventLink() method on a IUDDText.
Refer to the definition of the IUDDText object in the Document Generator Interface document.

Example:
def HandleUDDEvents(self, uddLinks):
if uddLinks[0] == "Open" Report":

# Get Design Name
oDesign = self.GetUDDDesignContext()
if oDesign != None:

oDesign.OpenReport(uddLinks[1])
return True

GetUDDSchema() : Returns the file path of the schema to validate the xml. This will override the
default schema used. Return string containing the full file path of the schema.

def GetUDDSchema(self):
return "C:\\Program
Files\\Ansoft\\Designer8.0\\Windows\\common\\docbook\\schema\\
xsd\\docbook.xsd"

GetUDDStyleSheetForHtml() : Returns the file path of the style sheet used to generate the html
document. This will override the default stylesheet for html. Returns string containing the full file path
of the style sheet.

def GetUDDStyleSheetForHtml(self):
return "C:\\Program
Files\\Ansoft\\Designer8.0\\Windows\\common\\docbook\\"

GetUDDStyleSheetForPdf() : Returns the file path of the style sheet used to generate the pdf
document. This will override the default stylesheet for pdf. Returns string containing the full file path
of the style sheet.

Example:
def GetUDDStyleSheetForPdf(self):
return "C:\\Program
Files\\Ansoft\\Designer8.0\\Windows\\common\\docbook\\xsl\\fo\
\docbook.xsl"
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GetFopExecutable() : Returns the file path of the fop executable used to generate the pdf
document. This will override the default stylesheet for pdf.Returns string containing the full file path
of the fop executable.

Example:
def GetFopExecutable(self):
return "C:\\Program
Files\\Ansoft\\Designer8.0\\Windows\\common\\ApacheFOP\\fop-
1.0\\fop"

GetUDDAppContext() : Returns the UDD Owner (if set). This is a Dispatch wrapper that is
essentially a COM IDispatch implementation and corresponds to the IDispatch pointing to the
desktop app.
GetUDDDesignContext() : Returns the UDD Owner (if set). This is a Dispatch wrapper that is
essentially a COM IDispatch implementation and corresponds to the IDispatch pointing to the
Design.

User Defined Documents: Python Script API

A User Defined Documents (UDD) extension is implemented as an IronPython script that defines a
classwith a specific name:UDDExtensionwhich derives from a specific base class
IUDDPluginExtension and implements its abstract methods.

Import Statements
The base class to be used and the types it uses in turn are contained in .NET assemblies. The use of
these requires that the assemblies be imported into the UDD script: the following import statements
should be added to the top of the python script:

from
Ansys.Ansoft.DocGeneratorPluginDotNet.DocGenerator.API.Data
import *
from
Ansys.Ansoft.DocGeneratorPluginDotNet.DocGenerator.API.Interfa
ces import *

UDDExtension Class
TheUDD itself should be implemented as an IronPython class calledUDDExtensionwhichmust
derive from the IUDDPluginExtension abstract base class (from the
Ansys.Ansoft.DocGeneratorPluginDotNet.DocGenerator.API.Interfaces namespace).
Note that power users could derive a class hierarchy tuned toward a specific type of UDDs and that
they can derive from their own base classes. The only requirement is that directly or indirectly, the
UDD classmust derive from IUDDPluginExtension.

Example:
def BaseClassUDD ((IUDDPluginExtension):
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#base class implementation
…
def UDDExtension ((BaseClassUDD):
#UDD class implementation
…

Note All of the above text has been copied from the help section for the UDOs andmodified for
the UDDs. Since the UDDs aremodelled after the UDOs, the usage is also similar.

IUDDPluginExtension Abstract Class

Required functions:
The IUDDPluginExtension abstract class declares the following abstract methods that must be
implemented in the UDDExtension class or one of its base classes. Not implementing any of these
methodswill result in a run-time error and a non functioning UDD.
GetUDDName() : Return a string that is used as a prefix for all solution instances created using this
UDD.

Example:
def GetUDDName(self):
return "MinMaxAvg

GetUDDDescription() : Returns a description for the UDD, its purpose etc.

Example:
def GetUDDDescription(self):
return "Sample UDD"

ShowDefaultSetupDialog() : Returns True if the default dialog is to be shown. Return False if the
user does not want the default dialog. In this case the user might want to implement/show a
customized setup dialog.

Example:
def ShowDefaultSetupDialog(self):
return True

GetUDDInputParams(List<UDDInputParams> uddInputs) : Returns the list of inputs
parameters for the User Defined Document. Returns boolean: True on success, False on failure.
The supplied input parameters are used to populate details of the parameters to which the UDD user
will specify value, specify the input names and their types.
uddInputs: .NET list of UDDInputParams objects. The UDD script is expected to add one instance
of UDDInputParams for each input definition it wants displayed. The UDD user will, when creating
the UDD, assign amatching value to each such input.

Example:
def GetUDDInputParams(self, uddInputs)
# Boolean input
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param1 = UDDInputParams("Summary","Display Summary",
Constants.kBoolTypeStr, True)
uddInputs.Add(param1)
# Text input
param2 = UDDInputParams("Name","User Name",
Constants.kTextTypeStr , "Sita Ramesh")
uddInputs.Add(param2)
# Number input
param3 = UDDInputParams("Version","Script Version",
Constants.kNumberTypeStr, 1021)
uddInputs.Add(param3)
# Solution input
param5 = UDDInputParams("DLMetrics","Data Line
Metrics",Constants.kSolutionTypeStr)
uddInputs.Add(param4)
# Trace input
param5 = UDDInputParams("DQ0","DQ0",Constants.kTraceTypeStr)
uddInputs.Add(param5)

return True

Based on the input params the following dialog is displayed when you clickReports>Create
Document. The name and description of the UDD are also displayed in this dialog.

Post Processing andGenerating Reports 23-229
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Generate(List<UDDInputData> uddInputs, IUDDGenerator generator, IProgressMonitor
progressMonitor) : This is themainmethod which accesses the data from the uddInputs and
generates the document.
uddInputs: The list of inputs that the user setup in the dialog. They are now available to query for
data.
generator: This is the document generator object which we use to create different elements of the
document like titles, sections, tables, images and write the data too. This interface is explained in the
Document Generator Interface document.
progressMonitor : IProgressMonitor object. This can be used to set progress for long running
calculations, check for user initiated abort etc.

Example:
def Generate(self, input, docgen, progMon):

# Gather data from inputs
boolinput = input[0].Data()
textinput = input[1].Data()
dblinput = input[2].Data()

# Get document root
docroot = docgen.GetDocumentRoot()

# Add Section
section1 = docroot.AddSection("Summary", "Overall Results ")

# Add a table
table1 = section1.AddTable("Test Summary")

#Add a table group with 2 columns
tgroup1 = table1.AddTableGroup(2)

# get desktop application
oApp = self.GetUDDAppContext()
if oApp != None:
oDesktop = oApp.GetAppDesktop()
if oDesktop != None:
# version number
version = oDesktop.GetVersion()
text1 = tgroup1.AddContent()
text1 .Add(0, "Product Version")
text1 .Add(1, version)

oProject = oDesktop.GetActiveProject()
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if oProject != None:
projectname= oProject.GetName()
text1 = tgroup1.AddContent()
text1 .Add(0, "Project")
text1 1.Add(1, projectname)

oDesign = self.GetUDDDesignContext()
if oDesign != None:
designname = oDesign.GetName()
text1 = tgroup1.AddContent()
text1 .Add(0, "Design")
text1 .Add(1, designname)

# Provides a script path
scriptpath = docgen.GetScriptPath()
text1 = tgroup1.AddContent()
text1 .Add(0, "Script Path")
text1 .Add(1, scriptpath )

#Provides the script version
text1 = tgroup1.AddContent()
text1 .Add(0, "Script Version")
text1 .Add(1, str(dblinput ))

#Provides the output xml path
outputpath = docgen.GetOutputFilePath()
text1 = tgroup1.AddContent()
text1 .Add(0, "Output Path")
text1 .Add(1, outputpath )

#Provides the user information
text1 = tgroup1.AddContent()
text1 .Add(0, "User")
text1 .Add(1, textinput)

# Generate Xml output
docgen.Write(False)

# Generate Html output
docgen.WriteHTML()

# Generate PDF output
docgen.WritePDF()
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return True

Optional functions:
SetupUDDInputParams(List<UDDInputParams> uddInputs) : Displays a customized dialog
and returns the user choices for the input params.
uddInputs- .NET list of UDDInputParams objects with values for each of them. These can be the
user choice for each input obtained through a custom dialog or some other non graphical
assignment.
We cannot process trace and solution types of input with a custom dialog because there is no way of
assigning solution data to the input without the invocation of the reporter dialog.

Example:
def SetupUDDInputParams(self, uddInputs)
udddialog = BaseExampleUDDDialog()
if udddialog.ShowDialog() == Forms.DialogResult.OK:

# Boolean input
param1 = udddialog.GetInput("Summary")
uddInputs.Add(param1)

# Text input
param2 = udddialog.GetInput("Name")
uddInputs.Add(param2)

# Number input
param3 = udddialog.GetInput("Version")
uddInputs.Add(param3)

HandleUDDEvents(List<string> eventTags) : The tags associated with the event is received
by plugin using this abstract class.
Thismethod is the event handler for all link events set by the SetEventLink() method on a IUDDText.
Refer to the definition of the IUDDText object in the Document Generator Interface document.

Example:
def HandleUDDEvents(self, uddLinks):
if uddLinks[0] == "Open" Report":

# Get Design Name
oDesign = self.GetUDDDesignContext()
if oDesign != None:

oDesign.OpenReport(uddLinks[1])
return True
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GetUDDSchema() : Returns the file path of the schema to validate the xml. This will override the
default schema used. Return string containing the full file path of the schema.

def GetUDDSchema(self):
return "C:\\Program
Files\\Ansoft\\Designer8.0\\Windows\\common\\docbook\\schema\\
xsd\\docbook.xsd"

GetUDDStyleSheetForHtml() : Returns the file path of the style sheet used to generate the html
document. This will override the default stylesheet for html. Returns string containing the full file path
of the style sheet.

def GetUDDStyleSheetForHtml(self):
return "C:\\Program
Files\\Ansoft\\Designer8.0\\Windows\\common\\docbook\\"

GetUDDStyleSheetForPdf() : Returns the file path of the style sheet used to generate the pdf
document. This will override the default stylesheet for pdf. Returns string containing the full file path
of the style sheet.

Example:
def GetUDDStyleSheetForPdf(self):
return "C:\\Program
Files\\Ansoft\\Designer8.0\\Windows\\common\\docbook\\xsl\\fo\
\docbook.xsl"

GetFopExecutable() : Returns the file path of the fop executable used to generate the pdf
document. This will override the default stylesheet for pdf.Returns string containing the full file path
of the fop executable.

Example:
def GetFopExecutable(self):
return "C:\\Program
Files\\Ansoft\\Designer8.0\\Windows\\common\\ApacheFOP\\fop-
1.0\\fop"

GetUDDAppContext() : Returns the UDD Owner (if set). This is a Dispatch wrapper that is
essentially a COM IDispatch implementation and corresponds to the IDispatch pointing to the
desktop app.
GetUDDDesignContext() : Returns the UDD Owner (if set). This is a Dispatch wrapper that is
essentially a COM IDispatch implementation and corresponds to the IDispatch pointing to the
Design.

Data Types Used in Python Script

There are several types that youmust use while authoring the python script. Some of them are used
to pass data fromUI to python script and to provide interface for working with this data. Some are
used to pass data from python script to UI.
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To pass data from python script to UI the objects of the C# classmust be created in python script
using their C# constructors. Then they can be set as functions return values or set to the output
parameters using their API.

Constants class

kTraceTypeStr : string constant used to specify an input of trace type
kSolutionTypeStr : string constant used to specify an input of solution type
kNumberTypeStr : string constant used to specify an input of number type
kTextTypeStr : string constant used to specify an input of text type
kBoolTypeStr : string constant used to specify an input of boolean type
kStandardReportStr : string constant to specify a standard report
kEyeDiagramReportStr : string constant to specify an eye diagram report
kUserDefinedReportStr : string constant to specify a user defined report
kSweepDomainStr : string constant to specify the sweep domain
kTimeDomainStr : string constant to specify the time domain

UDDInputParams class

The objects of this classmust be created in python script in theGetUDDInputParams() function
and theSetUDDInputParams() function.
Attributes :
Input Name (string)
Input Description (string)
Input Type ( Can be Boolean, Number, Text, Trace or Solution) (string)
BoolData (boolean)
DoubleData (double)
TextData (string)
ReportType (string)
SolutionName (string)
DomainName (string)
Constructors:
UDDInputParams(string name, string description, string type)
UDDInputParams(string name, string description, string type, bool data)
UDDInputParams(string name, string description, string type, double data)
UDDInputParams(string name, string description, string type, string data)
UDDInputParams(string name, string description, string type, string reportType, string
solutionName, string domainName)
Property Accessors :
Name : Get/Set the name of an input
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Description : Get/Set the desccription of an input
Type : Get/Set the type of an input
BoolData : Get/Set the data of a boolean input
DoubleData : Get/Set the data of a number input
TextData : Get/Set the data of a text input
ReportType : Get/Set the report type
SolutionName : Get/Set the name of the solution
DomainName : Get/Set the name of the domain

IProgressMonitor Abstract Class

The object of this class is a progressmonitor. It is used to display calculations progress in UI and
check is the user has requested an abort of the computation.
When displayed in the application, each progressmessage has four items:

A task name
A sub-task name
The progress amount
A button to abort the task in progress.

All of this functionality and abort interaction is achieved using the following functions.
SetTaskName (string taskName):
SetSubTaskName (string subTaskName)
BeginTask (string name)
SetTaskProgressPercentage(int progressPercent)

CheckForAbort(): If the quantities being generated are computationally expensive, the UDO
author can periodically call thismethod and then call EndTaskwith Fail and return False.
EndTask (bool passFail)
Example:

progMon.BeginTask("Process DQS")
progMon.SetSubTaskName("Compute UI segments")
progMon.SetTaskProgressPercentage(33)
progMon.SetSubTaskName("Compute the rest")
progMon.SetTaskProgressPercentage(100)
progMon.EndTask(True)

Data Types Used in Python Script

There are several types that youmust use while authoring the python script. Some of them are used
to pass data fromUI to python script and to provide interface for working with this data. Some are
used to pass data from python script to UI.
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To pass data from python script to UI the objects of the C# classmust be created in python script
using their C# constructors. Then they can be set as functions return values or set to the output
parameters using their API.

Constants class

kTraceTypeStr : string constant used to specify an input of trace type
kSolutionTypeStr : string constant used to specify an input of solution type
kNumberTypeStr : string constant used to specify an input of number type
kTextTypeStr : string constant used to specify an input of text type
kBoolTypeStr : string constant used to specify an input of boolean type
kStandardReportStr : string constant to specify a standard report
kEyeDiagramReportStr : string constant to specify an eye diagram report
kUserDefinedReportStr : string constant to specify a user defined report
kSweepDomainStr : string constant to specify the sweep domain
kTimeDomainStr : string constant to specify the time domain

UDDInputParams class

The objects of this classmust be created in python script in theGetUDDInputParams() function
and theSetUDDInputParams() function.
Attributes :
Input Name (string)
Input Description (string)
Input Type ( Can be Boolean, Number, Text, Trace or Solution) (string)
BoolData (boolean)
DoubleData (double)
TextData (string)
ReportType (string)
SolutionName (string)
DomainName (string)
Constructors:
UDDInputParams(string name, string description, string type)
UDDInputParams(string name, string description, string type, bool data)
UDDInputParams(string name, string description, string type, double data)
UDDInputParams(string name, string description, string type, string data)
UDDInputParams(string name, string description, string type, string reportType, string
solutionName, string domainName)
Property Accessors :
Name : Get/Set the name of an input
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Description : Get/Set the desccription of an input
Type : Get/Set the type of an input
BoolData : Get/Set the data of a boolean input
DoubleData : Get/Set the data of a number input
TextData : Get/Set the data of a text input
ReportType : Get/Set the report type
SolutionName : Get/Set the name of the solution
DomainName : Get/Set the name of the domain

IProgressMonitor Abstract Class

The object of this class is a progressmonitor. It is used to display calculations progress in UI and
check is the user has requested an abort of the computation.
When displayed in the application, each progressmessage has four items:

A task name
A sub-task name
The progress amount
A button to abort the task in progress.

All of this functionality and abort interaction is achieved using the following functions.
SetTaskName (string taskName):
SetSubTaskName (string subTaskName)
BeginTask (string name)
SetTaskProgressPercentage(int progressPercent)

CheckForAbort(): If the quantities being generated are computationally expensive, the UDO
author can periodically call thismethod and then call EndTaskwith Fail and return False.
EndTask (bool passFail)
Example:

progMon.BeginTask("Process DQS")
progMon.SetSubTaskName("Compute UI segments")
progMon.SetTaskProgressPercentage(33)
progMon.SetSubTaskName("Compute the rest")
progMon.SetTaskProgressPercentage(100)
progMon.EndTask(True)

Data Types Used in Python Script

There are several types that youmust use while authoring the python script. Some of them are used
to pass data fromUI to python script and to provide interface for working with this data. Some are
used to pass data from python script to UI.
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To pass data from python script to UI the objects of the C# classmust be created in python script
using their C# constructors. Then they can be set as functions return values or set to the output
parameters using their API.

Constants class

kTraceTypeStr : string constant used to specify an input of trace type
kSolutionTypeStr : string constant used to specify an input of solution type
kNumberTypeStr : string constant used to specify an input of number type
kTextTypeStr : string constant used to specify an input of text type
kBoolTypeStr : string constant used to specify an input of boolean type
kStandardReportStr : string constant to specify a standard report
kEyeDiagramReportStr : string constant to specify an eye diagram report
kUserDefinedReportStr : string constant to specify a user defined report
kSweepDomainStr : string constant to specify the sweep domain
kTimeDomainStr : string constant to specify the time domain

UDDInputParams class

The objects of this classmust be created in python script in theGetUDDInputParams() function
and theSetUDDInputParams() function.
Attributes :
Input Name (string)
Input Description (string)
Input Type ( Can be Boolean, Number, Text, Trace or Solution) (string)
BoolData (boolean)
DoubleData (double)
TextData (string)
ReportType (string)
SolutionName (string)
DomainName (string)
Constructors:
UDDInputParams(string name, string description, string type)
UDDInputParams(string name, string description, string type, bool data)
UDDInputParams(string name, string description, string type, double data)
UDDInputParams(string name, string description, string type, string data)
UDDInputParams(string name, string description, string type, string reportType, string
solutionName, string domainName)
Property Accessors :
Name : Get/Set the name of an input
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Description : Get/Set the desccription of an input
Type : Get/Set the type of an input
BoolData : Get/Set the data of a boolean input
DoubleData : Get/Set the data of a number input
TextData : Get/Set the data of a text input
ReportType : Get/Set the report type
SolutionName : Get/Set the name of the solution
DomainName : Get/Set the name of the domain

IProgressMonitor Abstract Class

The object of this class is a progressmonitor. It is used to display calculations progress in UI and
check is the user has requested an abort of the computation.
When displayed in the application, each progressmessage has four items:

A task name
A sub-task name
The progress amount
A button to abort the task in progress.

All of this functionality and abort interaction is achieved using the following functions.
SetTaskName (string taskName):
SetSubTaskName (string subTaskName)
BeginTask (string name)
SetTaskProgressPercentage(int progressPercent)

CheckForAbort(): If the quantities being generated are computationally expensive, the UDO
author can periodically call thismethod and then call EndTaskwith Fail and return False.
EndTask (bool passFail)
Example:

progMon.BeginTask("Process DQS")
progMon.SetSubTaskName("Compute UI segments")
progMon.SetTaskProgressPercentage(33)
progMon.SetSubTaskName("Compute the rest")
progMon.SetTaskProgressPercentage(100)
progMon.EndTask(True)

Data Types Used in Python Script

There are several types that youmust use while authoring the python script. Some of them are used
to pass data fromUI to python script and to provide interface for working with this data. Some are
used to pass data from python script to UI.
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To pass data from python script to UI the objects of the C# classmust be created in python script
using their C# constructors. Then they can be set as functions return values or set to the output
parameters using their API.

Constants class

kTraceTypeStr : string constant used to specify an input of trace type
kSolutionTypeStr : string constant used to specify an input of solution type
kNumberTypeStr : string constant used to specify an input of number type
kTextTypeStr : string constant used to specify an input of text type
kBoolTypeStr : string constant used to specify an input of boolean type
kStandardReportStr : string constant to specify a standard report
kEyeDiagramReportStr : string constant to specify an eye diagram report
kUserDefinedReportStr : string constant to specify a user defined report
kSweepDomainStr : string constant to specify the sweep domain
kTimeDomainStr : string constant to specify the time domain

UDDInputParams class

The objects of this classmust be created in python script in theGetUDDInputParams() function
and theSetUDDInputParams() function.
Attributes :
Input Name (string)
Input Description (string)
Input Type ( Can be Boolean, Number, Text, Trace or Solution) (string)
BoolData (boolean)
DoubleData (double)
TextData (string)
ReportType (string)
SolutionName (string)
DomainName (string)
Constructors:
UDDInputParams(string name, string description, string type)
UDDInputParams(string name, string description, string type, bool data)
UDDInputParams(string name, string description, string type, double data)
UDDInputParams(string name, string description, string type, string data)
UDDInputParams(string name, string description, string type, string reportType, string
solutionName, string domainName)
Property Accessors :
Name : Get/Set the name of an input
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Description : Get/Set the desccription of an input
Type : Get/Set the type of an input
BoolData : Get/Set the data of a boolean input
DoubleData : Get/Set the data of a number input
TextData : Get/Set the data of a text input
ReportType : Get/Set the report type
SolutionName : Get/Set the name of the solution
DomainName : Get/Set the name of the domain

IProgressMonitor Abstract Class

The object of this class is a progressmonitor. It is used to display calculations progress in UI and
check is the user has requested an abort of the computation.
When displayed in the application, each progressmessage has four items:

A task name
A sub-task name
The progress amount
A button to abort the task in progress.

All of this functionality and abort interaction is achieved using the following functions.
SetTaskName (string taskName):
SetSubTaskName (string subTaskName)
BeginTask (string name)
SetTaskProgressPercentage(int progressPercent)

CheckForAbort(): If the quantities being generated are computationally expensive, the UDO
author can periodically call thismethod and then call EndTaskwith Fail and return False.
EndTask (bool passFail)
Example:

progMon.BeginTask("Process DQS")
progMon.SetSubTaskName("Compute UI segments")
progMon.SetTaskProgressPercentage(33)
progMon.SetSubTaskName("Compute the rest")
progMon.SetTaskProgressPercentage(100)
progMon.EndTask(True)

UDD Input interfaces

TheGenerate function takes in a list of inputs. These input interfaces allow the user to access data
from the design.
IUDDInputBool : This interface exposes 3methods

Name() : Gets the inputs name.

Post Processing andGenerating Reports 23-241
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Type() : Gets the input type.
Data() : Gets the boolean data, set by the user in the setup dialog.

IUDDInputDouble : This interface exposes 3methods
Name() : Gets the inputs name.
Type() : Gets the input type.
Data() : Gets the double data, set by the user in the setup dialog.

IUDDInputText : This interface exposes 3methods
Name() : Gets the inputs name.
Type() : Gets the input type.
Data() : Gets the text data, set by the user in the setup dialog.

IUDDInputTrace : This interface exposes 3methods
Name() : Gets the inputs name.
Type() : Gets the input type.

DoubleData() : Method used to return x and y double data as a IDictionary<double, double>

DoubleData(IDictionary<string, string> variation) : Method used to return x and y double data
as a IDictionary<double, double>, given a variation.

ComplexData() : Method used to return x data and y complex data as a IDictionary<double,
double[]>

ComplexData(IDictionary<string, string> variation) : Method used to return x data and y
complex data as a IDictionary<double, double[]>, given a variation.

TextData() : Method used to return x data and y data as a IDictionary<string, string>

TextData(IDictionary<string, string> variation) : Method used to return x data and y data as a
IDictionary<string, string>, given a variation.

VariableValues() : Method used to get a list of variations as a IList<Dictionary<string, string>>
IUDDInputSolution : This interface exposes 3methods

Name() : Gets the inputs name.
Type() : Gets the input type.

DoubleData(string name) : Method used to return x and y double data as a
IDictionary<double, double>, given a quantity name.
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DoubleData(string name, IDictionary<string, string> variation) : Method used to return x and y
double data as a IDictionary<double, double>, given a quantity name and a variation.

ComplexData(string name) : Method used to return x data and y complex data as a
IDictionary<double, double[]>, given a quantity name.

ComplexData(string name, IDictionary<string, string> variation) : Method used to return x
data and y complex data as a IDictionary<double, double[]>, given a quantity name and a
variation.

TextData(string name) : Method used to return x data and y data as a IDictionary<string,
string> given a quantity name.

TextData(string name, IDictionary<string, string> variation) : Method used to return x data and
y data as a IDictionary<string, string>, given a quantity name and a variation.

CategoryNames() : Method to return a list of category names in the solution as an
IList<string>

QuantityNames(string category) : Method to return a list of quantity names in the solution as
an IList<string>, given a category.

VariableValues() : Method used to get a list of variations as a IList<Dictionary<string, string>>

Examples:
def Generate(self, input, docgen, progMon):
# Getting the boolean data set by the user
boolinput = input[0].Data()
# Getting the double data set by the user
dblinput = input[1].Data()
# Getting the text data set by the user
textinput = input[2].Data()
# Getting the category names in a solution
categories = input[3].CategoryNames()
# Getting the quantity names based on a category
quantities = input[3].QuantityNames(categories[0])
# Getting the XY data from the trace
xydata = input[4].DoubleData()
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User Defined Document Scripting Interface
To access the UserDefineddocuments scripting object, use:

Set oModule = oDesign.GetModule("UserDefinedDocuments")

Once you have the scripting object, you can use the followingmethods:-
1. AddDocument([in] VARIANT data, [in] VARIANT traces, [out, retval]

BSTR* uniqueName)

a. Takes a VARIANT data which defines the document.
b. Takes a VARIANT trace data for the inputs in the document.
c. Returns a unique name

2. EditDocument( [in] BSTR originalName, [in] VARIANT modifiedData,
[in] VARIANT modifiedTraces, [out, retval] BSTR* uniqueName)

a. Takes the name of the original document.
b. Takes a VARIANT data which defines the edited document.
c. Takes a VARIANT trace data for the inputs in the document.
d. Returns a unique name

3. RenameDocument( [in] BSTR oldName, [in] BSTR newName)

a. Takes the name of the original document.
b. Takes the new name of the document.

4. DeleteDocument( [in] BSTR name)

a. Takes the name of the document to be deleted.
5. UpdateDocument( [in] BSTR name)

a. Takes the name of the document to be updated.
6. ViewHtmlDocument( [in] BSTR name)

a. Takes the name of the document to be viewed in HTML.
7. ViewPdfDocument( [in] BSTR name)

b. Takes the name of the document to be viewed as a PDF.
8. SaveHtmlDocumentAs( [in] BSTR name, [in] BSTR saveTo)

a. Takes the name of the document to be saved.
b. Takes the file path to save the socument as.

9. SavePdfDocumentAs( [in] BSTR name, [in] BSTR saveTo)

a. Takes the name of the document to be saved.
b. Takes the file path to save the socument as.

10. GetDocumentDefinitionNames( [in] BSTR separator, [out, retval]
VARIANT* names)

a. 'separator' is used to convey the directory "level"
b. Returns the (file) names of doc definitions according to the files in various installation

directories.
11. DeleteAllDocuments()

12. UpdateAllDocuments()
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For 6, 7, 8, and 9, the document must have an existing, generated HTML or PDF.

The UserDefinedDocument Data format in the script:

To define a document in VB script:

Array("NAME:Test Report", (Name of the document)
"Test Report", (Description of the document)
"SysLib", (Location of the python script(Syslib, Userlib, PeronalLib etc)
"TestUDDReport", (Relative path of the script in the UserDefinedDocuments folder)

// Start of input definition //
Array("NAME:Inputs", (Document Inputs keyword)
// Solution input //
Array("NAME:DLMetrics", (Input name)
"Solution", (Solution Input Type)
"Data LineMetrics", (Input Description)
-1, (Solution ID)
-1), (Report ID)
// Trace input //
Array("NAME:DQ0", (Input name)
"Trace", (Trace Input Type)
"DQ0", (Input Description)
-1, (Solution ID)
-1), (Report ID)
// Text input //
Array("NAME:Name", (Input name)
"Text", (Text Input Type)
"User Name", (Input Description)
Array("Sita Ramesh")), (Default Value)
// Bool input //
Array("NAME:Summary", (Input name)
"Bool", (Boolean Input Type)
"Display Summary", (Input Description)
Array(true)), (Default Value)
// Number input //
Array("NAME:Version", (Input name)
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"Number", (Number Input Type)
"Script Version", (Input Description)
Array(1021)))), (Default Value)
// Trace selection for the solution and trace inputs //
Array("NAME:DocTraces", (Document traces keyword)
// For input "DLMetrics" //
Array("NAME:DLMetrics", (Input name)
// Trace defintion similar to the UDO. This trace definition is a User defined solution //
Array("User Defined",
"", "DDR3 AC-Timing 4-DQ1", Array("Context:=", ""), Array("Index:=", Array("All"), "Trise:=", Array
("Nominal"), "Tfall:=", Array("Nominal"), "Pulse_Width:=", Array("Nominal"), "Data_Rate:=", Array
("Nominal"), "Length:=", Array("Nominal")), Array("Probe Component:=", Array("")), Array())),
// For input "DQ0" //
Array("NAME:DQ0",
// Trace defintion similar to the UDO. This trace definiton is a Standard solution //
Array("Standard", "DQ0", "NexximTransient", Array("NAME:Context", "SimValueContext:=", Array
(1, 0, 2, 0, false, false, -1, 1, 0, 1, 1, "", 0, 0, "DE", false, "0", "DP", _
false, "20000000", "DT", false, "0.001", "WE", false, "100ns", "WM", false, _
"100ns", "WN", false, "0ps", "WS", false, "0ps")), Array("Time:=", Array("All"), "Trise:=", Array( _
"Nominal"), "Tfall:=", Array("Nominal"), "Pulse_Width:=", Array("Nominal"), "Data_Rate:=", Array
("Nominal"), "Length:=", Array("Nominal")), Array("Probe Component:=", Array( _
"DQ0")), Array())))

Python Script to Define Document

To define a document in Python script:
[
"NAME:Test Report", "Test Report", "SysLib",
"Examples/TestUDDInputs",
[
"NAME:Inputs",
[
"NAME:DLMetrics","Solution", "Data Line Metrics", -1, -1
],
[
"NAME:DQ0", "Trace", "DQ0", -1, -1
],
[
"NAME:DQS", "Trace", "DQS", -1, -1
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],
[
"NAME:Name", "Text", "User Name", ["Sita Ramesh"]
],
[
"NAME:Summary", "Bool", "Display Summary", [True]
],
[
"NAME:Version", "Number", "Script Version" [1021]
]
]
],
[
"NAME:DocTraces",
[
"NAME:DLMetrics",
[
"User Defined", "", "DDR3 AC-Timing 4-DQ1",
[
"Context:=" , ""
],
[
"Index:=" , ["All"], "Trise:=" , ["Nominal"], "Tfall:=" ,
["Nominal"], "Pulse_Width:=" ,
["Nominal"], "Data_Rate:=" , ["Nominal"], "Length:=" ,
["Nominal"]
],
[
"Probe Component:=" , [""]
],
[]
]
],
[
"NAME:DQ0",
[
"Standard", "DQ0", "NexximTransient",
[
"NAME:Context", "SimValueContext:=" ,
[1,0,2,0,False,False,-
1,1,0,1,1,"",0,0,"DE",False,"0","DP",False,"20000000","DT",Fal
se,"0.001","WE",False,"100ns","WM",False,"100ns","WN",False,"0
ps","WS",False,"0ps"]
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],
[
"Time:=" , ["All"],"Trise:=" , ["Nominal"],"Tfall:=" ,
["Nominal"],"Pulse_Width:=" ,["Nominal"],
"Data_Rate:=" , ["Nominal"], "Length:=" , ["Nominal"]
],
[
"Probe Component:=" , ["DQ0"]
],
[]
]
],
]

Sample Script:- This one adds, edits, renames and deletes a document

Set oModule = oDesign.GetModule("UserDefinedDocuments")
' Add a UDD
oModule.AddDocument Array("NAME:Test Report1", "Test Report",
"SysLib", _
"Examples/TestUDDInputs", Array("NAME:Inputs", Array
("NAME:DLMetrics", "Solution", _
"Data Line Metrics", -1, -1), Array("NAME:DQ0", "Trace",
"DQ0", -1, -1), Array("NAME:DQS",
"Trace", "DQS", -1, -1), Array("NAME:Name", "Text", "User
Name", Array("Sita Ramesh")), Array("NAME:Summary", "Bool",
"Display Summary", Array(true)), Array("NAME:Version",
"Number", "Script Version"))), Array("NAME:DocTraces", Array
("NAME:DLMetrics", Array("User Defined", "", "DDR3 AC-Timing
4-DQ1", Array("Context:=", ""), Array("Index:=", Array("All"),
"Trise:=", Array( "Nominal"), "Tfall:=", Array("Nominal"),
"Pulse_Width:=", Array("Nominal"), "Data_Rate:=", Array( 
"Nominal"), "Length:=", Array("Nominal")), Array("Probe
Component:=", Array("")), Array())), Array("NAME:DQ0", Array( 
_
"Standard", "DQ0", "NexximTransient", Array("NAME:Context",
"SimValueContext:=", Array( _
1, 0, 2, 0, false, false, -1, 1, 0, 1, 1, "", 0, 0, "DE",
false, "0", "DP", false, "20000000", "DT", false, "0.001",
"WE", false, "100ns", "WM", false, "100ns", "WN", false,
"0ps", "WS", false, "0ps")), Array("Time:=", Array("All"),
"Trise:=", Array("Nominal"), "Tfall:=", Array("Nominal"),
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"Pulse_Width:=", Array("Nominal"), "Data_Rate:=", Array
("Nominal"), "Length:=", Array("Nominal")), Array("Probe
Component:=", Array("DQ0")), Array())))

' Edit Document
oModule.EditDocument "Test Report1", Array("NAME:Test Report",
"Test Report", _
"SysLib", "Examples/TestUDDInputs", Array("NAME:Inputs", Array
("NAME:DLMetrics", _
"Solution", "Data Line Metrics", 1000001, 0), Array
("NAME:DQ0", "Trace", "DQ0", 32, _
2), Array("NAME:DQS", "Trace", "DQS", 32, 4), Array
("NAME:Name", "Text", "User Name", Array( "Sita Ramesh")),
Array("NAME:Summary", "Bool", "Display Summary", Array(true)),
Array("NAME:Version", "Number", "Script Version"))), Array
("NAME:DocTraces", Array("NAME:DLMetrics", Array( "User
Defined", "Solution", "DDR3 AC-Timing 4-DQ1", Array
("Context:=", ""), Array("Index:=", Array( "All"), "Trise:=",
Array("Nominal"), "Tfall:=", Array("Nominal"), "Pulse_
Width:=", Array( "Nominal"), "Data_Rate:=", Array("Nominal"),
"Length:=", Array("Nominal")), Array("Probe Component:=",
Array("")), Array())), Array("NAME:DQ0", Array("Standard",
"DQ1", "NexximTransient", Array("NAME:Context",
"SimValueContext:=", Array(1, 0, 2, 0, false, false, -1, 1, 0,
1, 1, "", 0, 0, "DE", false, "0", "DP", _
false, "20000000", "DT", false, "0.001", "WE", false, "100ns",
"WM", false, "100ns", "WN", false, "0ps", "WS", false,
"0ps")), Array("Time:=", Array("All"), "Trise:=", Array
("Nominal"), "Tfall:=", Array("Nominal"), "Pulse_Width:=",
Array("Nominal"), "Data_Rate:=", Array("Nominal"), "Length:=",
Array("Nominal")), Array("Probe Component:=", Array("DQ1")),
Array())))

' Rename a UDD
oModule.RenameDocument "Test Report", "Test UDD Report"

' Update UDD
oModule.UpdateDocument "Test UDD Report"

' View Html
oModule.ViewHtmlDocument "Test UDD Report"

' View Pdf
oModule.ViewPdfDocument "Test UDD Report"
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' Save Html
oModule.SaveHtmlDocumentAs "Test UDD Report",
"c:/AnsysProjects/Test.html"

' Save pdf
oModule.SavePdfDocumentAs "Test UDD Report",
"c:/AnsysProjects/Test.pdf"

' Delete UDD
oModule.DeleteDocument "Test UDD Report"

Note The product has to implement the GetModule call to create the UserDefinedDocument
scripting object. For e.g. Check AltraSimDesign.cpp (function GetMgrIDispatch()).

Document Generator Interfaces
This document briefly describes the API interfaces available in the document generator plugin.
(Ansys.Ansoft.DocGeneratorPluginDotNet.dll)
Scripting objects available in the script for the Generate function

l oApp = self.GetUDDAppContext( 
Gets the application context
Usage:- Gets the active project ad the version of the product

oDesktop = oApp.GetAppDesktop()

if oDesktop != None:
vr = oDesktop.GetVersion()
oProject = oDesktop.GetActiveProject()

l oDesign = self.GetUDDDesignContext()
Gets the design context
Usage:- Gets the design name.

oDesign = self.GetUDDDesignContext()
if oDesign != None:
nm = oDesign.GetName()

l IUDDGenerator interface
This interface available in the Generatemethod of the UDDPluginExtension.
This interface can be used to

1. Set the document output file path.
docgen.SetOutput("C:\\Examples\\DocumentOutput.xml")
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2. Get the document root.
docroot = docgen.GetDocumentRoot()

3. Write out to the output file.
docgen.Write()

4. Write Html document
void WriteHTML();

5. Write PDF document
void WritePDF();

6. Load the Html transform object
void LoadHTMLTransform();

7. Load the cached PDF transform object
void LoadPDFTransform();

8. Get script path
string GetScriptPath();

9. Get output file path
string GetOutputFilePath();

l IUDDRoot interface
Calling GetDocumentRoot() on the IUDDGenerator interface provides you with the this
interface. This interface can be used to

1. Add a new section to the document. Provide a section title.
section1 = docroot.AddSection("Section title")

2. Add a new section to the document. Provide a section title and subtitle
section1 = docroot.AddSection("Section title", "Section
subtitle")

3. Add a new title
section1 = docroot.AddTitle("Title")

4. Add a new subtitle
section1 = docroot.AddSubtitle("Subtitle")

Post Processing andGenerating Reports 23-251
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l IUDDSection interface
Calling AddSection() on the IUDDRoot interface provides you with the this interface. This
interface can be used to

1. Set an ID for the section for internal links.
section1.SetID("id")

2. Add a new table to the document. Provide a table title.
table1 = section1.AddTable("Table title")

3. Add a new image to the document. Provide an image title and a file path to the image file.
image1 = section1.AddImage("Image title")

4. Add text to the document.
text1 = section1.AddText("Random text........")

l IUDDImage interface
Calling AddImage() on the IUDDSection interface provides you with the this interface. On this
interface you can call the followingmethods

1. Set an ID for the image for internal links.
image1.SetID("id")

2. Set alignment information . can be "center", "left" and "right".
image1.SetAligment("center")

3. Set the file path of the image file. Not necessary if image file path is set through the AddImage
() method

image1.SetFileRef("Image path")

4. Set the format of the image file. Can be "BMP", "PNG", "JPEG", "JPG", "DVI" etc.. Not sure
about the necessity of this one.

image1.SetFormat("format")

l IUDDText interface
Calling AddText() on the IUDDSection interface provides you with the this interface. On this
interface you can call the followingmethods

1. Set an ID for the text for internal links.
text1.SetID("id")

2. Set the emphasis attribute on the text
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text1.SetEmphasis()

3. Set the quotes attribute on the text
Text1.SetQuotes()

4. Set the block quotes attribute on the text
text1.SetBlockquotes()

5. Set quotes on the text
Text1.SetQuotes()

6. Set the wordsize attribute on the text
text1.SetSize(size as an integer)

7. Set a link to an ID of any element to provide internal links
text1.SetLink("linkname")

8. Set an event link to handle an event. The HandleUDDEventsmethod should be implemented
in the script to handle the event.

text1.SetEventLink("linkname")

l IUDDTable interface
Calling AddTable() on the IUDDSection interface provides you with the this interface. On this
interface you can call the followingmethods

1. Set an ID for the table for internal links.
table1.SetID("id")

2. Set alignment information . can be "center", "left" and "right".
table1.SetAlignment("center")

3. Set the background color of the table
table1.SetBgColor(string bgcolor)

4. Set the frame type. Can be "all", "bottom", "top,", "sides", "topbot"
table1.SetFrame(string frame)

5. Add a table group and specify the number of columns. A table can havemultiple table groups.
IUDDTableGroup table1.SetTableGroup(int columns)

l IUDDTableGroup interface
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Calling AddTableGroup() on the IUDDTable interface provides you with the this interface. On
this interface you can call the followingmethods

1. Set an ID for the table group for internal links.
tgroup1.SetID("id")

2. Set alignment information . can be "center", "left" and "right".
tgroup1.SetAlignment("center")

3. Set the columnwidth of a column given the index of the column and the required width. Width
can be set in 2 ways.

l Width can be set relative to 1. E.g Setting it to "2*" makes the columnwidth double the
width of the others.

l If the entire table width is considered to be 99.99 units. Width can be a number relative to
this.

tgroup1.SetColumnWidth(int index, string width)

4. Add a header to the table group
IUDDTableRow tgroup1.AddHeader()

5. Add a header with multiple rows to the table group. Takes number of sub rows.
IUDDTableRow tgroup1.AddHeader(int rows)

6. Add a row of content to the table group
IUDDTableRow tgroup1.AddContent()

7. Add content with multiple rows to the table group. Takes number of sub rows.
IUDDTableRow tgroup1.AddContent(int rows)

l IUDDTableRow interface
Calling AddHeader() & AddContent() on the IUDDTableGroup interface provides you with the
this interface. On this interface you can call the followingmethods

1. Set an ID for the table row for internal links.
trow1.SetID("id")

2. Set alignment information . can be "center", "left" and "right".
trow1.SetAlignment("center")

3. Set cell text. Can be cell content or header text. Takes a column index and a text string. It is
added to the first row.

Post Processing andGenerating Reports 23-254
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

IUDDTextElement trow1.Add(int column, string text)

4. Set cell text. Can be cell content or header text. Takes a column index, row index and a text
string. Takes in a row number because a table row can havemultiple sub rows.

IUDDTextElement trow1.Add(int column, int subrow, string
text)

5. Set cell content. Takes a column index and an int value. It is added to the first row.
IUDDTextElement trow1.Add(int column, int value)

6. Set cell content. Takes a column index, row index and a int value.
IUDDTextElement trow1.Add(int column, int subrow, string
text)

7. Set cell text. Takes a column index and a double value. It is added to the first row.
IUDDTextElement trow1.Add(int column, double value)

8. Set cell text. Takes a column index, row index and a double value.
IUDDTextElement trow1.Add(int column, int subrow, double
value)

9. Set cell text spanning 2 columns. Can be cell content or header text. Takes a sub row index ,
starting column index., ending column index and a text string.

IUDDTextElement trow1.AddSpanningcolumnst(int subrow, int
columnstart, int columnend, string text)

10. Set cell text. Can be cell content or header text. Takes a column index, starting sub row index,
ending sub row index and a text string.

IUDDTextElement trow1.AddpanningRows(int column, int
subrowstart, int subrowend, string text)

l IUDDTableRow interface
Calling Add() on the IUDDTableGroup interface provides you with the this interface. On this
interface you can call the followingmethods

1. Set an ID for the table row for internal links.
trow1.SetID("id")

2. Set alignment information . can be "center", "left" and "right".
trow1.SetAlignment("center")

Includes all themethods exposed by the IUDDText interface.
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24 - Desktop Scripting with IronPython
This document describes IronPython briefly and then goes on to describe the desktop provided
IronPython scripting console and scripting with IronPython. You can open an IronPython Command
Window by clicking Tools>Command Window.

The document assumes that you know how desktop scripting works using VBScript or Javascript.
Introduction to IronPython
IronPythonMini-cookbook
Translating Script commands fromVBScript to IronPython
Scripting Using Iron Python: Putting it all Together
IronPython Samples
Creating User Defined Primitives and User DefinedModels in Python Scripts

Related Topics

User DefinedOutputs: An Introduction

Introduction to IronPython
IronPython is an implementation of the Python programming language targeting the .NET runtime.
What thismeans in practical terms is that IronPython uses the Python programming language syntax
and standard python libraries and can additionally use .NET classes and objects to give one the best
of both worlds. This usage of .NET classes is fairly seamless in that a class defined in a .NET
assembly can be used as a base class of a python class.

Scope
Functioning as a tutorial on Python or IronPython is way out of the scope of this document. There are
several excellent resources online that do a very good job in that regard. This document only

Maxwell Online Help
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attempts to provide a limited introduction to IronPython as used to script ANSYS Electromagnetics
products.
This document is also not a tutorial on the scripting of ANSYS Electromagnetics products. It
complements the existing scripting guide (available from a product's Helpmenu) and provides a
pythonic interpretation of that information. The reader might have to refer to either the scripting guide
or recorded samples of VBScript to follow some of the sections.

Python compatibility
The version of IronPython in use is 2.6.1 and built on the .NET framework version 2.0: this version
targetsPython 2.6 language compatibility. While most python files will execute under IronPython
with no changes, python libraries that make use of extensionswritten in the C programming
language (NumPy or SciPy for instance), are not expected to work under IronPython. In such cases,
it might be possible to locate .NET implementation of such libraries or explore the use of IronClad.
(http://code.google.com/p/ironclad/).

Advantages of IronPython
The advantages that IronPython use provides are significant:

l Python has a large eco-systemwith plenty of supporting libraries, Visual IDEs and debuggers.
It is actively developed and enhanced.

l IronPython, in addition, has access to the entire .NET eco system. This allows us, for instance,
to create amodern GUI using theSystem.Windows.Forms assembly from IronPython code
and call any other .NET assembly for that matter.

l The use of IronPython's technologies enables the ability to interactively script Desktop
(feature in development). This allows better discovery of the scripting APIs aswell as directly
programming to the scripting API in python, a languagemore tractable and platform
independent compared with VBScript.

l The Python syntax of dictionaries is somewhat easier to read and write when supplying
arguments to the scriptingmethods.

Related Topics

IronPythonMini-cookbook
Translating Script commands fromVBScript to IronPython
Scripting Using Iron Python: Putting it all Together
IronPython Samples

IronPython Mini-cookbook
While a tutorial on Python syntax is beyond the scope of this document, it will present simple
counterparts the VBScript constructs that users tend to regularly use.
Comments
Assigning/Creating variables
Create Lists/Arrays
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Create Dictionaries/Maps
Boolean Values
Converting Numbers to Strings and Vice Versa
String Formatting/Concatenation
Looping over Lists
Looping over a Range
A Note About Indentation
Additional Sections:
ObtainingMore Information
DiscoveringMethods
Help on aMethod

Comments

VBScript IronPython
' Comments start with a single
quote
' like this line

# Comments start with a sharp or
hash
# symbol, like these lines

Assigning/Creating Variables

VBScript IronPython
' Declare with a Dim
Dim oDesktop

'Assignment needs a Set
instruction
Set oDesktop = oApp.GetAppDesktop
()

# No Set syntax. Simply create and
assign
oDesktop = oApp.GetAppDesktop()

Create Lists/Arrays

VBScript IronPython
' Declare as array of String with 11
' indices from 0 through 10
DimmyArray(0 to 10) as String
myArray(0) = "Hello"
myArray(1) = "bye"

' Declare n array with no size
Dim array2() as String

# Declare an empty array
myEmptyArray = []

# declare an array and initialize it with 5
ints
myInitedArray = [ 1, 2, 3, 4, 5]

# Python lists can have items of any type
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' Re-Dimension the array once size
is
' known
ReDim array2(0 to 2) as String
array2(0) = "this"
array2(1) = "also"

# and there is no pre-declaration
# declare an array and init with mixed
types
mixed = ["hello", 1 ,2 ["nested"]]

# append to an array
mixed.append( 3.5 )

Create Dictionaries/Maps

VBScript IronPython
' No direct equivalent is available
as
' far as the author knows

# an IronPython dictionary is a collection of
# name value pairs. Just like arrays, there is
# no restriction on the keys or the values.
# For purposes of ANSYS EM scripting
however,
# all keysmust be strings

# delimiters are curly braces
# use a ":" between the key and the value
# separate key value pairs with a ","
myDict = {

"a" : 1,
"b" : "hello there",
"c" : [ 1, 2, "abc"]

}

Boolean Values

VBScript IronPython
' Boolean literals are in lower
case
true
false

# The first letter is
capitalized
True
False

Converting Numbers to Strings and Vice Versa

VBScript IronPython
' UseCInt, CDbl, CBool, CLng
' to convert the string representation
' to the number representation. Use
' IsNumber to check before

# use the integer() or float() or double()
# functions to cast a string CONTAINING
the
# string representation of whatever you are
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conversion
Dim nStr = "100"
Dim n = CInt(nStr)

' Use CStr to convert a number to
' its string representation
Dim v, vStr
v = 100
vStr = CStr(v)

# casting to.
strInt = "3"
intVal = int(strVal)
floatVal = float(strVal)

# invoke the str() function with the int/float
# values as needed. You can alternately use
# the string formattingmethod listed below
strVal = str(42)
strVal = str(42.345)

String formatting/concatenation

VBScript IronPython
' string concatenation uses the &
' operator
Dim allStr, str1
str1 = " how are you"
allStr = "Hello " & " There" & str1

' there seems to be no direct string
' formatting function in VBScript
' using string concatenation or using
' Replace are the two builtin
options
Dim fmt = "{1} climbs stalk {2}"
Dim str = Replace(fmt, "{1}", "jack")
str = Replace(str, "{2"}, 10)

# if you have two strings, you can always
# concatenate then using the '+' operator
str1 = "hello"
str2 = "world"
str12 = str1 + " " + str2

# if you have different types though, string
# and int say, youmust use the string
# formatting commands.When formatting
#multiple arguments, theymust be
entered
# as a tuple ( item1, item2, )
num = 10
str3 = "%s climbs stalk%d"% ("jack",
num)
str4 = "%d stalks"% num

Looping over lists

VBScript IronPython
DimmyArray(0 to 2) as
String
myArray(0) = "alpha"
myArray(1) = "bravo"
myArray(2) = "charlie"

For Each i in myArray
Print i
Next

vals = [1, 3, 3.456]

def process(val):
return 2*val

# is of the form
# for variable_name in array
':'
# < indent> statement1
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# <indent> statement2
for i in vals:

print i
print " -> " process(i)

Looping over a range

VBScript IronPython
' Loop over a range, specify start,
end
' and step
For i = 0 To 10 Step 1
Print i
Next

# prints out values from 0 through
9
for i in range(0, 10):
print i

Related Topics

A Note About Indentation
ObtainingMore Information
DiscoveringMethods
Help on aMethod
Introduction to IronPython
Translating Script commands fromVBScript to IronPython
Scripting Using Iron Python: Putting it all Together
IronPython Samples

A note about indentation

Python is one of the languageswhere whitespace (spaces, tabs etc) are syntactically significant.
Youmust understand the basics of indentation before scripting in python.
Any statement that introduces a block of code should be written such that every line of the block has
the same indent (leading spaces or tabs) and the indent should be at least onemore than the indent
of the introducing statement.

# define a function that starts at 0 indentation.
def multInt(a,b):

# every line following the def multInt which is expected
# to be a part of the function, must have the indent used
# by the first line of the function (3 spaces)

# here we introduce one more block, the if condition
# each line that belongs to the body of this func should
# have an indent that is more than the indent used by the
# if statement
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If a%2 == 0:
# I am using an indent 2 more than the parent. i.e. 5
# spaces in total
return (a * b) + 100

else:
return (a * b) + 1000

Sample Script 1: Describing python indentation

Related Topics

ObtainingMore Information
DiscoveringMethods
Help on aMethod
Introduction to IronPython
Translating Script commands fromVBScript to IronPython
Scripting Using Iron Python: Putting it all Together
IronPython Samples

Obtaining more Information on Python

Reading a book and searching online are two of the standard options. There are several very good
python tutorials online and the commandwindow is also a great way to quickly execute code and
learn by doing.
Much of the official python documentation is embedded into each python distribution and the
commandwindow can also be used to get more help. You can open the IronPython Command
Window by clicking Tools>CommandWindow. You can also aces the commandwindow
executable, Ipy.exe, from the IronPython directory under the ANSYS Electromagnetics product
installation directory. You can use this window to interactively enter python commands (any of the
pure python samples in this document)

Related Topics

DiscoveringMethods
Help on aMethod
Introduction to IronPython
Translating Script commands fromVBScript to IronPython
Scripting Using Iron Python: Putting it all Together
IronPython Samples
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Discovering Methods

For instance, if you want to list all methods available in the stringmodule, you would type in "import
string" to import themodule first and then type in "dir(string)". You will get a list of all themethods
available (as well as some __somename__ internal names that can be ignored)

Related Topics

ObtainingMore Information
Help on aMethod
Introduction to IronPython
Translating Script commands fromVBScript to IronPython
Scripting Using Iron Python: Putting it all Together
IronPython Samples

Help on a Method

Once you know a function name (maybe you see something you like from the dir(string) listing
above), you can get more help on it using the builtin helpmethod. For instance, executing help
(string.split) in the IronPython Command Window displays the following:
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Related Topics

ObtainingMore Information
DiscoveringMethods
Introduction to IronPython
Translating Script commands fromVBScript to IronPython
Scripting Using Iron Python: Putting it all Together
IronPython Samples

Translating Script commands from VBScript to IronPython
This chapter briefly describesDesktop scriptingmethods and arguments via VBScript samples. The
distinctionsmade here are significant and come in use later when translating scripts written in
VBScript to IronPython.
Script Method Argument
VBscript Method Call Types
VBScript Sub-Routines
Converting VBScript Function calls to IronPython Syntax

Related Topics

Introduction to IronPython
IronPythonMini-cookbook
Scripting Using Iron Python: Putting it all Together
IronPython Samples

Script Method Argument

Script method calls in VBscript are described later in this document, they generally take the form:
objectName .methodName ( arg1, arg2, ..)

The function call syntax is a standard followed by several programming languages, however, the
argument types in VBScript objects, when used for product scripting, are restricted to the following
Primitive types
Named Array
Named Function

Primitive Types
Primitive types are the standard bool, int, float, double and string

Named Array
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Named arrays are a special construct used very commonly and can be found in practically every
recorded script sample.
It starts withArray( "NAME:someName" and is followed by a collection of comma separated
valueswhich can be:

l A primitive value
l An array of primitive values
l Another named array
l A key, of the form "keyName:=" followed by

l A primitive value
l A function (described next)

Named Function
Named functions are arrayswhich start withArray( and do not have a leading "NAME:name" item.
They are always introduced by a key and can contain comma separated values of the following
type:

l A primitive value
l A key (of the form "keyName:=") followed by

l A primitive value
l Another function (nested function)

Related Topics

Translating Script commands fromVBScript to IronPython

VBscript Method Call Types

VBScript method calls fall into two categories and the distinction between the two results in syntax
differences. These syntax differences are significant when converting VBScript to IronPython.

VBScript Functions
In VBScript terminology functions return values. The syntax for this is the one shared with practically
all programming languages.

Set oDesktop = oAnsoftApp.GetAppDesktop()
Set oProject = oDesktop.NewProject

Sample Script 2: VBScript function call sample
Note that the significant item here is that themethod name is always followed by an argument list
enclosed in parentheses if there are arguments. If the argument list is empty as shown above for
theNewProject call, the parentheses can be omitted.

VBScript Sub-Routines
VBScript Sub-Routines are those that do not have any return value. VBScript allows these to be
written without any parentheses even if they have a non-empty argument list.
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oModule.CreateReport "XY Plot1", "Standard", "XY Plot", "optimtee :
optimtee", _

Array("Domain:=", "Sweep"), Array("Freq:=", Array("All"),
"offset:=",_

Array("0uin")), Array("X Component:=", "Freq", "Y Component:=", _

Array("dB20(S(1,1))", "dB20(S(1,2))", "dB20(S(1,3))", _

"dB20(S(2,1))", "dB20(S(2,2))", "dB20(S(2,3))", "dB20(S(3,1))",

"dB20(S(3,2))", "dB20(S(3,3))")), Array()

Sample Script 3: VBScript Sub-Routine sample

Related Topics

Translating Script commands fromVBScript to IronPython

Converting VBScript Function calls to IronPython Syntax

When converting functions, the important point to remember is that IronPython function names,
when used for scripting, are always followed by parentheses. So:

l If you see a VBScript snippet that looks like a VBScript Sub-Routine, remember to add
parentheses.

l If you see a VBScript function that has no arguments and no parenthesis, remember to add
them around an empty argument list.

The parentheses change is the only one to keep inmind when converting VBScript function calls
syntax to IronPython.
Return Values
PrimitiveMethod Arguments
Named Array Argument
Named Array Valueswith All Key Value Pairs
Named Arrayswith Nested Named Arrays
Function Blocks

Return Values

VBscript return values are sometimes assigned via theSet declaration. IronPython return values are
simple assignment (see the cookbook chapter)

Related Topics

Converting VBScript Function calls to IronPython Syntax
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Primitive Method Arguments

Replace each VBScript primitive with an equivalent IronPython primitive. Themain thing to notice
here is that Boolean values in IronPython have their first letter capitalized.

True instead of true and False instead of false

Related Topics

Converting VBScript Function calls to IronPython Syntax

Named Array Argument

The recommended approach here is to simply replace a VBScript array with a python array. The
mapping is quite simple:

l ChangeArray( to [ and close with a ] instead of the )
l Remove the line continuation symbols: _
l MapBoolean values correctly

oEditor.CreateCone Array("NAME:ConeParameters", "XCenter:=", "0mm", _
"YCenter:=", "0mm", "ZCenter:=", "0mm", "WhichAxis:=", "Z", "Height:=", "2mm",_
"BottomRadius:=", "1.56204993518133mm", "TopRadius:=", "0mm"), Array("NAME:Attributes",
"Name:=", "Cone1", "Flags:=", "", "Color:=", _
"(132 132 193)", "Transparency:=", 0, "PartCoordinateSystem:=", _
"Global", "UDMId:=", "", "MaterialValue:=", _
"" & Chr(34) & "vacuum" & Chr(34) & "", "SolveInside:=", true)

Sample Script 4: Create cone recorded snippet
For instance, method and named VBScript arrays in the snippet above are translated to

oEditor.CreateCone(
[

"NAME: ConeParameters",
"XCenter:=" , "0mm",
"YCenter:=" , "0mm",
"ZCenter:=" , "0mm",
"WhichAxis:=" , "Z",
"Height:=" , "2mm",
"BottomRadius:=" , "1.56204993518133mm",
"TopRadius" , "0mm"

],
[

"NAME:Attributes",
"Name:=" , "Cone1",
"Flags:=" , "",
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"Color:=" , "(132 132 193)",
"Transparency:=" , 0,
"PartCoordinateSystem:=" , "Global",
"UDMId:=" , "",
"MaterialValue:=" , "\"vacuum\"",
"SolveInside:=" , True

])

Sample Script 5: Create a cone in IronPython
Note that the formatting (which helps readability immensely) is not really needed. All that had to be
done was

l Add the parentheses since the VBScript subroutine omits it
l Replace theArray( ) delimiters with [ ].
l Remove the Char(34) function (which introduced a double quote) and replace it with the
escaped double quote \" literal.

l Replace truewith True
l Remove the line continuation symbol, _

Related Topics

Converting VBScript Function calls to IronPython Syntax

Named Array Values with All Key Value Pairs

While it is in general not allowed to replace the arrays and nested arrayswith python dictionaries, in
the case where the named array consists entirely of key value pairs (like the sample above), one can
use a dictionary and avoid typing the trailing ":=" symbols after the keys. This further aids
readability of the script.

l If all key value pairs
l Remove the trailing ":=" after each key
l Replace the "," after the keywith a ":"
l If the named array is the top level argument, ensure that the "NAME:name" is present and is
split into "NAME" : "name" as a key value pair

l Enclose the converted array in a { } pair to declare the dictionary.
oEditor.CreateCone(

{
"NAME" : "ConeParameters",
"XCenter" : "0mm",
"YCenter" : "0mm",
"ZCenter" : "0mm",
"WhichAxis" : "Z",
"Height" : "2mm",
"BottomRadius": "1.56204993518133mm",
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"TopRadius" : "0mm"
},
{
"NAME" : "Attributes",
"Name" : "Cone1",
"Flags" : "",
"Color" : "(132 132 193)",
"Transparency" : 0,
"PartCoordinateSystem": "Global",
"UDMId" : "",
"MaterialValue" : "\"vacuum\"",
"SolveInside" : True
}

Sample Script 6: CreateCone in IronPython using dictionary syntax

Related Topics

Converting VBScript Function calls to IronPython Syntax

Named Arrays with Nested Named Arrays

l Split the "NAME:name" field into a key value pair
l Translate array key value pair to a dictionary key value pair.
l Create a new keywith the name of the nested array and keep the nested array (as an array or
as a dictionary) as its value. If the nested array is being retained as an array,
the"NAME:name" field should be retained in the array. If the nested array is being
converted to a dictionary, the name is optional: if also retained in the nested array, it must
match the outer key.

[ "NAME:name",
"key1:=" , 1,
"key2:=" , 2,
["NAME:name2", "R:=", 255]

]

Sample Script 7: Named array with nested named array in array syntax
The above named arraywith a nested named array (after conversion to IronPython as named array)
can be converted to a dictionary aswell. The dictionary can take any of the following forms

{ "NAME" : "name",
"key1" : 1,
"key2" : 2,
"name2" : ["NAME:name2", "R:=", 255]

}
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Sample Script 8: Named array with nested named array as mixed dictionary + array

{ "NAME" : "name",
"key1" : 1,
"key2" : 2,
"name2" : {"R" : 255}
}

Sample Script 9: Named array with nested named array in all dictionary syntax

{ "NAME" : "name",
"key1" : 1,
"key2" : 2,
"name2" : {

"NAME" : "name2",
"R" : 255

}
}

Sample Script 10: Nested named array with optional "NAME:" field

Related Topics

Converting VBScript Function calls to IronPython Syntax

Function Blocks

Function blocks in VBScript argument syntax are represented as arrayswithout the "NAME:.." field.
However, functions are always introduced by a key in a parent structure. Function blocks can
therefore never exist as a top-level argument. They are only found as the value pairs inside a named
array or inside another function block.

Note Function blocks and their items cannot be converted to dictionaries even though theymight
be composed entirely of key value pairs.

The reason for this is the need tomain the user-entered order. Every item in a function block is
expect to be transmitted to the script method in exactly the same order as typed out and this is
impossible to achieve when a dictionary is used (as the keys get reordered according to the
dictionary's internal tree/key sorting scheme).

Note When you see a function block, simply replace the Array( ) delimiters with the python array
delimiters [ ]
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Related Topics

Converting VBScript Function calls to IronPython Syntax

Scripting Using Iron Python: Putting it all Together
If you have existing VBScript/Javascript scripts use existing scripts them asmuch as possible by
either embedding the test into the IronPython script or invoking them via the Runmethods described
later in this chapter.

Translating a script in VBScript to IronPython
Read the chapter on translation and study the samples in that chapter aswell as those in the
appendix. For python syntax and the differences, themini-cookbook chapter will also be useful.

Writing an IronPython script from scratch
Read through the scripting guide available from the product's helpmenu and translate the VBScript
methods described to IronPython using the information provided in the chapter on translation.
Studying the samples in the document will also prove helpful.
For python syntax and the differences, themini-cookbook chapter will also be useful.
IronPython Script Execution Environment
Scripting using Embedded VBScript or JavaScript
Scripting with IronPython
Methods for Manipulating Registry Values

Related Topics

Introduction to IronPython
IronPythonMini-cookbook
Translating Script commands fromVBScript to IronPython
Appendix: IronPython Samples

IronPython Script Execution Environment

Scripts written in IronPython are executed by desktop in four different ways:
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l Tools>Command Window, to open the IronPython Command Window:

l Tools > Run Scriptmenu item, select "IronPython" from the file type drop down
l Launch the product with a script argument, e.g.,Maxwell -runscript someScript.py
l Register an IronPython script as an external tool using the Tools > External Toolsmenu
item.

When desktop executes a script, it does so in an execution environment setup with predefined
variables and functions. These predefined variables and functions are how the script communicates
with the desktop and they come in three flavors.
Script Argument for IronPython
Script Objects for IronPython
Methods for IronPython

Script Argument for IronPython

When scripts are launched using the Tools > Run Scriptmenu item, the dialog that pops up allows
the user to specify arguments.

Figure 1: Run Script dialog and script arguments
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Any argument specified here is communicated to the script being executed as the predefined
variableScriptArgument.

Related Topics

IronPython Script Execution Environment

Script Objects for IronPython

TheDesktop script objects are available to every IronPython script being run. The names used
follow the same convention aswith VBScript.

l oAnsoftApplication is the script object representing the entire application.
l oDesktop is the script object representing the desktop.While this can be obtained from the
oAnsoftApplication using oAnsoftApplication.GetAppDesktop(), since this is a very commonly
used script object, it is alwaysmade available.

The use of these objects is done as per the individual product scripting guideswith some syntax
adjustmentsmade for the parameters to account for the IronPython differences.

Related Topics

IronPython Script Execution Environment

Methods for IronPython

A collection of methods ismade available to all python scripts to enable the use of existing scripts
written in VBScript or Javascript. Additional utilitymethods to addmessages to the desktopmessage
window are also present.

l AddErrorMessage(str), AddWarningMessage(str), AddInfoMessage(str) and
AddFatalMessage(str) this family of methods allows a script to addmessages to the
product'smessage window. All methods take a python string.

l RunScriptFile(filename) runs the contents of the supplied file as a script. The type of the
script (Javascript/VBScript) is deduced from the file extension.

l SetScriptingLanguageToJavascript(), SetScriptingLanguageToVBScript() allows the
script to change the syntax of the language being used in theRun*Command commands
listed below. Once set, the language choice remains for the rest of the script execution or till it
is changed. The default isVBScript.

l RunScriptCommand(CommandString) runs the supplied script text. The language of the
text is controlled by a previous call toSetScriptingLanguageToJavascript() or
SetScriptingLanguageToVBScript()

l RunDesktopCOmmand(CommandString) runs the supplied script text. The text is
expected to generally be a single line and be amethod call on a oDesktop object. The
oDesktop object is initialized based on the supplied optional ProjectNamePparameter. If the
ProjectName parameter is not supplied, the active project is used.
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l RunProjectCommand(CommandString,ProjectName=None, ProjectName=None)
runs the supplied script text. The oDesign object is initialized based on the supplied optional
parameters. If the ProjectName is not supplied, the active project is used to resolve the
project. If the DesignName is not supplied, the project’s active design or first design will be
used to resolve the oDesign object within the project.

l RunModuleCommand(CommandString,ModuleName, DesignName=None,
ProjectName=None) runs the supplied script text. The text is expected to be a single line and
be amethod call on a oModule object. The design targeted is resolved using the supplied
optional DesignName and ProjectName parameters and the oModule object is initialized
using the suppliedModule name on that resolved design.

l RunEditorCommand(CommandString, EditorName,DesignName=None,
ProjectName=None) runs the supplied script text. The text is expected to be a single line and
be amethod call on a oEditor object. The design targeted is resolved using the supplied
optional DesignName and ProjectName parameters and the oEditor object is initialized using
the supplied Editor name on that resolved design.

l RunDefinitionManagerCommand(CommandString, ProjectName=None) runs the
supplies script text. The text is expected to be a single line and be amthod call on a
oDefinitionManager object. The oDefinitionManager object is created for the project
specifie4d by the optional ProjectName parameter.

Related Topics

IronPython Script Execution Environment

Methods for Manipulating Registry Values

The ANSYS Registry is stored as an XML file format, file is located (by default) at
C:\Users\<UserName>\Documents\Ansoft\<AnsysProductNameversion>\config\<PC_NAME>_
user.XML. Most of the ANSYS product configuration information is stored in this XML file. So the
following sixmethods allow a user to change the product configuration in VB-script or Python script.

l GetRegistryString("KeyPath") - returns the registry key string value, if successful.
Example:
value = oDesktop.GetRegistryString
("Desktop/ActiveDSOConfigurations/HFSS")

l SetRegistryString "KeyPath", "string" - sets the registry key to the specified string value.
Example:
oDesktop.SetRegistryString
"Desktop/ActiveDSOConfigurations/HFSS", "Local"

l GetRegistryInt("KeyPath") - returns the registry key int value.
Example:
num = oDesktop.GetRegistryInt
("Desktop/Settings/ProjectOptions/HFSS/UpdateReportsDynamicallyO
nEdits")

l SetRegistryInt("KeyPath", int) - Sets a registry key to a specified int value.
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Example:
oDesktop.SetRegistryInt
("Desktop/Settings/ProjectOptions/HFSS/UpdateReportsDynamicallyO
nEdits", 0)

l DoesRegistryValueExist("KeyPath") - returns a boolean true if a key exists, and false if
not.
Example:
bExist =oDesktop.DoesRegistryValueExist
("Desktop/ActiveDSOConfigurations/HFSS")

l SetRegistryFromFile("FilePath") - full path to an Analysis Configuration File, which has
been exported from theHPC and Analysis Options panel.
Example:
oDesktop.SetRegistryFromFile("c:\\temp/test.acf")

Example for how to set the DSO & HPC analysis setup with Python script
1. In a PC start HFSS go to the DSOandHPC options dialog, create a setup name it as "test"
2. Export the setup to a file c:\tem\test.acf.
3. Copy the exported file to a target PC f:\temp\test.acf.
4. Run the following script.

#import the setup
oDesktop.SetRegistryFromFile("f:\\temp\\test.acf")
# Set Active Setup to "test"
oDesktop.SetRegistryString
("Desktop/ActiveDSOConfigurations/HFSS", "test")

Scripting using Embedded VBScript or JavaScript

Since script recording is still done in VBScript and users are expected to have a significant collection
of VBScript or JavaScript assets, it is useful to continue to use existing script files and snippets even
when scripting in IronPython. The variousRun<*>Commandmethods have been designed for this
purpose.
For instance: one can create a parameterized cone in HFSS by executing the following IronPython
script from the Tools>Run Scriptmenu.
# assign the VBScript snippet obtained from a script recording from
HFSS to

# coneScript and replace the BottomRadius recorded value with
botRadius

coneScript = """Dim oAnsoftApp

Dim oDesktop

Dim oProject

Dim oDesign
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Dim oEditor

Dim oModule

Set oAnsoftApp = CreateObject("AnsoftHfss.HfssScriptInterface")

Set oDesktop = oAnsoftApp.GetAppDesktop()

oDesktop.RestoreWindow

Set oProject = oDesktop.GetActiveProject()

oProject.InsertDesign "HFSS", "HFSSPyTestDesign", "DrivenModal", ""

Set oDesign = oProject.SetActiveDesign("HFSSPyTestDesign")

Set oEditor = oDesign.SetActiveEditor("3D Modeler")

oEditor.CreateCone Array("NAME:ConeParameters", _

"XCenter:=", "0mm", "YCenter:=", "0mm", "ZCenter:=", "0mm",_

"WhichAxis:=", "Z", "Height:=", "2mm", _

"BottomRadius:=", "3mm", _

"TopRadius:=", "0mm"), Array("NAME:Attributes", "Name:=", _

"Cone1", "Flags:=", "", "Color:=", "(132 132 193)",
"Transparency:=", 0, _

"PartCoordinateSystem:=", "Global", "UDMId:=", "",
"MaterialValue:=", _

"" & Chr(34) & "vacuum" & Chr(34) & "", "SolveInside:=", _

true)

"""

SetScriptingLanguageToVBScript()

RunScriptCommand(coneScript)

Sample Script 11: Hybrid VBScript + IronPython scripting: parameterized Cone Creation
Even though recorded VBScript is used for scripting, the incremental functionality that is provided
using IronPython is the ability to write a GUI using IronPython/.NET, collect information from the
user and thenmodify or generate the VBScript commands to actually script the ANSYS
Electromagnetics desktop. ThisGUI functionality is cross platform and a significant positive. The
following example demonstrates a contrived use of a .NET window form to display the argument
supplied to the IronPython script (via theScriptArgument variable).

#import the CLR references
import clr
clr.AddReference("System.Windows.Forms")

from System.Windows.Forms import Application, Form, Label,
Button, DockStyle

# the GUI form to show some text
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# the class below derives from From
(System.Windows.Forms.Form)
# imported above from the .NET assembly.
class ShowPropertiesForm(Form):

def __init__(self, name, text):
self.Name = name
self._label = Label()
self._label.Text = text
self._label.Dock = DockStyle.Fill

_button = Button()
_button.Text = "Close"
_button.Dock = DockStyle.Bottom
_button.Click += self._buttonPressed

self.Controls.Add(self._label)
self.Controls.Add(_button)

def _buttonPressed(self,sender,args):
self.Close()

#----------------------------------------------------
# Main script code
#----------------------------------------------------
#display the ScriptArgument variable as the text label
# in the form.
gui = ShowPropertiesForm("Sample Form", ScriptArgument)

# This makes it a modal dialog.
gui.ShowDialog()

# the following will make it a non-modal dialog
#Application.Run(gui)

Sample Script 12: Demonstrates the use of a .NET form from IronPython
While creating cross platform user interfaces from scripts is one of themainmotivations driving the
adoption of IronPython, any .NET assembly can be used with the caveat that Linux use requires
Mono compatibility of any used assemblies.
While this hybrid approach is useful when you have existing VBScript commands that you want to
reuse or when you want to quickly parameterize a recorded sample, the one significant limitation of
this approach is the inability to capture return values fromVBScript or JavaScript calls that do return
something. Full two way communication with the product requires the use of pure IronPython to
directly invoke the script objects as described below.
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Related Topics

IronPython Script Execution Environment

Scripting with IronPython

While this section talks about directly interacting with the script objects, note that you can execute
VBScript or Javascript at any point using any of the available Run*Command functions. using your
existing script assets in this fashion andmixing with IronPython code for new functionality as needed
is a viable and option.
Access to the application scripting objects is provided via the predefined oDesktop object (as listed
in Script Objects). Interacting with the script objects is very natural, method calls aremade just like in
VBScript except that the argument syntax is somewhat simplified to follow natural Python syntax. All
primitive types (string, integer, double) map to the natural primitive types in python. The only
differences from the VBScript syntax are seen when specifying array type arguments. The
differences are described in earlier chapters.

Note The typical VBScript calls to obtain the registered COMscripting interface via
CreateObject calls and then obtain the oDesktop object from it using theGetAppDesktop()
is not needed (or even supported on all platforms). Since all scripting occurs in the context
of a running workbench, the available Desktop object is always provided and expected to
be used directly.

Scripting using the IronPython scripting API is verymuch like scripting with VBScript except that
l Any argument is supplied via the built inScriptArgument variable
l The oDesktop object is always available
l The scriptingmethod names are identical to the ones used with VBScript
l Method calls, while the name is the same have to adhere to the rule of ensuring trailing
parentheses irrespective of whether the function returns anything or has any arguments.

l Any compound/block arguments should be translated to the appropriate IronPython array or
dictionary syntax.

The samples section lists a collection of pure IronPython snippets: these, along with the various
script snippets listed in this document should serve as a guide and reference.

Related Topics

IronPython Script Execution Environment

IronPython Samples

Change property
The following snippets show how a change property command (in this case, to change the color of a
cone) looks in VBScript and its two possible IronPython variants.
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oEditor.ChangeProperty Array("NAME:AllTabs", Array
("NAME:Geometry3DAttributeTab",_

Array("NAME:PropServers", "Cone1"), _
Array("NAME:ChangedProps", _
Array("NAME:Color", "R:=", 255, "G:=", 255, "B:=", 0))))

Sample Script 13: ChangeProperty command to change color of a cone in VBScript
oEditor.ChangeProperty(
["NAME:AllTabs",

["NAME:Geometry3DAttributeTab",
["NAME:PropServers", "Cone1"],
["NAME:ChangedProps",
["NAME:Color", "R:=", 0, "G:=", 0, "B:=", 64]
]

]
])

Sample Script 14: ChangeProperty command to change color of cone using Python
arrays
Any time there are named arrays composed purely of key-value pairs, they can always be
represented using a Python dictionary, irrespective of the nesting of said named array.

oEditor.ChangeProperty(
["NAME:AllTabs",
["NAME:Geometry3DAttributeTab",

["NAME:PropServers", "Cone1"],
["NAME:ChangedProps",
{
"NAME":"Color",
"R" : 0,

"G" : 64,
"B" : 0
}]]

])

Sample Script 15: ChangeProperty command to change the color of a cone using Python
arrays and dictionaries

Create a Cone using IronPython
Most scripting tasks using IronPython are expected to be formatted as the example below. One
starts with the predefined oDesktop object and drills down to the design, editors, modules etc and
issues any required commands on the object while formatting the script command arguments in
natural python syntax.

oProject = oDesktop.GetActiveProject()
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oDesign = oProject.InsertDesign
("HFSS","Random","DrivenModal","")
oEditor = oDesign.SetActiveEditor("3D Modeler")
oEditor.CreateCone(
{

"NAME" : "ConeParameters",
"XCenter" : "0mm",
"YCenter" : "0mm",
"ZCenter" : "0mm",
"WhichAxis" : "Z",
"Height" : "2mm",
"BottomRadius" : "1.56204993518133mm",
"TopRadius" : "0mm"
},
{
"NAME" : "Attributes",
"Name" : "Cone1",
"Flags" : "",
"Color" : "(132 132 193)",
"Transparency" : 0,
"PartCoordinateSystem": "Global",
"UDMId" : "",
"MaterialValue" : "\"vacuum\"",
"SolveInside" : True
}
)

Sample Script 16: IronPython script to create a cone

Create geometry and then create a grid from it using copy/paste/move
The following script demonstrates slightlymore advanced use of scripting and the use of return
values from script methods. It creates a 5x5 grid of cones and also demonstrates the adding of
informationmessages to the application'smessage window.

oProject = oDesktop.GetActiveProject()
oDesign = oProject.InsertDesign("HFSS","Hersheys
Kisses","DrivenModal","")
oEditor = oDesign.SetActiveEditor("3D Modeler")

# create the first cone
AddInfoMessage("Creating first cone")
firstConeName = "firstCone"
coneBotRad = "1.5mm"
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oEditor.CreateCone(
{
"NAME" : "ConeParameters",
"XCenter" : "0mm",
"YCenter" : "0mm",
"ZCenter" : "0mm",
"WhichAxis" : "Z",
"Height" : "2mm",
"BottomRadius": coneBotRad,
"TopRadius" : "0mm"
},
{
"NAME" : "Attributes",
"Name" : firstConeName,
"Flags" : "",
"Color" : "(132 132 193)",
"Transparency" : 0,
"PartCoordinateSystem": "Global",
"UDMId" : "",
"MaterialValue" : "\"vacuum\"",
"SolveInside" : True
}
)

# Now replicate this a few times and create an array out of it
AddInfoMessage("Replicating it 24 times")
for x in range(5):

for y in range(5):

# leave the first one alone in it's created
# position

if x == 0 and y == 0:

continue

# all other grid positions, replicate from the
# first one

# copy first
oEditor.Copy(

{
"NAME" : "Selections",
"Selections" : firstConeName
}
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)

# paste it and capture the pasted name
# the pasted names come in an array as we could
# be pasting a selection cmposed of multiple objects
pasteName = oEditor.Paste()[0]

# now move the pasted item to it's final position
oEditor.Move(

{
"NAME" : "Selections",
"Selections" : pasteName
},
{
"NAME" : "TransalateParameters",
"CoordinateSystemID" : -1,
"TranslateVectorX" : "%d * 3 * %s" % (x, coneBotRad),
"TranslateVectorY" : "%d * 3 * %s" % (y, coneBotRad),
"TranslateVectorZ" : "0mm"
}

)

# Now fit the display to the created grid
oEditor.FitAll()

Sample Script 17: Sample script to create a cone and then use copy/paste/move to
replicate it.

Related Topics

Introduction to IronPython
IronPythonMini-cookbook
Translating Script commands fromVBScript to IronPython
Scripting Using Iron Python: Putting it all Together

Creating User Defined Primitives and User Defined Models in Python
Scripts
You can create User Defined Primitives and User DefinedModels in Python scripts (based on the
IronPython implementation).

Advantages Compared to C++
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l No need to create and build project; all you need to do is create a Python script
l Python script is platform independent
l Scripts can inherit functionality from existing scripts
l Garbage collector - no need to freememory
l Easy debugging

Changes compared to C
Thoughmethods, constants and structures are kept as close to the C implementation as possible,
some changes had to bemade tomake code Python-compatible.

Structures
l Structures have the same names as in C implementation.
l Structures fields names are capitalized.
l Arrays in structures become lists in Python (Technically a.NET IList container)
l Structure instances are created using the supplied constructors andmembers are accessed
using the provided accessmethods.

For a complete list of structures and examples please see UDP/UDMStructures.

Constants
Enumeration/Enum constants have almost the same names as in C but the enummust be qualified
by the type. Additionally, redundant "UDP", "UDM" or type prefixes have been removed. This allows
for better human-readability.

# Example of specifying the LengthUnit enum by qualifying it
# with the type of the enum: UnitType
unitType = UnitType.LengthUnit

For a complete list of enum constants please see UDP/UDMConstants.

Methods
Methods are described in IUDPExtensionmethods, IUDMExtensionmethods, UDPFunctionLibrary
and UDMFunctionLibrary listed further in this document.
Themain differences in functions parameters (fromC implementation):

l functions names in UDPFunctionLibrary and UDMFunctionLibrary are capitalized
l arrays become a python list of objects
l void * callback parameter is dropped from the parameter list
l output parameters (pointer types that are filled during the function call) usually become return
values

l 'list size' parameter usually will be omitted as redundant

Output Parameters
The rule for the output parameters is as follows:

l If the function has one output parameter variable and no return value, the variable will become
function's return value.The samewill happen if the return value is a 'success/failure' boolean
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('None' will be returned on failure and parameter variable - on success).
l If the function has one output parameter and a return value, the function will return a Python
tuple where function return value will be the first one in the tuple.

l If there ismore than one out variable, the function will return a Python tuple with all output
parameters in the specified order. If function has a return value, it must always be the first in
the tuple.

# one output parameter; return value is ignored
udmDefinition = udmFunctionLibrary.GetDefinition()

# one output parameter; return value must be preserved. return
# and output values are packed into the return tupe, in order
(lRet, partIdsList) = udpFunctionLibrary.DetachFaces(nPartIds,
faceIdsList)

# Two output parameter; return value must be preserved
# the return tuple is (returnVal, output1, output2)
(bRet, udpPositionLow, udpPositionHigh) =
udmFunctionLibrary.GetBoundingBox(partId,exact);

Comparison with C function:

C Python
bool getDefinition(UDMDefinition*
udmDefinition,
void* callbackData );

where udmDefinition is an output
parameter

udmDefinition = udmFunctionLibrary.GetDefinition()

(Note: callbackData is omitted in py interface)

long detachlFaces( int
nFacesAndPartIds,
long* faceIds,
long* partIds,
void* callbackData);

where partIds is an output
parameter

(bRet, partIds) = udmFunctionLibrary.DetachlFaces
(nFacesAndPartIds, faceIds)

(Note: callbackData is omitted in py interface)

'List Size' Parameters
The rule for the 'list size' is as follows:

l If function has input 'List' parameter and input 'list size' parameter, 'list size' parameter will be
omitted.

l If function has output 'List' parameter and output 'list size' parameter, 'list size' parameter will
be omitted.
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l If function has output 'List' parameter and input 'list size' parameter, 'list size' parameter won't
be omitted as it's needed for memory allocation in the corresponding C++ function from the
UDP/UDM function library.

Example:
# input list, input list size
lret = udpFunctionLibrary.Unite(objectIds)

# output list, output list size
faceIdList = udmFunctionLibrary.GetAllFaces(PartId)

# output list, input list size
(lret, partIdList) = udpFunctionLibrary.DetachFaces(listSize,
faceIdList)

Comparison with C function:

C Python
bool getAllFaces(  long partId,
long* numFaces,
long** faceIds,
void* callbackData);

where numFaces and faceIds are output parameters
and numFaces is the size of faceId.

faceIds =
udmFunctionLibrary.GetAllFaces
(partId)

(ignore numFaces as redundant:
folded into faceIds,
return value is omitted: folded into the
faceIds is None check
callbackData is omitted)

long unite(  long numObjects,
long* objectIds,
void* callbackData);

where numObjects and objectIds are input parameters
and numObjects is the size of objectIds.

lret = udpFunctionLibrary.Unite
(objectIds)

(ignore numObjects as redundant:
folded into objectIds
callbackData is omitted)

long detachFaces(  long nSize,
long* faceIds,
long* partIds,
void* callbackData);

where partIds is and output list and nSize is an input
parameters and nSize is the size of partIds.

(lret, partIdList) =
udpFunctionLibrary.DetachFaces
(nSize, faceIds)

(nSize is not ignored,
callbackData is omitted)

Added Parameters
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There is a special case in UDPFunctionLibrary: two functions - DuplicateAlongLine and
DuplicateAroundAxis - have new integer listSize parameter added to their signatures.
This parameter defines the size of the output List. This is done for compliance with C++ geometry
library as the size of the List must be predefined and this size is different from the existing
parameter’s values.
Example:

(ret, cloneIDs) = funcLib.DuplicateAlongLine(partID, transVec,
numCubes, cloneIdsSize)
(ret, cloneIDs) = funcLib.DuplicateAroundAxis(partID, axis,
angle, nClones, cloneIdsSize)

Here cloneIdsSize is a new integer parameter.
Comparison with C function:

C Python
long duplicateAlongLine( 
long partId,
UDPVector transVector,
int nClones,
long* nClones,
void* callbackData);

(lret, cloneIds) = udmFunctionLibrary.DuplicateAlongLine(partId,
transVec, nClones, cloneIdsSize)

(callbackData is omitted
cloneIdsSize is a new parameter)

long duplicateAroundAxis( 
long partId,
UDPCoordinateSystemAxis
axis,
double angle,
int nClones,
long* nClones,
void* callbackData);

(lret, cloneIds) = udmFunctionLibrary.DuplicateAroundAxis(partId,
axis, angle, nClones, cloneIdsSize)

(callbackData is omitted
cloneIdsSize is a new parameter)

Developing a UDM/UDP

Creation
To create a User Defined Primitive in Python you write a Python script that implements
UDPExtension class. To create a User DefinedModel in Python you write a Python script that
implements UDMExtension class (see links for full description).

Location
The scripts are located the sameway the C based UDM/UDP are. They are expected to be under
the UserDefinedParts or UserDefinedModels sub-directories of one of the library folders (SysLib,
UserLib or PersonalLib). Theywill then appear under the appropriatemenu items:Draw>User
Defined Primitives for UDP orDraw>User Defined Model for UDM.
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The sub-directories structure created in one of the specified directory will be displayed in the
UDP/UDMmenu.
Keep inmind that there is no difference between themenu display for C and Python
implementations of UDMor UDP - only the file nameswithout extensions are displayed

Organize
"Lib" sub-directory is a special directory. The contents of this directory is not shown in themenu. In
the "Lib" directory you can create Python scripts with base classes and utilities to be used in
UDP/UDMPython scripts. All the Lib directories upstream of a script (till the UserDefinedModels or
UserDefinedPrimitives) are included in the Python search path and this allows for easy import of
helper modules in such directories.
To use UDMdata structures, constants, and/or classes in your Lib sub-directory scripts you have to
add import statement to the scripts:
For UDM:extension:

from UDM import *

For UDP:extension:
from UDP import *

Edit/Reload
Python is a scripting language, so if you have errors in your script, you will see them at the time you
try to run the script. The errors will be displayed in theMessageManager Window. If you needmore
information, youmight be able to get it from log files. See theLogging section for more details.
You can always change your script, callUpdate Menu command from Draw>User Defined
Model> menu orDraw>User Defined Primitives> menu and run the script again. If you delete
script youmight want to restart the application instead of callingUpdate Menu.

UDPExtension

Import
You do not have to add import statements for the predefined classes, structures, and constants - it is
done for you and all data types described in this document can be used in your Python script.
However you have to add import statements to your helper scripts in your Lib sun-directory.

from UDP import *

Main class: UDPExtension
Youmust write a class derived from IUDPExtension with amandatory nameUDPExtension:

class UDPExtension(IUDPExtension):

The class should implement IUDPextensionmethods described below.
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IUDPExtension methods

All methods are same as themethods in the C UDP implementation. The changes to themethods
signatures are just to conform to the Python style.

Mandatory methods.
Thesemethodsmust be implemented in the UDP Python script asmethods of UDPExtension class.

GetLengthParameterUnits()
l returns string.

GetPrimitiveTypeInfo()
l returnsUDPPrimitiveTypeInfo.

GetPrimitiveParametersDefinition2()
l returns a list of UDPPrimitiveParameterDefinition2 or None on failure

AreParameterValuesValid2(errorMsg, udpParams)
l errorMsg is a c# list of strings
l udpParams is a c# list of UDPParam
l returns True if udpParams are valid, False otherwise.

CreatePrimitive2(funcLib, udpParams)
l funcLib is UDPFunction library
l udpParams is a c# list of UDPParam
l returns True on success, False on failure.

Optional methods
Thesemethods, which have default implementations, can be implemented asmethods of
UDPExtension class as needed. Default methodswill return NULL or FALSE depending on the
return type.

GetPrimitiveParameters()
l returns Python list of strings or NULL

GetRegisteredFaceNames()
l returns Python list of strings or NULL

GetRegisteredEdgeNames()
l returns Python list of strings or NULL

GetRegisteredVertexNames()
l returns Python list of strings or NULL

ProjectParametersOnToValidPlane2(currentUDPParams, projectedUDPParams)
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l currentUDPParams is a list of UDPParam
l projectedUDPParams is a list of UDPParam
l returns True on success, False on failure.

MapParametersDefinitionVersions2(oldVersion, oldUDPParams)
l oldVersion is a string
l oldUDPParamsis a list of UDPParam
l returns Python list of UDPParam or NULL

GetOldPrimitiveParametersDefinition2(version )
l version is a string
l returns a list of UDPPrimitiveParameterDefinition2 or None on failure.

Example UDP

import sys
class UDPExtension(IUDPExtension):

def GetLengthParameterUnits(self):
return "mm"

def GetPrimitiveTypeInfo(self)
typeInfo = UDPPrimitiveTypeInfo(

name = "SampleUDP",
purpose = "example",
company="ANSYS",
date="12.21.12",
version = "1.0")

return typeInfo
...
...

For the full example, see Example Scripts for Python UDP andUDM.

UDPFunctionLibrary

UDPFunctionLibrary implements IUDPFunctionLib interface: The IUDPFunctionLib object is
passed as a parameter to Python script in functionsCreatePrimitive2. You can call any of the
functions from the functions list (shown below).

udpFunctionLib.AddMessage(MessageSeverity.WarningMessage ,"New
warning");
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Considering that out variables are returned asmembers of the return tuple, sample code that calls
DetachFaces in Python script can look like this:

intVal = 10
inList = [..., ...]
(lret, outList) = udpFunctionLibrary.DetachFaces(intVal,
inList)

As you can see outList output parameter is defined in the call to DetachFaces function. Unlike in C,
there is no need to define it before the function call.

Functions list:
1. bool: bret = AddMessage(MessageSeverity:messageSeverity, string:message)
2. int: iret = NameAFace(UDPPosition: pointOnFace, string: faceName)
3. int: iret = NameAEdge(UDPPosition: pointOnEdge, string: edgeName)
4. int: iret = NameAVertex(UDPPosition: pointOnVertex, string: vertexName)
5. int: iret = GetFaceIDFromPosition(UDPPosition: pointOnFace)
6. int: iret = GetEdgeIDFromPosition(UDPPosition: pointOnEdge)
7. int: iret = CreatePolyline(UDPPolylineDefinition: polylineDefinition)
8. int: iret = CreateRectangle(CoordinateSystemPlane:whichPlane,UDPPosition:

centerPoint, List_of_double:widthAndHeight, int: isCovered)
9. int: iret = CreateArc(CoordinateSystemPlane:whichPlane,UDPPosition: centerPoint,

UDPPosition: startPoint, double: fAngle)
10. int: iret = CreateCircle(CoordinateSystemPlane:whichPlane,UDPPosition:

centerPoint, double: fRadius, int: isCovered)
11. int: iret = CreateEllipse(CoordinateSystemPlane:whichPlane,UDPPosition:

centerPoint, double: fMajorRadius, double: fRadiusRatio, int: isCovered)
12. int: iret = CreateRegularPolygon(CoordinateSystemPlane:whichPlane,UDPPosition:

centerPoint,UDPPosition: startPoint, int: numOfSides, int: isCovered)
13. int: iret = CreateEquationBasedCurve(UDPEquationBasedCurveDefinition:

curveDefinition)
14. int: iret = CreateEquationBasedSurface(UDPEquationBasedSurfaceDefinition:

surfaceDefinition)
15. int: iret = CreateSpiral(UDPSpiralDefinition: spiralDefinition)
16. int: iret = CreateBox(UDPPosition: startPoint, List_of_double: boxXYZsize)
17. int: iret = CreateSphere(UDPPosition: centerPoint, double: fRadius)
18. int: iret = CreateCylinder(CoordinateSystemAxis:whichAxis,UDPPosition:

centerPoint, double: fRadius, double: fHeight)
19. int: iret = CreateCone(CoordinateSystemAxis:whichAxis,UDPPosition: centerPoint,

double: fBottomRadius, double: fTopRadius, double: fHeight)
20. int: iret = CreateTorus(CoordinateSystemAxis:whichAxis,UDPPosition: centerPoint,

double: fMajorRadius, double: fMinorRadius)
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21. int: iret = CreatePolyhedron(CoordinateSystemAxis:whichAxis,UDPPosition:
centerPoint,UDPPosition: startPosition, int: numOfSides, double: fHeight)

22. int: iret = CreateHelix(UDPHelixDefinition: helixDefinition)
23. int: iret = Unite(List_of_int: pObjectIDArray)
24. int: iret = Subtract(List_of_int: pBlankObjectIDArray, List_of_int: pToolObjectIDArray)
25. int: iret = Intersect(List_of_int: pObjectIDArray)
26. int: iret = Imprint(List_of_int: pBlankObjectIDArray, List_of_int: pToolObjectIDArray)
27. int: iret = SweepAlongVector(int: profileID,UDPVector: sweepVector,

UDPSweepOptions: sweepOptions)
28. int: iret = SweepAroundAxis(int: profileID,CoordinateSystemAxis:whichAxis, double:

sweepAngle,UDPSweepOptions: sweepOptions)
29. int: iret = SweepAlongPath(int: profileID, int: pathID,UDPSweepOptions:

sweepOptions)
30. int: iret = Translate(int: partID,UDPVector: translateVector)
31. int: iret = Rotate(int: partID,CoordinateSystemAxis:whichAxis, double: rotateAngle)
32. int: iret =Mirror(int: partID,UDPPosition:mirrorPlaneBasePosition,UDPVector:

mirrorPlaneNormalVector)
33. int: iret = Transform(int: partID, List_of_double: rotationMatrix,UDPVector:

translateVector)
34. int: iret = Scale(int: partID, double: xScale, double: yScale, double: zScale)
35. (int: lret, List_of_double: cloneIDs) = DuplicateAlongLine(int: partID,UDPVector:

translateVector, int: numTotalObjs, int: cloneIDsListSize)
36. (int: lret, List_of_double: cloneIDs) = DuplicateAroundAxis(int: partID,

CoordinateSystemAxis:whichAxis, double: rotateAngle, int: numTotalObjs, int:
cloneIDsListSize)

37. int: iret = DuplicateAndMirror(int: partID,UDPPosition:mirrorPlaneBasePosition,
UDPVector:mirrorPlaneNormalVector)

38. int: iret = Connect(List_of_int: objectIDArray)
39. int: iret = Offset(int: partID, double: offsetDistance)
40. int: iret = Section(int: partID,CoordinateSystemPlane: sectionPlane)
41. (int: iret , int: newPartID) = Split(int: partID,CoordinateSystemPlane: splitPlane,

SplitWhichSideToKeep:whichSideToKeep, bool: bSplitCrossingObjectsOnly)
42. (int: iret , List_of_int: importedObjectIDs) = ImportNativeBody2(string:

fileNameWithFullPath)
43. (int: lret, List_of_int: importedObjectIDs) = ImportAnsoftGeometry(string:

fileNameWithFullPath, List_of_string: overridingParamsNameArray, List_of_UDPParam:
overridingParamsArray)

44. int: iret = Clone(int: partID)
45. int: iret = DeletePart(int: partID)
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46. int: iret = CreateObjectFromFace(int: faceID)
47. int: iret = Fillet(UDPBLNDElements: entitiesToFillet,UDPBLNDFilletOptions:

filletOptions)
48. int: iret = Chamfer(UDPBLNDElements: entitiesToChamfer,

UDPBLNDChamferOptions: chamferOptions)
49. (int: iret , List_of_int: newPartIDArray) = DetachFaces(int: newPartIDArraySize, List_of_

int: faceIDArray)
50. (int: iret , List_of_int: newPartIDArray) = DetachEdges(int: newPartIDArraySize, List_

of_int: edgeIDArray)
51. int: iret = CreateObjectFromEdge(int: edgeID)
52. int: iret = SheetThicken(int: partID, double: fThickness, bool: bThickenBothSides)
53. (int: iret , List_of_int: newPartIDArray) = SweepFaceAlongNormal(int:

newPartIDArraySize, List_of_int: faceIDArray, double: sweepLength)
54. int: iret = CoverLine(int: partID)
55. int: iret = CoverSurface(int: partID)
56. int: iret = UncoverFaces(List_of_int: faceIDArray)
57. (int: iret , int: numPartsCreated, List_of_int>: faceIDArray) = SeparateBodies(int: partID,

int: numPartsCreated)
58. int: iret =MoveFaces(List_of_int: faceIDArray, bool: bMoveAlongNormal, double:

fOffsetDistance,UDPVector:moveVector)
59. int: iret =WrapSheet(int: sheetBodyID, int: targetBodyID)
60. int: iret = ImprintProjection(int: blankBodyID, List_of_int: toolBodyIDArray, bool:

bNormalProjection,UDPVector: projectDirection, double: projectDistance)
61. string: str = GetTempDirPath()
62. string: str = GetSysLibDirPath()
63. string: str = GetUserLibDirPath()
64. string: str = GetPersonalLibDirPath()
65. string: str = GetInstallDirPath()
66. string: str = GetProjectPath()
67. (bool: bret, bool: abort) = SetProgress(UDPProgress: progress)

UDMExtension

Import
You do not have to add import statements for the predefined classes and structures - it is done for
you and all data types described in this document can be used in your Python script.
However you have to add import statements to your helper scripts in your Lib sub-directory.

from UDM import *
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Main class: UDMExtension
Youmust write a class derived from IUDMExtension with amandatory nameUDMExtension:

class UDMExtension(IUDMExtension):

The class should implement IUDMExtensionmethods described below.

IUDMExtension methods

All methods are the same as themethods in the C UDM implementation. The changes to the
methods signatures are just to conform to the Python style.

Mandatory methods.
Thesemethodsmust be implemented in the UDMPython script asmethods of UDMExtension class.

GetInfo()
l returnsUDMInfo object populated with appropriate UDM information.

IsAttachedToExternalEditor()
l returns True if UDMdll is attached to external editor.
l In case of python UDMs, this should typically return False

CreateInstance(funcLib)
l funcLib is UDMFunctionLibrary
l returnsUDMParameters.

GetUnits(instanceId)
l instanceId is a long
l returns string containing units for the instance.

Refresh(funcLib, udmInParams, updatedParams, refreshModifiedPartsOnly,
nonEditedPartRefIds )
ThisMethod is called every time a UDM is refreshed. Geometry creation/refresh should happen in
thismethod.

l funcLib is UDMFunctionLibrary
l udmInParams is a list of UDMParameters that comes from desktop
l updatedParams: UDM script can change the UDMparameters it receives. Updated
parameters need to be sent back to desktop. If the UDM script is not going to change any of
the parameters that it received, it needs to copy udmInParams to updatedParams.

l refreshModifiedPartsOnly is a boolean
Supporting this flag is optional. For UDMswhere the refresh performance is not an issue, it is
recommended to ignore this flag and update all parts every time.
This flag can be used to optimize performance of Refreshmethod when themodel created by
UDM is large. If the UDM consists of multiple parts, and new parameters change only a few
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parts amongst them, UDM script can onlymodify parts that are changed by the new
parameters.

l nonEditedPartRefIds: If RefreshModifiedPartsOnly is true and the UDM script supports partial
update, Refreshmethod needs to return ids of parts that are unchanged.
returns True on success, False on failure.

ReleaseInstance(instanceId)
l instanceId is a long
l This should release any resources assigned to this particular instance of UDM.
l returns True on success, False on failure.

GetAttribNameForEntityId()
l Returns string that acts as a the name of the attribute containing entity IDs.
l For example, it can return a unique string such as "ATTRIB_XACIS_ID"
l Python UDMs should implement thismethod.

GetAttribNameForPartId()
l Returns string that acts as a the name of the attribute containing entity IDs.
l For example, it can return a unique string such as "ATTRIB_XACIS_ID" (Can be same as
GetAttribNameForEntityId())

l Python UDMs should implement thismethod.

Optional methods
Thesemethods have default implementations (default is to return NULL or FALSE depending on the
return type) but can be overridden by the user as needed asmethods of UDMExtension class.

DialogForDefinitionOptionsAndParams(self, defData, optData, params):
Replaces the old UDMDialogForDefinitionAndOptionsmethod, which is still supported, but users
are urged to use UDMDialogForDefinitionOptionsAndParams. If bothmethods are present,
application will use UDMDialogForDefinitionOptionsAndParams.

l UDMcan pop up dialog for UDMdefinition, options, parameters in thismethod. Definition,
options, and parameters are set/modified by user and returned to application. Dll can also just
give default definition, options and parameters.

l Returns two booleans and a string
l First boolean returnswhether themethod was successful or not.
l Second boolean returnswhether the application should popup a dialog. If it is True,
application will populate a dialog with definition, options, parameters that are returned.

l String returned contains length units for parameters.

DialogForDefinitionAndOptions(self, defData, optData) [Deprecated]
UDMcan pop up dialog for UDMdefinition and options in thismethod. Definition, and options are
set/modified by user and returned to application. Dll can also just give default definition and options.

l Returns two booleans.
l First boolean provideswhether the call to thismethod was successful or not.
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l Second boolean determineswhether the application should pop up a dialog. If this is true,
application will populate the dialog with the definitions and options that are returned. As no
parameters are returned, no parameters are shown in this dialog.

GetInstanceSourceInfo(instanceId)
l instanceId is a long
l returns string containing source information of UDM instance. It is used to create initial name
for UDM instance.

ShouldAttachDefinitionFilesToProject()
l returns true if any of definition files needs to be attached to project
l returns python list of string containing definition names of files or NULL

Example UDM

class UDMExtension(IUDMExtension):

def IsAttachedToExternalEditor(self):
return False

def GetInfo(self)
udmInfo = UDMInfo(

name = "SampleUDM",
purpose = "udm example",
company="ANSYS",
date="12.21.12",
version = "1.0")

return udmInfo
...
...

For the full example, see Example Scripts for Python UDP andUDM.

UDMFunctionLibrary

UDMFunctionLibrary implements IUDMFunctionLib interface. The IUDMFunctionLib object is
passed as a parameter to Python script in the following functions

l CreateInstance
l Refresh

You can call any of the functions from the functions list (shown below).
partRefId = udmFunctionLib.GetPartRefId(partId)

For example sample code that calls GetBoundingBox in Python script can look like this:
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partId = 10
exact = True
udpPosition = UDPPosition(0,0,0)

(bret, udpPositionLow, udpPositionHigh) =
udmFunctionLibrary.GetBoundingBox(partId, exact);

if bret:
udpPosition.X = udpPositionLow.X

As you can see udpPositionLow and udpPositionHigh output parameters are defined in the call to
GetBoundingBox function. There is no need to define them before the function call.

Functions list:
1. List_of_UDMDefinition: udmDefinitionList = GetDefinition()
2. List_of_UDMOption: udmOptionList = GetOptions()
3. bool: bret = SetMaterialName(string:matName, int: partId)
4. bool: bret = SetMaterialName2(string:matName, string: partName)
5. bool: bret = SetPartName(string: partName, int: partId)
6. int: iret = GetInstanceId()
7. string: str = GetPartRefId(int: partId)
8. bool: bret = SetPartRefId(int: partId, string: refId)
9. List_of_int: faceIds = GetAllFaces(int: partId)
10. List_of_int: edgeIds = GetAllEdges(int: partId)
11. List_of_int: vertexIds = GetAllVertices(int: partId)
12. bool: bret = SetFaceAttribs(List_of_int: faceIds, List_of_string: attribs)
13. bool: bret = SetEdgeAttribs(List_of_int: edgeIds, List_of_string: attribs)
14. bool: bret = SetVertexAttribs(List_of_int: vertexIds, List_of_string: attribs)
15. string: str = GetModelerUnit()
16. string: str = GetCacheFileForUDMResume()
17. bool: bret = SetPartColor(int: partId, int: nColor)
18. bool: bret = SetPartFlags(int: partId, int: nFlags)
19. (bool: bret,UDPPosition: low,UDPPosition: high) = GetBoundingBox(int: partId, bool:

exact)
20. bool: bret = IsParametricUpdate()
21. bool: bret = SetMaterialNameByRefId(string: partRefID, string:matName)
22. bool: bret = SetPartNameByRefId(string: partRefId, string: partName)
23. bool: bret = SetPartColorByRefId(string: partRefId, int: nColor)
24. bool: bret = SetPartFlagsByRefId(string: partRefId, int: nFlags)
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In addition to the above functions all functions defined in the UDPFunctionLib are available in the
IUDMFunctionLib and can be called directly exactly the sameway as the IUDMFunctionLib
functions.
Example:

udmFunctionLib.CreateCircle(center,radius,ratio,isCovered)

UDP/UDM Structures and constants

The following sections describe:
l UDP/UDMStructures
l UDP/UDMConstants

UDP/UDM Structures

Differences compared to C API
l UDMDefinition
l UDMOptions
l UDMParameters

Instead of containing arrays of data, the structures contain single fields where each field corresponds
to an item in a different array from the original C API. The structure objects thus constructed are
added to the Python list. Alternately the Python list can be initialized using the structure objects.
Example (creating UDMParameter list):

udmParamList = [UDMParameter("cubeSizeName",
UnitType.LengthUnit,

UDPParam(ParamDataType.Double, cubeSize),
ParamPropType.Value,
ParamPropFlag.MustBeReal),
UDMParameter("cubeDistanceName", UnitType.LengthUnit,

UDPParam(ParamDataType.Double, cubeDistance),

ParamPropType.Value,
ParamPropFlag.MustBeReal),

UDMParameter("numCubesName", UnitType.LengthUnit,

UDPParam(ParamDataType.Int, numCubes),
ParamPropType.Number,
ParamPropFlag.MustBeInt)]

l UDPParam
l UDPParamData

Data field in UDPParam is now an object - the same for all types of data used - as Python can work
with any type of data.
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UDPParamData is obsolete, thus not implemented. Be sure to set proper data type to
UDPParam.DataType when setting UDPParam.Data.
Example:

nCubesParam = UDPParam(ParamDataType.Int, numCubes)
nCubes = nCubesParam.Data

distanceParam = UDPParam()
distanceParam.setDouble(10.5)
doubleDistance = distanceParam.Data * 2

l UDP3x3Matrix
The structure is not implemented. Use size 9 Python List of doubles instead.
Example:

rotationMatrix =[0,0,1, 1,0,0, 0,0,1]
udpFunctionLib.Transform(partId, rotationMatrix,
translationVector)

List of structures
You can use constructors to create a structure. You can alsomodify fields - directly or by provided
methods.
Example:

pos1 = UDPPosition(1,2,3)
pos2 = UDPPosition(x=1,y=10,z=0)
pos2.Z = pos1.Z

udpParam = UDPParam(ParamDataType.Double,1)
value = udpParam.Data

Structure Construction Members
UDPPrimitiveTypeInfo UDPPrimitiveTypeInfo(

string name,
string purpose,
string company,
string date,
string version)

string Name
string Purpose
string Company
string Date
string Version

UDPPrimitiveParameterDefiniti
on

UDPPrimitiveParameterDefiniti
on(
string name,
string description,
UnitType unitType,
double defaultValue)

string Name
string Description
UnitType UnitType
double DefaultValue

UDPParam UDPParam() ParamDataType DataType
object Data
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Structure Construction Members
UDPParam(
ParamDataType dataType,
object data)
object can be int, double, string,
bool or UDPPosition

methods:

setInt(int val)
setBool(bool val)
setString(string val)
setDouble(double val)
setPosition(UDPPosition val)

object can be int, double ,
string, bool or UDPPosition

UDPPrimitiveParameterDefiniti
on2

UDPPrimitiveParameterDefiniti
on2(
string name,
string description,
UnitType unitType,
ParamPropType propType,
ParamPropFlag propFlag,
UDPParam defaultValue)

string Name
string Description
UnitType UnitType
ParamPropType PropType
ParamPropFlag PropFlag
UDPParamDefaultValue

UDPPosition UDPPosition(
double x,
double y,
double z)

double X
double Y
double Z

UDPVector UDPVector(
double x,
double y,
double z)

double X
double Y
double Z

UDPSweepOptions UDPSweepOptions(
SweepDraftType draftType,
double draftAngle,
double twistAngle)

SweepDraftType
DraftType
double DraftAngle
double TwistAngle

UDPPolylineSegmentDefinition UDPPolylineSegmentDefinition(
PolylineSegmentType
segmentType,
int segmentStartIndex,
int numberOfPoints,
double angle,

PolylineSegmentType
SegmentType
int segmentStartIndex,
int numberOfPoints,
double angle,
UDPPosition centerPoint,
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Structure Construction Members
UDPPosition centerPoint,
CoordinateSystemPlane
arcPlane)

CoordinateSystemPlane
arcPlane)

UDPPolylineDefinition UDPPolylineDefinition()
UDPPolylineDefinition(
List_of_UDPPosition positions,
List_of_
UDPPolylineSegmentDefinition
segDefs,
int closed,
int covered)

int IsClosed
int IsCovered
List_of_UDPPosition
ArrayOfPosition
List_of_
UDPPolylineSegmentDefi
nition
ArrayOfSegmentDefinition

UDPEquationBasedCurveDefini
tion

UDPEquationBasedCurveDefini
tion(
string functionXt,
string functionYt,
string functionZt,
double tStart,
double tEnd,
int numOfPointsOnCurve)

string FunctionXt
string FunctionYt
string FunctionZt
double TStart
double TEnd
int NumOfPointsOnCurve

UDPEquationBasedSurfaceDefi
nition

UDPEquationBasedSurfaceDefi
nition(
string functionXuv,
string functionYuv,
string functionZuv,
double uStart,
double uEnd,
double vStart,
double vEnd)

string FunctionXuv
string FunctionYuv
string FunctionZuv
double UStart
double UEnd
double VStart
double VEnd

UDPHelixDefinition UDPHelixDefinition(
int profileID,
UDPPosition ptOnAxis,
UDPPosition axisDir,
double noOfTurns,
bool isRightHanded,
double radiusChangePerTurn,
double pitch)

int ProfileID
UDPPosition PtOnAxis
UDPPosition AxisDir
double NoOfTurns
bool IsRightHanded
double
RadiusChangePerTurn
double Pitch

UDPSpiralDefinition UDPSpiralDefinition(
int profileID,
UDPPosition ptOnAxis,
UDPPosition axisDir,

int ProfileID
UDPPosition PtOnAxis
UDPPosition AxisDir
double NoOfTurns
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Structure Construction Members
double noOfTurns,
bool isRightHanded,
double radiusChangePerTurn)

bool IsRightHanded
double
RadiusChangePerTurn

UDPBLNDElements UDPBLNDElements(
int partID)

int PartID
List_of_int ListOfEdges
List_of_int ListOfFaces

UDPBLNDFilletOptions UDPBLNDFilletOptions(
bool supressFillet,
BLNDFilletRadiusLaw
filletRadiusLaw,
double filletStartRadius,
double filletEndRadius,
bool
followSmoothEdgeSequence,
BLNDFilletType filletType,
double setbackDistance,
double bulgeFactor)

bool SupressFillet
BLNDFilletRadiusLaw
FilletRadiusLaw
double FilletStartRadius
double FilletEndRadius
bool
FollowSmoothEdgeSeque
nce
BLNDFilletType FilletType
double SetbackDistance
double BulgeFactor

UDPBLNDChamferOptions UDPBLNDChamferOptions(
bool supressChamfer,
BLNDChamferRangeLaw
chamferRangeLaw,
double chamferLeftRange,
double chamferRightRange)

bool SupressChamfer
BLNDChamferRangeLaw
ChamferRangeLaw
double ChamferLeftRange
double
ChamferRightRange

UDPProgress UDPProgress(
int prog,
int subProg,
stringmesg,
string subMesg)

int Prog
int SubProg
stringMesg
string SubMesg

UDMInfo UDMInfo(
string name,
string purpose,
string company,
string date,
string version)

string Name
string Purpose
string Company
string Date
string Version

UDMDefinition UDMDefinition()

UDMDefinition(
string name,

string DefName
UDPParamDefValue
ParamPropType PropType
ParamPropFlag PropFlag
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Structure Construction Members
UDParam value,
ParamPropType propType,
ParamPropFlag propFlag)

UDMOption UDMOption()

UDMOption(
string name,
UDParam value,
ParamPropType propType,
ParamPropFlag propFlag)

string OptName
UDPParamOptValue
ParamPropType PropType
ParamPropFlag PropFlag

UDMParameter UDMParameter()

UDMParameter(
string name,
UDParam value,
UnitType unitType,
ParamPropType propType,
ParamPropFlag propFlag)

string ParamName
UDPParamParamValue
UnitType UnitType
ParamPropType PropType
ParamPropFlag PropFlag

UDP/UDM Constants

Full names of enum constantsmust be used in scripts.
Example:

unitType = UnitType.LengthUnit
dataType = ParamDataType.Int

Enum constants:

enum Constant Parameters
UnitType NoUnit

LengthUnit
AngleUnit

ParamDataType Int
Double
String
Bool
Position
Unknown

ParamPropType Text
Menu
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enum Constant Parameters
Number
Value
FileName
Checkbox
Position
Unknown

ParamPropFlag NoFlag
ReadOnly
MustBeInt
MustBeReal
Hidden
Unknown

CoordinateSystemAxis XAxis
YAxis
ZAxis

CoordinateSystemPlane XYPlane
YZPlane
ZXPlane

SweepDraftType ExtendedDraft
RoundDraft
NaturalDraft
MixedDraft

SplitWhichSideToKeep SplitKeepBoth
SplitKeepPositiveOnly
SplitKeepNegativeOnly

PolylineSegmentType LineSegment
ArcSegment
SplineSegment
AngularArcSegment

MessageSeverity WarningMessage
ErrorMessage
InfoMessage
IncompleteMessage
FatalMessage

BLNDFilletRadiusLaw BLNDConstantRadius
BLNDVariableRadius

BLNDFilletType BLNDRound
BLNDMitered

BLNDChamferRangeLaw BLNDConstantRange
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enum Constant Parameters
BLNDVariableRange

PartPropertyFlags PropNonModel
PropDisplayWireFrame
PropReadOnly
PostprocessingGeometry
PropInvisible
PropShowDirection
PropDummy

Logging and Desktop Messaging

There is error logging and displaying script errors in DesktopMessageManager for UDP/UDM
Python scripts.
You can also addmessages toMessageManager using the UDPFunctionLibrary AddMessage
method, but no logging is done in this case.

Collecting EBU Logs
The instructions below are for Windows, but theywork similarly for Linux. On Linux, determine your
shell (execute echo $SHELL) and, based on that, use setenv or export to set the environment
variables.

1. Create a directory that serves as a folder for the logs. Make sure that this directory is empty:
clean it out if it already has files. For this example, the name of the directory is
c:\ansdir\ansdebug.

2. Start a new shell to set the environment. (You can set it permanently, but this is not
recommended.)

3. Set the following env variables in this shell:
l Set ANSOFT_DEBUG_MODE to 2. Set it to a higher number such as 4 or 5 if the
developer requests it.

l Set ANSOFT_DEBUG_LOG to a file in the previously created ansdebug directory: for
example, set ANSOFT_DEBUG_LOG=c:\ansdir\ansdebug\ansdebug.log.

l Set ANSOFT_DEBUG_LOG_SEPARATE to 1.
4. From the above shell, start the ANSYS Electromagnetics product and exercise the problem

scenario.
5. Zip all the log files in the c:\ansdir\ansdebug directory, and send them to the developer or

support person requesting them.

Collecting WB Logs
1. Under WB, execute the Tools/Optionsmenu option, and under the Journals And Logs section,

ensure theWriteWorkbench Log Files is checked.
Note the location of the log files. (OnWindows this is typically%TEMP%\WorkbenchLogs.)
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Navigate to that directory and remove all files.
2. Set up the ANSYS Electromagnetics env vars if you need to collect those aswell, following

the instructions above.
3. Exercise the problem scenario.
4. Collect theWB log files and optionally the ANSYS Electromagnetics logs, and send them to

the developer or support person requesting them.

Example Scripts for Python UDP and UDM
TheUDP example for Python creates a rectangular spiral.

1. UseDraw>User Defined Primitive>Examples>Rectangular Spiral. This opens a dialog
in which you can set parameters such as Xpos, Ypos, distance between turns, and Number of
turns.

ClickOK to create the spiral.
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The UDMexample for Python creates an on die spiral inductor.
1. UseDraw>User Defined Model>OnDieSpiralInductor.

This opens a Properties dialog for which you can set parameters.
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2. Set the parameters and clickOK create the UDM.
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25 - Optimetrics
Optimetrics enables you to determine the best design variation among amodel's possible variations.
You create the original model, the nominal design, and then define the design parameters that vary,
which can be nearly any design parameter assigned a numeric value inMaxwell. For example, you
can parameterize themodel geometry or material properties. You can then perform the following
types of analyses on your nominal Maxwell design:

Parametric In a parametric analysis, you define one or more variable sweep definitions, each
specifying a series of variable valueswithin a range. For example, you can
parameterize component values. (See Variables in Maxwell for more
information.) Optimetrics solves the design at each variation. You can then
compare the results to determine how each design variation affects the
performance of the design. Parametric analyses are often used as precursors to
optimization solutions because they help to determine a reasonable range of
variable values for the optimization analysis.

Optimization For an optimization analysis, you identify the cost function and the optimization
goal. Optimetrics changes the design parameter values tomeet that goal. The
cost function can be based on any solution quantity that Maxwell can compute.

Sensitivity In a sensitivity analysis, you useOptimetrics to explore the vicinity of the design
point to determine the sensitivity of the design to small changes in variables.

Tuning Tuning allows you to change variable values interactively while monitoring the
performance of the design.If you want to ensure that tuning does not resolve
variations already solved by parametric setup, youmust checkSave Fields
Mesh in theOptions tab of the optimetrics setup.

Statistical In a statistical analysis, you useOptimetrics to determine the distribution of a
design's performance, which is caused by a statistical distribution of variable
values.

Design of
Experiments

Design of Experiments involves the creation of a response surface that depicts
and predicts how variable valueswill affect the design.

DesignXplorer An optimization tool for studying a range of design variations, used with Design of
Experiments.

Note Sweeping or using a complex variable is not allowed in any optimetrics setup, including
optimization, statistical, sensitivity, and tuning setups.

Related Topics

Setting up a Parametric Analysis
Setting up anOptimization Analysis
Setting up a Sensitivity Analysis
Tuning a Variable
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Optimetrics 25-1
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Setting up a Statistical Analysis
Parametric Overview
Optimization Overview
Sensitivity Analysis Overview
Statistical Analysis Overview
TuningOverview
Using Distributed Analysis

Parametric Overview
Running a parametric analysis enables you to simulate several design variations using a single
model. You define a series of variable valueswithin a range, or a variable sweep definition, and
Maxwell generates a solution for each design variation. You can then compare the results to
determine how each design variation affects the performance of the design.
You can vary design parameters that are assigned a quantity, such as geometry dimensions,
material properties, and boundary and excitation properties. (See the online help topic for the
specific parameter you want to vary.) The number of variations that can be defined in a parametric
sweep setup is limited only by your computing resources.
To perform a parametric analysis, you first create a nominal design. A nominal design is created like
any other design, except that variables are assigned to those aspects of themodel you want to
change. All variablesmust be defined before you start the parametric analysis. Although you are not
required to solve the nominal design before performing a parametric analysis, doing so helps ensure
that themodel is set up and operates as intended. Alternatively, you can perform a validation check
on the nominal design before performing a parametric analysis.
Parametric analyses are often used as precursors to optimization analyses because they enable you
to determine a reasonable range of variable values for an optimization analysis.

Related Topics

Setting up a Parametric Analysis

Setting Up a Parametric Analysis
A parametric setup specifies all of the design variations that Optimetrics drivesMaxwell to solve. A
parametric setup ismade up of one or more variable sweep definitions, which are a set of variable
valueswithin a range that you want Maxwell to solve when you run the parametric setup.
You can definemore than one parametric setup per design.

Note Once you have created a parametric setup, you can copy and paste it, and thenmake
changes to the copy, rather than redoing the whole process for minor changes.

To add a parametric setup to a design:
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1. On theMaxwell3D or Maxwell2Dmenu, point toOptimetrics Analysis, and then clickAdd

Parametric .
l Alternatively, right-clickOptimetrics in the project tree, and then clickAdd>Parametric on
the shortcut menu.

TheSetup Sweep Analysis dialog box appears.
2. Add a variable sweep definition.

After you define a parametric sweep, a shortcut menu becomes available when you right-click the
setup name.

Note Sweeping or using a complex variable is not allowed in any optimetrics setup, including
optimization, statistical, sensitivity, and tuning setups.

Related Topics

Adding a Variable SweepDefinition
Specifying a Solution Setup for a Parametric Setup
Using Distributed Analysis
Parametric Overview

Adding a Variable Sweep Definition

A parametric setup ismade up of one or more variable sweep definitions. A variable sweep definition
is a set of variable valueswithin a range that Optimetrics drivesMaxwell to solve when the
parametric setup is analyzed. You can add one or more sweep definitions to a parametric setup.

Note Sweeping a complex variable is not allowed in any optimetrics setup, including
optimization, statistical, sensitivity, and tuning setups.

1. On theMaxwell3D or Maxwell2Dmenu, point toOptimetrics Analysis, and then clickAdd

Parametric .
l Alternatively, right-clickOptimetrics in the project tree, and then clickAdd>Parametric on
the shortcut menu.

TheSetup Sweep Analysis dialog box appears.
2. Under theSweep Definitions tab, clickAdd.

TheAdd/Edit Sweep dialog box appears.
All the independent variables associated with the design are listed in theVariable pull-down
list.

3. Click the variable for which you are defining the sweep definition from theVariable pull-down
list.
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If you do not define a sweep definition for a variable in the list, the variable's current value in
the nominal design is used in the parametric analysis.

4. Specify the variable values to be included in the sweep.
5. ClickAdd, and then clickOK.

You return to theSetup Sweep Analysis dialog box. The variable sweep is listed in the top
half of the window.

6. View the design variations that are to be solved in table format under the Table tab. Viewing
the sweep definition in table format enables you to visualize the design variations that are to be
solved andmanually adjust sweep points if necessary.

7. Optionally, click the button for settingHPC and Analysis Options, which allows you to select
or create an analysis configuration.

8. ClickOK.

Related Topics

Specifying Variable Values for a SweepDefinitions
Synchronizing Variable SweepDefinitions
Modifying a Variable SweepDefinitionManually
Overriding a Variable’s Current Value in a Parametric Setup

Specifying Variable Values for a Sweep Definition

To specify the variable values to include in a sweep definition:
1. Select one of the following in the Add/Edit Sweep dialog box:

Single value Specify a single value for the sweep definition.

Linear step Specify a linear range of valueswith a constant step size.

Linear count Specify a linear range of values and the number, or count of points within
this range.

Decade
count

Specify a logarithmic (base 10) series of values, and the number of values
to calculate in each decade.

Octave count Specify a logarithmic (base 2) series of values, and the number of values to
calculate in each octave.

Exponential
count

Specify an exponential (base e) series of values, and the number of values
to calculate.

2. If you selectedSingle value, type the value of the sweep definition in theValue box.
If you selected another sweep type, do the following:
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a. Type the starting value of the variable range in theStart text box.
b. Type the final value of the variable range in theStop text box.

Warning Variable valuesmust be single real numbers, or expressions that evaluate to
single real numbers. Complex numbers cannot be used as the values of
variables in any optimetric analysis.

3. If you selected Linear step as the sweep type, type the step size in theStep box.
The step size is the difference between variable values in the sweep definition. The step size
determines the number of design variations between the start and stop values. Maxwell will
solve themodel at each step in the specified range, including the start and stop values. The
step size can be negative, when theStop value is less than theStart value
If you selected another sweep type, type the number of points, or variable values, in the sweep
definition in theCount text box. ForDecade count andOctave count, theCount value
specifies the number of points to calculate in every decade or octave. For Exponential
count, theCount value is the total number of points. The total number of points includes the
start and stop values.

Related Topics

Synchronizing Variable SweepDefinitions

Synchronizing Variable Sweep Definitions

By default, variable sweep definitions are nested. Alternatively, you can synchronize the variable
sweep definitions if they have the same number of sweep points.
For example, if you synchronize a sweep definition that includes values of 1, 2, and 3 incheswith a
second sweep definition that includes values of 4, 5, and 6 inches, Maxwell will solve 3 design
variations. The first variation is solved at the variable values of 1 and 4; the second variation is solved
at the variable values 2 and 5; and the third variation is solved at the final variable values 3 and 6.
To synchronize variable sweep definitions:

1. Under theSweep Definitions tab of theSetup Sweep Analysis dialog box, select the rows
containing the sweep definitions you want to synchronize.

2. ClickSync.
The synchronized sweeps are given a group number, which is listed in theSync # column.

Optionally, view the design variations that are to be solved in table format under the Table tab.

Related Topics

Specifying Variable Values for a SweepDefinitions

Optimetrics 25-5
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Modifying a Variable Sweep Definition Manually

You canmanuallymodify the variable values that are solved for a parametric setup by explicitly
changing, adding, or deleting existing points in a variable sweep definition under the Table tab of the
Setup Sweep Analysis dialog box.
Tomanuallymodify a variable sweep definition:

1. Click the Table tab of theSetup Sweep Analysis dialog box.
The design variationsMaxwell solves for the parametric setup listed in table format.

2. Do one of the following:
l Tomodify a variable value, click a value text box in the table and type a new value.
l To delete a variable value from the sweep definition, click the row you want to delete, and
then clickDelete.

l To add a new variable value to the sweep definition, clickAdd. Then click in the value text
box and type a new value.
Warning Variable valuesmust be single real numbers, or expressions that evaluate to

single real numbers. Complex numbers cannot be used as the values of
variables in any optimetric analysis.

Your modifications are tracked and available for viewing at the bottom of theSetup Sweep
Analysis dialog box under theSweep Definitions tab. The operations you performed are listed
with descriptions.

Warning If youmodify an original sweep definition using theAdd/Edit Sweep dialog box after
you havemanuallymodified its table of design variations, your manual modifications
become invalid and are removed. A warning is displayed to inform you that your manual
values are about to become invalid, so you can decide whether or not to proceed.

Related Topics

Adding a Variable SweepDefinition
Overriding a Variable’s Current Value in a Parametric Setup

Overriding a Variable's Current Value in a Parametric Setup

If you choose not to sweep a variable, Maxwell uses the variable's current value set for the nominal
design when it solves the parametric setup. To override the current variable value for a parametric
setup:

1. In theSetup Sweep Analysis dialog box, click theGeneral tab.
Under Starting Point, all of the current independent design variable values are listed.

2. Click theValue box of the variable with the value you want to override for the parametric
setup.

3. Type a new value in theValue box, and then pressEnter.
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TheOverride option is now selected. This indicates that the value you entered will be used for
the parametric setup. For this parametric setup, the new value will override the current value
in the nominal design.

Note Alternatively, you can select theOverride option first, and then type a new variable value
in theValue box.

4. Optionally, click a new unit in theUnits box.
To revert to the current variable value, clear theOverride option.

Warning Variable valuesmust be single real numbers, or expressions that evaluate to single real
numbers. Complex numbers cannot be used as the values of variables in any optimetric
analysis.

Related Topics

Adding a Variable SweepDefinition
Modifying a Variable SweepDefinitionManually

Specifying a Solution Setup for a Parametric Setup

To specify the solution setup that Maxwell analyzeswhen it solves a parametric setup:
1. In theSetup Sweep Analysis dialog box, click theGeneral tab.
2. Select the solution setup you want Maxwell to use when it solves the parametric setup.

Maxwell solves the parametric setup using the solution setup you select. If you select more
than one, results are generated for all selected solution setups.

Related Topics

Specifying the Solution Quantity to Evaluate for Parametric Analysis
Specifying a Solution Quantity’s Calculation Range

Specifying the Solution Quantity to Evaluate for Parametric Analysis

When you add a parametric setup, you can identify one or more solution quantities to be presented in
thePost Analysis Display dialog box. The solution quantities are specified bymathematical
expressions that are composed of basic quantities, such as output variables. When you view the
results, Maxwell extracts the solution quantities and lists them in the results table.

1. In theSetup Sweep Analysis dialog box, click theCalculations tab.
This displays a table that will show Solutions and associated Calculations. Below the table, are
control buttons toSetup Calculations... andDelete.

2. ClickSetup Calculations.
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This displays theAdd/Edit Calculation dialog. The dialog contains panes to set theContext,
the Trace tab for theCalculation Expression, and theCalculation Range tab for the
Calculation Range.
Follow the procedure to Setup Calculations for Optimetrics.

3. ClickAdd Calculation to add the expression in theAdd/Edit Calculation dialog
Calculation Expression field to the Calculations tab of theSetup Sweep Analysis dialog.

4. ClickDone to close theAdd/Edit Calculation dialog.

Related Topics

Specifying a Solution Quantity’s Calculation Range
Specifying Output Variables
Setup Calculations for Optimetrics.

Setup Calculations for Optimetrics

TheSetup dialogs for each of the Optimetrics types include aSetup Calculations button. Clicking
this displays theAdd/Edit Calculation dialog box. The dialog box contains distinct panes and tabs
to set theContext, theCalculation Expression, and theCalculation Range.
TheContext pane contains fields for the Report Type to use, the Solution, and depending on the
Report Type selection, the Geometry.
The Trace tab contains fields for the Calculation expression, and, to build the expression, a
Category list, a Quantity list with a Text Filter field, and a list of Functions available for the selected
Category. The Range function button opens a dialog in which you can define a range function to
apply a function to the expression.
The Category list for the Trace tab includes Variables andOutput Variables. AnOutput Variables...
button lets you open a dialog box to define and edit the Output Variables.
To setup anOptimetrics calculation:

1. Click theSetup Calculations button to open theAdd/Edit/Calculation dialog.
2. In theReport Type text field in theContext pane, select from the drop down list of available

types.
Selecting Fields as the Report type causes theGeometry field to display.

3. In theSolution text box, select from the drop down list of available solutions.
4. If theGeometry field is available, select from the drop down list.
5. In the Trace tab, specify the solution Category, a Quantity, and Functions. The resulting

expression will be displayed in theCalculation Expression field.
a. Select theCategory from the list.

The selection appears in theCalculation Expression field, and theQuantity and
Function fields list what is available for the corresponding selection.

b. Select theQuantity from the list.
The selected quantity appears in theCalculation Expression field.
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If theQuantity list is long, you can filter it for easier selection by typing in the text filter field.
Only quantities that contain those alphanumeric characters anywhere in their namewill
remain visible in the list.
If you want to create an output variable that represents the solution quantity, do the
following:

l Click theOutput Variables button.
TheOutput Variables dialog box appears.

l Add the expression you want to evaluate, and then clickDone.
The recently created output variable appears in theQuantity list.

l Click a new output variable in the Quantity pull-down list.
Note The calculation you specifymust be able to be evaluated into a single, real

number.

The selectedQuantity appears in theCalculation Expression field.
c. Select the Function from the list.

The selected function is applied to theQuantity in theCalculation Expression field.
6. To apply aRange function to theCalculation Expression, see Setting a Range function.
7. ClickAdd Calculation to add the expression in theAdd/Edit Calculation dialog

Calculation Expression field to the Calculations tab of theSetup Sweep Analysis dialog.
8. ClickDone to close theAdd/Edit Calculation dialog box.

Related Topics

Specifying a Solution Quantity to Evaluate
Setting a Range function

Specifying a Solution Quantity's Calculation Range

The calculation range of a solution quantity determines the value of intrinsic variables such as
frequency (F) at which the solution quantity will be extracted. For a parametric setup, the calculation
rangemust be a single value.

1. In theSetup Sweep Analysis dialog box, click theCalculations tab.
2. Click theSetup Calculations button.

TheAdd/Edit/Calculation dialog box appears.
3. Select theCalculation Range tab.
4. In theVariable list, click an intrinsic variable.

Depending on the variable and Report Type, either a single value or All appears in the Value
field.

5. To change the Value, click the ellipsis button.to display a dialog box that lets you select
particular values, or specify a range of values (for Time sweeps). By default,Use all values is
selected.
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l For variables other than Time, uncheckingUse all values enables a list of available values.
You can use the buttons toClear All or Select All values.
a. Select theSweepDefault or Edited radio buttons to specify whether to accept the

default or edited sweeps.
b. To edit the sweeps further, select the ellipsis [...] button to display anEdit Sweep dialog

box. For frequency variables, this lets you specify a single value, linear step, linear
count, decade count, octave count, or exponential count. You canAdd legal values to
the list of sweep values,Update the list for changes, orDelete selected entries.

c. When finished selecting/editing sweep values, close the dialog box. The values you
select are displayed in the Value field.

l For Time sweeps:
a. Select theSpecify range radio button to enable theMin andMax value fields.
b. Enter the desiredMin andMax values, and choose the associated units of measure

from the drop down lists.
c. When finished, close the dialog box. The values you selected are displayed in the Value

field.
6. ClickUpdate, and then clickDone.

Viewing Results for Parametric Solution Quantities

1. In the project tree, right-click the parametric setup for which you want to view the results
calculated for the solution quantities, and then clickView Analysis Result on the shortcut
menu.
ThePost Analysis Display dialog box appears.

2. Select the parametric setup with the results you want to view from the pull-down list at the top
of the dialog box.

3. If it is not already selected, select Table as the view type.
The results for the selected solution quantities are listed in table format for each solved design
variation. The variation column in the table lists the entries in order. Clicking the Vision header
inverts the order. Clicking other headers sorts the entries by value, and clicking again inverts
the order.

4. Optionally, selectShow complete output name.
The complete name of the solution for which the results are being displayed will be listed in the
column headings.

5. Optionally, click a design variation in the table, and then clickApply (at the far right side of the
dialog box).
The design displayed in the 3D Modeler window is changed to represent the selected design
variation.

Related Topics

Plotting Solution Quantity Results vs. a Swept Variable
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Using Distributed Analysis

If you have purchased the appropriate license, Maxwell supports distributed solve, which involves
distributing rows of a parametric table during Optimetrics solve.
If you do a distributed solve, Maxwell launches solver engines onmultiple machines, assuming that
you have configured your machines appropriately.
To run a distributed analysis:

1. UnderOptimetrics in the project tree, right-click the specific parametric setup.
A shortcut menu appears.

2. SelectDistribute Analysis from the shortcut menu.
Note After you define a parametric sweep, a shortcut menu becomes available when you

right-click the setup name.

While the analysis is running, you can access parent and child progress bars. By default, only
themain progress bar is displayed, while the child progress bars (or subtasks) remain hidden.
You can toggle between showing and hiding the child progress bars.
To show the child progress bars:

l Right-click the progresswindow, and selectShow Subtask Progress Bars.
To hide the child progress bars:

l Right-click the progresswindow, and selectHide Subtask Progress Bars.

Related Topics

General Options: Remote Analysis
Solving Remotely (WindowsOnly)
Setting UpDistributed Analysis with Licensing
Viewing Distributed Analysis Subtasks

Adding a Parametric Sweep from a File

You can specify the parameters for a parametric sweep in a spreadsheet that uses either a .csv
(comma delimited) or .txt (tab delimited) format. You can then import the parametric sweep using the
Maxwell (2D or 3D)>Optimetrics Analysis>Add Parametric from File command.
For example, a .txt spreadsheet file could resemble the following:

a $b $c[in] d[m] $e $f
0.1 mil 2mm 11 21 0.6in 8
0.2mil 3mm 1.3 2.6mm 3 9cm
...

The first row lists the Project and Design Variable names, and when followed by parentheses, the
units. The following rows provide the variable values and units. Project or Design variablesmust be
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defined before they are accepted from a file. The characters in variable names are not case
sensitive. Consecutive separators are treated as one separator.
The header row also takes units in ( ) as well as the conventional [ ].

Related Topics

Setting up a Parametric Analysis

Optimization Overview
Optimetrics interfaceswith ANSYS Electromagnetics products to enable the optimization of a wide
variety of design parameters based on variable geometry, materials, excitations, component values,
etc. Optimization is the process of locating theminimumof a user-defined cost function. Optimetrics
modifies the variable values until theminimum is reached with acceptable accuracy.

Related Topics

Setting Up anOptimization Analysis
Choosing anOptimizer

Choosing an Optimizer

Conducting an optimization analysis allows you to determine an optimum solution for your problem.
InMaxwell optimization analyses, you have five choices of optimizer, though inmost cases, the
Sequential Nonlinear Programming optimizer is recommended.

l Sequential Nonlinear Programming (SNLP)
l Sequential Mixed Integer NonLinear Programming (SMINLP)
l Quasi Newton
l Pattern Search
l Genetic Algorithm
l MATLAB Optimizer

All five optimizers assume that the nominal problem you are analyzing is close to the optimal solution;
therefore, youmust specify a domain that contains the region in which you expect to reach the
optimum value.
All five optimizers allow you to define amaximum limit to the number of iterations to be executed.
This prevents you from consuming your remaining computing resources and allows you to analyze
the obtained solutions. From this reduced range, you can further narrow the domain of the problem
and regenerate the solutions.
All optimizers also allow you to enter a coefficient in theAdd Constraintswindow to define the
linear relationship between the selected variables and the entered constraint value. For the SNLP
and NMINLP optimizers, the relationship can be linear or nonlinear. For the Quasi Newton and
Pattern Search optimizers, the relationshipmust be linear.
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Cost functions can be quite nonlinear. As a result, during the function evaluations of the algorithm,
the cost function can vary significantly. Also, it is important to understand the relationship between
optimization function evaluation and iteration. Every iteration, depending on the number of
parameters to be optimized, performs several function evaluations. These function evaluations,
depending on how nonlinear the cost function is, could show drastic changes. The presence of
drastic changes has no bearing on whether the optimization algorithm converged or not.
In the case of non-gradient search-based optimization algorithms, such as "pattern search," which
are entirely based on function evaluations, one could see drastic changes in the function evaluations
depending on how nonlinear the cost function is. This could seemmisleading as if the algorithm did
not converge since in theory one expects the cost function to decrease from one iteration to the next.
The optimetrics, however, reports function evaluations and not necessarily the optimizer
performance per iteration.

Note TheMATLAB optimizer displays function evaluation when theShow all functions
evaluation check box is selected. If the check box is not selected, it displays
iteration.

Quasi Newton

If the Sequential Non Linear ProgrammingOptimizer has difficulty, and if the numerical noise is
insignificant during the solution process, use theQuasi Newton optimizer to obtain the results. The
Quasi Newton optimizer works on the basis of finding aminimumor maximumof a cost function
which relates variables in themodel or circuit to overall simulation goals. The user defines one or
more variables in the problem definition and a cost function in the optimization setup. The cost
function relates the variable values to field quantities, design parameters like force or torque, power
loss, etc. The optimizer can thenmaximize or minimize the value of the design parameter by varying
the problem variables.
Sir IsaacNewton first showed that themaximumor minimumof any function can be determined by
setting the derivative of a function with respect to a variable (x) to zero and solving for the variable.
This approach leads to the exact solution for quadratic functions. However, for higher order functions
or numerical analysis, an iterative approach is commonly taken. The function is approximately locally
by a quadratic and the approximation is solved for the value of x. This value is placed back into the
original function and used to calculate a gradient which provides a step direction and size for
determining the next best value of x in the iteration process.
In the Quasi-Newton optimization procedure, the gradients (Hessian) are not well behaved functions
and are calculated numerically. Essentially, the change in the estimate of x and the change in the
gradient are used to estimate the Hessian for the next iteration. The ratio of the change in the
gradients to the change in the values of x provides the Hessian for the next step and is know as the
quasi-Newton condition. In order to perform theQuasi-Newton optimization, at least three solutions
are required for each parameter being varied. This can have a significant computational cost
depending upon the type of analysis being performed.
There are numerousmethods described in the literature for solving for the Hessian and the details of
themethod used byOptimetrics are beyond the scope of this document. However, as the Quasi-
Newtonmethod is, at its heart, a gradient method, it suffers from two fundamental problems
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common to optimization. The first is the possible presence of local minima. The figure below
illustrates the problem of local minima. In this scenario, you can see that in order to find theminimum
of the function over the domain, a number of factors will determine the overall success including the
initial starting point, the initial set of gradients calculated, the allowable step size, etc. Once the
optimizer has located aminimum, the Quasi-Newton approach will locate the bottom and will not
search further for other possible minima. In the example shown, when the optimizer begins at the
point labeled "Starting Point 1" theminima it finds is a local minima and not a good global solution to
the problem.

The second basic issue with Quasi-Newton optimization is numerical noise. In gradient optimization,
the derivatives are assumed to be smooth, well behaved functions. However, when the gradients
are calculated numerically, the calculation involves taking the differences of numbers that get
progressively smaller. At some point, the numerical imprecision in the parameter calculations
becomes greater than the differences calculated in the gradients and the solution will oscillate and
may never reach convergence. To illustrate this, consider the figure shown below. In this scenario,
the optimizer is looking for the point labeled "minimum". Three possible solutions are labeled A, B
and C, with each arrow indicating the direction of the derivative of the function at that point. If points
A and B represent the last two solution points for the parameter, then it is easy to see that the
changes in themagnitude and the consistent direction of the derivativeswill serve to push the
solution closer to the desiredminimum. If, however, points A and C are the last two solution points
respectively, themagnitude indicates the proper direction of movement, but the derivatives are
opposite, possibly causing the solution tomove away from theminimum, back in the direction of point
A.
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In order to use theQuasi-Newton optimizer effectively, the cost function should be based on
parameters that exhibit a smooth characteristic (little numerical noise) and a starting point of the
optimization should be chosen somewhat close to the expectedminimumbased on an
understanding of the physical problem being optimized. This becomes increasingly difficult,
however, whenmultiple parameters are being varied or whenmultiple parameters are to be
optimized. In addition, the computational burden of multivariate optimization with Quasi-Newton
increases geometrically with the number of variables being optimized. As a result, thismethod
should only be attempted when 1 or 2 variables are being optimized as a time.
For more information regarding Quasi-Newton optimizationmethods, see the following reference:
Schoenberg, Ronald.Optimization with the Quasi-NewtonMethod. Aptech Systems, Inc. 2001.

Related Topics

Optimization Setup for Quasi NewtonOptimizer

Pattern Search

If the noise is significant in the nominal project, use the Pattern Search optimizer to obtain the results.
It performs a grid-based simplex search, whichmakes use of simplices: triangles in 2D space or
tetrahedra in 3D space. A simplex is a Euclidean geometric spatial element having theminimum
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number of boundary points, such as a line segment in one-dimensional space, a triangle in two-
dimensional space, or a tetrahedron in three-dimensional space.
The cost value is calculated at the vertices of the simplex. The optimizer mirrors the simplex across
one of its faces based onmathematical guidelines and determines if the new simplex provides better
results. If it does not produce a better result, the next face is used for mirroring and the pattern
continues. If no improvement occurs, the grid is refined. If improvement occurs, the step is accepted
and the new simplex is generated to replace the original one. The figures below illustrates a
triangular simplexmirrored several times to demonstrate the pattern search approach in two
variables and the simplices superimposed on a 2D cost function to demonstrate the convergence
toward aminimum in the cost function.
Cost functions can be quite nonlinear. As a result, during the function evaluations of the algorithm,
the cost function can vary significantly. Also, it is important to understand the relationship between
optimization function evaluation and iteration. Every iteration, depending on the number of
parameters to be optimized, performs several function evaluations. These function evaluations,
depending on how nonlinear the cost function is, could show drastic changes. The presence of
drastic changes has no bearing on whether the optimization algorithm converged or not.
In the case of non-gradient search-based optimization algorithms, such as "pattern search," which
are entirely based on function evaluations, one could see drastic changes in the function evaluations
depending on how nonlinear the cost function is. This could seemmisleading as if the algorithm did
not converge since in theory one expects the cost function to decrease from one iteration to the next.
The optimetrics, however, reports function evaluations and not necessarily the optimizer
performance per iteration.

Note TheMATLAB optimizer displays function evaluation when theShow all functions
evaluation check box is selected. If the check box is not selected, it displays
iteration.
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The Pattern Search algorithms are extensible to three variable optimization by using tetrahedral
simplices, however, they are not easily represented in graphical form. Generally, Pattern Search
algorithms are not used whenmore than three variables are used in the optimization.
When there is not improvement in the cost function regardless of the direction the simplex is
mirrored, then the simplex is subdivided into smaller simplices and the process restarted.
Pattern Search algorithms have several advantages over Quasi-Newton algorithms. First, they are
less sensitive to noise because the cost function is evaluated at all node points on the simplex and
the numerical noise averages out over the simplex. The second advantage is that the number of
initial solutions is generally smaller as shown in the table. However, since the pattern search does
not use gradient information to locate theminimum the process convergesmore slowly toward the
trueminimum, takingmore steps to successively divide the simplices as theminimum is approached.

Related Topics

Optimization Setup for Pattern SearchOptimizer

Sequential Non-linear Programming (SNLP)

Themain advantage of SNLP over Quasi Newton is that it handles the optimization problem inmore
depth. This optimizer assumes that the optimization variables span a continuous space. As a result,
there is noMinimumStep Size specified in this optimizer and the variablesmay take any value within
the allowable constraints and within the numerical precision limits of the simulator. Like Quasi
Newton, the SNLP optimizer assumes that the noise is not significant. It does reduce the effect of the
noise, but the noise filtering is not strong.
The SNLP optimizer approximates the FEA characterization with Response Surfaces (RS). With
the FEA-approximation and with light evaluation of the cost function, SNLP has a good
approximation of the cost function in terms of the optimization variables. This approximation allows
the SNLP optimizer to estimate the location of improving points. The overall cost approximations are
more accurate. This allows the SNLP optimizer a faster practical convergence speed than that of
quasi Newton.
The SNLP Optimizer creates the response surface using a Taylor Series approximation from the
FEA simulation results available from past solutions. The response surface ismost accurate in the
local vicinity. The response surface is used in the optimization loop to determine the gradients and
calculate the next step direction and distance. The response surface acts as a surrogate for the FEA
simulation, reducing the number of FEA simulations required and greatly speeding the problem.
Convergence improves asmore FEA solutions are created and the response surface approximation
improves.
The SNLPmethod is similar to the Sequential Quadratic Programming (SQP) method in two ways:
Both are sequential, updating the optimizer state to the current optimal values and iterating.
Sequential optimization can be thought of a walking a path, step by step, toward an optimal goal.
SNLP and SQP optimizers are also similar in that both use local and inexpensive surrogates.
However, in the SNLP case, the surrogate can be of a higher order and ismore generally
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constrained. The goal is to achieve a surrogatemodel that is accurate enough on a wider scale, so
that the search procedures are well lead by the surrogate, even for relatively large steps. All
functions calculated by the supporting finite element product (for example, Maxwell 3D or HFSS) is
assumed to be expensive, while the rest of the cost calculation (for example, an extra user-defined
expression)— which is implemented in Optimetrics— is assumed to be inexpensive. For this
reason, it makes sense to remove inexpensive evaluations from the finite element problem and,
instead, implement them in Optimetrics. This optimizer holds several advantages over the Quasi
Newton and Pattern Search optimizers.
Most importantly, due to the separation of expensive and inexpensive evaluations in the cost
calculation, the SNLP optimizer ismore tightly integrated with the supporting FEA tools. This tight
integration providesmore insight into the optimization problem, resulting in a significantly faster
optimization process. A second advantage is that the SNLP optimizer does not require cost-
derivatives to be approximated, protecting against uncertainties (noise) in cost evaluations. In
addition to derivative-free state of the RS-based SNLP, the RS technique also proves to have noise
suppression properties.

Related Topics

Optimization Setup for SNLP Optimizer

Sequential Mixed Integer NonLinear Programming

The Sequential Mixed Integer Nonlinear Programming (SMINLP) optimizer is equivalent to the
SNLP optimizer with only one difference. Many problems require variables take only discrete values.
One examplemight be to optimize on the number of turns in a coil. To be able to optimize on number
of turns or quarter turns, the optimizer must handle discrete optimization variables. The SMINLP
optimizer canmix continuous variables among the integers, or can have only integers, and works if
all variables are continuous. The setup resembles the setup for SNLP, except that youmust flag the
integer variables.supporting integer variables. You can set up internal variables based on the integer
optimization variable.
For example, consider N to be an integer optimization variable. By definition it can only assume
integer values. You can establish another variable, which further depends on this one: K = 2.345 * N,
or K = sin(30 * N). This way K has a discrete value, but is not necessarily integer. Or, one can use N
directly as a design parameter.

Related Topics

Optimization Setup for SMINLP Optimizer

Optimetrics 25-19
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Genetic Algorithm

Genetic Algorithm (GA) optimizers are part of a class of optimization techniques called stochastic
optimizers. They do not use the information from the experiment or the cost function to determine
where to further explore the design space. Instead, they use a type of random selection and apply it
in a structuredmanner. The random selection of evaluations to proceed to the next generation has
the advantage of allowing the optimizer to jump out of a local minima at the expense of many random
solutionswhich do not provide improvement toward the optimization goal. As a result, the GA
optimizer will runmanymore iterations andmay be prohibitively slow.
TheGenetic Algorithm search is an iterative process that goes through a number of generations (see
picture below). In each generation some new individuals (Children / Number of Individuals) are
created and the grown population participates in a selection (natural-selection) process that in turn
reduces the size of the population to a desired level (Next Generation / Number of Individuals).

When a smaller set of individualsmust be created from a bigger set, the GA selects individuals from
the original set. During this process, better fit (in relation to the cost function) individuals are
preferred. In the elitist selection, simply the best somany individuals are selected, but if you turn on
the roulette selection, then the selection process gets relaxed. An iterative process starts selecting
the individuals and fill up the resulting set, but instead of selecting the best somany, we use a
roulette wheel that has for each selection-candidate divisionsmade proportional to the fitness level
(relative to the cost function) of the candidate. Thismeans that the fitter the individual is, the larger
the probability of his survival will be.

Related Topics

Optimization Setup for Genetic AlgorithmOptimizer
Optimization Variables in Design Space
Cost Function
AdvancedGenetic AlgorithmOptimizer Options

Optimetrics 25-20
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

MATLAB Optimizer

TheMATLAB optimizer option lets you pass a script to MATLAB to perform the optimization.When
the optimization is analyzed, MATLAB is launched and a script is passed in toMATLAB to perform
the optimization. During the optimization, MATLAB will call back into our application to perform the
solve and compute the cost. The cost will be reported back toMATLAB, andMATLAB's optimization
will determine the next step in the optimization.
The optimization script is specified as part of the optimization setup. Bymodifying the optimization
script, users can change the optimization parameters and optimizationmethod aswell as use the full
power of MATLAB in their optimization.

Running the Optimization
TheMATLAB optimization is launched just like any other optimization. TheMessageWindow will
display statusmessageswhenMATLAB is being launched, and statusmessageswill be generated
for each solve that is being performed.
In most cases, MATLAB will terminate when the optimization has been completed. Some reasons
whyMATLAB would not terminate are:

l The user hasmodified theMATLAB script to not terminateMATLAB after the optimization.
l A syntax error or some other has occurred.
l The user has added some other code which runs after the optimization has completed.

System Requirements
In order to useMATLAB to perform optimizations from your application:

l A version of MATLABmust be installed on your system.
l The computing platform (i.e. 64 bit or Linux) of MATLABMUSTmatch the platform of the
ANSYS application you are using it with.

l Youmust have theMATLAB Optimization Toolkit installed.

Specifying the MATLAB Location
TheMiscellaneous options panel contains a setting for theMATLAB application location. This setting
must to point to the version of MATLAB to be used for performing the optimization. The platform (i.e.
64 bit or Linux) of the specified version of MATLABmust match the platform of this application.

MATLAB Optimization Setup
MATLAB optimization starts by creating an optimization and selectingMATLAB from the optimizer
dropdown list. If you select MATLAB as the optimizer, theSetup Optimization dialog displays a
Setup... button.
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SelectSetup... to open theMATLAB Options dialog.

Thee upper text panel is informative. The Script section drop down lets you select a lower panel
display for Optimization algorithm, Options, or the Full script template.
This panel allows you tomodify the script that is passed toMATLAB to perform the optimization. The
complete script contains all the instructions necessary for MATLAB to connect to Maxwell and
perform the optimization. The drop-down selection lets you view only the portion of code of interest
without having to view the full script. The choices are:

l Optimization algorithm: displays only the line of code invoking the actual optimization
function. By changing this line, the user can use a different MATLAB function for optimization.
By default we use fmincon(), which is a derivative-based constrained optimization. By
modifying this line, the user could replace the fmincon() call with fminsearch() to use
an unconstrained pattern searching optimizer or another optimization function.See the
MATLAB documentation for details about available optimization functions.

l Options: Each optimization function containsmany options and parameters, which are set in
theMATLAB script prior to actually calling the optimization function. Bymodifying these
options, the optimization can be customized as desired. For instance, options can be set for
fmincon() to specify the algorithm that it uses internally.See theMATLAB documentation
for details about options available for each optimization function.

l Full script template: This choice displays the full optimization script that is passed to
MATLAB.

The initial Script Section display for the Optimization algorithm shows the following:
% invoke optimization
[x,fval,exitflag,output] = fmincon(wrapperfunc, startingpoint,
[], [], [], [], $ANS_MINVAL, $ANS_MAXVAL, nlcon, options)

The initial Script Section Options display shows the following:
% customers can add their own options below
options = optimset(options, 'display', 'iter')
options = optimset(options, 'Algorithm', 'interior-point')
% options = optimset(options, 'PlotFcns', @optimplotfval)

Optimetrics 25-22
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

You canmodify the script to extend and customize the optimization to your needs. Youmust ensure
that the script followsMATLAB syntax. For instance, bymodifying the optimization script you can:

l Change the optimization algorithm (e.g. call fminsearch instead of fmincon)
l Change the parameters/options of the optimization algorithm (see theMATLAB
documentation for details).

l Specify a plot function to provide graphical output during optimization.
l Specify a user defined output function to be called at completion or per iteration.

Symbols:
Whenmodifying theMATLAB code, users can use symbols to represent values from the
optimization setup. The symbols and their definitions are listed below.

$ANS_VARIABLE_
LIST:

list of variables we are optimizing

$ANS_STARTING_
POINT:

vector of starting values of variables used in the optimization

$ANS_
MAXITERATIONS:

maximumnumber of iterations specified in optimization setup

$ANS_MINVAL: vector of minimum values from optimization setup
$ANS_MAXVAL: vector of maximum values from optimization setup
$ANS_MINSTEP: vector of minimum step sizes from optimization setup
$ANS_MAXSTEP: vector of maximum step sizes from optimization setup
$ANS_A_MATRIX matrix of linear constraint coefficients (left-hand side) generated from

optimization setup
$ANS_B_MATRIX matrix of linear constraint bounds (right-hand side) generated from

optimization setup

Note The linear constraints as generated for MATLAB have the form [A][x] <= [B], where [A] is
the coefficient matrix, [x] is the variable list matrix (column vector), and [B] is the bounds
matrix (column vector).

Note While modifying the script, please ensure that the script followsMATLAB
syntax.

MATLAB Optimization Script Template
The script template shown in the Script Section is as follows:
% make sure platform matches

if strcmp(computer, '$ANS_EXPECTED_PLATFORM') ~= 1

h = msgbox('32/64 platform does not match calling application,
exiting')

uiwait(h)

exit
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end

% add installation dir to search path so .mex file can be found

originalpath = addpath('$ANS_EXEDIR')

% connect back to opticomengine

callbackinterface = optimex('connect', '$ANS_CONNECTIONSTRING')

% set up optimization

% variables are: $ANS_VARIABLELIST

startingpoint = $ANS_STARTINGPOINT

options = optimset('MaxIter', $ANS_MAXITERATIONS)

iterationCallbackWrapper = @(x, optimValues, state) optimex
('notifyiterationcomplete', callbackinterface, x, optimValues.fval,
state)

options = optimset(options, 'OutputFcn', iterationCallbackWrapper)

% halt execution so debugger can be attached

% h = msgbox('attach debugger if desired')

% uiwait(h)

% attributes that user can pass to optimization algorithm

% variables are: $ANS_VARIABLELIST

% this is the objective function which returns cost

wrapperfunc = @(x)optimex('eval', callbackinterface, x)

% this is our non linear constraint function, returns no constraints

returnempty = @(x)[];

nlcon = @(x) deal(returnempty(x), returnempty(x));

% DO NOT EDIT THIS LINE - START OPTIONS SECTION

% customers can add their own options below

options = optimset(options, 'display', 'iter')

options = optimset(options, 'Algorithm', 'interior-point')

% options = optimset(options, 'PlotFcns', @optimplotfval)

% DO NOT EDIT THIS LINE - END OPTIONS SECTION

% DO NOT EDIT THIS LINE - START OPTIMIZATION ALGO SECTION

% invoke optimization

[x,fval,exitflag,output] = fmincon(wrapperfunc, startingpoint, $ANS_
A_MATRIX, $ANS_B_MATRIX, [], [], $ANS_MINVAL, $ANS_MAXVAL, nlcon,
options)

% DO NOT EDIT THIS LINE - END OPTIMIZATION ALGO SECTION

% write exit message to Ansoft message window
(warning=0,error=1,info=2)

optimex('postansoftmessage', callbackinterface, 2, output.message)
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% notify opticomengine that optimization is finished

optimex('optimizationfinished', callbackinterface, exitflag)

% restore original path

path = originalpath

% note: comment below line if you want MATLAB to remain

% running after optimization

exit

Related Topics

Optimization Setup for theMATLAB Optimizer
Tools>General Options:Miscellaneous tab

Optimization Variables and the Design Space

Once the optimization variables are specified, the optimizer handles each of them as an n-
dimensional vector x. Any point in the design space corresponds to a particular x-vector and to a
design instance. Each design instancemay be evaluated via FEA and assigned a cost value;

therefore, the cost function is defined over the design space (cost(x): , where n is the
number of optimization variables.
In practice, a solution of theminimization problem is sought only on a bounded subset of the Rn
space. This subset is called the feasible domain and is defined via linear constraints.

Setting Up an Optimization Analysis
Optimization allows you to vary predefined variables in the nominal design to search for the solution
that best satisfies a set of user defined goals or cost functions. Optimetricsmodifies the variable
values until theminimum is reached with acceptable accuracy.

Note l You can definemore than one optimization analysis setup per design.
l You can create anOptimization setup before defining variables but all variablesmust
be defined before you start the Optimization analysis.

l Once you have created an optimization analysis setup, you can copy and paste it,
and thenmake changes to the copy, rather than redoing the whole process for minor
changes.

To provide a broad range of capability, Optimetrics incorporates the following types of numerical
optimizers:

l Sequential Nonlinear Programming (Gradient) (SNLP)
l Sequential Mixed Integer Nonlinear Programming (Gradient and Discrete) (SMINLP)
l Quasi Newton (Gradient)
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l Pattern Search (Search-based)
l Genetic Algorithm (Random search)
l MATLAB

Click on the links above to view the setup procedure for each optimizer. Options for the analysis are
listed in the table.
The following optional optimization solution setup options can also be used:

l Modify the starting variable value.
l Modify theminimumandmaximum values of variables that will be optimized.
l Exclude variables from optimization.
l Modify the values of fixed variables that are not being optimized.
l Set theminimumandmaximum step size between solved design variations (For the Quasi
Newton and Patterns Search optimizers, Variables tab).

l Set theminimumandmaximum focus size. (For the SNLP and SMINLP optimizers,
Variables tab).

l Set Linear constraints.
l Request that Optimetrics solve a parametric sweep before an optimization analysis.
l Request that Optimetrics solve a parametric sweep during an optimization analysis.
l Automatically update optimized variables to the optimal values during an optimization or
after an optimization analysis is completed.

l Change the norm used for the cost function calculation (AdvancedOption)
l SetHPC and Analysis Options, which allows you to select or create an analysis
configuration.

Note Sweeping or using a complex variable is not allowed in any optimetrics setup, including
optimization, statistical, sensitivity, and tuning setups.

Related Topics

Optimization Overview
Choosing anOptimizer

Optimization Setup for the Quasi Newton(Gradient) Optimizer

Following is the procedure for setting up an optimization analysis using theQuasi Newton(gradient)
Optimizer. Once you have created a setup, you canCopy andPaste it, and thenmake changes to
the copy, rather than redoing the whole process for minor changes.

1. Set up the variables you want to optimize in theDesign Properties dialog box.
2. On theMaxwell3D or Maxwell2D menu, point toOptimetrics Analysis, and then clickAdd

Optimization .
TheSetup Optimization dialog box appears.

Optimetrics 25-26
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

3. Under theGoals tab, select the optimizer by selectingQuasi Newton(Gradient) from the
Optimizer pull-down list. Selecting Quasi Newton enables theAcceptable Cost and Noise
fields.

4. Type themaximumnumber of iterations you want Optimetrics to perform during the
optimization analysis in theMax. No. of Iterations text box.

5. UnderCost Function, add a cost function by selecting theSetup Calculations button to
open theAdd/Edit Calculation dialog.

6. Type the value of the cost function at which the optimization process should stop in the
Acceptable Cost text box.

7. Type the cost function noise in theNoise text box.
8. If you want to select aCost Function Norm Type:

l Check the Show Advanced Option check box.

TheCost Function Norm Type pull-down list appears.

l Select L1, L2, orMaximum.

A norm is a function that assigns a positive value to the cost function.

For L1 norm the actual cost function uses the sum of absolute weighted values of the
individual goal errors. For L2 norm (the default) the actual cost function uses the weighted
sum of squared values of the individual goal error. For theMaximumnorm the cost function
uses themaximumamong all the weighted goal errors. (For further details, see Explanation of
the L1, L2, andMaxNorms in Optimization.)

The norm type doesn’t impact goal setting that use as condition the “minimize” or “maximize”
scenarios.

9. Optionally, click the button for settingHPC and Analysis Options, which allows you to select
or create an analysis configuration.

10. In theVariables tab, specify theMin/Max values for variables included in the optimization,
and theMin/Max Step Size for the analysis.
l Youmay also override the variable starting values by clicking theOverride check box and
entering the desired value in theStarting Value field.

l Optionally, modify the values of fixed variables that are not being optimized.
l Optionally, set Linear constraints.
l Select theView all columns check box to see all columns, including hidden columns.

11. In theGeneral tab, specify whether Optimetrics should use the results of a previous
Parametric analysis or perform one as part of the optimization process.
Enabling theUpdate design parameters’ value after optimization check boxwill cause
Optimetrics tomodify the variable values in the nominal design tomatch the final values from
the optimization analysis.

12. Under theOptions tab, if you want to save the field solution data for every solved design
variations in the optimization analysis, selectSave Fields And Mesh.
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Note Do not select this option when requesting a large number of iterations as the data
generated will be very large and the systemmay become slow due to the large I/O
requirements.

Youmay also selectCopy geometrically equivalent meshes to reuse themesh when
geometry changes are not required, for example when optimizing on amaterial property or
source excitation.This will provide some speed improvement in the overall optimization
process.

Optimization Setup for the Pattern Search (Search-based) Optimizer

Following is the procedure for setting up an optimization analysis using the Pattern Search(Search-
based) Optimizer. Once you have created a setup, you canCopy andPaste it, and thenmake
changes to the copy, rather than redoing the whole process for minor changes.

1. Set up the variables you want to optimize in theDesign Properties dialog box.
2. On theMaxwell3D or Maxwell2D menu, point toOptimetrics Analysis, and then clickAdd

Optimization .
TheSetup Optimization dialog box appears.

3. Under theGoals tab, select the optimizer by selectingPattern Search(Search-based) from
theOptimizer pull-down list. Selecting Pattern Search enables theAcceptable Cost and
Noise fields.

4. Type themaximumnumber of iterations you want Optimetrics to perform during the
optimization analysis in theMax. No. of Iterations text box.

5. UnderCost Function, add a cost function by selecting theSetup Calculations button to
open theAdd/Edit Calculation dialog.

6. Type the value of the cost function at which the optimization process should stop in the
Acceptable Cost text box.

7. Type the cost function noise in theNoise text box.
8. If you want to select aCost Function Norm Type:

l Check the Show Advanced Option check box.

TheCost Function Norm Type pull-down list appears.

l Select L1, L2, orMaximum.

A norm is a function that assigns a positive value to the cost function.

For L1 norm the actual cost function uses the sum of absolute weighted values of the
individual goal errors. For L2 norm (the default) the actual cost function uses the weighted
sum of squared values of the individual goal error. For theMaximumnorm the cost function
uses themaximumamong all the weighted goal errors. (For further details, see Explanation of
the L1, L2, andMaxNorms in Optimization.)
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The norm type doesn’t impact goal setting that use as condition the “minimize” or “maximize”
scenarios.

9. Optionally, click the button for settingHPC and Analysis Options, which allows you to select
or create an analysis configuration.

10. In theVariables tab, specify theMin/Max values for variables included in the optimization,
and theMin/Max Step Size for the analysis.
l Youmay also override the variable starting values by clicking theOverride checkbox and
entering the desired value in theStarting Value field.

l Optionally, modify the values of fixed variables that are not being optimized.
l Optionally, set Linear constraints.
l Select theView all columns check box to see all columns, including hidden columns.

11. In theGeneral tab, specify whether Optimetrics should use the results of a previous
Parametric analysis or perform one as part of the optimization process.
Enabling theUpdate design parameters’ value after optimization check boxwill cause
Optimetrics tomodify the variable values in the nominal design tomatch the final values from
the optimization analysis.

12. Under theOptions tab, if you want to save the field solution data for every solved design
variations in the optimization analysis, selectSave Fields And Mesh.
Note Do not select this option when requesting a large number of iterations as the data

generated will be very large and the systemmay become slow due to the large I/O
requirements.

Youmay also selectCopy geometrically equivalent meshes to reuse themesh when
geometry changes are not required, for example when optimizing on amaterial property or
source excitation.This will provide some speed improvement in the overall optimization
process.

Optimization Setup for the Sequential Nonlinear Programming (Gradient)
Optimizer

Following is the procedure for setting up an optimization analysis using the Sequential Nonlinear
Programming (Gradient) Optimizer or SNLP Optimizer. Once you have created a setup, you can
Copy andPaste it, and thenmake changes to the copy, rather than redoing the whole process for
minor changes.

1. Set up the variables you want to optimize in theDesign Properties dialog box.
2. On theMaxwell3D or Maxwell2D menu, point toOptimetrics Analysis, and then clickAdd

Optimization .
TheSetup Optimization dialog box appears.
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3. Under theGoals tab, select the optimizer by selectingSequential Nonlinear Programming
(Gradient) from theOptimizer pull-down list.

4. Type themaximumnumber of iterations you want Optimetrics to perform during the
optimization analysis in theMax. No. of Iterations text box.

5. UnderCost Function, add a cost function by selecting theSetup Calculations button to
open theAdd/Edit Calculation dialog.

6. If you want to select aCost Function Norm Type:
l Check the Show Advanced Option check box.

TheCost Function Norm Type pull-down list appears.

l Select L1, L2, orMaximum.

A norm is a function that assigns a positive value to the cost function.

For L1 norm the actual cost function uses the sum of absolute weighted values of the
individual goal errors. For L2 norm (the default) the actual cost function uses the weighted
sum of squared values of the individual goal error. For theMaximumnorm the cost function
uses themaximumamong all the weighted goal errors. (For further details, see Explanation of
the L1, L2, andMaxNorms in Optimization.)

The norm type doesn’t impact goal setting that use as condition the “minimize” or “maximize”
scenarios.

7. Optionally, click the button for settingHPC and Analysis Options, which allows you to select
or create an analysis configuration.

8. In theVariables tab, specify theMin/Max values for variables included in the optimization,
and theMin/Max Focus for the analysis.
l Youmay also override the variable starting values by clicking theOverride checkbox and
entering the desired value in theStarting Value field.

l Optionally, modify the values of fixed variables that are not being optimized.
l Optionally, set Linear constraints.
l Select theView all columns check box to see all columns, including hidden columns.

9. In theGeneral tab, specify whether Optimetrics should use the results of a previous
Parametric analysis or perform one as part of the optimization process.
Enabling theUpdate design parameters’ value after optimization check boxwill cause
Optimetrics tomodify the variable values in the nominal design tomatch the final values from
the optimization analysis.

10. Under theOptions tab, if you want to save the field solution data for every solved design
variations in the optimization analysis, selectSave Fields And Mesh.
Note Do not select this option when requesting a large number of iterations as the data

generated will be very large and the systemmay become slow due to the large I/O
requirements.

Youmay also selectCopy geometrically equivalent meshes to reuse themesh when
geometry changes are not required, for example when optimizing on amaterial property or
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source excitation.This will provide some speed improvement in the overall optimization
process.

Optimization Setup for the Sequential Mixed Integer Nonlinear
Programming (Gradient and Discrete) Optimizer

Following is the procedure for setting up an optimization analysis using the Sequential Mixed Integer
Nonlinear Programming (Gradient and Discrete) Optimizer or SMINLP. Once you have created a
setup, you canCopy andPaste it, and thenmake changes to the copy, rather than redoing the
whole process for minor changes.

1. Set up the variables you want to optimize in theDesign Properties dialog box.
2. On theMaxwell3D or Maxwell2D menu, point toOptimetrics Analysis, and then clickAdd

Optimization .
TheSetup Optimization dialog box appears.

3. Under theGoals tab, select the optimizer by selectingSequential Mixed Integer Nonlinear
Programming(Gradient and Discrete) from theOptimizer pull-down list.

4. Type themaximumnumber of iterations you want Optimetrics to perform during the
optimization analysis in theMax. No. of Iterations text box.

5. UnderCost Function, add a cost function by selecting theSetup Calculations button to
open theAdd/Edit Calculation dialog.

6. If you want to select aCost Function Norm Type:
l Check the Show Advanced Option check box.

TheCost Function Norm Type pull-down list appears.

l Select L1, L2, orMaximum.

A norm is a function that assigns a positive value to the cost function.

For L1 norm the actual cost function uses the sum of absolute weighted values of the
individual goal errors. For L2 norm (the default) the actual cost function uses the weighted
sum of squared values of the individual goal error. For theMaximumnorm the cost function
uses themaximumamong all the weighted goal errors. (For further details, see Explanation of
the L1, L2, andMaxNorms in Optimization.)

The norm type doesn’t impact goal setting that use as condition the “minimize” or “maximize”
scenarios.

7. Optionally, click the button for settingHPC and Analysis Options, which allows you to select
or create an analysis configuration.

8. In theVariables tab, specify theMin/Max values for variables included in the optimization,
and theMin/Max Focus for the analysis.
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l Youmay also override the variable starting values by clicking theOverride checkbox and
entering the desired value in theStarting Value field.

l Optionally, modify the values of fixed variables that are not being optimized.
l Optionally, set Linear constraints.
l Select theView all columns check box to see all columns, including hidden columns.

9. In theGeneral tab, specify whether Optimetrics should use the results of a previous
Parametric analysis or perform one as part of the optimization process.
Enabling theUpdate design parameters’ value after optimization check boxwill cause
Optimetrics tomodify the variable values in the nominal design tomatch the final values from
the optimization analysis.

10. Under theOptions tab, if you want to save the field solution data for every solved design
variations in the optimization analysis, selectSave Fields And Mesh.
Note Do not select this option when requesting a large number of iterations as the data

generated will be very large and the systemmay become slow due to the large I/O
requirements.

Youmay also selectCopy geometrically equivalent meshes to reuse themesh when
geometry changes are not required, for example when optimizing on amaterial property or
source excitation.This will provide some speed improvement in the overall optimization
process.

Optimization Setup for the Genetic Algorithm (Random search) Optimizer

Following is the procedure for setting up an optimization analysis using theGenetic Algorithm
(Random search) Optimizer. Once you have created a setup, you canCopy andPaste it, and then
make changes to the copy, rather than redoing the whole process for minor changes.

1. Set up the variables you want to optimize in theDesign Properties dialog box.
2. On theMaxwell3D or Maxwell2D menu, point toOptimetrics Analysis, and then clickAdd

Optimization .
TheSetup Optimization dialog box appears.

3. Under theGoals tab, select the optimizer by selectingGenetic Algorithm(Random search)
from theOptimizer pull-down list.

4. Click theSetup... button tomodify the AdvancedGenetic AlgorithmOptimizer Options.
5. UnderCost Function, add a cost function by selecting theSetup Calculations button to

open theAdd/Edit Calculation dialog.
6. If you want to select aCost Function Norm Type:

l Check the Show Advanced Option check box.

TheCost Function Norm Type pull-down list appears.

l Select L1, L2, orMaximum.
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A norm is a function that assigns a positive value to the cost function.

For L1 norm the actual cost function uses the sum of absolute weighted values of the
individual goal errors. For L2 norm (the default) the actual cost function uses the weighted
sum of squared values of the individual goal error. For theMaximumnorm the cost function
uses themaximumamong all the weighted goal errors. (For further details, see Explanation of
the L1, L2, andMaxNorms in Optimization.)

The norm type doesn’t impact goal setting that use as condition the “minimize” or “maximize”
scenarios.

7. Optionally, click the button for settingHPC and Analysis Options, which allows you to select
or create an analysis configuration.

8. In theVariables tab, specify theMin/Max values for variables included in the optimization,
and theMin/Max Focus for the analysis.
l Youmay also override the variable starting values by clicking theOverride checkbox and
entering the desired value in theStarting Value field.

l Optionally, modify the values of fixed variables that are not being optimized.
l Optionally, set Linear constraints.
l Select theView all columns check box to see all columns, including hidden columns.

9. In theGeneral tab, specify whether Optimetrics should use the results of a previous
Parametric analysis or perform one as part of the optimization process.
Enabling theUpdate design parameters’ value after optimization check boxwill cause
Optimetrics tomodify the variable values in the nominal design tomatch the final values from
the optimization analysis.

10. Under theOptions tab, if you want to save the field solution data for every solved design
variations in the optimization analysis, selectSave Fields And Mesh.
Note Do not select this option when requesting a large number of iterations as the data

generated will be very large and the systemmay become slow due to the large I/O
requirements.

Youmay also selectCopy geometrically equivalent meshes to reuse themesh when
geometry changes are not required, for example when optimizing on amaterial property or
source excitation.This will provide some speed improvement in the overall optimization
process.

Optimization Setup for the MATLAB Optimizer

Following is the procedure for setting up an optimization analysis using theMATLAB Optimizer.
Once you have created a setup, you canCopy andPaste it, and thenmake changes to the copy,
rather than redoing the whole process for minor changes.

1. Set up the variables you want to optimize in theDesign Properties dialog box.
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2. On theMaxwell3D or Maxwell2D menu, point toOptimetrics Analysis, and then clickAdd

Optimization .
TheSetup Optimization dialog box appears.

3. Under theGoals tab, select the optimizer by selectingMATLAB from theOptimizer pull-
down list. SelectingMATLAB enables theAcceptable Cost and Noise fields.

4. Click theSetup... button tomodify theMATLAB Optimizer Options.
5. Type themaximumnumber of iterations you want Optimetrics to perform during the

optimization analysis in theMax. No. of Iterations text box.
6. UnderCost Function, add a cost function by selecting theSetup Calculations button to

open theAdd/Edit Calculation dialog.
7. Type the value of the cost function at which the optimization process should stop in the

Acceptable Cost text box.
8. Type the cost function noise in theNoise text box.
9. If you want to select aCost Function Norm Type:

l Check the Show Advanced Option check box.

TheCost Function Norm Type pull-down list appears.

l Select L1, L2, orMaximum.

A norm is a function that assigns a positive value to the cost function.

For L1 norm the actual cost function uses the sum of absolute weighted values of the
individual goal errors. For L2 norm (the default) the actual cost function uses the weighted
sum of squared values of the individual goal error. For theMaximumnorm the cost function
uses themaximumamong all the weighted goal errors. (For further details, see Explanation of
the L1, L2, andMaxNorms in Optimization.)

The norm type doesn’t impact goal setting that use as condition the “minimize” or “maximize”
scenarios.

10. Optionally, click the button for settingHPC and Analysis Options, which allows you to select
or create an analysis configuration.

11. In theVariables tab, specify theMin/Max values for variables included in the optimization,
and theMin/Max Step Size for the analysis.
l Youmay also override the variable starting values by clicking theOverride checkbox and
entering the desired value in theStarting Value field.

l Optionally, modify the values of fixed variables that are not being optimized.
l Optionally, set Linear constraints.
l Select theView all columns check box to see all columns, including hidden columns.

12. In theGeneral tab, specify whether Optimetrics should use the results of a previous
Parametric analysis or perform one as part of the optimization process.
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Enabling theUpdate design parameters’ value after optimization checkboxwill cause
Optimetrics tomodify the variable values in the nominal design tomatch the final values from
the optimization analysis.

13. Under theOptions tab, if you want to save the field solution data for every solved design
variation in the optimization analysis, selectSave Fields And Mesh.

Note Do not select this option when requesting a large number of iterations as the data
generated will be very large and the systemmay become slow due to the large I/O
requirements.

Youmay also selectCopy geometrically equivalent meshes to reuse themesh when
geometry changes are not required, for example when optimizing on amaterial property or
source excitation. This will provide some speed improvement in the overall optimization
process.

Setting the Maximum Iterations for an Optimization Analysis

TheMax. No. of Iterations value is themaximumnumber of design variations that you want
Optimetrics to solve during an optimization when using theSNLP, SMINLP,Quasi Newton, or
Pattern Search Optimizer. This value is a stopping criterion; if themaximumnumber of iterations
has been completed, the optimization analysis stops. If themaximumnumber of iterations has not
been completed, the optimization continues by performing another iteration, that is, by solving
another design variation.
If themaximumnumber of iterations has not been reached, the optimizer performs iterations until the
acceptable cost function is reached or until the optimizer cannot proceed as a result of other
optimization setup constraints, such aswhen it searches for a variable value with a step size smaller
than theminimum step size.

Note TheGenetic Algorithm optimizer does not use theMax. No. of Iterations
criteria.

To set themaximumnumber of iterations for an optimization analysis:
l Under theGoals tab of theSetup Optimization dialog box, type a value in theMax. No. of
Iterations text box.

Related Topics

Adding a Cost Function

Cost Function

Optimetricsmanipulates themodel's design variable values to find theminimum location of the cost
function; therefore, you should define the cost function so that aminimum location is also the
optimum location.
When using theQuasi Newton optimizer, which is appropriate for designs that are not sensitive to
noise, the best cost function is a smooth, second-order function that can be approximated well by
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quadratics in the vicinity of theminimum; the slope of the cost function should decrease as
Optimetrics approaches the optimum value. The preferred cost function takes values between 0 and
1. In practice, most functions that are smooth around theminimumare acceptable as cost functions.
Most importantly, the cost function should not have a sharp dip or pole at theminimum. A well
designed cost function can significantly reduce the optimization process time.
The cost function is defined in theSetup Optimization dialog box or the Design of Experiments
setup when you set up an optimization analysis. If you know the exact syntax of the solution quantity
on which you want to base the cost function, you can type it directly in theCalculation text box. You
can also useSetup Calculations to add a solution quantity via theAdd/Edit Calculation dialog
box, or to create an output variable that represents the solution quantity in the Output Variables
dialog box.

Related Topics

Adding a Cost Function
Acceptable Cost
Cost Function Noise
Linear Constraints
GoalWeight
Step Size
Explanation of L1, L1, NormCosts in Optimization

Acceptable Cost

The acceptable cost is the value of the cost function at which the optimization process should stop;
otherwise known as the stopping criterion.The cost function valuemust be equal to or below the
acceptable cost value for the optimization analysis to stop. The acceptable cost may be a negative
value.

Related Topics

Cost Function
Adding a Cost Function

Cost Function Noise

The numerical calculation of the electromagnetic field introduces various sources of noise to the cost
function, particularly because of changes in the finite element mesh. Youmust provide the optimizer
with an estimate of the noise. The noise indicateswhether a change during the solution process is
significant enough to support achievement of the cost function.
For example, if the cost function, c, is
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where |L11| is themagnitude of the inductance, at theminimum, |L11| is expected to be very small,

.

From the solution setup, the error in |L11| is expected to be . The perturbed cost function
is therefore

Near theminimum, the error in the cost functionEc is given by

Therefore, the cost function noise would be 1.0.

Related Topics

Cost Function

Adding a Cost Function

A cost function can include one or more goals for an optimization analysis. Optimetricsmanipulates
themodel's design variable values to fulfill the cost function.The optimization will stop when the
solution quantitymeets the acceptable cost criterion.
Following is the general procedure for adding a cost function with a single goal:

1. Under theGoals tab of theSetup Optimization dialog box, clickSetup Calculations...
The Add/Edit Calculation dialog box is displayed.

2. In theAdd/Edit Calculation dialog box, follow these general steps to set up a cost function.
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a. Set theContext for the calculation.
b. Choose theCategory of available data type depending upon the Solution type of the

design being optimized.
c. Select theQuantity to add to theCalculated Expression field. Available quantities

depend upon theCategory selection.
d. Youmay optionallymake a selection from the function list to apply to the calculated

expression.
e. When theCalculation Expression has the desired equation, clickAdd Calculation to

add the expression to the cost function table.
f. Repeat to add additional calculations to the cost function or clickDone to exit the

Add/Edit Calculation dialog box and return toSetup Optimization.
3. Tomodify theSolution on which the calculation is based, click in theSolution column and

select the solution fromwhich the cost function is to be extracted from the pull-down list.
4. To edit the calculation on which to base the cost function goal, selectEdit from the pull-down

list.
5. In theCondition text box, click one of the following conditions from the pull-down list:

<= Less than or equal to

= Equal to

>= Greater than or equal to

Minimize Reduce the cost function to aminimum
value

Maximize Identify amaximized condition

6. In theGoal text box, type the value of the solution quantity that you want to be achieved during
the optimization analysis. If the solution quantity is a complex calculation, the goal valuemust
be complex; two goal valuesmust be specified. The Minimize andMaximize options do not
require you to specify aGoal value.

7. Optionally, if you havemultiple goals and want to assign higher or lower priority to a goal, type
a different value for the goal's weight in theWeight text box. The goal with the greater weight
is givenmore importance. If the goal is a complex value, the weight valuemust be complex;
two weight valuesmust be specified. The weight value cannot be variable dependent.
Note Click theEdit Goal/Weight button to open theEdit Goal Value/Weight dialog box

where you canmodify weights for all goals simultaneously; as well as, set theGoal
Values to expressions.

8. Optionally, click the button for settingHPC and Analysis Options, which allows you to select
or create an analysis configuration.

9. Specify other options (such as acceptable cost, noise, and number of passes), and then click
OK.

The optimization stopswhen the solution quantitymeets the acceptable cost criterion.
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Related Topics

Setting aGoal Value
Cost Function
Acceptable Cost
GoalWeight

Adding/Editing a Cost Function Calculation

The Add/Edit Calculation dialog box allows you to define themathematical equation for one or
multiple cost functions. It represents the calculation to be performed on the optimization variables to
compare to the goal values. To set up a calculation for a cost function:

1. In theContext section of the dialog:
l Select theReport Typewith a pull-down selection list containing the available types for this
design.

l Select theSolution from the drop down selection list. This lists the available setups and
sweeps. As aminimum, the LastAdaptive solution is available.

l Select the Geometry from the drop down selection list or select none (the default). This
modifies the list of quantities available to the ones that apply to the specific geometry.

2. TheOutput Variables button opens theOutput Variables dialog box allowing you to create
special output variables to be used in the cost function.

3. TheCalculated Expression field in the Trace tab is used to enter the equation to be used for
the cost function. To enter an expression, youmay type it directly into the field or use the
Category,Quantity, and Function lists as follows:
l Select theCategory, these depend on the Solution type and the design. This lets you
specify the category of information to be used in the cost function.

l Select aQuantity from the list. Available quantities depend upon the Solution type, aswell
as the Geometry and Category selection. Selecting aQuantity automatically enters it into
the Calculated Expression field.

l Select a Function to apply to the value in the calculated expression.
l For swept variables, the Range Function button opens theSet Range Function dialog
to apply functions to the expression that apply over the sweep range.

4. TheCalculation Range tab applies to swept variables and allows you to specify the range of
the sweep over which to apply the calculation.

5. When the desiredCalculated Expression has been obtained, click theAdd Calculation
button to add the entry to the cost function table. Youmay addmultiple entries to the table
simply by changing theCalculated Expression and using theAdd Calculation button.

6. To update or edit a selected cost function, enter the desired Calculated Expression and click
theUpdate Calculation button.

7. ClickDone to return to the Setup Calculations dialog box.
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Specifying a Solution Quantity for a Cost Function Goal

When setting up a cost function, youmust identify the solution quantity on which to base each goal.
Solution quantities are specified bymathematical expressions that are composed of basic quantities,
such asmatrix parameters, and output variables.
1. Add a row (a goal) to the cost function table:

a. Under theGoals tab of theSetup Optimization dialog box, clickAdd.
A new row is added to theCost Function table.

b. In theSolution column, click the solution fromwhich the cost function is to be extracted.
2. In theSolution text box, click the solution fromwhich the solution quantity is to be extracted.
3. In theCalculation text box, specify the solution quantity in one of the following ways:

l If you know the syntax of themathematical expression or the output variable's name, type it
in theCalculation text box.

l If you want to create an output variable that represents the solution quantity, do the
following:
a. ClickEdit Calculation.

TheOutput Variables dialog box appears.
b. Add the expression you want to evaluate, clickDone.
c. ClickDone to close theOutput Variables dialog box.
In the Setup Optimization dialog box, themost recently created output variable
appears in theCalculation text box.

d. To specify a different defined output variable, click theCalculation text box. It becomes
a pull-down list that displays all of the defined output variables. Click an output variable
from the pull-down list.

Setting the Calculation Range of a Cost Function Goal

The calculation range is the range within which you want a cost function goal to be calculated. It can
be a single value or a range of values, depending on the solution or solution quantity selected for the
goal.

1. Under theGoals tab in theSetup Optimization dialog box, clickEdit Cal. Range.
2. In theVariable pull-down list, click a variable.

If you chose to solve a parametric setup during the optimization analysis, the variables swept
in that parametric setup are available in theVariable pull-down list. If you sweep a variable in
the parametric setup that is also being optimized, that variable is excluded from the
optimization.
Other examples of available variables include frequency, if the solution quantity is an S-
parameter quantity, and phi or theta, if the solution quantity is a radiated field quantity.

3. After you select a variable from theVariable pull-down list, you can select a range of values
for the calculation range as follows:
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a. SelectRange.
b. In theStart text box, type the starting value of the range.
c. In theStop text box, type the final value of the range.

4. To select a single value for the calculation range:
a. SelectSingle Value.
b. In theValue text box, type the value of the variable at which the cost function goal is to be

extracted.
5. ClickUpdate, and then clickOK.

Setting a Goal Value

A goal is the value you want a solution quantity to reach during an optimization analysis. It can be a
real value or a complex value. If the solution quantity is a complex calculation, the goal valuemust be
complex. You can type the goal value in theGoal text box. Alternatively, you can use theEdit
Goal/Value Weight dialog box to specify the goal value as a single value, amathematical
expression, or a value dependent on a variable such as frequency.

Related Topics

Specify a single goal value.
Specify an expression as the goal value.
Specify a variable-dependent goal value.

Specifying a Single Goal Value

1. Under theGoals tab in theSetup Optimization dialog box, clickEdit Goal/Weight.

TheEdit Goal/Weight dialog box appears.

2. Under theGoal Value tab, clickSimple Numeric Value from the Type list.
3. If the goal value is complex, click real/imag in the pull-down list to the right if you want to

specify the real and imaginary parts of the goal value.

Alternatively, clickmag/ang if you want to specify themagnitude and angle of the goal value.

4. Type the goal value in theGoal Value table.

If the goal value is complex, type both parts of the goal value in the text box below theGoal
Value heading. For example, type 1, 1 to specify the real part of the goal value as 1 and the
imaginary part as 1.

If the goal value is real, type a real goal value in the text box below theGoal Value heading.

5. ClickOK.

The goal value you specified appears in theGoal text box.
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Specifying an Expression as a Goal Value

1. Under theGoals tab in theSetup Optimization dialog box, clickEdit Goal/Weight.

TheEdit Goal/Weight dialog box appears.

2. Under theGoal Value tab, clickExpression from the Type list.
3. If you know the syntax of themathematical expression or the existing output variable's name,

type it in the text box below theGoal Value heading.

Alternatively, if you want to create an output variable that represents the goal value, do the
following:

a. ClickEdit Expression.
TheOutput Variables dialog box appears.

b. Add the expression you want to be the goal value, and then clickDone.
Maxwell enters themost recently created output variable in the text box below theGoal
Value heading.

4. ClickOK.

The goal value you specified appears in theGoal text box.

Specifying a Variable-Dependent Goal Value

1. Under theGoals tab in theSetup Optimization dialog box, clickEdit Goal/Weight.

TheEdit Goal/Weight dialog box appears.

2. Under theGoal Value tab, clickVariable Dependent from the Type list.
3. Click a variable from the pull-down list to the left of the table.
4. Type the value of that variable in the first column of the table.

Warning Variable valuesmust be single real numbers, or expressions that evaluate to
single real numbers. Complex numbers cannot be used as the values of variables
in any optimetric analysis.

5. Type a corresponding goal value for that variable value in the text box below theGoal Value
heading.

6. ClickAdd to add another row to the reference curve.
7. Repeat steps 4, 5, and 6 until you have specified the reference curve.
8. ClickOK.

The goal value is listed as being variable dependent in theGoal text box.
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Goal Weight

If an optimization setup has a cost functionmade up of multiple goals, you can assign a different
weight to each goal. The goal with the greater weight is givenmore importance during the cost
calculation.
The error function value is a weighted sum of the sub-goal errors. Each sub-goal, at each frequency
at which it is evaluated, gives rise to a (positive) error value that represents the discrepancy between
the simulated response and the goal value limit. If the response satisfies the goal value limit, then the
error value is 0. Otherwise, the error value depends on the differences between the simulated
response and the respective goal limit. The error functionmay be defined as follows:

where
l G is the number of sub-goals.
l Wj is the weight factor associated with the jth sub-goal.
l Nj is the number of frequencies for the jth sub-goal.
l ei is the error contribution from the jth sub-goal at the ith frequency.

The value of ei is determined by the band characteristics, target value, and the simulated response
value. The choices for band characteristics are <=, =, and >=.

Band Characteristics (Condition)
ei evaluation where si is the simulated response and

gi is the desired limit.

<=

Optimetrics 25-43
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

=

>=

If the total error value is within the acceptable cost, the optimization stops.

Related Topics

Adding a Cost Function
Cost Function

Modifying the Starting Variable Value for Optimization

A variable's starting value is the first value to be solved during the optimization analysis. Optimetrics
automatically sets the starting value of a variable to be the current value set for the nominal design.
You canmodify this value for each optimization setup.

Note If you choose to solve a parametric setup before an optimization analysis, a variable's
starting value is ignored if a more appropriate starting value is calculated for it during the
parametric analysis.

1. In theSetup Optimization dialog box, click theVariables tab.
All of the variables that were selected for the optimization analysis are listed.

2. Type a new value in theStarting Value text box for the value you want to override, and then
pressEnter.
TheOverride option is now selected. This indicates that the value you entered is used for this
optimization analysis, and the current value set for the nominal model is ignored.
l Alternatively, you can select theOverride option first, and then type a new variable value in
theStarting Value text box.
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3. Optionally, click a new unit system in one of theUnits text boxes.
Note To revert to the default starting value, clear theOverride check

box.

Related Topics

Setting theMin. andMax. Variable Values for Optimization
Step Size
Setting theMin andMax Focus
Modifying the Starting Variable Value for Sensitivity Analysis
Modifying the Starting Variable Value for Statistical Analysis

Setting the Min. and Max. Variable Values for Optimization

For every optimization setup, Optimetrics automatically sets theminimumandmaximum values it will
consider for a variable being optimized. Optimetrics sets a variable'sminimum value equal to
approximately 50% of its starting value. (The starting value is the variable's current value set for the
nominal design.) Optimetrics sets the variable'smaximum value equal to approximately 150% of the
starting value. During the optimization analysis, variable values that lie outside of this range are not
considered.

Warning Variable valuesmust be single real numbers, or expressions that evaluate to single real
numbers. Complex numbers cannot be used as the values of variables in any optimetric
analysis.

Related Topics

Text Entry for Calc. Range or Edit Calculation Range Dialog
Override the default min andmax variable values for a single optimization setup.
Change the default min andmax variable values for every optimization setup.

Text Entry for Calc. Range or Edit Calculation Range Dialog

In theSetup Optimization dialog, you can enter the Calc. Range SweepMin/Max by directly
editing the Calc. Range field or by accessing anEdit Calculation Range dialog.

The edit field accepts the following forms of text:
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l sweep that allows you to select different discrete values:
discrete values, for example, F(10GHz, 11GHz)
min/max range, for example, F([10GHz, 11GHz])

l editable sweep, which allows you to customize values (that is, a sweep that has an enabled
"edited" radio button in sweep selection dialog):
Themin/max is used on top of selected values. For example, if you use the sweep dialog and
choose "0 deg, 60 deg, 180 deg, 240 deg", then [60deg, 240deg] will select values "60 deg,
180 deg, 240 deg".

l sweep that uses a full range:
all values, for example, Time(All)
min/max range, for example, Time([1ms, 2ms])

l You solve 1 to 20GHz step .1 and specify F[10.381GHz, 11.381GHz]: it is equivalent to
selecting values between 10.4GHz and 11.3GHz.

l You can specifymultiple sweep values by separating those with a comma (,).
For example, F(1GHz), cap(1pf, 1.2pf)
For example, Distance(All), Freq([1ghz,2ghz]), Phase(0 deg)

If you clickEdit on themenu, you see theEdit Calculation Range dialog. Click on the ellipsis [...]
button to select Use all values, Select values, or Specify range. The Select values option is available
depending on the solution type.
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This example shows how the range appears in the Calc. Range field when you specify a range,.
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You could also enter the range directly in the Cal. Range field.

Overriding the Min. and Max. Variable Values for a Single Optimization Setup

1. In theSetup Optimization dialog box, click theVariables tab.
All of the variables that were selected for optimization analysis are listed.

2. Type a new value in theMin orMax text box for the value you want to override, and then press
Enter.
TheOverride option is now selected. This indicates that the value you entered is used for this
optimization analysis; the variable's currentMin orMax value in the nominal design is ignored.
l Alternatively, you can select theOverride option first, and then type a new value in theMin
orMax text box.

3. Optionally, click a new unit system in one of theUnits text boxes.
To revert to the default minimumandmaximum values, clear theOverride option.

Changing the Min. and Max. Variable Values for Every Optimization Setup

1. Make sure that the variable'sminimumandmaximum values are not being overridden in any
single optimization setup.

2. If the variable is a design variable, do the following: ClickMaxwell3D or Maxwell2D>Design
Properties.
If the variable is a project variable, do the following: ClickProject>Project Variables.
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TheProperties dialog box appears.
3. SelectOptimization.
4. Type a new value in theMin orMax text box for the value you want to override, and then press

Enter.
5. ClickOK.

WhenOptimetrics solves an optimization setup, it does not consider variable values that lie
outside of this range.

Step Size

Tomake the search for theminimum cost value reasonable, the search algorithm is limited in two
ways. First, you do not want the optimizer to continue the search if the step size becomes irrelevant
or small. This limitation impacts the accuracy of the final optimum. Second, in some cases you do not
want the optimizer to take large steps either. In case the cost function is suspected to possess large
variations in a relatively small vicinity of the design space, large stepsmay result in toomany trial
steps, which do not improve the cost value. In these cases, it is safer to proceed with limited size
steps and havemore frequent improvements.
For these two limitations, the optimizer uses two independent distancemeasures. Both are based on
user-defined quantities: theminimumandmaximum step limits for individual optimization variables.
Since the particular step is in a general direction, thesemeasures are combined together in order to
derive the limitation for that particular direction.
The step vector between the ith and (i+1)th iterate is as follows:

The natural distancemeasure is,

which is the Euclidean norm.
A more general distancemeasure incorporates some "stretching" of the design space:,
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where thematrixD incorporates the linear operation of the stretching of design space. The simplest
case is when theDmatrix is diagonal, meaning that the design space is stretched along the
orthogonal direction of the base vectors.
The optimizer stops the search if,

whereDmin consists of diagonal elements
equal to the inverse of theMin. Step value assigned to the corresponding optimization variable.
Similarly the optimizer truncates steps for which

whereDmax has diagonal elements equal to the inverse ofMax. Step values of the corresponding
optimization variables.

Related Topics

Setting theMin. andMax. Step Sizes
Cost Function
Adding a Cost Function

Setting the Min. and Max. Step Sizes

For the Quasi Newton and Pattern Search optimizers, the step size is the difference in a variable's
value between one solved design variation and the next. The step size is determined when
Optimetrics locates the next design variation that should be solved in an effort to meet the cost
function.

1. In theSetup Optimization dialog box, click theVariables tab.
2. Optimetrics displaysMin Step andMax Step columns, with default values for each variable to

be optimized.
3. In theMin Step text box, type theminimum step size value. Optionally, modify the unit system

in theUnits text box.
4. In theMax Step text box, type themaximum step size value. Optionally, modify the unit
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system in theUnits text box.
5. ClickOK.

Hint A value of zero is recommended for theminimum step
size.

Related Topics

Step Size

Setting the Min and Max Focus

For the SNLP, SMINLP andGenetic Algorithm optimizers, themin focus andmax focus criteria
allow you to specify a sub-range of parameter valueswhere the optimizer should lookwhen
performing the optimization. This focus box is where you suspect the optimal solution will be, so it is a
hint for the optimizer.

l The domain limits the search. The domain = physical limits.
l The focus box does not limit the search. Rather, the Focus box = an initial guess of optimum
search domain. The starting point is the center of the focus box, but the search does extend
beyond the box.

l This focusmust be inside the domain limits. Consequently, it has to be equal or smaller size.
An error message is generated if you specify a focus outside the domain.

l The focus boxmust be at least one hundredth of the domain size. Otherwise, an error
message is sent.

Equalizing the influence of different optimization variables.

The optimizer seeks optimal values for the optimization variables. These variables are usually
quantities with specified units. The change in one variable could bemeasured in [mm] and the
change in other variable could bemeasured in [mA]. Instead of those units, the optimizer uses
internal abstract units, so that a change in one variable changes the design behavior about asmuch
as the same change in another variable, where changes aremeasured in the respective internal
abstract units. When you define the focus box, the unit of the abstract internal unit is defined as the
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difference of the upper and lower focus limits. This way you can use the focus box to equalize the
influence of different optimization variables on the design behavior.

To set the Min and Max Focus values:

1. In theSetup Optimization dialog box, click theVariables tab.
2. Optimetrics displaysMin. Focus andMax. Focus columns, with default values for each

variable to be optimized.
If you do not have an initial guess based on your knowledge of the problem, make the focus
box equal to the domain; that is, the physical limits. This tells SNLP to search the entire
decision space.
l In theMin. Focus text box, type theminimum value of the focus range. Optionally, modify
the unit system in theUnits text box.

l In theMax. Focus text box, type themaximum value of the focus range. Optionally, modify
the unit system in theUnits text box.

l ClickOK.

Solving a Parametric Setup Before an Optimization

Solving a parametric setup before an optimization setup is useful for guiding Optimetrics during an
optimization.
To solve a parametric setup before an optimization setup:

1. In theSetup Optimization dialog box, click theGeneral tab.
2. In theParametric Analysis pull-down list, click the parametric setup you want Optimetrics to

solve before optimization.
Note The parametric setupmust include sweep definitions for the variables you are

optimizing.

3. SelectSolve the parametric sweep before optimization.
If the parametric setup has not yet been solved, Optimetrics solves it. Optimetrics uses the cost value
evaluated at each parametric design variation to determine the next step in the optimization analysis.
This enables you to guide the direction in which the optimizer searches for the optimal design
variation.

Related Topics

Solving a Parametric Setup During anOptimization

Solving a Parametric Setup During an Optimization

Solving a parametric setup during an optimization analysis is useful when you want Optimetrics to
solve every design variation specified in the parametric setup at each optimization iteration. A cost
function goal could then depend on the value of the variable swept in the parametric setup.
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To solve a parametric setup during an optimization analysis:
1. In theSetup Optimization dialog box, click theGeneral tab.
2. In theParametric Analysis pull-down list, click the parametric setup you want Optimetrics to

solve during an optimization.
3. SelectSolve the parametric sweep during optimization.
4. Optionally, you can adjust the sweep values to be used during the optimization.

a. Click on theGoal tab, clickSetup Calculations to specify a calculation.
TheAdd/Edit Calculation dialog box is displayed.

b. Click theCalculation Range tab.
c. Click theEdit button for the sweep to bemodified.
d. In the pop-up dialog box, select the sweep values to use.
e. Close the pup-up dialog box. ClickDone to close theAdd/Edit Calculation dialog.

Automatically Updating a Variable's Value After Optimization

WhenOptimetrics finds an optimal variable value by solving an optimization setup, it can
automatically update that variable's current value set for the nominal model to the optimal value.

1. In theSetup Optimization dialog box, click theGeneral tab.
2. SelectUpdate design parameters' values after optimization.

When optimization is complete, the current variable value for each optimized variable is
changed to the optimal value.

Changing the Cost Function Norm

You can select the norm to be used in the calculation of the cost goal.
1. In theSetup Optimization dialog box, click theGoals tab.
2. SelectShow Advanced Options.
3. Select a norm from the pull-down in theCost Function Norm Type field. The options are L1,

L2, andMaximum. L2 is the default.

Related Topics

Explanation of L1, L2 andMaxNorms in Optimization
Cost Function

Explanation of L1, L2 and Max norms in Optimization

When you set multiple goals for an optimization, the question arises as to what is actually going to
drive the optimizer which is not amulti-objective one. The cost function will have a lot to do with it.

Optimetrics 25-53
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

The following discussion explains how the cost function is put together when there aremultiple
goals.
The general goal setting structure in Optimetrics is a logical sentence with the format:

Calculation(i)Condition(i)Goal(i)Weight(i)
The cost function that the optimizer uses is built based on the norm setting as long as there are
multiple goals and none of those use the “minimize” or “maximize” conditions. Thus, in this case the
error associated with each individual goal (weighted) is combined in a way that is specific for each
norm type chosen.
For L1 norm the actual cost function uses the sum of absolute weighted values of the individual goal
errors:

For L2 norm the actual cost function uses the weighted sum of absolute values of the individual

For theMaximum norm the cost function uses themaximumamong all the weighted goal errors:

For all the above situationsN is the number of individual goalswiεi are individual weighting factors
and residual error respectively. A minimization of the cost function is performed during optimization
since it makes sense tominimize the error in the sense of the chosen norm type.
The graphical representation of the error is possible and depends upon the actual condition being
used. If a “<” condition is used, the error can be represented as below:
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If a “>” condition is used, the error can be represented as below:

If a “=” condition is used, the error is double-sided and can be represented as below:

The norm type doesn’t impact goal setting that use as condition the “minimize” or “maximize”
scenarios. Note that when using “minimize” or “maximize” settings for the condition there should be a
single goal setting which in this case coincideswith the cost function.
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Related Topics

Cost Function

Advanced Genetic Algorithm Optimizer Options

TheGenetic Algorithm (GA) search for Optimization analysis is an iterative process that goes
through a number of generations. In each generation some new individuals (Children / Number of
Individuals) are created and the so grown population participates in a selection (natural-selection)
process that in turn reduces the size of the population to a desired level (Next Generation / Number
of Individuals).
If you select the Genetic Algorithm for anOptimization analysis, aSetup button is enabled on the
Setup Optimization page.

1. Click theSetup button to open theAdvanced Genetic Algorithm Optimizer Options
dialog.

2. Select the Stopping Criteria. Any of the three following, or any combination of these can be
selected.
l Maximum number of generations. If checked, this enables a value field.
l Elapsed time. If checked, this enables a drop downmenuwith times ranging from five
minutes to two weeks.

l Slow convergence.
3. Specify the Parents.

The first step towardsmating is a selection process that determines the participating
individuals. Potential parents are selected from the Current Generation. This is a set of
individuals that is always a subset of the current generation.
l Number of individuals value field -- specify the number of parents for the optimizer to
use. You can set the Number of Individuals to less than or equal to the size of the "Current
Generation". One reason to consider fewer parents than the possible maximum is to steer
the GA towards improvement by selecting the better portion of the current generation to be
able tomate.

l Roulette selection check box -- if checked, this enables the Selection pressure value
field. This number defines how many timesmore probable is the selection of the best
individual over the worst individual in an elementary spin of the roulette wheel.

4. Specify theMating pool.
TheMating pool is created by selecting randomly from the parents, but with each selection, the
parent gets "cloned" so it can be selected again and again.
l Number of individuals field -- specify the number individuals to include in themating pool.

l Reproduction setup-- this button opens theGenetic Algorithm Optimizer
Reproduction Setup dialog.
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5. Click theReproduction setup button for the dialog to specify the Crossover setup, and the
Mutation setup.
The crossover andmutation operator have different roles:Crossovermixes "features" of the
parents in a new combination, whilemutation slightly alters the "features" of the individuals.
Both need to be present in a GA. The crossover is a way to discover new combinationswhile
themutation acts as a local search or fine-tuning step. Mutation also keeps diversity in a
population, which is amust for GA.
The crossover operator has two steps. It first alters the variable values of the parents
according to a distribution. This tends to produce one child that looks a lot like one parent, and
one child that looks a lot like the other parent. Next, some of the variable values of the two
children can be exchanged in order to achievemore variation.
For crossover there are four possible parameters.
a. Individual Crossover Probability determines, for each pair in themating pool, the

probability that their featureswill bemixed. Usually, this probability should be close or
equal to one. If you set it set less than one, some parents will produce two children which
are exact clones of the parents. Thismeans that some children inherit all the features of
their parents unchanged.

b. Parents often havemultiple variables. If the parent is a candidate for mixing, theVariable
Crossover Probability determines, for each variable, the probability of mixing. This is
usually set high to ensure that most or all variablesmix.

c. Variable Exchange Probability: After the slight change in the variable values has been
made, the crossover operation is also able to exchange the values of the variables
between the two children that are being constructed. The Variable Exchange Probability
governs the likelihood of exchange of any variable.

d. Mu is a general parameter defining the sharpness of the distribution that might be used for
theVariable Crossover Probability. Mu should be greater than one. There is no
theoretical upper limit, but we recommend not exceeding 30.

6. Select one of the fourCrossover types from the drop-downmenu.
The crossover type selected affects the options available.

Uniform Individual crossover
probability
Variable crossover probability

One point Individual crossover
probability

Two point Individual crossover
probability

Simulated binary
crossover

Individual crossover
probability
Variable crossover probability
Variable exchange probability
Mu
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7. Select theMutation type--this can be one of three types, which you select from a drop-down
menu.
l Uniform Distribution
l Gaussian Distribution
l Polynomial Mutation.

8. For the selectedmutation type, set the following parameters:
l Uniform Mutation Probability: If this ismore than zero (recommendation is to have still a
small probability here), then there will be some children whose features are simply a
completely random design (design variables randomly selected over the domain).

l Individual Mutation Probability controls, for each child, the likelihood of amild mutation.
l Variable Mutation Probability. If the child will bemutated, this probability controls at the
variable level the likelihood of amutation of the variables.

l Standard Deviation is the standard deviation of the selected distribution that is being used
for themutation and it ismeasured relatively to the optimization-domain.

9. When you have completed the Reproduction setup in theGenetic Algorithm Optimizer
Reproduction Setup dialog, clickOK to close it and return to the Advanced Genetic
Algorithm Optimizer Options dialog.

10. In the Advanced Genetic Algorithm Optimizer Options dialog, specify the children as a
Number of Individuals.

11. Set thePareto Front value.
This the number of the very best individuals (identified relative to the cost function) to keep for
future generations.

12. Set the Next Generation parameters. The Next Generation is selected from the Parents, the
children, and the Pareto front.
l Number of individuals value field -- specify the number of individuals to survive to form
the next generation for the optimizer to use.

l Roulette selection check box -- if checked, this enables the Selection pressure value
field. This number defines how many timesmore probable is the selection of the best
individual over the worst individual in an elementary spin of the roulette wheel.

13. ClickOK to accept the settings for the Genetic Algorithm and to close the dialog.

Related Topics

Setting up anOptimization Analysis
Adding a cost function
Optimization Overview
Acceptable Cost
Explanation of L1, L2, andMaxNorms in Optimization
Choosing anOptimizer
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Sensitivity Analysis Overview
During a sensitivity analysis, Optimetrics explores the vicinity of the design point to determine the
sensitivity of the design to small changes in variables. The variables and their attributes define the
design point, the problem around which the sensitivity analysis is performed.
WhenOptimetrics performs a sensitivity analysis, its goal is to calculate the second-order regression
polynomials for all of the design's output parameters. The algorithm first determines an appropriate
interval for each variable. The intervals are further sub-divided according to the available number of
iterations and variables. If themaster output is not used, the specified initial displacement values
define those intervals.
When all of the design calculations are complete, the second-order polynomials are fitted for all the
output parameters. Optimetrics then reports the following quantities:

l Regression value at the current variable value.
l First derivative of the regression.
l Second derivative of the regression.

Related Topics

Setting Up a Sensitivity Analysis
Selecting aMaster Output

Selecting a Master Output

During a sensitivity analysis, the design variations that Optimetrics selects to solve are close to the
design point, but not so close that numerical noise (from the finite element mesh) affects the analysis.
The algorithm that Optimetrics uses to determine the design variations to solvemust be based on
only one output parameter and that output parameter's numerical noise. Therefore, if you have
definedmore than one output parameter, be sure to selectMaster Output for the output variable on
which you want the selection of design variations to be based.

Related Topics

Setting Up anOutput Parameter
Setting Up a Sensitivity Analysis

Setting Up a Sensitivity Analysis
Following is the general procedure for setting up a sensitivity analysis. Once you have created a
setup, you canCopy andPaste it, and thenmake changes to the copy, rather than redoing the
whole process for minor changes. You can create a sensitivity setup before defining variables but all
variablesmust be defined before you start the sensitivity analysis.
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1. Before a variable can be included in a sensitivity analysis, youmust specify that you intend for
it to be used during a sensitivity analysis in theDesignProperties dialog box.

2. On theMaxwell3D or Maxwell2D menu, point toOptimetrics Analysis, and then clickAdd

Sensitivity .
TheSetup Sensitivity Analysis dialog box appears.

3. Under theCalculations tab, type themaximumnumber of iterations per variable value that
you want Maxwell to perform in theMax. No. of Iterations/Sensitivity Variable text box.

4. Set up an output parameter calculation and select aMaster Output
5. Specify the value of the design point at which the sensitivity analysis should stop in the

Approximate Error in Master Output text box.
6. In theVariables tab, specify theMin/Max values for variables included in the optimization,

and the Initial Displacement (Initial Disp.) for the analysis.
Youmay also override the variable starting values by clicking theOverride check box and
entering the desired value in theStarting Value field.

7. In theGeneral tab, specify whether Optimetrics should use the results of a previous
Parametric analysis or perform one as part of the optimization process.

8. Under theOptions tab, if you want to save the field solution data for every solved design
variations in the optimization analysis, selectSave Fields And Mesh.
Note Do not select this option when requesting a large number of iterations as the data

generated will be very large and the systemmay become slow due to the large I/O
requirements.

Youmay also selectCopy geometrically equivalent meshes to reuse themesh when
geometry changes are not required, for example when optimizing on amaterial property or
source excitation.This will provide some speed improvement in the overall optimization
process.

The following optional sensitivity analysis setup options can also be used:
l Modify the starting variable value.
l Modify theminimumandmaximum values of variables that will be solved.
l Exclude variables from the sensitivity analysis.
l Set the initial displacement.
l Modify the values of fixed variables that are not beingmodified during the sensitivity
analysis.

l Set linear constraints.
l Request that Optimetrics solve a parametric sweep before a sensitivity analysis.
l You can also request that Optimetrics solve a parametric sweep during a sensitivity
analysis.

l SetHPC and Analysis Options, which allows you to select or create an analysis
configuration.

Note Sweeping or using a complex variable is not allowed in any optimetrics setup, including
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optimization, statistical, sensitivity, and tuning setups.

Related Topics

Sensitivity Analysis Overview
Setting theMaximum Iteration Per Variable

Setting the Maximum Iterations Per Variable

TheMax. No. of Iterations/Sensitivity Variable value is themaximumnumber of design
variations that Optimetrics solves per variable during a sensitivity analysis. This value is a stopping
criterion; if themaximumnumber of iterations has been completed, the sensitivity analysis stops. If
themaximumnumber of iterations has not been completed, the sensitivity analysis continues by
performing another iteration, that is, by solving another design variation. It performs iterations until
the approximate error in master output value is reached or until Optimetrics cannot proceed as a
result of other sensitivity setup constraints, such aswhen it searches for a variable value that is larger
than themaximum value.
To set themaximumnumber of iterations for a sensitivity analysis:

l Under theCalculations tab of theSetup Sensitivity Analysis dialog box, type a value in the
Max. No. of Iterations/Sensitivity Variable text box.

Related Topics

Setting Up anOutput Parameter

Setting Up an Output Parameter

Following is the general procedure for adding an output parameter to a sensitivity setup:
1. Under theCalculations tab of theSetup Sensitivity Analysis dialog box, clickSetup

Calculations to open theAdd/Edit Calculations dialog box.
2. In theAdd/Edit Calculations dialog box, set up output parameter calculations to be

evaluated for sensitivity.
3. Tomodify the solution fromwhich the output parameter is to be extracted, click in the

Solution column and select from the options in the pop-up list.
4. You canmodify the Calculation specified by clicking on the output parameter in the table and

selectingEdit.
5. For output parameters based on swept variable, youmust choose a single value in the

Calculation Range at which to evaluate the output parameter.
6. If you havemore than one output parameter, selectMaster Output if you want Optimetrics to

use the output parameter to base its selection of solved design variations.
Note During a sensitivity analysis, the design variations that Optimetrics selects to solve
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are close to the design point, but not so close that numerical noise (from the finite
element mesh) affects the analysis. The algorithm that Optimetrics uses to
determine the design variations to solvemust be based on only one output
parameter and that output parameter’s numerical noise. If you have definedmore
than one output parameter, be sure to selectMaster Output for the output variable
on which you want the selection of design variations to be based.

Related Topics

Selecting aMaster Output

Specifying a Solution Quantity for an Output Parameter

When setting up an output parameter, youmust identify the solution quantity on which to base the
output parameter. Solution quantities are specified bymathematical expressions that are composed
of basic quantities, such asmatrix parameters; and output variables.
TheAdd/Edit Calculation dialog box allows you to define themathematical equation for one or
multiple output parameters. To set up an output parameter:

1. In theContext section of the dialog:
l Select theReport Typewith a pull-down selection list containing the available types for this
design.

l Select theSolution from the drop down selection list. This lists the available setups and
sweeps. As aminimum, the LastAdaptive solution is available.

l Select theGeometry from the drop down selection list or select none (the default). This
modifies the list of quantities available to the ones that apply to the specific geometry.

l When selecting a geometry, youmay also be required to specify a point within the geometry
where the calculation is to be performed.

2. TheOutput Variables button opens theOutput Variables dialog box allowing you to create
special output variables to be used in the output parameter.

3. TheCalculation Expression field in the Trace tab is used to enter the equation to be used
for the output parameter. To enter an expression, youmay type it directly into the field or use
theCategory,Quantity, and Function lists as follows:
l Select theCategory, these depend on the Solution type and the design. This lets you
specify the category of information to be used in the output parameter.

l Select aQuantity from the list. Available quantities depend upon the Solution type, aswell
as the Geometry and Category selection. Selecting aQuantity automatically enters it into
the Calculation Expression field.

l Select a Function to apply to the value in the calculated expression.
l For swept variables, the Range Function button opens theSet Range Function dialog to
apply functions to the expression that apply over the sweep range.

4. TheCalculation Range tab applies to swept variables and allows you to specify the range of
the sweep over which to apply the calculation.
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5. When the desiredCalculation Expression has been obtained, click theAdd Calculation
button to add the entry to the calculation table in the Setup Sensitivity Analysis dialog box. You
may addmultiple entries to the table simply by changing theCalculation Expression and
using theAdd Calculation button.

6. To update or edit a selected cost function, enter the desired Calculation Expression and click
theUpdate Calculation button.

7. ClickDone to return to the Setup Sensitivity Analysis dialog box.
Note The solution quantity you specifymust be able to be evaluated to a single, real

number.

Related Topics

Setting the Calculation Range of anOutput Parameter

Setting the Calculation Range of an Output Parameter

The calculation range of a solution quantity determines the intrinsic variable value at which the
solution quantity is to be extracted. For a sensitivity setup, the calculation rangemust be a single
value. If you specified that the solution quantity be extracted from a frequency sweep solution, by
default, Optimetrics uses the starting frequency in the sweep.

1. Under theCalculations tab of theSetup Sensitivity Analysis dialog box, click in the
Calculation Range column of the table for the calculation to be modified.
TheEdit Calculation Range dialog box appears.

2. In the table, click theEdit button in the row to bemodified.
If you choose to solve a parametric setup during the sensitivity analysis, the variables swept in
that parametric setup are available in the pop-up list dialog box. If you sweep a variable in the
parametric setup that is also a sensitivity variable, that variable is excluded from the sensitivity
analysis.

3. Click on the value for the calculation range in the list and dismiss the pop-up dialog
box.

4. ClickOK in the Edit Calculation Range dialog box to accept the new value for the
intrinsic variable, and return to the Setup Sensitivity Analysis dialog box.

Related Topics

Setting Up anOutput Parameter

Modifying the Starting Variable Value for Sensitivity Analysis

The design point of the sensitivity analysis is the starting value of the sensitivity variable and is usually
the first variation to be solved. Optimetrics automatically sets the starting value of a variable to be the
current value set for the nominal design. You canmodify the design point for each sensitivity setup.
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Warning Variable valuesmust be single real numbers, or expressions that evaluate to single real
numbers. Complex numbers cannot be used as the values of variables in any optimetric
analysis.

1. In theSetup Sensitivity Analysis dialog box, click theVariables tab.
All of the variables that were selected for the sensitivity analysis are listed.

2. Type a new value in theStarting Value text box for the value you want to override, and then
pressEnter.
TheOverride option is now selected. This indicates that the value you entered is to be used
for this sensitivity analysis; the current value set for the nominal model will be ignored.
l Alternatively, you can select theOverride option first, and then type a new variable value in
theStarting Value text box.

3. Optionally, click a new unit system in one of theUnits text boxes.
To revert to the default starting value, clear theOverride option.

Related Topics

Setting Up a Sensitivity Analysis

Setting the Min. and Max. Variable Values

For every sensitivity setup, Optimetrics automatically sets theminimumandmaximum values that it
will consider for a sensitivity variable. Optimetrics sets a variable’sminimum value equal to
approximately one-half its starting value. (The starting value is the variable’s current value set for the
nominal design.) Optimetrics sets the variable’smaximum value equal to approximately 1.5 times the
starting value. During sensitivity analysis, variable values outside this range are not considered.

Warning Variable valuesmust be single real numbers, or expressions that evaluate to single real
numbers. Complex numbers cannot be used as the values of variables in any optimetric
analysis.

Related Topics

Override the default minimumandmaximum variable values for a single sensitivity setup.
Change the default minimumandmaximum variable values for every sensitivity setup.

Overriding the Min. and Max. Variable Values for a Single Sensitivity Setup

1. In theSetup Sensitivity Analysis dialog box, click theVariables tab.
All of the variables that were selected for sensitivity analysis are listed.

2. Type a new value in theMin orMax text box for the value you want to override, and then press
Enter.
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TheOverride option is now selected. This indicates that the value you entered is to be used
for this sensitivity analysis; the variable's currentMin orMax value set in the nominal design is
ignored.
l Alternatively, you can select theOverride option first, and then type a new value in theMin
orMax text box.

3. Optionally, click a new unit system in one of theUnits text boxes.
To revert to the default minimumandmaximum values, clear theOverride option.

Related Topics

Setting Up a Sensitivity Analysis

Changing the Min. and Max. Variable Values for Every Sensitivity Setup

1. Make sure the variable'sminimumandmaximum values are not being overridden in any
sensitivity setup.

2. If the variable is a design variable, do the following: ClickMaxwell3D or Maxwell2D>Design
Properties.
If the variable is a project variable, do the following: ClickProject>Project Variables.
TheProperties dialog box appears.

3. SelectSensitivity.
4. Type a new value in theMin orMax text box for the value you want to override, and then press

Enter.
WhenOptimetrics solves a sensitivity setup, it does not consider variable values that lie
outside of this range.

Related Topics

Setting Up a Sensitivity Analysis

Setting the Initial Displacement

The initial displacement is the difference in a variable's starting value and the next solved design
variation. During the sensitivity analysis, Optimetrics does not consider an initial variable value that is
greater than this step size away from the starting variable value.

1. In theSetup Sensitivity Analysis dialog box, click theVariables tab.
2. Optimetrics displays the Initial Disp. column, with default values for each sensitivity variable.
3. In the Initial Disp. text box, type the initial displacement value. Optionally, modify the unit

system in theUnits text box.
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Related Topics

Setting Up a Sensitivity Analysis

Solving a Parametric Setup Before a Sensitivity Analysis

Solving a parametric setup before a sensitivity setup is useful for guiding Optimetrics in a sensitivity
analysis.
To solve a parametric setup before a sensitivity setup:

1. In theSetup Sensitivity Analysis dialog box, click theGeneral tab.
2. Click the parametric setup you want Optimetrics to solve before the sensitivity setup from the

Parametric Analysis pull-down list.
Note The parametric setupmust include sweep definitions for the sensitivity

variables.

3. SelectSolve the parametric sweep before analysis.
If the parametric setup has not yet been solved, Optimetrics solves it. Optimetrics uses the results (of
the solution calculation you requested under theGoals tab of theSetup Sensitivity dialog box) to
determine the next design variation to solve for the sensitivity analysis.

Related Topics

Setting Up a Sensitivity Analysis

Solving a Parametric Setup During a Sensitivity Analysis

Solving a parametric setup during a sensitivity analysis is useful when you want Optimetrics to solve
every design variation in the parametric setup at each sensitivity analysis iteration. An output
parameter goal could then depend on the value of the variable swept in the parametric setup.
To solve a parametric setup during a sensitivity analysis:

1. In theSetup Sensitivity Analysis dialog box, click theGeneral tab.
2. Click the parametric setup you want Optimetrics to solve during the sensitivity analysis from

theParametric Analysis pull-down list.
3. SelectSolve the parametric sweep during analysis.

Related Topics

Setting Up a Sensitivity Analysis
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Statistical Analysis Overview
Statistical analysis allows you to explore the effects of random combinations of values of selected
variables on selected global or local available analysis results. Therefore, before a variable can be
included in a statistical analysis, youmust specify that you intend for it to be used during a statistical
analysis. For each variable youmust specify the type of distribution (Uniform, Gaussian, Lognormal
or User Defined) and the corresponding parameters of the selected distribution.

Note A statistical analysis is currently limited to using amaximumof 30 variables.

In addition to specifying the variables to be used in the statistical analysis and the parameters of the
chosen distribution, the output quantities of interest also need to be specified. These quantities can
be global ones such as previously defined parameters (Force/torque, inductance / capacitance, etc),
other named quantities, quantities defined in the field calculator as global (such a domain integral of
a certain field quantity) or local (such as field value at a certain location). The calculations to be
performed during the statistical analysis are specified during setup, in amanner similar to other types
of analysis in Optimetrics.
Following the analysis the statistical distribution of the output quantities can be visualized in
histogram format. To access available reports, after the statistical analysis is complete, right click the
respective Statistical analysis setup and selectView Analysis Result.

Related Topics

Setting Up a Statistical Analysis

Setting Up a Statistical Analysis
Following is the general procedure for setting up a statistical analysis. Once you have created a
setup, you canCopy andPaste it, and thenmake changes to the copy, rather than redoing the
whole process for minor changes. You can create a statistical setup before defining variables but all
variablesmust be defined before you start the statistical analysis.

Note A statistical analysis is currently limited to using amaximumof 30 variables.

1. Before a variable can be included in a statistical analysis, youmust specify that you intend for it
to be used during a statistical analysis in theProperties dialog box.

2. On theMaxwell3D or Maxwell2D menu, point to Optimetrics Analysis, and then click

Add Statistical . TheSetup Statistical Analysis dialog box appears.
3. Under theCalculations tab, type themaximumnumber of iterations you want Maxwell to

perform in theMaximum Iterations text box.
4. If you want to specify an initial seed value, select theSpecify initial seed value check box

and enter a positive value in the text box. Each different seed value creates a new statistical
sequence.
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5. Specify a solution quantity to evaluate.
6. In theCalculation text box, set the value at which the solution quantity is to be computed.
7. Optionally, modify the distribution criteria to be used.
8. The following optional statistical analysis setup options can also be used:

l Modify the starting variable value.
l Exclude variables from the statistical analysis.
l Modify the values of fixed variables that are not beingmodified during the statistical
analysis.

l Request that Optimetrics solve a parametric sweep during a statistical analysis.
Note Sweeping or using a complex variable is not allowed in any optimetrics setup,

including optimization, statistical, sensitivity, and tuning setups.

l SetHPC and Analysis Options, which allows you to select or create an analysis
configuration.

9. If you want to save the field solution data for the design variations solved during analysis,
selectSave Fields.

Related Topics

Statistical Analysis Overview

Setting the Maximum Iterations for a Statistical Analysis

TheMaximum Iterations value is themaximumnumber of design variationsOptimetrics solves
during a statistical analysis. This value is a stopping criterion; if themaximumnumber of iterations
has been completed, the analysis stops. If themaximumnumber of iterations has not been
completed, Optimetrics continues by performing another iteration, that is, by solving another design
variation.
To set themaximumnumber of iterations for a statistical analysis:

l Under theCalculations tab of theSetup Sensitivity Analysis dialog box, type a value in the
Maximum Iterations text box.

Related Topics

Setting up a Statistical Analysis

Specifying an Initial Seed Value for a Statistical Analysis

The Initial Seed Value is a positive integer used as the starting point during a statistical analysis.
When you enter a new seed value, a new statistical sequence is created.
To set an initial seed value for a statistical analysis:

l Under theCalculations tab of theSetup Sensitivity Analysis dialog box, select the
Specify initial seed value check box and type a positive value in the text box.
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Related Topics

Setting up a Statistical Analysis

Specifying the Solution Quantity to Evaluate for Statistical Analysis

When you add a statistical setup, you can identify one or more solution quantities to evaluate. The
solution quantities are specified bymathematical expressions that are composed of basic quantities.
When you view the results, Maxwell displays the distribution of the solution quantities.

1. In theCalculations tab of theSetup Statistical Analysis dialog box, click
SetupCalculations.
TheAdd/Edit Calculations dialog box is displayed, allowing you to define one or more
mathematical expressions for statistical evaluation.

2. In theContext section of the dialog:
l Select theReport Typewith a pull-down selection list containing the available types for this
design.

l Select theSolution from the drop down selection list. This lists the available setups and
sweeps. As aminimum, the LastAdaptive solution is available.

l Select theGeometry from the drop down selection list or select none (the default). This
modifies the list of quantities available to the ones that apply to the specific geometry.

l When selecting a geometry, youmay also be required to specify a point within the geometry
where the calculation is to be performed.

3. TheOutput Variables button opens theOutput Variables dialog box allowing you to create
special output variables to be used in the output parameter.

4. TheCalculation Expression field in the Trace tab is used to enter the equation to be used
for the solution quantities. To enter an expression, youmay type it directly into the field or use
theCategory,Quantity, and Function lists as follows:
l Select theCategory, these depend on the Solution type and the design. This lets you
specify the category of information to be used in the output parameter.

l Select aQuantity from the list. Available quantities depend upon the Solution type, aswell
as the Geometry and Category selection. Selecting aQuantity automatically enters it into
the Calculation Expression field.

l Select a Function to apply to the value in the calculated expression.
l For swept variables, the Range Function button opens theSet Range Function dialog to
apply functions to the expression that apply over the sweep range.

5. TheCalculation Range tab applies to swept variables and allows you to specify the range of
the sweep over which to apply the calculation.

6. When the desiredCalculation Expression has been obtained, click theAdd Calculation
button to add the entry to the calculation table in the Setup Statistical Analysis dialog box. You
may addmultiple entries to the table simply by changing theCalculated Expression and
using theAdd Calculation button.
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7. To update or edit a selected cost function, enter the desired Calculation Expression and click
theUpdate Calculation button.

8. ClickDone to return to the Setup Statistical Analysis dialog box.
Note The solution quantity you specifymust be able to be evaluated to a single, real

number.

Related Topics

Setting up a Statistical Analysis
Setting theMaximum Iterations for a Statistical Analysis

Setting the Solution Quantity's Calculation Range

The calculation range of a solution quantity determines the intrinsic variable value at which the
solution quantity is extracted. For a statistical setup, the calculation rangemust be a single value. If
you specified that the solution quantity be extracted from a frequency sweep solution, Optimetrics
will use the starting frequency in the sweep by default.The calculation range should be set during the
setup of the solution quantity for statistical evaluation. In order to modify the calculation range, do the
following:

1. Under theCalculations tab of theSetup Statistical Analysis dialog box, click in the
Calculation Range column of the table for the calculation to be modified.
TheEdit Calculation Range dialog box appears.

2. In the table, click theEdit button in the row to bemodified.
If you choose to solve a parametric setup during the statistical analysis, the variables swept in
that parametric setup are available in the pop-up list dialog box. If you sweep a variable in the
parametric setup that is also a statistics variable, that variable is excluded from the statistics
analysis.

3. Click on the value for the calculation range in the list and dismiss the pop-up dialog
box.

4. ClickOK in the Edit Calculation Range dialog box to accept the new value for the
intrinsic variable, and return to the Setup Statistical Analysis dialog box.

Related Topics

Setting up a Statistical Analysis

Setting the Distribution Criteria

For every statistical setup, Optimetrics automatically sets the distribution criteria to be uniformwithin
a 10% tolerance of the variable's starting value. You canmodify the distribution type and criteria for a
single statistical setup or for every statistical setup.
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Related Topics

Override the default distribution criteria for a single statistical setup.
Change the default distribution criteria for every statistical setup.

Overriding the Distribution Criteria for a Single Statistical Setup

To override the default distribution criteria for a single statistical setup:
1. In theSetup Statistical Analysis dialog box, click theVariables tab.

All of the variables that were selected for statistical analysis are listed.
2. Check or clear the Include check box for each variable to define the specific variables to be

varied in the statistical analysis setup.
3. For each included variable, selectUniform,Gaussian, Lognormal, orUser Defined in the

Distribution column for the variable you want to override.
If you changed the distribution type, theOverride option is now selected. This indicates that
the distribution type you selected is to be used for this optimization analysis; the current
distribution type selected for the variable in the nominal design is ignored in this statistical
analysis.
l Alternatively, you can select theOverride option first, and then select a different distribution
type in theDistribution text box.

4. Optionally, if you want to change the distribution criteria, click inDistribution Criteria column
for the variable you want to override.
TheEdit Distribution dialog box appears.

5. If the distribution type isGaussian, do the following:
a. Type the lower limit of the distribution in theCutoff Probability text box. This is a value

=>0 and < 0.1.
b. Type themean value of the distribution in theMean text box.
c. Type the standard deviation of the distribution in theStd Dev text box.

Maxwell will solve design variations using aGaussian distribution within the low and high
cutoff values.

6. If the distribution type isUniform, do the following:
l Enter a tolerance value in the text box.

Maxwell will solve design variationswithin the tolerance range of the starting value, using
an even distribution.

7. If the distribution type isLognormal, do the following:
a. Enter the cutoff probability in theCutoff Probability text box.
b. Enter the sigma value of the distribution in theSigma text box and select a unit from the

pull-down.
c. Enter them value of the distribution in theM text box.
d. Enter the theta value in the Theta text box and select a unit from the pull-down.
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8. If the distribution type is User Defined, do the following:
a. Enter the cutoff probability in theCutoff Probability text box.
b. ClickEdit XY Data to open theEdit Datasets dialog box in which you can select an

existing dataset, or create a new one.
9. By default, all variables are set to sample using Latin Hypercube sampling. This sampling

method provides for greater variability than random sampling by keeping track of chosen
samples and guaranteeing that samples cannot be repeated. Youmay revert to random
sampling by clearing the check box in the Latin Hypercube column for any desired variable.

10. ClickOK.
To revert to the default distribution settings, clear theOverride option.

Related Topics

Statistical Cutoffs

Changing the Distribution Criteria for Every Statistical Setup

To change the default distribution criteria for every statistical setup:
1. Make sure that the variable's distribution criteria are not being overridden in any statistical

setup.
2. If the variable is a design variable, do the following: On theMaxwell3D or Maxwell2Dmenu,

clickDesign Properties.
If the variable is a project variable, do the following: ClickProject>Project Variables.
TheProperties dialog box appears.

3. SelectStatistics.
4. Click in theDistribution column for the variable you want to change, and then select

Uniform,Gaussian, Lognormal, orUser Defined.
5. Optionally, if you want to change the distribution criteria, click in theDistribution Criteria

column for the variable you want to change.
If the distribution type isGaussian, theGaussian Distribution dialog box appears. If the
distribution type isUniform, theUniform Distribution dialog box appears.

6. If the distribution type isGaussian, do the following:
a. Type the lower limit of the distribution in theCutoff Probability text box. This is a value

=>0 and < 0.1.
b. Type themean value of the distribution in theMean text box.
c. Type the standard deviation of the distribution in theStd Dev text box.

Maxwell will solve design variations using aGaussian distribution within the low and high
cutoff values.

7. If the distribution type isUniform, do the following:
a. Type a cutoff probability value in theCutoff Probability text box.
b. Typemean and tolerance values in the corresponding text boxes.
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Maxwell will solve design variationswithin the tolerance range of the starting value, using
an even distribution.

8. If the distribution type isLognormal, do the following:
a. Type a cutoff probability value in theCutoff Probability text box.
b. Type values for Sigma, M, and Theta in the corresponding text boxes.

9. If the distribution type isUser Defined, do the following:
a. Type a cutoff probability value in theCutoff Probability text box.
b. ClickEdit XY Data to open theEdit Dataset dialog.
c. Either type or import the X and Y data values for the distribution in theEdit Dataset

dialog.
10. ClickOK.

Related Topic
Statistical Cutoffs

Statistical Cutoffs

The cutoff probability values affects the Gaussian distribution criteria. This is a value =>0 and < 0.1.
Maxwell solves design variations using aGaussian distribution using a lower limit cutoff probability
and specifiedmean and standard deviation values.

Uniform distributions such as variable “length” above use only the Tolerance value, and do not have
a cutoff probability.
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Edit Distribution

When setting the distribution type for a variable, you have the option of changing the distribution
parameters from the default values.

1. If the distribution type isGaussian, do the following:
a. Type the lower limit of the distribution in theCutoff Probability text box. This is a value

=>0 and < 0.1.
b. Type themean value of the distribution in theMean text box.
c. Type the standard deviation of the distribution in theStd Dev text box.

Maxwell solves design variations using aGaussian distribution within the specifiedmean
and standard deviation values.

2. If the distribution type isUniform, do the following:
a. Type the lower limit of the distribution in theCutoff Probability text box.
b. Type themean value of the distribution in theMean text box.
c. Enter the tolerance in the Tolerance text box.

Maxwell solves design variationswithin the tolerance range of the starting value, using an
even distribution.

3. If the distribution type isLognormal, do the following:
a. Type the lower limit of the distribution in theCutoff Probability text box.
b. Enter the shape parameter of the distribution in theSigma text box.
c. Enter the scale parameter in theM text box. The scale parameter should be set to 1 for the

standard lognormal distribution.
d. Enter the location parameter value for Theta in the text box. The value for a standard

lognormal distribution is 0.
.Maxwell solves design variationswith a logarithmic distribution using the shape, scale
and location parameters provided.
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4. If the distribution type isUser Defined, do the following:
a. Type the lower limit of the distribution in theCutoff Probability text box.
b. Select theEdit XY Data button tomanually define the data distribution using datasets.

Related Topics

Adding Datasets
Changing the Distribution Criteria for Every Statistical Setup
Overriding the Distribution Criteria for a Single Statistical Setup

Modifying the Starting Variable Value for Statistical Analysis

A variable's starting value is the first value that is solved during the statistical analysis. Optimetrics
automatically sets the starting value of a variable to be the current value set for the nominal design.
You canmodify this value for each statistical setup.

Warning Variable valuesmust be single real numbers, or expressions that evaluate to single real
numbers. Complex numbers cannot be used as the values of variables in any optimetric
analysis.

1. In theSetup Statistical Analysis dialog box, click theVariables tab.
All of the variables selected for the statistical analysis are listed.

2. Type a new value in theStarting Value text box for the value you want to override, and then
pressEnter.
TheOverride option is now selected. This indicates that the value you entered is to be used
for this statistical analysis; the current value set for the nominal model will be ignored.
l Alternatively, you can select theOverride option first, and then type a new variable value in
theStarting Value text box.

3. Optionally, click a new unit system in one of theUnits text boxes.
To revert to the default starting value, clear theOverride option.

Related Topics

Setting up a Statistical Analysis
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Solving a Parametric Setup During a Statistical Analysis

Solving a parametric setup during a statistical analysis is useful when you want Optimetrics to solve
every design variation in the parametric setup at each statistical analysis iteration.
To solve a parametric setup during a statistical analysis:

1. In theSetup Statistical Analysis dialog box, click theGeneral tab.
2. Click the parametric setup you want Optimetrics to solve during the statistical analysis from the

Parametric Analysis pull-down list.
3. SelectSolve the parametric sweep during analysis.

Related Topics

Setting up a Statistical Analysis

Using Design of Experiments
Design of Experiments (DOE) is a technique used to scientifically determine the location of sampling
points and is included as part of the Response Surface, Goal DrivenOptimization, and Analysis
systems. Design of Experiments plus amathematical approximation of output parameters lets you:

l Reduce the number of simulations
l Interactively explore the design space before running optimization

Design of Experiments describes the relationship between the design variables and the
performance of the product by using Design of Experiments (DOE), combined with response
surfaces. DOE and response surfaces provide all of the information required to achieve Simulation
Driven Product Development. Once the variation of the performance with respect to the design
variables is known, it becomes easy to understand and identify all changes required tomeet the
requirements for the product.
The goal is to create a response surface by interpolating through calculated points (a best curve fit).
For each design, you can create a response surface for each output parameter. Once the response
surfaces are created, you can share the information can in easily understandable terms: curves,
surfaces, sensitivities, etc. They can be used at any time during the development of the product
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without requiring additional simulations to test a new configuration.

The Design of Experiments feature is integrated inside Electronics Desktop. Combined with
Electronics Desktop‘s distributed solve feature, you can build the response surfaces from the DOE
variation tablemuch faster.
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Selecting a Design of Experiments under Optimization opens a dialog with several tabs:

In the Design of Experiments setup, you select the DOE type, select the Response Surface, specify
goals, view and include variables.
There are a wide range of DOE algorithms or methods available in engineering literature. These
techniques all have one common characteristic: they try to locate the sampling points such that the
space of random input parameters is explored in themost efficient way, or obtain the required
information with aminimumof sampling points. Sample points in efficient locations only reduce the
required number of sampling points and increases the accuracy of the response surface generated.
For more information on the available types of DOE, see Design of Experiments Types.
Once you have set up your input parameters, you can update the DOE, which submits the generated
design points to the analysis system for solution. Design points are solved simultaneously if the
analysis system is set up to do so; sequentially, if not. After the solution is complete, you can update
the Response Surface cell, which generates response surfaces for each output parameter based on
the data in the generated design points.

Note Requirements and recommendations regarding the number of input parameters vary
according to DOE type. For more information, see Number of Input Parameters for DOE
Types.

If you change the Design of Experiments type after doing an initial analysis and preview the Design
of Experiments Table, any design points generated for the new algorithm that are the same as
design points solved for a previous algorithmwill appear as up-to-date. Only the design points that
are different from any previously submitted design points need to be solved.
You should set up your DOE Properties before generating your DOE Design Point matrix. The
following topics describe setting up and solving your Design of Experiments, and viewing the results.

Related Topics

Setting UpDesign of Experiments
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Viewing the Result for Design of Experiments
Setup Calculations for Optimetrics

Setting Up Design of Experiments

The process for setting up a Design of Experiments analysis is as follows:

Choose the Variables for Design Exploration

Youmust define local or project variables asOptimization /Design of Experiments variables for the
Design of Experiments setup to include the variable.

Add the Design of Experiments Setup

Right-click on theOptimetrics icon in the Project tree and selectAdd>Design of Experiments. You
can also useMaxwell 2D (or 3D)>Optimetrics Analysis>Add Design of Experiments.
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The Design of Experiments Setup dialog appears.

It has tabs for:
l Design of Experiments, where you specify the sampling points and associated parameters.
l Table, which shows the sampling points defined by the Design of Experiments settings you
provide. If you select Custom and the Design of Experiments type, you can import data files as
well as add or edit rows. You can also Export files of DOE sampling points you have defined
by anymethod.

l Response Surface, which specifies the Response surface type, and Refinement parameters.
l Calculations, which accessesOptimetrics calculations.
l Goals, including cost functions calculations and norm type.
l Variables, previously defined for Optimization/Design of Experiments as Project or Design
variables, and whether to include them, treat as discrete, whether to UseManufacturable
Variables, and the available Levels.

l Options, to Save Fields andMesh, and whether to copy geometrically equivalent meshes.
Once you have set parameters and clickOK, theDesign of Experiments setup appears under the
Optimetrics icon in the Project tree.

From here you can right click on the DesignOfExperiments setup for the shortcut menu to run
Analyze, Submit Job... or Validate for Large Scale DSO.
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Related Topics

Using Design of Experiments
Design of Experiments Tab
Table Tab for Design of Experiments
Response Surface Tab for Design of Experiments
Variables Tab for Design of Experiments
Setup Calculations for Optimetrics
View Analysis Results for Design of Experiments

Design of Experiments Tab

TheDesign of Experiments tab in the DOE Setup includes selections for defining the sampling points
that define your experiment. Each selection for Design of Experiments type has a different set of
associated parameters so the appearance of the dialog changes to show the parameters for your
selection.
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The Design of Experiments Types available in the Desktop include the following:

Design of
Experiments Types Brief Description (click links for more details)

Optimal Space
Filling(Default)

An optimized Latin Hypercube Samplingmaximizing distance between
experiments.
Several design type criteria are available:

l Max-Min Distance
l Centered L2
l MaximumEntropy

Several sampling types available which determine the number of samples
in the design:

l CCD samples (Central Composite Designs are five level factorial
designs that are suitable for calibrating the quadratic response
model)

l Linear model samples
l Pure quadraticmodel samples
l Full quadraticmodel samples
l User-Defined samples

You also specify aMaximumNumber of Cycles and a RandomGenerator
Seed.

Central Composite
Design

Several design types available:
l Face-Centered
l Rotatable
l VIF-Optimality
l G-Optimality
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Design of
Experiments Types Brief Description (click links for more details)

l Auto-defined
You can also choose a Standard or Enhanced Template.

Box-Behnken
Avoids critical configurations in the corner of the design space.
Maximumnumber of input parameters is 12.

Custom

Lets you customize a DOEmatrix, by editing values, adding or removing
samples, and/or importing samples from aCSV file. Selecting Custom
enables an Import button and the Table tab, as well as buttons toAdd
editable rows orDelete selected rows.
If you previously solved the DOE using one of the other algorithms, those
design points are retained and you can add new design points to the table.
You can also import and export design points into the customDOE Table
from the Parameter Set.

Latin Hypercube
Sampling

Statistical design where no two experiments share input parameters of the
same value.
The samples Type can be:

l CCD Samples
l Linear Model Samples
l PureQuadraticModel Samples
l Full QuadraticModel Samples
l User-Defined Samples, for which you also specify the Number of
Samples.

For each samples type, you also specify a RandomGenerator Seed.

The Table tab provides a preview view of the design points defined by your selections.

Related Topics

Setting UpDesignOf Experiments

Optimal Space Filling Design (OSF)

The goal in Design of Experiments is to determine the smallest sufficient set of points required to
calculate a response surface. Therefore, you choose the type depending on the parametric problem
and targeted response surface. The number of points depends on the number of input parameters,
or is user defined.
Optimal Space-Filling Design (OSF) creates optimal space filling Design of Experiments (DOE)
plans according to some specified criteria. Essentially, OSF is a Latin Hypercube Sampling Design
(LHS) that is extended with post-processing. It is initialized as an LHS and then optimized several
times, remaining a valid LHS (without points sharing rows or columns) while achieving amore
uniform space distribution of points (maximizing the distance between points).
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To offset the noise associated with physical experimentation, classical DOE types such asCCD
focus on parameter settings near the perimeter of the design region. Because computer simulation is
not quite as subject to noise, though, the Optimal Space-Filling (OSF) design is able to distribute the
design parameters equally throughout the design space with the objective of gaining themaximum
insight into the design with the fewest number of points. This advantagemakes it appropriate when a
more complexmeta-modeling technique such as Kriging, Non-Parametric Regression, or Neural
Networks is used.
OSF shares some of the same disadvantages as LHS, though to a lesser degree. Possible
disadvantages of anOSF design are:

l When the CCD Samples sample type is selected, amaximumof 20 input parameters is
supported.

l Extremes, such as the corners of the design space, are not necessarily covered.
l The selection of too few design points can result in a lower quality of response prediction.

The following properties are available for the OSF DOE type.
l Design Type: The following choices are available:

l Max-Min Distance (default): Maximizes theminimumdistance between any two points.
This strategy ensures that no two points are too close to each other. For a small size of
sampling (N), theMax-Min Distance design generally lies on the exterior of the design
space and fill in the interior as N becomes larger. Generally, this is the faster algorithm.

l Centered L2: Minimizes the centered L2-discrepancymeasure. The discrepancy
measure corresponds to the difference between the empirical distribution of the
sampling points and the uniform distribution. Thismeans that the centered L2 yields a
uniform sampling. This design type is computationally faster than theMaximum
Entropy type.

l Maximum Entropy: Maximizes the determinant of the covariancematrix of the
sampling points to minimize uncertainty in unobserved locations. This option often
provides better results for highly correlated design spaces. However, its cost increases
non-linearly with the number of input parameters and the number of samples to be
generated. Thus, it is recommended only for small parametric problems.

l Maximum Number of Cycles: Determines the number of optimization loops the algorithm
needs, which in turns determines the discrepancy of the DOE. The optimization is essentially
combinatorial, so a large number of cycles slows down the process. However, thismakes the
discrepancy of the DOE smaller. For practical purposes, 10 cycles is generally good for up to
20 variables. The valuemust be greater than 0. The default is 10.
l Samples Type: Determines the number of DOE points the algorithm should generate. This
option is suggested if you have some advanced knowledge about the nature of the
metamodel. The following choices are available:
l CCD Samples (default): Supports amaximumof 20 inputs. Generates the same
number of samples a CCD DOE would generate for the same number of inputs. You can
use this to generate a space filling design that has the same cost as a corresponding
CCD design.
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l Linear Model Samples: Generates the number of samples as needed for a linear
metamodel.

l Pure Quadratic Model Samples: Generates the number of samples as needed for a
pure quadraticmetamodel (no cross terms).

l Full Quadratic Samples: Generates the number of samples needed to generate a full
quadraticmodel.

l User-Defined Samples: Specify the desired number of samples.
l Seed Value: Set the value used to initialize the random number generator invoked internally
by the LHS algorithm. Although the generation of a starting point is random, the seed value
consistently results in a specific LHS. This property allows you to generate different samplings
by changing the value or regenerate the same sampling by keeping the same value. The
default is 0.

l Number of Samples: Enabled whenSamples Type is set toUser-Defined Samples.
Specifies the default number of samples. The default is 10.

Related Topics

Setting UpDesignOf Experiments

Central Composite Design (CCD)

The goal in Design of Experiments is to determine the smallest sufficient set of points required to
calculate a response surface. Therefore, you choose the type depending on the parametric problem
and targeted response surface. The number of points depends on the number of input parameters,
or is user defined.
Central Composite Design (CCD) provides a screening set to determine the overall trends of the
metamodel to better guide the choice of options in Optimal Space-Filling Design. The CCD DOE
type supports amaximumof 20 input parameters.
The following properties are available for the CCD DOE type:

l Design Type: By specifying theDesign Type for CCD, you can help to improve the
response surface fit for DOE studies. For each CCD type, the alpha value is defined as the
location of the sampling point that accounts for all quadraticmain effects. The following CCD
design types are available:

l Face-Centered: A three-level design with no rotatability. The alpha value equals 1.0. A
Template Type setting automatically appears, with Standard and Enhanced options.
Choose Enhanced for a possible better fit for the response surfaces.

l Rotatable: A five-level design that includes rotatability. The alpha value is calculated
based on the number of input variables and a fraction of the factorial part. A design with
rotatability has the same variance of the fitted value regardless of the direction from the
center point.

l VIF-Optimality: A five-level design in which the alpha value is calculated byminimizing a
measure of non-orthogonality known as the Variance Inflation Factor (VIF). Themore
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highly correlated the input variable with one or more terms in a regressionmodel, the
higher the VIF.

l G-Optimality: Minimizes ameasure of the expected error in a prediction andminimizes
the largest expected variance of prediction over the region of interest.

l Auto-Defined: Design exploration automatically selects the Design Type based on the
number of input variables. Use of this option is recommended for most cases as it
automatically switches between theG-Optimality if the number of input variables is 5 or
VIF-Optimality otherwise.
However, you can use the Rotatable design if the default option does not provide good
values for the Goodness of Fit from the response surface plots. Additionally, you can use
the Enhanced template if the default Standard template does not fit the response
surfaceswell.

l Template Type: Enabled for the Rotatable and Face-Centered design types. The following
options are available:

l Standard
l Enhanced: Choose this option for a possible better fit for the response surfaces

Related Topics

Setting UpDesignOf Experiments

Box Behnken Design (CCD)

The goal in Design of Experiments is to determine the smallest sufficient set of points required to
calculate a response surface. Therefore, you choose the type depending on the parametric problem
and targeted response surface. The number of points depends on the number of input parameters,
or is user defined.
A Box-Behnken Design is a three-level quadratic design that does not contain fractional factorial
design. The sample combinations are treated in such a way that they are located at midpoints of
edges formed by any two factors. The design is rotatable (or in cases, nearly rotatable).
One advantage of a Box-Behnken design is that it requires fewer design points than a full factorial
CCD and generally requires fewer design points than a fractional factorial CCD. Additionally, a Box-
Behnken Design avoids extremes, allowing you to work around extreme factor combinations.
Consider using the Box-Behnken Design DOE type if your project has parametric extremes (for
example, has extreme parameter values in corners that are difficult to build). Since the Box-Behnken
DOE doesn’t have corners and does not combine parametric extremes, it can reduce the risk of
update failures.
Possible disadvantages of a Box-Behnken design are:

l Prediction at the corners of the design space is poor and that there are only three levels per
parameter.

l Amaximumof 12 input parameters is supported.
No additional properties are available for the Box-Behnken Design DOE type.
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Related Topics

Setting UpDesignOf Experiments

Custom DOE Type

The goal in Design of Experiments is to determine the smallest sufficient set of points required to
calculate a response surface. Therefore, you choose the type depending on the parametric problem
and targeted response surface. The number of points depends on the number of input parameters,
or is user defined.
TheCustom DOE type allows for definition of a customDOE Table. You canmanually add new
design points, entering the input and (optionally) output parameter values directly into the table. If
you previously solved the DOE using one of the other algorithms, those design points are retained
and you can add new design points to the table. You can also import and export design points into
the customDOE Table from the Parameter Set.
You can change the editionmode of the DOE table to edit the output parameter values. You can also
copy and paste data and import data from aCSV file by right-clicking and selecting Import Design
Points.

Related Topics

Setting UpDesignOf Experiments

Latin Hypercube Sampling

The goal in Design of Experiments is to determine the smallest sufficient set of points required to
calculate a response surface. Therefore, you choose the type depending on the parametric problem
and targeted response surface. The number of points depends on the number of input parameters,
or is user defined.
In the Latin Hypercube SamplingDesign DOE type, the DOE is generated by the LHS algorithm,
an advanced form of theMonte Carlo samplingmethod that avoids clustering samples. In a Latin
Hypercube Sampling, the points are randomly generated in a square grid across the design space,
but no two points share the same value. Thismeans that no point shares a row or a column of the
grid with any other point.
Possible disadvantages of an LHS design are:

l When the CCD Samples sample type is selected, amaximumof 20 input parameters is
supported. For more information, see Number of Input Parameters for DOE Types.

l Extremes, such as the corners of the design space, are not necessarily covered. Additionally,
the selection of too few design points can result in a lower quality of response prediction.

Note: TheOptimal Space-Filling Design DOE type is an LHS design that is extended with post-
processing.
The following properties are available for the LHS DOE type:
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l Samples Type: Determines the number of DOE points the algorithm should generate. This
option is suggested if you have some advanced knowledge about the nature of the
metamodel. The following choices are available:

l CCD Samples (default): Supports amaximumof 20 inputs. Generates the same
number of samples a CCD DOE would generate for the same number of inputs. You can
use this to generate a space filling design that has the same cost as a corresponding
CCD design.

l Linear Model Samples: Generates the number of samples as needed for a linear
metamodel.

l Pure Quadratic Model Samples: Generates the number of samples as needed for a
pure quadraticmetamodel (no cross terms).

l Full Quadratic Samples: Generates the number of samples needed to generate a full
quadraticmodel.

l User-Defined Samples: Specify the desired number of samples.
l Seed Value: Set the value used to initialize the random number generator invoked internally
by the LHS algorithm. Although the generation of a starting point is random, the seed value
consistently results in a specific LHS. This property allows you to generate different LHS
samplings (by changing the value) or to regenerate the same LHS sampling (by keeping the
same value). The default is 0.

l Number of Samples: Enabled whenSamples Type is set toUser-Defined Samples.
Specifies the default number of samples. The default is 10.

Related Topics

Setting UpDesignOf Experiments

Table Tab for Design of Experiments

The Table tab for theDesign of Experiments Setup dialog displays a preview of the design points
designed by your selections on theDesign of Experiments tab. There is one column for each
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defined variable. TheExport button lets you create a file of the table in a format you specify.

If you have specified Custom as the Design of Experiments Type, the table is editable and the Table
tab includes buttons for Add and Delete Rows. The added Rows are editable. You can add new
rows by entering values in the * row of the table. You enter values in the input parameter columns.
Once you have entered a value in one column in the * row, the row is added to the table and the
values for the remaining input parameters are set to the initial values of the parameters. You can
then edit that row in the table and change any of the other input parameter values if needed. Output
parameter values are then calculated when the design is solved updated.
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Depending on the context, the tables are read-only and filled automatically or they are partially or
completely editable. The background color of a cell indicates if it is editable or not:

l A gray background indicates a read-only cell
l A white background indicates an editable cell

Output parameter values calculated from a simulation (a design point update) are displayed in black
text.
The CustomTable view also includes an Import button. Import and Export files can be:

l Comma delimited data files, (*.csv)
l Tab delimited data files, (*.tab)
l Ansoft Plot Data files, (.dat)
l Post Processor format data files, (*.txt)

The Table updates automatically when you change your selections on theDesign of Experiments
tab.

Related Topics

CustomDOE Type

Response Surface Tab for Design of Experiments

TheResponse Surface tab for theDesign of Experiments Setup dialog lets you select the
Response Surface type asGenetic Aggregation or Standard Response Surface.

The selection here specifies the refinement applied to the initial Design of Experiments. TheGenetic
Aggregation Response Surface finds the best possible response surface for each output
automatically by combining

l Metamodels
l Settings
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l Kernal Variation
l Polynomial Regression

For each output, a Fitness factor works tominimize error, including cross-validation errors. The
automatic refinement adds design points to the DOE until the response surface accuracymeets user
requirements. You can specify requirements for:

l MaximumRelative Error %
l MaximumNumber or Refinement attempts

You do have the option of selecting Standard Response Surface- Full 2ndOrder Polynomial.
After you have completed an analysis you can view the generated plot.

Related Topics

Setting UpDesignOf Experiments

Variables Tab for Design of Experiments

The Variables tab for theDesign of Experiments Setup dialog displays list of the variables defined
for the Design and Project asOptimetrics/Design of Experiments variables.

The columns list the Variable names, the current Min andMaxValues and Units, and provides
options for the following:
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l Override--check this to override the current design value. Unchecking this causes a dialog to
appear asking you to confirm the return to the design value.

l Include--whether to include the variable in an analysis.
l Discrete--Discrete Variables physically represent different configurations or states of the
model. When checkbox in the Discrete column is checked the button in the “Levels” column
will be enabled. The discrete values can be bounded by amin/man range and/or
manufacturable values. Click the Levels button for the row to edit the Discrete values. An edit
dialog for the variable appears.

l Continuous Variables physically vary in a continuousmanner between a lower and an
upper bound (min/max) defined by the user. With continuous Variables, you can also apply a
Manufacturable Values filter to the Variable. Manufacturable Values represent real-world
manufacturing or production constraints. Theminman valueswill be upper and lower
constraints on the availablemanufacturable values bounded by the range.

l When check box in the “UseManufacturable Values” column is checked the button in the
“Levels” column is enabled. Click the button to edit the values. An edit dialog for the variable
appears.
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Related Topics

Setting UpDesignOf Experiments

View Analysis Result for Design of Experiments

After the Analysis has competed, you can clickView Analysis Result. This opens a dialog that
includes aResult tab that lists the variations and variable values, a solutionProfile tab with start,
stop, time elapsed, andmachines used, aswell as aResponse Surface tab. When you include
more than one variable in the setup, response surface view is available. You can choose any two
variables as the X, Y axis, and choose an output calculation as the Z axis, by clicking the “...” button
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next to the view list box.

From the Response Surface tab, the “View” list box lets you select all available views of the selected
response-surface-setup.

l Refinement points table
l Response points table
l Verification points table
l Goodness of Fit
l Response Curve (see below)
l Response Curve (2D Slices, see below)
l Response Surface

TheUpdate push button is disabled when the response surface is up to date. After the setup, if you
modify a verification point or refinement points, it is enabled. Click this button to re-generate the
response-surface with new settings. It may start new simulations if any of the design points in the
DOE, refinement points, or verification points has not been solved.
Response Curve
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Discrete Variable
If you choose Discrete Variable as the X-axis, a bar chart plot is shown:
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Response Curves (2D Slices)
If you have includedmore than one variable in the setup, the Response Curves (2D) view is
available:

Related Topics

Using Design of Experiments
Setting UpDesign of Experiments

Refinement Points Table

From the Response Surface tab, the “View” list box lets you select all available views of the selected
response-surface-setup. All refinement points are shown in the Refinement Points table:
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Refinement points are points added to your model to enrich and improve your response surface.
They can either be generated automatically with the response surface update or addedmanually, as
described inPerforming a Manual Refinement. As with design points, DesignXplorer must
perform a design point update (a "real solve") in order to obtain the output parameters for the
refinement points.
Upon update, the refinement points are used to build the response surface and are taken into
account for the generation of verification points. Along with DOE points, refinement points are also
used as "learning points" for Goodness of Fit calculations.

Performing a Manual Refinement

Manual refinement is a way to force the response surface to take into account points of your choice,
in addition to the points already in the Design of Experiments. You can insert a refinement point in
the Refinement Points table, and do not need to do an initial solve of the response surface (without
the refinement point) before updating your response surface with your manual refinement. Manual
refinement is available for all response surface types except for SparseGrid.
You can add, delete, or modify refinement points by clicking theAdd orDelete buttons, or by
modifying point values directly in the grid.
Manual Refinement Point can be inserted from the Response point table and Verification Points
Table.

Related Topics

Setting UpDesign of Experiments
Using Design of Experiments

Response Points Table

From the Response Surface tab, the “View” list box lets you select all available views of the selected
response-surface-setup. All Response points are shown in the Response Points table:
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A response point is defined by a snapshot of variable valueswhere output calculation valueswere
calculated in ANSYS DesignXplorer from a response surface. As such, the output calculation(or
cost) values are approximate and calculated from response surfaces.
You can add, delete, save, or export response points by using the command buttons in the dialog or
you canmodify response pointsmanually bymodifying point values directly in the grid.
ClickAdd to Verify orAdd to Refine buttons to insert the selected response point to the
verification table or refinement table.

Related Topics

Setting UpDesign of Experiments
Using Design of Experiments

Verification Points Table

From the Response Surface tab, the “View” list box lets you select all available views of the selected
response-surface-setup. All Verification points are shown in the Verification Points table:
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Verification points enable you to verify that the response surface accurately approximates the output
parameter values; they compare the predicted and observed values of the output parameters.
You can add, delete andmodify Verification pointsmanually.

l Same as add/delete/modify refinement points.
l Insert fromResponse Points Table.

Click theAdd to Refine button to insert the selected response point to the refinement table.
A design point update (that is, a "real solve") calculates each verification point. These verification
point results are then compared with the response surface predictions and the difference is
calculated.
Verification points are useful in validating any type of response surface. In particular, however, you
should always use verification points to validate the accuracy of interpolated response surfaces,
such as Kriging or SparseGrid.
You can add, delete, save, or export verification points by using the command buttons in the dialog or
you canmodify verification pointsmanually bymodifying point values directly in the grid.

Related Topics

Setting UpDesign of Experiments
Using Design of Experiments

Goodness of Fit (Predicted vs Observed Chart)

From the Response Surface tab, the “View” list box lets you select all available views of the selected
response-surface-setup.Response surfaces are built from design points in the Design of
Experiments (DOE) and refinement points (collectively, called "learning points"). TheGoodness of
Fit calculations compare the response surface outputs with the DOE results used to create them.
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The closer the points are to the diagonal line, the better the response surface fits the points.

You can view Goodness of Fit information for any of the output parameters in a response surface. To
do so click the ellipsis button [...] button to bring up this dialog:

Related Topics

Setting UpDesign of Experiments
Using Design of Experiments
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Tuning Overview
Tuning a variable is useful when you want to manuallymodify its value and immediately perform an
analysis of the design. For example, it is useful after performing an optimization analysis, in which
Optimetrics has determined an optimal variable value, and you want to fine tune the value to see how
the design results (for example, traces in a report) are affected.
A design can be updated after a tuning analysis to reflect a design variation solved during a tuning
analysis and the results, including field solutions if you selectSave Fields and Mesh on the
Options tab of the setup.

Related Topics

Tuning a Variable

Tuning a Variable
If you want to ensure that tuning does not resolve variations already solved by an optimization setup,
youmust checkSave Fields and Mesh in theOptions tab of that setup.

1. Before a variable can be tuned, youmust specify that you intend for it to be used during a
tuning analysis in a Project or DesignProperties dialog box.

2. On theMaxwell3D or Maxwell2D menu, clickOptimetrics Analysis>Tune .
The Tune dialog box appears, listing the variables which have been included for tuning.
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3. Clear theReal Time option.
Clearing theReal Time option enables the Tune button. If this option is selected, a simulation
begins immediately after youmove the slider. Otherwise, you use the Tune button to apply the
current values to a simulation.

4. If you want to see updates to an open Report plot while tuning a post processing variable, you
must select theBrowse available variations check box. Selecting Browse available
variations disables the sweep check box, and the fields for minimumandmaximum variable
values. This feature lets you see the effect of changes to the post processing variables on
plotted results.
ClearingBrowse available variations enables the Sweep check box, theminimumand
maximum fields, and changes the Nominal field to Step. See step 6.

5. In theSim. Setups column, select the solution setup you want Maxwell to use when it solves
the specified design variation.
Maxwell solves the analysis using the solution setup you select. If you select more than one,
results are generated for all selected solution setups.
Checking the Tune box for a SimSetup enables the Real Time check box, the Browse
available variations check box, and the Snap radio buttons. Clearing the Tune box disables
those selections.

6. In theNominal text box for the variable you want to tune, type the value of the variable you
want Maxwell to solve, or drag the slider to increase or decrease its value.
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Warning Variable valuesmust be single real numbers, or expressions that evaluate to
single real numbers. Complex numbers cannot be used as the values of variables
in any optimetric analysis.

Alternatively, if you want Maxwell to solve a range of values, specify a linear range of values
with a constant step size:
a. Select theSweep check box.
b. In the text box below theStep value, type the starting value in the variable range.
c. Type the step size, or difference between variable values in the sweep definition, in the

Step text box. The step size determines the number of design variations between the start
and stop values. Maxwell solves themodel at each step in the specified range, including
the start and stop values.

d. In the text box just below the variable name, type a stopping value in the variable range.
7. If you have cleared the Real Time check box, clickTune to apply the changes you havemade

to the variable values.
Note Sweeping or using a complex variable is not allowed in any optimetrics setup,

including optimization, statistical, sensitivity, and tuning setups.

8. Changing a variable value with the sliders of by typing in the text field enables theSave and
Reset buttons.
ClickingSave opens aSave As dialog with a name field, and anApply tuned values to
design check box.
Clicking Reset changes the variable values back to what theywere originally.

9. If you have changed one or more included variables, clickingClose on the Tuning dialog
opens theApply Tuned Variation dialog. This lists the included variables and the values for
each tuning. If you have triedmultiple values, they are listed, and the current value is
highlighted. Select another value to change the highlight. ClickOK to apply the highlighted
values to the design, orDon’t Apply to ignore the changes from the original variable values.
If you have applied variant values, you should see the new values listed in the relevant Design
or Project Properties lists of variables and values, and if the changes affect plots or physical
features of amodel, those changes should also appear.
ClickCancel to close the dialog and go back to the Tune dialog.

Related Topics

Applying a Tuned State to a Design
TuningOverview
Resetting Variable Values after Tuning

Applying a Tuned State to a Design

You can apply the variable values solved during a tuning analysis to the nominal design in one of the
following three ways:
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l When closing the Tune dialog box:
1. ClickClose to exit the Tune dialog box.

TheApply Tuned Variation dialog box appears.

2. Click the design variation you want to apply, and then clickOK.

The variable values from the solved design variation become the current variable values for
the nominal design. If you have applied variant values, you should see the new values listed in
the relevant Design or Project Properties lists of variables and values, and if the changes
affect plots or physical features of amodel, those changes should also be apparent.

l When saving a tuned state.
l When reverting to a tuned state.

Saving a Tuned State

You can save the settings in the Tune dialog box, including the variable values you specified for a
tuning analysis. Saved states are only available during the current session of the Tune dialog box;
they are not stored for the next session.

1. After tuning a variable, clickSave in the Tune dialog box.
A Save As dialog box appears.

2. Type a name for the tuned state in the text box.
3. SelectApply tuned values to design if you want to update themodel to the new variable

values.
4. ClickOK to return to the Tune dialog box.

Related Topics

Reverting to a Saved Tuned State
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Reverting to a Saved Tuned State

You can revert to a group of saved settings in the Tune dialog box, including the variable values you
specified for a specific tuning analysis. Saved states are only available during the current session of
the Tune dialog box; they are not stored for the next session.

1. In the Tune dialog box, clickRevert.
TheRevert dialog box appears.

2. Type the name of the tuned state you want to apply or click a name in the pull-down list.
3. SelectApply tuned values to design if you want to update themodel to the selected tuned

state's variable values.
4. ClickOK to return to the Tune dialog box.

Related Topics

Saving a Tuned State

Resetting Variable Values after Tuning

If you want to reset variable values to the values theywere set to when you started the current
session of the Tune dialog box:

l After tuning a variable, clickReset in the Tune dialog box.
Solutions for the design variations solved during tuning analyses remain available for post
processing.

Saving Field Solutions for Optimetrics Analyses
In order to preserve disk space, by default Maxwell does not save field solution data for every solved
design variation in an optimization analysis. It only saves the field solutions for the nominal design
when an adaptive analysis is specified in the solution setup or when you request that fields be saved
for each solved point in a frequency sweep. If the nominal design is not included in the optimization
analysis, all field solutions are deleted.
To save the fields for all design variations, change the default setting for all projects:

1. Select Tools>Options, and then select eitherMaxwell3D Options or Maxwell2DOption.
The appropriate Options dialog box appears.

2. Under theGeneral tab, selectSave Optimetrics field solutions.
Save Fields is selected by default when you create a new Optimetrics setup.

Related Topics

Saving Field Solutions for a Parametric Setup
Saving Field Solutions for anOptimization Setup
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Saving Field Solutions for a Sensitivity Setup
Saving Field Solutions for a Tuning Analysis
Saving Field Solutions for a Statistical Setup
CopyGeometrically Equivalent Meshes

Saving Field Solutions for a Parametric Setup

In order to preserve disk space, by default Maxwell does not save field solution data for every solved
design variation in a parametric setup. It only saves the field solutions for the nominal design. If the
nominal design is not included in the parametric setup, by default field solutionswill not be available.
To save the fields for all design variations solved during a parametric analysis:

1. EitherAdd Sweep or right click on an existing sweep to open theSetup Sweep Analysis
dialog box.

2. Select theOptions tab.
3. Click theSave Fields And Mesh check box.Optionally, selectCopy geometrically

equivalent meshes and choose whether toSolve with copied meshes only, or toSolve
with copied meshes and continue adaptive passes
Maxwell will save the field solution data for every solved design variation in the parametric
setup.

Related Topics

Saving Field Solutions for Optimetrics Analyses

Saving Field Solutions for an Optimization Setup

In order to preserve disk space, by default Maxwell does not save field solution data for every solved
design variation in an optimization analysis. It only saves the field solutions for the nominal design
when an adaptive analysis is specified in the solution setup or when you request that fields be saved
for each solved point in a frequency sweep. If the nominal design is not included in the optimization
analysis, all field solutions are deleted.
To save the fields for all design variations solved during an optimization analysis:

1. Open anEdit Sweep dialog by either adding a sweep or right-click on a an existing sweep to
view the short cut menu and selecting Properties.

2. Select theOptions tab.
3. Click theSave Fields And Mesh check box.Optionally, selectCopy geometrically

equivalent meshes and choose whether toSolve with copied meshes only, or toSolve
with copied meshes and continue adaptive passes
Maxwell will save the field solution data for every solved design variation in the optimization
setup.
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Related Topics

Saving Field Solutions for Optimetrics Analyses

Saving Field Solutions for a Sensitivity Setup

In order to preserve disk space, by default Maxwell does not save field solution data for every solved
design variation in a sensitivity analysis. It only saves the field solutions for the nominal design when
an adaptive analysis is specified in the solution setup or when you request that fields be saved for
each solved point in a frequency sweep. If the nominal design is not included in the sensitivity
analysis, all field solutions are deleted.
To save the fields for all design variations solved during a sensitivity analysis:

1. Open theSetup Sensitivity Analysis dialog box.
2. Select theOptions tab.
3. Click theSave Fields And Mesh check box. Optionally, selectCopy geometrically

equivalent meshes and choose whether toSolve with copied meshes only, or toSolve
with copied meshes and continue adaptive passes
Maxwell will save the field solution data for every solved design variation in the sensitivity
analysis.

Related Topics

Saving Field Solutions for Optimetrics Analyses

Saving Field Solutions for a Tuning Analysis

In order to preserve disk space, by default Maxwell does not save field solution data for every design
variation solved in a tuning analysis. It only saves the field solutions for the nominal design when an
adaptive analysis is specified in the solution setup or when you request that fields be saved for each
solved point in a frequency sweep. If the nominal design is not included in the tuning analysis, all field
solutions are deleted.
To save the fields for all design variations solved during a tuning analysis:

l In the Tuning dialog box, selectSave Fields.
Maxwell will save the field solution data for every solved design variation in a tuning analysis.

Related Topics

Saving Field Solutions for Optimetrics Analyses
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Saving Field Solutions for a Statistical Setup

In order to preserve disk space, by default Maxwell does not save field solution data for every design
variation solved in a statistical analysis. It only saves the field solutions for the nominal design when
an adaptive analysis is specified in the solution setup or when you request that fields be saved for
each solved point in a frequency sweep. If the nominal design is not included in the statistical
analysis, all field solutions are deleted.
To save the fields for all design variations solved during a statistical analysis:

1. Open theSetup Statistical Analysis dialog box.
2. Select theOptions tab.
3. Click theSave Fields And Mesh check box. Optionally, selectCopy geometrically

equivalent meshes and choose whether toSolve with copied meshes only, or toSolve
with copied meshes and continue adaptive passes
Maxwell will save the field solution data for every solved design variation in the statistical
setup.

Related Topics

Saving Field Solutions for Optimetrics Analyses

Saving Fields Solutions for a Design of Experiments Setup

In order to preserve disk space, by default Maxwell does not save field solution data for every solved
design variation in a Design of Experiments setup. It only saves the field solutions for the nominal
design. If the nominal design is not included in the setup, by default field solutionswill not be
available.
To save the fields for all design variations solved during a Design of Experiments analysis:

1. Open theDesign of Experiments dialog box.
2. Select theOptions tab.
3. Click theSave Fields And Mesh check box. Optionally, selectCopy geometrically

equivalent meshes and choose whether toSolve with copied meshes only, or toSolve
with copied meshes and continue adaptive passes.
Maxwell will save the field solution data for every solved design variation in the Design of
Experiments setup.

Related Topics

Saving Field Solutions for Optimetrics Analyses
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Copying Meshes in Optimetrics Sweeps
An option in the Optimetrics Analysis setups allows you to request Maxwell to copy amesh that was
calculated for one sweep variation for reuse on a geometrically-equivalent sweep variation. For
example, with this option selected a sweep on a scan angle would not need to generatemeshes for
each solution. The option is available on the setups for sweeps on parametrics, optimization,
sensitivity, and statistics.
To copy and reusemeshes on geometrically-equivalent parametric variations:

1. Define a variable for the kind of Optimetrics sweep you intent to setup.
2. SelectMaxwell3D or Maxwell2D and then select the appropriateOptimetrics>Add

command to display aSetup dialog box.
3. Click theOptions tab in the Setup dialog box.
4. SelectCopy geometrically equivalent meshes.

Maxwell will copy themesh solution calculated for a particular parametric sweep for reuse on
each geometrically-equivalent sweep variation.

Note This option is available with all Optimetrics setups, and is applied when these analyses
generate geometrically-equivalent values. However, it is most relevant to parametric
sweep, where such equivalences aremore likely to occur.

TheCopy geometrically equivalent mesh option is not recommended for use when the
frequency is varying, sincemeshing is frequency-dependent. Youmaywish to turn this option off
when the first geometrically equivalent variation requires numerous passes after the initial mesh, but
the other geometrically-equivalent variations require fewer additional passes, so that it is cheaper to
start with the initial mesh each time.

Adding an Expression in the Output Variables Window
When you are in the Output Variables window (after clicking Edit Calculation from the one of the
setup analysis windows), do the following to specify an expression:

1. Type a name for the expression in theName text box.
2. Do the following in theCalculation section of the window to insert a quantity into the

expression:
a. Select theReport Type andSolution from the pull-down lists.
b. Select aCategory,Quantity, and Function from the lists, and click Insert Quantity Into

Expression.
c. If you want to insert a specific pre-defined function, select one from the Function pull-

down list, and click Insert Function.
3. You can also type numbers or expression by hand directly into theExpression area.
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Excluding a Variable from an Optimetrics Analysis
To exclude a variable from being optimized or included in a sensitivity or statistical analysis:

1. Do one of the following:
l In theSetup Optimization dialog box, click theVariables tab.
l In theSetup Sensitivity Analysis dialog box, click theVariables tab.
l In theSetup Statistical Analysis dialog box, click theVariables tab.
All of the independent variables that were selected for the optimization analysis are listed.

2. Clear the Include option for the variable you want to exclude from the analysis.
TheOverride option is now selected. This indicates that, for this optimization analysis, the
variable is not included.

Note Alternatively, you can select theOverride option first, and then clear the Include option for
the variable you want to exclude.

3. ClickOK.

Modifying the Value of a Fixed Variable
If you are not including a variable in an optimization, sensitivity, or statistical analysis, Optimetrics
uses that variable's current value during the analysis.
To override the current value of a fixed variable for anOptimetrics setup:

1. Do one of the following:
l In theSetup Optimization dialog box, click theVariables tab.
l In theSetup Sensitivity Analysis dialog box, click theVariables tab.
l In theSetup Statistical Analysis dialog box, click theVariables tab.

2. ClickSet Fixed Variables.
TheSetup Fixed Variables dialog box appears. Under Fixed Variables, all of the current
independent variable values are listed.

3. Click theValue text box of the variable with the value you want to override.
4. Type a new value in theValue text box, and then pressEnter.

TheOverride option is now selected. This indicates that the value you entered is used for this
Optimetrics setup; the current variable value set for the nominal design is ignored.

Note Alternatively, you can select theOverride option first, and then type a new value in the
Value text box.

5. Optionally, click a new unit system in theUnits text box.
6. ClickOK.

To revert to a default variable value, clear theOverride option.
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Linear Constraints
Once the optimization variables are specified, the optimizer handles each of them as an n-
dimensional vector x. Any point in the design space corresponds to a particular x-vector and to a
design instance. Each design instancemay be evaluated via Finite Element Analysis and assigned a
cost value; therefore, the cost function is defined over the design space (cost(x):Rn→R), where n is
the number of optimization variables.
In practice, a solution of theminimization problem is sought only on a bounded subset of theRn
space. This subset is called the feasible domain and is defined via linear constraints.
Youmay constrain the feasible domain of a design variable by defining linear constraints for the
optimization process. The feasible domain is defined as the domain of all design variables that satisfy
all upper and lower bounds and constraints. Linear constraints are defined by the following
inequalities:

where
l αij are coefficients.
l cj is a comparison value for the jth linear constraint.
l xi is the ith designer parameter.

Related Topics

Setting a Linear Constraint

Setting a Linear Constraint

A linear constraint defines the linear relationship between variables. Setting linear constraints in
Optimetrics is useful for establishing limitations involving linear combinations of variable values.

1. Do one of the following:
l If you are setting up an optimization analysis: In theSetup Optimization dialog box, click
theVariables tab.

l If you are setting up a sensitivity analysis: In theSetup Sensitivity Analysis dialog box,
click theVariables tab.

2. ClickLinear Constraint.
The Linear Constraint dialog box appears.

3. ClickAdd.
TheEdit Linear Constraint dialog box appears.
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4. Click aCoeff text box and type a positive or negative coefficient value.
5. Click a condition, < (less than) or > (greater than), from the pull-down list.
6. Type the inequality value, which should be a constant value, in the text box to the right of the

condition.
7. ClickOK.

You return to the Linear Constraint dialog box. The left-hand side of the constraint appears
in the LHS (left-hand side) column. The condition is listed in theCondition column, and the
inequality value is listed in theRHS (right-hand side) column.

Related Topics

Modifying a Linear Constraint
Deleting a Linear Constraint
Linear Constraints

Modifying a Linear Constraint

1. Do one of the following:
l If you are setting up an optimization analysis: In theSetup Optimization dialog box, click
theVariables tab.

l If you are setting up a sensitivity analysis: In theSetup Sensitivity Analysis dialog box,
click theVariables tab.

2. ClickLinear Constraint.
The Linear Constraint dialog box appears.

3. Click the row listing the constraint you want to modify, and then clickEdit.
TheEdit Linear Constraint dialog box appears.

4. Optionally, click aCoeff text box and type a new coefficient value.
5. Optionally, click a different condition, < (less than) or > (greater than), in the pull-down list.
6. Optionally, type a different inequality value in the text box to the right of the condition, and then

clickOK.
You return to the Linear Constraint dialog box. The new coefficient value, the condition, and
the inequality value appear in the LHS (left-hand side),Condition, andRHS (right-hand side)
columns, respectively.

Deleting a Linear Constraint

1. Do one of the following:
l If you are setting up an optimization analysis: In theSetup Optimization dialog box, click
theVariables tab.

l If you are setting up a sensitivity analysis: In theSetup Sensitivity Analysis dialog box,
click theVariables tab.
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2. ClickLinear Constraint.
The Linear Constraint dialog box appears.

3. Click the row listing the constraint you want to delete, and then clickDelete.
The constraint is deleted.

Running an Optimetrics Analysis
Once you have created all necessaryOptimetrics based analyses, you have several options for
running the simulations.

l To use theAnalyze All command at the Project or design level to simulate the nominal
problem and subsequently run all Optimetrics setups, do the following:

1. In the Project Manager window, right-click on the project or design name.
2. ClickAnalyze All from the shortcut menu.

l To use theAnalyze All command from theOptimetricsmenu to simulate only the Optimetrics
based setups, do the following:

1. In the Project Manager window, right-click onOptimetrics.
2. ClickAnalyze>All from the shortcut menu.

l You can choose to analyze only the setups related to a specific Optimetrics type of analysis. In
order to simulate setups of a specific type, do the following:

1. In the Project Manager window, right-click onOptimetrics.
2. ClickAnalyze>All{TYPE} from the shortcut menu where TYPE is the specific analysis

type of interest, Parametric, Optimization, Sensitivity, or Statistical.

Viewing Analysis Results for Optimetrics Solutions
To view data specific to anOptimetrics solution, in general, do the following:

l In the project tree, right-click the Optimetrics setup for which you want to view the results, and
then clickView Analysis Result on the shortcut menu.
ThePost Analysis Display dialog box appears.

l Select from available setups by using the dropdown selectionmenu.

l Select theResult tab to view results in plot or table form.When you view results in Table form
you can resort the results based on each column. For example, click the Variation column
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head to invert the sort from lowest to highest setup number. Click the variable name column to
resort the results by step value. Click the Cost column head to sort the results from lowest cost
to highest cost. Clicking a column again inverts the current sort.

l Click theOptions button to open a dialog that permits you to specify theMaximumnumber of
significant digits to display when showing the analysis result. The default is 4.

l Select theProfile tab to view start, stop, and elapsed times for each variable, and the analysis
machine for each variation. You can click the column heads to sort the table by variation
number,variable value, start, stop, or elapsed time, or (if you have run a distributed analysis)
machine.

See the help topics in this section for more details about viewing optimization analysis results.

Related Topics

Viewing Solution Data for anOptimetrics Design Variation
Viewing anOptimetrics Solution's Profile Data
Viewing Results for Parametric Solution Quantities
Viewing Cost Results for anOptimization Analysis
ViewingOutput Parameter Results for Sensitivity Analysis
Viewing Distribution Results for Statistical Analysis

Viewing Solution Data for an Optimetrics Design Variation

To view the convergence information, computing resources used, or matrices computed for any
design variation solved during an optimization analysis, youmust first select the design variation in
theSet Design Variation dialog box. This dialog box is accessible from theSolutions Data
window and via theResults>Apply Solved Variation command in theMaxwell3D, Maxwell2D,
or RMxprt menu.

1. ClickMaxwell3D, Maxwell2D, or RMxprt and then select Results>Solution Data.
TheSolutions dialog box appears.

2. Click the browsing dots beside theDesign Variation box.
TheSet Design Variation dialog box appears.

3. Clear theUse nominal design option.
4. Click the design variation for which you want to view the solution data, and then clickOK.

The solution data is displayed in the table.

Related Topics

Viewing anOptimetrics Solution's Profile Data
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Viewing an Optimetrics Solution's Profile Data

At any time during or after the Optimetrics solution process, you can see an overview of the
computing resources or profile data that was used byMaxwell as it solved each design variation. The
profile data indicates the how long each design variation took to solve.
1. In the project tree, right-click the Optimetrics solution setup of interest, and then clickView

Analysis Result on the shortcut menu.
ThePost Analysis Display dialog box appears.

2. Click theProfile tab.
3. Select the Optimetrics setup with the results you want to view from the pull-down list at the top

of the dialog box.
4. Optionally, to examinemore detailed profile data for a specific design variation, do the

following:
a. Click a design variation in the table.
b. ClickSolver Profile.

TheSolutions dialog box appears with the profile data for the selected design variation.
The profile line for thematrix solver is in the following format:

Solver 123

where:
l 1 is the precision type: M (mixed) or D (double)
l 2 is thematrix data type: R (real) or C (complex)
l 3 is the symmetry type: S (symmetric), A (asymmetric), H (hermitian)

Related Topics

Viewing a Solution's Profile
Viewing Solution Data for anOptimetrics Design Variation

Viewing Results for Parametric Solution Quantities

1. In the project tree, right-click the parametric setup for which you want to view the results
calculated for the solution quantities, and then clickView Analysis Result on the shortcut
menu.
ThePost Analysis Display dialog box appears.

2. Select the parametric setup with the results you want to view from the pull-down list at the top
of the dialog box.

3. If it is not already selected, select Table as the view type.
The results for the selected solution quantities are listed in table format for each solved design
variation. The variation column in the table lists the entries in order. Clicking the Vision header
inverts the order. Clicking other headers sorts the entries by value, and clicking again inverts
the order.
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4. Optionally, selectShow complete output name.
The complete name of the solution for which the results are being displayed will be listed in the
column headings.

5. Optionally, click a design variation in the table, and then clickApply (at the far right side of the
dialog box).
The design displayed in the 3D Modeler window is changed to represent the selected design
variation.

Related Topics

Plotting Solution Quantity Results vs. a Swept Variable

Plotting Solution Quantity Results vs. a Swept Variable

To plot solution quantity results versus a swept variable's values on a rectangular (x - y) plot:
1. In the project tree, right-click the parametric setup for which you want to view the results, and

then clickView Analysis Result on the shortcut menu.
ThePost Analysis Display dialog box appears.

2. If it is not already selected, selectPlot as the view type.
3. Select the variable with the swept values you want to plot on the x-axis from theX pull-down

list.
4. Only one sweep variable at a time can be plotted against solution quantity results. Any other

variables that were swept during the parametric analysis remain constant.
Optionally, to modify the constant values of other swept variables, do the following:
a. ClickSet Other Sweep Variables Value.

TheSetup Plot dialog box appears. All of the other solved variable values are listed.
b. Click the row with the variable value you want to use as the constant value in the plot, and

then clickOK.
5. Select the solution quantity results you want to plot on the y-axis from theY pull-down list.

The xy plot appears in the view window.
6. Right-click in the plot area to get the shortcut menu where you can set modify the plots display

properties, print, copy to the clipboard, or export the data to a file.

Viewing Cost Results for an Optimization Analysis

To view cost values versus completed iterations in data table format:
1. In the project tree, right-click the optimization setup for which you want to view the cost results,

and then clickView Analysis Result on the shortcut menu.
ThePost Analysis Display dialog box appears.

2. Under theResult tab, select Table as the view type, if it is not already selected.
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The cost value at each solved design variation is listed in table format.
3. Optionally, click a design variation in the table, and then clickApply.

Maxwell now points to the selected design variation as the nominal solution and as a result, the
design displayed in theModeler window is changed to represent the selected design
variation.
ClickRevert to return the design in the view window to the original value.

Related Topics

Plotting Cost Data for anOptimization Analysis
Viewing Solution Data for anOptimetrics Design Variation

Plotting Cost Results for an Optimization Analysis

To view cost values versus completed iterations in rectangular (x-y) plot format:
1. In the project tree, right-click the optimization setup for which you want to view the cost results,

and then clickView Analysis Result on the shortcut menu.
ThePost Analysis Display dialog box appears.

2. Under theResult tab, selectPlot as the view type.
A plot of the cost value at each iteration appears.

Viewing Output Parameter Results for a Sensitivity Analysis

To view actual output parameter values versus design point in data table format:
1. In the project tree, right-click the sensitivity setup for which you want to view the parameter

results, and then clickView Analysis Result on the shortcut menu.
ThePost Analysis Display dialog box appears.

2. Under theResult tab, select Table as the view type, if it is not already selected.
The following values are listed in table format:
l The regression value of the output parameter at the design point is listed in the Func.
Value column.

l The first derivative of the regression is listed in the 1st D column.
l The second derivative of the regression is listed in the 2nd D column.

3. ClickApply.
Maxwell now points to the selected design variation as the nominal solution and as a result, the
design displayed in theModeler window is changed to represent the selected design
variation.
ClickRevert to return the design in the view window to the original value.
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Related Topics

Plotting Output Parameter Results for a Sensitivity Analysis
Viewing Solution Data for anOptimetrics Design Variation

Plotting Output Parameter Results for a Sensitivity Analysis

To plot output parameter results versus sensitivity variable values on a rectangular (xy) plot:
1. In the project tree, right-click the sensitivity setup for which you want to view the output

parameter results, and then clickView Analysis Result on the shortcut menu.
ThePost Analysis Display dialog box appears.

2. Under theResult tab, selectPlot as the view type.
3. Select the sensitivity variable with the sweep values you want to plot on the x-axis from theX

pull-down list.
4. Select the output parameter results you want to plot on the y-axis from theY pull-down list.

The xy plot appears in thePost Analysis Display dialog box.
The plot displays actual output parameter results for each solved design variation. It also
displays a parabola that best fits these results. The parabola is amore accurate
representation of sensitivity around the design point than any individual solved design
variation.

Viewing Distribution Results for a Statistical Analysis

1. In the project tree, right-click the statistical setup for which you want to view the distribution
results calculated for the solution quantities, and then clickView Analysis Result on the
shortcut menu.
ThePost Analysis Display dialog box appears.

2. Select the statistical setup with the results you want to view from the pull-down list at the top of
the dialog box.

3. To view the results in tabular form, select Table as the view type.
The distribution results for the selected solution quantities are listed in table format for each
solved design variation.

4. Optionally, click a design variation in the table, and then clickApply (at the far right side of the
dialog box).
The design displayed in the 3D Modeler window is changed to represent the selected design
variation.

5. To view the results in graphic format, selectPlot as the view type.
6. Type the number of bins you want to plot on the x-axis.
7. Select the solution quantity for which you want to plot distribution results on the y-axis from the

Y pull-down list.
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A histogram plot appears in thePost Analysis Display dialog box. It displays the distribution
of the selected solution quantity.

8. Optionally, click a design variation in the table, and then clickApply (at the far right side of the
dialog box).
Maxwell now points to the selected design variation as the nominal solution and as a result, the
design displayed in theModeler window is changed to represent the selected design
variation.
ClickRevert to return the design in the view window to the original value.

Related Topics

Plotting Distribution Results for a Statistical Analysis
Viewing Solution Data for anOptimetrics Design Variation

Plotting Distribution Results for a Statistical Analysis

1. In the project tree, right-click the statistical setup for which you want to view the distribution
results calculated for the solution quantities, and then clickView Analysis Result on the
shortcut menu.
ThePost Analysis Display dialog box appears.

2. Select the statistical setup with the results you want to view from the pull-down list at the top of
the dialog box.

3. If it is not already selected, selectPlot as the view type.
4. Type the number of bins you want to plot on the x-axis.
5. Select the solution quantity for which you want to plot distribution results on the y-axis from the

Y pull-down list.
A histogram plot appears in thePost Analysis Display dialog box. It displays the distribution
of the selected solution quantity.

Link to Design Xplorer
You can export a .xml file containing information on aMaxwell setup, optimization variables, and
output variables that enables ANSYS Design Xplorer to manageMaxwell simulations, for example,
for design of experiments and optimization. Design Xplorer will launchMaxwell simulations of design
variations and evaluate theMaxwell outputs.
To do so:

1. ClickMaxwell>Optimetrics Analysis>Add Design Xplorer Setup... or right-click on
Optimetrics in theProjectwindow, and selectAdd Design Xplorer Setup... from the
short-cut menu.
This opens theDesign Xplorer dialog with theGeneral tab selected. it lists the setups
available in the current project, and the input variables it contains.
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2. Check Include for the simulation setups you want to use.
3. Check the Design variables to use. You can also chose to Override the value of a design

variable. You can edit the Value and Units fields. UncheckingOverride returns the values to
their original state.

4. To setup any output calculations, click theCalculation tab and click theSetup Calculations
button.
This opens theAdd/Edit Calculation dialog. Here you can define the simulation results of
interest. The dialog box contains distinct panes and tabs to set theContext, theCalculation
Expression, and theCalculation Range. See Setup Calculations for Optimetrics for details.
Use theAdd Calculation button to add expressions to the Calculations table of theDesign
Xplorer Setup dialog,Calculations tab.

5. When you have added the calculations of interest, clickOK to save the setup.
An icon for the Design Xplorer setup appears under Optimization in the Project tree.
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6. To create a .xml file with the setup information for Design Xplorer, first Save your project.
7. Then right-click on the setup and selectExport External Connector Addin Configuration.

This displays a browser dialog that you can use to navigate your file system, and name and
saves the .xml file. The .xml file contains information regarding theMaxwell path along with the
setup, variables, and simulation results that you specified.

8. If you have an ANSYSWorkbench installation you can perform additional steps. Ensure that
you have provided a path to theWorkbench installation in the Tools>General Options dialog
on theMiscellaneous panel.

9. Then clickCreate Workbench Project.
This lets you name aWorkbench project containing the information in the setup. The ANSYS
Workbench will be launched with the connection to theMaxwell project established. To this
connection, you can add a Design Xplorer Setup. See the documentation of Ansys
Workbench for details on Design Xplorer.
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26 - Getting Started with RMxprt
RMxprt™ is a template-based electrical machine design tool that provides fast, analytical calculations
of machine performance and 2-D and 3-D geometry creation for detailed finite element calculations
in ANSYS®Maxwell®.
Using RMxprt, you can simulate and analyze the following types of machines:

l Three-phase and single-phase inductionmotors.
l Three-phase synchronousmachines.
l Brushless permanent-magnet DC motors.
l Adjust-speed synchronousmotors and generators.
l Permanent-magnet DC motors.
l Switched reluctancemotors.
l Line-start permanent-magnet synchronousmotors.
l Universal motors.
l General DC machines.
l Claw-pole alternators.
l Three-Phase Non-Salient SynchronousMachine
l Generic RotatingMachine

When you start to design a new model in RMxprt, you first select one of the abovemotor or generator
types. You then enter the parameters associated with that machine type in each RMxprt Properties
window. The properties windows are accessed by clicking each of themachine elements (for
example, stator, rotor, shaft) underMachine in the project tree. General options are available
directly at theMachine level of the project tree. Solution and output options (such as the rated output
power) are set when you add a solution setup (by right-clickingAnalysis in the project tree).

Related Topics

TheRMxprt Desktop
RMxprt Commands
Setting Up A MachineModel
Creating a New RMxprt Project
Specifying RMxprt Machine Data
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Getting Started with RMxprt
RMxprt™ is a template-based electrical machine design tool that provides fast, analytical calculations
of machine performance and 2-D and 3-D geometry creation for detailed finite element calculations
in ANSYS®Maxwell®.
Using RMxprt, you can simulate and analyze the following types of machines:

l Three-phase and single-phase inductionmotors.
l Three-phase synchronousmachines.
l Brushless permanent-magnet DC motors.
l Adjust-speed synchronousmotors and generators.
l Permanent-magnet DC motors.
l Switched reluctancemotors.
l Line-start permanent-magnet synchronousmotors.
l Universal motors.
l General DC machines.
l Claw-pole alternators.
l Three-Phase Non-Salient SynchronousMachine
l Generic RotatingMachine

When you start to design a new model in RMxprt, you first select one of the abovemotor or
generator types. You then enter the parameters associated with that machine type in each RMxprt
Properties window. The properties windows are accessed by clicking each of themachine elements
(for example, stator, rotor, shaft) underMachine in the project tree. General options are available
directly at theMachine level of the project tree. Solution and output options (such as the rated output
power) are set when you add a solution setup (by right-clickingAnalysis in the project tree).

Related Topics

TheRMxprt Desktop
RMxprt Commands
Setting Up A MachineModel
Creating a New RMxprt Project
Specifying RMxprt Machine Data

Creating a Project and Inserting a New RMxprt Design

To create a new project:
1. ClickFile>New.

A new project is listed in the project tree. It is named Projectn by default, where n is the order in
which the project was added to the current session.
Project definitions, such asmaterial assignments, are stored under the project name in the
project tree.
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2. ClickProject>Insert RMxprt Design or click the RMxprt icon on the toolbar.
TheSelect Machine Typewindow appears.

3. Select themachine type you want, and clickOK.
Specify the name of the project when you save it using the File>Save or File>Save As commands.

Opening Existing RMxprt Projects and Saving as New

Youmay also create new projects from existing ones, by saving them under new file names.
To create a new project from an existing one:

1. If you are already in the existing project, clickFile>Save As. TheSave Aswindow appears.
(Otherwise, open the existing project you want to copy first.)

2. Enter a new name for the new project, and clickSave.
The new project is now saved, with the same information as the existing project.
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Opening RMxprt Projects

Open a previously saved project using the File>Open command.
1. ClickFile>Open.

TheOpen dialog box appears.
2. Use the file browser to find the RMxprt version 6 project file.

By default, files that can be opened or translated byRMxprt are displayed.
3. Select the file you want to open.
4. ClickOK.

The project information appears in the project tree.

Opening Recent RMxprt Projects

To open a project you recently saved:
l Click the name of the project file at the bottom of the Filemenu.

Saving RMxprt Projects

Use the File>Save As command to do the following:
l Save a new project.
l Save the active project with a different name or in a different location.
l Save the active project in another file format for use in another program.

Use the File>Save command to save the active project.

Related Topics

Saving a New Project
Saving the Active Project
Saving a Copy of a Project

Saving a New RMxprt Project

1. ClickFile>Save As.
TheSave As dialog box appears.

2. Use the file browser to find the directory where you want to save the file.
3. Type the name of the file in the File name box.

By default, all files will have the .aedt extension.
1. ClickSave.

ANSYS Electronics Desktop saves the project to the location you specified.
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Related Topics

Saving the Active Project
Saving a Copy of a Project

Saving the Active RMxprt Project

l ClickFile>Save.
RMxprt saves the project over the existing one.

Warning Be sure to savemachinemodels periodically. Saving frequently helps prevent the loss of
your work if a problem occurs. Although RMxprt has an "auto-save" feature, it may not
automatically save frequently enough for your needs.

Related Topics

Saving a New Project
Saving a Copy of a Project

Saving a Copy of an RMxprt Project

To save an existing, active project with a new name, a different file extension, or to a new location:
1. ClickFile>Save As.
2. Use the file browser to find the directory where you want to save the file.
3. Type the name of the file in the File name box.
4. ClickSave.

ANSYS Electronics Desktop saves the project with the new name or file extension to the
location you specified.

Related Topics

Saving a New Project
Saving the Active Project

Saving RMxprt Project Data Automatically

RMxprt stores recent actions you performed on the active project in an ANSYS Electronics Desktop
auto-save file in case a sudden workstation crash or other unexpected problem occurs. The auto-
save file is stored in the same directory as the project file and is namedProjectn.aedt.auto by
default, where n is the order in which the project was added to the current session. ANSYS
Electronics Desktop automatically saves all data for the project to the auto-save file, except solution
data. By default, ANSYS Electronics Desktop automatically saves project data after every ten edits.
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An "edit" is any action you perform that changes data in the project or the design, including actions
associated with project management, model creation, and solution analysis.
With auto-save activated, after a problem occurs, you can choose to re-open the original
project file (Projectn.aedt) in an effort to recover the solution data or to open the auto-save file.
Tomodify the auto-save settings:

1. ClickTools>Options>General Options.
TheOptions dialog box appears.

2. In theGeneral>Desktop Configuration panel, verify thatDo Autosave is selected.
This option is selected by default.

3. In theAutosave interval box, enter the number of edits that you want to occur between
automatic saves. By default, this option is set at 10.
Note Auto-save always increments forward; therefore, even when you undo a command,

ANSYS Electronics Desktop counts it as an edit.

4. ClickOK to apply the specified auto-save settings.
Once the specified number of edits is carried out, a "model-only" save occurs. Thismeans that
ANSYS Electronics Desktop does not save solutions data or clear any undo/redo history.
When ANSYS Electronics Desktop auto-saves, an ".auto" extension is appended to the
original project file name. For example,Project1.aedtwill automatically be saved as
Projectn.aedt.auto.

Warning When you close or rename a project, ANSYS Electronics Desktop deletes the auto-save
file. ANSYS Electronics Desktop assumes that you have saved any desired changes at
this point.

Related Topics

Recovering Project Data in an Auto-Save File

Recovering RMxprt Project Data in an Auto-Save File

Following a sudden workstation crash or other unexpected problem, you can recover the project
data in its auto-save file.

Warning When you recover a project's auto-save file you cannot recover any solutions data;
recovering an auto-save file means you will lose any solutions data that existed in the
original project file.

To recover project data in an auto-save file, if ANSYS Electronics Desktop containing an RMxprt
design has unexpectedly crashed:

1. Launch ANSYS Electronics Desktop from your desktop.
2. ClickFile>Open,.
3. Select the original Projectn.aedt project file for which you want to recover its

Projectn.aedt.auto auto-save file.
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TheCrash Recoverywindow appears, giving you the option to open the original project file
or the auto-save file.

4. SelectOpen project using autosave file to recover project data in the auto-save file, and
then click OK. ANSYS Electronics Desktop replaces the original project file with the data in
the auto-save file.
ANSYS Electronics Desktop immediately overwrites the original project file data with the auto-
save file data, removing the results directory (solutions data) from the original project file as it
overwrites to the auto-save file.

Warning If you choose to recover the auto-save file, you cannot recover the original project file
that has been overwritten; recovering data in an auto-save file is not reversible.

Related Topics

Saving Project Data Automatically

RMxprt Files

When you create any design in the ANSYS Electronics Desktop, including an RMxprt design, it is
given an .aedt file extension and stored in the directory you specify. Any files related to that project
are also stored in that directory.
Some common file and folder types are listed below:

.aedt Maxwell or RMxprt project.
project_
name.aedtresults

Folder containing results data for a project.

design_
name.results

Folder containing results data for a design. This folder is
stored in the project_name.aedtresults folder.

design_name.asol Results data for a design. This file's contentsmay be
empty if a solution is unavailable. This file is stored in the
project_name.aedtresults folder.

Saving Project Notes in RMxprt

You can save notes about a project, such as its creation date and a description of the device being
modeled. This is useful for keeping a running log on the project.
To add notes to a project:

1. ClickRMxprt>Edit Notes.
TheDesign Notes dialog box appears.

2. Click in the window and type your notes.
3. ClickOK to save the noteswith the current project.
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To edit existing project notes:
1. Double-click theNotes icon in the project tree.

TheDesign Noteswindow appears, where you can edit the project's notes.
2. ClickOK to save any changes, or clickCancel to exit without saving edits.

The RMxprt Desktop

RMxprt is integrated within theMaxwell desktop. Consistent with theMaxwell desktop, the RMxprt
interface consists of several desktop components: a title bar, a menu bar, toolbars, a status bar, a
project manager window, a properties window, amessagemanager window, a progresswindow,
and amachine editor window. If user-defined rotor or stator slots are used in the design, a slot editor
window also displayswhen a rotor or stator slot is selected in the project tree. The project manager
window, the properties window, themessagemanager window and the progresswindow are
dockable and resizable.
You can openmultiple machine editor windows to display different parts at the same time. One can
remain fixed on the winding, one on the diagram, and one on themain desktop window. To open a
new window, clickWindow>NewWindow.
Tomove back and forth between windows, select the window you want to view from theWindows.
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RMxprt Title Bar

The title bar is located at the top of the application window. It displays the information of the active
design. If a machine editor window ismaximized, its title is appended in the title bar within square
brackets. The information of the active design includes the desktop name, the project name, the
design name and the design type. For an RMxprt design, the design type isMachine.

Working with the RMxprt Menu Bar

Themenu bar enables you to perform all Maxwell, ePhysics, and/or RMxprt tasks, depending on the
software you purchased. Such tasks includemanaging project files, customizing the desktop,
drawing objects, and setting andmodifying all project parameters.
RMxprt contains the followingmenus, which appear at the top of the desktop:

File
menu

Use the Filemenu commands tomanage RMxprt project files and printing options.

Edit
menu

Use theEditmenu commands tomodify properties in the active design, manage
designs in one or more projects, delete projects, and undo and redo actions.

View
menu

Use theViewmenu commands to display or hide desktop components, and change the
machine editor window view.

Project
menu

Use theProjectmenu commands to add aMaxwell 3D, Maxwell2D, or RMxprt design
to the active project, analyze all designs of the active project, and define project variables
and datasets.

Machine
menu

Use theMachinemenu to work with themachine data, such as edit winding layout, edit
wire size, and set dimension unit for the active editor window.

RMxprt
menu

Use theRMxprtmenu commands to validate design input data, analyze designs, set up
parameters, add analysis setups, set up Optimetrics, post process solutions, and other
design tasks.

Tools
menu

Use the Toolsmenu tomodify the active project'smaterial library, arrange thematerial
libraries, run and record scripts, update project definitions from libraries, display options,
customize the desktop's toolbars, andmodifymany of the software's default settings.

Window
menu

Use theWindowmenu commands to rearrange the application windows and toolbar
icons.

Help
menu

Use theHelpmenu commands to access the online help system and view the current
software version information.

Related Topics

"Getting Help" on page 4-1
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Working with the RMxprt Shortcut Menus

A variety of shortcut menus—menus that appear when you right-click a selection— are available in
the toolbars area of the desktop, in theMachine Editor window, in theProject Manager window,
in thePropertieswindow, and in theMessage Manager window.

In the
toolbars
area

Use the shortcut menu in the toolbars area of the desktop to show or hide windows
or toolbars, and customize the toolbars.

In Machine
Editor
window

Use the shortcut menu in theMachine Editor window to edit winding layout,
display or hidden coil connection, change the view, and copy to Clipboard.

In the Slot
Editor
window

Use the shortcut menu in theSlot Editor window to insert, append, modify, and
remove slot segments.

In the
Project
Manager
window

Use the shortcut menus in theProject Manager window (or the project tree) to
manage project files and design properties; these commands duplicatemenu
commands at the top of the screen.

In Properties
window

Use the shortcut menus in thePropertieswindow to edit (cut, copy, paste or
delete) property values.

In Message
Manager
window

Use the shortcut menus in theMessage Manager window to clear, copymessage,
or seemessage details.

Note Most of the commands on the shortcut menus are also available on themenu
bar.

Shortcut Menu in the Toolbars Area

Use the shortcut menu in the toolbars area of the desktop to show or hide windows or toolbars, and
customize the toolbars.
To access the shortcut menu in the toolbars area:

l Right-click in the toolbars area at the top of the desktop.
A check box appears next to a command if the item is visible. For example, if a check box appears
next to the Project Manager command, then the Project Manager window is currently visible
on the desktop.
ClickCustomize to open theCustomize dialog box, which enables you tomodify the toolbar
settings on the desktop.
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Shortcut Menus in the Project Manager Window

Each node, or item, in the project tree has a shortcut menu.
To access the shortcut menu in theProject Manager window, for a particular node:

l Select a node or item.
l Right-click in theProject Manager window.

Working with the RMxprt Toolbars

The toolbar buttons and shortcut pull-down lists act as shortcuts for executing various commands.
You can rearrange the position of the various toolbars.

l To execute a command, click a toolbar button or click a selection on the shortcut pull-down list.
l To display a brief description of the toolbar button, move the pointer over the button.
l To relocate a toolbar, click on the left edge of a toolbar and drag it to new location.

Hint Tomodify the toolbars on the desktop, clickTools>Customize. To display all toolbar
buttons, click the Reset All button in theCustomizewindow.

Undoing RMxprt Commands

Use theUndo command on theEditmenu to cancel, or undo, the last action you performed on the
active project or design.

1. In theProject Manager window, do one of the following:
l To undo the last action you performed on the active project, such as inserting a design, click
the project icon.

l To undo the last action you performed on the active design, click the design icon.
Note You cannot undo an analysis that you have performed on a model, that

is, the RMxprt>Analyze command.

2. ClickEdit>Undo.
Your last action is now undone.

Note When you save a project, RMxprt always clears the entire undo/redo history for the project
and its designs.

Related Topics

Redoing Commands

Redoing RMxprt Commands

Use theRedo command on theEditmenu to reapply, or redo, the last action that was canceled, or
undone.You can redo a canceled action related to project management, model creation,
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and post-processing.
1. In theProject Manager window, do one of the following:

l To redo the last action you canceled on the active project, such as inserting a design or
adding project variables, click the project icon.

l To redo the last action you canceled on the active design, such as drawing an object or
deleting a field overlay plot, click the design icon.

2. ClickEdit>Redo.
Your last canceled action is now reapplied.

Note When you save a project, RMxprt always clears the entire undo/redo history for the project
and its designs.

Related Topics

Undoing Commands

Working with the RMxprt Status Bar

The status bar is located at the bottom of the application window. It displays information about the
command currently being performed.
To display or hide the status bar:

l ClickView>StatusBar.
A check box appears next to this command if the status bar is visible.
When visible, the status bar contains buttons to show or hide themessage window and
progresswindow.
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Working with the RMxprt Machine Editor Windows

You can openmultiple machine editor windows in RMxprt. One can remain fixed on theWinding
Editor, one on theDiagram tab, and one on theMain tab. To open a new window, click
Window>NewWindow. Tomove back and forth between windows, select theWindowsmenu,
and select the window you want to view.
You can cascade allMachine Editor windows, tile them horizontally or vertically. You can
maximize, minimize or close aMachine Editor window by clicking the relevant button on the right-
top corner of the window. If noMachine Editor window is displayed, you can use
RMxprt>Machine Editor to bring one window up.When only oneMachine Editor window is
maximized, the window title is displayed within square brackets in the Title Bar of themain
application window.
As you enter appropriate property values, theMachine Editor window dynamically updates the
rotor, stator, slots, and windings in theMain,Diagram andWinding Editor tabs. As you provide
winding information, theWinding Editor tab displays a table of values.

Related Topics

Setting theWindow View
Printing in RMxprt

Setting the Window View

To fit the entire diagram in the window:
l ClickView>Fit All.

To zoom into the diagram in the window:
l ClickView>Zoom In.

To zoom out of the diagram in the window:
l ClickView>Zoom Out.

Printing in RMxprt

The printing commands enable you to print the display in the active window.
To print the project:

1. ClickFile>Print.
The Print dialog box appears.

2. You can change the print quality (a higher dpi produces a higher quality print but takesmore
time and printer memory), or you can send the output to a .prn file.

3. Do one of the following:
l ClickOK to print the project.
l ClickCancel to dismiss the window without printing.
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l ClickProperties to define printer settings.

Working with the RMxprt Project Manager

TheProject Manager window displays the open project's structure, which is referred to as the
project tree. TheProject Manager window displays details about all projects open in theMaxwell
Desktop, regardless of type.
To show or hide theProject Manager window, do one of the following:

l ClickView>Project Manager.
A check box appears next to this command if theProject Manager window is visible.

l Right-click in the toolbar area on the desktop, and then clickProject Manager on the shortcut
menu.
A check box appears next to this command if theProject Manager window is visible.

Related Topics

Working with the RMxprt Project Tree
Shortcut Menus in the Project Manager Window
"Working with the Project Manager" on page 3-14

Working with the RMxprt Project Tree

The project tree is located in theProject Manager window and contains details about all open
projects. The top node listed in the project tree is the project name. It is named Projectn by default,
where n is the order in which the project was added to the current session of theMaxwell Desktop.
Expand the project icon to view all designs andmaterial definitions belonging to the project. For
RMxprt projects, the project tree showswhere you can select each portion of themachine to open
the corresponding tab sheet in the Propertieswindow. The project tree lists options for the general
motor characteristics, the stator, the rotor, and other options such aswinding data or commutating
data. The specific options depend on themachine type you have selected.

Related Topics

Viewing RMxprt Design Details
Automatically Expand the Project Tree

Setting the RMxprt Project Tree to Expand Automatically

You can set the project tree to automatically expand when an item is added to a project.
1. ClickTools>Options>General Options.

TheOptions dialog box appears.
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2. Click theProject Options tab.
3. UnderAdditional Options, selectExpand Project Tree on Insert.
4. ClickOK.

Viewing RMxprt Design Details

Once you insert an RMxprt design into a project, it is listed as the second-level node in the project
tree. It is namedRMxprtDesignn by default, where n is the order in which the design was added to
the project. Expand the design icon in the project tree to view specific data about themodel.
The RMxprtDesignn node contains the following project details:

Machine Allows you to specify parameters for various aspects of themachine. A whole or part
geometry will be drawn in theMain tab of theMachine Editor window (based on the
values you enter).

Analysis Displays the solution setups for an RMxprt design. A solution setup specifies how
RMxprt computes the solution.

Optimetrics Displays anyOptimetrics setups added to an RMxprt design.
Results Displays any post-processing reports that have been generated.

Note To edit a project's design details:
l In the project tree, double-click the design setup icon that you want to
edit.

A dialog box appears with that setup's parameters, which you can then
edit.

Working with the RMxprt Properties Window

ThePropertieswindow displays the attributes, or properties, of an item selected in the project tree
and enables you to edit an item's properties. The properties, and the ability to edit them in the
Propertieswindow vary depending on the type of item selected. The tabs available in the
Propertieswindow also vary depending the selection.
Single clicking on an item in theMachine section of the project tree displays a dockedProperties
window located under the project tree. A horizontal scroll bar lets you adjust the view of the
properties if necessary. Changes to values in the docked properties window apply immediately to the
selected object.
Double-clicking on an item in theMachine section of the project tree opens a floatingProperties
window. The floating window can bemoved for convenience in viewing the RMxprtMachine Editor
window. Some objects have tabs on the window to control the properties displayed. Changes to
values in the floating window are not applied until you click theOK button.
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Related Topics

Showing and Hiding the PropertiesWindow
Setting the PropertiesWindow to Open Automatically

Showing and Hiding the RMxprt Properties Window

To show or hide thePropertieswindow on the desktop, do one of the following:
l ClickView>Property Window.

A check box appears next to this command if thePropertieswindow is visible.
l Right-click in the toolbar area at the top of the desktop, and then click Properties on the
shortcut menu.

A check box appears next to this command if thePropertieswindow is visible.

Working with the RMxprt Progress Window

TheProgresswindow monitors a simulation while it is running.
To display or hide theProgresswindow on the desktop, do one of the following:

l Click theShow Progress orHide Progress buttons on the status bar:

Whenmore than one progress bar is active, the top progress bar is represented on the status
bar with a progress indicator.

l ClickView>Progress Window.
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A check box appears next to this command if theProgresswindow is visible.
l Right-click in the toolbar area at the top of the desktop, and then clickProgress on the
shortcut menu.
A check box appears next to this command if theProgresswindow is visible.

Working with the RMxprt Message Manager

TheMessage Manager displaysmessages associated with a project's development, such as error
messages about the design's setup or informational messages about the progress of an analysis.
To display or hide theMessage Manager window on the desktop, do one of the following:

l Click theShow Messages orHide Messages buttons on the status bar:

l ClickView>Message Manager.
l Right-click in the toolbar area at the top of the desktop, and then clickMessage Manager on
the shortcut menu.
A check box appears next to this command if theMessage Manager is visible.

Related Topics

ClearingMessages for the RMxprt Project
ClearingMessages for the RMxprt Model
CopyingMessages in RMxprt

Clearing Messages for the RMxprt Project

You can clear all themessages for a particular project.
To clear messages:

1. Right-click the project# in theMessage Manager.
A pop-up appears.
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2. ClickClear messages for Project#.

Clearing Messages for the RMxprt Model

You can clear all themessages for a particular model.
To clear messages:

1. Right-click theRMxprtDesign# in theMessage Manager.
A pop-up appears.

2. ClickClear messages for RMxprtDesign#.

Copying Messages in RMxprt

You can copy all themessages for a particular project.
To copymessages:

1. Right-click in theMessage Manager.
A pop-up appears.

2. ClickCopy messages to clipboard.

Quick Start for RMxprt

This section briefly introduces how to enter the environment of the softwareRMxprt and quick
mastering itsmain functions by providing a simple example.
The basic process flow chart is shown below.
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RMxprt Example Part 1: Create a New Project

To create a new project:
1. Start Maxwell from the desktop.
2. ClickFile>New from themenu bar.

This creates a new project folder in the project window with the default name of Projectn.

RMxprt Example Part 2: Select a Machine

To select amachine to insert into the new project:
1. Click Project>Insert RMxprt Design or click the RMxprt icon in the tool bar.

This displays theSelect Machine Typewindow.
2. From the list of machine types, for this example, selectBrushless Permanent Magnet DC

Motor and clickOK.
This closes the window and inserts the Brushless Permanent Magnet DC Motor design in the
project.

Continue to Part 3 of the example to Input Design Data.
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RMxprt Example Part 3: Input Design Data

In this part of the example, you provide values for the design and for various parts.
1. Click the + symbol by the RMxprt:Designn icon in the project tree to view the design hierarchy.

This displays theMachine Icon.
2. Double-click the icon to view theMachine Properties window.

Set the values as indicated below.
Machine
Type

Brushless Permanent Magnet DC Motor

Number
of Poles

Set this to 4

Rotor
Position

Set to Inner

Frictional
Loss

Set this to 11 (Frictional and wind loss is typically within the range of 1%~3% of the
rated output power, in this example, 2% is estimated.) This value is referred to the
givenReference Speed. The frictional loss at the computed rated speed will be
modified if the computed rated speed is different from the given rated speed.

Wind
Loss

0

Reference
Speed

Set this to 1500

Control
Type

DC

Circuit
Type

Set this to C2.
Click the button to display the Select Circuit Type window.

Select the C2 button, andOK to close the window.

3. ClickOK to close the Machine properties window.
4. Click the + symbol by theMachine icon to view the design hierarchy of themotor.
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5. Double-click the Circuit icon to view the Circuit properties window.
Set the values as indicated below.

Lead Angle of
Trigger

Set this to 0 to obtain themaximumaverage emf for the following phase in the
trigonal period.

Trigger Pulse
Width

Set this to 90

Transistor Drop Set this to 2
Diode Drop Set this to 2

6. ClickOK to close the circuit properties window.
7. Double-click the Stator icon to view the Stator properties window.

Set the values as shown below.
Outer
Diameter

Set this to 120.

Inner
Diameter

Set this to 75.

Length Set this 65 for the length of the Stator iron core.
Stacking
Factor

0.95

Steel
Type

Click on the button to display theMaterialswindow. SelectRMxprt library in the
Libraries box in the upper right corner of theMaterialswindow: then selectM19-24G.
Note: If RMxprt is not listed in the libraries box in the upper right corner of theMaterials
window, quit theMaterials window, clickTools>Configure Libraries, addRMxprt
(under materials) and click theSave as Default check box. Then clickOK.

Number
of Slots

Set this to 24.

Slot Select 2 as the Slot type. Click the button on the row cell to display the Select Slot Type
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Type window.

Click the 2 button andOK to close the window.
Skew
Width

Set this to 1. (To skew one slot pitch.)

8. ClickOK to close theStator Properties window.
Take amoment to look at theMaxwell Design window. If you click theMain tab, you will see
two concentric rings that represent the inner and outer diameters you specified. If you click the
Winding Editor tab, you see a table of the coils, with columns for Phase, turns, the in slots,
and the out slots. There is also a drawing showing the placement of the 24 slots of the type
that you defined here.

9. Click the + symbol by theStator icon to view the hierarchy under the stator.
10. Double-click the slot icon to view theSlot Properties window.

Set the values as shown below. Some of the properties will not appear until you disable the
Auto Design property in the first row.

Auto
Design

Uncheck the box to disable auto design. Close the properties window and open it again.
Then set the given values for the slot shapes.

Parallel
Tooth

Uncheck this box. The ToothWidth property becomes invisible.

Tooth
Width
Hs0 Set to 0.5
Hs1 Set to 1.0
Hs2 Set to 8.2
Bs0 Set to 2.5
Bs1 Set to 5.6
Bs2 Set to 7.6
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11. ClickOK to close theSlot Propertieswindow.
12. Double-click the statorWinding icon to view theWinding Propertieswindow.

Set the values as shown below.
Winding tab Winding

Layers
Winding
Type

Set this to 2, "Whole Coiled."

Parallel
Branches

Select 1 for the number of parallel-connected branches, i.e. the
coils in all the slots per phase are in series-connected.

Conductors
per Slot

Set this to 60 for the number of conductors per slot, i.e. the number
of turns per coil is equal to 30 for double-layer winding.

Coil Pitch Set this to 5. For this example, full pitch = 24 slots / 4 poles = 6. This
example uses short coil pitch, 5, i.e. a coil spans from slot 1 to slot 6.

Number of
Strands

Select 1 for the number of strands (or number of wires per
conductor).

Wire Wrap Select 0. This is the total thickness of double side wire insulation.
The input value 0means thatRMxprtwill automatically check into
the wire gauge library for the wrap thickness relevant to the wire
gauge. Different manufacturers produce differentWire Wrap
Thickness for electromagnetic wire. Typically,Wire Wrap
Thickness for electromagnetic wire is 7~10% ofWire Diameter.

Wire Size Click on the Properties field to display theWire Size window and
selectAUTO for automatic design of wire gauge.Wire Size will be
set to 0 in theWire Size window. This example relies onRMxprt to
automatically select the optimum diameter and the gauge code for
electromagnetic wire.

End/Insulation
tab

Input Half-
turn Length

Uncheck this box.

Half Turn
Length

This item is not shown if Input Half Turn Length is unchecked.

End
Adjustment

Set this to 0 for the linear overhang of the end part of the coil out of
the iron core as shown below. In this example, the coil turns
immediately at the slot opening, therefore input 0.
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Base Inner
Radius

0

Tip Inner
Diameter

0

End
Clearance

0

Slot Liner Set this to 0.3 for the single side thickness of slot insulation.
Wedge
Thickness

0

Layer
Insulation

0

Limited Fill
Factor

0.75
(The slot fill factor is the ratio between the cross-sectional area of all
conductors in one slot and the entire slot area.)

13. ClickOK to close the stator Winding Properties window.
14. ClickMachine>Winding>Connect All Coils.

TheWinding tab in themain window shows all coils connected.
15. Double-click the Rotor Icon to view theRotor Propertieswindow.

Set the values as shown below.
Outer
Diameter

Set this to 74.0. This is the Stator inner diameter - 2* AirGap.

Inner
Diameter

Input 26 for the inner diameter of the rotor core. This is also the diameter to match the
shaft

Length Input 65 for the length of the rotor core. In this example, the lengths of the iron cores of
the stator and the rotor are the same.

Steel
Type

SelectM19-24 for the brand of the silicon-steel sheet for the rotor. In this example, the
laminations are punched together on the same sheet; therefore, the brands of the
silicon-steel sheet and the stacking factors are the same for the stator and the rotor.
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Stacking
Factor

Input 0.95.

Pole
Type

Select 1. Click on the button on the Pole Type field to display the Select Pole Type
window.

Click the 1 button andOK to close the window.

16. ClickOK to close the Rotor Properties window.
17. Click the + symbol by the Rotor icon to open the project hierarchy under the rotor.
18. Double-click the Pole icon to view the Pole Properties window.

Set the values as shown below.
Embrace Input 0.7. Embrace of the rotor represents the ratio of the rotor central angle

corresponding to the arc length along the rotor surface of an arched permanent-
magnetic piece to the rotor central angle corresponding to a rotor pole. In a four pole
machine withEmbrace, 1, each arched permanent-magnetic piece covers 90
mechanical degrees along the rotor surface. Similarly,Embrace 0.667means 60
mechanical degrees of the coverage of themagnet as shown in the figure.
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Offset Input 0. The arched permanent-magnetic pieces to form themagnets of the rotor
might not be concentric with the rotor as shown in the figure. In the electricmachines
with non-uniform air-gap, there exists an offset between the two centers.RMxprt
terms it asPole Arc Offset. This example uses uniform air-gap; therefore, the offset
is set to 0.

Magnet
Type

SelectXG196/96. This permanent-magnetic steel possesses residual flux density
0.96 Tesla, coercive force 690 kA/m, maximummagnetic energy product 183 kJ/m3,
and relative recoil magnetic permeability 1.0.
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Magnet
Thickness

Input 3.5 for the thickness of the permanent-magnetic steel.

19. ClickOK to close the Pole Properties window.
To continue to Part 4 of the example, go to Analyze the Design.

RMxprt Example Part 4: Analyze the Design.

Before analyzing a design project, a few options should be decided by the following procedures:
1. ClickTools>Options>Machine Options.

TheMachineOptionswindow appears. TheWire setting should be set to American.
2. ClickOK to close the window.
3. ClickRMxprt>Analysis Setup>Add Setup.

This displays the Solution Setup window. Add the following values.
4. Close the dialog to save the Setup.

Load Type Const
Power

Rated Output Power 0.55 kW
Rated Voltage 220
Rated Speed 1500
Operating
Temperature

75c

5. ClickRMxprt>Validation Check to ensure that all values have been set.
If any items do not pass validation, use the diagnostic information in theMessageWindow to
resolve any issues.

6. When the design has been validated, clickRMxprt>Analyze All.
The progress of the analysis is shown in the Progresswindow.

To continue to Part 5 of the example, go to Create Reports and View Output.

RMxprt Example Part 5: Create Reports and View Output

After you have run an analysis, you can view the solution data.
1. ClickRMxprt>Results>Solution Data.

This opens theSolutionswindow with theSolutions tab selected, and the Full Load
Operation Data displayed. The Solutionswindow contains tabs for the following:
l Solution Data - the Data field in the Solutionswindow is a drop downmenu fromwhich you
can select the following:
l Full LoadOperation
l Material Consumption
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l No LoadOperation
l Permanent Magnet
l Rotor Data
l Stator Slot
l Stator Winding
l Steady State Parameters

l Parameter
l Design Sheet
l Curves - Selecting theCurves tab lets you view predefined graphs.

2. With theSolution tab selected, selectStator Winding as theData selected.
Except for a few data corresponding to the wire gauge, this part of data should be the same as
the data input in the Stator Winding Properties window. Since automatic design function for
the wire gauge is selected in the input,RMxprt calculates the following data:

Wire
Diameter
(mm):

0.8118 for the diameter of the electromagnetic wire.

Wire
Wrap
Thickness
(mm):

0 for the insulation thickness of the electromagnetic wire. Because input wire wrap
is 0, RMxprt picks it up from the selected wire library (American wire), but it still 0
based on the wire wrap data in the library.

Stator
Slot Fill
Factor
(%):

61.4557.

The electromagnetic wire withWire Diameter of 0.8118 is equivalent to AWG20. Stator
Slot Fill Factor represents the percentage of occupation of the slot area, i.e. the ratio of the
total square sectional area of wires (includingWire Wrap Thickness) in a slot to the total slot
area less the slot insulation.
a. Now thatWire Diameter of the electromagnetic wire is calculated byRMxprt, you can

open theWinding Propertieswindow and specify the value.
b. ForWire Size, open theWire Size selection window, select 0.8118 for the

electromagnetic wire diameter, which corresponds to 20 for the wire gauge.
c. In the slotWire Wrap field, input 0.08 for the insulation thickness of the electromagnetic

wire.
d. ClickOK to close the properties window.
e. Click RMxprt>Analyze All.
After the second analysis is completed, clickRMxprt>Results>Solution Data to view the
effect ofWire Wrap Thickness of the electromagnetic wire onStator Slot Fill Factor.
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Wire Diameter (mm): 0.8118
.

Wire Wrap Thickness
(mm):

0.08.

Stator Slot Fill Factor (%): 74.165
.

3. In theSolutionswindow, change the Data selection toRotor Data.
The Rotor data is displayed.
Heremost of the data is the same as input in theRotor Pole properties window. The only
difference is that thePole Arc radius replacesPole Arc Offset and, in addition to
MechanicalPole Embrace which is input based on the physical geometry,ElectricalPole
Embrace is also given. Electrical Pole Embrace is calculated by the ratio of the average
magnetic flux density to themaximummagnetic flux density according to themagnetic flux
density distribution along the air-gap.

4. In theSolutions window, change the Data selection toPermanent Magnet.
This part displays the characteristic data of the permanent magnets aswell as the
Demagnetization Flux density, the Recoil Residual Flux density and Recoil Coercive Force of
the recoil line based on the demagnetization flux density, which are used for finite element
analysis when a linear PM characteristicsmust be specified.

5. In theSolutionswindow, change the Data selection toSteady State Parameters.
This part displays the stator winding factor, direct- and the quadratic-axis inductances, the
leakage inductance, the resistance of the phase winding, the direct- and the quadratic-axis
time constants, the ideal torque constant KT and the ideal back emf constant KE.

6. In theSolutionswindow, change the Data selection toNo-Load Operation.
This part displays themagnetic flux densities in the teeth and the yoke of the stator, and the
yoke of the rotor. Themaximum value among the threemagnetic flux densities is 1.52 Tesla,
which locates at the knee part of the B-H curve, below the saturation situation.
Themmfs of the teeth and the yoke of the stator, the air-gap, the yoke and the permanent
magnet of the rotor are given respectively for half magnetic reluctance path.
The armature reactionmmf due to the armature current is referred to the demagnetization
mmf. Themagnetic flux leakage coefficient takes into account the part of themagnetic flux in
the rotor not linking with the stator. The correction factors for the yoke lengths of the stator and
the rotor to calculate the yokemmfs of the stator and the rotor are also given here.
The no-load revolution speed of thismachine is equal to 2001 rpm.

7. In the Solutionswindow, change the Data selection to Full Load Operation.
AtRated Output Power (kW):0.550, the following characteristic parameters of themachine
are calculated as:

Parameters Calculated Units
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Values

Average Input Current 2.93 A

(of input current waveform in one voltage period)

RMS Armature Current 2.45 A

(of phase current waveform in one voltage period)

Armature Thermal Load 70.88 A
2/mm3

(product of Specific Electric Loading andArmature Current
Density

)

Specific Electric Load 14.97 A/mm

(stator current distribution per circumferential length along air-gap)

Armature Current Density 4.73 A/mm2

(through cross-sectional area of stator wire)

Frictional and Wind Loss 11.46 W

(at computedRated Speed)
Iron-Core Loss 20.24 W

(due to loss curves of stator and rotor iron-corematerials)

Armature Copper Loss 53.87 W

(stator winding ohmic loss)

Transistor Loss 9.32 W

(transistor switching loss)

Diode Loss 0.69 W

(diode power consumption)

Total Loss 95.6 W

(sum of above losses)

Output Power 550 W

(the rated operating point is derived based onOutput Power)
Input Power 645.6 W

(product ofRated Voltage andAverage Input Current)
Efficiency 85.2 %

(ratio ofOutput Power to Input Power)
Rated Speed 1562 rpm

(atRated Output Power)
Rated Torque 3.36 Nm
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(atRated Output Power)
Locked-Rotor Torque 32.3 Nm

(starting torque at zero revolution speed)

Locked-Rotor Current 47.6 A

(starting current at zero revolution speed)

8. In theSolutionswindow, select theDesign Sheet tab, and scroll down toWinding
Arrangement.
This is the layout and the arrangement of the whole two-phase winding of phases A and B,
and the short coil pitch factor 5 is taken into account.
The 2-phase, 2-layer winding can be arranged in 6 slots as below:
AAABBB

9. In theSolutions window with the Design Sheet table selected, scroll down to
Transient FEA Input Data. (This is at the very bottom.)

Angle per slot (elec. degrees): 30

Phase-A axis (elec. degrees): 105

First slot center (elec.
degrees):

0

The following data of the armature winding corresponds to one phase armature winding.

Number of Turns 360

(total number of turns viewed into output terminals)

Parallel Branches 1

Terminal Resistance 4.5 Ohm

(stator winding dc resistance under given operating temperature,
75oC)

End Leakage Inductance 1.7 mH

(of stator winding)

The following data is the equivalent values used to 2D electromagnetic field analyses.

Equivalent Model Depth 65 mm

Equivalent Stator Stacking Factor 0.95

Equivalent Rotor Stacking Factor 0.95

Equivalent Br (residual flux density) 0.87 Tesla
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Equivalent Hc (coercive force) 690 kA/m

Estimated Rotor Moment of
Inertia

0.0015 kg.m
2

10. In theSolutionswindow, click theCurves tab.
This displays the Input DC Current Versus Speed graph. If the text is too small to read, you
can resize the window. You can view other predefined graphs by selecting from the drop
downmenu in the Name field.
Selecting the Curves tab lets you view predefined graphs for the following relations:
l Input DC Current Versus Speed
l Efficiency Versus Speed
l Output Power Versus Speed
l Output Torque Versus Speed
l Cogging Torque in Two Teeth
l Induced Coil Voltages at Rated Speed
l Air-Gap FluxDensity
l InducedWinding Phase Voltage at Rated Speed
l Winding Currents Under Load
l Phase Voltage Under Load
You can also create additional plots with multiple curves.

11. For example, clickRMxprt>Results>Create Report.
This displays theCreate Report dialog box. ClickOK to display the Traceswindow.

12. In the Traceswindow, select Input DC Current and Efficiency vs Speed, and click the
Add Trace button. Then selectOutput Torque.

13. These traces appear in the Traces field. ClickDone to close the Traceswindow and display
the combined graph.

To continue to part Six of the example, go to Output Design Data.

RMxprt Example Part 6: Output Design Data

To export themodel for Maxwell 2D Analysis:
1. ClickRMxprt>Set Export Options.

This opens theExport Optionswindow.

Periodic According to the geometric symmetry, the structure of electricmachine can be
divided into several periods. The four pole electricmachine in this example has a
whole slot number per pole per phase, therefore, it can be divided into four periods.
Choose the smaller period to shorten the run-time for 2D Maxwell analyses.

Difference The angular displacement from the rotor to the stator in electric degrees.
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Band Arc The air-gap is divided uniformly along the circumference.Band Arc is the central
angle corresponding to each division. The effective range of its value is between 1o
to 5o, the default value is 3o. In 2D electromagnetic field analysis to the torque with
2D Maxwell, the value ofBand Arc is sensitive. The lower the value, the finer the
air-gapmeshes, themore accurate the torque calculation, but longer the
computation time in order.

Teeth to
Teeth

If you select this box, the central lines of the rotor teeth or the rotor magnet poles
coincide with the periodic dividing lines, otherwise, the central lines of the rotor slots
or the interpole lines of the rotor magnet poles coincide with the periodic dividing line.
Nevertheless, the central lines of the stator teeth always coincide with the periodic
dividing lines.

Design
Sheet

This lets you specify an Excel Spreadsheet template for a customized design sheet.

2. ClickRMxprt>Analysis Setup>Export>Maxwell 2D.
This displays the Export Maxwell 2D window.

3. Specify a ProjectName.
4. ClickOK.
5. TheProgresswindow shows activity.
6. To export a Simplorer model, clickRMxprt>Analysis Setup>Export>Simplorer Model.

This displays theExport Simplorer window.
7. Provide a project name and a location.
8. ClickOK.
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Setting Up RMxprt Projects
AnRMxprt project is a folder that includes one or moremodels, or designs. Each design ultimately
includes a geometricmodel, material assignments, and field solution and post-processing
information.
A new project calledProjectn is automatically created when the software is launched, where n is a
number. You can also open a new project by clicking File>New. In general, use the Filemenu
commands tomanage projects. If youmove or change the names of files without using these
commands, the softwaremay not be able to find information necessary to solve themodel.

Setting Up A Machine Model

To set up an RMxprt model, follow this general procedure:
1. Insert an RMxprt design. (Click Project>Insert RMxprt Design., and specify themachine

type from theSelect Machine Typewindow.)
2. Use the Toolsmenu commands to specify general options (such as post-processing and

auto-save settings), solver options (such as the default process priority), and specific RMxprt
options. Also specify theMachine options (such as the units and the wire setting such as the
wire shape and gauge).

3. Double-click theMachine items in the project tree, to specify the settings for the various parts
of the selectedmachine parameters.

4. Under Definitions in the project tree, assign anyMaterials to themachine parts, setting values
such as:
l Permanent magnet definition, including the coercivity, energy density, and relative recovery
permeability.

l BH-curve parameters.
5. Use theSetup commands (either on the RMxprt menu or on the Analysis or Optimetrics

submenus via the project tree) to specify variable, parametric, and optimization settings.
6. Use the Validate command to validate the design.
7. Use the Analyze commands to generate a solution, run a parametric analysis, or run an

optimization.
8. Use the Results post-processing commands to display the lamination and plot the solutions.

Related Topics

Specifying RMxprt Winding Data
Quick Start for RMxprt

Changing the Machine Type

RMxprt allows you to change themachine type for an existing design. The original machine data
which applies to the new machine type is not retained. Instead, the initial default data for the new
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machine type is used.
To change themachine type for an existingmodel:

1. Right-click on the design treemachine item, or pull down the RMxprt mainmenu, and click on
Machine Type to open theMachine Type<project_name> - <design_name> dialog box.

2. Choose the desired new machine type and click theOK button.
l The design’smachine type label is changed to that of the new machine type. For example, if
the original design name and type was 3hp (Single Phase Induction Motor), and you
change themachine type to a Switched ReluctanceMotor, the design namewould be 3hp
(Switched Reluctance Motor).

l The design tree items (such as theMachine Rotor, Stator, and Shaft data) under the design
type will be updated with the default machine data applicable to the new machine type.
Note You canUndo/Redo themachine type change if you wish to revert to the original

machine type and vice-versa.
TheSetMachineType script command provides for this functionality in scripts.

Related Topics

RMxprt Machine Types

SetMachineType

Use:Modifies an existingmachine type.
Command: RMxprt>Machine Type or right-click on amachinemodel in the Project Manager and
selectMachine Type on the context menu.
Syntax: SetMachineType <MachineType>
Return Value: None
Parameters: <MachineType>
Type: <string>
The desiredmachine type.
Possible values are: “ASSM”, “BLDC”, “CPSM”, “DCM”, “GRM”, “LSSM”, “PMDC”, “SPIM”, “SRM”,
“TPIM”, “NSSM”, “TPSM”, “UNIM”.
representing respectively:
Adjust-Speed SynchronousMachine, Brushless Permanent-Magnet DC Motor, Claw-pole
SynchronousMachine, DC Machine, Generic RotatingMachine, Line-Start Permanent-Magnet
SynchronousMotor, Permanent-Magnet SynchronousGenerator, Single-Phase InductionMotor,
Switched ReluctanceMotor, Three-Phase InductionMotor", Non-Salient SynchronousMachine,
Three-Phase SynchronousMachine, Universal Motor
Example:SetMachineType “ASSM”
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Design Settings in RMxprt

TheDesign Settings dialog allows you to specify how the simulator will deal with some aspects of the
design.

l Set theMaterial Threshold for treatingmaterials as conductors/insulators.
l Set Export Options.
l Specify User Defined Data.

Setting the Material Threshold in RMxprt

1. ClickRMxprt>Design Settings.
TheDesign Settings dialog box appears with theMaterial Threshold tab selected.

2. Type a value in theConductivity Threshold text box (Default=10,000).
3. Type a value in thePermeability text box (Default=100).

Note RMxprt will treat materials with conductivity greater than 10,000 as conductors, and
materials with Permeability greater than 100 as steels.

4. If you want these values to be the default, change the values by clicking the
Tools>Options>General Optionsmenu and setting thematerial thresholds in the
RMxprt>Threshold panel.

5. ClickOK.

Related Topics

Setting RMxprt Options

RMxprt Export Options

To set export options for the project:
1. ClickRMxprt>Design Settings.

TheDesign Settings dialog box appears.
2. For theDesign Sheet, type a file name in theExcel Template text box.

l You can also click the ... button to find and select a file.
3. ClickOK.

Related Topics

Generating a CustomDesign Sheet for RMxprt
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Setting User Defined Data for a Design

RMxprt allows a user to define some design data in a text file which can be created by a text editor,
instead of byRMxprt UI, for the following special circumstances:

l Some special requests from a user which are not necessary to be added to RMxprt UI;
l Some common requests from users which have been implemented in RMxprt solver, but have
not been added in RMxprt UI.

When a user's requests have been implemented in an RMxprt solver but have not been added in the
RMxprt UI, the updated solver and the required file format for user defined data will be sent to the
user. To use the user defined data feature, the user must first edit the data file using a text editor
according to the format provided. Then, selectRMxprt>Design Settings to display the Design
Settings dialog.

1. Select theUser Defined Data tab.
2. Click theEnable check box to enable the use ofUser Defined Data.
3. User defined datamay be entered directly into the text box. Click in the box and enter the data

entries desired.
l For example: If you want to create a full 360 degmodel of the solved RMxprt design,
enter Fractions 1 in the text box and clickOK. After solving the RMxprt design, if you
choose to create aMaxwell 2D or 3D design, a full 360model is generated.

4. Alternatively, click Import File to import user defined data from an external file.
5. Browse to the directory containing the file.
6. Select the user defined data file which will be displayed in File name box.
7. ClickOpen to confirm the selection.
8. The file contents will be imported into the text box. ClickOK to complete the setup.

User Defined Data is save in the design file. Changes toUser Defined Datawill cause existing
solutions to become invalid.

Validating RMxprt Projects

Before you run an analysis on amodel, it is very important that you first perform a validation check on
the project. When you perform a validation check on a project, RMxprt runs a check on all setup
details of the active project to verify that the necessary steps have been completed and their
parameters are reasonable.
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To perform a validation check on the active project:
1. ClickRMxprt>Validation Check.

RMxprt checks the project setup, and then the Validation Checkwindow appears.
2. View the results of the validation check in theValidation Checkwindow.

The following icons can appear next to an item:

Indicates the step is complete.

Indicates the step is incomplete.

Indicates the stepmay require your
attention.

3. View anymessages in theMessage Manager window.
4. If the validation check indicates that a step in your project is incomplete or incorrect, carefully

review the setup details for that particular step and revise them as necessary.
5. ClickRMxprt>Validation Check to run a validation check after you have revised any setup

details for an incomplete or incorrect project step.
6. ClickClose.

Setting General Options in RMxprt

Default settings for many of the options in RMxprt may be set through the Tools>Optionsmenu. To
set general options for RMxprt:

1. ClickTools>Options>General Options.
TheGeneral Optionswindow appears, displaying six available tabs:
l Project Options
l MiscellaneousOptions
l Default Units
l Remote Analysis Options
l WebUpdate Options
l Desktop Performance

2. Click each tab, andmake the desired selections.
3. ClickOK.
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Related Topics

Setting RMxprt Options

Setting RMxprt Options

To specify settings for RMxprt options:
1. ClickTools>Options>General Options to open the Options dialog, displaying a

hierarchical list of options. Click the + next toRMxprt to show the following choices:General,
Machine Type, Threshold

2. In theGeneral options panel, select or clear the following check boxes:
l Save before solving

Note When you enable theSave before solving setting, the project is only saved if it
has beenmodified since its last save.

l Apply variation deletions immediately
3. On theMachine Type panel, to change the default machine type when you initially insert a

design, select one of the following from theDefault machine type pull-down list:
l Three Phase InductionMotor
l Single Phase InductionMotor
l Three Phase SynchronousMachine
l Brushless Permanent-Magnet DC Motor
l Adjust-Speed SynchronousMachine
l Permanent-Magnet DC Motor
l Switched ReluctanceMotor
l Line-Start PMSynchronousMotor
l Universal Motor
l DCMachine
l Claw-Pole SynchronousMachine
l Three Phase Non-Salient SynchronousMachine
l Generic RotatingMachines

4. On the Threshold panel, enter the Default conductivity andDefault permeability values
in siemens/m.
Note Setting thematerial thresholds under Tools>Options impacts the default setting for

the current and all future projects/designs. To change thematerial threshold for the
current design only, use theRMxprt>Design Settings command and change the
material thresholds on theSet Material Thresholds tab.

5. ClickOK to close the dialog box.
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Configuring a Wire Specification Library

In order to be able to select wire size for your design, your need to configure a wire specification
library before you insert a new design in your project. RMxprt provides the following libraries of wire
gauge specifications based on the current widely used standards for bare copper wire gauges
(including both round and rectangular wires). These files are stored in the syslib directory.

American.wir
File American.wir provides
dimensions for all ANSI bare
wires.

ANSI_SingleFilm.wir
ANSI_HeavyFilm.wir
ANSI_TripleFilm.wir
ANSI_QuadFilm.wir

Files ANSI*.wir provide
dimensions for bare and film
insulated copper wires with
single, heavy, triple and quad
builds of integer and half AWG
numbers.

AWG_Int_SingleFilm.wir
AWG_Int_HeavyFilm.wir
AWG_Int_TripleFilm.wir
AWG_Int_QuadFilm.wir

Files AWG_Int*.wir provide
dimensions of integer AWG
numbers.

Chinese.wir

IEC_R20Grade1.wir
IEC_R20Grade2.wir
IEC_R20Grade3.wir
IEC_R40Grade1.wir
IEC_R40Grade2.wir
IEC_R40Grade3.wir

Files IEC_R20*.wir provide
dimensions of enameled copper
wires with Grade-1, 2, and 3
insulations of R20 series. Files
IEC_R40*.wir provide
dimensions of R40 series. In
files IEC*.wir, the gauge
numbers are equivalent to the
AWGnumbers according to the
nominal diameters.

1. ClickMachine>Wire
TheEdit Wire Data dialog box appears.

2. Click Import to import wire data from any of the standard wire libraries are provided in the
syslib directory. The corresponding data for wire gauge appears automatically in the table.

3. Edit wire data as needed.

Editing Wire Data

Usersmust generate their own data files for wire gauges using data for wire gauge and thickness of
insulation provided bymanufacturers. There are no national standards for insulation thickness,
therefore different manufacturers produce electromagnetic wire with different thickness of insulation.
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The data fileAmerican.wir does not provide data for thickness of insulation; the data file
Chinese.wir does provide the data for thickness of insulation, but only for the purpose of reference
to users. These files are stored in the file folder syslib along with several other wire data reference
libraries.
To define or edit wire data:

1. ClickMachine>Wire to open theEdit Wire Data dialog box
2. Select the units from theUnit System pull-down list.

English Unit System stands for British unit system,Metric Unit System stands for the
metric unit system.When changing the unit system, themessage boxNote pops up to inform
changing in unit system is only for specifying input data unit, but not for transferring data
between two unit systems

3. Optionally, click Import to import wire data from a file. Provide the file name to import in the
File name: edit box (or by browsing) and use the default file typeWire Size File (*.wir).
Several standard wire libraries are provided in the syslib directory.

4. Click theRound orRectangle tab for the wire shape you want to edit.
ForRound:

a. Specify the desired values for Gauge No., Diameter, and/or Wrap.

Gauge No. wire gauge index number.

Diameter diameter of bare copper wire, in mmor inch.

Wrap thickness of insulation wrap, in mmor inch.

b. Modify the wire data as needed.
c. Optionally, Add or Delete Rows for wire values.
ForRectangle:
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a. Specify the desired values to limit ratios of the two sides.

Wire Shape Limit (B/A) max themaximum ratio between the wide
and the narrow sides.

Wire Shape Limit (B/A) min theminimum ratio between the wide
and the narrow sides.

b. Use the radio buttons to specify whether to consider priority factors.
All Size – for No Consideration of Priority Factors

Select the radio buttonAll Size, and then click theCalculate button. All the sectional areas of wire
gauge with the ratio B/A between the wide and the narrow sides satisfying the condition (B/A)
max > B / A > (B/A) min appear in the table.

Skip One – for Consideration of Priority Factors
Select the radio buttonSkip One, and then click theCalculate button. All the sectional
areas of wire gauge with the ratio B/A between the wide and the narrow sides satisfying
the condition (B/A) max > B / A > (B/A) min appear in three different modes in the table
Rectangular Wire Data.

l At the intersection of the odd columns and the odd rows, the sectional areas appear in
black numbers (recommended to use).

l At the intersection of the odd columns and the even rows or the even columns and the
odd rows, the sectional areas appear in blue numbers (rarely used).

l At the cross of the even columns and the even rows, the sectional areas do not show
(generally not used).

c. Optionally, Add or Delete rows or columns for wire values.
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4. Optionally, clickExport to export the data you entered to a file. Provide the file name to import
in the File name: edit box (or by browsing) and use the default file typeWire Size File (*.wir).
The default directory for an exported wire data file is userlib.

5. When you are finished, clickSave to save the data, and clickClose to close the window.

Note Saving wire data only updates the wire data in the active
design.

Related Topic

"Configuring aWire Specification Library" on page 26-40

Setting Model Units

1. ClickMachine>Units.
TheSet Model Units dialog box appears.

2. Select the desired units from the pull-down list.
3. Select or clear theRescale to new units check box.
4. ClickOK.

Edit AC Windings

RMxprt can automatically arrange almost all commonly used single- or double-layer poly-phase ac
windings provided all coils have the same number of turns. Users do not need to define coils one by
one. For a double-layer winding, RMxprt can also handle the coils with half turns which are arranged
in the order of even, odd, even, odd,…, as long as it is physically possible.
RMxprt also provides a very flexible tool, theWinding Editor, to allow users to design a variety of
special winding types according to their own needs, such as compound single- and double-layer
winding, big- and small-phase-spread variable-polemultiple-speed winding, sine-wave three-phase
winding, and so forth. TheWinding Editor is available to the following types of electricmachines:
1. Three-phase inductionmotors
2. Single-phase inductionmotors
3. Three-phase synchronousmotors and generators
4. Line-start permanent-magnet synchronousmotors
5. Claw-pole alternators
6. Adjustable-speed permanent-magnet synchronousmotors and generators
7. Brushless permanent-magnet DC motors
When you edit the AC winding of a new design for the first time, RMxprt creates a default winding
arrangement based on the basic winding specifications:Number of Phases,Number of Poles,
Number of Slots,Winding Layers,Conductors per Slot, andCoil Pitch. Then you can edit the
winding configuration based on the default arrangement.
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Enable Winding Editor

Setting theWinding Type property toEditor enables the commandMachine>Edit Layout on the
menu bar.
To display the dialog boxWinding Editor:
1. SelectWinding in the Project Tree. In the Properties window, set theWinding Type Value to

Editor. To do this, click on the buttonWinding Type Value to display theWINDINGType
selection window, as shown:

2. SelectEditor as theWinding Type and clickOK.
This closes theWINDINGType selection window and sets theWinding Type Value to Editor.
It also enables the commandMachine>Winding>Edit Layout on themenu bar. Now the
Machine Editor window displays the default winding arrangement, as shown:
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3. ClickMachine>Winding>Edit Layout.
This displays theWinding Editor dialog as shown. TheWinding Editor dialog box includes
functions that do not appear in theWinding Editor tab sheet in the RMxprt Machine Editor
window.
In addition, right-clicking in the data table section of theWinding Editor tab in theMachine
Editor displays a shortcut menu where youmay also selectEdit Layout.
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Edit Winding Configuration

Each row of the winding data table in the dialog boxWinding Editor in Figure 3.13 is identified with
the coil index in the columnCoil. This information is displayed in the tab sheetWinding Editor in the
RMxprt Machine Editor window aswell, but it is editable in the dialog boxWinding Editor.
The winding data table contains four columns:

Phase is for the phase to which the coil belongs.
Turns is for the number of turns of the coil.

In
Slots

is for the slot number with the coil side current flowing in ('flow-in-side' for short). If 2 Layers
are specified in theWinding Properties window, the slot number endswith a "T" to show the

top layer.

Out
Slots

is for the slot number with the coil side current flowing out ("flow-out-side" for short). If 2
Layers are specified in theWinding Properties window, the slot number endswith a "B" to

show the bottom layer.
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View Winding Connections

When you have specified the winding data, you can execute the following commands to display or
hide the winding connections.

1. Click themenu commandMachine>Winding>Connect All Coils.
Upon executing, the graphical display in theMachine Editor window shows the connections as
shown:

2. To remove the connections in the graphical display in theMachine Editor window, select
Machine>Winding>Disconnect All Coils.

3. Winding connectionsmay also be viewed by shortcut menu.Right-click on thewinding
layout section of theMachine Editor window, a shortcut menu pops up. SelectConnect All
Coils orDisconnect All Coils to toggle the coils display on or off.
If you right-click on a slot layer, commands related to that slot layer will be enabled, and you
will be able to view or hide only one coil or one phase connection related to the slot layer. You
may copy the connection drawing to clipboard from the shortcut menu aswell.
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Working with the Slot Editor

RMxprt provides a flexible tool, theSlot Editor, to enable users to edit user-defined slots easily.
Standard slot types in a project can be converted to equivalent user-defined versions that can be
edited in the RMxprt Slot Editor tool as follows:

1. In the Project tree, select the Rotor or Stator whose slot is to be converted.
2. In the Rotor or Stator PropertiesWindow, click theSlot Type Value button to open the

Select Slot Type dialog box.
3. CheckUser Defined Slot, and clickOK.

The slot label in the Project tree changes to one of the following:
UserDefSymmetricSlot (user-defined symmetric slot),UserDefUnsymmetricSlot (user-
defined unsymmetric slot), orUserDefHalfSlot (user-defined half slot), depending on the
standard Slot Type on which it is based.

Standard Slot Types 1, 2, 3, 4, and 6 are symmetric. Standard slot Type 5 is unsymmetric. Half
slots are present if themachine’s Rotor or Stator PropertiesWindow includes a Half Slot
property that has been enabled.
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Related Topics

The Slot Editor Window
Slot Editor Data Editing View
Slot Editor Graphical View
The New Slot Dialog Box
Editing Slot Segments
Editing Unsymmetric Slots
Editing Half Slots
The Edit Slot Segments Dialog Box

The Slot Editor Window

When you select a user-editable slot in the Project tree, the Slot Editor window appears on the
desktop. The slot editor window is split into two frames. The left frame is the data editing view, which
contains an expandable tree view of the slot and its constituent segments. The right frame shows a
graphical view of the slot geometry formed by its segments.
Slot geometry types that can be edited are: symmetric, unsymmetric, and half-slot. A symmetric slot
is shown in the figure below.
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Related Topics

Slot Editor Data Editing View
Slot Editor Graphical View
The New Slot Dialog Box
Editing Slot Segments
Editing Unsymmetric Slots
Editing Half Slots
The Edit Slot Segments Dialog Box

Slot Editor Data Editing View

In the tree view, theSlot root tree item is predefined and cannot bemodified. The top segment in the
tree,Segment1, cannot be deleted. In the slot data edit view, the slot segment tree items always
follow in order from top to bottom of the slot. Segment names also follow this top-to-bottom order,
Segment1, Segment2, Segment3, etc., regardless of any operations that aremade. Adjacent
segments viewed in the tree are geometrically connected to each other as viewed on the slot graph.
The data of neighboring segments are tightly coupled due to this geometry connection.
Selecting a segment in the tree highlights the corresponding segment (and itsmirror image for
symmetric slots) in the Slot Editor Graphic view – indicated by small open circles at the endpoints of
the segments.

The PropertiesWindow is also updated to show the selected segment’s properties. Changing
segment values in the slot editor updates the PropertiesWindow, and vice-versa.

Related Topics

The Slot Editor Window
Slot Editor Graphical View
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TheNew Slot Dialog Box
Editing Slot Segments
Editing Unsymmetric Slots
Editing Half Slots
The Edit Slot Segments Dialog Box

Editing Symmetric Slots

For a symmetric slot, right-clicking theSlot tree item pops up a context menu displaying the
following choices:

l New Slot - opens theNew Slot dialog box in which the user can select a new standard
slot.

l Split to Half-Half - splits the slot into a Left Side and aRight Side transforming it into an
unsymmetric slot. Each side then can be edited independently.

l Remove Left (orRight) Half,Remove Right Half - removes the segments for the left (or
right) half of the symmetric slot, transforming the slot into a half-slot.

Related Topics

TheNew Slot Dialog Box
Editing Slot Segments
Editing Unsymmetric Slots
Editing Half Slots
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Editing Unsymmetric Slots

For an unsymmetric (i.e., split) slot type, two additional expandable sub-branches, Left Side
andRight Side, are present in the slot tree. The segments in each side can be edited
independently.

Right-clicking theSlot tree item pops up a context menu with the following choices:
l New Slot - opens theNew Slot dialog box in which the user can select a new standard
slot.

l Merge Left (orRight) to Symmetric - the left (or right) side segments aremirrored and
merged to form a symmetric slot.

l Left Right Flip - the left side and right side segments are flipped (reflected and
interchanged). The slot remains unsymmetric.

l Remove Left Half,Remove Right Half - removes the segments for the left (or right) half
of the symmetric slot, transforming the slot into a half-slot.

Right-clicking either theRight Side or Left Side sub-branch tree item opens a context menu
on which you can choose either:Merge to Symmetric, whichmirrors the selected side’s
segments andmerges the segments into a symmetric slot; orRemove, which removes the
selected side and all of its segments, resulting in a right or left half-slot.

Related Topics

TheNew Slot Dialog Box
Editing Slot Segments
Editing Symmetric Slots
Editing Half Slots
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Editing Half Slots

For a half slot, only the segments on one side of the slot can be edited.

Right-clicking theSlot tree item pops up a context menu displaying the following choices:
l New Slot - opens theNew Slot dialog box in which the user can select a new standard
slot.

l Merge to Symmetric - the left (or right) half-slot segments aremirrored andmerged to
form a symmetric slot.

l Left Right Flip - the left (or right) half-slot segments are flipped (reflected). The slot
remains unsymmetric.

l Mirror - the left (or right) half-slot segments aremirrored (reflected and copied),
transforming the slot into an unsymmetric slot.

Related Topics

TheNew Slot Dialog Box
Editing Slot Segments
Editing Symmetric Slots
Editing Unsymmetric Slots

The New Slot Dialog Box

SelectingNew Slot in any of theSlot tree item context menus opens theNew Slot dialog box.
Radio buttons allow the user to select aSymmetric Slot,Unsymmetrical Slot, Left Half Slot, or
Right Half Slot as the type to be added. ClickingOK confirms the choice and replaces the existing
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slot type in the editor with a slot of the selected type. The new slot has onlySegment1 present. The
user must then edit the slot segments to form the desired slot geometry.

Slot Editor Graphical View

The slot editor graphic view allows users either toView One Slot of the type currently being edited,
or toView theGeometry of themachine stator or rotor with all of the slots in place.

Right-clicking anywhere in the graphic view pops up a context menu. In addition to changing the
view, themenu provides commands to Zoom In and Zoom Out, to Fit All the view in the frame, as
well as commands to Insert,Append,Modify, andRemove slot segments. These commands are
discussedmore fully in the section onEditing Slot Segments.

Related Topics

The Slot Editor Window
Slot Editor Data Editing View
The New Slot Dialog Box
Editing Slot Segments
Editing Unsymmetric Slots
Editing Half Slots
The Edit Slot Segments Dialog Box

Editing Slot Segments

TheRMxprt Slot Editor allows users to edit the segments that form the geometry of slots. In the slot
data edit view, selecting a slot segment item on the tree, then right-clicking on it displays a context
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menuwith commands that allow users to Insert,Append,Modify, andRemove segments.
Alternatively, users can select a slot segment directly in the graphic view, then right-click to bring up a
context menu containing the same segment editing commands.
When a slot segment is selected, users can alsomodify the segment data directly in the desktop
property window. Each edit triggers immediate validation. If edited values are improper, warning
message windows are displayed describing the problem. Editing operations support Undo/Redo.
Scripting functions are also available.

l Insert Segment -adds a segment before the currently selected segment. The added
segment is defined by the user in theEdit Slot Segment dialog box.

NOTE: You cannot insert a segment beforeSegment1.

l Append Segment - adds a segment after (i.e., below) the currently selected segment. The
appended segment is defined by the user in theEdit Slot Segment dialog box.

l Modify Segment - modifies the currently selected segment. The segment ismodified by
the user in theEdit Slot Segment dialog box.

l Remove Segment - removes the currently selected segment. The ends of the segments
on either side of the removed segment are joined when the segment is removed.

NOTE: Segment1 cannot be removed.

The Edit Slot Segment Dialog Box

In theEdit Slot Segment dialog, user can define the shape and dimension(s) of the segment to be
added, inserted, or appended relative to the currently selected segment in the slot data edit view. As
shown below, eight basic geometric shapes are provided for defining the slot segment. The
Selected Shape panel shows dimensional parameters that affect the segment shape such as:
height, starting and ending width, and radius. Parameters that determine the shape of the segment
can be edited in theSegment Data panel.
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l Start width - sets the starting width and unit of
measure. The value shown depends on the ending
width of the previous segment and thus is not editable.

l End width - sets the ending width and unit of measure.
A drop-down box provides three additional options for
controlling the segment shape:

l Line edge (the default) - makes the segment a straight
line.

l Arc offset on slot center - makes the segment an arc
whose radius is determined by a user-specified offset
from the rotor/stator center with respect to the slot
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center.
l Arc offset on tooth center - makes the segment an
arc whose radius is determined by a user-specified
offset from the rotor/stator center with respect to the
tooth center.

l Start width - sets the starting width and unit of
measure. The value shown depends on the ending
width of the previous segment and thus is not editable.

l Height -sets the height and unit of measure for the
segment.

A drop-down box provides three options for controlling the
segment shape:

l End width (the default)- sets the ending width and unit
of measure.

l Parallel slot - effectively
sets the segment end width to the same value as the
start width resulting in the slot sides being parallel to
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each other.

l Parallel tooth - sets the
segment end width to a value such that the slot side is
parallel to the adjacent slot side of the tooth formed
between them.

l Start width - sets the starting width and unit of
measure. The value shown depends on the ending
width of the previous segment and thus is not editable.

l End width - sets the ending width and unit of measure.

l Start width - sets the starting width and unit of
measure. The value shown depends on the ending
width of the previous segment and thus is not editable.

l Radius - sets the radius and unit of measure for the
segment.

Validation of the entered data is done when either theOK or Preview is clicked. If edited values are
improper, warningmessage windows are displayed describing the problem. ThePreview button
allows users to preview the current changes in the slot graph window without confirming the
changes.
Clicking theOK button confirms the changes and closes the dialog box.
Clicking theCancel button cancels the changes and closes the dialog box.

Related Topics

TheNew Slot Dialog Box
Editing Slot Segments
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Editing Symmetric Slots
Editing Unsymmetric Slots
Editing Half Slots

Working with Variables in RMxprt

A variable is a numerical value, mathematical expression, or mathematical function that can be
assigned to a design parameter in RMxprt. Variables are useful in the following situations:

l When you expect to change a parameter often.
l When you expect to use the same parameter value often.
l When you intend to run a parametric analysis in which you specify a series of variable values
within a range to solve.

l When you intend to optimize a parameter value by running an optimization analysis.
There are two types of variables in RMxprt:

Project
Variables

A project variable can be assigned to any parameter value in the project in which it was
created. RMxprt differentiates project variables from other types of variables by
prefixing the variable namewith the $ symbol. You canmanually include the $ symbol in
the project variable's name, or RMxprt can automatically append the $ after you define
the variable.

Design
Variables

A design variable can be assigned to any parameter value in the RMxprt design in
which it was created.

Related Topics

Setting up anOptimetrics Analysis

Adding a Project Variable in RMxprt

A project variable can be assigned to a parameter value in the RMxprt project in which it was
created. RMxprt differentiates project variables from other types of variables by prefixing the variable
namewith the following symbol: $. You canmanually include the symbol $ in the project variable's
namewhen you create it, or RMxprt will automatically append the project variable's namewith the
symbol after you define the variable. Project variables can be used in any design within the project.

1. ClickProject>Project Variables.
l Alternatively, right-click the project name in the project tree, and then clickProject
Variables on the shortcut menu.

TheProperties dialog box appears.
2. Under theProject Variables tab, clickAdd.

TheAdd Property dialog box appears.
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3. In theName box, type the name of the variable.
Project variable namesmust start with the symbol $ followed by a letter. Variable namesmay
include alphanumeric characters and underscores ( _ ). The names of intrinsic functions and
the predefined constant pi (π) cannot be used as variable names.
You can sort the project variables by clicking on the Name column header. By default,
variables are sorted in original order. Clicking once sorts them in ascending order, noted by a
triangle pointing up. Clicking against sorts in descending order, noted by a triangle pointing
down. Clicking a third time sorts in original order, with no triangle.

4. Select a radio button for the variable use:

Selected Use Setable Properties
Variable Unit Type, Units, Value.

Separator Value

Array Index
Variable

Associate Array variable,
Value

Each selection affects the settable options.
5. For Project Variables in theUnit Type text box you can use the drop downmenu to select

from the list of available unit types. “None” is the default.
When you select a Unit Type, the choices in drop-downmenu for the Units text box adapt to
that unit type. For example, selecting Length as the Unit Type causes theUnitmenu to show
a range of metric and english units for length. Similarly, if you select the Unit Type as
Resistance, the Units drop down lists a range of standard Ohmunits.

6. In theValue box, type the quantity that the variable represents. Optionally, include the units of
measurement.

Warning If you include the variable's units in its definition (in theValue box), do not include
the variable's units when you enter the variable name for a parameter value.

The quantity can be a numerical value, amathematical expression, or amathematical
function. The quantity entered will be the current, or default, value for the variable.

7. ClickOK.
You return to theProperties dialog box. The new variable and its value are listed in the table.
If the value is an expression, the evaluated value is shown. Updating the expression also
changes the evaluated value display. The evaluated values of any dependent variables also
are changed.
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8. Optionally, type a description of the variable in theDescription box.
9. Optionally, selectRead-Only. The variable's name, value, unit, and description cannot be

modified whenRead-only is selected.
10. Optionally, selectHidden. If you clear theShow Hidden option, the hidden variable will not

appear in theProperties dialog box.
11. You can also designate a variable as Sweep. Youmay need to use the scroll bar or resize the

dialog to view the check boxes.

The Sweep check box lets you designate variables to include in solution indexing as a way to
permit faster post processing. Variables with Sweep unchecked are not used in solution
indexing. If a solution exists, checking or unchecking a variable’s Sweep setting produces a
warning that the change will invalidate existing solutions. To continue, clickOK to dismiss the
warning dialog.
If a variable has dependent variables, the Sweep check box is disabled and cannot be
changed.

12. ClickOK.
The new variable can now be assigned to a parameter value in the project in which it was created.

Adding a Design Variable in RMxprt

A design variable is associated with an RMxprt design. A design variable can be assigned to a
parameter value in the RMxprt design in which it was created.

1. ClickRMxprt>Design Properties.
l Alternatively, right-click the design name in the project tree, and then clickDesign
Properties on the shortcut menu.

TheProperties dialog box appears opened on the Local Variables tab. From the Properties
dialog you can Add, Add Array, Edit, or Remove variables.

Getting Started with RMxprt 26-61
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Any existing Design variables are listed in theProperties dialog with the name followed by
cells for Value, Unit, Evaluated Value, Type, Description, and Read-only and Hidden check
boxes. A Show Hidden check box on the lower right of the Properties dialog controls the
appearance of anyHidden variables.
Initially, leave the radio button with Value selected until you have defined a variable. The other
radio buttons let you enable defined variables for Optimization/Design of Experiments,
Tuning, Sensitivity or Statistics. Selecting one of these radio buttons adds a new column to the
Variable definition row for which you can check or uncheck Include for regular variables for
that kind of Optimetrics simulation.

2. ClickAdd.
TheAdd Property dialog box appears.

3. In theName box, type the name of the variable.
Variable namesmust start with a letter, andmay include alphanumeric characters and
underscores ( _ ). The names of intrinsic functions and the predefined constant pi (π) cannot
be used as variable names.
You can sort the variables by clicking on the Name column header. By default, variables are
sorted in original order. Clicking once sorts them in ascending order, noted by a triangle
pointing up. Clicking against sorts in descending order, noted by a triangle pointing down.
Clicking a third time sorts in original order, with no triangle.

4. Select a radio button for the variable use:

Selected Use Setable Properties
Variable Unit Type, Units, Value

Array Index Variable Associate Array variable,
Value

Separator Value

Post Processing
Variable

Unit Type, Units, Value

Each selection affects the settable options.
5. In theUnit Type text box you can use the drop-downmenu to select from the list of available

unit types. “None” is the default.
When you select a Unit Type, the choices in drop-downmenu for the Units text box adapt to
that unit type. For example, selecting Length as the Unit Type causes the Unit menu to show a
range of metric and english units for length. Similarly, if you select the Unit Type as
Resistance, the Units drop down lists a range of standard Ohmunits.

6. In theValue box, type the quantity that the variable represents. Optionally, include the units of
measurement.
Note If you include the variable's units in its definition (in theValue box), do not include the

variable's units when you enter the variable name for a parameter value.
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The quantity can be a numerical value, amathematical expression, or amathematical
function. The quantity entered will be the current (or default value) for the variable. If the
mathematical expression includes a reference to an existing variable, this variable is treated
as a dependent variable. The units for a dependent variable will automatically change to those
of the independent variable on which the value depends. Additionally, dependent variables,
though useful in many situations, cannot be the direct subject of optimization, sensitivity
analysis, tuning, or statistical analysis.

Note Complex numbers are not allowed for variables to be used in anOptimetrics sweep, or for
optimization, statistical, sensitivity or tuning setups.

7. ClickOK.
You return to theProperties dialog box. The new variable and its value are listed in the table.
If the value is an expression, the evaluated value is shown. Updating the expression also
changes the evaluated value display. The evaluated values of any dependent variables also
are changed.

8. Optionally, type a description of the variable in theDescription box.
9. You can designate a variable asRead-only, Hidden, or Sweep. Youmay need to use the

scroll bar or resize the dialog to view the check boxes.

The Sweep check box lets you designate variables to include in solution indexing as a way to
permit faster post processing. Variables with Sweep unchecked are not used in solution
indexing. If a solution exists, checking or unchecking a variable’s Sweep setting produces a
warning that the change will invalidate existing solutions. To continue, clickOK to dismiss the
warning dialog.
If a variable has dependent variables, the Sweep check box is disabled and cannot be
changed.

10. ClickOK.
The new variable can now be assigned to a parameter value in the design in which it was created.
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Add Array of Values for an RMxprt Design Variable

A design variable is associated with an RMxprt design. You can also add a variable defined with an
array of values.

1. ClickRMxprt>Design Properties.
l Alternatively, right-click the design name in the project tree, and then clickDesign
Properties on the shortcut menu.
The Local VariablesProperties dialog box appears. From the Properties dialog you can
Add, Add Array, Edit... or Remove variables. This section describes Add Array. Use the
links for descriptions of Add,.Edit and Remove,

Any existing Design variables are listed in theProperties dialog with the name followed by
cells for Value, Unit, Evaluated Value, Type, Description, and Read-only and Hidden check
boxes. A Show Hidden check box on the lower right of the Properties dialog controls the
appearance of anyHidden variables.
Initially, leave the radio button with Value selected until you have defined a variable. The
other radio buttons let you enable regular variables for Optimization/Design of Experiments,
Tuning, Sensitivity or Statistics. Array variables cannot be enabled for Optimetrics use.

2. Click theAdd Array.... button.
TheAdd Array dialog displays.

3. Specify a variable Name in the text field.
4. Select a Unit Type and Units from the drop-downmenus.

5. To specify the array with Edit in Grid Selected, you can begin by clicking theAppend Rows...
button to display theNumber of Rows dialog. (For Edit in plain text field, see below.)
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6. Specify a value and clickOK.
This displays a list of indexed data rows in theAdd Array dialog. You can type any data value
in the cells. If you enter alphanumeric text in a cell it must be delimited by double quotes. You
can edit the rows relative a row selection by clicking buttons to Add Row Above, Add Row
Below, or Remove Row. All cellsmust contain a value.

7. When you have completed the array, clickOK to close the dialog,
The Array variable is listed in theDesign Properties dialog as a Local Variable. The array
variable value field includes the array contents in brackets with the unindexed data values
delimited by commas.
If you elected to edit the array Edit in plain text field in theAdd Array dialog, the bracketed and
comma delimited format is used.

Defining Mathematical Functions in RMxprt

Amathematical function is an expression that references another defined variable. A function's
definition can include both expressions and variables.
The followingmathematical functionsmay be used to define expressions:

Basic
functions

/, +, -, *, mod (modulus), ** (exponentiation), - (Unaryminus), == (equals), ! (not),
!= (not equals), > (greater than), < (less than), >= (greater than equals), <= (less
than equals),&& (logical and), || (logical or)

Intrinsic
functions

if, sqn, abs, exp, pow, ln (natural log), sqrt

Trigonometric
expressions

sin, cos, tan, asin, acos, atan, sinh, cosh, tanh

The predefined variables X, Y, Z, Phi, Theta, R, and Rhomust be entered as such. X, Y, and Z are
the rectangular coordinates. Phi, Theta, and Rho are the spherical coordinates. R is the cylindrical
radius, and Rho is the spherical radius.
If you do not specify units, all trigonometric expressions expect their arguments to be in radians, and
the inverse trigonometric functions’ return values are in radians. If you want to use degrees, you
must supply the unit name deg. When the argument to a trigonometric expression is a variable, the
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units are assumed to be radians. These function names are reserved andmay not be used as
variable names.

Defining an Expression in RMxprt

Expressions aremathematical descriptions that typically contain intrinsic functions, such as sin(x),
and arithmetic operators, such as +, -, *, and /, as well as defined variables. For example, you could
define: x_size = 1mm, y_size = x_size + sin(x_size).

The symbol, pi ( ), is the only available predefined constant. It may not be reassigned a new value.
Numerical valuesmay be entered in ANSYS’ shorthand for scientific notation. For example, 5x107
could be entered as 5e7.

Using Valid Operators for Expressions in RMxprt

The operators that can be used to define an expression or function have a sequence in which they
are performed. The following list shows both the valid operators and the sequence in which they are
accepted (listed in decreasing precedence):

( ) parenthesis 1
! not 2
^ (or
**)

exponentiation
(If you use "**" for exponentiation, as in previous software versions, it is automatically
changed to "^".)

3

- unaryminus 4

* multiplication 5
/ division 5
+ addition 6
- subtraction 6
== equals 7
!= not equals 7
> greater than 7
< less than 7
>= greater than or equal to 7
<= less than or equal to 7
&& logic and 8
|| logic or 8
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Using Intrinsic Functions in Expressions in RMxprt

RMxprt recognizes a set of intrinsic trigonometric andmathematical functions that can be used to
define expressions. Intrinsic function names are reserved andmay not be used as variable names.
The following intrinsic functionsmay be used to define expressions:

Function Description Syntax
abs Absolute value (|x|) abs(x)
sin Sine sin(x)
cos Cosine cos(x)
tan Tangent tan(x)
asin Arcsine asin(x)
acos Arccosine acos(x)
atan Arc tangent. Takes a tangent value as an argument. Because there are two

angles in a circle that can have the same tangent value, and atan can return
only one value, it returns a value in the range between -90 degrees and +90
degrees (or between -pi/2 and pi/2 in radians).

atan(x)

atan2 A two-argument version of the atan function. Takes the y and x coordinates
(including sign information) of a point as arguments and returns the angle
from the X-axis. Can return angle values for the full circle (-180 degrees to
+180 degrees or -pi to +pi in radians).

atan2
(y,x)

asinh Hyperbolic Arcsine asinh(x)
atanh Hyperbolic Arctangent atanh(x)
sinh Hyperbolic Sine sinh(x)
cosh Hyperbolic Cosine cosh(x)
tanh Hyperbolic Tangent tanh(x)
even Returns 1 if integer part of the number is even; returns 0 otherwise. even(x)
odd Returns 1 if integer part of the number is odd; returns 0 otherwise. odd(x)
sgn Sign extraction sgn(x)
exp Exponential (ex) exp(x)
pow Raise to power (xy) pow(x,y)
if If if(cond_

exp,true_
exp,
false_
exp)

pwl Piecewise Linear with linear extrapolation on x pwl
(dataset_
exp,
variable)
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pwlx Piecewise Linear x with linear extrapolation on x pwlx
(dataset_
exp,
variable)

pwl_
periodic

Piecewise Linear with periodic extrapolation on x pwl_
periodic
(dataset_
exp,
variable)

sqrt Square Root sqrt(x)
ln Natural Logarithm

(The "log" function has been discontinued. If you use "log(x)" in an
expression, the software automatically changes it to "ln(x)".)

ln(x)

log10 Logarithm base 10 log10(x)
int Truncated integer function int(x)
nint Nearest integer nint(x)
max Maximum value of two parameters max(x,y)
min Minimum value of two parameters min(x,y)
mod Modulus mod(x,y)
rem Fractional part (remainder) rem(x.y)

Note If you do not specify units, all trigonometric functions interpret their arguments as radians.
Likewise, inverse trigonometric functions' return values are in given in radians.When the
argument to a trigonometric expression is a variable, the units are assumed to be radians.
If you want values interpreted in degrees, supply the argument with the unit name deg.

Using Piecewise Linear Functions in Expressions in RMxprt

The following piecewise linear intrinsic functions are accepted in expressions:
pwl (dataset_expression, variable)
pwlx (dataset_expression, variable)
pwl_periodic (dataset_expression, variable)

The pwl and pwlx functions interpolate along the x-axis and returns a corresponding y value. The
pwl_periodic function also interpolates along the x-axis but periodically.

Using Dataset Expressions in RMxprt

Dataset expressions take the following form:
dset((x0,y0), ..., (xn,yn))
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These expressionsmay be used as the first parameter to piecewise linear (pwl, pwlx and pwl_
periodic) functions, andmay also be assigned to variables, in which case the variablemay be used
as the second parameter to pwl, pwlx and pwl_periodic functions.
Dataset expressions are derived from a series of points in a plot created in theDatasets dialog box.
Each plot consists of straight line segments whose vertices represent their end points. A curve is
fitted to the segments of the plot, and an expression is derived from the curve that best fits the
segmented plot. The created expression is then used in the piecewise linear intrinsic functions.

Assigning Variables in RMxprt

To assign a variable to a parameter in RMxprt:
l Type the variable name or mathematical expression in place of a parameter value in aValue
box.
If you typed a variable name that has not been defined, theAdd Variable dialog box appears,
enabling you to define the design variable.
If you typed a variable name that included the $ prefix, but that has not been defined, theAdd
Variable dialog box appears, enabling you to define the project variable.
You can assign a variable to nearly any design parameter assigned a numeric value in
RMxprt.

Choosing a Variable to Optimize in RMxprt

Before a variable can be optimized, youmust specify that you intend for it to be used during an
optimization analysis in theProperties dialog box.

1. If the variable is a design variable, clickRMxprt>Design Properties.
If the variable is a project variable, clickProject>Project Variables.
TheProperties dialog box appears.

2. Click the tab that lists the variable you want to optimize.
3. Click the row containing the variable you want to optimize.

Note Dependent variables cannot be
optimized.

4. Select theOptimization/Design of Experiments option.
5. For the variable you want to optimize, select Include.

The selected variable is now available for optimization in an optimetrics setup defined in the
current design or project.

6. Optionally, override the default minimumandmaximum values that Optimetrics will use for the
variable in every optimization analysis. During optimization, the optimizer does not consider
variable values that lie outside of this range.

7. ClickOK.
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Related Topics

Setting up anOptimization Analysis

Including a Variable in a Sensitivity Analysis in RMxprt

Before a variable can be included in a sensitivity analysis, youmust specify that you intend for it to be
used during a sensitivity analysis in theProperties dialog box.

1. If the variable is a design variable, clickRMxprt>Design Properties.
If the variable is a project variable, clickProject>Project Variables.
TheProperties dialog box appears.

2. Click the tab that lists the variable you want to include in the sensitivity analysis.
3. Click the row containing the variable you want to include in the sensitivity analysis.

Note Dependent variables cannot be included in a sensitivity
analysis.

4. Select theSensitivity option.
5. For the variable you want to include in the sensitivity analysis, select Include.

The selected variable is now available for sensitivity analysis in a sensitivity setup defined in
the current design or project.

6. Optionally, override the default minimumandmaximum values that Optimetrics will use for the
variable in every sensitivity analysis. During sensitivity analysis, Optimetrics will not consider
variable values that lie outside of this range.

7. Optionally, override the default initial displacement value that Optimetrics will use for the
variable in every sensitivity analysis. During sensitivity analysis, Optimetrics will not consider a
variable value for the first design variation that is greater than this step size away from the
starting variable value.

8. ClickOK.

Related Topics

Setting up a Sensitivity Analysis

Choosing a Variable to Tune in RMxprt

Before a variable can be tuned, youmust specify that you intend for it to be tuned in theProperties
dialog box.

1. If the variable is a design variable, clickRMxprt>Design Properties.
If the variable is a project variable, clickProject>Project Variables.
TheProperties dialog box appears.
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2. Click the tab that lists the variable you want to tune.
3. Click the row containing the variable you want to tune.

Note Dependent variables cannot be
tuned.

4. Select the Tuning option.
5. For the variable you want to tune, select Include.
6. ClickOK.

The selected variable is now available for tuning in the Tune dialog box.

Related Topics

Tuning a Variable

Including a Variable in a Statistical Analysis in RMxprt

Before a variable can be included in a statistical analysis, youmust specify that you intend for it to be
used during a statistical analysis in theProperties dialog box.

1. If the variable is a design variable, clickRMxprt>Design Properties.
If the variable is a project variable, clickProject>Project Variables.
TheProperties dialog box appears.

2. Click the tab that lists the variable you want to include in the statistical analysis.
3. Click the row containing the variable you want to include in the statistical analysis.

Note Dependent variables cannot be included in a statistical
analysis.

4. Select theStatistics option.
5. For the variable you want to include in the statistical analysis, select Include.

The selected variable is now available for statistical analysis in a statistical setup defined in the
current design or project.

6. Optionally, override the distribution criteria that Optimetrics will use for the variable in every
statistical analysis.

7. ClickOK.

Related Topics

Setting up a Statistical Analysis
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Working with Materials in RMxprt
RMxprt sharesmany common functions related tomaterials andmaterial handling withMaxwell3D
andMaxwell2D. For general topics such as, AssigningMaterials, Searching for Materials, Adding
New Materials, and Viewing andModifyingMaterial Attributes, see the topics in Maxwell help under
Assigning Materials.
RMxprt includes amaterial library containing commonmaterials used inmotor design. However,
this library needs to be configured so that it is automatically loaded for any new RMxprt design.
Once the library is configured, you can add, remove, and edit RMxprt materials in twomain ways:

l Using the Tools>Edit Libraries>Materials menu command.
l Right-clickingMaterials in the project tree and selectingEdit Library.

Editing definitions from the project window does not modify the configured libraries for any particular
design. To consider the current design, use the Tools>Edit Libraries option. Doing so ensures that
new libraries are added to the configured list for the current design. If you edit materials from this
command for the current and then export them, theywill also be available to assign to objects in
other designs.

Related Topics

Material LibraryManagement for RMxprt

Material Library Management for RMxprt

The threemost crucial electromagneticmaterials in the electricmachine are soft-magneticmaterial
(silicon steel sheet), hard-magneticmaterial (permanent magnet) and electromagnetic wire. It is
convenient to create a data file library for them for quick selection while inputting design data.

Soft-Magnetic Materials

The stator and the rotor iron cores in the electricmachine are generally laminated with punched
sheets of nonlinear soft-magnetic silicon steel. Some special types of electricmachines, such as
moment motor, turbo-generator etc., use integrated solid rotor iron core of soft-magneticmaterial.
For magnetic field analysis and core loss analysis of the electricmachine, themagnetization
characteristics (B-H Curve) and the loss characteristics (B-P Curve) of the iron-corematerial must
be defined. The dialogue boxes to do so are accessed from theView/Edit Material window, which,
in turn is accessed from the Edit Librarieswindow. Access to the window for editing the B-H curve
is enabled when you set theMagnetic Permeability value to nonlinear (rather than simple or
Anisotropic). When you set the value to nonlinear, the value field changes to a B-H Curve button.
Click the B-H curve button to open the window.
For the loss characteristics (B-P Curve), you first set theCore Loss Model of thematerial to
Electrical Steel (rather thanNone or Power Ferrite) as amaterial property in theView/Edit
Materialwindow.When you do so, this enables theCalculate Properties selection for drop down
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at the bottom of the window. SelectCore Loss Coefficient from the drop downmenu to open the
B-P Curve window.

Related Topics

Adding New Materials to an RMxprt Project
Setting theMaterial Threshold for RMxprt
AssigningMaterials
RemovingMaterials
ValidatingMaterials
SortingMaterials
Viewing andModifyingMaterial Attributes
CopyingMaterials
ExportingMaterials to a Library
Calculating Properties for Core Loss in RMxprt (BP Curve)

Adding New Materials to an RMxprt Project

You can add a new material to a project or to the global user-definedmaterial library. Tomake the
new project material available to all projects, youmust export thematerial to a global user-defined
material library.
To assign amaterial to an object:

1. ClickTools>Edit Libraries>Materials.
l In the project tree, you can also right-clickMaterials, and selectEdit Library.
TheEdit Libraries dialog box appears.

1. ClickAdd Material.
TheView/Edit Material dialog box appears.

2. Type a name for the new material in the Material Name text box.
3. In theView/Edit Material for section, select whether thismaterial should be available for the

Active Design only, for This Product only or forAll Products. The selectionmakes a
difference in the properties displayed.
Note When you select certain Type or Value options, additional parameters appear

beneath some properties in the sameway thatMagnitude appears beneath
Magnetic Coercivity. As necessary, specify values for any additional parameters
that appear.

4. In theProperties of the Material table, specify the Type and theValue for the following
material properties, displayed whenActive Design is selected:
l Relative Permeability.
l Bulk Conductivity
l Magnetic Coercivity (including theMagnitude of the vector)

Getting Started with RMxprt 26-73
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l Core LossModel - model selections for this propertymay enable access to coefficient
calculation windows, and enable additional properties.

l MassDensity
If you select This Product, additional fields are displayed.
l Relative Permittivity
l Dielectric Loss Tangent
l Magnetic Loss Tangent
l Composition

5. Optionally, change theUnits for any of the properties.
6. ClickValidate Material to verify the settings you have specified are valid for the existing

properties.
If thematerial setup is valid, a green checkmark appears below the Validate Material
button.

7. ClickOK to save the new material.
TheEdit Libraries dialog box reappears, with the new material added to the list of materials.

8. ClickOK to close the Edit Libraries dialog box.

Relative Permittivity for RMxprt Material

Specify the following for Relative Permittivity. and specify the units.

Type Value
Simple Type a value for theRelative

Permittivity.
Anisotropic The following two parameters appear:

l T(1,1)
l T(2,2)

Type a simple value for each.

Note This property is not used in RMxprt design analysis, but it will be transferred toMaxwell 3D
Design automatically when the design is created byRMxprt.

Relative Permeability for a Maxwell or RMxprt Material

Select one the following for relative permeability and specify the units:

Type Value
Simple Type a value for theRelative Permeability.
Anisotropic The following parameters appear:

l T(1,1)
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l T(2,2)
l T(3,3)

Select either aSimple orNonlinear Type for each of these parameters.
Nonlinear ClickBH Curve, and specify the coordinates for the BH-curve in the BH Curve

dialog box.
Also enables X, Y, and Z Component unit vector fields for Magnetic Coercivity.

Note The current release adds support for Nonlinear and Anisotropic properties for 3D Eddy
current solutions. To support nonlinearity in the frequency domain, the equivalent BH
curve is required. In the current release, this equivalent BH curve is derived based on the
average of permeability of one period under the assumption that the flux density B is
sinusoidal and themagnetic field H is non-sinusoidal due to nonlinearity.

Note The Anisotropic type is not used in RMxprt
design.

Specifying a BH Curve for Nonlinear Relative Permeability

When you define a new material or edit an existingmaterial in theView /Edit Materialswindow with
a nonlinear relative permeability, you need to specify themagnetization characteristics (B-H Curve).

1. Open theView / Edit Materials dialog from theEdit Materialswindow either by:
l Selecting an existingmaterial that you need to edit, and clickView / Edit Material.
l ClickingAdd Material.
Any of these actions open theView/ Edit Materials dialog box.

2. For theRelative Permeability property do one of the following (depending on the type of
material you are defining):
a. SelectNonlinear as the Type. A B-H Curve button appears in theValue column.
b. SelectAnisotropic as the Type to display the additional parameters: T(1,1), T(2,2), T

(3,3).

SelectingNonlinear for any of these additional parameters also causes aB-H Curve button
to appear in theValue column.

Input the BH curve by clicking theB-H Curve button opens the BH Curve dialog box.
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3. Set theUnits forH andB by selecting from the drop downmenus.
4. Choose the type of curve you want to define by selecting eitherNormal or Intrinsic.

For amaterial property without an existing BH curve definition, the dialog openswith an empty
list of coordinates and the default type will beNormal. For a property with existing BH curve
definition, the selected radio button corresponds to the existing B type.

Note l The IntrinsicBH curve is supported only in Maxwell 2D/3D magnetostatic, Eddy
current, and transient design types. A material property defined using an Intrinsic BH
curve will fail validation check in all the other product/design types.

l When an IntrinsicBH curve is added, theRelative Permeability Value button
label in theView/Edit Material dialog box changes toBi-H Curve as visual
indication of the type of curve currently defined for thematerial.

You can change the type at any time. For an existing curve, validation checks are performed
on the coordinate list when you attempt to change the type. If the data is not valid, an error
message will be displayed and the type of B will not be changed. If data is valid, a query dialog
box displays asking if the coordinates should be converted.
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PressingNo can be used, fer example, when users have specified the BH coordinates and
then realize they haven't select the desired type.

Note Changing the type of the BH curve invalidates all solution
data

5. Enter B and H values in each row of theCoordinates table. Placing the cursor in a table cell
enables theAdd Row Above,Add Row Below, andDelete Rows buttons.
Note the following requirements for creating a valid curve:
l For aNormalBH curve, the slope of the curve can not be less than that of free space
anywhere along the curve.

l For an IntrinsicBH curve, the slope of the curve can not be less than 0.
l The value of B must increase along the curve.
l The initial value of B must be 0 (zero).
l Since BH operating points in the FEA solutionmay extend beyond the input BH data set,
the BH data set is extrapolated inMaxwell. The slope of the last two user-defined data
points is used to extrapolate the BH curve, and thus should be as close to μ0 as possible.

l The data points representing the BH curve should have enough points for accurate
representation of the curve. Twenty (20) or more points should be specified with increased
representation on the "knee" of the curve.

As you enter values, the graph is updated.
To Add or Edit rows, you can click the following buttons:

l AddRow Above
l AddRow Below
l Append Rows (to specify the number of rows to append to the table)
l Delete Rows

Optionally, click Import Dataset to import BH curve data from a file, and if they are in the
wrong columns, clickSwap X-Y Data to switch the B values and H values in the graphics
display. You can also use the SheetScan tool to extract curve data from sources such as
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manufacturer datasheets to a dataset, which can then be exported to a tab-delimited file, and
imported via Import Dataset. (Refer toAdding Datasets andExporting Datasets for related
information on working with datasets. Refer toUsing SheetScan for working with the
SheetScan tool.)
Normal BH curveswith a positive B value at the first point will be extrapolated. Intrinsic curves
are not extrapolated.

6. When finished entering data, clickOK to close the window.
When youOK the dialog, an error message displays if a slope is out of tolerance, identifying
the data points between which the slope is less than that of free space. Out of tolerance data
pointsmust be corrected before you can successfully exit the dialog. If the slope of the last two
points ismore than twice the permeability of free space, a warningmessage is issued during
the solution. The slope of the last 2 points should be as close to μ0 as possible to represent a
fully saturatedmaterial.
The BH curve you have defined is associated with the Relative Permeability property of the
material.

Note When an IntrinsicBH curve is added, theRelative Permeability Value button label
changes to Bi-H Curve as visual indication of the type of curve currently defined for the
material.
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Bulk Conductivity for an RMxprt Material

Specify the following for bulk conductivity and specify the units:

Type Value
Simple Type a value for the Bulk Conductivity.
Anisotropic The following two parameters appear:

l T(1,1)
l T(2,2)

You can specify aSimple orNonlinear type for each of these
parameters.

Note The Anisotropic type is not used in RMxprt
designs.

Dielectric Loss Tangent for RMxprt Material

Specify the following for dielectric loss tangent.

Type Value
Simple Type a value for the Bulk

Conductivity.
Anisotropic The following two parameters appear:

l T(1,1)
l T(2,2)

Type a simple value for each.

Note This property is not used in RMxprt design analysis, but it will be transferred toMaxwell 3D
Design automatically when the design is created byRMxprt.

Magnetic Loss Tangent for RMxprt Material

Type Value
Simple Type a value for the Bulk

Conductivity.
Anisotropic The following two parameters appear:

l T(1,1)
l T(2,2)
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Type a simple value for each.

Note This property is not used in RMxprt design analysis, but it will be transferred toMaxwell 3D
Design automatically when the design is created byRMxprt.

Magnetic Coercivity for Maxwell and RMxprt Materials

Specify the following for magnetic coercivity and specify the units:

Type Value
Vector Appears by default.

l If the Relative Permeability Type is either Simple orAnisotropic, enter aValue for
theMagnitude.

l If the Relative Permeability Type is Nonlinear, Magnitude becomes uneditable, and
three additional fields of TypeUnit Vector: X Component, Y Component, and Z
Component appear in which you can enter values or specify functions.

Core Loss Model for an RMxprt Material

Specify the following for core loss type and specify the units:

Name Value
None No core loss is to be calculated for thismaterial.
Electrical
Steel

The following parameters appear:
l Kh: Hysteresis
l Kc: Classical Eddy
l Ke: Excess

Selecting Electrical Steel also enables the Calculate Properties for Core Loss
Coefficient pull-down list item at the bottom of the dialog box. Selecting theCore Loss
Coefficient opens theBP Curve window.

Power
Ferrite

The following parameters appear:
l Cm
l X
l Y

Selecting Power Ferrite also enables the Calculate Properties for Core Loss versus
Frequency pull-down list item at the bottom of the dialog box. Selecting theCore Loss
versus Frequency opens theBP Curve window.
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Calculating Properties for Core Loss in RMxprt (BP Curve)

To be able to extract parameters from the loss characteristics (B-P Curve), you first set theCore
Loss Model of thematerial to Electrical Steel as amaterial property in theView / EditMaterial
window.
To calculate core loss properties for an electrical steel material:

1. ClickTools>Edit Libraries>Materials.
l Or in the project tree, you can also right-clickMaterials, and selectEdit Library.
TheEdit Libraries window appears.

1. ClickAdd Material.
TheView/Edit Materialwindow appears.

2. In theCore Loss Type row, selectElectrical Steel from theValue pull-down list.
This enables theCalculate Properties for pull-downmenu at the bottom of the dialogue box
with the following two choices:
l Calculate Properties for: Core Loss at One Frequency
l Calculate Properties for: Core Loss versus Frequency
It also displays parameters associated with Electrical Steel materials.

Electrical Steel Core Loss from a Single-Frequency Loss Curve

With theCore Loss Type set to Electrical Steel:
1. SelectCore Loss at One Frequency from theCalculate Properties for: pull-downmenu.

TheBP Curvewindow appears.
2. Do one of the following to specify a BP curve:

l Import the curve from a saved file.
l Enter the coordinatesmanually.

Note The accuracy in inputting the data for B-P Curve for the electrical steel material
has significant effect on the correctness of the analyses to the electromagnetic
characteristics of the electricmachine. You should input the data for B-P Curve
according to the accurate data provided by themanufacturers of materials.

3. Select the units in which the B-P curve ismeasured from theCore Loss Unit pull-down list.
4. Type values and select units for the following:

l MassDensity
l Frequency
l Thickness
l Conductivity
The following parameters are dynamically updated with both the specified unit and the
standard unit (w/m^3) as the input data changes.
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l Kh -Hysteresis
l Kc - Classical Eddy
l Ke - Excess

5. ClickOK.
The View/Edit Material dialog box reappears. The property values froKh,Kc, andKe are
updated as new default values.

Computation of Core Loss from a Single-Frequency Loss Curve

The principles of the computation algorithm are summarized as follows.
The iron-core loss is expressed as:

where the eddy-current loss is

the hysteresis loss is

and the excessive loss is

Therefore
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The classical eddy-current loss coefficient is calculated directly as

where σ is the conductivity and d is the thickness of one lamination sheets.
Minimize the quadratic form to obtainK1 andK2.

wherePvi , Bmi – the i-th point of the data on the loss characteristics curve.
The other two loss coefficients are obtained as

where f0 is the testing frequency forB-H Curve.
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Related Topics

Calculating Properties for Core Loss (BP Curve) for Maxwell
Core LossCoefficients for Electrical Steel
Core LossCoefficient Extraction
Core LossModel for aMaxwell Material

Electrical Steel Core Loss from Multi-Frequency Loss Curves

With theCore Loss Type set to Electrical Steel:
1. SelectCore Loss versus Frequency from theCalculate Properties for: pull-downmenu.

TheCore Loss versus Frequencywindow appears as shown:

2. Using the Edit area,Add frequency points at which a dataset is available for the Core Loss.
3. For each Dataset added, click theEdit Dataset button to launch the Edit Dataset dialog.
4. Add Dataset information for the frequency bymanually entering the data or importing the data

from a table. ClickOK to accept the dataset and return to theCore Loss versus Frequency
dialog. Continue adding dataset information until all frequencies have datasets defined.

5. ClickOK when all frequencies have valid data to complete the core loss calculation and return
to theView/Edit Material dialog.
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Computation of Core Loss from Multi-Frequency Loss Curves

The principles of the computation algorithm are summarized as follows.
The iron-core loss is expressed as:

Minimize the quadratic form to obtain kh , kc and ke directly.

wherem - the number of loss curves, ni - the number of points of the i-th loss curve, and
Pvij = f(fi , Bmij) - two dimensional lookup table for multi-frequency loss curves.

Power Ferrite Core Loss from Multi-Frequency Loss Curves

With theCore Loss Type set to Power Ferrite:
1. SelectCore Loss versus Frequency from theCalculate Properties for: pull-downmenu.

TheCore Loss versus Frequencywindow appears as shown:
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2. Using the Edit area,Add frequency points at which a dataset is available for the Core Loss.
3. For each Dataset added, click theEdit Dataset button to launch the Edit Dataset dialog.
4. Add Dataset information for the frequency bymanually entering the data or importing the data

from a table. ClickOK to accept the dataset and return to theCore Loss versus Frequency
dialog. Continue adding dataset information until all frequencies have datasets defined.

5. ClickOK when all frequencies have valid data to complete the core loss calculation and return
to theView/Edit Material dialog.

Computation of Power Ferrite Core Loss from Loss Curves

The principles of the computation algorithm are summarized as follows.
The iron-core loss is expressed as:

or
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where

Minimize the quadratic form to obtain c, x and y.

wherem - the number of loss curves, ni - the number of points of the i-th loss curve, and
Pvij = f(fi , Bmij) - two dimensional lookup table for multi-frequency loss curves. Then Cm is
calculated from the equation above.

Mass Density for RMxprt Material

Provide a Simple value for Mass density in kg/m^3.

Composition for RMxprt Material

Specify whether the composition is Solid or Lamination.
If Lamination, specify the:

l Stacking Factor - takes a simple value
l Stacking Direction - a drop downmenu lets you select V(1), V(2), or V(3).

Note This property is not used in RMxprt design analysis, but it will be transferred toMaxwell 3D
Design automatically when the design is created byRMxprt.

Permanent Magnet Materials in RMxprt

A permanent magnet is defined as amaterial that generates amagnetic flux due to permanent
magnetic dipoles in that material.

Compute Remanent Br from B-H curve

The value of the remanent Br of the individual element after themagnetization field is computed is
determined in such a way: after having located the operating point on the original non-remanent B-H

curve, draw a line which is parallel to the original recoil curve with the slope of and passes the
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operating point, the intersection of this line with B-axis is the remanent Br as the result of the applied
magnetization field.

Calculating the Properties for a Non-Linear Permanent Magnet in RMxprt

Non-linear permanent magnet propertiesmay be specified in one of two ways.

First, a BH curve may be input directly as follows:

1. Click theView/Edit Materials… button in theEdit Libraries dialog box.
TheView/Edit Material dialog box appears.

2. The nonlinear BH curve is defined by setting theRelative PermeabilityType either to
Nonlinear orAnisotropic.
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If you select Anisotropic, each of its components can be selectedNonlinear and can be
specified by aBH Curve.

A B-H Curve button appears in the nonlinear property’sValue column
3. Input the BH curve by clicking theB-H Curve button in the propertyValue column.

This opens theBH Curve dialog box in which you can input (or modify) curve data. (Refer to
Adding Datasets for general information on working with datasets.

Getting Started with RMxprt 26-89
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l For aNormalBH curve, the slope of the curve can not be less than that of free space
anywhere along the curve.

l For an IntrinsicBH curve, the slope of the curve can not be less than 0.
Note l The IntrinsicBH curve is supported only in Maxwell 2D/3D magnetostatic

and transient design types. A material property defined using an Intrinsic BH
curve will fail validation check in all the other product/design types.

l When an IntrinsicBH curve is added, theRelative Permeability Value
button label changes toBi-H Curve as visual indication of the type of curve
currently defined for thematerial.

When youOK the dialog, an error message displays if a slope is out of tolerance, identifying
the data points between which the slope is less than that of free space.
The operations to input a nonlinear demagnetization curve are the same as entering a BH
curve for Steel material. When a BH curve goes through the second quadrant or third
quadrant, the curve is treated as a demagnetization curve.

4. Tomodel temperature dependency for a nonlinear permanent magnet youmust:
l Use an IntrinsicBH curve tomodel theRelative Permeability
l Specify a ThermalModifier for bothRelative Permeability and theMagnitude of
Magnetic Coercivity. Apply a thermal Modifier by selecting the Thermal Modifier check
box. Checking this box causes the Thermal Modifier column to display at the right side of
theProperties of the Material table. SelectingEdit rather thanNone causes display of
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theEdit Thermal Modifier dialog.

Alternatively, a non-linear BH curve can be modeled by the following four parameters:

l residual flux densityBr
l coercive field forceHc
l maximumenergy product (BH)max
l relative recoil permeability µr

From the View/Edit Materialswindow:
1. Set theRelative Permeability toNonlinear.

This enables theCalculate Properties for... drop downmenu at the bottom of the window.
2. ClickNon-Linear Permanent Magnet from the drop downmenu.

This displays theProperties for Non-Linear Permanent Magnet dialog box, which
contains the following fields into which you enter the appropriate values.

Mur Provide a value for relative permeability.

Hc Coercive field forceHc in the units specified. Provide a value and select units from the drop
downmenu.

Br Residual flux densityBr, in Tesla.
If enabled, provide a value and select units from the drop downmenu.

BH
max

Maximummagnetic energy product (BH)max
If enabled, provide a value and select units form the drop downmenu.

3. ClickOK to close the dialogue and return to theView/Edit Materials window.
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The values forRelative Permeability andMagnitude underMagnetic Coercivity are
updated as new default values. Maxwell will create a lookup table based on the Four-
Parameter Curve Fitting algorithm, and update the coordinates of the BH curve automatically
as long as the input data of four parameters pass the validation check.

Related Topics

Non-Linear vs. Linear Permanent Magnets
Calculating the Properties for a Linear Permanent Magnet
Temperature Dependent Nonlinear Permanent Magnets

Calculating the Properties for a Linear Permanent Magnet

Edit a linear demagnetization curve is simple. From the View/Edit Materialswindow:
1. Set theRelative Permeability toSimple.

This enables theCalculate Properties for Permanent Magnet drop downmenu at the
bottom of the window.

2. ClickPermanent Magnet from the drop downmenu.
This displays theProperties for Permanent Magnetwindow. This contains the following
fields.

Mu (enabled by
default)

Provide a value.

Hc (enabled by
default)

Coercive field forceHc in the units specified. Provide a value and select units
from the drop downmenu.

Br/Mp (disabled by
default)

Checking this enables the radio buttons that let you specify either Br or Mp.

Br Residual flux densityBr, in Tesla.
If enabled, provide a value and select units from the drop downmenu.

Mp If enabled, provide a value and select units form the drop downmenu.

3. ClickOK to close the dialogue and return to theView/Edit Materials window.
The values forRelative Permeability andMagnitude underMagnetic Coercivity are updated as
new default values.

Note The accuracy in inputting the characteristic parameters for the permanent-magnetic
material has significant effect on the correctness of the analyses to the electromagnetic
characteristics of the electricmachine. It is suggested that users should input the
characteristic parameters of the permanent-magneticmaterial according to the accurate
data provided by themanufacturers of materials.RMxprt provides a few characteristic
parameters of permanent-magneticmaterials for reference.
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Using Demagnetization Curves

Many permanent magnet manufactures directly provide demagnetization curves for their products,
but in most cases, manufactures provide somemain parameters, such as residual flux densityBr,
coercive field forceHc andmaximummagnetic energy product (BH)max, and relative recoil magnetic
permeability µr. This section and the next section describe the basic parameters for the
demagnetization curve of permanent magnets and the curve fitting based on these parameters.

Hysteresis Loop

The permanent-magneticmaterial belongs to hard-magneticmaterial. It is characterized with "fat"
hysteresis loop, which encloses large area as shown in the figure. Whenmagnetized, it keeps high
magnetic property with the external magnetic field removed, therefore is used in the permanent-
magnet electricmachine to producemagnetic field. The characteristics of the permanent-magnetic
material are represented with itsmain parameters: residual flux densityBr, coercive field forceHc
andmaximummagnetic energy product (BH)max.

Demagnetization Curve

The part of themaximumhysteresis loop of the permanent-magneticmaterial in the second
quadrant is called the demagnetization curve as shown in the next figure. It is the basic
characteristics curve of the permanent-magneticmaterial. On the demagnetization curve, the
magnetic flux density has positive values, but themagnetic field intensity has negative values. It
means that the permanent-magneticmaterial is applied with demagnetizationmagnetic field
intensity. SinceHm andBm are in opposite directions, when themagnetic flux goes through the
permanent-magneticmaterial, themagnetic potential difference along the direction of themagnetic
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flux does not drop, but rises. Therefore, the permanent-magneticmaterial is amagnetic source,
similar to the electric source in the electric circuit.

The two extreme positions on the demagnetization curve are the two significant parameters to
represent themagnetic characteristics of the permanent-magneticmaterial. On the demagnetization
curve, the value of themagnetic flux density corresponding to zeromagnetic field intensityH is
termed residual flux densityBr, on the other hand, the value of themagnetic field intensity
corresponding to zeromagnetic flux densityB is termed coercive field forceHc. The produce of the
magnetic flux density and themagnetic field intensity at any point on the demagnetization curve is
termedmagnetic energy product (BH), which is proportional to themagnetic energy density
possessed by the permanent magnet at the given operating situation. At the two extreme positions
(B = Br, H = 0) and (B = 0, H = Hc), themagnetic energy product is equal to zero. Somewhere at an
intermediate position, themagnetic energy reaches itsmaximum value and is termedmaximum
magnetic energy product (BH)max, which is another significant parameter to represent themagnetic
characteristics of the permanent-magneticmaterial. To some permanent-magneticmaterials with
linear demagnetization curve, it is obvious that at (B = Br / 2, H = Hc / 2), themagnetic energy
product reaches itsmaximum value, i.e. (BH)max = BrHc / 4.

Recoil Lines

The relationship between themagnetic flux density and themagnetic field intensity represented by
the demagnetization curve only exists when themagnetic field intensity varies in the same direction.
In fact, when the permanent magnet electricmachine is working, the demagnetization field intensity
varies repeatedly in both directions.When demagnetization field is applied to themagnetized
permanent magnet, themagnetic flux density decreases along the curly segmentBrP on the
demagnetization curve as shown in the figure
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If the external demagnetization field intensityHp is removed when themagnetic flux density reaches
the pointP, themagnetic flux density will increase not along the original demagnetization curve, but
along another curvePVR. If the external demagnetization field intensity is reapplied, themagnetic
flux density will decrease along the new curveRUP. By repeatedly applying the demagnetization
field intensity, a localized loop is formed and is termed local hysteresis loop. On the local hysteresis
loop, the rising segment and the dropping segment are quite close to each other, therefore can be
approximated by the straight linePR, which is termed recoil line withP as the starting point. If
demagnetization field with intensityHq not exceeding the original valueHp is applied thereafter, the
magnetic flux density will vary reversibly along the recoil linePR. IfHq > Hp, themagnetic flux density
drops to a new starting pointQ. It will vary along the new recoil lineQS, but not the previous onePR.
This sort of irreversible variation in magnetic flux density causes instability in the characteristics of
electricmachines and complicates the design computation of permanent magnet electricmachines,
therefore should be avoided as possible.

Recoil Magnetic Permeability

The ratio of the average slope of the recoil line to themagnetic permeability in vacuum µ0
(µ0= 4 x 10-

7 H/m) is termed relative recoil magnetic permeability or recoil magnetic permeability for
short, µr:
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If the demagnetization curve is curly, the value of µr depends on the location of the starting point and
is a variable, but typically varies within a small range. Therefore, it is approximated as a constant and
is taken as the slop of the tangent to the point (Br, 0) on the demagnetization curve. In other words,
the recoil lines at different starting points are approximated as a family of parallel lines, which are all
parallel to the tangent to the point (Br, 0) on the demagnetization curve.

Inflection Point

Some permanent-magneticmaterials, such as some ferrite permanent-magneticmaterials, show
straight upper segment on the demagnetization curve.When the demagnetization field intensity
drops to a given value, the demagnetization curve turns to decrease rapidly. The turning point is
termed inflection point. If the demagnetization field intensity does not exceed the inflection point k,
the recoil line coincideswith the straight segment on the demagnetization curve. If the
demagnetization field intensity exceeds the inflection point k, the new recoil lineRP no longer
coincideswith the straight segment on the demagnetization curve.

Some permanent-magneticmaterials, such asmost of the rare-earth permanent-magnetic
materials, show straight demagnetization curve in the whole range. In those cases, the recoil line
coincideswith the demagnetization curve. Thismakes themagnetic property keep stable while the
permanent-magnet electricmachine is working. This is the best ideal demagnetization curve for
electricmachine applications.

Curve Fitting of Demagnetization Curves

RMxprt fits the demagnetization curve according to the given characteristic parametersBr,Hc,
(BH)max and µr.
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Three Parameter Curve Fitting

Given the three characteristic parametersBr,Hc and (BH)max, the principles of the three-parameter
curve fitting algorithm are summarized as follows.Using the following figure as a reference:

and

where a<1.
Anymagnetic flux densityB in the interval

corresponds to themagnetic field intensityH:
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The tangent at any point is given by:

Themagnetic flux densityBm and themagnetic field intensityHm corresponding to themaximum
magnetic energy product satisfy the following relationship:

Solving yields:

Let themagnetic energy product at the point equal to (BH)max be:

Solving yields:

Getting Started with RMxprt 26-98
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

The relative recoil magnetic permeability µr is calculated as:

Four Parameter Curve Fitting

The three-parameter curve fitting technique fits the demagnetization curve well. For the nonlinear
permanent-magneticmaterial, the real operating point lies often not on the demagnetization curve,
but on the recoil line. The relative recoil magnetic permeability calculated with the three-parameter
curve fitting technique will cause deviation, therefore RMxprt employs amore accurate fitting
technique: four-parameter curve fitting technique, as introduced below.
Given the four characteristic parametersBr,Hc, (BH)max and µr, the principles of the four-parameter
curve fitting algorithm are summarized as follows:

1. Draw a line through the point (0, Br) with the slope equal to -µrµo as shown in the Figure. The
segment of this line in the second quadrant is termed the ideal recoil line.

Getting Started with RMxprt 26-99
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

2. Find the virtual magnetic flux densityBr0.
3. WithBr0,Hc, and (BH)max, draw the demagnetization curve with the three-parameter curve

fitting technique. The curve should touch the ideal recoil line at the tangent point (Ht, Bt).
4. Anymagnetic flux densityB in the interval

corresponds to themagnetic field intensityH:

The virtual magnetic flux densityBr0 is found by iteration:
1. Start from the initial guess for the lower and the upper bounds for the virtual magnetic flux

densityBr0:

2. Let:

3. WithBr0,Hc, and (BH)max, draw the demagnetization curve with the three-parameter curve
fitting technique.
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4. The curve should touch a line parallel to the ideal recoil line at the tangent point (Ht, Bt).

and

1. For anymagnetic flux densityB in the interval

the correspondingmagnetic field intensityH will be calculated by:

Getting Started with RMxprt 26-101
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

1. Calculate the value ofHr corresponding toBr using:

2. IfHr>0, the assumed virtualBr0 is too small, the lower bound of the interval needs to be
increased, so let B0=Br0. If, however,Hr<0, the assumedBr0 is too big, the upper bound of
the interval needs to be decreased, so let B1=Br0.

3. Repeat steps (2) through (7) untilHr converges to 0 within satisfactory precision.

Conductor Data

When amaterial is assigned to amachine part, RMxprt checks that thematerial is appropriate for the
machine part based upon whether it is a conductor or other material type. RMxprt distinguishes
conductors based onmaterial threshold settings. RMxprt’s treatment of conductorsmay be set by
the used by adjusting theMaterial Threshold.

Setting the Material Threshold for RMxprt

1. ClickRMxprt>Design Settings.
TheDesign Settings dialog box appears with theMaterial Threshold tab selected.

2. Type a value in theConductivity Threshold text box (Default=100,000).
3. Type a value in thePermeability text box (Default=100).

Note RMxprt will treat materials with conductivity greater than 100,000 as conductors,
andmaterials with Permeability greater than 100 as steels.

4. If you want these values to be the default, change the values by clicking the
Tools>Options>RMxprt Optionsmenu and setting thematerial thresholds in theRMxprt
Options dialog.

5. ClickOK.

Editing Conductivity Properties in RMxprt

1. ClickTools>Edit Libraries>Materials to open theEdit Libraries dialog box.
2. Select thematerial in the list whose conductivity properties you wish to edit and click the

View/Edit Materials button.
3. In theView/Edit Materials dialog,Bulk Conductivity has two property types in the Type

pull-down list.
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l Simple: For this type, youmust enter a simple value for the property value.
l Anisotropic: For this type, youmust specifymaterial properties for three principal
directions:

a. T(1,1)
b. T(2,2)
c. T(3,3)

Note The Anisotropic type is not used in RMxprt design analysis, but it will be
transferred toMaxwell 3D Design automatically when the design is created
byRMxprt.

4. Mass Density is a Simple parameter.
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Specifying RMxprt Solution Settings
Specify how RMxprt computes a solution by adding a solution setup to the design. You can define
more than one solution setup per design.
To add a solution setup to a design:

1. Select a design in the project tree.
2. ClickRMxprt>Analysis Setup>Add Solution Setup.

l Alternatively, right-clickAnalysis in the project tree, and then clickAdd Solution Setup
on the shortcut menu.

TheSolution Setup dialog box appears. It is divided among the following tabs:

General Includes general solution settings, including rated output power, speed, operating
temperature, etc.

<machine
type>

Includes settings specific to the selectedmachine type.

Defaults Includes settings to save and clear user-defined default values.

3. Click theGeneral tab.
4. If available for themachine you are using, select anOperation Type from the pull-down list.

Thismay beMotor or Generator.
Note To enable selection ofGenerator for Adjust-Speed SynchronousMachines, themachine

Control Typemust be set toAC in its Properties window.

When youmake the selection, thismakes a difference in the Load Type available.
5. Select a Load Type from the pull-down list. ForMotor operation, the options are:

l Const Speed
l Const Power
l Const Torque
l Linear Torque
l Fan Load
If themodel has anOperation Type, and you selectGenerator, the Load Type options are:
l Infinite Bus
l Independent Generator

6. Type theRated Output Power, and select the units.
7. Type theRated Voltage, and select the units.
8. Type theRated Speed, and select the units.
9. Type theOperating Temperature, and select the units.
10. Click the <machine type> tab (if any for thismachine).

The options vary depending on themachine. For example, the 3 Phase InductionMotor
includes options for:
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l Frequency and Units
l Winding Connection (Wye or Delta).
The 3 Phase SynchronousMachine includes options for:
l Rated Power Factor
l Winding Connection (Wye or Delta)
l Exciter Efficiency
l Input Exciting current and units
The BrushlessDC Motor does not use the <machine type> tab.

11. Specify the desired settings, based on themachine type you have selected.
12. ClickOK.

Note To edit a setup after it has been created, right-click the specific setup (for example,
Setup1), underAnalysis in the project tree, and then clickProperties on the
shortcut menu.

Generating a Custom Design Sheet for RMxprt

RMxprt allows users to import all the data items ofDesign Output into aMicrosoft Excel
worksheet in order for users to designDesign Sheet of their own styles according to their own
requirements usingMicrosoft Excel.
Before you can specify a design sheet, you first need to customize a template in Microsoft Excel and
set the export options.
To set the export options:

1. ClickRMxprt>Design Settings.
TheDesign Settings dialog box appears. Select theExport Options tab.

2. In theDesign Sheet section, specify anExcel Template by clicking the ... button, selecting
the template you want to use, and clickingSave.

3. ClickOK.
To create a design sheet based on a previously-customized template after the design has been
analyzed:

1. ClickRMxprt>Analysis Setup>Export.
TheExport dialog box appears.

2. SelectCustomized Design Sheet from the Type pull-downmenu.
3. Choose theSolution Setup from the pull-downmenu.
4. In thePath field, enter the location to export the files to, or use the ellipsis (...) button to browse

to the desired location.
5. ClickOK.

RMxprtwill connect toMicrosoft Excel according to the set path and automatically import the
relevant data fromDesign Output into a copy of the customizedDesign Sheet Template. Specific
data not available inDesign Output is shown asN/A, for instance,RS inSlot Sizes isN/A (mm)
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when stop type is 1. The post-processing of data is automatically performed, for instance,Winding
Weight is 0.947 (kg).

Note SeveralDesign Sheet examples are shipped with RMxprt in the examples subdirectory of
your installation.

Related Topics

Exporting aMaxwell or Simplorer Model

Key Words in Output Data for RMxprt

InDesign Output ofRMxprt, the literal expressions for various parameters are termed keywords
of output data. For example, theDesign Output for Line-start Permanent-magnet Synchronous
Motor (lssm) example project sm-1.aedt is shown below.
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In theDesign Sheet, "RatedOutput Power", "Rated Voltage", "Number of Poles", "Frequency",
"Frictional andWindage Loss", etc. are all keywords of output data.

Creating RMxprt Customized Design Sheet Template

As a sample example, the Line-start Permanent-magnet SynchronousMotor (lssm) is used to
demonstrate the process for creating aCustomizedDesign Sheet template.
StartMicrosoft Excel, rename the blankworksheet file as "lssm" and save it under the path
ansoft\rmxprt5 as shown below.

Design Template of Microsoft Excel Worksheet in Preferred Styles

According to special requirements and preferences, select relevant parameters, arrange the page
formats of worksheet. Taking as example a part of the parameters of theDesign Sheet of the Line-
start Permanent-magnet SynchronousMotor (lssm), the designed worksheet template is shown
below.
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In the template, the yellow-colored areas are reserved for importing data.

Resort to Key Words in Design Output

In the spaces for importing data in the template (shown in yellow), key in = "xxxxx". Within the double
quotationmarks, xxxxx stands for the relevant keywords as shown below.
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Set Boundary for Data Imported into Worksheet for RMxprt

RMxprt automatically searches for matching keywordswhile importing data into theMicrosoft
Excelworksheet. To reduce the searching space, and therefore the searching time, it is possible to
set the searching boundary.RMxprt defines = "" as identification of boundary. In the figure below,
for instance, the cells in the green-colored area are all keyed in with = "" to form boundary. While
importing data,RMxprtwill not search below or to the right of the boundary for matching keywords.
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Insert Figures into Template for RMxprt

With resort to functionPaste, it is possible to insert desired figures into the worksheet template. In
the following example, for instance, four figures of slot types are inserted.
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Use Different Languages for RMxprt Design Sheets

It is possible to use a preferred language other than English in theMicrosoft Excelworksheet
template. In the following example, for instance, Simplified Chinese is used.
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Note Keywords are not allowed to be expressed in other
languages.

Post-process Data for RMxprt

Using the relevant functions ofMicrosoft Excel, it is possible to post-process data in the worksheet
template. For example, calculate the weight of a winding using the following formula:

In the following figure, the formula is entered into the relevant cell as:
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=H7*D30*D31*D36*3.14*D32*D32*0.0078/4
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Running an RMxprt Simulation
After you specify how RMxprt will compute the solution, begin the solution process.

1. Select a solution setup in the project tree.
2. ClickRMxprt>Analyze.

To runmore than one analysis at a time, follow the same procedure while a simulation is running.
The next solution setup will be solved when the previous solution is complete.
To solve every solution setup in a design:

1. In the project tree, under the design you want to solve, selectAnalysis.
2. ClickRMxprt>Analyze All.

Each solution setup is solved in the order it appears in the project tree.

Aborting RMxprt Analyses

To end the solution process before it is complete:
l Right-click in theProgresswindow, and selectAbort from the shortcut menu.
The analysis stops immediately.

If you aborted the solution in themiddle of an adaptive pass, the data for that pass or current
frequency point is deleted. Any solutions that were completed prior to the one that was aborted are
still available.

Re-solving an RMxprt Problem

If youmodify a design after generating a solution, the solution in memorywill no longer match the
design. The solution setup with the invalid solution ismarked with anX in the project tree and in the
Resultswindow.
To generate a new solution after modifying a design, follow the procedure for running a simulation:

1. Select a solution setup in the project tree.
2. ClickRMxprt>Analyze.
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Post Processing and Generating Reports in RMxprt
WhenRMxprt has completed a solution, you can display and analyze the results in the following
ways:

l View solution data.
l Specify output variables.
l Export amodel to be used inMaxwell2D, Maxwell 3D, Simplorer, or Motor-CAD™.
l Create a Customized Design Sheet

Viewing RMxprt Solution Data

To access theSolutions dialog box, do one of the following:
l ClickRMxprt>Results>Solution Data.
l Right-clickResults in the project tree, and then clickSolution Data on the shortcut menu.
l Right-clickSetup1 in the Project tree, and then clickPerformance on the shortcut menu.
l Click theSolution Data button on the toolbar.

TheSolutions dialog contains three tabs:
l Performance - this contains a Data field with a drop-downmenu that allows you to view many
different data tables, which vary with themachine type. Some examples are:
l AuxWinding
l Full LoadOperation
l Material Consumption
l No LoadOperation
l Permanent Magnet
l Rotor Data
l Rated Parameters
l Stator Slot
l Stator Winding
l Steady State Parameters

l Design Sheet - this displays the contexts of the .res file for the current setup. The file contains
tables with information for such things as (depending on themachine type):
l General Data
l Stator Data
l Rotor Data
l Permanent Magnet Data
l Material Consumption
l RatedOperation
l No-LoadOperation
l Steady State Parameters
l No LoadMagnetic Data
l Full Load Data
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l Winding Arrangement
l Transient FEA Input Data
To print the design sheet:

1. Right-click the design sheet to display the context menu.
2. SelectPrint from the shortcut menu.

ThePrint dialog box appears.

3. Select the printer, and clickOK to print.
l Curves - this displays the plots that were automatically generated by the solver. You can
select these from a drop-downmenu (menu contents vary with themachine type):
l Input DC Current vs Speed
l Efficiency vs Speed
l Output Power vs Speed
l Output Torque vs Speed
l Cogging Torque in Two Teeth
l Induced Coil Voltage at Rated Speed
l Air Gap FluxDensity
l InducedWinding Phase Voltage at Rated Speed
l Winding Currents Under Load
l Phase Voltage Under Load

Note You can also open theSolution Data dialog box directly on theCurves tab by
clicking theCurves toolbar button.

To print plots from theCurve tab:
1. Right-click on the desired plot to display the context menu.
2. ClickPrint on themenu to display thePrint dialog.
3. Select the printer, and clickOK to print.

Note The context menu also provides commands that allow the user to change various
plot characteristics such as: trace type and properties such as color; add/edit data
markers and labels; edit axis, legend, and title properties. The plot image can also be
copied to the clipboard for pasting in another application. Plot data can also be
exported to various formatted text files that can then be imported into spreadsheets,
etc. Refer toModifying the Background Properties of a Report for additional
information.

Browse Solutions in RMxprt

If you have run different solutions on a design, you can use theRMxprt>Results>Browse
Solutions to look through andmanage them.

1. ClickRMxprt>Results>Browse Solutions
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This displays theSolutions dialog with the Browse tab selected.
From here you can select a design, and view the Setup, Solution and State tables.

2. Click theProperties button to view theSolution Browser properties dialog.
This contains radio buttons for you to select the tree view. It can be organized as:
l Variation / Setup / Solution
l Setup / Solution / Variation
l Setup /Variation / Solution
ClickOK to accept your selection and close the dialog.

3. From theSolutions dialog, you can also select and delete solutions.

Exporting a Simplorer Model, MotorCAD Project, or Customized Design
Sheet

To export themodel to a Simplorer model, a MotorCAD™ project, or Customized Design Sheet:
1. First, solve the design for the specific solution setup fromwhich the export is desired.

Note Attempting to export without the requisite files present automatically launches
simulation to generate them.

2. ClickRMxprt>Analysis Setup>Export to open theExport dialog box.
You can also right-click onAnalysis orAnalysis>Setup in the Project Manager and select
Export.

3. Select one of the following from the Type drop-down list:
l Simplorer Model
l Customized Design Sheet
l MotorCAD Project

4. Select the setup you want to export from theSolution Setup drop-down list.
5. Optionally, click the Variation ellipsis [... ] button to specify a designVariation to use during

export.
6. Specify thePath to store the exported files in by clicking the Path ellipsis [...] button and

browsing to the desired directory. You can also create a new directory, if desired.
7. ClickOK.

– ForMotorCAD Project, a <project_name>.mot file that includes all machine and housing
data will be generated. You can then open the project in Motor-CAD for analysis.
– ForCustomized Design Sheets, a <design_sheet_name>.xls file will be generated.
– For Simplorermodels, three files will be exported:

l <project name>_<design name>_<setup name>.sml
l <project name>_<design name>_<setup name>_signals.sml
l <project name>_<design name>_<setup name>_SimCkt.vbs
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You can now use the Simplorer Tools>Run Script command to run the .vbs script to
generate the components on the Simplorer schematic. (Refer to the Simplorer online help for
detailed information on running scripts.)

You can now workwith themodel in the product to which you exported it, and perform other kinds of
analyses.

Related Topics

Generating a CustomDesign Sheet for RMxprt

Create a Maxwell Design

RMxprt provides a way to export solvedmodels as either aMaxwell 2D or Maxwell 3D design.
l All the RMxprt machine types are supported.
l Setups for boundaries, excitations, parameters, etc. are automatically created.
l Variable definitions and assignments are automaticallymapped from the solved RMxprt
design to theMaxwell design.
Note Creating aMaxwell2D/3D design from an old version (version 15 or older) of a

solved RMxprt design results in theMaxwell2D/3D design being createdwithout
any variables even if the original RMxprt design uses variables. In such cases, the
Message Manager displays a warningmessage informing the user that the
Maxwell design being created does not contain any variable assignments from
the RMxprt design; and recommends re-solving the setup to get the variable
assignments.

To export themodel to aMaxwell 2D Design or Maxwell 3D Design:
1. ClickRMxprt>Analysis Setup>Create Maxwell Design

TheCreate Maxwell Design dialog box appears.
2. Select one of the following from the Type drop-down list:

l Maxwell 2D Design
l Maxwell 3D Design

3. Select the setup you want to export from theSolution Setup drop-down list.
4. Optionally, click the [...] button to specify aVariation in theSet Design Variation dialog box.

This allows the user to choose the default variable values to be used in theMaxwell design
being created with variables.

5. ClickOK to create theMaxwell design.
You can now workwith themodel in theMaxwell2D or Maxwell3D design, add boundaries and
excitations, perform analyses, and analyze results.

Note l For Maxwell 2D/3D designs for motor applications, the computed output mechanical
power at a given constant speedmay not reach the desired rated power. Therefore,
it is useful to apply constant power as themechanical load. In Maxwell 2D/3D
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designs created byRMxprt, themechanical transient is setup according to the rated
mechanical output power, and equivalent damping is added to accelerate the
process approaching to the rated output power. This setup is visible whenConsider
Mechanical Transient on theMechanical tab of theMotion Setup dialog box is
checked.

l For Maxwell 2D/3D designs of AC machines, RMxprt automatically enables an
alternating flux (AF) model in the voltage definition for each winding to reduce
transient solution time to reach steady-state when theMaxwell 2D or 3D model is
created.

Creating an Icepak Design

RMxprt provides a way to export solvedmodels as Icepak designs.
To export themodel as an IcepakDesign:

1. ClickRMxprt>Analysis Setup>Create Icepak Design; or right-click on the analysis setup
in the Project tree and selectCreate Icepak Design from the context menu.
TheCreate Icepak Design dialog box appears.

2. Select the setup you want to export from theSolution Setup drop-down list.
3. Optionally, click the [...] button to specify aVariation in theSet Design Variation dialog box.

This allows the user to choose either the nominal design or to choose the variation to be used
in the Icepak design being created.

4. Enter or choose thePathwhere the Icepak project is to be output.
5. Do one of the following:

a. ClickOK without selecting Launch Icepak application to generate the Icepak project
and put it in the designated folder.

b. Select Launch Icepak application and clickOK to generate the Icepak project in the
designated folder, and automatically open the Icepak design in the Icepak application.

Note l If you want to launch the Icepak application,
ensure that theWorkbench path is set in the
Tools/Options/General Option/Miscellaneous
tab.

l Refer to the Icepak documentation for
information on working with Icepak designs.

Creating Reports in RMxprt

After RMxprt has generated a solution, all of the results for that solution are available for analysis.
One of the ways you can analyze your solution data is to create a report, or graphical representation,
that displays the relationship between a design's values and the corresponding analysis results.
Reports are created using the Traces dialog box. The available options in the Traces dialog box
depend on the report type you create and the available solution data.
Following is the general procedure for creating a report:
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1. ClickRMxprt>Results>Create Report.
TheCreate Report dialog box appears.

2. In the Target Design pull-down list, click the design containing the solution data you want to
plot.

3. In theReport Type pull-down list, clickRMxprt.
4. In theDisplay Type pull-down list, select the type of report you want to create.
5. ClickOK.

The Traces dialog box appears.
6. In theSolution pull-down list, click the solution containing the data you want to plot.
7. To create a new mathematical expression to plot, do the following:

a. ClickOutput Variables.
TheOutput Variables dialog box appears.

b. Add the expression you want to plot, and then clickDone.
8. Add one or more traces to include in the report.
9. ClickDone.

The report appears in the view window and is listed in the project tree. Once you have created
a report, addition options become available on theResults submenu.

Modifying Reports in RMxprt

Tomodify the data that is plotted in a report:
1. In the project tree, right-click the report you want to modify.

A shortcut menu appears
2. SelectModify Report from the shortcut menu.

The Traces dialog box appears.
3. Modify the selections in the Traces dialog box as needed.
4. ClickDonewhen you are finishedmodifying the report.

The updated report appears in the view window.
To update all modified reports:

Click RMxprt>Results>Update Reports.

Opening All Reports in RMxprt

To open all reports for a project:
Click RMxprt>Results>Open All Reports.

This opens all reports.
To simplify viewing and comparisons, it may be helpful to useWindow>Cascade orWindow>Tile
Horizontally orWindow>Tile Vertically commands.
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To close all open reports:
Click Window>Close All.

Deleting All Reports in RMxprt

To delete all reports for a project:
ClickRMxprt>Results>Delete All Reports.
This deletes all reports for the project.

Selecting the Display Type in RMxprt

The information in a report can be displayed in several formats. Select from the followingDisplay
Type formats in theCreate Report dialog box:

Rectangular
Plot

A 2D rectangular (x-y) graph.

3D
Rectangular
Plot

A 3D rectangular (x-y-z) graph.

Data Table A spreadsheet with rows and columns that displays, in numeric form, selected
quantities against a swept variable or another quantity.

Creating 2D Rectangular Plots in RMxprt

A rectangular plot is a 2D, x-y graph of results.
1. Click RMxprt>Results>Create Report.

TheCreate Report window appears.
2. In the Target Design list, click the design containing the solution data you want to plot.
3. In theReport Type list, click the data type you want to plot.
4. In theDisplay Type list, clickRectangular Plot.
5. ClickOK.

The Traces dialog box appears. TheY tab is selected by default.
6. Under theY tab, specify the information to plot along the y-axis:

a. In theCategory list, click the type of information to plot.
b. In theQuantity list, click the value to plot.
c. In the Function list, click themathematical function of the quantity to plot.

7. Under theX tab, specify the quantity to plot along the x-axis in one of the following ways:
l SelectUse Primary Sweep.
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The first (primary) sweep variable listed under theSweeps tab will be plotted along the x-
axis.

l Clear theUse Primary Sweep option, and then select theCategory,Quantity, and
Function of the quantity to plot on the x-axis. The quantity will be plotted against the
primary sweep variable listed under theSweeps tab.

8. Under theSweeps tab, confirm or modify the sweep variables that will be plotted.
9. ClickAdd Trace.

A trace represents one or more lines connecting data points on the graph. The trace is added
to the traces list at the top of the Traces dialog box. Each column lists an axis on the report
and the information that will be plotted on that axis.

10. Optionally, add another trace by following the procedure above.
11. ClickDone.

The function of the selected quantity is plotted against the swept variable values or quantities
you specified on an x-y graph. The plot is listed underResults in the project tree.

Related Topics

Sweeping a Variable
Working with Traces

Creating 3D Rectangular Plots in RMxprt

A rectangular plot is a 3D, x-y-z graph of results.
1. ClickRMxprt>Results>Create Report.

TheCreate Report window appears.
2. In the Target Design list, click the design containing the solution data you want to plot.
3. In theReport Type list, click the data type you want to plot.
4. In theDisplay Type list, click 3D Rectangular Plot.
5. ClickOK.

The Traces dialog box appears. The Z tab is selected by default.
6. Under the Z tab, specify the information to plot along the z-axis:

a. In theCategory list, click the type of information to plot.
b. In theQuantity list, click the value to plot.
c. In the Function list, click themathematical function of the quantity to plot.

7. Under theY tab, specify the information to plot along the y-axis in one of the following ways:
l SelectUse Secondary Sweep.

The second (secondary) sweep variable listed under theSweeps tab will be plotted along
the y-axis.

l Clear theUse Secondary Sweep option, and then select theCategory,Quantity, and
Function of the quantity to plot on the y-axis. The quantity you select will be plotted against
the secondary sweep variable listed under theSweeps tab.
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8. Under theX tab, specify the information to plot along the x-axis in one of the following ways:
l SelectUse Primary Sweep.

The first (primary) sweep variable listed under theSweeps tab will be plotted along the x-
axis.

l Clear theUse Primary Sweep option, and then select theCategory,Quantity, and
Function of the quantity to plot on the x-axis. The quantity you select will be plotted against
the primary sweep variable listed under theSweeps tab.

9. Under theSweeps tab, confirm or modify the swept variables that will be plotted.
10. ClickAdd Trace.

A trace represents one or more lines connecting data points on the graph. The trace is added
to the traces list at the top of the Traces dialog box. Each column lists an axis on the report
and the information that will be plotted on that axis.

11. Optionally, add another trace by following the procedure above.
12. ClickDone.

The function of the selected quantity or quantities is plotted against the values you specified on
an x-y-z graph. The plot is listed underResults in the project tree.

Related Topics

Sweeping a Variable
Working with Traces

Creating Data Tables in RMxprt

A data table is a spreadsheet with rows and columns that displays, in numeric form, selected
quantities against a swept variable or other quantities.

1. ClickRMxprt>Results>Create Report.
TheCreate Report window appears.

2. In the Target Design list, click the design containing the solution data you want to plot.
3. In theReport Type list, click the data type you want to plot.
4. In theDisplay Type list, clickData Table.
5. ClickOK.

The Traces dialog box appears. TheY tab is selected by default.
6. Under theY tab, select the quantity you are interested in and its associated function:

a. In theCategory list, click the type of information to display.
b. In theQuantity list, click the value to display.
c. In the Function list, click themathematical function to use for the quantity.

7. Under theX tab, select the values you want to plot the quantity against in one of the following
ways:
l SelectUse Primary Sweep.
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The quantity you selected in step 5 will be displayed against the first (primary) sweep
variable listed under theSweeps tab.

l Clear theUse Primary Sweep option, and then select theCategory,Quantity, and
Function of the quantity to plot against the quantity you selected in step 5. This quantity will
be plotted against the primary swept variable listed under theSweeps tab.

8. Under theSweeps tab, confirm or modify the swept variables that will be plotted.
9. ClickAdd Trace.

In the context of a data table, a trace represents a quantity's value at another quantity's value
or at selected swept variable values. The trace is added to the traces list at the top of the
Traces dialog box.

10. Optionally, add another trace by following the procedure above.
11. ClickDone.

The quantity you selected in step 5 is listed at each variable value or additional quantity value you
specified. The data table is listed underResults in the project tree.

Related Topics

Sweeping a Variable
Working with Traces

Working with Traces in RMxprt

A trace in a 2D or 3D report defines one or more curves on a graph. A trace in a data table defines
part of the displayedmatrix of text values.
The values used for a plot's axes can be variables in the design or functions and expressions based
on the design's solutions. If you have solved one or more variables at several values, you can
"sweep" over some or all of those values, resulting in a curve in 2D or 3D space.
A report can include any number of traces and, for rectangular graphs, up to four independent y-
axes.
In general, to add a trace to a report:

1. In the Traces dialog box, specify the information you want to plot along the appropriate axes.
2. ClickAdd Trace.

A trace is added to the traces list at the top of the Traces dialog box. The trace represents the
function of the quantity you selected and will be plotted against other quantities or swept
variable values. Each column lists an axis on the report and the information that will be plotted
on that axis.
You canmodify the information to be plotted by typing the name of the quantity or sweep
variable to plot along an axis directly in the boxes.
The trace will be visible in the report when you clickDone.

Note l The Traces dialog box can be accessed via theCreate Report
dialog box.
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l You can also Add Trace Characteristics to 2D reports.

Removing Traces in RMxprt

You can traces from the traces list in the following ways:
To remove one trace from the report:

l Select the trace you want to remove from the traces list, and then clickRemove Trace.
To remove all traces from the report:

l ClickRemove All Traces.

Related Topics

Working with Traces

Replacing Traces in RMxprt

To replace a trace in the traces list with a different trace definition:
1. Select the trace you want to remove from the traces list.
2. In the Traces dialog box, specify the information you want to plot along the appropriate axes.
3. ClickReplace Trace.

The trace you selected is removed, and the new trace information you specified replaces it in
the traces list.

4. ClickDone.

Related Topics

Working with Traces

Adding Blank Traces in RMxprt

To add a blank trace to the traces list:
l ClickAdd Blank Trace.

You can now type the quantities to plot in the appropriate axes boxes.

Related Topics

Working with Traces
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Sweeping a Variable in a Report in RMxprt

In RMxprt, a swept variable is an intrinsic, project, or design variable that typically hasmore than one
value. From the Traces dialog box, you can plot any calculated or derived quantity against one or
more of the swept variable's values.
When you click the Sweeps tab in the Traces dialog box, the first sweep variable listed is the
"primary sweep". If you are creating a 3D report, the second sweep variable listed is the "secondary
sweep". Any additional sweep variables are represented as additional curves on the graph.
Tomodify which variable is the primary sweep variable:

l Click theName box for the primary sweep variable, and then click the variable name you want
to be the primary sweep variable.

Tomodify the secondary sweep variable or any additional sweep variable, follow the same
procedure.
Tomodify the values that will be plotted for a variable:

1. Click a variable in the table.
To the right, all of the possible values for the selected variable are listed.

2. SelectAll Values.
All of the selected variable's values are plotted.
l Alternatively, clearAll Values and select the specific values to plot against the selected
quantity.

Selecting a Function in RMxprt

The value of a quantity being plotted depends upon itsmathematical function, which you select from
the Function list in theReport dialog box. The available, valid functions depend on the type of
quantity (real or complex) that is being plotted. The function is applied to the quantity which is
implicitly defined by all the swept and current variables. For example, "Volume(Stator)" is the volume
of themodel object named Stator for every swept combination of variables ("height" and so forth).
These functions can also be applied to previously specified Quantities and Functions asRange
Functionswhen using the Set Range Function dialog.
Some of these functions can operate along an entire curve. These are: deriv, min, max, integ, rms,
pk2pk, cang_deg and cang_rad. These functions have syntax as follows:

l deriv(quantity) implicitly implies derivative over the primary sweep
l deriv(quantity, SweepVariable) explicitlymeans derivative over the sweep variable specified
in the second argument (such as "Freq").

You can select from the following functions in the Trace tab Function list, or type them directly into
the Yor X field, if necessary:

abs Absolute value of the simulation quantity which results in a number that is
always positive.
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acos Arc cosine i.e. the inverse function of a cosine.
acosh Inverse hyperbolic arc cosine.
ang Magnitude of an angle.
ang_deg Angle (phase) of a complex number, cut at +/-180.
ang_rad Angle in radians.
arg Argument of a complex number. It is the angle the complex number makes

with the positive x axis. Same as ang_deg.
asin Arc sine i.e. inverse function of sine.
asinh Inverse hyperbolic sine.
atan Arc tangent. Takes a tangent value as an argument. Because there are two

angles in a circle that can have the same tangent value, and atan can return
only one value, it returns a value in the range between -90 degrees and +90
degrees (or between -pi/2 and pi/2 in radians).

atanh Inverse hyperbolic tan.
atan2 A two-argument version of the atan function. Takes the y and x coordinates

(including sign information) of a point as arguments and returns the angle
from the X-axis. Can return angle values for the full circle (-180 degrees to
+180 degrees or -pi to +pi in radians).

avgabs Returns themean of the absolute value of the selected quantity.
bandwidth Returns the 3dB bandwidth of the selected simulation quantity. For

bandwidth, the calculation is based on 3dB below themaximumpeak.
cang_deg Cumulative angle (phase) of the first parameter (a complex number) in

degrees, along the second parameter (typically sweep variable). Returns a
double precision value cut at +/-180.

cang_rad Cumulative angle of the first parameter in radians along a second parameter
(typically a sweep variable). Returns a double precision value.

cmplx(re, im)
A complex number, where re is the real part and im is the imaginary part.

conjg Conjugate of the complex number.
cos Cosine.
cosh Hyperbolic cosine.
crestfactor Returns the crest factor (peak/RMS) for the selected quantity.
cum_integ The cumulative integral function returns a set of values that have the same

length as the original set of points (the first element will always be zero).
Element I of the set returned by cum_integ is the integral of elements 1
through I of the original data set.

cum_sum The cumulative sum function returns a data set that has the same length as
the original set of points. Element I of the set returned by cum_sum is the sum
of elements 1 through I of the original data set.
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dB(x) 20*log10(|x|) to base 10.
dBc Decibels relative to the carrier. It is the power ratio of the signal to a carrier

signal. Gives the relative signal strength.
dBm(x) 10*log10(|x|) +30.
dBW(x) 10*log10(|x|).
dB10 10*log(|x|) to base 10.
dB10normalize 10*log [normalize(mag(x))].
dB20 20*log(x) to base 10.
dB20normalize 20*log [normalize(mag(x))].
deadtime Obtains the latest time when the qtyl is within a tolerance of zero.
delaytime Obtains the time from zero to 50% of the target point.
degel Conversion from degrees electrical to secondswith respect to Hz.
deriv Derivative of first parameter with respect to second parameter.
distortion Returns the total distortion for the selected simulation quantity and an

additional argument frequency, which is the frequency in Hz at which to
calculate the fundamental RMS of the simulation quantity.

even Returns 1 if integer part of the number is even; returns 0 otherwise.
exp Exponential function (the natural anti-logarithm) of the simulation quantity.
formfactor Returns the form factor (RMS/Mean Absolute Value) for the selected

quantity.
fundamentalmag Returns the RMS value of the fundamental frequency for the selected

quantity, and an additional argument, Frequency, which specifies the
fundamental frequency.

gaincrossover Returns the gain crossover frequency (where the gain is 0 dB) of the selected
simulation quantity in Hz.

gainmargin Returns the gainmargin in dB at the phase crossover frequency of the
selected simulation quantity. It also requires a reference simulation quantity to
which themeasured quantity is compared and the AC magnitude and phase
angle of the reference quantity. These are entered as the arguments
Reference Channel, Base SourceMagnitude, and Base Source Angle.

iae Returns the integral of the absolute deviation of the selected quantity from a
target value that is entered via the additional argument. To use this function,
you need to open the Add Trace Characteristics dialog and select the Error
category.

if if(cond_exp,true_exp, false_exp).
im Imaginary part of the complex number.
int Truncated integer function.
integ Integral of the selected quantity. Uses trapezoidal area.
integabs Absolute value of integral.
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ise Returns the integral of the squared deviation of the selected quantity from a
target value that is entered via an additional argument. To use this function,
you need to open the Add Trace Characteristics dialog and select the Error
category.

itae Returns the time-weighted squared deviation of the selected quantity from a
target value that is entered via an additional argument. To use this function,
you need to open the Add Trace Characteristics dialog and select the Error
category.

itse Returns the time-weighted squared deviation of the selected quantity from a
target value that is entered via an additional argument. To use this function,
you need to open the Add Trace Characteristics dialog and select the Error
category.

j0 Bessel function of the first kind (0th order).
j1 Bessel function of the first kind (1st order).
jn Bessel function of the first kind (nth order).
ln Natural logarithm.
log Natural logarithm (same as ln).
log10 Logarithm base 10.
lowercutoff Returns the lower 3dB frequency of the selected simulation channel in Hertz.
lsidelobeX The 'x' value for the left side lobe: the next highest value to the left of themax

value.
lsidelobeY The 'y' value for the left side lobe: the next highest value to the left of themax

value.
mag Magnitude of the complex number.
max Returnsmaximum value of the simulation quantity.
max_swp Returnsmaximum value of a sweep.
max2 Maximum value of the two simulation quantities. For example, max2(a,b)will

plot maximumof a and b for a particular instance.
mean Returns the average in the set of quantities selected.

mean = sum( all y-value) / (number of y-values)
min Returns theminimum value of the simulation quantity.
min_swp Returns theminimum value of a sweep.
min2 Minimum value of the two simulation quantities. For example, min2(a,b)will

plot minimumof a and b for a particular instance.
mod Returns themodulus or absolute value of the simulation quantity.
nint Nearest integer.
none Returns null value.
normalize Divides each value within a trace by themaximum value of the trace. ex.

normalize(mag(x)).
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odd Returns 1 if integer part of the number is odd; returns 0 otherwise.
overshoot Calculates peak overshoot given a threshold value and number of evenly

spaced points over entire time range.
peakgain Returns the peak value of gain of the selected simulation quantity in dB.
peakgainfreq Returns the frequency in Hz at which the peak gain of the selected simulation

quantity occurs.
polar Coverts the complex number in rectangular co-ordinates to polar co-

ordinates.
per Returns the period of a simulation quantity.
phasecrossover Returns the phase crossover frequency, at which the phase is -180 degrees,

in Hz for the selected simulation quantity.
phasemargin Returns the phase angle in degrees at the gain crossover frequency of the

selected simulation quantity.
pk2pk Peak to peak. Difference betweenmax andmin of the first parameter over

the second parameter. Returns the peak-to-peak value for the selected
simulation quantity.

pkavg Returns the ratio of the peak to peak-to-average for the selected quantity.
pmax Maximumperiod of the selected simulation quantity.
pmin Minimumperiod of the selected simulation quantity.
pow Raises x to the power of y; pow(x,y).
prms Period Root Mean Square.
pulsefall9010 Returns the pulse fall time of the selected quantity according to the 90%-10%

estimate.
pulsefront1090 Returns the pulse front time of the selected quantity according to the 10%-

90% estimate.
pulsefront3090 Returns the pulse front time of the selected quantity according to the 30%-

90% estimate.
pulsemax Returns the pulsemaximum from the front and tail estimates for the selected

quantity.
pulsemaxtime Returns the time at which themaximumpulse value of the selected quantity is

reached.
pulsemin Returns the pulseminimum from the front and tail estimates for the selected

quantity.
pulsemintime Returns the time at which theminimumpulse value of the selected quantity is

reached.
pulsetail50 Returns the pulse tail time of the selected quantity from the virtual peak to

50%.
pulsewidth5050 Returns the pulse width of the selected quantity asmeasured from the 50%

points on the pulse front and pulse tail.
pwl Piecewise Linear.
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pwl_periodic Piecewise Linear for periodic extrapolation on x.
pwlx Piecewise Linear x with linear extrapolation on x.
pw_minus Pulse width of the first negative pulse.
pw_minus_avg Returns the average of the negative pulse width input stream.
pw_minus_max Returns themaximumpulse width of the negative pulse of input stream.
pw_minus_min Returns theminimumpulse width of the negative pulse of input stream.
pw_minus_rms RMS of the negative pulse width input stream.
pw_plus Pulse width of the first positive pulse.
pw_plus_avg Average of the positive pulse width input stream.
pw_plus_max Max. Pulse width of the positive pulse of input stream.
pw_plus_min Min. Pulse width of the positive pulse of input stream.
pw_plus_rms RMS of the positive pulse width input stream.
re Real part of the complex number.
rect Converts the complex number in polar to rectangular co-ordinates.
rem Fractional part of the selected simulation quantity i.e. remainder.
ripple Returns the ripple factor (AC RMS/Mean) for the selected quantity.
risetime Obtains the time taken to go from 10% to 90% of target point.
rms Returns the root mean square value of the selected quantity.
rmsAC Returns the AC RMS for the selected quantity.
root nth root function.
rSidelobeX Returns the X value of right side-lobe occurrence.
rSidelobeY Returns the Y value of right side-lobe occurrence.
settlingtime Returns the latest time at which the value of the selected simulation quantity

fell outside its tolerance band. The target value of the quantity and the +/-
bandwidth of the tolerance band are the additional args.

sgn Sign extraction.
sin Sine.
sinh Hyperbolic sine.
slidingmean Returns themoving average value of the selected simulation quantity

(specified by the first argument). The average is calculated over a period
(specified by the second argument).

slidingrms Returns themoving RMS value of the selected simulation quantity (specified
by the first argument). The RMS value is calculated over a period (specified
by the second argument).

sqr Square of the selected simulation quantity.
sqrt Square root of the selected simulation quantity.
stddev Returns the standard deviation of given values.
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sum Returns the sum of the given values.
tan Tangent.
tanh Hyperbolic tangent.
undershoot Calculates peak undershoot given a threshold value and number of evenly

spaced points over entire time range.
uppercutoff Returns the upper 3dB frequency of the selected simulation channel in Hz.
variance Calculates the variance of the given values.
XAtYMax Threshold crossing time: report first time (x value) at which an output quantity

crosses YMax.
XAtYMin Threshold crossing time: report first time (x value) at which an output quantity

crosses a user definable threshold.
XAtYVal Returns the X value at the first occurrence of Y value.
XWidthAtYVal Returns the X width between the first 2 occurrence of Y value.
xdb10beamdwidth Width between left and right occurrences of values 'x' db10 frommax. Takes

'x' as argument (3.0 default). To use this function, you need to open the Add
Trace Characteristics dialog and select the Radiation category.

xdb20beamwidth Width between left and right occurrences of values 'x' db20 frommax. Takes
'x' as argument (3.0 default). To use this function, you need to open the Add
Trace Characteristics dialog and select the Radiation category.

YAtXMax Returns the X value at maximum value of Y.
YAtXMin Returns the Y value at minimum value of X.
YAtXVal Returns the Y value at the first occurrence of X value.
y0 Bessel function of the second kind (0th order).
y1 Bessel function of the second kind (1st order).
yn Bessel function of the second kind (nth order).

Selecting a Parameter, Variable, or Quantity to Plot in RMxprt

Each trace in a report includes a quantity that is plotted along an axis. The quantity being plotted can
be a value that was calculated byRMxprt, such as L11, a value from a calculated expression.
To select a parameter, variable, or quantity to plot:

1. In the Traces dialog box, select one of the following categories:

Variables User-defined project or design variables.

Output
Variables

Derived quantities RMxprt project or design variables, parameters or
solution curves.
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2. Select a quantity to plot from theQuantity list. The available quantities depend on the
selected category and the setup of the design.

Creating Quick Reports in RMxprt

Following is the procedure for creating a quick report.
1. On the Project tree, select a setup or sweep icon of interest.
2. Right-click to display the shortcut menu and selectQuick Report.

TheQuick Report dialog appears.
3. Select the one or more categories for the report from the list and clickOK.

A rectangular plot for each selected category displays. The new plot or plots appear in the
Project tree under the Results icon.

Related Topics

Creating Reports
Modifying Reports
RMxprt Quick Report Categories

RMxprt Quick Report Categories

When using theQuick Reports function for Solutions, the following report categoriesmay be
available depending upon the solution parameters requested, solution type, etc:

Category Description
Coil Voltage Report voltages in themachine coil.
Current Report currents for each line or phase of themachine, source current, line current,

armature current.
Flux Density Report flux density in themachine air gap, flux linkages.
Induced
Voltage

Report Induced Line and Phase voltages.

Misc. Report miscellaneous quantities specific to themachine type such as power factor,
torque to current ratio.

Percentage Report machine efficiency.
Power Report air gap power, output power.
Torque Report cogging torque, output torque, magnet generated torque, induction torque.
Voltage Report Line and Phase voltage.
Angle Reports power factor angle.
Angular
Speed

Reports angular speed.
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Inductance Reports air gap permeance.
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Specifying RMxprt Winding Data
To define the winding data for an RMxprt machine

1. In the project tree, underMachine, open the folder that requires a winding, and double-click
Winding to open the windingProperties dialog box.
l For somemachine types this would beMachine>Rotor>Winding, for others,
Machine>Stator>Winding.

l You can also enter values in theProperties section of the desktop without opening a
separate window.

2. Specify the desired settings.
3. ClickOK to close theProperties dialog box.

The specific properties available depend on the specificmachine.
The followingmachine types have winding data available:

l Three-Phase InductionMotors (stator winding) and (rotor winding)
l Three-Phase SynchronousMachines (stator winding) and (rotor winding)
l Brushless PMDCMotors (stator winding)
l Adjust-Speed SynchronousMachines (stator winding)
l PMDCMotors (rotor winding)
l Switched ReluctanceMotors (stator winding)
l Line-Start Permanent-Magnet SynchronousMotors (stator winding)
l Universal Motors (stator winding) and (rotor winding)
l General DC Machines (rotor winding)
l Claw-Pole Alternators (stator winding)
l Generic RotatingMachines

Setting the Winding Type

RMxprt can automatically arrange almost all commonly used single- or double-layer poly-phase ac
windings provided all coils have the same number of turns. Users do not need to define coils one by
one. For a double-layer winding,RMxprt can also handle the coils with half turns which are
arranged in the order of even, odd, even, odd,…, as long as it is physically possible.
RMxprt also provides a very flexible toolWinding Editor in order for the users to design a variety of
special winding types according to their own needs, such as compound single- and double-layer
winding, big- and small-phase-spread variable-polemultiple-speed winding, sine-wave three-phase
winding, and so forth. TheWinding Editor is available to the following types of electricmachines:

1. Three-phase inductionmotors
2. Single-phase inductionmotors
3. Three-phase synchronousmotors and generators
4. Line-start permanent-magnet synchronousmotors
5. Claw-pole alternators
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6. Adjustable-speed permanent-magnet synchronousmotors and generators
7. Brushless permanent-magnet DC motors

When you edit the AC winding of a new design for the first time, RMxprt creates a default winding
arrangement based on the basic winding specifications:Number of Phases,Number of Poles,
Number of Slots,Winding Layers,Conductors per Slot, andCoil Pitch. Then you can edit the
winding configuration based on the default arrangement.

Winding Types Available for Machines

Use theWinding Type dialog to set theWinding type.
1. To display theWinding Type dialog double-click on theWinding property button.

Passing the cursor over the buttons for theWinding types changes the graphic to show the
available windings for themotor in the design. Choices differ depending on themotor. A
Winding Editor selection does not have a graphic.
Selections for the Three Phase InductionMotor (stator winding) and (rotor winding), Three-
Phase SynchronousMachine (stator winding) and (rotor winding), Brushless Permanent
Magnet DC Motor (stator winding), Adjust Speed SynchronousMachine (stator winding), Line
Start PMSynchronousMotor (stator winding), and Claw Pole alternator (stator winding)
include:
l Editor - enable theWinding Editor
l Whole Coiled
l Half Coiled
Selections for the DC Permanent Magnet Motor (rotor winding) and Universal Motor include
(stator winding) and (rotor winding):
l Lap
l Wave
Selection for the General DC Machines (rotor winding) include:
l Lap
l Wave
l Frogleg
Selections for single-phase inductionmotor include:
l Editor - enable theWinding Editor
l Lap - 90 deg phase belt 2-layer coil for both single and double layer
l Sin_1 - first class sinusoidal coil for double layer only
l Sin_2 - second class sinusoidal coil for double layer only
The Switched Reluctancemotor does not involve winding selections.

2. Select theWinding Type and clickOK.
This closes the window and sets theWinding Type property. If you select the Editor type, It
also enables theMachine>Edit Layout command on themenu bar.
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Enable the Winding Editor

Setting theWinding Type property toEditor enables the commandMachine>Edit Layout on the
menu bar. To display the dialog boxWinding Editor:

1. Open theWinding Properties window and set theWinding Type value to Editor. To do this,
double-click on the buttonWinding Type value to display theWinding Type selection window.

2. Select Editor as theWinding Type and clickOK. This closes theWinding Type selection
window and sets theWinding Type Value to Editor. It also enables the command
Machine>Winding>Edit Layout on themenu bar. Now theMachine Editor window displays
the default winding arrangement.
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3. ClickMachine>Winding>Edit Layout. This displays the dialog boxWinding Editor as
shown. The dialog boxWinding Editor includes functions that do not appear in the tab sheet
Winding Editor in the RMxprt Machine Editor window.

4.

Edit Winding Configuration

Each row of the winding data table in the dialog boxWinding Editor in Figure 3.13 is identified with
the coil index in the columnCoil. This information is displayed in the tab sheetWinding Editor in the
RMxprt Machine Editor window aswell, but it is editable in the dialog boxWinding Editor.
The winding data table contains four columns:

Phase is for the phase to which the coil belongs.
Turns is for the number of turns of the coil.

In
Slots

is for the slot number with the coil side current flowing in ('flow-in-side' for short). If 2 Layers
are specified in theWinding Properties window, the slot number endswith a "T" to show the

top layer.

Out
Slots

is for the slot number with the coil side current flowing out ("flow-out-side" for short). If 2
Layers are specified in theWinding Properties window, the slot number endswith a "B" to

show the bottom layer.
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Setting the Number of Winding Layers

To set the number of winding layers:
1. Open theWinding Propertieswindow by double-clicking on theWinding icon in the

properties window.
2. Use the drop-downmenu in theWinding Layers field to set the number as 1 or 2.

This sets the winding layers used in the winding.
The number of layers selectedmakes a difference in the display of data in theWinding
Editor.

Connecting and Disconnecting Windings

When you have specified the winding data, you can execute the following commands to
automatically connect or disconnect the windings.

l Machine>Winding>Connect All Coils
Upon executing, the graphical display in themain window shows the connections.

l Machine>Winding>Disconnect All Coils
Upon executing, the graphical display in themain window updates to remove the connection.

Related Topics

ViewWinding Connections

Poly-phase Winding Editor

RMxprt provides aWinding Editor in order for users to design variety of special winding types
according to their own needs, such as compound single- and double-layer winding, big- and small-
phase-spread variable-polemultiple-speed winding, sine-wave three-phase winding, and so forth.
TheWinding Editor is available to the following types of electricmachines:

l Three-phase InductionMotor
l Three-phase SynchronousMotor
l Three-phase SynchronousGenerator
l Permanent-magnet SynchronousGenerator
l Line-start Permanent-magnet SynchronousMotor
l Adjustable-speed Permanent-magnet SynchronousMotor
l Brushless Permanent-magnet DC Motor
l Claw-pole Alternator

You input data forNumber of Poles in the Machine Propertieswindow and data for theNumber
of Slots and Slot Type in theStatorPropertieswindow. You set theNumber of Slots in the
Winding Properties window.RMxprt automatically arranges the winding layout and display the
relevant information that has been specified in theWinding Editor tab of theRMxprtmain window.
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As long as the edited winding data have been saved, theWinding Editor tab will display the last
saved winding data wheneverWinding Editor dialog is launched. The left top part of theWinding
Editor tab shows the winding data, as does theWinding Editor dialog. In this area, the total number
of rows equals half the number of slots.

Enabling the Winding Editor Dialog
Setting theWinding Type property to Editor enables the Machine>Edit Layout command on the
menu bar. To display theWinding Editor dialog:

1. Open theWindingPropertieswindow and set theWinding property to Editor.
To do this, double-click on theWinding property button to display theWinding Type selection
window.

2. SelectEditor as theWinding Type and clickOK.
This closes theWinding Typewindow and sets theWinding Type property to Editor. It also
enables theMachine>Edit Layout command on themenu bar.

3. ClickMachine>Edit Layout.
This displays theWinding Editor dialog. TheWinding Editor dialog box includes functions
that do not appear in the RMxprtmain windowWinding Editor tab.
You can also invoke theWinding Editor dialog by:
a. Right-click on the data table section of theWinding Editor tab of themain window.
b. This displays an Edit Layout button.
c. Click the Edit Layout button to display theWinding Editor dialog.
You can also display theWinding Editor dialog by:
a. Right click in theWinding Editor tabmain window display.

This displays a shortcut menu.

b. ClickEdit Layout from the shortcut menu.
Each row of the winding data is identified with coil index in theCoil column. This information is
displayed in theWinding Editor tab in the RMxprt Main window, and it editable in theWinding
Editor dialog.

l ColumnPhase is for the phase to which the coil belongs.
l Column Turns is for the number of turns of coil.
l Column In Slots is for the slot number with the coil side current flowing in ('flow-in-side' for
short). If 2 Layers are specified in theWinding Properties window, the slot number endswith a
"T" to show the top layer.

l ColumnOut Slots is for the slot number with the coil side current flowing out ('flow-out-side'
for short). If 2 Layers are specified in theWinding Properties window, the slot number ends
with a "B" to show the bottom layer.

By changing the belonging phase in columnPhase, the number of turns in column Turns, the flow-
in-side slot number in column In Slot, the flow-out-side slot number in columnOut Slot for each coil,
it is possible to arrange the distribution of coils of single and double layer winding of any type
required.
TheWinding Editor dialog also includes three check boxes:
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l Periodic Multiplier: indicates the possibility to select the number of unit machines for editing
winding arrangement. It has a drop-downmenu to show the possible numbers for the periodic
multiplier.
When checked, the pull-down list box to the right displays the numbers of unit machines for
selection. Selecting 1meanswhole slots are considered as one unit machine, and all coils is
listed in the table of the edit window. Selecting 2 lists half of the total coils in the table, and
whole slots are divided into two unit machines, etc. When the check boxPeriodic Multiplier:
is unchecked, the pull-down list box to the right is grayed (enabled); all the coils are listed in the
table.

l Constant Turns.
Checking the check box (multiple choices)Constant Turns indicates that the number of turns
keeps constant and the column Turns in the table is grayed (disabled). If the check box
Constant Turns is unchecked, the column Turns in the table is brightened allowing for
editing andmodifying the number of turns.

l Constant Pitch
Checking this box grays theOut Slots column to the values cannot be edited. It means that the
coil pitch is constant. For two-layer windings, all flow-in-side slots are defined as top layer, and
all flow-out-side slots as bottom layer. The flow-out-side slot number is automatically
computed based on the input in the edit boxCoil Pitch in Stator2 page in RMxprt window, and
Out Slot column is disabled.
When the check boxConstant Pitch is unchecked, the columnOut Slot is enabled to allow
arbitrarily changing slot pitch for each coil.

TheWinding Editor dialog includes three command buttons.
l Click the command buttonDefault in the windowWinding Editor, all the data in the table
resumes to the situation of data from automatic arrangement byRMxprt.

l Click the command buttonReset in the windowWinding Editor, all the data in the table
resumes to the situation of data when the windowWinding Editor was first opened, or
resumes to the data that you have saved.

l ClickOK to accept the current values and close theWinding Editor dialog.

Windings Basic Terminology

Conductor
A conductor refers to a half turn of a coil. A conductor may be formedwith one insulated wire, or with
several strands of insulated wires.

Strands
A conductor may consist of several wires of same or different sizes stranded together. The number
of strands is also called number of wires per conductor. The conductor current may not uniformly
distribute among all wires, but the current density is uniformly distributed.

Coil
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A coil is wound with several turns, each turn consisting of two conductors. Coils are generally
wound with insulation-wrapped electromagnetic wire continuously on a windingmould. However,
coils with single-turn for heavy current are often formedwith two separate thick conductors. A thick
conductor is hammered onto the windingmould to form a half-coil. The linear part of a conductor
imbedded into a slot of iron core is termed effective side.

Coil Pitch
The number of slots of the armature iron core spanned by the two effective sides of a coil is termed
coil pitch, denoted by y. For instance, if the side of a coil in the 1-st slot spans 8 slots and is connected
to the side of the coil in the 9-th slot, the coil pitch of the coil is y = 8.

Full coil pitch: coil pitch = pole pitch
Short coil
pitch:

coil pitch < pole pitch

Long coil
pitch:

coil pitch > pole pitch, usually used in variable-polemultiple-speed
machines

Pole pitch: distance between two contiguous polesmeasured in number of slots.

Coil Set
The coils belonging to the same phase under one pole are connected in series as a coil set.

Winding
The coils or coil sets of a phase are connected according to certain rules to form a phase winding. A
phasemay consist of several branches connected in parallel. Every branchmust produce exactly
the same back emf andmust have the same resistance. As a result, the phase winding current is
uniformly distributed among all branches.
In summary, awindingmay be connected with several branches in parallel; each branch consists
of one or more coil sets connected in series; a coil setmay have several series coils; a coil is wound
with a number of turns; a turn is formed by two conductors; a conductormay be stranded by one or
more same- or different-size wires.

Poly Phase AC Winding

The common armature winding of poly-phase acmachines is catalogued and classified as shown in
the following table.
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Polyphase AC Winding
Double layer Variable-polemultiple speed type

Fractional slot number type
Wave-type
Concentric type
Lap Type

Single Layer Crossed Concentric type (whole coiled or half
coiled)
Crossed Chain-type (whole coiled or half coiled)
Concentric type (whole coiled or half coiled)
Lap-type (whole coiled or half coiled)
Chain-type (whole coiled or half coiled)

Compound
layer

Whole-coiled Windings

When the coils of an AC winding are connected so that there are asmany coil sets per phase as
there are poles, the winding is called "whole-coiled."

Half-coiled Windings

When the coils are connected so that there is only one coil set per phase per pair of poles, the
winding is called "half-coiled."
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Single-Layer Windings

All the conductors in one slot are connected in series with all the conductors in another slot to form a
single-layer coil. You set the number of winding layers in theWinding properties window,Winding
tab. Comparing to double-layer type, this type is characterized by

l Number of coils halved;
l No need for insulation between layers, therefore higher slot filling factor;
l Coil pitch depends on the connection, and is not adjustable;
l Being widely used in small capacity electricmachines.

According to different layouts of the end winding, single-layer windings are classified as chain-, lap-,
concentric- and crossed-types.

Chain-type Windings
The name single-layer chain-type is from the linked chain-like developed winding diagram. For a
chain-type winding, every coil set has only one coil.

Half-coiled Chain-type Winding

An example of three-phase 6-pole 18-slot single-layer half-coiled chain-type winding is shown in the
following figure.
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Whole-coiled Chain-type Winding

An example of three-phase 4-pole 24-slot single-layer whole-coiled chain-type winding is shown in
the following figure.

Lap-type Windings

The name single-layer lap-type is from the lapped layout of end connection. In a lap-type winding, at
least one coil set has 2 or more coils which are overlapped each other. If some coil sets have only
one coil, this winding type is also called "crossed lap-type".

Half-coiled Lap-type Winding

An example of three-phase 4-pole 24-slot single-layer half-coiled lap-type winding is shown in the
figure on the left, and an example of three-phase 8-pole 36-slot single-layer half-coiled crossed lap-
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type windings is shown in the following figure on the right.

Whole-coiled Lap-type Winding

An example of three-phase 4-pole 48-slot single-layer whole-coiled lap-type winding is shown on the
left, and an example of three-phase 4-pole 36-slot single-layer whole-coiled crossed lap-type
winding is shown on the right1

Concentric-type Windings

In a concentric-type winding, at least one coil set has 2 or more coils and non coils are overlapped
each other. If some coil sets have only one coil, this winding type is also called "crossed concentric-
type".
The single-layer concentric-type is formed of coils with different coil pitch, but with the same central
line and of concentric-circle-like, therefore is named concentric-type. Its end connection can be
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arranged in layers, and therefore is convenient to imbed into slots. Nevertheless, the endmagnetic
leakage is a bit bigger.

Half-coiled Concentric-type Winding

An example of three-phase 4-pole 24-slot single-layer half-coiled concentric-type winding is shown
on the left, and an example of three-phase 8-pole 36-slot single-layer half-coiled crossed concentric-
type winding is shown on the right.

Whole-coiled Concentric-type Winding

An example of three-phase 4-pole 48-slot single-layer whole-coiled concentric-type winding is
shown on the left, and an example of three-phase 4-pole 36-slot single-layer whole-coiled crossed
concentric-type winding is shown on the right.
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Double-Layer Windings

In this type, the conductors in a slot are arranged in upper and lower layers. One side of each coil is
imbedded in the upper layer in one slot and the other side is imbedded in the lower layer in another
slot. You set the number of winding layers in theWinding properties window,Winding tab.
Comparing to single-layer-type, this type is characterized by:

l Number of coils doubled;
l Need for insulation between layers, therefore lower slot filling factor, and danger in electric
breakdown between phases;

l Adjustable coil pitch, therefore possible weakening of harmonic emfs with proper short pitch
factor to improve electromagnetic properties of electricmachines;

l Being widely used in electricmachineswith capacity over 10 kW.
For the single speed electricmachine, the double-layer winding typically adopts whole-coiled type.
For the double speed electricmachine with doubling number of poles, the double-layer winding is
whole-coiled in high speed, half-coiled in low speed.
According to different coil shapes, double-layer windings are classified as lap-, concentric- and
wave-types.

Double-layer Lap-type Winding

An example of three-phase 4-pole 24-slot whole-coiled double-layer lap-type windings (short pitch
y = 5) is shown below.

Double-layer Concentric-type Winding

An example of three-phase 4-pole 24-slot whole-coiled double-layer concentric-type windings (short
pitch y = 5) is shown below.
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Double-layer Wave-type Winding

The name double-layer wave-type is from the wave-like developed winding diagram as shown
below.

Compared to lap-type:
l Thewinding of each phase connects the coils under different poles in series in one round, and
returns to the left to the first coil, then winds the next round, and so on so forth until all the coils
belonging to this phase are connected.

l This type is usually used in single-turn preformed hard coil for low voltage high current electric
machines.

l This type needs less connection wire between poles.

Fractional-Pitch Winding

First, introduce a number q, called number of slots per pole per phase, which is defined as
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A fractional-pitch winding has a fractional number .
An example of three-phase 6-pole 45-slot fractional-pitch double-layer winding

( , short pitch y = 7, pole pitch ) is shown here.

Auto-arrangement of AC Windings

RMxprt can arrange these windings automatically if all coils have the same number of turns. This
section describes the process to automatically arrange the coil distribution.For winding layout display
inRMxprt, the lap-type is default if windings are automatically arranged. If a concentric-type layout
display is desired, the winding can be defined bywinding editor, as described in the next section.
The wave-type winding is effective to a lap-type winding, and is also displayed as a lap-type winding.

Star Vector Diagram

The conductors (or coils) in slots produce emf (or mmf), which can be expressed with unit vector.
When the electricmachine has number of pole p, and number of slotsZ, the angular phase
difference in electric degrees between two contiguous slots is
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Drawing the vectors of emfs (or mmfs) in all the slots according to their phase angles forms the star
vector diagram of the winding. The figure below shows an example of the star vector diagram of 4-
pole 24-slot winding.

If there exists the greatest common factor t between the number of slotsZ and the number of pole
pairs pp (= p/2), the star vector diagram repeats t times, i.e. the winding has t periods. Let

,
and

,
then Z0 and p0 construct a complete star vector diagram and form a unit electricmachine. For the
whole-pitch winding electricmachine (q, as shown later, is an integer), t = p/2. For the fractional-
pitch winding electricmachine,

wherem is the number of phases. If t > 1, the angular phase difference between two contiguous
vectors is
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and the difference between the ordinal numbers of the slots of two contiguous vectors is

whereG is a minimum integer to make y0 equal to an integer (y0 should take into account the
possible reverse connection of coils under the contiguous pole).

Phase Spread

In the star vector diagram of a unit electricmachine, the range occupied by the vectors of each phase
under one pole is termed phase spread, expressed in electric degrees or number of slots. For a
single-layer winding, the phase spread is 180°/m (m – the number of phases). The phase spread of a
double-layer half-coiled winding is 360°/m, and the phase spread of a double-layer full-coiled
winding is 180°/m.
The phase spread of a 2-phase winding is always 90° (= 180°/m). Therefore, a 2-phase winding
cannot take the double-layer half-coiled winding type. The windings for single-phase inductionmotor
are also considered as 2-phase windings.
When the number of phases is an even number of greater than or equal to 4, the phase spread is
always 360°/m. Therefore, a winding with even number of phases (4, 6,…) can take only the
double-layer half-coiled winding type.
When the number of phases is an odd number of greater than or equal to 3, the phase spread can be
either 360°/m or 180°/m. Therefore, a winding with odd number of phases (3, 5,…) can take any
winding types.

Coil Arrangement

Coil arrangement is completed by the following processes. First, draw the star vector diagram based
on number of slots and number of poles. Then divide the whole region (360 electric degrees) to
several phase spreads, which is derived from the number of phases and the winding type. Finally,
assign all phase spreads to each phase in such a way that the axis of each succeeded phase lags by
360/m electric degrees (90 electric degrees for 2 phases).

Double-layer Windings

Take a three-phase winding as an example. The width of phase spread of half-coiled winding is
360o / 3 = 120o, the sequence of the phase spread is A, B, C. For whole-coiled winding, the width of
phase spread is 180o / 3 = 60o, the sequence of phase spread is A, –C, B, –A, C, –B, where the
phase spread with negative sign is termed negative phase spread.
The winding types can be set in theWinding Type panel for amachine that includes these options (in
this case, a brushless permanent magnetic DC motor), for double-layer whole-coiled windings as
shown in on the left and double-layer half-coiled windings as shown on the right.
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The star vector diagram of a three-phase whole-coiled (60o-phase-spread) winding is shown below
on the left, and that of a half-coiled (120o phase spread) winding is shown below on the right.

Single-layer Windings

Thewinding layers can be set in the properties window for the winding, for single-layer whole-coiled
windings as shown on the left and single-layer half-coiled windings as shown on the right.
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The phase spread of a three-phase single-layer whole-coiled or half-coiled winding is 60o, and the
star vector diagram is the same as the double-layer whole-coiled winding.

Fractional-pitch Windings

The number of slots per pole per phase of fractional-pitch winding is amixed number.

In the unit electricmachine, the numbers of slots occupied by phase spread are not all the same, but
repeat with the radix d. In each d poles, there are c poles with the slot number of phase spread equal
to b + 1 (big phase spread), d – c poles with the slot number of phase spread equal to b (small phase
spread).
Take as an example a three-phase 10-pole 36-slot fractional-pitch winding with phase spread of 60°.
The number of slots per pole per phase of fractional-pitch winding is

the greatest common factor between the number of slots 36 and the number of pole pairs 5 is t = 1,
the angular phase difference between two contiguous vectors in the star vector diagram is
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the difference between the ordinal numbers of the slots of two contiguous vectors is (G = 2)

the repetition radix d = 5. In each 5 pole region, each phase has big phase spread of 1 + 1 = 2 slots
under 1 pole, and small phase spread of 1 slot under 4 poles. The repeating format is 2 1 1 1 1 for
phase A. The repetition of phase spread distribution for all phases is shown in the following table.

Slot number 1~2 3 4 5 6 7~8 9 10 11 12 13~14 15 16 17 18

Phase
spread

A –
C

B –
A

C –B A –
C

B –
A

C –
B

A –
C

B

Slot number 19~20 21 22 23 24 25 27 28 29 30 31 33 34 35 36

Phase
spread

–A C –
B

A –
C

B –
A

C –
B

A –C B –
A

C –
B

The star vector diagram of winding is shown below.

Asymmetric Windings

Whole-pitch windings (q is integer) are always symmetric. Fractional-pitch windingswith
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becomes asymmetric if the denominator d is a multiple of the number of phasesm. In general, it is
avoid using asymmetric windings as possible. Nevertheless, it is sometime possible to design poly-
phase windingswith little asymmetry in order to use existing punching tools.
If d is a multiple of the number of phasesm, but the total number of slotsZ can be divided bym, it is
possible to construct poly-phase winding with little asymmetry.RMxprt can perform automatic
arrangement for this sort of windings and obtain the phase-spread in electric degrees for each
phase.
Take as an example a three-phase 6-pole 66-slot fractional-pitch winding electricmachine. Since

d =m = 3, the winding is asymmetric. The output in the window Design Output is shown below.
The information for WINDINGARRANGEMENT is displayed as follows:
The distribution of coil slots to phases:
The 3-phase, 2-layer winding can be arranged in 66 slots as below:

AAAAZZZZBBBXXXXCCCCYYYAAAZZZZBBBBXXXCCCCYYYYAAAAZZZBBBBXXX
XCCCYYYY

X, Y and Z stands for –A, -B and –C, respectively. For asymmetric windings, additional information is
output, as shown below.
The winding factors of each phase are:

Phase
A

0.954119

Phase
B

0.954119

Phase
C

0.949042

The angles between two-phase winding axes are:

Phase A &
B

119.082

Phase B &
C

120.459

Phase C &
A

120.459

If a sinusoidal rotating field links the winding, the fundamental induced-voltage components will be:
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Positive-sequence component 100%

Negative-sequence
component

0.286577%

Zero-sequence component 0.639823%

Coil Connections

Connection of Double-layer Lap Windings

Every vector represents the top-layer effective side of a coil. The bottom effective side of the coil is
determined based on the coil pitch, and is not displayed in the diagrams. Therefore, every vector in
the diagrams can also stand for a coil. Connect all coils in phase spread of A in positive direction, and
all coils in phase spread of –A in negative direction to form the phase A winding. In this way, phase B
and C windings can also be connected. The winding connection layouts for the vector diagrams are
shown below.
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Connection of Single-layer Half-coiled Windings

Every vector in A, B and C phase spread represents "go" effective side of a coil, the "return" effective
side of the coil is located in –A, –B and –C phase spread. For the lap type connection, all coils are
with full coil pitch. The connection layouts of the lap type and the concentric type, with respect to the
same vector drawing are shown below.

Connection of Single-layer Whole-coiled Windings

In the previous example, for the concentric type (lower right in the diagram), if coil 1 is not connected
from slot 1 to slot 8 (long coil pitch: coil pitch = 7 > pole pitch = 6), but connected from slot 1 to slot 20,
and slot 8 to slot 13, all coils of phase A winding have coil pitch of 5. In this way, the winding becomes
single-layer whole-coiled type with the same star vector diagram and phase spread, and hasmuch
shorter average coil pitch. Therefore, single-layer whole-coiled windings consume less
electromagnetic wire than single-layer half-coiled windings.RMxprt can optimize connections to
minimize the average coil pitch to form a single-layer whole-coiled winding.
An example of three-phase 4-pole 36-slot single-layer whole-coiled crossed lap-type winding (q = 3,
60o phase-spread) is shown below.
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An example of three-phase 4-pole 36-slot single-layer whole-coiled crossed concentric-type winding
(q = 3, 60o phase-spread) is shown below.

A star vector diagramwith fractional coil pitch can also be connected with single-layer whole-coiled
type.When the number of slots per pole per phase q <2, as shown in the following vector diagram,
the number of coil sets per phasemay not equal to the number of poles (6 coils vs 10 poles), but the
algorithm to connect coils is the same (minimize the average coil pitch), and therefore, it is still
referred aswhole coiled windings.
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The winding connection layout for the previous vector diagram is shown below.

Another example is an asymmetric three-phase winding. The connection layout is shown below.
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Connection of Double-pole Dual-speed Windings

Commonly used for coils of double-layer windings are lap- and concentric-types. Single-speed
double-layer winding electricmachine is usually connected aswhole-coiled winding. Double-pole
dual-speed electricmachine is connected as double-layer whole-coiled winding at high speed and as
double-layer half-coiled winding at low speed.
Take as an example a three-phase dual-speed 2/4-pole 24-slot double-layer winding. The
arrangement of coils is shown in the Table and in the following figure.

Slot
number

1 2 3 4 5 6 7 8 9 10 11 12

Two poles A A A A –
C

–
C

–
C

–
C

B B B B

Four poles A A A A C C C C B B B B

Slot
number

13 14 15 16 17 18 19 20 21 22 23 24

Two poles –
A

–
A

–
A

–
A

C C C C –
B

–
B

–
B

–
B

Four poles A A A A C C C C B B B B

The connection for variation of number of poles is shown in the next figure. On the top-left is the 2-
pole 2Y-connection at high speed, on the top-right is the 4-pole -connection at low speed.
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DC Windings

Lap Winding

Thewinding layout of a lap-type winding for dcmachines is as shown below.

A lap-type winding has the following relationships:

Coil pitch

Commutator pitch yk = ±m
Number of branches in
parallel

a = mp
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where

Z number of slots
p number of poles
m number of

multiplex

Wave Winding

Thewinding layout of a wave-type winding for dcmachines is as shown below.

A wave-type winding has the following relationships:

Coil pitch

Commutator pitch

Number of branches in
parallel

a = m
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Frog-leg Winding

A frog-leg winding consists of a lap winding and a wave winding. Assume the lap winding hasm
multiplex number. In order to connect the wave winding in parallel with the lap winding, the wave
winding should have the same branch bake emf as the lap winding. Therefore, the number of
branches in parallel of the wave winding has to be the same as that of the lap winding, or the
multiplex number of the wave windingmust bemp/2. The winding layout of a frog-leg-type winding
withm=1 for dcmachines is as shown below.

A frog-leg-type winding has the following relationships:

Coil pitch

Commutator pitch

yKa = ±m
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Number of branch in
parallel

a = pm

where

m number of multiplex (of the lap
winding)

Virtual Slots

Windings of the dcmachine are usually double-layer type. In many cases, often a number of coil
sides are imbedded into one slot for simplification of structure. Therefore, the number of slotsZ is
less than the number of coilsS. There exists the relationship

where µ is the number of coil sides in each layer in one slot and is termed virtual slot factor.
Therefore, the number of conductors per slots is equal to multiple of 2µ.

Equipotential Connectors

The points ideally possessing the same electric potential in armature winding are often wholly or
partly connected by short copper wire, which is termed equipotential connector.

Equipotential Connector Class A of Simplex-lap Winding

Asymmetry in magnetic circuit, such as eccentric air-gap, causes circulating current in lap winding,
increases losses and affects commutation in order. The equipotential connector Class A on the
commutator of simplex-lap winding can solve this problem. The connection pitch of equipotential
connector Class A of simplex-lap winding yp is equal to the number of commutator segments per
pole pair.
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Winding with yp = integer is termed symmetric winding. Only symmetric winding can have
equipotential connector Class A.

No need for Equipotential Connector for Simplex-wave Winding

Simplex-wave winding does not possess electrically equipotential points, therefore, can not have
equipotential connector. On the other hand, simplex-wave winding does not need equipotential
connector.

Equipotential Connector Class B of Multiplex-wave Winding

There are electric equipotential points among different sets of simplex-wave windings of multiplex-
wave winding. They can be connected to eliminate the nonuniform distribution of electric potential on
commutator segments due to inequality of brush resistances. This is termed equipotential connector
Class B. The connection pitch of equipotential connector Class B of multiplex-wave winding yp is
equal to the number of commutator segments per branch pair in parallel.

Equipotential Connector of Multiplex-lap Winding

For multiplex-lap winding, equipotential connector Class A is needed for each set of simplex-lap
windings, equipotential connector Class B is needed among different sets of simplex-lap windings.
There exist no electrically equipotential points among different sets of simplex-lap windings on the
commutator side of armature, however, there exist electrically equipotential points among different
sets of simplex-lap windings on different sides of armature as points A and B in the figure below.

Those points can be connected by conductors passing through inside armature.
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No Need for Equipotential Connector for Frog-leg Winding

For frog-leg winding, each pair of electrically equipotential points on commutator is connected by a
lap coil and a wave coil in series. The connection acts as equipotential connector Class A for lap
winding and as equipotential connector Class B for wave winding. Therefore there is no need for
extra equipotential connectors.

Pole Windings

The following two types of electricmachines possess similar pole winding structure:
l DCmachine (motor and generator)
l Three-phase synchronousmachine (motor and generator)

RMxprt adopts the same arrangement procedure for pole windings of the two types of electric
machines. There are three types of structure as shown in the figure below:

Round Wire pole winding with round wire.

Cylinder Coil pole winding with rectangular wire wound in standing way.

Edgewise pole winding with rectangular wire wound in flatting way.
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Coil

Limited Space for Wire Arrangement

Before completing a winding arrangement,RMxprt needs to determine the limited space sizes for
the winding. The limited sizes include: limitedOverall Height, limitedOverall Width andWinding
Clearance (the clearance between two adjacent pole windings), as shown below.

Overall Height,Overall Width andWinding Clearance can be input fromRMxprt panel. If either
Overall Height orOverall Width is set to 0,RMxprt perform automatic space optimization to
obtain themaximum space for pole winding arrangement in the condition to guarantee the clearance
between pole windings.
If the space from input or determined by space optimization is not sufficient to arrange for the input
number of turns per pole, amessage of "The rotor/shunt/series/commutating winding control
dimension is not big enough." is displayed inDesign Output window.

Round Wire Winding

The arrangement of pole winding with round wire is shown below.
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With auto-arrangement of pole windings,RMxprt calculatesmaximumnumber of layers, minimum
number of layers, maximumnumber of turns per layer, minimumnumber of turns per layer, and the
maximumnumber of turns per pole that is available from the limited space, and so forth.

Cylinder Coil

The arrangement of magnetic-pole winding with rectangular wire wound in standing way byRMxprt
is shown below.
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The cylinder coil is wound with half-turn over lapped layer by layer. Layers with the same number of
turns constitute a section. The output window Design Output displays the number of layers and the
number of turns per layer of each section, and themaximumnumber of turns per pole that is
available from the limited space.

Edgewise Coil

The arrangement of magnetic-pole winding with rectangular wire wound in flatting way byRMxprt is
shown below.
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To guarantee the clearance between two adjacent pole windings, the wire width of the lower parts is
decreased, while the wire thickness is increased to keep the sectional area of wire invariant as
possible. The turnswith the samewire gauge constitute a section (maximum three sections are
allowed). The output window Design Output displays the number of turns of each section and the
sizes of wire gauge, and themaximumnumber of turns per pole that is available from the limited
space.

Pole Winding with Half Turns

For some largemachines, a half turnmay be included due to too few turns per pole. When the
number of turns per pole is an integer number, the number of conductors per pole is an even number
with equal conductor number at both pole sides. Therefore, the two terminal leads of one pole coil
are at the same axial side (or at different pole sides), as shown below.
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When the number of turns per pole includes a half turn, the number of conductors per pole is an odd
number. In this case, one pole side has onemore conductor than the other pole side, and the two
terminal leads of one pole coil are at different axial sides (or at the same pole side), as shown below.

Exporting Winding Data

Winding datamay be export to a table:
1. Select theMachine>Winding>Export Layout command from themenu. Youmay also

right-click in theWinding Editor window and selectExport Layout from the shortcut menu.
2. Browse to the location to save the file and enter a filename.
3. ClickSave to export the winding data to a file and dismiss the dialog.

Note Thewindingmust be editable for the Export Layout command to be available. If you
are using a standard winding, you can switch to theWinding Editor by:
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1. Click on thewinding in the Project Tree window.
2. In the PropertiesWindow, click on the button next toWinding Type.

TheWinding Type dialog is displayed.
3. SelectEditor as the winding type and clickOK.

Getting Started with RMxprt 26-173
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

RMxprt Machine Types
Using Ansoft High-Frequency Structure Simulator, you can simulate and analyze the following
thirteenmachine types:

l Adjust-Speed SynchronousMachine
l Brushless Permanent-Magnet DC Motor
l Claw-Pole Alternator
l General DC Machine
l Generic RotatingMachine
l Line-Start Permanent-Magnet SynchronousMotor
l Permanent-Magnet DC Motor
l Single-Phase InductionMotor
l Switched ReluctanceMotor
l Three-Phase InductionMotor
l Three-Phase Non-Salient SynchronousMachine
l Three-Phase SynchronousMachine
l Universal Motor

Three-Phase Induction Motors

After you have selected Three-Phase Induction Motors as your model type, youmust define the
following:

l General data, such as the voltage, speed, andmaterials.
l Stator data, such as the slot types, diameter, and wire dimensions.
l Rotor data, such as the slot dimensions, skew, and ventage holes.
l Solution data, such as rated output voltage and frequency.

By option, you can:
l Add amachine housing.
l Add vents to and remove an existing vent from the stator and rotor.

Analysis Approach for Three-Phase Induction Motors

For a three-phase inductionmotor, the stator winding (with a sinusoidal spatial distribution and p
pairs of poles) is connected to a three-phase symmetric voltage power supply. The resulting currents
in the stator produce a rotatingmagnetic field. The rotor winding is often a squirrel cage type with the
number of poles dictated by the number of poles in the stator. Currents are induced in the rotor bars
and produce, in turn, a second rotatingmagnetic field. The two rotating fields produce a resultant
rotatingmagnetic field in the air gap of themachine. The interaction of this field in the air gap with the
rotor bar currents produces an electromagnetic torque, which acts on the rotor in the direction of the
rotation of the field in the air gap. A torque of equal value acts upon the stator in the opposite
direction.
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The stator winding, which is connected to a phase of the supply system, has p coils, each with a
symmetric spatial distribution and an opening of πD/2p, whereD is the diameter of the winding. In
this case, themagnetic field in the air gap has p periods, and the winding has p pairs of poles.
The performance of three-phase inductionmotors (IndM3) is analyzed based on the equivalent
circuit of one phase in the frequency domain as shown in Figure 1.
In the figure, R1 is the stator resistance, X1 is stator leakage reactance, which consists of stator slot
leakage reactance, end-winding leakage reactance, and differential leakage reactance. X2 and R2
are rotor leakage reactance and rotor resistance, respectively. X2 includes rotor slot leakage
reactance, end-ring leakage reactance, differential leakage reactance, and skewing leakage
reactance. Due to the saturation of the leakage field, X1 and X2 are nonlinear. The parameters in the
equivalent circuit are dependent on the stator and rotor currents. Due to the skin effects, X2 and R2
are the equivalent values from a distributed-parameter circuit, as shown in Figure 2.
They vary with the rotor slip s. All rotor parameters have been referred to the stator side.

In the exciting branch, Xm is themagnetizing reactance, and RFe is the resistance corresponding to
iron-core losses. Xm is a linearized nonlinear parameter that varies with the saturation of themain
field.
After a phase voltage U1 is applied to the phase terminals, stator phase current I1 and rotor current
I2, which has been referred to the stator, can be easily computed by the circuit analysis. The
electromagnetic power Pm, or air-gap power, is computed by the following:

Pm = 3 * I2^2 * R2/s

The electromagnetic torque Tm is:

Tm = Pm/

where w is the synchronous speed in rad/s.
The output mechanical shaft torque T2 is:

T2 = Tm - Tfw

where Tfw is the frictional and wind torque.
The output power is:
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P2 = T2 * 2

where 2 = * (1 - s) and is rotor speed in rad/s.
The input power is:

P1 = P2 + Pfw + Pcu2 + PFe + Pcu1 + Ps

where Pfw, Pcu2, PFe, Pcu1, and Ps are frictional and wind loss, rotor copper loss, iron-core loss,
stator copper loss, and stray loss, respectively.
The power factor is derived from:

PF = P1/(m * U1 * I1)

The efficiency is computed by:
eff = P2/P1 * 100%

Defining a Three-Phase Induction Motor

The general procedure for defining a three-phase inductionmotor is as follows:
1. Insert a three-phase inductionmotor into an existing or new project.
2. Double-click theMachine entry in the project tree to define the general data, such as the

number of poles andmachine losses.
3. Double-click theMachine-Stator entry in the project tree to define the stator geometry.
4. Double-click theMachine-Stator-Slot entry in the project tree to define the stator slot

dimensions.
5. Double-click theMachine-Stator-Winding entry in the project tree to define the stator

windings and conductors.
6. Double-click theMachine-Rotor entry in the project tree to define the rotor geometry.
7. Double-click theMachine-Rotor-Slot entry in the project tree to define the rotor slot

dimensions.
8. Double-click theMachine-Rotor-Winding entry in the project tree to define the rotor

conductor, ventage hole dimensions, and skew.
9. Double-click theMachine-Shaft entry in the project tree to define themagnetism of the shaft.
10. Optionally, right-click theMachine entry in the project tree and click Insert Housing to add a

machine housing.
11. Right-clickAnalysis in the project tree, and clickAdd Solution Setup to define the solution

data.
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12. Choose File>Save to save the project.
13. ChooseRMxprt>Analyze to analyze the design.

Note When you place the cursor over an entry field in the data windows, a brief
description of that field appears in the status bar at the bottom of theRMxprt
window.

Once the design is analyzed, themodel can be viewed in theMaxwell 2D Modeler, or it can be used
to create a new Maxwell 2D project, and a new Maxwell 3D design.
Please refer to the Three-Phase InductionMotor Problem application note, on the technical support
page of the ANSYS web site, for a specific example of a three-phase inductionmotor problem.

Defining the General Data for a Three Phase Induction Motor

Use theGeneral Data Properties window to define the basic parameters of the inductionmotor,
such as the number of poles, and frictional loss.
To define the general data:

1. To open theGeneral Data Propertieswindow, double-click theMachine entry in the project
tree on the desktop. (You can also enter values in theProperties section of the desktop
without opening a separate window.)

2. Enter the number of poles for themachine in theNumber of Poles field. This value is the total
number of poles in the stator (or the number of pole pairsmultiplied by two).

3. Enter the stray loss factor in theStray Loss Factor field. The stray load loss consists of the
losses arising from non-uniform current distribution in the copper and additional core losses
produced in the iron by distortion of themagnetic flux by the load current. The IEEE Standard
provides different assumed stray load loss values for AC motors rated less than 2500 hp, as
follows:

l 1) 1-125 HP = 1.8% of rated output power
l 2) 126-500 HP = 1.5%
l 3) 501-2499 HP = 1.2%

4. Enter the energy loss due to friction at the given speed in the Frictional Loss field.
5. Enter the wind loss due to air resistancemeasured at the reference speed in theWind Loss

field.
6. Enter the given speed in theReference Speed field.
7. ClickOK to close thePropertieswindow.

General Data for Three-Phase Induction Motors

To access the general data, double-click theMachine entry in the project tree.
TheGeneral Data Propertieswindow for a three-phase inductionmotor contains the following
fields:

Machine Type Themachine type you selected when inserting a new RMxprt design (Three
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Phase InductionMotor).
Number of
Poles

The number of poles themachine contains.

Stray Loss
Factor

The stray loss factor: the ratio of stray loss to rated output power.

Frictional
Loss

The frictional energy loss (due to friction) measured at the reference speed.

Wind Loss Thewind loss (due to air resistance) measured at the reference speed.
Reference
Speed

The given speed of reference.

Defining the Stator Data for a Three-Phase Induction Motor

The stator is the outer lamination stackwhere the three-phase windings reside. In the project tree,
double-clickMachine>Stator,Machine-Stator-Slot, andMachine-Stator-Winding to define the
physical dimensions, slot data, wires, and conductors for the stator.
TTo define general stator data:

1. To open theStator Data Propertieswindow, double-click theMachine>Stator entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter theOuter Diameter of the stator.
3. Enter the Inner Diameter of the stator.
4. Enter the length of the stator core in the Length field.
5. Enter the stacking factor for the stator core in the Stacking Factor field.
6. Select aSteel Type for the stator core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

7. Enter theNumber of Slots in the stator.
8. Select theSlot Type:

a. Click the button for theSlot Type.

TheSelect Slot Typewindow appears.

b. Select a slot type (available types include 1 through 4).
Note When you place themouse cursor over the slot type, a schematic of the selected

type appears, displaying the slot dimension variables.

Optionally, checkUser Defined Slot if you wish to define the slot dimensions using theSlot
Editor.
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c. ClickOK to close theSelect Slot Type window and return to thePropertieswindow.
9. Enter the number of sectors in the Lamination Sectors field.
10. Enter the thickness of themagnetic end pressboard in thePressboard Thickness field.

Enter 0 for a non-magnetic end pressboard.
11. Enter the skew width, measured in slot number, in theSkew Width field.
12. ClickOK to close thePropertieswindow.

Stator Data for Three-Phase Induction Motors

To access the general stator data, double-click theMachine>Stator entry in the project tree.
TheStator Data Propertieswindow contains the following fields:

Outer Diameter The outer diameter of the stator core.
Inner Diameter The inner diameter of the stator core.
Length The length of the stator core.
Stacking Factor The stacking factor of the stator core.
Steel Type The steel type of the stator core. Click the button to open theSelect

Definition window.
Number of Slots The number of slots the stator core contains.
Slot Type The type of slots in the stator core. Click the button to open theSelect Slot

Typewindow.
Lamination
Sectors

The number of lamination sectors.

Pressboard
Thickness

Themagnetic press board thickness (0 for a non-magnetic press board).

Skew Width The skew widthmeasured in slot number.

Defining the Stator Slots for a Three-Phase Induction Motor

Note If you choseUser Defined Slot in theSelect Slot Typewindow, youmust define the slot
dimensions using theSlot Editor.

To define the stator slots:
1. To open theStator Slot Data Propertieswindow, double-click theMachine-Stator-Slot

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Optionally, to automatically design the dimensions of slotsHs2,Bs1, andBs2, select the
Auto Design check box.

3. Optionally, to design dimensions of slotsBs1 andBs2 based on the stator tooth width, select
theParallel Tooth check box, and enter a value in the Tooth Width field.
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4. Enter the available slot dimensions.
Hs0 Always available.
Hs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.
Bs0 Always available.
Bs1 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto

Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

Bs2 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto
Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

Rs Rs is added when the slot type is 3 or 4.

5. ClickOK to close thePropertieswindow.

Stator Slot Data for Three-Phase Induction Motors

To access the stator slot data, double-click theMachine-Stator-Slot entry in the project tree.
TheStator Slot Data Propertieswindow contains the following fields:

Auto
Design

Select or clear this to enable or disable auto-design of slotsHs2,Bs1, andBs2. When
this check box is selected, only two other fields appear in the window:Hs0 andBs0.

Parallel
Tooth

Select this to designBs1 andBs2 based on the tooth width. When this check box is
selected, theBs1 andBs2 fields are removed, and the Tooth Width field is added.

Tooth
Width

The tooth width for the parallel tooth, on whichBs1 andBs2 are designed.

Hs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Hs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Rs A slot dimension. (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected). Rs is added when the slot type is 3 or 4.
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Defining the Stator Windings for a Three-Phase Induction Motor

Define the wires, conductors, insulation, and windings of the stator.
To define the wires and windings:

1. To open theStator Slot Winding Propertieswindow, double-click theMachine-Stator-
Winding entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Click theWinding tab.
3. Enter the number of layers in the stator winding in theWinding Layers field.
4. Select aWinding Type:

a. Click the button forWinding Type.
TheWinding Typewindow appears.

b. Select from one of the following three types of winding:
l Whole Coiled
l Half Coiled
l Editor

When you place themouse cursor over a winding button, an outline of the selected winding appears.
The following table describes the six types of windings that are possible (three for one-layer and
three for two-layer):

Type Description
One layer winding

Editor
A user-defined one-layer winding arrangement. You need to set up the
winding arrangement for each slot.

Whole Coiled

A one-layer whole-coiled winding:

Half Coiled A one-layer concentric half-coiled winding:
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Two Layer
Winding
Editor

A user-defined two-layer winding arrangement. When you select for winding layers
the you can specify a different winding arrangement for each slot in theWinding
Editor.

Whole
Coiled

A two-layer whole coiled winding:

The phase belt for this winding configuration is equal to 360/2m, wherem is the
phase number.

Half Coiled A two-layer half-coiled winding:
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There is only one coil per phase per pair of
poles.

Note For a two-layer winding, if you checkConstant Pitch in theWinding Editor, only the top
layer needs to be defined; the bottom layer will be determined according to the coil pitch.

a. Once you have clicked a button to select a winding, clickOK to close theWinding Type
window and return to thePropertieswindow.

b. Select or enter the number of parallel branches in one phase of the winding in theParallel
Branches field.

c. Enter the total number of conductors in each stator slot in theConductors per Slot field. This
value is the number of turns per coil multiplied by the number of layers.

d. Enter the coil pitch, measured in number of slots, in theCoil Pitch field. The coil pitch is the
number of slots separating one winding. For example, if a coil starts in slot 1 and ends in slot 6,
it has a coil pitch of 5.

e. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to have
RMxprt auto-design this value.

f. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to
automatically obtain this value from the wire library.
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g. Select theWire Size:
h. Click the button forWire Size.

TheWire Sizewindow appears.
i. Select a value from theWire Diameter pull-down list.
j. Select a wire gauge from theGauge pull-downmenu. You can select from the following
options:

<number>
You can select a specific gauge number. When you select
a gauge number, theWire Diameter field is automatically
updated.

USER

This option allows you tomanually enter theWire
Diameter. This is useful when you want to enter a
diameter that does not correspond to a particular wire
gauge.

AUTO

This option sets theWire Diameter to zero, and RMxprt
automatically calculates the optimal value. The diameter
information is then written to the output file when you
analyze the design.

MIXED

This option allows you to define a conductor that ismade of
different size wires. For example, a single conductor may
consist of 5 wires, 3 wires with a diameter of 0.21mmand 2
with a diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.

a. When you are done setting the wire size, clickOK to close theWire Sizewindow and
return to thePropertieswindow.

b. Click theEnd/Insulation tab.
c. Select or clear the Input Half-turn Length check box.
d. Do one of the following:
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l If you selected Input Half-turn Length, then enter the half-turn length of the armature
winding in the Half Turn Length field.

l If you cleared Input Half-turn Length, then enter the end length adjustment of the stator
coils in theEnd Adjustment field. The end adjustment is the distance one end of the
conductor extends vertically beyond the end of the stator.

5. Enter the inner radius of the base corner in theBase Inner Radius field.
6. Enter the inner diameter of the coil tip in the Tip Inner Diameter field.
7. Enter the distance between two stator coils in theEnd Clearance field.
8. Enter the thickness of the slot liner insulation in theSlot Liner field.
9. Enter the thickness of the wedge insulation in theWedge Thickness field.
10. Enter the thickness of the insulation layer in the Layer Insulation field.
11. Enter the limited slot fill factor for the wire design in the Limited Fill Factor field. The slot fill

factor is the ratio between the cross-sectional area of all conductors in one slot and the entire
slot area.

12. ClickOK to close thePropertieswindow.

Stator Winding Data for Three-Phase Induction Motors

To access the stator winding data, double-click theMachine-Stator-Winding entry in the project
tree.
TheStator Winding Data Propertieswindow contains the following fields:

Winding tab Winding Layers The number of winding layers.
Winding Type The type of stator winding. Click the

button to open theWinding Type
window and choose fromWhole
Coiled,Half Coiled, andEditor.
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Parallel Branches The number of parallel branches in the
stator winding.

Conductors per Slot The number of conductors per stator slot
(0 for auto-design).

Coil Pitch The coil pitchmeasured in number of
slots.

Number of Strands The number of wires per conductor (0 for
auto-design).

Wire Wrap The thickness of the double-sided wire
wrap (0 to automatically obtain this value
from the wire library).

Wire Size The diameter of the wire (0 for auto-
design). Click the button to open the
Wire Sizewindow where you can
specify units, wire type, diameter, and
gauge.

End/Insulation tab Input Half-turn Length Select or clear this check box to specify
whether or not you want to enter the
half-turn length. When this check box is
selected, theHalf Turn Length field
appears the next time you open the
Propertieswindow.When this check
box is selected, theEnd Adjustment
field appears instead.

Half Turn Length The half-turn length of the armature
winding.

End Adjustment The end length adjustment of the stator
coils, which is the distance one end of
the conductor extends vertically beyond
the end of the stator.

Base Inner Radius The inner radius of the base corner.
Tip Inner Diameter The inner diameter of the coil tip.
End Clearance The end clearance between two

adjacent coils.
Slot Liner The thickness of the slot liner insulation.
Wedge Thickness The thickness of the wedge insulation.
Layer Insulation The thickness of the insulation layer.
Limited Fill Factor The limited slot fill factor for the wire

design. The slot fill factor is the ratio
between the cross-sectional area of all
conductors in one slot and the entire slot
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area.

Winding Editor for a Three-Phase Induction Motor

For a three-phase inductionmotor, youmaywant to specify a different number of conductors for
each stator slot. TheWinding Editormakes this possible by enabling you to specify the number of
turns for each coil. To enable theWinding Editor, youmust have set theWinding Property for the
Winding Type toEditor.
To specify the number of turns for each coil:

1. ClickMachine>Winding>Edit Layout.
TheWinding Editor window appears.

2. In the table in the upper left, set which phase you want for each coil and which slot is the “in”
and “out” slot for the current in each coil.

3. If you are working on a quarter or half model, youmaywant to specify amultiplier by clicking
thePeriodic Multiplier check box and specifying a value.

4. Select or deselect theConstant Turns orConstant Pitch check boxes, depending on
whether you want to be able to change these setting in the table above.When these options
are selected, you cannot change the turns or pitch.

5. When you are satisfied with the coil settings, clickOK to close theWinding Editor window.

Defining Different Size Wires for a Three-Phase Induction Motor

Use theGauge option if you have a conductor that ismade up different size wires.
To define different size wires:

1. In theWire Size window, selectMIXED from theGauge pull-downmenu.
2. Select eitherRound orRectangular as theWire Type.
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3. Enter the appropriate wire data in the table:
l For a round wire:

l Enter theDiameter in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
diameter.

l For a rectangular wire:
l Enter theWidth of the wire in the table.
l Enter the Thickness of the wire in the table.
l Enter the Fillet value in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this data.

4. ChooseAdd to add the new wire data.
5. Repeat steps 3 and 4 for each size wire you want to add.
6. When you are finished defining the wires, clickOK to close theWire Sizewindow.

Note For example, if one conductor ismade up of 5 wires, and 3 of those wires have a
diameter of 0.21mm, and the other 2 have a diameter of 0.13mm, then themixed
wire size table will have two lines. The first line will list Diameter = 0.21 and Number
= 3. The second line will list Diameter = 0.13 and Number = 2. An equivalent wire
diameter is displayed asWire Size value in theWinding tab in the Properties
window.

Stator Vent Data for Three-Phase Induction Motors

By option, you can add a vent to a three-phase inductionmotor. To add a vent to stator in a three-
phase inductionmotor.

1. Select the stator icon in the project tree.
2. Right-click to display the pop-upmenu and select Insert Vent.

The vent icon appears in the project tree under the stator.
To remove a vent to stator in a three-phase inductionmotor.

1. Select the stator icon in the project tree.
2. Right-click to display the pop-upmenu and selectRemove Vent.

The vent icon disappears in the project tree under the stator.
The Vent data for the stator includes the following fields.

Vent Ducts Number of radial vent ducts
Duct Width Width of radial vent ducts
Magnetic Spacer
Width

Width of magnetic spacer which holds vent ducts. 0 for nonmagnetic
spacer

Duct Pitch Center-to-Center distance between two adjacent Vent ducts
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Defining the Rotor Data for a Three-Phase Induction Motor

The rotor consists of copper bars in which current is induced by themagnetic fields produced by the
stator windings. In the project tree, double-clickMachine-Rotor,Machine-Rotor-Slot, and
Machine-Rotor-Winding to define the rotor slots and vents.
To define general stator data:

1. To open theRotor Data Propertieswindow, double-click theMachine>Rotor entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter the stacking factor for the rotor core in the Stacking Factor field.
3. Enter theNumber of Slots in the rotor.
4. Select theSlot Type:

a. Click the button for theSlot Type.
TheSelect Slot Typewindow appears.

b. Select a slot type (available types include 1 through 4).
Note When you place themouse cursor over the slot type, a schematic of the selected

type appears, displaying the slot dimension variables.

c. ClickOK to close theSelect Slot Type window and return to thePropertieswindow.
5. Enter the outer diameter of the rotor in theOuter Diameter field.
6. Enter the inner diameter of the rotor in the Inner Diameter field.
7. Enter the length of the rotor core in the Length field.
8. Select aSteel Type for the rotor core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

9. Enter theSkew Width, measured in rotor slot pitch. This value defines by how much the rotor
bars are skewed.

10. Optionally, selectCast Rotor to allow the conductor to fill all the space available in the slot.
Otherwise, RMxprt assumes the slot wedge that fixes the bars is filled with insulator material in
a 2D/3D geometrymodel.

11. Optionally, selectHalf Slot to draw only half of the rotor slots.
12. Optionally, selectDouble Cage to specify the winding as a double-squirrel-cage winding.

If you select Double Cage, another line appears in the properties to let you specify the Bottom
Slot type.
a. Click on the Custom button on the Double Cage row. This displays the Select Slot Type

window.
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TheSelect Slot Typewindow appears.
b. Select a slot type (available types include 1 through 4).

Note When you place themouse cursor over the slot type, a schematic of the selected
type appears, displaying the slot dimension variables.

13. ClickOK to close thePropertieswindow.

Rotor Data for Three-Phase Induction Motors

To access the general rotor data, double-click theMachine>Rotor entry in the project tree.
TheRotor Data Propertieswindow contains the following fields:

Stacking
Factor

The stacking factor of the rotor core.

Number of
Slots

The number of slots the rotor core contains.

Slot Type The type of slots in the rotor core. Click the button to open theSelect Slot Type
window.

Outer
Diameter

The outer diameter of the rotor core.

Inner
Diameter

The inner diameter of the rotor core.

Length The length of the rotor core.
Steel Type The steel type of the rotor core. Click the button to open theSelect Definition

window.
Skew Width The skew widthmeasured in slot number.
Cast Rotor Select or clear this to specify whether the rotor squirrel-cage winding is cast or

not.
Half Slot Select this to specify a half-shaped unsymmetrical slot.
Double Cage Select this to specify the winding as double-squirrel-cage.

Defining the Rotor Slots for a Three-Phase Induction Motor

To define the type and dimensions of the rotor’s slots:
1. To open theRotor Data Slot Propertieswindow, double-click theMachine-Rotor-Slot

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Enter the slot dimensions in the following fields:Hs0,Hs01,Hs2,Bs0,Bs1,Bs2,Rs.
3. ClickOK to close thePropertieswindow.
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Rotor Slot Data for Three-Phase Induction Motors

To access the rotor slot data, double-click theMachine-Rotor-Slot entry in the project tree.
TheRotor Slot Data Properties window contains the following fields:

Hs0 A slot dimension (see the diagram shown in themodeling window whenMachine-Rotor-
Slot is selected).

Hs01 A slot dimension (see the diagram shown in themodeling window whenMachine-Rotor-
Slot is selected).

Hs2 A slot dimension (see the diagram shown in themodeling window whenMachine-Rotor-
Slot is selected).

Bs0 A slot dimension (see the diagram shown in themodeling window whenMachine-Rotor-
Slot is selected).

Bs1 A slot dimension (see the diagram shown in themodeling window whenMachine-Rotor-
Slot is selected).

Bs2 A slot dimension (see the diagram shown in themodeling window whenMachine-Rotor-
Slot is selected).

Rs A slot dimension. (see the diagram shown in themodeling window whenMachine-Stator-
Slot is selected). Rs is added when the slot type is 3 or 4.

Defining the Rotor Winding for a Three-Phase Induction Motor

To define the rotor winding data:
1. To open theRotor Data Slot Propertieswindow, double-click theMachine-Rotor-

Winding entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Select aBar Conductor Type for the rotor winding bar:
a. Click the button forBar Conductor Type.

TheSelect Definitionwindow appears.
b. Select a conductor type from the list, or define a new conductor type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

3. Enter the length of the gap between the end ring and the iron core in theEnd Length field.
This field specifies the value for only one end of the gap, not both.

4. Enter the end ring dimension in the axial direction in theEnd-Ring Width field. The end ring
connects the bars of the rotor to one another.

5. Enter the end ring dimension in the radius direction in theEnd-Ring Height field. The end
ring’s height covers at least the cross section of the rotor conductor.

6. Select anEnd Ring Conductor Type for the rotor winding end ring:
a. Click the button for End Ring Conductor Type.

TheSelect Definitionwindow appears.
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b. Select a conductor type from the list, or define a new conductor type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

7. ClickOK to close thePropertieswindow.

Rotor Winding for Three-Phase Induction Motors

To access the rotor winding data, double-click theMachine-Rotor-Winding entry in the project
tree.
TheRotor Winding Data Propertieswindow contains the following fields:

Bar Conductor
Type

The type of bar conductor used in the winding. Click the button to open the
Select Definition window.

End Length The length of the single-side end of the extended bar.
End Ring Width Thewidth of one side of the end rings in the axial direction. The end ring

connects the bars of the rotor to one another.
End Ring Height The height of the end rings in the radian direction. The end ring connects the

bars of the rotor to one another.
End Ring
Conductor Type

The type of end ring conductor used in the winding. Click the button to open
theSelect Definition window.

Rotor Vent Data for Three-Phase Induction Motors

By option, you can add a vent to a rotor in a three-phase inductionmotor.
To add a vent to rotor:

1. Select the rotor icon in the project tree.
2. Right-click to display the pop-upmenu and select Insert Vent.

The vent icon appears in the project tree under the rotor.
To remove a vent to stator in a three-phase inductionmotor.

1. Select the rotor icon in the project tree.
2. Right-click to display the pop-upmenu and selectRemove Vent.

The vent icon disappears in the project tree under the stator.
The Vent data for the rotor includes the following fields.

Vent Ducts Number of radial vent ducts
Duct Width Width of radial vent ducts
Magnetic Spacer
Width

Width of magnetic spacer which holds vent ducts. 0 for nonmagnetic
spacer

Duct Pitch Center to center distance between vent ducts
Holes per row Number of axial vent holes per row.
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Inner hole diameter Diameter of vent holes in inner row.
Outer hole diameter Diameter of vent holes in outer row.
Inner hole location Center to center diameter of inner hole vents
Outer hole location Center to center diameter of outer hole vents.

Defining the Shaft Data for a Three-Phase Induction Motor

To define the shaft:
1. To open theShaft Data Propertieswindow, double-click theMachine>Shaft entry in the

project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Select or clear theMagnetic Shaft check box to specify whether or not the shaft is to be
made of magneticmaterial.

3. ClickOK to close thePropertieswindow.

Shaft Data for Three-Phase Induction Motors

To access the shaft data, double-click theMachine>Shaft entry in the project tree.
TheShaft Data Propertieswindow contains the following fields:

Magnetic
Shaft

Select or clear this check box to indicate whether or not the shaft ismade of
magneticmaterial.

Setting Up Analysis Parameters for a Three-Phase Induction Motor

To define the solution data:
1. To open the Solution Setup window, right-clickAnalysis in the project tree, and clickAdd

Solution Setup.
2. Click theGeneral tab. TheOperation Type is automatically set toMotor for thismachine

type.
3. Select the Load Type used in themotor from the following options:

Const
Speed

The speed remains constant in themotor.

Const
Power

The output power remains constant in themotor.

Const
Torque

The torque remains constant regardless of the speed. In this case, Tload = Trated,
given by the output power divided by the given rated speed.

Linear
Torque

The torque increases linearly with speed. In this case, Tload = Trated * (n/nrated)
where Trated is given by the output power divided by the given rated speed.
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Fan
Load

The load varies nonlinearly with speed. In this case, Tload = Trated * (n/nrated)2
where Trated is given by the output power divided by the given rated speed.

4. Enter the output power developed at the shaft of themotor in theRated Output Power field.
5. Enter the RMS line-to-line voltage in theRated Voltage field.
6. Enter the desired rotor speed in theRated Speed field. When input Rated Speed is less than

the Synchronous Speed, themachine operates as amotor. When input Rated Speed is
greater than the Synchronous Speed, themachine operates as a generator. For an induction
generator, the rated performance will be calculated at the input Rated Speed with the three-
phase windings connecting to infite bus.

7. Enter the temperature at which the system functions in theOperating Temperature field.
8. Click the Three-Phase Induction Motor tab.
9. Enter the electrical line frequency in the Frequency field, and select the units.
10. Select theWinding Connection from the following options:

l Wye (Y)
l Delta

11. ClickOK to close theSolution Setupwindow.

Related Topics

Solution Data for Three-Phase InductionMotors

Solution Data for Three-Phase Induction Motors

To access the solution data, right-clickAnalysis in the project tree, and clickAdd Solution Setup.
TheSolution Setupwindow contains the following fields:

Operation
Type

On theGeneral tab. The operation type is automatically set toMotor for this
machine type.

Load Type On theGeneral tab. Select fromConst Speed,Const Power,Const Torque,
Linear Torque, and Fan Load. The default isConst Power.

Rated
Output
Power

On theGeneral tab. Type a value for the rated output voltage, and select the units.

Rated
Voltage

On theGeneral tab. Type a value for the rated voltage, and select the units.

Rated Speed On theGeneral tab. Type a value for the rated speed, and select the units.
Operating
Temperature

On theGeneral tab. Type a value for the operating temperature, and select the
units.

Frequency On the Three-Phase Induction Motor tab. Type a value for the frequency, and
select the units.

Winding On the Three-Phase Induction Motor tab. Select fromWye orDelta.

Getting Started with RMxprt 26-194
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Connection

Related Topics

Setting Up Analysis Parameters for a Three-Phase InductionMotor

Single-Phase Induction Motors

After you have selectedSingle-Phase Induction Motors as your model type, youmust define the
following:

l General data, such as the voltage, speed, andmaterials used in themotor.
l Stator data, such as the slot types, diameter, and wire dimensions.
l Rotor data, such as the slot dimensions, skew width, and ventage holes.
l Solution data, such as rated output voltage and frequency.

By option, you can:
l Add amachine housing.
l Add a vent or remove a vent from the rotor.

Analysis Approach for Single-Phase Induction Motors

The construction of a single-phase inductionmotor is structurally similar to the poly-phase squirrel-
cage inductionmotors. The primary difference is that the stator windings, which consist of amain
winding and an auxiliary winding, have axes of these that are displaced 90 electrical degrees in
space. To produce a starting torque, the currents in the two windingsmust be out of phase. Usually a
capacitor is connected in series with the auxiliary winding so that the auxiliary winding current is
forced to lead themain winding current by about 90 electrical degrees. Two parallel capacitors can
also be used: one for starting, and one for running, so that both a starting and running performance
are obtained.
An algorithm called symmetric component method is applied to analyze single-phase induction
motors (IndM1). Both voltages and currents of themain-phase and auxiliary-phase windings are
decomposed to positive- and negative-sequence components. The equivalent circuits for main-
phase positive-sequence components, auxiliary-phase positive-sequence components, main-phase
negative-sequence components, and auxiliary-phase negative-sequence components are shown in
(a), (b), (c), and (d) of Figure 3, respectively.
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In the figures, R1m, X1m, R1a, X1a, R2, X2, and Xmaremain-phase stator resistance, main-phase
stator leakage reactance, auxiliary-phase stator resistance, auxiliary-phase stator leakage
reactance, rotor resistance, rotor leakage reactance, andmagnetizing reactance, respectively. XC is
the reactance of the capacitor connected in series with the auxiliary winding, and the coefficient k is
the ratio of effective turns of the auxiliary winding to that of themain winding. R2, X2, and Xmhave
been referred to themain winding. The equivalent impedance of the four circuits is Zm1, Za1, Zm2,
and Za2, as shown in the figures.
According to the symmetric component method, the positive and negative components of auxiliary-
phase currents can be expressed in the form of a phasor as the following:

Ia1 = (j / k)Im1
Ia2 = ((j / k)Im2

Because themain winding and the auxiliary winding have the same applied terminal voltage U1, the
voltage equations for both windings become the following:

U1 = Um1 + Um2 = Im1Zm1 + Im2Zm2
U1 = Ua1 + Ua2 = Ia1Za1 + Ia2Za2 = (j / k)(Im1Za1 - Im2Za2)

The positive and negative components of main-phase current are calculated by the following:
Im1 = U1(Za2 - jkZm2) / (Zm1Za2 + Zm2Za1)
Im2 = U1(Za1 + jkZm1) / (Zm1Za2 + Zm2Za1)

The total input current is:
I1 = Im + Ia = (Im1 + Im2) + (Ia1 + Ia2)

Based on these two components of main-phase current, all current components shown in Figure 3
can be obtained by simple computation.
Then the total input current is:

I1 = Im + Ia = (Im1 + Im2) + (Ia1 + Ia2)
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The positive- and negative-sequence air-gap power can be computed in the following way:
Pm1 = 2 * Irm1^2 * R2 / s
Pm2 = 2 * Irm2^2 * R2 / (2 - s)

The total air-gap power is:
Pm = Pm1 - Pm2

Tm, T2, P2, P1, and eff are computed in the sameway as for three-phase inductionmotors.
The power factor is derived from:

PF = P1 / (U1 * I1)

Defining a Single-Phase Induction Motor

The general procedure for structurally defining a single-phase inductionmotor is as follows:
1. Insert a single-phase inductionmotor design in an existing or newly created project.
2. Double-click theMachine entry in the project tree to define the general data.
3. Double-click theMachine-Stator entry in the project tree to define the stator geometry.
4. Double-click theMachine-Stator-Slot entry in the project tree to define the stator slot

dimensions.
5. Double-click theMachine-Stator-Winding entry in the project tree to define the stator

windings and conductors.
6. Double-click theMachine-Rotor entry in the project tree to define the rotor geometry.
7. Double-click theMachine-Rotor-Slot entry in the project tree to define the rotor slot

dimensions.
8. Double-click theMachine-Rotor-Winding entry in the project tree to define the rotor

conductor, ventage hole dimensions, and skew.
9. Double-click theMachine-Shaft entry in the project tree to define themagnetism of the shaft.
10. Optionally, for Inner Rotor machines only, right-click theMachine entry in the project tree and

click Insert Housing to add amachine housing.
11. Right-clickAnalysis in the project tree, and clickAdd Solution Setup to define the solution

data.
12. Choose File>Save to save the project.
13. ChooseRMxprt>Analyze to analyze the design.

Note When you place the cursor over an entry field in the data windows, a brief
description of that field appears in the status bar at the bottom of theRMxprt
window.

Once the design is analyzed, themodel can be imported into theMaxwell 2D Modeler, or can be
used to create a new Maxwell 2D project, and a new Maxwell 3D design.
Please refer to theA Capacitor-Run Single-Phase InductionMotor Problem application note, on the
technical support page of the ANSYS web site, for a specific example of a single-phase induction
motor problem.
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Defining the General Data for a Single-Phase Induction Motor

Use theGeneral Data Properties window to define the basic parameters of the inductionmotor,
such as the number of poles, frictional loss, and operationmode.
To define the general data:

1. To open theGeneral Data Propertieswindow, double-click theMachine entry in the project
tree on the desktop. (You can also enter values in theProperties section of the desktop
without opening a separate window.)

2. Enter the number of poles for themachine in theNumber of Poles field. This value is the total
number of poles in the stator (or the number of pole pairsmultiplied by two).

3. Select one of the following for theRotor Position:
l Inner Rotor
l Outer Rotor

4. Enter the energy loss due to friction at the given speed in the Frictional Loss field.
5. Enter the wind loss due to air resistancemeasured at the reference speed in theWind Loss

field.
6. Enter the given speed in theReference Speed field.
7. Select theOperation Mode:

a. Click the button.
The Select Operation Mode window appears.

b. Select from one of the following:
C-Run Capacitance-runmode. The capacitor is in series with the auxiliary

winding. In the Capacitor runmode, the capacitor will be designed (if
the auto-designmode is selected) to minimize the backward
magnetomotive force.

C-Start Capacitance-start mode. The auxiliary winding is in series with the
capacitor and is disconnected when the rotor reaches the switching
speed.

C-R&S Capacitance-run and start mode. Two capacitors are in series with
the auxiliary winding; one for starting, one for running.

R-Start Resistor-start mode. The auxiliary winding is disconnected when the
rotor reaches the switching speed.

c. ClickOK to close the Select Operation Modewindow and return to theProperties
window.
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8. Enter values in the following capacitance, resistance, and switching speed fields:
Run Capacitance Available for C-Run, C-R&S
Run Resistance Available for C-Run, C-R&S
Start Capacitance Available for C-Start, C-R&S
Start Resistance Available for C-Start, C-R&S
Switching Speed Available for C-Start, C-R&S, R-

Start

9. If the start winding needs to be optimized, select theObjective Type from the following three
options:
l (Tst/Ist)max. Accept the defaults. This is the ratio of themaximum starting torque to the
starting current ratio.

l (Tst)max. Enter the given start current ratio. This is themaximum starting torque
l (Ist)min (minimum starting current). Enter the given start torque ratio.

Note The start-winding optimization goal is disabled for theC-Run operationmode.
In capacitor-runmode, the capacitor is designed tominimize the backward
magnetomotive force. For other modes, if the auto-design function is active, the
capacitor and the resistance are designed according to the start goal, selected
from the following:

l Themaximum value of (Starting Torque/Starting Current).
l Themaximum starting torque.
l Theminimum starting current.

10. ClickOK to close thePropertieswindow.

General Data for Single-Phase Induction Motors

To access the general data, double-click theMachine entry in the project tree.
TheGeneral Data Propertieswindow for a three-phase inductionmotor contains the following
fields:

Machine
Type

Themachine type you selected when inserting a new RMxprt design (Single Phase
InductionMotor).

Number of
Poles

The number of poles themachine contains.

Rotor
Position

Select whether the rotor is an Inner Rotor orOuter Rotor.

Frictional
Loss

The frictional energy loss (due to friction) measured at the reference speed.

Wind Loss Thewind loss (due to air resistance) measured at the reference speed.
Reference
Speed

The given speed of reference.

Operation Click the button to select from the following four modes:C-Run, C-Start,C-R&S,

Getting Started with RMxprt 26-199
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Mode andR-Start.
Run
Capacitance

The capacitance of the run capacitor. Available for C-Run and C-R&S operation
modes.

Run
Resistance

The resistance of the run capacitor. Available for C-Run and C-R&S operation
modes. SeeNote below.

Start
Capacitance

The resistance of the start capacitor. Available for C-Start and C-R&S operation
modes.

Start
Resistance

The resistance of the start capacitor. Available for C-Start and C-R&S operation
modes.

Switching
Speed

The switching speed of the capacitor or resistor. Available for C-Start, C-R&S, and
R-Start operationmodes.

Objective
Type

If the start winding needs to be optimized, select from the following three objective
types: (Tst/Ist)max, (Tst)max, or (Ist)min.

• For (Tst/Ist) max, accept the defaults. This is the ratio of themaximum
starting torque to the starting current ratio.
• For (Tst) max, enter theGiven Start Current Ratio. This is themaximum

starting torque.
• For (Ist) min (minimum starting current), enter theGiven Start Torque

Ratio.
The start-winding optimization goal is disabled for theC-Run operationmode.

Note When exporting the RMxprt model to Maxwell:
l If the value of theRun Resistance is zero in RMxprt, the value of theRun
Resistancewill be autocomputed inMaxwell to a value of 1% of the capacitor
reactance.

l To neglect theRun Resistance in Maxwell, set the value to a small non-zero
number in RMxprt.

Defining the Stator Data for a Single-Phase Induction Motor

The stator is the outer lamination stackwhere the three-phase windings reside. In the project tree,
double-clickMachine-Stator,Machine-Stator-Slot, andMachine-Stator-Winding to define the
physical dimensions, slot data, wires, and conductors for the stator.
To define general stator data:

1. To open theStator Data Propertieswindow, double-click theMachine>Stator entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter theOuter Diameter of the stator.
3. Enter the Inner Diameter of the stator.
4. Enter the length of the stator core in the Length field.
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5. Enter the stacking factor for the stator core in the Stacking Factor field.
6. Select aSteel Type for the stator core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

7. Enter theNumber of Slots in the stator.
8. Select theSlot Type:

a. Click the button for theSlot Type.
TheSelect Slot Typewindow appears.

b. Select a slot type (available types include 1 through 4).
Note When you place themouse cursor over the slot type, a schematic of the selected

type appears, displaying the slot dimension variables.

c. ClickOK to close theSelect Slot Type window and return to thePropertieswindow.
9. Enter the overall width of the stator outer profile in theOverall Width field.
10. ClickOK to close thePropertieswindow.

Stator Data for Single-Phase Induction Motors

To access the general stator data, double-click theMachine>Stator entry in the project tree.
TheStator Data Propertieswindow contains the following fields:

Outer
Diameter

The outer diameter of the stator core.

Inner
Diameter

The inner diameter of the stator core.

Length The length of the stator core.
Stacking
Factor

The stacking factor of the stator core.

Steel Type The steel type of the stator core. Click the button to open theSelect Definition
window.

Number of
Slots

The number of slots the stator core contains.

Slot Type The type of slots in the stator core. Click the button to open theSelect Slot Type
window.

Overall Width The overall width of the stator outer profile.

Defining the Stator Slots for a Single-Phase Induction Motor

Use theStator1window to define the physical dimensions of the stator slots.
To define the stator slots:
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1. To open theStator Slot Data Propertieswindow, double-click theMachine-Stator-Slot
entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Optionally, to automatically design the dimensions of slotsHs2,Bs1, andBs2, select the
Auto Design check box.

3. Optionally, to design dimensions of slotsBs1 andBs2 based on the stator tooth width, select
theParallel Tooth check box, and enter a value in the Tooth Width field.

4. Enter the available slot dimensions.
Hs0 Always available.
Hs1 Always available.
Hs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.
Bs0 Always available.
Bs1 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto

Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

Bs2 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto
Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

Rs Rs is added when the slot type is 3 or 4.

5. ClickOK to close thePropertieswindow.
Parallel
Branches

The number of parallel branches in the series winding.

Number of
Strands

The number of wires per conductor in the series winding (0 for auto-
design).

Wire Wrap The thickness of the double-sided wire wrap (0 for auto-pickup from the
wire library).

Wire Size Thewire diameter (0 for auto-design).

Stator Slot Data for Single-Phase Induction Motors

To access the stator slot data, double-click theMachine-Stator-Slot entry in the project tree.
TheStator Slot Data Propertieswindow contains the following fields:

Auto
Design

Select or clear this to enable or disable auto-design of slotsHs2,Bs1, andBs2. When
this check box is selected, only two other fields appear in the window:Hs0 andBs0.

Parallel
Tooth

Select this to designBs1 andBs2 based on the tooth width. When this check box is
selected, theBs1 andBs2 fields are removed, and the Tooth Width field is added.

Tooth The tooth width for the parallel tooth, on whichBs1 andBs2 are designed.
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Width
Hs0 A slot dimension (see the diagram shown in themodeling window whenMachine-

Stator-Slot is selected).
Hs1 A slot dimension (see the diagram shown in themodeling window whenMachine-

Stator-Slot is selected).
Hs2 A slot dimension (see the diagram shown in themodeling window whenMachine-

Stator-Slot is selected).
Bs0 A slot dimension (see the diagram shown in themodeling window whenMachine-

Stator-Slot is selected).
Bs1 A slot dimension (see the diagram shown in themodeling window whenMachine-

Stator-Slot is selected).
Bs2 A slot dimension (see the diagram shown in themodeling window whenMachine-

Stator-Slot is selected).
Rs A slot dimension. (see the diagram shown in themodeling window whenMachine-

Stator-Slot is selected). Rs is added when the slot type is 3 or 4.

Defining the Stator Windings for a Single-Phase Induction Motor

Define the wires, conductors, insulation, and windings of the stator.
To define the wires and windings:

1. To open theStator Winding Propertieswindow, double-click theMachine-Stator-
Winding entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Click theWinding tab.
3. Enter the thickness of the slot liner in theSlot Liner field.

4. Enter the thickness of the wedge insulation in theWedge Thickness field.
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5. Enter the limited slot fill factor for the wire design in the Limited Fill Factor field. The slot fill
factor is the ratio between the cross-sectional area of all conductors in one slot and the entire
slot area.

6. Select or clear the Include Series Winding check box. This option sets whether or not to
include the series winding in the speed adjustment. When this option is selected, a third tab,
Series (C), appears in thePropertieswindow.

7. Enter the number of layers in theWinding Layers field.
8. Enter the number of slots in theCoil Pitch field.
9. Select aWinding Type:

a. Click the button forWinding Type.
TheWinding Typewindow appears.

b. Select from one of the following types of winding:
l Lap
l Sin_1
l Sin_2
l Editor

When you place themouse cursor over a winding button, an outline of the selected
winding appears. The following table describes the four types of windings that are
possible:

Editor

A user-defined one or two-layer winding arrangement, determined
by yourWinding Layers selection. Enables theWinding Editor ,
where you can specify a different winding arrangement for each
slot.

Lap

90 deg phase belt 2-layer coil for both single and double layer

Sin_1

A first-class sinusoidal coil for double layer only. TheConductors
per Layer field defines themaximumnumber of conductors in the
slot. The software will determine the winding distribution in the slots
to get the sinusoidal current distribution.
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Sin_2

A second-class sinusoidal coil for double layer only. The
Conductors per Layer field defines themaximumnumber of
conductors in the slot. The software will determine the winding
distribution in the slots to get the sinusoidal current distribution.

c. Once you have clicked a button to select a winding, clickOK to close theWinding Type
window and return to thePropertieswindow.

10. Click theMain (A) tab.
a. Enter the end length adjustment of themain stator coil in theEnd Extension field. The

end adjustment is the distance one end of the conductor extends vertically beyond the
end of the stator.
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b. Enter the number of conductors per layer of main winding in theConductors per
Layer field.

c. Enter the number of parallel branches in themain stator winding in theParallel
Branches field.

d. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to
have RMxprt auto-design the value.

e. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to
automatically obtain this value from the wire library.

f. To select theWire Size: Click the button forWire Size.
TheWire Sizewindow appears.

g. Select a value from theWire Diameter pull-down list.
h. Select a wire gauge from theGauge pull-downmenu. You can select from the following

options:
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<number>
You can select a specific gauge number. When you select a
gauge number, theWire Diameter field is automatically
updated.

USER
This option allows you tomanually enter theWire Diameter.
This is useful when you want to enter a diameter that does
not correspond to a particular wire gauge.

AUTO

This option sets theWire Diameter to zero, and RMxprt
automatically calculates the optimal value. The diameter
information is then written to the output file when you analyze
the design.

MIXED

This option allows you to define a conductor that ismade of
different size wires. For example, a single conductor may
consist of 5 wires, 3 wires with a diameter of 0.21mmand 2
with a diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.

i. When you are done setting the wire size, clickOK to close theWire Sizewindow and
return to thePropertieswindow.

11. Click theAux (B) tab.
a. Enter the end length adjustment of the auxiliary stator coil in theEnd Extensionfield.
b. Enter the number of conductors per layer of auxiliary winding in theConductors per

Layer field.
c. Enter the number of parallel branches in the auxiliary stator winding in theParallel

Branches field.
d. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to

have RMxprt auto-design the value.
e. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to

automatically obtain this value from the wire library.
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f. To select theWire Size: Click the button forWire Size.
TheWire Sizewindow appears.

g. Select a value from theWire Diameter pull-down list.
h. Select a wire gauge from theGauge pull-downmenu. You can select from the following

options:

<number>
You can select a specific gauge number. When you select a
gauge number, theWire Diameter field is automatically
updated.

USER
This option allows you tomanually enter theWire Diameter.
This is useful when you want to enter a diameter that does
not correspond to a particular wire gauge.

AUTO

This option sets theWire Diameter to zero, and RMxprt
automatically calculates the optimal value. The diameter
information is then written to the output file when you analyze
the design.

MIXED

This option allows you to define a conductor that ismade of
different size wires. For example, a single conductor may
consist of 5 wires, 3 wires with a diameter of 0.21mmand 2
with a diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table
usingMachine>Wire, and then you can select this wire table using the
Tools>Options>Machine Options command.

i. When you are done setting the wire size, clickOK to close theWire Sizewindow and
return to thePropertieswindow.

12. ClickOK to close thePropertieswindow.

Stator Winding Data for Single-Phase Induction Motors

To access the stator winding data, double-click theMachine-Stator-Winding entry in the project
tree.
TheStator Winding Data Propertieswindow contains the following fields:

Winding
tab

Slot Liner The thickness of the slot liner.

Wedge
Thickness

 The thickness of the wedge insulation

Limited Fill
Factor

The limited slot fill factor for the wire design. The slot fill factor is the ratio
between the cross-sectional area of all conductors in one slot and the
entire slot area.

Winding
Layers

The number of winding layers. Not visible if theWinding Type is either
Sin_1 or Sin_2.
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Coil Pitch The coil pitchmeasured in number of slots. Not visible if theWinding
Type is either Sin_1 or Sin_2.

Winding
Type

The type of stator winding for themain phase. Click the button to open
theWinding Typewindow and choose from Lap, Sin_1, Sin_2,and
Editor.

Main (A) End
Extension

The end length adjustment of the stator coils.

Conductors
per Layer

The number of conductors per layer in themain winding.

Parallel
Branches

The number of parallel branches in themain stator winding.

Number of
Strands

The number of wires per conductor (0 for auto-design).

Wire Wrap The thickness of the double-sided wire wrap (0 for auto-pickup from the
wire library).

Wire Size Thewire diameter (0 for auto-design).
Aux (B) End

Extension
The end length adjustment of the auxiliary winding.

Conductors
per Layer

The number of conductors per layer in the auxiliary winding.

Parallel
Branches

The number of parallel branches in the auxiliary stator winding.

Number of
Strands

The number of wires per conductor in the auxiliary winding (0 for auto-
design).

Wire Wrap The thickness of the double-sided wire wrap (0 for auto-pickup from the
wire library).

Wire Size Thewire diameter (0 for auto-design).

Winding Editor for a Single-Phase Induction Motor

For a single-phase inductionmotor, youmaywant to specify a different number of conductors for
each stator slot. TheWinding Editor makes this possible by enabling you to specify the number of
turns for each coil.
To specify the number of turns for each coil:

1. ClickMachine>Winding>Edit Layout.
TheWinding Editor window appears.

2. In the table in the upper left, set which phase you want for each coil and which slot is the “in”
and “out” slot for the current in each coil.

3. If you are working on a quarter or half model, youmaywant to specify amultiplier by clicking
thePeriodic Multiplier check box and specifying a value.
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4. Select or deselect theConstant Turns orConstant Pitch check boxes, depending on
whether you want to be able to change these setting in the table above.When these options
are selected, you cannot change the turns or pitch.

5. When you are satisfied with the coil settings, clickOK to close theWinding Editor window.

Defining Different Size Wires for a Single-Phase Induction Motor

Use theGauge option if you have a conductor that ismade up different size wires.
To define different size wires:

1. In theWire Size window, selectMIXED from theGauge pull-downmenu.
2. Select eitherRound orRectangular as theWire Type.
3. Enter the appropriate wire data in the table:

l For a round wire:
l Enter theDiameter in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
diameter.

l For a rectangular wire:
l Enter theWidth of the wire in the table.
l Enter the Thickness of the wire in the table.
l Enter the Fillet value in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this data.

4. ChooseAdd to add the new wire data.
5. Repeat steps 3 and 4 for each size wire you want to add.
6. When you are finished defining the wires, clickOK to close theWire Sizewindow.

Note For example, if one conductor ismade up of 5 wires, and 3 of those wires have a
diameter of 0.21mm, and the other 2 have a diameter of 0.13mm, then themixed
wire size table will have two lines. The first line will list Diameter = 0.21 and Number
= 3. The second line will list Diameter = 0.13 and Number = 2. An equivalent wire
diameter is displayed asWire Size value in theWinding tab in the Properties
window.

Defining the Rotor Data for a Single-Phase Induction Motor

The rotor consists of copper bars in which current is induced from the stator windings. The rotor
rotates at a slightly slower speed than the stator electromagnetic field. In the project tree, double-
clickMachine>Rotor,Machine-Rotor-Slot, andMachine-Rotor-Winding to define the physical
dimensions, slot data, wires, and conductors for the rotor.
To define the general rotor data:
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1. To open theRotor Propertieswindow, double-click theMachine>Rotor entry in the project
tree on the desktop. (You can also enter values in theProperties section of the desktop
without opening a separate window.)

2. Enter the stacking factor for the rotor core in the Stacking Factor field.
3. Enter theNumber of Slots in the rotor.
4. Select theSlot Type:

a. Click the button for theSlot Type.
TheSelect Slot Typewindow appears.

b. Select a slot type (available types include 1 through 4).
Note When you place themouse cursor over the slot type, a schematic of the selected

type appears, displaying the slot dimension variables.

c. ClickOK to close theSelect Slot Type window and return to thePropertieswindow.
5. Enter the outer diameter of the rotor in theOuter Diameter field.
6. Enter the inner diameter of the rotor in the Inner Diameter field.
7. Enter the length of the rotor core in the Length field.
8. Select aSteel Type for the rotor core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

9. Enter theSkew Width, measured in rotor slot pitch. This value defines by how much the rotor
bars are skewed.

10. Optionally, selectCast Rotor to allow the conductor to fill all the space available in the slot.
Otherwise, RMxprt assumes the slot wedge that fixes the bars is filled with insulator material in
a 3D/3D geometrymodel.

11. ClickOK to close thePropertieswindow.

Rotor Data for Single-Phase Induction Motors

To access the general rotor data, double-click theMachine>Rotor entry in the project tree.
TheRotor Data Propertieswindow contains the following fields:

Stacking
Factor

The stacking factor of the rotor core.

Number of
Slots

The number of slots the rotor core contains.

Slot Type The type of slots in the rotor core. Click the button to open theSelect Slot Type
window.

Outer
Diameter

The outer diameter of the rotor core.

Inner The inner diameter of the rotor core.
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Diameter
Length The length of the rotor core.
Steel Type The steel type of the rotor core. Click the button to open theSelect Definition

window.
Skew Width The skew widthmeasured in slot number.
Cast Rotor Select or clear this to specify whether the rotor squirrel-cage winding is cast or

not.

Defining the Rotor Slots for Single-Phase Induction Motors

To define the rotor’s slots:
1. To open theRotor Slot Propertieswindow, double-click theMachine-Rotor-Slot entry in

the project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter the slot dimensions in the following fields:Hs0,Hs01,Hs2,Bs0,Bs1,Bs2, Rs.
3. ClickOK to close thePropertieswindow.

Rotor Slot Data for Single-Phase Induction Motors

To access the rotor slot data, double-click theMachine-Rotor-Slot entry in the project tree.
TheRotor Slot Data Properties window contains the following fields:

Hs0 A slot dimension (see the diagram shown in themodeling window whenMachine-Rotor-
Slot is selected).

Hs01 A slot dimension (see the diagram shown in themodeling window whenMachine-Rotor-
Slot is selected).

Hs1 A slot dimension (see the diagram shown in themodeling window whenMachine-Rotor-
Slot is selected).

Hs2 A slot dimension (see the diagram shown in themodeling window whenMachine-Rotor-
Slot is selected).

Bs0 A slot dimension (see the diagram shown in themodeling window whenMachine-Rotor-
Slot is selected).

Bs1 A slot dimension (see the diagram shown in themodeling window whenMachine-Rotor-
Slot is selected).

Bs2 A slot dimension (see the diagram shown in themodeling window whenMachine-Rotor-
Slot is selected).

Rs A slot dimension. (see the diagram shown in themodeling window whenMachine-Stator-
Slot is selected). Rs is added when the slot type is 3 or 4.
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Defining the Rotor Windings for Single-Phase Induction Motors

To define the rotor windings:
1. To open theRotor Winding Propertieswindow, double-click theMachine-Rotor-Winding

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Select aBar Conductor Type for the rotor winding bar:
a. Click the button forBar Conductor Type.

TheSelect Definitionwindow appears.
b. Select a conductor type from the list, or define a new conductor type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

3. Enter the length of the gap between the end ring and the iron core in theEnd Length field.
This field specifies the value for only one end of the gap, not both.

4. Enter the end ring dimension in the axial direction in theEnd-Ring Width field. The end ring
connects the bars of the rotor to one another.

5. Enter the end ring dimension in the radius direction in theEnd-Ring Height field. The end
ring’s height covers at least the cross section of the rotor conductor.

6. Select anEnd Ring Conductor Type for the rotor winding end ring:
a. Click the button for End Ring Conductor Type.

TheSelect Definitionwindow appears.
b. Select a conductor type from the list, or define a new conductor type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

7. ClickOK to close thePropertieswindow.

Rotor Winding Data for Single-Phase Induction Motors

To access the rotor winding data, double-click theMachine-Rotor-Winding entry in the project
tree.
TheRotor Winding Data Propertieswindow contains the following fields:

Bar Conductor
Type

The type of bar conductor used in the winding. Click the button to open the
Select Definition window.

End Length The length of the single-side end of the extended bar.
End Ring Width Thewidth of one side of the end rings in the axial direction.
End Ring Height The height of the end rings in the radian direction.
End Ring
Conductor Type

The type of end ring conductor used in the winding. Click the button to open
theSelect Definition window.

Defining the Shaft Data for a Single-Phase Induction Motor

To define the shaft:
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1. To open theShaft Data Propertieswindow, double-click theMachine>Shaft entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Select or clear theMagnetic Shaft check box to specify whether or not the shaft is to be
made of magneticmaterial.

3. ClickOK to close thePropertieswindow.

Shaft Data for Single-Phase Induction Motors

To access the shaft data, double-click theMachine>Shaft entry in the project tree.
TheShaft Data Propertieswindow contains the following fields:

Magnetic
Shaft

Select or clear this check box to indicate whether or not the shaft ismade of
magneticmaterial.

Adding or Removing a Vent from a Single-Phase Induction Motor

By option, you can add a vent to a single-phase inductionmotor. To add a vent:.
1. Select the rotor icon in the project tree.
2. Right-click to display the pop-upmenu and select Insert Vent.

The vent icon appears in the project tree under the rotor.
To remove a vent from a rotor in a three-phase inductionmotor.

1. Select the rotor icon in the project tree.
2. Right-click to display the pop-upmenu and selectRemove Vent.

The vent icon disappears in the project tree under the rotor.
The Vent data for the stator includes the following fields.

Holes per row Number of axial vent holes per row.
Inner hole
diameter

Diameter of vent holes in inner row.

Outer hole
diameter

Diameter of vent holes in outer row.

Inner hole location Center to center diameter of inner hole vents
Outer hole location Center to center diameter of outer hole

vents.

Setting Up Analysis Parameters for a Single-Phase Induction Motor

To define the solution data:
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1. To open theSolution Setupwindow, right-clickAnalysis in the project tree, and clickAdd
Solution Setup.

2. Click theGeneral tab. TheOperation Type is automatically set toMotor for thismachine
type.

3. Select the Load Type used in themotor from the following options:
Const
Speed

The speed remains constant in themotor.

Const
Power

The output power remains constant in themotor.

Const
Torque

The torque remains constant regardless of the speed. In this case, Tload = Trated,
given by the output power divided by the given rated speed.

Linear
Torque

The torque increases linearly with speed. In this case, Tload = Trated * (n/nrated)
where Trated is given by the output power divided by the given rated speed.

Fan
Load

The load varies nonlinearly with speed. In this case, Tload = Trated * (n/nrated)2
where Trated is given by the output power divided by the given rated speed.

4. Enter the output power developed at the shaft of themotor in theRated Output Power field.
5. Enter the RMS line-to-line voltage in theRated Voltage field.
6. Enter the desired output speed of themotor at the load point in theRated Speed field.
7. Enter the temperature at which the system functions in theOperating Temperature field.
8. Click theSingle-Phase Induction Motor tab.
9. Enter the electrical line frequency in the Frequency field, and select the units.
10. ClickOK to close theSolution Setupwindow.

Related Topics

Solution Data for Single-Phase InductionMotors

Solution Data for Single-Phase Induction Motors

To access the solution data, right-clickAnalysis in the project tree, and clickAdd Solution Setup.
TheSolution Setupwindow contains the following fields:

Operation
Type

On theGeneral tab. The operation type is automatically set toMotor for this
machine type.

Load Type On theGeneral tab. Select fromConst Speed,Const Power,Const Torque,
Linear Torque, and Fan Load. The default isConst Power.

Rated
Output
Power

On theGeneral tab. Type a value for the rated output voltage, and select the units.

Rated
Voltage

On theGeneral tab. Type a value for the rated voltage, and select the units.
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Rated Speed On theGeneral tab. Type a value for the rated speed, and select the units.
Operating
Temperature

On theGeneral tab. Type a value for the operating temperature, and select the
units.

Frequency On theSingle-Phase Induction Motor tab. Type a value for the frequency, and
select the units.

Related Topics

Setting Up Analysis Parameters for a Single-Phase InductionMotor

Adjust-Speed Synchronous Machines

After you have selectedAdjust-Speed Synchronous Machines as your model type, you need to
define the following:

l General data, such as the voltage, speed, and circuit type of themodel.
l Circuit data, such as trigger pulse width, transistor drop, and control circuit information.
l Stator data, such as the diameter, slot dimensions, and skew width of the stator.
l Stator Winding
l Rotor pole data, such as the associated permanent-magnet dimensions, air gap, and stacking
factor.

l Solution data, such as rated output voltage and frequency.
By option, you can:

l Add amachine housing.

Analysis Approach for Adjust-Speed Synchronous Machines

In adjustable-speed permanent-magnet synchronousmachines, the rotor speed is controlled by
adjusting the frequency of the input voltage. Unlike standard brushless permanent-magnet DC
motors, this type of machine does not utilize position sensors.
Permanent magnets aremounted on the rotor of a permanent-magnet synchronousmachine, which
could be either inner or outer rotor type. The poly-phase armature winding is embedded in the stator,
whose number of poles is the same as that of the rotor. Themachine can operate as a generator or
as amotor. When themachine operates as amotor, the stator poly-phase winding can be fed either
by a sinusoidal AC source or by a DC source via a DC to AC inverter. When themachine operates
as a generator, the stator poly-phase winding supplies an AC source for electric loads.

Stator Winding Connected to a Sinusoidal AC Source

In this case, the performance of themachine can be analyzed in the frequency domain based on the
phasor diagrams, as shown in Figure 6.1 for the generators and Figure 6.2 for themotors.
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In the figures,R1 andX1 are the resistance and the leakage reactance of the armature winding,Xad
andXaq are the d-axis armature reactance and the q-axis armature reactance, respectively. In the
phasor diagram,Xad is a linearized nonlinear parameter, andXaq is a linear parameter. The d-axis
synchronous reactanceXd and q-axis synchronous reactanceXaq are calculated directly from
Let ? denote the power angle for a generator (the angle thatU lagsE0), or the torque angle for a
motor (the angle that E0 lagsU), then we have
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where the plus sign + is for themotor and theminus sign - is for the generator.
Solving for Id and Iq yields

where the plus sign + is for themotor and theminus sign - is for the generator.

Let the angle that I lagsE0 be , we have

The power factor angle (the angle that I lagsU) is
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where the plus sign + is for themotor and theminus sign - is for the generator.
For themotor operation, the input electric power is

The output mechanical power is

wherePfw, PCua, andPFe denote the frictional and wind, the armature copper and the iron-core
losses, respectively.
The output mechanical torque is

where denotes the synchronous speed in rad/s.
The efficiency of themotor is

For the generator operation, the output electric power is

The input mechanical power is
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wherePfw, PCua, andPFe denote the frictional and wind, the armature copper and the iron-core
losses, respectively.
The input mechanical torque is

where denotes the synchronous speed inmechanical rad/s.
The efficiency of the generator is

Stator Winding Fed by a DC to AC Inverter

In this case, this adjustable-speed synchronousmachine (ASSM) operates as amotor, and the
analysis approach is similar to that of a brushlessDC (BLDC) motor. The stator poly-phase
armature winding is connected to a DC power supply through a DC to AC inverter to produce the
rotational magnetic field in the air-gap. Themain difference between ASSMand BLDC motor is: in
BLDC motor, trigger time exactly depends on the rotor position; but in ASSM, the trigger time is
independent of the rotor position. If themechanical load of a BLDC motor increases, the rotor
speed and the induced voltage decreases, causing the armature current and torque increase to
balance the increasedmechanical load. However, for an ASSM, if themechanical load increases,
the rotor speed decreases temporarily, which causes the torque angle (the same as lead angle of
trigger for a BLDC motor) increase and then torque increase to retain the synchronous speed.
Therefore, the speed of a BLDC motor varies with input voltage andmechanical load, while the
speed of an ASSMdoes not. The speed of an ASSM can be changed by adjusting the frequency of
the controlling signal, which explains why it is calledAdjustable-Speed Permanent-Magnet
SynchronousMachine.
Using the time-domainmathematical model to analyze the characteristics of the electricmachine,
Park's voltage equation in thematrix form is as follows
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whereR1 is the armature winding resistance, Ld, Lq and L0 are the d-, the q- and the 0-axis

inductances respectively, is the revolution speed in electric radians per second, the differential
operator is

The coordinate transformation equations for the terminal voltage, the induced emf and the armature
winding current are

The transformationmatrices for the two-, the three- and the four-phase systems areC2,C3 andC4,
respectively, as follows
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where

The input electric power is obtained from the voltage and the current as:

The output mechanical power is:

wherePfw, PCua, Pt andPFe denote the frictional and wind, the armature copper, the switching and
the iron-core losses, respectively.
The output mechanical torque is

Getting Started with RMxprt 26-222
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

where denotes the revolution speed inmechanical radians per second.
The efficiency of the electricmachine is

Defining an Adjustable-Speed Synchronous Machine

The general procedure for defining a adjust-speed synchronousmachine is as follows:
1. Insert the adjust-speed synchronousmachine into a new or existing project.
2. Double-click theMachine entry in the project tree to define the general data.
3. Double-click theMachine>Circuit entry in the project tree to define the control circuit.
4. Double-click theMachine>Stator entry in the project tree to define the stator geometry.
5. Double-click theMachine-Stator-Slot entry in the project tree to define the stator slot

dimensions.
6. Double-click theMachine-Stator-Winding entry in the project tree to define the stator

windings and conductors.
7. Double-click theMachine-Rotor entry in the project tree to define the rotor geometry.
8. Double-click theMachine-Rotor-Pole entry in the project tree to define the pole, embrace,

offset, and air gap data for the rotor pole.
9. Double-click theMachine>Shaft entry in the project tree to define themagnetism of the shaft.

10. Optionally, right-click theMachine entry in the project tree and click Insert Housing to add a
machine housing.

11. Right-clickAnalysis in the project tree, and clickAdd Solution Setup to define the solution
data.

12. Choose File>Save to save the project.
13. ChooseRMxprt>Analyze to analyze the design.

Note When you place the cursor over an entry field in the data windows, a brief
description of that field appears in the status bar at the bottom of theRMxprt
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window.

Once analyzed, themodel can be viewed in theMaxwell 2D Modeler, or it can be used to create a
new Maxwell 2D project, and a new Maxwell 3D design.

Defining the General Data for an Adjust-Speed Synchronous Machine

Use theGeneral window to define the basic parameters of themotor, such as themotor’s rated
output power, rated voltage, losses, and circuit types.
To define the general data:

1. To open theGeneral Data Propertieswindow, double-click theMachine entry in the project
tree on the desktop. (You can also enter values in theProperties section of the desktop
without opening a separate window.)

2. Enter the number of poles for themachine in theNumber of Poles field. This value is the total
number of poles in the stator (or the number of pole pairsmultiplied by two).

3. Enter the energy loss due to friction at the given speed in the Frictional Loss field.
4. Enter the wind loss due to air resistancemeasured at the reference speed in theWindage

Loss field.
5. Enter the given speed in theReference Speed field.
6. Select one of the following from theControl Type pull-down list:

l DC: Switched DC voltage at the given input frequency.
l PWM: Pulse widthmodulation.When you select this source type, youmust enter the
following values in theCircuit Data Propertieswindow:Modulation Index (the ratio of
the sine wave amplitude to the triangular amplitude) andCarrier Frequency Times (the
ratio of the triangular frequency to the sine wave frequency).

l AC: An AC excitation.
7. Select aCircuit Type from the following types:

Y3 Y-connected, three-
phase.

L3 Loop-type, three-phase.
S3 Star-type, three-phase.
C2 Cross-type, two-phase.
L4 Loop-type, four-phase.
S4 Star-type, four-phase.

The circuit types are based on industry standards. By default, typeY3, a three-phase, six-
status circuit, is selected as the circuit type.

Note When you place themouse cursor over a circuit type, an outline schematic of the circuit
appears.

8. ClickOK to close thePropertieswindow.
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General Data for Adjust-Speed Synchronous Machines

To access the general data, double-click theMachine entry in the project tree.
TheGeneral Data Propertieswindow for a three-phase inductionmotor contains the following
fields:

Machine
Type

Themachine type you selected when inserting a new RMxprt design (Adjust-
Speed SynchronousMachine).

Number of
Poles

The number of poles themachine contains.

Rotor
Position

Select whether the rotor is an Inner Rotor orOuter Rotor.

Frictional
Loss

The frictional energy loss (due to friction) measured at the reference speed.

Windage
Loss

Thewindage loss (due to air resistance) measured at the reference speed.

Reference
Speed

The given speed of reference.

Control
Type

Theway the circuit is controlled. Select fromDC, PWM (pulse-widthmodulation),
orAC.

Circuit Type The drive circuit type. Click the button to open theCircuit Typewindow and select
from the following six types:

•Y3: Y-Type, 3-Phase
• L3: Loop-Type, 3-Phase
•S3: Star-Type, 3-Phase
•C2: Cross-Type, 2-Phase
• L4: Loop-Type, 4-Phase
•S4: Star-Type, 4-Phase

Defining the Circuit Data for an Adjust-Speed Synchronous Machine

Use theCircuit Data Properties window to define the circuit properties for an adjustable-speed
synchronousmachine.

Note No circuit data properties exist whenAC is selected as theControl
Type.

1. To open theCircuit Data Propertieswindow, double-click theMachine>Circuit entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. If you selected DC as theControl Type, enter the period from on-status to off-status of a
transistor, in electrical degrees, in the Trigger Pulse Width field.
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3. Enter the voltage drop across one transistor when the transistor is turned on in the Transistor
Drop field. Refer to the figures of the different circuit types in step 2.

4. Enter the voltage drop of one diode in the discharge loop in theDiode Drop field. If you
selected a star-type circuit (S3 or S4) as theCircuit Type, enter the total discharge voltage in
this field.

5. If you selected PWMas theControl Type, then enter values in the following two fields:
l Modulation Index: The ratio of the sine-wave amplitude to the triangular amplitude. (PWM
circuits only.)

l Carrier Frequency Times: The ratio of the triangular frequency to the sine-wave
frequency. (PWMcircuits only.)

6. ClickOK to close thePropertieswindow.

Circuit Data for Adjust-Speed Synchronous Machines

To access theCircuit Data Propertieswindow, double-click theMachine>Circuit entry in the
project tree. No circuit data properties exist whenAC is selected as theControl Type.

Trigger Pulse Width The period from on-status to off-status for a transistor, in electrical
degrees.
(DC circuits only.)

Transistor Drop The voltage drop across one transistor when the transistor is turned on.
Diode Drop The voltage drop across one diode in the discharge loop.
Modulation Index The ratio of the sine-wave amplitude to the triangular amplitude.

(PWMcircuits only.)
Carrier Frequency
Times

The ratio of the triangular frequency to the sine-wave frequency.
(PWMcircuits only.)

Defining the Stator Data for an Adjust-Speed Synchronous Machine

Use theStator Properties windows to define the stator dimensions, slots, windings, and
conductors.
The stator is the outer lamination stackwhere the polyphase voltage windings reside.
To define the general stator data:

1. To open theStator Data Propertieswindow, double-click theMachine>Stator entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter theOuter Diameter of the stator.
3. Enter the Inner Diameter of the stator.
4. Enter the length of the stator core in the Length field.
5. Enter the stacking factor for the stator core in the Stacking Factor field.
6. Select aSteel Type for the stator core:
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a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

7. Enter theNumber of Slots in the stator.
8. Select theSlot Type:

a. Click the button for theSlot Type.
TheSelect Slot Typewindow appears.

b. Select a slot type (available types include 1 through 4).
Note When you place themouse cursor over the slot type, a schematic of the selected

type appears, displaying the slot dimension variables.

c. ClickOK to close theSelect Slot Type window and return to thePropertieswindow.
9. Enter the skew width, measured in slot number, in theSkew Width field.
10. ClickOK to close thePropertieswindow.

Defining the Stator Dimensions and Slots

To define the stator slots:
1. To open theStator Slot Data Propertieswindow, double-click theMachine-Stator-Slot

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Optionally, to automatically design the dimensions of slotsHs2,Bs1, andBs2, select the
Auto Design check box.

3. Optionally, to design dimensions of slotsBs1 andBs2 based on the stator tooth width, select
theParallel Tooth check box, and enter a value in the Tooth Width field.

4. Enter the available slot dimensions.
Hs0 Always available.
Hs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.
Bs0 Always available.
Bs1 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto

Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

Bs2 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto
Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

Rs Rs is added when the slot type is 3 or 4.

5. ClickOK to close thePropertieswindow.
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Stator Data for Adjust-Speed Synchronous Machines

To access the general stator data, double-click theMachine>Stator entry in the project tree.
TheStator Data Propertieswindow contains the following fields:

Outer
Diameter

The outer diameter of the stator core.

Inner
Diameter

The inner diameter of the stator core.

Length The length of the stator core.
Stacking
Factor

The stacking factor of the stator core.

Steel Type The steel type of the stator core. Click the button to open theSelect Definition
window.

Number of
Slots

The number of slots the stator core contains.

Slot Type The type of slots in the stator core. Click the button to open theSelect Slot Type
window.

Skew Width The skew widthmeasured in slot number.

Stator Slot Data for Adjust-Speed Synchronous Machines

To access the stator slot data, double-click theMachine-Stator-Slot entry in the project tree.
TheStator Slot Data Propertieswindow contains the following fields:

Auto
Design

Select or clear this to enable or disable auto-design of slotsHs2,Bs1, andBs2. When
this check box is selected, only two other fields appear in the window:Hs0 andBs0.

Parallel
Tooth

Select this to designBs1 andBs2 based on the tooth width. When this check box is
selected, theBs1 andBs2 fields are removed, and the Tooth Width field is added.

Tooth
Width

The tooth width for the parallel tooth, on whichBs1 andBs2 are designed.

Hs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Hs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Hs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).
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Bs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Rs A slot dimension. (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected). Rs is added when the slot type is 3 or 4.

Defining the Stator Windings and Conductors for an Adjust-Speed Synchronous Machine

To define the stator windings and conductors:
1. To open theStator Slot Winding Propertieswindow, double-click theMachine-Stator-

Winding entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Click theWinding tab.
3. Enter the number of layers in the stator winding in theWinding Layers field.
4. Select aWinding Type:

a. Click the button forWinding Type.
TheWinding Typewindow appears.

b. Select from one of the following three types of winding:
l Whole Coiled
l Half Coiled
l Editor

When you place themouse cursor over a winding button, an outline of the selected winding appears.
The following table describes the six types of windings that are possible (three for one-layer and
three for two-layer):

Type Description
One Layer

Winding Editor
A user-defined one-layer winding arrangement. You need to set up the
winding arrangement for each slot.

Whole Coiled

A one-layer whole-coiled winding:

Half A one-layer concentric half-coiled winding:

Getting Started with RMxprt 26-229
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Coiled

Editor A user-defined two-layer winding arrangement. When you select 20, theWinding Editor
opens, where you can specify a different winding arrangement for each slot.

Whole
Coiled

A two-layer wave winding:

The phase belt for this winding configuration is equal to 360/2m, wherem is the phase
number.

Half Coiled A two-layer half-coiled winding:
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There is only one coil per phase per pair of
poles.

Note For a two-layer winding, if you checkConstant Pitch in theWinding Editor, only the top
layer needs to be defined; the bottom layer will be determined according to the coil pitch.

a. Once you have clicked a button to select a winding, clickOK to close theWinding Type
window and return to thePropertieswindow.

b. Select theWinding Type for the stator.
Note When you place themouse cursor over the winding type, a schematic of the

selected winding appears.

Winding types 10 and 20 are user-defined. If you select either of these, a window appears,
asking you to define the name of the winding arrangement. The window closeswhen the user-
defined winding is entered.
Select from the following winding types:

One-Layer
Winding Editor

A user-defined single-layer winding arrangement. When you select this type,
enter the winding arrangement, and chooseOK.

11 A one-layer whole-coiled winding:
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12 A one-layer concentric half-coiled winding:

20 A user-defined winding arrangement. When you select this type, enter the winding
arrangement, and chooseOK.

21 A two-layer wave winding:

The phase belt for this winding configuration is equal to 360/2m, wherem is the phase number.

22 A two-layer winding:
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1. Select or enter the number of parallel branches in one phase of the winding in theParallel
Branches field.

2. Enter the total number of conductors in each stator slot in theConductors per Slot field. This
value is the number of turns per coil multiplied by the number of layers.

3. Enter the coil pitch, measured in number of slots, in theCoil Pitch field. The coil pitch is the
number of slots separating one winding. For example, if a coil starts in slot 1 and ends in slot 6,
it has a coil pitch of 5.

4. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to have
RMxprt auto-design this value.

5. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to
automatically obtain this value from the wire library.

6. Select theWire Size:
a. Click the button forWire Size.

TheWire Sizewindow appears.
b. Select a value from theWire Diameter pull-down list.
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c. Select a wire gauge from theGauge pull-downmenu. You can select from the following
options:

<
number

>

You can select a specific gauge number. When you select a gauge number,
theWire Diameter field is automatically updated.

USER
This option allows you tomanually enter theWire Diameter. This is useful
when you want to enter a diameter that does not correspond to a particular
wire gauge.

AUTO
This option sets theWire Diameter to zero, and RMxprt automatically
calculates the optimal value. The diameter information is then written to the
output file when you analyze the design.

MIXED
This option allows you to define a conductor that ismade of different size wires.
For example, a single conductor may consist of 5 wires, 3 wires with a diameter
of 0.21mmand 2 with a diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.

a. When you are done setting the wire size, clickOK to close theWire Sizewindow and
return to thePropertieswindow.

b. Click theEnd/Insulation tab.
c. Select or clear the Input Half-turn Length check box.
d. Do one of the following:

l If you selected Input Half-turn Length, then enter the half-turn length of the armature
winding in the Half Turn Length field.

l If you cleared Input Half-turn Length, then enter the end length adjustment of the stator
coils in theEnd Adjustment field. The end adjustment is the distance one end of the
conductor extends vertically beyond the end of the stator.
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5. Enter the inner radius of the base corner in theBase Inner Radius field.
6. Enter the inner diameter of the coil tip in the Tip Inner Diameter field.
7. Enter the distance between two stator coils in theEnd Clearance field.
8. Enter the thickness of the slot liner insulation in theSlot Liner field.

9. Enter the thickness of the wedge insulation in theWedge Thickness field.
10. Enter the thickness of the insulation layer in the Layer Insulation field.
11. Enter the limited slot fill factor for the wire design in the Limited Fill Factor field. The slot fill

factor is the ratio between the cross-sectional area of all conductors in one slot and the entire
slot area.

12. ClickOK to close thePropertieswindow.

Winding Editor for an Adjustable-Speed Synchronous Machine

For a adjustable-speed synchronousmachine, youmaywant to specify a different number of
conductors for each stator slot. TheWinding Editor makes this possible by enabling you to specify
the number of turns for each coil.
To specify the number of turns for each coil:

1. ClickMachine>Winding>Edit Layout.
TheWinding Editor window appears.

2. In the table in the upper left, set which phase you want for each coil and which slot is the “in”
and “out” slot for the current in each coil.

3. If you are working on a quarter or half model, youmaywant to specify amultiplier by clicking
thePeriodic Multiplier check box and specifying a value.

4. Select or deselect theConstant Turns orConstant Pitch check boxes, depending on
whether you want to be able to change these setting in the table above.When these options
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are selected, you cannot change the turns or pitch.
5. When you are satisfied with the coil settings, clickOK to close theWinding Editor window.

Defining Different Size Wires for an Adjustable Speed Synchronous Machine
Use theGauge option in theWire Size dialog if you have a conductor that ismade up different size
wires.
To define different size wires:

1. In theWire Size window, selectMIXED from theGauge pull-downmenu.
2. Select eitherRound orRectangular as theWire Type.
3. Enter the appropriate wire data in the table:

l For a round wire:
l Enter theDiameter in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
diameter.

l For a rectangular wire:
l Enter theWidth of the wire in the table.
l Enter the Thickness of the wire in the table.
l Enter the Fillet value in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this data.

4. ClickAdd to add the new wire data.
5. Repeat steps 3 and 4 for each size wire you want to add.
6. When you are finished defining the wires, clickOK to close theWire Sizewindow and return

to the RMxprtPropertieswindow.
Note For example, if one conductor ismade up of 5 wires, and 3 of those wires have a

diameter of 0.21mm, and the other 2 have a diameter of 0.13mm, then themixed
wire size table will have two lines. The first line will list Diameter = 0.21 and Number
= 3. The second line will list Diameter = 0.13 and Number = 2. An equivalent wire
diameter is displayed asWire Size value in theWinding tab in the Properties
window.

Stator Winding Data for Adjust-Speed Synchronous Machines

To access the stator winding data, double-click theMachine-Stator-Winding entry in the project
tree.
TheStator Winding Data Propertieswindow contains the following fields:

Winding tab Winding Layers The number of winding layers.
Winding Type The type of stator winding. Click the

button to open theWinding Type
window and choose fromWhole
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Coiled,Half Coiled, andEditor.
Parallel Branches The number of parallel branches in the

stator winding.
Conductors per Slot The number of conductors per stator slot

(0 for auto-design).
Coil Pitch The coil pitchmeasured in number of

slots.
Number of Strands The number of wires per conductor (0 for

auto-design).
Wire Wrap The thickness of the double-sided wire

wrap (0 to automatically obtain this value
from the wire library).

Wire Size The diameter of the wire (0 for auto-
design). Click the button to open the
Wire Sizewindow where you can
specify units, wire type, diameter, and
gauge.

End/Insulation tab Input Half-turn Length Select or clear this check box to specify
whether or not you want to enter the
half-turn length. When this check box is
selected, theHalf Turn Length field
appears the next time you open the
Propertieswindow.When this check
box is selected, theEnd Adjustment
field appears instead.

Half Turn Length The half-turn length of the armature
winding.

End Adjustment The end length adjustment of the stator
coils, which is the distance one end of
the conductor extends vertically beyond
the end of the stator.

Base Inner Radius The inner radius of the base corner.
Tip Inner Diameter The inner diameter of the coil tip.
End Clearance The end clearance between two

adjacent coils.
Slot Liner The thickness of the slot liner insulation.
Wedge Thickness The thickness of the wedge insulation.
Layer Insulation The thickness of the insulation layer.
Limited Fill Factor The limited slot fill factor for the wire

design. The slot fill factor is the ratio
between the cross-sectional area of all
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conductors in one slot and the entire slot
area.

Defining the Rotor Data for an Adjust-Speed Synchronous Machine

The rotor consists of copper bars in which current is induced by themagnetic fields produced by the
stator windings. In the project tree, double-clickMachine>Rotor andMachine-Rotor-Pole to
define the rotor and the pole.
To define general stator data:

1. To open theRotor Data Propertieswindow, double-click theMachine>Rotor entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter the outer diameter of the rotor in theOuter Diameter field.
3. Enter the inner diameter of the rotor in the Inner Diameter field.
4. Enter the length of the rotor core in the Length field.
5. Select aSteel Type for the rotor core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

6. Enter the stacking factor for the rotor core in the Stacking Factor field.
7. Select aPole Type:

a. Click the button.
TheSelect Pole Typewindow appears.

b. Click a button to select the desired pole type (1, 2, 3, 4, or 5). TIP:When you run the
mouse over each option, the diagram changes to show that pole type.
Note When you place themouse cursor over a rotor type, an outline of the selected
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circuit type appears.

c. ClickOK to close theSelect Pole Typewindow and return to thePropertieswindow.
8. ClickOK to close thePropertieswindow.

Rotor Data for Adjust-Speed Synchronous Machines

To access the general rotor data, double-click theMachine>Rotor entry in the project tree.
TheRotor Data Propertieswindow contains the following fields:

Outer
Diameter

The outer diameter of the rotor core.

Inner
Diameter

The inner diameter of the rotor core.

Length The length of the rotor core.
Steel
Type

The steel type of the rotor core. Click the button to open theSelect Definition
window.

Stacking
Factor

The stacking factor of the rotor core.

Pole
Type

The pole type for the rotor. Click this button to open theSelect Pole Typewindow
and select from the following types: 1, 2, 3, 4, 5.

Defining the Rotor Pole for an Adjust-Speed Synchronous Machine

The rotor pole drives the electromagnetic field which is coupled with the stator windings. Use the
Rotor Pole Data Properties window to define the rotor pole.

Note Some of the fields in theRotor Pole window change, or are inactive, depending on the
Rotor Type you select.

To define the rotor pole:
1. To open theRotor Pole Data Propertieswindow, double-click theMachine-Rotor-Pole

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. For all pole types except type 4, enter the ratio of the actual arc distance in relation to the
maximumpossible arc distance in theEmbrace field. This value is between 0 and 1.
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3. For pole type 4, enter the shaft diameter of the rotor in theShaft Diameter field.
4. For pole types 1, 2, and 3, enter the distance from the center of the rotor to the polar arc center

in theOffset field. Enter 0 for a uniform air gap.

5. For pole type 5, enter the thickness of the bridge across the two poles in theBridge field.
6. For pole type 5, enter the width of the rib supporting the bridge in theRib field.
7. Select the type of magnet to use in the rotor pole from theMagnet Type pull-downmenu.
8. For pole types 4 and 5, enter the width of themagnet in theMagnet Width field.
9. Enter themaximum radial thickness of themagnet in theMagnet Thickness field.
10. ClickOK to close thePropertieswindow.

Rotor Pole Data for Adjust-Speed Synchronous Machines

To access the pole rotor data, double-click theMachine-Rotor-Pole entry in the project tree.
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TheRotor Pole Data Propertieswindow contains the following fields:

Embrace The pole embrace. For pole types 1, 2, 3, and 5.
Shaft
Diameter

The shaft diameter of the rotor. For pole type 4.

Offset The pole-arc center offset from the rotor center (0 for a uniform air gap). For
pole types 1, 2, and 3.

Bridge The thickness of the bridge across two adjacent poles. For pole type 5.
Rib Thewidth of the rib at the center of two adjacent poles that support the bridge.

For pole type 5.
Magnet Type The type of magnet. Click the button to open theSelect Definitionwindow. For

all pole types.

Magnet Width Themaximumwidth of themagnet. For pole types 4 and 5.
Magnet
Thickness

Themaximum thickness of themagnet. For all pole types.

Defining the Shaft Data for an Adjust-Speed Synchronous Machine

To define the shaft:
1. To open theShaft Data Propertieswindow, double-click theMachine>Shaft entry in the

project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Select or clear theMagnetic Shaft check box to specify whether or not the shaft is to be
made of magneticmaterial.

3. ClickOK to close thePropertieswindow.

Shaft Data for Adjust-Speed Synchronous Machines

To access the shaft data, double-click theMachine>Shaft entry in the project tree.
TheShaft Data Propertieswindow contains the following fields:

Magnetic
Shaft

Select or clear this check box to indicate whether or not the shaft ismade of
magneticmaterial.

Setting Up Analysis Parameters for an Adjust-Speed Synchronous Machine

To define the solution data:
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1. Right-clickAnalysis in the project tree, and clickAdd Solution Setup to open the Solution
Setup window.

2. Click theGeneral tab. TheOperation Type is automatically set toMotor for thismachine
type.
Note To enable selection ofGenerator for Adjust-Speed SynchronousMachines, the

machineControl Typemust be set toAC in its Properties window.

a. If Motor was selected for the Operation Type, select the Load Type used in themotor
from the following options:

Const
Speed

The speed remains constant in themotor.

Const
Power

The output power remains constant in themotor.

Const
Torque

The torque remains constant regardless of the speed. In this case, Tload =
Trated, given by the output power divided by the given rated speed.

Linear
Torque

The torque increases linearly with speed. In this case, Tload = Trated *
(n/nrated) where Trated is given by the output power divided by the given rated
speed.

Fan
Load

The load varies nonlinearly with speed. In this case, Tload = Trated *
(n/nrated)2 where Trated is given by the output power divided by the given
rated speed.

b. If Generator was selected for the Operation Type, select the Load Type used in the
generator from the following options: Infinite Bus or Independent Generator.
Infinite Bus When the generator is connected to an infinite bus of the power system,

the terminal voltages remain constant and the output power is
determined by the output currents.

Independent
Generator

The generator supplies electrical power to a load inductor. For an AC
generator, the resistance and inductance of the load inductor are
determined by the rated output power, the rated voltage, and the rated
power factor. For a DC generator, the resistance of the load resistor is
determined by the rated output power and the rated voltage.

3. Enter the output power developed at the shaft of themotor in theRated Output Power field.
4. Enter either the RMS line-to-line voltage (for AC control type), or the DC voltage (for DC and

PWMcontrol types) in theRated Voltage field.
5. Enter the desired output speed of themotor at the load point in theRated Speed field.
6. Enter the temperature at which the system functions in theOperating Temperature field.
7. Click theAdjust-Speed Synchronous Machine tab and select either Time or Frequency

as theDomain for the solution.
8. ClickOK to close theSolution Setupwindow.
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Related Topics

Solution Data for Adjust-Speed SynchronousMachines

Solution Data for Adjust-Speed Synchronous Machines

To access the solution data, right-clickAnalysis in the project tree, and clickAdd Solution Setup.
For thismachine type, there is only one tab, theGeneral tab.
TheSolution Setupwindow contains the following fields:

Operation
Type

The operation type is automatically set toMotor for thismachine type.

Load Type Select fromConst Speed,Const Power,Const Torque, Linear Torque,
and Fan Load. The default isConst Power.

Rated Output
Power

Type a value for the rated output voltage, and select the units.

Rated Voltage Type a value for the rated voltage, and select the units.

Rated Speed Type a value for the rated speed, and select the units.

Operating
Temperature

Type a value for the operating temperature, and select the units.

Related Topics

Setting Up Analysis Parameters for an Adjust-Speed SynchronousMachine

Permanent-Magnet DC Motors

After you have selectedPermanent-Magnet DC Motors as your model type, you need to define
the following:

l General data, such as the voltage, speed, and circuit type of themodel.
l Stator data, such as the diameter, slot dimensions, and skew width of the stator.
l Stator pole data, such as its associated pole dimensions, type of steel, and polemagnet
specifications.

l Rotor data, such as the slot types and dimensions, slot data, and windings.
l Commutator and brush data, such as the commutator dimensions and brush length.
l Shaft data
l Solution data, such as rated output voltage and frequency.

By option, you can:
l Add amachine housing.
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Analysis Approach for PMDC Motors

For a permanent-magnet DC motor, the stator is equipped with P pairs of permanent magnets,
creating P pairs of alternating north and south poles. The distribution of themagnetic field produced
by the permanent magnet’s field flux is fixed with respect to the stator. The rotor is equipped with a
distributed winding connected to a commutator that revolves together with the rotor.
A system of brushes is kept in permanent electrical contact with the commutator. When DC current
is applied to the rotor winding (via the brushes and commutator), a torque is produced by the
interaction of the rotor (armature) currents and the field produced by the permanent magnets.
The commutator causes the armature to create amagnetic flux distribution that is fixed in space and
whose axis is perpendicular to the axis of the field flux produced by the permanent magnets. For
thesemotors, the commutator acts as amechanical rectifier.
The performance of a permanent-magnet DC (PMDC) motor is computed byDC analysis only. The
voltage equation of a PMDCmotor is:

U = Ub + R1 * I + E

where Ub is the voltage drop of one-pair brushes, R1 is the armature resistance,E = Ke * is the

back emf withKe the back-emf constant in Vs/rad, and is the speed in rad/s. For a given speed
, armature current can be computed based on the applied voltageU, as shown below:

I = (U - Ub - Ke * )/R1

The shaft torque T2 is computed by:
T2 = Kt * I - Tfw

whereKt is the torque constant in Nm/A, which is numerically the same asKe, and Tfw is the
frictional torque.
The output power (mechanical power) is:

P2 = T2 *

The input power (electrical power) is:
P1 = P2 + Pfw + Pcua + Pb + PFe

wherePfw, Pcua, Pb, andPFe are frictional and wind loss, armature copper loss, brush drop loss,
and iron-core loss, respectively.
The efficiency is:

eff = P2/P1 * 100%
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Defining a Permanent-Magnet DC Motor

The general procedure for defining a permanent-magnet DC motor is as follows:
1. Insert the permanent-magnet DC motor into a new or existing project.
2. Double-click theMachine entry in the project tree to define the general data.
3. Double-click theMachine>Stator entry in the project tree to define the stator geometry.
4. Double-click theMachine-Stator-Pole entry in the project tree to define the stator pole

dimensions.
5. Double-click theMachine>Rotor entry in the project tree to define the rotor geometry.
6. Double-click theMachine-Rotor-Slot entry in the project tree to define the rotor slot

dimensions.
7. Double-click theMachine-Rotor-Winding entry in the project tree to define the rotor

windings and conductors.
8. Double-click theMachine>Commutator entry in the project tree to define the commutator

and brush data.
9. Double-click theMachine>Shaft entry in the project tree to define themagnetism of the shaft.

10. Optionally, for Inner Rotor machines only, right-click theMachine entry in the project tree and
click Insert Housing to add amachine housing.

11. Right-clickAnalysis in the project tree, and clickAdd Solution Setup to define the solution
data.

12. Choose File>Save to save the project.
13. ChooseRMxprt>Analyze to analyze the design.

Note When you place the cursor over an entry field in the data windows, a brief
description of that field appears in the status bar at the bottom of theRMxprt
window.

Once analyzed, themodel can be viewed in theMaxwell 2D Modeler, or it can be used to create a
new Maxwell 2D project, and a new Maxwell 3D project.
Refer to thePermanent-Magnet DC Motor Problem application note, on the technical support page
of the ANSYS web site, for a specific example of a permanent-magnet DC motor problem.

Defining the General Data for PMDC Motors

Use theGeneralwindow to specify the rated output power, voltage values, circuit type, and speed of
the DC motor.
To define the general data:

1. To open theGeneral Data Propertieswindow, double-click theMachine entry in the project
tree on the desktop. (You can also enter values in theProperties section of the desktop
without opening a separate window.)
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2. Enter the number of poles for themachine in theNumber of Poles field. This value is the total
number of poles in the stator (or the number of pole pairsmultiplied by two).

3. Enter the energy loss due to friction at the given speed in the Frictional Loss field.
Note To use theBrush Press and Frictional Coefficient fields when you define the

commutator and brush later in theCommutator/Brush Datawindow, enter 0 here
for the Friction Loss.

4. Enter the wind loss due to air resistancemeasured at the reference speed in theWind Loss
field.

5. Enter the given speed in theReference Speed field.
6. ClickOK to close thePropertieswindow.

General Data for PMDC Motors

To access the general data, double-click theMachine entry in the project tree.
TheGeneral Data Propertieswindow for a three-phase inductionmotor contains the following
fields:

Machine
Type

Themachine type you selected when inserting a new RMxprt design (DC
Permanent Magnet Motor).

Number of
Poles

The number of poles themachine contains.

Rotor
Position

Select whether the rotor is an Inner Rotor orOuter Rotor.

Frictional
Loss

The frictional energy loss (due to friction) measured at the reference speed.

Wind Loss Thewind loss (due to air resistance) measured at the reference speed.
Reference
Speed

The given speed of reference.

Defining the Stator Data for a PMDC Motor

The stator is the outer lamination stackwhere the polyphase voltage windings reside.
To define the general stator data:

1. To open theStator Data Propertieswindow, double-click theMachine>Stator entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter theOuter Diameter of the stator.
3. Enter the Inner Diameter of the stator.
4. Enter the length of the stator core in the Length field.
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5. Enter the stacking factor for the stator core in the Stacking Factor field. This value is a ratio
of the effectivemagnetic length of the core, and ranges from 0 to 1. It is defined as the total
lengthminus the total insulation from the laminations, divided by the total length. A value of 1
indicates that the stator is not laminated.

6. ClickOK to close thePropertieswindow.

Stator Data for PMDC Motors

To access the general stator data, double-click theMachine>Stator entry in the project tree.
TheStator Data Propertieswindow contains the following fields:

Outer
Diameter

The outer diameter of the stator
core.

Inner Diameter The inner diameter of the stator
core.

Length The length of the stator core.
Stacking
Factor

The stacking factor of the stator
core.

Defining the Stator Pole for a PMDC Motor

The rotor pole drives the electromagnetic field which is coupled with the stator windings. Use the s
Stator Pole Data Properties window to define the stator pole.
To define the rotor pole:

1. To open theStator Pole Data Propertieswindow, double-click theMachine-Stator-Pole
entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)
Note For a two-polemachine, a pole embrace of 0.75 yields amagnet with a span of 135

degrees (based on 0.75*180 degrees).

2. Enter the ratio of the actual arc distance in relation to themaximumpossible arc distance in the
Embrace field. This value is between 0 and 1.
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3. Enter the distance from the center of the stator to themagnet arc center in theOffset field.
Enter 0 for a uniform air gap.

4. To select the type of magnet to use in the rotor pole:
a. Click theMagnet Type button.

TheSelect Definitionwindow appears.
b. Select or define amaterial for themagnet type.
c. ClickOK to close theSelect Definitionwindow and return to thePropertieswindow.

5. Enter the length of themagnet in the axial direction in theMagnet Length field.
6. Enter themaximum radial thickness of themagnet at the center of the pole in theMagnet

Thickness field. To control the flux, themagnet’s thicknessmay vary.
7. ClickOK to close thePropertieswindow.

Stator Pole Data for PMDC Motors

To access the stator pole data, double-click theMachine-Stator-Pole entry in the project tree.
TheStator Pole Data Propertieswindow contains the following fields:

Embrace The pole embrace.
Offset The pole-arc center offset from the stator center (0 for a uniform air gap).
Magnet Type The type of magnet. Click the button to open theSelect Definition

window.
Magnet Length Themaximum length of themagnet.
Magnet
Thickness

Themaximum thickness of themagnet.
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Defining the Rotor Data for a PMDC Motor

The rotor is equipped with slots containing copper conductors that are connected to the commutator.
The commutator acts as amechanical rectifier in themotor.
Use theRotor Data Properties,Rotor Slot Data Properties, andRotor Winding Data
Propertieswindows to define the rotor slots, windings, and dimensions.
To define general rotor data:

1. To open theRotor Data Propertieswindow, double-click theMachine>Rotor entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter the stacking factor for the rotor core in the Stacking Factor field.
3. Enter theNumber of Slots in the rotor.
4. Select theSlot Type:

a. Click the button for theSlot Type.
TheSelect Slot Typewindow appears.

b. Select a slot type (available types include 1 through 4).
Note When you place themouse cursor over the slot type, a schematic outline of the

slot appears.

c. ClickOK to close theSelect Slot Type window and return to thePropertieswindow.
5. Enter the outer diameter of the rotor in theOuter Diameter field.
6. Enter the inner diameter of the rotor in the Inner Diameter field.
7. Enter the length of the rotor core in the Length field.
8. Select aSteel Type for the rotor core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

9. Enter the skew width, measured in slot number, in theSkew Width field.
10. ClickOK to close thePropertieswindow.

Rotor Data for PMDC Motors

To access the general rotor data, double-click theMachine>Rotor entry in the project tree.
TheRotor Data Propertieswindow contains the following fields:

Stacking
Factor

The stacking factor of the rotor core.

Number of
Slots

The number of slots the rotor core contains.

Slot Type The type of slots in the rotor core. Click the button to open theSelect Slot Type
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window.
Outer
Diameter

The outer diameter of the rotor core.

Inner
Diameter

The inner diameter of the rotor core.

Length The length of the rotor core.
Steel Type The steel type of the rotor core. Click the button to open theSelect Definition

window.
Skew Width The skew widthmeasured in slot number.

Defining the Rotor Slots for a PMDC Motor

To define the physical dimensions of the rotor slots:
1. To open theRotor Slot Data Propertieswindow, double-click theMachine-Rotor-Slot

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Optionally, to automatically design the dimensions of slotsHs2,Bs1, andBs2, select the
Auto Design check box.

3. Enter the available slot dimensions.
Hs0 Always available.
Hs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.
Bs0 Always available.
Bs1 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically. WhenParallel Tooth is selected, this slot
dimension is determined based on the value entered in the Tooth Width field.

Bs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot
dimension is determined automatically. WhenParallel Tooth is selected, this slot
dimension is determined based on the value entered in the Tooth Width field.

Rs Rs is added when the slot type is 3 or 4.

4. ClickOK to close thePropertieswindow.

Rotor Slot Data for PMDC Motors

To access the stator slot data, double-click theMachine-Rotor-Slot entry in the project tree.
TheRotor Slot Data Propertieswindow contains the following fields:

Auto
Design

Select or clear this to enable or disable auto-design of slotsHs2,Bs1, andBs2. When
this check box is selected, only two other fields appear in the window:Hs0 andBs0.

Hs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
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Rotor-Slot is selected).
Hs2 A slot dimension (see the diagram shown in themodeling window whenMachine-

Rotor-Slot is selected).
Bs0 A slot dimension (see the diagram shown in themodeling window whenMachine-

Rotor-Slot is selected).
Bs1 A slot dimension (see the diagram shown in themodeling window whenMachine-

Rotor-Slot is selected).
Bs2 A slot dimension (see the diagram shown in themodeling window whenMachine-

Rotor-Slot is selected).
Rs A slot dimension. (see the diagram shown in themodeling window whenMachine-

Stator-Slot is selected). Rs is added when the slot type is 3 or 4.
Rs A slot dimension. (see the diagram shown in themodeling window whenMachine-

Stator-Slot is selected). Rs is added when the slot type is 3 or 4.

Defining the Rotor Windings and Conductors for a PMDC Motor

To define the rotor windings, wires, and conductors:
1. To open theRotor Slot Winding Propertieswindow, double-click theMachine-Rotor-

Winding entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Click theWinding tab.
3. Select aWinding Type:

a. Click the button forWinding Type.
TheWinding Typewindow appears.

b. Select from one of the following three types of winding:
l Lap
l Wave
l Frog Leg

4. Enter the number of windings in theMultiplex Number field (1 for a single winding, 2 for
double windings, 3 for triple windings). For a lap winding, themultiplex number is the number
of commutators between the start and end of one winding, and the number of parallel
branches is equal to the number of polesmultiplied by themultiplex number. For a wave
winding, the number of parallel branches equals themultiplex number multiplied by two.
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5. Enter the number of virtual slots per each real slot in theVirtual Slots field. The rotor is
assumed to have two layers of conductors, an upper and a lower layer. Each layer of
conductors can have a number of windings, which are referred to as virtual slots.
Note For example, the upper and lower layer can have two windings each, which would

yield a virtual slot number of two; for a 12 slot machine, this would yield 24
commutation segments.

6. Enter the total number of conductors in each rotor slot in theConductors per Slot field. This
value is the number of turns per coil multiplied by the number of layers. This value is the total
number of conductors in one real full rotor slot.

7. Enter the coil pitch, measured in number of slots, in theCoil Pitch field. The coil pitch is the
number of slots separating one winding. For example, if a coil starts in slot 1 and ends in slot 6,
it has a coil pitch of 5.

8. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to have
RMxprt auto-design this value.

9. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to
automatically obtain this value from the wire library.
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10. Select theWire Size:
a. Click the button forWire Size.

TheWire Sizewindow appears.
b. Select a value from theWire Diameter pull-down list.
c. Select a wire gauge from theGauge pull-downmenu. You can select from the following

options:

<number>
You can select a specific gauge number. When you select a
gauge number, theWire Diameter field is automatically
updated.

USER
This option allows you tomanually enter theWire Diameter.
This is useful when you want to enter a diameter that does not
correspond to a particular wire gauge.

AUTO

This option sets theWire Diameter to zero, and RMxprt
automatically calculates the optimal value. The diameter
information is then written to the output file when you analyze
the design.

MIXED

This option allows you to define a conductor that ismade of
different size wires. For example, a single conductor may
consist of 5 wires, 3 wires with a diameter of 0.21mmand 2
with a diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.

a. When you are done setting the wire size, clickOK to close theWire Sizewindow and
return to thePropertieswindow.

b. Click theEnd/Insulation tab.
c. Select or clear the Input Half-turn Length check box.
d. Do one of the following:

l If you selected Input Half-turn Length, then enter the half-turn length of the armature
winding in the Half Turn Length field.
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l If you cleared Input Half-turn Length, then enter the end length adjustment of the stator
coils in theEnd Adjustment field. The end adjustment is the distance one end of the
conductor extends vertically beyond the end of the stator.

5. Enter the inner radius of the base corner in theBase Inner Radius field.
6. Enter the inner diameter of the coil tip in the Tip Inner Diameter field.
7. Enter the distance between two rotor coils in theEnd Clearance field.
8. Enter the thickness of the slot liner insulation in theSlot Liner field.

9. Enter the thickness of the wedge insulation in theWedge Thickness field.
10. Enter the thickness of the insulation layer in the Layer Insulation field.
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11. Enter the limited slot fill factor for the wire design in the Limited Fill Factor field. The slot fill
factor is the ratio between the cross-sectional area of all conductors in one slot and the entire
slot area.

12. Select the type of equalizer connection from theEqualizer Connection pull-downmenu.
Select fromNone,Half, or Full.

13. ClickOK to close thePropertieswindow.

Defining Different Size Wires for a PMDC Motor

Use theGauge option if you have a conductor that ismade up different size wires.
To define different size wires:

1. In theWire Size window, selectMIXED from theGauge pull-downmenu.
2. Select eitherRound orRectangular as theWire Type.
3. Enter the appropriate wire data in the table:

l For a round wire:
l Enter theDiameter in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
diameter.

l For a rectangular wire:
l Enter theWidth of the wire in the table.
l Enter the Thickness of the wire in the table.
l Enter the Fillet value in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this data.

4. ClickAdd to add the new wire data.
5. Repeat steps 3 and 4 for each size wire you want to add.
6. When you are finished defining the wires, clickOK to close theWire Sizewindow and return

to the RMxprtPropertieswindow.
Note For example, if one conductor ismade up of 5 wires, and 3 of those wires have a

diameter of 0.21mm, and the other 2 have a diameter of 0.13mm, then themixed
wire size table will have two lines. The first line will list Diameter = 0.21 and Number
= 3. The second line will list Diameter = 0.13 and Number = 2. An equivalent wire
diameter is displayed asWire Size value in theWinding tab in the Properties
window.

Rotor Winding Data for PMDC Motors

To access the stator winding data, double-click theMachine-Rotor-Winding entry in the project
tree.
TheRotor Winding Data Propertieswindow contains the following fields:
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Winding tab Winding Type The type of rotor winding. Click the
button to open theWinding Type
window and choose from Lap,Wave,
and Frog Leg.

Multiplex Number Single, double, or triple windings (1, 2, or
3).

Virtual Slots The number of virtual slots per real slot.
Conductors per Slot The number of conductors per rotor slot

(0 for auto-design).
Coil Pitch The coil pitchmeasured in number of

slots.
Number of Strands The number of wires per conductor (0 for

auto-design).
Wire Wrap The thickness of the double-sided wire

wrap (0 to automatically obtain this value
from the wire library).

Wire Size The diameter of the wire (0 for auto-
design). Click the button to open the
Wire Sizewindow where you can
specify units, wire type, diameter, and
gauge.

End/Insulation tab Input Half-turn Length Select or clear this check box to specify
whether or not you want to enter the
half-turn length. When this check box is
selected, theHalf Turn Length field
appears the next time you open the
Propertieswindow.When this check
box is selected, theEnd Adjustment
field appears instead.

Half Turn Length The half-turn length of the armature
winding.

Base Inner Radius The inner radius of the base corner.
Tip Inner Diameter The inner diameter of the coil tip.
End Clearance The end clearance between two

adjacent coils.
Slot Liner The thickness of the slot liner insulation.
Wedge Thickness The thickness of the wedge insulation.
Layer Insulation The thickness of the insulation layer.
Limited Fill Factor The limited slot fill factor for the wire

design. The slot fill factor is the ratio
between the cross-sectional area of all
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conductors in one slot and the entire slot
area.

Equalizer Connection The connection type of the equalizer.
Select fromNone,Half, or Full.

Defining the Commutator and Brush for a PMDC Motor

The commutator allows current transfer between DC terminals or brushes and the rotor coils,
providing the current to the system as a function of rotation. Due to the action of the commutator, the
correspondingmagnetic field has a fixed distribution with respect to the stator.
To define the commutator and brush pairs:

1. To open theCommutator Data Propertieswindow, double-click the
Machine>Commutator entry in the project tree on the desktop. (You can also enter values in
theProperties section of the desktop without opening a separate window.)

2. Click theCommutator tab.
3. SelectCylinder or Pancake Type as theCommutator Type.

Note When you place themouse cursor over the commutator type, an outline of the
commutator appears.

4. ForCylinder commutators, do the following:
a. Enter theCommutator Diameter.
b. Enter theCommutator Length.

5. For Pancake commutators, do the following:
a. Enter theOuter Diameter.
b. Enter the Inner Diameter.
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6. Enter the thickness of the insulation between two consecutive commutator segments in the
Commutator Insulation field.

7. Click theBrush tab.
8. Enter theBrush Width.
9. Enter theBrush Length.
10. Enter the number of brush pairs when using a wave armature winding in theBrush Pairs

field.
11. Enter the angle of displacement from the neutral axis, in mechanical degrees, in theBrush

Displacement field.
Note The brush displacement is positive for the counter-clockwise direction. For example,

if the rotor turns clockwise and the brush displacement is also clockwise, then the
angle is negative; if the rotor turns clockwise but the brush displacement is counter-
clockwise, then the angle is positive.

12. Enter the voltage drop across one brush pair in theBrush Drop field.
13. Enter themechanical pressure of the brushes as they press against the commutator in the

Brush Press field.
14. Enter the Frictional Coefficient of the brush.

Note If the Friction Loss field is used in theGeneralwindow, theBrush Press and
Frictional Coefficient fields will be hidden in theCommutator/Brushwindow.
These fields are shown only when the Friction Loss field in theGeneralwindow is
set to zero.

15. ClickOK to close thePropertieswindow.

Commutator and Brush Data for PMDC Motors

To access the commutator and brush data, double-click theMachine>Commutator entry in the
project tree.
TheCommutator Data Propertieswindow contains the following fields:

Commutator
tab

Commutator
Type

The type of commutator. Click the button to open theSelect
Commutator Typewindow and select fromCylinder or
Pancake.

Commutator
Diameter

For aCylinder commutator type, the diameter of the commutator.

Commutator
Length

For aCylinder commutator type, the length of the commutator.

Outer
Diameter

For aPancake commutator type, the outer diameter of the
commutator.

Inner
Diameter

For aPancake commutator type, the inner diameter of the
commutator.

Commutator The thickness of the insulation between the two commutator bars.
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Insulation
Brush tab Brush Width Thewidth of the brush.

Brush
Length

The length of the brush.

Brush Pairs The number of brush pairs.
Brush
Displacement

The displacement of the brush from the neutral position, in
mechanical degrees (positive for anti-rotating direction).

Brush Drop The voltage drop across a one-pair brush.
Brush Press The brush press per unit area. (Available only when Frictional

Loss is set to zero for themachine.)
Frictional
Coefficient

The frictional coefficient of the brush. (Available only when
Frictional Loss is set to zero for themachine.)

Defining the Shaft Data for a PMDC Motor

To define the shaft:
1. To open theShaft Data Propertieswindow, double-click theMachine>Shaft entry in the

project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Select or clear theMagnetic Shaft check box to specify whether or not the shaft is to be
made of magneticmaterial.

3. ClickOK to close thePropertieswindow.

Shaft Data for PMDC Motors

To access the shaft data, double-click theMachine>Shaft entry in the project tree.
TheShaft Data Propertieswindow contains the following fields:

Magnetic
Shaft

Select or clear this check box to indicate whether or not the shaft ismade of
magneticmaterial.

Setting Up Analysis Parameters for a PMDC Motor

To define the solution data:
1. To open theSolution Setupwindow, right-clickAnalysis in the project tree, and clickAdd

Solution Setup.
2. Click theGeneral tab. TheOperation Type is automatically set toMotor for thismachine

type.
3. Select the Load Type used in themotor from the following options:

Const The speed remains constant in themotor.
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Speed
Const
Power

The output power remains constant in themotor.

Const
Torque

The torque remains constant regardless of the speed. In this case, Tload = Trated,
given by the output power divided by the given rated speed.

Linear
Torque

The torque increases linearly with speed. In this case, Tload = Trated * (n/nrated)
where Trated is given by the output power divided by the given rated speed.

Fan
Load

The load varies nonlinearly with speed. In this case, Tload = Trated * (n/nrated)2
where Trated is given by the output power divided by the given rated speed.

4. Enter the output power developed at the shaft of themotor in theRated Output Power field.
5. Enter the RMS line-to-line voltage in theRated Voltage field.
6. Enter the desired output speed of themotor at the load point in theRated Speed field.
7. Enter the temperature at which the system functions in theOperating Temperature field.
8. ClickOK to close theSolution Setupwindow.

Related Topics

Solution Data for PMDC Motors

Solution Data for PMDC Motors

To access the solution data, right-clickAnalysis in the project tree, and clickAdd Solution Setup.
For thismachine type, there is only one tab, theGeneral tab.
TheSolution Setupwindow contains the following fields:

Operation
Type

The operation type is automatically set toMotor for thismachine type.

Load Type Select fromConst Speed,Const Power,Const Torque, Linear Torque, and
Fan Load. The default isConst Power.

Rated Output
Power

Type a value for the rated output voltage, and select the units.

Rated Voltage Type a value for the rated voltage, and select the units.
Rated Speed Type a value for the rated speed, and select the units.
Operating
Temperature

Type a value for the operating temperature, and select the units.

Related Topics

Setting Up Analysis Parameters for a PMDCMotor
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Three-Phase Synchronous Machines

After you have selected Three-Phase Synchronous Machines as your model type, you need to
define the following:

l General data, such as the unit system, power, and voltage.
l Stator data, such as the slot types and dimensions, stator diameter, skew width, and
laminations.

l Optional stator Vent data.
l Winding data, such as the parallel branches, conductors, and wire dimensions.
l Rotor pole data, such as its associated pole-body dimensions and air gaps.
l Optional Rotor damper data, such as the damper dimensions, rings, andmaterial properties.
l Rotor winding data and the winding control parameters.
l Shaft Data
l Optional machine housing.
l Solution data, such as specifyingmotor or generator application, and rated output voltage and
frequency.

Also see the Analysis Approach for Three-Phase SynchronousMachines.

Analysis Approach for Three-Phase Synchronous Machines

The three-phase salient-pole synchronous electricmachine has two types: the generator and the
motor. Their basic structures are the same. Three-phase synchronous generators are themain
source of electrical energy for industrial, commercial, and private use. They receivemechanical
energy at the shaft and transform it into electrical energy. The rotor is equipped with amulti-pole
winding excited by a DC source. The stator is equipped with a three-phase winding that has a
sinusoidal spatial distribution. The spinning rotor produces a rotatingmagnetic field in the air gap of
themachine. The frequency of the voltage induced in the stator is given by f=pv, where p is the
number of pairs of poles, and v is the velocity of the rotor. Themachine is capable of producing both
active and reactive power as required by the load connected at the stator phasor.
The three-phase salient-pole synchronous electricmachine has two types: the generator and the
motor. Their basic structures are the same. Usually the frequency-domain phasor diagram is
adopted to analyze the characteristics. The phasor diagram for a generator is shown on the left and
that for amotor is shown on the right.
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In the figure, R1, X1, Xad, and Xaq are armature resistance, armature leakage reactance, d-axis
armature reactance, and q-axis armature reactance, respectively. Xad is nonlinear, while a
linearized value is used in the phasor diagram. Taking the input voltageU as the reference phasor,
for a given current:

where is the power factor angle, a phasor represented byOM can be derived by:
U + I(R1 + jX1 + jXaq)
The direction of E0 can, therefore, be obtained. Taking the power angle, the angle thatU legsE0, as

, then the angle that I legsE0 is:

The d- and q-axis currents are then represented by the following:

Id = I * sin( )

Getting Started with RMxprt 26-262
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Iq = I * cos( )

The phasor length ON represents the d-axis back EMF from d-axis resultant flux linkage and is used
to determine the d-axis field saturation. Then a frozenmethod is applied to deriveE0, Xad, and
exciting current If.
The output power (electric power) is directly computed from voltage and current as:

P2 = 3*U*I*cos( )

The input power (mechanical power) is defined as:
P1 = P2 + Pfw + Pcua + PFe + Padd + Pcuf + Pex

where Pfw, Pcua, PFe, Padd, Pcuf and Pex are frictional and wind loss, armature copper loss, iron-
core loss, additional loss, field winding copper loss, and exciter loss, respectively.
The input mechanical shaft torque is:

T1 = P1/

where SYMBOL is synchronous speed in rad/s.
The efficiency is computed by:

eff = P2/P1 * 100%

Main Features
l Adapted to both SynchronousMotor andGenerator
The structures of the salient-pole synchronousmotor and the generator are basically the
same, but their phasor relationships and the computationmethods are slightly different, their
output characteristics data are also different. This is specified in the solution setup.

l Auto Arrangement of Three-phaseWindings
Almost all commonly used three-phase single- and double-layer, half- and whole-type ac
windings (including fractional-pitch windings) can be automatically arranged. Users do not
need to define coils one by one. RMxprt also supports a double-layer winding with half-turn
coils which are auto-arranged in the order of even, odd, even, odd,…, and even, odd, as long
as it is physically possible.
When a designer adopts single-layer whole-coiled windings, RMxprt will performwinding
arrangement optimization tominimize the average coil pitch. When asymmetric three-phase
windings are used, winding arrangement is optimized in such a way that minimumnegative-
sequence and zero-sequence components are achieved.

l Winding Editor Supporting Any Single- and Double-Layer Windings
Besides taking advantage of the winding auto-arrangement function in RMxprt, users can also
specify any special winding by using of theWinding Editor function.

Getting Started with RMxprt 26-263
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

InWinding Editor, throughmodification of phase belonging, number of turns, in-slot and out-
slot number of each coil, it is possible to design single- and double-layer winding arrangement
for any purposes.

l Analyze Air-GapMagnetic Field Distribution
For both uniform and non-uniform air gaps, Schwarz-Christopher Transformation is adopted
to solve for the air-gapmagnetic field distribution.

l Analyze EMFWaveform and Total Harmonic Distortion (THD)
Based on the analysis of the air-gapmagnetic field waveform, taking into account coil short
pitch, winding distribution, skew slot, winding connection, load effects and other factors, the
emf waveforms in the coils and the windings are analyzed to solve for the emf distortion
factors.

l Analyze Dynamic Parameters of DampingWinding
Different from the squirrel-cage winding of the inductionmachine, the damping winding of the
salient-pole synchronousmachine is located in the surface of magnetic field poles, which
deviates greatly along the d- and the q-axes. Furthermore, the connection of damping bars
has several forms. The bars under each pole could be connected, but not connected with
those under other poles. All the bars could be connected together. The bars could be
connected through end-plate. RMxprt can deal with all those complicated situations and give
the dynamic parameters for the damping winding.

Defining a Three-Phase Synchronous Machine

The general procedure for defining a three-phase synchronousmachine is as follows:
1. Insert a three-phase synchronousmachine into a existing or new project.
2. Double-click theMachine entry in the project tree to define the general data.
3. Double-click theMachine-Stator entry in the project tree to define the stator geometry.
4. Double-click theMachine-Stator-Slot entry in the project tree to define the stator slot

dimensions.
5. Optionally, you can add a vent to, or remove an existing vent from the stator. To add a vent,

select the stator, and right-click to display the pop-upmenu for Insert Vent.
6. Double-click theMachine-Stator-Winding entry in the project tree to define the stator

windings, conductors, and insulation data.
7. Double-click theMachine-Rotor entry in the project tree to define the general rotor geometry,

the pole data, and the insulation data.
8. Double-click theMachine-Rotor-Winding entry in the project tree to define the rotor

conductors and windings.
9. Optionally, you can add a damper to the design or remove an existing damper. To add a

damper, useMachine-Insert Damper. This inserts the damper in the project tree under the
rotor. Youmust then specify the slot type and other properties for the damper.

10. Optionally, you can add a vent to, or remove an existing vent from the rotor. To add a vent
select the rotor, and right-click to display the pop-upmenu. Use Insert Vent.
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11. Double-click theMachine-Shaft entry in the project tree to define themagnetism of the shaft.
12. Optionally, right-click theMachine entry in the project tree and click Insert Housing to add a

machine housing.
13. Right-clickAnalysis in the project tree, and clickAdd Solution Setup to define this solution

data.
14. Choose File>Save to save the project.
15. ChooseRMxprt>Analyze to analyze the design.

Note When you place the cursor over an entry field, a brief description of that field
appears in the status bar at the bottom of theRMxprtwindow.

Once the design is analyzed, themodel can be viewed in theMaxwell 2D Modeler, or it can be used
to create a new Maxwell 2D project, and aMaxwell 3D design.

Defining the General Data for a Three-Phase Synchronous Machine

Use theGeneral Data Properties window to define the power settings, speed, and efficiency of the
generator. This window allows you to define the basic parameters of the synchronous generator,
such as power, voltage, winding connections, and losses.
To define the general data:

1. To open theGeneral Data Propertieswindow, double-click theMachine entry in the project
tree on the desktop. (You can also enter values in theProperties section of the desktop
without opening a separate window.)

2. Enter the number of poles for themachine in theNumber of Poles field. This value is the total
number of poles in the stator (or the number of pole pairsmultiplied by two).

3. Enter the power lost through frictional forces in the Frictional Loss field.
4. Enter the wind lossmeasured at the reference speed in theWind Loss field.
5. Enter the given speed in theReference Speed field.
6. ClickOK to close thePropertieswindow.

General Data for Three-Phase Synchronous Machines

To access the general data, double-click theMachine entry in the project tree.
TheGeneral Data Propertieswindow for a three-phase inductionmotor contains the following
fields:

Machine
Type

Themachine type you selected when inserting a new RMxprt design (Three Phase
SynchronousMachine).

Number of
Poles

The number of poles themachine contains.

Frictional
Loss

The frictional energy loss (due to friction) measured at the reference speed.
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Wind Loss Thewind loss (due to air resistance) measured at the reference speed.
Reference
Speed

The given speed of reference.

Defining the Stator for a Three-Phase Synchronous Machine

Use theStator windows to define the slot dimensions, stacking factors, air ducts, and insulation of
the stator. The stator is the outer lamination stackwhere the three-phase windings reside.
To define general stator data:

1. To open theStator Data Propertieswindow, double-click theMachine>Stator entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter theOuter Diameter of the stator.
3. Enter the Inner Diameter of the stator.
4. Enter the length of the stator core in the Length field.
5. Enter the stacking factor for the stator core in the Stacking Factor field.
6. Select aSteel Type for the stator core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

7. Enter theNumber of Slots in the stator.
8. Select theSlot Type:

a. Click the button for theSlot Type.
TheSelect Slot Typewindow appears.

b. Select a slot type (available types include 1 through 6). Slot types 1 though 4 are filled with
round wire. Slot types 5 and 6 are filled with rectangular wire. IfAuto Design is enabled,
the software designs an optimum slot geometry; in this case, you can input the tooth width
dimension, and the software determines the slot width accordingly.
Note When you place themouse cursor over the slot type, a schematic of the selected

type appears, displaying the slot dimension variables.

c. ClickOK to close theSelect Slot Type window and return to thePropertieswindow.
9. Enter the number of sectors in the Lamination Sectors field.
10. Enter the thickness of themagnetic pressboard in thePressboard Thickness field. Enter 0

for a non-magnetic pressboard.
11. Enter the skew width, measured in slot number, in theSkew Width field.
12. ClickOK to close thePropertieswindow.
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Stator Data for Three-Phase Synchronous Machines

To access the general stator data, double-click theMachine>Stator entry in the project tree.
TheStator Data Propertieswindow contains the following fields:

Outer Diameter The outer diameter of the stator core.
Inner Diameter The inner diameter of the stator core.
Length The length of the stator core.
Stacking Factor The stacking factor of the stator core.
Steel Type The steel type of the stator core. Click the button to open theSelect

Definition window.
Number of Slots The number of slots the stator core contains.
Slot Type The type of slots in the stator core. Click the button to open theSelect Slot

Typewindow.
Lamination
Sectors

The number of lamination sectors.

Pressboard
Thickness

Themagnetic press board thickness (0 for a non-magnetic press board).

Skew Width The skew widthmeasured in slot number.

Defining Stator Slots for a Three-Phase Synchronous Machine

To define the slot dimensions:
1. To open theStator Slot Data Propertieswindow, double-click theMachine-Stator-Slot

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Optionally, to automatically design the dimensions of slotsHs2,Bs1, andBs2, select the
Auto Design check box.

3. Optionally, to design dimensions of slotsBs1 andBs2 based on the stator tooth width, select
theParallel Tooth check box, and enter a value in the Tooth Width field.
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4. Enter the available slot dimensions.
Hs0 Always available.
Hs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.
Bs0 Always available.
Bs1 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto

Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

Bs2 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto
Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

5. ClickOK to close thePropertieswindow.

Stator Slot Data for Three-Phase Synchronous Machines

To access the stator slot data, double-click theMachine-Stator-Slot entry in the project tree.
TheStator Slot Data Propertieswindow contains the following fields:

Auto
Design

Select or clear this to enable or disable auto-design of slotsHs2,Bs1, andBs2. When
this check box is selected, only two other fields appear in the window:Hs0 andBs0.

Parallel
Tooth

Select this to designBs1 andBs2 based on the tooth width. When this check box is
selected, theBs1 andBs2 fields are removed, and the Tooth Width field is added.

Tooth
Width

The tooth width for the parallel tooth, on whichBs1 andBs2 are designed.

Hs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Hs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Rs A slot dimension. (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected). Rs is added when the slot type is 3 or 4.
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Defining Stator Windings and Insulation for a Three-Phase Synchronous Machine

Use theStator Windingwindow to define the stator winding data, such as the coils, wires,
insulation, number of parallel branches, and physical dimensions of the windings.

The stator winding data defines the configuration of one phase of the three-phase windings.
To define the stator windings and insulation:

1. To open theStator Slot Winding Propertieswindow, double-click theMachine-Stator-
Winding entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Click theWinding tab.
3. Enter the number of layers in the stator winding in theWinding Layers field.
4. Select aWinding Type:

a. Click the button forWinding Type.
TheWinding Typewindow appears.

b. Select from one of the following three types of winding:
l Whole Coiled
l Half Coiled
l Editor

When you place themouse cursor over a winding button, an outline of the selected winding appears.
The following table describes the six types of windings that are possible (three for one-layer and
three for two-layer):

Type Description

Editor
A user-defined one-layer winding arrangement. You need to set up the winding
arrangement for each slot. For this winding type, the following letters are used for the
phase windings:
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• Phase A/A return uses A/X.
• Phase B/B return uses B/Y.
• Phase C/C return usesC/Z.

Whole
Coiled

A one-layer whole-coiled winding:

Half
Coiled

A one-layer concentric half-coiled winding:

Editor A user-defined two-layer winding arrangement. When you select 20, theWinding Editor
opens, where you can specify a different winding arrangement for each slot.

Whole
Coiled

A two-layer wave winding:
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The phase belt for this winding configuration is equal to 360/2m, wherem is the phase
number.

Half Coiled

A two-layer half-coiled winding:

There is only one coil per phase per pair of
poles.

Note Example 1: A one layer winding arranged in 12 slots should be defined as type 10, with
the following arrangement:AAZZBBXXCCYY
Example 2: A two layer winding arranged in 12 slots should be defined as type 20, with
the following arrangement:AAZZBBXXCCYY
Only the top layer needs to be defined; the bottom layer will be determined according to the
coil pitch.

a. Once you have clicked a button to select a winding, clickOK to close theWinding Type
window and return to thePropertieswindow.
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b. Select aWinding Type. When you place themouse cursor over a winding, an outline of the
selected winding appears. The following winding types are available:

10 A user-defined single-layer winding arrangement. When you select it, enter the winding
arrangement, and chooseOK. For this winding type, the following letters are used for the
phase windings:

l phase A/A return uses A/X.
l phase B/B return uses B/Y.
l phase C/C return usesC/Z.

11 A one-layer whole-coiled winding:

12 A one-layer concentric half-coiled winding:

20 A user-defined winding arrangement. When you select this type, enter the winding
arrangement, and chooseOK.

21 A two-layer wave winding:
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The phase belt for this winding configuration is equal to 360/2m, wherem is the phase
number.

22 A two-layer winding:

Note Example 1: A one layer winding arranged in 12 slots should be defined as type 10,
with the following arrangement:AAZZBBXXCCYY
Example 2: A two layer winding arranged in 12 slots should be defined as type 20,
with the following arrangement:AAZZBBXXCCYY
Only the top layer needs to be defined; the bottom layer will be determined
according to the coil pitch.

c. Select or enter the number of parallel branches in one phase of the winding in theParallel
Branches field.

d. Enter the total number of conductors in each stator slot in theConductors per Slot field. This
value is the number of turns per coil multiplied by the number of layers.
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e. Enter the coil pitch, measured in number of slots, in theCoil Pitch field. The coil pitch is the
number of slots separating one winding. For example, if a coil starts in slot 1 and ends in slot 6,
it has a coil pitch of 5.

f. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to have
RMxprt auto-design this value.

g. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to
automatically obtain this value from the wire library.

h. Select theWire Size:
i. Click the button forWire Size.
TheWire Sizewindow appears.

j. Select a value from theWire Diameter pull-down list.
k. Select a wire gauge from theGauge pull-downmenu. You can select from the following

options:

<number>
You can select a specific gauge number. When you select a
gauge number, theWire Diameter field is automatically
updated.

USER
This option allows you tomanually enter theWire Diameter.
This is useful when you want to enter a diameter that does not
correspond to a particular wire gauge.

AUTO

This option sets theWire Diameter to zero, and RMxprt
automatically calculates the optimal value. The diameter
information is then written to the output file when you analyze
the design.

MIXED

This option allows you to define a conductor that ismade of
different size wires. For example, a single conductor may
consist of 5 wires, 3 wires with a diameter of 0.21mmand 2
with a diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.
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a. When you are done setting the wire size, clickOK to close theWire Sizewindow and
return to thePropertieswindow.

b. Click theEnd/Insulation tab.
c. Select or clear the Input Half-turn Length check box.
d. Do one of the following:

l If you selected Input Half-turn Length, then enter the half-turn length of the armature
winding in the Half Turn Length field.

l If you cleared Input Half-turn Length, then enter the end length adjustment of the stator
coils in theEnd Adjustment field. The end adjustment is the distance one end of the
conductor extends vertically beyond the end of the stator.

5. Enter the inner radius of the base corner in theBase Inner Radius field.
6. Enter the inner diameter of the coil tip in the Tip Inner Diameter field.
7. Enter the distance between two stator coils in theEnd Clearance field.
8. Enter the thickness of the slot liner insulation in theSlot Liner field.
9. Enter the thickness of the wedge insulation in theWedge Thickness field.
10. Enter the thickness of the insulation layer in the Layer Insulation field.
11. Enter the limited slot fill factor for the wire design in the Limited Fill Factor field. The slot fill

factor is the ratio between the cross-sectional area of all conductors in one slot and the entire
slot area.

12. ClickOK to close thePropertieswindow.

Stator Winding and Insulation for Three-Phase Synchronous Machines

To access the stator winding and insulation data, double-click theMachine-Stator-Winding entry in
the project tree.
TheStator Winding Data Propertieswindow contains the following fields:
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Winding tab Winding Layers The number of winding layers.
Winding Type The type of stator winding. Click the

button to open theWinding Type
window and choose fromWhole
Coiled,Half Coiled, andEditor.

Parallel Branches The number of parallel branches in the
stator winding.

Conductors per Slot The number of conductors per stator slot
(0 for auto-design).

Coil Pitch The coil pitchmeasured in number of
slots.

Number of Strands The number of wires per conductor (0 for
auto-design).

Wire Wrap The thickness of the double-sided wire
wrap (0 to automatically obtain this value
from the wire library).

Wire Size The diameter of the wire (0 for auto-
design). Click the button to open the
Wire Sizewindow where you can
specify units, wire type, diameter, and
gauge.

End/Insulation tab Input Half-turn Length7 Select or clear this check box to specify
whether or not you want to enter the
half-turn length. When this check box is
selected, theHalf Turn Length field
appears the next time you open the
Propertieswindow.When this check
box is selected, theEnd Adjustment
field appears instead.

Half Turn Length The half-turn length of the armature
winding.

End Adjustment The end length adjustment of the stator
coils, which is the distance one end of
the conductor extends vertically beyond
the end of the stator.

Base Inner Radius The inner radius of the base corner.
Tip Inner Diameter The inner diameter of the coil tip.
End Clearance The end clearance between two

adjacent coils.
Slot Liner The thickness of the slot liner insulation.
Wedge Thickness The thickness of the wedge insulation.
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Layer Insulation The thickness of the insulation layer.
Limited Fill Factor The limited slot fill factor for the wire

design. The slot fill factor is the ratio
between the cross-sectional area of all
conductors in one slot and the entire slot
area.

Winding Editor for a Three-Phase Synchronous Machine

For a three-phase synchronousmachine, youmaywant to specify a different number of conductors
for each stator slot. TheWinding Editor makes this possible by enabling you to specify the number of
turns for each coil.
To specify the number of turns for each coil:

1. ClickMachine>Winding>Edit Layout.
TheWinding Editor window appears.

2. In the table in the upper left, set which phase you want for each coil and which slot is the “in”
and “out” slot for the current in each coil.

3. If you are working on a quarter or half model, youmaywant to specify amultiplier by clicking
thePeriodic Multiplier check box and specifying a value.

4. Select or deselect theConstant Turns orConstant Pitch check boxes, depending on
whether you want to be able to change these setting in the table above.When these options
are selected, you cannot change the turns or pitch.

5. When you are satisfied with the coil settings, clickOK to close theWinding Editor window.

Defining Different Size Wires for a Three-Phase Synchronous Machine

Use theGauge option if you have a conductor that ismade up different size wires.
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To define different size wires:
1. In theWire Size window, selectMIXED from theGauge pull-downmenu.
2. Select eitherRound orRectangular as theWire Type.
3. Enter the appropriate wire data in the table:

l For a round wire:
l Enter theDiameter in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
diameter.

l For a rectangular wire:
l Enter theWidth of the wire in the table.
l Enter the Thickness of the wire in the table.
l Enter the Fillet value in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this data.

4. ChooseAdd to add the new wire data.
5. Repeat steps 3 and 4 for each size wire you want to add.
6. When you are finished defining the wires, clickOK to close theWire Sizewindow.

Note For example, if one conductor ismade up of 5 wires, and 3 of those wires have a
diameter of 0.21mm, and the other 2 have a diameter of 0.13mm, then themixed
wire size table will have two lines. The first line will list Diameter = 0.21 and Number
= 3. The second line will list Diameter = 0.13 and Number = 2. An equivalent wire
diameter is displayed asWire Size value in theWinding tab in the Properties
window.

Stator Vent Data for Three-Phase Synchronous Machines

To insert a vent on a stator for a three phase synchronousmachine:
1. Right click on the stator icon in the project tree to display the shortcut menu.
2. Click Insert Vent.

The vent icon appears in the project tree under the stator.
To remove an existing vent item,

1. Right-click on the stator icon in the project tree to display the shortcut menu.
2. ClickRemove Vent.

This removes the vent item from the project tree.
To access the Vent properties for a vent, double click on a vent item. TheVent Propertieswindow
contains the following fields.

Vent Ducts The number of radial vent ducts.
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Duct Width Thewidth of the radial vent ducts.
Magnetic spacer
width

Width of magnetic spacer which holds vent ducts. O for non-magnetic
spacer.

Duct pitch. Center-to-Center distance between two adjacent Vent ducts

Defining the Rotor for a Three-Phase Synchronous Machine

The rotor consists of copper bars in which current is induced by themagnetic fields produced by the
stator windings. In the project tree, double-clickMachine-Rotor andMachine-Rotor-Winding to
define the rotor.
To define the general rotor data:

1. To open theRotor Data Propertieswindow, double-click theMachine-Rotor entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Click theRotor tab.
3. Enter the outer diameter of the rotor in theOuter Diameter field.
4. Enter the inner diameter of the rotor in the Inner Diameter field.
5. Enter the length of the rotor core in the Length field.
6. Select aSteel Type for the rotor core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

7. Enter the stacking factor for the rotor core in the Stacking Factor field.
8. Click thePole tab.
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9. Enter the pole-arc center offset from the rotor center in thePole Arc Offset field.

10. Enter the width of the pole shoe in thePole Shoe Width field.
11. Enter the height of the pole shoe in the Pole Shoe Height field.
12. Enter the width of the pole body in thePole Body Width field.
13. Enter the height of the pole body in thePole Body Height field.
14. Enter the width between the rotor pole and rotor yoke in theSecond Air Gap field.
15. To include the two arcs in the half-pole range, do the following:

a. Select the Select Pole Arc check box.
b. Enter the offset of the second arc perpendicular to the pole-center line in theOff2_x field.
c. Enter the offset of the second arc parallel with the pole-center line in theOff2_y field.

Note If the Off2_x andOff2_y parameters for the second arc are invalid, the second
arc is ignored and the pole includes only the first arc defined by Pole ArcOffset.

Getting Started with RMxprt 26-280
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

1. Select or clear theMagnetic PressBoard check box to specify whether or not the press
board ismade of magneticmaterial.

2. Enter the thickness of the press board in thePress Board Thickness field.
3. Click the Insulation tab.
4. Enter the thickness of the insulatingmaterial beneath the shoe pole in theShoe Insulation

field.
5. Enter the thickness of the insulatingmaterial on the side of the pole body in thePole

Insulation field.
6. Enter the clearance distance between the windings in theWinding Clearance field.
7. ClickOK to close thePropertieswindow.

Rotor, Rotor Pole, and Insulation for Three-Phase Synchronous Machines

To access the general rotor data, pole data, and insulation data double-click theMachine>Rotor
entry in the project tree.
TheRotor Data Propertieswindow contains the following fields:

Rotor tab Outer
Diameter

The outer diameter of the rotor core.

Inner The inner diameter of the rotor core.
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Diameter
Length The length of the rotor core.
Steel Type The steel type of the rotor core. Click the button to open theSelect

Definitionwindow.
Stacking
Factor

The stacking factor of the rotor core.

Pole tab Pole Arc
Offset

The pole-arc center offset from the rotor center.

Pole Shoe
Width

Thewidth of the pole shoe.

Pole Shoe
Height

The height of the pole shoe.

Pole Body
Width

Thewidth of the pole body.

Pole Body
Height

The height of the pole body.

Second Air
Gap

Thewidth of the second air gap, between the rotor pole and rotor yoke.

Second
Pole Arc

Select or clear this option to specify whether or not the pole surface
includes the two arcs in the half-pole range.When you select this check
box, two additional fields appear:Off2_x andOff2_y.

Off2_x The offset of the second arc perpendicular to the pole-center line. This
field is only available whenSecond Pole Arc is selected.
Note: IfOff2_x for the second arc is invalid, the second arc is ignored
and the pole includes only the first arc defined byPole Arc Offset.

Off2_y The offset of the second arc parallel with the pole-center line. This field
is only available whenSecond Pole Arc is selected.
Note: IfOff2_y for the second arc is invalid, the second arc is ignored
and the pole includes only the first arc defined byPole Arc Offset.

Magnetic
PressBoard

Select or clear this option to specify whether or not the press board is
made of magneticmaterial.

Press
Board
Thickness

The thickness of the press board.

Steel Type The steel type of the rotor pole. Click the button to open theSelect
Definitionwindow. Default value is the same as the rotor core.

Stacking
Factor

The stacking factor of the rotor pole. Default value is the same as the
rotor core.

Insulation
tab

Shoe
Insulation

The thickness of the insulatingmaterial beneath the pole shoe.

Pole The thickness of the insulatingmaterial on the side of the pole body.
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Insulation
Winding
Clearance

The clearance distance between the windings.

Defining the Rotor Pole for a Three-Phase Synchronous Machine

The rotor pole drives the electromagnetic field that is coupled with the stator windings.
The following figure shows a partial diagram of a rotor pole:

The following figure shows a diagram of an entire rotor:
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Defining the Rotor Winding Data for a Three-Phase Synchronous Machine

Use theRotor Windingwindow to define the wires and physical dimensions of the rotor winding.
The rotor winding provides the excitation for the electromagnetic field that produces the rotor pole.

To define the rotor windings:
1. To open theRotor Winding Propertieswindow, double-click theMachine-Rotor-Winding

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Select theWinding Type for the rotor:
a. Click the button.

TheWinding Type window appears.
b. Click to select the type of winding, fromRound,Cylinder, or EdgeWise.

When you place themouse cursor over the winding type, a schematic of the selected
winding appears

c. ClickOK to return to thePropertieswindow.
3. Enter the number of parallel branches for the winding in theParallel Branches field.
4. Conductors per Pole
5. Enter the number of wires in each conductor in theNumber of Strands field.
6. Enter the width of the insulating wire wrap in theWire Wrap field.
7. Interturn Insulation
8. Enter the gauge of the wire in theWire Size field.
9. Enter theAxial Clearance to specify the axial distance between the core and the coil at the

end of the lamination stack.
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10. Limited CrossWidth
11. Limited CrossHeight
12. Winding Fillet
13. ClickOK to close thePropertieswindow.

Rotor Winding Data for Three-Phase Synchronous Machines

To access the rotor winding data, double-click theMachine-Rotor-Winding entry in the project
tree.
TheRotor Winding Data Propertieswindow contains the following fields:

Winding
Type

The type of rotor winding. Click the button to open theWinding Typewindow and
choose fromWhole Coiled,Half Coiled, andEditor.

Parallel
Branches

The number of parallel branches in the rotor winding.

Conductors
per Pole

The number of conductors per rotor pole (0 for auto-design).

Number of
Strands

The number of wires per conductor (0 for auto-design).

Wire Wrap The thickness of the double-sided wire wrap (0 to automatically obtain this value
from the wire library).

Interturn
Insulation

The thickness of the inter-turn insulation of an edgewise winding. This field only
appears whenEdgewiseCoil is selected as theWinding Type.

Wire Size The diameter of the wire (0 for auto-design). Click the button to open theWire Size
window where you can specify units, wire type, diameter, and gauge.

Axial The axial gap between the field winding and the pole body or inner coil.
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Clearance
Limited
Cross
Width

The limited cross-section width for the winding design or arrangement (0 for
availablemaximumarea).

Limited
Cross
Height

The limited cross-section height for the winding design or arrangement (0 for
availablemaximumarea).

Winding
Fillet

The size of the winding fillet.

Defining the Rotor Damper Data

To define a rotor damper for amachine that permits one:
1. ClickMachine>Insert Damper.

TheDamper icon appears in the project tree under the rotor icon. A slot icon appears in the
hierarchy under the damper.

2. Double click on the Damper icon to display the properties window for the damper.
3. Enter the appropriate values for the damper. The slot type, the bar conductor type, and end

conductor type are entered by clicking on buttons that open other windows.
4. ClickOK to close the properties window.

Damper Data for Three-Phase Synchronous Machines

By option, you can add a damper to or remove damper from the rotor of a three phasemachine.
To add a damper:

1. Right-click on the rotor icon in the project tree to display the short cut menu.
2. Click Insert Damper on themenu.

The damper appears in the project tree under the rotor. The damper also includes an
associated slot.

1. To remove a damper, right-click on the rotor icon in the project tree to display the short cut
menu.

2. ClickRemove Damper on themenu.
The damper and associated slot are removed from the project tree.

The damper data contains the following fields.

Damper
slots per
pole

Number of damper slots per pole.

Slot type Damper slot type. Specify this by clicking the button in the properties field and
selecting from the Select Slot Type window.
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Cast Rotor. Whether the rotor squirrel cage winding is cast.
Bar
conductor
type.

Specify this by clicking the button in the properties field, and using the Select
Definition window to find and assignmaterials.

End length Single side end extended bar length/
End ring
width

Axial width of end ring.

End ring
height

Radial height of end ring.

End ring
conductor
type.

Specify this by clicking the button in the properties field and using the Select
Definition window to find and assign thematerial.

Slot pitch Slot pitch in mechanical degrees.
Center slot
pitch

Center slot pitch in mechanical degrees

End Ring
type

Type of end ring for the damper. Specify this by clicking the button in the properties
field and use the Select Pole type window to select from the available types.

Defining the Shaft Data for a Three-Phase Synchronous Machine

To define the shaft:
1. To open theShaft Data Propertieswindow, double-click theMachine>Shaft entry in the

project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Select or clear theMagnetic Shaft check box to specify whether or not the shaft is to be
made of magneticmaterial.

3. ClickOK to close thePropertieswindow.

Shaft Data for Three-Phase Synchronous Machines

To access the shaft data, double-click theMachine>Shaft entry in the project tree.
TheShaft Data Propertieswindow contains the following fields:

Magnetic
Shaft

Select or clear this check box to indicate whether or not the shaft ismade of
magneticmaterial.

Setting Up Analysis Parameters for a Three-Phase Synchronous Machine

To define the solution data:
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1. To open theSolution Setupwindow, right-clickAnalysis in the project tree, and clickAdd
Solution Setup.

2. Click theGeneral tab.
3. SelectMotor orGenerator from theOperation Type pull-down list.
4. Select the Load Type used in themotor from the following options:

Infinite Bus When the generator is connected to an infinite bus of the power system, the
terminal voltages remain constant and the output power is determined by the
output currents.

Independent
Generator

The generator supplies electrical power to a load inductor. For an AC
generator, the resistance and inductance of the load inductor are determined
by the rated output power, the rated voltage, and the rated power factor. For
a DC generator, the resistance of the load resistor is determined by the rated
output power and the rated voltage.

Const
Speed

For Motors. The speed remains constant in themotor.

Const
Power

For Motors. The output power remains constant in themotor.

Const
Torque

For Motors. The torque remains constant regardless of the speed. In this
case, Tload = Trated, given by the output power divided by the given rated
speed.

Linear
Torque

For Motors. The torque increases linearly with speed. In this case, Tload =
Trated * (n/nrated) where Trated is given by the output power divided by the
given rated speed.

Fan Load For Motors. The load varies nonlinearly with speed. In this case, Tload =
Trated * (n/nrated)2 where Trated is given by the output power divided by the
given rated speed.

5. Enter the output power developed at the shaft of themachine in theRated Output Power
field.

6. Enter the RMS line-to-line voltage in theRated Voltage field.
7. Enter the desired output speed of themotor at the load point in theRated Speed field.
8. Enter the temperature at which the system functions in theOperating Temperature field.
9. Click the Three-Phase Synchronous Machine tab.
10. Enter a value in theRated Power Factor field.
11. SelectWye orDelta from theWinding Connection pull-down list.
12. In theExciter Efficiency field, enter the efficiency of the exciter used to supply the rotor

winding with DC current if it is mechanically connected to the shaft of the generator. The
efficiency value ranges between 0 and 1 and will only affect the total efficiency result.

13. To enter an Input Exciting Current, select the check box, enter a value, and select the units.
14. ClickOK to close theSolution Setupwindow.
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Related Topics

Solution Data for Three-Phase SynchronousMachines

Solution Data for Three-Phase Synchronous Machines

To access the solution data, right-clickAnalysis in the project tree, and clickAdd Solution Setup.
TheSolution Setupwindow contains the following fields:

Operation
Type

On theGeneral tab. Select fromMotor orGenerator.

Load Type On theGeneral tab. For amotor, select fromConst Speed,Const Power,
Const Torque, Linear Torque, and Fan Load. The default isConst Power. For
a generator, select from Infinite Bus and Independent Generator.

Rated
Output
Power

On theGeneral tab. Type a value for the rated output voltage, and select the units.

Rated
Voltage

On theGeneral tab. Type a value for the rated voltage, and select the units.

Rated Speed On theGeneral tab. Type a value for the rated speed, and select the units.
Operating
Temperature

On theGeneral tab. Type a value for the operating temperature, and select the
units.

Rated Power
Factor

On the Three-Phase Synchronous Machine tab. Type a value for the rated
power factor.

Winding
Connection

On the Three-Phase Synchronous Machine tab. Select fromWye orDelta.

Exciter
Efficiency

On the Three-Phase Synchronous Machine tab. Type a percent for the exciter
efficiency.

Input
Exciting
Current

On the Three-Phase Synchronous Machine tab. If you select this check box,
then enter the exciting current, and select the units.

Related Topics

Setting Up Analysis Parameters for a Three-Phase SynchronousMachine

Brushless Permanent-Magnet DC Motors

After you have selectedBrushless Permanent-Magnet DC Motors as your model type, you need
to define the following:
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l General data, such as the voltage, speed, and circuit type of themodel.
l Circuit data, such as lead trigger angle, transistor drop, and control circuit information.
l Stator data, such as the diameter, slot dimensions, winding data, and skew width of the stator.
l Rotor data
l Rotor pole data, such as themagnet dimensions and stacking factor.
l Shaft data
l Optional machine housing.
l Solution data, such as rated output voltage and frequency.

Analysis Approach for Brushless PMDC Motors

The stator of a brushlessDC motor is equipped with a polyphase winding. The phases are
connected to the DC bus through a switching circuit. The switching sequence is controlled so that it is
synchronized with the position of the rotor. As a result, the stator produces a rotatingmagnetic field.
The rotor is equipped with permanent magnets, creating a structure with the same number of poles
at the stator. The stator switches act like a commutator in a classic DC motor.
In brushless permanent-magnet DC (BLDC) motors, the armature currents are commutated exactly
according to rotor position. The signal of rotor positionmay be obtained from a position sensor, or
from induced voltages for sensor-less control system.
The performance of BLDC motors is analyzed via a time-domain simulation. The voltage equation in
the time domain is:

whereR1, Ld, Lq, and L0 are armature resistance, d-axis synchronous inductance, q-axis

synchronous inductance, and 0-axis inductance, respectively. e is rotor speed in electrical rad/s,

and represents for d/dt.
The transformations for terminal voltages, induced voltages, and winding currents are given by the
following three equations:
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The transformationmatrices for 2-phase, 3-phase, and 4-phases systems, noted asC2,C3, andC4,
are as follows:

where = 2 /3.
The input power (electric power) can now be computed from the voltage and current as:
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The output power (mechanical power) is:
P2 = P1 - (Pfw + PCua + Pt + PFe)

wherePfw, PCua, Pt, andPFe are frictional and wind loss, armature copper loss, transistor/diode
loss, and iron-core loss, respectively.
The output mechanical shaft torque T2 is:

T2 = P2 /

where is the rotor speed inmechanical rad/s.
The efficiency is computed by:

eff = P2/P1 * 100%

Defining a Brushless Permanent-Magnet DC Motor

The general procedure for defining a brushless permanent-magnet DC motor is as follows:
1. Insert the permanent magnet brushlessDC motor into a new or existing project.
2. Double-click theMachine entry in the project tree to define the general data.
3. Double-click theMachine-Circuit entry in the project tree to define the control circuit.
4. Double-click theMachine-Stator entry in the project tree to define the stator geometry.
5. Double-click theMachine-Stator-Slot entry in the project tree to define the stator slot

dimensions.
6. Double-click theMachine-Stator-Winding entry in the project tree to define the stator

windings and conductors.
7. Double-click theMachine-Rotor entry in the project tree to define the rotor geometry.
8. Double-click theMachine-Rotor-Pole entry in the project tree to define the pole, embrace,

offset, and air gap data for the rotor pole.
9. Double-click theMachine-Shaft entry in the project tree to define themagnetism of the shaft.
10. Optionally, right-click theMachine entry in the project tree and click Insert Housing to add a

machine housing.
11. Right-clickAnalysis in the project tree, and clickAdd Solution Setup to define the solution

data.
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12. Choose File>Save to save the project.
13. ChooseRMxprt>Analyze to analyze the design.

Note When you place the cursor over an entry field in the data windows, a brief
description of that field appears in the status bar at the bottom of theRMxprt
window.

Once analyzed, themodel can be viewed in theMaxwell 2D Modeler, or it can be used to create a
new Maxwell 2D project, and a new Maxwell 3D design
Please refer to theBrushless Permanent-Magnet DC Motor Problem application note, on the
technical support page of the ANSYS web site, for a specific example of a brushless permanent-
magnet DC motor problem.

Defining the General Data for a Brushless PMDC Motor

Use theGeneralwindow to specify the rated output power, voltage values, circuit type, and speed of
the brushlessDC motor.
To define the general data:

1. To open theGeneral Data Propertieswindow, double-click theMachine entry in the project
tree on the desktop. (You can also enter values in theProperties section of the desktop
without opening a separate window.)

2. Enter the number of poles for themachine in theNumber of Poles field. This value is the total
number of poles in the stator (or the number of pole pairsmultiplied by two).

3. Enter the energy loss due to friction at the given speed in the Frictional Loss field.
4. Enter the wind loss due to air resistancemeasured at the reference speed in theWind Loss

field.
5. Enter the given speed in theReference Speed field.
6. SelectDC orCCC from theControl Type pull-down list.
7. Select aCircuit Type from the following types:

Y3 Y-connected, three-
phase.

L3 Loop-type, three-phase.
S3 Star-type, three-phase.
C2 Cross-type, two-phase.
L4 Loop-type, four-phase.
S4 Star-type, four-phase.

The circuit types are based on industry standards. By default, typeY3, a three-phase, six-
status circuit, is selected as the circuit type.

Note When you place themouse cursor over a circuit type, an outline schematic of the circuit
appears.

8. ClickOK to close thePropertieswindow.
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General Data for Brushless PMDC Motors

To access the general data, double-click theMachine entry in the project tree.
TheGeneral Data Propertieswindow for a three-phase inductionmotor contains the following
fields:

Machine
Type

Themachine type you selected when inserting a new RMxprt design (Brushless
Permanent-Magnet DC Motor).

Number of
Poles

The number of poles themachine contains.

Rotor
Position

Select whether the rotor is an Inner Rotor orOuter Rotor.

Frictional
Loss

The frictional energy loss (due to friction) measured at the reference speed.

Wind Loss Thewind loss (due to air resistance) measured at the reference speed.
Reference
Speed

The given speed of reference.

Control
Type

Theway the circuit is controlled. Select fromDC orCCC (chopped current control).

Circuit
Type

The drive circuit type. Click the button to open theCircuit Typewindow and select
from the following six types:

•Y3: Y-Type, 3-Phase
• L3: Loop-Type, 3-Phase
•S3: Star-Type, 3-Phase
•C2: Cross-Type, 2-Phase
• L4: Loop-Type, 4-Phase
•S4: Star-Type, 4-Phase

Defining the Circuit Data for a Brushless PMDC Motor

Use theCircuit Data Propertieswindow to define the circuit data for a brushless PMDCMotor.
1. To open theCircuit Data Propertieswindow, double-click theMachine>Circuit entry in the

project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter the trigger’s lead angle in electrical degrees in the Lead Angle of Trigger field. The
trigger’s lead angle is shown in the following plot of the open circuit induced voltage versus
position. An angle of 0means that the induced voltage in the triggered phase is at amaximum:
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Note A positive value represents a lead angle, and a negative value represents a lag
angle.

3. Enter the period from on-status to off-status of a transistor, in electrical degrees, in the
Trigger Pulse Width field.

4. Enter the voltage drop across one transistor when the transistor is turned on in the Transistor
Drop field. Refer to the figures of the different circuit types in step 2.

5. Enter the voltage drop of one diode in the discharge loop in theDiode Drop field. If you
selected a star-type circuit (S3 or S4) as theCircuit Type, enter the total discharge voltage in
this field.

6. If you selected CCC (chopped current control) as theControl Type, then enter themaximum
andminimum current values in theMaximum Current andMinimum Current fields.

7. ClickOK to close thePropertieswindow.

Circuit Data for Brushless PMDC Motors

To access theCircuit Data Propertieswindow, double-click theMachine>Circuit entry in the
project tree.

Lead Angle of
Trigger

The trigger’s lead angle, in electrical degrees.

Trigger Pulse
Width

The period from on-status to off-status for a transistor, in electrical degrees.

Transistor Drop The voltage drop across one transistor when the transistor is turned on.
Diode Drop The voltage drop across one diode in the discharge loop.
Maximum
Current

Themaximum current for the chopped current control. This field is not
available for a DC circuit.
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Minimum
Current

Theminimum current for the chopped current control. This field is not
available for a DC circuit.

Defining the Stator Data for a Brushless PMDC Motor

The stator is the outer lamination stackwhere the polyphase voltage windings reside.
To define the general stator data:

1. To open theStator Data Propertieswindow, double-click theMachine>Stator entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter theOuter Diameter of the stator.
3. Enter the Inner Diameter of the stator.
4. Enter the length of the stator core in the Length field.
5. Enter the stacking factor for the stator core in the Stacking Factor field.
6. Select aSteel Type for the stator core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

7. Enter theNumber of Slots in the stator.
8. Select theSlot Type:

a. Click the button for theSlot Type.
TheSelect Slot Typewindow appears.

b. Select a slot type (available types include 1 through 4).
Note When you place themouse cursor over the slot type, a schematic of the selected

type appears, displaying the slot dimension variables.

c. ClickOK to close theSelect Slot Type window and return to thePropertieswindow.
9. Enter the skew width, measured in slot number, in theSkew Width field.
10. ClickOK to close thePropertieswindow.

Stator Data for Brushless PMDC Motors

To access the general stator data, double-click theMachine>Stator entry in the project tree.
TheStator Data Propertieswindow contains the following fields:

Outer
Diameter

The outer diameter of the stator core.

Inner
Diameter

The inner diameter of the stator core.

Length The length of the stator core.
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Stacking
Factor

The stacking factor of the stator core.

Steel Type The steel type of the stator core. Click the button to open theSelect Definition
window.

Number of
Slots

The number of slots the stator core contains.

Slot Type The type of slots in the stator core. Click the button to open theSelect Slot Type
window.

Skew Width The skew widthmeasured in slot number.

Defining the Stator Slots for a Brushless PMDC Motor

To define the physical dimensions of the stator slots:
1. To open theStator Slot Data Propertieswindow, double-click theMachine-Stator-Slot

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Optionally, to automatically design the dimensions of slotsHs2,Bs1, andBs2, select the
Auto Design check box.

3. Optionally, to design dimensions of slotsBs1 andBs2 based on the stator tooth width, select
theParallel Tooth check box, and enter a value in the Tooth Width field.

4. Enter the available slot dimensions.
Hs0 Always available.
Hs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.
Bs0 Always available.
Bs1 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto

Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

Bs2 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto
Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

5. ClickOK to close thePropertieswindow.

Stator Slot Data for Brushless PMDC Motors

To access the stator slot data, double-click theMachine-Stator-Slot entry in the project tree.
TheStator Slot Data Propertieswindow contains the following fields:

Auto Select or clear this to enable or disable auto-design of slotsHs2,Bs1, andBs2. When
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Design this check box is selected, only two other fields appear in the window:Hs0 andBs0.
Parallel
Tooth

Select this to designBs1 andBs2 based on the tooth width. When this check box is
selected, theBs1 andBs2 fields are removed, and the Tooth Width field is added.

Tooth
Width

The tooth width for the parallel tooth, on whichBs1 andBs2 are designed.

Hs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Hs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Hs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Rs A slot dimension. (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected). Rs is added when the slot type is 3 or 4.

Defining the Stator Windings and Conductors for a Brushless PMDC Motor

To define the stator windings, wires, and conductors:
1. To open theStator Slot Winding Propertieswindow, double-click theMachine-Stator-

Winding entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Click theWinding tab.
3. Enter the number of layers in the stator winding in theWinding Layers field.
4. Select aWinding Type:

a. Click the button forWinding Type.
TheWinding Typewindow appears.

b. Select from one of the following three types of winding:
l Whole Coiled
l Half Coiled
l Editor

When you place themouse cursor over a winding button, an outline of the selected winding appears.
The following table describes the six types of windings that are possible (three for one-layer and
three for two-layer):

Type Description
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Editor

A user-defined one-layer winding arrangement. You need to set up the winding
arrangement for each slot. For this winding type, the following letters are used for the
phase windings:

• Phase A/A return uses A/X.
• Phase B/B return uses B/Y.
• Phase C/C return usesC/Z.

Whole
Coiled

A one-layer whole-coiled winding:

Half
Coiled

A one-layer concentric half-coiled winding:

Editor A user-defined two-layer winding arrangement. When you select 20, theWinding Editor
opens, where you can specify a different winding arrangement for each slot.

Whole
Coiled

A two-layer wave winding:

Getting Started with RMxprt 26-299
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

The phase belt for this winding configuration is equal to 360/2m, wherem is the phase
number.

Half Coiled

A two-layer half-coiled winding:

There is only one coil per phase per pair of
poles.

Note For a two layer winding, if you checkConstant Pitch in theWinding Editor, only the top
layer needs to be defined; the bottom layer will be determined according to the coil pitch.

a. Once you have clicked a button to select a winding, clickOK to close theWinding Type
window and return to thePropertieswindow.

b. Select aWinding Type.
The following winding types are available:
Note When you place themouse cursor over a winding, an outline of the selected winding

appears.
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10 A user-defined single-layer winding arrangement. When you select this type, enter the
winding arrangement, and chooseOK. For this winding type, the following letters are
used for the phase windings:

l Phase A/A return uses A/X.
l Phase B/B return uses B/Y.
l Phase C/C return usesC/Z.

11 A one-layer whole-coiled winding:

12 A one-layer concentric half-coiled winding:

20 A user-defined two-layer winding arrangement. When you select this type, enter the
winding arrangement, and chooseOK.

21 A two-layer wave winding:
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The phase belt for this winding configuration is equal to 360/2m, wherem is the phase
number.

22 A two-layer winding:

c. Select or enter the number of parallel branches in one phase of the winding in theParallel
Branches field.

d. Enter the total number of conductors in each stator slot in theConductors per Slot field. This
value is the number of turns per coil multiplied by the number of layers.

e. Enter the coil pitch, measured in number of slots, in theCoil Pitch field. The coil pitch is the
number of slots separating one winding. For example, if a coil starts in slot 1 and ends in slot 6,
it has a coil pitch of 5.

f. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to have
RMxprt auto-design this value.

g. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to
automatically obtain this value from the wire library.
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h. Select theWire Size:
i. Click the button forWire Size.

TheWire Sizewindow appears.
j. Select a value from theWire Diameter pull-down list.
k. Select a wire gauge from theGauge pull-downmenu. You can select from the following

options:
<

number
>

You can select a specific gauge number. When you select a gauge number,
theWire Diameter field is automatically updated.

USER
This option allows you tomanually enter theWire Diameter. This is useful
when you want to enter a diameter that does not correspond to a particular
wire gauge.

AUTO
This option sets theWire Diameter to zero, and RMxprt automatically
calculates the optimal value. The diameter information is then written to the
output file when you analyze the design.

MIXED
This option allows you to define a conductor that ismade of different size wires.
For example, a single conductor may consist of 5 wires, 3 wires with a diameter
of 0.21mmand 2 with a diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.

a. When you are done setting the wire size, clickOK to close theWire Sizewindow and
return to thePropertieswindow.

b. Click theEnd/Insulation tab.
c. Select or clear the Input Half-turn Length check box.
d. Do one of the following:

l If you selected Input Half-turn Length, then enter the half-turn length of the armature
winding in the Half Turn Length field.

l If you cleared Input Half-turn Length, then enter the end length adjustment of the stator
coils in theEnd Adjustment field. The end adjustment is the distance one end of the

Getting Started with RMxprt 26-303
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

conductor extends vertically beyond the end of the stator.

5. Enter the inner radius of the base corner in theBase Inner Radius field.
6. Enter the inner diameter of the coil tip in the Tip Inner Diameter field.
7. Enter the distance between two stator coils in theEnd Clearance field.
8. Enter the thickness of the slot liner insulation in theSlot Liner field.

9. Enter the thickness of the wedge insulation in theWedge Thickness field.
10. Enter the thickness of the insulation layer in the Layer Insulation field.
11. Enter the limited slot fill factor for the wire design in the Limited Fill Factor field. The slot fill

factor is the ratio between the cross-sectional area of all conductors in one slot and the entire
slot area.

12. ClickOK to close thePropertieswindow.
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Winding Editor for a Brushless DC Motor

For a brushlessDC motor, youmaywant to specify a different number of conductors for each stator
slot. TheWinding Editor makes this possible by enabling you to specify the number of turns for each
coil.
To specify the number of turns for each coil:

1. ClickMachine>Winding>Edit Layout.
TheWinding Editor window appears.

2. In the table in the upper left, set which phase you want for each coil and which slot is the “in”
and “out” slot for the current in each coil.

3. If you are working on a quarter or half model, youmaywant to specify amultiplier by clicking
thePeriodic Multiplier check box and specifying a value.

4. Select or deselect theConstant Turns orConstant Pitch check boxes, depending on
whether you want to be able to change these setting in the table above.When these options
are selected, you cannot change the turns or pitch.

5. When you are satisfied with the conductor settings, clickOK to close theWinding Editor
window.

Defining Different Size Wires for a Brushless DC Motor

Use theGauge option in theWire Size dialog if you have a conductor that ismade up different size
wires.
To define different size wires:

1. In theWire Size window, selectMIXED from theGauge pull-downmenu.
2. Select eitherRound orRectangular as theWire Type.
3. Enter the appropriate wire data in the table:

l For a round wire:
l Enter theDiameter in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
diameter.

l For a rectangular wire:
l Enter theWidth of the wire in the table.
l Enter the Thickness of the wire in the table.
l Enter the Fillet value in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this data.

4. ClickAdd to add the new wire data.
5. Repeat steps 3 and 4 for each size wire you want to add.
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6. When you are finished defining the wires, clickOK to close theWire Sizewindow and return
to the RMxprtPropertieswindow.
Note For example, if one conductor ismade up of 5 wires, and 3 of those wires have a

diameter of 0.21mm, and the other 2 have a diameter of 0.13mm, then themixed
wire size table will have two lines. The first line will list Diameter = 0.21 and Number
= 3. The second line will list Diameter = 0.13 and Number = 2. An equivalent wire
diameter is displayed asWire Size value in theWinding tab in the Properties
window.

Stator Winding Data for Brushless PMDC Motors

To access the stator winding data, double-click theMachine-Stator-Winding entry in the project
tree.
TheStator Winding Data Propertieswindow contains the following fields:

Winding tab Winding Layers The number of winding layers.
Winding Type The type of stator winding. Click the

button to open theWinding Type
window and choose fromWhole
Coiled,Half Coiled, andEditor.

Parallel Branches The number of parallel branches in the
stator winding.

Conductors per Slot The number of conductors per stator slot
(0 for auto-design).

Coil Pitch The coil pitchmeasured in number of
slots.

Number of Strands The number of wires per conductor (0 for
auto-design).

Wire Wrap The thickness of the double-sided wire
wrap (0 to automatically obtain this value
from the wire library).

Wire Size The diameter of the wire (0 for auto-
design). Click the button to open the
Wire Sizewindow where you can
specify units, wire type, diameter, and
gauge.

End/Insulation tab Input Half-turn Length Select or clear this check box to specify
whether or not you want to enter the
half-turn length. When this check box is
selected, theHalf Turn Length field
appears the next time you open the
Propertieswindow.When this check
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box is selected, theEnd Adjustment
field appears instead.

Half Turn Length The half-turn length of the armature
winding.

End Adjustment The end length adjustment of the stator
coils, which is the distance one end of
the conductor extends vertically beyond
the end of the stator.

Base Inner Radius The inner radius of the base corner.
Tip Inner Diameter The inner diameter of the coil tip.
End Clearance The end clearance between two

adjacent coils.
Slot Liner The thickness of the slot liner insulation.
Wedge Thickness The thickness of the wedge insulation.
Layer Insulation The thickness of the insulation layer.
Limited Fill Factor The limited slot fill factor for the wire

design. The slot fill factor is the ratio
between the cross-sectional area of all
conductors in one slot and the entire slot
area.

Defining the Rotor Data for a Brushless PMDC Motor

The rotor consists of copper bars in which current is induced by themagnetic fields produced by the
stator windings. In the project tree, double-clickMachine>Rotor andMachine-Rotor-Pole to
define the rotor and the pole.
To define general rotor data:
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1. To open theRotor Data Propertieswindow, double-click theMachine>Rotor entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter the outer diameter of the rotor in theOuter Diameter field.
3. Enter the inner diameter of the rotor in the Inner Diameter field.
4. Enter the length of the rotor core in the Length field.
5. Select aSteel Type for the rotor core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

6. Enter the stacking factor for the rotor core in the Stacking Factor field.
7. Select aPole Type:

a. Click the button.
TheSelect Pole Typewindow appears.

b. Click a button to select the desired pole type (1, 2, 3, 4, or 5). TIP:When you run the
mouse over each option, the diagram changes to show that pole type.
Note When you place themouse cursor over a pole type, an outline of the selected

circuit type appears.

c. ClickOK to close theSelect Pole Typewindow and return to thePropertieswindow.
8. ClickOK to close thePropertieswindow.

Rotor Data for Brushless PMDC Motors

To access the general rotor data, double-click theMachine>Rotor entry in the project tree.
TheRotor Data Propertieswindow contains the following fields:

Outer
Diameter

The outer diameter of the rotor core.

Inner
Diameter

The inner diameter of the rotor core.

Length The length of the rotor core.
Steel
Type

The steel type of the rotor core. Click the button to open theSelect Definition
window.

Stacking
Factor

The stacking factor of the rotor core.

Pole
Type

The pole type for the rotor. Click this button to open theSelect Pole Typewindow
and select from the following types: 1, 2, 3, 4, 5.

Getting Started with RMxprt 26-308
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Defining the Rotor Pole for a Brushless PMDC Motor

The rotor pole drives the electromagnetic field which is coupled with the stator windings. Use the
Rotor Pole Data Properties window to define the rotor pole.

Note Some of the fields in theRotor Pole window change, or are inactive, depending on the
Rotor Type you select.

To define the rotor pole:
1. To open theRotor Pole Data Propertieswindow, double-click theMachine-Rotor-Pole

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. For all pole types except type 4, enter the ratio of the actual arc distance in relation to the
maximumpossible arc distance in theEmbrace field. This value is between 0 and 1.

3. For pole type 4, enter the shaft diameter of the rotor in theShaft Diameter field.
4. For pole types 1, 2, and 3, enter the distance from the center of the rotor to the polar arc center

in theOffset field. Enter 0 for a uniform air gap.
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5. For pole type 5, enter the thickness of the bridge across the two poles in theBridge field.
6. For pole type 5, enter the width of the rib supporting the bridge in theRib field.
7. Select the type of magnet to use in the rotor pole from theMagnet Type pull-downmenu.
8. For pole types 4 and 5, enter the width of themagnet in theMagnet Width field.
9. Enter themaximum radial thickness of themagnet in theMagnet Thickness field.
10. ClickOK to close thePropertieswindow.

Rotor Pole Data for Brushless PMDC Motors

To access the pole rotor data, double-click theMachine-Rotor-Pole entry in the project tree.
TheRotor Pole Data Propertieswindow may contain the following fields, depending on the pole
type specified.

Embrace The pole embrace. For pole types 1, 2, 3, and 5.
Shaft
Diameter

The shaft diameter of the rotor. For pole type 4.

Offset The pole-arc center offset from the rotor center (0 for a uniform air gap). For pole
types 1, 2, and 3.

Bridge The thickness of the bridge across two adjacent poles. For pole type 5.
Rib Thewidth of the rib at the center of two adjacent poles that support the bridge.

For pole type 5.
Magnet Type The type of magnet. Click the button to open theSelect Definitionwindow. For

all pole types.
Magnet Width Themaximumwidth of themagnet. For pole types 4 and 5.
Magnet
Thickness

Themaximum thickness of themagnet. For all pole types.
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Defining the Shaft Data for a Brushless PMDC Motor

To define the shaft:
1. To open theShaft Data Propertieswindow, double-click theMachine>Shaft entry in the

project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Select or clear theMagnetic Shaft check box to specify whether or not the shaft is to be
made of magneticmaterial.

3. ClickOK to close thePropertieswindow.

Shaft Data for Brushless PMDC Motors

To access the shaft data, double-click theMachine>Shaft entry in the project tree.
TheShaft Data Propertieswindow contains the following fields:

Magnetic
Shaft

Select or clear this check box to indicate whether or not the shaft ismade of
magneticmaterial.

Setting Up Analysis Parameters for a Brushless PMDC Motor

To define the solution data:
1. To open the Solution Setup window, right-clickAnalysis in the project tree, and clickAdd

Solution Setup.
2. Click theGeneral tab. TheOperation Type isMotor for thismachine type.
3. Select the Load Type used in themotor from the following options:

Const
Speed

The speed remains constant in themotor.

Const
Power

The output power remains constant in themotor.

Const
Torque

The torque remains constant regardless of the speed. In this case, Tload = Trated,
given by the output power divided by the given rated speed.

Linear
Torque

The torque increases linearly with speed. In this case, Tload = Trated * (n/nrated)
where Trated is given by the output power divided by the given rated speed.

Fan
Load

The load varies nonlinearly with speed. In this case, Tload = Trated * (n/nrated)2
where Trated is given by the output power divided by the given rated speed.

4. Enter the output power developed at the shaft of themotor in theRated Output Power field.
5. Enter the RMS line-to-line voltage in theRated Voltage field.
6. Enter the desired output speed of themotor at the load point in theRated Speed field.
7. Enter the temperature at which the system functions in theOperating Temperature field.
8. ClickOK to close theSolution Setupwindow.

Getting Started with RMxprt 26-311
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Related Topics

Solution Data for Brushless PMDCMotors
Analysis Offered

Analysis Offered

l Adapted to both SynchronousMotor andGenerator
The structures of the salient-pole synchronousmotor and the generator are basically the
same, but their phasor relationships and the computationmethods are slightly different, their
output characteristics data are also different. Therefore, RMxprt divides the synchronous
machine into two designmodules: SynchronousMotor and SynchronousGenerator.

l Auto Arrangement of Three-phaseWindings
Almost all commonly used three-phase single- and double-layer, half- and whole-type ac
windings (including fractional-pitch windings) can be automatically arranged. Users do not
need to define coils one by one. RMxprt also supports a double-layer winding with half-turn
coils which are auto-arranged in the order of even, odd, even, odd,…, and even, odd, as long
as it is physically possible.
When a designer adopts single-layer whole-coiled windings, RMxprt will performwinding
arrangement optimization tominimize the average coil pitch. When asymmetric three-phase
windings are used, winding arrangement is optimized in such a way that minimumnegative-
sequence and zero-sequence components are achieved.

l Winding Editor Supporting Any Single- and Double-Layer Windings
Besides taking the great advantage of the winding auto-arrangement function in RMxprt,
users can also specify any special winding by using of theWinding Editor function.
InWinding Editor, throughmodification of phase belonging, number of turns, in-slot and out-
slot number of each coil, it is possible to design single- and double-layer winding arrangement
for any purposes.

l Analyze Air-GapMagnetic Field Distribution
For both uniform and non-uniform air gaps, Schwarz-Christopher Transformation is adopted
to solve for the air-gapmagnetic field distribution.

l Analyze EMFWaveform and Total Harmonic Distortion (THD)
Based on the analysis of the air-gapmagnetic field waveform, taking into account coil short
pitch, winding distribution, skew slot, winding connection, load effects and other factors, the
emf waveforms in the coils and the windings are analyzed to solve for the emf distortion
factors.

l Analyze Dynamic Parameters of DampingWinding
Different from the squirrel-cage winding of the inductionmachine, the damping winding of the
salient-pole synchronousmachine is located in the surface of magnetic field poles, which
deviates greatly along the d- and the q-axes. Furthermore, the connection of damping bars
has several forms. The bars under each pole could be connected, but not connected with
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those under other poles. All the bars could be connected together. The bars could be
connected through end-plate. RMxprt can deal with all those complicated situations and give
the dynamic parameters for the damping winding.

Related Topics

Setting Up Analysis Parameters for a Brushless PMDCMotor

Solution Data for Brushless PMDC Motors

To access the solution data, right-clickAnalysis in the project tree, and clickAdd Solution Setup.
For thismachine type, there is only one tab, theGeneral tab.
TheSolution Setupwindow contains the following fields:

Operation
Type

The operation type is automatically set toMotor for thismachine type.

Load Type Select fromConst Speed,Const Power,Const Torque, Linear Torque, and
Fan Load. The default isConst Power.

Rated Output
Power

Type a value for the rated output voltage, and select the units.

Rated Voltage Type a value for the rated voltage, and select the units.
Rated Speed Type a value for the rated speed, and select the units.
Operating
Temperature

Type a value for the operating temperature, and select the units.

Related Topics

Setting Up Analysis Parameters for a Brushless PMDCMotor

Switched Reluctance Motors

After you have selectedSwitched Reluctance Motors as your model type, define the following:
l General data, such as the power, voltage, and speed of themotor.
l Circuit data.
l Stator core data, such as the number of poles, diameter, and yoke thickness.
l Stator coil data, such as the slot liner thickness, number of parallel branches, and number of
wires in each conductor.

l Rotor core data, such as the air gap dimensions and number of poles in the rotor.
l Shaft data.
l Optional machine housing.
l Solution data.
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Analysis Approach for Switched Reluctance Motors

Thismotor type operateswith shaft position feedback to synchronize the commutation of the phase
currents with precise rotor position. Typically, both the stator and the rotor are salient to increase the
torque-producing characteristics of themotor. The rotor has no windings; the torque is produced by
the alignment tendency of the rotor to the stator so that the stator flux linkage ismaximized.
In thesemotors, the stator and rotor have different numbers of poles. The stator phase windings are
energized at precisemoments synchronized with the position of the rotor. The task of energizing the
stator windings is performed by a complex electronic system.
The number of phases in the winding is the ratio of the stator number of poles to the smallest
common divider of the stator and the rotor number of poles.
In switched reluctancemotors (SRM), the stator and the rotor have a different number of poles, and
the stator currents are commutated exactly according to rotor position. The signal of the rotor
position is obtained from a position sensor. The stator windings are triggered one by one, and
normally the current in a winding has finished or almost finished freewheeling when the next winding
is triggered. Therefore, themutual effects between two phases can be neglected. The voltage
equation of one phase is:

where uT is the transistor or diode voltage drop, andRs is the stator winding resistance. ( , i) is

the flux linkage of the winding at rotor position and winding current i, as is shown in Figure 8,
where the rotor position when the center of the rotor slot is aligned to the winding axis is defined as 0.
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where e is the rotor speed in electrical rad/s, and p is the differential operator as given by:

The instant electromagnetic torque t2 is:

The input electric power is computed from voltage and current as:

The output mechanical power is:

wherePfw, PCua, Pt, andPFe are frictional and wind loss, armature copper loss, transistor/diode
loss, and iron-core loss, respectively.
The average output mechanical shaft torque T2 is:

where is the rotor angular speed inmechanical rad/s.
The efficiency of the electricmachine is computed by:
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Defining a Switched Reluctance Motor

The general procedure for defining a switched reluctancemotor is as follows:
1. Insert a Switched Reluctancemotor into a new or existing project.
2. Double-click theMachine entry in the project tree to define the general data.
3. Double-click theMachine-Circuit entry in the project tree to define the control circuit.
4. Double-click theMachine-Stator entry in the project tree to define the stator geometry.
5. Double-click theMachine-Stator-Winding entry in the project tree to define the stator

windings and conductors.
6. Double-click theMachine-Rotor entry in the project tree to define the rotor geometry.
7. Double-click theMachine-Shaft entry in the project tree to define themagnetism of the shaft.
8. Optionally, right-click theMachine entry in the project tree and click Insert Housing to add a

machine housing.
9. Right-clickAnalysis in the project tree, and clickAdd Solution Setup to define the solution

data.
10. Choose File>Save to save the project.
11. ChooseRMxprt>Analyze to analyze the design.

Note When you place the cursor over an entry field in the data windows, a brief
description of that field appears in the status bar at the bottom of theRMxprt
window.

Once analyzed, themodel can be viewed in theMaxwell 2D Modeler, or it can be used to create a
new Maxwell 2D project, and a new Maxwell 3D project.
Please refer to theSwitched ReluctanceMotor Problem application note, on the technical support
page of the ANSYS web site, for a specific example.

Defining the General Data for a Switched Reluctance Motor

Use theGeneral window to define the power settings, speed, and period of themotor.
To define the general data:

1. To open theGeneral Data Propertieswindow, double-click theMachine entry in the project
tree on the desktop. (You can also enter values in theProperties section of the desktop
without opening a separate window.)
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2. Enter the energy loss due to friction at the given speed in the Frictional Loss field.
3. Enter the wind loss due to air resistancemeasured at the reference speed in theWind Loss

field.
4. Enter the given speed in theReference Speed field.
5. SelectDC orCCC from theControl Type pull-down list.
6. Select aCircuit Type from the following types:

l Full-
Voltage

l Half-
Voltage

l Coupled-
Coil

The circuit types are based on industry standards. By default, type Full-Voltage, is selected
as the circuit type.

Note When you place themouse cursor over a circuit type, an outline schematic of the circuit
appears.

7. ClickOK to close thePropertieswindow.

General Data for Switched Reluctance Motors

To access the general data, double-click theMachine entry in the project tree.
TheGeneral Data Propertieswindow for a three-phase inductionmotor contains the following
fields:

Machine
Type

Themachine type you selected when inserting a new RMxprt design (Switched
ReluctanceMotor).

Frictional
Loss

The frictional energy loss (due to friction) measured at the reference speed.

Wind
Loss

Thewind loss (due to air resistance) measured at the reference speed.

Reference
Speed

The given speed of reference.

Control
Type

Theway the circuit is controlled. Select fromDC orCCC (chopped current control,
which forces the current to fall between theminimumandmaximum values specified).

Circuit
Type

The drive circuit type. Click the button to open theCircuit Typewindow and select
from the following three types:

• Full-Voltage
•Half-Voltage
•Coupled-Coil
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Defining the Circuit Data for a Switched Reluctance Motor

Use theCircuit Data Properties window to specify the rated output power, voltage values, circuit
type, and speed of the brushlessDC motor.
To define the general data:

1. To open theCircuit Data Propertieswindow, double-click theMachine-Circuit entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter the trigger’s lead angle in electrical degrees in the Lead Angle of Trigger field. The
trigger angle is the point at which themagnetic poles interact to begin themotion of themotor.
An angle of 0means that each phase is triggered when its axis is aligned with the rotor slot
center. The trigger’s lead angle is shown in the following plot of the open circuit induced
voltage versus position. An angle of 0means that the induced voltage in the triggered phase is
at amaximum:

Note A positive value represents a lead angle, and a negative value represents a lag
angle.

3. Enter the period from on-status to off-status of a transistor, in electrical degrees, in the
Trigger Pulse Width field. The trigger pulse width is the width of the energizing pulse applied
to the winding, or the period for an ‘on’ status of the transistors. Themaximum ‘on’ period is
given by 180 degrees plus the value for the lead angle of trigger.

4. Enter the voltage drop across one transistor when the transistor is turned on in the Transistor
Drop field. Refer to the figures of the different circuit types in step 2. This value is over one
conduction path when the transistors are triggered.

5. Enter the voltage drop on all anti-parallel diodes in the discharge path in theDiode Drop field.
If you selected a star-type circuit (S3 or S4) as theCircuit Type, enter the total discharge
voltage in this field.
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6. If you selected CCC (chopped current control) as theControl Type, then enter themaximum
andminimum current values in theMaximum Current andMinimum Current fields.

7. ClickOK to close thePropertieswindow.

Circuit Data for Switched Reluctance Motors

To access theCircuit Data Propertieswindow, double-click theMachine>Circuit entry in the
project tree. WhenAC is selected at theControl Type, now circuit data properties exist.

Lead Angle of
Trigger

The trigger’s lead angle, in electrical degrees.

Trigger Pulse
Width

The period from on-status to off-status for a transistor, in electrical degrees.

Transistor Drop The voltage drop across one transistor when the transistor is turned on.
Diode Drop The voltage drop across one diode in the discharge loop.
Maximum
Current

Themaximum current for the chopped current control. This field is not
available for a DC circuit.

Minimum
Current

Theminimum current for the chopped current control. This field is not
available for a DC circuit.

Defining the Stator Data for a Switched Reluctance Motor

The stator is the outer lamination stackwhere the polyphase voltage windings reside.
To define the general stator data:

1. To open theStator Data Propertieswindow, double-click theMachine>Stator entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter theOuter Diameter of the stator.
3. Enter the Inner Diameter of the stator.
4. Enter the total length of the stator core in the Length field.
5. Enter the effectivemagnetic length of the core in the Stacking Factor field. This value

typically ranges from between 0.93 and 1.0, and is defined as the total lengthminus the total
lamination insulation, divided by the total length.

6. Select aSteel Type for the stator core:
a. Click the button for Steel Type.

TheSelect Definitionwindow appears.
b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

7. Enter the number of poles the stator core contains in theNumber of Poles field.

Getting Started with RMxprt 26-320
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

8. Enter the pole embrace in theEmbrace field. The pole embrace is the ratio of the actual pole
arc angle to themaximumpossible pole angle in the field. This value ranges from between 0
and 1.

9. Enter the thickness of the stator coil yoke in theYoke Thickness field.
10. ClickOK to close thePropertieswindow.

Stator Data for Switched Reluctance Motors

To access the general stator data, double-click theMachine>Stator entry in the project tree.
TheStator Data Propertieswindow contains the following fields:

Outer
Diameter

The outer diameter of the stator core.

Inner Diameter The inner diameter of the stator core.
Length The length of the stator core.
Stacking
Factor

The stacking factor of the stator core.

Steel Type The steel type of the stator core. Click the button to open theSelect Definition
window.

Number of
Poles

The number of poles the stator core contains.

Embrace The stator pole embrace.
Yoke
Thickness

The thickness of the yoke at the stator core.

Defining the Stator Winding Data for a Switched Reluctance Motor

The stator coils provide the excitation for the rotatingmagnetic poles.
Use theStator Coilwindow to define the parallel branches, wire specifications, and slot liner for the
stator coil.
To define the stator coils:

1. To open theStator Slot Winding Propertieswindow, double-click theMachine-Stator-
Winding entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Enter the thickness of the insulation between the stator core and the field winding in the
Insulation Thickness field.

3. Enter the end length adjustment of the stator coils in theEnd Adjustment field. The end
adjustment is the distance one end of the conductor extends vertically beyond the end of the
stator.
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4. Select or enter the number of parallel branches in one phase of the winding in theParallel
Branches field.

5. Enter the number of turns per stator pole in the Turns per Pole field.
6. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to have

RMxprt auto-design this value.
7. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to

automatically obtain this value from the wire library.

8. Select theWire Size:
a. Click the button forWire Size.

TheWire Sizewindow appears.
b. Select a value from theWire Diameter pull-down list.
c. Select a wire gauge from theGauge pull-downmenu. You can select from the following

options:

<number>
You can select a specific gauge number. When you select a
gauge number, theWire Diameter field is automatically
updated.

Getting Started with RMxprt 26-322
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

USER
This option allows you tomanually enter theWire
Diameter. This is useful when you want to enter a diameter
that does not correspond to a particular wire gauge.

AUTO

This option sets theWire Diameter to zero, and RMxprt
automatically calculates the optimal value. The diameter
information is then written to the output file when you
analyze the design.

MIXED

This option allows you to define a conductor that ismade of
different size wires. For example, a single conductor may
consist of 5 wires, 3 wires with a diameter of 0.21mmand 2
with a diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.

a. When you are done setting the wire size, clickOK to close theWire Sizewindow and
return to thePropertieswindow.

b. Enter the conductor area ratio of the coupled circuit to themain circuit in theCoupled Ratio
field.

c. ClickOK to close thePropertieswindow.

Defining Different Size Wires for a Switched Reluctance Motor

Use theGauge option in theWire Size window if you have a conductor that ismade up different
size wires.
To define different size wires:

1. In theWire Size window, selectMIXED from theGauge pull-downmenu.
2. Select eitherRound orRectangular as theWire Type.
3. Enter the appropriate wire data in the table:

l For a round wire:
l Enter theDiameter in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
diameter.

l For a rectangular wire:
l Enter theWidth of the wire in the table.
l Enter the Thickness of the wire in the table.
l Enter the Fillet value in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this data.

4. ClickAdd to add the new wire data.
5. Repeat steps 3 and 4 for each size wire you want to add.
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6. When you are finished defining the wires, clickOK to close theWire Sizewindow and return
to the RMxprtPropertieswindow.
Note For example, if one conductor ismade up of 5 wires, and 3 of those wires have a

diameter of 0.21mm, and the other 2 have a diameter of 0.13mm, then themixed
wire size table will have two lines. The first line will list Diameter = 0.21 and Number
= 3. The second line will list Diameter = 0.13 and Number = 2. An equivalent wire
diameter is displayed asWire Size value in theWinding tab in the Properties
window.

Stator Winding Data for Switched Reluctance Motors

To access the stator winding data, double-click theMachine-Stator-Winding entry in the project
tree.
TheStator Winding Data Propertieswindow contains the following fields:

Insulation
Thickness

The thickness of the insulation between the stator core and the field winding.

End
Adjustment

The end length adjustment of the stator coils, which is the distance one end of the
conductor extends vertically beyond the end of the stator.

Parallel
Branches

The number of parallel branches in the stator winding.

Turns per
Pole

The number of turns per stator pole (0 for auto-design).

Number of
Strands

The number of wires per conductor (0 for auto-design).

Wire Wrap The thickness of the double-sided wire wrap (0 to automatically obtain this value
from the wire library).

Wire Size The diameter of the wire (0 for auto-design). Click the button to open theWire Size
window where you can specify units, wire type, diameter, and gauge.

Coupled
Ratio

The conductor area ratio of the coupled circuit to themain circuit.

Defining the Rotor Data for a Switched Reluctance Motor

The rotor core channels the flux generated by stator windings and provides shaft torque. The rotor
consists of copper bars in which current is induced by themagnetic fields produced by the stator
windings. Use theRotor Data Properties window to define the air gaps, rotor dimensions, and
type of steel used in the rotor core. In the project tree, double-clickMachine>Rotor to define the
rotor.
To define general rotor data:
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1. To open theRotor Data Propertieswindow, double-click theMachine>Rotor entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter the outer diameter of the rotor in theOuter Diameter field.
3. Enter the inner diameter of the rotor in the Inner Diameter field.
4. Enter the length of the rotor core in the Length field.
5. Select aSteel Type for the rotor core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

6. Enter the effectivemagnetic length of the core in the Stacking Factor field. This value ranges
from 0 to 1, and is defined as the total lengthminus the total lamination insulation, divided by
the total length.

7. Enter the number of poles the rotor core contains in theNumber of Poles field.
8. Enter the ratio of the actual pole angle in relation to themaximumpossible pole angle in the

Embrace field. The value ranges from 0 to 1.
9. Enter the thickness of the rotor yoke in theYoke Thickness field.
10. ClickOK to close thePropertieswindow.

Rotor Data for Switched Reluctance Motors

To access the general rotor data, double-click theMachine-Rotor entry in the project tree.
TheRotor Data Propertieswindow contains the following fields:

Outer
Diameter

The outer diameter of the rotor core.

Inner Diameter The inner diameter of the rotor core.
Length The length of the rotor core.
Steel Type The steel type of the rotor core. Click the button to open theSelect Definition

window.
Stacking
Factor

The stacking factor of the rotor core.

Number of
Poles

The number of poles the rotor core contains.

Embrace The rotor pole embrace.
Yoke
Thickness

The thickness of the rotor core yoke.
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Defining the Shaft Data for a Switched Reluctance Motor

To define the shaft:
1. To open theShaft Data Propertieswindow, double-click theMachine>Shaft entry in the

project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Select or clear theMagnetic Shaft check box to specify whether or not the shaft is to be
made of magneticmaterial.

3. ClickOK to close thePropertieswindow.

Shaft Data for Switched Reluctance Motors

To access the shaft data, double-click theMachine-Shaft entry in the project tree.
TheShaft Data Propertieswindow contains the following fields:

Magnetic
Shaft

Select or clear this check box to indicate whether or not the shaft ismade of
magneticmaterial.

Setting Up Analysis Parameters for a Switched Reluctance Motor

To define the solution data:
1. To open the Solution Setup window, right-clickAnalysis in the project tree, and clickAdd

Solution Setup.
2. Click theGeneral tab. TheOperation Type is automatically set toMotor for thismachine

type.
3. Select the Load Type used in themotor from the following options:

Const
Speed

The speed remains constant in themotor.

Const
Power

The output power remains constant in themotor.

Const
Torque

The torque remains constant regardless of the speed. In this case, Tload = Trated,
given by the output power divided by the given rated speed.

Linear
Torque

The torque increases linearly with speed. In this case, Tload = Trated * (n/nrated)
where Trated is given by the output power divided by the given rated speed.

Fan
Load

The load varies nonlinearly with speed. In this case, Tload = Trated * (n/nrated)2
where Trated is given by the output power divided by the given rated speed.

4. Enter the output power developed at the shaft of themotor in theRated Output Power field.
5. Enter the RMS line-to-line voltage in theRated Voltage field.
6. Enter the desired output speed of themotor at the load point in theRated Speed field.
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7. Enter the temperature at which the system functions in theOperating Temperature field.
8. ClickOK to close theSolution Setupwindow.

Related Topics

Solution Data for Switched ReluctanceMotors

Solution Data for Switched Reluctance Motors

To access the solution data, right-clickAnalysis in the project tree, and clickAdd Solution Setup.
For thismachine type, there is only one tab, theGeneral tab.
TheSolution Setupwindow contains the following fields:

Operation
Type

The operation type is automatically set toMotor for thismachine type.

Load Type Select fromConst Speed,Const Power,Const Torque, Linear Torque, and
Fan Load. The default isConst Power.

Rated Output
Power

Type a value for the rated output voltage, and select the units.

Rated Voltage Type a value for the rated voltage, and select the units.
Rated Speed Type a value for the rated speed, and select the units.
Operating
Temperature

Type a value for the operating temperature, and select the units.

Related Topics

Setting Up Analysis Parameters for a Switched ReluctanceMotor

Line-Start Permanent-Magnet Synchronous Motors

Once you have selected Line-Start Permanent-Magnet Synchronous Motors as your motor
type, you can define the following:

l General data, such as the frequency, winding connection, number of poles, and voltage.
l Stator data, such as the slot type and dimensions, stator diameter, and winding data.
l Rotor pole data, such as its associated dimensions, stacking factor, andmagnet type.
l Shaft data.
l Solution data.

By option, you can:
l add amachine housing.
l add a vent to or remove an existing vent from a stator,
l add a damper to or remove a damper from a rotor.
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Analysis Approach for Line-Start PM Synchronous Motors

Synchronousmotors use a three-phase sinusoidal voltage source to induce a rotatingmagnetic field
in the stator. Applying this three-phase sinusoidal voltage source to the stator winding of a
synchronousmotor yields the rotational magnetic field in the air gap. The permanent magnet poles
mounted on the rotor try to align in this rotating field, producing a synchronous torque on the rotor.
Upon starting, the damping winding on the rotor generates the asynchronous starting torque,
creating a self-starting feature.
The phasor diagram for the line-start permanent-magnet synchronousmotor (LSSM) in the
frequency domain is shown in Figure 6.

In Figure 6,R1, Xd, andXq are armature resistance, d-axis synchronous reactance, and q-axis
synchronous reactance, respectively.Xd is the sum of leakage reactance,X1 and d-axis armature
reactanceXad, andXq is the sum of X1 and q-axis armature reactanceXaq:

For a given torque angle , the angle that E0 lagsU, we have the following:
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Solving for Id and Iq yields:

The angle that I legsE0 is:

The power factor angle (or torque angle) that I legsU, is:

The input power (electric power) can now be computed from voltage and current as:

Getting Started with RMxprt 26-329
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

The output power (mechanical power) is:

wherePfw, PCu, andPFe are frictional and wind loss, armature copper loss, and iron-core loss,
respectively.
The output mechanical power (torque) T2 is:

where is the synchronous speed in rad/s.
The efficiency is computed by:

Themotor is started the sameway as for an inductionmotor, by using a squirrel-cage-type winding --
called a damper winding in this case -- that ismounted on the rotor, producing the starting torque.

Defining a Line-Start Permanent Magnet Synchronous Motor

The general procedure for defining a line-start synchronousmotor is as follows:
1. Insert a line-start synchronousmotor into a new or existing project.
2. Double-click theMachine entry in the project tree to define the general data.
3. Double-click theMachine-Stator entry in the project tree to define the stator geometry.
4. Double-click theMachine-Stator-Slot entry in the project tree to define the stator slot

dimensions.
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5. Double-click theMachine-Stator-Winding entry in the project tree to define the stator
windings and conductors.

6. Double-click theMachine-Rotor entry in the project tree to define the rotor geometry.
7. Double-click theMachine-Rotor-Pole entry in the project tree to define the pole, embrace,

offset, and air gap data for the rotor pole.
8. Double-click theMachine-Shaft entry in the project tree to define themagnetism of the shaft.
9. Optionally, right-click theMachine entry in the project tree and click Insert Housing to add a

machine housing.
10. Right-clickAnalysis in the project tree, and clickAdd Solution Setup to define the solution

data.
11. Choose File>Save to save the project.
12. ChooseRMxprt>Analyze to analyze the design.

Note When you place the cursor over an entry field in the data windows, a brief
description of that field appears in the status bar at the bottom of theRMxprt
window.

Once analyzed, themodel can be viewed in theMaxwell 2D Modeler, or it can be used to create a
new Maxwell 2D project, and a new Maxwell 3D design.

Defining the General Data for a Line-Start PM Synchronous Motor

Use theGeneral window to define the basic parameters of themotor, such as themotor’s rated
output power, rated voltage, losses, and connection type.
To define the general data:

1. To open theGeneral Data Propertieswindow, double-click theMachine entry in the project
tree on the desktop. (You can also enter values in theProperties section of the desktop
without opening a separate window.)

2. Enter the number of poles for themachine in theNumber of Poles field. This value is the total
number of poles in the stator (or the number of pole pairsmultiplied by two).

3. Enter the energy loss due to friction at the given speed in the Frictional Loss field.
4. Enter the wind loss due to air resistancemeasured at the reference speed in theWind Loss

field.
5. Enter the given speed in theReference Speed field.
6. ClickOK to close thePropertieswindow.

General Data for Line-Start PM Synchronous Motors

To access the general data, double-click theMachine entry in the project tree.
TheGeneral Data Propertieswindow for a three-phase inductionmotor contains the following
fields:
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Machine
Type

Themachine type you selected when inserting a new RMxprt design (Line-Start
PMSynchronousMotor).

Number of
Poles

The number of poles themachine contains.

Frictional
Loss

The frictional energy loss (due to friction) measured at the reference speed.

Wind Loss Thewind loss (due to air resistance) measured at the reference speed.
Reference
Speed

The given speed of reference.

Defining the Stator Data for a Line-Start PM Synchronous Motor

The stator is the outer lamination stackwhere the polyphase voltage windings reside.
Use theStator Data, Stator Slot Data, andStator Winding Data windows to define the stator
data, such as physical dimensions of the lamination, windings, and conductors.
To define the general stator data:

1. To open theStator Data Propertieswindow, double-click theMachine>Stator entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter theOuter Diameter of the stator.
3. Enter the Inner Diameter of the stator.
4. Enter the length of the stator core in the Length field.
5. Enter the effectivemagnetic length of the core in the Stacking Factor field.
6. Select aSteel Type for the stator core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

7. Enter theNumber of Slots in the stator.
8. Select theSlot Type:

a. Click the button for theSlot Type.
TheSelect Slot Typewindow appears.

b. Select a slot type (available types include 1 through 4).
Note When you place themouse cursor over the slot type, a schematic of the selected

type appears, displaying the slot dimension variables.

c. ClickOK to close theSelect Slot Type window and return to thePropertieswindow.
9. Enter the skew width, measured in slot number, in theSkew Width field.
10. ClickOK to close thePropertieswindow.
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Stator Data for Line-Start PM Synchronous Motors

To access the general stator data, double-click theMachine>Stator entry in the project tree.
TheStator Data Propertieswindow contains the following fields:

Outer
Diameter

The outer diameter of the stator core.

Inner
Diameter

The inner diameter of the stator core.

Length The length of the stator core.
Stacking
Factor

The stacking factor of the stator core.

Steel Type The steel type of the stator core. Click the button to open theSelect Definition
window.

Number of
Slots

The number of slots the stator core contains.

Slot Type The type of slots in the stator core. Click the button to open theSelect Slot Type
window.

Skew Width The skew widthmeasured in slot number.

Defining the Stator Slots for a Line-Start PM Synchronous Motor

To define the slot type:
1. To open theStator Slot Data Propertieswindow, double-click theMachine-Stator-Slot

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Optionally, to automatically design the dimensions of slotsHs2,Bs1, andBs2, select the
Auto Design check box.

3. Optionally, to design dimensions of slotsBs1 andBs2 based on the stator tooth width, select
theParallel Tooth check box, and enter a value in the Tooth Width field.
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4. Enter the available slot dimensions.
Hs0 Always available.
Hs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.
Bs0 Always available.
Bs1 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto

Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

Bs2 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto
Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

Rs Rs is added when the slot type is 3 or 4.

5. ClickOK to close thePropertieswindow.

Stator Slot Data for Line-Start PM Synchronous Motors

To access the stator slot data, double-click theMachine-Stator-Slot entry in the project tree.
TheStator Slot Data Propertieswindow contains the following fields:

Auto
Design

Select or clear this to enable or disable auto-design of slotsHs2,Bs1, andBs2. When
this check box is selected, only two other fields appear in the window:Hs0 andBs0.

Parallel
Tooth

Select this to designBs1 andBs2 based on the tooth width. When this check box is
selected, theBs1 andBs2 fields are removed, and the Tooth Width field is added.

Tooth
Width

The tooth width for the parallel tooth, on whichBs1 andBs2 are designed.

Hs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Hs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Hs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Rs A slot dimension. (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected). Rs is added when the slot type is 3 or 4.
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Defining the Stator Windings and Conductors for a Line-Start PM Synchronous Motor

To define the stator windings and conductors:
1. To open theStator Slot Winding Propertieswindow, double-click theMachine-Stator-

Winding entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Click theWinding tab.
3. Enter the number of layers in the stator winding in theWinding Layers field.
4. Select theWinding Type for the stator:

a. Click the button forWinding Type.
TheWinding Typewindow appears.

b. Select from one of the following three types of winding:
l Whole Coiled
l Half Coiled
l Editor

Note When you place themouse cursor over the winding type, a schematic of that
type appears.

c. ClickOK to close theWinding Typewindow and return to thePropertieswindow.
5. Select or enter the number of parallel branches in one phase of the winding in theParallel

Branches field.
6. Enter the total number of conductors in each stator slot in theConductors per Slot field. This

value is the number of turns per coil multiplied by the number of layers.
7. Enter the coil pitch, measured in number of slots, in theCoil Pitch field. The coil pitch is the

number of slots separating one winding. For example, if a coil starts in slot 1 and ends in slot 6,
it has a coil pitch of 5.

8. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to have
RMxprt auto-design this value.

9. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to
automatically obtain this value from the wire library.
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10. Select theWire Size:
a. Click the button forWire Size.

TheWire Sizewindow appears.
b. Select a value from theWire Diameter pull-down list.
c. Select a wire gauge from theGauge pull-downmenu. You can select from the following

options:

<
number>

You can select a specific gauge number. When you select a
gauge number, theWire Diameter field is automatically
updated.

USER
This option allows you tomanually enter theWire Diameter.
This is useful when you want to enter a diameter that does not
correspond to a particular wire gauge.

AUTO

This option sets theWire Diameter to zero, and RMxprt
automatically calculates the optimal value. The diameter
information is then written to the output file when you analyze the
design.

MIXED

This option allows you to define a conductor that ismade of
different size wires. For example, a single conductor may consist
of 5 wires, 3 wires with a diameter of 0.21mmand 2 with a
diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.

d. When you are done setting the wire size, clickOK to close theWire Sizewindow and
return to thePropertieswindow.

e. Click theEnd/Insulation tab.
f. Select or clear the Input Half-turn Length check box.
g. Do one of the following:
l If you selected Input Half-turn Length, then enter the half-turn length of the armature
winding in the Half Turn Length field.
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l If you cleared Input Half-turn Length, then enter the end length adjustment of the stator
coils in theEnd Adjustment field. The end adjustment is the distance one end of the
conductor extends vertically beyond the end of the stator.

11. Enter the inner radius of the base corner in theBase Inner Radius field.
12. Enter the inner diameter of the coil tip in the Tip Inner Diameter field.
13. Enter the distance between two stator coils in theEnd Clearance field.
14. Enter the thickness of the slot liner insulation in theSlot Liner field.

15. Enter the thickness of the wedge insulation in theWedge Thickness field.
16. Enter the thickness of the insulation layer in the Layer Insulation field.
17. Enter the limited slot fill factor for the wire design in the Limited Fill Factor field. The slot fill

factor is the ratio between the cross-sectional area of all conductors in one slot and the entire
slot area.

18. ClickOK to close thePropertieswindow.
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Winding Editor for a Line-Start Synchronous Motor

For a line-start synchronousmotor, youmaywant to specify a different number of conductors for
each stator slot. TheWinding Editor makes this possible by enabling you to specify the number of
turns for each coil.
To specify the number of turns for each coil:

1. ClickMachine>Winding>Edit Layout.
TheWinding Editor window appears.

2. In the table in the upper left, set which phase you want for each coil and which slot is the “in”
and “out” slot for the current in each coil.

3. If you are working on a quarter or half model, youmaywant to specify amultiplier by clicking
thePeriodic Multiplier check box and specifying a value.

4. Select or deselect theConstant Turns orConstant Pitch check boxes, depending on
whether you want to be able to change these setting in the table above.When these options
are selected, you cannot change the turns or pitch.

5. When you are satisfied with the coil settings, clickOK to close theWinding Editor window.

Defining Different Size Wires for a Line-Start Synchronous Motor

Use theGauge option in theWire Sizewindow if you have a conductor that ismade up different
size wires.
To define different size wires:

1. In theWire Size window, selectMIXED from theGauge pull-downmenu.
2. Select eitherRound orRectangular as theWire Type.
3. Enter the appropriate wire data in the table:

l For a round wire:
l Enter theDiameter in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
diameter.

l For a rectangular wire:
l Enter theWidth of the wire in the table.
l Enter the Thickness of the wire in the table.
l Enter the Fillet value in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this data.

4. ClickAdd to add the new wire data.
5. Repeat steps 3 and 4 for each size wire you want to add.
6. When you are finished defining the wires, clickOK to close theWire Sizewindow and return

to the RMxprtPropertieswindow.
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Note For example, if one conductor ismade up of 5 wires, and 3 of those wires have a
diameter of 0.21mm, and the other 2 have a diameter of 0.13mm, then themixed
wire size table will have two lines. The first line will list Diameter = 0.21 and Number
= 3. The second line will list Diameter = 0.13 and Number = 2. An equivalent wire
diameter is displayed asWire Size value in theWinding tab in the Properties
window.

Stator Winding Data for Line-Start PM Synchronous Motors

To access the stator winding data, double-click theMachine-Stator-Winding entry in the project
tree.
TheStator Winding Data Propertieswindow contains the following fields:

Winding tab Winding Layers The number of winding layers.
Winding Type The type of stator winding. Click the

button to open theWinding Type
window and choose fromWhole
Coiled,Half Coiled, andEditor.

Parallel Branches The number of parallel branches in the
stator winding.

Conductors per Slot The number of conductors per stator slot
(0 for auto-design).

Coil Pitch The coil pitchmeasured in number of
slots.

Number of Strands The number of wires per conductor (0 for
auto-design).

Wire Wrap The thickness of the double-sided wire
wrap (0 to automatically obtain this value
from the wire library).

Wire Size The diameter of the wire (0 for auto-
design). Click the button to open the
Wire Sizewindow where you can
specify units, wire type, diameter, and
gauge.

End/Insulation tab Input Half-turn Length Select or clear this check box to specify
whether or not you want to enter the
half-turn length. When this check box is
selected, theHalf Turn Length field
appears the next time you open the
Propertieswindow.When this check
box is selected, theEnd Adjustment
field appears instead.
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Half Turn Length The half-turn length of the armature
winding.

End Adjustment The end length adjustment of the stator
coils, which is the distance one end of
the conductor extends vertically beyond
the end of the stator.

Base Inner Radius The inner radius of the base corner.
Tip Inner Diameter The inner diameter of the coil tip.
End Clearance The end clearance between two

adjacent coils.
Slot Liner The thickness of the slot liner insulation.
Wedge Thickness The thickness of the wedge insulation.
Layer Insulation The thickness of the insulation layer.
Limited Fill Factor The limited slot fill factor for the wire

design. The slot fill factor is the ratio
between the cross-sectional area of all
conductors in one slot and the entire slot
area.

Optional Vent for Line-Start PM Synchronous Motor Stator

To add a Vent to the stator, select the stator icon and right-click to display the pop-upmenuwith
Insert Vent.
The vent is shown in the project tree under the stator.
To remove an existing Vent, select the stator and right-click to display the up-upmenuwithRemove
Vent.
The Vent Data properties window contains the following fields.
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Vent Ducts Number of radial vent ducts
Duct Width Width of radial vent ducts
Magnetic spacer
width

Width of magnetic spacer which hold vent ducts. 0 for non-magnetic
spacer.

Duct pitch Vent ducts.

Defining the Rotor Data for a Line-Start PM Synchronous Motor

The rotor consists of copper bars in which current is induced by themagnetic fields produced by the
stator windings. In the project tree, double-clickMachine-Rotor andMachine-Rotor-Pole to
define the rotor and the pole.
To define general rotor data:

1. To open theRotor Data Propertieswindow, double-click theMachine>Rotor entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter the outer diameter of the rotor in theOuter Diameter field.
3. Enter the inner diameter of the rotor in the Inner Diameter field.
4. Enter the length of the rotor core in the Length field.
5. Select aSteel Type for the rotor core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

6. Enter the effectivemagnetic length of the rotor core in the Stacking Factor field. This value
ranges from 0 to 1 and is defined as the total lengthminus the total lamination insulation,
divided by the total length. A value of 1 indicates that the rotor is not laminated.

7. Select aPole Type:
a. Click the button.

TheSelect Pole Typewindow appears.
b. Click a button to select the desired pole type (1, 2, 3, 4, 5, 6, 7, or 8). TIP:When you run

themouse over each option, the diagram changes to show that pole type.
Note When you place themouse cursor over a pole type, an outline of the selected

circuit type appears.

c. ClickOK to close theSelect Pole Typewindow and return to thePropertieswindow.
8. ClickOK to close thePropertieswindow.

Rotor Data for Line-Start PM Synchronous Motors

To access the general rotor data, double-click theMachine>Rotor entry in the project tree.
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TheRotor Data Propertieswindow contains the following fields:

Outer
Diameter

The outer diameter of the rotor core.

Inner
Diameter

The inner diameter of the rotor core.

Length The length of the rotor core.
Steel
Type

The steel type of the rotor core. Click the button to open theSelect Definitionwindow.

Stacking
Factor

The stacking factor of the rotor core.

Pole
Type

The pole type for the rotor. Click this button to open theSelect Pole Typewindow and
select from the following types: 1, 2, 3, 4, 5, 6, 7, 8. When youmouse over each button,
a diagram appears for that pole type, showing the arrangement and dimensions.

Defining the Rotor Pole for a Line-Start PM Synchronous Motor

The rotor pole drives the electromagnetic field which is coupled with the stator windings. Use the
Rotor Pole Data Properties window to define the rotor pole.

Note Some of the fields in theRotor Pole window change, or are inactive, depending on the
Rotor Type you select.

To define the rotor pole:
1. To open theRotor Pole Data Propertieswindow, double-click theMachine-Rotor-Pole

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Enter the limited diameter for themagnet ducts in theD1 field.
3. Enter one or more of the followingmagnet duct dimensions, depending on the pole type

selected:O1,O2,B1.
4. For all pole types except number 8, enter the width of the rib supporting the bridge in theRib

field.
5. Select the type of magnet to use in the rotor pole:

a. ClickMagnet Type button.
TheSelect Definitionwindow appears.

b. Select amaterial.
c. ClickOK to close theSelect Definitionwindow and return to thePropertieswindow.

6. Enter the total width of all magnets per pole in theMagnet Width field.
7. Enter themaximum radial thickness of themagnet in theMagnet Thickness field.
8. ClickOK to close thePropertieswindow.
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Rotor Pole Data for Line-Start PM Synchronous Motors

To access the pole rotor data, double-click theMachine-Rotor-Pole entry in the project tree.
TheRotor Pole Data Propertieswindow contains the following fields:

D1 The limited diameter for themagnet ducts. See the diagrams in theSelect Pole Type
window for the location of each dimension and which pole types require which
dimensions.

O1 Amagnet duct dimension. See the diagrams in theSelect Pole Typewindow for the
location of each dimension and which pole types require which dimensions.

O2 Amagnet duct dimension. See the diagrams in theSelect Pole Typewindow for the
location of each dimension and which pole types require which dimensions.

B1 Amagnet duct dimension. See the diagrams in theSelect Pole Typewindow for the
location of each dimension and which pole types require which dimensions.

Rib Thewidth of the rib at the center of two adjacent poles that support the bridge. For
pole types except number 8.

Magnet
Type

The type of magnet. Click the button to open theSelect Definitionwindow. For all
pole types.

Magnet
Width

Themaximumwidth of themagnet. For all pole types.

Magnet
Thickness

Themaximum thickness of themagnet. For all pole types.

Optional Rotor Damper for Line-Start PM Synchronous Motor

l To add a damper, right-click on the rotor item in the project tree to display the pop-upmenu
with Insert Damper.

l To remove an existing damper, right-click on the rotor icon in the project tree to display the
shortcut menu withRemove Damper.

TheDamper Data properties window contains the following fields.

Damper Slots
per Pole

Number of damper slots per pole.

Slot Type Damper slot type. Click the field button open the Slot selection window and
select one of the four types.

Cast Rotor. Specify whether the rotor squirrel cage winding is cast.
Bar conductor
type

Click the field button to open theMaterials Selection window to specify the
material for the bar conductor.

End Length Single side end extended bar length
End Ring Width Axial width of end ring.
End Ring Height Radial height of end ring
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End Ring
Conductor type

Click the field button to open theMaterials Selection window to specify the
material for the end ring conductor.

Defining the Shaft Data for a Line-Start PM Synchronous Motor

To define the shaft:
1. To open theShaft Data Propertieswindow, double-click theMachine-Shaft entry in the

project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Select or clear theMagnetic Shaft check box to specify whether or not the shaft is to be
made of magneticmaterial.

3. ClickOK to close thePropertieswindow.

Shaft Data for Line-Start PM Synchronous Motors

To access the shaft data, double-click theMachine-Shaft entry in the project tree.
TheShaft Data Propertieswindow contains the following fields:

Magnetic
Shaft

Select or clear this check box to indicate whether or not the shaft ismade of
magneticmaterial.

Setting Up Analysis Parameters for a Line-Start PM Synchronous Motor

To define the solution data:
1. To open the Solution Setup window, right-clickAnalysis in the project tree, and clickAdd

Solution Setup.
2. Click theGeneral tab. TheOperation Type is automatically set toMotor for thismachine

type.
3. Select the Load Type used in themotor from the following options:

Const
Speed

The speed remains constant in themotor.

Const
Power

The output power remains constant in themotor.

Const
Torque

The torque remains constant regardless of the speed. In this case, Tload = Trated,
given by the output power divided by the given rated speed.

Linear
Torque

The torque increases linearly with speed. In this case, Tload = Trated * (n/nrated)
where Trated is given by the output power divided by the given rated speed.

Fan
Load

The load varies nonlinearly with speed. In this case, Tload = Trated * (n/nrated)2
where Trated is given by the output power divided by the given rated speed.

4. Enter the output power developed at the shaft of themotor in theRated Output Power field.
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5. Enter the RMS line-to-line voltage in theRated Voltage field.
6. Enter the desired output speed of themotor at the load point in theRated Speed field.
7. Enter the temperature at which the system functions in theOperating Temperature field.
8. Click the Line-Start PM Synchronous Motor tab.
9. SelectWye orDelta from theWinding Connection pull-down list.
10. ClickOK to close theSolution Setupwindow.

Related Topics

Solution Data for Line-Start PMSynchronousMotors

Solution Data for Line-Start PM Synchronous Motors

To access the solution data, right-clickAnalysis in the project tree, and clickAdd Solution Setup.
For thismachine type, there is only one tab, theGeneral tab.
TheSolution Setupwindow contains the following fields:

Operation
Type

General tab. The operation type is automatically set toMotor for thismachine
type.

Load Type General tab. Select fromConst Speed,Const Power,Const Torque, Linear
Torque, and Fan Load. The default isConst Power.

Rated Output
Power

General tab. Type a value for the rated output voltage, and select the units.

Rated
Voltage

General tab. Type a value for the rated voltage, and select the units.

Rated Speed General tab. Type a value for the rated speed, and select the units.
Operating
Temperature

General tab. Type a value for the operating temperature, and select the units.

Winding
Connection

Line-Start PM Synchronous Motor tab. SelectWye orDelta from the
Winding Connection pull-down list.

Related Topics

Setting Up Analysis Parameters for a Line-Start PMSynchronousMotor

Universal Motors

After you have selectedUniversal Motors as your model type, enter themotor data to define the
following:

l General data, such as the number of poles, frictional loss, and reference speed.
l Stator pole and winding data, such as its associated pole dimensions, type of steel, and wire
definitions.
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l Rotor data, such as the slot types and dimensions, rotor diameter, laminations, and windings
and conductors.

l Commutator and brush data, such as the commutator dimensions and brush length.
l Shaft data.
l Optional machine housing.
l Solution data.

Analysis Approach for Universal Motors

For a DC motor, if its field winding is connected in series with its armature winding, it becomes a
seriesmotor. When the polarity of the terminal voltage changes, the direction of the produced
electromagnetic torque does not change because the armature and the exciting currents alternate
their directions at the same time. That means themotor can operate not only with a DC source but
also with an AC source. Because it can operate with both DC and AC sources, a seriesmotor is also
called universal motor (UniM).
For a universal motor, the stator is equipped with p pairs of coil-wound poles, creatingP pairs of
alternating north and south poles. The coil excitationmay be either AC or DC. The rotor is equipped
with a distributed winding connected to a commutator that revolves together with the rotor.
A system of brushes is kept in permanent electrical contact with the commutator. When AC or DC
current is applied to the rotor winding (via the brushes and commutator) a torque is produced by the
interaction of the rotor (armature) currents and the field produced by the stator poles.
The commutator causes the armature to create amagnetic flux distribution whose axis is
perpendicular to the axis of the field flux produced by the permanent magnets. For thesemotors, the
commutator acts as amechanical rectifier.
The performance of a universal motor is analyzed in the frequency domain. The voltage equation of
a universal motor is:

where,Ra,Rf, andRb are the armature resistance, field winding resistance, and the brush contact
resistance, respectively. La, Lf, andMaf are the armature self inductance, field winding self
inductance, and their mutual inductance, respectively, and are linearized nonlinear parameters. Gaa
andGaf are the coefficients of motion induced voltages by the armature and field winding currents,

respectively, and are also linearized nonlinear parameters. is the radian frequency, and e the
rotor speed in electric rad/s. Z is equivalent input impedance.When the brush axis is aligned with q-
axis:
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For a given rotor speed e, armature current can be computed based on the applied voltageU, as:

The input power (electric power) is directly computed from voltage and current as:

The output power (mechanical power) is:

wherePfw, Pb, Pcua, Pcuf, andPFe are frictional and wind loss, brush drop loss, armature copper
loss, field winding copper loss, and iron-core loss, respectively.
The output mechanical shaft torque T2 is:

The efficiency is computed by:
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Defining a Universal Motor

The general procedure for defining a universal motor is as follows:
1. Insert a universal motor into a new or existing project.
2. Double-click theMachine entry in the project tree to define the general data.
3. Double-click theMachine-Stator entry in the project tree to define the stator geometry.
4. Double-click theMachine-Stator-Pole entry in the project tree to define the stator pole

dimensions.
5. Double-click theMachine-Stator-Winding entry in the project tree to define the stator

windings and conductors.
6. Double-click theMachine-Rotor entry in the project tree to define the rotor geometry.
7. Double-click theMachine-Rotor-Slot entry in the project tree to define the rotor slot

dimensions.
8. Double-click theMachine-Rotor-Winding entry in the project tree to define the rotor

windings and conductors.
9. Double-click theMachine-Commutator entry in the project tree to define the commutator

and brush data.
10. Double-click theMachine-Shaft entry in the project tree to define themagnetism of the shaft.
11. Optionally, right-click theMachine entry in the project tree and click Insert Housing to add a

machine housing.
12. Right-clickAnalysis in the project tree, and clickAdd Solution Setup to define the solution

data.
13. Choose File>Save to save the project.
14. ChooseRMxprt>Analyze to analyze the design.

Note When you place the cursor over an entry field in the data windows, a brief
description of that field appears in the status bar at the bottom of theRMxprt
window.
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Once analyzed, themodel can be viewed in theMaxwell 2D Modeler, or it can be used to create a
new Maxwell 2D project, and a new Maxwell 3D design.
Refer to theUniversal Motor Problem application note, on the technical support page of the ANSYS
web site, for a specific example.

Defining the General Data for a Universal Motor

Use theGeneral window to define the basic parameters of the universal motor such as the power
settings, speed, and rated voltage.
To define the general data:

1. To open theGeneral Data Propertieswindow, double-click theMachine entry in the project
tree on the desktop. (You can also enter values in theProperties section of the desktop
without opening a separate window.)

2. Enter the number of poles for themachine in theNumber of Poles field. This value is the total
number of poles in the stator (or the number of pole pairsmultiplied by two).

3. Enter the energy loss due to friction at the given speed in the Frictional Loss field.
4. Enter the wind loss due to air resistancemeasured at the reference speed in theWind Loss

field.
5. Enter the given speed in theReference Speed field.
6. ClickOK to close thePropertieswindow.

General Data for Universal Motors

To access the general data, double-click theMachine entry in the project tree.
TheGeneral Data Propertieswindow for a three-phase inductionmotor contains the following
fields:

Machine
Type

Themachine type you selected when inserting a new RMxprt design (Switched
ReluctanceMotor).

Number of
Poles

Number of poles for thismachine.

Frictional
Loss

The frictional energy loss (due to friction) measured at the reference speed.

Wind Loss Thewind loss (due to air resistance) measured at the reference speed.
Reference
Speed

The given speed of reference.

Defining the Stator Data for a Universal Motor

Use theStator Properties windows to define the stator dimensions, slots, windings, and
conductors.
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The stator is the outer lamination stackwhere the polyphase voltage windings reside.
To define the general stator data:

1. To open theStator Data Propertieswindow, double-click theMachine>Stator entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter theOuter Diameter of the stator.
3. Enter the overall width of the stator outer profile in theOverall Width field.
4. Enter the Inner Diameter of the stator.
5. Enter the length of the stator core in the Length field.
6. Enter the stacking factor for the stator core in the Stacking Factor field.
7. Select aSteel Type for the stator core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

8. ClickOK to close thePropertieswindow.

Stator Data for Universal Motors

To access the general stator data, double-click theMachine>Stator entry in the project tree.
TheStator Data Propertieswindow contains the following fields:

Outer
Diameter

The outer diameter of the stator core.

Overall Width The overall width of the stator outer profile.
Inner
Diameter

The inner diameter of the stator core.

Length The length of the stator core.
Stacking
Factor

The effectivemagnetic length of the stator core.

Steel Type The steel type of the stator core. Click the button to open theSelect Definition
window.

Defining the Stator Pole for a Universal Motor

The rotor pole drives the electromagnetic field which is coupled with the stator windings. Use the s
Stator Pole Data Properties window to define the stator pole.
To define the rotor pole:

1. To open theStator Pole Data Propertieswindow, double-click theMachine-Stator-Pole
entry in the project tree on the desktop. (You can also enter values in theProperties section
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of the desktop without opening a separate window.)
Note For a two-polemachine, a pole embrace of 0.75 yields amagnet with a span of 135

degrees (based on 0.75*180 degrees).

2. Enter the ratio of the actual arc distance in relation to themaximumpossible arc distance in the
Embrace field. This value is between 0 and 1.

3. Enter the distance from the center of the stator to themagnet arc center in theOffset field.
Enter 0 for a uniform air gap.

4. Enter theminimumpole width in thePoleWidth field.
5. Enter the yoke thickness in the Ty field.
6. Enter the shoe-tip thickness in the Ts field.
7. Enter the pole’s hole radius in theR1 field. If there is no hole in the design, enter 0.
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8. Enter the pole’s side fillet radius in theR2 field.
9. Enter the radius of the pole’s center side fillet arcs in theR3 field.
10. Enter the radius of the shoe connecting arc in theR4 field. To auto-design this dimension,

enter 0. For a linear connection, enter 0.
11. Enter the inner radius of the screw hole between the two poles in theR5 field. If there is no

hole in the design, enter 0.
12. Enter the outer radius of the screw hole between the two poles in theR6 field. If there is no

hole in the design, enter 0.
13. ClickOK to close thePropertieswindow.

Stator Pole Data for Universal Motors

To access the stator pole data, double-click theMachine-Stator-Pole entry in the project tree.
TheStator Pole Data Propertieswindow contains the following fields:

Embrace The pole embrace.
Offset The pole-arc center offset from the stator center (0 for a uniform air gap).
PoleWidth Theminimumpole width.
Ty The yoke thickness.
Ts The shoe-tip thickness.
R1 The hole radius in the pole (0 for no hole).
R2 The radius of the pole side fillet.
R3 The radius of the center of the pole side fillet arcs.
R4 The radius of the shoe connecting arc (0 for auto-design or for a linear

connection).
R5 The inner radius of the screw hole between two poles (0 for no hole).
R6 The outer radius of the screw hole between two poles (0 for no hole).

Defining the Stator Windings and Conductors for a Universal Motor

To define the stator windings and conductors:
1. To open theStator Winding Propertieswindow, double-click theMachine-Stator-

Winding entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Enter the thickness of the insulation between the stator core and the field winding in the
Insulation Thickness field.

3. Enter the end length adjustment of the stator coils in theEnd Adjustment field. The end
adjustment is the distance one end of the conductor extends vertically beyond the end of the
stator.
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4. Enter the number of parallel branches in the stator winding in theParallel Branches field.
5. Enter the number of turns per stator pole in the Turns per Pole field. To auto-design the

number of turns, enter 0.
6. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to have

RMxprt auto-design this value.
7. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to

automatically obtain this value from the wire library.

8. Select theWire Size:
a. Click the button forWire Size.

TheWire Sizewindow appears.
b. Select a value from theWire Diameter pull-down list.
c. Select a wire gauge from theGauge pull-downmenu. You can select from the following

options:
<

number
>

You can select a specific gauge number. When you select a gauge number,
theWire Diameter field is automatically updated.

USER This option allows you tomanually enter theWire Diameter. This is useful
when you want to enter a diameter that does not correspond to a particular
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wire gauge.

AUTO
This option sets theWire Diameter to zero, and RMxprt automatically
calculates the optimal value. The diameter information is then written to the
output file when you analyze the design.

MIXED
This option allows you to define a conductor that ismade of different size wires.
For example, a single conductor may consist of 5 wires, 3 wires with a diameter
of 0.21mmand 2 with a diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.

a. When you are done setting the wire size, clickOK to close theWire Sizewindow and
return to thePropertieswindow.

b. Enter the thickness of the wedge insulation in theWedge Thickness field.
c. Enter the thickness of the insulation layer in the Layer Insulation field.
d. Enter the limited slot fill factor for the wire design in the Limited Fill Factor field. The slot fill

factor is the ratio between the cross-sectional area of all conductors in one slot and the entire
slot area.

e. ClickOK to close thePropertieswindow.

Defining Different Size Wires for a Universal Motor Stator Winding

To define different size wires:
1. In theWire Size window, selectMIXED from theGauge pull-downmenu.
2. Select eitherRound orRectangular as theWire Type.
3. Enter the appropriate wire data in the table:

l For a round wire:
l Enter theDiameter in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
diameter.

l For a rectangular wire:
l Enter theWidth of the wire in the table.
l Enter the Thickness of the wire in the table.
l Enter the Fillet value in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this data.

4. ClickAdd to add the new wire data.
5. Repeat steps 3 and 4 for each size wire you want to add.
6. When you are finished defining the wires, clickOK to close theWire Sizewindow and return

to the RMxprtPropertieswindow.
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Note For example, if one conductor ismade up of 5 wires, and 3 of those wires have a
diameter of 0.21mm, and the other 2 have a diameter of 0.13mm, then themixed
wire size table will have two lines. The first line will list Diameter = 0.21 and Number
= 3. The second line will list Diameter = 0.13 and Number = 2. An equivalent wire
diameter is displayed asWire Size value in theWinding tab in the Properties
window.

Stator Winding Data for Universal Motors

To access the stator winding data, double-click theMachine-Stator-Winding entry in the project
tree.
TheStator Winding Data Propertieswindow contains the following fields:

Insulation
Thickness

The thickness of the insulation between the stator core and the field winding.

End
Adjustment

The end length adjustment of the stator coils, which is the distance one end of the
conductor extends vertically beyond the end of the stator.

Parallel
Branches

The number of parallel branches in the stator winding.

Turns per
Pole

The number of turns per stator pole (0 for auto-design).

Number of
Strands

The number of wires per conductor (0 for auto-design).

Wire Wrap The thickness of the double-sided wire wrap (0 to automatically obtain this value
from the wire library).

Wire Size The diameter of the wire (0 for auto-design). Click the button to open theWire Size
window where you can specify units, wire type, diameter, and gauge.

Defining the Rotor Data for a Universal Motor

The rotor is equipped with slots containing copper conductors that are connected to the commutator.
The commutator acts as amechanical rectifier in themotor.
The rotor consists of copper bars in which current is induced by themagnetic fields produced by the
stator windings. In the project tree, double-clickMachine>Rotor andMachine-Rotor-Pole to
define the rotor and the pole.
To define general stator data:

1. To open theRotor Data Propertieswindow, double-click theMachine>Rotor entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter the stacking factor for the rotor core in the Stacking Factor field. This value relates to
the effectivemagnetic length of the core, and ranges from 0 to 1. It is defined as the total
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lengthminus the total insulation from the laminations, divided by the total length. A value of 1
indicates that the rotor is not laminated.

3. Enter the number of slots in the rotor core in theNumber of Slots field.
4. Select aSlot Type:

a. Click the button.
TheSelect Slot Typewindow appears.

b. Click a button to select the desired pole type (1, 2, 3, 4, 5, or 6). Though slots 3 and 4 are
visually similar, they differ in how the edges are constructed. Slot 3 has a tapered edge
leading from the slot opening to themain slot body. Slot 4 has a rounded edge at the same
location, where the quantityHr1 defines the radius of the corner slot. TIP:When you run
themouse over each option, the diagram changes to show that pole type.

c. ClickOK to close theSelect Slot Typewindow and return to thePropertieswindow.

Optionally, checkUser Defined Slot if you wish to define the slot dimensions using theSlot
Editor.

5. Enter the outer diameter of the rotor core in theOuter Diameter field.
6. Enter the inner diameter of the rotor core in the Inner Diameter field.
7. Enter the length of the rotor core in the Length field.
8. Select aSteel Type for the rotor core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

9. Enter the number of slots in the skew width in theSkew Width field.
10. ClickOK to close thePropertieswindow.

Rotor Data for Universal Motors

To access the general rotor data, double-click theMachine>Rotor entry in the project tree.
TheRotor Data Propertieswindow contains the following fields:

Stacking
Factor

The effectivemagnetic length of the rotor core.

Number
of Slots

The number of slots in the rotor core.

Slot Type The rotor core slot type. Click the button to open the Select Slot Typewindow and
select from the following types: 1, 2, 3, 4, 5, 6.

Outer
Diameter

The outer diameter of the rotor core.

Inner
Diameter

The inner diameter of the rotor core.
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Length The length of the rotor core.
Steel
Type

The steel type of the rotor core. Click the button to open theSelect Definition
window.

Skew
Width

The skew widthmeasured in slot number.

Defining the Rotor Slots for Universal Motors

To define the physical dimensions of the rotor slots:
1. To open theRotor Slot Data Propertieswindow, double-click theMachine-Rotor-Slot

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Optionally, to automatically design the dimensions of slotsHs2,Bs1, andBs2, select the
Auto Design check box. Using this option causes the software to converge to a flux density
value of 1.5 Tesla in the rotor teeth.

3. Enter the available slot dimensions. The following dimensionsmay be listed, depending on the
Slot Type selected and depending on whether or notAuto Design is selected.:
Hs0 Always available.
Hs1 Always available.
Hs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.
Bs0 Always available.
Bs1 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically. WhenParallel Tooth is selected, this slot
dimension is determined based on the value entered in the Tooth Width field.

Bs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot
dimension is determined automatically. WhenParallel Tooth is selected, this slot
dimension is determined based on the value entered in the Tooth Width field.

Rs Always available. Rs is added when the slot type is 3 or 4.

4. ClickOK to close thePropertieswindow.

Rotor Slot Data for Universal Motors

To access the rotor slot data, double-click theMachine-Rotor-Slot entry in the project tree.
TheRotor Slot Data Propertieswindow contains the following fields:

Auto
Design

Select or clear this to enable or disable auto-design of slotsHs2,Bs1, andBs2. When
this check box is selected, only two other fields appear in the window:Hs0 andBs0.

Parallel
Tooth

Select this to designBs1 andBs2 based on the tooth width. When this check box is
selected, theBs1 andBs2 fields are removed, and the Tooth Width field is added.
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Tooth
Width

The tooth width for the parallel tooth, on whichBs1 andBs2 are designed.

Hs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Hs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Hs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Bs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Bs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Bs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Rs A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Rs A slot dimension. (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected). Rs is added when the slot type is 3 or 4.

Defining the Rotor Windings and Conductors for a Universal Motor

To define the rotor windings, wires, and conductors:
1. To open theRotor Slot Winding Propertieswindow, double-click theMachine-Rotor-

Winding entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Click theWinding tab.
3. Select aWinding Type:

a. Click the button forWinding Type.
TheWinding Typewindow appears.

b. Select from one of the following three types of winding:
l Lap
l Wave
l Frog Leg

4. Enter the number of windings in theMultiplex Number field (1 for a single winding, 2 for
double windings, 3 for triple windings). For a lap winding, themultiplex number is the number
of commutators between the start and end of one winding, and the number of parallel
branches is equal to the number of polesmultiplied by themultiplex number. For a wave
winding, the number of parallel branches equals themultiplex number multiplied by two.

Getting Started with RMxprt 26-358
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

5. Enter the number of virtual slots per each real slot in theVirtual Slots field. The rotor is
assumed to have two layers of conductors, an upper and a lower layer. Each layer of
conductors can have a number of windings, which are referred to as virtual slots.
Note For example, the upper and lower layer can have two windings each, which would

yield a virtual slot number of two; for a 12 slot machine, this would yield 24
commutation segments.

6. Enter the total number of conductors in each rotor slot in theConductors per Slot field. This
value is the number of turns per coil multiplied by the number of layers. This value is the total
number of conductors in one real full rotor slot.

7. Enter the coil pitch, measured in number of slots, in theCoil Pitch field. The coil pitch is the
number of slots separating one winding. For example, if a coil starts in slot 1 and ends in slot 6,
it has a coil pitch of 5.

8. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to have
RMxprt auto-design this value.

9. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to
automatically obtain this value from the wire library.
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10. Select theWire Size:
a. Click the button forWire Size.

TheWire Sizewindow appears.
b. Select a value from theWire Diameter pull-down list.
c. Select a wire gauge from theGauge pull-downmenu. You can select from the following

options:
<

number
>

You can select a specific gauge number. When you select a gauge number,
theWire Diameter field is automatically updated.

USER
This option allows you tomanually enter theWire Diameter. This is useful
when you want to enter a diameter that does not correspond to a particular
wire gauge.

AUTO
This option sets theWire Diameter to zero, and RMxprt automatically
calculates the optimal value. The diameter information is then written to the
output file when you analyze the design.

MIXED
This option allows you to define a conductor that ismade of different size wires.
For example, a single conductor may consist of 5 wires, 3 wires with a diameter
of 0.21mmand 2 with a diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.

a. When you are done setting the wire size, clickOK to close theWire Sizewindow and
return to thePropertieswindow.

b. Click theEnd/Insulation tab.
c. Select or clear the Input Half-turn Length check box.
d. Do one of the following:

l If you selected Input Half-turn Length, then enter the half-turn length of the armature
winding in the Half Turn Length field.

l If you cleared Input Half-turn Length, then enter the end length adjustment of the stator
coils in theEnd Adjustment field. The end adjustment is the distance one end of the
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conductor extends vertically beyond the end of the stator.

5. Enter the inner radius of the base corner in theBase Inner Radius field.
6. Enter the inner diameter of the coil tip in the Tip Inner Diameter field.
7. Enter the distance between two rotor coils in theEnd Clearance field.
8. Enter the thickness of the slot liner insulation in theSlot Liner field.

9. Enter the thickness of the wedge insulation in theWedge Thickness field.
10. Enter the thickness of the insulation layer in the Layer Insulation field.
11. Enter the limited slot fill factor for the wire design in the Limited Fill Factor field. The slot fill

factor is the ratio between the cross-sectional area of all conductors in one slot and the entire
slot area.
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12. Select the type of equalizer connection from theEqualizer Connection pull-downmenu.
Select fromNone,Half, or Full.

13. ClickOK to close thePropertieswindow.

Defining Different Size Wires for a Universal Motor Rotor Winding

Use theGauge option if you have a conductor that ismade up different size wires.
To define different size wires:

1. In theWire Size window, selectMIXED from theGauge pull-downmenu.
2. Select eitherRound orRectangular as theWire Type.
3. Enter the appropriate wire data in the table:

l For a round wire:
l Enter theDiameter in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
diameter.

l For a rectangular wire:
l Enter theWidth of the wire in the table.
l Enter the Thickness of the wire in the table.
l Enter the Fillet value in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this data.

4. ClickAdd to add the new wire data.
5. Repeat steps 3 and 4 for each size wire you want to add.
6. When you are finished defining the wires, clickOK to close theWire Sizewindow and return

to the RMxprtPropertieswindow.
Note For example, if one conductor ismade up of 5 wires, and 3 of those wires have a

diameter of 0.21mm, and the other 2 have a diameter of 0.13mm, then themixed
wire size table will have two lines. The first line will list Diameter = 0.21 and Number
= 3. The second line will list Diameter = 0.13 and Number = 2. An equivalent wire
diameter is displayed asWire Size value in theWinding tab in the Properties
window.

Rotor Winding Data for Universal Motors

To access the stator winding data, double-click theMachine-Rotor-Winding entry in the project
tree.
TheRotor Winding Data Propertieswindow contains the following fields:

Winding tab Winding Type The type of rotor winding. Click the
button to open theWinding Type
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window and choose from Lap,Wave,
and Frog Leg.

Multiplex Number Single, double, or triple windings (1, 2, or
3).

Virtual Slots The number of virtual slots per real slot.
Conductors per Slot The number of conductors per rotor slot

(0 for auto-design).
Coil Pitch The coil pitchmeasured in number of

slots.
Number of Strands The number of wires per conductor (0 for

auto-design).
Wire Wrap The thickness of the double-sided wire

wrap (0 to automatically obtain this value
from the wire library).

Wire Size The diameter of the wire (0 for auto-
design). Click the button to open the
Wire Sizewindow where you can
specify units, wire type, diameter, and
gauge.

End/Insulation tab Input Half-turn Length Select or clear this check box to specify
whether or not you want to enter the
half-turn length. When this check box is
selected, theHalf Turn Length field
appears the next time you open the
Propertieswindow.When this check
box is selected, theEnd Adjustment
field appears instead.

Half Turn Length The half-turn length of the armature
winding.

End Adjustment The end length adjustment of the rotor
coils.

Base Inner Radius The inner radius of the base corner.
Tip Inner Diameter The inner diameter of the coil tip.
End Clearance The end clearance between two

adjacent coils.
Slot Liner The thickness of the slot liner insulation.
Wedge Thickness The thickness of the wedge insulation.
Layer Insulation The thickness of the insulation layer.
Limited Fill Factor The limited slot fill factor for the wire

design. The slot fill factor is the ratio
between the cross-sectional area of all
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conductors in one slot and the entire slot
area.

Equalizer Connection The connection type of the equalizer.
Select fromNone,Half, or Full.

Defining the Commutator and Brush for a Universal Motor

The commutator allows current transfer between DC terminals or brushes and the rotor coils,
providing the current to the system as a function of rotation. Due to the action of the commutator, the
correspondingmagnetic field has a fixed distribution with respect to the stator.
To define the commutator and brush pairs:

1. To open theCommutator Data Propertieswindow, double-click the
Machine>Commutator entry in the project tree on the desktop. (You can also enter values in
theProperties section of the desktop without opening a separate window.)

2. Click theCommutator tab.
3. SelectCylinder or Pancake Type as theCommutator Type.

Note When you place themouse cursor over the commutator type, an outline of the
commutator appears.

4. ForCylinder commutators, do the following:
a. Enter theCommutator Diameter.
b. Enter theCommutator Length.

5. For Pancake commutators, do the following:
a. Enter theOuter Diameter.
b. Enter the Inner Diameter.

6. Enter the thickness of the insulation between two consecutive commutator segments in the
Commutator Insulation field.

7. Click theBrush tab.
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8. Enter theBrush Width.
9. Enter theBrush Length.
10. Enter the number of brush pairs when using a wave armature winding in theBrush Pairs

field.
11. Enter the angle of displacement from the neutral axis, in mechanical degrees, in theBrush

Displacement field.
Note The brush displacement is positive for the counter-clockwise direction. For example,

if the rotor turns clockwise and the brush displacement is also clockwise, then the
angle is negative; if the rotor turns clockwise but the brush displacement is counter-
clockwise, then the angle is positive.

12. Enter the voltage drop across one brush pair in the Brush Drop field.
13. Enter themechanical pressure of the brushes as they press against the commutator in the

Brush Press field.
14. Enter the Frictional Coefficient of the brush.

Note If the Friction Loss field is used in theGeneralwindow, theBrush Press and
Frictional Coefficient fields will be hidden in theCommutator/Brushwindow.
These fields are shown only when the Friction Loss field in theGeneralwindow is
set to zero.

15. ClickOK to close thePropertieswindow.

Commutator and Brush Data for Universal Motors

To access the commutator and brush data, double-click theMachine>Commutator entry in the
project tree.
TheCommutator Data Propertieswindow contains the following fields:

Commutator
tab

Commutator
Type

The type of commutator. Click the button to open theSelect
Commutator Typewindow and select fromCylinder or
Pancake.

Commutator
Diameter

For aCylinder commutator type, the diameter of the commutator.

Commutator
Length

For aCylinder commutator type, the length of the commutator.

Outer
Diameter

For aPancake commutator type, the outer diameter of the
commutator.

Inner
Diameter

For aPancake commutator type, the inner diameter of the
commutator.

Commutator
Insulation

The thickness of the insulation between the two commutator bars.

Brush tab Brush Width Thewidth of the brush.
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Brush
Length

The length of the brush.

Brush Pairs The number of brush pairs.
Brush
Displacement

The displacement of the brush from the neutral position, in
mechanical degrees (positive for anti-rotating direction).

Brush Drop The voltage drop across a one-pair brush.
Brush Press The brush press per unit area. (Available only when Frictional

Loss is set to zero for themachine.)
Frictional
Coefficient

The frictional coefficient of the brush. (Available only when
Frictional Loss is set to zero for themachine.)

Defining the Shaft Data for a Universal Motor

To define the shaft:
1. To open theShaft Data Propertieswindow, double-click theMachine>Shaft entry in the

project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Select or clear theMagnetic Shaft check box to specify whether or not the shaft is to be
made of magneticmaterial.

3. ClickOK to close thePropertieswindow.

Shaft Data for Universal Motors

To access the shaft data, double-click theMachine>Shaft entry in the project tree.
TheShaft Data Propertieswindow contains the following fields:

Magnetic
Shaft

Select or clear this check box to indicate whether or not the shaft ismade of
magneticmaterial.

Setting Up Analysis Parameters for a Universal Motor

To define the solution data:
1. To open theSolution Setupwindow, right-clickAnalysis in the project tree, and clickAdd

Solution Setup.
2. Click theGeneral tab. TheOperation Type is automatically set toMotor for thismachine

type.
3. Select the Load Type used in themotor from the following options:

Const
Speed

The speed remains constant in themotor.

Const The output power remains constant in themotor.
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Power
Const
Torque

The torque remains constant regardless of the speed. In this case, Tload = Trated,
given by the output power divided by the given rated speed.

Linear
Torque

The torque increases linearly with speed. In this case, Tload = Trated * (n/nrated)
where Trated is given by the output power divided by the given rated speed.

Fan
Load

The load varies nonlinearly with speed. In this case, Tload = Trated * (n/nrated)2
where Trated is given by the output power divided by the given rated speed.

4. Enter the output power developed at the shaft of themotor in theRated Output Power field.
5. Enter the RMS line-to-line voltage in theRated Voltage field.
6. Enter the desired output speed of themotor at the load point in theRated Speed field.
7. Enter the temperature at which the system functions in theOperating Temperature field.
8. Click theUniversal Motor tab.
9. Enter the Frequency, and select the units.
10. ClickOK to close theSolution Setupwindow.

Related Topics

Solution Data for Universal Motors

Solution Data for Universal Motors

To access the solution data, right-clickAnalysis in the project tree, and clickAdd Solution Setup.
For thismachine type, there is only one tab, theGeneral tab.
TheSolution Setupwindow contains the following fields:

Operation
Type

General tab. The operation type is automatically set toMotor for thismachine
type.

Load Type General tab. Select fromConst Speed,Const Power,Const Torque, Linear
Torque, and Fan Load. The default isConst Power.

Rated Output
Power

General tab. Type a value for the rated output voltage, and select the units.

Rated
Voltage

General tab. Type a value for the rated voltage, and select the units.

Rated Speed General tab. Type a value for the rated speed, and select the units.
Operating
Temperature

General tab. Type a value for the operating temperature, and select the units.

Frequency Universal Motor tab. Enter a frequency in the Frequency field, and select the
units.
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Related Topics

Setting Up Analysis Parameters for a Universal Motor

General DC Machines

After you have selectedDC Machine as your model type, enter themotor data to define the
following:

l General data, such as the output power, rated voltage, speed, andmachine type (motor or
generator).

l Stator data, such as its associated pole dimensions, type of steel, and polemagnet
specifications.

l Stator field data, such as shoe and pole insulation, dimensions, and winding information.
l Rotor data, such as the slot types and dimensions, rotor diameter, lamination, and wire
specifications.

l Commutator and brush data, such as the commutator type and dimensions and brush length.
l Shaft data.
l Solution data.

By option you can insert or remove the following for a DC machine.
l Add amachine housing.
l Compensating data, added under the stator
l Commutating data, added under the stator
l Vent data, added under the rotor
l Shunt data, added under the stator field.
l Series data, added under the stator field.

Analysis Approach for General DC Machines

For a Direct-Current (DC) ElectricMachine Design, either a generator or motor, the rotor is
equipped with a distributed winding -- called armature winding -- that is connected to a commutator
revolving together with the rotor.
The stator is equipped with p pairs of poles, which are excited by p pairs of shunt and/or series
windings. A shunt windingmay be separately excited or self-excited. The separately excited shunt
winding is excited by a separate DC voltage source. The self-excited shunt winding is excited by the
terminal voltage of the armature winding and is connected in parallel with the armature winding. A
series winding is connected in series with the armature winding. If both self-excited shunt and series
windings aremounted on the stator poles, RMxprt assumes that the armature winding connects the
series winding in series first, then connects the shunt winding in parallel.
A system of brushes is kept in permanent electrical contact with the commutator. When DC current
is applied to the rotating armature winding via the brushes and commutator, a stationarymagnetic
field distribution is created with the axis electrically perpendicular to the axis of the field produced by
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the shunt and/or series windings. As a result, a torque is produced by the interaction of the fields
produced by the armature and exciting currents. For these brush commutatingmachines, the
commutator together with the brushes acts as amechanical rectifier.
The field produced by the armature current is called armature reaction field. The armature reaction
field causes poor commutating and poor voltage distribution along commutator bars. In order to
improve commutating, commutating poles and winding can be equipped between two adjacent main
poles and compensating winding can be equipped under main poles.
The performance of a DC machine is computed byDC analysis.

DC Machine Operating as a Motor

The voltage equation of a DC motor is

where,Ub is the voltage drop of one-pair brushes,R1 is the total series resistance of the armature
branch,E is the back emf as given below:

whereCEf andCEs, which depend on the saturation of themagnetic field, are the back-emf
coefficients in ohm.s/rad, is the rotor speed inmechanical rad/s, and If and Ia are the exciting
currents of the shunt and series windings, respectively.
For a given speed, armature current can be computed based on the terminal voltageU, as shown
below:

The shaft torque is computed from:

whereCTf andCTs are the torque coefficients in Nm/A^2 which are numerically the same asCEf and
CEs, respectively. Tfw is the frictional and wind torque. The output power (mechanical power) is
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The input power (electrical power) is

wherePfw, PCua, Pb, andPFe are the frictional and wind loss, armature branch copper loss, brush
drop loss, iron-core loss and shunt winding copper loss, respectively. The efficiency is:

DC Machine Operating as a Generator

For a DC generator, the voltage equation is

The performance is analyzed as follows
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Defining a General DC Machine

The general procedure for defining a a general DC machine is as follows:
1. Insert a DC machine into a new or existing project.
2. Double-click theMachine entry in the project tree to define the general data.
3. Double-click theMachine-Stator entry in the project tree to define the stator geometry.
4. Double-click theMachine-Stator-Pole entry in the project tree to define the stator pole

dimensions.
5. Double-click theMachine-Stator-Field entry in the project tree to define the stator windings,

conductors, and insulation data.
6. Double-click theMachine-Rotor entry in the project tree to define the general rotor geometry,

the pole data, and the insulation data.
7. Double-click theMachine-Rotor-Slot entry in the project tree to define the rotor slot

dimensions.
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8. Double-click theMachine-Rotor-Winding entry in the project tree to define the rotor
conductors and windings.

9. Double-click theMachine-Commutator entry in the project tree to define the commutator
and brush data.

10. Double-click theMachine-Shaft entry in the project tree to define themagnetism of the shaft.
11. Optionally, right-click theMachine entry in the project tree and click Insert Housing to add a

machine housing.
12. Right-clickAnalysis in the project tree, and clickAdd Solution Setup to define the solution

data.
13. Choose File>Save to save the project.
14. ChooseRMxprt>Analyze to analyze the design.

Note When you place the cursor over an entry field, a brief description of that field
appears in the status bar at the bottom of theRMxprtwindow.

Once analyzed, themodel can be viewed in theMaxwell 2D Modeler, or it can be used to create a
new Maxwell 2D project, and a new Maxwell 3D design.
Refer to theDCMachine application note, on the technical support page of the ANSYS web site, for
a specific example of a problem using a DC machine.

Defining the General Data for a General DC Machine

Use theGeneral window to define the basic parameters of the DC motor, such as the power
settings, speed, and rated voltage.
To define the general data:

1. To open theGeneral Data Propertieswindow, double-click theMachine entry in the project
tree on the desktop. (You can also enter values in theProperties section of the desktop
without opening a separate window.)

2. Enter the number of poles for themachine in theNumber of Poles field. This value is the total
number of poles in the stator (or the number of pole pairsmultiplied by two).

3. Enter the energy loss due to friction at the given speed in the Frictional Loss field.
4. Enter the wind loss due to air resistancemeasured at the reference speed in theWind Loss

field.
5. Enter the given speed in theReference Speed field.
6. ClickOK to close thePropertieswindow.

General Data for General DC Machines

To access the general data, double-click theMachine entry in the project tree.
TheGeneral Data Propertieswindow for a three-phase inductionmotor contains the following
fields:

Getting Started with RMxprt 26-372
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Machine Type Themachine type you selected when inserting a new RMxprt design (DC
Machine).

Number of
Poles

The number of poles themachine contains.

Frictional Loss The frictional energy loss (due to friction) measured at the reference speed.
Wind Loss Thewind loss (due to air resistance) measured at the reference speed.
Reference
Speed

The given speed of reference.

Defining the Stator Data for a General DC Machine

Use theStator Properties windows to define the stator dimensions, slots, windings, and
conductors.
The stator is the outer lamination stackwhere the polyphase voltage windings reside.
To define the general stator data:

1. To open theStator Data Propertieswindow, double-click theMachine>Stator entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter themaximumdiameter for a polygon-type frame in the Frame Outer Diameter field.
3. Enter theminimumouter width for a polygon-type frame in the Frame Overall Width field.
4. Enter the Frame Thickness.
5. Enter the Frame Length.
6. Select a steel type for the frame:

a. Click the button for Frame Material.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

7. Select aPole Type:
a. Click the button.

TheSelect Pole Typewindow appears.
b. Click a button to specify the desired field type (either 1 or 2).
c. ClickOK to close theSelect Pole Typewindow and return to the Properties window.

8. Enter the length of the stator main pole in thePole Length field.
9. Enter the effectivemagnetic length for the stator main pole in thePole Stacking Factor field.
10. Select a steel type for the stator main pole:

a. Click the button for Pole Material.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.
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11. Enter the thickness of the pole press boards in thePress Board Thickness field.
12. If the pole press board ismade of magneticmaterial, then select theMagnetic Press Board

check box.
13. ClickOK to close thePropertieswindow.

Stator Data for General DC Machines

To access the general stator data, double-click theMachine>Stator entry in the project tree.
TheStator Data Propertieswindow contains the following fields:

Frame Outer
Diameter

Themaximumdiameter for a polygon-type frame.

Frame
Overall Width

Theminimumouter width for a polygon-type frame.

Frame
Thickness

The thickness of the frame.

Frame
Length

The length of the frame.

Frame
Material

The steel type of the frame. Click the button to open theSelect Definition
window.

Pole Type The pole type of the stator. Click the button to open theSelect Pole Type
window and select from the following two types: 1 and 2.

Pole Length The length of the stator main pole.
Pole Stacking
Factor

The stacking factor of the stator main pole.

Pole Material The steel type of the stator main pole. Click the button to open theSelect
Definitionwindow.

Press Board
Thickness

The thickness of the pole press boards.

Magnetic
Press Board

Whether or not the pole press board ismade of magneticmaterial.

Defining the Stator Pole for a General DC Machine

The rotor pole drives the electromagnetic field which is coupled with the stator windings. Use the s
Stator Pole Data Properties window to define the stator pole.
To define the rotor pole:

1. To open theStator Pole Data Propertieswindow, double-click theMachine-Stator-Pole
entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)
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Note For a two-polemachine, a pole embrace of 0.75 yields amagnet with a span of 135
degrees (based on 0.75*180 degrees).

2. Enter the inner diameter at the pole center in the Dmin field.
3. Enter the diameter at the pole tip in the Dmax field.
4. Enter the width of the pole arc with a uniform air gap in the Bp0 field. For an eccentric air gap,

enter 0.
5. Enter the width of the pole tip in the Bp1 field.
6. Enter themaximumwidth of the pole shoe in the Bp2 field. This field is only available for a Pole

Type of 1.
7. Enter theminimumwidth of the pole shoe in the Bp3 field. This field is only available for a Pole

Type of 1.
8. Enter the size of the pole shoe fillet in the Rp0 field. THis field is only available for a Pole Type

of 2.
9. Enter the fillet between the pole shoe and the pole body in the Rp1 field. THis field is only

available for a Pole Type of 2.
10. Enter the pole shoe height in the Hp field.
11. Enter the pole bodywidth in the Bm field.
12. ClickOK to close thePropertieswindow.

Stator Pole Data for General DC Machines

To access the stator pole data, double-click theMachine-Stator-Pole entry in the project tree.
TheRotor Pole Data Propertieswindow contains the following fields:

Dmin The inner diameter at the pole center.
Dmax The diameter at the pole tip.
Bp0 Thewidth of the pole arc with a uniform air gap (0 for an eccentric air

gap).
Bp1 Thewidth of the pole tip.
Bp2 Themaximumwidth of the pole shoe. For pole type 1.
Bp3 Theminimumwidth of the pole shoe. FOr pole type 1.
Rp0 The pole shoe fillet. For pole type 2.
Rp1 The fillet between the pole shoe and the pole body. For pole type 2.
Hp The height of the pole shoe.
Bm Thewidth of the pole body.

Defining the Stator Field Data for a General DC Machine

To define the stator windings and insulation data:
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1. To open theStator Field Propertieswindow, double-click theMachine-Stator-Field entry
in the project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter the thickness of the insulation under the pole shoe in theShoe Insulation field.
3. Enter the thickness of the insulation at the pole body side in thePole Insulation field.
4. Enter theminimumgap in theWinding Clearance field. The winding clearance is one of the

following: theminimumgap between two field windings, or theminimumgap between a field
winding and a commutating winding.

5. Enter the thickness of the insulation between the shunt winding and the series winding in the
Winding Insulation field.

6. Select the type of exciting of the series winding to the shunt winding from theCompound
Exciting Mode pull-down list. The options areCumulative andDifferential.

7. ClickOK to close thePropertieswindow.

Stator Field Data for General DC Machines

To access the stator field data, double-click theMachine-Stator-Field entry in the project tree.
TheStator Field Data Propertieswindow contains the following fields:

Shoe
Insulation

The thickness of the insulation under the pole shoe.

Pole
Insulation

The thickness of the insulation at the pole body side.

Winding
Clearance

Theminimumair gap between two field windings, or theminimumgap between a
field winding and a commutating winding.

Winding
Insulation

The thickness of the insulation between the shunt winding and the series winding.

Compound
Exciting
Mode

The cumulative exciting or differential exciting of the series winding to the shunt
winding. SelectCumulative orDifferential from the pull-down list.

Shunt Data for General DC Machines

By option you can insert or remove a shunt from aGeneral DC Machine. If you insert a shunt, it
appears in the project tree under the stator field data.
To insert a shunt.

1. Right click on the Field icon under the stator in the project tree to display the popupmenu.
2. Click Insert Shunt.

The Shunt icon appears under the field icon.
To Remove an existing shunt:
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1. Right click on the Field icon under the stator in the project tree to display the popupmenu.
2. ClickRemove Shunt.

The shut is removed from the project tree.
The Shunt data for a General DC Machine contains the following fields.

Winding
type

Specified asRound, Cylinder coil, or Edgewise coil, by clicking the button to display
theWinding Type selection window.

Parallel
branches

Number of parallel branches.

Conductors
per pole

Number of conductors per pole. 0 for auto-design. Odd number of strands for the
case where the input and output leads are on different sides.

Number of
strands

Number of strands (number of wires per conductor). 0 for auto-design.

Wire wrap Double side wire wrap thickness. 0 for auto-pickup in the wire library.
Wire size. Click the button to display theWire Size selection window.
Axial
Clearance

Axial gap between field winding and pole body on the inner coil.

Limited
cross width

Limited cross section width for winding design or arrangement. 0 for available
maximumarea.

Limited
cross
height

Limited cross section height for winding design or arrangement. 0 for available
maximumarea.

Winding
fillet.

Series Data for General DC Machines

By option, you can insert or remove a series from aGeneral DC Machine. If you insert a series, it
appears in the project tree under the stator field data.
To insert a series:

1. Right click on the Field icon under the stator in the project tree to display the popupmenu.
2. Click Insert Series.

The Series icon appears under the field icon.
To Remove an existing series:

1. Right click on the Field icon under the stator in the project tree to display the popupmenu.
2. ClickRemove Series.

The series is removed from the project tree.
The Series data for a General DC Machine contains the following fields.
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Winding
type

Specified asRound, Cylinder coil, or Edgewise coil, by clicking the button to display
theWinding Type selection window.

Parallel
branches

Number of parallel branches.

Conductors
per pole

Number of conductors per pole. 0 for auto-design. Odd number of strands for the
case where the input and output leads are on different sides.

Number of
strands

Number of strands (number of wires per conductor). 0 for auto-design.

Wire wrap Double side wire wrap thickness. 0 for auto-pickup in the wire library.
Wire size. Click the button to display theWire Size selection window.
Axial
Clearance

Axial gap between field winding and pole body on the inner coil.

Limited
cross width

Limited cross section width for winding design or arrangement. 0 for available
maximumarea.

Limited
cross
height

Limited cross section height for winding design or arrangement. 0 for available
maximumarea.

Winding
fillet.

Compensating Data for General DC Machines

By option, you can insert or remove Compensating for a General DC Machine.
To insert compensating:

1. Right-click on the Stator icon to display the pop-upmenu.
2. Click Insert Compensating.

To remove an existing Compensating:
1. Right click on the Stator icon to display the pop-upmenu.
2. ClickRemove Compensating.

To access the data for compensating inserted to a General DC Machine, double click on the
Machine-Rotor-Compensating item in the project tree.
TheCompensating properties window contains the following fields.

Slots per pole Number of slots per pole for the compensating winding.
Bc0 Opening width of the compensating slots.
Hc0 Opening height of the compensating slots.
Bc2 Width of the compensating slots.
Hc2 Height of the compensating slots.
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Parallel
branches

Number of parallel branches.

Conductors per
slot

Number of conductors per slot for the compensating windings

Number of
strands

Number of strands (number of wires per conductor), 0 for auto-design.

Wire wrap Double-side wire wrap thickness, 0 for auto pickup in the wire library
Rectangle wire Whether to use round (the default) or rectangle wire.
Wire size Click the button to display theWire Size window to specify the wire diameter

and gauge.
Slot liner Insulation slot liner thickness
End adjustment one side end length adjustment of a conductor.

Commutating Data for General DC Machines

Commutatingmust be inserted under the stator by right-clicking on the stator icon to display the pop-
upmenu, and click Insert Commutating command. This command also inserts an icon in the
project tree for an associated winding.
To remove an existing Commutating (and associated winding), right-click on the stator icon to
display the pop-upmenu and clickRemove Commutating. This removes the commutating and the
associated winding.
Note: This is distinct from the general Commutator data associated with rotor.

Pole width Width of the commutating poles
Pole height Height of the commutating poles.
Pole length Length of the commutating poles
Shoe width Shoewidth of the commutating poles
Shoe height Shoe height of the commutating poles.
Second air gap Length of the second air gap between the commutating pole and the frame.
Pole stacking
factor

Stacking factor for the commutating poles.

Pole material Steel type of the commutating poles. Click the button to display the Select
Definition window.

Pole insulation Thickness of insulation on the pole body side.
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Winding Data for Commutating

If you have inserted commutating for a General DC machine, an additional winding icon appears in
the project tree for the associated winding.

Winding
type

Specified asRound, Cylinder coil, or Edgewise coil, by clicking the button to display
theWinding Type selection window.

Parallel
branches

Number of parallel branches.

Conductors
per pole

Number of conductors per pole. 0 for auto-design. Odd number of strands for the
case where the input and output leads are on different sides.

Number of
strands

Number of strands (number of wires per conductor). 0 for auto-design.

Wire wrap Double side wire wrap thickness. 0 for auto-pickup in the wire library.
Wire size. Click the button to display theWire Size selection window.
Axial
Clearance

Axial gap between field winding and pole body on the inner coil.

Limited
cross width

Limited cross section width for winding design or arrangement. 0 for available
maximumarea.

Limited
cross
height

Limited cross section height for winding design or arrangement. 0 for available
maximumarea.

Winding
fillet.

Defining the Rotor Data for a General DC Machine

The rotor is equipped with slots containing copper conductors that are connected to the commutator.
The commutator acts as amechanical rectifier in themotor.
The rotor consists of copper bars in which current is induced by themagnetic fields produced by the
stator windings. In the project tree, double-clickMachine>Rotor andMachine-Rotor-Pole to
define the rotor and the pole.
To define general stator data:

1. To open theRotor Data Propertieswindow, double-click theMachine>Rotor entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter the stacking factor for the rotor core in the Stacking Factor field. This value relates to
the effectivemagnetic length of the core, and ranges from 0 to 1. It is defined as the total
lengthminus the total insulation from the laminations, divided by the total length. A value of 1
indicates that the rotor is not laminated.
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3. Enter the number of slots in the rotor core in theNumber of Slots field.
4. Select aSlot Type:

a. Click the button.
TheSelect Slot Typewindow appears.

b. Click a button to select the desired slot type (1, 2, 3, 4, 5, or 6). Though slots 3 and 4 are
visually similar, they differ in how the edges are constructed. Slot 3 has a tapered edge
leading from the slot opening to themain slot body. Slot 4 has a rounded edge at the same
location, where the quantityHr1 defines the radius of the corner slot. TIP:When you run
themouse over each option, the diagram changes to show that pole type.

c. ClickOK to close theSelect Slot Typewindow and return to thePropertieswindow.

Optionally, checkUser Defined Slot if you wish to define the slot dimensions using theSlot
Editor.

5. Enter the number of lamination sectors in the Lamination Sectors field.
6. Enter the outer diameter of the rotor core in theOuter Diameter field.
7. Enter the inner diameter of the rotor core in the Inner Diameter field.
8. Enter the length of the rotor core in the Length field.
9. Select aSteel Type for the rotor core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

10. Enter the thickness of the pole press boards in thePress Board Thickness field.
11. Enter the number of slots in the skew width in theSkew Width field.
12. ClickOK to close thePropertieswindow.

Rotor Data for General DC Machines

To access the general rotor data, double-click theMachine>Rotor entry in the project tree.
TheRotor Data Propertieswindow contains the following fields:

Stacking Factor The effectivemagnetic length of the rotor core.
Number of Slots The number of slots the rotor core contains.
Slot Type The type of slots in the rotor core. Click the button to open theSelect Slot

Typewindow.
Lamination
Sectors

The number of lamination sectors.

Outer Diameter The outer diameter of the rotor core.
Inner Diameter The inner diameter of the rotor core.
Length The length of the rotor core.
Steel Type The steel type of the rotor core. Click the button to open theSelect
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Definitionwindow.
Press Board
Thickness

The thickness of the pole press boards.

Skew Width The skew widthmeasured in slot number.

Defining the Rotor Slots for a General DC Machine

To define the physical dimensions of the rotor slots:
1. To open theRotor Slot Data Propertieswindow, double-click theMachine-Rotor-Slot

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Optionally, to automatically design the dimensions of slotsHs2,Bs1, andBs2, select the
Auto Design check box. Using this option causes the software to converge to a flux density
value of 1.5 Tesla in the rotor teeth.

3. Enter the available slot dimensions. The following dimensionsmay be listed, depending on the
Slot Type selected and depending on whether or notAuto Design is selected.:
Hs0 Always available.
Hs1 Always available.
Hs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.
Bs0 Always available.
Bs1 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically. WhenParallel Tooth is selected, this slot
dimension is determined based on the value entered in the Tooth Width field.

Bs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot
dimension is determined automatically. WhenParallel Tooth is selected, this slot
dimension is determined based on the value entered in the Tooth Width field.

Rs Always available.

4. ClickOK to close thePropertieswindow.

Rotor Slot Data for General DC Machines

To access the rotor slot data, double-click theMachine-Rotor-Slot entry in the project tree.
TheRotor Slot Data Propertieswindow contains the following fields:

Auto
Design

Select or clear this to enable or disable auto-design of slotsHs2,Bs1, andBs2. When
this check box is selected, only two other fields appear in the window:Hs0 andBs0.

Parallel
Tooth

Select this to designBs1 andBs2 based on the tooth width. When this check box is
selected, theBs1 andBs2 fields are removed, and the Tooth Width field is added.

Tooth
Width

The tooth width for the parallel tooth, on whichBs1 andBs2 are designed.
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Hs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Hs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Hs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Bs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Bs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Bs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Rs A slot dimension (see the diagram shown in themodeling window whenMachine-
Rotor-Slot is selected).

Rs A slot dimension. (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected). Rs is added when the slot type is 3 or 4.

Defining the Rotor Windings and Conductors for a General DC Machine

To define the rotor windings, wires, and conductors:
1. To open theRotor Slot Winding Propertieswindow, double-click theMachine-Rotor-

Winding entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Click theWinding tab.
3. Select aWinding Type:

a. Click the button forWinding Type.
TheWinding Typewindow appears.

b. Select from one of the following three types of winding:
l Lap
l Wave
l Frog Leg

4. Enter the number of windings in theMultiplex Number field (1 for a single winding, 2 for
double windings, 3 for triple windings). For a lap winding, themultiplex number is the number
of commutators between the start and end of one winding, and the number of parallel
branches is equal to the number of polesmultiplied by themultiplex number. For a wave
winding, the number of parallel branches equals themultiplex number multiplied by two.
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5. Enter the number of virtual slots per each real slot in theVirtual Slots field. The rotor is
assumed to have two layers of conductors, an upper and a lower layer. Each layer of
conductors can have a number of windings, which are referred to as virtual slots.
Note For example, the upper and lower layer can have two windings each, which would

yield a virtual slot number of two; for a 12 slot machine, this would yield 24
commutation segments.

6. Enter the total number of conductors in each rotor slot in theConductors per Slot field. This
value is the number of turns per coil multiplied by the number of layers. This value is the total
number of conductors in one real full rotor slot.

7. Enter the coil pitch, measured in number of slots, in theCoil Pitch field. The coil pitch is the
number of slots separating one winding. For example, if a coil starts in slot 1 and ends in slot 6,
it has a coil pitch of 5.

8. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to have
RMxprt auto-design this value.

9. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to
automatically obtain this value from the wire library.
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10. Select theWire Size:
a. Click the button forWire Size.

TheWire Sizewindow appears.
b. Select a value from theWire Diameter pull-down list.
c. Select a wire gauge from theGauge pull-downmenu. You can select from the following

options:
<

number
>

You can select a specific gauge number. When you select a gauge number,
theWire Diameter field is automatically updated.

USER
This option allows you tomanually enter theWire Diameter. This is useful
when you want to enter a diameter that does not correspond to a particular
wire gauge.

AUTO
This option sets theWire Diameter to zero, and RMxprt automatically
calculates the optimal value. The diameter information is then written to the
output file when you analyze the design.

MIXED
This option allows you to define a conductor that ismade of different size wires.
For example, a single conductor may consist of 5 wires, 3 wires with a diameter
of 0.21mmand 2 with a diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.

a. When you are done setting the wire size, clickOK to close theWire Sizewindow and
return to thePropertieswindow.

b. Click theEnd/Insulation tab.
c. Select or clear the Input Half-turn Length check box.
d. Do one of the following:

l If you selected Input Half-turn Length, then enter the half-turn length of the armature
winding in the Half Turn Length field.

l If you cleared Input Half-turn Length, then enter the end length adjustment of the stator
coils in theEnd Adjustment field. The end adjustment is the distance one end of the
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conductor extends vertically beyond the end of the stator.

5. Enter the inner radius of the base corner in theBase Inner Radius field.
6. Enter the inner diameter of the coil tip in the Tip Inner Diameter field.
7. Enter the distance between two rotor coils in theEnd Clearance field.
8. Enter the thickness of the slot liner insulation in theSlot Liner field.

9. Enter the thickness of the wedge insulation in theWedge Thickness field.
10. Enter the thickness of the insulation layer in the Layer Insulation field.
11. Enter the limited slot fill factor for the wire design in the Limited Fill Factor field. The slot fill

factor is the ratio between the cross-sectional area of all conductors in one slot and the entire
slot area.
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12. Select the type of equalizer connection from theEqualizer Connection pull-downmenu.
Select fromNone,Half, or Full.

13. ClickOK to close thePropertieswindow.

Defining Different Size Wires for a General DC Machine Rotor Winding

Use theGauge option if you have a conductor that ismade up different size wires.
To define different size wires:

1. In theWire Size window, selectMIXED from theGauge pull-downmenu.
2. Select eitherRound orRectangular as theWire Type.
3. Enter the appropriate wire data in the table:

l For a round wire:
l Enter theDiameter in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
diameter.

l For a rectangular wire:
l Enter theWidth of the wire in the table.
l Enter the Thickness of the wire in the table.
l Enter the Fillet value in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this data.

4. ClickAdd to add the new wire data.
5. Repeat steps 3 and 4 for each size wire you want to add.
6. When you are finished defining the wires, clickOK to close theWire Sizewindow and return

to the RMxprtPropertieswindow.
Note For example, if one conductor ismade up of 5 wires, and 3 of those wires have a

diameter of 0.21mm, and the other 2 have a diameter of 0.13mm, then themixed
wire size table will have two lines. The first line will list Diameter = 0.21 and Number
= 3. The second line will list Diameter = 0.13 and Number = 2. An equivalent wire
diameter is displayed asWire Size value in theWinding tab in the Properties
window.

Rotor Winding Data for General DC Machines

To access the rotor winding data, double-click theMachine-Rotor-Winding entry in the project
tree.
TheRotor Winding Data Propertieswindow contains the following fields:

Winding tab Winding Type The type of rotor winding. Click the
button to open theWinding Type
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window and choose from Lap,Wave,
and Frog Leg.

Multiplex Number Single, double, or triple windings (1, 2, or
3).

Virtual Slots The number of virtual slots per real slot.
Conductors per Slot The number of conductors per rotor slot

(0 for auto-design).
Coil Pitch The coil pitchmeasured in number of

slots.
Number of Strands The number of wires per conductor (0 for

auto-design).
Wire Wrap The thickness of the double-sided wire

wrap (0 to automatically obtain this value
from the wire library).

Wire Size The diameter of the wire (0 for auto-
design). Click the button to open the
Wire Sizewindow where you can
specify units, wire type, diameter, and
gauge.

End/Insulation tab Input Half-turn Length Select or clear this check box to specify
whether or not you want to enter the
half-turn length. When this check box is
selected, theHalf Turn Length field
appears the next time you open the
Propertieswindow.When this check
box is selected, theEnd Adjustment
field appears instead.

Half Turn Length The half-turn length of the armature
winding.

End Adjustment The end length adjustment of the rotor
coils.

Base Inner Radius The inner radius of the base corner.
Tip Inner Diameter The inner diameter of the coil tip.
End Clearance The end clearance between two

adjacent coils.
Slot Liner The thickness of the slot liner insulation.
Wedge Thickness The thickness of the wedge insulation.
Layer Insulation The thickness of the insulation layer.
Limited Fill Factor The limited slot fill factor for the wire

design. The slot fill factor is the ratio
between the cross-sectional area of all
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conductors in one slot and the entire slot
area.

Equalizer Connection The connection type of the equalizer.
Select fromNone,Half, or Full.

Vent Data for General DC Machines

By option, you can insert or remove Vent data for general DC machines. If you have inserted a Vent,
the icon appears under the rotor winding in the project tree.
To insert a vent:

1. Right-click on the rotor icon to display the pop-upmenu.
2. Click Insert Vent.

To remove an existing vent:
1. Right click on the Stator icon to display the pop-upmenu.
2. ClickRemove Vent.

TheVent Data Propertieswindow contains the following fields.

Vent Ducts Number of radial vent ducts
Duct Width Width of radial vent ducts
Magnetic Spacer
Width

Width of magnetic spacer which hold vent ducts. 0 for non-magnetic
spacer.

Duct Pitch Vent ducts
Holes per Row Number of axial vent holes per row
Inner Hole Diameter Diameter of vent holes in inner row.
Outer Hole Diameter Diameter of vent holes in outer row.
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Inner Hole Location Center-to-center diameter of inner row hole vents.
Outer Hole Location Center-to-center diameter of outer row hole vents.
Banding Slots Number of axial banding slots to tight the rotor winding.
Width of Banding
Slots

Width of axial banding slots

Depth of Banding
Slots

Depth of axial banding slots

Defining the Commutator and Brush for a General DC Machine

The commutator allows current transfer between DC terminals or brushes and the rotor coils,
providing the current to the system as a function of rotation. Due to the action of the commutator, the
correspondingmagnetic field has a fixed distribution with respect to the stator.
To define the commutator and brush pairs:

1. To open theCommutator Data Propertieswindow, double-click the
Machine>Commutator entry in the project tree on the desktop. (You can also enter values in
theProperties section of the desktop without opening a separate window.)

2. Click theCommutator tab.
3. SelectCylinder or Pancake Type as theCommutator Type.

Note When you place themouse cursor over the commutator type, an outline of the
commutator appears.

4. ForCylinder commutators, do the following:
a. Enter theCommutator Diameter.
b. Enter theCommutator Length.

5. For Pancake commutators, do the following:
a. Enter theOuter Diameter.
b. Enter the Inner Diameter.

6. Enter the thickness of the insulation between two consecutive commutator segments in the
Commutator Insulation field.

7. Click theBrush tab.
8. Enter theBrush Width.
9. Enter theBrush Length.
10. Enter the number of brush pairs when using a wave armature winding in theBrush Pairs

field.
11. Enter the angle of displacement from the neutral axis, in mechanical degrees, in theBrush

Displacement field.
Note The brush displacement is positive for the counter-clockwise direction. For example,

if the rotor turns clockwise and the brush displacement is also clockwise, then the
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angle is negative; if the rotor turns clockwise but the brush displacement is counter-
clockwise, then the angle is positive.

12. Enter the voltage drop across one brush pair in theBrush Drop field.
13. Enter themechanical pressure of the brushes as they press against the commutator in the

Brush Press field.
14. Enter the Frictional Coefficient of the brush.

Note If the Friction Loss field is used in theGeneralwindow, theBrush Press and
Frictional Coefficient fields will be hidden in theCommutator/Brushwindow.
These fields are shown only when the Friction Loss field in theGeneralwindow is
set to zero.

15. ClickOK to close thePropertieswindow.

Commutator and Brush Data for General DC Machines

To access the commutator and brush data, double-click theMachine>Commutator entry in the
project tree.
TheCommutator Data Propertieswindow contains the following fields:

Commutator
tab

Commutator
Type

The type of commutator. Click the button to open theSelect
Commutator Typewindow and select fromCylinder or
Pancake.

Commutator
Diameter

For aCylinder commutator type, the diameter of the commutator.

Commutator
Length

For aCylinder commutator type, the length of the commutator.

Outer
Diameter

For aPancake commutator type, the outer diameter of the
commutator.

Inner
Diameter

For aPancake commutator type, the inner diameter of the
commutator.

Commutator
Insulation

The thickness of the insulation between the two commutator bars.

Brush tab Brush Width Thewidth of the brush.
Brush
Length

The length of the brush.

Brush Pairs The number of brush pairs.
Brush
Displacement

The displacement of the brush from the neutral position, in
mechanical degrees (positive for anti-rotating direction).

Brush Drop The voltage drop across a one-pair brush.
Brush Press The brush press per unit area. (Available only when Frictional

Loss is set to zero for themachine.)
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Frictional
Coefficient

The frictional coefficient of the brush. (Available only when
Frictional Loss is set to zero for themachine.)

Defining the Shaft Data for a General DC Machine

To define the shaft:
1. To open theShaft Data Propertieswindow, double-click theMachine>Shaft entry in the

project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Select or clear theMagnetic Shaft check box to specify whether or not the shaft is to be
made of magneticmaterial.

3. Select or clear theNo Fan check box to specify whether or not themachine contains a
ventilation fan.

4. If you cleared theNo Fan check box, then do the following:
a. Enter the outer diameter of the ventilation fan in the Fan Diameter field.
b. Enter the width of the fan blades in theBlade Width field.

5. ClickOK to close thePropertieswindow.

Shaft Data for General DC Machines

To access the shaft data, double-click theMachine>Shaft entry in the project tree.
TheShaft Data Propertieswindow contains the following fields:

Magnetic
Shaft

Select or clear this check box to indicate whether or not the shaft ismade of magnetic
material. When selected, the shaft ismagnetic. Default is unchecked for PM_
INTERIOR rotor type.

Frictional
Loss

The frictional lossmeasured at theReference Speed.

Windage
Loss or
Power

TheWindage Loss (or Power for wind power generators) measured at the
Reference Speed.

Reference
Speed

The speed at which the friction and windage losses aremeasured. Default is 3600
rpm for PM_INTERIOR and AXIAL_CAGE rotor types.

Setting Up Analysis Parameters for a General DC Machine

To define the solution data:
1. To open theSolution Setupwindow, right-clickAnalysis in the project tree, and clickAdd

Solution Setup.
2. Click theGeneral tab. TheOperation Type is automatically set toMotor for thismachine

type.
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3. Select the Load Type used in themotor from the following options:
Const
Speed

The speed remains constant in themotor.

Const
Power

The output power remains constant in themotor.

Const
Torque

The torque remains constant regardless of the speed. In this case, Tload = Trated,
given by the output power divided by the given rated speed.

Linear
Torque

The torque increases linearly with speed. In this case, Tload = Trated * (n/nrated)
where Trated is given by the output power divided by the given rated speed.

Fan
Load

The load varies nonlinearly with speed. In this case, Tload = Trated * (n/nrated)2
where Trated is given by the output power divided by the given rated speed.

4. Enter the output power in theRated Output Power field.
5. Enter the applied or output rated DC voltage in theRated Voltage field.
6. Enter the given rated speed in theRated Speed field.
7. Enter the temperature at which the system functions in theOperating Temperature field.
8. Click theDC Machine tab.
9. Select one of the following from the Field Exciting Type pull-down list:

l Separately Excited
l Self Excited

10. Enter theExciting Voltage, and select the units.
11. Enter theSeries Resistance, and select the units.
12. To automatically obtained the Exciting Voltage and Series Resistance via theRated Speed,

rather than entering their values, then select theDetermined by Rated Speed check box.
13. ClickOK to close theSolution Setupwindow.

Related Topics

Solution Data for General DC Machines

Solution Data for General DC Machines

To access the solution data, right-clickAnalysis in the project tree, and clickAdd Solution Setup.
For thismachine type, there is only one tab, theGeneral tab.
TheSolution Setupwindow contains the following fields:

Operation
Type

General tab. SelectMotor orGenerator from the pull-down list.

Load Type On theGeneral tab. For amotor, select fromConst Speed,Const Power,
Const Torque, Linear Torque, and Fan Load. The default isConst Power. For
a generator, select from Infinite Bus and Independent Generator.

Rated General tab. Type a value for the rated output voltage, and select the units.
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Output
Power
Rated
Voltage

General tab. Type a value for the rated voltage, and select the units.

Rated Speed General tab. Type a value for the rated speed, and select the units.
Operating
Temperature

General tab. Type a value for the operating temperature, and select the units.

Field
Exciting
Type

DC Machine tab. Select Separately Excited or Self Excited from the pull-down
list.

Determined
by Rated
Speed

Select this check box to automatically calculate theExciting Voltage and the
Series Resistance from theRated Speed, rather than entering the values.

Exciting
Voltage

Enter a voltage value in the field, and select the units from the pull-down list.

Series
Resistance

Enter a resistance value in the field, and select the units from the pull-down list.

Related Topics

Setting Up Analysis Parameters for a General DC Machine

Claw-Pole Alternators

After you have selectedClaw-Pole Alternators as your model type, enter themotor data to define
the following:

l General data, such as the output power, rated voltage, and speed.
l Stator data.
l Stator slot data.
l Stator winding data.
l Rotor data, such as the slot types and dimensions, rotor diameter, and lamination.
l Rotor pole data.
l Shaft data.
l Optional machine housing.
l Solution data.

Analysis Approach for Claw-Pole Alternators

Claw-pole alternators (or claw-pole synchronous generators) are widely used in auto industry. They
receivemechanical energy at the shaft and transform it into electrical energy.
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The stator of a claw-pole alternator is equipped with a polyphase winding. The rotor is comprised of
claw poleswith the same pole number as the stator winding. The claw poles of the rotor are
magnetized by a cylinder winding and/or a cylinder permanent magnet. The spinning rotor creates a
rotatingmagnetic field in the air gap, which produces induced voltage in the stator winding.
The performance of a claw-pole alternator is analyzed based on the frequency-domain phasor
diagram, as shown in the figure below.

If a claw-pole alternator is equipped with a permanent magnet, the d-axis armature reactanceXad
and q-axis armature reactanceXaq are about constant. Otherwise,Xad is a linearized nonlinear
parameter, andXaq is a linear parameter. The d-axis synchronous reactanceXd and q-axis
synchronous reactanceXq are calculated directly from the following:

Rotor Equipped with an Excitation Winding

If the rotor is equipped with an excitation winding, the exciting current can be adjusted, and the d-
and the q-axis currents are obtained based on the following process.
Take the input voltageU as the reference phasor, let the power factor angle be f, then the current
phasor is
The phasor represented byOM can be expressed as
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The phasor represented byOM can be used to determine the direction of E0.

Let denote the power angle (the angle thatU lagsE0), then the angle that I lagsE0 is

The d- and the q-axis currents are obtained as follows

In the phasor diagrams, the phasor length ON represents the d-axis back emf due to the d-axis
resultant flux linkage and is used to determine the d-axis field saturation. From the no-load
characteristic curve of themagnetic circuit,E0, Xad and the excitation current If can be determined
based on the frozenmethod.

Rotor Equipped with a Permanent Magnet Only

If the rotor is equipped with a permanent magnet only, the field excitation can not be adjusted, and
the d- and the q-axis currents are obtained based on the following process.

For a given power angle (the angle thatU lagsE0), we have
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Solving for Id and Iq yields.

Let the angle that I lagsE0 be , we have

The power factor angle f (the angle that I lagsU) is

Power and Efficiency

The output electric power is
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The input mechanical power is

wherePfw, PCua, PFe, , andPCuf are the frictional and wind, the armature copper, the iron-core, the
excitation winding copper (if an excitation winding is equipped) losses, respectively.
The input mechanical torque is

where denotes the synchronous speed in rad/s.
The efficiency of the generator is:

Defining a Claw-Pole Alternator

The general procedure for defining a claw-pole alternator is as follows:
1. Create the alternator project.
2. Double-click theMachine entry in the project tree to define the general data.
3. Double-click theMachine-Stator entry in the project tree to define the stator geometry.
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4. Double-click theMachine-Stator-Slot entry in the project tree to define the stator slot
dimensions.

5. Double-click theMachine-Stator-Winding entry in the project tree to define the stator
windings and conductors.

6. Double-click theMachine-Rotor entry in the project tree to define the rotor geometry.
7. Double-click theMachine-Rotor-Pole entry in the project tree to define the pole, embrace,

offset, and air gap data for the rotor pole.
8. Double-click theMachine-Shaft entry in the project tree to define themagnetism of the shaft.
9. Optionally, right-click theMachine entry in the project tree and click Insert Housing to add a

machine housing.
10. Right-clickAnalysis in the project tree, and clickAdd Solution Setup to define the solution

data.
11. Choose File>Save to save the project.
12. ChooseRMxprt>Analyze to analyze the design.

Note When you place the cursor over an entry field in the data windows, a brief
description of that field appears in the status bar at the bottom of theRMxprt
window.

Once analyzed, themodel can be viewed in theMaxwell 2D Modeler, or it can be used to create a
new Maxwell 2D project, and new Maxwell 3D design.
Refer to theClaw-Pole Alternator Problem application note, on the technical support page of the
ANSYS web site, for a specific example of a permanent-magnet DC motor problem.

Defining the General Data for a Claw-Pole Alternator

Use theGeneral window to define the basic parameters of the alternator, such as the power
settings, speed, and rated voltage.
To define the general data:

1. To open theGeneral Data Propertieswindow, double-click theMachine entry in the project
tree on the desktop. (You can also enter values in theProperties section of the desktop
without opening a separate window.)

2. Enter the number of poles for themachine in theNumber of Poles field. This value is the total
number of poles in the stator (or the number of pole pairsmultiplied by two).

3. Enter or select theNumber of Phases (2, 3, or 4).
4. Enter the energy loss due to friction at the given speed in the Frictional Loss field.
5. Enter the wind loss due to air resistancemeasured at the reference speed in theWind Loss

field.
6. Enter the given speed in theReference Speed field.
7. ClickOK to close thePropertieswindow.
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General Data for Claw-Pole Alternators

To access the general data, double-click theMachine entry in the project tree.
TheGeneral Data Propertieswindow for a three-phase inductionmotor contains the following
fields:

Machine Type Themachine type you selected when inserting a new RMxprt design (Claw-Pole
SynchronousMachine).

Frictional
Loss

The frictional energy loss (due to friction and air resistance) measured at the
reference speed.

Number of
Poles

The number of poles themachine contains.

Number of
Phases

The number of phases.

Wind Loss Thewind lossmeasured at the reference speed.
Reference
Speed

The given speed of reference.

Defining the Stator Data for a Claw-Pole Alternator

Use theStator Properties windows to define the stator dimensions, slots, windings, and
conductors.
The stator is the outer lamination stackwhere the polyphase voltage windings reside.
To define the general stator data:

1. To open theStator Data Propertieswindow, double-click theMachine>Stator entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter theOuter Diameter of the stator.
3. Enter the Inner Diameter of the stator.
4. Enter the length of the stator core in the Length field.
5. Enter the stacking factor for the stator core in the Stacking Factor field. This value is a ratio

of he effectivemagnetic length of the core, and ranges from 0 to 1. The stacking factor is
defined as the total lengthminus the total insulation from the laminations, divided by the total
length. A value of 1 indicates that the rotor is not laminated.

6. Select aSteel Type for the stator core:
a. Click the button for Steel Type.

TheSelect Definitionwindow appears.
b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

7. Enter theNumber of Slots in the stator.
8. Select theSlot Type:
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a. Click the button for theSlot Type.
TheSelect Slot Typewindow appears.

b. Select a slot type (available types include 1 through 4).
Note When you place themouse cursor over the slot type, a schematic of the selected

type appears, displaying the slot dimension variables.

Optionally, checkUser Defined Slot if you wish to define the slot dimensions using theSlot
Editor.

c. ClickOK to close theSelect Slot Type window and return to thePropertieswindow.
9. Enter the skew width, measured in slot number, in theSkew Width field.
10. ClickOK to close thePropertieswindow.

Stator Data for Claw-Pole Alternators

To access the general stator data, double-click theMachine>Stator entry in the project tree.
TheStator Data Propertieswindow contains the following fields:

Outer
Diameter

The outer diameter of the stator core.

Inner
Diameter

The inner diameter of the stator core.

Length The length of the stator core.
Stacking
Factor

The stacking factor of the stator core.

Steel Type The steel type of the stator core. Click the button to open theSelect Definition
window.

Number of
Slots

The number of slots the stator core contains.

Slot Type The type of slots in the stator core. Click the button to open theSelect Slot Type
window.

Skew Width The skew widthmeasured in slot number.

Defining the Stator Slot Data for a Claw-Pole Alternator

To define the stator slots:
1. To open theStator Slot Data Propertieswindow, double-click theMachine-Stator-Slot

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Optionally, to automatically design the dimensions of slotsHs2,Bs1, andBs2, select the
Auto Design check box.
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3. Optionally, to design dimensions of slotsBs1 andBs2 based on the stator tooth width, select
theParallel Tooth check box, and enter a value in the Tooth Width field.

4. Enter the available slot dimensions.
Hs0 Always available.
Hs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.
Bs0 Always available.
Bs1 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto

Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

Bs2 Available only whenAuto Design and Parallel Tooth are both cleared.WhenAuto
Design is selected, this slot dimension is determined automatically. WhenParallel
Tooth is selected, this slot dimension is determined based on the value entered in the
Tooth Width field.

Rs Rs is added when the slot type is 3 or 4.

5. ClickOK to close thePropertieswindow.

Stator Slot Data for Claw-Pole Alternators

To access the stator slot data, double-click theMachine-Stator-Slot entry in the project tree.
TheStator Slot Data Propertieswindow contains the following fields:

Auto
Design

Select or clear this to enable or disable auto-design of slotsHs2,Bs1, andBs2. When
this check box is selected, only two other fields appear in the window:Hs0 andBs0.

Parallel
Tooth

Select this to designBs1 andBs2 based on the tooth width. When this check box is
selected, theBs1 andBs2 fields are removed, and the Tooth Width field is added.

Tooth
Width

The tooth width for the parallel tooth, on whichBs1 andBs2 are designed.

Hs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Hs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Hs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs0 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs1 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).

Bs2 A slot dimension (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected).
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Rs A slot dimension. (see the diagram shown in themodeling window whenMachine-
Stator-Slot is selected). Rs is added when the slot type is 3 or 4.

Defining the Stator Winding Data for a Claw-Pole Alternator

To define the stator windings and conductors:
1. To open theStator Slot Winding Propertieswindow, double-click theMachine-Stator-

Winding entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Click theWinding tab.
3. Enter the number of layers in the stator winding in theWinding Layers field.
4. Select aWinding Type:

a. Click the button forWinding Type.
TheWinding Typewindow appears.

b. Select from one of the following three types of winding:
l Whole Coiled
l Half Coiled
l Editor

5. Select or enter the number of parallel branches in one phase of the winding in theParallel
Branches field.

6. Enter the total number of conductors in each stator slot in theConductors per Slot field. This
value is the number of turns per coil multiplied by the number of layers.

7. Enter the coil pitch, measured in number of slots, in theCoil Pitch field. The coil pitch is the
number of slots separating one winding. For example, if a coil starts in slot 1 and ends in slot 6,
it has a coil pitch of 5.

8. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to have
RMxprt auto-design this value.

9. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to
automatically obtain this value from the wire library.
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10. Select theWire Size:
a. Click the button forWire Size.

TheWire Sizewindow appears.
b. Select a value from theWire Diameter pull-down list.
c. Select a wire gauge from theGauge pull-downmenu. You can select from the following

options:
<

number
>

You can select a specific gauge number. When you select a gauge number,
theWire Diameter field is automatically updated.

USER
This option allows you tomanually enter theWire Diameter. This is useful
when you want to enter a diameter that does not correspond to a particular
wire gauge.

AUTO
This option sets theWire Diameter to zero, and RMxprt automatically
calculates the optimal value. The diameter information is then written to the
output file when you analyze the design.

MIXED
This option allows you to define a conductor that ismade of different size wires.
For example, a single conductor may consist of 5 wires, 3 wires with a diameter
of 0.21mmand 2 with a diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.

a. When you are done setting the wire size, clickOK to close theWire Sizewindow and
return to thePropertieswindow.

b. Click theEnd/Insulation tab.
c. Select or clear the Input Half-turn Length check box.
d. Do one of the following:

l If you selected Input Half-turn Length, then enter the half-turn length of the armature
winding in the Half Turn Length field.

l If you cleared Input Half-turn Length, then enter the end length adjustment of the stator
coils in theEnd Adjustment field. The end adjustment is the distance one end of the
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conductor extends vertically beyond the end of the stator.

5. Enter the inner radius of the base corner in theBase Inner Radius field.
6. Enter the inner diameter of the coil tip in the Tip Inner Diameter field.
7. Enter the distance between two stator coils in theEnd Clearance field.
8. Enter the thickness of the slot liner insulation in theSlot Liner field.

9. Enter the thickness of the wedge insulation in theWedge Thickness field.
10. Enter the thickness of the insulation layer in the Layer Insulation field.
11. Enter the limited slot fill factor for the wire design in the Limited Fill Factor field. The slot fill

factor is the ratio between the cross-sectional area of all conductors in one slot and the entire
slot area.

12. ClickOK to close thePropertieswindow.

Getting Started with RMxprt 26-405
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Winding Editor for a Claw-Pole Alternator

For a claw-pole alternator, youmaywant to specify a different number of conductors for each stator
slot. TheWinding Editormakes this possible by enabling you to specify the number of turns for
each coil.
To specify the number of turns for each coil:

1. ClickMachine>Winding>Edit Layout.
TheWinding Editor window appears.

2. In the table in the upper left, set which phase you want for each coil and which slot is the “in”
and “out” slot for the current in each coil.

3. If you are working on a quarter or half model, youmaywant to specify amultiplier by clicking
thePeriodic Multiplier check box and specifying a value.

4. Select or deselect theConstant Turns orConstant Pitch check boxes, depending on
whether you want to be able to change these setting in the table above.When these options
are selected, you cannot change the turns or pitch.

5. When you are satisfied with the coil settings, clickOK to close theWinding Editor window.

Defining Different Size Wires for a Claw-Pole Alternator

Use theGauge option in theWire Size window if you have a conductor that ismade up different size
wires.
To define different size wires:

1. In theWire Size window, selectMIXED from theGauge pull-downmenu.
2. Select eitherRound orRectangular as theWire Type.
3. Enter the appropriate wire data in the table:

l For a round wire:
l Enter theDiameter in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
diameter.

l For a rectangular wire:
l Enter theWidth of the wire in the table.
l Enter the Thickness of the wire in the table.
l Enter the Fillet value in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this data.

4. ClickAdd to add the new wire data.
5. Repeat steps 3 and 4 for each size wire you want to add.
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6. When you are finished defining the wires, clickOK to close theWire Sizewindow and return
to the RMxprtPropertieswindow.
Note For example, if one conductor ismade up of 5 wires, and 3 of those wires have a

diameter of 0.21mm, and the other 2 have a diameter of 0.13mm, then themixed
wire size table will have two lines. The first line will list Diameter = 0.21 and Number
= 3. The second line will list Diameter = 0.13 and Number = 2. An equivalent wire
diameter is displayed asWire Size value in theWinding tab in the Properties
window.

Stator Winding Data for Claw-Pole Alternators

To access the stator winding data, double-click theMachine-Stator-Winding entry in the project
tree.
TheStator Winding Data Propertieswindow contains the following fields:

Winding tab Winding Layers The number of winding layers.
Winding Type The type of stator winding. Click the

button to open theWinding Type
window and choose fromWhole
Coiled,Half Coiled, andEditor.

Parallel Branches The number of parallel branches in the
stator winding.

Conductors per Slot The number of conductors per stator slot
(0 for auto-design).

Coil Pitch The coil pitchmeasured in number of
slots.

Number of Strands The number of wires per conductor (0 for
auto-design).

Wire Wrap The thickness of the double-sided wire
wrap (0 to automatically obtain this value
from the wire library).

Wire Size The diameter of the wire (0 for auto-
design). Click the button to open the
Wire Sizewindow where you can
specify units, wire type, diameter, and
gauge.

End/Insulation tab Input Half-turn Length Select or clear this check box to specify
whether or not you want to enter the
half-turn length. When this check box is
selected, theHalf Turn Length field
appears the next time you open the
Propertieswindow.When this check
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box is selected, theEnd Adjustment
field appears instead.

Half Turn Length The half-turn length of the armature
winding.

End Adjustment The end length adjustment of the stator
coils, which is the distance one end of
the conductor extends vertically beyond
the end of the stator.

Base Inner Radius The inner radius of the base corner.
Tip Inner Diameter The inner diameter of the coil tip.
End Clearance The end clearance between two

adjacent coils.
Slot Liner The thickness of the slot liner insulation.
Wedge Thickness The thickness of the wedge insulation.
Layer Insulation The thickness of the insulation layer.
Limited Fill Factor The limited slot fill factor for the wire

design. The slot fill factor is the ratio
between the cross-sectional area of all
conductors in one slot and the entire slot
area.

Defining the Rotor Data for a Claw-Pole Alternator

The rotor is equipped with slots containing copper conductors that are connected to the commutator.
The commutator acts as amechanical rectifier in themotor.
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The rotor consists of copper bars in which current is induced by themagnetic fields produced by the
stator windings. In the project tree, double-clickMachine-Rotor andMachine-Rotor-Pole to
define the rotor and the pole.
To define general rotor data:

1. To open theRotor Data Propertieswindow, double-click theMachine>Rotor entry in the
project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter the outer diameter of the rotor in theOuter Diameter field.
3. Enter the inner diameter of the rotor in the Inner Diameter field.
4. Enter the length of the rotor core in the Length field.
5. Select aSteel Type for the rotor core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

6. Enter the diameter of the rotor yoke in theYoke Diameter field.
7. ClickOK to close thePropertieswindow.

Rotor Data for Claw-Pole Alternators

To access the general rotor data, double-click theMachine>Rotor entry in the project tree.
TheRotor Data Propertieswindow contains the following fields:

Outer
Diameter

The outer diameter of the rotor core.

Inner
Diameter

The inner diameter of the rotor core.

Length The length of the rotor core.
Steel Type The steel type of the rotor core. Click the button to open theSelect Definition

window.
Yoke
Diameter

The diameter of the rotor yoke.

Defining the Rotor Pole for a Claw-Pole Alternator

The rotor pole drives the electromagnetic field which is coupled with the stator windings. Use the
Rotor Pole Data Properties window to define the rotor pole.

Note Some of the fields in theRotor Pole window change, or are inactive, depending on the
Rotor Type you select.

To define the rotor pole:
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1. To open theRotor Pole Data Propertieswindow, double-click theMachine-Rotor-Pole
entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Enter the pole embrace at the pole tip in the Tip Embrace field. This valuemust be between 0
and 1, exclusive.

3. Enter the pole embrace at the pole root in the Root Embrace field. This valuemust be
between 0 and 2, exclusive.

4. Enter the pole thickness at the pole tip in the Tip Thickness field.
5. Enter the pole thickness at the pole root in the Root Thickness field.
6. Enter thePole Length.
7. Enter theSlot Depth.
8. Enter the Shoe Thickness.
9. Select the type of magnet to use in the rotor pole from theMagnet Type pull-downmenu.
10. If a magnet is being used, enter its length in theMagnet Length field.
11. Enter the width of the second air gap in theSecond Air Gap field.
12. ClickOK to close thePropertieswindow.

Rotor Pole Data for Claw-Pole Alternators

To access the pole rotor data, double-click theMachine-Rotor-Pole entry in the project tree.
TheRotor Pole Data Propertieswindow contains the following fields:

Tip Embrace The pole embrace at the pole tip. Must be > 0 and < 1.
Root
Embrace

The pole embrace at the pole root. Must be > 0 and < 2.

Tip
Thickness

The pole thickness at the pole tip.

Root
Thickness

The pole thickness at the pole root.

Pole Length The length of the pole.
Slot Depth The slot depth.
Shoe
Thickness

The shoe thickness.

Magnet Type The type of magnet. Click the button to open theSelect Definitionwindow. For
all pole types.

Magnet
Length

The length of themagnet (if a magnet is used).

Second Air
Gap

Thewidth of the second air gap.
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Defining the Shaft Data for a Claw-Pole Alternator

To define the shaft:
1. To open theShaft Data Propertieswindow, double-click theMachine>Shaft entry in the

project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Select or clear theMagnetic Shaft check box to specify whether or not the shaft is to be
made of magneticmaterial.

3. ClickOK to close thePropertieswindow.

Shaft Data for Claw-Pole Alternators

To access the shaft data, double-click theMachine>Shaft entry in the project tree.
TheShaft Data Propertieswindow contains the following fields:

Magnetic
Shaft

Select or clear this check box to indicate whether or not the shaft ismade of
magneticmaterial.

Setting Up Analysis Parameters for a Claw-Pole Alternator

To define the solution data:
1. To open the Solution Setup window, right-clickAnalysis in the project tree, and clickAdd

Solution Setup.
2. Click theGeneral tab. TheOperation Type is automatically set toGeneral for thismachine

type.
3. Select the Load Type used in themachine from the following options:

Infinite Bus When the generator is connected to an infinite bus of the power system, the
terminal voltages remain constant and the output power is determined by the
output currents.

Independent
Generator

The generator supplies electrical power to a load inductor. For an AC
generator, the resistance and inductance of the load inductor are determined
by the rated output power, the rated voltage, and the rated power factor. For
a DC generator, the resistance of the load resistor is determined by the rated
output power and the rated voltage.

4. Enter the output power developed at the shaft of the generator in theRated Output Power
field.

5. Enter the RMS line-to-line voltage in theRated Voltage field.
6. Enter the desired output speed of the alternator at the load point in theRated Speed field.
7. Enter the temperature at which the system functions in theOperating Temperature field.
8. Click theClaw-Pole Synchronous Machine tab.
9. Enter a value in theRated Power Factor field.
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10. To enter an Input Exciting Current, select the check box, enter a value, and select the units.
11. ClickOK to close theSolution Setupwindow.

Related Topics

Solution Data for Claw-Pole Alternators

Solution Data for Claw-Pole Alternators

To access the solution data, right-clickAnalysis in the project tree, and clickAdd Solution Setup.
For thismachine type, there is only one tab, theGeneral tab.
TheSolution Setupwindow contains the following fields:

Operation
Type

General tab. SelectMotor orGenerator from the pull-down list.Generator is
automatically selected for thismachine type

Load Type On theGeneral tab. Select from Infinite Bus and Independent Generator.
Rated
Output
Power

General tab. Type a value for the rated output voltage, and select the units.

Rated
Voltage

General tab. Type a value for the rated voltage, and select the units.

Rated Speed General tab. Type a value for the rated speed, and select the units.
Operating
Temperature

General tab. Type a value for the operating temperature, and select the units.

Rated Power
Factor

Claw-Pole Synchronous Machine tab. Type a value in the field.

Input
Exciting
Current

Select this check box, enter a value, and select the units. If this check box is
cleared, the value will be calculated automatically rather than entered.

Related Topics

Setting Up Analysis Parameters for a Claw-Pole Alternator

Three-Phase Non-Salient Synchronous Machines (NSSM)

After you have selected Three-Phase Non-Salient SynchronousMachine as your model type, enter
the data to define the following:

l General data, such as the number of poles, frictional loss, and reference speed.
l Stator pole and winding data, such as its associated pole dimensions, type of steel, and wire
definitions.
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l Rotor data, such as the slot types and dimensions, rotor diameter, laminations, and windings
and conductors.

l Commutator and brush data, such as the commutator dimensions and brush length.
l Shaft data.
l Optional machine housing.
l Solution data.

Also see Analysis Approach for the Three-Phase Non-Salient SynchronousMachine

Analysis Approach for Three-Phase Non-Salient Synchronous Machines

The three-phase non-salient-pole synchronous electricmachine has two types: the generator and
themotor. Their basic structures are the same. The three-phase non-salient-pole synchronous
generators are themain source of the electrical energy for industrial, commercial, and private use.
They receive themechanical energy at the shaft and transform it into the electrical energy. The rotor
is equipped with a non-salient-pole winding excited by a DC source. The stator is equipped with a
three-phase winding that has a sinusoidal spatial distribution. The spinning rotor produces a rotating
magnetic field in the air gap of themachine. The frequency of the voltage induced in the stator is
given by:

where p is the number of pairs of poles, and n is themechanical speed of the rotor in rpm, which is
called the synchronous speed. Themachine is capable of producing both the active and the reactive
power as required by the load connected at the stator terminal.
Usually the frequency-domain phasor diagram is adopted to analyze the characteristics. The phasor
diagrams for a generator and amotor are shown.
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In the figure,R1, X1, andXa are the armature resistance, the armature leakage reactance, and the
armature reactance, respectively. In a non-salient-pole synchronousmachine,Xad≅Xaq and they
are both expressed byXa. Taking the input voltageU as the reference phasor, for a given current:

where ϕ is the angle I lagsU , which is called the power factor angle.
The internal back EMF induced by the resultant air gap field considering the effects of armature
reactionEi can be derived from:
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Based onEi, the resultant air gap flux considering the effects of armature reaction can be computed,
and therefore, themagnetic circuit can be solved.With solvedmagnetic saturation factor, saturated
Xa is derived, and therefore, the no-load induced voltageE0 with the samemagnetic saturation
(frozenmagnetic circuit) can be calculated from:

Let the angleU legsE0 be θ, which is called the power angle for the generator or the torque angle for
themotor, then the angle I lagsE0 is

The d- and the q-axis currents can be obtained respectively as follows:

Based on themagnetic circuit solution andE0, Xa and the excitation current If can be determined
based on the frozenmethod.

1. For the generator:
The output power (electric power) is directly computed from the voltage and the current as:

The input power (mechanical power) is defined as:
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wherePfw, PCua, PFe, Padd, Pcuf andPex are the frictional and wind loss, the armature copper loss,
the iron-core loss, the additional loss, the field winding copper loss, and the exciter loss, respectively.
The input mechanical shaft torque is:

whereω denotes the synchronous speed in rad/s.
1. For themotor:

The input power (electric power) is directly computed from the voltage and the current as:

The output power (mechanical power) is defined as:

wherePfw, PCua, PFe, Padd, Pcuf andPex are the frictional and wind loss, the armature copper loss,
the iron-core loss, the additional loss, the field winding copper loss, and the exciter loss, respectively.
The output mechanical shaft torque is:

The efficiency is computed for both the generator and themotor by:
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Related Topics

Defining Three-Phase Non-Salient SynchronousMachines

Defining Three-Phase Non-Salient Synchronous Machines

The general procedure for defining a three-phase non-salient synchronousmachine is as follows:
1. Create the non-salient synchronousmachine project.
2.

After you have selected Three-Phase Non-Salient Synchronous Machine as your model type,
youmust define the following:

l General data, such as number of poles, losses, and reference speed.
l Stator data, such as dimensions, slot type, skew, and laminations.
l Define the Stator slot dimensions.
l Winding data, such as the parallel branches, conductors, and wire dimensions and insulation.
l Rotor data, such as the rotor dimensions, lamination and slot type.
l Define the Rotor slot data.
l Define the Shaft Data.
l Solution data, such as specifyingmotor or generator application, and rated output voltage and
frequency.

Youmay also use the following options:
l Add amachine housing.
l Add a damper to or remove an existing damper from the rotor;
l Add vents to and remove existing vents from the stator.

Defining the General Data for a Three-Phase NSSM

To access the general data, double-click theMachine entry in the project tree.
ThePropertieswindow for a three-phase non-salient synchronousmachine contains the following
fields to be entered:

Machine
Type

Themachine type you selected when inserting a new RMxprt design (Three Phase
Non-Salient SynchronousMachine).

Number
of Poles

The number of poles themachine contains. This value is the total number of poles in
the stator (or the number of pole pairsmultiplied by two).

Frictional
Loss

The frictional energy loss (due to friction) measured at the reference speed.

Windage
Loss

Thewindage loss (due to air resistance) measured at the reference speed.

Reference
Speed

The given speed of reference.
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Related Topics

Defining the Stator for Three-Phase NSSM

Defining the Stator for Three-Phase NSSM

The stator is the outer lamination stackwhere the three-phase windings reside.
Double-click the iconMachine>Stator in the project tree to display theProperties dialog box.
ThePropertieswindow contains the following fields:

Outer Diameter The outer diameter of the stator.
Inner Diameter The inner diameter of the stator.
Length The length of the stator core.
Stacking Factor The stacking factor of the stator core.
Steel Type The steel type of the stator core. Click the button to open theSelect

Definition window.
Number of Slots The number of slots the stator core contains.
Slot Type The type of slots in the stator core. Click the button to open theSelect Slot

Typewindow.
Lamination
Sectors

The number of lamination sectors.

Pressboard
Thickness

Themagnetic press board thickness (enter 0 for a non-magnetic press
board).

Skew Width The skew widthmeasured in slot number.

To define general stator data:
1. To open theStator Data Propertieswindow, double-click theMachine>Stator entry in the

project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Enter theOuter Diameter of the stator.
3. Enter the Inner Diameter of the stator.
4. Enter the length of the stator core in the Length field.
5. Enter the stacking factor for the stator core in the Stacking Factor field.
6. Select aSteel Type for the stator core:

a. Click the button for Steel Type.
TheSelect Definitionwindow appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition window and return to thePropertieswindow.

7. Enter theNumber of Slots in the stator.
8. Select theSlot Type:
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a. Click the button for theSlot Type.
TheSelect Slot Typewindow appears.

b. Select a slot type (available types include 1 through 6). Slot types 1 though 4 are filled with
round wire. Slot types 5 and 6 are filled with rectangular wire. IfAuto Design is enabled,
the software designs an optimum slot geometry; in this case, you can input the tooth width
dimension, and the software determines the slot width accordingly.
Note When you place themouse cursor over the slot type, a schematic of the selected

type appears, displaying the slot dimension variables.

Optionally, checkUser Defined Slot if you wish to define the slot dimensions using theSlot
Editor.

c. ClickOK to close theSelect Slot Type window and return to thePropertieswindow.
9. Enter the number of sectors in the Lamination Sectors field.
10. Enter the thickness of themagnetic pressboard in thePressboard Thickness field. Enter 0

for a non-magnetic pressboard.
11. Enter the skew width, measured in slot number, in theSkew Width field.
12. ClickOK to close thePropertieswindow.

Related Topics

Defining Stator Slots for a Three-Phase NSSM

Defining Stator Slots for a Three-Phase NSSM

To define the slot dimensions:
1. To open theStator Slot Data Propertieswindow, double-click theMachine>Stator>Slot

entry in the project tree on the desktop. (You can also enter values in theProperties section
of the desktop without opening a separate window.)

2. Optionally, to automatically design the dimensions of slotsHs2,Bs1, andBs2, select the
Auto Design check box.

3. Enter the available slot dimensions.
Hs0 Always available.
Hs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.
Bs0 Always available.
Bs1 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.
Bs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.

4. ClickOK to close thePropertieswindow.
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Related Topics

Defining Stator Windings and Insulation for a Three-Phase NSSM

Defining Stator Windings and Insulation for a Three-Phase NSSM

Double-click the iconMachine>Stator>Winding in the project tree to display theProperties dialog
box, which has two tab sheets:Winding andEnd/Insulation.

Define Wires, Conductors and Windings of NSSM Stator

In theWinding tab, define the wire, conductor and winding of the stator.

Winding
Layers

The number of layers in the stator winding. Select the winding layers from the pull-
down list (available choices 1 and 2).

Winding
Type

The type of the stator winding. Set the winding type toEditor to use theWinding
Editor dialog to design the coil windings

Parallel
Branches

The number of parallel branches in one phase of the stator winding.

Conductors
per Slot

The total number of conductors in each stator slot. This value is the number of turns
per coil multiplied by the number of layers. Enter 0 to have RMxprt auto-design this
value.

Coil Pitch The coil pitchmeasured in number of slots. The coil pitch is the number of slots
separating one winding. For example, if a coil starts in slot 1 and ends in slot 6, it has
a coil pitch of 5.

Number of
Strands

The number of wires per conductor. Enter 0 to have RMxprt auto-design this value.

Wire Wrap The thickness of the double-sided wire wrap. Enter 0 to automatically obtain this
value from the wire library.

Wire Size Wire size (0 for auto-design). You can assign wire size of round wires or rectangle
wires. When the slot type you selected is 1 to 4, round wires are used.When the slot
type you selected is 5 or 6, rectangle wires are used.

Related Topics

Define EndWindings and Insulation of NSSMStator
Winding Editor

Define End Windings and Insulation of NSSM Stator

In the tab sheetEnd/Insulation, define the end winding and the insulation of the stator.
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Input Half-
turn
Length

Select or clear this check box to specify whether or not you want to enter the half-
turn length. When this check box is selected, the row Half Turn Length appears
the next time you open theProperties dialog box.When this check box is cleared,
the row End Adjustment appears instead.

Half-turn
Length

The half-turn length of the armature winding. It is available when Input Half-turn
Length is selected.

End
Adjustment

The end length adjustment of the stator coils, which is the distance of one end of the
conductor extending vertically beyond the end of the stator. It is available when
Input Half-turn Length is cleared.

Base Inner
Radius

The inner radius of the base corner.

Tip Inner
Diameter

The inner diameter of the coil tip.

End
Clearance

The end clearance between two adjacent stator coils.

Coil Wrap Single-side coil wrap insulation thickness.
Slot Liner The thickness of the slot liner insulation.
Wedge
Thickness

The thickness of the wedge insulation.

Layer
Insulation

The thickness of the insulation layer.

Bottom
Insulation

Bottom insulation thickness.

Related Topics

DefineWires, Conductors, andWindings of NSSMStator

Winding Editor

For a non-salient synchronousmotor, youmaywant to specify a different number of conductors for
each stator slot. TheWinding Editormakes this possible by enabling you to specify the number of
turns for each coil. To enable theWinding Editor, youmust have set theWinding Property for the
Winding Type toEditor.

Stator Vent Data for Three-Phase NSSM

To insert a vent on a stator for a three phase synchronousmachine:
1. Right click on the stator icon in the project tree to display the shortcut menu.
2. Click Insert Vent.

The vent icon appears in the project tree under the stator.
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To remove an existing vent item,
1. Right-click on the stator icon in the project tree to display the shortcut menu.
2. ClickRemove Vent.

This removes the vent item from the project tree.
To access the Vent properties for a vent, double click on a vent item. TheVent Propertieswindow
contains the following fields.

Vent Ducts The number of radial vent ducts.
Duct Width Thewidth of the radial vent ducts.
Magnetic spacer
width

Width of magnetic spacer which holds vent ducts. O for non-magnetic
spacer.

Duct pitch. Center-to-Center distance between two adjacent Vent ducts

Define NSSM Rotor Data

Double-click the iconMachine>Rotor in the project tree to display theProperties dialog box, which
has one tab sheet:Rotor. In theRotor tab, define the rotor general data.

Outer Diameter The outer diameter of the rotor core.
Inner Diameter The inner diameter of the rotor core.
Length The length of the rotor core.
Stacking Factor Stacking factor of the rotor core.
Steel Type Select a steel type for the rotor corematerial.
Press Board
Thickness

Magnetic press board thickness, 0 for non-magnetic press board.

Indexing Slots Number of indexing slots of the rotor core used to determine slot
pitch.

Real Slots Number of Slots of the rotor core.
Slot Type Slot type of the rotor core. There are six types of rotor slots.

Define NSSM Rotor Slot

Double-click the iconMachine>Rotor>Slot in the project tree to display theProperties dialog box.
In theSlot tab, define the available rotor slot dimensions as illustrated. There are in total six types of
slots that are available:
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Related Topics

Define NSSMRotor Winding

Define NSSM Rotor Winding

The rotor winding is equipped on the rotor pole to provide the excitation for themagnetic field.
Double click the iconMachine>Rotor>Winding in the project tree to display theProperties dialog
box, where you define the wires and physical dimensions of the rotor winding.
In theWinding tab, the following are defined:.

Parallel
Branches

The number of parallel branches in the rotor winding.
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Conductors
per Slot

The number of conductors per slot (0 for auto-design).

Number of
Strands

The number of wires per conductor (0 for auto-design).

Wire Wrap The thickness of the double-sided wire wrap (0 to automatically obtain this value
from the wire library).

Wire Size Wire size (0 for auto-design). You can assign wire size of round wires or rectangle
wires. When you select RoundWire for Winding Type, round wires are used ((refer
to section 8.4.1 Assign RoundWire Sizes). Otherwise, rectangle wires are used
(refer to section 8.4.2 Assign Rectangular Wire Size).

In theEnd/Insulation tab the following are defined:

Input Half-
turn
Length

Select or clear this check box to specify whether or not you want to enter the half-
turn length. When this check box is selected, the row Half Turn Length appears
the next time you open theProperties dialog box.When this check box is cleared,
the row End Adjustment appears instead.

Half-turn
Length

The half-turn length of the armature winding. It is available when Input Half-turn
Length is selected.

End
Adjustment

One-side end extended length.

Inner Fillet
Radius

Inner fillet radius at the span corner.

End
Clearance

End clearance between two adjacent coils.

Coil Wrap Insulation: single-side coil wrap thickness.
Slot Liner Insulation: slot liner thickness.
Wedge
Thickness

Insulation: wedge thickness.

Bottom
Insulation

Insulation: bottom insulation thickness.

Limited
Cross
Height

The limited cross-section height for the winding design or arrangement, or Overall
Height as shown in Figure 12.12 (0 for availablemaximumarea).

Winding
Fillet

The size of the winding fillet.

Related Topics

Define NSSMShaft Data
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Rotor Vent Data for NSSMs

By option, you can add vents to a rotor in a three-phase NSSM.
To add a vents to the rotor:

1. Select the rotor icon in the project tree.
2. Right-click to display the pop-upmenu and select Insert Vent.

The vent icon appears in the project tree under the rotor.
To remove a vent to stator in a three-phase inductionmotor.

1. Select the rotor icon in the project tree.
2. Right-click to display the pop-upmenu and selectRemove Vent.

The vent icon disappears in the project tree under the stator.
The Vent data for the NSSM rotor includes the following fields.

Surface Ducts Number of surface tangential vent
ducts

Surface Duct
Width

Width of surface tangential vent ducts

Surface Duct
Depth

Depth of surface tangential vent ducts

Surface Duct Pitch Pitch of surface tangential vent ducts
Axial Ducts Number of axial vent ducts per pole
Axial Duct Width Width of axial vent ducts in main teeth
Axial Duct Depth Depth of axial vent ducts in main teeth

Define NSSM Shaft Data

To define the shaft:
1. Click the iconMachine>Shaft in the project tree to display theProperties dialog box.
2. In the tab sheet Shaft, select or clear the check boxMagnetic Shaft to specify whether or not

the shaft is to bemade of themagneticmaterial.
3. ClickOK to close theProperties dialog box.

Analysis Setup for Three-Phase Non-Salient Synchronous Machines

Add Solution Setup for NSSM

To set up the solution data:
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1. Right click the icon Analysis in the project tree, then click Add Solution Setup from the shortcut
menu to display the dialog box Properties. There are two tab sheets.

2. On theGeneral tab, define the solution setup data.
Operation
Type

Two options from the pull-down list: Generator andMotor.

Load Type Select a load type for themotor or generator from the pull-down list (refer to
section 7.8 Assign Load Types).

Rated
Apparent
Power

The output electric apparent power in kVA developed at the terminal for the
generator, or
Rated Output Power: The output mechanical power in kW developed at
the shaft for themotor.

Rated
Voltage

TheRMS line-to-line voltage.

Rated Speed The desired synchronous speed.
Operating
Temperature

The temperature at which the system functions, and select the units. The
Operating Temperature will affect all winding resistances and therefore
affect all ohmic losses.

3. On theNSSM tab, define the connection data:
Rated
Power
Factor

The rated power factor. For generators, the rated output power is determined
by the rated apparent power multiplying the rated power factor.

Winding
Connection

Select Wye or Delta from the pull-down list.

Exciter
Efficiency

The percentage efficiency of the exciter used to supply the rotor winding with
the DC current if it is mechanically connected to the shaft of the generator.
The efficiency value ranges between 0% and 100% andwill only affect the
total efficiency result.

Input
Exciting
Current

If the check box is selected, the companying edit box is enabled. You need to
input the exciting current value and select the units if needed.

Exciting
Current

Exciting current for rated operation.

4. ClickOK to close the pop-up dialog box

Validate NSSM Solution Setup

1. ClickRMxprt>Validation Check to display the information box Validation Check.
2. If any items do not pass validation, use the diagnostic information in the window to resolve any

issues.
3. Click Close to close the information box Validation Check.
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4. When the design has been validated, click RMxprt>Analyze All.
5. The analysis progress is shown in the Progresswindow and the analysismessage is shown in

theMessageManager.

Design Output for Non-Salient Synchronous Machines

WhenRMxprt has completed a solution, you can display and analyze the results in the following
ways:

View Performance

To view the solutions:
ClickRMxprt>Results>Solution Data to display the information box Solutions. It has three tab
sheets.
In the tab sheet Performance, from the pull-down list Data, you have 13 different data tables for the
line start permanent magnet motor, which can be used to define Output Variables for design
optimization:

l FEA input Data
l FieldWinding
l Full-loadMagnetic Variables
l Important Factors
l Material Consumption
l No-loadMagnetic Variables
l RatedOperation
l Stator Slot
l Stator Winding
l Steady State Parameters per Unit
l Transient Data
l Transient Data per Unit
l Unsaturated Steady State Parameters

View Design Sheet

In the tab sheet Design Sheet, you have 12 sets of information, as follows:
l General Data
l Stator Data
l Stator Winding Data
l Rotor Data
l FieldWinding Data
l Some Factors andMaterial Consumption
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l Unsaturated Steady State Parameters
l No LoadMagnetic Data
l Full LoadMagnetic Data
l Full Load Electric Data
l Transient Parameters and TimeConstants
l Transient FEA Input Data

Note To print theDesign Sheet: Right click theDesign Sheet, selectPrint from the shortcut
menu, select the printer and other parameters from the dialog boxPrint, and clickOK to
print.

View Curves

In the tab sheetCurves, from the pull-down list Name, you have 10 curves as shown:

Getting Started with RMxprt 26-428
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Getting Started with RMxprt 26-429
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Getting Started with RMxprt 26-430
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Note To print the plots from theCurve: Right click on the plot, selectPrint from the shortcut
menu, select the printer and other parameters from the dialog boxPrint, and clickOK to
print.

Create Reports

1. ClickRMxprt>Results>Create RMxprt Report>Rectangular Plot.
The dialog boxReport appears as shown:
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2. Under the tab sheet Trace, there areVariables, Output Variables, Current, Misc,
Percentage, and Power under theCategory column. Select one from theCategory
column, select the traces that belong to it from theQuantity column, and click the buttonAdd
Trace to add them one by one. Finally click the buttonNew report to create the plot. You can
always add additional curves to the same plot by repeating the process.

3. Double click the iconResults>XY Plot1 to display the graph with multiple traces in a new
window.
Note To print the plots from theCurves: Right click on the plot, selectPrint from the

shortcut menu, select the printer and other parameters from the dialog boxPrint,
and clickOK to print.
To get a screen shot of from theCurves: Right click on the plot, selectCopy Image,
then paste to a destination file.

Transient FEA of the Non-Salient Synchronous Machines

If you expect to continue the transient or electromagnetic-field FEA withMaxwell2D, you can create
aMaxwell2D design directly fromRMxprt. For transient FEA, RMxprt can create aMaxwell2D
design with all setups completed.

Create Maxwell 2D Design

Click the commandRMxprt>Analysis Setup>Create Maxwell Design… in RMxprt to create a
Maxwell2D design with Auto setup checked (refer to subsection 5.2.1 CreateMaxwell 2D Design). A
Maxwell2D design calledMaxwell2DDesign1 is created with the displayed geometry as shown
below. All setups are automatically completed byRMxprt.
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Review Maxwell2D Design Setups

This section reviews all setups automatically completed byRMxprt. For detailed setup process,
please refer toAPPENDIX Setup Maxwell 2D Designs.

Solution Type Setup

ClickMaxwell 2D>Solution Type… in Maxwell2D, you can review that theSolution Type is set as
Magnetic Transient.

Model Setup

1. Model Depth
ClickMaxwell 2D>Design Setting… in Maxwell2D and clickSet Model Depth… tab to
review theModel Depth: 3590mm.

2. Motion Type
Double click onMaxwell2DDesign1>Model>MotionSetup1 in the Project Manager
window. In the Type tab you can review theMotion Type being set asRotation, and the
Moving Vector asPositive Global: Z.

3. Initial Position
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In theData tab of theMotion Setup panel you can review the Initial Position being set as
100 deg withRotate Limit unchecked. The rotor initial position is set to such a position that
the initial flux linkage of the phase-A winding is at its negativemaximum value.

4. Mechanical Load
In theMechanical tab of theMotion Setup panel you can review theAngular Velocity
being set as 3000 rpmwithConsider Mechanical Transient unchecked.

5. SymmetryMultiplier
Right click onMaxwell2DDesign1>Model in the Project Manager window, and selectSet
Geometry Multiplier in the pop-up panel, you can review that theSymmetry Multiplier is
set as 2.

Boundary Setup

1. Vector Potential Boundary
Double click onMaxwell2DDesign1>Boundaries>VectorPotential1 in the Project
Manager window, you can review that the highlighted outer half circle in the geometry is set as
theVector Potential Boundary, and its value is set as 0.

2. Master Boundary
Click onMaxwell2DDesign1>Boundaries>Master1 in the Project Manager window, you
can review that the highlighted arrowhead line from left to right in the geometry is set as the
Master Boundary.

3. Slave Boundary
Double click onMaxwell2DDesign1>Boundaries>Slave1 in the Project Manager window,
you can review that the highlighted arrowhead line from right to left in the geometry is set as
theSlave Boundary, and the relation of the slave boundary to themaster boundary is set as
Bs = -Bm. This is because the geometry includes only 1magnetic pole of themachine.

Material Assignment

In theMaxwell2D modeler windows history tree, you can see that all stator and rotor coil terminals
are assigned tomaterial copper by default.Band, InnerRegion andOuterRegion are assigned as
vacuum as shown:
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Two new materials called DW540_50_SF0.932, and DW540_50_SF0.946 are automatically
created for Stator andRotor, based on the original material of DW540_50 used in RMxprt and the
equivalent stacking factors of 0.932 and 0.946. Shaft is also assigned asDW540_50_SF0.946,
because the shaft is defined asmagnetic in RMxprt.

Excitation Setup

1. Windings
Click onMaxwell2DDesign1>Excitations>PhaseA in the Project Manager window, all
objects assigned to this phase are highlighted in themodeler window. In the Properties
window, you can review all winding properties:Voltage forWinding Type; Stranded for
IsSolid; 0.00226117 ohms forResistance; 8.87325e-005H for Inductance; 1 forNumber
of Parallel Branches; 11267.7 * sin(2*pi*50*time-43.4944*pi/180) for Voltage, where 50 is
the frequency in Hz, 11267.7 is the phase peak voltage in Volts, pi is a predefined constant,
and time is a predefined variable for time. By using sin function instead of cos function, the
applied voltage and back EMF are in phase. Therefore, a phase shift in the applied voltage
source will be the power angle of themotor. 43.4944 degrees is the power angle at full load
operation. The values for resistance, inductance and number of parallel branches are
obtained from the TRANSIENT FEA INPUT DATA section in RMxprt design sheet.
Clicking onPhaseB, PhaseC, or Field, you can review all objects assigned to this winding in
themodeler window, and winding properties in thePropertieswindow.
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2. Coil Terminals
A winding consists of several coil terminals, and two coil terminals represent a coil in a
complete 2D model. Since we are working with only one-half of themotor structure, one coil
terminal can represent one complete coil with master/slave boundary conditions provided. A
coil terminal has properties ofNumber of Conductors andPolarity Type.Number of
Conductors is the number of turns per coil, and it is equal to theNumber of Turns given in
RMxprt divided by number of coils per phase.Polarity Type defines the direction of the
current in the coil; it can be either positive or negative. Expand a winding and click on a coil
terminal, you can review the object corresponding to this coil terminal in themodeler window
and all coil terminal properties in thePropertieswindow. In this example,Number of
Conductors of A, B, and C coil terminals is assigned as 1, and it is 12 for the Field windings.
Click onPhaseB, PhaseC, or Field, you can review all objects assigned to this winding in the
modeler window, and winding properties in the properties window.

3. Y Connection for Three-PhaseWindings
Right click onMaxwell2DDesign1>Excitations in the Project Manager Window, and click
Setup Y Connection… in the pop-up panel, you can review the Y -connection setup.
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Mesh Operation Setup

Maxwell2D meshmaker can createmeshes according to predefinedmesh operations. A mesh
operation defines one or more conditions for some selected objects for meshmaker to create
meshes that satisfy the conditions. RMxprt automatically sets up somemesh operations for different
machine parts based on geometry sizes. For this example, mesh operations include Length_Coil
(set maximummesh length as 18mm for all coils), Length_Field (set maximummesh length as 19
mm for field winding coils), Length_Main (set themaximummesh length as 135mm for all other
parts), SurfApprox_Main (set the limited Surface Deviation as 1.175mmand the limited Normal
Deviation as 30 deg for all parts with true-surface arcs).
Click on one of themesh operations underMaxwell2DDesign1>Mesh Operations in the Project
Manager window, you can review its properties in the Properties window.

Solution Setup

Click onMaxwell2DDesign1>Analysis>Setup1 in the Project Manager window, you can review
its properties in the Properties window: 0.2s for Stop time, that is 10 periods; 0.0002s for Time step
with 100 steps per period.

Analyze Maxwell 2D Design

Before analyzing theMaxwell2D design, youmaywant to ApplyMeshOperations and Plot Mesh.
Youmay also want to create several Quick Reports to display results.
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To analyze theMaxwell2D design: right click onMaxwell2DDesign1>Analysis>Setup1 in the
project tree, and clickAnalyze. While the design is being analyzed, you can update one or all result
reports and view the reports.
To update all reports: right click onMaxwell2DDesign1>Results in the project tree, and select
Update All Reports.
To update one report: right click on the report underMaxwell2DDesign1>Results in the project
tree, and selectUpdate Report.
To view all traces of a report: when you double click on the report under
Maxwell2DDesign1>Results in the project tree, theModeler window changes to the Results
window, and all traces (a curve in a report is a trace) of the selected reports are displayed in the
Results window.
To view a trace of a report: when you click on a trace of a report under
Maxwell2DDesign1>Results in the project tree, the selected trace is highlighted in the Results
window.
To cancel the simulation: right click on the progress bar in the progresswindow, and pick upAbort in
the pop-up panel.
To stop the simulation so that you can continue the simulation later: right click on the progress bar in
the progresswindow, and pick upClean Stop in the pop-up panel.
For this example, the simulated three-phase currents and the electro-magnetic torque are shown in
Figure 12.24 and 12.25, respectively.
Right click on theWindingQuick Report in the Results window, and pick upMarker>Add X Marker in
the pop-up panel, yellow-shaded boxes are added in the report to indicate X and all Y values. Click
on the X box (or the vertical line), and drag it to some place where you see the steady-state peak
value of a phase current as shown:
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Add X makers in TorqueQuick Report to indicate the steady-statemaximumandminimum values of
torque as shown below. The average torque can be approximately obtained from themaximumand
minimum values as Tav = (Tmax + Tmin) / 2 = (10.63 + 7.33) / 2 = 8.98 Nm.
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Generic Rotating Machines

TheGeneric RotatingMachine type allows you to setup any of several derivedmachine types
defined for the core types listed below using various stators and rotors, as well as AC and DC source
types. The available stator and rotor core types depend onmachine structure and source type, as
shown in the following table.

Core Type Description
SLOT_AC Slotted core with AC winding (Inner/Outer, Stator/Rotor, AC/DC)
SLOT_CAGE Slotted core with Squirrel-cage damper (Inner/Outer, Rotor, AC/DC)
SALNT_
POLE

Salient-pole core with field winding (Inner/Outer, Stator/Rotor, AC/DC)

PM_
INTERIOR

Interior PM core (Inner, Stator/Rotor, AC/DC)

SOLID Solid core with/without copper/hysteresis sleeve (Inner/Outer, Rotor,
AC/DC)

AXIAL_AC Axial-flus slotted core with AC winding (Axial, Stator/Rotor, AC/DC)
AXIAL_CAGE Axial-flux slotted core with squirrel-cage damper (Axial, Rotor, AC/DC)
AXIAL_PM Axial-flux PM core (Axial, Stator/Rotor, AC/DC)
NONS_RELU Non-salient reluctance core without winding (Inner, Rotor, AC/DC)
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Based on the above table:
l When an inner rotor structure is selected, all cores for outer stator are available for Stator
Type, and cores for inner rotor are available for Rotor Type.

l Similarly, when an outer rotor structure is selected, all cores for inner stator are available for
Stator Type, and cores for outer rotor are available for Rotor Type.

l When an axial-flux structure is selected, all cores for axial-flux stator are available for Stator
Type, and cores for axial-flux rotor are available for Rotor Type.

l For SLOT_AC and AXIAL_AC core types, you can select themachine with or without
position control for the AC winding.

Themachine types that can be derived from the various core type combinations, source types, and
position control types are listed in the following table.
You can click on theDerived Machine Typewith Full solution output for a description of analysis
approach.

Stator / Rotor
Type

Source
Type

Position
Control

Derived
Machine Type Description Solutions

SLOT_AC /
SLOT_AC

AC Yes DFIG Double fed induction
generator

Full

SLOT_AC /
SLOT_CAGE

AC/DC No IndM Outer/inner rotor induction
machine

Partial

SLOT_AC /
SALNT_POLE

AC/DC No SynM Rotaing field/armature
synchronousmachine

Partial

SLOT_AC / PM_
INTERIOR

AC Yes BLDC BrushlessDC motor Full
(single PM
layers)

AC/DC No ASSM Adjustable speed
synchronousmotor

Full

AC No ASSM IPM synchronous generator Partial
SLOT_AC /
SOLID

AC/DC No HysM Hysteresismotor; Solid-rotor
inductionmotor

Partial

AXIAL_AC /
AXIAL_CAGE

AC/DC No AFIndM Axial-flux inductionmachine Partial

AXIAL_AC /
AXIAL_PM

AC Yes AFBLDC Axial-flux brushlessDC
motor

Full

AC/DC No AFASSM Axial-flux adjustable speed
synchronousmotor

Full

AC No AFASSM Axial-flux synchronous
generator

Partial

SLOT_AC /
NONS_RELU

AC SynRM Synchronous reluctance
motor

Partial
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For the derivedmachine typeswith Full solution output, RMxprt:
l Computes and displaysmachine performance data and performance curves.
l Allows you to createmachinemodels for Simplorer.
l Allows you to createMaxwell 2D/3D designs.

For the derivedmachine typeswithPartial solution output, RMxprt allows you to createMaxwell
2D/3D designs only.

Analysis Approach for a Doubly Fed induction Generator

A Doubly Fed Induction Generator (DFIG) can be configured to operate as any of the following
types:

l Generator

DFIG Operating as a Generator

Doubly-fed induction generators (DFIGs) are widely used in wind power systems. A DFIGworks as
a component of a wind power system, as shown below, where the wind turbine transformswind
energy intomechanical energy, and the DFIG transformsmechanical energy into electrical energy.

For a DFIG, both the stator and the rotor are equipped with poly-phase AC windings. The stator and
rotor windingsmay, or may not, have the same number of phases, but theymust have the same
number of poles p. In order to produce terminal voltageswith desired frequency f in the stator
winding, the rotor windingmust be excited by balanced poly-phase currents with the slip frequency sf
via an AC-DC-AC convert. Slip s is defined as:

where n is the rotor speed, and n0 is the synchronous speed as given below:
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When the rotor speed is lower than the synchronous speed, the rotor currents have the same phase
sequence as the stator currents, and the rotor winding gets power from the converter. However,
when the rotor speed is higher than the synchronous speed, the phase sequence of the rotor
currents is different from that of the stator currents, and the rotor winding outputs power to the
converter.
For a given wind turbine, the power coefficient (the ratio of turbine power to the wind power), is a
function of the tip speed ratio (the ratio of the blade tip speed to the wind speed). In order to track the
maximumpower point, the tip speed ratio must keep constant - at its optimal value. The input
mechanical power with MaximumPower Point Tracking (MPPT) must satisfy:

wherePm_ref is the turbine power with MPPT at a reference speed of based on the optimal tip

speed ratio, and is the rotor speed in rad/s.
The rotor mechanical loss is:

wherePf_ref is mechanical lossmeasured at a reference speed of .
The electro-magnetic power in the air gap is:

Therefore, the stator output electrical power at rated operation is:

wherem1 is the number of phases of the stator winding,R1 is the stator phase resistance,V1 is the

stator rated phase voltage, I1 is the rated stator phase current to be determined, and is the
rated power factor. Solving for I1 , one obtains:
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Then, based on the equivalent circuit shown below, one obtains:

Now, rotor input electrical power can be computed as:

wherem2 is the number of phases of the rotor winding.
The electromagnetic torque Tem is:

where ? denotes the synchronous speed in rad/s.
The input mechanical torque on the shaft is:
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where Tf denotes the frictional torque.
The total electrical output power is:

where pFe is the core loss.
The efficiency is defined as:

Defining a Generic Rotating Machine

The general procedure for defining a a generic rotatingmachine is as follows:
1. Insert a Generic RotatingMachine into a new or existing project.
2. Double-click theMachine entry in the project tree to define the general data.
3. Double-click theMachine>Stator entry in the project tree to define the stator geometry, pole

data, and circuit type.
4. Double-click theMachine>Stator>Core entry in the project tree to define the stator core

dimensions, composition, and other material characteristics.
5. Double-click theMachine>Stator>Core>Slot entry in the project tree to define the stator slot

dimensions. (Not applicable to AXIAL_PMand SALNT_POLE stator types.)
6. For AXIAL_PM stator type, double-click theMachine>Stator>Core>Pole entry in the project

tree to define the AXIAL_PM stator core pole properties.
7. For SALNT_POLE stator type, double-click theMachine>Stator>Core>Pole entry in the

project tree to define the SALNT_POLE stator core pole properties.
8. Double-click theMachine>Stator>Winding entry in the project tree to define the stator

windings, conductors, and insulation data. (Not applicable to AXIAL_PMand SALNT_POLE
stator types.)

9. For SALNT_POLE stator type:
a. Double-click theMachine>Stator>Field entry in the project tree to define the SALNT_

POLE stator field properties.
b. Double-click theMachine>Stator>Field>Winding entry in the project tree to define the

SALNT_POLE stator field winding properties.
10. For DC Source Typemachines, double-click theMachine>Stator>Circuit entry in the

project tree to define the stator circuit properties. (Not applicable to AXIAL_PM stator type.)
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11. Double-click theMachine>Rotor entry in the project tree to define the rotor geometry, the
pole data, and circuit type.

12. Double-click theMachine>Rotor>Core entry in the project tree to define the rotor core
dimensions, composition, and other material characteristics.

13. Double-click theMachine>Rotor>Core>Slot entry in the project tree to define the rotor slot
dimensions. (Not applicable to AXIAL_PM, SALNT_POLE, NONS_RELU, or PM_
INTERIOR rotor types.)

14. For AXIAL_CAGE or SLOT_CAGE rotor types, double-click the
Machine>Rotor>Core>Damper (orBottom Damper) entry in the project tree to define the
rotor core damper dimensions, composition, and other material characteristics.

15. For AXIAL_CAGE or SLOT_CAGE rotor types, double-click the
Machine>Rotor>Core>Damper (orBottom Damper)>Slot entry in the project tree to
define the rotor core damper slot dimensions.

16. For AXIAL_PMor PM_INTERIOR rotor types, double-click theMachine>Rotor>Core>Pole
entry in the project tree to define either the AXIAL_PM rotor core pole properties or the PM_
INTERIOR rotor core pole properties.

17. For SALNT_POLE rotor type, double-click theMachine>Rotor>Core>Pole entry in the
project tree to define the SALNT_POLE rotor core pole properties.

18. For NONS_RELU (non-salient reluctance) rotor type, double-click the
Machine>Rotor>Core>Pole entry in the project tree to define the NONS_RELU rotor core
pole properties.

19. Double-click theMachine>Rotor>Winding entry in the project tree to define the rotor
conductors, windings, and insulation data. (Not applicable to AXIAL_PM, SALNT_POLE,
NONS_RELU, or PM_INTERIOR rotor types.)

20. For SALNT_POLE rotor type:
a. Double-click theMachine>Rotor>Field entry in the project tree to define the SALNT_

POLE rotor field properties.
b. Double-click theMachine>Rotor>Field>Winding entry in the project tree to define the

SALNT_POLE rotor field winding properties.
20. For DC Source Typemachines (Inner andOuter Structure only), double-click the

Machine>Rotor>Circuit entry in the project tree to define the rotor circuit properties. (Not
applicable to PM_INTERIOR rotor type.)

21. Optionally, you can insert or remove Vent data. (Not applicable to SALNT_POLE, NONS_
RELU, or SOLID rotor types.

22. Optionally, for generic rotatingmachines that have a SALNT_POLE stator or rotor defined,
you can insert or remove Damper data.

23. Optionally, you can insert or remove Brush data for generic rotatingmachines that have an
Axial AC rotor defined.

24. Double-click theMachine>Shaft entry in the project tree to define themagnetism, frictional
and windage losses, and reference speed of the shaft.
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25. Optionally, for Inner Rotor machines only, right-click theMachine entry in the project tree and
click Insert Housing to add amachine housing.

26. Right-clickAnalysis in the project tree, and clickAdd Solution Setup to define the solution
data.

27. Choose File>Save to save the project.
28. ChooseRMxprt>Analyze All to analyze the design.

Note When you place the cursor over an entry field, a brief description of that field
appears in the status bar at the bottom of theRMxprtwindow.

Once analyzed, themodel can be viewed in theMaxwell 2D Modeler, or it can be used to create a
new Maxwell 2D project, and a new Maxwell 3D design.
Refer to theGeneric RotatingMachine application note, on the technical support page of the
ANSYS web site, for a specific example of a problem using aGeneric RotatingMachine.

Defining the General Data for a Generic Rotating Machine

Use theMachine tab in the Properties dialog box (or Properties window) to define the basic
parameters of the Generic RotatingMachine, such as the source type, structure, and rotor and stator
types. Some typical structures are shown below.

Inner Rotor Structure
with SALNT_POLE Rotor

Axial-Flux Rotor Structure
with AXIAL_CAGE Rotor

Outer Rotor Structure
with SLOT_CAGE Rotor
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To define the general data:
1. To open theProperties dialog box, double-click theMachine entry in the project tree on the

desktop. (You can also enter values in thePropertieswindow of the desktop without opening
the dialog box.)

2. Select the source type for themachine from the drop-down list in theSource TypeValue
field. The default value isAC.

3. Select the structure for themachine from the drop-down list in theStructureValue field.
Choices include: Inner Rotor,Outer Rotor, andAxial-Flux Rotor. The default value is
Inner Rotor.
a. Optionally, if the selectedStructure isAxial-Flux Rotor, choose if either the rotor, stator,

or neither is to beDouble-Sided. The default value isNone.
b. Optionally, if the selectedStructure isAxial-Flux Rotor, set theAir Gap Length.

4. Select the stator type for themachine from the drop-down list in theStator TypeValue field.
5. Select the rotor type for themachine from the drop-down list in theRotor TypeValue field.
6. ClickOK to close theProperties dialog box.

General Data for Generic Rotating Machines

To access the general data, double-click theMachine entry in the project tree.
TheGeneral Data Propertieswindow for a generic rotatingmachine contains the following
fields:

Source
Type

The source to deliver electric power. (AC or DC) Default is AC.

Structure The type of rotor structure for themachine. (Inner Rotor, Outer Rotor, or Axial-Flux
Rotor) Default is Inner Rotor.

Stator
Type

l The stator core type. (AXIAL_AC, AXIAL_PM, SLOT_AC, or SALNT_POLE)
l If Structure type is Axial-Flux Rotor, then stator can be either AXIAL_AC or
AXIAL_PM. Default is AXIAL_AC.

l If Structure type is Inner Rotor or Outer Rotor, stator type can be either SLOT_
AC or SALNT_POLE.

Rotor
Type

l The rotor core type. (AXIAL_AC, AXIAL_PM, SLOT_AC, PM_INTERIOR,
SALNT_POLE, AXIAL_CAGE, NONS_RELU, or SOLID)

l If Structure type isOuter Rotor, then rotor type can be either SLOT_AC, SLOT_
CAGE, SALNT_POLE, or SOLID.

l If Structure type is Axial-Flux Rotor, then rotor type can be either AXIAL_AC,
AXIAL_PM, or AXIAL_CAGE.

l If Structure type is Inner Rotor, then rotor type can be SLOT_AC, PM_
INTERIOR, SLOT_CAGE, SALNT_POLE, NONS_RELU, or SOLID.

Double-
Sided

Present only if Structure type is Axial-Flux.
l Choose Rotor, Stator, or None.
l Default is None.
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Air Gap
Length

Present only if Structure type is Axial-Flux.
l Set the air gap length. Default is 0.

Defining the Stator and Rotor Data for a Generic Rotating Machine

Use theStator Properties andRotor Properties dialog boxes to define the stator and rotor poles,
slots, windings, and optional position control.

Note This section is not applicable to the SOLID rotor type. There are no rotor data settings for
the SOLID rotor type.

To define the general stator and rotor data:
1. To open theStator orRotor Properties dialog box, double-click theMachine>Stator (or

Machine>Rotor) entry in the project tree on the desktop. (You can also enter values in the
correspondingPropertieswindow of the desktop without opening a separate dialog box.)

2. For all rotor and stator types except AXIAL_CAGE, enter the number of poles in theNumber
of Poles field.

3. Depending on the rotor or stator type being used, do one of the following:
a. If the rotor or stator type is either AXIAL_AC, or SLOT_AC, continue with step 4.
b. If the rotor or stator type is either AXIAL_PMor SALNT_POLE, there are no additional

settings. ClickOK to close the dialog.
c. If the rotor type is PM_INTERIOR or NONS_RELU, there are no additional settings. Click

OK to close the dialog.
d. If the rotor type is AXIAL_CAGE or SLOT_CAGE, enter the number of slots in the

Number of Slots field. There are no additional settings. ClickOK to close the dialog.
4. Enter the number of slots in theNumber of Slots field.
5. Select a circuit type for the stator (or rotor):

a. Click the button forCircuit Type.

TheCircuit Type dialog box appears.

b. Click a button to specify the desired circuit type.
c. ClickOK to close theCircuit Type dialog box and return to theProperties dialog box.

6. Select aSlot Type:
a. Click the Slot Type button.

TheSelect Slot Type dialog box appears.

b. Select a slot type (available typesmay include 1 through 6).
Note When you place themouse cursor over the slot type, a schematic of the selected

type appears, displaying the slot dimension variables.

Optionally, checkUser Defined Slot if you wish to define the slot dimensions using theSlot
Editor.
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c. ClickOK to close theSelect Slot Type dialog box and return to theProperties dialog
box.

7. If the drive circuit is to be controlled by position signals from a position sensor, select the
Position Control check box.

8. ClickOK to close theProperties dialog box.

Stator and Rotor Data for Generic Rotating Machines

To access the general stator or rotor data, double-click theMachine>Stator or
Machine>Rotor entry in the project tree.

Note This section is not applicable to the SOLID rotor type. There are no rotor data settings for
the SOLID rotor type.

TheStator (orRotor) Propertieswindow contains the following fields:
Number
of
Poles

The number of poles on which the winding is wound. Default is 2.
For AXIAL_PM core type: the number of permanent magnet poles. Default is 2.
For PM_INTERIOR rotor core type: the number of permanent magnet poles. Default is
4.
Invisible for AXIAL_CAGE and SLOT_CAGE core types.

Number
of Slots

The number of slots of the iron core. Default is 18.
Invisible for AXIAL_PM, SALNT_POLE, and PM_INTERIOR core types.

Circuit
Type

The drive circuit type. Default is Y3.
Invisible for AXIAL_PM, AXIAL_CAGE, SLOT_CAGE, SALNT_POLE, and PM_
INTERIOR core types.

Slot
Type

The slot type of the iron core. Default is Type 1.
Invisible for AXIAL_PM, AXIAL_CAGE, SLOT_CAGE, SALNT_POLE, and PM_
INTERIOR core types.

Position
Control

Determines if the drive circuit is controlled by position signals from a position sensor. For
example, the input DC voltage of a BLDC or SR Motor is triggered phase-by-phase
based on the position signals from a position sensor. Default is unchecked (not
controlled by signals from a position sensor).
Invisible for AXIAL_PM, AXIAL_CAGE, SLOT_CAGE, SALNT_POLE, and PM_
INTERIOR core types.

Defining Stator and Rotor Core Data for a Generic Rotating Machine

1. To open the stator or rotor coreProperties dialog box, double-click the
Machine>Rotor>Core orMachine>Stator>Core entry in the project tree on the desktop.
(You can also enter values in the correspondingPropertieswindow of the desktop without
opening a separate dialog box.)

2. Enter the outer diameter of the core in theOuter Diameter field.
3. Enter the inner diameter of the core in the Inner Diameter field.
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4. Enter the length of the core in the Length field.
5. Enter the stacking factor for the core in the Stacking Factor field. This value relates to the

effectivemagnetic length of the core, and ranges from 0 to 1. It is defined as the total length
minus the total insulation from the laminations, divided by the total length. A value of 1
indicates that the rotor is not laminated.

6. Select aSteel Type for the core:
a. Click the button for Steel Type.

TheSelect Definition dialog box appears.

b. Select a steel type from the list, or define a new steel type.
c. ClickOK to close theSelect Definition dialog box and return to theProperties dialog

box.
7. Depending on the rotor or stator type being used, do one of the following:

a. If theMachine Rotor Type is PM_INTERIOR, continue with step 8.
b. If theMachine Rotor or Stator Type is SALNT_POLE, continue with step 9.
c. If theMachine Rotor or Stator Type is SLOT_AC, AXIAL_AC, AXIAL_CAGE, SLOT_

CAGE, or AXIAL_PM, continue with step 10.
d. If theMachine Rotor Type is SOLID, continue with step 12.
e. If theMachine Rotor Type is NONS_RELU, continue with step 13.

8. If theMachine Rotor Type is PM_INTERIOR, select aPole Type for the core:
a. Click the button for Pole Type.

TheSelect Pole Typewindow appears.

b. Select the desired pole type (1 through 6). You can hover over the numbered buttons to
view the pole type configuration in the window. The default type is 3.

c. ClickOK to close theSelect Pole Typewindow.
Note WhenMachine>Rotor>Core>Pole is selected in the Project Manager tree, the

selected pole type diagram displays on themachine editor window Diagram tab.
TheMain tab also shows the pole drawing, which is dynamically updated as the
pole properties are defined.

d. There are no additional settings for the PM_INTERIOR rotor type. Continue with step 14.
9. If theMachine Rotor or Stator Type is SALNT_POLE, select aPole Type for the core:

a. Click the button for Pole Type.

TheSelect Pole Type (rotor) window or Select Pole Type (stator) window appears.

b. Select the desired pole type. You can hover over the numbered buttons to view the pole
type configuration in the window.
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c. ClickOK to close theSelect Pole Typewindow.
Note WhenMachine>Rotor>Core>Pole is selected in the Project Manager tree, the

selected pole type diagram displays on themachine editor window Diagram tab.
TheMain tab also shows the pole drawing, which is dynamically updated as the
pole properties are defined.

d. Continue with step 10.
10. Enter the skew width (measured in degrees) in theSkew Width field.

Note TheSkew Width field is not available if theMachine Rotor Type is PM_
INTERIOR.

11. If theMachine Structure type is either Inner Rotor or Outer Rotor and the Stator or Rotor Type
is SLOT_AC, SLOT_CAGE, or SALNT_POLE; or if theMachine Structure type is Axial-flux
Rotor and the Rotor Type is AXIAL_CAGE:
a. Enter the thickness of the press boards in thePress Board Thickness field.
b. If the press board ismade of magneticmaterial, check theMagnetic Press Board check

box.
c. For SLOT_AC stator and rotor types only, enter the number of lamination sectors in the

Lamination Sectors field.
d. For the AXIAL_CAGE and SLOT_CAGE rotor types only, check theHalf Slot orDouble

Cage check-boxes to enable those design options.
e. Continue with step 14.

12. If theMachine Rotor Type is SOLID:
a. Select a Sleeve Type (No Sleeve, Conductor, Hysteresis).
b. If the sleeve type is No Sleeve, continue with step 13.
c. If the sleeve type is either Conductor or Hysteresis, enter the Sleeve Thickness.
d. If the sleeve type is Conductor, click the SleeveMaterial button and select a conductor

typematerial from the list in the Select Definition dialog. Themessagemanager informs
you if your choice is not a conductor typematerial.

e. If the sleeve type is Hysteresis, click the SleeveMaterial button and select or define a
material whose core lossmodel type is hysteresis. Themessagemanager informs you if
your choice is not a hysteresis typematerial.

f. Continue with step 14.
13. If theMachine Rotor Type is NONS_RELU, select aPole Type for the core:

a. Click the button for Pole Type.
TheSelect Pole Typewindow appears.

b. Select the desired pole type. You can hover over the labeled buttons to view the pole
type configuration in the window. The default type isHyperbolic-polyline.
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c. ClickOK to close theSelect Pole Typewindow.

Note WhenMachine>Rotor>Core>Pole is selected in the Project Manager tree,
the selected pole type diagram displays on themachine editor window
Diagram tab. TheMain tab also shows the pole drawing, which is dynamically
updated as the pole properties are defined.

14. ClickOK to close theProperties dialog box.

Stator and Rotor Core Data for Generic Rotating Machines

To access the stator or rotor core data, double-click theMachine>Rotor>Core or
Machine>Stator>Core entry in the project tree.
The core dataProperties dialog box contains the following fields:

Outer
Diameter

The outer diameter of the core.

Inner
Diameter

The inner diameter of the core.

Length The length of the core.
Stacking
Factor

The effectivemagnetic length of the core.

Steel Type The steel type of the core. Click the button to open theSelect Definitionwindow.
Pole Type For PM_INTERIOR rotor type: Default type is 3.

For SALNT_POLE rotor and stator type: Default type is 1.
For NONS_RELU rotor type: Default type is Hyperbolic-polyline (type 4)
Invisible for all other stator and rotor core types.

Press
Board
Thickness

The thickness of the pole press boards.
Invisible for AXIAL_PMand AXIAL_AC rotor and stator types.
Invisible for PM_INTERIOR, NONS_RELU and SOLID rotor types.

Magnetic
Press
Board

Defines if the press board ismade of magneticmaterial.
Invisible for AXIAL_PMand AXIAL_AC rotor and stator types.
Invisible for PM_INTERIOR, NONS_RELU, and SOLID rotor types.

Skew
Width

The skew widthmeasured in degrees.
Invisible for AXIAL_AC rotor and stator types.
Invisible for PM_INTERIOR, NONS_RELU, and SOLID rotor types.

Lamination
Sectors

The number of lamination sectors.
Invisible for AXIAL_PM, AXIAL_AC, and SALNT_POLE rotor and stator types.
Invisible for PM_INTERIOR, AXIAL_CAGE, SLOT_CAGE, NONS_RELU, and
SOLID rotor types.

Half Slot For AXIAL_CAGE and SLOT_CAGE rotor types: Check to set the rotor damper
slots to half slots.
Invisible for all other stator and rotor core types.
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Double
Cage

For AXIAL_CAGE and SLOT_CAGE rotor types: Check to add a bottom damper.
Invisible for all other stator and rotor core types.

Sleeve
Type

The sleeve type for the rotor.
Type 0: No Sleeve; Type 1: Hysteresis; Type 2: Conductor.
Default is Hysteresis

Sleeve
Thickness

The thickness of the sleeve.
Invisible when the Sleeve Type is No Sleeve.

Sleeve
Material

Thematerial type of the sleeve.
Invisible when the Sleeve Type is No Sleeve.
Click the button to open theSelect Definitionwindow.
The selectedmaterial must be validated as a hysteresismaterial if the Sleeve Type is
Hysteresis, or as a conductor if the Sleeve Type is Conductor. TheMessage
Manager informs you if the selectedmaterial is not valid.

Defining Rotor Core Dampers for a Generic Rotating Machine

Note This section applies only to AXIAL_CAGE and SLOT_CAGE rotor
types.

To define the physical dimensions of the rotor core damper and bottom damper:
1. To open the rotor core damper dataProperties dialog box, double-click the

Machine>Rotor>Core>Damper (orBottom Damper) entry in the project tree on the
desktop. (You can also enter values in thePropertieswindow of the desktop without opening
a separate dialog box.)

2. Select the Slot Type.
3. If the damper cage is cast material, check theCast Cage check box.
4. Enter theBar Fitting Gap,Bar End Extension, End Ring Width, andEnd Ring Height

dimensions.
5. Select theBar Conductor Type andEnd Ring Conductor Typematerials.
6. ClickOK to close thePropertieswindow

Rotor Core Damper Data for Generic Rotating Machines

To access the rotor core damper data, double-click either the
Machine>Rotor>Core>Damper or theMachine>Rotor>Core>Bottom Damper entry in
the project tree.
The rotor core damper dataProperties dialog box contains the following fields:

Slot Type Select the damper slot type: 1, 2, 3, or 4.
Cast Cage Select if the damper cage composition is cast material.
Bar Fitting Gap The gap between slot edge and bar edge.
Bar End Single-side end extended bar length.
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Extension
End Ring Width Axial width of end ring.
End Ring Height Radial height of end ring.
Bar Conductor
Type

Click the button to open theMaterials Selectionwindow to specify the
material for the bar conductor.

End Ring
Conductor Type

Click the button to open theMaterials Selectionwindow to specify the
material for the end ring conductor.

Rotor Core Damper Slot Data

To access the AXIAL_CAGE or SLOT_CAGE damper slot data, double-click either the
Machine>Rotor>Core>Damper>Slot orMachine>Rotor>Core>Bottom Damper>Slot
entry in the project tree.
The damper slot dataProperties dialog box contains the following fields:

Hs0 A slot dimension (see the diagram shown in themodeling Diagramwindow when
Machine>Stator (orRotor)>Core>Damper>Slot is selected).

Hs01 A slot dimension (see the diagram shown in themodeling Diagramwindow when
Machine>Stator (orRotor)>Core>Damper>Slot is selected).

Hs1 A slot dimension (see the diagram shown in themodeling Diagramwindow when
Machine>Stator (orRotor)>Core>Damper>Slot is selected).
Disabled and set to 0 when Slot Type is 1.

Hs2 A slot dimension (see the diagram shown in themodeling Diagramwindow when
Machine>Stator (orRotor)>Core>Damper>Slot is selected).

Bs0 A slot dimension (see the diagram shown in themodeling Diagramwindow when
Machine>Stator (orRotor)>Core>Damper>Slot is selected).

Bs1 A slot dimension (see the diagram shown in themodeling Diagramwindow when
Machine>Stator (orRotor)>Core>Damper>Slot is selected).

Bs2 A slot dimension (see the diagram shown in themodeling Diagramwindow when
Machine>Stator (orRotor)>Core>Damper>Slot is selected).

Rs A slot dimension (see the diagram shown in themodeling Diagramwindow when
Machine>Stator (orRotor)>Core>Damper>Slot is selected).
Disabled and set to 0 when the slot type is 1or 2.

Defining the Stator and Rotor Core Slots for a Generic Rotating Machine

Note This section is not applicable to:
l AXIAL_PM type stators or rotors.
l SALNT_POLE type stators or rotors.
l PM_INTERIOR, AXIAL_CAGE, SLOT_CAGE, NONS_RELU, or SOLID type
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rotors.

To define the physical dimensions of the stator and rotor core slots:
1. To open the stator or rotor core slot dataProperties dialog box, double-click the

Machine>Stator (orRotor)>Core>Slot entry in the project tree on the desktop. (You can
also enter values in thePropertieswindow of the desktop without opening a separate dialog
box.)

2. Optionally, to automatically design the dimensions of slotsHs2,Bs1, andBs2, select the
Auto Design check box. SelectingAuto Design also disables theParallel Tooth option.

3. Optionally, to automatically designBs1 andBs2 based on Tooth Width, select theParallel
Tooth check box. SelectingParallel Tooth also enables the Tooth Width field.

4. Enter the available slot dimensions. The following dimensionsmay be listed, depending on the
Slot Type selected and depending on whether or notAuto Design or Parallel Tooth is
selected.:
Hs0 Always available.
Hs1 Available only when the slot type is 2, 3, 4, 5, or 6.
Hs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically.
Bs0 Available only when the slot type is 1, 2, 3, 4, or 5.
Bs1 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot

dimension is determined automatically. WhenParallel Tooth is selected, this slot
dimension is determined based on the value entered in the Tooth Width field.

Bs2 Available only whenAuto Design is cleared.WhenAuto Design is selected, this slot
dimension is determined automatically. WhenParallel Tooth is selected, this slot
dimension is determined based on the value entered in the Tooth Width field.

Rs Available only when the slot type is 3 or 4.

5. ClickOK to close thePropertieswindow.

Core Slot Data for Generic Rotating Machines

To access the core slot data, double-click either theMachine>Rotor>Core>Slot or the
Machine>Stator>Core>Slot entry in the project tree.
The core slot dataProperties dialog box contains the following fields:

Auto
Design

Select or clear this to enable or disable auto-design of slotsHs2,Bs1, andBs2. When
this check box is selected, onlyHs0 ,Hs1,Bs0 andRs are present.

Parallel
Tooth

Select this to designBs1 andBs2 based on the tooth width. When this check box is
selected, theBs1 andBs2 fields are removed, and the Tooth Width field is added.

Tooth
Width

The tooth width for the parallel tooth, on whichBs1 andBs2 are designed.

Hs0 A slot dimension (see the diagram shown in themodeling window when
Machine>Stator (orRotor)>Core>Slot is selected).
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Hs1 A slot dimension (see the diagram shown in themodeling window when
Machine>Stator (orRotor)>Core>Slot is selected).

Hs2 A slot dimension (see the diagram shown in themodeling window when
Machine>Stator (orRotor)>Core>Slot is selected).

Bs0 A slot dimension (see the diagram shown in themodeling window when
Machine>Stator (orRotor)>Core>Slot is selected).

Bs1 A slot dimension (see the diagram shown in themodeling window when
Machine>Stator (orRotor)>Core>Slot is selected).

Bs2 A slot dimension (see the diagram shown in themodeling window when
Machine>Stator (orRotor)>Core>Slot is selected).

Rs A slot dimension (see the diagram shown in themodeling window when
Machine>Stator (orRotor)>Core>Slot is selected).
Rs is added when the slot type is 3 or 4.

Defining AXIAL_PM Type Stator and Rotor Core Poles for a Generic Rotating Machine

Note This section is applicable only to core poles for AXIAL_PM type stators or rotors.
l To define core poles for PM_INTERIOR type rotors, refer toDefining PM_
INTERIOR Type Rotor Core Poles for a Generic RotatingMachine.

l To define core poles for SALNT_POLE type rotors, refer toDefining SALNT_POLE
Type Rotor Core Poles for a Generic RotatingMachine.

l To define core poles for NONS_RELU type rotors, refer toDefining NONS_RELU
Type Rotor Core Poles for a Generic RotatingMachine.

To define the properties of AXIAL_PM type stator and rotor core poles:
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1. To open the stator or rotor core pole dataProperties dialog box, double-click the
Machine>Stator>Core>Pole orMachine>Rotor>Core>Pole entry in the project tree on
the desktop. (You can also enter values in thePropertieswindow of the desktop without
opening a separate dialog box.)

2. Set the poleEmbrace value.
3. Set theMagnet Thickness andMagnet Length.
4. Select theMagnet Type.
5. ClickOK to close thePropertieswindow.

AXIAL_PM Core Pole Data for Generic Rotating Machines

To access the core pole data for AXIAL_PM type stators and rotors, double-click either the
Machine>Stator>Core>Pole or theMachine>Rotor>Core>Pole entry in the project tree.
The core pole dataProperties dialog box contains the following fields:

Embrace Pole embrace value.
Magnet
Thickness

Axial thickness of themagnet, per side.

Magnet
Length

TheRadial length of themagnet.

Magnet Type Magnet material type.
Click the button to open theSelect Definitionwindow and select themagnet
material type from the list.

Defining PM_INTERIOR Type Rotor Core Poles for a Generic Rotating Machine

Note This section is applicable only to core poles for PM_INTERIOR type rotors.
l To define core poles for AXIAL_PM type stators and rotors, refer toDefining AXIAL_
PMType Stator and Rotor Core Poles for a Generic RotatingMachine.

l To define core poles for SALNT_POLE type rotors, refer toDefining SALNT_POLE
Type Rotor Core Poles for a Generic RotatingMachine.

l To define core poles for NONS_RELU type rotors, refer toDefining NONS_RELU
Type Rotor Core Poles for a Generic RotatingMachine.

1. To define the properties of PM_INTERIOR type rotor core poles:
– Either open the rotor core pole dataProperties dialog box by double-clicking the
Machine>Rotor>Core>Pole entry in the project tree on the desktop;
– or simply select thePole entry to enter values directly in thePropertieswindow of the
desktop without opening a separate dialog box.)
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Note l The currently selected pole type diagram displays on themachine editor window
Diagram tab. TheMain tab also shows the pole drawing, which is dynamically
updated as the pole properties are defined.

l Undo and Redo of property changes is supported.

l If you wish to change the pole type, select theMachine>Rotor>Core entry in the project
tree, then click the Pole Type button in its Properties window to open theSelect Pole Type
window.

l Select the desired pole type (1 through 6). You can hover over the numbered buttons to
view the pole type configuration in the window. The default type is 3.

l ClickOK to close the Select Pole Type window
2. Set theD1 diameter for magnet ducts.
3. Set theO1,O2,B1,Rib, andHRibmagnet duct dimensions.

Note l DimensionO1 is invisible for pole types 1 and
2.

l DimensionHRib is invisible for pole types 1, 2,
and 6.

4. Set the number of duct Layers. Default value is 1.
5. Set the Layer Pitch value (pitch value between two layers).
6. Set theMagnet Thickness value.
7. Set theMagnet Width value (total width of all magnets per pole).
8. Select theMagnet Type by clicking the button to open theSelect Definitionwindow

Materials tab and selecting the desiredmagnet material type. Use theMaterial Filter tab
settings to filter forMagnetmaterials. ClickOK to close the window.

9. ClickOK to close thePropertieswindow.

PM_INTERIOR Rotor Core Pole Data for Generic Rotating Machines

To access the core pole data for PM_INTERIOR type rotors, double-click the
Machine>Rotor>Core>Pole entry in the project tree.
The core pole dataProperties dialog box contains the following fields:
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D1 Limited diameter for magnet ducts.
O1 Magnet duct dimension.

Invisible when pole type is 1 or 2.
O2 Magnet duct dimension.
B1 Magnet duct dimension.
Rib Magnet duct dimension.
HRib Magnet duct dimension.

Invisible when pole type is 1,2, or 6.
Layers Number of duct layers.
Layer
Pitch

Pitch between two duct layers.

Magnet
Thickness

Magnet thickness, or duct thickness.

Magnet
Width

Total width of all magnets per pole.

Magnet
Type

Magnet material type.
Click the button to open theSelect Definitionwindow and select themagnet
material type from the list. Use theMaterial Filter tab settings to filter forMagnet
materials.

PM_INTERIOR Rotor Core Pole Types

The PM_INTERIOR rotor core type supports six pole types. You can choose the pole type by
selecting theMachine>Rotor>Core entry in the project tree, then clicking thePole Type button in
its Properties window to open theSelect Pole Typewindow.
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The six available pole types are shown below. Refer toDefining PM_INTERIOR Type Rotor Core
Poles for a Generic RotatingMachine for details on defining the various pole properties.

Pole Type 1 Pole Type 2
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Pole Type 3 Pole Type 4

Pole Type 5 Pole Type 6

Defining SALNT_POLE Type Rotor Core Poles for a Generic Rotating Machine

Note This section is applicable only to core poles for SALNT_POLE type rotors.
l To define core poles for SALNT_POLE type stators, refer toDefining SALNT_POLE
Type Stator Core Poles for a Generic RotatingMachine.

l To define core poles for AXIAL_PM type stators and rotors, refer toDefining AXIAL_
PMType Stator and Rotor Core Poles for a Generic RotatingMachine.

l To define core poles for PM_INTERIOR type rotors, refer toDefining PM_
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INTERIOR Type Rotor Core Poles for a Generic RotatingMachine.
l To define core poles for NONS_RELU type rotors, refer toDefining NONS_RELU
Type Rotor Core Poles for a Generic RotatingMachine.

1. To define the properties of SALNT_POLE type rotor core poles:
– Either open the rotor core pole dataProperties dialog box by double-clicking the
Machine>Rotor>Core>Pole entry in the project tree on the desktop;
– or simply select thePole entry to enter values directly in thePropertieswindow of the
desktop without opening a separate dialog box.)

Note l The currently selected pole type diagram displays on themachine editor window
Diagram tab. TheMain tab also shows the pole drawing, which is dynamically
updated as the pole properties are defined.

l Undo and Redo of property changes is supported.

2. Set thePole Body Width, Pole Body Height, Pole Shoe Width, andPole Shoe Height
dimensions.

3. Set theSecond Air Gap value. Default value is 0.
4. Set thePole Arc Offset value. Default value is 0.
5. Optionally, checkSecond Pole Arc and set values forOff2_x andOff2_y.
6. Set theStacking Factor value.
7. Select theSteel Type by clicking the button to open theSelect DefinitionwindowMaterials

tab and selecting the desiredmagnet material type. ClickOK to close the window. Use the
Material Filter tab settings to filter for Steelmaterials.

8. ClickOK to close thePropertieswindow.

SALNT_POLE Rotor Core Pole Data for Generic Rotating Machines

To access the core pole data for SALNT_POLE type rotors, double-click the
Machine>Rotor>Core>Pole entry in the project tree.
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The core pole dataProperties dialog box contains the following fields:
Second
Air Gap

The second air gap between the pole body and the yoke.

Pole
Body
Width

Pole body dimension.

Pole
Body
Height

Pole body dimension.

Pole
Shoe
Width

Pole shoe dimension.

Pole
Shoe
Height

Pole shoe dimension.

Pole Arc
Offset

The pole-arc center offset from the rotor center.

Second
Pole Arc

Check if you want the pole surface to include a second arc or line in a half-pole range.
When checked, enablesOff2_x andOff2_y.

Off2_x Offset of the second arc perpendicular to the pole-center line.
Off2_y Offset of the second arc in parallel with the pole-center line.
Stacking
Factor

The effectivemagnetic length of the rotor pole.

Steel
Type

Steel material type.
Click the button to open theSelect Definitionwindow and select the steel material
type from the list. Use theMaterial Filter tab settings to filter for Steelmaterials.

See the diagram below for details on Type 1 SALNT_POLE rotor core pole.
Type 1 SALNT_POLE Rotor Core Pole
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SALNT_POLE Rotor Core Pole Type

The SALNT_POLE rotor core type supports one pole type. You can choose the pole type by
selecting theMachine>Rotor>Core entry in the project tree, then clicking thePole Type button in
its Properties window to open theSelect Pole Typewindow.
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Refer toDefining SALNT_POLE Type Rotor Core Poles for a Generic RotatingMachine for details
on defining the various pole properties.

Defining SALNT_POLE Type Stator Core Poles for a Generic Rotating Machine

Note This section is applicable only to core poles for SALNT_POLE type stators.
l To define core poles for SALNT_POLE type rotors, refer toDefining SALNT_POLE
Type Rotor Core Poles for a Generic RotatingMachine.

l To define core poles for AXIAL_PM type stators and rotors, refer toDefining AXIAL_
PMType Stator and Rotor Core Poles for a Generic RotatingMachine.

l To define core poles for PM_INTERIOR type rotors, refer toDefining PM_
INTERIOR Type Rotor Core Poles for a Generic RotatingMachine.

1. To define the properties of SALNT_POLE type rotor core poles:
– Either open the rotor core pole dataProperties dialog box by double-clicking the
Machine>Stator>Core>Pole entry in the project tree on the desktop;
– or simply select thePole entry to enter values directly in thePropertieswindow of the
desktop without opening a separate dialog box.)
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Note l The currently selected pole type diagram displays on themachine editor window
Diagram tab. TheMain tab also shows the pole drawing, which is dynamically
updated as the pole properties are defined.

l Undo and Redo of property changes is supported.

2. Set thePole Body Width, Pole Body Height, Pole Shoe Width, andPole Shoe Height
dimensions.

3. Set theSecond Air Gap value. Default value is 0.
4. Set thePole Arc Offset value. Default value is 0.
5. Optionally, checkSecond Pole Arc and set values forOff2_x,Off2_y,Bp1/Rp1, and

Bp2/Rp2.
6. Set theStacking Factor value.
7. Select theSteel Type by clicking the button to open theSelect DefinitionwindowMaterials

tab and selecting the desiredmagnet material type. ClickOK to close the window. Use the
Material Filter tab settings to filter for Steelmaterials.

8. ClickOK to close thePropertieswindow.

SALNT_POLE Stator Core Pole Data for Generic Rotating Machines

To access the core pole data for SALNT_POLE type stators, double-click the
Machine>Stator>Core>Pole entry in the project tree.
The core pole dataProperties dialog box contains the following fields:

Second
Air Gap

The second air gap between the pole body and the yoke.

Pole
Body
Width

Pole body dimension.

Pole
Body
Height

Pole body dimension.
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Pole
Shoe
Width

Pole shoe dimension.

Pole
Shoe
Height

Pole shoe dimension.

Pole Arc
Offset

The pole-arc center offset from the stator center.

Second
Pole Arc

Check if you want the pole surface to include a second arc or line in a half-pole range.
When checked, enablesOff2_x andOff2_y.

Off2_x Offset of the second arc perpendicular to the pole-center line.
Invisible whenSecond Pole Arc is unchecked.

Off2_y Offset of the second arc in parallel with the pole-center line.
Invisible whenSecond Pole Arc is unchecked.

Bp1/Rp1 Bp1 for pole type 1. Parameter for shoemaximumwidth.
Rp1 for pole type 2. Shoe convex fillet radius.
Invisible for inner core type.

Bp2/Rp2 Bp2 for pole type 1. Parameter for shoemaximumwidth.
Rp2 for pole type 2. Shoe concave fillet radius.
Invisible for inner core type.

Stacking
Factor

The effectivemagnetic length of the stator pole.

Steel
Type

Steel material type.
Click the button to open theSelect Definitionwindow and select the steel material
type from the list. Use theMaterial Filter tab settings to filter for Steelmaterials.

See the diagrams below for details on Type 1 and Type 2 SALNT_POLE Stator core poles.
Type 1 SALNT_POLE Stator Core Pole
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Type 2 SALNT_POLE Stator Core Pole:
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SALNT_POLE Stator Core Pole Type

The SALNT_POLE stator core type supports two pole types. You can choose the pole type by
selecting theMachine>Rotor>Core entry in the project tree, then clicking thePole Type button in
its Properties window to open theSelect Pole Typewindow.

Refer toDefining SALNT_POLE Type Rotor Core Poles for a Generic RotatingMachine for details
on defining the various pole properties.

Optional SALNT_POLE Stator or Rotor Core Damper for a Generic Rotating Machine

l To add a damper, right-click on the stator or rotor core item in the project tree to display the
pop-upmenuwith Insert Damper.

l To remove an existing damper, right-click on the rotor icon in the project tree to display the
shortcut menu withRemove Damper.

TheDamper Data properties window contains the following fields.
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Damper Slots
per Pole

Number of damper slots per pole.

Slot Type Damper slot type. Click the button to open the Slot selection window and select
one of the four types. Default is type 1.

Slot Pitch Slot pitch in mechanical degrees.
Center Slot
Pitch

Center slot pitch in mechanical degrees.
Invisible whenDamper Slots per Pole is and odd number.

Cast Cage Specify whether the damper is cast.
Bar Fitting Gap The gap between slot edge and bar edge.
End Ring Type Type of end ring of the damper. Click the button to open the selection window

and select one of the four types. Default is type 3.
Bar End
Extension

Single side end extended bar length.
Invisible whenEnd Ring Type is 0 or 1.

End Ring
Width

Axial width of end ring.
Invisible whenEnd Ring Type is 0 or 1.

End Ring
Height

Radial height of end ring.
Invisible whenEnd Ring Type is 0 or 1.

Bar Conductor
Type

Click the button to open theMaterials Selectionwindow to specify thematerial
for the bar conductor.

End Ring
Conductor
type

Click the button to open theMaterials Selectionwindow to specify thematerial
for the end ring conductor.

SALNT_POLE Rotor or Stator Core Damper Slot Data

To access the SALNT_POLE damper slot data, double-click either the
Machine>Stator>Core>Damper>Slot or theMachine>Rotor>Core>Damper>Slot entry
in the project tree.
The core slot dataProperties dialog box contains the following fields:

Hs0 A slot dimension (see the diagram shown in themodeling Diagramwindow when
Machine>Stator (orRotor)>Core>Damper>Slot is selected).

Hs01 A slot dimension (see the diagram shown in themodeling Diagramwindow when
Machine>Stator (orRotor)>Core>Damper>Slot is selected).

Hs1 A slot dimension (see the diagram shown in themodeling Diagramwindow when
Machine>Stator (orRotor)>Core>Damper>Slot is selected).
Disabled and set to 0 when Slot Type is 1.

Hs2 A slot dimension (see the diagram shown in themodeling Diagramwindow when
Machine>Stator (orRotor)>Core>Damper>Slot is selected).

Bs0 A slot dimension (see the diagram shown in themodeling Diagramwindow when
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Machine>Stator (orRotor)>Core>Damper>Slot is selected).
Bs1 A slot dimension (see the diagram shown in themodeling Diagramwindow when

Machine>Stator (orRotor)>Core>Damper>Slot is selected).
Bs2 A slot dimension (see the diagram shown in themodeling Diagramwindow when

Machine>Stator (orRotor)>Core>Damper>Slot is selected).
Rs A slot dimension (see the diagram shown in themodeling Diagramwindow when

Machine>Stator (orRotor)>Core>Damper>Slot is selected).
Disabled and set to 0 when the slot type is 1or 2.

Defining SALNT_POLE Stator and Rotor Field Data for a Generic Rotating Machine.

To define the stator and rotor windings and insulation data:
1. To open the Stator or Rotor FieldPropertieswindow, double-click theMachine-Stator-

Field entry in the project tree on the desktop. (You can also enter values in theProperties
section of the desktop without opening a separate window.)

2. Enter the thickness of the insulation under the pole shoe in theShoe Insulation field.
3. Enter the thickness of the insulation at the pole body side in thePole Insulation field.
4. Enter theminimumgap in theWinding Clearance field. The winding clearance is one of the

following: theminimumgap between two field windings, or theminimumgap between a field
winding and a commutating winding.

5. Enter the exciter efficiency value in theExciter Efficiency field.
6. Enter the exciting current value in theExciting Current field.
7. ClickOK to close thePropertieswindow.

Defining SALNT_POLE Stator and Rotor Field Winding Data for a Generic Rotating Machine.

1. To open the rotor or stator field windingProperties dialog box, double-click the
Machine>Stator>Field>Winding orMachine>Rotor>Field>Winding entry in the project
tree on the desktop. (You can also enter values in theProperties section of the desktop
without opening a separate dialog box.)

2. Select aWinding Type:
a. Click the button forWinding Type to open theWinding Typewindow.
b. SelectRound,Cylinder, or EdgeWisewinding.

When you place themouse cursor over a winding button, an outline of the selected winding appears.
The following table describes the three types of windings:

Type Description
Round A Round winding:
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Cylinder A Cylinder winding:

EdgeWise An EdgeWise winding:

a. Once you have selected a winding, clickOK to close theWinding Type dialog box and
return to thePropertieswindow.

b. Enter the number of parallel branches in one phase of the winding in theParallel Branches
field.

c. Enter the total number of conductors for each pole in theConductors per Pole field. Odd
numbers for input and output leads on different sides. Enter 0 to have RMxprt auto-design this
value.

d. For Round and Cylinder winding types, enter the number of wires per conductor in the
Number of Strands field. Enter 0 to have RMxprt auto-design this value.
Note TheNumber of Strands field is invisible (not used) when the EdgeWise winding

type has been selected.
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e. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to
automatically obtain this value from the wire library.

f. For anEdgeWisewinding type, enter the thickness of the inter-turn insulation in the Inter-
turn Insulation field.
Note The Inter-turn Insulation field is invisible (not used) when either the Round or

Cylinder winding type has been selected.

g. Select theWire Size:
h. Click the button forWire Size.

TheWire Size dialog box appears.

h. Select a value from theWire Diameter pull-down list.
i. Select a wire gauge from theGauge pull-downmenu. You can select from the following
options:
<
number>

You can select a specific gauge number. When you select a
gauge number, theWire Diameter field is automatically
updated.

USER This option allows you tomanually enter theWire Diameter.
This is useful when you want to enter a diameter that does not
correspond to a particular wire gauge.

AUTO This option sets theWire Diameter to zero, and RMxprt
automatically calculates the optimal value. The diameter
information is then written to the output file when you analyze
the design.

MIXED This option allows you to define a conductor that ismade of
different size wires. For example, a single conductor may consist
of 5 wires, 3 wires with a diameter of 0.21mmand 2 with a
diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.
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a. When you are done setting the wire size, clickOK to close theWire Size dialog box and
return to theProperties dialog box.

b. Click theConductor Type button to open theSelect DefinitionwindowMaterials tab and
selecting the desired conductor material type. Use theMaterial Filter tab settings to filter for
Conductormaterials. ClickOK to close the window.

c. Enter the axial gap between the field winding and pole body in theAxial Clearance field.
d. Enter the inner radius at winding fillet in theWinding Fillet field.
e. Enter the inner diameter of the coil tip in the Tip Inner Diameter field.
f. Enter the limited cross-section width for winding design or arrangement in the Limited Cross

Width field. Enter 0 for maximumavailable area.
g. Enter the limited cross-section height for winding design or arrangement in the Limited

Cross Height field. Enter 0 for maximumavailable area.
h. ClickOK to close theProperties dialog box.

Defining NONS_RELU Type Rotor Core Poles for a Generic Rotating Machine

Note This section is applicable only to core poles for NONS_RELU type rotors.
l To define core poles for AXIAL_PM type stators and rotors, refer toDefining AXIAL_
PMType Stator and Rotor Core Poles for a Generic RotatingMachine.

l To define core poles for SALNT_POLE type rotors, refer toDefining SALNT_POLE
Type Rotor Core Poles for a Generic RotatingMachine.

l To define core poles for PM_INTERIOR type rotors, refer toDefining PM_
INTERIOR Type Rotor Core Poles for a Generic RotatingMachine.

1. To define the properties of NONS_RELU type rotor core poles:
– Either open the rotor core pole dataProperties dialog box by double-clicking the
Machine>Rotor>Core>Pole entry in the project tree on the desktop;
– or simply select thePole entry to enter values directly in thePropertieswindow of the
desktop without opening a separate dialog box.)

Note l The currently selected pole type diagram displays on themachine editor window
Diagram tab. TheMain tab also shows the pole drawing, which is dynamically
updated as the pole properties are defined.

l Undo and Redo of property changes is supported.
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l If you wish to change the pole type, select theMachine>Rotor>Core entry in the project
tree, then click the Pole Type button in its Properties window to open theSelect Pole Type
window.

l Select the desired pole type: Laminated (type 1), Concentric-polyline (type 2), Hyperbolic-
curve (type 3), or Hyperbolic-polyline (type 4). You can hover over the buttons to view the
pole type configuration in the window. The default type is Hyperbolic-polyline (type 4).

l ClickOK to close the Select Pole Type window
2. For pole types 2, 3, or 4, set the number ofBarriers per Pole. (Invisible when the pole type is

1.)
3. For pole types 2, 3, or 4, set theH bridge thickness dimension. (Invisible when the pole type is

1.)
4. For pole types 2, 3, or 4, set theW rib width at the barrier center dimension. (Invisible when

the pole type is 1.)
5. For pole types 2, 3, or 4, set theR barrier fillet radius dimension. (Invisible when the pole type

is 1.)
6. For pole types 2 or 4, set theR0 barrier arch center location dimension. (Invisible when the

pole type is 1 or 3.)
7. Set theRb in-circle radius of the bottom dimension.
8. For pole types 2, 3, or 4, set theB0 bottomwidth of the first barrier (at the barrier center)

dimension. (Invisible when the pole type is 1.)
9. Set theY0 bottomwidth of the first yoke (at the barrier center) dimension.
10. Optionally, for pole types 2, 3, or 4, you can check theBarrier Auto Arrangement box to

have RMxprt automatically arrange the pole barriers. (Invisible when the pole type is 1.)
11. For pole types 2, 3, or 4, if the number ofBarriers per Pole you specified is greater than 1,

and you have not enabledBarrier Auto Arrangement, clicking theExtra Barriers Setup
button opens theBarriers Setup dialog in which you can specify theBi (bottomwidths of the
additional barriers) andYi (bottomwidths of the additional yokes) dimensions.

Note TheExtra Barriersproperty is invisible if the number ofBarriers per Pole is 1, or
ifBarrier Auto Arrangement has been enabled.

12. ClickOK to close thePropertieswindow.

NONS_RELU Rotor Core Pole Data for Generic Rotating Machines

To access the core pole data for NONS_RELU type rotors, double-click the
Machine>Rotor>Core>Pole entry in the project tree.
The core pole dataProperties dialog box contains the following fields:

Barriers per Pole Number of barriers in one pole.
Invisible when pole type is 1 (Laminated).

H Bridge thickness.
Invisible when pole type is 1 (Laminated).

W Rib width at the barrier center.
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Invisible when pole type is 1 (Laminated).
R Barrier fillet radius.

Invisible when pole type is 1 (Laminated).
R0 Radius of the bottom barrier arch for Pole Type 2

(Concentric-polyline); or line connecting arch
radius for Pole Type 4 (Hyperbolic-polyline).
Visible only when Pole Type is 2 or 4.

Rb In-circle radius of the bottom barriers.
B0 The first (from inner to outer) barrier width at the

barrier center.
Invisible when pole type is 1 (Laminated).

Y0 The first yoke width (between the first and the
second barriers) at the barrier center.

Barrier Auto
Arrangement

Check the box to let barriers be auto-arranged.
Invisible when pole type is 1 (Laminated).

Extra Barriers For pole types 2, 3, or 4, if the number ofBarriers
per Pole is greater than 1, andBarrier Auto
Arrangement has not been enabled, theExtra
BarriersSetup button opens theBarriers
Setup dialog in which you can specify theBi
(bottomwidths of the additional barriers) andYi
(bottomwidths of the additional yokes)
dimensions.
Invisible if the number ofBarriers per Pole is 1,
or ifBarrier Auto Arrangement has been
enabled.

Related Topics
"Defining NONS_RELU Type Rotor Core Poles for a Generic RotatingMachine" on page 26-475
"NONS_RELU Rotor Core Pole Types" below

NONS_RELU Rotor Core Pole Types

TheNONS_RELU rotor core type supports four pole types. You can choose the pole type by
selecting theMachine>Rotor>Core entry in the project tree, then clicking thePole Type button in
its Properties window to open theSelect Pole Typewindow.
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The four available pole types are shown below. Refer toDefining NONS_RELU Type Rotor Core
Poles for a Generic RotatingMachine for details on defining the various pole properties.

Laminated (Type 1) Concentric-polyline (Type 2)
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Hyperbolic-curve (Type 3) Hyperbolic-polyline (Type 4)

Defining the Stator and Rotor Windings for a Generic Rotating Machine

Note This section is not applicable to:
l AXIAL_PM type stators or rotors.
l PM_INTERIOR, AXIAL_CAGE, and SOLID type rotors.
l SALNT_POLE type stators and rotors. Refer toDefining SALNT_POLE Stator and
Rotor FieldWinding Data for a Generic RotatingMachine for winding information for
SALNT_POLE stators and rotors.

To define the wires, conductors, insulation, and windings of a stator or rotor:
1. To open the rotor or stator slot windingProperties dialog box, double-click the

Machine>Stator>Winding orMachine>Rotor>Winding entry in the project tree on the
desktop. (You can also enter values in theProperties section of the desktop without opening
a separate dialog box.)

2. Click theWinding tab.
3. Choose the desired number of layers in the winding from the drop-down list in theWinding

Layers field.
4. Select aWinding Type:

a. Click the button forWinding Type.

TheWinding Typewindow appears.

b. Select from one of the following three types of winding:
l Whole Coiled
l Half Coiled
l Editor
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When you place themouse cursor over a winding button, an outline of the selected winding appears.
The following table describes the six types of windings that are possible (three for one-layer and
three for two-layer):

Type Description
Winding Editor
(one-layer)

A user-defined one-layer winding arrangement. You need
to set up the winding arrangement for each slot in the
Winding Editor.

Whole-Coiled
(one-layer)

A one-layer whole-coiled winding:

Half-Coiled
(one-layer)

A one-layer concentric half-coiled winding:

Winding Editor
(two-layer)

A user-defined two-layer winding arrangement. When you
select for winding layers you can specify a different winding
arrangement for each slot in theWinding Editor.

Whole-Coiled
(two-layer)

A two-layer whole-coiled winding:
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The phase belt for this winding configuration is equal to
360/2m, wherem is the phase number.

Half-Coiled
(two-layer)

A two-layer half-coiled winding:

There is only one coil per phase per pair of poles.

Note For a two-layer winding, if you checkConstant Pitch in theWinding Editor, only the top
layer needs to be defined; the bottom layer is determined according to the coil pitch.

a. Once you have clicked a button to select a winding, clickOK to close theWinding Type
dialog box and return to thePropertieswindow.

b. Enter the number of parallel branches in one phase of the winding in theParallel Branches
field.
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c. Enter the total number of conductors in each slot in theConductors per Slot field. This value
is the number of turns per coil multiplied by the number of layers. Enter 0 to have RMxprt auto-
design this value.

d. Enter the coil pitch, measured in number of slots, in theCoil Pitch field. The coil pitch is the
number of slots separating one winding. For example, if a coil starts in slot 1 and ends in slot 6,
it has a coil pitch of 5.
This field is not displayed when the number ofWinding Layers is 1.

5. Enter the number of wires per conductor in theNumber of Strands field. Enter 0 to have
RMxprt auto-design this value.

6. Enter the thickness of the double-sided wire wrap in theWire Wrap field. Enter 0 to
automatically obtain this value from the wire library.

7. Select theWire Size:
a. Click the button forWire Size.

TheWire Size dialog box appears.

b. Select a value from theWire Diameter pull-down list.
c. Select a wire gauge from theGauge pull-downmenu. You can select from the following

options:
<
number
>

You can select a specific gauge number. When you select a gauge number,
theWire Diameter field is automatically updated.

USER This option allows you tomanually enter theWire Diameter. This is useful
when you want to enter a diameter that does not correspond to a particular
wire gauge.

AUTO This option sets theWire Diameter to zero, and RMxprt automatically
calculates the optimal value. The diameter information is then written to the
output file when you analyze the design.

MIXED This option allows you to define a conductor that ismade of different size wires.
For example, a single conductor may consist of 5 wires, 3 wires with a diameter

Getting Started with RMxprt 26-482
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

of 0.21mmand 2 with a diameter of 0.13mm.

The gauge number is based on AWGsettings. You can create your ownwire table using
Machine>Wire, and then you can select this wire table using the Tools>Options>Machine
Options command.

a. When you are done setting the wire size, clickOK to close theWire Size dialog box and
return to theProperties dialog box.

b. Click theEnd/Insulation tab.
c. Select or clear the Input Half-turn Length check box.
d. Do one of the following:

l If you selected Input Half-turn Length, then enter the half-turn length of the armature
winding in the Half Turn Length field.

l If you cleared Input Half-turn Length, then enter the end length adjustment of the
stator/rotor coils in theEnd Extension field. The end extension is the distance one end of
the conductor extends vertically beyond the end of the stator or rotor.

8. Enter the inner radius of the base corner in theBase Inner Radius field.
9. Enter the inner diameter of the coil tip in the Tip Inner Diameter field.
10. Enter the distance between two adjacent coils in theEnd Clearance field.
11. Enter the thickness of the single-side coil wrap insulation in theCoil Wrap field.

This field is applicable and displayed only for slot types 5 and 6.
12. Enter the thickness of the slot liner insulation in theSlot Liner field.
13. Enter the thickness of the wedge insulation in theWedge Thickness field.
14. Enter the thickness of the insulation layer in the Layer Insulation field.

This field is applicable and displayed only when theWinding Layers value is 2.
15. Enter the bottom insulation thickness in theBottom Insulation field.

This field is applicable and displayed only for slot types 5 and 6.
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16. Enter the limited slot fill factor for the wire design in the Limited Fill Factor field. The slot fill
factor is the ratio between the cross-sectional area of all conductors in one slot and the entire
slot area.
This field is applicable and displayed only for slot types 1, 2, 3, and 4.

17. Enter the span length correction factor to scale the end span length in theCorrection Factor
field.

18. Enter the top spare slot space for a dual-windingmachine in the Top Spare Space field.
19. Enter the bottom spare slot space for a dual-windingmachine in theBottom Spare Space

field.
20. ClickOK to close theProperties dialog box.

Stator and Rotor Winding Data for Generic Rotating Machines

Note This section is not applicable to:
l AXIAL_PM type stators or rotors.
l PM_INTERIOR, AXIAL_CAGE, and SOLID type rotors.
l SALNT_POLE type stators and rotors. Refer toDefining SALNT_POLE Stator and
Rotor FieldWinding Data for a Generic RotatingMachine for winding information for
SALNT_POLE stators and rotors.

To access the core slot data, double-click either theMachine>Rotor>Core>Slot or the
Machine>Rotor>Core>Slot entry in the project tree.
The winding dataProperties dialog box contains the following fields:

Winding tab Winding Layers The number of winding layers. (The bottom layer is for
another side slot if the core is double-sided.)
Select 1 or 2 in the pull-down list. Default value is 2.
Winding Layers is always 2 if the core is double-sided.

Winding Type The type of stator winding. Click the button to open the
Winding Typewindow and choose fromWhole-Coiled,
Half-Coiled, andEditor.
Default value isWhole-Coiled.

Parallel
Branches

The number of parallel branches in the winding. Default
value is 1.

Conductors per
Slot

The number of conductors per slot (0 for auto-design).

Coil Pitch The coil pitchmeasured in number of slots. This field is
displayed only when the number ofWinding Layers is 2.
Coil Pitch is always 0 if the core is double-sided.

Number of
Strands

The number of wires per conductor (0 for auto-design).
Default value is 1.
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Wire Wrap The thickness of the double-sided wire wrap (0 to
automatically obtain this value from the wire library).

Wire Size The diameter of the wire (0 for auto-design). Click the
button to open theWire Size dialog boxwhere you can
specify units, wire type, diameter, and gauge.

End/Insulation
tab

Input Half-turn
Length

Select or clear this check box to specify whether or not you
want to enter the half-turn length. When this check box is
selected, theHalf Turn Length field appears the next time
you open thePropertieswindow.When this check box is
selected, theEnd Extension field appears instead. Default
value is unchecked.

Half Turn
Length

The average half-turn length of the armature winding.
Visible only when Input Half Turn Length is checked.

End Extension The end length adjustment of the coils, which is the
distance one end of the conductor extends vertically
beyond the end of the stator or rotor.
Invisible when Input Half Turn Length is checked.

Correction
Factor

End span length correction factor to scale the end span
length. Must be > 0. Default value is 1.0.
Invisible when Input Half Turn Length is checked

Base Inner
Radius

The inner radius of the base corner.

Tip Inner
Diameter

The inner diameter of the coil tip.
Invisible if the core is double-sided.

End Clearance The end clearance between two adjacent coils.
Coil Wrap The thickness of the single-side coil wrap. This field is

displayed only when theSlot Type is 5 or 6.
Slot Liner The thickness of the slot liner insulation.
Wedge
Thickness

The thickness of the wedge insulation.

Layer
Insulation

The thickness of the insulation layer.
Invisible when number of winding layers is 1 or the core is
double-sided.

Bottom
Insulation

Thickness of the bottom insulation. This field is displayed
only when theSlot Type is 5 or 6.

Limited Fill
Factor

The limited slot fill factor for the wire design. The slot fill
factor is the ratio between the cross-sectional area of all
conductors in one slot and the entire slot area. This field is
displayed only for Slot Types 1, 2, 3, or 4.

Top Spare
Space

The top spare slot space for a dual-windingmachine. The
valuemust be greater-than or equal-to 0 and less-than 1.
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Bottom Spare
Space

The bottom spare slot space for a dual-windingmachine.
The valuemust be greater-than or equal-to 0.
Also, the sum of the Top Spare Space andBottom
Spare Space valuesmust less-than 1.

Conductor
Type

Conductor material type of the Stator/Rotor Winding.

Winding Editor for a Generic Rotating Machine

For a generic rotatingmachine, youmaywant to specify a different number of conductors for
each stator or rotor slot. TheWinding Editor enables you to specify the number of turns for
each coil. To enable theWinding Editor, youmust have set theWinding Property for the
Winding Type toEditor.
To specify the number of turns for each coil:

1. ClickMachine>Winding>Edit Layout.

TheWinding Editor dialog box appears.

2. In the table in the upper left, set whichPhase you want for each coil and which slot is the “In”
and “Out” slot for the current in each coil.

3. If you are working on a quarter or half model, youmaywant to specify amultiplier by selecting
a value from thePeriodic Multiplier drop-downmenu.

4. Select or deselect theConstant Turns orConstant Pitch check boxes, depending on
whether you want to be able to change these setting in the table above.When these options
are selected, you cannot change the turns or pitch.

5. When you are satisfied with the coil settings, clickOK to close theWinding Editor dialog box.
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Defining Different Size Wires for a Generic Rotating Machine

Use theGauge option if you have a conductor that ismade up different size wires.
To define different size wires:

1. In theWire Size window, selectMIXED from theGauge pull-downmenu.
2. Select eitherRound orRectangular as theWire Type.
3. Enter the appropriate wire data in the table:

l For a round wire:
l ClickAdd to add the new wire data.
l Enter theDiameter in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
diameter.

l For a rectangular wire:
l ClickAdd to add the new wire data.
l Enter theWidth of the wire in the table. The width should be greater than the thickness.

l Enter the Thickness of the wire in the table.
l Enter the Fillet value in the table.
l Enter aNumber in the table to specify how many of the conductor’s wires have this
data.

4. Repeat step 3 for each size wire you want to add.
5. When you are finished defining the wires, clickOK to close theWire Sizewindow.

Note For example, if one conductor ismade up of 5 wires, and 3 of those wires have a
diameter of 0.21mm, and the other 2 have a diameter of 0.13mm, then themixed
wire size table will have two lines. The first line will list Diameter = 0.21 and Number
= 3. The second line will list Diameter = 0.13 and Number = 2. An equivalent wire
diameter is displayed asWire Size value in theWinding tab in the Properties
window.

Defining the Stator and Rotor Circuits for a Generic Rotating Machine
You can define stator and rotor Circuit parameters for generic rotatingmachineswhose Source
Type is DC.

Note This procedure is not applicable to:
• AXIAL_PM type stators or rotors.
• SALNT_POLE type stators or rotors.
• AXIAL_AC, AXIAL_CAGE, SLOT_CAGE, and SOLID type

rotors.
• PM_INTERIOR type rotors.

To define the circuit parameters of a stator or rotor:
1. To define the circuit parameters click either the stator or rotor Circuit icon in the project tree.

You can then edit the brush parameters directly in the Properties window. (You can also open
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the rotor or stator circuitProperties dialog box by double-clicking the
Machine>Stator>Circuit orMachine>Rotor>Circuit entry in the project tree on the
desktop.)

2. Select theControl Type from the drop downmenu. Choices are: DC, CCC, PWM, and
HCC.

3. If the stator or rotor Position Control has been enabled, set the Lead Angle of Trigger
value.

4. If theControl Type chosen is either DC or CCC, set the Trigger Pulse Width. The default
value is 120.

5. Set the Transistor Drop (voltage drop of one transistor).
6. Set theDiode Drop.
7. If theControl Type is CCC, set theMaximum Current andMinimum Current values.
8. If theControl Type is PWM, set theModulation Index andCarrier Frequency Times.
9. If theControl Type is HCC, set theReference Amplitude andHysteresis Band.

Stator and Rotor Circuit Data for Generic Rotating Machines

To access the stator or rotor circuit data, double-click either theMachine>Stator>Circuit or the
Machine>Rotor>Circuit entry in the project tree.
The circuit dataProperties dialog box contains the following fields:

Control Type Control Type: DC, CCC (chopping current control), PWM, HCC (hysteresis
current control). Default is DC.

Lead Angle of
Trigger

Lead angle of trigger in electrical degrees.
Visible only whenPosition Control is enabled.

Trigger Pulse
Width

Trigger pulse width in electrical degrees.
Visible only whenControl Type is DC or CCC. Default value is 120.

Transistor Drop Voltage drop of one transistor.
Diode Drop Voltage drop of one diode, or the total voltage for star-type circuits in the

discharge loop.
Maximum
Current

Maximum current for chopping current control.
Visible only whenControl Type is CCC.

Minimum
Current

Minimum current for chopping current control.
Visible only whenControl Type is CCC.

Modulation Index Modulation index (the ratio of the sine-wave amplitude to the triangular
amplitude).
Visible only whenControl Type is PWM.

Carrier
Frequency Times

Carrier frequency times (the ratio of the triangular frequency to the sine-wave
frequency).
Visible only whenControl Type is PWM.

Reference The amplitude of the sine-wave reference current.
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Amplitude Visible only whenControl Type is HCC.
Hysteresis Band The difference between the upper and lower hysteresis limits.

Visible only whenControl Type is HCC.

Defining the Axial AC Rotor Brush for a Generic Rotating Machine

Optionally, you can insert or remove brush data for generic rotatingmachines that have an Axial AC
Rotor Structure. If you have inserted a brush, the icon appears under the core slot in the project tree.
To insert a brush:

1. Right-click on the rotor core icon to display the pop-upmenu.
2. Click Insert Brush.
3. To edit the brush data, double-click the brush icon to open the brush properties dialog.

The brush dataProperties dialog box contains the following fields:
Diameter Brush surface diameter.
Brush Width Brush width.
Brush Length Brush length.
Brush Drop Voltage drop of a brush.
Contact Resistance Contact resistance of a brush.
Brush Press Brush pressure per unit area.
Frictional
Coefficient

Frictional coefficient of a
brush.

To remove an existing brush:
1. Right click on the rotor icon to display the pop-upmenu.
2. ClickRemove Brush.

Vent Data for Generic Rotating Machines

Optionally, you can insert or remove Vent data for generic rotatingmachines that have either an
Inner Rotor or Outer Rotor Structure. If you have inserted a Vent, the icon appears under the core
slot in the project tree.

Note l This section does not apply to the SALNT_POLE, NONS_RELU, or SOLID rotor
types.

To insert a vent:
1. Right-click on the stator or rotor core icon to display the pop-upmenu.
2. Click Insert Vent.

To remove an existing vent:
1. Right click on the stator or rotor icon to display the pop-upmenu.
2. ClickRemove Vent.
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The vent dataProperties dialog box contains the following fields.

Vent Ducts Number of radial vent ducts. Default is 0.
Duct Width Width of radial vent ducts.
Magnetic Spacer
Width

Width of magnetic spacer which hold vent ducts.
0 for non-magnetic spacer.

Duct Pitch Vent ducts
Holes per Row Number of axial vent holes per row

Not available for SLOT_CAGE rotor type.
Inner Hole Diameter Diameter of vent holes in inner row.

Not available for SLOT_CAGE rotor type.
Outer Hole Diameter Diameter of vent holes in outer row.

Not available for SLOT_CAGE rotor type.
Inner Hole Location Center-to-center diameter of inner row hole

vents.
Not available for SLOT_CAGE rotor type.

Outer Hole Location Center-to-center diameter of outer row hole
vents.
Not available for SLOT_CAGE rotor type.

Defining the Shaft Data for a Generic Rotating Machine

To define the shaft:
1. To open the shaft dataProperties dialog box, double-click theMachine>Shaft entry in the

project tree on the desktop. (You can also enter values in theProperties section of the
desktop without opening a separate window.)

2. Select or clear theMagnetic Shaft check box to specify whether or not the shaft is to be
made of magneticmaterial.

3. Enter the frictional loss in the Frictional Loss field.
4. Enter the windage loss (or power for wind power generators) measured at theReference

Speed in theWindage Loss or Power field.
5. Enter the reference speed at which frictional and windage losses aremeasured in the

Reference Speed field.
6. ClickOK to close thePropertieswindow.

Shaft Data for General DC Machines

To access the shaft data, double-click theMachine>Shaft entry in the project tree.
TheShaft Data Propertieswindow contains the following fields:
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Magnetic
Shaft

Select or clear this check box to indicate whether or not the shaft ismade of magnetic
material. When selected, the shaft ismagnetic. Default is unchecked for PM_
INTERIOR rotor type.

Frictional
Loss

The frictional lossmeasured at theReference Speed.

Windage
Loss or
Power

TheWindage Loss (or Power for wind power generators) measured at the
Reference Speed.

Reference
Speed

The speed at which the friction and windage losses aremeasured. Default is 3600
rpm for PM_INTERIOR and AXIAL_CAGE rotor types.

Setting Up Analysis Parameters for a Generic Rotating Machine

To define solution parameters for a generic rotatingmachine:
1. Right-clickAnalysis in the project tree, and clickAdd Solution Setup.

TheSolution Setup dialog box appears.
2. Click theGeneral tab.

a. If you wish to change the automatically assigned setup name, enter a name for the setup
in theSetup Name field.

b. The solution setup is enabled by default. Uncheck theEnabled box to disable the setup, if
desired.

c. Select an operation type (Motor,Generator, orWind Generator) from theOperation
Type pull-down list. TheOperation Type is set toMotor by default.

d. Select the Load Type used in themachine.
l If theOperation Type isMotor, select one of the following Load Type options:

Const
Speed

The speed remains constant in themotor.

Const
Power

The output power remains constant in themotor. (Default type.)

Const
Torque

The torque remains constant regardless of the speed. In this case, Tload =
Trated, given by the output power divided by the given rated speed.

Linear
Torque

The torque increases linearly with speed. In this case, Tload = Trated *
(n/nrated) where Trated is given by the output power divided by the given rated
speed.

Fan
Load

The load varies nonlinearly with speed. In this case, Tload = Trated *
(n/nrated)2 where Trated is given by the output power divided by the given
rated speed.

l If theOperation Type is eitherGenerator orWind Generator, select one of the
following Load Type options:
Infinite Bus When the generator is connected to an infinite bus of the power
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system, the terminal voltages remain constant and the output power is
determined by the output currents.

Independent
Generator

The generator supplies electrical power to a load inductor. For an AC
generator, the resistance and inductance of the load inductor are
determined by the rated output power, the rated voltage, and the rated
power factor. For a DC generator, the resistance of the load resistor is
determined by the rated output power and the rated voltage.

e. Enter the ratedmechanical or electrical output (apparent) power in theRated Output
Power field.

When theOperation Type isGenerator andSource Type isAC, the property name
changes toRated Apparent Power (kVA), and the unit column is blank.

f. Enter the applied or output rated voltage in theRated Voltage field. (RMS value for AC
source.) Default value is 208 V.

g. Enter the given rated speed in theRated Speed field. Default value is 3600 rpm.
h. Enter the temperature at which the system functions in theOperating Temperature field.

Default is 75 cel.
3. Click theGeneric Rotating Machine (GRM) tab.

a. For AC source typemachines, enter the rated power factor in theRated Power Factor
field. The default value is 0.8. This field is invisible when theSource Type isDC.

b. For AC source typemachines, if you wish to determine load impedance when the phase
current leads the phase voltage, enable theCapacitive Power Factor check box. This
field is invisible when theSource Type isDC.

c. Enter the source frequency in the Frequency field and select the appropriate unit of
measure. The default value is 60 Hz. This field is invisible when theSource Type isDC.

d. Optionally, you can click theUse Defaults button to restore the tab settings to default
values.

4. Optionally, click theDefaults tab. This tab contains two buttons:
l Click theSave Defaults button to save the currently-defined settings as defaults for future
setups.

l Click theRevert to Standard Defaults button to clear existing user-defined defaults and
revert to the standard settings.

5. ClickOK to close theSolution Setupwindow.

Related Topics

Solution Data for Generic RotatingMachines

Solution Data for Generic Rotating Machines

To access the solution data, double-click the solution setup located underAnalysis in the project
tree to open the solutionProperties dialog box. Solution data is also accessible in the desktop
Propertieswindow for the selected setup.
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The solution setup Properties contains the following fields:

General tab:

Name The name of the setup. Not editable.
Enabled Check box that enables/disables the solution setup.

Default is checked (enabled)
Operation
Type

Set the type of operation for themachine analysis. Pull-down list selections are:
Motor, Generator, WindGenerator. Default isMotor.

Load Type Select themechanical or electrical load type from the pull-down list.
For MotorOperation Type the selections are: Const Speed, Const Power, Const
Torque, Linear Torque, Fan Load. Default is Const Power.
For Generator andWindGeneratorOperation Type the selections are: Infinite
Bus and Independent Generator. Default is Infinite Bus.

Rated
Output
Power

Enter the ratedmechanical or electrical output (apparent) power, and select the
unit.

Rated
Voltage

Enter a value for the rated voltage and select the unit.

Rated Speed Type a value for the rated speed, and select the unit.
Operating
Temperature

Type a value for the operating temperature, and select the unit.

GRM tab:

Rated
Power
Factor

Enter the rated power factor for AC Source Type. This field is displayed only for AC
Source Type. Default value is 0.8.

Capacitive
Power
Factor

Check box that enables/disables use of a capacitive power factor. Used together with
theRated Power Factor when the phase current leads the phase voltage, to
determine load impedance. Default is unchecked.

Frequency Enter a value for the frequency, and select the unit.

Related Topics

Setting Up Analysis Parameters for a Generic RotatingMachine

Adding Machine Housings

You can addmachine housing parts to all machine types. Please note that machine housings for
Generic RotatingMachines and Single-Phase InductionMotors are available only for Inner Rotor
typemachines. RMxprt designs that includemachine housings can be exported toMotor-CAD™
for advanced thermal analysis.

Getting Started with RMxprt 26-493
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

1. To include a Housing in the design, right-click theMachine icon in the Project Manager tree
and select Insert Housing. A new Housing icon is added to themachine design containing
Front Cap and Rear Cap housing elements.

2. Right-click on Housing in the Project Manager tree to include and specify parameter data for
the following housing elements:
l Duct
l Fin
l Flange
l Foot

3. Specify properties for the Housing and related elements by selecting them and setting
parameter data values either in the Properties window or Properties dialog.

4. You can remove the Housing and all related elements by right-clickingMachine and selecting
Remove Housing. Individual housing elements can be removed by right-clicking Housing
and selecting the desiredRemove <objectname>menu item.
Note The Front Cap and Rear Cap elements are always included with the Housing and

cannot be removed individually.

Related Topics

Housing Data
Housing Duct Data
Housing Fin Data
Housing Flange Data
Housing Foot Data
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Housing Front Cap and Rear Cap Data
Exporting aMotorCAD Project

Housing Data

You can specify the following Housing properties:

Name Description Notes
Inner Diameter Housing inner diameter Inner Diameter > 0
Outer
Diameter

Housing outer diameter of the circle
profile

Outer Diameter > Inner
Diameter

Overall Width Housing overall width of the square
profile

Overall Width > Inner Diameter

Housing
Length

Length of the housing Housing Length > 0
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Related Topics

AddingMachine Housings
Housing Duct Data
Housing Fin Data
Housing Flange Data
Housing Foot Data
Housing Front Cap and Rear Cap Data

Housing Duct Data

You can specify the following housing Duct properties:

Name Description Notes
Number Number of ducts, or water Number of Ducts > 0
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of Ducts jackets
Duct
Type

Duct type Available types:
l 1-AxialWind Duct
l 2-AxialWater Jacket
l 3-SpiralWater Jacket

Default: AxialWind Duct.
Duct
Height

Duct height in radial direction 0 < Duct Height < Housing Thickness (half of the
difference between the housing and stator outer
diameters)

Duct
Embrace

Ratio of duct span, or duct width,
to duct pitch with uniform
distribution

0 < Duct Embrace < 1

Duct
Length

Axial length for axial wind duct
only

0 < Duct Length < Housing Length

Related Topics

AddingMachine Housings
Housing Data
Housing Fin Data
Housing Flange Data
Housing Foot Data
Housing Front Cap and Rear Cap Data
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Housing Fin Data

You can specify the following housing Fin properties:

Name Description Notes
Number
of Fins

Number of fins per side (one fourth of total
fins)

Number of Fins > 0

Fin Type Fin type Available types:
l 1-Radial Round
l 2-Radial Square
l 3-Parallel Round
l 4-Parallel Square
l 5-Square Ring
l 6-Servo Ring.
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Default: Radial Round (Types 5 & 6 are
disabled if Number of Fins = 1).

Corner
Cutout
(%)

Corner cutout percentage 0 ≤Corner Cutout < 1

Cutout
Depth

Corner cutout depth fromOuter Diameter,
or Fin Extension for Fin Type 5

Cutout Depth ³ 0

Fin
Thickness

Fin Thickness Fin Thickness > 0

Fin Typeswhen Number of fins = 1:

Fin typeswhen number of fins = 2 or greater:
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Related Topics

AddingMachine Housings
Housing Data
Housing Duct Data
Housing Flange Data
Housing Foot Data
Housing Front Cap and Rear Cap Data

Housing Flange Data

You can specify the following housing Flange properties:
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Name Description Notes
Flange
Diameter

Diameter of the flange section that covers the front
bearing

Flange Diameter > 0

Flange
Thickness

Thickness of the flange section that covers the
front bearing

Flange Thickness > 0

Plate Height Height of the cooling plate which the flange
mounts on

Plate Height > Flange
Diameter

Plate
Thickness

Thickness of cooling plate Plate Thickness > Flange
Thickness

PlateWidth Width of cooling plate PlateWidth > 0

Related Topics

AddingMachine Housings
Housing Data
Housing Duct Data
Housing Fin Data
Housing Foot Data
Housing Front Cap and Rear Cap Data

Housing Foot Data

You can specify the following housing Foot properties:
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Name Description Notes
Base Length Base plate length in axial direction Base Length > 0
BaseWidth Base plate width BaseWidth > 0
Base
Thickness

Base plate thickness Base Thickness > 0

Shaft Height Height of shaft from foot Shaft Height > Base Thickness
Foot Length Foot length in axial direction 0 < Foot Length < Base Length
FootWidth Foot width at junction with

housing
FootWidth > 0

Foot Distance Distance between two feet 0 < Foot Distance < BaseWidth
PalmHeight Palm height 0 < PalmHeight < (Shaft Height - Base

Thickness)
PalmWidth Palmwidth at junction with base

plate
PalmWidth ≤ (BaseWidth - Foot Distance)/2
PalmWidth ³ FootWidth

Related Topics

AddingMachine Housings
Housing Data
Housing Duct Data
Housing Fin Data
Housing Flange Data
Housing Front Cap and Rear Cap Data
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Housing Front Cap and Rear Cap Data

You can specify the following housing Front Cap and Rear Cap properties:

Name Description Notes
Outer
Diameter

Outer diameter of end cap CapOuter Diameter ³
Housing Outer Diameter

Length
Extension

Length extended from housing end to cap inner
surface, < 0 for rabbet length

Cap
Thickness

Axial thickness of end cap Cap Thickness > 0

Holder Outer diameter of bearing holder Holder Diameter > 0
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Diameter
Bearing
Diameter

Bearing outer diameter Bearing Diameter < Holder
Diameter

Bearing
Thickness

Axial thickness of bearing (or bearing holder) Bearing Thickness > 0

Shaft
Diameter

Shaft diameter at end cap Shaft Diameter < Bearing
Diameter

Shaft
Extension

Shaft extension length from end cap to outside for
torque output or fan installation

Shaft Extension ³ 0

Related Topics

AddingMachine Housings
Housing Data
Housing Duct Data
Housing Fin Data
Housing Flange Data
Housing Foot Data

Stator Vent Data

Select aMachine Type to get more information of Stator Vents:
l Three-Phase InductionMotors
l Three-Phase SynchronousMachines
l Three-Phase Non-Salient SynchronousMachines

Rotor Vent Data

Select aMachine Type to get more information of Rotor Vents:
l Three-Phase InductionMotors
l Three-Phase Non-Salient SynchronousMachines
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27 - Using the Maxwell Circuit Editor
To openMaxwell Circuit Editor:

l ClickStart>Programs>ANSYS Electromagnetics>ANSYS Electromagnetics Suite
[version]>ANSYS Maxwell Circuit Editor.

The followingmenus are available in Maxwell Circuit Editor:

Filemenu
Editmenu
Viewmenu
Projectmenu
Drawmenu
Schematicmenu
Maxwell Circuit
menu
Toolsmenu
Windowmenu
Helpmenu

Related Topics:
Schematic Editor
The Component LibrariesWindow
Copying and Pasting Properties
Maxwell Circuit Editor Component Models
Placing Components in theMaxwell Circuit Editor Schematic
Assigning Component Properties in Maxwell Circuit Editor

Schematic Editor
The Schematic editor is the tool for creating circuit schematics, or designs for a transient solution
type. A design graphically represents and captures the electrical structure and characteristics of a
circuit. You create such a design by starting the schematic editor and placing components, ports,
connectors, and wires into a default empty schematic.

The Schematic Editor Window

TheSchematic Editor window allows you to place components and wire them together. You can
move components by simply selecting and dragging them. Copy and paste can be used on
components and their wires within the schematic editor.

Maxwell Online Help
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As you place the cursor near a pin of a component, it changes from an arrow to anX. This indicates
that the schematic editor is in the wiringmode. In the wiringmode, click to start drawing a wire. Click
again to end the wire.

Commonly used items such as ports, n-port black boxes, grounds, and page connectors can be
placed in the schematic by clicking their toolbar icons or by using theDrawmenu.
View controls to zoom in, zoom out, and fit the drawing to the editor window are available on the
Viewmenu, and on the shortcut menu that openswhen you right-click in a schematic.
The arrow keys scroll the view up, down, left, or right in small increments. The page up and page
down keys scroll the view up or down in larger increments. If you scroll so far that no objects are in
the view, select Fit Drawing from theView pull-down on theMaxwell topmenu bar (or press
Ctrl+D) to re-center the entire design, resized to fill the window.

Setting Schematic Editor Options

These options are set under Schematic Editor in theOptions dialog box.
To set Schematic Editor options:
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1. ClickTools>Options>General Options.
2. ClickSchematic Editor.
3. Make your changes on the appropriate panels:

l General
l Fonts
l Colors
l Wiring
l Multiple Placement
l Symbol Editor

4. ClickOK.

Schematic Editor Options: General

These options are set in theGeneral panel under Schematic Editor in theOptions dialog.
l Symbol Graphics – specifies the graphic symbol style (IEEE or Traditional) to be used on
schematics. Each style contains two or more active levels for the graphic objects that comprise
a symbol.

l SubCircuit Pin Spacing – specifies the pin spacing in grid units for pins on a subcircuit
component symbol. The default value is 1 grid unit.

l Show Pin Labels – specifies that pin labels are to be displayed in theSchematic Editor.
l Property Display Angle Follows Symbol Angle – specifies that displayed text properties
rotate when the associated component is rotated. Disabled by default.

l Update Property Display on Definition Update – specifies that when component symbol
definitions are updated, the displayed properties of instances of the updated component on
the schematic are automatically updated. Enabled by default. If not enabled, only the symbol
graphics are updated.

l Auto Scroll when close to edges – specifies that theSchematic Editor display will scroll
automatically when the cursor is placed close to the edge of the editor window.

l Show advanced property data - turns on the display of less often used property tabs, such
as Symbol andGeneral for components.

l Net name display – sets the net name property display distance from the net.
l Symbol Scaling Factor – Third-party vendors often follow a different symbol dimensioning
system than that used inMaxwell. Symbol sizes that look appropriate in a third-party
applicationmay not be appropriate for Maxwell. Tomitigate such issues, the Symbol Scaling
factor can be used during import to scale the incoming symbol graphics for symbol formats
such as SVGby the specified amount. Similarly, when exporting, the symbol can be rescaled
to the original dimensions.

l Selection Colors – sets the colors of the first and subsequent objects as they are selected on
a schematic.

Schematic Editor Options: Fonts

These options are set in the Fonts panel under Schematic Editor in theOptions dialog.
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Set the Font Name (from a drop-down selection list) andSize for text used on schematics on the
Fonts tab of theSchematic Editor Options dialog box. A Sample Text display window shows the
appearance of the specified font and size.Apply this font to all property displays in the active
schematic specifies that all displays in the schematic editor are to use the font style and size you
selected.

Schematic Editor Options: Colors

These options are set in theColor panel under Schematic Editor in theOptions dialog.
The Schematic Objects panel allows you to set the color for eachObject Type.

l Object Type – a drop-downmenu used to select the object type whose colors you want to
modify. Types are:Components, Interface Ports, Page Ports,Global Ports,Grounds,
Graphic Items,Wires,Buses, Title Blocks, Page Borders, and Page Border Text.

l Set Color – implements the color you have selected for the object type.
l Clear Color – resets the color of the selected object type to its default value.

The Individual Definitions panel lets you set the color for specifiedComponents andWire
Domains.

l Component Name – is used to identify the component whose colors you want to modify.
(Visible only when theComponents Object Type is selected.)

l Add – allows you to add a component whose colors you want to define. (Visible only when
theComponents Object Type is selected.)

l Wire Domain – a drop-downmenu used to select the wire domain whose color you want to
modify. EachWire Domain is assigned a unique color by default. For Maxwell, the Domain
is:Conservative - Electrical.

l Set Color – implements the color you have selected for the specified component. All future
instances of the component added to the active schematic window display will possess the
selected color.

l Clear Color – resets the color of the component to its default value.
l Apply these color settings to the current schematic – applies the color settings for the
selectedObject Type to objects of that type in the active schematic window.

Schematic Editor Options: Wiring Tab

The following options are set on theWiring panel under Schematic Editor in theOptions dialog
box.
Connectivity Options:

l Show Merge Wire dialog before combining wires – displays theMerge Wire dialog box
before combining wires to allow for changes to themerge configuration.

l Show Split Wire dialog before separating wires – displays the Split Wire dialog box
before separating wires to allow for changes to the split configuration

l When renaming a physically separate piece of wire – offers two choices:
–Split into a different net
–Keep connected (name all pieces the same)
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l Show GlobalPort Disconnect dialog before separating – displays the GlobalPort
Disconnect dialog before separating wires to allow for changes to the global port
configuration.

Schematic Editor Options: Multiple Placement

Multiple placement allows you to place several objects of the same type in the schematic using
repeatedmouse clicks. These options are set in theMultiple Placementpanel under Schematic
Editor in theOptions dialog.
Check the desired objects in the Items for multiple placement list.

l Components
l Interface Ports
l Grounds
l Page Connectors
l Global Ports

Schematic Editor Options: Symbol Editor

These options are set in theSymbol Editor panel under Schematic Editor in theOptions dialog.
l Adjust Pin Orientation on Drag – enables symbol pin orientation to be adjusted
automatically as pins are dragged to the desired side of a symbol in the symbol editor.

The Component Libraries Window

TheComponent Libraries window is a dockable window that allows you to select and search for
schematic components that are available in the installed libraries. The Component Libraries window
contains a Components tab and a Search tab.
A typical Component Libraries window is shown below. Your actual window contents will vary with
the libraries installed and with use.
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Auto-Hide Feature
Clicking the auto-hide push-pin in the upper right corner of the Component Libraries window toggles
the auto-hide feature “on” and “off.” When auto-hide is enabled, the Component Libraries window
slides out of sight and a Component Libraries “mouse-over button” appears on the edge of themain
window. The Component Libraries window remains hidden until youmove themouse cursor over
themouse-over button. The Component Libraries window then slides into view for use; then hides
again when the cursor moves out of the Component Libraries window.
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The Components Tab

TheComponents tab in the Component Libraries window allows you to browse and select
schematic components from the available elements libraries. The installed libraries are listed
alphabetically in hierarchical folders grouped by component function. For example, theDedicated
Elements library expands as shown.
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Individual elements are designated by icons next to the element abbreviation and name.
Right-clicking a component opens a shortcut menu where you can choose to:

l add the component to the Favorites folder
l place the component on a schematic
l view component help

TheComponent tab includes a Favorites folder and aMost Recently Used folder. These folders
help provide quick access to components. Elements used in the current project are listed under
Project Components.

Using the Favorites and Most Recently Used Folders

To add a library element as a favorite:
1. Select the desired element and right-click to display the shortcut menu.
2. Select Add to Favorites to place the component in the Favorites folder. When a component

is in the Favorites folder, you can select, place, edit, view the component help, and load its
example project (if one exists) from there.
To remove an element from the Favorites folder:

1. Select an element and right click to display the short cut menu.
2. ClickRemove from Favorites.
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TheMost Recently Used folder contains a list of themost recently used elements. For
convenience, these elements can be selected and placed from this folder. The number of
elements in the folder is controlled by the Tools>Options>General Options dialog under
theComponent Libraries Options tab. The default number of elements is 10.

Online Help for Components

To launch online help for a component from theComponents tab of theComponent
Libraries window:

1. Right-click its icon.
2. ClickView Component Help.

Placing Components on a Schematic

To place a component, do one of the following:
l Double-click its icon.
l Select, drag, and drop a component in the schematic editor.
l Right-click its icon, and then selectPlace Component.

The Search Tab

TheSearch tab allows you to enter full or partial words (case-insensitive) present in the names or
descriptions of components in the search field. The search is done dynamically as you type. You can
also restrict the search by select the categories and libraries you want to include in the search. Use
theCtrl key to select multiple categories or libraries.
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For users runningMicrosoft®WindowsVista® or later, results appear in theResults panel as
symbols representing the componentsmatched by the search, and arranged in groups, depending
on how well a search stringmatches the component. Generally, components whichmatch the
search string exactly appear in theBest Match group. TheMatch groupings do not appear in
Windows® versions older than Vista®. Instead the results are simply presented sorted by priority.
When you select a particular component you can see its description and library path in the text box at
the bottom of the tab. You can either drag and drop the desired component from theResults panel
onto the schematic, or double-click to attach it to themouse. Use theComponent Help button to
view online help information for components.
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Copying and Pasting Properties

You can copy and paste properties for primitive drawing elements (graphical objects) and
components.
Primitive drawing elements (graphical objects)
You can copy and paste the common properties of the following primitive drawing elements
(graphical objects):

l Arcs
l Circles
l Lines
l Rectangles
l Polygons
l Text
l Images

Components
Properties are copied only when property namesmatch.
Parameters, and property displays are copied along with properties and their attributes.

Note Property displays are copied to the same location as the source if they are on the left,
bottom, right, top or center. Custom location property displays are copied to the default
bottom location.

Related Topics

ToCopy and Paste Selected Properties for Components
To Copy and Paste Common Properties for Primitive Drawing Elements

To Copy and Paste Selected Properties for Components

To copy and paste selected properties from one component to one or more components:
1. Select the component you want to copy from.
2. Use one of the followingmethods to accessCopyData:

l ClickEdit > Copy Data.
l Right-click the object and selectCopy Data.
l PressCtrl+Shift+C.

3. Select the components you want to paste to.
4. Paste the properties by using one of the followingmethods:

l Select Edit > Paste Data.
l Right-click the component and selectPaste Data.
l PressCtrl+Shift+V.
TheCopy Properties Datawindow is displayed.
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5. Do one of the following to select the properties to copy.
l Select one or more of the following check boxes: Parameters, or Property Displays.
l ClickSelect in the first column to toggle between selecting all and clearing all.
l Click theSelect check box for the property. If you do not want to include the property, clear
theSelect check box.

Click theShow Description check box to display the descriptions for each property.
6. ClickOK. The properties are pasted into the component.

Related Topics

Copying and Pasting Properties
To Copy and Paste Common Properties for Primitive Drawing Elements
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To Copy and Paste Common Properties for Primitive Drawing Elements

To copy and paste the common properties from one primitive drawing element (graphical object) to
another:

1. Select the object you want to copy from.
2. Use one of the followingmethods to accessCopyData:

l ClickEdit > Copy Data.
l Right-click the object and selectCopy Data.
l PressCtrl+Shift+C.

3. Select the object you want to paste to.
4. Paste the properties by using one of the followingmethods:

l Select Edit > Paste Data.
l Right-click the component and selectPaste Data.
l PressCtrl+Shift+V.
TheCopy Properties Datawindow is displayed.
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5. In theProperties pane, keep the default selections or clear the check boxes for the properties
you do not want to copy.
Click theShow Description check box to display the description for each property.

6. ClickOK. The properties are pasted into the object.

Related Properties
Copying and Pasting Properties
To Copy and Paste Selected Properties for Components

Components
A number of components are available in the Circuit simulator.
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To view and select components, click theComponents tab in theComponent Libraries Window.
To expand a component subgroup, double-click its book icon. To read about a specific component,
right-click its icon in the tree and selectView Component Help.
The following types of elements are available in Maxwell Circuit Editor:

l Dedicated Elements
l Passive Elements
l Probes
l Sources

Once components are placed in the schematic for a project, they appear in the project tree beneath
theProject Components branch. Themost recently placed components also appear under the
Most Recently Used branch in the project tree. You can also set Favorites that can be accessed
from the project tree.

Related Topics

Placing Components in theMaxwell Circuit Editor Schematic
Assigning Component Properties in Maxwell Circuit Editor

Dedicated Elements

The following dedicated elements are available in theMaxwell Circuit Editor project tree:
l AC_Model: Component for identifying windingswith AC currents
l BarC: Commutator Bar
l BarC_Model: Model Data for Commutator Bar
l Winding:Winding
l ECEW_Model: ECEWindingModel
l ECE3_Model: ECE 3-PhaseModel
l ECER_Model: ECE RotationModel
l ECEL_Model: ECE Linear MotionModel
l ECET_Model: ECE Transformer Model

The text before the colon (:) represents the component name and can be changed in theProperties
window once the component is placed in the schematic.

Related Topics

Assigning Component Properties in Maxwell Circuit Editor

AC_Model

The AC_model element is used to specify AC windings for which you want to modify eddy currents in
solid conductors. This allows you tomodify currents for AC windings at the beginning of each period
without interrupting the transient process.
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To change the name of themodel placed on the sheet, click the symbol on the sheet, and change the
name of the component in the property window (Value field in the DeviceName line, with the Param
Values tab selected).

The AC_Model contains the following parameters:
l DeviceName, which identifies the name of devicemodel
l Windings, which is the AC winding list separated by commas. For example, PhA, PhB, PhC.
l Frequency, which shows the frequency of the AC currents in Hz
l Tolerance, which shows the ratio of the DC component to the AC amplitude

Commutator Bar and Commutator Bar Model

The commutator bar element is intended to be used for themotor model with a commutator. This
element models the variable (periodic) contact resistance between the brush and the commutator
bars, as well as the switching (commutation of the current) that occurs when the brushmakes
contact with the two adjacent commutator bars.
The element itself must always be used together with the corresponding commutator bar model. The
commutator bar model can be dropped on the sheet anywhere and needs no connections. Only the
commutator bar element itself should be connected as required by the application. The commutator
bar elements need to reference the applicable commutator model.

Once the commutator bar element has been dropped on the sheet, you can double-click it to access
the properties (make sure theParameter Values tab is selected). Specify the applicable
commutator bar model name in theMOD line and also the Lag parameter in degrees. Lag identifies
the angle the commutator bar has to rotate from TIME = 0 in the chosen sense of rotation until it is
perfectly aligned with the brush. By defa1ult, the element ID and lagging angle in degrees are
displayed next to the element.
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The commutator bar model needs to be dropped on the circuit sheet. It is unique for every
commutator bar element. The commutator bar model contains the following parameters:

l Model name that has to be referenced by all the commutator bar elements;
l R, the full contact resistance between brush and commutator bar, regardless of which of the
two is wider;

l WidB is the brush width in mechanical degrees;
l WidC is the commutator bar width in mechanical degrees (does not include the insulation
between two adjacent bars);

l Period is the angular periodicity of the positive (or negative) brushes; use 360 for a two pole
machine, 180 for a four polemachine with lap winding, etc.

Related Topics

An Application of the Commutating Bar Element.

Winding

Thewinding element is used in theMaxwell Circuit Editor to create the necessary connection
between the finite element model (the type of solution that supports the concept of winding, such as
the transient type of analysis, with or without motion) and the driving circuits. It is necessary that the
name(s) assigned for the winding(s) in the finite element model arematched exactly in the driving
circuit created inMaxwell Circuit Editor. Windings can be placed on the design sheet at anymoment
while you are creating the circuitry to be used to drive the finite element windings.
To change the name of the winding placed on the sheet, click the winding symbol on the sheet, and
change the name of the component in the property window (Value field in the DeviceName line, with
the ParamValues tab selected).

Note The dot next to the winding symbol is used as the positive reference for the initial current
(positive current is oriented from the "dotted" terminal towards to "un-dotted" terminal of
the winding, through the winding).

ECEW_Model

The ECEWmodel enables you to create an ECEmodel fromMaxwell Transient solutions.
Compared with the procedure for creating ECEmodel fromMaxwell Magnetostatic solutions,
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creating an ECEmodel directly fromMaxwell Transient solutions takes advantage of winding and
motion setups inMaxwell Transient.
The ECEWmodel is used to setup the sweeping of one winding current. To change the name of the
model placed on the sheet, click the symbol on the sheet, and change the name of the component in
the property window (Value field in the DeviceName line, with the Parameter Values tab selected).

The ECEW_Model contains the following parameters:
l DeviceName – the name of the devicemodel with default name ECEW_Model1.
l WindingName – specifies the name of winding whose current is to be swept.
l CurrentSweeps – specifies lists of all sweep currents. The format is: “v1, v2, (dv1, n1), v3,
…”, where v1, v2, v3 specify individual sweep values, and (dv1, n1) specify a sweeping
range with dv1 being the increment, and n1 the number of increments. For example, a list of
“-2.5A, (0.5A, 10)” is equivalent to "-2.5A, -2A, -1.5A, -1A, -0.5A, 0, 0.5A, 1A, 1.5A, 2A,
2.5A", and a list of "(0.5A, 5)" is equivalent to “0, 0.5A, 1A, 1.5A, 2A, 2.5A”.

l Res – phase winding resistance (available when Show Hidden is checked).
l IndE – phase end-leakage inductance (available when Show Hidden is checked).

An ECEW_Model can be used individually to create the ECEmodel of a single-phase inductor, or
combined with other ECEW_Models to setup two or more windings for poly-phase inductors. It can
also be combined with an ECER_Model, as well as an ECE3_Model, for rotational electrical
machines.
For ECEmodel creation, the setup of Stop Time and Time step are ignored. At Maxwell run time, the
circuit simulator assigns currents for all windings step-by-step based on the lists of current sweeps
until all sweeps are finished. Then an ECEmodel is created automatically. You can import this ECE
model in Simplorer via theSimplorer Circuit/SubCircuit/Maxwell Component/Add Equivalent
Circuitmenu command. For more information on couplingMaxwell designs to Simplorer
components, refer to theMaxwell Equivalent Circuit Component topic in the Simplorer Online Help.

Note You can add an ECEW_Model to an existing external circuit without deleting the original
circuit. In such cases, the original circuit is ignored and can be kept for future use. If you
want to recover the original circuit for a transient simulation, instead of ECEmodel
creation, you just need to deactivate each ECE relatedmodel by right-clicking themodel
and selecting Deactivate in the short-cut menu.

For more information on couplingMaxwell designs to Simplorer components, refer to "Coupling
Maxwell to a Simplorer Component" on page 17-39 .
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ECE3_Model

The ECE3model enables you to create an ECEmodel fromMaxwell Transient solutions. Compared
with the procedure for creating ECEmodel fromMaxwell Magnetostatic solutions, creating an ECE
model directly fromMaxwell Transient solutions takes advantage of winding andmotion setups in
Maxwell Transient.
The ECE3model is used to setup the sweeping of currents in three-phase windings. To change the
name of themodel placed on the sheet, click the symbol on the sheet, and change the name of the
component in the property window (Value field in the DeviceName line, with the Parameter Values
tab selected).

The ECE3_Model contains the following parameters:
l DeviceName – the name of the devicemodel with default name ECE3_Model1.
l Windings – specifies the comma-separated name list of three-phase windingswhose
currents are to be swept.

l CurrentSweeps – specifies the current amplitude sweep list. The format is: "v1, v2, (dv1,
n1), v3,…", where v1, v2, v3 specify individual sweeping values, and (dv1, n1) specify a
sweep range with dv1 being the increment, and n1 the number of increments. For example,
a list of "(0.5A, 5)" is equivalent to "0, 0.5A, 1A, 1.5A, 2A, 2.5A".

l PhAngIntervals – specifies the sweep types, or the number of phase-angle sweep intervals.
For three-phase windings, only two independent variables are swept to derive three-phase
currents, instead of directly sweeping three-phase currents. The two independent variables

could be DQcurrents , two-phase currents , or current amplitude and phase

angle . When , the current amplitude and phase angle sweep type
are defined. The current amplitude Im is swept based on the setup of CurrentSweeps, and
the phase angle is swept from 0 to 360 electrical degreeswith the increment of

. PhAngIntervals = 0, 1, or 2, is defined for the DQcurrent sweep
type, and 3 for the two-phase current sweep type.WhenPhAngIntervals = 0, both Id and Iq
are swept based on the original setup of CurrentSweeps, and the look-up table is extended
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according to odd-symmetric conditions.WhenPhAngIntervals = 1, the Id sweep is
extended symmetrically from negative to positive, and the Iq sweep is extended
symmetrically after the look-up table is created.WhenPhAngIntervals = 2, both Id and Iq
sweeps are extended symmetrically from negative to positive, and the computed look-up

table is not extended.WhenPhAngIntervals = 3, both and sweeps are extended
symmetrically from negative to positive, and the computed look-up table is not extended.

l Res – phase winding resistance (available when Show Hidden is checked).
l IndE – phase end-leakage inductance (available when Show Hidden is checked).

An ECE3_Model can be used individually to create the ECEmodel of a three-phase inductor, or
combined with the ECER_Model for three-phase PMmachines. It can also be combined with the
ECER_Model and ECEW_Model for winding excited three-phase synchronousmachines. An
ECE3_Model with DQ current sweep typemust always be used with an ECER_Model.
For ECEmodel creation, the setup of Stop Time and Time step are ignored. At Maxwell run time, the
circuit simulator assigns currents for all windings step-by-step based on the lists of current sweeps
until all sweeps are finished. An ECEmodel is then created automatically. You can import this ECE
model in Simplorer via theSimplorer Circuit/SubCircuit/Maxwell Component/Add Equivalent
Circuitmenu command. For more information on couplingMaxwell designs to Simplorer
components, refer to theMaxwell Equivalent Circuit Component topic in the Simplorer Online Help.

Note You can add an ECE3_Model to an existing external circuit without deleting the original
circuit. In such cases, the original circuit is ignored and can be kept for future use. If you
want to recover the original circuit for a transient simulation, instead of ECEmodel
creation, you just need to deactivate each ECE relatedmodel by right-clicking themodel
and selecting Deactivate in the short-cut menu.

For more information on couplingMaxwell designs to Simplorer components, refer to theCoupling
Maxwell to a Simplorer Component topic in theMaxwell Online Help

ECER_Model

The ECER model enables you to create an ECEmodel fromMaxwell Transient solutions.
Compared with the procedure for creating ECEmodel fromMaxwell Magnetostatic solutions,
creating an ECEmodel directly fromMaxwell Transient solutions takes advantage of winding and
motion setups inMaxwell Transient.
The ECER model is used to setup the sweeping of rotor position. To change the name of themodel
placed on the sheet, click the symbol on the sheet, and change the name of the component in the
property window (Value field in the DeviceName line, with the Parameter Values tab selected).
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The ECER_Model contains the following parameters:
l DeviceName –the name of the devicemodel with default name ECER_Model1.
l RotAngMax – specifies themaximum rotating angle (in mechanical degrees) for sweeping.
l InElecDeg – check to define RotAngMax in elec. degrees, uncheck inmech. degrees
l RotAngIntervals – specifies the number of uniform sweep intervals for rotating angle.
l SkewAng – specifies the skew angle (in mechanical degrees) of the stator or rotor core for
2D only.

l Poles – specifies the number of poles of themachine.
l Slots – specifies the number of stator slots to determine cogging torque period (available
when Show Hidden is checked).

l Output – specifies how the look-up table outputs the winding flux linkages. 0 for flux linkages
in ABC; 1 for flux linkages in DQ0; 2 for inductances in DQand field flux linkage (available
when Show Hidden is checked).

An ECER_Model cannot be used individually. It should be used combined with an ECEW_Model
and/or an ECE3_Model for rotational electrical machines.WhenDQFluxOutput is checked, it must
be combined with an ECE3_Model.
For ECEmodel creation, the setup of Stop Time and Time step are ignored. At Maxwell run time, the
circuit simulator assigns currents for all windings step-by-step based on the lists of current sweeps
until all sweeps are finished. An ECEmodel is created automatically. You can import this ECEmodel
in Simplorer via theSimplorer Circuit/SubCircuit/Maxwell Component/Add Equivalent
Circuitmenu command. For more information on couplingMaxwell designs to Simplorer
components, refer to theMaxwell Equivalent Circuit Component topic in the Simplorer Online Help.

Note You can add an ECER_Model to an existing external circuit without deleting the original
circuit. In such cases, the original circuit is ignored and can be kept for future use. If you
want to recover the original circuit for a transient simulation, instead of ECEmodel
creation, you just need to deactivate each ECE relatedmodel by right-clicking themodel
and selecting Deactivate in the short-cut menu.

For more information on couplingMaxwell designs to Simplorer components, refer to "Coupling
Maxwell to a Simplorer Component" on page 17-39 .
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ECEL_Model

The ECEL_model is used to setup the sweeping of mover position of a translational motion. To
change the name of themodel placed on the sheet, click the symbol on the sheet, and change the
name of the component in the property window (Value field in the DeviceName line, with the
Parameter Values tab selected).

ECEL_Model1

The ECEL_Model contains the following parameters:
l DeviceName − the name of the devicemodel with the default name as ECEL_Model1;
l MotionMax − themaximummotion range for sweeping;
l MotionIntervals − the number of uniform sweeping intervals for motion range;
l MotionType − themotion type: 0 for limitedmotion; 1: for periodicmotion with full sweeping; 2
or more: for periodicmotion with half or less sweeping.

l MotionDir − themotion direction in (x, y, z);
The initial position set in Maxwell designs is always referred to as 0 position in ECEmodel. When
MotionType >= 1 (for periodicmotions), the number of sweepings is equal to MotionIntervals. In
such a case, the last point at MotionMax is not swept and is automatically extended from the first
sweeping point at zero position based on the periodic conditions.WhenMotionType = 0 (for limited
motion), the number of sweepings is equal to MotionIntervals + 1. In such a case, themotion limit is
always ranged from 0 toMotionMax in the ECEmodel.
An ECEL_Model cannot be used individually. It should be used combined with an ECEW_Model
and/or an ECE3_Model for rotational electrical machines.
For ECEmodel creation, the setup of Stop Time and Time step are ignored. At Maxwell run time, the
circuit simulator assigns currents for all windings step-by-step based on the lists of current and
position sweeps until all sweeps are finished. An ECEmodel is created automatically. You can
import this ECEmodel in Simplorer via theSimplorer Circuit/SubCircuit/Maxwell
Component/Add Equivalent Circuitmenu command. For more information on couplingMaxwell
designs to Simplorer components, refer to theMaxwell Equivalent Circuit Component topic in the
Simplorer Online Help.

Note You can add an ECEL_Model to an existing external circuit without deleting the original
circuit. In such cases, the original circuit is ignored and can be kept for future use. If you
want to recover the original circuit for a transient simulation, instead of ECEmodel
creation, you just need to deactivate each ECE relatedmodel by right-clicking themodel
and selecting Deactivate in the short-cut menu.

For more information on couplingMaxwell designs to Simplorer components, refer to "Coupling
Maxwell to a Simplorer Component" on page 17-39 .
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ECET_Model

The ECET_model is used to setup the sweeping of themagnetizing current for each phase of a
single- or poly-phase transformer. To change the name of themodel placed on the sheet, click the
symbol on the sheet, and change the name of the component in the property window (Value field in
the DeviceName line, with the Parameter Values tab selected).

ECET_Model1

The ECET_Model contains the following parameters:
l DeviceName − the name of the devicemodel with the default name as ECET_Model1;
l PriWindings − the name list of all primary windingswith semicolons for separators between
phase;

l SecWindings − the name list of all secondary windingswith semicolons for separators
between phases;

l TurnsRatios − the ratio of the secondary turns to the primary turns for only one phase.
If a transformer has two or more secondary windings for one phase, the secondary winding name list
is separated by commas between winding names for the same phase, and TurnsRatios is a value
list, instead of a single value, which is separated by commas between values for one phase. For
example, for a three-phase transformer with two secondary windings for each phase, the
parameters for ECET_Model are set as:

An ECET_Model cannot be used individually. It should be used combined with an ECEW_Model
and/or an ECE3_Model.
In an ECEmodel look-up table, only themagnetizing inductance for each phase is assumed to be
non-linear, and all leakage inductances for all primary and secondary windings are assumed to be
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constant. Therefore, only themagnetizing current of the primary winding for each phase is required
to be swept, which reduces the number of sweeping points significantly.
For ECEmodel creation, the setup of Stop Time and Time step are ignored. At Maxwell run time, the
circuit simulator assigns currents for all windings step-by-step based on the list of current sweeps
until all sweeps are finished. An ECEmodel is created automatically. You can import this ECEmodel
in Simplorer via theSimplorer Circuit/SubCircuit/Maxwell Component/Add Equivalent
Circuitmenu command. For more information on couplingMaxwell designs to Simplorer
components, refer to theMaxwell Equivalent Circuit Component topic in the Simplorer Online Help.

Note You can add an ECET_Model to an existing external circuit without deleting the original
circuit. In such cases, the original circuit is ignored and can be kept for future use. If you
want to recover the original circuit for a transient simulation, instead of ECEmodel
creation, you just need to deactivate each ECE relatedmodel by right-clicking themodel
and selecting Deactivate in the short-cut menu.

For more information on couplingMaxwell designs to Simplorer components, refer to "Coupling
Maxwell to a Simplorer Component" on page 17-39 .

Passive Elements

Thirteen passive elements are available in theMaxwell Circuit Editor project tree:
l Cap: Capacitor
l DIODE: Diode
l DIODE_Model: DiodeModel Data
l Ind: Inductor
l IndM: Mutual Inductance
l Res: Resistor
l SW_I: Current Controlled Switch
l SW_I4: Current Controlled Switch with Controlling Port
l SW_IModel: Model Data for Current Controlled Switches
l SW_V: Voltage Controlled Switch
l SW_V4: Voltage Controlled Switch with Controlling Port
l SW_VModel: Model Data for Voltage Controlled Switches
l Transformer: Ideal Transformer

The text before the colon (:) represents the component name and can be changed in theProperties
window once the component is placed in the schematic.

Related Topics

Assigning Component Properties in Maxwell Circuit Editor
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Diode & Diode Model

Diode element must always be used together with a diodemodel. One diodemodel element can be
used as reference for multiple diodes, as needed. Thus, once a diode is placed on the design sheet,
a correspondingmodel must also be present on the sheet. Once both needed elements (diode and
diodemodel) have been placed on the sheet, right mouse click the diodemodel and specify the
parameters as required by the application. Then, right mouse click the diode and create the
reference to the correspondingmodel by entering the name of themodel in theMOD line (Parameter
Values tab should be selected). If you select theShow Hidden check box, the AREA diode
parameter (used below in themodel definition) becomes visible. The default value of the AREA
parameter is 1.
The diodemodel used byMaxwell Circuit Editor is a staticmodel as described by the following
equation:
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Themodel parameters are as follows:
l IS is the saturation current in Amps.
l RS is contact resistance in Ohms.
l N is the emission coefficient.
l EG is the barrier height at 0 K, in volts.
l XTI is the diode saturation current temperature coefficient.
l BV is themagnitude of the reverse breakdown voltage in volts.
l IBV is themagnitude of the reverse breakdown current in amps.
l TNOM is the reference temperature in Celsius.

Capacitor (CAP)

A capacitor is assumed to be ideal (without losses or inductance) and is defined by the value of its
capacitance (in the unit chosen by the user) and the corresponding initial condition (initial voltage).
The straight bar of the capacitor symbol is used as the positive reference, and the curved bar of the
capacitor symbol is used as a negative reference for the initial voltage (expressed in volts). The
default value of the initial voltage for all capacitors is zero. By default, the capacitance and element
ID are displayed next to the component.
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Resistor (Res)

Resistor is assumed to be ideal (without inductive or capacitive effects) and is defined by the value of
its resistance (in the unit chosen by the user, Ohm by default.
By default the resistance and element ID are displayed next to the component.

Inductor (IND)

Inductor is assumed to be ideal (without resistive or capacitive effects) and is defined by the value of
its inductance (in the unit chosen by the user) and the corresponding initial condition (initial current).
Note that the dot next to the inductor symbol is used as the positive reference for the initial current
(positive current is oriented from the "dotted" terminal towards to "un-dotted" terminal of the inductor,
through the inductor). The dot is also used to specify themutual inductance between two or more
inductors and thus determines the "polarized" terminals of the inductors. The default value of the
initial current for all inductors is zero. By default the inductance and element ID are displayed next to
the component.

Using theMaxwell Circuit Editor 27-27
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Mutual Inductance (IndM)

Mutual inductance is used to specify the inductive coupling between inductors. It is defined by
specifying the IDs of the coupled inductors (always in pairs) and the coupling coefficient, a number
between -1 and 1. The default value of the coupling coefficient is 0.95.

Current Controlled Switch (SW_I)

The current controlled switch comes in two flavors: with controlling port and without a controlling
port. In either case amodel data for the current controlled switch needs to be specified, similarly to
the case of the diode.
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Right-click the current controlled switchmodel and select Properties. With the Parameter Values tab
selected, specify the switchmodel name (in theMOD line) aswell as the ID of the controlling
element: either an ammeter or a voltage source. In the later case the controlling quantity is the
current through the voltage source. (Note that an ammeter is a voltage source with zero voltage, i.e.
a short circuit).
The current controlled switch with controlling port allows for the controlling quantity to be wired
directly using connectionswith wires. In this case a reference arrow in the controlling port is
displayed and is internally used as current reference (positive current flow as indicated by the arrow).
In themodel for the current controlled switch the following parameters are used:

l Ron is the resistance of the switch in the on state (0.001 ohms default value).
l Roff is the resistance of the switch in the off state (1,000,000 ohms default value).
l Ion is the "on" value of the controlling current in amps. If I>Ion, then R=Ron.
l Ioff is the "off" value of the controlling current in amps. If I<Ioff, then R=Roff.

Note SettingROFF = 0 in the voltage or current controlled switchmodel data changes the
behavior of the device into a controlled conductance, according to the following
equation:

where:

is a function describing the controlling signal -- a time, position, or speed dependent
current source or voltage source. FunctionG(P) clearly shows that themagnitude of
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the conductance is dictated by both the value ofRON and themagnitude of the
control signal, while the time / position / speed dependency is dictated by the control
signal itself.

Note SettingRON = 0 in the voltage or current controlled switchmodel data changes the
behavior of the device into a controlled resistance, according to the following
equation:

where:

is a function describing the controlling signal -- a time, position, or speed dependent
current source or voltage source. FunctionR(P) clearly shows that themagnitude of
the conductance is dictated by both the value ofROFF and themagnitude of the
control signal, while the time / position / speed dependency is dictated by the control
signal itself.

Voltage Controlled Switch (SW_V)

The voltage controlled switch comes in two flavors: with controlling port and without a controlling
port. In either case amodel data for the voltage controlled switch needs to be specified, similarly to
the case of the diode and current controlled switches.

Right-click the voltage controlled switchmodel and select Properties. With the Parameter Values tab
selected, specify the switchmodel name (in theMOD line) aswell as the ID of the controlling
element: either a voltmeter or a current source. In the later case the controlling quantity is the voltage
across the current source. (Note that a voltmeter is a current source with zero current, i.e. an open
circuit).
The voltage controlled switch with controlling port allows for the controlling quantity to be wired
directly using connectionswith wires. In this case the reference for the voltage across the controlling
port is displayed by "+" and "-" symbols and the two symbols are internally used as voltage reference.
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In themodel for the voltage controlled switch the following parameters are used:
l Ron is the resistance of the switch in the on state (0.001 ohms default value).
l Roff is the resistance of the switch in the off state (1,000,000 ohms default value).
l Von is the "on" value of the controlling voltage in volts. If V>Von, then R=Ron.
l Voff is the "off" value of the controlling voltage in volts. If V<Voff, then R=Roff.

Note SettingROFF = 0 in the voltage or current controlled switchmodel data changes the
behavior of the device into a controlled conductance, according to the following
equation:

where:

is a function describing the controlling signal -- a time, position, or speed dependent
current source or voltage source. FunctionG(P) clearly shows that themagnitude of
the conductance is dictated by both the value ofRON and themagnitude of the
control signal, while the time / position / speed dependency is dictated by the control
signal itself.

Note SettingRON = 0 in the voltage or current controlled switchmodel data changes the
behavior of the device into a controlled resistance, according to the following
equation:

where:

is a function describing the controlling signal -- a time, position, or speed dependent
current source or voltage source. FunctionR(P) clearly shows that themagnitude of
the conductance is dictated by both the value ofROFF and themagnitude of the
control signal, while the time / position / speed dependency is dictated by the control
signal itself.
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Transformer

The transformer is an ideal element of infinite power without resistive or capacitive effects and linear.
It is defined the values of the primary and secondary inductances and the coupling coefficient
between the two windings.

Probes

Three types of probes are available in theMaxwell Circuit Editor project tree:
l Ammeter: Ammeter
l Voltmeter: Voltmeter
l VoltmeterG: Voltmeter with One Pin Grounded

The text before the colon (:) represents the component name and can be changed in theProperties
window once the component is placed in the schematic.

Related Topics

Assigning Component Properties in Maxwell Circuit Editor

Ammeter

The ammeter is an ideal element (equivalent with an ideal voltage source with zero voltage). An
arrow is attached to the symbol so that a positive current measured by the ammeter flows as
indicated by the arrow.
No numerical value is needed, just the element ID and namemay by altered by the user.
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Voltmeter

The voltmeter is an ideal element with two pins (equivalent with an ideal current source with zero
current). A plus sign is attached to the voltmeter symbol so that a reference for the voltagemeasured
by the voltmeter is possible.
No numerical value is needed, just the element ID and namemay by altered by the user.

Voltmeter with One Pin Grounded (VoltmeterG)

The voltmeter with one pin grounded is an ideal element with one pin, equivalent with an ideal
current source with zero current. A plus sign is not necessary since it is assumed that the grounded
pin (not available for connection in the circuit) is the negative one while the pin available for
connection is the positive one. Thus, the reference for the voltagemeasured by the voltmeter is
possible.
No numerical value is needed, just the element ID and namemay by altered by the user.

Current and Voltage Sources

Sources available in theMaxwell Circuit Editor can be defined such that in general the dependency
of the current or voltage can bemade function of time, position, or speed. The type of dependency is
part of the properties of the respective source and is always user-selectable. Thus, in the equation
defining the behavior of the source (when specified), the variable "t" canmean TIME or POSITION
or SPEED as selected by the user for each application.
The default dependency type is TIME.
Twelve types of sources are available in theMaxwell Circuit Editor project tree:
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l IDC: DC Current Source
l IExp: Exponential Current Source
l IPulse: Pulse Current Source
l IPWL: Piecewise Linear Current Source
l ISffm: Sinusoidal Current Source
l ISin: Sinusoidal Current Source
l VDC: DC Voltage Source
l VExp: Exponential Voltage Source
l VPulse: Pulse Voltage Source
l VPWL: Piecewise Linear Voltage Source
l VSffm: Sinusoidal Voltage Source
l VSin: Sinusoidal Voltage Source

The text before the colon (:) represents the component name and can be changed in theProperties
window once the component is placed in the schematic.

Related Topics

Assigning Component Properties in Maxwell Circuit Editor

DC Current Source

This type of source specifies the DC current flowing in a conductor. You can set either the total
current or the current density flowing in the object.

l If total current is specified, the current density is assumed to be uniformly distributed
throughout the object.

l If current density is specified, youmay define a uniform current density or one that varies as a
function of position.

Exponential Current Source

This is an independent current source with an exponential waveform of the current as function of
time as shown in the figure below. The arrow symbol shows the direction of the positive current flow
through the current source.
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Thus, the parameters of this exponential source are:
l Initial current in Amps, I1;
l Peak current in Amps, I2;
l Rise time delay, Td1:

l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

l Rise time constant, Tau1:
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l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

l Fall time delay, Td2:
l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

l Fall time constant, Tau2:
l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

Pulse Current Source

This is an independent current source with a trapezoidal waveform of the current as a function of
time. The arrow symbol shows the direction of the positive current flow through the current source.
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The parameters of a pulse current source are the following:
l Initial current in Amps, I1;
l Peak current in Amps, I2;
l Initial delay time, Td:

l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

l Rise time, Tr:
l In seconds if type is TIME
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l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

l Fall time Tf:
l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

l Pulse width, Pw:
l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

l Pulse period, Period:
l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

Piecewise Linear Current Source

This is an independent current source with a piecewise linear waveform of the current as a function
of time. The arrow symbol shows the direction of the positive current flow through the current source.
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A piecewise linear current source is described by up to 20 pairs (Ti, Ii), where every pair of values
specifies the value Ii in Amps of the current at time Ti in the following units:

l In seconds if type is TIME.
l In degrees if type is POSITION and type of motion is rotational.
l In geometry units if type is POSITION and type of motion is translational.
l In rpm if type is SPEED and type of motion is rotational.
l In geometry units per second if type is SPEED and type of motion is translational.
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Frequency-Modulated Sinusoidal Current Source

This is an independent current source with a single frequencymodulated sinusoidal waveform of the
current as a function of time. The arrow symbol shows the direction of the positive current flow
through the current source.

The equation describing the waveform is:

where:
l Io is Offset current in Amps.
l Ia is the peak amplitude in Amps.
l FC is the carrier frequency if type is TIME.
l Mdi is themodulation index.
l FS is the signal frequency if type is TIME.

If the type is POSITION, the frequency should be calculated based on the respective spatial
periodicity, taking into account the fact that "t" in the above equation ismeasured in degrees for
rotational type of motion and in the user-defined geometry units for translational type of motion.
If the type is SPEED, the frequency should be calculated based on the respective speed periodicity,
taking into account the fact that "t" in the above equation ismeasured in rpm for rotational type of
motion and in the user-defined geometry units per second for translational type of motion.

Sinusoidal Current Source

This is an independent current source with an exponentially damped sinusoidal waveform of the
current as a function of time. The arrow symbol shows the direction of the positive current flow
through the current source.
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The equation describing the waveform is:

where:
l Io is Offset current in Amps.
l Ia is the peak amplitude in Amps.
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l IFreq is the signal frequency if type is TIME.
l Td is the delay time in seconds if type is TIME.
l Phase is the signal phase delay if type is TIME.
l Df is the damping factor in 1/seconds if type is TIME.

If the type is POSITION, the frequency should be calculated based on the respective spatial
periodicity, taking into account the fact that "t" in the above equation ismeasured in degrees for
rotational type of motion and in the user-defined geometry units for translational type of motion. The
delay and damping factor should also be interpreted accordingly.
If the type is SPEED, the frequency should be calculated based on the respective speed periodicity,
taking into account the fact that "t" in the above equation ismeasured in rpm for rotational type of
motion and in the user-defined geometry units per second for translational type of motion. The delay
and damping factor should also be interpreted accordingly.

DC Voltage Source

This type of source specifies the total DC voltage (electric potential) on a conductor. Voltages can be
defined as constants or asmath functions; however, the potential on a conductor is constant over the
entire conductor. Note that conductors that touch should be set to the same voltage or defined as a
single voltage source, since their potentials are identical.
DC voltagemay also be specified on an edge or edges. Voltages can be defined as constant or as
functions of position (for instance, to model a specific distribution of potential on the surface of a
dielectric).

Exponential Voltage Source

This is an independent voltage source with an exponential waveform of the voltage as a function of
time. The "+" and "-" symbols are used tomark the polarity of the source.
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The parameters of an exponential voltage source are the following:
l Initial voltage in Volts, V1.
l Peak voltage in Volts, V2.
l Rise time delay, Td1:

l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

l Rise time constant, Tau1:
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l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

l Fall time delay, Td2:
l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

l Fall time constant, Tau2:
l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

Pulse Voltage Source

This is an independent voltage source with a trapezoidal waveform of the voltage as a function of
time. The "+" and "-" symbols are used tomark the polarity of the source.
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The parameters of a voltage pulse source are the following:
l Initial voltage in Volts, V1.
l Peak voltage in Volts, V2.
l Initial delay time, Td:

l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;
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l Rise time, Tr:
l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

l Fall time Tf:
l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

l Pulse width, Pw:
l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

l Pulse period, Period:
l In seconds if type is TIME
l In degrees if type is POSITION and type of motion is rotational;
l In geometry units if type is POSITION and type of motion is translational;
l In rpm if type is SPEED and type of motion is rotational;
l In geometry units per second if type is SPEED and type of motion is translational;

Piecewise Linear Voltage Source

This is an independent voltage source with a piecewise linear waveform of the voltage as a function
of time. The "+" and "-" symbols are used tomark the polarity of the source.
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A piecewise linear voltage source is described by up to 20 pairs (Ti, Vi), where every pair of values
specifies the value Vi in Volts of the voltage at time Ti in the following units:

l In seconds if type is TIME.
l In degrees if type is POSITION and type of motion is rotational.
l In geometry units if type is POSITION and type of motion is translational.
l In rpm if type is SPEED and type of motion is rotational.
l In geometry units per second if type is SPEED and type of motion is translational.
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Frequency-Modulated Sinusoidal Voltage Source

This is an independent voltage source with a single frequencymodulated sinusoidal waveform of the
voltage as a function of time. The "+" and "-" symbols are used tomark the polarity of the source.

The equation describing the waveform is:

where:
l Vo isOffset voltage in Volts.
l Va is the peak amplitude in Volts.
l FC is the carrier frequency if type is TIME.
l Mdi is themodulation index.
l FS is the signal frequency if type is TIME.

If the type is POSITION, the frequency should be calculated based on the respective spatial
periodicity. taking into account the fact that "t" in the above equation ismeasured in degrees for
rotational type of motion and in the user-defined geometry units for translational type of motion.
If the type is SPEED, the frequency should be calculated based on the respective speed periodicity,
taking into account the fact that "t" in the above equation ismeasured in rpm for rotational type of
motion and in the user-defined geometry units per second for translational type of motion.

Sinusoidal Voltage Source

This is an independent voltage source with an exponentially damped sinusoidal waveform of the
voltage as a function of time. The "+" and "-" symbols are used tomark the polarity of the source.
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The equation describing the waveform is:

where:
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l Vo isOffset voltage in Volts.
l Va is the peak amplitude in Volts.
l VFreq is the signal frequency if type is TIME.
l Td is the delay time in seconds if type is TIME.
l Phase is the signal phase delay if type is TIME.
l Df is the damping factor in 1/seconds if type is TIME.

If the type is POSITION, the frequency should be calculated based on the respective spatial
periodicity, taking into account the fact that "t" in the above equation ismeasured in degrees for
rotational type of motion and in the user-defined geometry units for translational type of motion. The
delay and damping factor should also be interpreted accordingly.
If the type is SPEED, the frequency should be calculated based on the respective speed periodicity,
taking into account the fact that "t" in the above equation ismeasured in rpm for rotational type of
motion and in the user-defined geometry units per second for translational type of motion. The delay
and damping factor should also be interpreted accordingly.

Using the AF (alternating flux) model
For transient simulationswhose excitation is the sinusoidal voltage source, the DC flux linkage
component may take a very long time to decay, especially for a device with a large time constant.
Setting AF=1 enables the AFmodel to be used by theMaxwell transient solver.

Using theMaxwell Circuit Editor 27-50
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

The AFmodel algorithm adds an additional voltage component to the original voltage definition
during the first half-cycle to quickly eliminate the DC flux linkage, thus speeding up simulation
solutions.

Note l RMxprt automatically enables the AFmodel in the voltage definition for each winding
when theMaxwell 2D or 3D model and associatedMaxwell circuit are created.

l This speedup capability is only applicable to voltage sourceswhose integration of
voltage quantity over one period is zero. Thismeans the DC component of all voltage
sourcesmust also be zero.

Placing Components in the Maxwell Circuit Editor Schematic
To place a circuit component:

1. Click theComponents tab in theComponent Libraries Window.
2. In the tree, expand theMaxwell Circuit Elements branch.
3. Expand the branch containing the component you want to place. The choices areDedicated

Elements, Passive Elements, Probes, andSources.
4. Click to select the name of the component you want to place.
5. Drag the component to the Schematic window.

A diagram of the component appears connected to themouse pointer.
6. Release themouse button to place the component in the location you prefer.
7. To place a second component of the same type, move themouse pointer to another location,

and release it again.
8. To exit from placement mode, do one of the following

l To place the component a final time before exiting, pressENTER.
l To exit without placing the component again, pressSPACE.

Hint To access these commands, you can also right-click and select one of the following
from the shortcut menu:

l Place and Finish
l Finish

Related Topics

Assigning Component Properties in Maxwell Circuit Editor

Assigning Component Properties in Maxwell Circuit Editor
Once a component has been placed in the Schematic window, do the following to edit its properties:

1. Double-click the component.
ThePropertieswindow opens.

2. Make the desired edits on the following four tabs:
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l Parameter Values
l General
l Symbol
l Property Displays

Note Variablesmay be assigned to parameter values in the circuit by entering a
variable name in the parameter value field and assigning a value in theAdd
Variable dialog box. Variables assigned inMaxwell Circuit Editor will be
exported with the circuit and are available for modifying when the circuit is
imported into anotherANSYS application.

3. Optionally, you can select or clear theShow Hidden check box on any of theProperties
window tabs.

4. ClickOK.
The specific properties differ per component, as seen in the help topics describing each circuit
component.
Each tab of thePropertieswindow contains a list of parameters (each individual row) and
properties you need to set for each parameter (each column is a property).

Related Topics

Placing Components in theMaxwell Circuit Editor Schematic
Callback Scripting Using PropHost Object

Callback Scripting Using PropHost Object
Callback scripts are scripts that can be set in the Property Dialog for individual properties by clicking
the button in the Callback column and choosing a script that is saved with the project. Callback
scripts can contain any legal script commands including general ANSYS script function calls (e.g.
GetApplication(), …). In addition, they can call functions on a special object named PropHost. The
PropHost represents the PropServer (owner of properties) that contains the Property that is calling
the Callback script. Therefore, the Callback script can use the PropHost's functions to query or set
other properties in the same PropServer. Refer to the Property Level scripting commands for more
information.

Related Topics

Scripting Guide:Property Level Commands

Opening the Online Help for Circuit Components
To start the online help for any component from the schematic editor:

1. In the Schematic editor, double-click the component for which you want to view help.
TheProperties dialog box opens.
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2. Click theParameter Values tab.
3. Select theValue radio button.
4. In the Info row, click the button in theValue column, as shown below forAC_Model:

The help viewer opens to display the component’s specifications.

Setting Up an External Circuit Using the Maxwell Circuit Editor

Note One use for an external circuit can be to supply an excitation to a coil terminal, rather than
using a voltage type of excitation.

Note External circuits intended for use with the TimeDecompositionMethod (TDM) can only
support basic circuit elements that are solution-independent. This is because, for TDM, all
time steps (or all time steps in a subdivision) are solved simultaneously - and thus the circuit
topology and its parametersmust be known before solving. Therefore some circuit
elements, such as solution-dependent switches, diodes, capacitors, and inductors which
are not directly connected to windings in series, are not supported.

The driving circuit for the winding in this design consists of a voltage source in series with a resistor
and with the winding.When complete, the circuit should look similar to the figure below.
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To set up the external circuit, follow this general procedure:
1. Add the circuit elements.
2. Connect the circuit elements in series.
3. Export the netlist.
4. Save theMaxwell Circuit Editor project.
5. Assign the external circuit.

Add the Circuit Elements

To add the circuit elements in Maxwell Circuit Editor:
1. ClickProject>Insert Maxwell Circuit Design.

The circuit sheet appears.
2. Place the winding circuit element on the sheet:

a. In theComponent Libraries, underMaxwell Circuit Elements>Dedicated Elements,
select theWinding element.

b. Drag it onto the sheet.
c. Right-click, and select Finish to place the component.
d. To view the properties, double-click the component in the Schematic window.

ThePropertieswindow appears.
e. Change theName to currentwinding, the same name you used when defining the

winding in theMaxwell design.
f. ClickOK.
g. ClickDraw>Rotate, and position the winding vertically.

3. Place a resistor on the sheet:
a. In the project tree, under Passive Elements, selectResistor.
b. Drag the resistor onto the sheet.
c. Right-click, and select Finish to place it where desired.
d. Double-click the symbol of the resistor, change the value of the resistor,R, to 3.09, keep

theUnit value set to ohm, and clickOK. The default is 100Ohms.
4. Place a voltage pulse on the sheet:
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a. In the project tree, under Sources select aVPulse element (Pulse Voltage Source).
b. Drag it to the sheet, and then right-click and select Finish to place it onto the sheet.
c. Double-click the source element symbol on the sheet, and then specify the following

source characteristics:
Parameter Value Description
V1 0 Initial

voltage

V2 5.97 Peak
voltage

Tr 0.001 Rise time

Tf 0.001 Fall time

Pw 1 Pulse width

Period 2

d. Leave the other fields set to the default values, and clickOK.

Connect the Circuit Elements in Series

To connect the circuit elements in series:
1. Fromwithin theMaxwell Circuit Editor, clickDraw>Wire.
2. Click each terminal.
3. When done, place theGround symbol: ClickDraw>Ground (or click theGround symbol on

the toolbar), place theGround symbol on the sheet, right-click, and select Finish to place the
symbol.

4. Connect the ground to the circuit: ClickDraw>Wire, and draw the final wire.

Export the Netlist

To export the netlist:
1. Fromwithin theMaxwell Circuit Editor, clickMaxwell Circuit>Export Netlist.

TheNetlist Export dialog box appears.
Note To view the netlist before exporting it, clickMaxwell Circuit>Browse

Netlist.

2. Select the folder where you want to save the external circuit file.
3. Type a name for the circuit in the File name box.
4. ClickSave.

TheNetlist Export dialog box closes and theMaxwell Circuit Editor reappears.
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Save the Maxwell Circuit Editor Project

To save the project and exit Maxwell Circuit Editor:
1. ClickFile>Save, type a name for the project, and clickSave to save theMaxwell Circuit Editor

project.
2. ClickFile>Exit to close theMaxwell Circuit Editor program.

Assign the External Circuit

To assign the circuit in theMaxwell design:
1. ClickMaxwell2D (or 3D)>Excitations>External Circuit>Edit External Circuit.

The Edit External Circuit dialog box appears.
2. Click Import Circuit Netlist.

TheSelect File dialog box appears.
3. SelectDesigner Net List Files (*.sph) from the Files of type pull-down list.
4. Browse to the location where you saved the circuit, select it, and clickOpen to import it.
5. ClickOK to close theEdit External Circuit dialog box.

Renaming a Source in Maxwell Circuit Editor
To rename a source that is drawn in the Schematic:

1. Double-click the source.
TheProperties dialog box appears.

2. Click theParameter Values tab (which should be the default tab visible).
3. Change the text value in theName row.
4. ClickOK.

The new name appears for the source label in the Schematic.

Applying the Commutating Bar Element
This paragraph describes how to apply the commutating bar element to simulate the commutating
process of brush-type DC machines. A two-pole 12-slot PMDC motor, as shown in Fig. 1, is used as
an example. The flux direction inside the S pole permanent magnet is from the air gap to stator yoke,
and that of the N pole is from the stator yoke to the air gap.
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The DC winding is of lap type with coil pitch of 5 slots. The flat-out extensional drawing of themotor
indicating the relationship of permanent magnets, coils, commutating bars, and brushes at the initial
position is shown in Fig. 2. With the rotation direction shown in Fig. 2, the brush aligned with the S
pole is positive, and the brush aligned with the N pole is negative. The "go" terminal of coil0 connects
to bar0, and its return terminal connects to bar1; the "go" terminal of coil1 connects to bar1, and its
return terminal connects to bar2; and so on.

At the initial time, bar0 lags the positive brush by 15mechanical degrees (a half commutating bar
pitch), and it lags the negative brush by 195mechanical degrees; bar1 lags the positive brush by -15
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mechanical degrees, or 345 degrees, and it lags the negative brush by 165mechanical degrees; and
so on. The functional connection of each commutating bar with the positive brush or negative brush
ismodeled by BarC (commutating bar) elements, as shown in Fig. 3 with ID number from 37 to 60.

In Fig. 3, elements with ID numbers of 37 to 48 represent the functional connections of bar0 to bar11
with the positive brush, respectively. Elements with ID numbers of 49 to 59 and 60 give the functional
connections of bar1 to bar11, and bar0 with the negative brush, respectively. The additional inductor
in series with each coil inductance represents the end turn effect that is desirable to consider in a 2D
model and possibly also in a 3D model that does not include the end turn geometry. The additional
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series resistor in series with each coil represents the global resistance of the coil and needs to be
included in both 2D and 3D simulations. The values between the BarC element symbols and ID
numbers are the respective lagging angles in mechanical degrees. The element parameters can be
edited by double-clicking on the element, as shown in Fig. 4.

In Fig. 4, the input value "ComModel" for MOD is themodel name that defines the parameters of
commutating bars and brushes. The parameters of ComModel can be edited by double-clicking the
BarC_Model element, as shown in Fig. 5.

Note As a rule, each BarC element references a unique BarC_Model
element.
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In this design, the commutator diameter is 24mm, and the brush width is 8mm. Therefore, the brush
width in mechanical degrees is the following:
WidB = 2 * arcsin(8/24) = 38.9 (deg)
The number of commutator bars is 12 (the same as the number of slots), and the commutator
insulation thickness is 0.5mm. Therefore, the commutator bar width in mechanical degrees is the
following:
WidC = 360/12 - 2 * arcsin(0.5/24) = 27.6 (deg)
The electric conductance between a commutating bar and a brush varies with the rotor position and
can be derived from themodel parameters, as shown in Fig. 6, whereGmax = 1 / R.

In Fig. 6, LagAngle is treated as a BarC element parameter because it is different for different
commutating bars. All other values (Gmax,WidB,WidC, and Period) can be obtained fromBarC_
Model parameters. Positions a, b, c, and d correspond to the positionswhen one side of a
commutating bar (solid color) aligns to one side of a brush, as shown in Figs. 7 and 8.
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The computed no-load induced voltage, taking into account the commutating process, is shown in
Fig. 9.
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28 - Maxwell 2D Technical Notes
Maxwell® 2D is an interactive software package that uses the finite element method (FEM) analysis
to simulate and solve two-dimensional electromagnetic field problems. Maxwell integrateswith other
ANSYS software to perform complex taskswhile remaining easy to use.
Maxwell 2D is used for analyzing electric andmagnetic fields in structureswith uniform
cross-sections or full rotational symmetry— where the field patterns in the entire device can be
analyzed bymodeling the field patterns in its cross-section.
In general, 2D modeling of electromagnetic fields solves for the fields in a 2D cross section of a
device which is considered to be placed far away from the extremities of the devices, thus ignoring
end effects. While it can provide excellent accuracy for all applicablemodeling tasks, 2D solution
sequences cannot be always used to accuratelymodel electromagnetic devices. Deviceswhere end
effects are significant or that may not exhibit complete rotational symmetrymust bemodeled in 3D
for greatest accuracy.

Technical Notes
These technical notes contain background information on the theory behind theMaxwell, including:

l A list of all Maxwell softwaremodules.
l Discussion of: background theory; capacitance, inductance, impedance, conductance, and
admittancematrices; virtual force and torque; flux linkage; and current flow for the following
field solvers:
l Electrostatic
l Magnetostatic
l Eddy current
l DC conduction
l AC conduction
l Transient

l The differences between field solutions in cartesian (XY) and axisymmetric (RZ) models.
l An overview of the phasor notation used in this guide to represent complex field quantities.

Related Topics

Optimization Overview

Solvers
Maxwell 2D consists of the following solver modules:

Electrostatic
Field Solver

Computes the static electric field that exists in a structure given a distribution of
DC voltages and static charges. A capacitancematrix, force, torque, and flux
linkagemay also be computed from the electric field.
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Magnetostatic
Field Solver

Computes the staticmagnetic field that exists in a structure given a distribution of
DC currents and permanent magnets. Themagnetic field may be computed in
structureswith both nonlinear and linear materials. An inductancematrix, force,
torque, and flux linkagemay also be computed from the energy stored in the
magnetic field.

AC
Conduction
Field Solver

Computes the AC voltages and current density distribution in amaterial having
both conductive and dielectric properties given a distribution of AC voltages. An
admittancematrix and current flow may also be computed from the calculated
fields.

DC
Conduction
Field Solver

Computes the DC currents that flow in a lossy dielectric given a distribution of DC
voltages. A conductancematrix and current flow may also be computed from the
computed electric field solution.

Eddy Current
Field Solver

Computes the oscillatingmagnetic field that exists in a structure given a
distribution of AC currents. Also computes current densities, taking into account
all eddy current effects (including skin effects). An impedancematrix, force,
torque, core loss, and current flow may also be computed from the computed field
solution.

Transient
Magnetic
Solver

Computes transient (TimeDomain) magnetic fields caused by permanent
magnets, conductors, and windings supplied by voltage and/or current sources
with arbitrary variation as functions of time, position and speed. It can also be
coupled with external circuits. Rotational or translational motion effects can be
included in the simulation.

Electrostatic Field Simulation
The electrostatic field simulator computes static electric fields arising from potential differences and
charge distributions.

Electrostatic Theory

The electrostatic field simulator solves for the electric potential, φ(x,y), in this field equation:

where:
l φ(x,y) is the electric potential.
l εr is the relative permittivity. It can be different for eachmaterial.
l εo is the permittivity of free space, 8.854 x 10—12 F/m.
l ρ(x,y) is the charge density.
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This equation is derived fromGauss’s Law and from Faraday’s law of induction. Gauss’s Law
indicates that the net electric flux passing through any closed surface is equal to the net positive
charge enclosed by that surface. In differential form, Gauss’s Law is:

whereD(x,y) is the electric flux density. SinceD=εrεoE, then:

In a static field, as a consequence of Faraday’s law, . Therefore,

which is the equation that the electrostatic field simulator solves using the finite element method.
After the solution for the potential is generated, the system automatically computes the E-field and

D-field using the relations andD=εrεoE.
An contour plot of electric potential generated by the electrostatic field simulator is shown below:
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Capacitance

At the simplest level, capacitance relates to the amount of energy stored in the electric field in and
surrounding a structure. In a single circuit, the capacitance represents the amount of energy stored
in the electric field that arises due to a voltage differential across a dielectric.

whereWe is the energy stored in the electric field, C is the capacitance, and v is the voltage across
the dielectric.
Maxwell computes the capacitance between two conductors by simulating the electric field that
ariseswhen a voltage differential is applied. By computing the energy stored in the field, the
corresponding capacitance can be computed.
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To compute capacitances using thismethod, the E-field and D-field associated with a given
distribution of voltagesmust first be computed. The electrostatic field simulator, which computes the
electric potential at all points in the problem region, does this.

Capacitance in Terms of Charges and Voltages

A capacitancematrix represents the charge coupling within a group of conductors— that is, the
relationship between charges and voltages for the conductors. Given the three conductors shown
below, with the outside boundary taken as a reference, the net charge on each object will be:

Q1 = C10 V1 + C12(V1 - V2) + C13(V1 - V3)
Q2 = C20 V2 + C12(V2 - V1) + C23(V2 - V3)
Q3 = C30 V3 + C13(V3 - V1) + C23(V3 - V2)

This can be expressed inmatrix form as:
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The capacitancematrix above gives the relationship betweenQand V for the three conductors and
ground. In a device with n conductors, this relationship would be expressed by an n x n capacitance
matrix. Capacitancematrix values are specified in farads (coulombs/volt).
If one volt is applied to Conductor 1 and zero volts is applied to the other two conductors, the
capacitancematrix becomes:

The diagonal elements in thematrix (such asC(1,1)) are the sum of all capacitances from one
conductor to all other conductors. These terms represent the self-capacitance of the conductors.
Each is numerically equal to the charge on a conductor when one volt is applied to that conductor
and the other conductors (including ground) are set to zero volts. For instance,
C(1,1) = C10 + C12 + C13
The off-diagonal terms in each column (such asC(1,2), C(1,3)) are numerically equal to the charges
induced on other conductors in the systemwhen one volt is applied to that conductor. For instance,
in column one of the example capacitancematrix, C(1,2) is equal to
-C12. This is equal to the charge induced on Conductor 2 when one volt is applied to Conductor 1
and zero volts are applied to Conductor 2.
The off-diagonal terms are simply the negative values of the capacitances between the
corresponding conductors (themutual capacitances). In column one of the example capacitance
matrix, the off-diagonal terms represent the capacitances between Conductor 1 and the other two
conductors; in column two, the terms represent the capacitance between Conductor 2 and the other
conductors; and so forth.
Note that the capacitancematrix is symmetric about the diagonal. This indicates that themutual
effects between any two objects are identical. For instance, C(1,3), the capacitance between
Conductor 1 and Conductor 3 (-C13), is equal to C(3,1), the capacitance between Conductor 3 and
Conductor 1.
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Capacitance in Terms of Currents and Time Varying Voltages

A capacitancematrix can also represent the relationship between currents and time varying voltages
in a system of conductors.
Given the three transmission lines shown here,

the currents caused by the time varying voltage source on each line are given by the following
relationship:

If dV2 /dt and dV3 /dt are set to zero, this relationship becomes:
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This gives the currents that are induced on Line 2 and Line 3 when a time varying voltage source is
applied to Line 1— that is, the capacitive coupling between the three lines, or the short circuit
capacitance.

Computing Capacitance

To compute a capacitancematrix for a structure, theMaxwell performs a sequence of electrostatic
field simulations. In each field simulation, one volt is applied to a single conductor and zero volts is
applied to all other conductors. Therefore, for an n-conductor system, n field simulations are
automatically performed.
The energy stored in the electric field associated with the capacitance between two conductors is
given by the following relation:

where:
l Wij is the energy in the electric field associated with flux lines that connect charges on
conductor i to those on conductor j.

l Di is the electric flux density associated with the case in which one volt is placed on conductor
i.

l Ej is the electric field associated with the case in which one volt is placed on conductor j.
The capacitance between conductors i and j is therefore:

Virtual Forces (Electrostatic)

To compute the virtual force on an object, the electrostatic field simulator uses the principle of virtual
work. In the structure shown below, the force on the bottom plate (plate B) in the direction of the
displacement, x, is given by the following relationship:
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whereW is the stored energy of the system,

Unlike the classical virtual workmethod, the plate is not actuallymoved during the numerical process
of the force computation. Instead, only the triangles that lie along the outside surface of the object
are virtually distorted.W and its derivative, dW/dx, are calculated from a single field solution using
finite element interpolation functions.

Virtual Torques (Electrostatic)

Similar to the virtual force calculation, the system uses virtual work principles to compute the torque
on an object. In the structure shown below, the virtual torque on the bottom plate (plate B) about the
axis of rotation is given by the following relationship:
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whereW is the stored energy of the system,

Unlike the classical virtual workmethod, the plate is not actually rotated during the numerical process
of the torque computation. Instead, only the triangles that lie along the outside surface of the object
are virtually distorted.W and its derivative, dW/dθ, are calculated from a single field solution using
finite element interpolation functions.

Flux Linkage (Electrostatic)

To compute the electric flux linkage, the electrostatic field solver uses the following relationship:

whereE is the electric field andA is the area over which flux density is computed.
l In cartesian (XY) models, the area is found by sweeping the flux line you’ve drawn in the xy-
plane into the z direction— forming a 3D surface. The electric flux value computed is the flux
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per meter depth in the z direction.
l In axisymmetric (RZ) models, the area is found by rotating the flux line you’ve drawn in the rz-
plane 360 degrees about the z axis. The electric flux computed is the total flux that passes
through this surface.

A separate flux linkage value is computed for each line you draw.

Magnetostatic Field Simulation
Themagnetostatic field simulator lets you compute staticmagnetic fields arising fromDC currents
and other sources like permanent magnets and external magnetic fields. Magnetic fields in both
linear and nonlinear materials can be simulated.

Magnetostatic Theory

Themagnetostatic field simulator solves for themagnetic vector potential,Az(x,y) in this field
equation:

where:
l Az(x,y) is the z component of themagnetic vector potential.
l Jz(x,y) is the DC current density field flowing in the direction of transmission.
l µr is the relative permeability of eachmaterial.
l µ0 is the permeability of free space.

Given Jz(x,y) as an excitation, themagnetostatic field simulator computes themagnetic vector
potential at all points in space.

Note In general, both J andA are vectors. However, J is assumed to only have a z-component.
A consequence of this is thatA only has a z-component aswell. Both quantities can
therefore be treated as scalars.

The equation that themagnetostatic field solver computes is derived fromAmpere’s law, which is:

and fromMaxwell’s equation, . Since , then:
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Since , due to , then:

Themagnetostatic field simulator solves this equation using the finite element method.
AfterAz(x,y) is computed, themagnetic flux density,B, and themagnetic field,H, can then be
computed using the relationships:

andH, for linear materials, is:
BothB andH lie in the xy cross-section being analyzed. An arrow plot of a B-field generated by the
magnetostatic field simulator is shown below:
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Inductance

At the simplest level, inductance relates to how much energy is stored in themagnetic field when
current flows.

where:
l Wm is the energy stored in themagnetic field
l L is the inductance
l i is the current flowing in the circuit

TheMaxwell computes inductances associated with a structure by simulating themagnetic field that
ariseswhen various voltages and currents are applied. Then, by computing the energy stored in
those fields, it can then compute the necessary inductances:
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To compute inductances using thismethod, the B-field and H-field associated with a distribution of
currentsmust first be computed. Themagnetostatic field simulator, which computes themagnetic
vector potential at all points in the problem region, performs this task.

Inductance in Terms of Flux Linkage and Currents

An inductancematrix represents themagnetic flux linkage between the current loops in a system.
Given the three current loops below, the relationship between induced flux and currents is as follows:
λ1 = L11 i1 + L12 i2 + L13 i3
λ2 = L12 i1 + L22 i2 + L23 i3
λ3 = L13 i1 + L23 i2 + L33 i3

This can be expressed inmatrix form as:

The inductancematrix above gives the relationship between λ and i for the three independent
current loops. In a device with n current loops, this relationship would be expressed by an n×n
inductancematrix. Inductancematrix values are specified in henries.
If one ampere is applied to Current Loop 1 and zero amperes are applied to the other two loops, the
inductancematrix becomes:
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The diagonal terms in thematrix (such as L11) represent the self-inductance of each current loop.
Self-inductance is numerically equal to the flux linkage in a current loop when one ampere is flowing
in it, and no current is flowing in the other loops. For example, L11 is equal to the flux in Current Loop
1 when one ampere is flowing in that current loop, and no current is flowing in the other loops.
The off-diagonal terms (such as L12, L13) represent themutual inductances between the current
loops. Mutual inductance is numerically equal to the flux linkage in a current loop when one ampere
is flowing through another loop, and no current is flowing anywhere else. For example, L12 is equal
to the flux linkage in Loop1 when one ampere is applied to Loop 2 and no current is flowing in the
other loops.
Note that the inductancematrix is symmetric about the diagonal. This indicates that themutual
effects between any two loops are identical. For instance, L13, the inductance between Current
Loop 1 and Current Loop 3, is equal to the inductance between Current Loop 3 and Current Loop 1.

Inductance in Terms of Voltages and Time Varying Currents

An inductancematrix can also represent the relationship between voltage and current fluctuations in
a system. Given the three transmission lines shown below, the voltage changes caused by the time
varying current source on each line are given by:
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The inductancematrix above gives the relationship between ∆V and di/dt for the three independent
transmission lines.
If di2/dt and di3/dt are set to zero, this relationship becomes

This gives the voltage changes that are induced on Lines 2 and 3 when a time-varying current source
is applied to Line 1— that is, the inductive coupling between all the loops.

Computing an Inductance Matrix

To compute an inductancematrix, the software performs a sequence of magnetostatic field
simulations. In each field simulation, one ampere is allowed to flow in a single conductor. The current
returns as defined underMaxwell2D>Parameters>Assign>Matrix—either in the conductor you
identified as the return path, or along outside balloon, value (Dirichlet) or odd symmetry boundaries.
No current flows in any other conductor.
For an n-conductor system, n field simulations are automatically performed. The energy stored in the
magnetic field that couples two conductors is:
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where:
l Wij is the energy stored in themagnetic field linking conductor iwith conductor j.
l I is the current in conductor i.
l Bi is themagnetic flux density where one ampere is allowed to flow through conductor i.
l Hj is themagnetic field where one ampere is allowed to flow through conductor j.

The inductance coupling conductors i and j is therefore:

For multiturn conductors, the net value of inductance is the value given by:

whereN is the number of turns in the coil.

Virtual Forces (Magnetostatic)

To compute the force on an object, the system uses the principle of virtual work. In the structure
shown below, the force on the plate in the direction of the displacement, s, is given by the following
relationship:

whereW(s,i) is themagnetic coenergy of the system. The current, i, is held constant.
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Unlike the classical virtual workmethod, the plate is not actuallymoved during the force computation.
Instead, only the triangles that lie along the outside surface of the object are virtually distorted. Thus,
the force computation only requires one field solution.

Virtual Torques (Magnetostatic)

Similar to the virtual force calculation, the system uses virtual work principles to compute the torque
on an object. In the structure shown below, the torque onObject B about the axis of rotation is given
by the following relationship:

whereW(θ, i) is themagnetic coenergy of the system. The current, i, is held constant.
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Unlike the classical virtual workmethod, Object B is not actually rotated during the torque
computation. Instead, only the triangles that lie along the outside surface of the object are virtually
distorted. Thus, the change in the system’s coenergy (and therefore the virtual torque) is given by the
change in the coenergy of these triangles.

Flux Linkage (Magnetostatic)

To compute themagnetic flux linkage, themagnetostatic field solver uses the following relationship:

The energymethod is used to calculate the inductance of a winding, which is thenmultiplied by the
current flowing in the winding to get the flux linkage.
To obtain a correct flux vector, all current-carrying coilsmust bemade part of the L-matrix
computation. If you leave out L-entries that belong to current-carrying coils, the fluxeswill be
incorrect.

Note Maxwell no longer uses the following computation algorithm:

Eddy Current Field Simulation
The eddy current field simulator allows you to simulate the effects of time-varying currents in parallel-
conductor structures— including eddy current effects in conductors.
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Related Topics

EddyCurrent Theory
"Deriving the EddyCurrent Equation" on page 28-22
"EddyCurrents and Skin Depth" on page 28-26
"ImpedanceMatrix" on page 28-27
"Virtual Forces (EddyCurrent)" on page 28-32
"Virtual Torques (EddyCurrent)" on page 28-34
"Current Flow (EddyCurrent)" on page 28-34
"Nonlinear EddyCurrent Field Simulation" on page 28-35

Eddy Current Theory

Time-varying currents flowing in a conductor produce a time-varyingmagnetic field in planes
perpendicular to the conductor. In turn, thismagnetic field induces eddy currents in the source
conductor and in any other conductor parallel to it. The eddy current field solver calculates the eddy
currents by solving forA and φ in the field equation:

where:
l A is themagnetic vector potential.
l φ is the electric scalar potential.
l µ is the absolutemagnetic permeability.
l ω is the angular frequency at which all quantities are oscillating.
l σ is the conductivity.
l ε is the absolute permittivity.

Note The eddy current equation is derived fromMaxwell’s equations. Phasor notation is
used to represent complex quantities.

A plot of flux lines produced by eddy currents that were computed in a structure by the eddy current
solver is shown below:
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Related Topics

"Components of Current Density" below
"Integrating the Current Density" on the next page
"EddyCurrent Assumptions" on the next page

Components of Current Density

Notice that the right side of the equation:

consists of a complex conductivitymultiplied by the complex value of E . It is therefore
equal to the complex current density, J, which has three components:

l Js, the source current density due to differences in electric potential, .
l Je, the induced eddy current density due to time-varyingmagnetic fields, - jωσA.
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l Jd, the displacement current density (time-varying electric fields), .
The total current density is the sum of these three components. The jω term in the eddy and
displacement components indicate that they are a function of frequency and become increasingly
significant as the frequency increases.

Integrating the Current Density

When setting up a problem, you specify the total current flowing in any conductor that is connected to
an external source. Therefore, the eddy current module is able tomake use of a second equation:

which simply reflects the fact the total current in a conductor equals the integral of the current density
over the cross-section of the conductor,Ω.

Eddy Current Assumptions

The eddy current field solver makes the following assumptions about the field quantities for which it
solves:

l Time-varying electromagnetic quantities are assumed to have the periodic waveform:

l All quantitiesmust have the same frequency (angular frequency), but can have different
phase angles (θ). If a current is not a pure sinusoid, decompose it into sinusoidal harmonics,
and solve separately at each frequency, but only for linear problems.

l All currents (source, eddy, and displacement) are assumed to flow perpendicular to the plane
being studied (that is, in the z-direction for XY applications). Therefore, themagnetic fields
associated with these currents lie within the xy-plane. As a result,A, themagnetic vector
potential, has a z-component only.

l Because no currents flow in the xy-plane, the electric field,E, has a z-component only. It
follows that φ is constant over the cross section of each conductor in the problem.

Deriving the Eddy Current Equation

The eddy current field solver uses the finite element method to computeA and φ using these two
relationships:
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where:
l A is themagnetic vector potential.
l φ is the electric scalar potential.
l µ is themagnetic permeability.
l ω is the angular frequency at which all quantities are oscillating.
l σ is the conductivity.
l ε is the permittivity.
l IT is the total current flowing in conductors.

The following section shows how these equations are derived fromMaxwell’s equations.

Maxwell’s Equations

The eddy current field simulator solves for time harmonic electromagnetic fields governed by
Maxwell’s equations:
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where:
l E is the electric field.
l D is the electric displacement, εE.
l B is themagnetic flux density.
l H is themagnetic field intensity,B/µ.
l J is the conduction current density, σE.
l ρ is the charge density.

The eddy current solver assumes that all time-varying electromagnetic quantities in the problem
have the form:

Using Euler’s formula:

If α = ωt+θ, F(t) equals the real portion of ej(ωt+θ):

Now, because each time-varying quantity has the form , and are equal to jωD
and jωB.
Therefore, with this simplification and the relationsH=µB,D=εE, and J=σE, Maxwell’s equations
reduce to:
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Relationship of Magnetic and Electric Field

The quantity that the eddy current field simulator actually solves for isA, themagnetic vector
potential. It is given by:

Substituting this into the first of Maxwell’s equations, the result is:

A solution for E in terms ofA is given by:

where φ is the electric potential. Substituting the right side of this relationship for E into the previous
equation results in:

This equation is one of the two used by the eddy current solver to computeA and φ.
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Relationship of Current and Current Density

Notice that the previous equation is in the form of a complex conductivity, (σ+jωε), times the complex
value of E. The result is the complex current density, J. Therefore, the integral of this expression over
the cross-section of a conductor is constrained to equal the total current that is specified as flowing in
that conductor:

This is the second equation that the eddy current solver uses in computingA and φ.
The total current, It, in this equation is the quantity you specify when setting up a problem. It is the
total current flowing in a conductor, and includes:

l Is, the current from an external source, .

l Ie, the induced eddy current, .

l Id, the displacement current, .
For problems solved by the eddy current solver,B is assumed to lie in the xy plane. Therefore,A can
only have a component in the z-direction. The simulator does not have to solve for the x and y
components ofA. SinceE only has a z-component, φ is a constant for each cross section of a
conductor. Therefore, Maxwell does not have to solve for φ at every node.
For amore detailed discussion of eddy current and skin effect problems inmulticonductor systems,
see:

J. Weiss, Z. Cendes. “A One-Step Finite Element Method for Multiconductor Skin Effect
Problems”, IEEE Transactions on Power Apparatus and Systems, Vol. PAS-101, No. 10
October 1982.

Eddy Currents and Skin Depth

Induced currents allow magnetic fields to penetrate conductors only to a certain depth, which is
approximated by the formula:
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where:
l ω is the angular frequency, which is equal to 2πf. (f is the frequency at which source currents
and voltages oscillate during the solution.)

l σ is the conductor’s conductivity, in siemens/meter.
l µr is the conductor’s relative permeability, in amperes/meter.
l µ0 is the permeability of free space, which is equal to 4π x 10-7 A/m.

Currents will be concentrated near the surface of the conductor, decaying rapidly past the skin
depth. As the formula above indicates, the skin depth gets smaller as the frequency increases.

Impedance Matrix

An impedancematrix summarizes the relationship between AC voltages and AC currents in multi-
conductor systems. Given the two current loops below, the relationships between voltages and
currents in each loop is as follows:
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This can be expressed inmatrix form as:

where:
l Vi and Ii are phasors.
l Z11 = R11 + jωL11 (the self-impedance of Loop 1).
l Z12 = R12 + jωL12 (themutual impedance between Loops 1 and 2).
l Z22 = R22 + jωL22 (the self-impedance of Loop 2).

The impedancematrix above gives the relationship between V and I for the two current loops. In a
device with n current loops, this relationship would be expressed by an n x n impedancematrix. The
matrix values displayed by the software are resistance and inductance (not resistance and
reactance) and therefore do not include jω.

Note All impedances are complex numbers in the form:

where:
l ω is equal to 2πf, where f is the frequency of the AC current
source.

l R is the AC resistance, given in ohms/meter (XY) or ohms
(RZ).

l L is the AC inductance, given in henries/meter (XY) or
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henries (RZ).

Related Topics

"Computing an ImpedanceMatrix" below
"Virtual Forces (EddyCurrent)" on page 28-32
"Virtual Torques (EddyCurrent)" on page 28-34
"Current Flow (EddyCurrent)" on page 28-34

Computing an Impedance Matrix

Maxwell breaks down the impedancematrix computation into two parts. First, it solves for the
inductancematrix (L-matrix) associated with themodel. It then solves for the resistancematrix (R-
matrix). When it finishes solving for thesematrices, the simulator combines them to form the
impedancematrix, using the relationship Z=R+jωL.
To compute the inductance and resistancematrices for the impedance solution, the simulator
generates an eddy-current field solution for each conductor in thematrix.
In the first solution, the current in the first conductor is set to one ampere; currents in the other
conductors that are included in the impedancematrix are set to zero. This is done by imposing
current sources on the conductors.
In the second solution, the current in the second conductor is set to one ampere, and all other
conductors that are included in the impedancematrix are set to zero amperes, and so forth.
Conductors that are not included in the impedancematrix are not affected.

Related Topics

"Matrix Inductance" below
"Matrix Resistance" on the next page
"Inductance and Resistance in Impedance Computations " on page 28-31

Matrix Inductance

To compute the inductance of the current loop, the simulator calculates the average energy,WAV, of
the system after a field solution is computed:

Since the instantaneous energy of the system is equal to:
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where the instantaneous value of the current is related to the peak value of the current by i =
IPeakcos(ωt+θ). The average value for the energy can then be found by integrating the
instantaneous energy:

From this, the average energy of the system is equal to:

The inductance, therefore is:

The software assumes that the object for which impedance is being computed has a peak current of
one ampere per coil turn flowing through it. Thus, the inductance is simply 4WAV.
The eddy current simulator includes the eddy effect in conductors when it computes inductance
during an impedance solution.

Matrix Resistance

To compute the resistance, the simulator calculates the ohmic loss, P, after a field solution has been
computed:
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The ohmic loss is related to the resistance by:

The resistance is therefore:

The system assumes that the object for which impedance is being computed has a peak current of
one ampere per coil turn flowing through it. Therefore, the resistance is simply 2P.
Note that the resistance for an eddy current problemwill be higher than the equivalent DC
resistance, due to the skin concentration of currents.

Inductance and Resistance in Impedance Computations

The inductances and resistances computed during an impedancematrix solution are different from
those computed for the equivalent DC case. This figure shows how they differ:
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The current density, J, in the DC case (the conductor on the left) is evenly distributed throughout the
cross-section of the conductor. The current density in the AC case (the conductor on the right) is
distributed non-uniformly on the surface due to skin effect. Since the area through which current can
flow is smaller, it follows that the resistance to the current flow is higher in the impedancematrix than
in a resistancematrix computed for the equivalent DC case.
In the DC example, no eddy currents occur. Themagnetic field created by the current flowing
through the conductor is static. In the AC example, the oscillatingmagnetic field induces currents in
conductors in themodel. These induced currents affect the computation of inductance for the
impedancematrix, causing it to be different from the equivalent DC computation of inductance.

Virtual Forces (Eddy Current)

Virtual force in an eddy current problem is computed the sameway as virtual force in a
magnetostatic problem. The only difference is that the average value of force over time is computed
— not the instantaneous force at a given time.
The difference between the time-averaged (or DC) force, AC force, and instantaneous force is
shown below:
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Force oscillates at twice the frequency of the source current andmagnetic field:

where:
l fF is the frequency of the force.
l fS is the frequency of the source current andmagnetic field.
l TF is the period of the force.

The time-averaged (or DC) force, AC force, and instantaneous force can be determined by:
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The AC force, FACmust be evaluated at a particular phase (=ωt) in order to determine itsmagnitude
at an instant in time. However, the peak value of the AC force is reported as the “AC Magnitude” in
the force and torque solution panel for Maxwell 2D.

Virtual Torques (Eddy Current)

Virtual torque in an eddy current problem is computed the sameway as virtual torque in a
magnetostatic problem. The only difference is that the average value of the torque over time is
computed, not the net torque at a given time.

Current Flow (Eddy Current)

To compute the current flow, the eddy current field solver uses the following relationship:

where:
l I is the current.
l J is the current density, given by:

l A is the area over which the current flow is computed.
l In cartesian (XY) models, the area is found by sweeping the current flow line you’ve drawn
in the xy-plane into the z direction— forming a 3D surface. The current flow computed is
the current per meter depth in the z-direction.

l In axisymmetric (RZ) models, the area is found by revolving the flux line you’ve drawn in the
rz-plane 360 degrees around the z-axis, forming a 3D surface. The current flow computed
is the total current that passes through this surface.

A separate current flow value is computed for each line you draw.
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Nonlinear Eddy Current Field Simulation

Note Applicable to bothMaxwell 2D and 3D Eddy current solvers.

TheMaxwell 2D and 3D Eddy current solvers, for designswith nonlinear materials, allow you to
analyze the fundamental components of B and H at a specified frequency.

Related Topics

"Nonlinear EddyCurrent Theory" below
"Sinusoidal B" below

Nonlinear Eddy Current Theory

Note Applicable to bothMaxwell 2D and 3D Eddy current solvers.

Unlike linear problems in which the field solution is assumed to be based on the sinusoidal complex
peak field values in a steady state, nonlinear problems are usually based on all harmonic
components of the fields.
That is to say for nonlinear problems, though the current is sinusoidal at its input, the resulting fields
are “harmonically rich.” Although the B- and H-fields are not sinusoidal at output, theMaxwell 2D
and 3D non-linear Eddy current solvers use equivalent fundamental components of B and H to
approximate non-linear field behavior associated with the assigned non-linear BH characteristic.

Related Topics

"Sinusoidal B" below

Sinusoidal B

Note Applicable to bothMaxwell 2D and 3D Eddy current solvers.

Assuming both thatB is sinusoidal with time, t, and that the value ofH is derived from the original
BH-curve, introduce a new valueHe to represent the effectivemagnetic field.
The derivation of the effective He is based on the equivalence of averaged energy between using
original, non-sinusoidal H field and the effective sinusoidal field Hesin(ωt). That is:

with:
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the above expression becomes:

Allowing α=ωt and extractingHe, simplifying yields:

or:

where:
l Bm corresponds to the last point on the original BH characteristic (in the saturation portion)
and which ismade equal with π/2.

The above equation is used to derive an effective (Bm, He) characteristic for the frequency domain
simulation. This process is required to be performed only once for a particular BH curve. During the
simulation, He is determined for a specific Bm such that an equivalent permeability can be computed
as the ratio Bm / He and used in the calculations.

DC Conduction Field Simulation
TheDC conduction field simulator allows you to analyze conduction currents due to static electric
fields in conductors and lossy dielectrics.
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DC Conduction Theory

When amaterial with a non-zero conductivity is subject to a potential difference, conduction current
flows in thematerial. At all points in the problem space, the current density (J) will be proportional to
the electric field (E) that is established due to the potential difference.

where:
l J(x,y) is the current density.
l E(x,y) is the electric field.
l σ is the conductivity of thematerial in MKS units (S/m).
l φ(x,y) is the electric potential.

The equation that the DC conduction field simulator solves is based on the fact that, under steady
state conditions, the amount of charge, ρ, leaving any infinitesimally small regionmust equal the
charge flowing into that region.

The field quantity that DC conduction actually solves for is the electric potential, φ, in the following
equation:

Note that .
A plot of electric potential that was computed by the DC conduction solver is shown below:
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Steady-state Conditions

TheDC conduction solver assumes that current flow in the conductingmaterial has already reached
steady state conditions. The implication of this assumption becomes clear when you compare the
initial and steady state conditions of a simple problem such as that shown here:
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First, consider the interval before steady state is reached. Assume that the switch establishing the
potential across the parallel plates in the figure above closes at t=0. Also assume that the current
required to deposit charges on the parallel plates (so that the voltage difference can be supported)
occurs instantaneously.
However, it will take a while for current to start flowing in the dielectric. The time it takes for current to
flow is determined by the time constant of thematerial. Therefore, at t=0, there will be an electric field
in the dielectric, but no current and no free charges. Consequently, the relationship that must be
satisfied at the interface of the two dielectrics is:

or, equivalently:

At the interface between the two dielectrics, this relationship implies that:
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whereEn is the normal component of E. Therefore, at t=0, before current starts to flow in the two
dielectrics, φ(x,y) is determined entirely by the permittivity of the dielectrics. Use the electrostatic field
solver to solve for φ(x,y) in such a case.
After current starts to flow in the dielectric and steady state is reached, free charges are able to
accumulate at the boundaries of the two dielectrics. The free charge, ρ, is no longer zero.

The relationship that must be satisfied now is:

or, equivalently,
This relationship implies that:

In this case, the solution depends on the conductivity (σ) of thematerials rather than on their
dielectric constant (ε). The DC conduction solver analyzes the steady state condition. Therefore, use
the DC conduction field solver when steady state conditions have been reached.

Relevant Time Constant

The time constant that determines how long it will take the current flowing in the conductivematerial
to reach steady state is given by τ=ε/σ. In a good conductor such as steel (ε=9x10-12, σ=1x107), τ=
9x10-19 seconds. Steady state conditions are reached almost instantaneously and in such cases you
should use the DC conduction solver to analyze the potential field.
On the other hand, for a good dielectric such as fused quartz (σ=1x10-17), the time constant is on the
order of 105 seconds. There will be a significant period before steady state currents start to flow and
you should use the electrostatic solver to analyze the electric field. For manymaterials in between, a
complete analysismay require an electric transient field solution.
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Conductance

A conductancematrix gives the relationship between currents and voltage drops. In the figure below,
two conductors at voltages V1 and V2 are touching a bar with a conductance, G.

Because the bar is not a perfect insulator, current will flow between the two conductors. Given the
conductors shown on the previous page, the relationship between the conduction current and the
voltage drop, V, in each conductor is:

where:
l I is the conduction current.
l G is the conductance, measured in Siemens.
l V is the voltage drop given byV1-V2.

Conductance, as evident from the equation, is the inverse of resistance. Therefore, if a material has
a large conductance, it will be a better conductor, and if it has a low conductance, it will be a better
resistor.

Current Flow (DC Conduction)

To compute current flow, the DC conduction field solver uses the following relationship:

Maxwell 2D Technical Notes 28-41
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

where:
l I is the current.
l J is the current density, given by:

l A is the area over which the current flow is computed.
l In cartesian (XY) models, the area is found by sweeping the current flow line you’ve drawn
in the xy-plane into the z direction— forming a 3D surface. The current flow computed is
the current per meter depth in the z direction.

l In axisymmetric (RZ) models, the area is found by revolving the flux line you’ve drawn in the
rz-plane 360 degrees around the z-axis, forming a 3D surface. The current flow computed
is the total current that passes through this surface.

A separate current flow value can be computed for each line you draw.

AC Conduction Field Simulation
The AC conduction field solver allows you to analyze conduction currents caused by time-varying
electric fields in conductors and lossy dielectrics.

AC Conduction Theory

The AC conduction field simulator solves for φ in the following equation:

where:
l φ(x,y) is themagnitude and phase of the electric potential at each value of x and y.
l ω is the angular frequency at which the potential is oscillating.
l σ is the conductivity.
l ε is the permittivity.
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The above equation is derived from:

where:
l J is the current density, σE.
l D is the electric flux density, εE.
l E is the electric field, -∇φ.

Complex quantities are represented using phasor notation.

AC Conduction Assumptions

The AC conduction field solver assumes the following conditions about field quantities:
l All time-varying electromagnetic quantities have the periodic waveform:

where all quantitiesmust have the same value ofω, but can have different phase angles (θ).
l If a current is not a pure sinusoid, it is decomposed into sinusoidal harmonics, and solved
separately at each frequency.

l The component of E due to time-varyingmagnetic fields caused by conduction currents can
be neglected.

Admittance

Admittance can best be explained as the inverse of impedance, and is expressed by:

where:
l ω is equal to 2πf, where f is the frequency of the AC voltage source.
l Y is the admittance in Siemens/meter.
l G is the conductance in Siemens/meter.
l ωC is the susceptance in Siemens/meter.

Note Thematrix values displayed by the software are conductance in ohms/meter and
capacitance in farads/meter (not conductance and susceptance) and therefore do
not include jω.
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Current Flow

To compute current flow, the AC conduction field solver uses the following relationship:

where:
l I is the current.
l J is the current density, given by J = σE.
l A is the area over which the current flow is computed. It is found by sweeping the current flow
line you’ve drawn in the xy-plane into the z direction, forming a surface. The current flow
computed is the current per meter depth in the z direction.

A separate current flow value can be computed for each line you draw.

Axisymmetric Field Simulation
If you selectedCylindrical About Z as the geometrymode when setting the solution type, a special
version of the selected field solver is used. It assumes that the 2D geometry being studied sweeps
360° around the z-axis of a cylindrical coordinate system, enabling you tomodel devices like
solenoids and insulators that have an axis of rotational symmetry. All electric or magnetic fields in the
problemmust also be rotationally symmetric so that the solution in anyRZ-plane is the same as any
other.

Note All cylindrical about Z modelsmust be drawn in the XZ plane with X >=
0

Axisymmetric field simulation is available for the following solvers:
l Electrostatic
l Magnetostatic
l EddyCurrent
l DC Conduction
l AC Conduction
l Transient with and without motion

Any field solution involving a long plank-shaped object is different from a solution involving an
annular object— even though the same equation is solved for both types of geometries.
Mathematically, the difference between cartesian and axisymmetric field solutions arises from the
difference in how gradients, curls and divergences are expressed in the two coordinate systems.

l In a cartesian (xyz) coordinate system, these operators are defined as follows (where F is a
scalar quantity and F is a vector quantity):
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If F has a z-component only, the curl is defined as:

l In a cylindrical (r, φ, z) coordinate system, these operators are defined as:
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If F has a φ-component only, the curl is defined as:

In the cylindrical case, an extra r shows up in placeswhere there is no analogous x in the cartesian
case, resulting in a different field solution. The calculations involving the differences inmathematics
between axisymmetric and cartesianmodels are implicitly handled by theMaxwell and are
transparent to you.

Transient Simulation
Transient Solver only.
The transient solver allows you to analyze themagnetic fields, energy, force/torque, power loss, core
loss, speed, and flux of amodel at various time steps of a solution over a specified period of time.
This solver allows for non-sinusoidal current or voltage excitation, as well as rotational or
translational motion.

Transient Simulation Assumptions

The transient solver assumes the following conditions about the problem:
l If motion occurs in themodel, nomotion occurs outside the band object.
l Rotational motion can be cylindrical or non-cylindrical.
l More than one object can be assigned identical motion within the band object.

Time-Dependent Magnetic Field Simulation

For a 2D XY problem, the vectors have only one component in the z-direction. The time-dependent
magnetic equation is expressed as:

Maxwell 2D Technical Notes 28-46
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

where:
l Hc is the coercivity of the permanent magnet.
l v is the velocity of themoving parts.
l A is themagnetic vector potential.
l V is the electric potential.

l is the reluctivity.
l Js is the source current density.

The transient solver applies a reference frame that is fixed with respect to the components in the
model by setting the velocity, v, equal to zero. This is possible by considering the equation for the
magnetic vector potential both in moving part and stationary part in their own reference frame in
which velocity is always zero. Because themoving components have now been fixed to their own
coordinate system, the partial time derivative becomes the total time derivative of A. Thus, the
motion equation becomes:

which is obtainable at each time step at every node in the finite element model. In above equation the
motion is contained implicitly in the total derivative of A.

Stranded Conductors

Stranded conductors lack eddy current behavior and are considered to be filaments too thin tomodel
in a practical finite element grid. Because of this, the transient solver assumes that their contribution
to the current density is averaged over the area of problem region.
These filaments can be connected in parallel or series, and carry the same current based on:
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where js, the uniformly distributed current density is given by:

and:
l if is the total terminal current flowing into a filament coil group (or winding).
l Nf is the total conductor number of the filaments in the winding.
l A is themagnetic vector potential.
l a is the number of parallel branches in the winding.
l df is the polarity (+1 or -1) to represent forward or return paths.
l Sf is the total area of the cross-section of the region occupied by the winding.
l p is the ratio of the original full model to the field domain to be solved.

Note that the filaments in the windingmay reside at several different locations as long as they are
connected in series or parallel.
The voltage seen from the terminal of the winding is the sum of the voltage across all the wires as
well as any possible external impedance based on:

and:

where:
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l rdc is the total DC resistance.
l rend is the end-turn resistance of the winding.
l rext is the external resistance connected to the winding.
l lend is the end turn inductance of the winding.
l lext is the external inductance connected to the winding.
l l is the thickness of themodel.

Note Please note that themain component of inductance is calculated byMaxwell; end
effects -when they can be evaluated- can however be included in themodel to
increase the overall accuracy of the simulation.

Solid Conductors

Solid conductors are large enough tomodel with finite elements, where skin effects depend not only
on the frequency of the system, but on the location of nearby conductors.
Based on Ampere’s Law, the total current density, jt, in the system is given by:

which reduces to:

or:

where:
l Vb is the voltage difference across the conductors end points.
l Je is the eddy current density.
l Js is the source current density.

Solid Conductors with Current Sources

For solid conductors with a current source, the total current is known, while the source component is
unknown. The transient solver computes the current source based on the following circuit equation
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for the nth conductor:

where:
l Ωc is the width cross-section of the nth conductor.
l It is the known total current.
l Js is the source component to be solved for.
l Jt is the total current density.

Solid Conductors with Voltage Sources

For solid conductors with a voltage source, the total voltage is known, while the total current density
is unknown. The transient solver computes the unknown quantities based on the following circuit
equation which is derived from the solid conductor equations. The resulting equation yields:

where:
l Ωc is the width cross-section of the nth conductor.
l Vb is the known voltage source between the two conductors.
l Jt is the total current density to be solved for.
l σ is the conductivity.
l l is the thickness of themodel.
l A is themagnetic vector potential.

Translational Motion

The transient motion simulator generates translational motion solutions based on the following
motion equation:
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where:
l m is themass of the object, in kg.
l a is the acceleration of the object, in m/s2.
l v is the velocity, in m/s.
l Fem is the computed electromagnetic force, in N.
l Fload is the external load force, in N.
l λ is the damping, in N.s/m.

Rotational Motion

The transient motion simulator generates rotational motion solutions based on the followingmotion
equation:

where:
l J is themoment of inertia, in kg.m2.
l Tem is the computed electromagnetic torque, in N.m.
l Tload is the external load torque, in N.m.
l ω is the angular speed, in rad/s.
l β is the angular acceleration, in rad/s2.
l λ is the damping factor, in N.m.s.

Phasor Notation
Time varying quantities that have the form:

can be represented as rotating phasors in the complex plane. Using Euler’s formula:
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If α = ωt+θ, F(t) equals the real portion of ej(ωt+θ):

Each time-varying quantity has the form . The component ismerely a complex

constant that can be represented by a stationary phasor in the complex plane. The
component is a complex number that depends on t, and can be represented as a rotating phasor in
the complex plane, as shown here.

The phasor’s projection on the real axis oscillates sinusoidally. It reaches a peakwhen parallel with
the real axis, and crosses zero when parallel with the imaginary axis. Thus, a phasor with θ=90°
represents a quantity that peaks 90 degrees after a phasor with θ=0°.
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Real and Imaginary Components

Maxwell expects you to enter magnitudes and phase angleswhen you specify voltages, currents,
and other boundary or source quantities in models where time-varying fields are to be computed
(that is, eddy current, AC conduction, and eddy axial models). But when themagnitude and phase
angle of a quantity are functions of position, it is easier to specify the functions in terms of real and
imaginary components “x+jy” rather than in terms of magnitude and amplitude. Therefore, when you
specify currents and boundary conditions as functions, the system expects you to describe the
functions in terms of real and imaginary components.
The “x+jy” description of a phasor indicates that the phasor is the sum of two components— a
sinusoid that peaks atωt=0° and a sinusoid that peaks atωt=90°.

l The “x” component of the phasor is called the real component and can be represented by a
phasor that lies on the real axis of the complex plane.

l The “y” component is called the imaginary component and is represented by a phasor that lies
on the j-axis of the complex plane.

The real and imaginary components of a three-phase system are shown below:

The real and imaginary components are related to themagnitude and phase of a sinusoid in this
way:
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Boundary Conditions
Boundary conditions define the behavior of the electric or magnetic field at object interfaces or edges
of the problem region. They are always necessary in order to insure the uniqueness of the
electromagnetic field calculation. They can also be used to:

1. Simulate structures that aremagnetically isolated, electrically insulated, or electrically isolated.

2. Set the electric or magnetic potential at a surface to a constant value or a function of position,
in order to define the behavior of the electric or magnetic field on that surface

3. Simulate the field patterns that would exist in a structure while modeling only part of it. To do
this, you can define planes of symmetry where electric or magnetic fields are either tangential
to or normal to the surface. Additionally, you can define planes of symmetry where the field on
one surfacematches themagnitude and direction (or opposite direction) of the field on
another surface.

4. Simulate the field patterns produced by thin resistive layers on conductors (DC conduction
solver) or eddy currents with very tiny skin depths in conductors (eddy current solver), without
having to explicitly draw, assignmaterials to, or solve for fields inside the objects in question.

Available boundary types inMaxwell 2D are listed in the table below. Select from the table to see
more information about a specific boundary type or for information on how to apply it in a specific
problem type.

Boundary Condition Applying in Problem Type
Vector Potential Magnetostatic

EddyCurrent
Transient

Symmetry Magnetostatic
Electrostatic

AC Conduction
DC Conduction
EddyCurrent
Transient

Balloon Magnetostatic
Electrostatic

AC Conduction
DC Conduction
EddyCurrent
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Boundary Condition Applying in Problem Type
Transient

Impedance EddyCurrent
Resistance DC Conduction
Master/Slave Magnetostatic

Electrostatic
AC Conduction
DC Conduction
EddyCurrent
Transient

Vector Potential

The Vector Potential boundary is available for use inMagnetostatic, EddyCurrent, and Transient
solver type designs. Use Vector Potential boundaries to set themagnetic vector potential,AZ, to a
constant value on a boundary.
The potential can also be defined as a function of position usingmath functions. Normally, this type of
boundary condition is used to specify the potential of outer boundaries. It can also be used to set the
interface between two objects to a potential, modeling the presence of a very thin conductor
between the objects. They are sometimes called Dirichlet boundaries.
The behavior of themagnetic field on a Vector Potential boundary depends on whether you define a
constant or functional potential on the boundary. Remember that themagnetic vector potential,A, is
defined to be a field that satisfies the equation:

Since themagnetostatic field solver assumes thatA has a z-component only andB lies in the xy-
plane, the relationship ofB toA is given by the following:

IfAZ is constant along a horizontal boundary, the partial derivatives ofAZwith respect to x will be
zero— forcingB to have an x-component only, and be tangential to the boundary. Likewise, ifAZ is
constant along a vertical boundary, the partial ofAZwith respect to y will be zero— forcingB to have
a y-component only and again indicating that the field will be tangential.
In general, themagnetic field will be tangential to any boundary on whichAZ has been set to a
constant.
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If the potential is a function of position, the partial derivatives ofAZwith respect to x and ywill not
necessarily be zero. It all depends on what type of math function was used to specify the potential.
Thus,Bmay not be tangential to the boundary and some flux will cross it.
In eddy current problems, themagnetic vector potential is a time-varying quantity in the form:

where Am is themagnitude of the potential and θ is its phase angle— its offset from a pure cosine
wave. Therefore, when specifyingAZ on a boundary, youmust enter both itsmagnitude and phase.
Themagnitude and phase of the potential can also be defined as a function of position usingmath
functions.

Vector Potential Boundaries in Axisymmetric Models

In axisymmetricmodels,A is assumed to have only a φ-component andB is assumed to lie only in
the rz-plane. The relationship betweenAφ andB is given by:

Because equipotential lines of rAφ in axisymmetricmodels coincide with the lines of magnetic flux,
youmust specify values or functions of rA (notA) when setting value boundaries.

Symmetry

The symmetry boundary is available for use inMagnetostatic, EddyCurrent, Transient, Electrostatic,
AC Conduction, and DC Conduction solver type designs. A symmetry boundarymodels a plane of
symmetry in a structure. Use this type of boundary condition to take advantage of geometric
symmetry and electrical symmetry in a structure. Doing so enables you to reduce the size of your
model— allowing you to conserve computing resources. Two types of symmetry boundaries—Odd
andEven—are available for use.

Odd Symmetry

An odd symmetry boundarymodels a structure in which the signs (positive or negative) of all
currents, voltages, or charges on one side of a symmetry plane are the opposite of those on the other
side. In magnetic field problems, themagnetic field is tangential to this type of boundary; while in
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electric field problems, the field is perpendicular to the boundary and equipotential lines are
tangential to the boundary.
To define an odd symmetry boundary for magnetic field problems, the simulator sets the selected
edge to a vector potential boundary with amagnetic vector potential of zero— acting as amagnetic
mirror to themodel. For electric field problems, the simulator sets the selected edge to a voltage of
zero.
For instance, the plane of symmetry shown below ismodeled by an odd symmetry boundary, since
the direction of the current flow in the conductor on the left side of the symmetry plane is the opposite
of the current flow in the conductor on the right side of the plane (the side that ismodeled):

Even Symmetry

An even symmetry boundarymodels a structure in which the signs (positive or negative) of the
currents, voltages, or charges on one side of a symmetry plane are the same as those on the other
side. Themagnetic field is perpendicular to this type of boundary; while the electric field is tangential
to this type of boundary, and contours of equal potential are perpendicular to it.
To define an even symmetry boundary, the simulator sets the selected edge to a Neumann
boundary.
For instance, the plane of symmetry shown below could bemodeled by an even symmetry
boundary, since the direction of the current flow in the conductor on the left side of the symmetry
plane is the same as that of the current flow in the conductor on the right side of the plane (the side
that ismodeled):
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Balloon

The balloon boundary is available for use inMagnetostatic, EddyCurrent, Transient, Electrostatic,
AC Conduction, and DC Conduction solver type designs. Balloon boundariesmodel the region
outside the drawing space as being nearly “infinitely” large— effectively isolating themodel from
other sources of current or magnetic fields. Visualize the background object as extending to infinity
along the edges identified as balloon boundaries.
For magnetic solution types, themagnetic vector potential,AZ orAφ, goes to zero at infinity. The
lines of magnetic flux are neither tangential to nor normal to a balloon boundary.
For electric field solution types, two types of balloon boundaries are available:

Charge Models the case where the charge at infinitymatches the charge in the solution region,
forcing the net charge to be zero. Physically, this represents an electrically insulated
system. This is the default for Electrostatic solutions.

Voltage Models the case where the voltage at infinity is zero. Physically, this represents an
electrically grounded system. Inmost cases, the results will be very similar to those
produced with theCharge option; however, the charge at infinitymay not exactlymatch
the charge in the drawing region.

The E-field is neither tangential to nor normal to a balloon boundary.
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Impedance

The impedance boundary is available for use in EddyCurrent solutions. Impedance boundaries
allow you to simulate the effect of induced currents in a conductor without explicitly computing them.
The ohmic loss due to induced currents is computed from the tangential components of the H-field
along the impedance boundary— the surface of the object that you are interested in.
Use this boundary condition for models where the following conditions occur:

l The skin depth in the conductor of interest is less than two orders of magnitude smaller than
the dimensions of the structure. In models like this, theMaxwell 2D’smeshmaker may not be
able to create a fine enoughmesh in the conductor to compute eddy currents.

l Themagnetic field decaysmuchmore rapidly inside the conductor in the direction that is
normal to the surface than it does in directions that are tangential to the surface.

l The AC current source is relatively far away from the surface where eddy currents occur,
compared to the size of the skin depth.

The object itself must be excluded from the solution region bymaking the object a perfect conductor.
When drawing the geometry, make the surface along which eddy currents are to be computed an
outer surface of the problem region. Then, when defining boundaries, assign an impedance
boundary to this surface. By entering the conductivity, σ, and the relative permeability, µr, of the
object, you specify the skin depth of induced eddy currents. The simulator uses this skin depth when
computing the electromagnetic field solution. It assumes that the H-field falls off exponentially inside
the conductor.
For instance, suppose you want to compute eddy current losses in the conductor next to the current
source shown below.

If AC current is passing through the current source at a frequency of 1MHz, the skin depth in the
conductor is given by the following relationship:
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where:
l ω = 2πf = 2π x 106 = 6.28 x 106 radians/second
l σ = 5.8 x 107 siemens/meter
l µr = 1
l µ0 = 4π x 10-7 henries/meter

Substituting these values into this equation, the skin depth is found to be 6.6x10-5meters. Since this
ismuch smaller than the thickness of the conductor and the surface where currents are induced is
relatively far away from the current source, an impedance boundary can be used tomodel the
induced currents in the conductor, as shown below. The conductor itself is not included in themodel;
instead, the outside boundary of themodel ismoved to the inside surface of the conductor. This
outside surface is defined as an impedance boundary, using the conductivity and permeability
specified previously.

After generating a solution, you can compute the ohmic loss for the surface using the plane
calculator and plot the loss density on the boundary.
For impedance boundaries, ohmic loss is given by:

where:
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l ω is the angular frequency, which is equal to 2πf.
l σ is the conductor’s conductivity in siemens/meter.
l µr is the conductor’s relative permeability.
l µ0 is the permeability of free space, which is equal to 4π x 10–7 H/m.
l Ht is the tangential component ofH on the impedance boundary.
l Ht* is the complex conjugate tangential component ofH on the impedance boundary.

Note Keep inmind that an impedance boundary approximates the effect of eddy currents
acting at a shallow skin depth; it does not directly compute them. In general, the
fieldsmodeled using an impedance boundary will closelymatch the field patterns
that would actually occur in the structure. However, the field patternsmay be
different at discontinuities in the surface such as corners.

Resistance

The resistance boundary is available for use in DC Conduction solutions. A resistance boundary
models a very thin layer of resistivematerial (such as that caused by deposits or oxidation on a
metallic surface) on a conductor at a known potential. Use this boundary condition when the resistive
layer’s thickness ismuch smaller than the other dimensions of themodel.
For instance, in the following example, the resistive layer on the conductor is 5x10-6meters thick.
Since this is four orders of magnitude smaller than the dimensions of themodel, use a resistance
boundary on the conductor to avoid having to create a very thin object modeling the layer— which
could cause problemswhen theMaxwell generates amesh for themodel and solves for its
conduction currents.
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Specify the thickness and conductivity of the resistivematerial, and the potential of the conductor.
Apply resistance boundaries only to the boundaries of objects that have been defined as perfect
conductors, or to the outside edge of the problem space.

Master/Slave

Master/Slave boundaries are available for use inMagnetostatic, EddyCurrent, Transient,
Electrostatic, AC Conduction, and DC Conduction solver type designs. Matching boundaries allow
you to take advantage of periodicity in a structure. For example, the following figure shows the cross
section of a DC motor. The field in such amotor repeats itself every 120 degrees; that is, the field
pattern in one third of themotor matches themagnitude and direction (or the opposite of the
direction) of the field pattern in the other two thirds.
Matching boundaries force themagnetic field at each point on one boundary (the “slave” boundary)
to match themagnetic field at each corresponding point on the other surface (the “master”
boundary). Modeling one third of the structure allows you tomake efficient use of the available
computing resources:
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To definematching boundaries, youmust define both amaster matching boundary and a slave
matching boundary.
The condition that needs to be enforced, as illustrated in the following figure, is that themagnitude of
themagnetic field at each point on the slave boundary surfacemust match themagnetic field at each
corresponding point on themaster boundary surface. The field on the slave boundarymust point in
either the same direction or in the exact opposite direction as the field on themaster boundary:

Note that a Vector Potential (Dirichlet), Neumann or symmetry boundary cannot be used to simulate
periodicity because themagnetic field is not necessarily either perpendicular or tangential to periodic
surfaces. For example, in the quarter model shown above, themagnetic field is exactly
perpendicular to the bounding surfaces only when the gap separating the permanent magnets is
perfectly horizontal or vertical. For all other positions of the rotor, matching boundaries are required
to take advantage of symmetry.
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2D Sources/Excitations
To compute fields for a structure, youmust define a source of charge, voltage, current, or electric or
magnetic fields for your model. Assign at least one object or edge as either a source (such as a
current, charge, or voltage) or a value boundary.
Permanently polarized or magnetizedmaterials also act as sources of charge or magnetic field
(respectively). If you do not identify some type of source, theMaxwell 2D will not be able to generate
a solution.
The field quantities computed by each solver— and the required electromagnetic sources— are
given in the following table:

Field Solver Sources Field
Computed

Derived Field
Quantities

Electrostatic Voltages
charges
charge density
floating

φ E,D

Magnetostatic DC current
current density

AZ (XY
models),
Aφ (RZ
models)

H,B

Eddy Current AC currents
current density

AZ(ωt)
(XY
models),
Aφ(ωt)
(RZ
models)

JZ(ωt) (XY models),
Jφ(ωt) (RZmodels),
H(ωt),B(ωt),

DC
Conduction

DC voltages φ E,D, J

AC
Conduction

AC voltages φ(ωt) E(ωt), J(ωt)

Transient Transient voltages and currents through
External Circuit connection. Current; current
density; coil; end connection

AZ (XY
and RZ
models)

H,B

where:
l A is themagnetic vector potential.
l H is themagnetic field.
l B is themagnetic flux density.
l φ is the electric potential.
l E is the electric field.
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l D is the electric flux density.
l J is the current density.

These quantities are phasors in AC simulations.

Related Topics

Permanently PolarizedMaterials
External StaticMagnetic Fields
Permanent Magnets
External AC Magnetic Fields

2D Voltage Sources

Voltage sources are available for the Electrostatic, DC Conduction, AC Conduction and Transient
solver types. Voltage sources specify the total DC voltage (electric potential), or themagnitude and
phase of the AC voltage on a conductor. Voltages can be defined as constants or as functions;
however, the voltage is assumed to be uniform over the source.
Voltage sourcesmay also be specified on a selected edge or edges.

Related Topics

AC Voltage Source
DC Voltage Source

DC Voltage Source

This type of source specifies the total DC voltage (electric potential) on a conductor. Voltages can be
defined as constants or asmath functions; however, the potential on a conductor is constant over the
entire conductor. Note that conductors that touch should be set to the same voltage or defined as a
single voltage source, since their potentials are identical.
DC voltagemay also be specified on an edge or edges. Voltages can be defined as constant or as
functions of position (for instance, to model a specific distribution of potential on the surface of a
dielectric).

AC Voltage Source

AC voltage sources are used in AC conduction, and Transient models. All voltages in AC models are
time-varying quantities in the form:
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where Vm is themagnitude of the voltage and θ is its phase angle— the offset of the current from a
pure cosine wave. Therefore, when specifying a voltage, youmust enter both itsmagnitude and
phase.

2D Current/Current Density

Current sources are available in theMagnetostatic, EddyCurrent, and Transient solver types. This
type of source specifies the total DC current, or themagnitude and phase of the AC current on a
conductor. Currents can be defined as total current, current density, or as functions.
Current sourcesmay also be specified on a selected edge or edges. Edge currents can be defined
as total surface current or a surface current density. In the case of edge currents, Eddy current
effects are not modeled, since all currents are surface currents.
Generally:

l If the total surface current is specified, the current density is assumed to be uniform.
l If the current density is specified, youmay define a uniform current density or one that varies
as a function of position tomodel specific distributions of current on the surface.

Related Topics

AC Current Source
DC Current Source

DC Current Source

This type of source specifies the DC current flowing in a conductor. You can set either the total
current or the current density flowing in the object.

l If total current is specified, the current density is assumed to be uniformly distributed
throughout the object.

l If current density is specified, youmay define a uniform current density or one that varies as a
function of position.

AC Current Source

Remember, all AC currents are time-varying quantities in the form:
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where Im is themagnitude of the current and θ is its phase angle— the offset of the current from a
pure cosine wave. Therefore, when specifying a current or current density, youmust enter both its
magnitude and phase.

l In a single-phase system, time t=0 is usually chosen so that the phase angle, θ, is zero— that
is, the current peaks at t=0.

l In multi-phase systems involving currents that are out of phase with each other, time t=0 is
usually chosen so that one current has a phase angle equal to zero. For example, phase
angles in a three-phase system could be assigned as shown here:

Active vs Passive Conductors

In addition, the conductors in an eddy current model can be divided into two groups:
l “Active” conductors. These conductors are connected to an external current source. Their
total current is constrained to the value you specify.

l “Passive” conductors. These conductors are not connected to an external source, but current
may be induced in them. Treat any conductor in which the current is constrained to zero (an
open circuit) as being connected to a zero-amp current source.

Active and passive conductors are shown in the figure below. In this simple transformer model, the
coil on the left is an active conductor carrying 1500 amps of current. The coil on the right is a passive
conductor in which current is induced by the oscillatingmagnetic field. The total current is plotted.
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Passive Conductors

Passive conductors can have eddy and displacement currents flowing through them, but have no
component of source current. Two types of passive conductorsmay be defined:

l To define a passive conductor modeling a short circuit, simply assign a conductingmaterial to
the desired object. Do not assign source current to it. There are no constraints on the eddy
and displacement currents flowing in this type of passive conductor. For cartesianmodels,
visualize this type of conductor as being infinitely long and eventually looping back on itself.
For axisymmetricmodels, visualize this type of conductor as a conducting ring that carries no
source current.

l To define a passive conductor modeling an open circuit, assign a solid current source with a
magnitude and phase of zero to it. Current may be induced in it, but the net current is
constrained to zero amps. In cartesianmodels, visualize this type of conductor as an infinitely
long conducting rod with no return path for current. In axisymmetricmodels, visualize this type
of conductor as a conducting ring with a gap in it.

Current Sources for Touching Conductors

Conductors whose surfaces touch are assigned sources as follows:
l If they are not assigned the samematerial, these conductorsmust be defined as a parallel
source. Otherwise, theywill behave as if they are separated by a thin layer of insulating
material.

l If they are assigned the samematerial, these conductorsmay be defined either as a parallel
source or as grouped conductors assigned a solid source.

This distributes current appropriately across the surfaces of the conductors.
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Current Sources for Perfect Conductors

This describes the case in which all current in a perfect conductor flows only on the surface of the
conductor. Magnetic fields cannot penetrate this type of conductor. You can only specify the total DC
current when defining a perfect conductor as a current source.
A perfect current source specifies themagnitude and phase of the AC current flowing through a
perfect conductor. All currents in perfect conductors are surface currents, simulating the conductor’s
behavior at very high frequencies. You can only specify themagnitude and phase of the total current.

Solid, Stranded, and Parallel Current Sources

These types of sources specify themagnitude and phase of the AC current flowing through a
conductor. Solid current sourcesmodel eddy and displacement currents in a solid conductor. The
amount of eddy current and displacement current— aswell as the amount of source current— are
included in the total current you specify.

l Stranded current sourcesmodel current as being carried on strandswithin a conductor. They
can be used tomodel conductorsmade up of many individual insulated turns, all small enough
so that eddy currents can be neglected. Eddy currents and displacement currents are not
computed inside the conductor. Either the total current or the current densitymay be specified.
A uniform current density is assumed throughout the conductor, unless a functional current
density is defined.

l Parallel current sources connect two or more conductors in parallel to an outside source. The
total current flowing through all selected conductors (including eddy and displacement
currents) is specified. However, the current flowing through individual conductors in the
parallel group is unconstrained and its value is computed during the solution.

The differences between each type of AC current source are shown below:
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For solid and parallel current sources, the current you specify is the total current in the conductor:

where:
l ITotal is the total current flowing through the source. It satisfiesOhm’s law with the potential
seen by the source.

l ISource is the current due to the potential difference generated by the external source. It is the
current that the source would supply if you reduced the potential difference by the back EMF
produced by the eddy and displacement currents in the conductor.

l IEddy is the eddy current induced in the conductor due to time-varyingmagnetic fields
penetrating the conductor.

l IDisplacement is the displacement current due to time-varying electric fields in the conductor. It
becomes significant only at very high frequencies.

For stranded current sources, the current you specify is the total source current (or source current
density), Itotal = Isource. Eddy current and displacement current effects are neglected.

2D Charge/Charge Density

This type of source specifies the total charge or charge density on a non-conducting object.
l If the total charge is specified, charge is assumed to be uniformly distributed throughout the
interior of the object.

l If a constant value for the charge density is specified, charge is assumed to be uniformly
distributed throughout the object. The charge density can also be specified as a function of
position tomodel a distribution of charge that varies inside the object.

This type of sourcemay also specify the charge on a selected edge or edges. It is used primarily to
assign surface charges to non-conductors. The “surfaces” being referred to are those created by
extending the edge in the z direction (cartesianmodels) or revolving it around the z-axis
(axisymmetricmodels). Specify either the total charge or the charge density.
If the total charge is specified, charge is assumed to be evenly distributed on the selected surface.
If the charge density is specified, you can define either a uniform charge density or one that varies as
a function of position— tomodel specific distributions of charge on the surface.
The electrostatic field simulator computes the electric potential on the edge during the solution.

2D Floating

This type of source specifies the total charge on a conductor, identifying it as a floating conductor.
Charge is assumed to be evenly distributed on the object’s surface. Its value can be defined as a
constant or as a function of position; however, charge is distributed over a conductor so that the
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electric potential is constant throughout the conductor. Because of this, the E-field is equal to zero in
this region and no solution is computed inside the conductor.

External Circuit Connections

Youmay define transient current sources and transient voltage sources using theMaxwell Circuit
Editor. This allows you to define an external circuit netlist which can be connected to the 2D model
to act as a source in the time domain.
To define an external connection, the general procedure should be followed:

1. Create sheets objects to be used as terminals.
2. Assign theCoil Terminal excitation to the sheet objects.
3. Create aWinding, provide a unique name for the winding, and specifyExternal Circuit as

the winding type. Select either Solid or Strand as the type of conductor for the external
connection.
Note You cannot mix solid and stranded sources in the external

circuit.

4. ChooseWinding, and add theCoil Terminals to the winding using theAdd Terminals
dialog.

5. Launch theMaxwell Circuit Editor from theWindowsStart menu.
6. Add aWinding element to the circuit with the same name as given to the winding in the

Maxwell design.
7. Add additional circuit element to the schematic to create the external source circuitry for the

winding.
Note The transient solver accepts only the following subset of elements available in

Schematic Capture: resistors, inductors, capacitors, diodes, switch on voltages,
switch on currents, current sources, voltage sources, current meters, and voltage
meters.

8. Export the circuit to a netlist, andSave andExit theMaxwell Circuit Editor.
9. In theMaxwell design, use theEdit External Circuits command to Import the netlist.

The external circuit is now ready for use in theMaxwell design.

References for Electric or Magnetic Potential

Youmust specify a reference for electric scalar potential or magnetic vector potential that Maxwell
2D can use when computing fields. To do so, assign one of the following boundary or source types to
at least one surface in your model:

l Value boundary
l Voltage source
l Odd symmetry boundary
l Balloon boundary
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If you do not set a reference for electric or magnetic potential, themodel is not uniquely defined and
an error message appears when you try to generate a field solution. This problem usually occurs
when you set up:

l Electrostatic problems that contain only charge sources. The electrostatic field solver requires
that a reference voltage be defined in order to compute the electric potential (and from it, the
electric field) in the problem region.

l Magnetostatic and eddy current problems that contain only current sources. These solvers
require that a reference value ofAZ or rAφ reference value be set in order to compute the
magnetic vector potential (Az) and from it, themagnetic field in the problem region.

End Connections in 2D Transient and Eddy Current

Choose this command to assign an end connection to a group of solid objects. This causes all
objects in the group to be connected electrically in parallel using a finite resistance and inductance
between adjacent objects.
End connections are primarily used in passive conductors (with no source current assigned) when
modeling cylindrical squirrel cage inductionmotors.
For evenly distributed conductors, the End Resistance, Re, and the End Inductance, Le, are
assigned between the ends of each conductor pair.

Note l Re and Le are the values on one end of the squirrel cage as shown in the schematic
below. Therefore in Maxwell 2D, you would enter 2ohm and 1mH for this squirrel
cage.

l The current reported as EndConnection1 is the current in the first bar located counter
clock-wise from the X axis.

For unevenly distributed conductors, the user supplied resistance and inductance values are scaled
such that the supplied values are used directly for the conductor pair with the smallest angle between
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them. All other conductor pairs are assigned values that are scaled up according to the following
equations:

Where θij is the angle between the conductor i and conductor j.

Functional Boundaries and Sources
Functional boundaries and sources have defined bymath functions, and are used:

l Tomodel distributions of charge, current or voltage that vary as a function of position.
l Tomodel external fields that vary as functions of position.
l To define voltage, current, charge or boundary values as variables to be used in a parametric
sweep.
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29 - Maxwell 3D Technical Notes
Maxwell® 3D is an interactive software package that uses the finite element method (FEM) analysis
to simulate and solve three-dimensional electromagnetic field problems. Maxwell integrateswith
other ANSYS software to perform complex taskswhile remaining easy to use.

Introduction to Maxwell
Maxwell 3D® supports the following five types of solutions:

l Electric 3D fields, which can fall in one of three categories:
l Electrostatic 3D fields in dielectrics caused by a user-specified distribution of voltages and
charges. Additional computed quantities you can specify include torque, force, and
capacitances.

l Electric 3D fields in conductors, characterized by a spatial distribution of voltage, electric
field, and DC current density. Themain additional quantity in this case is power loss.

l A combination of the first two with conduction solutions being used as boundary conditions
for an electrostatic problem.

l Magnetostatic linear and nonlinear 3D fields caused by a user-specified distribution of DC
current density, voltage, permanent magnets, or externally appliedmagnetic fields. Additional
computed quantities you can specify include torque, force, and inductances (self andmutual).

l Harmonic (Eddy current) (sinusoidal variation in time) steady state 3D magnetic fields with
pulsation-induced eddy currents in massive (solid) conductors caused by one of the following:
by a user-specified distribution of AC currents (all with the same frequency but with possibly
different initial phase angles), or by externally appliedmagnetic fields.
The electric field solution is correct inside a conductor due to Ohm's law and self-consistent
current densities (including current-bunching in solid conductors).Outside a conductor,
Maxwell 3D's electric field permits somewave effects, such as propagation to a radiation
boundary, but is limited in application and will ignore capacitance effect along source
conductors (no charge-bunching). In general, there is no change in the electrical phase angle
of the applied current source along the length of a conductor.

l Transient Magnetic (time domain) 3D magnetic fields caused by permanent magnets and
windings supplied by voltage and/or current sourceswith arbitrary variation as functions of
time; electrical circuits will be connected with the windings. Rotational or translational motion
effects can also be included in the simulation.

l Transient Electric (time domain) 3D electric fields caused by time-varying voltages, charge
distributions, or current excitations in inhomogeneousmaterials. The transient electric field
simulator computes time-varying electric fields. Electric potential is the solution quantity.

The complex functionality built into theMaxwell 3D solvers is accessed through themain user
interface (called the desktop). With the version 11 interface and later, you canmodel the problem in a
fairly arbitrary order (rather than following the steps in a precise order aswas required in previous
versions of Maxwell).
This flexibility allows experienced users to develop amodeling style that suits their preferences.
Once themodel is created, the automatedMaxwell solution sequence takes over and fully controls
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the solution processwithout any interaction from the user. When the solution becomes available, the
user can perform a variety of post-processing tasks as required by the design application.
For users new to electromagnetic field simulation, ANSYS recommends the following sequence of
modeling steps:

1. Based on your application, choose the type of electromagnetic analysis to be performed.
2. Draw the geometry of themodel using the drawing space provided by theModeler menu and

Draw menu commands available through theMaxwell desktop interface.
3. Assign thematerial properties to all solid objects in themodel, and define new material

properties if materials in the default library do not provide the neededmaterial.
Note Caution: Alwaysmake sure thematerial properties assigned to an object

correspond to the real properties of thematerials in the electromagnetic device that
is being simulated. Material properties supplied in the default library are generic
properties andmay not always be substituted for actual properties.

4. Specify the field sources (excitations) and boundary conditions for your unique solution.
5. Define additional global parameters that you want to calculate (such as force, torque,

inductance/capacitance, etc.).
6. Definemesh operations for special applications (such as seeding in areas/objects of interest).
7. Specify solution options.
8. Start the solution process.
9. When the solution becomes available, perform post processing, such as plotting field

quantities and calculating expressions.
The basicmodeling entity is the design (model). The next level up is the project. A project is a
collection of one or more designs (models) that is saved in a single *.aedt file. A new project is
automatically created when ANSYS Electronics Desktop is launched. AsmanyMaxwell designs as
needed can be added to a single project.
When setting up aMaxwell design, specific commands are available via themenu bar or toolbar
using themouse. You can also work directly in the project tree (the Project Manager area) of the
desktop.

Mouse Button Usage

In general the left mouse button is used to select items (menu commands, objects, properties, etc.).
Double-clicking the left mouse button on an item opens a properties window and allows you to
visualize settings and edit properties. Right-clicking is context-dependent and, in general, allows you
to perform context-specific operations (such as assigning boundary conditions or excitations or
performing field plots on previously selected geometry entities, exiting the zoommode or draw
mode, etc.).
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Maxwell Desktop

A brief description of the desktop workspace is provided below in a graphical format. The desktop
commands are located on themenu bar. The toolbar contains graphical symbols for the widely used
commands. The results of themodeling operations (as far as the geometry is concerned) are
reflected in the 3D modeler window and in the history tree window. The property window displays
the attributes of selected objects (when the attribute tab is selected) or command characteristics
(parameters) if the command tab is selected. Themainmodeling phases are accessible through the
project manager. Themessage window displaysmessages (info, warnings, and errors) while the
progresswindow shows the progress of the current solution process. The status bar is context
dependent and typically contains info guiding the user in themodeling process (displays current
status or expected input from user in the process of executing a command).

Finite Element Analysis

Finite element analysis (FEA) is a very sophisticated tool widely used by engineers, scientists, and
researchers to solve engineering problems arising from various physical fields such as
electromagnetic, thermal, structural, fluid flow, acoustic, and others. Currently the finite element
method is clearly the dominant numerical analysismethod for the simulation of physical field
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distributions, with success not paralleled by any other numerical technique. In essence, the finite
element method finds the solution to any engineering problem that can be described by a finite set of
spatial partial derivative equationswith appropriate boundary and initial conditions. It is used to solve
problems for an extremely wide variety of static, steady state, and transient engineering applications
from diversemarkets such as automotive, aerospace, nuclear, biomedical, etc.
The finite element method has a solid theoretical foundation. It is based onmathematical theorems
that guarantee an asymptotic increase of the accuracy of the field calculation towards the exact
solution as the size of the finite elements used in the solution process decreases. For time domain
solutions the spatial discretization of the problemmust be refined in amanner coordinated with the
time steps of the calculation according to estimated time constants of the solution (such asmagnetic
diffusion time constant).
Maxwell solves the electromagnetic field problems by solvingMaxwell's equations in a finite region of
space with appropriate boundary conditions and— when necessary— with user-specified initial
conditions in order to obtain a solution with guaranteed uniqueness. In order to obtain the set of
algebraic equations to be solved, the geometry of the problem is discretized automatically into
tetrahedral elements. All themodel solids aremeshed automatically by themesher. The assembly of
all tetrahedra is referred to as the finite element mesh of themodel or simply themesh. Inside each
tetrahedron, the unknowns characteristic for the field being calculated are represented as
polynomials of second order. Thus, in regionswith rapid spatial field variation, themesh density
needs to be increased for good solution accuracy (see also adaptivemesh refinement).

Types of Solutions and Degrees of Freedom (DOFs)

Solving an electromagnetic field problem is always based on solvingMaxwell's equations. However
the process of obtaining the solution is typically based on solving a second order consequence of
Maxwell's equationswith the consideration of applicable constitutive equations. At the same time --
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as a rule -- a subset of completeMaxwell’s equations is considered according to characteristic
aspects of the application. Thus for reasons of efficiency of the solution, applications are classified as
electrostatic, magnetostatic, frequency domain or time domain and as a consequence a specific type
of solver is used in each case. This allows the users to obtain the solution with the desired accuracy
but alwayswithin the limits of the fundamental assumptionsmadewhen the application was
classified along the lines of the abovementioned criteria. The guide lines that can be used to
correctly identify the type of solution to use arementioned in the following paragraphs. The
unknowns for each type of solution can be different, depending on the formulation.

Size of Mesh Vs. Accuracy

There is a trade-off among the size of themesh, the desired level of accuracy, and the amount of
available computing resources.
The accuracy of the solution depends on the size of each of the individual elements (tetrahedra).
Generally speaking, solutions based onmeshes using thousands of elements aremore accurate
than solutions based on coarsemeshes using relatively few elements. To generate a precise
description of a field quantity, each element must occupy a region that is small enough for the field to
be adequately interpolated from the nodal values.
However, generating a field solution involves inverting amatrix with approximately asmany
elements as there are tetrahedra nodes. For mesheswith a large number of elements, such an
inversion requires a significant amount of computing power andmemory. Therefore, it is desirable to
use amesh fine enough to obtain an accurate field solution but not so fine that it overwhelms the
available computer memory and processing power.
To produce the optimal mesh, Maxwell uses an iterative process, called an adaptive analysis, in
which themesh is automatically refined in critical regions. First, it generates a solution based on a
coarse initial mesh. Then, it refines themesh in areas of high error density and generates a new
solution. When selected parameters converge to within a desired limit, Maxwell breaks out of the
loop.

The Mesh Generation Process

Following is the general mesh generation process:
1. Maxwell generates an initial mesh, which includes surface approximation settings. If

necessary, themesher will automatically perform any repairs needed to recover an accurate
mesh representation of amodel. The solution profile will indicate whenmesh repairs have
beenmade, and the results of these repairs will be displayed per object in themesh statistics
panel.

2. Anymesh operations that were defined are used to refine themesh.
3. Using the resultingmesh, Maxwell computes the electromagnetic fields that exist inside the

structure based on the assigned excitations.
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4. If you are performing an adaptive analysis, Maxwell uses the current finite element solution to
estimate the regions of the problem domain where the exact solution has strong error.
Tetrahedra in these regions are refined.

5. Maxwell generates another solution using the refinedmesh.
6. Maxwell recomputes the error, and the iterative process (solve— error analysis— adaptive

refinement) repeats until the convergence criteria are satisfied or themaximumnumber of
adaptive passes is completed.

7. If a frequency sweep is being performed, thenMaxwell solves the problem at the other
frequency points without further refining themesh. An adaptive solution is performed only at
the specified solution frequency.
Note Maxwell does not generate an initial mesh each time it starts the solution process.

The initial mesh is generated only if a current mesh is unavailable.

Related Topics

Seeding theMesh
Guidelines for Seeding theMesh
Length-BasedMesh Refinement
Skin Depth-BasedMesh Refinement
Surface Approximation Settings
Guidelines for Modifying Surface Approximation Settings
Meshing Region Vs. ProblemRegion
Model Resolution

Seeding the Mesh

In Maxwell, mesh operations are optional mesh refinement settings that enable you to provide
Maxwell with engineering guidance based on your knowledge of the parts of themodel geometry
that are critical to the structure’s electromagnetic performance. Providing such guidance toMaxwell
prior to beginning the adaptive analysis process can reduce (sometimes extensively) the number of
passes necessary to converge upon a field solution aswell as the final number of tetrahedra in the
mesh for that solution. Although adaptive analysis convergence targets areaswhere field behavior is
found, refining themesh usingmore than the standard criteria, such asmaterial characteristics, can
result in finding areas of critical field behavior as soon as the first few passes are solved.
The technique of guidingMaxwell’smesh construction is referred to as "seeding" themesh. Seeding
is performed using theMesh Operations commands on theMaxwell menu.
You can instruct Maxwell to refine the length of tetrahedral elements on a surface or within a volume
until they are below a certain value (length-basedmesh refinement) or you can instruct Maxwell to
refine the surface triangle length of all tetrahedral elements on a surface or volume to within a
specified value (skin depth-basedmesh refinement.) These types of mesh operations can be defined
at any time. If you apply them before the adaptive solution process, they are used to refine the initial
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mesh after it has been generated. You can also choose to applymesh operationswithout generating
a solution, in which case themesh operations are applied to the current mesh.
In a few circumstances, youmay also want to define amesh operation that modifiesMaxwell’s
surface approximation settings for one or more faces. Surface approximation settings are only
applied to the initial mesh.

Related Topics

DefiningMeshOperations
Technical Notes: TheMeshGeneration Process

Guidelines for Seeding the Mesh

While seeding themesh is not required, it is useful in the following conditions:
l Seeding themesh inside a volume in themodel geometry where regions of strong electric
or magnetic fields (with strong capacitive or inductive loading) are expected. Examples
include a capacitively loaded gap in a resonant structure, sharp waveguide angles or
corners, or gaps betweenmulti-coupled lines in filter structures.

l Seeding themesh on every face of higher aspect ratio boundaries, such as long PCB
traces or on the surfaces of long wires. Spacing themesh points roughly equal to the trace
width of the wire diameter enables you tomore accurately capture the behavior of the high-
aspect structure from the first adaptive pass.

Related Topics

DefiningMeshOperations

Length-Based Mesh Refinement

When you request length-basedmesh refinement, you instruct Maxwell to refine the length of
tetrahedral elements until they are below a specified value. The length of a tetrahedron is defined as
the length of its longest edge.
You can specify themaximum length of tetrahedra on faces or inside of objects. You can also specify
themaximumnumber of elements that are added during the refinement. When the initial mesh has
been generated, the refinement criteria you specified will be used to refine the initial mesh.

Related Topics

Assigning Length-BasedMesh Refinement onObject Faces
Assigning Length-BasedMesh Refinement Inside Objects
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Skin Depth-Based Mesh Refinement

When you request skin depth-basedmesh refinement, you instruct Maxwell to refine the surface
triangle length of all tetrahedral elements on a face to within a specified value. A layeredmesh is
created based on the surfacemesh. The layers are graded based on the skin depth and number of
layers you specify.
During skin depth-basedmesh refinement, Maxwell creates a series of layers that are planes parallel
to the object face, and that are spaced within the specified skin depth. For each point on the surface
of the face, a series of points (P0, P1, P2, ..., Pn) are added to themesh, where n is the number of
layers. P0 is the point on the surface and the distance fromP0 to Pn is the skin depth. The points are
spaced in a non-uniformmanner, with the distance between them decreasing in a geometric
progression, as youmove fromPn to P0.
For example, if

Skin Depth: 12
mm

Number of Layers of Elements: 4

then

Distance
[P0,P1]:

0.8mm.

Distance
[P1,P2]:

1.6mm.

Distance
[P2,P3]:

3.2mm.

Distance
[P3,P4]:

6.4mm.

Distance
[P0,P4]:

0.8 + 1.6 + 3.2 + 6.4 = 12
mm

The skin depth-based refinement first satisfies the surface triangle edge length criterion, then
introduces the series of points to each additional layer. If a limit has been placed onmesh growth,
one of the following happens:

l The limit is set high enough to complete the skin depth refinement.
l The limit is set high enough to satisfy the surface triangle edge length criterion, but not high
enough to complete the depth seeding.

l The limit is not set high enough to satisfy even the surface triangle edge length criterion.
Because refining by skin depth can addmany seeding points, you should first refine the surface of
the object using length-basedmesh refinement to obtain an accurate count of the number of points
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Maxwell will add when refining by skin depth. This allows you to reach the surface edge length
criterion and approximate the number of elements in themesh and the number of points on the
surfaces before proceeding to skin depth seeding.
The refinement criteria you specified are used to refine the current mesh.

Related Topics

Assigning Skin Depth-BasedMesh Refinement onObject Faces

Surface Approximation Settings

Object surfaces inMaxwell may be planar, cylindrical or conical, toroidal, spherical, or splines. The
original model surfaces are called true surfaces. To create a finite element mesh, Maxwell first
divides all true surfaces into triangles. These triangulated surfaces are called faceted surfaces
because a series of straight line segments represents each curved or planar surface.
For planar surfaces, the triangles lie exactly on themodel faces; there is no difference in the location
or the normal of the true surface and themeshed surface.When an object’s surface is non-planar,
the faceted triangle faces lie a small distance from the object’s true surface. This distance is called
the surface deviation, and it ismeasured in themodel’s units. The surface deviation is greater near
the triangle centers and less near the triangle vertices.
The normal of a curved surface is different depending on its location, but it is constant for each
triangle. (In this context, "normal" is defined as a line perpendicular to the surface.) The angular
difference between the normal of the curved surface and the correspondingmesh surface is called
the normal deviation and ismeasured in degrees.
The aspect ratio of triangles used in planar surfaces is based on the ratio of circumscribed radius to
the in-radius of the triangle. It is unity for an equilateral triangle and approaches infinity as the triangle
becomes thinner.
You canmodify the surface deviation, themaximumpermitted normal deviation, and themaximum
aspect ratio of triangles settings on one or more faces at a time in theSurface Approximation
dialog box. (ClickMaxwell3D>Mesh Operations>Assign>Surface Approximation.)
The surface approximation settings are applied to the initial mesh.

Note For the initial mesh, all the vertices of the triangles lie on the true surfaces. Duringmesh
refinement, all the points are first added to the faceted surface for all products, not to the
true surfaces. Then, for all Maxwell projects, and for curvilinear meshing enabled HFSS
and HFIE projects, the points on the faceted surfaceswill bemoved to the curved surface
locationswhen suchmovement does not degrade the quality of themesh.

Related Topics

Modifying Surface Approximation Settings
Technical Notes: Guidelines for Modifying Surface Approximation Settings
Technical Notes: TheMeshGeneration Process
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Guidelines for Modifying Surface Approximation Settings

If you intend tomodify the surface approximation settings for an object face or faces, keep the
following guidelines in mind:

l When necessary, override the default surface approximation settings to represent curved
surfacesmore accurately. More accurate representation will increase themesh size and
consumemore CPU time andmemory. The default settings are adequate for most
circumstances.

l If you want to obtain a faster solution by using a cruder representation of curved surfaces,
set the coarser setting for the whole object, not just a single face.

l It is difficult for Maxwell to satisfy aspect ratio demands if the aspect ratio value is set close
to 1 because an arbitrary shape cannot be filled with only equilateral triangles. Therefore,
setting the aspect ratio to 1 can lead to unreasonably largemeshes. Maxwell limits the
aspect ratio to 4 for planar objects and 1.2 for curved objects.

Related Topics

Modifying Surface Approximation Settings
Technical Notes: Surface Approximation Settings

Meshing Region Vs. Problem Region

Maxwell distinguishes between the problem region and themeshing region. The problem region is
the region in which the solution is generated and themesh is refined. Themeshing region, which
includes the problem region, is the area in which an initial mesh is generated. After an initial mesh is
generated, themesh is refined only in the problem region.
The problem region encompasses an area that is just large enough to include the entire design, but
no larger. Maxwell automatically defines the problem region during the solution process. If you are
interested in effects outside of the structure, such as radiated effects, then you can create a virtual
object to expand the size of the problem region to include these areas.
Themeshing region, like the problem region, is a box that completely encloses the structure.
However themeshing regionmust be at least 10 times larger than themodel. The part of the
meshing region not occupied by objects is considered to be the background object. The background
extends to the boundaries of themeshing region and fills in any voids not occupied by objects. Since
the background object is defined as a perfect conductor, no solution is generated inside the
background even though an initial mesh is generated for it. Maxwell automatically defines the
meshing region during the solution process.
The problem region and themeshing region are illustrated below.
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Model Resolution

Model Resolution is a setting that determines the smallest details of amodel that themesher
should capture and represent in themesh.
Many times the analysis starts with the geometry already drawn in a different tool for different
purpose. Some tools are designed for manufacturing and the resultingmodels contain lots of extra
details not needed for electromagnetic analysis. If the user removes such details in the original tool
the results will be better. But if the user does not have access to the original drawing tool or
redrawing themodel without these details is not possible,Model Resolution is another way to
remove the details from analysis.
When the user sets themodel resolution length to be L, themesher will start with a surface
representation of themodel accurate to themodeler's tolerance limit. Then it will progressively
remove edges, move points, merge points etc., within the allowablemodel resolution limit and
simplify the surfacemesh. During this process, tiny fillets, rounds, and chamfer protrusions are
removed.
Other commonmodel translation anomalies are also handled usingModel Resolution. For
example, some geometry engineswill blindly export all of the surfaces as splines. When a user
imports such amodel for analysis, it would result in very large number of triangles. If the surface can
be represented by a smaller set of triangles usingModel Resolution, this procedure would reduce
the number of triangles in the surfacemesh.
The user can start with amodel resolution length around 0.1*wavelength. If themodel resolution
length chosen by the user is too large, themesher will detect it and report it as an error. Themodel
resolution length is specified in the user units of themodeler. It can be set on selected bodies only.
The default value is 100* the tolerance limit of the ACIS modeler.

Related Topics

ModifyingModel Resolution
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Electric Field Calculation
The Electric field solver uses the electric scalar potential values asDOFs. There are two basic types
of static electric field solutions, as well as the combination of these two:

l For the electrostatic solution, it is assumed that all objects are stationary (velocity is zero
everywhere in the space where the electrostatic field is calculated), there is no time variation

of any of the electromagnetic quantities ( ) and there is no current flow in conductors
(conductors are in electrostatic equilibrium) and thus Joule losses are zero everywhere. All
conductors are considered to be perfect and equipotential such that there is no electric field
inside conductors. The unknowns (DOFs) are electric scalar potentials at all the nodes of the
tetrahedra of themesh. The distribution of conductivity in the space of the problem is
irrelevant, only the distribution of permittivity is relevant for the solution process.
Note For the electrostatic solution, if two or more conductors touch each other, they

should be united into one object by using theModeler Boolean operation "Unite"
before analysis.

l For the DC current flow solution, only the conductors (with electric conductivity >
Insulator/Conductor Threshold) are considered in the solution process. The DOFs are also
the electric scalar potentials at the nodes of themesh. Here the distribution of electric
conductivity is relevant for the solution processwhile the permittivity is irrelevant. There is DC
current flow in conductors (conductors are not equipotential) and there is non-zero Joule loss
(ohmic power loss) in the conductors (which are part of an excited current path). The
conductors are considered to be immobile (velocity is zero everywhere). Themagnetic field
associated with the DC current flow is not calculated and is totally de-coupled from the
calculated electric field distribution in conductors.

l The combination of the DC current flow and electrostatic solution is based on the division of
the arrangement into conductors and insulators. Conductors are those objects whose electric

conductivity is greater then or equal to the Insulator/Conductor threshold, and insulators are

those whose conductivity is less then the Insulator/Conductor threshold. The solution of
such problems is performed in two steps: first the DC conduction problem in the conductors is
computed, then the electrostatic solution in insulators is calculated using the electric scalar
potential of the conductors as a voltage boundary condition.

For the electric field solution, there are ten nodal DOFs (electric scalar potential unknowns)
associated with each tetrahedron at each of the four vertices and at each of the sixmid-edge nodes.
Therefore, a quadratic approximation of the electric scalar potential inside each tetrahedron can be
obtained.
The electrostatic field solver solves a Poisson type partial differential equation for the electric

potential unknown, , with appropriate boundary conditions:
Maxwell 3D Technical Notes 29-12
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where:

l is the electric potential scalar function of position.

l is the relative permittivity, which is a function of position and can be isotropic or orthotropic.

l F/m is the permittivity of a vacuum.

l is the volume density of the electric charge.
Once the electric potential is obtained by solving the above second order differential equation in the
domain of the problem, Maxwell's equations and the applicable constitutive equation are then used

to obtain the electric field strength, , and electric flux density, , vectors, as follows:

Typical sources for electrostatic problems are net charges (assumed to have a uniform
distribution) applied to perfect insulator model objects or on surfaces that cannot touch conductors
and voltages (electric potential applied to perfect conductor model objects or on surfaces, also
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called a Dirichlet boundary condition). Additionally, a floating boundary condition can be applied to
perfect conductors (surrounded by insulators) or to surfaces surrounded by perfect insulators.
Volume charge density is another allowed excitation, which can have a spatial distribution
specified by the user and can be applied to insulating objects only that do not touch conductors.
At the interface between two dielectrics, the normal component of the electric flux density vector has
no jump if the charge density at the respective interface is zero:

where the permittivity and normal electric field values are considered in the two dielectrics and are
designated by the subscripts 1 and 2. Alternatively, when crossing a surface with non-zero charge
density, the normal component of the electric flux density has a jump equal to the respective local
superficial charge density. It follows that in dielectrics (such as air, for example) in the immediate
vicinity of conductive objects (perfect conductors), the (normal) component of the electric flux density
is equal to the neighboring local charge density on themetallic surface (since inmetallic objects the
field value is zero).

Note When voltages are applied to conductors, the charge transferred from the DC source(s) to
the conductors almost instantly receives a superficial distribution. For real (good)
conductors, the time constant for the diffusion of the charge is of the order of 10-19s.
Therefore, for all practical instances, we consider the charge relaxation process to occur
instantly. Once the charge on conductors reaches the steady state (almost
instantaneously), the electric field in the neighboring dielectrics has a distribution that is
governed by the laws of electrostatics, and the field in conductors is null while the field
distribution in dielectrics is dictated - as far asmaterial properties are concerned - by the
respective permittivities and is independent of the conductivity of the electric conductors.
This is why, in electrostatics, we can consider the real conductors to be perfect conductors.

Electrostatic regime of the electromagnetic field is rarely achieved in practice rigorously speaking.
However very good approximations aremany times possible to use for practical situationswithin the
limits specified above.
The DC current flow solver solves the following equation:

where:

Maxwell 3D Technical Notes 29-14
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

l is the electric potential scalar function of position.

l is the electric conductivity (in SI it ismeasured in S/m), which is a function of position and can
be isotropic or orthotropic.

Once the electric potential is obtained by solving the above second order differential equation in the
domain of the problem, Maxwell's equations and the applicable constitutive equation (Ohm's law in a

local formulation) are then used to obtain the electric field strength and the electric current density
vectors:

Typical sources for DC current flow problems are currents applied on surfaces of conductors and
voltages (electric potential applied to surfaces of conductors). The direction of the applied current is
either "in" or "out", always normal to the respective surfaces.

Note Multiple conduction paths are allowed. Each conduction path that has a current excitation
must also have either a voltage applied or a sink to ensure a unique solution.

The sink is a particular excitation (without a numerical value assigned to it) that is used to ensure the
divergence-free character of the calculated DC current density vector in each conduction path.
At the interface between two different conductors, the normal component of the current density
vector is continuous:

For DC current flow problems, the solution is dictated everywhere inside the conductors by the
distribution of electric conductivity, as far asmaterial properties are concerned.
Charge, voltage, floating, current, and sink type excitations are called "terminal" type excitations
since they can be referenced in amatrix extraction setup.
In perfect conductors, no computation occurs, and the electric scalar potential (the unknown in the
problem) has a uniform value. However, in the post-processing phase, the (constant) distribution of
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the electric scalar potential (voltage) is correctly rendered. No solution is available in solids explicitly
excluded from the solution.
The solution of any field problem is only possible if appropriate boundary conditions have been set.
The boundary conditions have three purposes:

l Boundary conditions are always necessary from amathematical perspective in order to
ensure the uniqueness of the solution calculated byMaxwell.

l Boundary conditions occasionally represent a convenient way of modeling different ideal
situations. For example, in order to model the field in a dielectric sandwiched between two
very thin conducting objects (the thickness is at least two orders of magnitude less than the
other relevant dimensions of the respective conducting objects), only the two respective
surfaces need to bemodeled on either side of the dielectric object. In the setup, those top and
bottom surfaces carry appropriate boundary conditions, and the field in the dielectric is
correctly simulated without having to draw the respective conductors.

l Boundary conditions also occasionally provide a convenient way of taking advantage of
symmetry situations. In such cases, themodelsmust have the same geometric andmaterial
properties, as well as electric symmetry.

Typical boundary conditions include voltage, floating, and insulation boundary conditions. In the
case of an insulating boundary condition, a conductor must exist at least on one of the sides of
the respective surface.
The default boundary condition applied to all faces of the boundary of the electric field (static or
stationary) problem is a Neumann homogeneous condition. This condition enforces an electric field
tangent behavior of the solution in the immediate vicinity of the boundaries. There is no need to apply
any particular boundary condition at the interface between objects with different material properties,
as the solution automatically ensures -in average - the continuity of the tangential component of the

electric field strength ( ) and the continuity of the normal component of the electric flux density

vector ( ) across surfaceswith zero superficial electric charge density (for electrostatic problems).

Symmetry for an Electric Field Solution

A symmetry boundarymodels a plane of symmetry in a structure. Use this type of boundary
condition to take advantage of both geometric symmetry and electric symmetry. Doing so enables
you to reduce the size of your model - allowing you to conserve computing resources. Two types of
symmetry boundaries are available:

l Even Symmetry (Flux Tangential)
l Odd Symmetry (Flux Normal)

These boundaries can only be assigned to the outside edges of the solution region.
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Even Symmetry (Flux Tangential) for an Electric Field Solution

Use an even symmetry boundary to define a plane of symmetry where the signs (positive or
negative) of the voltages and charges on one side of the plane are the same as those on the other
side. Electric flux is tangential to the boundary and thus does not cross it. To define an even
symmetry boundary, the simulator sets the selected edge to a Neumann boundary - acting as an
electrical mirror to themodel.

Odd Symmetry (Flux Normal) for an Electric Field Solution

Use an odd symmetry boundary to define a plane of symmetry where the signs (positive or negative)
of all charges and voltages on one side of the plane are the opposite of those on the other side.
Electric flux is normal to the boundary. To define an odd symmetry boundary, the simulator sets the
selected edge to a voltage boundary with a potential of zero volts.

Matching Boundary for an Electric Field Solution

Matching boundaries allow you tomodel planes of periodicity where the E-field on one surface
matches the E-field on another. They are very useful for modeling devices such asmotors, in which
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the electric field repeats every 180o, 120o, 90o, or less. They enable you tomodel the smallest
possible periodic segment of the device - reducing the amount of computing resources needed
during the solution.
To set upmatching boundaries, youmust create amaster boundary and a slave boundary. Unlike
symmetry boundaries,E does not have to be tangential or normal to these boundaries. The only
condition is that the fields on the two boundariesmust have the samemagnitude and direction (or the
samemagnitude and opposite directions).

Master Boundary for an Electric Field Solution

The simulator computes the electric field on amaster boundary using the charges and voltages that
you specified for themodel as input. No other special conditions are imposed.

Slave Boundary for an Electric Field Solution

The electric field on the slave boundary is forced tomatch the field on themaster boundary. The
magnitude of the electric field on both boundaries is the same. The fields on the two boundaries can
either point in the same direction, or in opposite directions.

When to Use Matching Boundaries for an Electric Field Solution

Consider a simple electrostaticmicromotor in which the rotor is held at zero volts and the six stator
poles are switched between zero volts, 100 volts, and -100 volts. The E-field pattern at any point in
time repeats itself every 180o— causing the field in one half of themotor to match the field in the
other half.
If you usematching boundaries, you only need tomodel half of themotor, as shown below. The E-
field on the slave boundary (the left side of themotor) is forced tomatch themagnitude and point in
the opposite direction from the E-field on themaster boundary (the right side of themotor) -
simulating the field pattern that would occur if the entire motor wasmodeled.
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A symmetry boundary cannot be used in place of matching boundaries in this example. The electric
field is not necessarily either perpendicular or tangential to themotor's periodic surfaces. In the
example above, the electric field would be exactly tangential to the periodic surface only when the
poles of the rotor are aligned with the poles of the stator. In the other positions of the rotor, the field is
not tangential andmatching boundaries are required.
A combined DC current flow + Electrostatic solution type is also possible. In this case, the
voltage distribution on conductors from the DC current flow solution is used as a Dirichlet (applied
voltage) boundary condition in the electrostatic phase of the solution process. This type of sequence
allows a certain class of problem involving electrostatic fields surrounding conductors with DC
current flow to achieve a comprehensive solution. In this case, the solution provides the electric field
in conductors and dielectrics.

Solution Process for an Electric Field Solution

Maxwell's electrostatic solver computes and stores the value of the electric potential at the vertices
andmidpoints of the edges of each tetrahedron in the finite element mesh. It solves for the electric
field using the following relationship:

After E is calculated, Maxwell writes out solution files and performs an error analysis. In an adaptive
analysis, it refines the tetrahedra with the highest error, and continues solving until the stopping
criterion ismet. In a non-adaptive solution, the process stops.
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Electric Field Energy for an Electric Field Solution

The energy, U, that is stored in a static electric field is given by the following equation:

where:
l E is the electric field.
l D is the electric flux density.

Capacitance Matrix for an Electric Field Solution

Capacitancematrices can be expressed in terms of charge and voltage, or current and time-varying
voltage. The unit of capacitance is F.

Note For a capacitancematrix, the elements are defined based on excitations, not
solids.
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Capacitance in Terms of Charge and Voltage

A capacitancematrix represents the charge coupling within a group of conductors - that is, the
relationship between their charges and voltages. Given a ground reference for the three conductors
below, the net charge on each object is:

This can be expressed inmatrix form as the following:
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The capacitancematrix above gives the relationship betweenQand V for the three conductors and
ground. An n-conductor device would have an n x n capacitancematrix.

Capacitance in Terms of Current and Time Varying Voltage

A capacitancematrix can also represent the relationship between currents and time varying voltages
in a system of conductors. Given the three transmission lines shown below, the currents caused by
the time varying voltage source on each line are given by the following equation:

If dV2 / dt and dV3 / dt are set to zero, this relationship becomes the following:
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This gives the currents that are induced on Line 2 and Line 3 when a time varying voltage source is
applied to Line 1 - that is, the capacitive coupling between the three lines, or the short circuit
capacitance.
The capacitancematrix can be exported to a circuit/system simulator, such as SIMPLORER, where
it can be used in a transient simulation.

Matrix Elements for an Electric Field Solution

If one volt is applied to Conductor 1 and zero volts are applied to the other two conductors, the
capacitancematrix becomes the following:

Diagonal Elements for an Electric Field Solution

These terms (such asC11) are the sum of all capacitances from one conductor to all other
conductors. These terms represent the self-capacitance of the conductors. Each is numerically
equal to the charge on a conductor when one volt is applied to that conductor and the other
conductors (including ground) are set to zero volts. For instance, C11 = C10 + C12 + C13. This term
is equal to the charge on Conductor 1 when it is set to one volt and the other conductors are set to
zero volts.

Off-Diagonal Elements for a Capacitance Matrix

The terms in each column (such asC12 , C13) are numerically equal to the charges induced on other
conductors in the systemwhen one volt is applied to a single conductor. For instance, in column one
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of the capacitancematrix shown above, C12 is equal to - C12. This is equal to the charge induced on
Conductor 2 when one volt is applied to Conductor 1 and zero volts are applied to Conductor 2.
The off-diagonal terms are simply the negative values of the capacitances between the
corresponding conductors (themutual capacitances). In column one of the example capacitance
matrix, the off-diagonal terms represent the capacitances between Conductor 1 and the other two
conductors; in column two, the terms represent the capacitance between Conductor 2 and the other
conductors; and so forth.

Symmetry for a Capacitance Matrix

The capacitancematrix is symmetric about the diagonal. This indicates that themutual effects
between any two objects are identical. For instance, C13, the capacitance between Conductor 1 and
Conductor 3 (C13), is equal to C31, the capacitance between Conductor 3 and Conductor 1.

Solution Process for a Capacitance Matrix

To solve for the capacitancematrix, the electrostatic solver generates a single field solution. The
system computes each entry of the capacitancematrix using the following relationship:

where the contributions of each conductor to the capacitancematrix aremodeled using numerical
matrixmanipulation techniques.

Only conductors with voltage excitations can be included in a capacitancematrix calculation.

Lumped Capacitance

Lumped capacitance is essentially the result of a 1x1 capacitancematrix. It is used to calculate the
electric field energy, U, from the E-field and D-field. Since the energy can also be expressed as:

the capacitance is:
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Maxwell assumes that the problem is set up so that the following is true:
l One conductor (or group of conductors) is set to +1 volt.
l Another conductor (or group of conductors) is set to zero volts.
l All other conductors are floating.

Therefore, the lumped capacitance between all conductors set to one volt and all those set to zero
volts is simply 2U.

Warning The lumped capacitance computation, as described above, is invalid if you assigned
voltages other than +1V or 0V to the conductors in your model.

Note For caseswhere amatrix extraction is desired inMaxwell, the respective extraction needs
to be compatible with the hypothesismade regarding the equipotentiality of the respective
surfaces, lack of radiation, etc., characteristic to a low frequency circuit approximation. In
the circuit representation, the respective lumped elements are interconnected with other
circuit elements at the nodes that physically represent the "terminals" in the
electromagnetic field problem. Thus, it is possible (within the limits of the lumped circuit
elements and applicable theory) to have circuit elements with field effects, such as
capacitors and inductors, capable of storing energy. You can access these elements
through the provided terminals/nodes, which can then be viewed as energy ports since
most of the extracted elements have the capability to store energy. The volume charge
density excitation is not a "terminal" type of excitation since the objects to which it is applied
cannot, as a rule, be considered equipotential.

Lorentz Force for an Electrostatic Calculation

The component of the Lorentz force due to current in an electric field is:

where:
l q is the charge.
l E is the electric field.

Warning The Lorentz force does not compute the correct force on objects that are assigned
materials with a relative permittivity greater than one. To find the force on these
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objects, use virtual force.

Lorentz Torque for an Electrostatic Calculation

The system uses Lorentz forces to compute the torque around the x, y, and z axes. The Lorentz
torque is given by the following equation:

where:
l r is the displacement vector from the axis of rotation.
l q is the charge.
l E is the electric field.

This integral is computed for the x-, y-, and z-axes, giving the net torque on the object(s) about each
axis of rotation.

Warning The Lorentz torque does not compute the correct torque on objects that are assigned
materials with a relative permeability greater than one. To find the torque on these
objects, use virtual torque.

Virtual Force for an Electrostatic Calculation

To compute the virtual force on an object, the electrostatic field simulator uses the principle of virtual
work. In the structure shown below, the force on the bottom plate (plate B) in the direction of the
displacement, x, is given by the following relationship:

where U is the electric field energy.
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Unlike the classical virtual workmethod, the plate is not actuallymoved during the numerical process
of the force computation. Instead, only the tetrahedra that lie along the outside surface of the object
are virtually distorted. U and its derivative, dU/dx, are calculated from a single field solution using
finite element interpolation functions.

Virtual Torque for an Electrostatic Calculation

Similar to the virtual force calculation, the system uses virtual work principles to compute the torque
on an object. In the structure shown below, the virtual torque on the bottom plate (plate B) about the
axis of rotation is given by the following relationship:

where U is the electric field energy.
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Unlike the classical virtual workmethod, the plate is not actually rotated during the numerical process
of the torque computation. Instead, only the tetrahedra that lie along the outside surface of the object
are virtually distorted. U and its derivative, dU/dθ, are calculated from a single field solution using
finite element interpolation functions.

Ohmic Loss for DC Conduction

TheOhmic loss,P, that is generated in conductors when solving DC current flow problems, is given
by the following equation:

where

l is the electric field.

l is the electric current density.
For the sake of brevity, the ohmic loss density in the post processor should be labeled asOhmic
Loss. The total ohmic loss of an object or the whole arrangement can be calculated by integrating
over a proper volume in the Field Calculator.
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Surface Charge Density

The Surface Charge Density,Q, that is generated on a surface between twomaterials when solving
electric field problems, is given by the following equation:

where
l E1 is the electric field and ε1 the permittivity in thematerial on one side of the boundary.
l E2 is the electric field and ε2 the permittivity in thematerial on opposite side of the boundary.
l n in the normal vector of the surface.

In order to calculate the surface charge, youmust first select a surface in themodeling window.

Surface Current Density

For impedance boundary, the Surface Current Density, Jsurf, is computed as the cross product of
the surface normal of the impedance boundary and the difference between H fields on the top and
bottom of the boundary., and is given by the following equation:

where
l n is the surface normal vector.
l (Htop –Hbottom) is the difference between H fields on the top and bottom of the impedance
boundary.

In order to calculate the surface current density, youmust first select a surface in themodeling
window.

Magnetostatic Field Calculation
In amagnetostatic solution, themagnetic field is produced byDC currents flowing in
conductors/coils and by permanent magnets. The electric field is restricted to the objectsmodeled as
real (non-ideal) conductors. The electric field existing inside the conductors as a consequence of the
DC current flow is totally decoupled from themagnetic field. Thus, as far asmagneticmaterial
properties are concerned, the distribution of themagnetic field is influenced by the spatial distribution
of the permeability. There are no time variation effects included in amagnetostatic solution, and
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objects are considered to be stationary. The energy transformation occurring in connection with a
magnetostatic solution is only due to the ohmic losses associated with the currents flowing in real
conductors.
Themagnetostatic field solution verifies the following twoMaxwell's equations:

with the following constitutive (material) relationship being also applicable:

where:

l is themagnetic field strength.

l is themagnetic flux density.
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l is the conduction current density.

l is the permanent magnetization.

l is the permeability of vacuum.

l is the relative permeability.
For nonlinear materials, the dependency between the H and B fields is nonlinear and can be

isotropic or orthotropic (in the case of anisotropicmaterial behavior, is a tensor). Similarly, for
permanent magnets, nonlinearity can occur in practical cases and is allowed. Additionally, if a
demagnetized condition is to be taken into account for (nonlinear) permanent magnets operating
below the knee, Maxwell provides an advanced setup option allowing a solution based on a
previously computed demagnetization operating point. If nonlinearity occurs in soft materials (with
negligible hysteresis) simultaneously with orthotropic behavior, Maxwell requires that the BH curves
for the principal directions in the respectivematerial(s) be provided. From these curves, the energy
dependency on H is extracted for each of the respective principal directions and is used in the
process of obtaining the nonlinear permeability tensor used in the Newton-Raphson iterative
solution process:
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where and are the previous field solution, is a general full tensor, and is given by the
following:

with taking into account the anisotropic effects of any laminations present in themodel.
The 3D magnetostatic solver considers themagnetic field H with the following components:

where is themagnetic scalar potential, is a particular solution constructed by assigning values
to all the edges in themesh in such a way that Ampere's law holds on all contours of all tetrahedra

faces in themesh, and accounts for the permanent magnets if any. Thus, the DOFs are the nodal
values of themagnetic scalar potential with ten values per tetrahedron at each of the four vertices
and all sixmid edge nodes, ensuring a quadratic approximation inside each finite element.
There aremajor advantages of this formulation over other existing ones, including using
considerably fewer computational resources (due to the scalar nature of the DOFs), not requiring a
gauge due to excellent numerical stability, significantly reducing cancellation errors, and capably of
automaticallymultiplying connected iron regions. Themagnetostatic solver handles both 3D linear
and nonlinear problems. In the case of nonlinear applications, a classic Newton- Raphson iterative
algorithmwith user-controlled accuracy is used.
Themagnetostatic solver calculates themagnetic field distribution produced by a combination of
knownDC current density vector distribution and a spatial distribution of objects with permanents
magnetization. It is also possible to apply boundary conditions to amodel such that the simulation of
the immersion of a device into an external magnetic field is also possible. In this latter case, the
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boundary conditions should be applied in such a way that Maxwell's equations are not violated inside
the domain of the solution or at the boundaries.
Typical sources for magnetostatic field problems include voltage, current, permanent
magnetization, and current density. When applying the sources for themagnetic field problems, the
applied current distributionmust be divergence free in the entire space of the solution as it is physical
for quasi-stationary conduction current density distributions. Thus, the conduction paths(s) for the
applied current distributionsmust be closed when totally contained within the solution space for the
problem, or must begin and end at the boundaries.

Maxwell 3D Technical Notes 29-33
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

The total current applied to conductors that touch the boundaries does not require the existence of
terminals at the endswhere the current is applied because the respective planar surfaces of the
conductors in the plane of the region (background) can be used to apply the excitations. In the case
of a closed conduction path, a terminal (sheet object) must be created, matching the cross-section of
the conductor at the desired location such that the excitation (current/voltage) can be applied.

Note Current and voltage excitations cannot bemixed on any conduction
path.

Voltage excitations (at least two) must be specified such that the current can flow in the respective
conductors to form an uninterrupted conduction path.Voltage drop excitation should by used in the
case of closed conduction paths (possibly containing objects with different electric conductivities),
primarily in situationswhere the total current is unknown. One voltage drop excitation per conduction
path should be applied. The total current for any conduction path should add up to zero.
Themagnetostatic solver does not compute the electric field distribution associated with a voltage
distribution outside conductors. However, the electric field inside conductors is indirectly available for
post processing via the conduction current density distribution, which is available. Thus it is possible
to calculate the ohmic loss in conductors with applied current or voltage excitations.
Permanent magnetization in Maxwell® is treated as amaterial property, but wemention it here
because of its source characteristics.

Permanent magnetization can be specified in Cartesian, cylindrical, or spherical material coordinate
systems, as shown in the above window where the R, Phi, and Z components (in a cylindrical
system, considered here as example) can be specified in anymeaningful combination. The actual
direction of the vector property is decided when the property is assigned to the object and when the
desired coordinate system is chosen (the global coordinate system always exists, while additional

Maxwell 3D Technical Notes 29-34
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

ones can be defined). If necessary, additional relative coordinate systems can be defined and used
to specify the orientation of the vector property.

While the type of material coordinate system is embedded into thematerial definition, the actual
orientation is not, such that amaterial property defined, for instance, in a cylindrical system can be
applied tomultiple objects with different orientations if multiple relative local coordinate systemswere
defined and used in the process of assigning the respectivematerial property.
A typical boundary conditions used inmagnetostatic problems is themagnetic field tangent
(the default, natural boundary condition that is automatically applied on all surfaces of the problem
space -the surfaces of the geometry entity containing themodel inside it). This default boundary
condition can be overwritten if other boundary conditions are applied on exterior surfaces of the
solution space. The default boundary condition confines themagnetic field to the solution space;
therefore, this boundarymust be placed at some distance from the sources to avoid over-
constraining the fields by placing the boundaries to close to themodel objects. While it is difficult to
provide "recipes" with general validity on the placement of the boundaries of problems, a good rule of
thumb asserts that if a model can be imagined as being contained in a sphere of radius R, then the
boundaries can be placed at a 4-5 radii R from the imaginary center of themodel.
The Zero Tangential H Field allows the user to prescribe a normal (in average) field orientation on
an arbitrary surface. This boundary condition does not require any further user input, meaning that
no value and coordinate system specification are necessary.
In the case of Tangential H Field boundary condition, the values of two tangential components and
a surface coordinate systemmust be defined and subsequently used in the assignment process of
this boundary condition. This boundary condition is restricted to two kinds of surfaces: planar or
cylindrical. The CS in the planar case would be a rectangular coordinate systemwith X and Y
components of H in the plane. The coordinate system in the cylindrical case would be a coordinate
systemwith a Z axis coinciding with the axis of the cylinder, and the two components to input would
be the PHI and Z axis components of H.
In the case of the tangential H field, caution is advised: This boundary condition should be specified
such that Ampere's theorem is not violated inside the field domain or at the boundaries.
Symmetry boundary conditions are used to solve problemswith symmetry and, thus, allow the
users to take advantage of the significantly reduced problem size for a given accuracy.
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Symmetry boundary conditions can be one of two kinds:
l Odd (flux tangent)
l Even (Flux normal)

Although the use of this symmetry boundary condition overlapswith previous conditions to some
extent, the symmetry boundary conditions should only be used in clear symmetry cases.

Symmetry for a Magnetostatic Field Solution

A Symmetry boundarymodels a plane of symmetry in a structure. Use this type of boundary
condition to take advantage of geometric andmagnetic symmetry in a structure. Doing so enables
you to reduce the size of your model, which helps to conserve computing resources. Two types of
symmetry are available:

l Odd Symmetry (Flux Tangential)
l Even Symmetry (Flux Normal)

These boundaries can only be assigned to the outside edges of the solution region.

Odd Symmetry (Flux Tangential) for a Magnetostatic Field Solution

Use an odd symmetry boundary tomodel a plane of symmetry in which current on one side of a
plane flows in the opposite direction to current on the other side of the plane. Magnetic flux is
tangential to this type of boundary. To define an odd symmetry boundary, the simulator sets the
selected edge to a Neumann boundary.

Even Symmetry (Flux Normal) for a Magnetostatic Field Solution

Use an even symmetry boundary to define a plane of symmetry where the direction of current flow is
the same on both sides of the plane. Magnetic flux is normal to this type of boundary. To define an
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even symmetry boundary, the simulator sets the selected edge to aMagnetic Field boundary with a
field value of zero - acting as amagneticmirror to themodel.

Warning When using even symmetry boundaries, be careful that you do not violate Ampere's
law.

Matching Boundary for a Magnetostatic Field Solution

Matching boundaries allow you tomodel planes of periodicity where the H-field on one surface
exactlymatches the H-field on another. They force themagnetic field at each point on one surface
(the "slave" boundary) to match themagnetic field at each corresponding point on the other surface
(the "master" boundary). They are very useful for modeling devices such asmotors, in which the
magnetic field repeats every 180o, 120o, 90o, or less. Basically, they enable you tomodel the
smallest possible periodic segment of the device - reducing the amount of computing resources
needed during the solution.
To set upmatching boundaries, youmust create both amaster boundary and a slave boundary.
Unlike Symmetry boundaries,H does not have to be tangential or normal to these boundaries. The
only condition is that the fields on the two boundariesmust have the samemagnitude and direction
(or the samemagnitude and opposite directions).

Master Boundary for a Magnetostatic Field Solution

The simulator computes themagnetic field on aMaster boundary using currents, permanent
magnets, andmagnetic fields as input. The field is thenmapped to the slave boundary.

Slave Boundary for a Magnetostatic Field Solution

Themagnetic field on the Slave boundary is forced tomatch the field on themaster boundary. The
magnitude of themagnetic field on both boundaries is the same. However, the fields on the two
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boundaries can either point in the same direction, or in opposite directions, as specified by the user
during setup.

When to Use Matching Boundaries for a Magnetostatic Field Solution

Matching boundaries enable you to take advantage of periodicity in a structure. For example, below
is a diagram of the cross-section of a simple brushlessDC motor. The field in such amotor repeats
itself every 90 degrees; that is, the field pattern in one quarter of themotor matches themagnitude
and direction (or the opposite of the direction) of the field pattern in the other three quarters. With
matching boundaries, all you have tomodel is one quarter of the structure.

A Symmetry boundary cannot be used to simulate periodicity because themagnetic field is not
necessarily either perpendicular or tangential to periodic surfaces. For example, in the quarter model
shown on the right, themagnetic field is exactly perpendicular to the bounding surfaces only when
the gap separating the permanent magnets is perfectly horizontal or vertical. For all other positions of
the rotor, matching boundaries are required.

Solution Process for a Magnetostatic Field Solution

In general, the solution process involves a phase in which the distribution of current density (if not
already known) is obtained, followed by the calculation of the distribution of magnetic field that
corresponds to the distribution of the sources. In the case of solid conductors with an applied current
source, an automatic process is initiated such that following an iterative process involving adaptive
mesh refinement, the current density vector distribution is obtained and subsequently the
correspondingmagnetic field distribution is computed. In the case of stranded conductors, it is
assumed that the current density is uniform on the cross-section of the respective conductors. Thus,
the stranded option for current excitations shouldmostly be used only in caseswhere the cross-
section of conductors is constant, consistently with the assumption that the respective object is a coil
built with strands of wire. For this reason, conductors (coils) could be created by either sweeping
around an axis using zero segments, or sweeping along a path having only true surface segments in
order to create a smooth surface coil having a completely uniform cross-sectional area over its entire
length.
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Magnetic Field Energy for a Magnetostatic Field Solution

Themagnetic energy of a system is given by the following expressions. The expressions represent
total values of energy for the volumes taken into account. Note that the integrals have simpler
expressions if thematerial property of the object considered is a linear one. In case of linear material
propertiesmagnetic energy and co-energy values are identical (W = Wc).

l In linear materials, the energy is:

l In nonlinear materials, the energy is:

where:
l H is themagnetic field.
l B is themagnetic flux density.

The figure below represents graphically the definitions of both energy and co-energy densities. Note
that both are local quantities (i.e. are function of X, Y, Z coordinates of the location in themodel) and
also depend on the operating point on the applicable B-H curve. Energy is equal to the area above
the BH-curve, and coenergy is equal to the shaded blue area below the BH-curve.
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For the sake of brevity, themagnetic flux density in the post processor should be labeled as
Magnetic Flux. The total magnetic flux of an object or the whole arrangement can be calculated by
integrating over a proper volume in the Field Calculator.

Related Topics

Technical Notes: Magnetic Co-energy
Technical Notes: Magnetic Apparent Energy

Magnetic Coenergy for a Magnetostatic Field Solution

Themagnetic coenergy of a system is given by the following expressions. The expressions
represent total values of co-energy for the volumes taken into account. Note that the integrals have
simpler expressions if thematerial property of the object considered is a linear one. In case of linear
material propertiesmagnetic energy and co-energy values are identical (W = Wc).

l In linear materials, the coenergy is:
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l In nonlinear materials, the coenergy is:

where:
l H is themagnetic field.
l B is themagnetic flux density.

The coenergy is related to themagnetic field energy.

Note In case permanent magnets are part of themodel, as a rule, themagnetic energy reported
by the solver and the post processor may be different. This occurs because the adaptive
meshing part of the solution sequence runs a special computation so that it can avoid
situationswith a total zero energy of the field (problemswith permanent magnets and no
other excitation). To avoid such situations, the solver uses (and reports) the total energy,
which includes the absolute value of the energy inside the permanent magnets. Because
of this, the energy reported by the solver in these cases is greater than the energy reported
by the post processor.

Related Topics

Technical Notes: Magnetic Field Energy
Technical Notes: Magnetic Apparent Energy

Magnetic Apparent Energy for a Magnetostatic Field Solution

Themagnetic apparent energy of a system is given by the following expression:

where:
l H0 is themagnetic field final operating point.
l B0 is themagnetic flux density final operating point .

Apparent energy is equal to the shaded area below.
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Related Topics

Technical Notes: Magnetic Field Energy
Technical Notes: Magnetic Co-Energy

Inductance Matrix for a Magnetostatic Field Solution

Inductancematrices can be expressed in terms of flux linkage and current, or in terms of voltage and
time-varying current. Inductance values are given in henries.

Types of Inductance

For nonlinear materials, the definition of inductance requires additional detail compared to the linear
case. Three commonly used inductance values are illustrated in the figure above - each inductance
has useful applications. Maxwell uses apparent inductance to calculate flux linkage as a function of
the independent variables, since it changeswith current as thematerial properties change. To obtain
apparent inductances for nonlinear materials in Maxwell, a two-step procedure is followed:

1. A nonlinear magnetostatic solution is generated with all sources at user specified values. This
establishes a value of permeability that varies with eachmesh element, since the degree of
saturation varies throughout the device.

2. These self-consistent values are used in a linear solution for the inductancematrix, with each
coil current set to one ampere. The resulting values are apparent inductances, which vary with
each specified coil current operating point because thematerial properties change.

The inductance calculation is now linearized on the self-consistent values. If the coil currents had
been increased to the specified values in the first step, in the linearizedmodel, the resultingmagnetic
field would be identical to the nonlinear solution. Therefore, the inductances from the second step
are the ratios of respective flux linkages to coil current, at the nonlinear operating point originally
determined.
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The slope of any line drawn on the figure above has units of inductance (henries) and any area
enclosed on this plot represents units of energy in joules if magnetic flux is expressed inWebers and
current is expressed in Amperes. The three inductances are defined as:

Incremental
(differential)
inductance

The slope of a line tangent to the curve at the operating point. Incremental
inductance is the usual textbook definition. For small signal AC analysis in
Maxwell SPICE or Saber, incremental inductance is evaluated using an
operating point determined from aDC solution. Incremental inductance can also
be used in time domain system simulations by using the compensation theorem,
but it has no useful relationship to stored energy.

Apparent
inductance

The slope of a line from the origin to the operating point. Apparent inductance
gives the total flux linkage as a function of current, so it is well-suited for the state
equation or basis function approach to time domain simulations. For small-signal
AC analysis, apparent inductance cannot be used directly, but can be used to
supply the proper derivatives toMaxwell SPICE. Energy can be calculated with
apparent inductance, but the result is not really the stored energy because it
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ignores the path taken along the nonlinear curve.
Apparent inductance does not provide the actual stored energy at the specified
operating point. However, during time domain simulations, apparent inductance
varies with current, and tracks the nonlinear curve shown in the figure.

Initial
inductance

The slope of a line tangent to the curve at the origin. Initial inductance applies to
manymagneticmaterials that have a "toe" in themagnetization curve.
Laboratorymeasurements at 0 A DC measure initial inductance, not the "linear"
value that may be somewhat higher.
Note: Initial inductance is a particular case of the incremental inductance where
the slope of the respective line passes through the origin of the (flux - current)
plane.

For linear materials, all three inductance values are equal. For nonlinear materials, the three values
are generally different. Except for initial inductance, each value varies with the operating point.
Ignoring the "toe" of the curve, the relation Lapp > Linc holds. Energy taken from or supplied to the
external circuit, as determined from the terminal voltage and current, will be correct.
The apparent inductance calculated byMaxwell at the actual operating point due to all sources in the
model (currents in the coils but also permanent magnets) is the base of all inductance calculations.
Incremental (differential) inductance information can be easily derived from the flux vs current
characteristic.
It should be noted that the apparent value relates to the local frozen, current dependent absolute
permeability as described above in the two step process. Incremental inductance relates to another
physical quantity which is the differential (incremental) permeability defined as dB/dH.
Solver calculatedmagnetostatic energy (reported as part of the solution convergence data) is the
apparent energy, always equal to the global, model-wise average between energy and co-energy.
For the linear material case in the entire model there is only one value of the inductance L = Linit =
Lincr = Lapp.

Inductance in Terms of Flux Linkage and Current

An inductancematrix represents themagnetic flux linkage between current loops. Given the three
current loops below, the relationship between induced flux and currents is:
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This can be expressed inmatrix form as:

The inductancematrix above gives the relationship between and i for the three independent
current loops. A device with n current loopswould have an n n inductancematrix.

Inductance in Terms of Voltage and Time-Varying Current

An inductancematrix can also represent the relationship between voltage and current fluctuations in
a system. Given the three independent transmission lines shown below, the voltage changes caused
by the time varying current source on each line are given by:
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The inductancematrix above gives the relationship between V and dI/dt for the three transmission
lines. If di2/dt and di3/dt are set to zero, this relationship becomes:

This gives the voltage changes that are induced on Lines 2 and 3 when a time-varying current source
is applied to Line 1 - that is, the inductive coupling between the three loops.
The inductancematrix can be exported to a circuit/system simulator, such as SIMPLORER, where it
can be used in a transient simulation.
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Matrix Elements for an Inductance Matrix

If one amp is applied to Current Loop 1 and zero amps is applied to the other two loops, the
inductancematrix becomes the following:

Diagonal Elements for an Inductance Matrix

Terms such as L11 represent the self-inductance of each current loop. Self-inductance is numerically
equal to the flux linkage in a current loop when one amp is flowing in it, and no current is flowing in
the other loops. For example, L11 is equal to the flux in Current Loop 1 when one amp is flowing in
that current loop, and no current is flowing in the other loops.

Off-Diagonal Elements for an Inductance Matrix

Terms such as L12 and L13 represent themutual inductances between the current loops. Mutual
inductance is numerically equal to the flux linkage in a current loop when one amp is flowing through
another loop, and no current is flowing anywhere else. For example, L12 is equal to the flux linkage in
Loop 1 when one amp is applied to Loop 2 and no current is flowing in the other loops.

Symmetry for an Inductance Matrix

The inductancematrix is symmetric about the diagonal. This indicates that themutual effects
between any two loops are identical. For instance, L13, the inductance between Current Loop 1 and
Current Loop 3, is equal to the inductance between Current Loop 3 and Current Loop 1.

Solution Process for an Inductance Matrix

To solve for the inductancematrix, themagnetostatic solver generates a single field solution. The
system computes each entry of the inductancematrix using the following relationships:
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But, assuming that the current, i, is one ampere:

where:

Each conductor in thematrix is assumed to be part of an independent current loop. The contributions
of each loop to the inductancematrix aremodeled using numerical matrixmanipulation techniques.

Warning Inductance is valid for different current levels in linear and nonlinear models:
l In models containing only linear materials, the system assumes that one amp of
current flows through each loop. The inductancematrix that is computed for these
models is valid for all current levels.

l In models containing nonlinear materials, the system uses the currents you
specified when setting up boundaries and sources. The inductancematrix that is
computed for thesemodels is valid only for these current levels.

Grouping Inductance Matrix Elements

The results of the inductancematrix calculationmay be post processed into series/parallel windings
using the grouping function. The operations of the grouping function can be one of two cases:

l Grouping all coils in series connection by grouping into 1 branch
l Grouping in amixed series/parallel combination by setting the number of branches to a
value of 2 or more.

Series Grouping
The inductances of the coils can be calculated as follows:
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Where Li is the per-turn inductance of the source calculated by the field solver and ni is the number
of turns specified in the grouping dialog box. Combining inductors in series, which is the case when
the number of branches is set to 1, is done according to:

where:
l m is the number of source entries being grouped.
l Lcoili represents the self inductance term for each coil entry to be grouped according to the
equation above.

l Mij andMji are themutual inductance terms between the sources being grouped.Mij and
Mjimust generally be considered separately as thematrixmay be unsymmetric.

l ni are the number of turns for each coil in the group.
Parallel Branches
If the number branches in the group is set to a value other than 1, the coils are first grouped in series
as described above, and then divided into by the number if branches specified.
The grouped inductance is then calculated as follows:

Where k is the number of branches set for the group.
The calculation above only relies on the inductancematrix calculated during the field solution and
can therefore bemanipulated as a post processing calculation.

Lorentz Force

The component of the Lorentz force due to current in amagnetic field is:
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where:
l J is the current density.
l B is themagnetic flux density.

Note The Lorentz force does not compute the correct force on objects that are
assignedmaterials with a relative permeability greater than one (that is, materials

where ). To find the force on these objects, use virtual force.

Lorentz Torque

The system uses Lorentz forces to compute the torque around the x-, y-, and z-axes. The Lorentz
torque is given by the following equation:

where:
l r is the displacement vector from the axis of rotation.
l J is the current density.
l B is themagnetic flux density.

This integral is computed for the x-, y-, and z-axes, giving the net torque on the object(s) about each
axis of rotation.

Note The Lorentz torque does not compute the correct torque on objects that are assigned

materials with a relative permeability greater than one (that is, materials where ).
To find the torque on these objects, use virtual torque.

Virtual Force

To compute the virtual force on an object, the system uses the principle of virtual work. In the
structure shown below, the force on the plate in the direction of the displacement, s, is given by the
following relationship:
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whereW(s,i) is themagnetic coenergy of the system. The current, i, is held constant.

Unlike the classical virtual workmethod, the plate is not actuallymoved during the force computation.
Instead, only the tetrahedra that lie along the outside surface of the object are virtually distorted.
Thus, the force computation only requires one field solution.

Virtual Torque

Similar to the virtual force calculation, the system uses virtual work principles to compute the torque
on an object. In the structure shown below, the torque onObject B about the axis of rotation is given
by the following relationship:
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whereW(θ, i) is themagnetic coenergy of the system. The current, i, is held constant.

Unlike the classical virtual workmethod, Object B is not actually rotated during the force
computation. Instead, only the tetrahedra that lie along the outside surface of the object are virtually
distorted. Thus, the change in the system’s coenergy (and therefore the virtual torque) is given by the
change in the coenergy of these tetrahedra.

Frequency Domain (Eddy Current) Solver

The 3D eddy current solver (frequency domain or harmonic solver) uses the
formulation. It is based on the assumption that all electromagnetic fields pulsate with the same
frequency (specified by the user) and havemagnitudes and initial phase angles calculated by
Maxwell. There are nomoving objects (velocity is zero everywhere). Permanent magnets cannot be
part of themodel, and all materials are assumed to be linear. Electromagnetic radiation can also be
simulated.
In the non conducting regions themagnetic field strength is given by the following equation:
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using node element with the same quadratic approximation as for the case of themagnetostatic
solver.
In regionswith non-zero conductivity where eddy current calculation has been set up, the following
equation is true:

where is the electric vector potential calculated using edge elements. At the interface between
conductors and non-conductors the tangential component of the electric vector potential is
constrained to zero.
The quantity calculated byMaxwell is in this case themagnetic field H(x,y,z,t).
Typical sources for eddy current problems include current and current density. In applying the
sources for themagnetic field problems, keep inmind that the applied current distributionmust be
divergence free in the entire space of the solution as it is physical for (quasi) stationary conduction
current density distributions. Thus, the conduction paths(s) for the applied current distributionsmust
be closed when totally contained within the solution space for the problem or must begin and end at
the boundaries. The total current applied to conductors that touch the boundaries doesn't require the
existence of terminals at the endswhere the current is applied, the respective planar surfaces of the
conductors in the plane of the region (background) can be used to apply the excitations.
Typical boundary conditions used in eddy current problems includemagnetic field tangent (the
default, natural boundary condition which is automatically applied on all surfaces of the problem
space -the surfaces of the geometry entity containing themodel inside it). This default boundary
condition can be overwritten if other boundary conditions are applied on exterior surfaces of the
solution space. The default boundary condition confines themagnetic field to the solution space and
thus this boundarymust be placed at some distance from the sources of the problem to avoid over-
constraining the fields by placing the boundaries to close to themodel objects. While it is difficult to
provide "recipes" with general validity on the placement of the boundaries of problems, a good rule of
thumb says that if a model can be imagined as being contained in a sphere of radius R, the
boundaries can be placed at a 4-5 radii R from the imaginary center of themodel.
The Zero Tangential H Field allows you to prescribe a normal (in average) magnetic field
orientation on an arbitrary surface. This boundary condition does not require any further user input,
that is, no value and coordinate system specification are necessary.
In the case of Tangential H Field boundary condition the values of two tangential complex
components (real and imaginary) and a surface coordinate system have to be defined and
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subsequently used in the assignment process of this boundary condition. This boundary condition is
restricted to two kinds of surfaces: planar or cylindrical. The CS in the planar case would be a
rectangular coordinate systemwith X and Y components of H in the plane. The coordinate system in
the cylindrical case would be a coordinate systemwith a Z axis coinciding with the axis of the cylinder
and the two components to input would be the PHI and Z axis components of H.
In the case of the tangential H field caution is advised: this boundary condition should be specified
such that Ampere's theorem is not violated inside the field domain or at the boundaries. This
boundary condition is very useful to simulate the behavior of devices "immersed" in an
electromagnetic filed of desiredmagnitude and orientation.
Symmetry boundary conditions are used to solve problemswith symmetry and thus allows the users
to take advantage of the significant reduction of the problem size for a given accuracy. Symmetry
boundary conditions are of two kinds,Odd (flux tangent) or Even (Flux normal). Although the use
of this symmetry boundary condition overlapswith previous conditions to some extent, the symmetry
boundary conditions should only be used in clear symmetry cases.
The Insulating boundary condition is of particular use for applicationswhere very thin insulating
layers are impractical to model due for example to high aspect ratio geometries that would be
generated and associatedmeshing difficulties. Thus insulating boundary condition can be assigned
to surfaces of separation between conductors. Another remarkable situation where such a boundary
condition proves to be extremely useful is in modeling faults in conductors (cracks for example).
Thus, modeling 2D (sheet) objects at the location of the respective cracks and applying the insulation
boundary condition proves to be a very effective way of modeling the flawswithout having to
generate 3D cracks that would be difficult and impractical to mesh.

Phasor Notation for an Eddy Current Solution

Time varying quantities that have the form:

can be represented as rotating phasors in the complex plane. Using Euler's formula:

If a = wt+q, F(t) equals the real portion of :
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Each time-varying quantity has the form . The component is a complex constant

that can be represented by a stationary phasor in the complex plane. The component is a
complex number that depends on t and can be represented as a rotating phasor in the complex
plane. The phasor's projection on the real axis oscillates sinusoidally. It reaches a peakwhen parallel
with the real axis, and crosses zero when parallel with the imaginary axis. Therefore, a phasor with
θ=90o represents a quantity that peaks 90 degrees after a phasor with θ=0o.

Real and Imaginary Components for an Eddy Current Solution

In general, youmust enter amagnitude and phase for all AC voltages, currents, and other boundary
or source quantities. But if themagnitude and phase angle of a quantity are functions of position,
specify the functions in terms of real and imaginary components (x+jy). The "x+jy" description of a
phasor indicates that the phasor is the sum of two components - a sinusoid that peaks atωt=0°and a
sinusoid that peaks atωt=90°.
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l The "x" component of the phasor is the real component and is represented by a phasor that
lies on the real axis of the complex plane.

l The "y" component is the imaginary component and is represented by a phasor that lies on the
j-axis of the complex plane.

The real and imaginary components of a three phase system are shown below:

They are related to themagnitude and phase of a sinusoid in this way:

where the real and imaginary components are:
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For a symmetric three-phase system, θ = 0, 120, 240 degrees, respectively.
For a frequency domain simulation (eddy current), all sources (currents, fields) must have the same
frequency. Therefore, the simulation frequency is specified as a global input parameter.
In simulationswhere the electromagnetic radiation is included the displacement, currents are
included in the calculation. In such a situation, the dependency between H and J is given by the
following equation:

Solution Process for an Eddy Current Solution

To solve for themagnetic field,H, the solver computes the values as follows:

In conductors where eddy currents occur,H is computed directly from source currents and applied
magnetic fields.
In non-conducting regions, H is computed from themagnetic scalar potential:

Directly solving forH requiresmore computing resources than using themagnetic potential, so this is
done only in regionswhere themagnetic potential cannot be used.
The solver combines the solutions and solves for themagnetic field.H is forced to be continuous on
the boundaries, producing a continuous field solution throughout themodel. It then saves the
completed solution to a file and performs an error analysis. In an adaptive analysis, it refines the
tetrahedra with the highest error and continues solving until the stopping criterion ismet.

Note Always use the peak value in the applied excitations in an eddy current
solution!

Maxwell 3D Technical Notes 29-57
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

Nonlinear Eddy Current Field Simulation (3D)

Refer to the following topics for detailed technical information on nonlinear 3D Eddy current field
simulation .
"Nonlinear EddyCurrent Field Simulation" on page 28-35
"Nonlinear EddyCurrent Theory" on page 28-35
"Sinusoidal B" on page 28-35

Skin Depth for an Eddy Current Solution

Induced currents allow magnetic fields to penetrate conductors only to a certain depth, of about 4-5
skin depths. The skin depth is approximated by the following formula:

where:
l ω is the angular frequency, which is equal to 2πf (f is the frequency at which source currents
and voltages oscillate during the solution).

l σ is the conductor's conductivity in siemens/meter.
l µr is the conductor's relative permeability.
l µ0 is the permeability of free space, which is equal to 4 x 10-7 H/m.

Currents are concentrated near the surface of the conductor, decaying rapidly past the skin depth.
As the formula above indicates, the skin depth gets smaller as the frequency increases.
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Note Due to the skin concentration of current, AC inductances and resistances are not equal to
their DC equivalents. This affects the inductance and resistance values computed during
impedance computations.

Both the skin depth / proximity effects and the displacement effectsmust be specifically requested.
Under the excitation setup, the respective effects can be specified for objects in themodel as shown
below:

Eddy (skin/proximity) effect can only be specified for objects with non-zero conductivity.
By default, eddy/displacement current effects are turned off. Including these in the calculation has a
potentially significant impact on the solution time since the electric vector potential calculation is
activated, causing the size of the solvedmatrix to increase significantly if the regionswith the electric
vector potential to be calculated have a large number of finite elements.
Displacement current calculation is normally activated in dielectrics (including vacuum) and allows
electromagnetic waves to propagate. In such cases, a radiation boundary condition should also be
used in the problem setup.

Magnetic Field Energy for an Eddy Current Solution

The energy density in the general case includes themagnetic and electric energy densities. The AC
magnetic field energy is given by the following:

where:
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l B is themagnetic flux density.
l H is themagnetic field.
l Re is the real part operation.
l The superscript * denotes complex conjugate.
l The symbol · is the dot product.

For the sake of brevity, the energy density in the post processor is labeled asEnergy. The total
energy (U) of an object or the whole arrangement can be calculated by integrating the energy
density over a proper volume in the Field Calculator, as follows:

This represents the average energy over time, not the instantaneous energy at a specific point in the
cycle. (The 1/4 factor is explained by the use of peak values for excitations.)

Hysteresis Loss for an Eddy Current Solution

The hysteresis loss is given by: the following

where:
l B is themagnetic flux density.
l H* is the complex conjugate of themagnetic field,H.
l ω is the angular frequency, equal to 2πf (where f is the solution frequency).

Themagnetic hysteresis loss density (ph) is given by the following:

where:
l Im is the imaginary part.
l ω is the angular frequency.

For the sake of brevity, the hysteresis loss density in the post processor is labeled asHysteresis
Loss. The total magnetic hysteresis loss (ph) of an object or the whole arrangement can be
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calculated by integrating the hysteresis loss density over a proper volume in the Field Calculator, as
follows:

Hysteresis loss applies if the structure includesmaterials with a non-zero value for the tangent of the
magnetic loss angle (equivalent to a non-zero imaginary permeability). Otherwise, it is equal to zero.

Ohmic Loss for an Eddy Current Solution

Ohmic loss is given by:

where:
l J is the current density.
l J* is the complex conjugate of the current density.
l σ is the conductivity in siemens/meter.

Ohmic loss is used to compute the power loss in a structure (P=I2R).
For impedance boundaries, ohmic loss is given by:

where:
l w is the angular frequency, which is equal to 2πf. (f is the frequency at which source currents
and voltages oscillate during the solution.

l s is the conductor's conductivity in siemens/meter.
l µr is the conductor's relative permeability.
l µ0 is the permeability of free space, which is equal to 4π x 10–7 H/m.
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l Ht is the tangential component of H on the impedance boundary.
l Ht* is the complex conjugate tangential component of H on the impedance boundary.

The ohmic loss density (po) is given by the following:

This loss is calculated from the conduction component of the current density:

For the sake of brevity, the ohmic loss density in the post processor is labeled asOhmic Loss. The
total ohmic loss (po) of an object or the whole arrangement can be calculated by integrating the
ohmic loss density over a proper volume in the Field Calculator, as follows:

Dielectric Loss for an Eddy Current Solution

The dielectric loss density (pd) is as follows:

The current density and the conduction current density are defined by the following two equations:
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For the sake of brevity, the dielectric loss density in the dielectric loss density in the post processor
should be labeled asDielectric Loss. The total dielectric loss (pd) of an object or the whole
arrangement can be calculated by integrating over a proper volume in the Field Calculator, as
follows:

The dielectric loss can also be called electric hysteresis loss.

Impedance Matrix for an Eddy Current Solution

An impedancematrix gives the relationship between AC voltages and AC currents for multiple
conductors. In the current loops below, the voltage and current in each loop is:
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This can be expressed inmatrix form as:

where:
l ∆Vi and Ii are phasors.
l Z11 = R1 + jωL11 (the self-impedance of Loop 1).
l Z12 = R12+ jωL12 (themutual impedance between Loops 1 and 2).
l Z22 = R2 + jωL22 (the self-impedance of Loop 2).

A device with n current loopswould have an n×n impedancematrix.

Matrix Elements for an Impedance Matrix

All impedances are complex numbers in the form:

where:
l ω is the angular frequency of the AC voltages and currents, which is equal to 2πf (where f is
the solution frequency).
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l R is the resistance, given in ohms.
l L is the inductance, given in henries.

If one amp flows in Loop 1 and zero amps in Loop 2, the impedancematrix becomes:

Diagonal Elements for an Impedance Matrix

The self-impedance of Loop 1 is given by Z11 = R1 + jωL11.
l R1 represents the internal resistance of the current loop.
l L11 represents the self-inductance of the loop. The jωL11 term represents the inductive
reactance of the loop— the apparent AC inductance due to the loop's self inductance.

Off-Diagonal Elements for an Impedance Matrix

Themutual impedance between Loops 1 and 2 is given by Z12 =R12+ jωL12.
l R12 represents themutual resistance of a neighboring conductor as seen from the source
conductor.

l L12 represents themutual inductance between the loops. The jωL12 term represents the
inductive reactance between the loops— the apparent AC inductance due to themutual
inductance.

Symmetry for an Impedance Matrix

The impedancematrix is symmetric about the diagonal. This indicates that themutual effects
between any two loops are identical.

Solution Process for an Impedance Matrix

The simulator divides the impedancematrix computation into two parts, as shown below.
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The solver generates a field solution for each conductor in thematrix. Each conductor is assumed to
be part of an independent current loop. In the first solution, the current in the first conductor is set to
one amp; currents in the other conductors are set to zero. This is done by imposing current sources
on the conductors. In the second solution, the current in the second conductor is set to one amp and
all other conductors are set to zero amps, and so forth. Objects that are not included in the
impedancematrix are not affected.
Using the field solution as input, the simulator performs inductance and resistance computations.
When it finishes solving for the inductance and resistance, the simulator combines them to form the
impedancematrix, using the relationship:

Inductance for an Impedance Matrix

The inductance solution for an impedance computation is similar to amagnetostatic inductance
solution. The system computes the following for eachmatrix entry:

where:
l B is themagnetic flux density.
l H* is the complex conjugate of themagnetic field.
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Resistance for an Impedance Matrix

To find the resistance, the system computes the ohmic loss, P, for each loop:

where J is the current density. Ohmic loss can also be expressed in terms of resistance and total
current, P=RIRMS2, where:

The resistance, therefore, is:

To solve this, the system computes the conduction current, J, for each conductor. Each subsolution,
Ji, represents the contribution of a current loop toward thematrix. After it solves for J for all
conductors, the system computes the resistancematrix.

Note Since all current loops are assumed to be independent, an impedancematrix only contains
terms for their internal resistance (or self-resistance). It does not include terms for the
mutual resistances between loops.

Line Impedance

Line impedance is represented by a 1x1 impedancematrix. That is to say, the line impedance is the
impedance of a single current loop given by:

where:
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l ω is the angular frequency of the AC voltages and currents, which is equal to 2πf (where f is
the solution frequency).

l R is the self-resistance of the loop.
l L is the self-inductance of the loop.

The inductance and resistance components of line impedance are computed separately.

AC Inductance and Resistance for an Impedance Matrix

The inductances and resistances computed during an impedance solution are different from those
computed for the equivalent DC case, as shown below. The darker blue area represents the cross-
section of the current flowing in the conductors.

The current density, J, in the DC case (the conductor on the left) is evenly distributed throughout the
cross-section of the conductor. The current density in the AC case (the conductor on the right) is
distributed close to the surface due to skin concentration of currents. Since the area through which
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current can flow is smaller, it follows that the resistance to the current flow is higher in the impedance
matrix than in the equivalent DC case.
In the DC example, no eddy currents occur. Themagnetic field created by the current flowing
through the conductor is static. In the AC example, the oscillatingmagnetic field induces currents in
other conductors in themodel. These induced currents affect the computation of inductance for the
impedancematrix, causing it to be different than the equivalent DC inductance.

Lorentz Force in an Eddy Current Solution

The Lorentz force represents the average force on an object (or group of objects) due to currents in a
time-varyingmagnetic field. Lorentz force is given by:

where:
l J(t) is the current density.
l B(t) is themagnetic flux density.

The average force is found by integrating the instantaneous force:

Warning The Lorentz force does not compute the correct average force on objects that are
assignedmaterials with a relative permeability greater than one. To find the force on
these objects, use virtual force.

Lorentz Torque in an Eddy Current Solution

The Lorentz torque represents the average torque on an object or group of objects due to currents in
a time-varyingmagnetic field. The Lorentz torque is given by:

where:
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l r is the displacement vector from the axis of rotation.
l J(t) is the current density.
l B(t) is themagnetic flux density.

The average torque is found by integrating the instantaneous torque:

This integral is computed for the x-, y- and z-axes, giving the average torque on the object(s) about
each axis of rotation.

Warning The Lorentz torque does not compute the correct average torque on objects that are
assignedmaterials with a relative permeability greater than one. To find the torque on
these objects, use virtual torque.

Virtual Force in an Eddy Current Solution

Virtual force in an eddy current problem is computed the sameway as themagnetostatic virtual
force. The only difference is that the average force over time is computed— not the net
(instantaneous) force at a given time. The average virtual force is found by integrating the
instantaneous force:

Virtual Torque in an Eddy Current Solution

Virtual torque in an eddy current problem is computed the sameway as themagnetostatic virtual
torque. The only difference is that the average torque over time is computed— not the net torque at
a given time. The average torque is found by integrating the instantaneous torque:
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Average Force in an Eddy Current Solution

The Lorentz force and virtual force computed for an eddy current model represent the average force,
not the instantaneous force at a specific point in the AC magnetic field's cycle. Similarly, the Lorentz
torque and virtual torque represent the average torque over time, since these torque computations
make use of the time-averaged force. The difference between the time-averaged (or DC) force, AC
force, and instantaneous force is shown below:

Force oscillates at twice the frequency of the source current andmagnetic field:

where:
l fF is the frequency of the force.
l fS is the frequency of the source current andmagnetic field.
l TF is the period of the force.

The time-averaged (or DC) force, AC force, and instantaneous force can be determined by:
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The AC force, FACmust be evaluated at a particular phase (=ωt) in order to determine itsmagnitude
at an instant in time.

Iterative Matrix Solver Technical Details
Two iterative solvers (PCGandQMR) are supported inMaxwell. The PCG is supported in the
magnetostatic and electrostatic solvers andQMR is supported in the eddy current solver.
For large simulations, the iterative solvers save significant memory - easily a factor two or more, and
may be also faster than the direct solver.
Consider thematrix equation:

(1)

where is amatrix, a right hand side and the solution.

When is computationally expensive or the exact solution is impossible, an alternative is to

seek an approximation to , with an error . The exact solution can therefore be
rewritten as:

(2)
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Substituting (2) into (1) results in the so-called residual equation:

(3)

where is called the residual defined by:

(4)

Asmentioned above, the exact solution for in (3) is impossible since it requires . However, if an

approximation is available, the error can be approximated in (3) by:

(5)

Finally, the approximation is updated by:

(6)
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It is (4)-(6) that form the foundation of the iterative solutionmethod. A matrix solver using the iterative

solutionmethod is called an iterativematrix solver. Themethod starts with an initial guess

and repeats (4)-(6) until the approximation to is within tolerance, or the number of iterations
exceeds a given number. In the former case, it is said the solution converges; while in the latter, it
doesn't.

The residual is used for measuring the closeness of to . Since and in (1) can be scaled by

the same factor without altering , so does the residual in (4). It typicallymakesmore sense to

replace as the stopping criterion with the relative residual:

(7)

where stands for vector norm.

in (5) is called a preconditioner of . A good preconditioner greatly reduces the number of iterations.

The followingmakes a good preconditioner: is a good approximation to in some sense and

is computationally cheap.
Some of the classic iterativematrixmethods include:
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l The Jacobi method where is the diagonal of .

l TheGauss-Seidel method where is the lower triangular or upper triangular matrix of .

l The successive over-relaxationmethod (SOR) where is a weighted combination of the

lower triangular and upper triangular matrix of .
Refer to the following reference for the details of iterative solvers:
Henk A. van der Vorst, "Iterative KrylovMethods for Large Linear System"Cambridge University
Press, 2003.

3D Transient Excitations (Sources)

In the 3D transient (time domain), the solver uses the formulation. Motion (translational or
cylindrical/non-cylindrical rotation) is allowed, excitations - currents and/or voltages- can assume
arbitrary shapes as functions of time, nonlinear BH material dependencies are also allowed. The
support of voltage excitations for the windings has as consequence the fact that the winding currents
are unknown and thus the formulation has to bemodified slightly to allow Maxwell to account for
source fields due to unknown currents in voltage - driven solid conductors (where eddy effects are
evaluated) and in voltage-driven stranded conductors -where the eddy effects (such as skin and
proximity effects) are ignored. Also for a simpler formulation of problemswheremotion is involved,
Maxwell uses a particular convention and uses the fixed coordinate system for theMaxwell's
equations in themoving and the stationary part of themodel. Thus themotion term is completely
eliminated for the translational type of motion while for the rotational type of motion a simpler
formulation is obtained by using a cylindrical coordinate systemwith the z axis aligned with the actual
rotation axis.
The formulation used by theMaxwell transient module supportsMaster-Slave boundary conditions
andmotion induced eddy currents everywhere in themodel, in the stationary aswell as in themoving
parts of themodel. Mechanical equations attached to the rigid-bodymoving parts allows a complex
formulation with the electric circuits being strongly coupled with the finite element part and also
coupled with themechanical elements whenever transient mechanical effects are included by users
in the solution. In this case the electromagnetic force / torque is calculated using the virtual work
approach. For problems involving rotational type of motion a "sliding band" type of approach is
followed and thus no re-meshing is done during the simulation. For translational type of motion the
mesh in the band object (surrounding the part in motion) needs to be re-created at each time step
with a degree of refinement which is dependent upon themesh size in themoving object. In this later
case themesh in both stationary andmoving objects remains unchanged as initially created by the
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user. For transient type of electromagnetic field analysis (with or without motion) the user is
responsible for creating themesh that is capable to "catch" the respective physics such as skin and
proximity effects -if any- are to be present in the resulting fields.
The following threeMaxwell's equations are relevant for transient (low frequency) applications:

The following two equations directly result from the above equations:

The final result is a formulation where vector fields are represented by first order edge elements and
scalar fields are represented by second order nodal unknowns.
Field equations are coupled with circuit equations for both solid and stranded conductors because, in
the case of applied voltage supplies, the currents are unknown. For the case of voltage driven solid
conductors, the following equation is used to account for the ohmic drop across the i-th conductor
loop:

where J0i represents the current density.
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The current density J0i corresponds to 1A of net current in loop i and vanishes outside loop i.
The induced voltage can be derived from the following equation:

where the integration is performed over the whole conductor region.
Stranded conductors are considered to be without induced eddy currents and, thus, are placed in the
non-conducting region. Thismeans that, for the purpose of calculating the ohmic voltage drop, we
cannot use the same procedure we use for solid conductors. Instead, we use a lumped parameter to
represent the DC resistance of the winding.We obtain the induced voltage due to the total flux
linkage in a similar way as for solid conductors. In both cases, it is also possible to add an external
inductance and capacitance.
For the time discretization, a backward time stepping scheme is used:

For the nonlinearities allowed in 3D transient applications, the classical Newton-Raphson algorithm
is used.
The transient solver in Maxwell supports the coil terminals andwinding definitions. Thus it is
possible to specify the number of turns of coils in models which is necessary for the calculation of
global quantities with high engineering value such as flux linkage and back emf of coils. Thus for the
3D transient solver a number of quantities are automatically calculated and displayed as 2D plots
(functions of time): voltage (current), flux linkage, back emf. Other global quantities can be also
calculated by the 3D transient solver and displayed as 2D plots such as power loss, core loss,
stranded loss, electromechanical quantities such as force/torque, speed and displacement.
A few types of sources can be used in 3D transient applications. TheCoil Terminal type is discussed
here.

Related Topics

LossQuantities
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Coil Terminals

A coil terminal excitation is the preferred excitation for Maxwell transient applications. This type of
excitation can be specified as functional (arbitrary functions of time) and is very flexible; 6 different
combinations can be used: current, voltage, and external circuit, with either solid or stranded
conductor options.
The current, stranded conductor option should be used when setting coils of constant cross-
sectionmade of strands of wire (with no eddy current effects to be taken into account in the coil). The
current can be functional and the specific variation as a function of time can be specified by the user.
When defining the function, already defined primitives such as sin( ), cos( ), exp( ), etc. can be used.
For arbitrary variations, a piecewise linear capability can also be used by defining the corresponding
dataset. You should also specify the number of winding turns.

Note When using the stranded option, coils and, more generally, each individual current path
must have a constant cross-section. However, coils and conductors that may have
different individual cross-sections can be connected in windings.

The current, solid conductor option does not carry the restriction of constant a cross-section. The
current path can have varying cross-section, and can also split as long as in the end all parallel
branchesmerge into a unique current path. You can also define a functional excitation and apply it to
the winding.
The voltage, strand option is similar to the corresponding current setting, with the obvious
difference being that now the voltage is known, while the current remains unknown. In many
situationswhen the voltage setup is used, other terminal characteristics that influence the current
calculation are also specified: for instance, series resistance, inductance, and capacitance. No eddy
current effects are taken into account, so a series resistance (DC resistance) must be specified. For
this type of source, the cross-section of each conductor needs to be constant, but the cross-section
can differ from one coil to another, and it is possible to construct windings using coils with different
cross-sections. After the solver calculates the total current, the current is uniformly distributed on the
cross-section, as it always is with a stranded option.
The voltage, solid option is chosen when solid conductors with eddy effects are part of the winding.
In this situation, eddy current effects are taken into account. If required by the application, you should
also include other characteristics of the source, such as series resistance, inductance, and
capacitance.
The external strand and external solid settings are used when the circuits attached to the
windings have an increased degree of complexity. In the case of external sources, solid or
stranded options are used, depending on whether or not eddy effects are to be taken into account.
There are normally two phases in the process of defining windings.

1. First, define the terminal(s) by selecting the planar surface(s) as appropriate for themodel,
and then assign the coil terminal excitation by specifying the orientation of the current with
respect to the terminal (current in or current out, graphically represented by an arrow). Specify
the actual number of conductors (turns) intersecting the chosen planar surface (coil terminal),
regardless of the symmetry (if any) of the problem.
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2. Right-click in the 3D Modeler window, add a new winding from the excitationmenu (no need
to select any geometry), and specify the remaining details of the setup (the screen shot below
shows a sinusoidal current with 10 A amplitude and 100 Hz frequency being used in the setup.

Note If external circuits are used in the excitation setup, they need to be created using the
Maxwell Circuit Editor before they can be assigned to windings.

Maxwell 3D Technical Notes 29-79
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

1. Right-click the winding in the property window, and specify the coil terminal(s) that belong to
the winding (unassigned coil terminals are listed and can be selected from the respective
window).
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Solution Process for a Transient Solution

The solution process for 3D transient applications poses several challenges not apparent for other
solver types. For instance, the behavior of fields ismore complex than it is for static or steady-state
applications, and a special finite element mesh structure is required in order for the software to
accurately represent the physics.

Inductance Computation for 2D and 3D Transient Solutions

Because both 2D and 3D transient solutions are nonlinear, for inductance computation, Maxwell
provides two options: apparent inductance and incremental inductance. After the FEA normal
solution is completed at each time step, the permeability associated with apparent inductance, or the
differential permeability associated with incremental inductance, of each element, is frozen – which
is equivalent to freezing the coefficient matrix (the left side of the equation to be solved). In order to
obtain winding self-inductance andmutual inductance, the solver sets an excitation current of 1A in
the first winding, while setting all other winding currents to zero (permanent magnet effects are
excluded). This excitation assignment corresponds to one source vector on the right-hand side of the
equation to be solved. As a result, the calculated flux linkage provides the self-inductance for the first
winding with 1A excitation current, and the calculated flux linkages represent mutual inductance for
all other windingswith zero current. Next, the solver excites the second winding with a current of 1A,
while setting all other winding currents to zero (permanent magnet effects are excluded). This
excitation assignment corresponds to another source vector on the right-hand side of the equation to
be solved. The solver continues this process until all windings have been assigned 1A current in turn.

Related Topics

"Matrix Computation Settings for Transient Solutions" on page 6-5

Complex Field Behavior for a Transient Solution

For 3D transient applications, the behavior of the fields ismore complex than it is for static or steady-
state applications. A diffusion of themagnetic field into thematerials occurs in 3D transient
situations. The distribution of themagnetic field inside objects typically has a number of spatial
harmonics, which usuallymeans the time step used in the analysis should be less (sometimesmuch
less) than themagnetic diffusion time constant. These time constants depend upon the geometry of
objects and also upon their respectivematerial properties. For example, for a cylinder, themagnetic
diffusion time constant of the fundamental spatial harmonic is given by the following equation:
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where is the permeability of the cylinder, is the conductivity, and a is the radius.

Special Mesh Structure for a Transient Solution

Since eddy currents are usually considered in conductive objects, a special finite element mesh
structure is required in order to accurately capture the physics. In general, a careful planning of the
(manual) meshing process is required in order to achieve an accurate solution with the available
hardware resources.

Overcoming Challenges for a Transient Solution

There are a number of applicationswhere the combined effects of magnetic diffusion and strong
eddy effects represent a significant challenge. Add the effect of nonlinearities that may also be
present, and you have the full picture of a difficult to solve application.
The following suggestions can help you overcome these challenges presented by some 3D transient
applications:

l Use symmetry whenever the problem allows it.
l Set the eddy effects only on objects where it really counts.
l In general, all unnecessary details, such as details of a geometric nature, should be
eliminated, particularly in caseswhere a large problem is the expected task.

Boundary Conditions for a Transient Solution

The behavior of theH-field at the edges of the problem space is controlled through boundary
conditions. The following boundary conditions can be assigned for a 3D transient model:

l Natural boundaries are assigned to the surface between objects.
l Neumann boundary conditions (homogeneous) are assigned to the outside faces of the
problem region.

l Odd Symmetry (Magnetic Flux Tangential)
l Even Symmetry (Magnetic Flux Normal)
l Matching
l Insulating

Default Boundary Conditions for a Transient Solution

By default, the Boundary/SourceManager automatically assigns the following boundary conditions
for a 3D transient model:
Natural boundaries are assigned to the surface between objects.
Neumann boundary conditions (homogeneous) are assigned to the outside faces of the problem
region.
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Natural Boundary Conditions for a Transient Solution

Natural boundary conditions behave the sameway as for magnetostatic or eddy (AC) problems: The
normal component of B and the tangential component of H (surfaceswithout superficial current
distribution) are continuous.

Neumann Boundary Conditions for a Transient Solution

Boundaries with Neumann conditions force themagnetic field (H) to be tangential, and themagnetic
field (and the associated energy of the field is assumed to be confined to the region with overall
Neumann boundaries. Typically, Neumann boundaries are placed at sufficient distance from the
sources of the field to avoid an over-constraint of the solution.
By default, the Boundary/SourceManager automatically applies the Neumann boundary to all faces
of the problem region— that is, surfaces exposed to the non-meshed space.

Symmetry for a Transient Solution

Symmetry boundary conditions take advantage of the symmetry of a problem.When deciding upon
the symmetry, youmust consider the geometry, as well asmaterial properties and source
distribution in space. Using symmetry boundary conditionswhen possible is very useful, particularly
in 3D transient applications, which typically require large computing resources. Two types of
symmetry are available:

l Odd Symmetry (Magnetic Flux Tangential)
l Even Symmetry (Magnetic Flux Normal)

These boundary conditions can be assigned to the faces of the problem region.

Odd Symmetry (Magnetic Flux Tangential) for a Transient Solution

Use an odd symmetry boundary tomodel a plane of symmetry in a symmetric problem in which
current on one side of the plane flows in the opposite direction than current on the other side of the
plane.

Note If the odd symmetry plane cuts through an object with eddy currents that tend to flow
normal to themagnetic flux tangent boundary, then the odd symmetry conditionmust be
explicitly applied to themodel. In this situation, you cannot rely on the default boundary
condition.

Even Symmetry (Magnetic Flux Normal) for a Transient Solution

Use an even boundary tomodel a plane of symmetry in a symmetric problem in which the direction of
current flow on both sides of the plane is the same. The currents on both sides of the plane are also
assumed to have the same variation in time.
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Examples of symmetry are shown in the following four pictures, where the inductor model presented
has three-fold symmetry:
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Matching Boundary for a Transient Solution

Matching boundaries allow you tomodel planes of periodicity where theH field on one surface
exactlymatches theH field on another by forcing themagnetic field at each location on one surface
(the "slave" boundary) to match themagnetic field at the corresponding location on the other surface
(the "master" boundary). Matching boundaries are used in periodic structures and decrease the
resources used in the computational process.
For matching boundaries, you need to set up both amaster and a slave boundary. Unlike symmetry
boundaries onmaster and slave boundaries, theH field does not need to be either tangential or
normal to these boundaries. However, theH field on the two boundariesmust have the same
magnitude and direction (or the samemagnitude and opposite direction) at each time step. The
variation in time of the fields at corresponding locations is the same onmatching (master and slave)
boundaries.
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Insulating Boundary for a Transient Solution

An insulating boundary prevents current from flowing across a surface - for instance, the interface
between two adjacent conductors. Use an insulating boundary tomodel very thin layers of insulating
material between conductors. Modeling thin insulating sheets saves you from the complications
associated with the geometry of the insulation and also speeds up the solution process.

Meshing and Band Setting Recommendations for 3D Transient
Applications With Motion
Maxwell supports three types of 3D transient problemswith motion:

l Translational motion (motion along a user specified, linear direction).
l Rotational motion (non-cylindrical such as the pivoting rotation around an axis encountered in
the armature of a relay).

l Rotational motion (cylindrical, such as the type of rotation encountered in an electricmachine
type of application).

Regardless of the particular type of motion involved, all types of motion applications require a band
object that must contain themoving part(s). If there aremultiple moving objects, all of themoving
partsmust be included in one all-inclusive object— this is because they all must bemoving as one
rigid body, with a single force acting on the assembly. Also, regardless of the type of motion, the user
must create amesh density capable of capturing the physical effects characteristic for the specific
application, such as field gradients, skin and proximity effects, etc.
In terms of meshing, themain characteristic of the first two types of motion is that, during the
analysis, a new mesh is created at each time step as themotion occurs. This re-meshed region is
always inside the band object between themoving part(s) and the stationary part(s). Themesh
corresponding to themoving part(s) and the stationary part(s) is kept fixed during the analysis. The
mesh density inside the band object is always controlled during the solution process: the edges of
any element created inside the band object during re-meshing will never be larger than the average
element edge on the entire surface of the band object where it is in contact with both themoving and
stationary parts. Thus, both themesh density created for themoving part (in the area where it
touches the band) and themesh density in the stationary part (in the area where it touches the band)
are used to actively control themesh density in the re-meshed part throughout the entire solution
process. This ensures good solution quality for any aspects conditioned by the quality of themesh.
In maximizing the quality of the solution for 3D transient applicationswith motion, a number of
observations and recommendations are available regarding the band object.
For applications with translational and non-cylindrical rotation types of motion:

l The band object can touch the symmetry plane if any exists.
l Themoving object cannot touch a stationary object duringmotion (the gap between the
moving object and the band can never become zero during analysis). The only exception to
this rule is for the particular case when both the band andmoving object surfaces touch a
symmetry plane (if any exists in the respective setup) and themoving object slides along the
symmetry plane (in this case the symmetry plane, respective band, andmoving object
surfaces coincide);
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l The band cannot have true surface faces; all facesmust be segmented (for example created
with the regular polyhedron primitive).

l The band object cannot separate the stationary part into unconnected sub-regions.

l Hollow objects cannot be used for band objects.
l Subtractions cannot be performedwithin the band object.

For the cylindrical type of rotational motion applications:
For this type of applications the band object must by somewhat larger than the rotating part(s) in ALL
directionswith only one exception, at the boundaries, which can just be touched. Thus the band
object must effectively enclose themoving part, not just by touching it, in the radial and axial
directions; so users have to leave some "room" between band and surrounding objects. The only
exceptions allowed to the requirement mentioned above are: symmetry plane (if any exists), M-S or
other boundaries as applicable for the application, can be touched i.e. at those planes it is allowed for
the band surface(s) to coincide with the respective planes.
Additionally, the following observations are also applicable:

l For the band object, always use a facetted (regular polyhedron) type of cylindrical object or a
wedge object if symmetry is used. The angular aperture of each facet depends on the
problem; however, an opening of 2-3 degrees per facet is usually sufficient.

l Hollow cylinders cannot be used for band objects.
l Subtractions cannot be performedwithin the band object.
l The band object can separate the stationary part into unconnected sub-regions (a rotor
sandwiched between two stators is allowed).
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l Non-cylindrical band objects are allowed.

Geometric Objects — Bondwires
A bondwire is a thin metal wire that connects ametal signal trace with a chip. You can choose to
draw a standard JEDEC 4-point bondwire, as shown below:
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where
h1 = the height between the bond pad point and the top of the loop.
h2 = the height between the lead point and the bond pad point.
radius = half the diameter, or thickness of the wire.

You can draw a standard JEDEC 5-point bondwire, as shown below:

where
α = the angle between the horizontal plane and the wire at the bond pad point.
β = the angle between the horizontal plane and the wire at the lead point.

When drawing the bondwire, first select the bond pad point, a point in 3D space that defines the
bond pad position in a horizontal plane. Then select the lead point, which indicates the distance the
wire covers in the horizontal plane. Maxwell uses the distance between the bond pad and lead points
to calculate the height between the bond pad and the lead point, or h2, a value that you canmodify in
theBondwires dialog box.

Related Topics

Drawing Bondwires

Healing Models
The underlying solid modeling technology used by ANSYS Electromagnetics products is provided by
ACIS geometricmodeler. Users can create directlymodels using primitives and operations on
primitives. In addition, users can import models saved in a variety of formats (Step, IGES, etc.) All
themodels are stored internally in ACIS native format (sat format). When users import models into
ANSYS Electromagnetics products, translators are invoked that convert themodels to sat format.
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ACIS regularly upgrades their solid modeling system and different versions of ANSYS
Electromagnetics products like HFSS, Maxwell, Q3D use different versions of ACIS. Third party
vendors also create files in ACIS sat format but the data in the files is in some cases not robust.
All of the above contribute to errors when amodel is read.When translating from (for example) IGES
to sat, some accuracy is lost. Not all third party vendors write files to the supported formats with a
high level of accuracy. Third party vendors sometimes create invalid sat files – the sat files are either
targeted at earlier versions of ACIS or incorporate invalid elements in the sat file. Sometimes there
are errors in reading a file generated by an earlier version of ACIS with the current version of ACIS
(for example, reading HFSS 9.2 files in HFSS 10 sometimes causes errors).
There is a final issue with using ACIS as themodeler when working with importedmodels. ACIS can
handlemixed dimensionalitymodels. It works with manifold and non-manifold bodies aswell as
sheet bodies, wire bodies and solid bodies. One of the goals of our use of the ACIS modeling system
is to create a valid volumetricmesh for simulation. Mixed dimensionalitymodels will not yield a valid
volumetricmesh. If users use ANSYS Electromagnetics products exclusively to create geometry
models, they are less likely to create invalid models. Importedmodels aremore likely to have errors
in geometry and topology definition.

Related Topics

Technical Notes: Error Types
Technical Notes: Detecting Errors
Technical Notes: Healing andMeshing
Analyzing Objects
Analyzing Interobject Misalignment
Analyzing SurfaceMesh
Healing an Imported Object
Validating Projects

Error Types

Whenmodels are imported there are two types of errors – geometry errors and topology errors.
Geometry errors are errors in definition of the underlying geometry while topology errors are errors
in how the underlying components like faces, edges and vertices are connected. These have to be
fixed beforemesh analysis can be performed.
Whenmodels pass the initial validity checks, mesh generation could still fail. If bodies in themodel
overlap, mesh will not be invoked. If bodies are very close to each other, meshmight fail. Small
features (small edges, small edges, sliver edges) might be present in the bodies whichmight cause
mesh to fail.
The following are common errors present in models:-

1. api_check_entity() errors. These are errors detected by ACIS and are geometry and topology
errors.
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2. non-manifold topology. These are non-manifold edges and vertices that are present in the
model.
Note One of the requirements for valid mesh generation is that the surfacemeshmust be

manifold, that is, a plot of all the surface triangles of a 3D solid object should not
have any “holes.” Such amesh is often referred to as awatertightmesh. If there is
a hole and you were to fill the object with water, the water would leak out of that hole
– themesh would not bewatertight. Zero-area holes (often called cracks) will also
“leak.” Havingmultiple triangles cover the same patch also results in amesh that is
not manifold.
Refer toDetecting Errors below for information on detecting and correcting such
errors.

3. Body pair intersection. This detects if pairs of bodies intersect.
4. Small feature detection – small edge length, small face area and sliver face detection.
5. Mis-aligned entities detection – detects pairs of faces from bodies that can be aligned to

remove interbody intersections. This improves the odds of mesh success.
6. Mesh failure error display. This is available for single body, body pairs and last simulation run

(all bodies in model). Errors reported by themeshingmodule are reported to the user.
Errors of type 1, 2, and 3must be resolved before themesh can be applied to themodel.

Detecting Errors

Errors in themodel can be detected by the followingmethods:
1. Perform a validation check (Maxwell3D >Validation check). This returns the following types

of errors— api_check_entity() errors, non-manifold errors, and intersection errors— and
works on all the bodies present in themodel.

2. Run an object analysis (Modeler >Model Analysis >Analyze Objects) on a subset of
bodies in themodel. This returns api_check_entity() errors and non-manifold edge/vertex
errors, and, optionally small edge, small face and sliver face detection errors.

3. Run an interobject misalignment analysis (Modeler >Model Analysis >Analyze
Interobject Misalignment). This yields face pairs from different bodies that are slightly
misaligned with respect to each other. Thismisalignment causes the faces to intersect each
other or to create small volumetric portion between the bodies that might causemesh to fail. If
these faces are aligned— that is, the faces aremade to share the same surface definition—
then the gap between the faces is eliminated and there is a higher likelihood that themesh will
succeed.

4. Run a surfacemesh analysis (Modeler >Model Analysis >Analyze Surface Mesh). For
the selected bodies, amesh is invoked on each individual body and, optionally, on body pairs.
Errors from running themesh analysis are displayed, helping you focus on bodies/body pairs
that fail meshing. If these are fixed, there is a higher probability that themesh will succeed.

5. Mesh errors from the last simulation run are displayed.
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Errors for 2, 3, 4 and 5 are displayed in theModel Analysis dialog box. Using themenu items for 2,
3 and 4 displays the dialog box. This dialog box can also be opened by clickingModeler >Model
Analysis >Show Analysis Dialog.

Healing and Meshing

Potential problems with 3D Models
This section lists problems that can prevent a 3D model from beingmeshed successfully.
Subsequent sectionswill describe how these problems can be detected and addressed.

ACIS errors
The underlying solid modeling technology used by ANSYS Electromagnetics 3D productsMaxwell,
HFSS andQ3D is provided by the ACIS geometricmodeler. You can createmodels directly in the
drawing environment of these ANSYS Electromagnetics products using primitives, such as boxes,
cylinders, etc. and operations on primitives, such as Boolean operations. In addition, you can import
models produced by other CAD tools in a variety of formats such as STEP, IGES, etc. In ANSYS
Electromagnetics 3D products, all models have to be stored internally in ACIS' native format, known
as sat format. When you import models into ANSYS Electromagnetics products, translators are
invoked that convert themodels to sat format. Often, models that were created in other CAD tools
were created initially for other purposes than electromagnetic analysis, such as,. for mechanical
design or just for display purposes. Theymay have imperfections that make them illegal to ACIS.
Further, there can be compatibility issues between different versions and even flavors of modeling
tools. All this can lead to errors in imported 3D models.
If you use ANSYS Electromagnetics products to create geometrymodels, and thereby avoidmodel
import and translation, you are unlikely to encounter such problems.

Mixed dimensionality
Even if a model is imported and translated without errors, there is a restriction to be aware of. ACIS
can handlemixed-dimensionalitymodels. One of the goals of ANSYS Electromagnetics use of the
ACIS modeling system is to create a valid volumetricmesh for simulation. Mixed-dimensionality
models will not yield a valid volumetricmesh. Therefore, the ANSYS Electromagnetics tools will not
mesh objects with mixed dimensionality, so-called non-manifold objects. For instance, imagine a 3D
object representing a curvedmetal plate with a small but finite thickness. If it reaches zero thickness
somewhere while having non-zero thickness elsewhere, it hasmixed dimensionality, 2D aswell as
3D. You will get an error message saying that the object is nonmanifold. Of course, 2D and 3D
objects can co-exist in amodel, but any one object cannot be both 2D and 3D.

Intersecting objects
Another restriction is that ANSYS Electromagnetics 3D tools do not allow partial intersections (also
known as partial overlaps) between 3D objects. Each element of themesh has to belong
unambiguously to one object. There is no problem if one object is enclosed completely inside a
bigger object, but partial intersections lead to ambiguities. As long as there are partial object
intersections, themesh generator will not attempt to create amesh. Instead, you will get an error
message notifying you which objects are intersecting. Youmust remove the intersections before you
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can proceed. You can do this by changing the shapes of objects slightly, or by subtracting one object
from the other.
Caveat: If, as a result of a subtraction, themodel has pairs of true surfaces that are coincident (that
is, smooth curved surfaces that fit exactly one inside the other), youmake it harder for themesh
generator to create amesh. This is because ACIS creates segmentations on each of these surfaces,
and these segmentations are not guaranteed to fit. Setting a small value for Surface Deviation under
Mesh Operations>Assign>Surface Approximation increases your chance of success in such a
case, but it is better to avoid such situations if you can.

Small features and misalignment
When there are no ACIS errors in themodel, no non-manifold objects and no partial object
intersections, themesh generator can be invoked to create a valid mesh for the electromagnetic
analysis. Even if the geometry is valid, mesh generation can still fail. Possible causes are the
presence of very short edges, very small faces, long and thin sliver faces, and slight misalignments
between faces that are supposed to be coincident.

Related Topics

Technical Notes:Detecting and AddressingModel Problems to ImproveMeshing

Detecting and Addressing Model Problems to Improve Meshing

The following sections describe a systematic procedure to detect and addressmodel problems that
can interfere with themeshing process.
Technical Notes:Healing During Geometry Import
Technical Notes:Healing After Geometry Import
Technical Notes:RemovingObject Intersections
Technical Notes:Removing Small Features
Technical Notes:Aligning Objects
Technical Notes: Troubleshooting if Meshing Still Fails

Stage One: Healing during geometry import

In case you do not draw your entire geometry in the ANSYS Electromagnetics environment but wish
to import (part of) it, in the Import Filewindow you select which geometry file to import. At the
bottom of this window is a check box "Heal Imported Objects". Twomodes exist, "auto" and
"manual". Auto Healing will try to address ACIS errors and non-manifold errors, the first two classes
of potential problems listed earlier. It will also fix surface normals in the body and updating orientation
of body, to avoid having a bodywith negative volume.
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Manual healing adds small-feature removal to this. You can remove small features at this stage if you
wish. However, the usual approach is to apply auto-healing at this stage and leave small-feature
removal until later.

Stage Two: Healing after geometry import

Healing can only be performed on objects that have no drawing history other than "import". If
necessary, object history can be deleted throughModeler >Purge History. If that causes a
warning that another object will be deleted, youmay need to purge the history of that other object
first, or purge the histories of several objects simultaneously.
At any time after import, you can perform a Validation Check:Maxwell3D >Validation Check. This
will enable you to focus on bodies and body pairs that need attention before amesh can be created.

1. Select the objects that have ACIS errors, such as failing api_check_entity(), and the objects
that have non-manifold features, i.e. mixed dimensionality.

2. InvokeModeler >Model Analysis >Analyze Objects.
This will bring up anOptions dialog to set thresholds for small feature detection and on
completion, the Model Analysis dialog is displayed. All bodies in themodel are shown in the
objects grid along with their status. Bodies can have the following status:
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1. Good
2. Null Body
3. Analysis not performed
4. Invalid entities found
5. Small-entity errors

Invalid-entity errors are ACIS errors and non-manifold errors. Small-entity errors are small faces,
sliver faces and small edges that are optionally detected based on user-defined parameters.

Note Invalid-entity errorsmust be fixed before amesh can be
generated.

To fix invalid entity errors:
1. Choose the bodies that have "Invalid Entities Found."
2. In the samewindow, choosePerform->Heal Objects, with or without an optional setting for

small-feature removal.
In most cases, the bodies will be healed and the errors fixed.

3. If errors still persist, choose "offending" faces and edges and click onDelete.
This will replace the selected face/edge entity by a tolerant edge/vertex respectively.

In order to avoid unintended changes, it is good practice to do the following:
1. At the bottom of theModel Analysiswindow, check the box "Auto Zoom to Selection."
2. Select one face or edge at a time
3. Decide for each face and edge whether you want to delete it.
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Note Healing causes changes to the geometry and topology of the body being healed.
Validation check has to be re-run after healing is done to identify body pairs that intersect. It
is possible that after healing, bodies that were disjoint before now overlap.

In some cases the replacement of the face/edge by tolerant edge/vertex will fail. If the object remains
invalid, you know at this point what parts of the object are invalid. You will need to change that part of
the object manually, either in ANSYS Electromagnetics drawing environment or in the original CAD
tool, to make it pass. Often, the invalid entities are in small details that can be changed without
noticeably affecting the results of the electromagnetic analysis. For example, it may be possible to
create a small object, well placed in the "offending" region, and to unite it with or subtract it from the
problematic object, such that the "offending" details no longer exist.

Stage Three: Removing Object Intersections

If there are any intersecting objects, a Validation Checkwill list them. Youmust eliminate object
intersections before amesh can be created.
In complicatedmodels, beforemaking changes, it is good practice to inspect the overlap visually. A
way to do this is to:

1. Duplicate both objects and place the copies outside themodel.
2. PerformBoolean Intersect on the copies.

This will show you what causes the intersection and will help you decide how to remove it.
3. Then, delete the copies.

The easiest way to eliminate object overlap is to subtract one object from the other, in the order that
leaves the desiredmaterial in the region of overlap. If the overlap is very small and you can choose
the order of subtraction, choose one that does not create coincident true surfaces, if possible.
Caveat: if as a result of a subtraction themodel has pairs of true surfaces that are coincident, that is,
smooth curved surfaces that fit exactly one inside the other, you will make it harder for themesh
generator to create amesh. This is because ACIS will create segmentations on each of these
surfaces, and these segmentations are not guaranteed to fit. Setting a small value for Surface
Deviation underMesh Operations>Assign>Surface Approximation increases your chance of
success in such a case, but it's better to avoid such situations if you can.
A way to eliminate object intersectionswithout subtraction is to split one object in parts, in such a way
that some parts are completely enclosed in the other object, and some parts are completely outside
the other object. Even for complicated objects, this is possible through a sequence of Boolean
operations on the objects and copies of the objects.
At this point, the geometry has no ACIS errors, no non-manifold objects and no partial object
intersections. A mesh can be created for the electromagnetic analysis.

Stage Four: Removing Small Features

Even though, in principle, the geometrymay be ready for amesh to be created, it is possible that
small features in the geometry lead to amesh that is unnecessarily large and contains long and thin
tetrahedra that make the simulation converge slower. Small featuresmay even cause themesh
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generation to fail. By small, wemean details on an object that are thousands of times smaller than
themain features of the object, and that, in most cases, are unintended consequences of the
drawing history in another CAD tool. Therefore, it is advantageous to remove small features.
To do this, youmay need to purge the history of objects, since healing and related operations can
only be performed on objects without history beyond import. Youmay have noticed that you could
have invoked small-feature removal at several earlier stages. There is no objection to doing it earlier.
The reason why it is presented here as stage four is that the previous stageswere necessary while
this one is optional.
To start the small-feature removal:

1. Select objects and invoke object analysis throughModeler >Model Analysis >Analyze
Objects.
Alternatively, without objects selected, useModeler >Model Analysis >Show Analysis
Dialog >Objects and select objects from the list. In theModel Analysis window, invoke
Perform >Analyze Objects.
The software will report the smallest edge length and the smallest face area, and enable you
to set thresholds for the detection of short edges, small faces and sliver faces.

2. Upon clicking OK, the analysis is performed.
As a result of the analysis, the software presents a list of all faces and edges that do not meet
the thresholds set by you.

3. Check the box "Auto-Zoom to Selection" at the bottom of theModel Analysis window and click
on small faces and short edges in the list.
Inspect them visually and decide whether they can be deleted. It is good practice to delete
them one by one rather than deletingmany at once in order to prevent unintended changes.
Sometimes, an edge or face cannot be deleted, and you get amessage notifying you. In that
case, either ignore it, or revisit it after deleting some other details first, or revisit it later
manually in the 3D drawing environment.
At this point, the geometry has no ACIS errors, no non-manifold objects and no partial object
intersections. Furthermore, there are fewer small features that were unintended or
unimportant for the electromagnetic analysis, so the quality of themodel has improved.

Stage Five: Aligning Objects

Objects that touch each other in imported geometries do not always have well-aligned faces. Often,
this is a consequence of the limited level of precision in the imported file. Misaligned faces can cause
tiny object intersections or tiny gaps between objects, which in turn can lead to an inefficient mesh or
even a failure to create themesh.
To repair such occurrences in an automated way, you can select groups of objects and invoke
Modeler >Model Analysis >Analyze Interobject Misalignment. This will yield face pairs from
different bodies that are slightlymisaligned with respect to each other.
In the window that shows this list, check the box "Auto-Zoom to Selection" and select face pairs
from the list. When you decide that faces should be aligned, click Align Faces. In some cases, face
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alignment will fail if the topology of the bodywould change by a large amount after alignment. In that
case, you can decide to ignore it, as it may not be a problem, or revisit it later manually in the 3D
Modeler environment.

Note In complicatedmodels, the Interobject Misalignment analysis can take a long time if you
select all objects before launching the analysis. If you do not know which pairs of objects to
analyze, just let themesh generator try to make amesh. If themesh fails, a list is presented
to you of misalignments that themesh generator finds suspicious but did not want to adjust
without permission. Not everymisalignment in the list is always a problem: this is a list of
features that might need your attention.

Note As facemisalignments between touching objects can cause small object intersections, this
alignment capability can already serve a useful role in stage three.

Stage Six: Troubleshooting if meshing still fails

If mesh generation fails, information about the reasons for the failure is presented underModeler
>Model Analysis >Show Analysis Dialog >Last Simulation Mesh.
Again, check the box "Auto Zoom to Selection" and click on the errors in the list. This can give you
hints about which parts of themodel are causing difficulties.
For instance, theremay be self-intersecting bodies or faces. Such errors can have a variety of
causes, such as a face that is supposed to be planar, but of which the vertices do not quite lie in the
same plane.When you zoom and search you are likely to see what causes the problem.
Also, theremay be facemisalignments. Once you know they exist, you can inspect them and decide
whether to align them under the ObjectsMisalignment tab.
One of the tabs of theModel Analysiswindow is theSurface Mesh tab. Under that tab, you can try
to create surfacemeshes for objects and pairs of objects. Since a surfacemesh on selected objects
is easier to create than a volumemesh for the wholemodel, this can help you to identify quickly which
objects are causing difficulties and why.
Also, in order to determine which objects are causing difficulties, you can exclude objects temporarily
from themodel. If themesh succeedswithout them, this helps to identify the reason for failure. To
exclude an object temporarily, select it and uncheck "Model" in its properties window. Then try to
create themesh again.
Once you know which objectsmake themesh fail, you can try to make small changes to them that do
not affect the electrical properties noticeably but help themeshmaker succeed. For example:

l Zoom in on details and consider removing details;
l Find coincident true surfaces andmove one of the faces over a very short distance so the pair
of faces is not coincident anymore;

l Split very complicated objects intomultiple less-complicated objects;
l Delete a complicated 3D ground object and create a 2D ground through a boundary condition
on the appropriate faces of a dielectric;

l Replace imported objects by objects drawn in ANSYS Electromagnetics 3D modeling
environment. For instance, someCAD tools produce cylinders that consist of two half
cylinders that have a seamwhere they join. The fit is not always perfect.
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Finally, for coincident true surfaces, set a very small value for Surface Deviation underMesh
Operations > Assign > Surface Approximation. ACIS will give themmore segments, but you
can compensate for that withModel Resolution. In a parametric sweep, you can experiment with
settings for Surface Deviation andModel Resolution.

Related Topics

AnalyzeObjects
Analyze Interobject Misalignment
Analyze SurfaceMesh
Healing
Validating Projects

Handling Complicated Models

Complicatedmodels, often imported from aCAD tool or layout tool, may slow down the interface,
use a lot of RAMduring file I/O and other operations, contain imperfections and object overlaps.
After analysis, post processing of suchmodelsmay be time consuming. Maxwell has several options
and features that address these problems.

l InterfaceOptions for ComplicatedModels
l Geometry Imperfections and ComplicatedModels
l Object Overlap Settings for ComplicatedModels
l Post Processing Settings for ComplicatedModels

Interface Options for Complicated Models

To improve the speed of the interface when dealing with complicated geometries, do the following:
Under Tools>Options>Modeler Options, on theDisplay tab...

l Set "Default View Render" to "Wire Frame". Wire-frame rendering is faster than shaded
rendering.

l Turn off "Display UV Isolines". For models with curved faces, this will simplify the wire-frame
display, so the rendering will be faster.

l Turn off "Visualize History of Objects". This will remove visualization of objects that are part of
themodel history. For largemodels, this is faster and uses lessmemory.

Under View>Visualization Settings
l Use larger deviations to view curved objects in less detail.

UnderModeler>Import
l Uncheck "CheckModel" and "Heal Imported Objects." This helps for complicatedmodels:
Validation and healing take considerable time for suchmodels. Use this option to defer
checking to a later stage (especially in caseswhere you know that you want to mesh the
model as is).

Under Tools>Options>General Options, on theProject Options tab…
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l Turn off "Do Autosave" or set the autosave interval to a larger value, for example, 50. Auto-
save can be time consuming.

Geometry Imperfections and Complicated Models

Modeler>Import
Many formats can be handled. It is recommended to import a version of the geometry that is as close
as possible to its source, rather than geometries that have been translated before from one format to
another, or that have been imported into another computational tool and later exported from it.
Modeler>Validation Settings
Geometry imperfections are listed as ACIS errors when executingMaxwell3D>Validation Check
and when starting an analysis. It is recommended to attempt to heal objects with such errors.
However, Maxwell enables you to bypass the errors (not the check itself) by choosing a setting under
Modeler>Validation Settings. "Warning Only" enables you to ignore all errors. "Basic" enables
you to bypass all but themost severe errors. TheMaxwell mesh generator has been enhanced to
handlemany geometry errors.

Object Overlap Settings for Complicated Models

In theSet Material Override Tab in theMaxwell3D>Design Settings menu...
Complicated geometries often have small object overlaps. This setting will allow overlaps between
dielectrics andmetals. In the overlap region, themetal will locally take priority over the dielectric, as if
this part of the dielectric has been subtracted. Overlaps between two dielectrics and overlaps
between twometals are still not allowed.

Post Processing for Complicated Models

Under Tools>Options>General Options, on theMiscellaneous Options tab...
l Turn off "Dynamically update postprocessing data during edits". This will disable expensive
updating of existing reports and plots.

l Turn off "Update reports on file open". This will disable expensive updating of reports and plots
when opening a project.

Materials
This section of the Technical Notes includes information on the followingmaterial properties:
Simple Materials

l Relative Permeability
l Relative Permittivity
l Bulk Conductivity
l Dielectric Loss Tangent
l Magnetic Loss Tangent
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Frequency Dependent
l Frequency-dependent material properties.
l DebyeMaterials

Anisotropic materials
l Anisotropicmaterials
l Anisotropic relative permeability tensors
l Anisotropic relative permittivity tensors
l Anisotropic conductivity tensors
l Anisotropic dielectric loss tangent tensors
l Anisotropicmagnetic loss tangent tensors
l Anisotropicmaterials and ports

Ferrite materials
l Magnetic Saturation
l LandeGFactor
l Delta H

Magnetostrictive materials
l MagnetostrictionModeling of Nonlinear MagneticMaterial

Relative Permeability

The permeability of dielectrics is assumed to be complex, as follows:

The relative permeability is a dimensionless quantity, defined as follows:

where µ0 is the permeability of free space.
The permeability can also be expressed as

where µ′ is the real portion of µ and µ′′/µ′ is themagnetic loss tangent.

Relative Permittivity

The permittivity of dielectrics is assumed to be complex, as follows:
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which can also be expressed as

where ε′ is the real portion of ε and fromwhich the relative permittivity is defined as:

where ε0 is the permittivity of free space.

ε′′/ε′ is the dielectric loss tangent.
If a material’s losses due to bulk conductivity will be significant, such as in semiconductor dielectric
materials, an additional bulk conductivity value, σ, must be added. From the time harmonic form of

Maxwell’s equations, the complex permittivity, εc is defined as

where

Bulk Conductivity

Maxwell is capable of including conductivity in themodel either as a bulkmaterial loss factor, similar
to dielectric loss tangent, or as an impedance boundary condition applied to the outer surfaces of the
object. The choice of bulkmaterial loss instead of the boundary condition ismade by selectingSolve
Inside in thePropertieswindow.
The choice between bulkmaterial loss and the surface boundary condition is problem dependent.
The boundary condition should be applied whenever the conductor ismuch thicker than the skin
depth at the solution frequency. In this case, the unknownswithin the conductor are not included in
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the unknown vector, resulting in a smaller matrix and a faster analysis. However, if the conductor is
not thick relative to the skin depth, the bulkmaterial conductivitymust be used to arrive at an
accurate solution. With this assumption, the wave equation reduces to

Dielectric Loss Tangent

To represent a dielectric that dissipates the power of a high-frequency electric field, enter a dielectric

loss tangent, ε′′/ε′, property value for thematerial. The smaller the loss tangent, the less lossy the
material.
The dielectric loss tangent may vary with frequency. To simulate the variances, define a function for
the dielectric loss tangent.

Magnetic Loss Tangent

To represent amagneticmaterial such as ferrite that dissipates the power of a high-frequency
magnetic field, enter amagnetic loss tangent, µ′′/µ′, property value for thematerial. The smaller the
loss tangent, the less lossy thematerial.

Note If you plan to do a fast frequency sweep for a design that includes dielectrics, make sure
that the dielectric or magnetic loss tangent does not vary significantly over the requested
frequency range. If they do, the resultsmay not be what you expect. In caseswhere the
loss tangent does vary significantly over the frequency range in which you are interested,
copy and solve the design several times, adjusting the loss tangent and associated
frequency range for the copied design so that the loss tangent is relatively stable over the
design’s requested frequency range.

Imaginary Permeability
EddyCurrent
Somematerials exhibit a permeability that includes both a real and imaginary component. The
imaginary component is used tomodel magnetic losses in a time-varying field using the relationship:

where:

is the real component of the relative permeability.

is the imaginary component of the relative permeability.
is the permeability of free space.
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As shown below, a complex relative permeability causes the B field to lag behind the H field – similar
to the behavior of a nonlinear, lossymaterial. The power loss during this cycle (the color shaded
area) is approximately equal to the hysteresis loss (the area within the blue lines). The hysteresis
curve for amaterial with a constant, real permeability (the straight yellow line) is shown as a
reference.

When the nature of losses is also due tomagnetic hysteresis, Maxwell allows you tomodel such
effects using complex permeability by allowing the specification of the tangent of magnetic loss.
When a linear material exhibits hysteresis effects, it should be characterized using a complex
permeability, as below:

where is themagnetic loss tangent,
Enter the imaginary relative permeability of amaterial, μ’’, in the Imag. Permeability field. The
default imaginary permeability of zero is that of amaterial that exhibits nomagnetic loss in a time-
varying field.

Ferrite Materials

Ferrite materials are used tomodel the interaction between amicrowave signal and amaterial
whosemagnetic dipolemoments are aligned with an applied bias field. The gyrotropic quality of the
ferrite is evident in the permeability tensor which is Hermitian in the lossless case. The Hermitian
tensor form leads to the non-reciprocal nature of the devices containingmicrowave ferrites. If the
microwave signal is circularly polarized in the same direction as the precession of themagnetic
dipolemoments, the signal interacts strongly with thematerial. When the signal is polarized in the
opposite direction to the precession, the interaction will be weaker. Because the interaction between
the signal andmaterial depends on the direction of the rotation, the signal propagates through a
ferrite material differently in different directions.
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If you assign a ferrite material to an object, youmust assign amagnetic bias source to the object.

Magnetic Saturation

Amaterial with a non-zeromagnetic saturation is considered to be a ferrite. When a ferrite is placed
in a uniformmagnetic field, themagnetic dipolemoments of thematerial begin to align with the field.
As the strength of the applied bias field increases, more of the dipolemoments align. Themagnetic
saturation,Ms, is a property that describes the point at which all of themagnetic dipolemoments of
thematerial become aligned. At this point, further increases in the applied bias field strength do not

result in further saturation. The relationship between themagneticmoment,M and the applied bias
field,H, is shown below.

Themagnetic saturation, 4πM, is entered in gauss.

Lande G Factor

The Lande g factor is a ferrite property that, on amicroscopic level, describes the total magnetic
moment of the electrons according to the relative contributions of the orbital moment and the spin
moment. When the total magneticmoment is due entirely to the orbital moment, g is equal to one.
When the total magneticmoment is due entirely to the spinmoment, g is equal to two. For most

microwave ferrite materials, g has a range from 1.99 to 2.01. The Lande g factor is dimensionless.

Delta H

Delta H is the full resonance line width at half-maximum, which ismeasured during a ferromagnetic
resonancemeasurement. It relates to how rapidly a precessional mode in the biased ferrite will
damp out when the excitation is removed. The factor ∆Η doesn’t appear in the permeability tensor;
instead, the factor α appears. The factor α is computed from
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The factor α changes the κ and χ terms in the permeability tensor from real to complex, whichmakes
the tensor complex non-symmetric (where it had been hermitian for lossless ferrites).
Enter the full resonance line width at half maximum in theDelta H value box. Delta H ismeasured at
a specific frequency. That frequency needs to be entered by the user at the interface. 9.4 Ghz is the
frequencywhere Delta H is typicallymeasured.

Anisotropic Materials

Anisotropicmaterials have characteristics that vary with direction. These characteristics are defined
by their anisotropy tensors. Youmust define three diagonals each for anisotropic permittivity, electric
loss tangent, conductivity, permeability, andmagnetic loss tangent. Each diagonal represents a
tensor of your model along an axis. The alignment of thematerials axis with respect to the object is
discussed in AssigningMaterial Property Types.
The following anisotropic characteristics can be defined:

l Anisotropic relative permeability tensors
l Anisotropic relative permittivity tensors
l Anisotropic conductivity tensors
l Anisotropic dielectric loss tangent tensors
l Anisotropicmagnetic loss tangent tensors
l Anisotropicmaterials and ports

Related Topics

AssigningMaterial Property Types
Setting Coordinate Systems
Creating a Relative Coordinate System
Change theOrientation of an object
Relative Permeability
Anisotropic Relative Permeability Tensors
Relative Permittivity
Bulk Conductivity
Dielectric Loss Tangent
Magnetic Loss Tangent

Anisotropic Relative Permeability Tensors

The relative permeability tensor for an anisotropicmaterial is described by
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where
l µ1 is the relative permeability along one axis of thematerial’s permeability tensor.
l µ2 is the relative permeability along the second axis.
l µ3 is the relative permeability along the third axis.
l µ0 is the permeability of free space.

The relationship betweenB andH is:

To specify the relative permeability for an anisotropicmaterial, enter the µ1, µ2, and µ3 values in the
Value boxes of the T(1,1), T(2,2), and T(3,3) rows, respectively. If the relative permeability is the
same in all directions, use the same value for µ1, µ2, and µ3.These values can also be entered as
variables.

Anisotropic Relative Permittivity Tensors

The relative permittivity tensor for an anisotropicmaterial is described by

where
l ε1 is the relative permittivity of thematerial along one tensor axis.
l ε2 is the relative permittivity along the second axis.
l ε3 is the relative permittivity along the third axis.
l ε0 is the permittivity of free space.

The relationship betweenE andD is then
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To specify the relative permittivity for an anisotropicmaterial, enter the ε1, ε2, and ε3 values in the
Value boxes of the T(1,1), T(2,2), and T(3,3) rows, respectively. These values can also be entered
as variables.

Anisotropic Conductivity Tensors

The conductivity tensor for an anisotropicmaterial is described by

where
l σ1 is the relative conductivity along one axis of thematerial’s conductivity tensor.
l σ2 is the relative conductivity along the second axis.
l σ3 is the relative conductivity along the third axis.

The relationship between J andE is then:

To specify the conductivity for an anisotropicmaterial, enter the σ1, σ2, and σ3 values in theValue
boxes of the T(1,1), T(2,2), and T(3,3) rows, respectively. The values of σ1 and σ2 apply to axes that
lie in the xy cross-section beingmodeled. The values of σ3 apply to the z-component. These values
affect current flowing in dielectrics between the conductors. These values can also be entered as
variables.

Anisotropic Dielectric Loss Tangent Tensors

The dielectric loss tangent tensor for an anisotropicmaterial is described by
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where
l tanδ1 is the ratio of the imaginary relative permittivity to the real relative permittivity in one
direction.

l tanδ2 is the ratio of the imaginary relative permittivity to the real relative permittivity in the
second direction.

l tanδ3 is the ratio of the imaginary relative permittivity to the real relative permittivity in the third
orthogonal direction.

l , , and are the real relative permittivities specified earlier.ε
The relationship betweenD andE will then be
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To specify the electric loss tangent for an anisotropicmaterial, enter the tanδ1, tanδ2, and tanδ3
values in theValue boxes of the T(1,1), T(2,2), and T(3,3) rows, respectively. These values can also
be entered as variables.

Anisotropic Magnetic Loss Tangent Tensors

Themagnetic loss tangent tensor for an anisotropicmaterial is described by

where
l tanδM1 is the ratio of the imaginary relative permeability to the real relative permeability in one
direction.

l tanδM2 is the ratio of the imaginary relative permeability to the real relative permeability in the
second direction.

l tanδM3 is the ratio of the imaginary relative permeability to the real relative permeability in the
third orthogonal direction.
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l , , and are the real relative permeabilities specified earlier.
The relationship betweenB andH will then be

To specify themagnetic loss tangent for an anisotropicmaterial, enter the tanδM1 , tanδM2, and
tanδM3 values in theValue boxes of the T(1,1), T(2,2), and T(3,3) rows, respectively. These values
can also be entered as functions.

Anisotropic Materials and Ports

An anisotropicmaterial can be in contact with a port under the following conditions:
l One principal axis of the anisotropicmaterial is aligned normal to the port.

Frequency-Dependent Material Properties

The properties of somematerials vary with the frequency of the field excitation. This frequency
dependence is often linear within a certain frequency range and constant outside of the frequency
range, as shown below,
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where
l epsrlower is the relative permittivity of amaterial below the frequency range 20 - 50GHz.
l epsrupper is the relative permittivity of amaterial above the frequency range 20 - 50GHz.
l flower is the lower frequency, below which thematerial property is constant.
l fupper is the upper frequency, above which thematerial property is constant.

In general, to account for this variance within a given frequency range, use thePiecewise Linear
Material Inputwindow dialog box to specify a property’s values at frequencies below and above the
frequency range. Based on these values, Maxwell automatically creates a linear dataset that
specifies the property’s values at the desired frequencies during solution generation. This dataset
can bemodified with additional points if desired.

Debye Materials

If thematerial is a lossy dielectric with a lower frequency near DC, use the Loss Model Material
Input dialog box to specify thematerial’s conductivity at DC or, if you prefer, its loss tangent value at
the lower frequency. Maxwell also enables you to specify the lossy dielectricmaterial’s high
frequency/optical permittivity.
In materials commonly encountered inmicrowave applications ion and dipole polarization dominate.
These polarization types can be described byDebye’s relaxation polarizationmodel:

where
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τ= the relaxation time.
εrstatic = the static permittivity.
εroptical = the high frequency/optical permittivity.
Maxwell uses the values you specify in the Loss Model Material Input dialog box in Debye’s
equation above to determine the relative permittivity at any frequency.
Debye’smodel is valid for most microwave applications. If the frequency exceeds the limit of Debye’s
model, other models that take atomic and electron polarization into account are available.
Frequency-dependent materials are appropriate for problems solved using a discrete or
interpolating sweep. In a fast sweep, frequency dependent material properties are evaluated at the
center frequencywhichmay result in less accurate results at the sweep extremes, depending on the
sweep range and frequency dependence of material property.
In the simulation of high speed connectors or PCB boards, it is important to take the losses into
account. Especially, in the case of transient analysis, where the improper specification of the
frequency dependence of thematerials would lead to unphysical results. This section discusses the
lossmechanism of dielectricmaterials. Magnetic losses could also be taken into account, but
materials commonly encountered in these applications are non-magnetic.
A lossy dielectricmaterial is characterized by twomeasured values at a certain frequency: dielectric
constant εr and loss tangent tgδ. There are two problemswith the specification of the frequency
dependence of dielectricmaterials:

l The frequency range, in which the solution has to be calculated, ismuch wider than the range
wheremeasuredmaterial data are available. It is very common to have just twomeasured
points. A low frequency point, which can be taken asDC value and a higher frequency point,
which serves to describe the behavior of thematerial at high frequency. The question arises:
What is an appropriatemodel across themeasured range aswell as outside themeasured
range?

l Ameasurement always suffers from errors. If themeasured data are not consistent, it could
cause unphysical effects during the time domain analysis. A question arises again: how to
checkwhether themeasured data are consistent, and how to adjust them if they are not.

To answer the questions raised we need to discusses the polarization lossmechanism of dielectric
materials.
Figure 1 shows the different polarizationmechanisms occur in the frequency domain. It can be seen
from the figure that up to themicrowave region, ion and dipole polarization dominate. These
polarization types can be described byDebye’s relaxation polarizationmodel:

(1)

where
τ is the relaxation time,εrstatic,and εroptical are the static and high frequency permittivity, respectively.
Debye’smodel is valid for themost of microwave applications. If the frequency exceeds the limit of
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Debye’smodel, there exists other models which take the atomic and electron polarization into
account [1].

Figure 1: Polarization mechanisms
The question is now how to fit Debye’smodel to the actual material characteristics. In order to do
this, let us express the real part of the dielectric constant and the conductivity fromEq. (1):

(2)

(3)

where
σo is the DC conductivity.
Eqs (2) and (3) have 4 parameters: σo, εrstatic, εroptical and τ.
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Usually, measured data are available at two frequencies for a regular material. Themeasured data
are the dielectric constant and the loss tangent. One set of themeasured data is at low frequency

( , ) and the other set is at higher frequency ( , ).
The static or dc values can be considered as the low frequencymeasured data. So,

(4)

and

(5)

The critical need is to predict the high frequency behavior of thematerial.
If we know εroptical frommeasurement, the high frequency behavior of Debye’smodel is set. We just
need to calculate the relaxation time as:

(6)

where

(7)

and
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(8)

Knowing τ, Eqs. (2) and (3) prescribe thematerial characteristic in the whole frequency region.
If we do not know εroptical , it can be calculated by simultaneously solving the following two equations
to get εroptical and τ:

(9)

(10)

where εr2 is measured and σ2is determined by Eq.(8).
Solving equations (9) and (10), we get:

(11)

Thismethod also yields the parameters of the Debye’smodel, but the accuracy of themethod,
especially at high frequencies, depends on the accuracy and the consistency of themeasurement at
frequency f2.
Typical Debye’smodel material characteristics can be seen in Fig. 2, where ε' = εr.
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(12)

(13)

Figure 2: Material characteristics of a Debye model
Themodel was verified by using a double strip line filled by FR4material. A 10mils section of the line
wasmodeled byHFSS and de-embedded into a 34 inch long line. The structure of HFSSmodel can
be seen in Fig. 3.
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Figure 3: A 10 mils long structure of a double strip line
The input data panel of HFSS for FR4 can be seen in Fig. 4:

Figure 4: Input data panel for FR4 material in HFSS
It can be seen from the panel that:
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The calculated andmeasured frequency response of S12 can be seen in Fig. 5. The agreement
between the calculated andmeasured values is good.
The transient response of the line to an input pulse also has been calculated. The schematic
arrangement of themodel in Maxwell Spice is shown in Fig. 6. The output signal is plotted in Fig. 7.
The green curve is the transient response of an ideal reference line (lossless) of the same length.

Figure 5: Calculated and measured frequency response of S12
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Figure 6: Schematic arrangement in Maxwell Spice
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Figure 7: Transient response by Maxwell Spice
Debye’smaterial lossmodel predicts the dielectric losses in the whole frequency range within an
acceptable accuracy. Themodel can be set up by using low frequency and higher frequency
measured dielectric constants and loss tangents and the optical dielectric constant. If the latter is not
available, themodel might be less accurate at high frequencies. Using Debye’smodel, no unphysical
phenomena can be observed at the transient response.
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Magnetostriction Modeling of Magnetic Material

Magnetostriction was first observed by J. Joule in 1842. Currently it is typically described as
"deformation of a body" as a result of itsmagnetization. The elongation or contraction in the direction
of appliedmagnetic field is usually between 10-5 and 10-3 and accompanied by the opposite sign
changing in the transverse direction, so that the volume remains almost the same. The phenomenon
of magnetostriction can be regarded as an energy transduction (or transformation) frommechanical
to magnetic and vice-versa. It can be described as a bidirectional magneto-mechanical coupling
between themechanical andmagnetic fields in themagnetostrictivematerial. The origin of this
phenomenon can be traced to the alignment of themagnetic domains inside thematerial. The
following figure is a schematic of the effect simplified to one dimension.When nomagnetic field is
applied to the system, the series of domains have randomly orientedmagneticmoments. Whereas
when amagnetic field is applied, the series of domains rotate to partially align themselves to the
magnetic field direction resulting in a change in length ∆l. Applying a sufficiently highmagnetic field
will result in perfectly aligned domains, in which case thematerial achieves themaximum
magnetically induced strain (i.e. peakmagnetostriction). Magnetostriction requires themagnetic
domains to be longer in one dimension than the other two to obtain a change in length when the
domain rotates. This, in general, results in anisotropy of the crystal structure of thematerial.
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Magnetostriction is considered to be one of themain sources of noise in Transformers. When an
alternating voltage is applied to one or more windings of a transformer, amagnetic flux is generated
in the transformer core laminationsmade of grain oriented electrical steel. The nonlinear anisotropic
property of magnetostriction implying alternating changes of the core dimensions due to the varying
magnetic flux in the laminations. Thosemagnetostrictive forces cause core vibrationswhich are
transmitted to the tank via the insulation oil and the core clamping points. Part of themechanical
energy is eventually radiated by the tankwalls as noise. In electricmotors, magnetostrictive forces
also contribute tomotor vibration and noise.
On the other hand, magnetostrictivematerials convert energy between themechanical and
magnetic domains (inversemagnetostriction). They deform in response to appliedmagnetic fields
and change their magnetic state when stressed. Somematerials (such as Terfenol-D, Galfenol)
have the ability to produce largemagnetostrictive strains at moderate fields. Short response times (in
themillisecond range) combined with resolutions in the order of microstrainsmake thesematerials
well-suited to precision sensing and actuationmechanisms.
Due to the complexity of themechanism of magnetostriction, it is very difficult to predict it with
analyticmodels. In general, empirical methods based on statistics and dimensional basic parameters
are used bymost transformer manufacturers and sensor producers. Those approaches present
limitationswhen applied to new designs and do not enable accurate parametric studies. Therefore,
predictionmodels based on finite element formulationswill be utilized to describe accurately the
complex interactions of the various design parameters and the coupling of the physical fields.
The finite element method (FEM) is widely used in engineering practice because using the irregular
grids it canmodel complex inhomogeneous and anisotropicmaterials and represent complicated
geometry. The FEMdiscretization produces a set of matrix differential equations. Because of the
nonlinearity, thematrices generally are dependent of the solution vectors, so an iterationmethod
such asNewton-Raphsonmethod should be used to solve these nonlinear matrix equations.
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Namely, the nonlinear matrix equations are linearized for each nonlinear iteration. The linearized
matrix equationsmay be solved by either a direct or iterativematrix solver.
The governing equation of magnetic field is given by:

(equation 1)
WhereA is themagnetic vector potential,σ is the electrical conductivity, and µ is themagnetic
permeability of material. J represents the current density.
Themagnetic flux densityB can be expressed as:

(equation 2)
The relationship betweenB andH (magnetic field) is based on the constitutive law:

(equation 3)
For a discretizedmechanical system, the governing equilibrium equation can be written as

(equation 4)
Where K is the system stiffnessmatrix, is the body force vector, and R the vector of external force, r
is vector of node displacement. The strain-displacement relationship can be written as

(equation 5)
WhereS is the strain tensor. And the stress-strain relationship can be described by
T=CS (equation 6)
where T is the stress tensor, andC is stiffnessmatrix.
When amagnetic field is applied to amagnetostrictivematerial, strain occurs within thematerial
placed in amagnetic field in response to the flux density within thematerial, while the stress gives
feedback to affect themagnetic field. For coupledmethod, we have:

(equation 7)

(equation 8)
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(equation 9)
Where d and dt aremagneto-mechanical coupling coefficients, λ is magnetostriction induced by
magnetic fieldH. Themagnetic field andmechanical stress field are solved together, whichmeans
both fields are solved on the samemesh simultaneously by using the onematrix solver.
For decoupledmethod, themagnetostrictionmay be determined once themagnetic field distribution
is obtained from FEM simulation. Hence an elastic analysis is reduced to the problem of finding the
stress due to an external load caused by a force applied to amaterial with a previously known
magnetostriction, the latter unrelated to the stress. Magnetostriction is transformed into stresswith
the usage of Hooke’s law. Equation (7) can be rewritten as:

(equation 10)

(equation 11)
where
dTH: magnetostrictive, deformation induced bymagnetic field H.
dT: inversemagnetostriction, impact of stressT onmagnetic fieldB.
By using the decoupledmethod, themagnetic field and stress field can be solved independently with
different mesh and different solver, andmagnetostriction and inversemagnetostriction can be
involved in either one or both. Compared to the coupledmethod, the decoupledmethod ismore
flexible and general. The process for the decoupledmethod is shown in the following figure:
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30 - Maxwell Examples
Maxwell contains numerous examples provided for customer use and review. These examples cover
Maxwell 3D, Maxwell 2D, and RMxprt. All examples are stored in theExamples/Maxwell
subdirectory of theMaxwell installation directory.

Related Topics

Maxwell 3D/2D Examples
RMxprt Examples

Maxwell 3D/2D Examples:

\Maxwell2D\opti_new.aedt This is amagnetostatic problem that usesOptimetrics and a
used defined cost function repeatedly simulate andmodify
the shape of one of the steel pieces in order to determine
the optimum shape needed to generate a uniform field in the
air gap on the right side of themodel.

\Maxwell2D\Getting_Started\
solenoid.aedt

The solenoidmodel shown is a 2D axisymmetric simulation
of a 3D actuator that demonstrates rotational symmetry
about a central axis. The problem is amagnetostaticmodel
that uses parametric analysis to determine the force on the
core as various locations along the length of the stroke. This
is a non-linear problem incorporating both non-linear steel
and a permanent magnet. This problem is used in Getting
Started with Maxwell: A 2D Magnetostatic Solenoid
Problem.
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\Maxwell3D\example_DC_
cond.aedt

This example is a real life example of an inductor. In a DC
analysis the focuswould be to look at the distribution of
current density, and ohmic power loss density. A heating /
stress application would also be interesting to do as users
maywant to couple the losses to ePhysics

\Maxwell3D\example_
electrostatic.aedt

The electrostatic example is a bushing application which is
one of themost widely used type for electrostatic solution
type, particularly in 3D. Has been used for many years and
is considered as a benchmark application. Themain results
to be extracted from this example are voltage and field
distribution. For themagnitude of electric field additional
meshing is required which is true for any dielectric
breakdown type of application.
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\Maxwell3D\
example_magnetostatic.aedt

Themagnetostatic example is a relay type of application
exhibiting 3D effects. There is a force setup allowing
extraction of a ’force vs. (rotational) displacement’ type of
characteristic. It also contains a parametric setup which
eventually allows the extraction of an ECEmodel to be used
in Simplorer.

\Maxwell3D\Getting_Started\
Rotational_actuator.aedt

The rotational actuator is another magnetostatic example
usable for the parametric study of the torque and inductance
characteristics vs. position. Possible variation(s) of the
setup can include using ferromagneticmaterials with
different magnetic (non-linear) characteristics and the
respective impact on torque and inductance characteristics.
Thismodel is used in the Getting Started with Maxwell:
Designing a Rotational Actuator guide.

\Maxwell3D\Getting_Started\
Rotational_Act_TR.aedt

Thismodel is amodified version of the Rotational Actuator
model listed above. It is configured with amotionband for
rotating the inner armature. It is a transient problem using
an external circuit to drive the coils with a pulse voltage. The
results demonstrate the torque, position, and current versus
time as the inner armature object moveswith time. This
model is used in the Getting Started with Maxwell: Transient
Problem guide.
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\Maxwell3D\Getting_Started\
ExternalCircuit.amcp

This project is theMaxwell Circuit Editor model used in the
transient rotational actuator problem to drive the coils with a
pulse input.

RMxprt Examples:

\RMxprt\assm\*.aedt Adjustable Speed SynchronousMachine
l ASSM can be used inMotor Mode or Generator
Mode, this example is in motor mode
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\RMxprt\bldc\
QuickStart.aedt
ws-1.aedt
ws-2.aedt
ws-3.aedt
ws-4.aedt
ws-5.aedt
ws-6.aedt

Brushless Permanent Magnet DC Motor
l ws-1 to ws-5 are examples of rotor PMPole Type 1-5
as defined the "Rotor" section

l ws-6 is an example of an outside rotor as shown

\RMxprt\cpsg\cpsg_1.aedt Claw Pole SynchronousMachine
3D Representation is shown.

\RMxprt\dcm\ DCMachines
l these do not have any permanent magnets
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z_500.aedt
zf_500.aedt

\RMxprt\dfig\
dfig_1.aedt
dfig_2.aedt

Generic RotatingMachines

\RMxprt\indm1\3hp.aedt Single Phase InductionMotor
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\RMxprt\indm3\
tsyde-22.aedt
ylew-95.aedt
yz200-6.aedt
yz200-24.aedt
yzd132-4.aedt
yzd132-8.aedt

Three Phase InductionMotor
l These are 22, 95, 6, 24, 4, and 8 polemotor variations
l 8 polemachine is shown.

\RMxprt\lssm\
sm-1.aedt
sm-2.aedt
sm-3.aedt
sm-4.aedt
sm-5.aedt
sm-6.aedt
sm-7.aedt
sm-8.aedt

Line Start Permanent Magnet SynchronousMotor
l sm-1 to sm-8 represent the 8 rotor pole types available

l sm-8 is shown.

\RMxprt\manual\
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AssymetricWinding.aedt
BLDC_4p1500rpm550W.aedt
CPSG_4p50Hz550VA.aedt
DCM_4p1100rpm500kW.aedt
IndM1_2p60Hz3hp.aedt
IndM3_6p50Hz11kW.aedt
LSSM_4p50Hz550W.aedt
PMDC_2p2400rpm75W.aedt
PMSG_4p50Hz550W.aedt
QuickStart.aedt
SRM_8-6p1500rpm550W.aedt
SynM3_6p50Hz538kW.aedt
UniM_2p12500rpm100W.aedt
\RMxprt\nssm\
nssm-1.aedt

\RMxprt\pmdc\
stndj-1.aedt

Permanent Magnet DC Motor
l These are brush typemotors
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\RMxprt\pmsg\
pmsg-1.aedt

Adjustable Speed SynchronousMachine
l ASSM can be used inMotor Mode or Generator
Mode, this example is a generator

\RMxprt\srm\srm-1.aedt Switched ReluctanceMotor

\RMxprt\syng3\
bjs7-6-1.aedt
bjs10-61.aedt
bsm.aedt
g2-5.aedt

Three Phase SynchronousMachine
l This can be either motor or generator mode, these
examples are generators

l Model g2-5 is shown
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\RMxprt\synm3\
Bjs7_mot.aedt

Three Phase SynchronousMachine
l This can be either motor or generator mode, this
example is amotor

\RMxprt\unim\ac120_i.aedt Universal Motor Example
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31 - Maxwell Terminology
This section defines the terminology used in the ANSYSMaxwell® help topics. Terms are listed in
alphabetical order.

Glossary: A

advanced nonlinear options
For themagnetostatic solution type, the advanced nonlinear options allow you to perform
more sophisticated simulations of themagnetostatic field. (Nonlinear materials arematerials in
which themagnetic flux density varies nonlinearly with themagnetic field.)

anisotropic materials
Anisotropicmaterials exhibit different values of the respectivematerial property in different
directions of the three-orthogonal coordinate system used to define it. Any of thematerial
properties can be anisotropic: electric conductivity, dielectric permittivity, magnetic
permeability. Mathematically, tensors are used to express the respective anisotropic
properties.

Glossary: B

B-H curve
In nonlinear materials, when amaterial has a permeability that varies with the flux density, a B-
H curve is used to describe thematerial's nonlinear behavior. The B refers to themagnetic flux
density. The H refers to themagnetic field intensity.

Glossary: C

capacitance
Capacitance is a quantity used to describe the ability of a pair of corresponding electrodes to
store electric energy. In an equivalent formulation, the storage of energy corresponds to
charge accumulation on the respective armatureswhile a voltage is established between
them. Mathematically, capacitance is the positive defined ratio between the charge
accumulated on one of the armatures and the voltage between the two armatures.

cascaded windows
Cascaded windows are a set of partially overlapping windows stacked on top of each other.
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coil terminals
A coil terminal is used to apply excitations to coils. It can be a 2D sheet object obtained, for
example via a section command (for closed coils that are totally contained within the region
where the field problem solution is being computed), or it can bematerialized by the
intersection between the problem region and open-ended conductors. It is assumed that the
current flow is perpendicular to the coil terminal.

conduction path
The conduction path is a sequence of conductors (objects with non-zero conductivity) through
which current flows.

conductivity
Conductivity (electric) represents the ability of amaterial to allow electric current to flow
through it.

conductor
Conductor are, in general, objects with non-zero value of conductivity. The way such objects
are treated by the software depends upon the user-defined conductivity threshold value.

cost function
In an optimization setup, a cost function is calculated based on goal values specified for one or
more solution quantities. The chosenOptimetrics engine automatically changes the design
parameter values to fulfill the objective of the optimization. The cost function can be based on
any quantity that can be computed directly byMaxwell or by the field calculator.

current density terminals
This refers to any terminal used to specify the current density of an object.

cutplane
A cutplane is any plane that cuts through themodel. Cut planes can cut through themodel at
any angle andmay bemoved to a new position to observe a difference in plotted fields.
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Glossary: D

damping (linear motion)
A value for damping for linear motion can be calculated by the windage and friction loss in
Watts divided by the speed inm/sec (at which those losses are defined); this is Damping with
resulting units of (W / (m/sec)^2) or (N*m * sec/m).

damping (rotational motion)
A value for damping for rotational motion (for electricmachines) can be calculated by the
windage and friction loss inWatts divided by the speed in rad/sec (at which those losses are
defined); this is Damping with resulting units of (W / (rad/sec)^2) or (N*m * sec/rad).

design variation
A single combination of variable values that is solved during a parametric or optimization
setup.

dielectric loss tangent
The dielectric loss tangent is amaterial property characteristic for lossy dielectrics, i.e.
dielectrics which exhibit power losses.

Dirichlet boundary
TheDirichlet boundary (or value boundary) allows you to prescribe the value of the function
(solution) on the respective surface of the solution domain where it is applied. Alone or
together with other applied boundary conditions, it ensures the uniqueness of the field solution
calculated byMaxwell.

Glossary: E

eddy current
Eddy currents are the currents due to the electric field induced by the time varyingmagnetic
field in conductors.

eddy effect
The eddy effect refers to the current flow induced by the time-varyingmagnetic field in
conductors. It can be turned on or off depending on the characteristics of the application.
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Turning the eddy effect off in conductors (when their effects are estimated to be negligible)
can save significant computing resources.

electric coercivity
This refers to the electric field that exists when the electric flux is zero.

electric retentivity
The electric retentivity refers to the value of the electric flux density when the electric field is
zero.

electric flux
Electric flux is defined as the integral of the electric flux density vector over a specified surface.
According to Gauss's law, the electric flux calculated for a closed surface is equal to the total
electric charge enclosed by the respective surface.

electric susceptibility
Thismaterial property refers to amaterial's ability to become polarized.

executive parameters
Executive parameters are parameters of great practical significance that are calculated
directly by theMaxwell solvers for all specified objects.

Glossary: F

finite element analysis
Finite element analysis (FEA) is a numerical method of solving physical domain partial
differential equations (such asMaxwell's equations for electromagnetic fields) bywhich the
solution domain is divided into a set of geometric entities such as tetrahedrons.

finite element mesh
The finite element mesh for aMaxwell problem is the assembly of all tetrahedral finite
elements used to discretize the solution space where the respective electromagnetic fields are
calculated.
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floating boundaries
In electrostatics, floating boundaries are similar to Dirichlet boundaries in that the entire
surface is at a single potential, except that you need not specify the potential as a known a
value. This is used tomodel conductors at unknown potentials.

floating conductor
Floating conductors are conductors at which the potential is unknown.

Glossary: G

Genetic Algorithm
Optimizationmethod of the experiment tool with automatic parameter variation and target
function determination.

goal
In an optimization setup, a goal is the value of a solution quantity that you want to be achieved
during the optimization. A goal is represented as one row in the cost function table. Each cost
function defined in an optimization setupmust include at least one goal.

grid plane
The grid plane is the plane on which you want to display the grid in the active view window.
Also called the drawing plane.

Glossary: H

hotkeys
Hotkeys are keystroke combinations that executemore complex commandswithout the need
for accessing the commands in themenu bars or tool bar icons.

Glossary: I

imaginary permeability
Thismaterial property refers to the imaginary component of the permeability of amaterial. See
permeability.
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imaginary anisotropic relative permeability
Thismaterial property refers to the imaginary component of the anisotropic relative
permeability of an object. See anisotropic permeability.

imaginary relative permeability
Thismaterial property refers to the imaginary component of the relative permeability of a
material. See relativepermeability.

impedance
Impedance represents the characteristic of an electric circuit element to impose a certain
dependency between the voltage between a pair of terminals and the corresponding AC
current flowing between the two terminals.

independent generator
The generator supplies electrical power to a load inductor. For an AC generator, the
resistance and inductance of the load inductor are determined by the rated output power, the
rated voltage, and the rated power factor. For a DC generator, the resistance of the load
resistor is determined by the rated output power and the rated voltage.

inductance
Inductance represents the property of amagnetic circuit to relate itsmagnetic flux to the
current which produced it. It is the expression of the property of magnetic devices to store
magnetic energy.

infinite bus
When the generator is connected to an infinite bus of the power system, the terminal voltages
remain constant and the output power is determined by the output currents.

insulating boundary
An insulating boundary is a convenient way of preventing the current flow across the
boundary. This boundary condition is placed between conductors and allows you to avoid
creating small separating spaces between conductors for insulation purposes.

insulator
An insulator refers to amaterial that does not allow the current to flow through it (typically with
zero electric conductivity). The way such objects are treated by the software depends upon
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the user-defined insulation threshold value.

isotropic materials
Isotropicmaterials refer to materials with properties independent of the direction (orientation)
of the axes of the coordinate system in which they are defined.

Glossary: L

lamination model
Laminationmodeling allows you to specify a stacking factor and stacking direction, which
represents the direction perpendicular to the plane of the lamination. This laminationmodel is
an alternative way of specifying anisotropic behavior when using laminations.

line impedance
The line impedance of an object is the impedance of a single current loop.

LMB
This is an acronym for the left mouse button. The left mouse button is used to choose
commands and select points, surfaces, and objects.

Lorentz force
The Lorentz force is the force on an object due to the currents in themagnetic field, neglecting
forces due to the effects of material properties.

Lorentz torque
The Lorentz torque is the torque of an object due to the currents in amagnetic field, neglecting
torques due to the effects of material properties.

lumped capacitance
Lumped capacitance is the capacitance between two conductors or groups of conductors.

Glossary: M

magnetic coercivity
This refers to themagnetic field that exists when themagnetic flux is zero.
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magnetic flux
Themagnetic flux is the total of all the lines of force in amagnetic field.

magnetic loss tangent
Themagnetic loss tangent allows you to represent a dielectric that dissipates the power of a
high-frequencymagnetic field. The smaller the loss tangent, the less lossy thematerial.

magnetic retentivity
In nonlinear materials, themagnetic retentivity (or remanence) refers to the value of the
magnetic flux density when themagnetic field is zero.

magnetic susceptibility
Themagnetic susceptibility is ameasure of the ability of thematerial to becomemagnetized.

matching boundaries
Matching boundary conditions force the field solution at one surface (the Slave surface) to
match themagnitude and orientation (or opposite orientation) of the field at theMaster
surface.

material consumption
Whole-circle laminations – Considers aminimum section of square “raw steel” fromwhich
the lamination could be cut. The calculation takes the rotor or stator diameter as the length of
the square and calculates the weight based on thematerial density.
Lamination sectors – For large sizemachines, a lamination layer of the stator coremay be
laminated sector-by-sector, instead of a whole circle lamination. The number of Lamination
Sectors indicates how many lamination sectors are needed to form a lamination layer.
Lamination sectors are punched as shown below so that material consumption isminimized.
There is a 3mmallowance in the edge and between two sectors.
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material coordinate system
Thematerial coordinate system is the coordinate system used to define the vector or
anisotropicmaterial property of objects. Maxwell supports the following threematerial
coordinate systems: Cartesian, cylindrical, and spherical.

mesh refinement
Mesh refinement refers to the process of successively breaking down large error finite
elements into smaller ones for the purpose of continuously increasing the accuracy of the finite
element calculation. Maxwell uses proprietary adaptivemesh refinement algorithms designed
to automatically detect and refine themesh in regionswith the largest field error.

multi-processing
Usingmore than one processor to solve aMaxwell design. Requires amultiple processor
license. Usingmultiple processors (if physically available on the computer) speeds up the
matrix solution process phase. Thus, shorter solution times can be achieved with significant
saves in absolute terms, particularly for largemodels of 100,000 finite elements or more.
There are no negative side effects if the number of processors to be used is set to more than
are available on the respective computer. In this case, the actual number of available
processors will be used in thematrix solution process.

Glossary: N

natural boundary
A natural boundary is a boundary condition at the interface between different objects. You do
not need to apply this boundary condition yourself, asMaxwell enforces it internally. The
natural boundary condition reflects the particular local form of Maxwell's equations at the
interface between objects where there is an sudden change in thematerial properties. When
crossing such a surface of discontinuity, Maxwell assumes the following behavior (in average):
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l The normal component of B is continuous.
l The normal component of D has a jump equal with the local superficial charge density (on the
discontinuity surface).

l The tangent component of H is continuous if there are no current sheets on the discontinuity
surface (has a jump equal with the density of the current sheet if they are present on the
discontinuity surface), and so on.

Neumann boundary
The homogeneousNeumann boundary condition specifies that (for magnetic field problems)
the normal component of the H field is zero. In other words, this boundary condition confines
themagnetic field within the space of the problem. If the out-most surfaces of the problem
region are not assigned any boundary conditions, they automatically receive a Neumann BC.
Because of this, as a rule, the solution space (region size) should be chosen such that the
respective region walls are not close to field sources (currents and/or permanent magnets);
this allows us to assume the field is a tangent at the region limits.

nodes
Nodes normally refer to the vertices of the tetrahedral finite elements. They can also refer to
the connection points of branches in an electric circuit (if external circuits are used to drive
coils).

nominal design
The original model on which Optimetrics analyses are based.

nonlinear materials
Nonlinear materials arematerials with the constitutive relationship being nonlinear (such as is
the case of the dependency between B and H for somemagneticmaterials).

Glossary: O

outer terminals
Typically, outer terminals are faces of 3D objects that lie on the surface of the problem region.

Glossary: P

parametric analysis
A parametric analysis consists of a sweep of one or more design or project variables for the
purpose of analyzing one or more output quantities (Maxwell parameters or quantities
calculated by the field calculator).
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paste buffer
When you cut or copy an object, such aswith theEdit commands, the object is stored in the
paste buffer. The paste buffer itself is an area of resident memory that is erased and replaced
with the newest item that has been cut or copied.

perfect conductor
Perfect conductors are idealizedmaterials with very high conductivity (typicallymany orders of
magnitude above the usual conductivity values). The actual value is influenced by the perfect
conductivity threshold value you specify in the solve options.

permanent magnets
Permanent magnets are anymaterials that generatemagnetic flux due to permanent
magnetic dipoles in thosematerials.

permeability
Permeability is amaterial property characteristic of magneticmaterials and relatesmagnetic
flux density to magnetic field strength in objects with no permanent magnetization present.

permittivity
Permittivity is amaterial property characteristic for dielectrics and relates electric flux density to
electric field strength in objects with no permanent electric polarization present.

phasors
Phasors represent a conventional way of representing sinusoidal (AC) quantities such as
voltages and currents. In a phasor representation, the amplitude of the signal relates to the
length of the rotating vector (phasor) while the initial phase is the starting angle at time t=0.
The angular velocity of the phasor rotation relates to the frequency of the signal.

polyline
A polyline is an object composed of one or more straight or curved line segments.

post processing
Post processing is the phase of the analysis when information is extracted from the simulation.
Typical results are 2D plots, contour and vector plots of field quantities, results from the field
calculator, animations, etc.
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press board (pressboard)
An optional material used above and below the lamination stack and as a spacer in
manufacturing. In RMxprt, users can specify the press board thickness and whether it is
magnetic or non-magnetic.

problem region
The problem region is the region whereMaxwell calculates the field solution. This is an all-
encompassing object with user-selectedmaterial properties and with surfaces that are used to
apply the necessary boundary conditions (user-specified or default ones).

Glossary: R

relative permeability
Relative permeability relates the absolute permeability of amagneticmaterial to the

permeability of vacuum (  H/m).

relative permittivity
Relative permittivity relates the absolute permittivity of amagneticmaterial to the permittivity of

vacuum(  H/m).

resistance
Resistance represents the characteristic of a DC electric circuit element to impose a certain
dependency between the voltage between a pair of terminals and the corresponding DC
current flowing between the two terminals.

RMB
This is an acronym for the right mouse button.

RMBM
This is an acronym for the right mouse buttonmenu. Thismenu becomes visible when you
hold the right mouse button downwhile the cursor is in a view window. Depending on the
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module you are in, youmay use thismenu to select or deselect objects, or accept or cancel
selections or values.

Glossary: S

section
This refers to theSurfaces/Section commandwhich creates a cross-section of 3D objects
with the XY, YZ, or XZ planes.

seeding
Seeding refers to the process of adding points to your finite element mesh to create a finer
one.

self-inductance
Self-inductance of an object or group of objects associates the current flowing in the
respective object(s) with the own flux linkage.

skin depth
The skin depth of amaterial is the distancemeasured inside a conductor from the surface
where the AC field (magnetic/electric) penetrating the conductor is reduced by a factor of 1/e
(~ 1/2.71). As general rule is that at 5 skin depths from the surface, the AC fields penetrating
inside conductors can be considered to be zero.

slot fill factor
The slot fill factor is the ratio between the cross-sectional area of all conductors in one slot and
the entire slot area.

solver
Maxwell has a number of solvers allowing you to choose from electric, magnetostatic, eddy,
and transient, depending upon the characteristics of the problem to be solved.

solver residual
The solver residual is an error term that measures the current accuracy of the solution process
when using an iterative solver.
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superposition
Superposition allows you to combine the results of field solutions, each corresponding to linear
problems. Superposition should not be used when problems are nonlinear.

surface
A surface is an object face.

sweep
Sweep can refer to two different topics:

l In the 3D Modeler, sweeping a face or object along a path or vector creates a new 3D object.
The object you sweep need not be orthogonal to the path or vector.

l In the Executive Parametersmodule, a parametric sweep refers a series of variables.

symmetry boundary
Symmetry boundariesmodel the planes of symmetry in a problem.

Glossary: T

terminal
As a terminal, you can use an exact cross-section of the conduction path, to apply an eligible
excitation.

tile window
Existing windows, regardless of their contents, can be tiled either horizontally or vertically.

toolbar
The toolbar is the location of the iconswhich can be used to shortcut commands.

Glossary: V

value boundary
SeeDirichlet boundary.
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variable sweep definition
A set of variable valueswithin a range that Optimetrics drivesMaxwell to solve when a
parametric setup is analyzed. A parametric setup can include one or more sweep definitions.

vector functions
Vector functions are used to specify certain vector type properties. For instance,
magnetization can be defined using vector properties in a chosen, previously defined
coordinate system.

view window
In the 3D Modeler, the view window is the window in which you create your model. The view
window gives a 3D view of themodel. In this window, you can assignmaterials to objects,
specify boundary conditions, set up any executive parameters, or post process data or fields in
themodel.

virtual force
Virtual force is the force calculated on an object or group of objects using a special
mathematical algorithm that contains the effects of a virtual motion along a generalized
coordinate (such as x, y, z). Themovement does not actually take place; it is virtual.

virtual torque
Virtual torque is the torque calculated on an object or group of objects using a special
mathematical algorithm that contains the effects of a virtual rotation around a coordinate axis
(such as x, y, z). Themovement does not actually take place; it is virtual.

visibility
Visibility refers to whether or not an object is displayed. You can show or hide an object using
theView>Active View Visibility commands.
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Ampere’s Law 28-11
analyses

monitoring 21-51
Optimetrics 25-1

re-solving 21-232 , 26-114
starting 19-1 , 21-1 , 26-114

animations
field 23-15
geometry 23-14
overview 23-13

anisotropicmaterials
and ports 29-111
conductivity tensor 29-108
electric loss tangent tensor 29-108
magnetic loss tangent tensor 29-110
permeability tensor 29-106
permittivity tensor 29-107

anisotropy
conductivity 29-108
electric loss tangent 29-108
magnetic loss tangent 29-110
permeability 29-106
permittivity 29-107

anisotropy tensors
definingmagnetic loss tangent 10-13

ANSYS RSMCluster (ARC) 21-174
ApplyOrientation 8-180
ARC 21-174
arcs

center-point 8-5
three-point 8-4

auto-save file 5-9 , 26-5
AutoCAD Drawing Interchange Format

files 5-22
average force 29-71
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axisymmetricmodels
electric flux linkage 28-10

B

balloon boundaries
charge at infinity 28-58

Band UDPs
3D master and slave boundaries 9-

14
outer region 9-7

Band.cpp 9-30
Band.h 9-29
Boolean operations 9-6
boundaries

setting default values 11-20
boundary conditions

functional 28-73
brushless permanent-magnet DC

motors
circuit type 26-224, 26-293, 26-318
general data 26-293, 26-319
general procedure 26-292
stator data 26-296, 26-320

conductors 26-251, 26-298, 26-
358, 26-383

end length adjustment 26-234,
26-254, 26-303, 26-337,
26-360, 26-385, 26-404

stator windings 26-298
winding types 26-300

trigger angle 26-319

C

calculator
exporting 23-167
General commands

CmplxMag 23-150

CmplxReal 23-150
output 23-163
registers 23-141

capacitance
in terms of charges and voltages 28-5 , 28-

5
Cell Filtering 22-17
ClawPoleCore UDPs 9-118

magnet 9-122
clean stop 21-231
clip planes 8-194
Code implementation

UDP parameters 9-10
color key

moving 23-128
colors

of selected objects 8-213
command properties 3-21
commutator 26-257, 26-364, 26-390
commutator type

cylinder 26-257, 26-364, 26-390
pancake 26-257, 26-364, 26-390

complex numbers
admittance 28-43
impedance 28-27

component libraries 8-70
Components Tab 27-7
ConCoil UDPs

single concentric coil 9-54
conductance 28-41
conduction paths

recalculating 11-19
showing 11-18

conductivity 29-102
and skin depth 28-26
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conductors
passive 28-68
stranded 28-47

convergence
output variable 16-6
viewing output variable 23-3

convergence data
output variable 23-3
plotting 23-3

coordinate systems
creating face 8-245
default planes 8-245
deleting 8-252
modifying 8-251
overview 8-240

Core regions 9-17
cost function

adding 25-37
Coupling 17-1

ANSYS Fluent 17-39
ANSYS Thermal 17-3
HFSS 17-37
Simplorer 17-39

creating a quick report 23-20 , 26-133
current

instantaneous 28-29
peak 28-30
source 28-21

current coordinate system, about 8-
240

current density
AC 28-32
source current 28-21

current sources
AC

parallel 28-69
perfect conductors 28-69
solid 28-69
stranded 28-69

D

datamarkers 23-134
dataset expressions

adding 5-112
using 5-130 , 26-68

datasets
adding 5-112
Importing 5-114
modifying 5-115

DC conduction solver
conductance 28-41
current flow 28-41
theory 28-37

DCMCore UDPs
commutating poles 9-83
frame 9-83
main poles 9-83
outer core 9-82

Debye’smodel 29-113
defaults

background color 8-201
lighting 8-200
mesh plot attributes 23-170
renderingmode 8-193
snap settings 8-235

delta H 29-105
Design of Experiments 25-76
Design Settings 6-2

Index-3
ANSYSElectromagnetics Suite 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential

information of ANSYS, Inc. and its subsidiaries and affiliates.



Maxwell Online Help

design variables
deleting 5-110

design variations
viewing solution data 25-114

Design Xplorer, exporting setup 25-
119

designs
setting up 6-1 , 26-135

desktop
Extensionswindow 3-27
menu bar 3-3 , 3-4 , 26-9
status bar 3-13 , 26-12
toolbars 3-8 , 26-11

Desktop Configuration 5-44 , 5-44 , 5-
45 , 5-46 , 5-49 , 8-41 , 8-43 , 8-
44

dielectric loss tangent 29-103
DiskCoil UDPs

whole winding 9-146
DiskPMCore UDPs

all magnets 9-151
onemagnet 9-151

DiskSlotCore UDPs
axial-flux slot core 9-142
squirrel-cage winding 9-143

displacement current 28-22
distributed analysis 25-11
DoubleCage UDPs

bars only 9-65
whole double-cage winding 9-64

Download fromServer 5-15
drawing amodel, overview 8-1
drawing objects

bondwires 8-28
boxes 8-19
circles 8-12

cones 8-20
cross-sections 8-160
cylinders 8-17
equation based curve 8-11
helices 8-22
planes 8-29
points 8-28
polylines 8-7
regular polygons 8-15
regular polyhedrons 8-19
spheres 8-17
straight line segments 8-3 , 8-29
toruses 8-21

drawing plane 8-253
Duplicate operations 9-5
duplicating objects

along a line 8-148
andmirroring 8-149
around an axis 8-148

E

eddy current
and skin depth 28-26

eddy current solver
current flow 28-34
impedance 28-27
theory 28-20
virtual force 28-32
virtual torque 28-34

electric flux density 28-3
electric potential

reference for 28-71
electrostatic solver

capacitance 28-4
flux linkage 28-10
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theory 28-2
virtual force 28-8

Excitations 28-64
setting default values 11-20

export a circuit 19-1 , 19-4
exporting

3D model files 5-23
expressions

dataset 5-130 , 26-68
defining 5-125 , 26-66
intrinsic functions in 5-128 , 26-67
piecewise linear functions in 5-130 ,

26-68
valid operators 5-126 , 26-66

extruding faces 8-161

F

face coordinate system
about 8-240
creating 8-245

faces
covering 8-158
extruding 8-161

ferrite materials
properties of 10-4

FFT 23-97
field overlay plots 23-109

modifying phase 23-108
vector plots 23-123

field plot animations 23-15
field quantities

phase angle 23-150
plotting basic 23-108

field simulation
electrostatic 7-3
magnetostatic 7-1

field solutions
saving for a statistical setup 25-105
saving for a tuning analysis 25-105
saving for all Optimetrics setups 25-

105
Fields calculator 23-138
file formats

.avi 23-18

.dsp 23-136

.dxf 5-22

.sat 5-24

.sm3 5-24
animatedGIF 23-18

files
auto-save 5-9 , 26-5

fixed variables, setting values during
analyses 25-110

frequency
and skin depth 28-26

Function library 9-6
Function pointers 9-3
functions

defining 5-125 , 26-65
valid operators 5-126 , 26-66

G

Gauss’s Law 28-3
generic rotatingmachine

rotor data 26-449
winding type 26-479

generic rotatingmachines
core data

inner diameter 26-450
outer diameter 26-450

general data
output power 26-491
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rated voltage 26-492
winding data

parallel branches 26-473, 26-
481

wire diameter 26-474, 26-482
wire gauge 26-474, 26-482
wire wrap 26-474, 26-482

geometry animations 23-14
global coordinate system, about 8-240
grid settings

choosing 8-203
density 8-205
grid plane 8-206
spacing 8-205
style 8-204
type 8-204
visibility 8-205

H

Helix UDPs 9-1
hiding

color key 8-206 , 23-127
objects 8-186

history tree
controlling view of objects 3-30
operations affecting relative CS 8-

240
Unclassified folder 3-32
Upgrade Version 3-37

holes
resizing 8-161

HPC diagnostics tool 21-226
hysteresis loss 29-60

I

IFFT 23-97

impedance
matrix 28-27 , 29-63

importing
data tables 5-35
files 5-26

Importing Datasets 5-114
imprint projection command 8-176
initial mesh settings 15-23
intersecting objects 8-166
Intrinsic function declarations 9-3
intrinsic functions 5-128 , 26-67
intrinsic variables 5-127
IPMCore UDPs 9-128

all magnets 9-130
one-polemagnets 9-131

IronPython 24-1
indentation 24-6

K

keyboard shortcuts
custom 3-12
General 3-11
Modeler 3-38

L

laminationmodeling 10-17
landeG factor 29-105
LapCoil UDPs

3D open insulation 9-48
single lap coil 9-47
whole lap winding 9-46

length-based refinement
inside objects 15-3
on faces 15-2

lighting 8-200
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line-start permanent-magnet
synchronousmotors 26-327

general data 26-331
general procedure 26-330
stator data 26-332
stator windings 26-335

linear constraints
deleting 25-112
modifying 25-112
setting 25-111

linear materials
properties of 10-4

LinearMCore UDPs
one coil 9-154

lines
between grid points 8-205

local variables
adding 5-105 , 26-61

Lorentz force 29-49
Lorentz torque 29-26 , 29-50

M

magnetic field
static 28-11

magnetic flux density
in nonlinear materials 10-63

magnetic loss tangent 10-12 , 10-12 ,
29-103 , 29-103

magnetic saturation 29-105
magnetic vector potential

reference for 28-71
magnetostatic solver

flux linkage 28-19
inductance 28-13
theory 28-11
virtual force 28-17

virtual torque 28-19
markers

point plot 23-133
material browser, accessing 10-1 , 11-1

, 13-1 , 26-72
material characteristics

magnetic loss tangent 10-12 , 29-103
nonlinear materials 10-62
permeability 29-101

material properties
anisotropic 10-5
conductivity 29-102
delta H 29-105
dielectric loss tangent 29-103
landeG 29-105
magnetic loss tangent 10-12 , 29-103
magnetic saturation 29-105
permeability 29-101
permittivity 29-101
simple 10-5

materials
assigning to objects 10-1 , 11-1 , 13-1

, 26-72
filtering 10-30
modifying 10-27
nonlinear 10-62
search by name 10-3
search by property 10-3
validating 10-29
viewing 10-27

MATLAB Optimizer 25-25
matrices

admittance 28-43
capacitance

diagonal terms in 28-6
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off-diagonal terms in 28-6
self-capacitance 28-6

conductance 28-41
and voltage drops 28-41

impedance 28-27 , 29-63 , 29-63
mutual impedance 28-28 , 29-

65
self-impedance 28-28 , 29-64
solution process 29-65

inductance
diagonal terms in 28-15
mutual inductance 28-15
self-inductance 28-15

Maxwell’s equations 28-23
MeasureMode

distance between two points 8-239
position 8-238

mesh
plotting 23-169

mesh generation
Copy geometric equivalent meshes

options 25-109
copy geometrically equivalent

meshes 25-109
process 29-5

mesh operations
defining 15-1
initial mesh settings 15-23
model resolution 15-20

mesh plots
creating 23-169
transparency 23-171

mesh refinement
definingmesh operations 15-1
without solving 15-23

meshing region 29-10

Message severity 9-3
Message window

about 3-23 , 26-17
displaying 3-23 , 26-17
new messages 3-25

mirroring objects 8-146
model analysis, Modeler menu command 8-

113
modifying objects 8-139
Motion Variables 3-18
movement mode

3D 8-232
choosing 8-231
in plane 8-231
out of plane 8-232

Movement mode 3D 8-253
moving faces

a specified distance 8-161
along a vector 8-162
along the normal 8-161

moving the cursor
in 3D space 8-232
in plane 8-231
out of plane 8-232
selectingmovement modes 8-231

mutual impedance 28-28 , 29-64
mutual inductance 28-15 , 29-65

N

ndExplorer
displayingmixed-mode parameters 22-19
Network Data Explorer 22-1

Network Data Explorer 22-1
Cell Filtering 22-17
changing port properties 22-18
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color codedmatrix plot 22-30
comparing network data 22-36
comparing variations 22-38
creating a statistics plot 22-35
displaying individual statistics 22-34
displaying statistics by

frequency 22-33
loading data into 22-6
Overview 22-3
reducingmatrix size 22-18
Smoothing 22-17
thresholding 22-15

nominal design 25-1
non-model objects 8-32
nonlinear materials 10-62 , 10-62 , 10-

62
NonSalientPoleCore UDPs

inner core 9-34

O

objects
bondwires 8-28
boxes 8-19
circles 8-12
cones 8-20
converting polyline segments 8-169
cylinders 8-17
equation based curve 8-11
helices 8-22
modifying 8-139
planes 8-29
points 8-28
polylines 8-7
regular polygons 8-15
regular polyhedrons 8-19
setting deformation 10-36

spheres 8-17
toruses 8-21

Online Help for Components 27-9
open objects 8-2
opening

legacyMaxwell projects 5-5
Optimetrics

Copy geometric equivalent
meshes 25-109

overview 25-2
tuning a variable 25-101
types of analyses 25-1
viewing analysis results 25-113
viewing solution data 25-114

optimization analysis
optional settings 25-25
overview 25-12
setting up 25-25

Optimization Overview 25-12
optimization setups

adding 25-25
procedure for defining 25-25
solving 21-1

optimizers 25-12
Other Cores and Coils UDPs 9-138 , 9-

138
output variables

deleting 23-103
specifying 23-98

P

parallel current sources
eddy current in 28-70

parameterizing, See variables 5-102 ,
26-59
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parametric analysis
setting up 25-2
solution quantity results 25-10 , 25-

10 , 25-116 , 25-116
parametric setup

overview 25-3
parametric setups

plotting solution quantity results 25-
116

solution quantity results 25-10 , 25-
10 , 25-116 , 25-116

solving 21-1
percent error 16-5
permanent-magnet DC motors

brush displacement 26-258, 26-
365, 26-390

commutator and brush data
brush pairs 26-257, 26-364, 26-

390
brush width 26-365
commutator type 26-257, 26-

364, 26-390
general data 26-245, 26-399
rotor data 26-249, 26-408

permanent magnets 10-38
nonlinear 10-38 , 10-38

permeability 16-9 , 29-101
nonlinear 10-62

permittivity 29-101
phase, modifying for field overlays 23-

108
phasors

real and imaginary
components 28-53

placing components 27-9
planes

default 8-29

play panel 23-16
Plot Data

Importing 23-105
plots

mesh 23-169
spectral domain 23-97

plotting
basic quantities 23-108

Plotting Standard Field Quantities
Current 23-110
Dielectric Loss 23-112
Electric Field Intensity 23-111
Electric Flux Density 23-111
Hysteresis Loss 23-112
Magnetic Field 23-110
Magnetic Flux Density 23-111
Ohmic Loss 23-111
Surface Current Density 23-111
Total Loss 23-112
Vector Potential 23-110
Voltage 23-111

PMCore UDPs 9-123
all magnets 9-126

PMDamperCore UDPs 9-131
all magnets 9-136

point of reference 8-231
PolygonHelix UDPs

left-handed 9-6
right-handed 9-6

polylines
spline segments 8-6
straight line segments 8-3 , 8-29

post processing
overview of options 23-1 , 26-115

potential 28-2
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problem region 29-10
Project Manager window

overview 3-14 , 26-14
showing 3-14 , 26-14

project tree
field overlays 23-108
field plot folders 23-108
showing 3-14 , 26-14

project variables
adding 5-102 , 26-59, 26-61
deleting 5-105

projection view 8-201
Projects

default names 5-1 , 26-34
deleting 5-16
managing 5-1 , 26-34
opening legacyMaxwell 5-5
opening recent 26-4
renaming 5-9
saving 5-7

Q

quantities
plotting field 23-85

quick report 23-20 , 26-133

R

RacetrackSlotCore UDPs
outer core 9-31

re-solving a problem 21-232
rectangular plots

creating 2D 23-38 , 26-121
creating 3D 23-41 , 26-122

RectHelix UDPs
left-handed 9-8
right-handed 9-8

reference point
moving relative to 8-231
selecting 8-231
setting 8-228

registers 23-141
relative coordinate system

about 8-240
creating 8-242
operations affecting 8-240

relative permeability 29-101
and skin depth 28-26

relative permittivity 29-102
remote analysis 21-4
Report Data 23-103
reports

background properties 23-32
creating 23-19 , 26-119
creating 2D rectangular plots 23-38 ,

26-121
creating 3D rectangular plots 23-41 ,

26-122
creating data tables 23-44 , 26-123
creating quick reports 26-133
creating rectangular contour plots 23-

46
overview 23-19 , 26-119
plotting field quantities 23-85
selecting a function 23-78 , 26-126
updating 23-104
user defined outputs 23-171

RMxprt
changing themachine type 26-34
general procedure 26-34

rotating
the view 8-182
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S

SalientPoleCore UDPs
damper 9-71

saving fields
for a statistical setup 25-106
for a tuning analysis 25-106 , 25-

107
for all Optimetrics setups 25-105

saving projects
automatically 5-9 , 26-5

scalar field plots
transparency 23-133

Scheduler
IronPython 21-201
proxy interfaces 21-191

scripting, IronPython 24-1
Search Tab 27-9
seed value 25-68
seeding themesh 29-6
selecting

all face edges 8-222
all object edges 8-222
all object faces 8-218
edges 8-220 , 8-224
faces 8-216
faces by name 8-218
multiple objects 8-209
object behind 8-225
objects 8-208
objects by name 8-210
vertices 8-222

selecting objects
by variable 8-226
history tree groups 8-213

self-capacitance 28-6

self-impedance 28-28 , 29-64
self-inductance 28-15 , 29-65
sensitivity analysis

optional settings 25-59
setting up 25-59

sensitivity setups
adding 25-59
procedure for defining 25-59

setting
reference point 8-227

setting the drawing plane 8-253
setting themovement mode 8-253
setting up designs 6-1 , 26-135
setting up projects 6-1 , 26-135
setups, solution 16-1 , 26-104
ShadedPoleCore2 UDPs

coil and terminals 9-88
core with poly holes 9-91
jointed shaded conductor and terminals 9-

89
outer shaded pole core 9-87
separated shaded conductor and

terminals 9-89
sheet objects 8-2
SheetScan Toolbars 5-117
showing

selections 8-189
simulations

monitoring 21-51
re-solving 21-232 , 26-114
runningOptimetrics 21-1
starting 19-1 , 21-1 , 26-114

single-phase inductionmotors
general data 26-198
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rotor data 26-210
rotor slots 26-212

stator data 26-200
inner diameter 26-211
outer diameter 26-211
slot type 26-211
slots 26-211
stator slots 26-201
wire diameter 26-206
wire gauge 26-206, 26-208

stator windings 26-203
snap settings

choosing 8-235
modes 8-235
setting default 8-235

solution data
viewing 23-2 , 26-115

solution settings
specifying 16-3 , 26-104

solution setups
adding 16-1 , 26-104

solutions
monitoring 21-51
re-solving 21-232 , 21-232 , 26-

114, 26-114
starting 19-1 , 21-1 , 26-114

Solver 7-1
EddyCurrent 7-2
Electrostatic 7-1
Magnetostatic 7-1

solvers
eddy current 7-2
electrostatic 7-3
magnetostatic 7-1
transient 7-2

solving 19-1 , 21-1 , 26-114
inside an object 10-2

Source code files 9-18
Band.cpp 9-30
Band.h 9-29
UDPBase.cpp 9-20
UDPBase.h 9-18

sources
AC conduction

required 28-64
Voltage 28-64

DC conduction
required 28-64
Voltage 28-64

eddy current
Current 28-64
parallel current 28-69
passive 28-68
perfect current 28-69
required 28-64
solid current 28-69
stranded current 28-69

electrostatic
Charge 28-64
Floating 28-64
polarizedmaterials 28-65
required 28-64
Voltage 28-64

functional 28-73
magnetostatic

Current 28-64
permanent magnets 28-65
required 28-64

spinning the view 8-183 , 8-184
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SquirrelCage UDPs
bars only 9-60
whole squirrel cage winding 9-60

SRMCore UDPs 9-102
core and all coils 9-105
inner or outer core 9-104

stack 23-141
stack commands

clear 23-143
exch 23-143
pop 23-143
push 23-143
rldn 23-143
rlup 23-143
undo 23-143

stacking direction 10-19
statistical analysis

setting up 25-67
statistical setups

adding 25-67
procedure for defining 25-67

status bar, overview 3-13
steady-state conditions 28-38
stitch sheets command 8-123 , 8-135 ,

8-137
stranded conductors 28-47
surfaces

covering 8-158
susceptance 28-43
Sweep functions 9-4
sweeping objects

along a path 8-152
along a vector 8-151
around an axis 8-150
draft types 8-151

switched reluctancemotors
general data 26-317

Synchronous reluctancemachines 9-107
SynRMCore UDPs 9-107

different barriers 9-109
inner core 9-109

T

three-phase inductionmotors
general data 26-177

output power 26-193, 26-215, 26-242,
26-260, 26-288, 26-311, 26-326,
26-344, 26-366, 26-393, 26-411

rotor data 26-189, 26-238, 26-307, 26-
324, 26-341, 26-355, 26-380

end ring 26-191, 26-213
stator data 26-178

conductors 26-181
inner diameter 26-189, 26-238, 26-

249, 26-279, 26-308, 26-325, 26-
341, 26-356, 26-381, 26-409

outer diameter 26-189, 26-238, 26-
249, 26-279, 26-308, 26-325, 26-
341, 26-356, 26-373, 26-381, 26-
409

parallel branches 26-269, 26-321, 26-
353

slot type 26-178, 26-189, 26-227, 26-
249, 26-266, 26-296, 26-332, 26-
401

slots 26-178, 26-189, 26-226, 26-249,
26-266, 26-296, 26-332, 26-400

stator slots 26-179
windings 26-181
wire diameter 26-184, 26-233, 26-253,

26-274, 26-303, 26-322, 26-336,
26-353, 26-360, 26-385, 26-404
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wire gauge 26-184, 26-234, 26-
253, 26-274, 26-303, 26-
322, 26-336, 26-353, 26-
360, 26-385, 26-404

wire wrap 26-183, 26-233, 26-
252, 26-274, 26-302, 26-
322, 26-335, 26-353, 26-
359, 26-384, 26-403

three-phase non-salient synchronous
machine

stator data
inner diameter 26-419
outer diameter 26-419
slot type 26-419
slots 26-419
stator slots 26-419

three-phase synchronous generators
general data 26-265
rotor winding data 26-284

parallel branches 26-284
winding type 26-284
wire wrap 26-284

stator data 26-266
stator slots 26-267
winding types 26-272

time-varying quantities
real and imaginary components 28-

53
Toolkit command 23-209
trace characteristics 23-66
traces

adding blank 26-125
adding characteristics 23-63
display properties 23-50
removing 23-69 , 26-125
replacing 26-125

Traces dialog box 23-19 , 26-119

TransCoil UDPs
three legs 9-161

TransCore UDPs
two yokes 9-158

Transform operations 9-5
transient simulation 28-46
transient solid conductors

current sources 28-49
voltage sources 28-50

TransTwist UDPs 9-164
core and all twist coils 9-169
twist insulator 9-170

tuning analysis
resetting variable values after 25-105
setting up 25-101

U

UDPBase.cpp 9-20
UDPBase.h 9-18
UDPs

ClawPoleCore 9-118
coding 9-1

intrinsic structures 9-1
ConCoil 9-49
core region 9-17
DCMCore 9-75
DiskCoil 9-143
DiskPMCore 9-148
DiskSlotCore 9-139
DoubleCage 9-62
helix 9-1
IPMCore 9-128
LapCoil 9-44
LinearMCore 9-151
NonSalientPoleCore 9-31
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